
Сложно в настройке 
и требует подготов-
ки. Нужно заранее 
продумать структуру 
базы данных. 

Можно использовать 
для представления 
информации. Лучше, 
чтобы студенты сами 
добавляли материал. 

База данных – 
универсальный 
инструмент, позво-
ляющий оценивать 
работу студентов. 

Частично подходит. 
Можно добавлять 
комментарии к 
записям. 

Можно редактиро-
вать собственную 
запись. Другие сту-
денты могут добав-
лять комментарии. 

6/6 возможно. 
Зависит от 
выбранного 
педагогического 
сценария. 

База данных/ 
Элемент курса 
Создание записей 
для просмотра и 
поиска информации 

Также просто, как 
пересылать файлы 
по электронной 
почте. Использовать, 
если имеет смысл. 

Да. Инструмент 
для размещения 
преподавателем 
ресурсов в виде 
файлов.  

Нет. Лучше 
обсудить работы в 
форуме или 
собрать при 
помощи «Задания». 

Нет. Этот 
инструмент не для 
взаимодействия 
или 
коммуникации. 

Нет. Для этого 
лучше 
использовать 
форум, вики или 
глоссарий. 

2/6.  
Является лишь 
передачей информа-
ции, а не учебной 
деятельностью. 

Файл/ Ресурс 

Добавление файла 
(документа Word/ 
PowerPoint) 

Передача 
информации  
Пригоден ли этот 
инструмент для 
распространения 
информации для 
Ваших студентов? 

Оценка 
обучения  
Позволит ли этот 
инструмент Вам 
оценить работу 
Ваших студентов? 

Общение и 
взаимодействие 
Пригоден ли этот 
инструмент для 
общения и 
взаимодействия 
между участниками 
процесса обучения? 

Совместная 
разработка 
учебного 
материала 
Можете ли Вы 
совместно с Вашими 
студентами 
разработать учебный 
материал? 

Инструменты Moodle 2: Руководство для преподавателей 

Требует дополните-
льной подготовки и 
навыка создания 
страниц с помощью 
этого инструмента. 

Да. В качестве 
источника информа-
ции. Редактирование 
преподавателем или 
студентами. 

Универсальный 
инструмент. Можно 
использовать, напри-
мер, для оценки 
качества страниц. 

Частично подходит 
для общения. 
Можно добавлять 
комментарии к 
страницам. 

Да. Студенты могут 
совместно создавать 
учеб. материал, ре-
дактируя и обсуждая 
содержимое вики. 

6/6 возможно. 
Зависит от 
выбранного 
педагогического 
сценария. 

Вики/  
Элемент курса 

Создание группой 
учебных текстов 

Просто. Можно 
настроить по 
своему 
усмотрению. 

Глоссарий для 
определения 
основных понятий, 
специальных 
терминов. 

Дать возможность 
студентам самим 
разработать 
глоссарий и оценить 
его качество. 

Частично подходит. 
Можно добавлять 
комментарии к 
определениям. 

6/6 возможно. 
Зависит от 
выбранного 
педагогического 
сценария. 

Глоссарий/  
Элемент курса 
Создание словаря 
терминов (возможно 
в группе) 

Чего Вы хотите 
достичь? (педагогика) 
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Просто. Нужно 
только найти веб-
адрес (URL), 
скопировать его и 
вставить. 

Хорошая возмож-
ность привлечь вни-
мание студентов к 
учебной информа-
ции в Интернете. 

Не совсем. Но мож-
но добавить ссылку 
на инструменты для 
оценки, размещен-
ные в Интернете. 

Не совсем. Но 
можно добавить 
ссылку на внешние 
инструменты для 
коммуникации. 

Не совсем. Но можно 
добавить ссылку на 
внешние сайты  для 
создания совмест-
ных документов. 

6/6 возможно.  
В зависимости от 
того, какую ссылку 
Вы разместите. 

Гиперссылка/ 
Ресурс 

Добавление ссылки 
на веб-страницу 

Просто. 
Форматирование 
текста, добавление 
изображений и 
видео-файлов. 

Да. Инструмент для 
создания 
преподавателем 
текстовой страницы 
в Moodle.  

Нет. Лучше 
обсудить работы в 
форуме или 
собрать при 
помощи «Задания». 

Возможна совмест-
ная разработка 
учебного материала 
при условии измене-
ния локальных прав. 

2/6.  
Является лишь 
передачей информа-
ции, а не учебной 
деятельностью. 

Страница/ 
Ресурс 
Создание в Moodle 
текстовой страницы 

Нет. Этот 
инструмент не для 
взаимодействия 
или 
коммуникации. 

Просто. 
Форматирование 
текста, добавление 
изображений и 
видео-файлов. 

Да. Хорошо подхо-
дит для передачи 
информации студен-
там. Возможен 
вывод на печать. 

Нет. Этот 
инструмент не для 
взаимодействия 
или 
коммуникации. 

Возможна совмест-
ная разработка 
учебного материала 
при условии измене-
ния локальных прав. 

Книга/ Ресурс 
Создание в Moodle 
связанного ряд а 
текстовых страниц 
*дополнение* 

Также просто, как 
пересылать файлы 
по электронной 
почте. Использовать, 
если имеет смысл. 

Да. Инструмент для 
размещения 
преподавателем 
тематически связан-
ных файлов в папке.  

Нет. Лучше 
обсудить работы в 
форуме или 
собрать при 
помощи «Задания». 

Нет. Этот 
инструмент не для 
взаимодействия 
или 
коммуникации. 

Возможен сбор и 
размещение 
студенческих 
работ. 

2/6.  
Является лишь 
передачей информа-
ции, а не учебной 
деятельностью. 

Папка/ Ресурс 
Добавление 
нескольких файлов 
в одну папку 

2/6.  
Является лишь 
передачей информа-
ции, а не учебной 
деятельностью. 
. 

Просто. Можно с 
помощью одного 
из 3-х видов анкет 
собрать информа-
цию о студентах. 

Нет. Анкета не 
подходит для 
передачи 
информации 
студентам. 

Нет. Поскольку это 
лишь односторонняя 
передача данных от 
студентов к 
преподавателю. 

2/6.  
Побуждает 
студентов к анализу 
учебного процесса. 

Анкета/  
Элемент курса 
Добавление ряда 
вопросов для сбора 
данных о студентах 

Скорее нет. 
Больше подходит 
для оценки 
качества учебных 
занятий. 

Нет. Поскольку 
анкета заполняется 
каждым студентом 
индивидуально. 

Нет. Но можно сде-
лать результаты 
контроля посеща-
емости видимыми и 
для студентов. 

Не совсем. Но можно 
учитывать при оценке 
знаний, если необхо-
димо личное присут-
ствие на занятиях. 

Нет. Предназначен 
лишь для контроля 
преподавателем 
посещаемости 
студентов. 

2/6.  
В открытом доступе 
побуждает студентов 
к посещению 
занятий. 

Посещаемость/ 
Элемент курса 
Создание журнала 
посещаемости занятий 

Нет. Но преподава-
тель может назна-
чить одного из 
студентов отмечать 
посещаемость. 

Просто в 
использовании. 
Затраты по времени 
на добавление 
занятий. 

Нет. Лучше 
обсудить работы в 
форуме или 
собрать при 
помощи «Задания». 

Можно редактиро-
вать собственную 
запись. Другие сту-
денты могут добав-
лять комментарии. 

Идея: Joyce Seitzinger  
www.cats-pyjamas.net  

Дополнено: Gavin Henrick ( @ghenrick ) 
http://www.somerandomthoughts.com 

Перевод на немецкий язык с дополнениями: Ralf Hilgenstock, Susanne Gebauer, Gerald Hartwig 
Перевод на русский язык: Надежда Жукова (ТУ Кайзерслаутерн) 
(перевод на русский язык выполнен в рамках проекта DKU Almaty) 

Таксономия Блума 
На какой уровень 
рассчитан 
инструмент: 
   1. Знание 
   2. Понимание 
   3. Применение 
   4. Анализ 
   5. Синтез 
   6. Оценка 

Как использовать это руководство?  
• Вы начинаете разрабатывать курс в Moodle? Это руко-

водство поможет Вам выбрать правильный инструмент. 
• Вы уже выбрали подходящий инструмент? В соответству-

ющей строке Вы найдете его преимущества и недостатки. 
• Вы уже определились с целью обучения? Выберите 

столбец, чтобы увидеть, какие инструменты могут Вам в 
этом помочь. 

• Используйте разные инструменты для достижения цели 
 

Нужна дополнительная информация и 
помощь по работе с Moodle?  
• Сообщество Moodle  https://moodle.org/?lang=ru 
• Сообщество  www.elearningpro.ru/group/moodle  
• Документация http://docs.moodle.org/archive/ru 
• Moodle Center http://moodle-center.ru 
Блоги 
• http://dialoge.info 
• http://www.somerandomthoughts.com 

 

O Moodle в Twitter 
  @moodle   
  @catspyjamasnz 
  @ghenrick 
  @ralfh 
  @markdrechsler 
  @moodlefairy 

просто | отлично 
подходит 

частично подходит 

сложно  | не 
подходит 

Удобство в 
использовании 
Насколько легко это 
может быть Вами 
создано? 

Часть I 



Затраты по времени 
на составление 
тестовых заданий. 
Автоматическая про-
верка результатов. 

Тест направлен на 
оценку, а не на 
передачу 
информации. 

Да. Для вопросов с 
однозначным 
ответом. Автомати-
ческая проверка 
результатов. 

Нет. Для общения 
лучше 
использовать 
форум или чат. 

Нет. Для работы в 
группе лучше 
использовать 
форум или вики. 

6/6.  
При творческом 
подходе возможна 
многосторонняя 
проверка знаний. 

Тест/  
Элемент курса 
Создание вопросов 
разных типов к 
учебному материалу 

Требует четкой 
структуры и последо-
вательности подачи 
уч.материала. Стоит 
затраченных усилий. 

Отлично подходит 
для представления 
логически 
связанной между 
собой информации. 

Да. Позволяет 
контролировать уро-
вень знаний благо-
даря встроенным 
тестовым заданиям. 

Нет. 
Предназначен для 
индивидуальной 
самостоятельной 
работы студентов. 

Нет. 
Предназначен для 
индивидуальной 
самостоятельной 
работы студентов. 

6/6.  
Возможны 
различные варианты 
при творческом 
подходе. 

Лекция/  
Элемент курса 
Создание ряда 
страниц с  тестами и 
доп. материалами  

Просто. Выбор 
одного из 4-х 
видов заданий. 

Нет. Но можно доба-
вить дополнительную 
информацию, 
необходимую для 
выполнения задания. 

Да. Возможно проста-
вление преподавате-
лем оценки за каж-
дое задание и добав-
ление комментария. 

Нет. Очень ограни-
ченное взаимодей-
ствие. Исключением 
является повторная 
работа над заданием. 

Не совсем. В случае, 
если задание 
выполняется группой 
студентов и сдается 
одним из них. 

6/6. 
В зависимости от 
постановки 
задачи и вида 
обратной связи. 

Задание/ 
Элемент курса 
Инструмент для 
проверки индив. 
работ студентов 
 

Нет. Поскольку 
предназначен для 
организации 
самостоятельной 
работы студентов. 

Да. Студенты могут 
также сами 
оценивать качество 
работ своих 
однокурсников. 

Нет. Позволяет 
лишь добавлять 
комментарий. 

Нет. Для работы 
студентов в 
группе лучше 
использовать 
форум или вики. 

6/6. 
В зависимости от 
постановки 
задачи и вида 
обратной связи. 

Семинар/ 
Элемент курса 
Инструмент для 
оценки работы  
 

Необходимо спец. 
ПО для разработки 
или приобретение 
содержимого 
пакета. 

Да. Отлично 
подходит для 
передачи 
информации. 

Да. Есть возмож-
ность добавить 
инструменты для 
оценки уровня 
знаний. 

Нет. Инструмент 
предназначен для 
индивидуальной 
работы студентов. 

Нет. Инструмент 
предназначен для 
индивидуальной 
работы студентов. 

6/6.  
Возможны 
различные варианты 
при творческом 
подходе. 

Пакет SCORM/ 
Элемент курса 
Добавление курсов 
из других систем 
обучения 

6/6. 
Зависит от 
добавленного 
инструмента.  

Внешнее 
приложение 
Связь с другими 
системами обучения 
(обмен данными LTI) 

Требует ввода 
данных для доступа 
к внешнему 
приложению другого 
производителя. 

Зависит от добавлен-
ного инструмента. 
Возможны различ-
ные варианты. 

Да. Необходим 
перенос оценок 
обратно в Moodle. 

Зависит от добавлен-
ного инструмента. 
Возможны различ-
ные варианты. 

Зависит от добавлен-
ного инструмента. 
Возможны различ-
ные варианты. 

Просто. Достаточно 
заполнить название 
и описание. 
Универсальный 
инструмент.  

Да. Новостной 
форум и 
оповещение 
студентов по 
электронной почте. 

Нет. Но можно 
оценивать качество 
сообщений в форуме 
в определенный 
период времени. 

Да. Асинхронная/ 
распределенная по 
времени коммуника-
ция. Подходит и для 
общения в группах. 

Да. Студенты могут 
согласовывать в 
форуме содержимое 
при разработке 
учебного материала. 

6/6. 
При творческом под-
ходе может быть эф-
фективен и для рабо-
ты в больших группах 

Форум/  
Элемент курса 
Инструмент для 
асинхронного 
общения студентов 

Прост в добавле-
нии. Требует моде-
рации и предназна-
чен для работы в 
малых группах. 

Чат/  
Элемент курса 
Инструмент для 
общения в режиме 
реального времени 

Участникам чата 
необходимо согласо-
вать дату и время для 
работы в виртуаль-
ном пространстве. 

Записи в чате и актив-
ное участие студентов 
в дискуссии могут 
быть оценены 
преподавателем. 

Да. Позволяет 
студентам общаться 
в малых группах или 
преподавателю да-
вать консультации. 

Да. Студенты 
могут работать в 
группе и активно 
участвовать в 
дискуссии. 

6/6. 
При творческом под-
ходе может быть эф-
фективен для рабо-
ты в малых группах. 

Требует четкой 
структуры и 
тщательного 
планирования 
каждого этапа. 

Нет. Опрос предна-
значен для быстрого 
сбора информации в 
рамках 
определенной темы. 

Можно использовать 
для поверхностного 
контроля усвоения 
одного из аспектов 
учебной темы. 

Нет. Для общения 
лучше 
использовать 
форум или чат. 

Нет. Для работы в 
группе лучше 
использовать 
форум, глоссарий 
или вики. 

2/6. 
Позволяет контроли-
ровать усвоение и 
понимание теорети-
ческого материала. 

Опрос/  
Элемент курса 
Создание ряда 
вопросов с 
вариантами ответа 

Просто. 
Добавление 
вопросов и 
вариантов ответа. 

Просто. Перенос 
файлов в личное 
пространство для 
хранения файлов. 

Расширяет 
возможности 
обучения вне 
зависимости от 
места и времени 

Мобильная 
версия 
Доступ с мобильных 
устройств и загрузка 
файлов в Moodle 

Нет. Для этого 
лучше использовать 
другие 
инструменты. 

Нет. Студенты 
работают 
индивидуально с 
мультимедийным 
содержимым. 

Простой путь для ис-
пользования в учеб-
ной деятельности 
видео, аудиофайлов 
и изображений. 

Позволяет 
студентам 
общаться через 
мобильный 
телефон. 

просто | отлично 
подходит 

частично подходит 

сложно  | не 
подходит 

Идея: Joyce Seitzinger  
www.cats-pyjamas.net  

Дополнено: Gavin Henrick ( @ghenrick ) 
http://www.somerandomthoughts.com 

Перевод на немецкий язык с дополнениями: Ralf Hilgenstock, Susanne Gebauer, Gerald Hartwig 

Перевод на русский язык: Надежда Жукова (ТУ Кайзерслаутерн) 
(перевод на русский язык выполнен в рамках проекта DKU Almaty) 

Передача 
информации  
Пригоден ли этот 
инструмент для 
распространения 
информации для 
Ваших студентов? 

Оценка 
обучения  
Позволит ли этот 
инструмент Вам 
оценить работу 
Ваших студентов? 

Общение и 
взаимодействие 
Пригоден ли этот 
инструмент для 
общения и 
взаимодействия 
между участниками 
процесса обучения? 

Совместная 
разработка 
учебного 
материала 
Можете ли Вы 
совместно с Вашими 
студентами 
разработать учебный 
материал? 

Чего вы хотите 
достичь? (педагогика) 
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Таксономия Блума 
На какой уровень 
рассчитан 
инструмент: 
   1. Знание 
   2. Понимание 
   3. Применение 
   4. Анализ 
   5. Синтез 
   6. Оценка 

Удобство в 
использовании 
Насколько легко это 
может быть Вами 
создано? 

Как использовать это руководство?  
• Вы начинаете разрабатывать курс в Moodle? Это руко-

водство поможет Вам выбрать правильный инструмент. 
• Вы уже выбрали подходящий инструмент? В соответству-

ющей строке Вы найдете его преимущества и недостатки. 
• Вы уже определились с целью обучения? Выберите 

столбец, чтобы увидеть, какие инструменты могут Вам в 
этом помочь. 

• Используйте разные инструменты для достижения цели 
 

Нужна дополнительная информация и 
помощь по работе с Moodle?  
• Сообщество Moodle  https://moodle.org/?lang=ru 
• Сообщество  www.elearningpro.ru/group/moodle  
• Документация http://docs.moodle.org/archive/ru 
• Moodle Center http://moodle-center.ru 
Блоги 
• http://dialoge.info 
• http://www.somerandomthoughts.com 

 

O Moodle в Twitter 
  @moodle   
  @catspyjamasnz 
  @ghenrick 
  @ralfh 
  @markdrechsler 
  @moodlefairy 

Инструменты Moodle 2: Руководство для преподавателей 
Часть II 
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В связи с выходом новой значительно более мощной по сравнению с предыдущими версиями системы дистанционного 

интерактивного управления обучением Moodle 2.5 потребовалась информация о ней на русском языке. Поскольку официальная 

документация поддерживается англоязычным мировым сообществом на очень высоком профессиональном уровне, показалось 

естественным просто перевести документацию и снабдить перевод исходным текстом на английском языке и веб-ссылками на те 

первоисточники, которые перевести пока не удалось, ведь Moodle 2.5 появилась в начале 2013 г. и её документация всё ещё 

пополняется. 

 

 

 

 

 

 

 

 

 

 

 

 

 Перевод на русский язык  В.А. Тунда, Ф.П. Тарасенко, 2013 



ВВЕДЕНИЕ 
Официальная документация по системе дистанционного интерактивного управления обучением Moodle поддерживается англоязычным 

мировым сообществом на очень высоком профессиональном уровне: она тщательно продумана, подробна, легко доступна, содержит множество 

разнообразных примеров и, самое главное, точно отражает информацию с экранов работающей версии системы.  

Перевод всей этой документации на русский язык за короткое время после выхода новой версии 2.5 (2013 год) невозможен из-за большого 

объёма и нецелесообразности некоторых технических подробностей для широкой аудитории русскоязычных пользователей этой системы. Вероятно, 

перевод по такому огромному количеству веб-страниц нужно осуществлять по всему кругу затронутых в документации тем, с каждым разом 

переводя всё более глубокие подробности, если это будет востребовано пользователями системы. При этом нужно по возможности избежать 

несогласованности в понимании английского текста документации на Сайтах разработчиков и перевода этого текста на русский язык. Для этого 

было принято решение: исходный текст на английском и перевод на русский вести параллельно на листах альбомной ориентации с применением 

одинаковых шрифтов и кеглей. В заголовках английского и русского текста употреблять одинаковую сплошную нумерацию, для облегчения 

сопоставления исходного текста и его перевода. Такое решение позволит людям, знающим английский язык, легко разобраться с тем, что и как 

переведено, а также продолжить перевод «в глубину» с любого места. 

Теперь о Сайтах с исходной документацией и нумерации заголовков перевода. Всё начинается с общедоступного Сайта, любезно 

предоставленного международным сообществом Moodle для всех желающих познакомиться с возможностями этой замечательной системы. Там 

приведено несколько слов о системе и есть ссылка «Moodle Docs» на Главную Страницу Документации. Справа в верхнем углу на ней приведены 

пять тем, касающихся работы в Moodle. Первая из них – тема «About Moodle (о системе Moodle)». В нижеследующем переводе эта тема будет 

частью номер 1, т.е. 1.About Moodle и, соответственно, 1.О системе Moodle. Если щёлкнуть по названию этой темы, то откроется экран темы 

«About Moodle», на котором есть своё оглавление: разделы этой темы 1, 2 и т.д. И так с каждой из тем 2.Инсталляция Moodle, 3.Управление 

Сайтом Moodle, 4.Управление Курсом Moodle, 5.Управление контентом Moodle – сквозная нумерация разделов, а внутри каждого раздела своя 

сквозная нумерация подразделов и т.д. в глубину. Нужно только в адресной строке своего браузера набрать первый из приведённых выше адресов, а 

дальше – от ссылки к ссылке. Сразу станет понятно, как скомпоновано данное пособие. 

Далее, чтобы предупредить недоумение по поводу стиля написания некоторых слов и словосочетаний в переводе, делаем пояснение. 

Некоторые слова и словосочетания в исходной англоязычной документации употребляются в нескольких смыслах. Так, например, «activity» – это и 

деятельность вообще, и термин «Действие», обозначающий как Интерактивное Действие типа «Форум», так и ресурс типа «Файл». Чтобы визуально 

выделить эти отличия, принято писать с заглавной буквы устойчивые термины и словосочетания, употребляющиеся в исходной англоязычной 

документации, скажем, Действие, когда речь идёт о Ресурсе или об Интерактивном Действии. Более того, если пишется перевод термина-

словосочетания, то оба его слова пишутся с заглавной буквы, а между словами – неразрывный пробел, например, База Данных. Здесь же хочется 

отметить, что в имеющейся русскоязычной литературе по системе Moodle почему-то «activity» называют элементом, хотя «элемент» – это нечто 

статичное, тогда как «activity» обозначает деятельность, действие, процесс. Другими словами, Ресурсы называются просто «Действиями», поскольку 

Студент с ними работает самостоятельно, например, изучает содержимое Файла, а Интерактивные Действия, такие как Форум, получили своё 

название потому, что с ними Студенты и Преподаватели работают совместно в интерактивном режиме. 

И, наконец, никакой перевод документации по действующей системе невозможен без постоянного уточнения в самой системе: «А так ли это 

на самом деле работает?». Другими словами, нужна была инсталляция Moodle 2.5 и поддержка её работоспособности в течение всего времени 

перевода документации. Эту работу любезно выполнил выпускник ММФ ТГУ Андрей Михайлович Яковлев, за что переводчик выражает ему 

искреннюю благодарность. 

https://moodle.org/about/
http://docs.moodle.org/25/en/About_Moodle
https://moodle.org/about/
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1.About Moodle 
 

 

 

Moodle is a software package for producing Internet-based courses and 

web sites. It is a global development project designed to support a social 

constructionist framework of education. 

 

Moodle is provided freely as Open Source software (under the GNU 

General Public License). Basically this means Moodle is copyrighted, but 

that you have additional freedoms. You are allowed to copy, use and 

modify Moodle provided that you agree to: provide the source to others; 

not modify or remove the original license and copyrights, and apply this 

same license to any derivative work. Read the full license for details and 

please contact the copyright holder via the Moodle.com helpdesk if you 

have any questions. 

 

Moodle can be installed on any computer that can run PHP, and can 

support an SQL type database (for example MySQL). It can be run on 

Windows and Mac operating systems and many flavors of Linux. There are 

many knowledgeable Moodle Partners to assist you, even host your 

Moodle site. 

The word Moodle was originally an acronym for Modular Object-Oriented 

Dynamic Learning Environment, which is mostly useful to programmers 

and education theorists. It's also a verb that describes the process of lazily 

meandering through something, doing things as it occurs to you to do 

them, an enjoyable tinkering that often leads to insight and creativity. 

 

As such it applies both to the way Moodle was developed, and to the way a 

student or teacher might approach studying or teaching an online course. 

Anyone who uses Moodle is a Moodler. 

Come Moodle With Us! 

1.1.Philosophy 
The design and development of Moodle is guided by a "social 

constructionist pedagogy". This page attempts to unpack this concept in 

terms of four main, related concepts: constructivism, constructionism, 

social constructivism, and connected and separate. 

 

 

 

1.О Системе Moodle 
Moodle является открытой системой управления ресурсами учебных программ (Open Source Course 

Management System (CMS) – http://download.moodle.org/), известной также как система управления обучением 

(Learning Management System (LMS)) или виртуальная среда образования (Virtual Learning Environment (VLE)). 

Moodle – это пакет программного обеспечения для производства Курсов и веб-

Сайтов на основе интернет-технологий. Это проект глобального развития, 

предназначенный для компьютерной поддержки структурной основы социально-

созидательной системы образования. 

Moodle относится к свободно распространяемому программному обеспечению (по 

Стандартной общественной лицензии GNU, созданной в рамках проекта по свободному 

распространению программного обеспечения). В основном это означает, что Moodle 

охраняется авторскими правами, но вы имеете дополнительные права. Вам разрешается 

копировать, использовать и модифицировать Moodle при условии, что вы согласны: 

предоставлять ваши дополнения другим, не модифицировать и не удалять 

оригинальную лицензию и авторские права, а также применять эту же лицензию к 

любым вторичным работам. Ознакомьтесь с полной лицензией и, пожалуйста, 

свяжитесь с Держателем авторских прав, если у вас есть какие-либо вопросы. 

Moodle может быть инсталлирована на любом компьютере, который может 

запустить PHP и может поддерживать базы данных типа SQL (например, MySQL). Она 

может быть запущена под операционными системами Windows и Mac и многих 

разновидностях Linux. Имеется много хорошо осведомлённых партнёров Moodle, готовых 

вам помочь и даже установить Moodle на ваш Сайт. 

Слово Moodle первоначально было аббревиатурой от Modular Object-Oriented 

Dynamic Learning Environment (модульная объектно-ориентированная динамическая среда 

обучения), которая использовалась программистами и теоретиками образования. Это 

слово также является англоязычным глаголом, который описывает процесс, постепенно 

развивающийся в том, что вы делаете на свой манер; приятную возню, во время которой 

часто возникают понимание и творчество.  

По существу это применимо как к способу развития Moodle, так и к тому, как 

студенты и преподаватели подходят к изучению или обучению в Курсе в режиме онлайн. 

Любой, кто использует Moodle, является её частью и её творцом. 

Идите в Moodle с нами! 

1.1.Философия 
Дизайн и развитие Moodle руководствуются «социально-конструктивистской 

педагогикой». Данный раздел пытается раскрыть эту концепцию в терминах четырёх 

главных, связанных концепций: конструктивизм, конструкционизм, социальный 

конструктивизм, а также связанный и разрозненный. 

http://download.moodle.org/
http://docs.moodle.org/25/en/Philosophy
http://docs.moodle.org/25/en/Philosophy
http://opensource.org/docs/osd
http://www.gnu.org/copyleft/gpl.html
http://www.gnu.org/copyleft/gpl.html
http://docs.moodle.org/dev/License
http://moodle.com/helpdesk
http://docs.moodle.org/25/en/Installing_Moodle
http://moodle.com/partners/
http://moodle.com/hosting/
http://moodle.com/hosting/
http://docs.moodle.org/25/en/Moodle
http://moodle.com/helpdesk
http://docs.moodle.org/24/en/Installing_Moodle
http://moodle.com/partners/
http://moodle.org/community/


 

7 

1.1.1.Constructivism 
From a constructivist point of view, people actively construct new 

knowledge as they interact with their environments. 

Everything you read, see, hear, feel, and touch is tested against your prior 

knowledge and if it is viable within your mental world, may form new 

knowledge you carry with you. Knowledge is strengthened if you can use 

it successfully in your wider environment. You are not just a memory bank 

passively absorbing information, nor can knowledge be "transmitted" to 

you just by reading something or listening to someone. 

This is not to say you can't learn anything from reading a web page or 

watching a lecture, obviously you can, it's just pointing out that there is 

more interpretation going on than a transfer of information from one brain 

to another. 

1.1.2.Constructionism 
Constructionism asserts that learning is particularly effective when 

constructing something for others to experience. This can be anything from 

a spoken sentence or an internet posting, to more complex artifacts like a 

painting, a house or a software package. 

 

For example, you might read this page several times and still forget it by 

tomorrow - but if you were to try and explain these ideas to someone else 

in your own words, or produce a slideshow that explained these concepts, 

then it's very likely you'd have a better understanding that is more 

integrated into your own ideas. This is why people take notes during 

lectures (even if they never read the notes again). 

1.1.3.Social constructivism 
Social constructivism extends constructivism into social settings, wherein 

groups construct knowledge for one another, collaboratively creating a 

small culture of shared artifacts with shared meanings. When one is 

immersed within a culture like this, one is learning all the time about how 

to be a part of that culture, on many levels. 

A very simple example is an object like a cup. The object can be used for 

many things, but its shape does suggest some "knowledge" about carrying 

liquids. A more complex example is an online course - not only do the 

"shapes" of the software tools indicate certain things about the way online 

courses should work, but the activities and texts produced within the group 

as a whole will help shape how each person behaves within that group. 

 

 

1.1.1.Конструктивизм 
С конструктивистской точки зрения, люди активно создают новое знание в 

процессе взаимодействия с окружающей средой. 

Всё, что вы читаете, видите, слышите и осязаете, воспринимается на основе 

предыдущих знаний, и только если это приемлемо вашему ментальному миру, оно может 

сформировать ваше новое знание. Знание подтверждается, если вы его успешно 

используете в окружающей вас среде. Вы не просто банк памяти, пассивно впитывающий 

информацию, да и знание не «передаётся» вам просто чтением чего-то или слушаньем 

кого-то. 

Это не значит, что вы не можете узнать что-то путём чтения веб-страницы или из 

услышанного на лекции; очевидно, вы можете. Это лишь указание на то, что при этом 

происходит больше интерпретация, истолкования, нежели простая передача информации 

от одного мозга к другому. 

1.1.2.Конструкционизм 
Конструкционизм утверждает, что обучение особенно эффективно, когда это познаётся на 

опыте создания чего-то для использования другими. Это может быть чем угодно – от 

произнесения высказывания, создания интернет корреспонденций, до создания более 

сложных искусственных объектов типа написания картины, постройки жилища или 

разработки пакета программ. 

Например, вы можете прочитать эту страницу несколько раз и всё же забыть её 

завтра, – но если вы постараетесь объяснить эти идеи кому-нибудь, да ещё и своими 

словами или изготовите слайд-шоу, объясняющее эти концепции, то весьма вероятно, что 

вы лучше поймёте, насколько это согласуется с вашими собственными идеями. Вот 

почему люди делают заметки на лекциях (даже если после этого никогда их не читают). 

 

1.1.3.Социальный конструктивизм 
Социальный конструктивизм расширяет конструктивизм на социальные ситуации, 

когда группы конструируют знание друг для друга, совместными усилиями создавая 

малую культуру из совместно используемых искусственных объектов, имеющих общие 

для всех смыслы. Когда кто-то погружен в культуру подобную этой, он беспрерывно 

учится тому, как быть частью такой культуры на многих уровнях. 

Очень простым примером является объект типа чашки. Этот объект может быть 

использован для многих целей, но сама его форма несёт некоторое «знание» о его 

назначении: содержать жидкость. Более сложным примером является онлайн-Курс: – не 

только «формы» программных инструментов указывают на то, как работают онлайн-

Курсы, но и конкретные Интерактивные Действия и тексты, изготовленные внутри 

Группы как целого, помогут формированию поведения каждого члена этой группы. 
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1.1.4.Connected and separate 
This idea looks deeper into the motivations of individuals within a 

discussion: 

 Separate behaviour is when someone tries to remain 'objective' and 

'factual', and tends to defend their own ideas using logic to find holes in 

their opponent's ideas. 

 Connected behaviour is a more empathic approach that accepts 

subjectivity, trying to listen and ask questions in an effort to understand 

the other point of view. 

 Constructed behaviour is when a person is sensitive to both of these 

approaches and is able to choose either of them as appropriate to the 

current situation. 

In general, a healthy amount of connected behaviour within a learning 

community is a very powerful stimulant for learning, not only bringing 

people closer together but promoting deeper reflection and re-examination 

of their existing beliefs. 

1.1.5.Conclusion 
Consideration of these issues can help to focus on the experiences that 

would be best for learning from the learner's point of view, rather than just 

publishing and assessing the information you think they need to know. It 

can also help you realise how each participant in a course can be a teacher 

as well as a learner. Your job as a 'teacher' can change from being 'the 

source of knowledge' to being an influencer and role model of class 

culture, connecting with students in a personal way that addresses their 

own learning needs, and moderating discussions and activities in a way 

that collectively leads students towards the learning goals of the class. 

Moodle doesn't FORCE this style of behaviour, but this is what the 

designers believe that it is best at supporting. In future, as the technical 

infrastructure of Moodle stabilises, further improvements in pedagogical 

support will be a major direction for Moodle development. 

1.1.6.See also 
 Background 

 

 

 

 

 

 

 

1.1.4.Связанное и раздельное 
Эта идея рассматривает глубже мотивацию индивидов в процессе обсуждения. 

 

 Раздельное поведение – это когда кто-то старается оставаться «объективным» и 

«придерживающимся фактов» и стремится защитить свои собственные идеи, используя 

логику, чтобы найти прорехи в идеях его оппонентов. 

 Связанное поведение – более эмпатический (сочувствующий) подход, который 

признаёт субъективность каждого, старается выслушать и задать вопросы, пытаясь 

понять точку зрения другого. 

 Конструктивное поведение – это когда человек воспринимает оба эти подхода и 

способен выбрать тот из них, который достаточен в текущей ситуации, или при 

необходимости употребить их в совокупности. 

В общем, здравая пропорция связанного поведения внутри обучающегося 

сообщества является очень мощным стимулом для обучения, не только сближающим 

людей, но и способствующим более глубокому рассмотрению и переоценке их 

собственных убеждений. 

1.1.5.Заключение 
Учёт этих фактов может помочь переключиться на практику преподавания, 

которая была бы лучше для обучения учащихся, чем обычная практика сообщения и 

оценивания информации, которую, по вашему мнению, им нужно знать. Это также может 

помочь вам осознать и осуществить педагогическую идею, что каждый участник Курса 

может быть и преподавателем, и учащимся. Ваша работа как «преподавателя» может 

измениться от «источника знаний» к роли влиятельного образцового носителя культуры 

класса, лично связанного со студентами, учитывающего их персональные собственные 

потребности в обучении, и роли модератора дискуссий и Интерактивных Действий, 

ведущего коллектив студентов к целям обучения класса. 

Moodle не НАВЯЗЫВАЕТ этот стиль поведения, но она, по мнению его 

разработчиков, является лучшей поддержкой такого стиля. В будущем, по мере 

становления технической инфраструктуры Moodle, главным направлением развития 

Moodle будет улучшение педагогической поддержки учебного процесса. 

1.1.6.См. также 
 Фон. 

http://docs.moodle.org/25/en/Background
http://docs.moodle.org/25/en/Background
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1.2.Pedagogy 
Let's sit back and really reflect on the pedagogy that is at the core of what 

we, as online educators, are trying to do. 

1.2.1.Definition of Pedagogy 
One definition of pedagogy in Wiktionary says 

1. The profession of teaching 

2. The activities of educating, teaching or instructing 

Wikipedia has a much longer page on Pedagogy. At one point it said 

Pedagogy is the art or science of being a teacher, generally refers to 

strategies of instruction, or a style of instruction. The word comes from the 

Ancient Greek παιδαγωγέω (paidagōgeō; from παῖς (child) and ἄγω 

(lead)): literally, "to lead the child”. 

1.2.2.Moodle in three short paragraphs 
The heart of Moodle is courses that contain activities and resources. There 

are about 20 different types of activities available (forums, glossaries, 

wikis, assignments, quizzes, choices (polls), scorm players, databases etc) 

and each can be customised quite a lot. The main power of this activity-

based model comes in combining the activities into sequences and groups, 

which can help you guide participants through learning paths. Thus, each 

activity can build on the outcomes of previous ones. 

 

There are a number of other tools that make it easier to build communities 

of learners, including blogs, messaging, participant lists etc, as well as 

useful tools like grading, reports, integration with other systems and so on. 

 

For more about Moodle, see http://moodle.org, and particularly the main 

community “course” called Using Moodle. It's crowded and busy these 

days, but jump in and you'll soon find interesting stuff I'm sure. The 

developers and the users are deliberately forced to mix in the same forums. 

The other great place to start is our online documentation which is a 

community-developed wiki site. 

1.2.3.Social Constructionism as a Referent 
 
I have these five points on a slide which I use in every presentation I do. 

They are useful referents taken from research that apply to education in 

general, boiled down into a simple list that I carry around under the 

moniker of "social constructionism". 

 

1.2.Педагогика 
Давайте основательно поразмышляем о педагогике, которая лежит в основе всего 

того, что мы, как онлайн-педагоги, стараемся делать. 

1.2.1.Определение педагогики 
Одно определение педагогики в Викисловаре (Wiktionary) говорит: 

1. Профессия обучения. 

2. Действия по образованию, преподаванию или инструктированию. 

В Википедии страниц по педагогике очень много. В одном месте там говорится о 

педагогике как искусстве или науке быть учителем, в общем, говорится о стратегиях 

преподавания и о стилях преподавания. Это слово происходит от древнегреческого 

παιδαγωγέω (paidagōgeō; от παῖς (дитя) и ἄγω (вести)): дословно «вести дитя». 

 

1.2.2.Moodle в трёх коротких параграфах 
Сердце Moodle – это Курсы, которые содержат Интерактивные Действия и 

Ресурсы. Существует более 20 типов возможных Действий (Форумы, Глоссарии, Вики, 

Задания, Экзамены, Варианты ответов (выборы), плееры SCORM, Базы Данных и т.д.), и 

каждое может использоваться пользователем многократно. Основная мощь этой 

основанной на Интерактивных Действиях модели обучения связана с комбинированием 

Интерактивных Действий в последовательности и группы, которые могут помочь вам 

вести участников по путям обучения. Таким образом, каждое Интерактивное Действие 

может основываться на результатах предыдущих Интерактивных Действий. 

Существует ряд других инструментов, облегчающих сбор обучающихся общин, в 

том числе Блоги, Обмен сообщениями, Перечни участников и т.д., а также другие 

полезные средства, подобные Оцениванию, Отчётам, Интеграции с другими системами и 

т.д. 

Дальнейшая информация о MOODLE приведена в документации на 

http://moodle.org и, в частности, в главном «курсе» сообщества, называемом 

«Использование Moodle». Ныне тут людно и оживлённо, но посетите этот Курс, и я 

уверяю, вы быстро обнаружите интересные материалы. Другим прекрасным местом для 

начала служит наша онлайн-документация, которая является развиваемым сообществом 

вики-Сайтом. 

1.2.3.Социальный конструкционизм как опорная 
концепция 

Эти пять пунктов у меня на слайде, который я использую в каждой презентации, 

которую я делаю. Это полезные понятия, взятые из научных исследований педагогики 

вообще, сконденсированные в простой список, который я подаю под кличкой 

«социальный конструктивизм». 

http://en.wiktionary.org/wiki/Pedagogy
http://en.wikipedia.org/wiki/Pedagogy
http://moodle.org/
http://moodle.org/course/view.php?id=5
http://docs.moodle.org/
http://moodle.org/
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1. All of us are potential teachers as well as learners - in a true 

collaborative environment we are both. 

It's so important to recognise and remember this. 

I think this perspective helps us retain some humility as teachers and 

fight the (very natural!) tendency to consolidate all your history and 

assume the revered position of “wise source of knowledge”. 

It helps us keep our eyes open for opportunities to allow the other 

participants in our learning situation to share their ideas with us and to 

remind us to listen carefully and ask good questions that elicit more 

from others. 

I find I need to constantly remind myself of this point, especially when 

the culture of a situation pushes me into a central role (like now!) 

 

2. We learn particularly well from the act of creating or expressing 

something for others to see. 

For most of us this is basically “learning by doing”, and is fairly 

obvious, yet it's worth reminding ourselves of it. 

It's surprising how much online learning is still just presenting static 

information, giving students little opportunity to practice the activities 

they are learning about. I often see online teachers spending a great deal 

of time constructing perfect resources for their course, which no doubt 

is a terrific learning experience for them, but then they deny their 

students that same learning experience. Even textbooks often do a better 

job, with exercises after every chapter and so on. 

Most importantly, such learning is best when you are expressing and 

presenting posts, projects, assignments, constructions etc for others to 

see. In this situation your personal “stakes” are a lot higher, and a lot of 

self-checking and reflection takes place that increases learning. 

Seymour Papert (the inventor of logo) famously described the process 

of constructing something for others to see as a very powerful learning 

experience, and really this sort of thinking goes right back to Socrates 

and beyond. 

3. We learn a lot by just observing the activity of our peers. 

Basically this is about “classroom culture”, or learning by osmosis. 

Humans are good at watching each other and learning what to do in a 

given situation through cues from others. 

For example, if you walk into a lecture theatre where everyone is sitting 

in seats, facing the front, listening quietly to the teacher at the front and 

taking notes, then that's most likely what you are going to do too, right? 

 

1. Каждый из нас – потенциальный преподаватель и ученик: мы оба действительно 

находимся в среде сотрудничества. 

Очень важно осознать и помнить это. 

Я думаю, эта точка зрения поможет нам соблюсти должную скромность 

преподавателей и перебороть (вполне естественную!) тенденцию, чтобы опереться на  

всю вашу историю и занять почтенную позу «мудрого источника знаний». 

Это поможет держать глаза открытыми на возможности позволить другим участникам 

нашей учебной ситуации поделиться с нами их идеями, и подвигнуть нас тщательно 

выслушивать и задавать хорошие вопросы, чтобы извлечь больше из других. 

 

Я обнаружил, что мне необходимо постоянно напоминать себе об этой точке зрения, 

особенно когда культура ситуации подталкивает меня к центральной роли (как 

сейчас!). 

2. Мы учимся особенно хорошо, что-то создавая или объясняя что-нибудь другим. 

 

Для большинства из нас это, по существу, «изучение на практике» и довольно 

очевидно, но всё же стоит напоминать себе об этом. 

Удивительно, но до сих пор онлайн-обучение – это лишь представление статичной 

информации, дающее студентам мало возможностей практически осуществить 

действия, которым они обучаются. Я часто сталкиваюсь с онлайн-преподавателями, 

затрачивающими много времени на создание совершенных Ресурсов для своего Курса, 

что, несомненно, является прекрасным опытом его изучения для них, но затем они 

отвергают получение такого опыта своими студентами. Даже учебники зачастую 

делают работу лучше своими упражнениями после каждой главы и т.д. 

Особенно важно, что обучение происходит лучше, когда вы объясняете и презентуете 

корреспонденции, проекты, задания, истолкования и т.д. для понимания другими. В 

такой ситуации ваши персональные «претензии» много выше, намного самокритичнее 

и обдуманнее, что усиливает изучение. Сеймур Пейперт (изобретатель Лого) 

превосходно описал процесс конструирования чего-то для других как очень мощный 

опыт обучения, и в самом деле, этот способ мышления восходит ещё к Сократу и даже 

ранее. 

 

3. Мы много познаём, просто наблюдая за действиями других. 

Главным образом, это о «культуре классной комнаты» или обучение осмосом 

(впитыванием). Люди способны наблюдать за другими и постигать, что следует делать 

в данной ситуации, по внешним сигналам от других. 

Например, если вы окажетесь в лекционной аудитории, где каждый сидит на своём 

месте, лицом вперёд, спокойно слушает преподавателя и делает записи, то весьма 

вероятно, что вы будете делать то же самое, не правда ли? 
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If you are in a less rigid class where people are asking If you are in a 

less rigid class where people are asking questions all the time, then it's 

likely you'll feel freer to do so too. By doing so you'll be learning about 

both the subject itself and the meta-subject of how learning occurs from 

overhearing the discussions of your peers and the kinds of questions 

that get asked, leading to a richer multi-dimensional immersion in 

learning. 

4. By understanding the contexts of others, we can teach in a more 

transformational way (constructivism) 

As you probably know from experience, advice from a mentor or friend 

can provide better, more timely and customised learning experience 

than with someone who doesn't know you and is speaking to a hundred 

people. 

If we understand the background of the people we are speaking to then 

we can customise our language and our expression of concepts in ways 

that are best suited to the audience. You can choose metaphors that you 

know the audience will relate to. You can use jargon where it helps or 

avoid jargon when it gets in the way. 

Again this is a pretty basic idea - every guide to public speaking talks 

about knowing your audience - but in online learning we need to be 

particular mindful of this because we often have not met these people in 

person and don't have access to many visual and auditory cues. 

 

5. A learning environment needs to be flexible and adaptable, so that 

it can quickly respond to the needs of the participants within it. 

Combining all the above, if you as a learning facilitator want to window 

because your participants know a lot less than you'd expected when you 

first designed the course, you should be able to readjust the schedule, 

and easily add new activities to help everyone (or just one group) catch 

up. Likewise, some great ideas for a simulation or something may have 

come up during discussions, so you should be able to add those later in 

the course. 

 

 

 

Timewise, your participants may be spread over different timezones, or 

maybe they live in the same timezone but have differing free time, so you 

should be able to offer asynchronous activities where people can work 

together but at different times. 

 

Однако, если вы в менее строгом классе, где люди постоянно задают вопросы, тогда, 

вероятно, вы будете делать так же. Делая так, вы будете обучаться как самому 

учебному предмету, так и мета предмету того, как происходит обучение из 

прослушивания дискуссий ваших сверстников и типов вопросов, которые задавались, 

ведущего к более богатому многомерному погружению в обучение. 

 

 

4. При понимании контекстов других, мы можем передавать знания более 

эффективно (конструктивизм). 

Как вы, возможно, знаете из своего опыта, совет от наставника или друга может 

обеспечить лучший, более быстрый и полезный результат обучения, чем при 

выслушивании кого-то, кто вас не знает, и произносит речь перед сотней людей. 

 

Если мы понимаем уровень подготовки людей, с которыми беседуем, то можем 

подстроить наш язык и наше объяснение концепций так, чтобы аудитория лучше 

воспринимала это. Вы можете выбрать метафоры, которые, вы знаете, будут понятны 

аудитории. Вы можете использовать жаргон там, где он поможет, или избежать 

жаргонных словечек, когда это помешает. 

И опять-таки это вполне базисная идея – каждое руководство по публичному 

выступлению говорит о знании вашей аудитории – но применительно к онлайн-

обучению это особенно необходимо помнить, поскольку мы зачастую не встречаемся 

персонально с этими людьми и не имеем доступа ко многим визуальным и речевым 

сигналам от них. 

5. Среда обучения должна быть гибкой и адаптивной, чтобы она могла быстро 

откликаться на потребности участников обучения 

Всё сказанное выше означает, что если вы как куратор обучения хотите получить 

преимущества от ваших растущих познаний об участниках, давая им подстроенные к 

ним возможности разделять идеи, задавать вопросы и выражать их знания, то вам 

необходима гибкая во времени и пространстве окружающая среда. Если вы 

обнаружили, что ваши планы стоит выбросить, потому что ваши участники знают 

много меньше, чем вы ожидали, когда конструировали Курс, вы должны быть 

способны легко изменить план и добавить новые Действия, чтобы помочь каждому 

(или целой группе) справиться с ним. Кроме того, во время дискуссий могут появиться 

блестящие идеи по моделированию или чему-то ещё, и вы должны быть способны 

добавить их в Курс. 

Это относится и ко времени: ваши участники могут находиться в разных часовых 

поясах или могут жить в том же самом часовом поясе, но иметь различное свободное 

время, так что вы должны быть способны предложить асинхронную деятельность, когда 

люди работают совместно, но в разное время. 
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Jason Cole from Open University recently referred to these as “Martin's 

five laws” (ha!) but really they are referents: guiding concepts that I 

personally find useful to refer to whenever I need to make a decision in any 

given educational situation. In particular I find them useful for 

building communities of learners. 

I guess you probably find a lot of this familiar, even if you use different 

terms. If not there is a lot of research about constructionism, 

constructivism and social Constructionism which you can find out more 

about in some of my more formal papers. 

1.2.4.How Moodle tries to support a Social 
Constructionist view 
I'm going to go through the earlier list again, this time pointing out existing 

features in Moodle. Pedagogy and software design are closely intertwined 

in online learning - the "shape" of the software can help or hinder the 

teacher in what they are trying to do. 

1. All of us are potential teachers as well as learners - in a true 

collaborative environment we are both 

Many of the activities in Moodle are designed to allow students to 

control common content, such as forums, wikis, glossaries, databases, 

messaging and so on. This encourages students to add to the total 

course experience for others. 

We made a huge step with a Roles implementation which further breaks 

down the distinction of teachers and students, allowing Moodle system 

administrators and teachers to create new roles with any mix of 

capabilities they like. If you want students to be allowed to facilitate 

forums, create quiz questions or even control the course layout then you 

can. There is a very fine degree of control – for example you can allow 

students the ability to delete posts in just one single forum if you like. 

 

I hope that people will take these features and experiment with control 

in their courses, allowing students more flexibility to do things that 

were previously thought of as something teachers should do. 

2. We learn particularly well from the act of creating or expressing 

something for others to see 

Moodle has a wide range of ways in which people can create 

representations of their knowledge and share them. 

 The course structure itself is terrific way to construct a shared and 

active representation of the learning journey that everyone is going 

through. 

Джейсон Кул из Открытого университета недавно назвал это как «Пять законов 

Мартина» (ха!), но в действительности они являются опорными понятиями: 

руководящими концепциями, которые я персонально нашёл полезными, когда мне 

необходимо принять решение в какой-нибудь образовательной ситуации. В частности, я 

нашёл их полезными для создания сообществ обучающихся. 

Я почти не сомневаюсь, что вы найдёте множество знакомых с этим, даже если вы 

используете другую терминологию. Если нет, то существует множество исследований по 

конструкционизму, конструктивизму и социальному конструкционизму, о которых вы 

можете найти больше в некоторых из моих статей (my more formal papers). 

1.2.4.Как Moodle старается поддерживать концепции 
социального конструкциониста 

Я собираюсь пройтись по предыдущему списку снова, на этот раз указывая на 

соответствующие средства в Moodle. Педагогика и конструкция программного 

обеспечения тесно переплетены в онлайн обучении – сама «форма» программного 

обеспечения может помочь или помешать преподавателю в том, что он старается сделать. 

1. Каждый из нас – потенциальный преподаватель и ученик: мы оба действительно 

находимся в среде сотрудничества 

Многие из Интерактивных Действий в Moodle сконструированы так, чтобы 

предоставить студентам возможность управлять общим содержимым, таким как 

Форумы, Вики, Глоссарии, Базы Данных, Обмен Сообщениями и т.д. Это поощряет 

студентов добавлять к общему Курсу свой опыт для использования его другими. 

Мы сделали гигантский шаг с реализацией Ролей, который скоро сотрёт различие 

между преподавателями и студентами, позволяя Администраторам системы Moodle и 

преподавателям создавать новые Роли с любой смесью Возможностей, которые им 

подходят. Если вы захотите, чтобы студенты развивали Форумы, создавали Вопросы 

для Экзаменов или даже управляли компоновкой Курса, то Moodle даёт вам такую 

возможность. У вас есть очень тонкий уровень контроля – например, вы можете (если 

захотите) позволить студентам удалять корреспонденцию только в каком-то одном 

Форуме. 

Я надеюсь, что эти средства для пробного управления Курсом будут восприняты, и 

студентам будет позволено делать вещи, которые, как считалось ранее, должны 

выполнять преподаватели. 

2. Мы учимся особенно хорошо, что-то создавая или объясняя что-нибудь другим 

 

Moodle имеет широкий диапазон способов, которыми люди могут создавать свои 

варианты форм представления своих знаний другим. 

 Структура Курса сама по себе есть потрясающий способ создания понятного и 

действенного представления об обучающем путешествии, которое каждый намерен 

совершить. 

http://dougiamas.com/writing/
http://dougiamas.com/writing/
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 Forums of course are the core of this, providing spaces for discussion 

and sharing of media and documents (using the media plugin filters, 

attachments or simply links). 

 Wikis are collaboratively-built pages useful for group work and other 

negotiations. 

 Glossaries are collaboratively-built lists of definitions that can then 

appear throughout the course. 

 Databases are an extension of this idea allowing participants to enter 

structured media of any type (for example a collection of digital photos 

or a library of references). 

3. We learn a lot by just observing the activity of our peers 

The participants link in the navigation block is the main place where 

you can see everyone in your course. It shows a lot of information about 

your participants and how recently they've been there. 

An Online Users block is the best way to see everyone else who might 

be on right now. 

The Recent Activity block shows a great deal of information about what 

has happened recently, and via link you can see reports with more 

detail. Things that happened not only include changes to the course and 

forum posts, etc, but also things like assignment submissions and quiz 

attempts. Students can't see the results that other students got from these  

activities, but they do get some sense that everyone is submitting 

Assignment I now and this peer pressure hopefully helps those who 

need it. 

Finally, almost all the modules will "tag" an entry or change with the 

name of the user, so that you can see who did what and when. For 

example, wiki pages all have a history link with full details on every 

edit. 

4. By understanding the contexts of others, we can teach in a more 

transformational way (constructivism) 

There are many different ways to find out about people. Access to these 

can be decided on a site basis (different sites have different privacy 

policies): 

 The user profile contains several fields where people can provide 

information about their background, etc. In particular there is a user 

profile photograph, which appears throughout Moodle whenever that 

person writes something. The photo links back to the profile page. 

 

 A compendium of forum posts (and discussion starters) by that person 

in that course (or across the site). 

 Форумы Курса являются основой этого, предоставляя пространство для обсуждений и 

совместного использования медиа и документов (с помощью Плагинов, Фильтров, 

Присоединений или просто Ссылок). 

 Вики являются совместно строящимися страницами, полезными для групповой работы 

и других переговоров. 

 Глоссарии являются совместно строящимися списками определений терминов, которые 

затем могут появляться на протяжении всего Курса. 

 Базы Данных являются расширением этой идеи, позволяя участникам входить в 

структурированные медиа любых типов (например, коллекции цифровых фото или 

библиотеку рекомендуемых публикаций). 

3. Мы многое познаём, просто наблюдая за действиями других 

Ссылка на участников в Блоке Навигации является главным местом, где вы можете 

увидеть каждого на вашем Курсе. Здесь приведено много информации о ваших 

участниках и о том, как давно они здесь. 

Блок Онлайн Пользователей – лучший способ увидеть каждого, кто только что 

включился. 

Блок Недавней Деятельности показывает достаточно много информации о том, что 

произошло в последнее время, и через ссылки вы можете просмотреть Отчёты более 

подробно. То, что происходит, включает не только изменения в Курсе и 

корреспонденции на Форуме и т.д., но также и поданные на рассмотрение 

преподавателям ответы студентов на Задания, и все их попытки сдачи Экзамена. 

Студенты не смогут увидеть сами результаты деятельности других студентов, но они 

могут узнать о том, что остальные тоже готовят ответы по Заданию 1, и сам этот факт 

может стать моральной поддержкой тем, кто в этом нуждается. 

Наконец, почти все модули «зафиксируют» ("tag") имя пользователя, внесшего 

новую запись или изменение, так что вы сможете увидеть, кто, что и когда делал. 

Например, все страницы Вики имеют ссылку на историю с подробной информацией о 

каждом редактировании. 

4. При понимании контекстов, обстоятельств у других, мы можем передавать знания 

более эффективно (конструктивизм). 

Существует много разных способов разузнать больше о людях. Доступ к такой 

информации может быть разрешён на базе Сайта (разные Сайты придерживаются разных 

подходов к приватности информации): 

 Профиль Пользователя содержит несколько полей, где люди могут оставить 

информацию о своём образовании, опыте работы, биографических данных и т.д. В 

частности, в Moodle имеется пользовательская фотография в Профиле, которая 

появляется на протяжении всего Курса, как только пользователь что-то записывает. 

Ссылки на фото возвращают на страницу Профиля. 

 Сборник корреспонденций Форумов (и инициатив обсуждений) по данной персоне в 

данном Курсе (или по всему Сайту). 
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 Individual blogs allow people to express things in a public but reflective 

way, often providing access to thinking that might not normally 

expressed in, say, a forum. Others can give comments on the blog posts. 

 Overall activity reports show all the contributions from a user in a 

course, including assignment submissions, glossary entries, etc. 

 

 User log reports show detailed logs of every action taken by a person in 

Moodle, as well as graphs showing overall activity statistics. 

 

 The survey module provides a variety of proven questionnaire 

instruments for discovering interesting information about the state of 

mind of the group. 

5. A learning environment needs to be flexible and adaptable, so that 

it can quickly respond to the needs of the participants within it 

 The course page itself is the main tool for a teacher, allowing them to 

add/remove and structure activities as necessary. Changing the course is 

one button click away at any time, so the teacher can change it on a 

whim. We have AJAX features, so that activities, sections and blocks 

can all be simply dragged-and-dropped. Access can be restricted 

according to time, conditions or user profile fields. 

 

 Roles can be applied individually in every context across the site, and 

can be further tweaked with overrides. So if you want to create one 

single quiz where everyone has access to everybody's results, or allow 

parents of students to see parts of your course, then you can. 

 Navigation around the course and site is automatically generated. 

 The gradebook is automatically maintained, and reflects the activities in 

the course at any given time. 

 There are preferences for many aspects of appearance and behaviour, at 

site, course and activity levels, allowing educators to fine-tune the 

behaviour of Moodle in many ways. 

 External systems can be integrated easily, to maintain authentication, 

enrolments and other things, allowing Moodle to react smoothly as data 

in other systems is modified.  

1.2.5.Finding a balance 
Before I talk about where we are going, let me talk a little about the 

balance that a Course Management System (aka VLE) like Moodle needs 

to achieve. One thing I found out quickly in a community like ours is that 

people have a wide range of expectations of online learning. 

 Индивидуальные Блоги позволяют каждому выражать своё мнение публично, но 

рефлекторно, часто приводя к мыслям, которые не могут быть высказаны, скажем, на 

Форуме. Другие могут комментировать корреспонденцию этого Блога. 

 Итоговые Отчёты по Интерактивным Действиям (Overall activity reports) показывают 

всё внесённое пользователем в Курс, включая готовые ответы на Задания, записи 

Глоссариев и т.д. 

 Отчёты по Зарегистрированным Пользователям (User log reports) показывают 

подробно каждое действие, предпринятое персоной в Moodle, а также графики со 

статистикой результатов деятельности. 

 Модуль Анкета (The survey module) предоставляет разнообразие проверенных 

инструментов для получения интересной информации об образе мышления группы. 

 

5. Среда обучения должна быть гибкой и адаптивной, чтобы она могла быстро 

откликаться на потребности участников обучения 

 Страница Курса сама по себе является главным инструментом преподавателя, 

позволяющим добавлять, перемещать и структурировать Интерактивные Действия как 

необходимо. Изменение Курса производится просто щелчком кнопки в любое время, 

так что преподаватель может изменять его по своей прихоти. Мы имеем средства 

AJAX, позволяющие перетаскивать или оставлять в нужном месте 

Интерактивные Действия, Разделы и Блоки. Доступ может быть ограничен в 

соответствии со временем, условиями или полями Профиля Пользователя. 

 Роли могут применяться индивидуально в каждом Контексте по всему Сайту и могут 

быть в дальнейшем скорректированы. Так что если вы хотите создать единый Экзамен, 

где каждый имеет доступ к результатам каждого, или разрешить родителям студентов 

видеть части вашего Курса, вы это можете сделать. 

 Навигация по Курсу и Сайту генерируется автоматически. 

 Журнал Оценок поддерживается автоматически и отражает деятельность в Курсе в 

любое заданное время. 

 Существуют предпочтения по многим аспектам внешнего вида и поведению на уровне 

Сайта, Курса и Интерактивных Действий, позволяющие педагогам проводить тонкую 

настройку поведения Moodle многими способами. 

 Могут легко интегрироваться внешние системы, предназначенные для ведения 

аутентификации, зачисления на Курсы, и др., позволяя Moodle чётко реагировать на 

модификацию данных в других системах. 

1.2.5.Нахождение баланса 
Прежде чем я расскажу, куда мы идём, позвольте мне немного поговорить о 

балансе, которого система управления Курсом (также известная как VLE), должна достичь 

подобно Moodle. Я очень быстро обнаружил, что в сообществе, подобном нашему, разные 

люди возлагают на онлайн-обучение весьма широкий спектр надежд. 
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At the authoritarian extreme there are those who want students to be highly 

controlled: reading resources that are revealed at set times and later sitting 

quizzes to prove they read those resources. I call this the rat-in-the-maze 

approach, or dump-and-pump. 

At the techno-hippy end of that spectrum there are those who want to 

devolve management completely, with every user running their own 

portfolio site, streaming blogs and files to each other using RSS and 

trackbacks. It's an interesting dream that really opens up thinking about 

education but I think the problems to be solved are many (such as security, 

accountability, the structure of institutions etc). 

 

The vast majority of people that I meet fall somewhere between these two 

extremes. Many of them are new to online learning, and are looking for the 

next step beyond what they were being paid to do offline, while being 

accepting of gentle guidance to improving their online techniques. These 

people are on a steep learning curve already without facing the aggregation 

of 100 different blogs. 

1.2.6.Progression 
Moodle needs to be flexible to cater for a wide variety of needs while 

remaining simple enough for ordinary teachers to start making good use of 

the power of the internet for community building and collaborative 

learning. My hope is that Moodle can be seen as a toolbox where they can 

start simply and naturally, and then progress to more and more advanced 

community facilitation over time. Ultimately, we'd like to see teachers 

being involved with and supported by a community of their peers. 

 

Let's look at a typical progression that a teacher might go through as they 

learn to use the Moodle tools: 

1. Putting up the handouts (Resources, SCORM) 

2. Providing a passive Forum (unfacilitated) 

3. Using Quizzes and Assignments (less management) 

4. Using the Wiki, Glossary and Database tools (interactive content) 

 

5. Facilitate discussions in Forums, asking questions, guiding 

 

6. Combining activities into sequences, where results feed later activities 

 

7. Introduce external activities and games (internet resources) 

8. Using the Survey module to study and reflect on course activity 

 

На авторитарном краю этого спектра находятся те, кто хочет держать студентов 

под жёстким контролем: они должны читать ресурсы в строго отведённое для этого время, 

а затем проходить тестирование, чтобы доказать, что они читали те ресурсы. Я нашёл пару 

метафор для такого подхода: «крыса в лабиринте», или «накачка и откачка». 

На «техно-хипповом» конце этого спектра находятся те, кто хочет вообще 

отменить управление, разрешив всем пользователям запускать их собственные Сайты 

Портфелей, рассылать Блоги и Файлы друг другу, используя RSS и механизмы 

уведомления Trackbacks. Это интересная мечта, которая действительно открывает простор 

воображению об образовании, но я думаю, что для её реализации потребуется решить 

много проблем (таких как безопасность, подотчётность, структура образовательных 

учреждений и т.д.). 

Подавляющее большинство людей, которых я встречаю, находятся между этих 

двух крайностей. Многие из них являются новичками в онлайн обучении, и ищут чего-то 

выходящего за рамки привычной работы в офлайн режиме, за которую они получали 

зарплату; они готовы подчиниться ненавязчивому руководству в совершенствовании 

своих навыков в работе онлайн. Эти люди очень быстро обучаются, не сталкиваясь с 

необходимостью агрегировать 100 различных блогов. 

1.2.6.Развитие 
Moodle должна быть достаточно гибкой, чтобы удовлетворять широкий спектр 

потребностей, оставаясь в то же время для обычных преподавателей достаточно простой, 

чтобы они могли начать использовать мощь интернета для построения сообщества и 

осуществления в нём соучастного обучения. Moodle можно рассматривать как набор 

инструментов, с помощью которых можно просто и естественно начать, а затем 

продвигаться с ускорением ко всё более эффективному участию в развитии сообщества. В 

конечном счёте, хотелось бы видеть всех преподавателей членами сообщества 

интерактивно сотрудничающих соратников. 

Давайте посмотрим на типичный прогресс преподавателя по мере освоения им 

работы с инструментами Moodle. 

1. Активация предоставленных средств (Ресурсы, SCORM). 

2. Создание пассивного Форума, без фасилитации (облегчающих подсказок). 

3. Использование Экзаменов и Заданий (с сокращённым менеджментом). 

4. Использование инструментов Вики, Глоссария и Базы Данных (интерактивное 

содержимое). 

5. Фасилитация (направляющее воздействие на) дискуссий Форумов; выдача Вопросов, 

советов по ходу работы. 

6. Комбинирование Интерактивных Действий в последовательность, в которой 

результаты предыдущих Действий нужны для последующих. 

7. Использование внешних Интерактивных Действий и игр (ресурсов интернета). 

8. Использование модуля Анкета (Survey) для слежения за ходом событий в Курсе и 

реагирования на них. 
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9. Using peer-review modules like Workshop, giving students more 

control over grading and even structuring the course in some ways 

 

10. Conducting active research on oneself, sharing ideas in a community of 

peers 

1.2.6.1.Repositories and Portfolios 
Special-purpose repositories are a growing area, and it means institutions 

can keep their valuable data where they want to, even if they switch front-

end systems like VLEs. Most importantly, this will allow the development 

of e-Portfolios to explode, and these are something I think a lot of us really 

want to see as a very positive pedagogical enhancement. 

 

1.2.6.2.Community Hubs 
We want to improve the way teachers and users of Moodle communicate 

with each other, not only about e-learning and Moodle, but also in their 

subject areas. For example, imagine a Biology 101 teacher finding a 

"community search" block in their course, taking them straight to a place 

where their peers are all discussing best practice for teaching Biology 101, 

sharing and browsing repositories of course materials and learning designs. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Использование интерактивных модулей, подобных модулю Семинар, предоставление 

студентам возможностей по управлению оцениванием и даже структурированием 

Курса разными способами. 

10. Критическое рассмотрение своей собственной деятельности, обмен возникающими при 

этом идеями с соратниками по сообществу. 

1.2.6.1.Репозитории и Портфели 
Репозитории специального назначения – расширяющаяся область, она 

предназначена для того, чтобы организации могли сохранять там своих значимые данные, 

даже если они выключат основные системы обработки данных, типа VLE (Virtual Learning 

Environment – виртуальная среда обучения). Более важно то, что это позволяет резко 

расширить разработку э-Портфелей, что, я думаю, многие из нас считают действительно 

очень сильным педагогическим усовершенствованием. 

1.2.6.2.Хабы сообществ 
Мы хотим улучшить способ, которым преподаватели и пользователи Moodle общаются 

друг с другом не только по вопросам электронного обучения и Moodle, но также и по 

вопросам их собственных предметных областей. Например, представьте себе 

преподавателя Курса «Биология 101», обнаружившего в своём Курсе «поиск сообщества», 

блока, который приведёт его прямо туда, где все его коллеги обсуждают наилучшие 

практики обучения Курса «Биологии 101», просматривают и совместно используют 

репозитории друг друга с материалами Курса и учебными планами. 

http://docs.moodle.org/25/en/Repository
http://docs.moodle.org/24/en/Repository
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The creation of networking between Moodles allows anyone to turn their 

Moodle site into a Moodle Community Hub. Login between Moodles is 

transparent but secure and fully controlled by site administrators. The peer-

to-peer nature of the design allows all sorts of interesting scenarios to 

develop. 

1.2.6.3.Interaction between tools 
By piping all the messaging from throughout the system via the Messaging 

module that we already have, users have a much finer control over exactly 

what sorts of messages they want to see. 

1.2.6.4.Metadata and outcome statements 
Moodle has a mechanism so that: 

1. admins can import a long list of outcome statements (as tags) 

 

2. teachers can relate a subset of these to their course 

3. teachers can connect each activity to an even smaller subset 

 

Progress Tracking allows these things to be guided by individual learning 

plans for each student. 

 

1.2.6.5.Role-playing and scenario simulations 
 
A popular and effective technique in face-to-face teaching is that of role-

playing in scenarios, and this can be difficult to do online. You could 

imagine an Environmental Science course running a role-playing 

simulation where some students play the government, some as Greenpeace, 

some as industry for a particular scenario. 

The plans for this have been around for a long time, but I hope it can be 

developed soon. It would be a module where people can be assigned roles 

within a simulated situation and appear to others anonymously in those 

roles, interacting in forums, wikis, and all the other tools in Moodle 

according to the rules of the simulation. 

1.2.7.What else would you like to see? 
I hope this has stimulated some thoughts about the sorts of things you 

would like to see in your ideal online learning environment. If so, please 

join in with the discussions on http://moodle.org and let's brainstorm them 

a bit. I hope we can come up with some new ideas to put in the Moodle 

Tracker, or at least some support or modifications for old ones. 

 

Создание сетевых контактов между системами Moodle позволит каждому 

включить свой Сайт Moodle в хаб-сообществ Moodle. Регистрация между системами 

Moodle прозрачна, но безопасна и полностью подконтрольна Администраторам Сайтов. 

Природа конструкции связей между коллегами позволяет создавать разные интересные 

сценарии для развития. 

1.2.6.3.Взаимодействие между инструментами 
Путём обмена сообщениями по всей системе посредством имеющегося модуля 

Обмена сообщениями (Messaging), пользователи могут более тонко управлять тем, какого 

сорта сообщения они хотят видеть. 

1.2.6.4.Метаданные и конечные формулировки 
Moodle имеет механизм, такой что: 

1. администраторы могут импортировать длинные списки формулировок Показателей 

работы (как тэги), 

2. преподаватели могут брать подмножества этих списков для своих курсов, 

3. преподаватели могут связать каждое Интерактивное Действие своих Курсов с 

подмножествами этих подмножеств. 

Инструмент для отслеживания происходящего внутри Курсов позволяет 

направлять перечисленное на осуществление индивидуальных планов обучения каждого 

студента. 

1.2.6.5.Разыгрывание Ролей и моделирование 
поведения Системы 

Популярная и эффективная техника обучения лицом к лицу является техникой 

исполнения Роли по сценариям, и это трудно осуществлять в онлайн режиме. Попробуйте 

вообразить Курс по экологии окружающей среды, основанный на моделировании по 

конкретному сценарию ролей, где одни студенты играют роль правительства, другие – 

роль представителей «Гринпис», третьи – роль промышленников. 

Планы реализации этого вынашиваются уже долго, но, надеюсь, смогут быть скоро 

реализованы. Это мог бы быть модуль, где Роли в моделируемой ситуации назначались бы 

людям анонимно, и они взаимодействовали бы на Форумах, Вики и во всех остальных 

инструментах Moodle  в соответствии с правилами игры. 

 

1.2.7.Что ещё вы хотели бы увидеть? 
Я надеюсь, это подтолкнёт к мыслям о тех вещах, которые вы бы хотели видеть в 

вашей идеальной среде обучения онлайн. Если это так, присоединяйтесь к обсуждениям на 

страницах http://moodle.org, и давайте устроим мозговой штурм по ним. Я надеюсь, мы 

сможем прийти к некоторым новым идеям, чтобы вложить их в Moodle Tracker (систему, 

следящую за идеями, связанными с Moodle), или, по крайней мере, поддержать или 

модифицировать старые идеи. 

http://docs.moodle.org/25/en/Community_hubs
http://docs.moodle.org/25/en/Tracking_progress
http://tracker.moodle.org/
http://tracker.moodle.org/
http://docs.moodle.org/25/en/Tracking_progress
http://moodle.org/
http://tracker.moodle.org/
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1.2.8.Interesting links 
 Effective use of the Guerra Scale in Moodle 

 Bloom's taxonomy Is, arguably, one of the most commonly used 

pedagogies in 6-10 education today. 

 

 Solo Pedagogy An alternative to Bloom's is Solo Taxonomy. 
 

1.3.Standards 
Moodle is a global learning management platform that supports open 

standards, and is interoperable by design to enable integration of external 

applications and information onto a single Moodle platform. 

 

Our commitment to open standards means institutions and organisations 

can leverage Moodle to customise and extend features for any teaching and 

learning requirements, and benefit from increased cost efficiencies, 

flexibility, easier manageability along with performance and scalability 

advantages of using Moodle. 

 

Moodle has achieved and is compliant with the following international 

standards: 

1.3.1.An Open Source Initiative 
Moodle is provided as a free, open source software that can be used, 

modified and freely distributed under the terms of the GNU General Public 

License. There are also plenty of documentation, course content and 

resources available on Moodle.org for anyone to use under the terms of 

various licenses, including: 

 Moodle Documentation: All documentation on docs.moodle.org is 

openly licensed under the terms of the GNU General Public License, 

and is Copyright © 2005 onwards by the individual authors of each 

page. 

 

 Moodle.net: All courses published on Moodle.net is published under 

Commons licenses. 

1.3.2.IMS LTI™ Certified 
Moodle is certified Learning Tool Interoperability (LTI) v1.0 and v1.1 

compliant. The LTI™ certification is a global technical standard  

 

 

1.2.8.Интересные ссылки 
 Эффективное использование Шкалы Гуерра в Moodle. 
 Таксономия Бенджамина Блума (стабильность и изменение человеческих 

характеристик и классификация образовательных целей) является, возможно, одной из  

наиболее широко используемых сегодня  педагогических методик в 6-10 классах. 

 Таксономия Соло (университет штата Квинсленд Австралии) является альтернативой 

таксономии Блума. 

1.3.Стандарты 
Moodle является платформой обучения во всём мире, которая поддерживает 

открытые (бесплатные) стандарты, и по своему замыслу и построению способна к 

многостороннему управлению интеграцией внешних приложений и информации в единой 

платформе Moodle. 

Наша приверженность к открытым стандартам означает, что институты и 

организации могут заставить Moodle настраиваться и расширять её функции (средства) в 

соответствии с любыми требованиями к преподаванию и обучению, и получать пользу от 

увеличения эффективности расходов, гибкости, облегчения управляемости и выполнения 

учебного процесса, и от возможности менять масштабы преимуществ от использования 

Moodle. 

Moodle выполнена и отвечает требованиям следующих международных 

стандартов): 

1.3.1.Инициатива Открытого ресурса 
Moodle предоставляется как свободное, открытое программное обеспечение, 

которое может использоваться, модифицироваться и свободно распространяться на 

условиях лицензии GNU General Public License. На Сайте Moodle.org имеется много 

документации, содержимого Курсов и ресурсов, доступных каждому для использования на 

условиях различных лицензий, включая следующие: 

 Документация по системе Moodle: вся документация на Сайте docs.moodle.org 

лицензионно открыта на условиях GNU General Public License (общая лицензия на 

программные продукты Фонда бесплатного программного обеспечения) и Copyright © 

2005 (авторское право), распространяемых на индивидуальных авторов каждой 

страницы. 

 Moodle.net: Все Курсы, опубликованные на Moodle.net, опубликованы на условиях 

Commons licenses (общих лицензий). 

1.3.2.Сертифицированный IMS LTI™ 
Moodle является сертифицированным Learning Tool Interoperability (LTI) 

(инструментом обучения коллективного пользования) совместимых версий v1.0 и v1.1. 

Сертификация LTI™ является всемирно признанным техническим стандартом  

http://muppetmasteruk.blogspot.com/2010/06/effective-use-of-guerra-scale-in-moodle.html
http://docs.moodle.org/25/en/Bloom%27s_taxonomy
http://www.tedi.uq.edu.au/downloads/biggs_solo.pdf
http://muppetmasteruk.blogspot.com/2010/06/effective-use-of-guerra-scale-in-moodle.html
http://docs.moodle.org/24/en/Bloom%27s_taxonomy
http://www.tedi.uq.edu.au/downloads/biggs_solo.pdf
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of integrating learning applications. Users can integrate and present 

externally hosted applications and content within a single Moodle platform 

without having to develop and maintain custom integrations. 

Learn more about integrating LTI resources onto your Moodle platform. 

1.3.3.SCORM-ADL compliant 
Moodle complies with the SCORM 1.2 specification. The SCORM 

(Sharable Content Object Reference Model) is a set of specifications and 

standards for web-based e-learning. Users can deliver SCORM content via 

Moodle by uploading any SCORM or AICC package to the Moodle 

course. There are also community plugins available that provide limited 

support for the Experience API (Tin Can). A commercial plugin that 

provides full support for SCORM 2004 and the Experience API is also 

available in Plugins here. 

1.3.4.Open Badges 
Mozilla’s Open Badges project is an online standard to recognise and 

verify learning using digital badges. Integrated as a core feature in Moodle, 

any institution, organisation or individual can create and issue badges to 

learners on their Moodle learning platform. Learn more here. 

 

 

1.3.5.Moodle and Interoperability 
In supporting the seamless integration and use of content from different 

sources and multiple vendors, the Moodle platform is designed to 

exchange data using open industry standards for Web deployments, and 

supports: 

1.3.4.1.Authentication using 
 LDAP, the most widely-used standard protocol for authentication. 

 

 

 Direct database lookup (e.g. in an external Oracle database), or on the 

Shibboleth protocol, or alternatively using IMAP, NNTP, CAS or 

FirstClass. 

1.3.4.2.Enrolment using: 
 LDAP server (e.g. Active Directory) 

 

 IMS Enterprise standard (via a downloadable plugin). 

 

интегрирующих обучающих приложений. Пользователи могут объединять и представлять 

внешние приложения и содержимое внутри единой платформы Moodle без обязательства 

развивать и поддерживать клиентские интеграции. 

Узнайте больше об интегрирующих ресурсах LTI на вашей платформе Moodle. 

1.3.3.Отвечающий требованиям SCORM-ADL 
Moodle удовлетворяет спецификациям SCORM 1.2. SCORM (Sharable 

Content Object Reference Model – образцовая модель содержимого объекта для свободного 

использования) – является набором спецификаций и стандартов для интернет-обучения. 

Пользователи могут доставить содержимое SCORM через Moodle загрузкой любого пакета 

SCORM или AICC в Курс Moodle. Существует также множество доступных плагинов, 

которые обеспечивают ограниченную поддержку Experience API (Tin Can). Коммерческий 

плагин, который обеспечивает полную поддержку для SCORM 2004 и Experience API, 

также доступен и здесь в Plugins. 

1.3.4.Открытые Символы Отличия 
Проект открытых Символов Отличия (беджиков) Mozilla является онлайн-

стандартом для распознавания и верификации обучения посредством 

использования цифровых Символов Отличия. Интегрированные как средство ядра в 

Moodle, они позволяют любому институту, организации или индивиду создавать и 

выдавать Символы Отличия обучающимся на их обучающей платформе Moodle. Узнайте 

больше здесь. 

1.3.5.Moodle и многостороннее управление 
С целью поддержки целостной интеграции и использования содержимого из 

разных источников и от многих продавцов, платформа Moodle сконструирована так, чтобы 

обмениваться данными, используя открытые отраслевые стандарты для веб-размещения и 

поддержки: 

1.3.4.1.Использование аутентификации 
 LDAP – наиболее широко используемый для аутентификации (сопоставление 

введённых пользователем регистрационного имени и пароля с хранимыми в учётной 

записи) протокол стандартов. 

 Непосредственный просмотр базы данных (например, во внешней базе данных Oracle) 

или по протоколу Шибболе́т, или в качестве альтернативы используя IMAP, NNTP, 

CAS или FirstClass. 

1.3.4.2.Использование зачисления: 
 Сервер LDAP (например, Active Directory от Microsoft, предназначенный для 

обеспечения управления, защиты, доступа и разработки компонентов сети) 

 Стандарт IMS Enterprise (через загружаемый плагин). 

http://docs.moodle.org/25/en/External_tool
http://docs.moodle.org/dev/openbadges/
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1.3.4.3.Content using the import of Reusable 

Learning Objects, packaged according to the 

SCORM/AICC/IMS Content Packaging standards. 

 
 Moodle 1.9.5 is certified SCORM 1.2 compliant. 

 Moodle 1.9.7 onwards supports IMS Common Cartridge import 

 

 Moodle 2.3 supports CC export. 

 The use of XML for content import/export (standard in Moodle). The 

"web services" method of exchanging data with other systems (e.g. via 

SOAP or XML-RPC) is not yet standard - but is in active development. 

1.3.4.4.Quiz questions via import and export using 

various formats. 

1.3.4.5.RSS newsfeeds, integrated into a Moodle site 

or course 
 Forum discussions, glossary entries and database content can be 

accessed as RSS newsfeeds, and therefore integrated into other RSS-

capable websites or systems. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1.3.4.3.Содержимое, использующее импорт повторно 
применяемых обучающих объектов, спакетированных 
в соответствии со стандартами пакетирования 
содержимого SCORM/AICC/IMS 
 Moodle 1.9.5 сертифицирована в соответствии с требованиями. SCORM 1.2. 

 Moodle 1.9.7 и далее поддерживают импорт IMS Common Cartridge (стандарты 

поддержки новых поколений обучающих технологий). 

 Moodle 2.3 поддерживает экспорт CC (лицензия Creative Commons). 

 Использование XML для импорта/экспорта содержимого (стандарт Moodle). Метод 

обмена данным «web services (веб-сервисов)» с другими системами (например, через 

SOAP или XML-RPC) пока ещё не стандарт, – но активно развивается. 

1.3.4.4.Вопросы Экзаменов через импорт и экспорт, 
используя различные форматы 
1.3.4.5.Новостные рассылки RSS, интегрируемые в 
Сайт Moodle или Курс 
 Обсуждения Форумов, записи Глоссариев и содержимое Баз Данных могут быть 

доступны как новостные рассылки RSS и, следовательно, интегрированы в другие веб-

Сайты или системы, поддерживающие RSS. 
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1.4.History 
Growing up in the Australian outback in the late 1970s, Moodle's Founder 

and Lead Developer Martin Dougiamas took lessons from the School of 

the Air, giving him from a young age an insight into distance learning. 

As an adult, he worked and later studied at Curtin University, where his 

experience with WebCT prompted him to investigate an alternative method 

of online teaching. In 1999 he started trialling early prototypes of a new 

LMS, the experiences of which formed the basis for his paper Improving 

the Effectiveness of online Learning. He registered the word 'Moodle' as a 

trademark of the Moodle Trust. and explained his choice of name in a 

forum post some years later. 

Research continued: the first ever Moodle site was Peter Taylor's 

http://smec2001.moodle.com/ at Curtin University, with Martin making the 

first post on his own Moodle.com site in November 2001. The pair 

published An Interpretive analysis of an internet based course constructed 

using a new courseware tool called Moodle. 

By the end of 2001, Moodle could be downloaded via CVS (Git arrived in 

2010 and replaced CVS in 2013) and basic installation documentation was 

available. It was still very much one man's vision, with Martin setting up 

the tracker in May 2002 "so you can see what I am working on." 

Moodle 1.0 was released in August 2002. Users were discussing Moodle 

on a new forum, translating Moodle into different languages and creating 

themes. A year later, the first contributed module (workshop) was released 

and Moodle.org became the community arm of Moodle, with Moodle.com 

representing the commercial aspect. 

Moodle grew quickly: the first ever Moodle Moot was held in Oxford in 

2004 and companies started applying to become Moodle partners. 2005 

marked the move to dedicated premises with Martin and 4 others; the 

current HQ, at Lord Street Perth, houses 16 with 11 working remotely. 

 

With improved documentation and new certification, Moodle had 

established itself by 2007 as a leading and award-winning open source 

LMS. From 1000 registered sites in 2004, it had gone to half a million users 

in 2008 and over a million users in 2010, with over 50 Moodle partners. Its 

translation repository AMOS held over 100 languages. The long awaited 

Moodle 2.0 came out in November 2010 and now, regular releases bring 

enhanced features every six months. The current focus is on mobile 

technology: an official HTML5 app was released in 2013 and the latest 

version of Moodle, 2.5, includes a customisable theme suitable for all 

screen sizes. 

1.4.История 
Выросший в австралийской глубинке в конце 1970-х, основатель и ведущий 

разработчик Moodle Мартин Дуджамас брал уроки в Школе с радиосвязью, давшей ему с 

юного возраста и понимание дистанционного обучения. 

Взрослым он работал и позднее учился в университете Куртина, где прошлый опыт 

работы с WebCT побудил его изучить альтернативный метод онлайн обучения. В 1999 

году он начал испытания ранних прототипов новой LMS, что послужило основой для его 

диссертации «Повышение эффективности обучения в режиме онлайн». Слово «Moodle» он 

зарегистрировал в качестве «Товарного знака доверительной собственности Moodle» и 

объяснил свой выбор названия несколько лет спустя в «Корреспонденциях форума». 

 

Исследования продолжились: первый Сайт Moodle создал Питер Тейлор 

http://smec2001.moodle.com/ в Куртинском университете, уже в ноябре 2001 года 

обменялся первыми корреспонденциями с собственным Сайтом Мартина Moodle.com. Эта 

пара опубликовала «Интерпретационный анализ интернет-курса, сконструированного с 

помощью нового инструмента разработки курсов, названного Moodle». 

К концу 2001 года Moodle могла быть загружена через CVS (в 2010 году появился 

Git и в 2013 году заменил CVS) и была доступна базовая инсталляционная документация. 

Во многом она всё ещё оставалась видением одного человека, с установкой Мартином в 

мае 2002 года «Средства Слеживания» «чтобы каждый смог увидеть, над чем я работаю». 

Moodle 1.0 была выпущена в августе 2002 года. Пользователи обсуждали Moodle 

на новом форуме, переводили Moodle на разные языки и создавали темы. Год спустя, был 

выпущен первый предлагаемый модуль (Семинар) и Сайт Moodle.org стал ветвью 

сообщества Moodle, а Сайт Moodle.com стал представлять коммерческий аспект. 

 

Moodle быстро росла: впервые в 2004 году в Оксфорде был проведены 

академические обсуждения Moodle, и компании стали становиться партнёрами Moodle. 

2005 год ознаменовал переезд Мартина и 4 других в выделенное помещение; текущая 

Штаб-квартира с 11 членами, работающими дистанционно, находится в Lord Street Perth, 

houses 16 (г. Перт (Австралия), улица Лорд, здание № 16). 

С улучшенной документацией и новой сертификацией Moodle зарекомендовала себя 

к 2007 году как ведущая и «Отмеченная наградами система управления обучением с 

открытым исходным кодом». От 1000 зарегистрированных Сайтов в 2004 году она дошла до 

полумиллиона пользователей в 2008 году и более миллиона пользователей в 2010 году, с 

более чем 50 партнёрами Moodle. Её репозиторий переводов «АМОС» поддерживает более 

100 языков. Долгожданная «Moodle 2.0» вышла в ноябре 2010 года и теперь, регулярные 

выпуски приносят расширенные средства каждые шесть месяцев. В настоящее время всё 

сфокусировано на мобильной технологии: «Официальное приложение HTML5» было 

выпущена в 2013 году и последняя версия «Moodle 2.5», включает в себя настраиваемые 

темы клиентов, которые подходят для экранов всех размеров. 

https://otl.curtin.edu.au/professional_development/conferences/tlf/tlf2000/dougiamas.html
http://docs.moodle.org/dev/License
https://moodle.org/mod/forum/discuss.php?d=27533&parent=129848
http://dougiamas.com/writing/herdsa2002/
http://dougiamas.com/writing/herdsa2002/
http://dougiamas.com/writing/herdsa2002/)
https://tracker.moodle.org/secure/Dashboard.jspa
https://moodle.org/mod/forum/discuss.php?d=31
https://moodle.org/mod/forum/discuss.php?d=31
https://moodle.com/
https://moodle.org/mod/forum/discuss.php?d=68408
https://moodle.org/mod/forum/discuss.php?d=68408
http://docs.moodle.org/25/en/AMOS
https://moodle.org/mod/forum/discuss.php?d=162906
https://moodle.org/mod/forum/discuss.php?d=227988
http://docs.moodle.org/25/en/New_features
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The inauguration of the Moodle Research conference in 2012 served as a 

reminder that, however advanced the technology, Moodle design and 

development is guided by social constructionist pedagogy. Educators 

everywhere are encouraged to share their experiences, just as did Martin 

over a decade previously. 

1.5.Usage 
1.5.1.Who uses Moodle? 

Moodle is used by a variety of institutions and individuals, 

including: 

 Universities 

 High schools 

 Primary schools 

 Government departments 

 Healthcare organisations 

 Military organistions 

 Airlines 

 Oil companies 

 Homeschoolers 

 Independent educators 

 special educators 

 

1.5.2.How many Moodle sites are there 
There are tens of thousands of registered Moodle sites in the sites list that 

we maintain, however it is impossible to know exactly how many Moodle 

sites exist because Moodle is open source, free to download and distribute, 

and doesn't force registration on its users. Very often we find people will 

not inform us about their sites. 

For up-to-date summary statistics about registered sites browse the Moodle 

Statisticspage. Statistics shown on this page are updated daily to provide an 

accurate summary of collected information. You can also browse 

the Moodle Sites page, which provides a useful list of registered sites 

grouped by country for all sites that have chosen to make their information 

public. 

 

 

 

 

 

Открытие в 2012 году «Научно-исследовательской конференции Moodle» послужило 

напоминанием того, что весьма продвинутая технология Moodle в области дизайна и 

развития руководствуется «Социальной конструктивистской педагогикой». Педагоги всего 

мира теперь приглашаются делиться своим опытом так же, как Мартин это сделал более 

десяти лет назад. 

1.5.Применение Moodle 
1.5.1.Кто использует Moodle? 

Moodle используется различными организациями и отдельными лицами: 

 

 Universities    (университеты) 

 High schools   (средние школы) 

 Primary schools   (начальные школы). 

 Government departments  (правительственные учреждения) 

 Healthcare organisations  (организации здравоохранения) 

 Military organistions  (военные организации) 

 Airlines    (авиакомпании) 

 Oil companies   (нефтяные компании) 

 Homeschoolers   (обучающиеся заочно) 

 Independent educators  (независимые преподаватели) 

 Special educators   преподаватели коррекционно-компенсирующего 

                                                            образования). 

1.5.2.Сколько существует Сайтов Moodle 
В списках Сайтов, которые мы поддерживаем, значатся десятки тысяч 

зарегистрированных Сайтов Moodle, невозможно знать точно, сколько существует 

Сайтов Moodle, потому что Moodle – открытая система, свободная для скачивания и 

распространения, не требующая обязательной регистрации её пользователей. Очень часто 

мы находим людей, которые не информируют нас о своих Сайтах. 

Текущие данные о статистике зарегистрированных Сайтов приведены на странице 

Moodle Statistics.(http://moodle.org/stats/). Статистика, приведённая на этой странице, 

обновляется ежедневно, чтобы обеспечить точность собранной информации. Можно также 

просмотреть страницу Moodle Sites (http://moodle.org/sites/http://moodle.org/sites/), которая 

предоставляет полезный список зарегистрированных Сайтов, сгруппированный по 

странам, для всех Сайтов, которые согласились на публикацию их информации. 

http://moodle.org/stats/
http://moodle.org/stats/
http://moodle.org/sites/
http://research.moodle.net/
http://docs.moodle.org/25/en/Philosophy
http://moodle.org/stats/
http://moodle.org/stats/
http://moodle.org/sites/
http://moodle.org/sites/http:/moodle.org/sites/
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1.5.3.How statistics are collected and 

maintained 
1.5.3.1.Registration 
All information collected by moodle.org is from site administrators that 

have registered their sites with us. For security and privacy reasons 

registration has been made a manual process that only a site administrator 

can undertake. Registration can be undertaken by clicking on the 

Registration button shown in the site administration block under 

Notification, and filling out the simple form that then gets sent back to us. 

Sites can update the registration information we hold about them at any 

time them by repeating the manual process. It is important to note that 

because of the manual process information that is collected by moodle.org 

may be out of date. 

Moodle since version 1.0 has allowed users to register their sites with us, 

registration being something that we encourage all publicly available sites 

to do. You can read more about registration, the registration process and 

what is collected on the Moodle Registration page. 

1.5.3.2.Moderation 
To ensure that the statistics that we collect are as accurate as possible there 

are certain conditions that a registered site has to meet in order to be 

included into both the statistics and sites pages. 

When a site first registers we check the information about the site to ensure 

that the URL they have provided is valid and that the email address for the 

site administrator is a valid email address. We also at this point sanity 

check the information being collected to remove obvious test sites. 

 

1.5.3.3.Maintenance 
Like most of the web many sites come and go. Since we strive to maintain 

accurate statistics we need to check registered sites on a regular basis and 

clean out old data. A sophisticated, automated site check process is used to 

undertake the task of checking every registered site on a weekly basis. 

In checking registered sites every sites is visited by our site check program 

that then evaluates and scores each site individually based on a collection 

of 21 defined rules that we have set to identify each and every Moodle 

release. The score that a site receives determines whether the site remains 

in the list , is flagged for manual inspection, or marked as invalid. Any site 

that fails the evaluation two weeks in a row is then 

 

1.5.3.Как собирается и поддерживается статистика 
 
1.5.3.1.Регистрация 

Вся информация, собираемая посредством Сайта moodle.org, поступает от 

Администраторов Сайтов, которые зарегистрировали Сайты у нас. Ради безопасности и 

приватности регистрация сделана ручным процессом, который может выполнять только 

Администратор Сайта. Регистрация может быть выполнена щелчком по кнопке 

Registration, показанной в Блоке «Site administration (управление Сайтом)» под Notification, 

и заполнением простой формы, которая затем отправляется обратно к нам. 

Сайты могут в любое время обновлять информацию о регистрации, которую мы 

содержим о них, повторяя процесс вручную. Важно заметить, что из-за ручной обработки 

информация, которая собирается на Сайте moodle.org, может быть запоздалой. 

 

Начиная с версии 1.0, когда Moodle позволила пользователям регистрировать свои 

Сайты у нас, мы рекомендуем регистрировать все общедоступные Сайты. Вы можете 

прочитать больше о процессе регистрации и о том, что собирается на странице 

регистрации Moodle. 

1.5.3.2.Модерация 
Чтобы гарантировать, что статистика, которую мы собираем, точна насколько это 

возможно, существуют определённые требования, которым регистрируемый Сайт должен 

отвечать, чтобы быть включённым на страницы статистических данных и Сайтов. 

Когда Сайт регистрируется впервые, мы проверяем информацию о Сайте, чтобы 

убедиться, что URL, который предоставлен, действительно существуют, и что адрес э-

почты Администратора Сайта является действующим адресом электронной почты. Мы 

также в этот момент контролируем разумность представляемой информации, для отсева 

очевидно сырых Сайтов. 

1.5.3.3.Поддержание 
Подобно многим веб Сайтам, наши Сайты возникают и исчезают. Поскольку мы 

стремимся вести точную статистику, нам приходится регулярно проверять 

зарегистрированные Сайты и вычищать устаревшие данные. Для выполнения задачи 

проверки по еженедельному графику каждого зарегистрированного Сайта, используется 

сложный автоматизированный процесс проверки Сайтов 

При проверке зарегистрированных Сайтов каждый Сайт посещается нашей 

программой проверки Сайтов, которая затем оценивает и ранжирует каждый Сайт 

индивидуально, в соответствии с 21 определёнными правилами для идентификации 

любого события в системе Moodle. Оценка, которую получает Сайт, определяет, остаётся 

ли Сайт в нашем списке, помечен ли он для проверки вручную, или отнесён к 

недействительным. Сайт, который не прошёл оценивание в течение двух недель подряд,  

http://docs.moodle.org/25/en/Moodle_registration
http://docs.moodle.org/25/en/Moodle_registration
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removed from the sites list, and not included in any statistics. 

1.5.3.4.Ensuring your site passes the weekly 
evaluation 
To ensure that your site passes the weekly evaluation check that your site 

meets the following three criteria. 

 Check the URL you registered is the URL of your Moodle registration. 

We check only the page returned from the URL you registered, we don't 

dig down into your site, or search any alternatives. 

 Check the site is publicly available on the Internet. We can't check your 

site if it is only available locally, or has been wrapped in any means of 

authentication. 

 Ensure you have content when you register your site. If you don't have 

any content when you register it is likely we will dismiss your site as a 

test site. Ensure that you have created at least one course, and three 

users within your installation before registering. 

If you want to find out when we last came through you can check your 

personal site statistics or web server logs and look for page requests on 

your registered URL that have the following user agent moodle.org Link 

Checker. 

1.5.4.See also 
 Moodle installation listings 

1.6.Features tour 
Moodle is a free, online Learning Management system enabling educators 

to create their own private website filled with dynamic courses that extend 

learning, any time, anywhere. Whether you're a teacher, student or 

administrator, Moodle can meet your needs. Come and take a look! 

 

1.6.1.Are you a teacher? 
In Moodle you can... 

 Drag your favourite teaching resources straight onto the page: 

 No complex uploading processes; just select your file, folder or 

other learning resource and place it exactly where you want in your 

course. 

 Search for and embed multimedia at the click of a button: 

 Moodle's easy to use text editor makes formatting your courses a 

pleasure,with customisable edit icons and built-in image, sound and 

video embedding. 

 

удаляется из списка Сайтов и не включается ни в какую статистику. 

1.5.3.4.Проверка того, что ваш Сайт прошёл 
еженедельное оценивание 

Чтобы убедиться, что ваш Сайт прошёл еженедельное оценивание, проверьте, 

отвечает ли ваш Сайт следующим трём критериям. 

 Проверьте URL, который вы зарегистрировали, – это URL вашей регистрации в 

Moodle. Мы проверяем только возвращаемую страницу от зарегистрированного вами 

URL, мы не роемся и не ищем альтернативы в вашем Сайте. 

 Проверьте ваш Сайт на публичность доступа по интернету. Мы не можем проверить 

ваш Сайт, если он доступен только локально или окутан какими-то средствами 

аутентификации. 

 Убедитесь, что у вас есть контент, когда вы регистрируете свой Сайт. Если у вас нет 

контента при регистрации, мы, вероятно, отклоним ваш Сайт как сырой. Необходимо, 

чтобы у вас был создан хотя бы один Курс, и что три пользователя перед этим были 

зарегистрированы в вашей инсталляции. 

Если вы хотите выяснить, когда мы последний раз производили проверку, вы 

можете просмотреть вашу персональную статистику Сайта или журналы веб-сервера и 

поискать по вашему зарегистрированному URL запросы страницы, которые имеют 

следующего пользовательского агента: Link Checker на moodle.org. 

1.5.4.См. также 
 Листинги инсталляции Moodle. 

1.6.Просмотр свойств 
Moodle является бесплатной онлайн системой управления образованием, 

позволяющей преподавателям создавать свои собственные Сайты, наполненные 

динамичными Курсами, и позволяющей осуществлять учебный процесс в любом месте и в 

любое время. Являетесь ли вы преподавателем, студентом или Администратором, Moodle 

может вам помочь в вашем деле. Познакомьтесь с нею! 

1.6.1.Вы Преподаватель? 
В Moodle вы можете… 

 Перенести ваши любимые средства обучения прямо на страницу: 

 Никаких сложных процессов пересылки; просто выберите нужный Файл (п. 4.4.2), 

Папку (п.4.4.3) или другой образовательный Ресурс и разместите его в вашем Курсе 

именно там, где нужно. 

 Найдите и встройте мультимедиа (п. 5.4) щелчком кнопки. 

 В Moodle легко использовать текстовый редактор (п. 4.2), который делает 

форматирование ваших Курсов приятным, благодаря иконкам пользовательской 

настройки редактирования, встроенным изображениям, и возможности встраивать 

звук и видео. 

http://docs.moodle.org/25/en/Category:Installations
http://docs.moodle.org/25/en/File_resource
http://docs.moodle.org/25/en/Folder_resource
http://docs.moodle.org/25/en/Working_with_media
http://moodle.org/sites/
http://docs.moodle.org/24/en/Category:Installations
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 Reward and motivate your students with badges: 

 Direct your students' learning path: 

 Let learners meander freely around your course or restrict their 

access dependent on criteria met, time or profile fields; it's your 

choice! 

 Get your students working and learning together: 

 From forums to collaborative wikis and glossaries, from comment 

boxes toprivate messaging, Moodle offers your students a number of 

ways to make their voice heard. 

 

 Assess and feedback with self-grading quizzes: 

 A wide range of standard and contributed question types make for a 

powerful tool for both formative and summative assessment. 

 

 Set them individual, group or anonymously graded assignments: 

 Students can submit anything from a short text-based task to a team 

project with multiple files, and you can grade with a single 

percentage or a complex, customised rubric . 

 

 Provide opportunities for them to peer and self assess: 

 Workshops challenge your class to evaluate their own and others' 

submissions according to criteria decided by you. 

Find out more... 

1.6.2.Are you a student? 
In Moodle you can... 

 Manage your files however and wherever you like: 

 Store your files in your personal files area or access them from 

Google, Dropbox, Flickr, Youtube, Skydrive... 

 Track your progress on each log in: 

 Checkboxes against every task remind you how far you've come 

 

 Create your own personal dashboard: 

 The customizable My Home page gives quick access to courses, 

work owing, online users or other items you choose to add. 

 

Find out more... 

 

 

 

 

 Поощряйте и мотивируйте ваших студентов Знаками Отличия (п. 4.9.5). 

 Руководите ходом обучения ваших студентов: 

 Позволяйте учащимся произвольно путешествовать по вашему Курсу или 

ограничьте их доступ (п. 4.9.2) в зависимости от выполнения требований, 

ограничений на время или полей Профиля, – определяете только вы! 

 Добивайтесь, чтобы ваши студенты работали и обучались совместно: 

 От Форумов (п.4.3.7) до совместных Вики (п.4.3.13) и Глоссариев (п. 4.3.8), от окошек 

Комментариев (п. 3.17.2) и до обмена Личными сообщениями (п. 3.17.4) – Moodle 

предоставляет студентам множество возможностей выразить своё мнение и быть 

услышанными. 

 Оценивания и Обратная Связь с помощью само-оцениваемых Экзаменов (п. 4.3.10): 

 Широкий спектр стандартных и предлагаемых независимыми производителями типов 

Вопросов создаёт мощный инструментарий, как для процесса формирования 

Итоговой Оценки, так и Оценивания Путём Суммирования. 

 Давайте им индивидуальные, групповые и анонимно оцениваемые Задания (п. 4.3.1). 

 Студенты могут предоставлять на оценивание что угодно, от краткого текста 

решения задачи, до командного проекта со множеством файлов, а вы можете 

оценивать это как в процентах, так и в виде сложных, настраиваемых Рубрик 

(п. 6.2.9). 

 Предоставьте им возможность взаимной оценки и самооценки: 

 Семинары (п. 4.3.14) вынуждают ваш класс оценивать ответы свои и других в 

соответствии с критериями, предложенными вами. 

Отыщите больше… 

1.6.2.Вы Студент? 
В Moodle вы можете… 

 Управлять своими Файлами как и где пожелаете: 

 Сохранять свои Файлы в Области Личных Фалов или брать их из Google, Dropbox, 

Flickr, Youtube, Skydrive... 

 Отслеживать ход своего обучения (п.4.9) при каждом входе в систему: 

 Окошки-флажки рядом с каждой задачей напоминают вам, как далеко вы 

продвинулись. 

 Создавать собственную инструментальную панель (dashboard). 

 Настраиваемая под ваши потребности страница My Home (домашняя страница, 

п. 3.8.2), предоставляет быстрый доступ к Курсам, невыполненным работам, онлайн 

пользователям и другим элементам, добавляемым по вашему выбору. 

Отыщите больше… 

http://docs.moodle.org/25/en/Conditional_activities
http://docs.moodle.org/25/en/Conditional_activities
http://docs.moodle.org/25/en/Moodle_site_-_basic_structure
http://docs.moodle.org/25/en/Advanced_grading_methods
http://docs.moodle.org/25/en/Moodle_site_-_basic_structure
http://docs.moodle.org/25/en/Moodle_site_-_basic_structure
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1.6.3.Are you an administrator? 
In Moodle you can... 

 Authenticate and enrol your users in a variety of ways: 

 

 Moodle's 50+ combined standard and contributed authentication and 

enrolment solutions give you vast scope for getting everyone online! 

 

 

 Create an attractive, mobile-friendly learning environment which can 

integrate with your website: 

 Choose themes for different devices; add your own CSS, custom 

HTML and logo, all from within the admin interface 

 

 Enhance your Moodle with contributed plugins, that you can update 

from inside your site: 

 Over 460 community generated extensions ranging from video 

conferencing to plagiarism detection are freely available. And if you 

can't find it, request it! 

 Sign up to Community Hubs sharing free courses: 

 Every Moodle site can link to Moodle.net, allowing teachers to 

download, adapt or offer enrolment in free courses shared 

worldwide. Why not help your locality with a hub of its own too? 

Find out more... 

1.7.New features in 2.5 
Moodle 2.5 brings a lot of exciting new features for teachers, students and 

administrators. This page highlights a few of the most interesting! 

Full details of the release, with technical information, can be found in the 

Moodle 2.5 Release notes. 

1.7.1.For teachers and students 
1.7.1.1.Badges 
Badges are a nice way to acknowledge good work, and it's now possible 

for teachers to award course badges based on a variety of chosen criteria. 

These badges are fully compatible with Mozilla Open Badges. 

 

This blog post has some interesting reflection on when badges might be 

most appropriate: The Badges of Oz. 

1.7.1.2.Forms are much shorter 
Moodle has a lot of settings and features, which means some of 

1.6.3.Вы Администратор? 
В Moodle вы можете… 

 Устанавливать подлинность и зачислять на Курсы ваших пользователей различными 

способами. 

 Более 50 комбинаций стандартных и предложенных независимыми 

производителями решений по аутентификации (п. 3.1) и зачислению на Курсы (п. 

3.1) дают вам широкие возможности предоставить каждому доступ в режиме 

онлайн! 

 Создавать привлекательную, дружественно-мобильную среду обучения, которая может 

интегрироваться с вашим Сайтом: 

 Выберите из интерфейса Администратора Сайта темы для различных устройств 

(экранов разных размеров), добавьте собственные CSS, пользовательские HTML и 

логотипы. 

 Совершенствуйте свой Moodle распространяемыми плагинами, которые вы можете 

обновлять из своего Сайта: 

 В свободном доступе находится более 460 созданных сообществом плагинов, от 

видео конференций до обнаружителей плагиата. Если вы их не можете найти – 

запросите их! 

 Подпишитесь на хабы Сообщества Moodle и используйте бесплатные курсы. 

 Каждый Сайт в Moodle может связаться с, что позволяет преподавателям скачивать, 

адаптировать или предлагать включение в общедоступные Курсы. Почему бы не 

помочь создать вам на месте ваш собственный хаб тоже? 

Отыщите больше… 

1.7.Новые средства в 2.5 
Moodle 2.5 принесла множество новых волнующих средств для преподавателей, 

студентов и администраторов. Эта страница освещает некоторые из наиболее интересных! 

Полная детализация технической информации этого выпуска приведена в Moodle 

2.5 Release notes. 

1.7.1.Для Преподавателей и Студентов 
1.7.1.1.Знаки Отличия 

Знаки Отличия являются прекрасным способом выразить признательность за 

хорошую работу, и сейчас для Преподавателей стало возможным награждать 

Знаками Отличия в Курсе в соответствии с разными критериями. Эти Знаки Отличия 

совместимы с системой Mozilla Open Badges. 

То, что сообщается в этом блоге, имеет интересную связь с тем, когда 

Знаки Отличия могут быть наиболее приемлемы: см. The Badges of Oz. 

1.7.1.2.Формы стали много короче 
Moodle имеет множество настроек и средств, что привело к тому, что некоторые из 

http://docs.moodle.org/25/en/Managing_a_Moodle_site
http://docs.moodle.org/dev/Moodle_2.5_release_notes
http://docs.moodle.org/25/en/Badges
http://openbadges.org/
http://alex.halavais.net/ozbadge
https://moodle.org/plugins/index.php
http://moodle.net/
http://docs.moodle.org/25/en/Community_hubs
http://docs.moodle.org/25/en/Managing_a_Moodle_site
http://docs.moodle.org/dev/Moodle_2.5_release_noteshttp:/docs.moodle.org/dev/Moodle_2.5_release_notes
http://docs.moodle.org/dev/Moodle_2.5_release_noteshttp:/docs.moodle.org/dev/Moodle_2.5_release_notes
http://docs.moodle.org/25/en/Badges
http://openbadges.org/
http://alex.halavais.net/ozbadgehttp:/alex.halavais.net/ozbadge
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our forms have been getting rather long. We know this is daunting for new 

users! 

The rich text editor is collapsed and can be expanded. 

We've made changes so that non-essential settings on forms are collapsed 

by default, yet you can quickly access them when you need them. 

In a similar space-saver, you can choose whether or not to enable the rich 

text editor when creating quiz questions: 

1.7.1.3.Reports moved to the Administration 
block 
Reports have moved and can now be seen in the newly named 

Administration block, (formerly Settings.) 

1.7.1.4.Quickly "Jump to.." another section 
If you're using the 'one section per page' setting, you can now move to 

other sections from a drop down menu: 

1.7.1.5.Drag and drop media and text onto the 
course page 
You can now drag an image or some text onto your course page and 

choose whether to display it embedded in a label or as a clickable resource. 

See the Label documentation for more information. 

1.7.1.6.Folders can be displayed inline on a 
course page 
You can now choose whether to have a folder show its contents in a 

separate screen, as previously, or to have it display them inline with any 

subfolders expanded: 

1.7.1.7.Assignment enhancements 
Along with neater options for choosing submission and feedback types, 

resubmitting options are much improved. See Assignment settings for 

more information. 

1.7.1.8.Word count in forum posts 
A new setting in forums will display the number of words in a post: 

 

1.7.1.9.Templates for Essay question types 
When using the Essay question type in a quiz, you can now set a template 

which appears in the students' text editor for scaffolding their response: 

 

 

 

наших форм стали очень длинными. Мы знаем, что это обескураживает новых 

пользователей! 

Полный Текстовый Редактор (RTE) свёрнут, но может быть развёрнут. 

Мы внесли изменения, так что несущественные настройки форм свёрнуты по 

умолчанию, однако вы всегда можете их быстро развернуть при необходимости. 

В подобных экономящих пространство местах вы можете выбрать, разрешить ли 

использование Полного Текстового Редактора при создании вопросов для Экзаменов. 

1.7.1.3.Отчёты, перемещены в Блок Управления 
 

Отчёты были перемещены, и могут быть просмотрены в переименованном 

Блоке Управления (Administration), ранее называемом Настройки (Settings). 

1.7.1.4.Быстро «Перейти в…» в другой раздел 
Если вы используете настройку «One section per page (один раздел на странице)», 

вы можете перейти к другим разделам из ниспадающего меню. 

1.7.1.5.Отбуксировать медиа и текст на страницу 
Курса 

Вы можете теперь отбуксировать изображение или некоторый текст на страницу 

вашего Курса и выбрать, отображать ли его встроенным в метку, или представить, как 

Ресурс, доступный по щелчку. Больше информации приведено в. 

1.7.1.6.Папки могут быть отображены на странице 
Курса 

Вы можете теперь выбрать, показывать ли содержимое Папки (п. 4.4.2) на 

отдельном экране, как раньше, или прямо здесь с развёрнутыми Подпапками. 

 

1.7.1.7.Усовершенствования Заданий 
Наряду с более аккуратными опциями для выбора типов пересылаемых на 

рассмотрение готовых ответов и Обратной Связи, сильно улучшены опции повторной 

отправки готовых ответов, Больше информации приведено в п.4.3.1.1. 

1.7.1.8.Подсчёт слов в корреспонденциях Форумов  
Новые настройки в Форумах будут отображать количество слов в 

корреспонденции. 

1.7.1.9.Шаблоны для Вопросов типа Эссе 
Когда используете Вопросы типа Эссе в Экзамене, вы можете теперь установить 

шаблон, который появится в текстовом редакторе студента в качестве опорной схемы для 

их ответа. 

http://docs.moodle.org/25/en/Folder_resource
http://docs.moodle.org/25/en/Label
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1.7.1.10.Glossary block enhancements 
You can now use a global glossary in the random glossary block, and you 

can display the entries in alphabetical order: 

1.7.1.11.Search the list of enrolled users 
A new Enrolled users search box makes finding users in very large courses 

much easier: 

1.7.2.For administrators 
1.7.2.1.New themes suited to all screen sizes 
 
Many of your favourite sites around the web these days use Bootstrap as a 

base framework and now Moodle does too! We have a new 'base' theme 

called "Bootstrapbase" that implements the basics, and a new usable 

theme called 'Clean' which extends it with some simple configuration 

options and also functions as a good template example for developing your 

own Bootstrap-based themes. It also (along with Afterburner) allows you 

to upload a logo directly from the file picker. 

The Bootstrap framework allows us to responsively reformat the layout 

according to the screensize of the device used - on phone or tablet screens 

blocks move to the bottom, freeing up space for the main content at the 

top. In the future we hope everyone will want to migrate their Moodle 

themes to be Bootstrap-based. 

1.7.2.2.Install add-ons from inside Moodle 
It's now possible to install add-ons from within Moodle, rather than 

accessing folders on the server; useful for those admins who do not have 

FTP access. Add-ons can be uploaded and installed from a zip file or 

located and installed from the Moodle plugins directory. 

1.7.3.See also 
 Category:New features - list of pages documenting new features in 

Moodle 2.5 

1.8.Moodle site - basic structure 
1.8.1.How does Moodle work? 
1.8.1.1.The Front page 
The Front page of a Moodle site - the page you reach from your browser - 

usually includes information about the establishment itself and can be 

highly customised. (Note that it is also possible to lock the front page down 

so that all 

1.7.1.10.Усовершенствования блока Глоссария 
Вы можете теперь использовать глобальный Глоссарий в 

Блоке Случайных Глоссариев, и можете отображать их записи в алфавитном порядке. 

1.7.1.11.Поиск в списке зачисленных пользователей 
Новое окошко поиска намного облегчает поиск зачисленных пользователей в 

очень больших Курсах. 

1.7.2.Для Администраторов 
1.7.2.1.Новые Темы, подходящие для экранов всех 
размеров 

Многие из ваших любимых Сайтов в интернете наших дней используют само 

настраиваемые программы как базовую схему, а сейчас и Moodle делает так! Мы имеем 

новую «базовую» Тему, называемую «База само-настраиваемая», которая реализует 

основы, а новая годная для применения тема называется «Чистая», которая расширяет её 

некоторыми простыми конфигурациями, а также служит образцом для разработки ваших 

собственных тем, основанных на самонастройке. Это также (наряду с программой 

Afterburner) позволяет вам загрузить логотип непосредственно из файлового меню. 

Общая схема Bootstrap (приведения устройства в желаемое состояние) позволяет 

нам реактивно переформатировать компоновку экрана в соответствии с размером экрана 

используемого устройства – блоки на экранах телефонов или планшетников перемещают 

вниз, освобождая пространство для основного контента вверху. В будущем, мы надеемся, 

каждый захочет перевести свои темы Moodle в формат на основе Bootstrap. 

1.7.2.2.Установка дополнений изнутри Moodle 
Теперь можно и изнутри Moodle устанавливать плагины, а не через папки сервера; 

полезно для тех администраторов, которые не имеют FTP доступа. Плагины могут быть 

взяты из интернета и инсталлированы прямо из zip-файла или размещены и 

инсталлированы из директории плагинов Moodle. 

1.7.3.См. также 
 Category:New features – список страниц документации по новым средствам в 2.5. 

 

1.8.Сайт Moodle – базовая структура 
1.8.1.Как работает Moodle? 
1.8.1.1.Главная страница 
 Главная Страница Сайта Moodle – это страница, на которую вы попадаете через ваш 

браузер, обычно включает информацию о самом учебном заведении, и может быть 

сделана очень привычной для конкретного клиента. (Заметьте, что эту Главную 

страницу можно также заблокировать, чтобы всё,

http://docs.moodle.org/25/en/Enrolled_users
http://docs.moodle.org/25/en/Installing_add-ons
https://moodle.org/plugins
http://docs.moodle.org/25/en/Category:New_featureshttp:/docs.moodle.org/25/en/Category:New_features
http://docs.moodle.org/24/en/Front_page
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a user sees when they click on the Moodle URL is a log in screen.) 

 

 How users join a Moodle site depends on the establishment: they might 

be given logins; they might be allowed to make accounts themselves, or 

they might be signed in automatically from another system. 

1.8.1.2.Inside Moodle 
 Moodle's basic structure is organised around courses. These are 

basically pages or areas within Moodle where teachers can present their 

learning resources and to students. They can have different layouts but 

they usually include a number of central sections where materials are 

displayed and side blocks offering extra features or information. 

 

 Courses can contain content for a year's studies, a single session or any 

other variants depending on the teacher or establishment. They can be 

used by one teacher or shared by a group of teachers. 

 

 How students enrol on courses depends on the establishment; for 

example they can self -enrol, be enrolled manually by their teacher or 

automatically by the admin. 

 Courses are organised into categories. Physics, Chemistry and Biology 

courses might come under the Science category for instance. 

1.8.1.3.Teachers, students and other Moodle 
users 
 You don't enter Moodle with the "teacher" or "student" role. 

 Everyone who logs into Moodle has no special privileges until they are 

allocated roles by the administrator according to their needs in 

individual courses or contexts. 

1.8.1.4.Finding your way around 
 A logged in user can access areas of Moodle such as their courses or 

profile from the Navigation block and Settings block. What a user sees 

in these blocks depends on their role and any privileges granted them by 

the administrator. 

 Each user has their own customisable page, accessed from the My 

home link. 

1.8.2.See also 
 Structural overview slide show by Mark Drechsler. 

 What is Moodle explained with Lego presentation by Tomaz Lasic. 

 

что увидит пользователь, когда он щёлкнет по Moodle URL, будет экраном входа в 

Систему.) 

 Как пользователи присоединяются к Сайту Moodle зависит от учебного заведения: оно 

может выдавать пароли; может позволить создавать учётные записи самим, или может 

автоматически зачислять из другой системы. 

1.8.1.2.Внутри Moodle 
 Базовая структура всей Системы Moodle организована вокруг Курсов (п. 4.1). В 

основном, это страницы или области внутри Moodle, в которых преподаватели могут 

предоставлять студентам свои обучающие Ресурсы (п. 4.4) и Интерактивные Действия 

(п. 4.3). Они могут иметь различные компоновки, но обычно состоят из нескольких 

центральных разделов, где отображаются материалы, и боковых Блоков, предлагающих 

дополнительные средства или информацию. 

 Курсы могут содержать содержимое для годового изучения, отдельного урока, или 

любых других вариантов, зависящих от преподавателя или учебного заведения. Они 

могут быть использованы одним преподавателем или совместно использоваться 

группой преподавателей. 

 Как студенты зачисляются (п. 3.3) на Курсы, зависит от учебного заведения; например, 

они могут зачисляться сами, быть зачислены вручную их преподавателем, или 

автоматически Администратором Сайта. 

 Курсы организуются по Категориям. Например, Курсы по физике, химии и биологии 

могут идти в Категории Наука. 

1.8.1.3.Преподаватели, студенты и другие 
пользователи Moodle 
 Вы не войдёте в Moodle с Ролью «преподаватель» или «студент». 

 Никто из зарегистрировавшихся в Moodle, не имеет особых прав, пока Администратор 

не распределит им Роли (п. 3.3) в соответствии с их потребностями в индивидуальных 

Курсах или Контекстах. 

1.8.1.4.Нахождение своей траектории 
 Вошедшему в систему пользователю доступны области Moodle, такие как их Курсы 

или Профиль из Блока Навигации (http://docs.moodle.org/24/en/Navigation_block) и 

Блока Управления (п. 4.5). Что пользователь видит в этих Блоках, зависит от его Роли и 

Полномочий, предоставленных ему Администратором. 

 Каждый пользователь имеет свою собственную страницу настройки, доступную по 

ссылке My home (п. 3.8.2). 

1.8.2.См. также 
 Структурный обзор – слайд-шоу от Марка Дречслера. 

 Как Moodle объясняется при помощи конструктора Lego – презентация от Томаза 

Ласица. 

http://docs.moodle.org/25/en/Enrolment
http://docs.moodle.org/25/en/Roles_and_capabilities
http://docs.moodle.org/24/en/Navigation_block
http://www.slideshare.net/mark.drechsler/moodle-structural-overview
http://www.slideshare.net/moodlefan/what-is-moodle-explained-with-lego-presentation
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1.9.Moodle key terms 
A Moodle site is made up of courses which are basically pages containing 

the learning materials teachers want to share with their students. A teacher 

in a Moodle course can select items from three different elements which 

together assist in the learning process. They are: Activities, Resources and 

Blocks. 

 

 

 

 

1.9.1.Activities 
 An Activity in Moodle is a feature where students learn by interacting 

with each other or with their teacher. They might for instance contribute 

in a forum, upload an assignment, answer questions in a quiz or 

collaborate together in a wiki. Activities can be graded. 

 

 A teacher can add activities by turning on the editing and choosing an 

activity by clicking Add an activity or resource in a course section. 

They then select an activity from the activity chooser. (If the activity 

chooser has been turned off, a drop down menu appears instead.) 

Activities usually appear in the central area of the course. 

 

 Moodle has a number of activities which come as standard and there are 

also extra ones available for download by the administrator. See 

Activities to find out more. 

1.9.2.Resources 
 A Resource in Moodle is an item that a teacher can add to a Moodle 

course to support learning, such as a file, a video or link to a website. A 

resource differs from an activity in that it is static; ie, the student can 

merely look at or read it, rather than participate. 

 A teacher can add resources by turning on the editing and by 

clicking Add an activity or resource in a course section. They then 

select a resource from the activity chooser.(If the activity chooser has 

been turned off, a drop down menu appears instead.) Resources usually 

appear in the central area of the course. 

 Moodle has a number of resources which come as standard and there 

are also extra ones available for download by the administrator. See 

Resources to find out more. 

Screenshot «Link to the activity chooser». 

1.9.Ключевые термины Moodle 
Сайт Moodle состоит из Курсов (п. 4.1), являющиеся страницами, содержащими 

учебные материалы, которые 

преподаватели хотят представить своим 

студентам. Преподаватель может 

набирать в Курсе Moodle такие 

комбинации из трёх различных 

элементов, которые в совокупности 

станут помогать студенту, а процессе 

обучения. Это Интерактивные Действия (п. 4.3), Ресурсы (п.4.4) и Блоки (4.5). 

1.9.1.Интерактивные Действия 
 Интерактивное Действие в Moodle является средством, с помощью которого студенты 

обучаются в процессе активного общения друг с другом или с преподавателем. Они 

могут, например, участвовать в Форуме (п. 4.3.7), скачивать Задания (п. 4.3.1), отвечать 

на вопросы Экзамена (п. 4.3.10), или совместно работать в Вики (п. 4.3.13). 

Интерактивные Действия могут оцениваться. 

 Преподаватель может добавить Интерактивное Действие в раздел Курса, войдя в 

режим редактирования и щёлкнув по кнопке «Add an activity or resource (добавить 

интерактивное действие или ресурс)». Затем он выбирает нужное 

Интерактивное Действие в Окне Выбора Действий. (Если это окно выбора отключено, 

вместо него появляется ниспадающее меню.) Обычно Интерактивные Действия 

появляются в центральной области Курса. 

 Moodle имеет ряд Интерактивных Действий, которые приходят системой как 

стандартные, а также и дополнительные, доступные для загрузки Администратором. 

Больше информации об этом приведено в п. 4.3. 

1.9.2.Ресурсы 
 Ресурс в Moodle является элементом, который преподаватель может добавить в Курс 

Moodle для поддержки обучения, например, Файл, видео или ссылку на веб Сайт. 

Ресурсы отличаются от Интерактивных Действий тем, что они статичны, т.е. студент 

может просто смотреть на них или читать, не внося изменений. 

 Преподаватель может добавить Ресурсы в раздел Курса, включив режим 

редактирования и щёлкнув по Add an activity or resource в разделе Курса Затем он 

выбирает Ресурс в Окне Выбора Действий. (Если это окно выбора отключено, вместо 

него появляется ниспадающее меню.) Ресурсы обычно появляются в центральной 

области Курса. 

 В Moodle имеется ряд стандартных Ресурсов, но существуют и дополнительные 

Ресурсы, доступными для загрузки Администратором. Больше информации приведено 

в п. 4.4. 

Снимок с экрана «Ссылка на Окно Выбора Действия»: 

http://docs.moodle.org/25/en/Resources
http://docs.moodle.org/25/en/Activities
http://docs.moodle.org/25/en/Resources
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Screenshot «Drop down menu when activity chooser is disabled». 

1.9.3.Blocks 
 A Block in Moodle is an item that a teacher can add to the left or right 

of a Moodle course page. They provide extra information or links to aid 

learning. Blocks are a bit like "widgets" elsewhere online and can 

contain; for example, RSS news feeds, quiz results, a calendar, links to 

blogs, glossary terms or private files. There is also a simple HTML 

block which can be customised as the teacher wishes. 

 

 

 A teacher can add blocks by turning on the editing and choosing from 

the "Add a block" drop down which is usually on the bottom right side 

of the course page. Blocks usually appear on the sides of the course. 

 Moodle has a number of blocks which come as standard and there are 

also extra ones available for download by the administrator. See Blocks 

to find out more. 

1.10.About Moodle FAQ 
Below is a list of general questions many educators ask about Moodle. 

There are also Frequently Asked Question pagesfo r many specific Moodle 

tools. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Снимок с экрана «Ниспадающее меню, когда окно выбора Действия отключено»: 

1.9.3.Блоки 
 Блок в Moodle является элементом, который преподаватель может добавить слева или 

справа страницы Курса Moodle. Блоки дают дополнительную информацию или ссылки 

на учебные пособия. Блоки подобны «вспомогательным устройствам», 

приспособленным для облегчения работы в режиме онлайн, и могут содержать, 

например, RSS рассылки новостей, результаты Экзаменов, Календарь Событий, ссылки 

на Блоги, термины Глоссария или Личные Файлы. Существует также простой 

Блок HTML, который может быть настроен в соответствии с пожеланиями 

преподавателя. 

 Преподаватель может добавлять Блоки, включив режим редактирования, и сделав 

выбор из ниспадающего меню «Add a block», которое обычно располагается справа 

внизу на странице Курса. Блоки обычно располагаются по бокам страниц Курса. 

 Moodle имеет ряд Стандартных Блоков, но существуют также дополнительные блоки, 

доступные для загрузки Администратором. Чтобы узнать о них больше см. п. 4.5. 

 

1.10. Часто задаваемые вопросы о Moodle 
Ниже приведён перечень общих вопросов от многих преподавателей, задаваемых о 

системе Moodle. Существуют также страницы с часто задаваемыми вопросами по многим 

специфическим инструментам Moodle. 

http://docs.moodle.org/25/en/Remote_RSS_feeds_block
http://docs.moodle.org/25/en/Quiz_results_block
http://docs.moodle.org/25/en/Calendar_block
http://docs.moodle.org/25/en/HTML_block
http://docs.moodle.org/25/en/HTML_block
http://docs.moodle.org/25/en/Blocks
http://docs.moodle.org/25/en/Category:FAQ


 

32 

1.10.1.Starting with Moodle 
1.10.1.1.What is Moodle? 
 Moodle is a learning management system (LMS, also called VLE), 

explained here. In many ways, Moodle is like Lego, as this Slideshare 

presentation shows. 

 

 

1.10.1.2.How do I start using Moodle? 
 You can download your own copy and install it on your server. If you 

want to try it out for yourself you can use one of the accounts on the 

Moodle Demonstration Site. To see a site with example content, visit 

the School Demonstration site. 

1.10.1.3.Where do I get it (from)? 
 You can download Moodle in a variety of packages and install it 

yourself or have a Moodle Partner do it for you. Some webhosts offer 

Moodle as part of their hosting packages, although these vary in 

reliability. Other webhosts offer Moodle for free but this usually comes 

with conditions attached; for instance, your site might have adverts on 

it. 

1.10.1.4.Do I have to be really good with 
technology to use Moodle? 
 To use Moodle, you only need the basic web browsing skills. To install 

it you need a little more knowledge, but guidance is provided. 

 

1.10.1.5.What age of learners and educational 
settings is Moodle most appropriate for? 
 Moodle can be and is successfully used from early years of Primary 

schools (examples here) through to the Secondary sector (examples) 

and universities worldwide. Moodle can be adapted to suit learners of 

all ages in any learning environment, including commercial training. 

1.10.1.6.Is Moodle just for online learning? 
 
 It can be. However, in most cases Moodle is used to support and 

combine face-to-face interaction with e-learning, m-learning and other 

forms of learning. 

 

 

1.10.1.Знакомство с Moodle 
1.10.1.1.Что такое Moodle? 
 Moodle – это система управления обучением (LMS – learning management system), также 

называемая виртуальной средой обучения (VLE – Virtual Learning Environment), 

объясняемая ниже и в. Во многих отношениях Moodle похожа на детский конструктор 

Lego, как это показано в презентации http://school.demo.moodle.net/. 

1.10.1.2.Как я начинаю применять Moodle? 
 Вы можете скачать свою собственную копию и установить её на свой сервер. Если вы 

хотите испробовать её сами, вы можете использовать одну из учётных записей на 

демонстрационном Сайте Moodle. Чтобы увидеть Сайт с примером содержимого, 

посетите демонстрационный сайт Школы (при регистрации в качестве имени указывайте student 

или teacher (кем вы хотите войти?) а в качестве пароля moodle). 

1.10.1.3.Где (откуда) я могу взять систему? 
 Вы можете скачать Moodle из разных пакетов и установить её самостоятельно или 

попросить сервисную компанию Moodle Partner сделать это для вас. Некоторые веб-

Сайты предлагают Moodle как часть распространяемых ими пакетов, хотя надёжность 

таких пакетов бывает разной. Другие Сайты предлагают Moodle бесплатно, но с 

прилагаемыми условиями, например, с необходимостью ссылаться на них. 

 

1.10.1.4.Смогу ли я справиться с технологией 
использования Moodle? 
 Чтобы использовать Moodle, вам необходимы только базовые навыки работы с 

браузером. Чтобы установить её, вам потребуется немного больше знаний, но 

предоставляется руководство по установке. 

1.10.1.5.Какой возраст учащихся и среда обучения 
наиболее предпочтительны для Moodle? 
 Moodle может успешно использоваться начиная с ранних лет начальной школы 

(примеры здесь), в секторе средней школы (примеры) и в университетах во всём мире. 

Moodle может быть адаптирована к потребностям учащихся всех возрастов и к любой 

среде обучения, включая коммерческие тренинги. 

1.10.1.6. Предназначена ли Мoodle только для онлайн 
обучения? 
 Это возможный вариант. Однако в большинстве случаев Moodle используется для 

поддержки и соединения обучения лицом-к-лицу с интернет обучением, а также с 

другими видами обучения. 

https://moodle.org/about/
http://school.demo.moodle.net/
http://demo.moodle.net/
http://school.demo.moodle.net/
http://docs.moodle.org/25/en/Moodle_Partners
http://docs.moodle.org/25/en/Primary_education
http://docs.moodle.org/25/en/Secondary_education
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1.10.1.7.Where can I get some tutorials or 
presentations about Moodle? 
 As well as the comprehensive free documentation here and 

thepublished Moodle books, you can search through a list of other 

manuals and resources, a selection of video tutorials and general 

presentations. 

1.10.1.8.Are there any provisions in Moodle 
for people with disabilities? 
 Certainly. Moodle supports many assistive technologies such as screen-

readers, screen-magnifiers, alternative mouse and key use, disabling of 

AJAX and Javascript, and more. 

1.10.1.9.Are there any comparisons of Moodle 
with other Learning Management Systems? 
 See the Comparisons and Advocacy forum and also Moodle buzz 

1.10.2.Navigation and settings 
1.10.2.1.How do I login to Moodle? 
 Go to the right URL (address) of the Moodle site, login with your 

username and password, or enter as a Guest (if allowed). Most Moodle 

sites will have a link to set up a new account or request forgotten details 

of your existing one. 

 

1.10.2.2.How do I get around Moodle? 
 Use the Navigation block on the side of your page. From there you can 

go directly to any part of Moodle you have access to. 

1.10.2.3.How do I edit things? 
 You can only edit things you have permission to edit. A regular user 

such as a student can only edit their My home page and possibly their 

profile page. A user with editing rights such as a teacher can use the 

'Turn editing on' button or the link in the Settings block to edit items. A 

guest can't edit anything and an Admin you can whatever they like. 

 

 

1.10.2.4.Who can create and edit activities and 
other things in courses? 
 Whoever has the editing capability. Usually, it is the Teacher who 

creates and edits courses and activities within courses, but this role can 

1.10.1.7.Где я могу получить какие-нибудь 
консультации или презентации по системе Moodle? 
 Не только в данной подробной бесплатной документации и в опубликованных книгах 

по системе Moodle, но также вы можете просмотреть список других руководств и 

источников, подборки видео-курсов и общие презентации. 

 

1.10.1.8.Имеется ли в Moodle какое-либо обеспечение 
для инвалидов? 
 Конечно, да. Moodle поддерживает многие специальные технологии, такие как чтение с 

экрана, экранная лупа, варианты использования мыши и клавиш, отключение AJAX и 

Javascript, и многое другое. 

1.10.1.9.Существуют ли сравнения Moodle с другими 
системами управления обучением? 
 См. обсуждения на форуме, а также сплетни о системе Moodle в. 

1.10.2.Навигация и настройки 
1.10.2.1.Как мне войти в Moodle? 
 Перейдите к URL (адрес) справа на Сайте Moodle, войдите (login) под вашим 

регистрационным именем пользователя и паролем, или войдите как Гость (если 

разрешено администрацией Сайта). Большинство из Сайтов Moodle имеют ссылку для 

установки новой учётной записи или запроса забытых вами данных существующей 

учётной записи. 

1.10.2.2.Как найти свою стезю в Moodle? 
 Используйте Блок Навигации сбоку вашей страницы. Оттуда вы можете перейти 

непосредственно к любой части Moodle, к которой вы имеете доступ. 

1.10.2.3.Как что-нибудь отредактировать? 
 Вы можете редактировать только то, на что у вас есть Полномочие редактировать. 

Постоянный пользователь, такой как студент, может редактировать только свою 

Домашнюю Страницу (см. п. 3.8.2) и, возможно, Страницу Профиля (см. п. 3.2). 

Пользователь с правами редактирования, такой как преподаватель, может использовать 

кнопку «Turn editing on (включить редактирование)» или ссылку в Блоке Управления 

для редактирования элементов. Гость не может редактировать ничего, а Администратор 

– всё, что угодно. 

1.10.2.4.Кто может создавать и редактировать 
Действия и другие вещи в Курсах 
 Все те, кто имеет полномочия редактировать. Обычно, это Преподаватель, который 

создаёт и редактирует Курсы и Действия внутри Курсов, но эта Роль может быть 

http://docs.moodle.org/25/en/Main_page
http://moodle.org/mod/data/view.php?id=7246
http://docs.moodle.org/25/en/Moodle_manuals
http://docs.moodle.org/25/en/Moodle_video_tutorials
http://docs.moodle.org/25/en/Moodle_presentations
http://moodle.org/mod/forum/view.php?id=2784
http://moodle.org/mod/data/view.php?d=19
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be changed, re-named (eg. Facilitator) and given to other people too. 

1.10.3.Examples 
1.10.3.1.Are there any good examples of 
Moodle use I can see? 

 Sure! Check this little collection of videos and flick through stories 

on Moodle Buzz. There is also an entire school full of examples for you 

to see and play with. 

1.10.3.2.How do I share ideas and learn from 
other educators using Moodle? 
 By participating in many ways, either through events, forums on 

Moodle.org and networks elsewhere. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

изменена, переименована (например, на Куратор), а также назначена другим людям. 

1.10.3.Примеры 
1.10.3.1.Есть ли примеры хорошего использования 
Moodle, которые можно посмотреть? 
 Несомненно! Посмотрите коллекцию видео и пробежитесь по рассказам о Moodle в. 

Существует также Сайт полный примеров, которые можно просмотреть и проиграть. 

 

1.10.3.2.Как я смогу поделиться идеями и поучиться у 
других Преподавателей, использующих Moodle? 
 Участием многими способами, как через события, форумы на Moodle.org, так и в 

других сетях. 

http://embedr.com/playlist/moodle-on-the-ground
http://moodle.org/mod/data/view.php?d=19
http://school.demo.moodle.net/
http://moodle.org/forums/
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1.10.3.3.Are there any good sources for 
shared courses? 
 There certainly are. Via Community Hubs you can search for, enrol in, 

download and publish, shared courses. 

1.10.4.Learning with Moodle – pedagogy 
1.10.4.1.What is the best way to use Moodle? 
 There is no one best way to use Moodle. Use of Moodle depends a lot 

on one's own educational philosophy, the context where Moodle is used 

and willingness to experiment and create a little (or a lot!). Moodle can 

be used by a strict controller using trusted material of 30 years or a free-

loving e-hippie exploring new ways of teaching and learning alike. 

 

 

1.10.4.2.Can Moodle be used in different 
subject (say maths, languages, art, media, 
science...)? 
 Yes. Moodle is used in a variety of fields. Users in some subject areas 

may benefit further from standard or compatible third-party modules 

and plugins (eg. in maths, Tex notation filter(standard) or DragMath 

equation editor (third-party plugin)). 

 

1.10.4.3.How can I use Moodle to stimulate 
students think harder and ask good 
questions? 
 By asking and encouraging good questions students can wrestle with 

and explore through and with the help of activities, resources in a 

course. For example, open a forum discussion with a provocative 

question, start a wiki where groups collaboratively build a solution ... 

and more! 

1.10.4.4.How can I communicate with students 
by using Moodle? 
 Many ways are available. Some examples include: Forums are great for 

extended conversations over time, Messages for private channels, Chat 

for synchronous conversations, and Commentsfor quick notices and 

remarks. You can also exchange online feedback with Assignment, 

comments to Blog posts ... and more! 

1.10.3.3.Существуют ли хорошие источники 
совместно используемых Курсов? 
 Определённо. Через хабы сообщества вы можете искать такие Курсы, зачисляться на 

них, скачивать и публиковать их для использования в своих целях. 

1.10.4.Обучение с Moodle – педагогические вопросы 
1.10.4.1.Каков наилучший путь использования Moodle? 
 Всеобщего наилучшего способа использования Moodle быть не может. Её 

использование во многом зависит от ваших собственных философских воззрений на 

педагогику, от контекста, в котором используется Moodle, и от желания 

экспериментировать и немножко (или много!) творить. Moodle может применяться как 

преподавателем-консерватором, использующим надёжные, проверенные материалы 30-

летней давности, так и свободолюбивым интернет-новатором, исповедующим новые 

способы преподавания и обучения. 

1.10.4.2.Может ли Moodle использоваться в различных 
предметах (скажем, математике, языкознании, 
искусстве, медиа, науке…)? 
 Да. Moodle используется в различных областях. Пользователи в некоторой предметной 

области могут продолжать извлекать выгоду из употребления стандартных или 

совместимых модулей и плагинов от сторонних организаций (например, в математике – 

фильтре нотации (стандартный плагин Тех) или редактор уравнений (плагин 

независимых разработчиков)). 

1.10.4.3.Как использовать Moodle, чтобы 
стимулировать студентов глубже мыслить и 
задавать хорошие вопросы? 
 Задавая студентам хорошие Вопросы и поощряя их задавать Вопросы, можно помочь 

им преодолевать трудности изучения Курса с помощью Интерактивных Действий, 

Ресурсов. Например, откройте дискуссию на Форуме провокационным Вопросом, 

начните Вики для группового совместного построения решения… и много ещё чего! 

 

1.10.4.4.Как общаться со студентами, используя 
Moodle? 
 Доступны многие способы. Некоторые примеры: Форумы хороши для асинхронного 

общения, Обмен Сообщениями (п. 3.17.4) – для личных бесед, Чат (п. 4.3.2) – для 

синхронных разговоров, Комментарии (п. 3.17.2) – для быстрых реплик и замечаний. 

Вы можете также организовать Обратную Связь в режиме онлайн по Заданиям 

(п. 4.3.1), Комментарии к корреспонденциям Блогов (п. 3.17.1) и ещё много чего! 

http://docs.moodle.org/25/en/Community_hub
http://docs.moodle.org/25/en/TeX_filter
http://docs.moodle.org/25/en/DragMath_equation_editor
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1.10.4.5.How can we share resources with 
Moodle? 
 Moodle offers a number of ways to share content: making files and 

folders available to course participants, collecting resources of any kind 

with a Database, attaching files to Forum posts, importing and linking 

resources to and from external repositories/portfolios ... and more! 

1.10.4.6.How can Moodle help people 
collaborate? 
 Moodle offers a number of ways to share content: making files and 

folders available to course participants, collecting resources of any kind 

with a Database, attaching files to Forum posts, importing and linking 

resources to and from external repositories/portfolios ... and more! 

 

1.10.4.7.How do I grade in Moodle? 
 Grades can be created for each activity in a course which are then added 

to the Gradebook. For example, grades in Assignment (all types), Quiz 

and Workshop activities are automatically added to Gradebook. In some 

activities you will have to turn grading on, such as ratings 'on' in Forum, 

Glossary and Database to send them to the Gradebook. You can also 

use the gradebook to adjust, assign or automatically scale an activity 

grade in your course. For some activities which don't automatically link 

to the gradebook, such as Chat or Feedback, you have to create a 

newgrade item manually. There are many ways you can give feedback 

to students on their progress in activities without giving them a grade. 

In Assignments for example, you can give written feedback. 

 

 

 

1.10.4.8.Can students do self and peer 
assessment type tasks with Moodle? 
 Yes. Probably the best activity to do that is Workshop module. 

Informally, students can evaluate (and even rate) each others' Forum 

posts, Glossary entries, and Database entries. 

1.10.4.9.Is 'social constructionist' approach 
necessary when using Moodle? 
 Moodle has continuously been built with a particular, social 

constructionist philosophy in mind. 

1.10.4.5.Как можно совместно с Moodle пользоваться 
ресурсами? 
 Moodle предлагает ряд способов совместного использование содержимого: создание 

Файлов и Папок, доступных любым участникам Курса, сбором Ресурсов любого типа в 

Базе Данных, присоединением Файлов к корреспонденции Форумов, экспортом и 

импортом Ресурсов из внешних Репозиториев/Портфелей, и ещё много чего! 

1.10.4.6.Как Moodle может помочь людям 
сотрудничать? 
 Используйте различные Интерактивные Действия, подобные Вики (п. 4.3.13), чтобы 

создавать содержимое вместе, Форумы (п. 4.3.7) и Комментарии (п. 3.17.2) для обмена 

идеями, Базы Данных (п. 4.3.4) для коллективного накопления ресурсов, Глоссарии (п. 

4.3.8) для совместного понимания концепций и т.д.! Вы можете распределить студентов 

по Группам (п. 4.8) для совместной работы в одном из Интерактивных Действий. 

1.10.4.7.Как оценивать в Moodle? 
 Оценки (п. 6.2) могут создаваться для каждого Интерактивного Действия (п. 4.3) в 

Курсе (п. 4.1), и затем поступать в Журнал Оценок (п. 6.2.1). Например, Оценки по 

Заданиям (всех типов), Интерактивным Действиям «Экзамен» и «Семинар» 

автоматически добавляются в Журнал Оценок. В некоторых Интерактивных Действиях 

вы должны включить оценивание, такое как Рейтинги «на» в Форумах, Глоссариях и 

Базах Данных, чтобы отослать их в Журнал Оценок. Вы можете также использовать 

Журнал Оценок, чтобы скорректировать, назначить или автоматически определить по 

Шкале Оценку Интерактивного Действия в вашем Курсе. Для некоторых 

Интерактивных Действий, которые автоматически не связываются с Журналом Оценок, 

таких как Чат (п. 4.3.2) или Обратная Связь (п. 4.3.6), вы должны создать новый 

Элемент Оценивания вручную. Существует много способов того, как можно дать 

студентам Обратную Связь на их движение по выполнению Интерактивных Действиям, 

не ставя Оценки. В Заданиях, например, вы можете предоставить свою письменную 

Обратную Связь (п. 4.3.1). 

1.10.4.8.Могут ли в Moodle Студенты сами оценивать 
какие-то типы задач или оцениваться сокурсниками? 
 Да. Возможно, что лучше всего это делать с модулем «Семинар» (п. 4.3.14). Студенты 

могут неформально оценивать (и даже упорядочивать по качеству) все 

корреспонденции в Форумах, вводимые в Глоссарии и Базы Данных записи. 

1.10.4.9.Обязателен ли подход «социального 
конструкциониста» при использовании Moodle? 
 Продолжительное время Moodle создавался с позиций специфической, социально 

конструкционистской философии (п. 1.1). 
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This of course does not prevent people from using Moodle in line with 

their own preferred view of learning and the purpose they use it for. 

1.10.5.Students 
1.10.5.1.How long does it take students to 
learn to use Moodle? 
 It really does not take a great deal of skill or computer knowledge to use 

Moodle. With basic web browsing and editing skills, students (and 

teachers) can use Moodle - instantly! 

1.10.5.2.What do my students need to know 
before using Moodle? 
 They need to know how login into the site and course, and have some 

basic web browsing and computer skills. For example, they need to how 

a mouse and keyboard works, what a link is, maybe how to attach, 

upload or download a file. 

1.10.5.3.Do students have to be online all the 
time to use Moodle? 
 Moodle is an online learning management system and at some point 

you and your students will have to spend some time in front of a 

computer. How much time depends on what you use Moodle for. Most 

Moodle sites are used to mix offline and online learning activities. 

1.10.6.Getting help 
1.10.6.1.Is there an official support desk for 
Moodle? 
 Yes and no. Moodle.org forums can serve as a support desk. Moodle 

Partners may charge for support desk as part of their service. Often, like 

the higher priced LMSs, a school or consortium will maintain a help 

desk. 

 

1.10.6.2.What do I do if I am stuck? Are there 
any good tutorials around? 
 Get some help at Moodle.org in a forum or search the Moodle 

documentation There are also many books and manual savailable for 

purchase. 

 

 

Конечно, это никому не мешает использовать Moodle в соответствии с предпочитаемой 

им точкой зрения на обучение. 

1.10.5.Студенты 
1.10.5.1.Сколько времени требуется Студентам, 
чтобы научиться пользоваться Moodle? 
 На самом деле для использования Moodle не требуется особых навыков или 

компьютерных знаний. С базовыми навыками веб-поиска и редактирования Студенты 

(и Преподаватели) могут использовать Moodle – немедленно! 

1.10.5.2.Что требуется знать Студентам, прежде чем 
использовать Moodle? 
 Им необходимо знать, как войти на Сайт и в Курс, иметь некоторые навыки веб поиска 

и работы с компьютером. Например, им требуется знать, как работают мышка и 

клавиатура, что такое ссылка и, может быть, как присоединять, загружать или 

скачивать файл. 

1.10.5.3.Должны ли Студенты всё время находиться в 
онлайн при использовании Moodle? 
 Moodle является онлайн-системой управления обучением, и иногда вы и ваши 

Студенты должны будете проводить время перед компьютером. Как долго – зависит от 

того, для чего вы используете систему Moodle. Большинство Сайтов Moodle 

используется для совмещения офлайн и онлайн деятельности по обучению. 

1.10.6.Получение помощи 
1.10.6.1.Существует ли официальный стенд для 
поддержки Moodle?  
 И да, и нет. Форумы Moodle.org могут служить в качестве стенда поддержки. 

Партнёрам Moodle можно поручить стенд поддержки как часть их сервиса. Зачастую, 

подобно высоко ценимым системам локального управления школами (LMS), школы и 

консорциумы поддерживают стенд помощи. 

1.10.6.2.Что делать, если я застрял? Есть ли какие-
нибудь хорошие наставления? 
 Получите некоторую помощь с Сайта Moodle.org на форуме или ищите в 

документации. Имеется также множество доступных для приобретения книг и 

руководств. 

http://docs.moodle.org/25/en/Moodle_Partners
http://moodle.org/forums/
http://docs.moodle.org/25/en/Main_Page
http://moodle.org/mod/data/view.php?id=7246
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1.10.6.3.What if I have a specific question 
about a tool, where can I find out more? 
 Research it in Moodle documentation by using the search box on the 

left of every page in Moodle Docs. Click on a help icon on your 

Moodle site. Go to a forum dedicated to that tool. Research it by using 

the Search moodle.org box at the top of this page. 

1.10.6.4.How can I suggest improvements and 
put forward what I would like to see in 
Moodle? 
 Moodle Tracker is by far THE best place to suggest improvement. File 

an issue or suggest improvement there, and let people know in a forum 

about your ideas. Maybe they will vote for it (which tends to get 

people's attention). 

1.10.6.5.Where can I get training on how to 
use Moodle? 
 A number of places offer training in how best to use Moodle. However, 

Moodle Partners know Moodle best and can provide official training. 

You can also think of doing the Moodle Course Creator Certificate to 

improve your skills. 

1.10.7.Basic Moodle jargon 
 Moodle uses jargon words that you may be familiar with from other, 

non-Moodle contexts. Within Moodle, These words have specific (and 

potentially different) meanings, explained below. 

1.10.7.1.What is a Course? 
 A course is the basic learning area on Moodle where a teacher displays 

materials for their students. See Courses. 

1.10.7.2.What is a Category? 
 A category is a group of things and has several meanings in Moodle. It 

can be a grouping of courses by a certain criteria (Such as: Science; 

Junior School; Staff Area). It can be a group of questions, or a group of 

entries in a glossary. 

1.10.7.3.What is an Activity? 
 Usually an activity is something that a student will do that interacts with 

other students and or the teacher. Moodle has over a dozen activity 

types of tools for a teacher to use in a course. 

 

1.10.6.3.Что если у меня возник специфический вопрос 
по инструменту, где я могу найти ответ? 
 Поищите ответ в документации Moodle, используя окошко поиска слева на каждой 

странице документации Moodle. Щёлкните иконку помощи на вашем Сайте Moodle. 

Перейдите на предназначенный для этого инструмента форум. Исследуйте его через 

окошко Search (искать) на Сайте moodle.org вверху этой страницы. 

1.10.6.4.Как я могу предложить улучшения и высказать 
пожелания о разработке чего-то ещё в системе 
Moodle? 
 Moodle Tracker (Средство Отслеживания Moodle – http://tracker.moodle.org/) является 

самым замечательным местом для предложения улучшений. Зарегистрируйте вопрос 

или предложение по улучшению, и пусть люди на форуме узнают о ваших идеях. 

Может быть, они проголосуют за это (что привлечёт внимание многих). 

1.10.6.5.Где можно пройти тренинг по использованию 
Moodle? 
 Ряд мест предлагают тренинги по лучшему использованию Moodle. Однако, 

партнёры Moodle знают эту Систему лучше и могут обеспечить официальные тренинги. 

Вы можете также подумать о получении Сертификата Создателя Курсов Moodle для 

улучшения своих навыков. 

1.10.7.Основной жаргон Moodle 
 Moodle использует жаргонные слова, которые могут быть вам знакомы из других, не 

Moodle-контекстов. Внутри Moodle эти слова имеют специфические (и возможно 

отличающиеся) значения, объясняемые ниже. 

1.10.7.1.Что такое Курс? 
 Курс – это основная обучающая область в Moodle, где преподаватель представляет 

материалы своим студентам. См. п.4.1. 

1.10.7.2.Что такое Категория? 
 Категория – это группа чего-то, и имеет в Moodle несколько значений. Она может быть 

Категорией Курсов (п. 4.1.2), отобранных по определённому критерию (такому как 

наука, начальная школа, область преподавательского состава). Она может быть группой 

Вопросов (п. 4.6) или группой записей в Глоссарии(п. 4.3.8). 

1.10.7.3.Что такое Интерактивное Действие? 
 Обычно, Интерактивное Действие (п. 4.3) является тем, что Студент будет делать, 

взаимодействуя с другими Студентами или Преподавателем. В Moodle имеется более 

дюжины типов Интерактивных Действий для использования Преподавателем в Курсе. 

http://moodle.org/forums/
http://tracker.moodle.org/
http://docs.moodle.org/25/en/Moodle_Partners
http://moodle.org/course/view.php?id=48
http://docs.moodle.org/25/en/Category
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1.10.7.4.What is a Resource? 
 Resources are items that a teacher can use to support learning, such as a 

file or a link. A standard Moodle comes with 6 resource types that can 

be added to a course. 

1.10.7.5.What is a Block? 
 Typically, blocks are items which may be added to the left or right in a 

course's home page. There are dozens of different blocks that can be 

added to a course, or pages within a course. 

1.10.7.6.What is a Plugin? 
 Plugin is an optional extra component which can add functionality to 

your Moodle. Some standard Moodle plugins need to be turned on by 

Moodle Administrator. Many more can be downloaded from the 

Modules and Plugins database. 

1.10.7.7.What is a Filter? 
 Filters can be used to add links, insert multimedia players, convert 

Mathematical expressions or emoticons into displayed images. 

 

1.10.7.8.What is a Section? 
 A section is an area within a course's homepage that hold activities and 

resources. Standard course section formats are topics, weeks, social and 

SCORM. 

1.10.7.9.What is a Role? 
 A role in Moodle refers to what a user is allowed (or not) to do on a 

Moodle site. Typical roles might include those of a student and teacher. 

A role is a collection of permissions that can be assigned to specific 

users in specific contexts. For example, when a user is enrolled in a 

course as a student. 

1.10.8.Security 
1.10.8.1.How secure is Moodle? 
 Moodle is designed to be very secure. However, a lot depends upon the 

webserver, the way Moodle is setup and regular updates of the package 

by the Moodle Administrator. 

1.10.8.2.Can Moodle get hacked into and 
student data stolen? 
 Highly unlikely if your Moodle site has up-to-date security and the site 

administrator has not given away the keys. Anything is possible on any 

website, but Moodle makes it difficult for nasty people to cause havoc. 

1.10.7.4.Что такое Ресурс? 
 Ресурсы (п. 4.4) являются элементами, которые Преподаватель может использовать для 

поддержки обучения, такими как Файл или Ссылка. Стандартный Moodle поставляется 

с 6 типами Ресурсов, которые могут быть добавлены в Курс. 

1.10.7.5.Что такое Блок? 
 Обычно, Блоки (п. 4.5) являются элементами, которые могут быть добавлены слева или 

справа на Домашнюю Страницу Курса. Существуют десятки различных Блоков, 

которые могут быть добавлены в Курс или на Страницы внутри Курса. 

1.10.7.6.Что такое Плагин? 
 Плагин является дополнительной компонентой по выбору, которая может добавить 

функциональности вашей Moodle. Некоторые стандартные Плагины Moodle требуют 

быть включенными Администратором Moodle. Много других могут быть скачаны из 

базы данных. 

1.10.7.7.Что такое Фильтр? 
 Фильтры (п. 5.5) могут использоваться для добавления ссылок, вставки проигрывателей 

мультимедиа, конвертации математических выражений или картинок, выражающих 

эмоции (смайликов), в отображаемое изображение. 

1.10.7.8.Что такое Раздел? 
 Раздел – область внутри Домашней Страницы (п. 4.1.5), которая содержит 

Интерактивные Действия и Ресурсы. Стандартными форматами Разделов Курса 

(п. 4.1.4.1.) являются Темы, Недели, Социальный и SCORM. 

1.10.7.9.Что такое Роль? 
 Роль в Moodle относится к тому, что пользователю разрешено (или нет) делать на Сайте 

Moodle. К Типичным Ролям (п. 3.4.5) относятся Роли Студента и Преподавателя. Роль – 

это коллекция Полномочий (п. 3.4), которые могут быть предоставлены конкретным 

пользователям в конкретных Контекстах (п. 6.3). Например, когда пользователь 

зачисляется на Курс в качестве Студента. 

1.10.8.Безопасность 
1.10.8.1.Насколько безопасна Moodle? 
 Moodle сконструирована так, чтобы оставаться очень безопасной. Однако многое 

зависит от веб сервера, способа установки Moodle и регулярности обновлений пакетов 

Администратором Moodle. 

1.10.8.2.Может Moodle подвергнуться хакерской атаке 
и похищению данных студентов? 
 Крайне невероятно, если ваш Сайт имеет современные средства безопасности, а 

Администратор Сайта не раздаёт ключи доступа. На любом Сайте может произойти 

всё, что угодно, но Moodle затрудняет нехорошим людям творить хаос. 

https://moodle.org/plugins/index.php
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1.10.8.3.What if I did something wrong and 
accidentally broke it - could it be easily fixed? 
 
 Moodle can be backed-up at any point. If a backup was made 5 minutes 

before you broke it, chances are it can be fixed easily. 

1.10.8.4.Is my student data safe on a cheap or 
free webhost? 
 While you do have some control of the security of a Moodle site on a 

free or cheap web host, the question is: How much do you trust your 

web host? 

1.10.8.5.Can I track and search what people do 
and post in Moodle? 
 Assuming you are a teacher and it is your course, yes. Moodle Admin 

can do that for the entire site. 

1.10.8.6.Can I backup Moodle so I don't lose 
things? 
 Yes, you can backup a Moodle site or as a teacher you can back up your 

course and download it (if your role permits it). With appropriate 

permissions, you can restore your course and/or import parts of courses 

elsewhere on your site or beyond. This can be particularly useful with 

Community Hubs (Moodle 2.0 feature). 

1.10.9.Technical 
1.10.9.1.Do I need my own server to run 
Moodle? 
 Moodle needs a web server. There are lots of options. See Moodle 

Partners, Complete install packages for Windows and Installation FAQ. 

 

 

 

 

 

 

 

 

 

1.10.8.3.Что если я сделаю что-то неправильно и 
случайно разрушу что-то – можно ли это легко 
восстановить? 
 В Moodle можно делать резервные копии в любой момент. Если копия была сделана за 

5 минут до разрушения, велики шансы легко всё восстановить. 

1.10.8.4.В безопасности ли данные моих студентов на 
недорогом или бесплатном веб сервере? 
 Когда вы осуществляете некоторый контроль безопасности Сайта Moodle на 

бесплатном или недорогом веб сервере, есть вопрос: Насколько вы доверяете вашему 

веб-серверу? 

1.10.8.5.Можно ли отслеживать и отыскивать, что 
люди делают и рассылают в Moodle? 
 Да, если вы – Преподаватель и это ваш Курс. Администратор Moodle может делать это 

по всему Сайту. 

1.10.8.6.Могу ли я сделать резервную копию Moodle, 
чтобы ничего не потерять? 
 Да, вы можете сделать резервную копию Сайта Moodle или как преподаватель вы 

можете сделать резервную копию вашего Курса и загрузить её (если ваша Роль 

допускает это). С подходящими полномочиями вы можете восстановить ваш Курс 

и/или импортировать части чужих Курсов на ваш Сайт или за его пределы. Это может 

быть особенно полезно в работе с хабами сообщества (возможности Moodle 2.0). 

1.10.9.Технические вопросы по работе с Moodle 
1.10.9.1.Нужен ли мне собственный сервер для запуска 
Moodle? 
Moodle нуждается в веб-сервере. Существует множество вариантов. См. партнёры Moodle, 

завершённые пакеты инсталляции для Windows и часто задаваемые вопросы по 

инсталляции

http://docs.moodle.org/25/en/Community_hub
http://docs.moodle.org/25/en/Moodle_Partners
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows
http://docs.moodle.org/25/en/Installation_FAQ
http://docs.moodle.org/25/en/Installation_FAQ
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1.10.9.2.Do I have to install Moodle myself? 
 You can, guidance provided. Most organisations will have a policy on 

this and/or someone to perform the installation. 

1.10.9.3.Can I customise a theme and make it 
about our school? 
 Yes, see Themes. You can customise themes down to a single course. 

There are many ways to make Moodle looks great too. 

1.10.9.4.Does it matter what computer type or 
browser I use for Moodle? 
 Moodle works well in all standard, modern browsers and different 

operating systems. As with any web based application, you should be 

aware of your audience, their typical bandwidth and web browsers. 

1.10.9.5.Can you use Moodle from anywhere? 
 Yes, if it is on a web server attached to the internet and you have a 

computer, mobile device or tablet. Or if it is on a web server attached to 

the same intranet (internal network) as a computers or tablets which 

need to work it. And you can even put Moodle on a USB drive. 

1.10.9.6.Can access to Moodle be restricted to 
just our school? 
 Yes, several ways to do this. For example, it can be installed on your 

schools internal network, or limit the IPs to those assigned by your 

school, or only manually enroll your students are just a few ways. 

 

1.10.9.7.Can I access Moodle from a mobile 
device? 
 Yes. In Moodle 2.1 you use the Mobile app for iPhone. You can set one 

theme as the default but also set another theme for a mobile device and 

a different one for a tablet. 

1.10.9.8.I've come from a school that used a 
different VLE/LMS. Can I move my stuff over 
to Moodle? 
 Sure. Some VLE/LMS-specific activities may (not) be compatible, but 

you can zip your content files and unzip them in Moodle. 

 

 

1.10.9.2.Должен ли я установить Moodle сам? 
 Вы можете, руководство предоставлено. Политика большинства организаций 

нацелена на это и/или на то, что кто-то выполнит инсталляцию. 

1.10.9.3.Могу ли я настроить Тему о нашей школе? 
 
 Да, см. Темы фона. Вы можете делать темы в соответствии с потребностями отдельного 

Курса. Существует множество способов сделать так, чтобы Moodle хорошо выглядела. 

1.10.9.4.Имеет ли значение, какой компьютер или 
браузер я использую для Moodle? 
 Moodle хорошо работает во всех стандартных современных браузерах и в различных 

операционных системах. Как и с любым веб приложением вы должны учитывать, 

какова ваша аудитория, каковы пропускная способность и веб браузеры. 

1.10.9.5.Можно ли использовать Moodle откуда угодно 
 Да, если это веб сервер, присоединённый к интернету, и вы имеете компьютер, 

мобильное устройство или планшет. Или если это веб сервер, присоединённый к тому 

же самому интранету (внутренняя сеть), что и компьютеры или планшеты, с которыми 

вы собираетесь работать. Вы можете даже установить Moodle на устройство USB. 

1.10.9.6.Можно ли ограничить доступ к Moodle только 
нашей школой 
 Да, существует несколько способов сделать это. Например, Система может быть 

инсталлирована в вашей внутренней сети школ, или ограничена теми IP-адресами, 

которые назначены вашей школой, или зачислением ваших студентов только вручную, 

и это не все способы. 

1.10.9.7.Могу ли я работать в Moodle с мобильного 
устройства? 
 Да, в Moodle 2.1 вы используете приложение Mobile для iPhone. Вы можете установить 

одну Тему (п. 3.8.6) по умолчанию, но также установить другую Тему для мобильного 

устройства, и ещё одну – для планшета. 

1.10.9.8.Я из школы, в которой используются 
различные среды и системы обучения. Могу ли я 
переслать мои материалы в Moodle? 
 Несомненно. Некоторые специфические действия в средах и системах обучения могут 

(не) быть совместимы, но вы можете заархивировать ваш контент в zip-файл и 

разархивировать его в Moodle. 

http://docs.moodle.org/25/en/Themeshttp:/docs.moodle.org/25/en/Themes
http://docs.moodle.org/25/en/Mobile_app
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1.10.9.9.I spotted a bug in the system. What 
do I do? 
 Go to Tracker, search if the bug has already been reported and create a 

new issue if not. 

1. 10.9.10.I have an idea for a feature and/or 
improvement in Moodle. What do I do? 
 Go to Tracker, search if something like your idea has already been 

noted and worked on and suggest it if not. 

1.10.10.Cost 
1.10.10.1.How much does it cost to download 
and use Moodle? 
 By way of its GNU General Public License, Moodle is and will remain 

free to download and use in any way you like. Consider it free like a 

'free puppy' that needs care and attention to grow, not free like a 'free 

beer'. 

1.10.10.2.How much does it cost to run 
Moodle? 
 Nothing to install, use and change. Of course, there are some associated 

costs if you have your Moodle hosted with someone, and costs 

associated with maintenance and training in an organisation (like any 

other software...). But no royalties, fees or user charges. 

 

1.10.10.3.How much does it cost to have 
Moodle hosted? 
 There are many options for hosting. Cost is usually related to services 

provided and capacity (eg. a university site with 10 000 users will 

naturally cost more to host and maintain than a small community 

school). Ask your local Moodle Partner and keep Moodle going that 

way too! 

1.10.11.See also 
 Case for Moodle 

 Decision FAQ 

 

 

 

 

1.10.9.9.Я обнаружил ошибку в Системе. Что мне 
делать? 
 Перейти в Средство Слежения, поискать, а нет ли там сообщения об этой ошибке, а 

если нет, создать новый пункт в нём. 

1.10.9.10.У меня появилась идея о новой возможности 
и/или улучшении Moodle. Что мне делать? 
 Перейти в Средство Слежения), поискать, вдруг нечто похожее на вашу идею уже 

замечено и сделано, и предложить её, если нет. 

1.10.10.Стоимость 
1.10.10.1.Сколько нужно заплатить, чтобы загрузить 
и использовать Moodle? 
 По лицензии GNU Moodle есть и останется бесплатной для скачивания и использования 

любыми предпочитаемыми вами способами. Рассматривайте её похожей на 

«бесплатного щенка», которому нужно внимание и уход для его роста, а не подобной 

«бесплатному пиву». 

1.10.10.2.Сколько стоит эксплуатация Moodle? 
 
 Нисколько: инсталляция, использование и изменения – бесплатны. Конечно, 

существуют некоторые сопутствующие затраты, если вы устанавливаете Moodle у кого-

то, и затраты, связанные с. поддержкой и обучением в другой организации (как с 

любым другим программным обеспечением…). А разработчикам Moodle никаких 

выплат не требуется. 

1.10.10.3.Сколько стоит иметь собственную Moodle? 
 
 Существует много вариантов установки. Стоимость обычно зависит от 

предоставляемого сервиса и мощности (например, установка и содержание 

университетского Сайта с 10 000 пользователей, естественно, стоят больше, чем для 

маленькой муниципальной школы). Спросите вашего местного партнёра Moodle и 

примените к Moodle этот же способ! 

1.10.11.См. также 
 Вариант для Moodle. 

 Часто задаваемые вопросы о Решениях. 

 

http://docs.moodle.org/25/en/Tracker
http://docs.moodle.org/25/en/Tracker
http://docs.moodle.org/dev/License
http://docs.moodle.org/25/en/Moodle_Partners
http://docs.moodle.org/25/en/Case_for_Moodle
http://docs.moodle.org/25/en/Decision_FAQ
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Обычно официальную англоязычную документацию, относящуюся к инсталляции того или иного программного обеспечения, переводить 

не принято. Системные Администраторы – люди весьма компетентные – читают, что называется «с листа». Но система Moodle 2.5 – случай 

особый. В комплект её поставки входят, так называемые, «Полностью Завершённые Пакеты Инсталляции», в том числе, и для операционной 

системы Windows. Нужны они, прежде всего, для разработчиков Moodle, которые разбросаны по всему миру, но можно использовать эти пакеты 

и обычному Преподавателю у себя на домашнем компьютере для отработки учебных Курсов в системе Moodle, прежде чем устанавливать его на 

сервере учреждения для эксплуатации. Ниже приводится перевод небольшой части документации по инсталляции Moodle, которая будет полезна 

именно Преподавателям, использующим возможности Moodle для создания Курсов по своим предметам и проведения занятий со Студентами. 

Современные Студенты, в основном, являются весьма продвинутыми пользователями разного рода программных систем, следовательно, и 

Студенты могут установить у себя на личных компьютерах эту замечательную бесплатно распространяемую Систему, где по-своему смогут 

проигрывать предлагаемые учебные Курсы, да и составлять свои. 

 

 

 

 

 

 

 

 

 

 

 

 Перевод на русский язык  В.А. Тунда, Ф.П. Тарасенко, 2013 
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2.INSTALLATION 
2.1.Installation 

If you are installing a new Moodle site, start here: 

2.1.1.Installation Quickstart 
For experts and the impatient. 

This page is intended for administrators who are experienced with 

installing web server applications and are in a hurry to get up and running. 

Otherwise please see Installing Moodle. 

2.1.2.Installing Moodle 
For everyone else 

This page explains how to install Moodle. If you are an expert and/or in a 

hurry try Installation Quickstart. 

If you just want to try Moodle on a standalone machine there are 'one-click' 

installers for Windows (see Complete install packages for Windows). 

These are unsuitable for production servers. 

2.1.2.1.Complete install packages for 
Windows 
Complete install packages are available from Moodle.org's Windows 

download page. The packages are designed for new installations on a 

standalone computer. The complete install package can be used on a 

server, but it is not recommended that it be used as a production site. 

Please note Moodle.org's Standard install packages only contain the 

Moodle code. 

This document provides instructions for using the Windows packages. 

The complete install packages allow Moodle to be installed, along with the 

prerequisites that includes a web server, Apache, database, MySQL, 

scripting language, PHP, an administration tool, phpMyAdmin and Moodle 

all wrapped in the Xampp-lite shell. Several versions of the complete 

install package are available. The instructions on the download page 

provide guidance on which version is likely to be most suitable. 

In short, complete install packages are designed to create a matched 

webserver and Moodle site on a standalone computer with minimal effort. 

 

 

 

 

 

 

2.ИНСТАЛЛЯЦИЯ 
2.1.Инсталляция 

Если вы инсталлируете новый сайт Moodle, начинайте отсюда: 

2.1.1.Инсталляция. Быстрый старт 
Для опытных и нетерпеливых 

Эта страница предназначена для Администраторов, которые имеют опыт по 

установке веб-серверных приложений и очень спешат установить и запустить систему (см. 

сайт). Другие пользователи, обращайтесь, пожалуйста, к п. 2.1.2 «Инсталляция Moodle». 

2.1.2.Инсталляция Moodle 
Для всех остальных 

Эта страница объясняет, как инсталлировать Moodle. Если вы эксперт и/или 

спешите, обращайтесь к «Инсталляция. Быстрый старт (п. 2.1.1.)». 

Если вы хотите всего лишь установить Moodle на отдельной машине, существуют 

инсталляторы «одним щелчком» для Windows (Завершённые Пакеты Инсталляции для 

Windows – см. п. 2.1.2.1). Они не пригодны для производственных серверов. 

2.1.2.1.Завершённые Пакеты Инсталляции Moodle для 
Windows 

Завершённые Пакеты Инсталляции доступны на странице скачивания Moodle.org 

для Windows. Пакеты разработаны для новых инсталляций на отдельном компьютере. 

Завершённый Пакет Инсталляции может быть использован и на сервере, но это не 

рекомендуется при использовании его в качестве производственного сайта. Пожалуйста, 

имейте в виду, что только Стандартные пакеты инсталляции на сайте Moodle.org содержат 

код Moodle. 

Данный документ предоставляет инструкции для использования пакетов Windows. 

Завершённые Пакеты Инсталляции позволяют установить Moodle вместе с 

необходимыми программами, которые включают веб-сервер, Apache, базу данных, 

MySQL, язык сценариев, PHP, инструмент администратора, phpMyAdmin и Moodle, 

все свёрнутые в оболочку Xampp-lite. Существует несколько версий 

Завершённого Пакета Инсталляции. Инструкции на странице скачивания содержат 

рекомендации о том, какая версия может быть наиболее подходящей. 

Короче говоря, Полный Пакет Инсталляции разработан для удобства создания 

согласованных веб-сервера и сайта Moodle на отдельном компьютере с минимальными 

усилиями. 

http://docs.moodle.org/25/en/Installing_Moodle
http://docs.moodle.org/25/en/Installing_Moodle
http://download.moodle.org/windows
http://download.moodle.org/windows
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2.1.2.1.1.System requirements 
 256 MB RAM (minimum), 512 MB RAM (recommended) 

  

 160 MB free Fixed Disk (more space will be needed depending on user 

uploads) 

 Windows 98/ME (minimum) 

 Windows NT/2000/XP (recommended) 

2.1.2.1.2.Install complete package process 
The complete install package is a zip file that contains a webserver called 

Apache, plus Moodle and Moodle's required MySQL database and PHP 

program. 

There are three basic parts to the this install process. 

1. Download and unpack the complete install package. 

2. Start the webserver. 

3. Install Moodle using a web browser. 

First create file structure 
Download the package 
Download Windows packed-zip file from Moodle. A downloaded 

complete install package Windows 1.9 zip file in Windows Explorer 

Unpack the package 
Unpack (extract files by clicking on) the zip file you downloaded to a drive 

or partition of your choice. The extract process will create three files 

("Start Moodle", "Stop Moodle", and "README") and a subfolder called 

"server". 

Do NOT rename the "server" subfolder 

Note: There will also be a folder under this server subfolder, called 

\moodle that holds the Moodle program. 

TIP: Create a folder and extract the files there. For example, you might 

have one folder called Moodle193 and another one called Moodle187 for 

different versions or purposes. 

TIP: Make path to "server" subfolder simple. Best way if it will be in drive 

root. Like "D:\moodle193\server". A long path, especially with any strange 

symbols, can prevent XAMPP from working properly. 

 

 

 

 

 

 

2.1.2.1.1.Системные требования  
 256 Мб RAM (минимум), 512 Мб RAM (рекомендовано). (Random Access Memories – 

запоминающее устройство с произвольным доступом). 

 160 Мб на жёстком диске (в зависимости от объёмов перекачиваемой пользователями 

информации, может потребоваться и больше памяти). 

 Windows 98/ME (минимальная версия операционной системы). 

 Windows NT/2000/XP (рекомендуемая версия). 

2.1.2.1.2.Процесс Инсталляции Завершённого Пакета 
Завершённый Пакет Инсталляции является zip-файлом, который содержит веб 

сервер, называемый Apache, плюс Moodle и требуемую для Moodle базу данных MySQL, а 

также программу PHP. 

Процесс инсталляции состоит из трёх основных частей: 

1. Скачать и распаковать Полный Пакет Инсталляции. 

2. Стартовать веб-сервер. 

3. Инсталлировать Moodle, используя веб-браузер. 

Во-первых, создайте файловую структуру 
Скачайте пакет 

Скачайте заархивированный zip-файл из Moodle. Скачанный 

Завершённый Пакет Инсталляции для Windows заархивирован последним архиватором zip 

версии 1.9 в Windows Explorer. 

Распакуйте пакет 
Распакуйте (извлечение файлов по щелчку) zip-файл, который скачали, чтобы 

привести в действие или разделить на части. Процесс извлечения создаст три файла («Start 

Moodleм, «Stop Moodle» и «README» – «запустить Moodle», «остановить Moodle» и 

«Прочти меня») и подпапку с именем «server». НЕ ПЕРЕИМЕНОВЫВАЙТЕ папку 

«server». Замечание: Внутри этой подпапки «server» появится папка с именем «\moodle», 

которая содержит программу Moodle. 

Совет: Создайте папку и извлеките туда файлы. Например, вы можете для 

различных версий или целей иметь одну папку, называемую Moodle193, и другую папку, 

называемую, Moodle187. 

Совет: Сделайте путь к подпапке «server» простым. Лучше всего, если это будет в 

корне устройства. Подобно «D:\moodle193\server». Длинный путь, особенно с любыми 

странными символами, может помешать XAMPP работать правильно. 

http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#System_requirements
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#Install_complete_package_process
http://docs.moodle.org/25/en/Apache
http://docs.moodle.org/25/en/MySQL
http://docs.moodle.org/25/en/PHP
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#First_create_file_structure
http://download.moodle.org/windows
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Second – start the webserver 
Now you are ready to start the webserver. Use the "Start Moodle.exe" file 

which you should find in the top directory. Once the "Start Moodle.exe" 

program is open, don't close it; use "Stop Moodle.exe" for that purpose. 

Note: These programs control both Apache and MySQL programs that 

operate the webserver. Some sites will individually start and stop Apache 

and MySQL with the Xampp bat files found in the "server" subfolder. 

 

Tip: Alternatively, on a standalone computer with several potential 

webservers that might be running, you can use the "xampp_restart.exe" file 

in the "server" subfolder. 

Tip: You can also add shortcuts to the commands that start and stop the site 

in your Windows "start" menu. 

Now you are ready to start the Moodle installation. 

Warning: Windows XP requires the msvcr71.dll library file in order to run 

Xampp. Installing the .Net 1.1 framework (not .Net 2.0 and upper) could 

resolve it. You can also search for the file on Google, download it and 

copy it into the server/apache/bin folder. 

Third – start Moodle installation 
Start your web browser and type localhost, or http://127.0.0.1 or 

http://localhost in the address bar. You will either start your first time 

Moodle installation or if it is already installed you will enter the Moodle 

site's Front Page or Login screen. 

A browser's addressbar showing "localhost". Click on the green Goto 

arrow will go to the installed Moodle site. 

Tip: After Moodle installs, put the site in your "favorites" or as a 

"bookmark" in you browser. 

Set language 
The initial install page will be displayed after you type "localhost". 

 

Set initial language 
Choose your preferred language (English is used in this example) and click 

the “Next” button. 

Diagnostic results 
A diagnostic report is displayed – hopefully it will look like this, if not you 

may need to address some issues. 

 Click the “Next” button to continue. 

 

 

 

Во-вторых, запустите веб-сервер 
Теперь вы готовы запустить веб-сервер. Используйте файл «Start Moodle.exe», 

который вы можете найти вверху оглавления. После запуска программы «Start 

Moodle.exe» не закрывайте её. Используйте для этой цели «Stop Moodle.exe». 

Замечание: Эти программы управляют программами Apache и MySQL, которые 

приводят в действие веб-сервер. Некоторые сайты в индивидуальном порядке запускают и 

останавливают Apache и MySQL с командными файлами Xampp, которые находятся в 

подпапке «server». 

Совет: Альтернативно, на отдельном компьютере с несколькими возможными 

веб-серверами, которые могут быть запущены, вы можете использовать файл 

«xampp_restart.exe» в подпапке «server». 

Совет: Вы можете также добавить ярлыки быстрого вызова к командам, которые 

запускают и останавливают сайт в вашем меню «Старт» системы Windows. 

Теперь вы готовы начать инсталляцию Moodle. 

Предупреждение: Windows XP требует файл из библиотеки «msvcr71.dll», для того 

чтобы запустить Xampp. Инсталляция .Net 1.1 framework – (НЕ .Net 2.0 и выше!) может 

решить эту проблему. Вы также можете отыскать этот файл в Google, скачать его и 

скопировать в папку «server/apache/bin». 

В-третьих, запустите инсталляцию Moodle 
Запустите ваш веб-браузер и напечатайте localhost или http://127.0.0.1, или 

http://localhost в его адресной строке. Вы либо запускаете инсталляцию вашей Moodle 

первый раз, либо, если она уже установлена, вы входите через Главную страницу сайта 

Moodle или экрана регистрации. 

Адресная строка браузера, показывающая «localhost». Щёлкните по зелёной 

стрелке Перейти, которая приведёт вас к инсталлированному Сайту Moodle. 

Совет: После инсталляции Moodle поместите этот сайт в «Любимые» или в 

«Закладки» вашего браузера. 

Установите язык 
После того, как вы наберёте в адресном окне браузера «localhost», отобразится 

начальная страница инсталляции. 

Установите начальный язык 
Выберите предпочитаемый вами язык (в этом примере использован English 

(английский)) и щёлкните кнопку «Next (далее)». 

Результаты диагностики 
Отобразится диагностический отчёт – он должен выглядеть как на картинке. Если 

это не произойдёт, вам потребуется решить некоторые проблемы. 

 Щёлкните кнопку «Next», чтобы продолжить. 

http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#Second_-_start_the_webserver
http://www.microsoft.com/downloads/details.aspx?familyid=262D25E3-F589-4842-8157-034D1E7CF3A3&displaylang=en
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#Third_-_start_Moodle_installation
http://docs.moodle.org/25/en/File:C_Install_Windows_1.png
http://docs.moodle.org/25/en/File:Complete_Windows_Install_2.png
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Moodle paths 
The paths for your Moodle installation are shown – if you are only using 

this as a local testing server, accept the ones that are shown on your screen. 

 

What you enter in the "Web Address" field depends on what you intend to 

use the new Moodle installation for. If you are just going to use it for local 

testing, then use 'http://localhost'. If you are going to test the new 

installation on a LAN, and will be accessing it from other machines on that 

LAN, then put the private IP address or network name of the serving 

machine, followed by a forward slash and moodle: Web Address - 

http://192.168.1.1/moodle If you are going to test the installation on the 

internet, then you will need to put the public ip address followed by a 

forward slash and moodle: http://your_ip_address/moodle or you can put 

your domain name here instead. 

 Click the “Next” button to continue. 

Database configuration 
In the next fields, we enter the database settings. The fields are populated 

with some suggested values. 

We strongly recommend you place a user name and password in this 

screen. (Don't forget them). 

Do not use the “root” user without a password for production installations 

as this creates a security vulnerability 

Screenshot «Installation's database settings». 

When the fields have been populated, click the “Next” button to continue. 

Check server 
The install process checks the server it installed. 

Screenshot «Check server environment screen». 

Click the “Next” button to continue. 

Confirm initial language pack 
Moodle will now check to see if the language pack is available for the 

language you selected at the first step. If it is not, Moodle will continue 

with the install in English. 

Screenshot «Language pack check». 

Confirm config.php 
Provided the Moodle folder is writable, a message confirming the 

configuration has been completed will be displayed. 

Screenshot «Confirmation that config.php has been created». 

Click the “Continue” button to proceed. 

 

 

Пути Moodle 
Это опция показывает пути для инсталляции вашей Moodle – если вы используете 

её только как локальный тестирующий сервер, примите один из путей, показанных на 

экране. 

То, что вы введёте в поле «Web Address» зависит от того, как вы намерены 

использовать новую инсталляцию Moodle. Если вы собираетесь использовать её лишь как 

локальную пробную, тогда используйте «http://localhost». Если вы собираетесь испытать 

новую инсталляцию в локальной сети LAN (Local Area Network) и будете связывать её с 

другими машинами этой LAN, тогда поместите персональный IP адрес или имя сети 

серверной машины, затем /moodle: Web Address – http://192.168.1.1/moodle. Если вы 

собираетесь попробовать инсталляцию в интернете, тогда вам нужно поместить 

публичный IP адрес, затем /moodle: http://your_ip_address/moodle, либо вместо него 

можете поместить имя вашего домена. 

 

 Щёлкните кнопку «Next», чтобы продолжить. 

Конфигурация базы данных 
В следующие поля мы вводим настройки базы данных. Поля заполняются 

некоторыми предлагаемыми значениями. 

Мы настоятельно рекомендуем вам разместить имя пользователя и пароль на этом 

экране. (Не забудьте их). 

Не используйте имя пользователя «root» без пароля для производственных 

инсталляций, так как это создаёт уязвимость системы безопасности. 

Снимок с экрана: «Инсталляционные настройки базы данных». 

Когда поля заполнены, щёлкните кнопку «Next», чтобы продолжить. 

Проверьте сервер 
Процесс инсталляции проверяет, как установлен сервер. 

Снимок с экрана: «Проверьте экран окружающей среды сервера». 

Щёлкните кнопку «Next», чтобы продолжить. 

Подтвердите первоначальный Языковый Пакет 
Теперь Moodle проверит, имеется ли Языковой Пакет для языка, который вы 

выбрали на первом шаге. Если нет, Moodle продолжит инсталляцию на английском языке. 

 

Снимок с экрана: «Проверка Языкового Пакета». 

Подтвердите config.php 
Если Moodle обеспечена возможностью записи в папку, отображается сообщение, 

подтверждающее, что конфигурация завершена. 

Снимок с экрана: «Подтверждение того, что config.php создан». 

Щёлкните кнопку «Continue», чтобы продолжать. 

http://192.168.1.1/moodle
http://your_ip_address/moodle
http://docs.moodle.org/25/en/File:Complete_install_Windows_3.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_4.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_5.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_6.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_6.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_7.png
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Moodle copyright & agreement 
The Moodle copyright / license notices are displayed. 

Screenshot «Copyright notice and agreement». 

Current release and unattended option 
The current release information is shown. Check off the unattended 

operations box. This will automatically advance through many screens. If 

you would like to watch the install screen by screen, do not check this box 

and be prepared to press the "continute button" many times. 

Click the "Continue" button and wait. 

Screenshot «Current release and "unattended" check box». 

 

Installation modules and blocks screens 
In most cases this will be followed by a series of screens that have a 

continue button on the bottom. This process stops with Admin user profile 

settings which needs to be filled out. 

Administrator user profile 
Screenshot «The administrator's users profile screen». 

Fill out the required fields. 

Click on "Save" to continue 

Front page settings 
The next screen is the Front Page settings page. There are two parts to it. 

The first part will ask for your Full site name and a short name for the 

navigation bar. There is also a place for a description. You can change 

these later. 

Screenshot «The Moodle sites Front Page information». 

The second part on the bottom instructs Moodle if you will disable the new 

user self authentication through email process. The default is to disable. 

This can be changed later in the site administration block. 

Screenshot. 

Determine if users can create their own profiles when they log onto the 

side via email self authentication 

Click on "Save changes" button to go to Moodle sites home page. 

 

Moodle on 
Now you are ready to Moodle! 

Screenshot «Blank Front page of your new site». 

The Site Administration block is on the left, the "Turn edit on" button in 

the upper right corner, withe the site description block just below it. 

 

 

Копирайт и соглашение Moodle 
Отображаются сертификаты авторского права и лицензии. 

Снимок с экрана: «Сертификат авторского права и лицензии». 

Текущий выпуск и опция автоматических действий 
Показана информация о текущем выпуске. Поставьте «галочку» в окошке 

автоматических действий. Это автоматически продвинется через многие экраны. Если 

вы предпочитаете наблюдать экраны инсталляции один за другим, не помечайте это 

окошко, и приготовьтесь нажимать кнопку «continute (продолжить)» много раз. Щёлкните 

кнопку «Continute» и ждите. 

Снимок с экрана: 

«Текущий выпуск и окошко-флажок «Действовать автоматически»». 

Экраны модулей инсталляции и блоков 
В большинстве случаев процесс инсталляции сопровождается серией экранов, 

которые внизу имеют кнопку Continue. Этот процесс останавливается Администратором 

посредством настроек профиля, которые нужно заполнить. 

Профиль Пользователя-Администратора 
Снимок с экрана: «Экран Профиля Пользователей-Администраторов». 

Заполните требуемые поля. 

Щёлкните «Save (сохранить)», чтобы продолжить. 

Настройки Главной Страницы 
Следующий экран является страницей настроек Главной Страницы. Она состоит 

из двух частей. Первая часть попросит вас заполнить имя сайта и краткое имя в строке 

навигации. Имеется также место для описания. Вы можете изменить всё это позднее. 

 

Снимок с экрана: «Информация Главной Страницы сайтов Moodle». 

Вторая часть внизу инструктирует Moodle на случай, если вы отключите само 

аутентификацию новых пользователей с помощью электронной почты. По умолчанию она 

отключена. Это можно изменить позднее в Блоке Управления Сайтом. 

Снимок с экрана. 

Определите, могут ли пользователи создавать свои Профили при входе на Сайт 

путём самоАутентификации по электронной почте. 

Щёлкните кнопку «Save changes (сохранить изменения)», чтобы перейти на 

домашнюю страницу сайта Moodle. 

Запуск Moodle 
Вот теперь вы готовы к работе с Moodle! 

Снимок с экрана: «Пустая Главная Страница Вашего Нового Сайта». 

Блок Управления Сайтом находится слева, кнопка «Turn edit on (включить 

редактирование)» – в правом верхнем углу, вместе с Блоком Описания Сайта прямо под 

ней. 

http://docs.moodle.org/25/en/File:Complete_install_Windows_8.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_9.png
http://docs.moodle.org/25/en/File:Complete_install_Windows_10.png
http://docs.moodle.org/25/en/Front_Page
http://docs.moodle.org/25/en/Site_administration_block
http://docs.moodle.org/25/en/File:Complete_install_Windows_11ba.png.
http://docs.moodle.org/25/en/File:Complete_install_Windows_12.png
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Congratulations – Moodle has been installed 
This finishes the installation of a complete package. Type http://localhost 

(or what ever you set for web address earlier in the setup!) in your browser 

and Moodle will open. 

Your next task will be to configure Moodle to meet your needs. Don't 

worry, it is easy to change any of the settings now that Moodle is up and 

running. 

Check Settings > Site administration for further links. 

2.1.2.1.3.More tips and cautions 
For installation on a Windows 2000 or Windows 2003 production server it 

is good practice to perform a manual install (see the manual installation 

section in Windows Installation). 

After installing the Windows package, you may wish to add additional 

contributed modules and plugins. Theset may involve more customization 

of configuration files. 

The latest complete install package version components, may not be 

backwardly compatible. Always check version compatibility of each 

component if you intend to develop materials on a later version of Moodle 

than the version installed on your "main" Moodle site. In short, complete 

install packages are designed for first time install on a "clean" machine. 

 

2.1.2.1.4.Security matters (A must read!) 
As mentioned before, XAMPP is not meant for production use but only for 

developers in a development environment. The way XAMPP is configured 

is to be open as possible and allowing the developer anything he/she wants. 

For development environments this is great but in a production 

environment it could be fatal. Here a list of missing security in XAMPP: 

The MySQL administrator (root) has no password. The MySQL daemon is 

accessible via network. phpMyAdmin is accessible via network. Examples 

are accessible via network. 

To fix most of the security weaknesses simply call the following URL: 

http://localhost/security/ 

The root password for MySQL + phpMyAdmin and also a XAMPP 

directory protection can be established here. 

Note that on the Windows installer package, some (all?) of these issues 

have been fixed already by default and the above link does not work. If in 

doubt, more info is here 

 

 

 

Примите поздравления – Moodle установлена 
На этом заканчивается инсталляция Полного Пакета. Наберите http://localhost 

(или что-то ещё, что вы установили раньше в качестве веб-адреса при инсталляции!) в 

вашем браузере, и с Moodle можно работать. 

Ваша следующая задача состоит в конфигурировании Moodle в соответствии с 

вашими потребностями. Не бойтесь, теперь любые настройки легко изменять, ведь Moodle 

установлена и запущена. 

Посетите AdministrationSite administration для дальнейших ссылок. 

2.1.2.1.3.Дополнительные советы и предупреждения 
Для инсталляции на производственном сервере Windows 2000 или Windows 2003 

хорошей практикой является выполнение инсталляции вручную (см. раздел инсталляции 

вручную в Инсталляции в Windows). 

После установки пакета Windows вы можете захотеть добавить дополнительно 

распространяемые модули и плагины. Это может потребовать дополнительной настройки 

файлов конфигурации. 

Компоненты самой последней версии Полного Пакета Инсталляции не могут 

работать со старыми. Всегда проверяйте совместимость версий для каждой компоненты, 

если вы намереваетесь развивать материалы на последней версии Moodle, а не на версии, 

установленной на вашем «главном» сайте Moodle. Короче говоря, 

Полные Пакеты Установки предназначены для установки в первый раз на «чистой» 

машине. 

2.1.2.1.4.Вопросы безопасности (Прочесть обязательно!) 
Как упоминалось раньше, XAMPP не предназначен для производственного 

использования, а только для разработчиков в среде разработки. XAMPP сконфигурирован 

так, чтобы быть открытым и позволять разработчикам делать всё, что они захотят. Для 

сред разработки это великолепно, но в рабочей среде это может быть фатальным. 

Приведём перечень возможных упущений в безопасности у XAMPP: 

Администратор MySQL (root) не имеет пароля. Демон MySQL доступен через сеть, 

phpMyAdmin доступен через сеть. Примеры наработок доступны через сеть. 

 

Чтобы исправить слабые места в обеспечении безопасности, просто вызовите 

следующий URL: http://localhost/security/. 
Пароль пользователя root для MySQL+phpMyAdmin, а также защита оглавления 

XAMPP могут быть установлены здесь. 

Заметьте, что пакет установщика Windows некоторые (все?) из этих вопросов уже 

исправил по умолчанию, и приведённая выше ссылка не работает. Если сомневаетесь, 

получите дополнительную информацию отсюда. 

http://localhost/
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#More_tips_and_cautions
http://docs.moodle.org/25/en/Windows_installation
http://docs.moodle.org/25/en/Windows_installation
http://localhost/security/
http://www.apachefriends.org/en/faq-xampp-windows.html
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2.1.2.1.5.Apache and MySQL tweaks 
Most of the time it is not necessary to tweak Apache or MySQL after 

completing the complete install package. Nor is it necessary to individually 

start and stop them because that is what the Xampp_start, Xampp_restart 

and Xammp_stop files are for. 

Installing Apache and MySQL as services 
(This is only for NT4 | Windows 2000 | Windows XP operating systems) 

\xampplite\apache\apache_installservice.bat = ==> Install Apache 2 as 

service 

\xampplite\apache\apache_uninstallservice.bat = ==> Uninstall Apache 2 

as service 

\xampplite\mysql\mysql_installservice.bat = ==> Install MySQL as service 

\xampplite\mysql\mysql_uninstallservice.bat = ==> Uninstall MySQL as 

service 

==> After all Service (un)installations, please restart your system! 

Apache Notes 
You can use the apache_start and apache_stop bat files to start and stop 

apache from running. However the Xampp_start or Xampp_restart and 

Xampp_stop is recommended to turn on/off both Apache and MySQL. 

Troubleshooting 
If you find that Apache is very flaky, with the page often not loading 

properly or even at all (especially on localhost), try adding these lines to 

the end of C:\your_moodle_installer_directory\apache\conf\httpd.conf 

 EnableSendfile Off 

 EnableMMAP Off 

 Win32DisableAcceptEx 

If You edit some .php files but browser still show old state of them, try to 

disable eAccelerator extension in \server\php\php.ini 

[eAccelerator] 

;extension=eaccelerator.dll 

MySQL notes 
Again, the recommendation to start and stop the entire webserver is to use 

the xampp_start or Xampp_restart and the Xampp_stop. The following 

maybe useful if you wish to tweak the system further. Please be careful. 

(1) The MySQL server can be started by double-clicking (executing) 

mysql_start.bat. This file can be found in the same folder you installed 

xampp in, most likely this will be C:\xampplite\. The exact path to this file 

is X:\xampplite\mysql_start.bat, where "X" indicates the letter of the drive 

you unpacked xampp into.This batch file starts the MySQL server in 

console mode. The first intialization might take a few minutes. 

2.1.2.1.5. Поправки Apache и MySQL 
В основном нет необходимости подправлять Apache и MySQL после выполнения 

Завершённого Пакета Инсталляции. Не требуется их индивидуально запускать и 

останавливать, поскольку для этого имеются файлы Xampp_start, Xampp_restart и 

Xammp_stop. 

Инсталлирование Apache и MySQL в качестве сервисов 
(Это только для операционных систем NT4 | Windows 2000 | Windows XP). 

\xampplite\apache\apache_installservice.bat = ==> Установите Apache 2 как сервис 

 

\xampplite\apache\apache_uninstallservice.bat = ==> Деинсталлируйте Apache 2 как сервис 

 

\xampplite\mysql\mysql_installservice.bat = ==> Установите MySQL как сервис 

\xampplite\mysql\mysql_uninstallservice.bat = ==> Деинсталлируйте MySQL как сервис 

 

==> После (де)инсталляций всех этих сервисов, пожалуйста перезагрузите вашу систему. 

Замечания по Apache 
Вы можете использовать командные файлы apache_start и apache_stop, чтобы 

запустить и остановить Apache. Однако, рекомендуется использовать Xampp_start или 

Xampp_restart и Xampp_stop, чтобы включать или отключать Apache и MySQL. 

Поиск неисправностей 
Если вы обнаружили странности Apache, типа частой неправильной загрузки 

страниц или даже невыполнения её вовсе (особенно на localhost), попробуйте добавить 

такие строки в конец C:\your_moodle_installer_directory\apache\conf\httpd.conf 

EnableSendfile Off 

EnableMMAP Off 

Win32DisableAcceptEx 

Если вы редактируете некоторые PHP-файлы, а браузер всё равно показывает их 

прежнее состояние, попробуйте отключить расширение eAccelerator в \server\php\php.ini 

[eAccelerator] 

;extension=eaccelerator.dll 

Замечания по MySQL 
Ещё раз рекомендуем запускать и останавливать веб-сервер целиком с помощью 

Xampp_start или Xampp_restart и the Xampp_stop. Следующее может быть полезно, если 

вы хотите поправлять систему в дальнейшем. Пожалуйста, будьте осторожны. 

(1) Сервер MySQL может быть запущен двойным щелчком (выполнение) по 

mysql_start.bat. Этот файл может быть найден в той же самой папке, куда вы установили 

XAMPP, наиболее вероятно, что это будет C:\xampplite\. Точный путь к этому файлу – 

X:\xampplite\mysql_start.bat, где «Х» указывает букву устройства, куда вы распаковали 

XAMPP. Этот командный файл запускает сервер MySQL в консольном режиме. 

Первоначальная инициализация может занять несколько минут.  

http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#Installing_Apache_and_MySQL_as_services
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#Apache_Notes
http://docs.moodle.org/25/en/Complete_install_packages_for_Windows#Troubleshooting
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Do not close the DOS window or you'll crash the server! To stop the 

server, please use mysql_shutdown.bat, which is located in the same 

directory. 

(2) To use the MySQL Daemon with "innodb" for better performance, 

please edit the "my" (or "my.cnf") file in the /xampplite/mysql/bin 

directory or for services the c:\my.cnf for windows NT/2000/XP. In that 

director, activate the 

"innodb_data_file_path=ibdata1:30M" statement. 

Attention, "innodb" is not recommended for 95/98/ME. To use MySQL as 

Service for NT/2000/XP, simply copy the "my" / "my.cnf" file to C:\my, or 

C:\my.cnf. Please note that this file has to be placed in C:\ (root), other 

locations are not permitted. Then execute the "mysql_installservice.bat" in 

the mysql folder. (3) MySQL starts with standard values for the user id and 

the password. The preset user id is "root", the password is "" (= no 

password). 

To access MySQL via PHP with the preset values, you'll have to use the 

following syntax:  

mysql_connect("localhost","root",""); 

If you want to set a password for MySQL access, please use of 

mysqladmin. To set the password "secret" for the user "root", type the 

following: 
\xampplite\mysql\bin\mysqladmin -u root password secret 

After changing the password you'll have to reconfigure phpMyAdmin to 

use the new password, otherwise it won't be able to access the databases. 

To do that, open the file config.inc.php in \xampplite\phpmyadmin\ and 

edit the following lines: 

   $cfg['Servers'][$i]['user']            = 'root';   // MySQL user 

   $cfg['Servers'][$i]['auth_type'] = 'http';   // HTTP authentificate 

So first the 'root' password is queried by the MySQL server, before 

phpMyAdmin may access. 

Have a lot of fun! Viel Spaß! Bonne Chance! 

2.1.2.1.6.Vista and Windows 7 
Many people have trouble installing the packages for Windows on Vista 

and Windows 7. One simple solution is to use 

http://bitnami.org/stack/moodle (from amazon.com). 

2.1.2.1.7.See also 
 Return to Windows installation 

 Multiple web servers, on 1 computer similar to windows installation 

page, with some tips 

 Troubleshootingif you are running Skype. 

Не закрывайте окно DOS, или вы загубите этот сервер! Чтобы остановить сервер, 

пожалуйста, используйте mysql_shutdown.bat, который размещён в той же директории. 

 

(2) Чтобы использовать демона MySQL с «innodb» для лучшего выполнения, 

пожалуйста, отредактируйте файл «my» (или«my.cnf») в директории /xampplite/mysql/bin. 

или для сервисов в c:\my.cnf для Windows NT/2000/XP. В этой директории активируйте 

оператор: 

"innodb_data_file_path=ibdata1:30M". 

Внимание, «innodb» не рекомендуется для 95/98/ME. 

Чтобы использовать MySQL как сервис для NT/2000/XP, просто скопируйте 

«my» / «my.cnf» в C:\my или C:\my.cnf. Пожалуйста, отметьте, этот файл должен быть 

размещён в C:\ (root), другие места не разрешаются. Затем выполните 

«mysql_installservice.bat» в папке mysql.  (3) MySQL запускается со стандартными 

значениями ID пользователя и пароля. Предварительно установленный ID пользователя – 

«root», а пароля – «» (нет пароля). 

Чтобы получить доступ к MySQL через PHP с этими предварительно 

установленными значениями, вы должны использовать следующий синтаксис: 

mysql_connect("localhost","root",""); 

Если вы хотите установить пароль для доступа к MySQL, пожалуйста, используйте 

mysqladmin. Чтобы установить пароль «secret» для пользователя «root», наберите 

следующее: 

\xampplite\mysql\bin\mysqladmin -u root password secret 

После изменения пароля вы должны реконфигурировать phpMyAdmin, чтобы 

использовать новый пароль, в противном случае не будет доступа в базы данных. Чтобы 

сделать это, откройте файл config.inc.php в \xampplite\phpmyadmin\ и отредактируйте 

следующие строки: 

$cfg['Servers'][$i]['user'] = 'root';  //пользователь MySQL 

$cfg['Servers'][$i]['auth_type'] = 'http';  //проверка подлинности HTTP 

Таким образом, пароль «root» заносится в очередь сервером MySQL перед тем, как 

phpMyAdmin сможет иметь доступ. 

Пусть работа вам будет приятной! Viel Spaß! Bonne Chance! 

2.1.2.1.6.Vista and Windows 7 
Многие испытывают трудности при установке этих пакетов для Windows на Vista 

и Windows 7. 

Одно простое решение состоит в использовании (из amazon.com). 

2.1.2.1.7.См. также 
 Вернитесь к инсталляции Windows. 

 Несколько веб-серверов на одном компьютере подобно странице установки Windows с 

некоторыми советами. 

 Поиск и устранение неисправностей, если вы запустили Skype. 

http://bitnami.org/stack/moodle
http://docs.moodle.org/25/en/Windows_installation
http://docs.moodle.org/25/en/Windows_1_computer_many_servers
http://docs.moodle.org/en/Windows_installation_using_XAMPP#Troubleshooting
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2.1.3.Cron 
The Moodle 'cron' process is a PHP script (part of the standard Moodle 

installation) that must be run regularly in the background. The Moodle 

cron script runs different tasks at differently scheduled intervals. 

IMPORTANT: Do not skip setting up the cron process on your server 

for your Moodle. Your site will not work properly without it 

A special program (typically called - not surprisingly - 'cron') is used to run 

the Moodle cron script at a regular interval. The Moodle cron script runs 

tasks include sending mail, updating Moodle reports, RSS feeds, activity 

completions, posting forum messages and other tasks. Since different tasks 

have different schedules, not every task will run in Moodle when the cron 

script is triggered. 

The cron program (that runs the Moodle script) is a core part of Unix based 

systems (including Linux and OSX) being used to run all manner of time-

dependent services. On Windows the simplest solution is to create a task in 

the Windows Task Scheduler and set it to run at regular intervals. On 

shared hosting, you should find the documentation (or ask support) how 

cron is configured. 

Essentially, the task involves adding a single command to the list of cron 

activities on your system. On Unix based systems this list is a file called a 

'crontab' which all users have. 

2.1.4.Installing add-ons 
An add-on is an optional plugin for adding additional features and 

functionality to Moodle, such as new activities, new quiz question types, 

new reports, integrations with other systems and many more. 

 

2.2.Upgrading 
If you are upgrading your Moodle site, start here: 

2.2.1.Upgrading 
This page explains in detail how to upgrade Moodle. For a summary of the 

process, see Upgrade overview. 

2.2.2.Upgrade overview 
Start enjoying the cool features of the latest and greatest version of Moodle 

in four easy steps... 

Moodle 2.5 available now! 

Step 1: Make sure that your server can run Moodle 2.2 
 (Note: You need to upgrade to Moodle 2.2 before upgrading to 2.5.) 

 

2.1.3.«Хрон» 
Процесс «Cron» в Moodle является PHP-сценарием (часть стандартной 

инсталляции Moodle), который должен регулярно запускаться в фоновом режиме. PHP-

сценарий Moodle запускает различные задачи в разные запланированные интервалы. 

ВАЖНО: не пропустите установку процесса «Cron» на вашем сервере для 

вашей Moodle. Без него ваш сайт не будет работать правильно. 

Специальная программа (обычно называемая «Cron», – от слова chronological) 

используется для запуска сценария Moodle cron через регулярные интервалы. Сценарий 

Moodle Cron запускает задачи, включая отправку почты, обновления отчетов в Moodle, 

RSS рассылки, завершения Действий, пересылку сообщений Форумов и другие задачи. 

Поскольку различные задачи имеют различные расписания, не каждая из задач будет 

запускаться, когда включается сценарий Cron. 

Программа Cron (которая запускает сценарий Moodle) является главной частью 

Unix-подобных систем (включая Linux и OS X) и используется для запуска всякого рода 

сервисов, зависящих от времени. В Windows простейшее решение заключается в создании 

задачи в планировщике задач Windows Task Scheduler и установки его на запуск через 

регулярные интервалы. На разделяемых установках вам нужно отыскать документацию 

(или попросить поддержку) по данной конфигурации Cron. 

По существу, каждая из задач включает добавление единственной команды в 

список действий Cron на вашей системе. На системах, основанных на Unix, этот список 

является файлом, называемым «crontab», и его имеют все пользователи. 

2.1.4.Инсталлирование дополнительных плагинов 
Add-on – это необязательный плагин для добавления новых средств и 

функциональных возможностей в Moodle, таких как новое Интерактивное Действие, 

новые типы вопросов для Экзаменов, новые Отчёты, интеграции с другими системами, и 

многое другое. 

2.2.Модернизация 
Если вы модернизируете сайт Moodle, начинайте отсюда: 

2.2.1.Модернизация 
Эта страница подробно объясняет, как модернизировать Moodle. Краткое 

изложение этого процесса приведено в п. 2.2.2. 

2.2.2.Обзор модернизации 
Начните с удовольствием пользоваться «крутыми» средствами самой последней и 

самой полной версии Moodle, совершив четыре простых шага… 

Теперь доступна версия Moodle 2.5! 

Шаг 1: Убедитесь, что ваш сервер может использовать Moodle 2.2 
(Замечание: Вам необходимо модернизировать систему до Moodle 2.2, прежде чем 

модернизировать до Moodle 2.5.)  
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Go to Settings > Site administration > Server > Environment 

Status OK for everything? Great! Go to step 2... 

 

Any problems? You probably need to upgrade your server software (such 

as PHP) to a more recent version. 

Step 2: Be prepared! 
As usual with any large upgrade, you should always be prepared to "roll 

back" if there's an issue with your data or some custom code you've added. 

 

A test install 
We highly advise you make a copy of your production site to practice the 

upgrade on first. That way, if you run into any problems that need fixing 

you won't affect your main site. 

Always make backups 

When upgrading your production instance, make sure you have copies of 

everything, just in case. Full instructions are here: Site backup. 

 

Step 3: Replace your Moodle code 
At this point you can replace the Moodle code on your server with the 

version you downloaded. 

Check plugins 
Any plugins you have installed will also to be replaced with a version for 

your new Moodle version. 

If there is not yet an updated version of the plugin available, it will need to 

be uninstalled before upgrading your site. 

Step 4: Perform the upgrade! 
Trigger the upgrade by visiting the admin page. 

If you have a large site this may take hours, so we recommend upgrading 

via command line. 

How did you go? 
Yes – it worked! 

Great! Repeat the process for Moodle 2.5, and please post in the 

Installation problems forum and share your success with the Moodle 

community! 

No – I had an error 

Don’t worry, help is at hand. Post in the Installation problems forum where 

our experts are waiting to explain any errors you obtain. 

 

 

 

Перейдите к AdministrationSite administrationServerEnvironment 

Статус OK для всех действий по проверке сервера? Отлично! Переходим к 

шагу 2… 

Какие-то проблемы? Вам, вероятно, нужно модернизировать программное 

обеспечение вашего сервера (такое как PHP) до более современной версии. 

Шаг 2: Подготовьтесь! 
Как обычно при большой модернизации, вам следует обеспечить возврат к 

исходному состоянию, если что-то пойдёт не так с вашими данными или каким-то 

из добавленных вами пользовательских кодов. 

Пробная инсталляция 
Мы настоятельно рекомендуем сделать копию вашего производственного сайта, 

чтобы сначала попрактиковаться в его модернизации. Это на тот случай, если у вас 

возникнут проблемы, которые нужно решить без воздействия на ваш основной сайт. 

Всегда делайте резервные копии 

При модернизации производственного экземпляра убедитесь, что у вас есть копии 

всего, просто на всякий случай. Полные инструкции по резервному копированию 

находятся здесь. 

Шаг 3: Замените код вашей Moodle 
В этот момент вы можете заменить код Moodle на вашем сервере на новую 

скачиваемую версию. 

Проверьте плагины 
Все установленные вами плагины тоже будут заменены версией для вашей новой 

версии Moodle. 

Если не доступна обновлённая версия какого-то из плагинов, он должен 

быть деинсталлирован перед модернизацией сайта! 

Шаг 4: Выполните модернизацию! 
Начните модернизацию, посетив страницу управления. 

Если у вас большой сайт, это может занять часы, в этом случае мы 

рекомендуем проводить модернизацию через командную строку. 

Что получилось? 
Да – это сработало! 

Прекрасно! Повторите этот процесс для Moodle 2.5 и, пожалуйста, отправьте 

почтовое сообщение на форум, и поделитесь своим успехом с сообществом Moodle! 

 

Нет, не вышло, – у меня ошибка. 

Не переживайте, этому можно помочь. Отправьте почтовое сообщение на форум, 

где наши эксперты готовы объяснить любые ваши ошибки. 

http://docs.moodle.org/25/en/Site_backup
http://docs.moodle.org/25/en/Upgrading#Finishing_the_upgrade
http://docs.moodle.org/25/en/Administration_via_command_line#Upgrading_via_command_line
http://moodle.org/mod/forum/view.php?id=28
http://moodle.org/mod/forum/view.php?id=28


 

11 

2.2.3.Git for Administrators 
This page describes how to maintain a copy of Moodle on your production 

server which can easily be upgraded using Git. If you have customisations 

of Moodle core code, you are advised to follow the instructions in the 

Quick Git start guide for Moodle development. 

 

To get the most of of Git it is worth making the effort to understand its 

basic concepts - see the See also section below. It can be a bit of a learning 

curve, especially if you are used to CVS or Subversion. 

 

2.2.4.Administration via command line 
If you have shell access to your web server, you may find various CLI 

(command line interface) scripts useful during Moodle administration. 

Core admin CLI tools are located in the admin/cli/* folder. Other plugins 

provide their CLI functionality via scripts in their own cli folder. For 

example, the enrol_db sync script is located in enrol/db/cli/. 

 

To avoid problems with access control, you should run them as the owner 

of the web server process. It is especially important for CLI installation 

and upgrade as they create new files in moodledata directory and the web 

server has to have write access to them. In Linux distributions, the user that 

runs the web server is usually apache or wwrun or httpd or something 

similar. As a root, you will probably want to execute Moodle CLI scripts 

like this: 

   $ cd /path/to/your/moodle/dir 

   $ sudo -u apache /usr/bin/php admin/cli/somescript.php --params 

Most of the scripts accept common --help (or -h) parameter to display the 

full usage information, for example: 

   $ sudo -u apache /usr/bin/php admin/cli/install.php –help 

 

 

 

 

 

 

 

 

 

 

 

2.2.3.Git для администраторов 
Эта страница описывает то, как поддержать копию Moodle на вашем 

производственном сервере, который может быть легко модернизирован с использованием 

Git (распределённая система управления версиями файлов). Если у вас есть код 

приспособления к требованиям конкретных пользователей ядра Moodle, мы советуем вам 

последовать инструкциям руководства. 

Чтобы получить больше сведений о Git, имеет смысл сделать усилия по 

пониманию её основных концепций – просмотрите раздел «См. также» ниже. Это может 

оказаться весьма полезным, особенно если вы используете CVS (Concurrent Versions 

System «система одновременных версий») или подверсию. 

2.2.4.Управление через командную строку 
Если у вас доступ к веб-серверу через оболочку, вы можете найти различные 

сценарии CLI (command line interface – интерфейс командной строки), полезные для 

управления Moodle. Инструментарий Core admin CLI (управление ядром через командную 

строку) размещён в папке theadmin/cli/*. Другие плагины предоставляют свою 

функциональность CLI посредством сценариев в их собственных папках cli. Например, 

сценарий enrol_db sync размещён в папке inenrol/db/cli/. 

Чтобы избежать проблем с управлением доступом, вы должны запускать их как 

собственник процесса веб сервера. Это особенно важно для инсталляции через интерфейс 

командной строки CLI и при модернизации, так как они создают новые файлы в 

оглавлении moodledata, и веб-сервер должен иметь права записи их. В дистрибутивах 

Linux пользователь, который запускает веб-сервер, обычно, является apache или wwrun, 

или httpd, или чем-то подобным. Как root (корневой пользователь в Unix) вы, вероятно, 

захотите выполнить сценарий Moodle с помощью команд, подобных этим: 

$ cd /path/to/your/moodle/dir 

$ sudo -u apache /usr/bin/php admin/cli/somescript.php --params 

Большинство сценариев принимают общий параметр --help (или -h), чтобы 

отобразить информацию о применении, например: 

$ sudo -u apache /usr/bin/php admin/cli/install.php --help 

Дополнительную информацию можно почерпнуть по адресу: 

http://docs.moodle.org/25/en/Administration_via_command_line. 

http://docs.moodle.org/25/en/Development:Quick_Git_start_guide_for_Moodle_development
http://docs.moodle.org/25/en/Administration_via_command_line
http://docs.moodle.org/25/en/Administration_via_command_line
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Одно из самых больших достоинств Системы Moodle – гибкость настроек для поддержания разнообразных учебных курсов при 

смешанном (онлайн и офлайн) обучении в её среде – которое достигается за счёт наличия в Системе развитого механизма Ролей 

(Администратора, Преподавателя, Студента и др.), каждой из которых присваиваются свои Полномочия (установить новый Курс, зачислить на 

Курс кого-то из пользователей, добавить новых пользователей в Систему, и т.п.) и Возможности (просматривать, редактировать, инициировать 

темы форумов, оценивать ответы Студентов, и пр.,– всего более 500 Возможностей!). 

Возможно, ни Преподавателю, ни Студенту никогда не придётся заниматься установкой Ролей, но представлять, как они 

устанавливаются, как они связаны с Полномочиями и Возможностями для полноценной работы в Системе Moodle, им, безусловно, 

необходимо. Кроме того, современные учащиеся – народ, что называется, продвинутый: им ничего не стоит самостоятельно инсталлировать 

Moodle на домашнем компьютере (см. ч. 2), а затем уже насладиться назначением и проигрыванием Ролей в рамках и м и  самими же 

разработанных Курсов, опережая, может быть, в чём-то и Преподавателей. Данная часть документации как раз и посвящена описанию этого, и 

других связанных с ними, механизмов Системы Moodle. 
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3.Managing a Moodle Site 
A user with the role of Administrator is typically in charge of a Moodle 

site once it has been installed, although some tasks may be delegated to 

others by assigning them a role such as Manager. The links below provide 

more information about how to manage your Moodle site. 

3.1.Authentication 
Authentication - different methods of adding new users to your Moodle. 

Authentication is the process of allowing a user to login to a Moodle site 

based on their username and password. 

3.1.1.Authentication plugins 
Moodle provides a number of ways of managing authentication, called 

authentication plugins. 

3.1.1.1.Manual accounts 
Manual accounts - accounts created manually by an administrator. 

Location: Settings>Site. 

3.1.1.2.No login 
No login - suspend particular user account. 

An administrator may "turn off" or suspend a user's account by selecting 

"No Login" in the "Choose an authentication method setting" in the users 

profile in edit mode. 

 

Different users have to have unique email addresses in their profile, even 

when email is not enabled. When the "No Login" setting is used, the 

account email may not be re-used to create another account. This 

essentially is a way to bar a particular user account from using Moodle for 

the duration that the account is assigned to this authentication type. 

 

 

 

Note: An alternative way of suspending a user's account (available in 

Moodle 2.2.1 onwards) is to tick the 'Suspended account' checkbox on the 

edit profile page. 

3.1.1.2.1.See also 
Using Moodle What is the difference between suspending and soft-deleting 

a user? forum discussion. 

 

3.Управление Сайтом Moodle 
Пользователь с Ролью Администратора обычно ответственен за Сайт Moodle сразу 

после его инсталляции, хотя некоторые задачи могут быть делегированы другим 

посредством поручения им Роли Менеджера. Ссылки на опции ниже предоставляют 

больше информации о том, как управлять Сайтом Moodle. 

3.1.Аутентификация 
Аутентификация – это различные методы попадания новых пользователей в вашу 

Moodle. Аутентификация – процесс, позволяющий пользователю входить на Сайт Moodle 

под его регистрационным именем и паролем. 

3.1.1.Плагины Аутентификации 
Moodle обеспечивает ряд способов управления Аутентификацией (п. 3.1.2), 

называемых Плагинами Аутентификации. 

3.1.1.1.Учётные записи, созданные вручную 
Manual accounts – учётные записи, созданные вручную. 

Местоположение: AdministrationSite. 

3.1.1.2.Не пускать в Систему  
No login – приостанавливает учётную запись конкретного пользователя. 

Администратор может «выключить» или приостановить некую пользовательскую 

учётную запись выбором «No Login» в настройке «Choose an authentication method 

(выбрать метод аутентификации)» в Профиле Пользователя в 

режиме редактирования. 

Различные пользователи должны иметь уникальные 

адреса э-почты в их Профиле, даже когда э-почта не 

разрешена. Когда использована настройка «No Login», э-

почта данной учётной записи не может повторно 

использоваться для создания новой учётной записи. Это, по 

существу, есть способ запрещения отдельному пользователю 

работать в Moodle после истечения срока, предусмотренного для данного типа 

аутентификации. 

Замечание: Альтернативный способ приостановления учётных записей 

пользователей (доступен, начиная с Moodle 2.2.1) – пометить окошко-флажок «Suspended 

account» («приостановленная учётная запись») на странице редактирования Профиля. 

3.1.1.2.1.См. также 
Обсуждения форума по использованию Moodle «В чём отличие между 

приостановкой и программным удалением пользователя?». 

http://moodle.org/mod/forum/discuss.php?d=173432
http://moodle.org/mod/forum/discuss.php?d=173432
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3.1.1.3.Email-based self-registration 
Email-based self-registration - for enabling users to create their own 

accounts. 

The email-based self-registration authentication method enables users to 

create their own accounts via the 'Create new account' button on the login 

page. They then receive an email at the address they specified in their 

account profile to confirm their account. 

 

 

3.1.1.3.1. Enabling email-based self-registration 
 
An administrator can enable email-based self-registration in Settings > Site 

administration > Plugins > Authentication > Manage authentication. 

 

 

In addition to enabling the plugin, email-based self-registration must be 

selected from the self registration drop-down menu in the common 

settings. 

Warning: Enabling self registration results in the possibility of spammers 

creating accounts in order to use forum posts, blog entries etc. for spam. 

This risk can be minimized by limiting self registration to particular email 

domains with the allowed email domains setting in Settings > Site 

administration > Plugins> Authentication > Manage authentication. 

Alternatively, self registration may be enabled for a short period of time to 

allow users to create accounts, and then later disabled. 

 

Note: The Email-based self-registration authentication plugin must be 

enabled to allow users who previously self-registered to login. Selecting 

Email-based self-registration as the self registration method allows 

potential users to self register. 

 

 

 

 

 

 

 

 

 

 

3.1.1.3.Саморегистрация по э-почте 
Саморегистрация по э-почте – для разрешения пользователям создавать их 

собственные учётные записи. 

Метод аутентификации саморегистрацией по э-почте разрешает пользователям 

создавать их собственные учётные записи посредством кнопки «Create new account 

(создать новую учётную запись)» на странице 

регистрации. Затем они получают корреспонденцию по 

адресу э-почты, который указали сами в Профиле их 

учётной записи, чтобы подтвердить их учётную запись. 

3.1.1.3.1.Разрешение 
саморегистрации по э-почте 

Администратор может разрешить 

саморегистрацию по э-почте в 

AdministrationSite administrationPluginsAuthenticationManage authentication. 

В дополнение к включению плагина, саморегистрация по э-почте должна быть 

выбрана из ниспадающего меню саморегистрации в общих настройках. 

 

Предупреждение: Разрешение саморегистрации ведёт к возможности создания 

учётных записей спамерами для того, чтобы использовать корреспонденции форумов, 

записи блогов и т.д. для спама. Этот риск может быть минимизирован ограничением 

саморегистрации конкретными доменами э-почты с настройкой таких доменов э-почты в 

AdministrationSite administrationPluginsAuthenticationManage authentication. В 

качестве альтернативы саморегистрация может быть разрешена пользователям на 

короткий промежуток времени для создания учётных записей, а затем позднее отключена. 

 

Замечание. Плагин аутентификации саморегистрацией по э-почте должен быть 

включён, чтобы разрешить пользователям, которые ранее самозарегистрировались, войти 

в Систему Moodle. Выбор саморегистрации по э-почте в качестве метода само- 

регистрации, разрешает потенциальным пользователям саморегистрацию. 
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3.1.1.3.2.Enable reCAPTCHA element 
A CAPTCHA is a program that can tell whether its user is a human or a 

computer. CAPTCHAs are used by many websites to prevent abuse from 

bots, or automated programs usually written to generate spam. No 

computer program can read distorted text as well as humans can, so bots 

cannot navigate sites protected by CAPTCHAs. 

 

 

Screenshot «New account form with CAPTCHA element». 

Spam protection may be added to the email-based self-registration new 

account form with a CAPTCHA element - a challenge-response test used 

to determine whether the user is human. 

In addition to enabling the reCAPTCHA element, email-based self-

registration should be set as the self registration authentication plugin and 

reCAPTCHA keys should be set in the manage authentication common 

settings. 

3.1.1.3.3.Support contact 
An administrator can specify a support name, email and/or support page in 

Settings > Site administration > Server > Support contact for including in 

the confirmation email. 

3.1.1.3.4.See also 
 No Email 

Using Moodle forum discussions: 

 Admin approving self registrations? 

 Sending the email confirmation again 

 Self registration with validation 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1.1.3.2.Разрешить тест CAPTCHA 
CAPTCHA – это программа, которая может сообщить, является ли пользователь 

человеком или компьютером. CAPTCHA используется многими веб-Сайтами для 

предотвращения злоупотреблений со стороны роботов-компьютеров или 

автоматизированных программ, которые обычно пишут для генерации спама. Ни одна 

программа не может прочитать текст с искажёнными символами также хорошо, как это 

может человек, так что роботы-компьютеры не могут путешествовать по Сайтам, 

защищённым CAPTCHA. 

Снимок с экрана «Новая форма учётной записи с тестом CAPTCHA». 

Защита от спама может быть добавлена в НОВУЮ форму учётной записи само- 

регистрации по э-почте как тест CAPTCHA – тест запрос-ответ, используемый для 

определения, является ли пользователь человеком. 

В дополнение к включению теста CAPTCHA, саморегистрация по э-почте должна 

быть установлена как плагин аутентификации саморегистрацией, и должны быть 

установлены ключи CAPTCHA в общих настройках по управлению аутентификацией. 

 

3.1.1.3.3.Контакт поддержки 
Администратор может указать наименование поддержки, э-почту и/или страницу 

поддержки в AdministrationSite administrationServerSupport contact для включения в 

почтовое подтверждение. 

3.1.1.3.4.См. также 
 Без э-почты. 

Обсуждения форума по использованию Moodle: 

 Санкционирование Администратором саморегистрации. 

 Повторная отправка почтового подтверждения. 

 Саморегистрация с проверкой достоверности. 

http://docs.moodle.org/24/en/File:New_account_form_with_captcha_element.png
http://docs.moodle.org/24/en/No_Email
http://moodle.org/mod/forum/discuss.php?d=97938
http://moodle.org/mod/forum/discuss.php?d=80518
http://moodle.org/mod/forum/discuss.php?d=92958
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3.1.2.Managing authentication 
3.1.2.1.Setting the authentication method(s) 
An administrator can set the authentication method(s) for the site as 

follows: 

 Go to Settings > Site administration > Plugins > Authentication > 

Manage authentication 

 Click the eye icon to enable selected authentication plugins (closed eye 

= disabled, open eye = enabled) 

 Click the settings link opposite the authentication plugin(s) you have 

chosen 

 Configure the required settings and click the "Save changes" button 

 

 Repeat until you have edited all the plugins you have enabled 

More than one authentication plugin may be enabled. Any authentication 

plugin can be used to find a username/password match. Once found, a user 

is logged in and alternative plugins are not used. Therefore the plugin 

which handles the most logins should be moved to the top of the page in 

order that less load is put on authentication servers. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.1.2.Управление аутентификацией 
3.1.2.1.Установка метода(ов) аутентификации 

Администратор может установить метод(ы) аутентификации для Сайта 

следующим образом: 

 Перейдите к 

AdministrationSite administrationPluginsAuthenticationManage authentication. 

 Щёлкните иконку «глаз», чтобы включить выбранные плагины аутентификации (глаз 

закрыт – отключен, глаз открыт – включен). 

 Щёлкните ссылку настроек напротив плагина(ов) аутентификации, который(ве) вы 

выбрали. 

 Сконфигурируйте требуемые настройки и щёлкните кнопку «Save changes (сохранить 

изменения». 

 Повторяйте это до тех пор, пока не отредактируете все плагины, которые вы включили. 

Можно включить более одного плагина аутентификации. Всякий плагин 

аутентификации может быть использован для поиска соответствия 

регистрационного имени пользователя/пароля. После того, как соответствие найдено, 

пользователь входит в Систему, и 

альтернативные плагины не используются. 

Следовательно, плагин, который обрабатывает 

большую часть входов в Систему, должен 

быть перемещён вверх страницы, для того 

чтобы уменьшить нагрузку на серверы 

аутентификации. 

На странице документации приведены 

ссылки и на другие плагины аутентификации: 

CAS server (SSO), External database, FirstClass 

server, IMAP server, LDAP server, Moodle 

Network authentication, NNTP server, No authentication, PAM (Pluggable Authentication 

Modules), POP3 server, RADIUS server, Shibboleth и Web services authentication. 

http://docs.moodle.org/24/en/Authentication
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3.1.2.2.Authentication common settings 
Authentication common settings can be changed by an administrator in 

Settings > Site administration > Plugins > Authentication > Manage 

authentication. 

3.1.2.2.1.Self registration 
If you wish users to be able to create their own user accounts, i.e. self-

register, then select Email-based self-registration (or any other enabled 

plugin that can support self registration, like LDAP) from the drop-down 

menu. This will result in a "Is this your first time here?" instructions and a 

"Create new account" button being displayed on the login page. 

 

 

 
 

Warning: Enabling self registration results in the possibility of spammers 

creating accounts in order to use forum posts, blog entries etc. for spam. 

This risk can be minimized by limiting self registration to particular email 

domains with the allowed email domains setting (see below). 

Alternatively, self registration may be enabled for a short period of time to 

allow users to create accounts, and then later disabled by setting 'Self 

registration' to Disable in the common settings in Settings > Site 

administration > Plugins > Authentication > Manage authentication. 

 

Note: The Email-based self-registration authentication plugin must be 

enabled to allow users who previously self-registered to login with that 

plugin. Selecting Email-based self-registration as the self registration 

method allows potential users to self register. 

3.1.2.2.2.Guest login button 
You can hide or show the guest login button on the login page. Hiding the 

guest login button disables guest access to the Moodle site, however 

logged-in users can still enter any courses which allow guest access 

without being required to enrol. 

 

 

 

 

 

 

 

 

3.1.2.2.Общие настройки аутентификации 
Общие настройки аутентификации могут быть изменены Администратором в 

AdministrationSite administrationPluginsAuthenticationManage authentication. 

 

3.1.2.2.1.Саморегистрация 
Если вы хотите, чтобы пользователи были 

способны создавать свои собственные 

пользовательские учётные записи, т.е. само- 

регистрироваться, тогда выберите «Email-based self-

registration (саморегистрация по э-почте)» (или 

любой другой доступный плагин, который может 

поддерживать саморегистрацию, подобный LDAP) из ниспадающего меню. Это приведёт 

к инструкциям «Is this your first time here? (Вы здесь первый раз?)» и к отображению 

кнопки «Create new account (создать новую учётную запись)» на странице регистрации. 

Предупреждение: Разрешение саморегистрации ведёт к возможности создания 

учётных записей спамерами для того, чтобы использовать корреспонденции Форумов, 

записи Блогов и т.д. для спама. Этот риск может быть минимизирован ограничением 

саморегистрации конкретными доменами э-почты с настройкой разрешённых доменов э-

почты (см. ниже). В качестве альтернативы саморегистрация может быть разрешена 

пользователям на короткий промежуток времени для создания учётных записей, а затем 

позднее отключена переводом настройки «Self registration» в Disable (отключена) в общих 

настройках в 

AdministrationSite administrationPluginsAuthenticationManage authentication. 

Замечание. Плагин аутентификации саморегистрацией по э-почте должен быть 

включён, чтобы разрешить пользователям, которые ранее саморегистрировались, входить 

в Систему Moodle. Выбор саморегистрации по э-почте в качестве метода саморегистрации 

разрешает потенциальным пользователям самим попасть в журнал регистрации. 

3.1.2.2.2.Кнопка входа в Систему Гостя 
Вы можете спрятать или показать кнопку Guest login (вход в Систему Гостя) на странице 

регистрации. Скрытие кнопки Guest login отключает доступ Гостя (п. 3.4.5) на Сайт 

Moodle, однако, зарегистрированные пользователи всё ещё могут входить в любые Курсы, 

которые разрешают доступ Гостю без требования его зачисления. 
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3.1.2.2.3.Alternate login URL 
This should be used with care, since a mistake in the URL or on the actual 

login page can lock you out of your site. If you do mess it up, you can 

remove the entry from your database (table mdl_config) using, e.g., 

phpmyadmin for mysql. (You can read some more useful information 

about changing $CFG->alternateloginurl = ' your url '; on the following 

discussion) 

3.1.2.2.4.Forgotten password URL 
If your lost password handling is performed entirely outside of Moodle (for 

example, only by a help desk), you can set the url of that service here. 

Anybody pressing a "lost password" link in Moodle will be redirected to 

this URL. Note that this will disable all of Moodle's lost password recovery 

options regardless of authentication method(s) in use. 

3.1.2.2.5.Instructions 
The instructions field is for providing custom login instructions on the 

login page. If the field is left blank then the default login instructions will 

be displayed. 

Screenshot «Login page with default instructions displayed». 

 

Screenshot «Login page with custom instructions displayed». 

An alternative method of providing custom login instructions is to edit the 

default login instructions using the language customization feature. This 

method should be used if you wish to provide custom login instructions in 

more than one language. 

 Go to Settings > Site administration > Language > Language 

customization 

 Select a language then click the button 'Open language pack for editing' 

then click continue 

 Select moodle.php and enter loginsteps as string identifier then click 

'Show strings' 

 Enter your custom login instructions in the local customisation text box 

 

 Click the button 'Save changes to the language pack' then click continue 

 

 Repeat the steps for other languages. 

 

 

 

 

3.1.2.2.3.Альтернативный URL для входа в Систему 
Этим нужно использоваться с осторожностью, поскольку ошибка в URL или на 

фактической странице входа в Систему может заблокировать ваш Сайт. Если вы всё же 

совершили такую ошибку, вы можете удалить такой вход в вашу базу данных (таблица 

mdl_config), используя, например, phpmyadmin для MySQL. (Вы можете прочитать 

несколько больше об изменениях $CFGalternateloginurl = 'our url' в следующем 

обсуждении.) 

3.1.2.2.4.URL забытого пароля 
Если вы потеряли пароль, обработка этого ведётся не в Moodle (например, только 

посредством панели помощи), вы можете установить URL этого сервиса здесь. Каждый, 

нажавший ссылку «Lost password (пароль утерян)» в Moodle, перенаправляется на этот 

URL. Заметьте, что это отключит все опции восстановления утерянного пароля Moodle, 

несмотря на используемый(е) метод(ы) аутентификации. 

3.1.2.2.5.Инструкции 
Поле инструкций служит для обеспечения клиента инструкциями входа в Систему 

на странице регистрации. Если это поле оставлено пустым, то будут отображаться 

инструкции по входу в Систему, принятые по умолчанию. 

Снимок с экрана «Страница регистрации с отображёнными инструкциями по 

умолчанию». 

Снимок с экрана «Страница входа в Систему с отображаемыми инструкциями». 

Альтернативный метод предоставления инструкций клиенту по входу в Систему 

состоит в редактировании инструкций входа по умолчанию, используя средство настройки 

языка, привычного клиенту. Этот метод нужен, если вы хотите предоставить 

пользовательские инструкции входа в Систему более чем на одном языке. 

 Перейдите к AdministrationSite administrationLanguageLanguage customization. 

 

 Выберите язык, затем щёлкните кнопку «Open language pack for editing (открыть 

языковый пакет для редактирования)». 

 Выберите moodle.php и введите loginsteps как строковый идентификатор, затем 

щёлкните «Show strings (показать строки)». 

 Введите ваши инструкции по входу клиента в Систему в текстовое окошко Local 

customisation (локальные настройки привычные клиенту). 

 Щёлкните кнопку «Save changes to the language pack (сохранить изменения в языковом 

пакете)». 

 Повторите эти шаги для других языков. 

https://moodle.org/mod/forum/discuss.php?d=86952
http://docs.moodle.org/24/en/File:login_page_default_instructions.png
http://docs.moodle.org/24/en/File:login_page_default_instructions.png
http://docs.moodle.org/24/en/File:custom_login_instructions.png
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3.1.2.2.6. Allowed and denied email domains 
Authentication may be restricted to particular email domains when using 

Email-based self-registration so that, for example, only students with a 

university email can login. 

3.1.2.2.7. Restrict domains when changing email 
You can choose to enforce email domains only when users create an 

account using Email-based self-registration i.e. after creating an account, 

users may change their email to a different domain. 

 

3.1.2.2.8. ReCAPTCHA 
A CAPTCHA is a program that can tell whether its user is a human or a 

computer. CAPTCHAs are used by many websites to prevent abuse from 

bots, or automated programs usually written to generate spam. No 

computer program can read distorted text as well as humans can, so bots 

cannot navigate sites protected by CAPTCHAs. 

 

 

Spam protection may be added to the Email-based self-registration new 

account form with a CAPTCHA element - a challenge-response test used 

to determine whether the user is human. 

ReCAPTCHA keys can be obtained from 

http://www.google.com/recaptcha by signing up for an account (free) then 

entering a domain. The public and private keys provided can then be 

copied and pasted into the recaptchapublickey and recaptchaprivatekey 

fields in the manage authentication common settings, and the changes 

saved. 

In addition to setting reCAPTCHA keys, email-based self-

registration should be set as the self registration authentication plugin in 

the manage authentication common settings and the reCAPTCHA element 

should be enabled in the Email-based self-registration settings. 

 

 

 

 

 

 

 

 

 

 

3.1.2.2.6.Разрешённые и запрещённые домены э-почты 
Аутентификация может быть ограничена отдельными доменами э-почты при 

использовании саморегистрации по э-почте (п. 3.1.5) так, что, например, только Студенты 

с университетской э-почтой могут зарегистрироваться. 

3.1.2.2.7.Ограничить домены при изменении э-почты 
Вы можете выбрать вариант активизации доменов э-почты только после того, как 

пользователи создадут учётную запись, используя саморегистрацию по э-почте, т.е. 

пользователи могут связывать их э-почту с различными доменами только после создания 

учётной записи. 

3.1.2.2.8.Относительно CAPTCHA 
CAPTCHA – это программа, которая может сообщить, является ли пользователь 

человеком или компьютером. CAPTCHA используется многими веб-Сайтами для 

предотвращения злоупотреблений со стороны роботов-компьютеров или 

автоматизированных программ, которые обычно пишут для генерации спама. Ни одна 

компьютерная программа не может прочитать текст с искажёнными символами также 

хорошо, как это может человек, так что роботы-компьютеры не могут путешествовать по 

Сайтам, защищённым CAPTCHA. 

Защита от спама может быть добавлена в НОВУЮ форму учётной записи 

саморегистрации по э-почте как тест CAPTCHA – тест запрос-ответ, используемый для 

определения, является ли пользователь человеком. 

Ключи CAPTCHA могут быть получены из http://www.google.com/recaptcha 

подпиской для получения учётной записи (свободной), затем входом в домен. 

Предоставляемые общественные и личные ключи могут затем быть скопированы и 

вклеены в поля recaptchapublickey и recaptchaprivatekey в общие настройки управления 

аутентификацией, а изменения сохранены. 

 

В дополнение к повторной настройке ключей CAPTCHA, саморегистрация по э-

почте должна быть установлена как плагин аутентификации саморегистрацией в общих 

настройках управления аутентификацией, а тест CAPTCHA должен быть включён в 

настройках саморегистрации по э-почте. 

http://www.google.com/recaptcha
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3.1.2.3. Profile fields data mapping and locking 
 
Most (but not all) authentication plugins that use an external source for the 

user account details allow us to retrieve some user profile details (like first 

name, last name, email, etc.). By using the Data Mapping section on those 

authentication plugins configuration page we can configure what, when 

and how to manage all those user profile details. 

 

Screenshot «Data Mapping Options». 

These fields are optional. You can choose to pre-fill some Moodle user 

fields with information from the external authentication source (if you are 

using one), from the fields that you specify here. If you leave these fields 

blank, then nothing will be transferred from the external authentication 

source and Moodle defaults will be used instead. In either case, the user 

will be able to edit all of these fields after they log in. 

 

In addition to specifying how to fill this fields, we can set how to update 

them (in both directions, to Moodle or from Moodle), and whether we want 

to lock them (so the user cannot modify their value) or not: 

 Update local: When the user field will be updated from the external 

authentication source: 

 On creation: when the user account is created during the first login 

 

 On every login: every time the user logs in (or there is a user 

synchronization, for those authentication plugins that support it). 

Fields set to update locally should be locked. 

 

 Update external: When the external authentication source will be 

updated from the user field: 

 Never: never update the external authentication source from 

Moodle. 

 On update: the external authentication source will be updated when 

the user profile is updated. Fields should be unlocked to allow edits. 

 Lock value: To prevent users from altering some fields (e.g. students 

changing profile information to inappropriate or misleading 

information), the site administrator can lock profile fields. It's usually a 

good idea to lock profile fields if you are maintaining this data in the 

external authentication system. 

 

3.1.2.3.Отображение и блокирование данных полей 
Профиля 

Большинство (но не все) плагинов аутентификации, которые используют внешние 

источники для детализации пользовательских учётных данных, позволяют нам 

запрашивать некоторые детали Профиля Пользователя (имена, фамилии, э-почту и т.д.). 

Используя раздел Отображения Данных на странице конфигурации этих плагинов 

аутентификации, мы можем определить, когда и как управлять этими деталями 

Профиля Пользователя. 

Снимок с экрана «Опции отображения данных»: 

Это поля по выбору. Вы можете выбрать 

некоторые заранее заполненные поля пользователя 

Moodle информацией из внешних источников аутентификации (если вы выбрали один из 

них), из полей, которые вы укажете здесь. Если вы оставите эти поля пустыми, тогда 

ничего не будет передаваться из внешних источников аутентификации, и Moodle вместо 

них будет использовать значения по умолчанию. В любом случае, каждый из 

пользователей сможет редактировать эти поля после того, как зарегистрируется. 

В дополнение к указанию, как заполнять эти поля, вы можете установить, как 

обновлять их (в обоих направления: к Moodle и от Moodle) и хотите ли заблокировать их 

(так что пользователь не сможет модифицировать их значения) или нет. 

 Обновить локально: когда поле пользователя будет обновлено из внешнего источника 

аутентификации: 

 При создании: когда учётная запись пользователя создаётся во время первой 

регистрации. 

 При каждом входе в Систему: каждый раз при входе пользователя в Систему (или 

есть пользовательская синхронизация для этих плагинов аутентификации, которая 

это поддерживает). Поля, установленные в обновление локально, следует 

заблокировать. 

 Обновить внешне: когда внешний источник аутентификации будет 

обновляться из поля пользователя: 

 Никогда: никогда не обновлять внешний источник аутентификации из Moodle. 

 При обновлении: внешний источник аутентификации будет обновляться при 

обновлении Профиля пользователя. Поля следует разблокировать, чтобы позволить 

их редактировать. 

 Заблокировать значение: чтобы предотвратить пользователей от изменения 

некоторых полей (например, Студентов, изменяющих информацию Профиля на 

неподходящую или вводящую в заблуждение информацию), Администратор Сайта 

может заблокировать поля Профиля. Обычно эта идея блокировки полей Профиля 

хороша, если вы поддерживаете эти данные во внешней Системе аутентификации. 
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 Unlocked: The field is unlocked and can be edited by the user at 

any time. 

 Unlocked if empty: The field is unlocked if it is empty, but once 

the user fills in some information, it becomes locked and cannot be 

edited any more. 

 Locked: The field is locked and cannot be edited by the user. 

 

If you are using a mixture of authentication types (such as IMAP and 

manual), then the fields you map and lock in the authentication options are 

specific to that particular authentication plugin. Each authentication plugin 

has its own set of mapped and locked fields. 

 

Remember to test the field locking by logging in with the proper type of 

account! If you test with a manual account but have set the field locking to 

apply to IMAP accounts, you will not be able to tell if it worked! 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Разблокировано: это поле разблокировано и может быть отредактировано 

пользователем в любое время. 

 Разблокировано, если пустое: это поле разблокировано, если оно пустое, но как 

только пользователь заполнит его какой-либо информацией, оно станет 

заблокированным и не сможет быть больше отредактировано. 

 Заблокировано: это поле заблокировано и не может быть отредактировано 

пользователем. 

Если вы используете смешанные типы аутентификации (такие как IMAP и 

вручную), то эти поля вы можете отображать и блокировать в опциях аутентификации, 

которые специфичны для конкретного плагина аутентификации. Каждый плагин 

аутентификации имеет свой собственный набор отображаемых и блокируемых полей. 

 

Не забудьте тестировать блокировку поля посредством входа в Систему с 

правильным типом учётной записи! Если вы тестируете с учётной записью, созданной 

вручную, но блокировка поля установлена применительно к учётным записям IMAP, вы не 

будете способны определить, работает ли это. 
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3.2.Managing accounts 
An administrator can perform various tasks relating to user accounts in 

Settings>Site Administration>Users>Accounts. 

3.2.1.Browse list of users 
How to search for, find and edit user accounts. 

3.2.1.1.Overview 
An administrator can browse and search the list of all user accounts in 

Settings > Site administration > Users > Accounts > Browse list of users. 

Screenshot «Example of Browse user list». 

Administrators can search for a particular user, using their name or email 

address as the search term, and then edit their profile. Editing a user's 

profile is a way to reset the user's passwords when they are unable to log 

in. Another reason for needing to edit a user’s profile is to disable their 

email address if the site is receiving lots of undelivered mail. 

 

If you are using Email-based self-registration and a user has a problem 

confirming their account, you can confirm their account for them by 

clicking the confirm link opposite their name. 

3.2.1.1.1.Table Sorting 
All of the columns in the browse list may be sorted in alphabetical (or 

numerical) order either ascending or descending, by clicking on the 

column heading. Your first column click sorts the user data A-Z, the 

second click sorts the data Z-A. 

3.2.1.1.2. Filters 
You can search for users, using particular criteria or Filters. These criteria 

can be configured to display data as per the following limits: 

 

 contains 

 doesn't contain 

 is equal to 

 starts with 

 ends with 

 is empty 

 

 

 

 

 

3.2.Управление учётными записями 
Администратор может выполнить различные задачи, связанные с учётными 

записями пользователей в AdministratorSite administrationUsersAccounts. 

3.2.1.Просмотреть список пользователей 
Как искать, находить и редактировать учётные записи пользователей. 

3.2.1.1.Обзор 
Администратор может просмотреть и отыскать список учётных записей всех 

пользователей в AdministratorSite administrationUsersAccountsBrowse list of users. 

Снимок с экрана «Пример списка просмотра пользователей». 

Администраторы могут отыскать конкретного пользователя, используя его имя или 

адрес э-почты в качестве термина поиска, и затем отредактировать его Профиль. 

Редактирование Профиля пользователя – это способ перезагрузить пароль пользователя, 

когда он не может войти в Систему. Другой причиной редактирования Профиля 

пользователя состоит в отключении адресов их э-почты, если Сайт получает много 

недоставленной почты. 

Если вы используете саморегистрацию по э-почте, а у пользователя проблема с 

подтверждением его учётной записи, вы можете подтвердить вместо него его учётную 

запись выбором ссылки Confirm напротив его имени. 

3.2.1.1.1.Сортировка таблицы 
Все колонки в списке просмотра могут быть отсортированы в алфавитном (или 

числовом) порядке или по возрастанию, или по убыванию щелчком по заголовку колонки. 

Ваш первый щелчок по колонке отсортирует данные пользователя от A до Z, второй 

щелчок отсортирует те же самые данные от Z до A. 

3.2.1.1.2.Фильтры 
Вы можете отыскать пользователей, используя конкретные критерии или фильтры. 

Эти критерии могут быть сконфигурированы, чтобы отражать данные по следующим 

ограничениям: 

 содержит 

 не содержит 

 одинаково с 

 начинается с 

 оканчивается на 

 пусто 

http://docs.moodle.org/24/en/File:Administration_Block_Site_User_Accounts_Browse.png
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For example, if you wished to search for all users with John in their First 

Name or Last Name you would enter 'John' in the Full name filter and 

select the 'contains' limit. 

Clicking the Show Advanced button will provide you with additional 

search Filters and data limits. The Filters under the Advanced area will 

also include any custom user profile fields that have been created within 

your Moodle installation 

Screenshot «Advanced search with custom user profile field». 

 

After applying a Filter to a user search, click the Add Filter button to run 

the user search. All Filters applied to the search are listed above the search 

results. You can add or remove (using the corresponding tickbox) Filters to 

your search criteria as required. These filters are saved within a single 

Moodle session. 

3.2.1.2.See also 
 Update profile 

3.2.2.Bulk user actions 
How to message, confirm, download or perform other actions on a large 

group of users globally. 

The bulk user actions feature in Settings > Site administration > Users > 

Accounts > Bulk user actions enables administrators to select users by 

creating a filter and then perform any of the following actions: 

 Confirm user accounts created through Email-based self-registration 

which are not yet confirmed by the user. 

 Send a message (requires Messaging to be enabled) 

 Delete user accounts 

 Display a list of users on a page 

 Download user data in text, ODS or Excel file format 

 Force users to change their passwords 

 Add users to a cohort 

 

 

 

 

 

 

 

 

 

Например, если вы хотите отыскать всех пользователей с именем Джон или 

фамилией Джон, вы можете ввести «Джон» в фильтр Full name (полное имя – имя и 

фамилия) и выбрать ограничение «Contains». 

Щелчок кнопки Show Advanced (показать расширенное) предоставит 

дополнительные фильтры поиска и ограничения по данным. Фильтры области Advanced 

будут также включать любые клиентские поля Профиля пользователя, которые созданы 

внутри вашей инсталляции Moodle. 

Снимок с экрана «Расширенный поиск по клиентскому полю Профиля 

пользователя». 

После применения фильтра к поиску пользователя щёлкните кнопку Add Filter 

(добавить фильтр), чтобы запустить поиск пользователя. Все фильтры, применённые к 

поиску, перечисляются выше результатов поиска. Вы можете добавить или удалить 

(используя соответствующие отмечаемые окошки) фильтры в ваших критериях поиска как 

вам нужно. Эти фильтры сохраняются в течение единственной сессии Moodle. 

3.2.1.2.См. также 
 Обновить профиль. 

3.2.2.Действия с массовым пользователем 
Как отправить сообщения, подтвердить, загрузить или выполнить другие действия 

с массовым пользователем глобально. 

Средство действий с массовым пользователем в 

AdministratorSite administrationUsersAccountsBulk user actions позволяет 

Администраторам выбирать пользователей путём создания фильтра и выполнения затем 

любых следующих действий: 

 Подтвердить учётные записи пользователей, созданные посредством само-регистрации 

по э-почте (п. 3.1.1.3.), которые ещё не подтверждены пользователем. 

 Отправить сообщение (требует разрешения на обмен сообщениями, см. п. 3.17.4). 

 Удалить учётные записи пользователей. 

 Отобразить список пользователей на странице. 

 Загрузить данные пользователя из файла в текстовом, ODS или Excel формате. 

 Заставить пользователей изменить их пароли. 

 Добавить пользователей в Когорту. 

http://docs.moodle.org/24/en/Update_profile
http://docs.moodle.org/24/en/File:customfilter.png
http://docs.moodle.org/24/en/File:customfilter.png
http://docs.moodle.org/24/en/Update_profile
http://docs.moodle.org/24/en/Cohorts
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3.2.2.1.To perform a bulk user action 
 
 If you know them, choose your users from the available list or else click 

Show Advanced to create a filter. 

 Users can be filtered according to full name, surname, first name, email 

address, city/town, country, confirmed, first access, last access, last 

login, username, authentication. (Screenshot 1 below) 

 

 If you have set a custom profile field, this is available too from the 

"Profile" dropdown box (Screenshot 2 below) 

 Select users from the list. 

 Choose an action from the dropdown menu (Screenshot 3 below) 

 Click the Add filter button. 

 Select in the box on the left those users you require and move them to 

the box on the right. 

 From the dropdown box With selected users, choose the action you 

wish to perform and then click Go. 

Screenshot «Show advanced ». 

Screenshot «Filtering with custom profile fields ». 

Screenshot «Choosing a bulk user action ». 

3.2.3.Add a new user 
How to create one individual user account. 

An administrator or manager (or any other user with the capability 

moodle/user:create) can create new user accounts in Settings > Site 

administration > Users > Accounts > Add a new user. (To add users in 

bulk, see Upload users.) 

Screenshot « Add a new user». 

3.2.3.1.General 
3.2.3.1.1.Username 
The user will use this username to log in to the Moodle instance. It needs 

to be unique. This may be changed. A user's name can only contain 

alphabetical letters in lowercase, numbers, hyphen '-', underscore '_', period 

'.', or an at character '@'. 

 

 

 

 

 

3.2.2.1.Чтобы выполнить действие с массовым 
пользователем 
 Если вы их знаете, выберите ваших пользователей из доступного списка или щёлкните 

ещё Show Advanced, чтобы создать фильтр. 

 Пользователи могут быть отфильтрованы в соответствии со своим именем и фамилией, 

по фамилии, по имени, по адресу э-почты, по городу/посёлку, по стране, по 

подтверждённым, по первому доступу, по последнему доступу, по последней 

регистрации, по имени пользователя, по аутентификации (Снимок с экрана 1 ниже). 

 Если вы установили клиентское поле Профиля, это также доступно из ниспадающего 

окошка «Profile» (Снимок с экрана 2 ниже). 

 Выберите пользователей из этого списка. 

 Выберите действие из ниспадающего меню (Снимок с экрана 3 ниже). 

 Щёлкните кнопку Add filter. 

 Выберите в окошке слева тех пользователей, которых нужно переместить в окошко 

справа. 

 Из ниспадающего окошка With selected users (с выбранными пользователями) выберите 

действие, которое хотите выполнить и затем щёлкните Go (выполнять). 

Снимок с экрана 1 «Показать расширенное». 

Снимок с экрана 2 «Фильтрация по клиентским полям Профиля». 

Снимок с экрана 3 «http://docs.moodle.org/24/en/File:Bulkuser.png». 

3.2.3.Добавить нового пользователя 
Как создать одну учётную запись индивидуального пользователя. 

Администратор или Менеджер (или любой другой пользователь с Возможностью 

moodle/user:create) могут создать новые учётные записи пользователей в 

AdministratorSite administrationUsersAccountsAdd a new user. (Чтобы добавить 

пользователей в массовом порядке, см. п. 3.2.4.) 

Снимок с экрана «Добавить нового пользователя». 

3.2.3.1.Общие настройки 
3.2.3.1.1.Идентифицирующее имя пользователя 

Пользователь использует это имя пользователя, чтобы войти в конкретный 

экземпляр Moodle. Оно должно быть уникальным. Оно может быть изменено. 

Идентифицирующее имя пользователя может содержать только строчные буквы алфавита, 

цифры, тире «-», подчерк «_», точку «.» или символ «@». 

http://docs.moodle.org/24/en/File:Bulkuserfilter.png
http://docs.moodle.org/24/en/File:customfilter.png
http://docs.moodle.org/24/en/File:Bulkuser.png
http://docs.moodle.org/24/en/File:Addanewuser.png
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3.2.3.1.2.Authentication method 
The setting specifies how Moodle will check whether the user's specified 

password is correct. 

Accounts created by an administrator use the Manual Accounts method, 

and accounts created by the user themselves using the email sign-up 

method use the E-mail based self-registration method. 

 

3.2.3.1.3.Suspended account 
Suspended user accounts cannot log in or use web services, and any 

outgoing messages are discarded. 

3.2.3.1.4.Password 
This is the user's password. It is subject to the password policy in Site 

policies. A user can change their password by the Settings block > My 

Profile settings > Change password link. 

3.2.3.1.5.First Name 
The user's first name. It is displayed along with the last name in messages, 

forum posts, participants list, reports and anywhere where something about 

the user is shows on the page. 

3.2.3.1.6.Surname 
The user's surname. It is displayed along with the first name in messages, 

forum posts, participants list, reports and anywhere where something about 

the user is shows on the page. 

3.2.3.1.7.Email address 
Password reset notices, forum digests and other messages are sent to this 

email address from the Moodle site. 

3.2.3.1.8.Email display 
This setting controls who can see the user's email address. 

3.2.3.1.9.Email format 
This setting can be used such that Moodle will send text-only emails to the 

user. 

3.2.3.1.10.Email digest type 
This setting set whether the user will receive an email for each new forum 

post in subscribed forums, or if new posts should be sent once per day in a 

digest, and which type of digest. 

 No digest (one receives individual emails), 

 Complete (a single digest daily) or 

 Subjects (a single digest daily with only the post topics included). 

 

3.2.3.1.2.Метод аутентификации 
Эта настройка указывает, как Moodle будет проверять корректность указанного 

пароля пользователя. 

Учётные записи, созданные Администратором, используют метод Manual Accounts 

(создание учётных записей вручную), а учётные записи, созданные самими 

пользователями, использующими метод записи по э-почте, используют метод 

саморегистрации по э-почте. 

3.2.3.1.3.Приостановленная учётная запись 
Приостановленные учётные записи пользователя не позволяют войти в Систему 

или использовать веб-сервисы, и любые исходящие сообщения отвергаются. 

3.2.3.1.4.Пароль 
Это пароль пользователя. Он связан с политикой паролей, принятой в политиках 

Сайта. Пользователь может изменить свой пароль посредством ссылки 

AdministratorCourse administrationMy Profile settingsChange password. 

3.2.3.1.5.Имя 
Имя пользователя (в отличие от фамилии). Оно отображается наряду с фамилией в 

сообщениях, корреспонденциях форумов, списке Участников, отчётах и везде, где о 

пользователе что-нибудь показывается на странице. 

3.2.3.1.6.Фамилия 
Фамилия пользователя. Она отображается наряду с именем в сообщениях, 

корреспонденциях форумов, списке Участников, отчётах и везде, где о пользователе что-

нибудь показывается на странице. 

3.2.3.1.7.Адрес э-почты 
Извещения о восстановлении пароля, дайджесты форумов и другие сообщения 

посылаются с Сайта Moodle на этот адрес э-почты. 

3.2.3.1.8.Отображение э-почты 
Эта настройка контролирует, кто может видеть адрес э-почты пользователя. 

3.2.3.1.9.Формат э-почты 
Эта настройка может быть использована так, что Moodle будет отсылать 

пользователю только текстовые почтовые корреспонденции. 

3.2.3.1.10.Тип почтового дайджеста 
Эта настройка устанавливает, будет ли пользователь получать э-почту по каждой новой 

почтовой корреспонденции Форумов, на которые он подписан, или новые почтовые 

корреспонденции будут отсылаться один раз в день в дайджесте, а также тип дайджеста. 

 No digest (нет дайджеста – пользователь получает отдельные электронные письма). 

 Complete (завершённый – единственный дайджест ежедневно) или 

 Subjects (темы – единственный дайджест ежедневно, содержащий только темы 

почтовых корреспонденций). 
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 3.2.3.1.11.Forum auto-subscribe 
If a user subscribes to a forum, new posts will be sent in the digest as 

specified. This setting sets whether a user is automatically subscribed to 

forums or if a manual click on the subscription button in each forum is 

required. 

3.2.3.1.12.Forum tracking 
THis setting specifies whether new posts written since the user's last visit 

should be highlighted as such. 

3.2.3.1.13.When editing text 
This setting specifies whether the user prefers to see the WYSIWYG text 

editor or just a plain text box. 

3.2.3.1.14.Screen Reader 
Enabling this setting will improve the display of Moodle to make it more 

compatible with screen readers. 

3.2.3.1.15.City/town 
The user's city or town. 

3.2.3.1.16.Country 
The user's country. 

Note: City and country defaults may be set in Settings > Site 

administration > Location > Location settings. 

3.2.3.1.17.Timezone 
This setting is used to adjust the times of messages and assignment/quiz 

due dates to match the user's local time. 

3.2.3.1.18.Preferred language 
This will cause the Moodle interface to be displayed in the specified 

language. (See Language packs) 

Note: Content will not be translated automatically, but if multi-language 

content is entered the appropriate language content will be displayed, if 

available. 

3.2.3.1.19.Description 
Information about the user that other users can see. 

3.2.3.2.User Picture 
The user's picture can be displayed next to the user's name next to any 

content he/she has posted in Moodle activities such as the forum. See User 

pictures for details. 

3.2.3.3.Interests 
The list of interests can be used as a way of connecting users with 

3.2.3.1.11.Автоподписка на Форумы 
Если пользователь подписался на Форум, новые почтовые корреспонденции будут 

отсылаться в дайджест, как указано. Эта настройка устанавливает, автоматически ли 

пользователь подписывается на Форумы, или если только вручную щёлкнет по кнопке 

подписки в каждом Форуме, который ему потребуется. 

3.2.3.1.12.Отслеживание Форума 
Эта настройка указывает, будут ли новые (с момента последнего посещения 

Форума пользователем) почтовые корреспонденции подсвечиваться при отображении. 

3.2.3.1.13.При редактировании текста 
Эта настройка указывает, предпочитает ли пользователь видеть текстовый 

редактор «Что видишь, то и имеешь» или просто обычное текстовое окошко. 

3.2.3.1.14.Читатель экрана 
Включение этой настройки улучшит отображение Moodle, сделает его более 

удобным для читателей экрана. 

3.2.3.1.15.Город/посёлок 
Город или посёлок пользователя. 

3.2.3.1.16.Страна 
Страна пользователя. 

Замечание: Город и страна по умолчанию могут быть установлены в 

AdministratorSite administrationLocationLocation settings. 

3.2.3.1.17.Временная зона 
Эта настройка используется для подстройки времени сообщений и дат 

Задания/Экзамена к местному поясному времени пользователя. 

3.2.3.1.18.Предпочитаемый язык 
Эта настройка приведёт к отображению интерфейса Moodle на указанном языке. 

(См. Языковые пакеты в п. 3.9.3) 

Замечание: Содержимое не будет транслироваться автоматически, но, если введено 

многоязыковое содержимое, это содержимое по возможности будет отображаться на 

подходящем языке. 

3.2.3.1.19.Описание 
Информация о пользователе, которую могут видеть другие пользователи. 

3.2.3.2.Портрет пользователя 
Фотография пользователя может быть отображена рядом с именем пользователя, 

сопровождаемым любым содержимым, которое он/она отправили в 

Интерактивные Действия Moodle такие как Форум. Подробности см. в п. 3.2.5. 

3.2.3.3.Интересы 
Список интересов может быть использован как способ связи пользователей по 
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similar interests. Tags must be enabled on the site. 

3.2.3.4.Optional 
There are several optional fields that come with an standard install. These 

include: Web Page, ICA number, Skype ID, AIM ID, Yahoo ID, MSN ID, 

ID number, Institution, Department, Phone, Mobile Phone, Address. 

The site administrator may add more custom fields and/or turn off any of 

these "optional" fields. 

3.2.4.Upload users 
How to bulk create new user accounts 

An administrator can upload multiple user accounts via text file in Settings 

> Site administration > Users > Accounts > Upload users. 

There are many robust options for uploading information (fields associated 

with a user) with this method: from enrolling users in multiple courses with 

course specific roles to updating user information in the User profile to 

deleting users from the site. 

Rather than uploading the text file, it can simply dragged from the desktop 

and dropped into the upload area, as demonstrated in the screencast Drag 

and drop new users into Moodle 2.3 (by Mary Cooch). 

Tip: It is usually not necessary to upload users in bulk with Upload users. 

To keep maintenance work down you should first explore forms of 

authentication that do not require manual maintenance, such as connecting 

to existing external databases or letting the users create their own accounts 

(Self enrolment).  

 

See Authentication for more information. 

Screenshot «Initial upload users screen»/ 

3.2.4.1.Upload user process 
Here is an outline of the process: 

 Create file for uploading 

 Go to Settings>Site administration>Users>Accounts>Upload users 

 Add file to upload 

 Upload users preview - check settings and default user profile settings 

 

 Upload users preview - click "Upload users" 

 Upload users results - shows list of users, exceptions made in upload 

and summary of number of users 

 Upload users results - click "Continue" 

 Returns to Upload users screen 

 

схожим интересам. На Сайте должны быть разрешены теги. 

3.2.3.4.По выбору 
Существует несколько дополнительных полей, которые могут приходить со 

стандартной установкой. Это: Web Page, номер ICA, Skype ID, AIM ID, Yahoo ID, MSN ID, 

номер ID, Организация, Отдел, телефон, Мобильный телефон, Адрес. 

Администратор Сайта может добавить дополнительные клиентские поля (см. 

п. 3.2.6) и/или отключить любые из этих полей «по выбору». 

3.2.4.Загрузить пользователей 
Как создавать новые учётные записи пользователей оптом. 

Администратор может загрузить учётные записи пользователей оптом посредством 

текстового файла в AdministratorSite administrationUsersAccounts Upload user. 

Существует много здравых опций для загрузки информации (полей, связанных с 

пользователем) этим методом: от зачисления пользователей на несколько Курсов с их 

специфическими Ролями в каждом Курсе до обновления информации о пользователе в 

Профиле пользователя, вплоть до удаления пользователей с Сайта. 

Вместо пересылки текстового файла можно просто его отбуксировать с рабочего 

стола в область пересылки как продемонстрировала Мэри Куч в фильме с экрана 

«Буксировка новых пользователей в Moodle 2.3». 

Совет: Обычно нет необходимости пересылать пользователей в большом 

количестве в разделе «Upload users (загрузить пользователей)». Чтобы сократить 

сопроводительную работу, вы должны, во-первых, расширить формы аутентификации, 

которые не требуют ручного обслуживания, такие как подсоединение к существующим 

внешним базам данных или предоставление пользователям их собственных учётных 

записей (самоЗачисление себя на Курс) 

Больше информации приведено в п. 3.1 «Аутентификация». 

Снимок с экрана «Начальный экран пересылки пользователей». 

3.2.4.1.Процесс загрузки пользователя 
Здесь очерчены контуры этого процесса: 

 Создайте файл для пересылки. 

 Перейдите к AdministratorSite administrationUsersAccountsUpload user. 

 Добавьте файл в Upload (область загрузки на экране «Upload users»). 

 Предварительный просмотр экрана «Upload users» – проверьте настройки и настройки 

Профиля пользователя по умолчанию. 

 Предварительный просмотр экрана «Upload users» – щёлкните «Upload users». 

 Экран результатов загрузки пользователей – показывает список пользователей, не 

включённых в загрузку и общее число пользователей.  

 Экран результатов загрузки пользователей – щёлкните «Continue (продолжить)». 

 Возврат к экрану «Upload users». 

http://youtu.be/6E-TQXTkZB0
http://docs.moodle.org/24/en/File:uploadusersnew.png
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3.2.4.2.Updating users preview 
 
There are settings for the kind of Upload user function you want to 

perform on the "Upload users preview" page. 

 

Screenshot «Upload users preview in Moodle 2.x». 

 

3.2.4.2.1.Updating existing accounts 
By default Moodle adds new user accounts and skips existing users lines 

where the username matches an existing account. Set "Upload Type" to 

Add new and update existing users, and existing user account will be 

updated. 

 

 Add all, append number to usernames if needed 

 

 Add new and update existing users 

 Update existing users only 

Warning: errors updating existing accounts can affect your users badly. Be 

careful when using the options to update. 

 

3.2.4.2.2.Additional Options 
There are also fields settings to force password change, allow renames, 

allow deletes, prevent email address duplicates, standardise usernames and 

select for bulk operations (new users updated users, all users). 

 

 Standardise usernames - This folds username to lowercase and strips 

out illegal characters. This is roughly equivalent to: 

 

$username = preg_replace('/[^-\.@_a-z0-9]/', , $username); 

3.2.4.2.3.Set default user values 
You may be able to set default user field values, if the fields were not 

included in the uploaded file on this page. 

3.2.4.3.Upload user results 
After accepting the preview settings by clicking on "Upload users", you 

should see the the Upload users results screen. 

Screenshot «The results screen; everything went well!». 

This screen will show you any exceptions or changes that were made to 

each user in the upload process. For example if you 

3.2.4.2.Предварительный просмотр обновления 
пользователей 

Существуют настройки для, в некотором роде, функции Upload user, которые вы 

хотите выполнить на странице «Upload users preview (предварительный просмотр загрузки 

пользователей)». 

Снимок с экрана «Предварительный просмотр загрузки пользователей в Moodle 

2.x». 

3.2.4.2.1.Обновление существующих учётных записей 
По умолчанию Moodle добавляет новые учётные записи пользователей и 

пропускает существующие строки пользователей, где Username (имя, идентифицирующее 

пользователя) соответствует существующей учётной записи. Установите «Upload Type» 

для Add new and update existing users, и существующая учётная запись пользователя 

будет обновлена. 

 Добавьте всё, присоединяя номер к именам, идентифицирующим пользователей, если 

необходимо. 

 Добавьте новых и обновите существующих пользователей. 

 Обновите только существующих пользователей. 

Предупреждение: ошибки обновления существующих учётных записей могут 

плохо отозваться на ваших пользователях. Будьте осторожны, когда используете опции 

для обновления. 

3.2.4.2.2.Дополнительные опции 
Существуют также настройки принудительного изменения пароля, позволения 

переименования, позволения удалений, предотвращения дублирования адресов э-почты, 

стандартизации имён, идентифицирующих пользователей, и выбора массовых операций (с 

новыми обновляемыми пользователями, всеми пользователями). 

 Стандартизация имён, идентифицирующих пользователей, – это свёртка имени, 

идентифицирующего пользователя, к написанию строчными буквами без применения 

недопустимых символов. Это примерно эквивалентно: 

$username = preg_replace('/[^-\.@_a-z0-9]/', , $username); 
3.2.4.2.3.Установить значения пользователя по умолчанию 

Вы можете быть в состоянии устанавливать значения полям пользователя по 

умолчанию, если эти поля не были включены в файл обновлений на этой странице. 

3.2.4.3.Результаты пересылки пользователей 
После принятия настроек предварительного просмотра щелчком по «Upload users» 

вы можете увидеть экран Upload users results (результаты загрузки пользователей). 

Снимок с экрана «Экран результатов; всё прошло хорошо!». 

Этот экран покажет вам любые отклонения от нормы или изменения, которые были 

сделаны по каждому пользователю в процессе загрузки. Например, если вы 

http://docs.moodle.org/24/en/File:Upload_users_preview_2.0.JPG
http://docs.moodle.org/24/en/File:Upload_users_preview_2.0.JPG
http://docs.moodle.org/24/en/File:Upload_users_results_2.0.JPG
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were updating user information, the updated information will be shown. Or 

if a user was not added that record will be highlighted. 

The screen will summarize how many users were uploaded or updated, 

indicate the number of weak passwords and the number of errors. 

3.2.4.4.File formats for upload users file 
The upload users file has fields separated by a comma (or other delimiter) 

ONLY - no space. The first line contains the valid field names. The rest of 

the lines (records) contain information about each user. 

 

Tip: Avoid special characters in field information like quotes or other 

commas. Test a file with only one record before a large upload. Remember 

there are other ways to authenticate users on you site or enroll users in a 

course. 

Tip: You can use a spread sheet program to create the file with the required 

columns and fields. Then save the file as "CSV (comma delimited)". These 

files can be opened with simple text editors for verification. 

 

3.2.4.4.1.Valid upload file for testing 
 
Here is an example of a simple valid upload file: 

username,password,firstname,lastname,email,course1,group1,cohort1 

jonest,verysecret,Tom,Jones,jonest@someplace.edu,math102,Section 

1,year 3 

reznort,somesecret,Trent,Reznor,reznort@someplace.edu,math102,Section 

3,year 4 

3.2.4.4.2.Fields that can be included 
Tip: We strongly recommend that you test a file that contains fields you 

proposed to use with one user before attempting a file upload for the first 

time. http://demo.moodle.net might be a good place to see if your test file 

works. 

Required fields: 
username,firstname,lastname,email 

Validity checks are performed for: 

 username can only contain alphabetical lowercase letters, numbers, 

hypen '-', underscore '_', period '.', or at-sign '@' 

 email is in the form: name@example.com. 

 

 

 

обновляете информацию пользователя, будет показана обновлённая информация. Или, 

если пользователь не был добавлен, эта учётная запись будет подсвечена. 

Этот экран подытожит, как много пользователей было переслано или обновлено, 

укажет число недельных паролей и число ошибок. 

3.2.4.4.File formats for upload users file 
Файл пересылки пользователей имеет поля, отделённые запятой (или другим 

разделителем) ТОЛЬКО НЕ пробелом. ПЕРВАЯ СТРОКА содержит действительные 

имена полей (учётной записи). Оставшиеся строки (записи) содержат информацию о 

каждом пользователе. 

Совет: Избегайте специальных символов в информации поля подобных кавычкам 

или другим запятым. Тестируйте файл только с одной записью перед большой 

пересылкой. Помните, существуют другие способы аутентификации пользователей на 

вашем Сайте или зачисления пользователей на Курс. 

Совет: Вы можете использовать программу крупноформатных таблиц, чтобы 

создать файл с требуемыми колонка и полями. Затем сохраните этот файл как «CSV 

(разделённый запятыми с расширением .csv)». Эти файлы могут быть открыты простыми 

текстовыми редакторами для проверки. 

3.2.4.4.1.Действительный файл пересылки для 
тестирования 

Здесь приведён пример простого действительного файла пересылки: 

username,password,firstname,lastname,email,course1,group1,cohort1 

jonest,verysecret,Tom,Jones,jonest@someplace.edu,math102,Section 1,year 3 

 

reznort,somesecret,Trent,Reznor,reznort@someplace.edu,math102,Section 3,year 4 

 

3.2.4.4.2.Поля, которые могут быть включены 
Совет: Мы строго рекомендуем, чтобы вы тестировали файл, который содержит 

поля, которые вы предполагаете использовать, с одним пользователем, перед попыткой 

пересылки файла в первый раз. http://demo.moodle.net может быть хорошим местом, чтобы 

увидеть, работает ли ваш тестовый файл. 

Требуемые поля: 
username,firstname,lastname,email 

Проверка достоверности выполняется для: 

 username может содержать только строчные буквы алфавита, цифры, дефис «-», 

подчёркивание «_», пробел « » или знак «эт @». 

 email заносится в виде: name@example.com. 
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Password field: "password" field is optional if "Create password if 

needed" setting is chosen (default). 

 If included, values should meet the requirements for the site's Password 

policy. To force password change for a particular user, set the password 

field to changeme. 

 If omitted, a password will be generated for each user (during the next 

Cron job) and welcome e-mails sent out. 

 Note: the text for the welcome e-mail is in the language settings. Please 

refer to this forum thread for details. 

Optional fields: To provide values other than the default include one 

or more of these 

institution,department,city,country,lang,auth,timezone,idnumber,icq,phone

1,phone2,address,url,description,mailformat,maildisplay,htmleditor,autosu

bscribe 

 Country - use a country TWO LETTER CODE 

 Some fields have a maximum number of characters that are allowed 

(notably institution should be 40 characters long). See hints below. 

 

 Maildisplay, htmleditor and autosubscribe can be set from an import 

screen. 

Custom profile field names: (Optional). xxxxx is the real custom 

user profile field name (i.e. the unique shortname) 

profile_field_xxxxx 

Create the custom fields BEFORE importing. Use the standard header. The 

"shortname" for your custom field is xxxxx (NB the shortname must be all 

lowercase, otherwise won't be recognised). The first record must include 

"profile_field_xxxxx". 

 

Example: To create a custom field "genre", you must write a shortname 

"genre" in the new field, and write "profile_field_genre" in the header of 

the .csv file. 

For custom profile fields that are a menu, use the corresponding value 

(new in Moodle 2.3 onwards). 

Example: A custom field 'Department' with one of three values 'HR', 

'Marketing' or 'Training'. Just insert one of those three words (e.g. 

'Training') as the value for that field. 

Special fields: Used for changing of usernames or deleting of users 

oldusername, deleted 

 

Поле Password: поле «пароль» необязательно, если выбрана настройка (по 

умолчанию) «Create password if needed (создайте пароль, если необходимо)». 

 Если включено, его значения столкнутся с требованиями политики паролей города. 

Чтобы заставить изменить пароль для конкретного пользователя, установите поле 

Password в changeme. 

 Если опущено, пароль будет сгенерирован для каждого пользователя (во время 

очередной работы Хрона) и будет отправлена э-почта с приветствием. 

 Замечание: Текст для приветствия по э-почте находится в настройках языка. 

Пожалуйста, обращайтесь за подробностями к этому форуму. 

Поля по выбору: чтобы предоставить значения, отличные от значений по 

умолчанию, включите одно или более следующих строк: 

institution,department,city,country,lang,auth,timezone,idnumber,icq,phone1,phone2,address,url,d

escription,mailformat,maildisplay,htmleditor,autosubscribe 

 

 Country – используйте ДВУХБУКВЕННЫЙ КОД страны. 

 Некоторые поля имеют максимальное число символов, которые разрешены (что 

касается образования, они должны быть не боле 40 символов в длину). См. советы 

ниже. 

 Maildisplay (отображение почты), htmleditor (HTML-редактор) и autosubscribe 

(автоподписка) могут быть установлены с экрана импорта. 

Клиентские названия полей Профиля: (по выбору). xxxxx – это реальное 

клиентское название поля Профиля пользователя (т.е. уникальное краткое название) 

profile_field_xxxxx. 

Создайте клиентские поля ПЕРЕД импортированием. Используйте стандартный 

заголовок. «shortname (краткое название)» для вашего клиентского поля есть xxxxx 

(ОБРАТИТЕ особое внимание на то, что краткое название должно состоять из строчных 

букв, иначе оно будет не распознано). Первая запись должна включать 

«profile_field_xxxxx». 

Пример: чтобы создать клиентское поле «genre», вам нужно написать краткое название 

«genre» в этом новом поле и написать «profile_field_genre» в заголовке csv –файла. 

 

Для клиентских полей Профиля, которые представляют собой меню, используйте 

соответствующее значение (новое средство начиная с Moodle 2.3). 

Пример: клиентское поле «Department» с одним из трёх значений «HR», «Marketing» 

или «Training». Просто вставьте одно из этих трёх слов (например, «Training») в качестве 

значения для этого поля. 

Специальные поля: используемые для изменения имён, идентифицирующих 

пользователя, или удаления пользователей 

oldusername, deleted. 

https://moodle.org/mod/forum/discuss.php?d=210359&parent=917138
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Enrolment fields: (Optional): 

course1,type1,role1,group1,enrolperiod1,course2,type2,role2,group2,enrol

period2 etc. 

 course is the "shortname" of the course, if present the user will be 

enrolled in those courses. 

 type refers to the role to be used for associated course enrolment. Value 

1 is default course role, 2 is legacy Teacher role and 3 is legacy Non-

editing Teacher. 

 

 You can use role field instead to specify roles directly - use either role 

short name or id (numeric names of roles are not supported). 

 

 Users may be also assigned to groups in course (group1 in course1, 

group2 in course2, etc.). 

 A group is identified by name or id (numeric group names are not 

supported) 

 You can set the enrolment duration, in days, for each course 

(enrolperiod1 for course1, enrolperiod2 for course2, etc.). 

Cohort field: (Optional): 
cohort1 

Internal cohort id numbers or non-numeric Cohort IDs of existing cohorts 

must be used, names are not allowed. 

Commas within a field must be encoded as &#44 - the script will decode 

these back to commas. 

For Boolean fields, use 0 for false and 1 for true. 

To prevent users from receiving a large number of emails from courses or 

forced subscription forums use the maildigest. The options for this field are 

0 = No digest, 1 = Complete digest and 2 = Digest with just subjects. 

 

3.2.4.5.Advanced potentials of Upload user 
 
3.2.4.5.1.Templates 
Note: This section needs checking and updating if necessary for Moodle 

2.0. Please do so and remove this note when finished. 

The default values are processed as templates in which the following codes 

are allowed: 

 

 

 

Поля зачисления на Курс (по выбору): 

course1,type1,role1,group1,enrolperiod1,course2,type2,role2,group2,enrolperiod2 и т.д. 

 

 course – «shortname (краткое название)» Курса, если Курс с таким названием 

существует, этот пользователь будет на него зачислен. 

 type ссылается на Роль, которая будет использована при зачислении на 

соответствующий Курс. Значение 1 – Роль, принятая на Курсе по умолчанию, 2 – 

унаследованная Роль Преподавателя, 3 – унаследованная Роль не редактирующего 

Преподавателя. 

 Вы можете использовать поле Роли вместо указания Роли напрямую – используйте 

либо краткое название Роли, либо её идентификатор (цифровые имена Ролей не 

поддерживаются). 

 Пользователи могут также распределены по Группам в Курсе (Группа 1 в Курсе 1, 

Группа 2 в Курсе 2 и т.д.). 

 Группа идентифицируется названием или идентификатором (цифровые имена Групп не 

поддерживаются). 

 Вы можете установить продолжительность зачисления на Курс в днях для каждого 

Курса (период зачисления 1 для Курса 1, период зачисления 2 для Курса 2 и т.д.). 

Поле Когорты (по выбору): 

cohort1 

Должны быть использованы внутренние числовые идентификаторы Когорты или 

нечисловая идентификация существующих Когорт, имена не разрешаются. 

Запятая внутри поля должна быть закодирована как &#44 – скрипт (программа на 

макроязыке) декодирует эту последовательность обратно в запятую. 

Для логических полей используйте 0 для Ложь, 1 для Истина. 

Чтобы предохранить пользователей от получения большого числа почтовых 

отправлений из Курсов или принудительной подписки на Форумы, используйте maildigest 

(почтовый дайджест). Опции для этого поля: 0 – нет дайджеста, 1 – полный дайджест, 2 – 

дайджест просто из тем. 

3.2.4.5.Продвинутые возможности пересылки 
пользователя 
3.2.4.5.1.Шаблоны 

Замечание: Этот раздел нуждается в проверке, если необходимо, для Moodle 2.0. 

Пожалуйста, сделайте это и удалите это замечание, когда закончите. 

Значения по умолчанию обрабатываются как шаблоны, в которых разрешены 

следующие коды: 
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 %l - will be replaced by the lastname 

 %f - will be replaced by the firstname 

 %u - will be replaced by the username 

 %% - will be replaced by the % 

Between the percent sign (%) and any code letter (l, f or u) the following 

modifiers are allowed: 

 (-) minus sign - the information specified by the code letter will be 

converted to lowercase 

 (+) plus sign - the information specified by the code letter will be 

converted to UPPERCASE 

 (~) tilde sign - the information specified by the code letter will be 

converted to Title Case 

 a decimal number - the information specified by the code letter will be 

truncated to that many characters 

For example, if the firstname is John and the lastname is Doe, the 

following values will be obtained with the specified templates: 

 %l%f = DoeJohn 

 %l%1f = DoeJ 

 %-l%+f = doeJOHN 

 %-f_%-l = john_doe 

http://www.example.com/~%u/ results in http://www.example.com/~jdoe/ 

(if the username is jdoe or %-1f%-l) 

Template processing is done only on default values, and not on the values 

retrieved from the CSV file. 

In order to create correct Moodle usernames, the username is always 

converted to lowercase. Moreover, if the "Allow extended characters in 

usernames" option in the Site policies page is off, characters different to 

letters, digits, dash (-) and dot (.) are removed. For example if the 

firstname is John Jr. and the lastname is Doe, the username %-f_%-l will 

produce john jr._doe when Allow extended characters in usernames is on, 

and johnjr.doe when off. 

 

When the "New username duplicate handling" setting is set to Append 

counter, an auto-increment counter will be append to duplicate usernames 

produced by the template. For example, if the CSV file contains the users 

named John Doe, Jane Doe and Jenny Doe without explicit usernames, the 

default username is %-1f%-l and New username duplicate handling is set 

to Append counter, then the usernames produced will be jdoe, jdoe2 and 

jdoe3. 

 

 %l – будут замещены фамилией. 

 %f – будут замещены именем. 

 %u – будут замещены идентификационным именем пользователя. 

 %% – будут замещены %. 

Между знаком процента (%) и любой буквой кода (l, f или u) разрешены 

следующие модификаторы: 

 (-) знак минус – информация, указанная буквой кода, будет конвертирована в строчные 

буквы. 

 (+) знак плюс – информация, указанная буквой кода, будет конвертирована в 

ПРОПИСНЫЕ буквы. 

 (~) знак тильда – информация, указанная буквой кода, будет конвертирована в 

Заголовок. 

 Десятичное число – информация, указанная буквой кода, будет усечена до этого 

количества символов. 

Например, если имя есть John, а фамилия – Doe,тогда следующие значения будут 

получены по указанным шаблонам: 

 %l%f = DoeJohn 

 %l%1f = DoeJ 

 %-l%+f = doeJOHN 

 %-f_%-l = john_doe 

http://www.example.com/~%u/ приведёт к http://www.example.com/~jdoe/ (если 

идентификационное имя пользователя есть jdoe или %-1f%-l). 

Обработка шаблона выполняется только над значениями по умолчанию, но не над 

значениями, полученными из CSV-файла. 

Для того чтобы создать правильные идентификационные имена пользователей 

Moodle, идентификационное имя пользователя всегда конвертируется в строчные буквы. 

Более того, опция «Allow extended characters in usernames (разрешить расширенные 

символы в идентификационных именах пользователей)» на странице политик Сайта 

выключена, символы отличные от букв, цифр, тире (–) и точки (.) удаляются. Например, 

имя John Jr. и фамилия Doe, идентификационное имя пользователя %-f_%-l образуют john 

jr._doe, когда опция «Allow extended characters in usernames» включена, и johnjr.doe, когда 

она выключена. 

Когда настройка «New username duplicate handling (обработка дубликатов 

идентификационных имён пользователей)» установлена в Append counter (счётчик 

добавлять), тогда счётчик авто-приращения добавит к дубликатам идентификационных 

имён пользователей образуемое по шаблону. Например, если CSV-файл содержит 

пользователей с именами John Doe, Jane Doe и Jenny Doe без явных идентификационных 

имён пользователей, идентификационное имя пользователя по умолчанию есть %-1f%-l, 

«New username duplicate handling» установлена в Append counter, тогда образуемые 

идентификационные имена пользователей будут jdoe, jdoe2 и jdoe3. 
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3.2.4.5.2.Deleting accounts 
If the deleted field is present, users with value 1 for it will be deleted. In 

this case, all the fields may be omitted, except for username. After 

uploading the file, be sure to change the "Upload type" to "Update existing 

users only" and the "Allow deletes" option to "Yes". 

 

Tip: A similar field is available for suspended. This enables a user account 

to be temporarily disabled rather than completely removed. 

Deleting and uploading accounts could be done with a single CSV file. For 

example, the following file will add the user Tom Jones and delete the user 

reznort: 

username,firstname,lastname,deleted 

jonest,Tom,Jones,0 

reznort,,,1 

3.2.4.6.Encoding file format 
On the initial Upload user screen, you may select the file encoding format 

from a pull down list. These include UTF-8 (the default), ASCII, ISO-

8859-1 to ISO-8859-11 or any one of over 36 formats. 

3.2.4.7.Hints 
3.2.4.7.1.Spreadsheet 

If you use a spreadsheet program such as Excel to create your .csv 

file, check the resulting output in a text editor before you before you 

upload it. It is possible to get trailing commas on each line from an empty 

field if you have added and deleted columns of information prior to saving 

the final file. Also check the character encoding. A csv file is a simple text 

file (ASCII or Unicode) that can be used to upload user accounts. 

 

Excel translates passwords that begin with - (minus) or + (plus) as zero. 

Even when saving as .csv and saying "Yes" to "Keep this format, and leave 

out any incompatible features." Check for this before uploading, as a zero 

halts the upload process. 

 

If you use a formula in Excel to create fields (for example, the concatenate 

function to create a user name), then remember to copy the cells with the 

formula and use special paste with values checked to make them into an 

acceptable data for a csv file. 

The upload will also fail if you have trailing spaces at the end of your data 

fields. Often, this can not be removed with a simple Find " " and Replace 

with "". If information has been copied from web sources than it is possible  

3.2.4.5.2.Удаление учётных записей 
Если удалённое поле присутствует, то пользователи со значением 1 для него будут 

удалены. В этом случае все поля могут быть опущены за исключением 

идентификационного имени пользователя. После пересылки файла убедитесь в изменении 

«Upload type» в «Update existing users only(обновить только существующих 

пользователей» и установке «Allow deletes (разрешить удаления)» в «Yes». 

Совет: Подобное поле доступно для приостановления. Это разрешено, если 

счётчик пользователя временно отключён, а полностью удалён. 

Удаление и пересылка счётчиков могут быть выполнены с единственным CSV-

файлом. Например, следующий файл добавит пользователя Tom Jones и удалит 

пользователя reznort: 

username,firstname,lastname,deleted 

jonest,Tom,Jones,0 

reznort,,,1 

3.2.4.6.Формат кодировки файла 
На начальном экране Upload user (пересылка пользователя) вы можете выбрать 

формат кодирования файла из ниспадающего списка. Он включает UTF-8 (по умолчанию), 

ASCII, ISO-8859-1 до ISO-8859-11 или любой из 36 форматов дополнительно. 

3.2.4.7.Советы 
3.2.4.7.1.Электронная таблица 

Если вы используете программу электронных таблиц, такую как Excel, для 

создания вашего CSV-файла, проверьте результирующий вывод в текстовом редакторе 

перед его загрузкой. Возможно получение запятых в конце каждой строки из-за пустых 

полей, если вы добавляли и удаляли колонки информации до окончательного сохранения 

файла. Также проверьте кодировку символов. CSV-файл – это просто текстовый файл 

(ASCII или Unicode), который может использоваться для пересылки учётных записей 

пользователей. 

Excel транслирует пароли, которые начинаются с – (минус) или + (плюс), как zero 

(ноль). Даже при сохранении CSV и установке в «Yes» опции «Keep this format, and leave 

out any incompatible features (Сохраните этот формат и не принимайте во внимание любые 

несовместимые средства)». Проверьте это перед загрузкой, так как zero остановит процесс 

пересылки. 

Если вы используете формулы в Excel для создания полей (например, функцию 

конкатенации для создания имени пользователя), тогда не забывайте копировать ячейки с 

формулами и используйте специальное вклеивание со значениями, проверяемыми, чтобы 

сделать их приемлемыми данными для CSV-файла. 

Загрузка также будет ошибочной, если в конце полей ваших данных есть 

хвостовые пробелы. Часто их невозможно удалить простым Find (найти) " " и Replace 

(заменить) "". Если информация скопирована из веб-источников, тогда возможная 
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to include non-breaking spaces which will prevent your upload from being 

completed correctly. To find  these invisible spaces, use the Find and 

Replace function in Excel. In the find field, hold alt and type 0160. Leave 

the replace field blank. 

3.2.4.7.2.Country 
The country should be written as a two letter code, in capitals. For 

example, use BE for Belgium or NL for the Netherlands. Using "be" or 

"nl" as a country code will result in a database error. 

Tip: If you are having trouble working out the two-letter code for a 

country, you can consult the list of country names and code elements 

available on the ISO Website. A common error is to use UK for United 

Kingdom; it should be GB. 

3.2.4.7.3.Field size limits 
Some fields have maximum character lengths. Typically the file will 

import to the preview list screen but not finish the process. Turn on debug 

to see the fields that are too long. Common fields to cause problems are 

"Institution" which is limited to 40 characters, and "City", also limited (20 

characters). The error will be "User not added - error". 

 

3.2.4.7.4.All fields listed here 
All the fields that are valid are listed below, except for any custom fields 

you may have created. 

firstname, lastname, username, email, city, country, lang, timezone, 

mailformat, maildisplay, maildigest, htmleditor, ajax, autosubscribe 

,institution, department, idnumber, skype , msn, aim, yahoo, icq, phone1, 

phone2, address, url, description, descriptionformat, password, auth, 

oldusername , deleted, suspended, course1, course2, course3, course4 

 

 

 

 

 

 

 

 

 

 

 

 

 

вставка неразрывных пробелов может помешать правильно завершиться вашей загрузке. 

Чтобы найти эти невидимые пробелы используйте функции Find и Replace в Excel. В поле 

поиска функции Find удерживая клавишу ALT, наберите 0160. Поле замены функции 

Replace оставьте пустым. 

3.2.4.7.2.Страна 
Страна должна быть записана как двухбуквенный код прописными буквами. 

Например, BE для Belgium (Бельгия) или NL для Netherlands (Нидерланды). 

Использование "be" или "nl" в качестве кода страны приведёт к ошибке в базе данных. 

Совет: Если у вас есть проблемы с выбором двухбуквенного кода для страны, 

сверьтесь со списком имён стран и элементами кодов, доступным на веб-Сайте ISO. 

Общая ошибка состоит в использовании UK для Объединённого королевства, а должно 

быть GB. 

 

3.2.4.7.3.Ограничения размера поля 
Некоторые поля имеют максимальные длины в символах. Обычно файл будет 

импортировать на экран список предварительного просмотра, но не закончит этот процесс. 

Включите отладку, чтобы увидеть поля, которые слишком длинные. Общие поля, 

вызывающие проблемы, это «Institution (организация)», которое ограничено 40 символами, 

и «City (город)», также ограничено (20 символов). Текст ошибки выглядит так «User not 

added – error (пользователь не добавлен – ошибка)». 

3.2.4.7.4.Все поля перечислены здесь 
Все действительные поля за исключением любых клиентских полей, которые 

могут быть созданы, перечислены ниже. 

firstname (имя), lastname (фамилия), username (идентификационное имя пользователя), email (э-

почта), city (город), country (страна), lang (язык), timezone (временная зона), mailformat (формат 

почты), maildisplay (отображение почты), maildigest (почтовый дайджест), htmleditor (редактор 

html), ajax («фоновый» обмен данными браузера с веб-сервером), autosubscribe (авто-подписка), 

institution (организация), department (департамент), idnumber (идентификационный номер), 

skype (текстовая, голосовая связь и видеосвязь через Интернет между компьютерами (IP-

телефония)), msn (клиент службы мгновенных сообщений MSN Messenger), aim (программа 

мгновенного обмена сообщениями, предлагаемая фирмой AOL (America OnLine)), yahoo (э-почта), 

icq («аська» – централизованная служба мгновенного обмена сообщениями сети Интернет), 

phone1 (телефон 1), phone2 (телефон 2), address (адрес), url (единый указатель ресурсов), 

description (описание), descriptionformat (формат описания), password (пароль), auth 

(аутентичный), oldusername (старое идентификационное имя пользователя), deleted (удалено), 

suspended (приостановлено), course1 (Курс 1), course2 (Курс 2), course3 (Курс 3), course4 (Курс 

4). 

http://www.iso.org/iso/country_names_and_code_elements
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3.2.4.8.See also 
 Flat file enrolment 

 User profile fields for details of how to include data about custom user 

profile fields in the upload users file 

Using Moodle forum discussions: 

 Can I auto enroll from Excel? 

 Uploading users to custom roles 

 User upload option: standardise usernames 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.4.8.См. также 
 Плоский файл (п. 3.3.9) зачисление на Курсы. 

 Поля Профиля пользователя (п. 3.2.6) – подробности того, как включить данные о 

клиентских полях Профиля пользователя в файл пересылки пользователей. 

Обсуждения форума по использованию Moodle: 

 Можно автозачислиться на Курсы из Excel?. 

 Пересылка пользователя в клиентские роли. 

 Опция пересылки пользователя: типизация идентификационных имён пользователей. 

https://moodle.org/mod/forum/discuss.php?d=36851
https://moodle.org/mod/forum/discuss.php?d=97903
https://moodle.org/mod/forum/discuss.php?d=181259


 

26 

3.2.5.User pictures 
How to bulk upload profile pictures for users 

3.2.5.1.User pictures 
Every user on Moodle is able to have their own personal profile picture (or 

"avatar") which can be uploaded via their profile. If no picture has been 

uploaded then the default is: 

 

3.2.5.2.Viewing all user pictures 
 An administrator can do a quick check of the user pictures by typing in 

the browser http://www.YOURMOODLESITE.com/userpix when 

logged in as admin. 

 Moodle.org has a modified version of this http://moodle.org/userpics/ - 

which shows to everyone the profile pictures of the 150 most recent 

logged-in users. 

3.2.5.3.Updating user pictures 
Users can update their picture by editing their user profile in Settings > My 

profile > Edit profile. (The site administrator can disable this ability in 

Settings > Site administration > Security > Site policies.) 

 

The user's picture is usually displayed next to the user's name. For 

example, next to content they have has posted in a forum, or in a 

participant list. 

There is a default image that is used by the Moodle site. The site 

administrator can change the default picture for the site by replacing the F1 

and F2 images in the theme or pic folders. Remember to refresh your 

browser to see any picture changes! 

There is a delete box when checked will delete the picture when the profile 

is saved. 

There is a browse button for the user to find and upload a picture file. 

 

The upload image will be reduced and saved in two files of 100px by 

100px and 35px by 35px. 

The picture description appears when the mouse rolls over the picture. 

 

Tip: Want the default picture to be blank? Replace the picture with a file 

that has 1 white pixel. 

 

 

 

3.2.5.Изображения пользователей 
Как оптом загружать изображения из Профилей для пользователей. 

3.2.5.1.Изображения пользователей 
Каждый пользователь Moodle может иметь своё собственное персональное 

изображение в Профиле (или «аватар»), которое может загружаться из Профиля. 

Если никакое изображение не было загружено, тогда используется изображение 

по умолчанию: 

3.2.5.2.Просмотр изображений всех пользователей 
 Администратор может выполнить быструю проверку изображений пользователей, 

напечатав в своём браузере (после регистрации в качестве Администратора) 

http://www.YOURMOODLESITE.com/userpix. 

 Moodle.org имеет модифицированную версию этого http://moodle.org/userpics/ – которая 

показывает каждому из изображений Профиля до 150 самых последних 

зарегистрированных пользователей. 

3.2.5.3.Обновление изображений пользователей 
Пользователи могут обновить их изображение, редактируя свой Профиль 

пользователя в AdministrationMy profile Settings Edit profile. (Администратор Сайта 

может запретить эту возможность в 

AdministrationSite administrationSecuritySite policies.) 

Изображение пользователя обычно отображается рядом с именем пользователя. 

Например, рядом с содержимым, которое они отправили на Форум или в списке 

Участников. 

Существует изображение по умолчанию, которое используется Сайтом Moodle. 

Администратор может изменить изображение по умолчанию для этого Сайта, заменяя 

изображения F1 и F2 в Theme (тема фоновой картинки) или папке изображений Pic. Не 

забудьте освежить ваш браузер, чтобы увидеть любые изменения изображений! 

Существует окно удалений, когда оно помечено изображение будет удалено при 

сохранении содержащего его Профиля. 

Существует кнопка Browse (просмотреть) для того пользователя, которому нужно 

отыскать и переслать файл с изображением. 

Пересылаемое изображение будет уменьшено и сохранено в двух файлах: 100 

пикселей на 100 пикселей и 35 пикселей на 35 пикселей. 

Описание изображение появляется при наведении указателя мышки на это 

изображение. 

Совет: Хотите, чтобы по умолчанию изображение было пустым? Замените 

изображение файлом, который содержит 1 белый пиксель. 

http://www.yourmoodlesite.com/userpix
http://moodle.org/userpics/
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3.2.5.4.Uploading user pictures in bulk 
An administrator can upload a zip file containing user images in Settings > 

Site administration > Users > Accounts > Upload user pictures. 

 

Screenshot «Upload user pictures». 

The image files should be named after the username, the idnumber or the 

id of the student (along with the correct image file extension.) For 

example, a student with the username jbrown98 would have a picture 

called jbrown98.jpg 

 

Image types supported include gif, jpg, and png. 

Image file names are not case sensitive. 

3.2.5.5.Gravatars 
An administrator can enable the use of gravatars in Settings > Site 

administration > Users > Permissions > User policies. If a user has not 

uploaded a user picture, Moodle will check whether the user's email 

address has an associated gravatar and if so, will use the gravatar as the 

user's picture. 

See also (for 2.3.3 onwards) Gravatar default image URLs in Roles 

settings 

3.2.5.6.See also 
 Using Moodle Cannot upload or change profile pictures forum 

discussion 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.5.4.Загрузка изображений пользователей оптом 
Администратор может переслать zip-файл, содержащий изображения 

пользователей в AdministrationSite administrationUsersAccountsUpload user 

pictures. 

Снимок с экрана «Загрузть изображения пользователей». 

Файлы изображений должны именоваться в соответствии с идентификационным 

именем пользователя, идентификационным номером или идентификатором Студента 

(наряду с правильным расширением файла изображения). Например, Студент с 

идентификационным именем пользователя jbrown98 может иметь изображение, 

называемое jbrown98.jpg. 

Поддерживаемые типы изображений включают gif, jpg и png. 

Имена файлов изображений не чувствительны к регистру. 

3.2.5.5.Граватары 
Администратор может разрешить использовать граватары в 

AdministrationSite administrationUsersPermissionsUser policies. Если пользователь 

не переслал изображение пользователя, Moodle проверит, имеет ли почтовый адрес 

пользователя связанного с ним граватара, и если имеет, этот граватар будет изображением 

пользователя. 

См. также (для Moodle 2.3.3 и выше) URLs изображений граватаров по умолчанию 

в настройках Ролей (п. 3.4.3). 

3.2.5.6.См. также 
 Обсуждение форума по использованию Moodle «Не могу переслать или изменить 

изображения Профиля». 

http://docs.moodle.org/24/en/File:Uploaduserpictures.png
https://moodle.org/mod/forum/discuss.php?d=141378
https://moodle.org/mod/forum/discuss.php?d=141378
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3.2.6. User profile fields 
How to create customised profile fields. 

3.2.6.1.Overview 
Administrators can create new user profile categories and fields in Settings 

> Site administration > Users > Accounts > User profile fields. 

Certain fields can be "locked" in Settings>Site 

Administration>Plugins>Authentication>Manual accounts. Users are not 

allowed to change the locked fields. 

Profile fields may be a menu of choices, text area, text input or a checkbox 

and may be required or not. 

New profile fields will appear on each user’s profile page unless "Who is 

this field visible to?" is set to "Not visible" in which case only the 

administrator can see the field. The fields can also be displayed on the 

signup page if "Display on signup page?" is set to "Yes" (although note 

that they will never be displayed if set to "Not visible"). 

 

You can set the order in which your custom profile fields appear under the 

associated profile category using the up/down arrows on the User profiles 

fields page. 

To create a new profile field, select the profile field format you require 

from the dropdown list. 

3.2.6.2.Common Settings 
All new fields must be given a unique Short Name and a Name (this is 

displayed on the profile page). You may also choose to enter a Description 

for the field for your own reference. 

There are also a number of configuration options common to all custom 

profile field types: 

Is this field required? 

This option specifies whether this is a mandatory or optional field for 

user accounts. 

Is this field locked? 

This option determines whether once information is populated in this 

field, it cannot be edited by the user. 

Should the data be unique? 

If you need the information populated in your field to be unique across 

the system (such as an ID number) select Yes to this option and the 

profile page update will perform a validation check on the data entered. 

 

 

3.2.6.Поля Профиля Пользователя 
Как создавать настраиваемые под клиента поля Профиля. 

3.2.6.1.Обзор 
Администраторы могут создавать новые Категории Профилей пользователя и поля 

в AdministratorSite administration UsersAccountsUser profile fields. 

Определённые поля могут быть «заблокированы» в AdministratorSite 

administrationPluginsAuthenticationManual accounts. Пользователям не разрешено 

изменять заблокированные поля.  

Поля Профиля могут представлять собой меню выбора, текстовую область, 

текстовый вход или окошко-флажок и могут быть обязательны или нет. 

Новые поля Профиля на каждой пользовательской странице Профиля, если только 

«Who is this field visible to? (кто это поле видит?)» не установлено в «Not visible (не 

видимо)», в этом случае только Администратор может видеть это поле. Поля могут также 

быть отображены на странице подписки, если «Display on signup page? (отображать 

страницу подписки?)» установлено в «Yes» (хотя заметьте, что они никогда не будут 

отображаться, если установлено «Not visible»). 

Вы можете установить порядок, в котором ваши настраиваемые под клиента поля 

Профиля появляются под связанной Категорией Профиля, используя стрелки вверх/вниз 

на странице полей Профиля Пользователя. 

Чтобы создать новое поле Профиля, выберите формат поля Профиля, который вы 

требуете от ниспадающего списка. 

3.2.6.2.Общие настройки 
Всем новым полям должны быть заданы уникальные «Short Name (краткое 

название)» и «Name (название)» (они отображаются на странице Профиля). Вы можете 

также выбрать ввод описания этого поля в качестве вашей собственной справки. 

Существует также ряд опций конфигурации общих для всех типов настраиваемых 

под клиента полей Профиля. 

Is this field required? (это поле обязательно?) 

Эта опция указывает, обязательно или не обязательно это поле для учётных записей 

пользователя? 

Is this field locked? (это поле заблокировано?) 

Эта опция определяет, не может ли информация, заполнившая это поле, 

редактироваться пользователем. 

Should the data be unique? (должны эти данные быть уникальными?) 

Если вам нужно, чтобы информация, попавшая в это поле, была уникальна во всей 

Системе (так же, как ID-номер), выберите Yes для этой опции и обновления страницы 

Профиля, тогда будет выполнена проверка достоверности введённых данных. 
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Display on signup page? 

Depending on the authentication method in use on your Moodle site, 

you may have some users creating their own accounts. If you would 

like this custom field to appear on the registration or signup page, select 

Yes. 

Who is this field visible to? 

Each custom field can be given one of three visibility settings: 

 Visible to everyone 

 Not visible 

 Visible to user 

The Not visible setting would typically be set by an administrator who 

wants to hold private data on the users. The Visible to user setting 

would normally be selected for a field that holds sensitive information, 

while the Visible to everyone setting can be used for any type of 

information. 

3.2.6.3.Specific Settings 
There are also a few field type Specific Settings requiring configuration 

around default value and size. 

Important 
If the site administrator bulk uploads user data via .csv file, it is essential to 

use the correct convention to represent the new profile field. The 

convention is profile_field_shortname. 

Replace 'shortname' with the actual short name used for the new profile 

field eg. dob. So the field should read something like profile_field_dob. 

 

Also, you will need to visit Settings > Site Administration > Users > 

Accounts > User Profile Fields > Create new Profile Field before 

attempting to upload a file using it. Creating an upload file first with 

custom profile fields without creating the User Profile Fields first in Site 

Administration will result in the error profile_field_shortname is not a 

valid field name. 

 

 

 

 

 

 

 

 

 

Display on signup page? (отображать на странице подписки?) 

В зависимости от метода аутентификации, используемого на вашем Сайте Moodle, вы 

можете иметь некоторых пользователей, создающих свои собственные учётные записи. 

Если вы предпочитаете, чтобы это настраиваемое под клиента поле появлялось на 

странице регистрации или подписки, выберите Yes. 

Who is this field visible to? (кто видит это поле?) 

Каждому настраиваемому под клиента полю может быть задана одна из трёх настроек 

видимости: 

 Visible to everyone (видимо каждому) 

 Not visible (не видимо) 

 Visible to user (видимо пользователю) 

Настройка Not visible типично могла бы быть установлена Администратором, 

который хочет поддерживать личные данные пользователей. Настройка Visible to user 

обычно выбирается для поля, которое содержит деликатную информацию, в то время как 

настройка Visible to everyone может использоваться для любого типа информации. 

3.2.6.3.Специфические настройки 
Существует также несколько специфических настроек типов полей, требующих 

конфигурирования, которые связаны с величиной и размером по умолчанию. 

Важно 
Если Администратор пересылает оптом данные пользователя через .csv-файл, 

важно использовать правильное условное обозначение по представлению нового поля 

Профиля. Этим правильным условным обозначением является profile_field_shortname. 

Замените «shortname» реальным кратким названием, используемым для этого 

нового поля Профиля, например, dob. Так что поле нужно читать что-то наподобие 

profile_field_dob. 

Также вам будет нужно посетить 

AdministratorSite administrationUsersAccountsUser profile fieldsCreate new Profile

 Field до попытки загрузить файл, используя это. Создание сначала файла загрузки с 

настраиваемыми под клиента полями Профиля без создания перед этим User Profile Fields 

(поля профиля пользователя) в Site administration (блок управления Сайтом) приведёт к 

ошибке: profile_field_shortname – не действительное имя поля. 
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3.2.6.4.Examples of use 
3.2.6.4.1.House System 
Many schools have a 'House' system where students and staff are assigned 

to a given House. For example, a school has eight houses, named after its 

founders: Adderton, Coolock, Gorry, Loretto, McAuley, Mercedes, Tighe 

and Whitty. The site administrator can add a user profile field that offers a 

'Menu of choices' to the user. A default value can also be selected. If the 

administrator decides to bulk upload House data for users via a .csv file, it 

is important to represent the above array of values as 1,2,3,4,5,6,7,8 in the 

file. That is to state, if a user belongs to Adderton House, the value '1' 

should be entered for the 'House' user profile field in the given record. 

 

3.2.6.4.2.U.S. States 
This can be used to improve ambiguous postal addresses by including (for 

example) the State. 

 Birthday block (contributed code) 

3.2.6.5.See also 
 dev:User profile fields developer documentation 

3.2.7.Accounts FAQ 
 
3.2.7.1.How can I get my students to sign up 
to my Moodle site? 
Look at how to set up email based self registration. 

3.2.7.2.How can I suspend a user's account? 
 
Tick the 'Suspended account' checkbox on the edit profile page. 

 

3.2.7.3.Can Moodle send a notification e-mails 
automatically to a new user when an account 
is created for them? 
Not at the moment with core Moodle. See Tracker items MDL-19390. 

There is a work around. If you create a CSV for your user, and OMIT the 

password field a cron job does get triggered and an e-mail is sent to the 

user. The text of the e-mail is customisable by an administrator in the 

admin settings. See: 

http://docs.moodle.org/24/en/Upload_users#Fields_that_can_be_included 

3.2.6.4.Примеры использования 
3.2.6.4.1.Домашняя Система 

Многие школы имеют Систему «House (дом)», где Студенты и администрация 

назначаются в данный House. Например, школа имеет восемь домов, названных по имени 

их основателей: Adderton, Coolock, Gorry, Loretto, McAuley, Mercedes, Tighe и Whitty. 

Администратор Сайта может добавить поле Профиля пользователя, которое предлагает 

«Menu of choices (меню выбора)» пользователю. Значение по умолчанию также может 

быть выбрано. Если Администратор решил пересылать данные House для пользователей 

через .csv-file, важно представить вышеприведённый массив значений как 1,2,3,4,5,6,7,8 в 

этом файле. То есть определить, что если пользователь принадлежит Adderton House, то 

для поля «House» Профиля пользователя в данной записи должно быть введено значение 

«1». 

3.2.6.4.2.Американские штаты 
Это может быть использовано для улучшения двусмысленных почтовых адресов 

включением (например) the State (штат), т.е. вместо просто U.S.  U.S. State. 

 Блок дня рождения (предлагаемый независимыми разработчиками код). 

3.2.6.5.См.также 
 Документация разработчика «Поля Профиля пользователя». 

3.2.7.Часто задаваемые вопросы по учётным 
записям 
3.2.7.1.Как подписать моих Студентов на мой Сайт 
Moodle 

Просмотрите, как устанавливать саморегистрацию по э-почте в п. 3.1.4. 

3.2.7.2.Как приостановить действие учётных записей 
пользователей? 

Пометьте окошко-флажок «Suspended account» на странице редактирования 

Профиля. 

3.2.7.3.Может Moodle автоматически послать извещение 
по э-почте новому пользователю, когда для него 
создана учётная запись? 

Не сейчас из-за ядра Moodle. См. элементы Средства Отслеживания MDL-19390. 

Работа над этим ведётся. Если вы создали CSV-файл для пользователя и НЕ 

ВКЛЮЧИЛИ поле пароля, задание Хрон инициируется и э-почта будет послана 

пользователю. Текст сообщения по э-почте настраивается под клиента Администратором в 

настройках Администратора. См. 

http://docs.moodle.org/24/en/Upload_users#Fields_that_can_be_included. 

http://docs.moodle.org/24/en/Birthday_block
http://docs.moodle.org/dev/User_profile_fields
http://tracker.moodle.org/browse/MDL-19390
http://docs.moodle.org/24/en/Upload_users#Fields_that_can_be_included
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3.2.7.4.How can I log in as another user? 
 
This is normally only allowed for administrators because of possible 

security issues. Click on the user's profile and then look in the Settings 

block on the side. Click the link there. 

Note that when you have finished, you will be logged out and will have to 

log in again. This is deliberate, again for security reasons, but you will be 

returned to the page you just left. 

3.2.7.5.How can I prevent users from editing 
elements of their profile? 
You can lock user fields from Settings>Site 

Administration>Plugins>Authentication>Manual accounts. 

3.2.7.6.The search box for users is limited to 
100 displayed users. Can I change this? 
For a discussion on changing the code, please see 

https://moodle.org/mod/forum/discuss.php?d=186777 For the teacher 

request see https://tracker.moodle.org/browse/MDL-36395 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.2.7.4.Как я могут зарегистрировать другого 
пользователя? 

Это обычно разрешается только Администратору, потому что возможны проблемы 

с безопасностью. Щёлкните на Профиле пользователя и затем взгляните на блок настроек 

Administrator сбоку экрана. Выберите там ссылку Login as (войти как). 

Заметьте, что когда вы закончите, вы будете разрегистрированы и должны будете 

зарегистрироваться снова. Это не случайно, снова по причинам безопасности, но 

вернётесь вы на ту страницу, которую покинули. 

3.2.7.5.Как помешать пользователям редактировать 
элементы их Профиля? 

Вы можете заблокировать поля пользователя из 

AdministratorSite administrationPluginsAuthenticationManual accounts. 

3.2.7.6.Окошко поиска пользователей ограничено 100 
отображаемыми пользователями. Можно это изменить? 

Дискуссию по изменению кода, пожалуйста, см. в 

https://moodle.org/mod/forum/discuss.php?d=186777. Запросы Преподавателя смотрите в 

https://tracker.moodle.org/browse/MDL-36395. 

https://moodle.org/mod/forum/discuss.php?d=186777
https://tracker.moodle.org/browse/MDL-36395
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3.3.Enrolments 
Enrolment, or 'enrollment', is the process of marking users as participants 

in the course, that includes both students and teachers. At the same time 

users are usually give a role in the course which specifies what they are 

allowed to do. 

3.3.1.Enrolment plugins 
Moodle provides a number of ways of managing course enrolment, called 

enrolment plugins. 

Screenshot «Available course enrolment plugins». 

 

 

 

3.3.1.1.Setting the enrolment method(s) 
 
 
To set an enrolment method: 

 

 Click on Settings > Site administration > Plugins > Enrolments > 

Manage enrol plugins. 

 
 

 Click on the enable checkboxes opposite your chosen enrolment 

plugin(s). If you wish, you may choose more than one enrolment 

method. For example if you have some courses which students must 

pay for and some free courses, you can use PayPal and self enrolment. 

 

 Click the "Save changes" button. 

 Click the settings link opposite the enrolment plugin(s) you have 

chosen. 

 Configure the required settings and click the "Save changes" button. 

 Repeat until you have edited all the plugins you have enabled. 

The order in which enrolment plugins are applied can be set. This may be 

important for some plugins. It also affects the order of enrolment options 

on the course enrol page. 

 

 

 

 

3.3.Зачисления на Курсы 
Зачисление – это процесс фиксации пользователей как Участников в каком-

то учебном Курсе, что включает и Студентов и Преподавателей. В то же самое время 

пользователям обычно даётся Роль в этом Курсе, которая указывает, что им разрешено 

делать. 

3.3.1.Плагины зачислений 
Moodle предоставляет ряд способов управления зачислением на Курсы, 

называемых плагинами 

зачислений. 

Снимок с экрана 

«Доступные плагины 

зачисления на Курс». 

3.3.1.1.Установка 
метода(ов) 
зачисления 

Чтобы установить 

метод зачисления: 

 Щёлкните по 

AdministrationSite administrationPluginsEnrolmentsManage enroll plugins. 

 Щёлкните по окошкам-флажкам в колонке Enable (включить) против выбранных вами 

плагинов зачислений. Если хотите, можете выбрать более одного метода зачисления. 

Например, если вы имеете некоторые Курсы, которые Студенты должны оплатить и 

некоторые бесплатные Курсы, то вы можете выбрать PayPal (оплата через интернет) и 

Self enrolment (самоЗачисление). 

 Щёлкните кнопку «Save changes (сохранить изменения)». 

 Щёлкните ссылку Settings (настройки) против плагина(ов) зачисления, которые вы 

выбрали. 

 Сконфигурируйте требуемые настройки и щёлкните кнопку «Save changes». 

 Повторяйте до тех пор, пока не отредактируете все плагины, которые вы включили. 

Можно установить порядок, в котором применяются плагины зачислений. Это 

может оказаться важным для некоторых плагинов. Это также воздействует не порядок 

опций зачислений на странице зачисления на Курс. 
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3.3.1.2.Enrolment capabilities 
3.3.1.2.1.Category enrolments: 
Capabilities/enrol/category:synchronised 
This capability is for use with the Category enrolments enrolment plugin. It 

allows users with a particular role, such as student, to be enrolled in all 

courses in a category. 

This capability is not set for any of the default roles. 

3.3.1.2.2.Cohort sync: 
Capabilities/enrol/cohort:config 

 This allows a user to add the Cohort sync enrolment plugin to a course 

via Settings > Course administration > Users > Enrolment methods 

(provided that it has been enabled by admin in Settings > Site 

administration > Plugins > Enrolments > Manage enrol plugins) 

 The default roles of Manager and Teacher have this set to allow. 

NOTE: By default, a teacher cannot add the Cohort sync plugin to their 

course. It needs to be configured by an Administrator or a user with the 

Manager role. 

The required capabilities for setting up a cohort sync are: 

 moodle/course:enrolconfig in the course context 

 moodle/cohort:config in the course context 

 moodle/cohort:view in the same context as category 

The required capabilities for manually enrolling cohort members are the 

same as cohort sync (note: this is a bug MDL-28431) 

 enrol/manual:enrol in course context 

 moodle/course:enrolreview in course context 

3.3.1.2.3.Guest access: 
Capabilities/enrol/guest:config 

 This allows a user to add the Guest access enrolment plugin to a course 

via Settings > Course administration > Users > Enrolment methods 

(provided that it has been enabled by admin in Settings > Site 

administration > Plugins > Enrolments > Manage enrol plugins) 

 The default roles of Manager and Teacher have this capability set to 

allow. 

 

 

 

 

 

 

3.3.1.2.Возможности зачислений 
3.3.1.2.1.Зачисления по Категориям 

Возможность Capabilities/enrol/category:synchronised 

Для использования с плагином зачисления Category enrolments. Она разрешает 

пользователям с конкретной Ролью, такой как Студент, быть зачисленными на все Курсы 

в Категории. 

Эта Возможность не устанавливается по умолчанию ни для каких Ролей. 

3.3.1.2.2.Синхронизация Когорты 
Возможность Capabilities/enrol/cohort:config 

 Позволяет пользователю добавить в Курс плагин зачисления Cohort sync посредством 

AdministrationCourse administrationUsersEnrolment methods  

(при условии, что это разрешено Администратором в 

AdministrationSite administrationPluginsEnrolmentsManage enroll plugins). 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Замечание: По умолчанию Преподаватель не может добавить 

Плагин Синхронизации Когорты в свой Курс. Это должно быть сконфигурировано 

Администратором или пользователем с Ролью Менеджера. 

Для синхронизации Когорты требуется установить следующие Возможности: 

 moodle/course:enrolconfig в Контексте Курса. 

 moodle/cohort:config в Контексте Курса. 

 moodle/cohort:view в том же самом Контексте, что и Категория. 

Требуемые Возможности для зачисления членов Когорты вручную те же самые, 

что и для синхронизации Когорты (замечание: это – ошибка MDL-28431) 

 enrol/manual:enrol в Контексте Курса. 

 moodle/course:enrolreview в Контексте Курса. 

3.3.1.2.3.Доступ Гостя 
Возможность Capabilities/enrol/guest:config 

 Позволяет пользователю добавить в Курс плагин зачисления Guest access посредством 

AdministrationCourse administrationUsersEnrolment methods  

(при условии, что это разрешено Администратором в 

AdministrationSite administrationPluginsEnrolmentsManage enroll plugins). 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

http://docs.moodle.org/24/en/Category_enrolments
http://docs.moodle.org/24/en/Cohort_sync
http://tracker.moodle.org/browse/MDL-28431
http://docs.moodle.org/24/en/Guest_access
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3.3.1.2.4.LDAP enrolments: 
Capabilities/enrol/ldap:manage 

 This capability allows a user to manage LDAP enrolment via 

Settings>Site administration>Plugins>Manage enrol plugins 

 

 The default role of Manager has this set to allow 

3.3.1.2.5.Manual enrolments: 
Capabilities/enrol/manual:config 

 This allows a user to edit the Manual enrolment method and set the 

default enrolment period and default role in Settings > Course 

administration > Users > Enrolment methods 

  

 This capability is allowed for the default role of manager only 

Capabilities/enrol/manual:enrol 

 This allows a user to enrol other users into a course manually via 

Settings > Course administration>Users > Enrolled users 

 The default roles of manager and teacher have this capability set to 

allow. 

Capabilities/enrol/manual:manage 

 This allows a user to manage enrolled users in Settings>Course 

administration>Users>Enrolled users 

 This capability is allowed for the default roles of Manager and Teacher 

Capabilities/enrol/manual:unenrol 

 This allows a user to unenrol other users manually in Settings > Course 

administration > Users > Enrolled users 

 This capability is allowed for the default roles of Manager and Teacher 

Capabilities/enrol/manual:unenrolself 

 This allows a user to manually unenrol themselves from a course in 

which they were previously manually enrolled via Settings>Course 

administration>Unenro me from this course 

 This capability is not set for any of the default roles 

 To allow students to unenrol themselves from courses which they were 

previously manually enrolled in, the capability must be set to "allow" 

for the student role via Settings > Site Administration > Users > 

Permissions > Define roles. 
 

 

 

 

3.3.1.2.4.LDAP-зачисления 
Возможность Capabilities/enrol/ldap:manage 

 Позволяет пользователю управлять LDAP-зачислением посредством 

AdministrationCourse administrationUsersEnrolment methods. LDAP (Lightweight 

Directory Access Protocol) – облегчённый протокол доступа к каталогам. 

 Эта Возможность по умолчанию предоставлена Роли Менеджера. 

3.3.1.2.5.Зачисления вручную: 
Возможность Capabilities/enrol/manual:config 

 Позволяет пользователю редактировать метод Manual 

enrolment и устанавливать период зачисления по 

умолчанию и Роль по умолчанию в 

AdministrationCourse administrationUsersEnrolment methods. 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера. 

Возможность Capabilities/enrol/manual:enrol 
 Позволяет пользователю зачислить других пользователей на Курс вручную 

посредством AdministrationCourse administrationUsers Enrolled users. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

 

Возможность Capabilities/enrol/manual:manage 

 Позволяет пользователю управлять зачисленными пользователями в 

AdministrationCourse administrationUsers Enrolled users. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/enrol/manual:unenrol 

 Позволяет пользователю отчислить других пользователей вручную в 

AdministrationCourse administrationUsers Enrolled users. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/enrol/manual:unenrolself 

 Позволяет пользователю отчислить самого себя вручную из Курса, в который он 

предварительно был зачислен вручную посредством 

AdministrationCourse administrationUnenrol me from this course. 

 Эта Возможность не устанавливается ни каким Ролям по умолчанию. 

 Чтобы разрешить Студентам отчислять себя самим из Курсов, на которые они 

предварительно был зачислены вручную, эта Возможность должна быть установлена в 

«Allow (разрешить)» для Роли Студент посредством 

AdministrationSite administrationUsersPermissionsDefine roles). 

http://docs.moodle.org/24/en/Manual_enrolment
http://docs.moodle.org/24/en/Manual_enrolment
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3.3.1.2.6.Course meta link: 
Capabilities/enrol/meta:config 

 This capability allows a user to configure a Course meta link enrolment 

method 

 This capability is allowed for the default roles of Manager and Teacher 

Capabilities/enrol/meta:selectaslinked 

 This capability allows a user to choose courses for a Course meta link 

 This capability is allowed for the default role of Manager only and is 

not set for the default Teacher role 

 To enable a teacher to choose courses for a Course meta link, they need 

to have this capability set to "allow" via Settings>Site 

Administration>Users>Permissions>Define roles, alongside the 

capability enrol:meta:config 

3.3.1.2.7.PayPal: 
Capabilities/enrol/paypal:config 

 This capability allows a user to configure Paypal enrolment for a course 

in Settings > Course administration > Users > Enrolment methods 

 This capability is allowed for the default role of Manager only 

Capabilities/enrol/paypal:manage 

 This capability allows a user to manage users enrolled through Paypal 

enrolment 

 This capability is allowed for the default roles of Manager and Teacher 

Capabilities/enrol/paypal:unenrol 

 This allows a user to unenrol other users who were enrolled via Paypal 

enrolment in Settings > Course administration > Users > Enrolled users 

 

 This capability is allowed for the default role of Manager only 

Capabilities/enrol/paypal:unenrolself 

 This allows a user to unenrol themselves from a course which they were 

enrolled in via Paypal enrolment in Settings > Course administration > 

Unenrol me from this course 

 This capability is not set for any of the default roles 

3.3.1.2.8.Self enrolment: 
Capabilities/enrol/self:config 

 This capability allows a user to configure Self enrolment for a course in 

Settings > Course administration > Users > Enrolment methods 

 This capability is allowed for the default roles of Manager and Teacher 

 

3.3.1.2.6.Ссылка на мета-Курс 
Возможность Capabilities/enrol/meta:config 

 Позволяет пользователю сконфигурировать метод зачисления Course meta link (п. 

3.3.5). 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/enrol/meta:selectaslinked 

 Позволяет пользователю выбрать Курсы для ссылки на них как на мета-Курс. 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера и не 

устанавливается по умолчанию для Роли Преподавателя. 

 Чтобы разрешить Преподавателю выбирать Курсы для ссылки на них как на мета-Курс, 

он должен иметь эту Возможность, установленную в «Allow (разрешить)», посредством 

AdministrationSite administrationUsersPermissionsDefine roles) рядом с 

Возможностью enrol:meta:config. 

3.3.1.2.7.Оплата Курса онлайн по PayPal 
Возможность Capabilities/enrol/paypal:config 

 Позволяет пользователю сконфигурировать зачисление на Курс с оплатой по Paypal 

(п.3.3.13) в AdministrationCourse administrationUsersEnrolment methods. 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера. 

Возможность Capabilities/enrol/paypal:manageig 

 Позволяет пользователю управлять зачисляемыми пользователями через зачисление с 

оплатой по Paypal (п.3.3.13). 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/enrol/paypal:unenrol 

 Позволяет пользователю отчислять других пользователей, которые были зачислены 

через зачисление с оплатой по Paypal (п.3.3.13) в 

AdministrationCourse administrationUsersEnrolled users. 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера. 

Возможность Capabilities/enrol/paypal:unenrolself 

 Позволяет пользователю отчислить самого себя с Курса, на который он был зачислен 

через зачисление с оплатой по Paypal (п.3.3.13) в 

AdministrationCourse administration Unenrol me from this course. 

 Эта Возможность не установлена по умолчанию ни одной из Ролей. 

3.3.1.2.8.СамоЗачисление 
Возможность Capabilities/enrol/self:config 

 Позволяет пользователю сконфигурировать самоЗачисление (п. 3.3.3) на Курс в 

AdministrationCourse administrationUsersEnrolment methods. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 
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Capabilities/enrol/self:manage 

 This capability allows a user manage users enrolled through Self 

enrolment in Settings > Course administration > Users > Enrolled users 

 

 This capability is allowed for the default roles of manager and teacher 

Capabilities/enrol/self:unenrol 

 This allows a user to unenrol other users who were enrolled via Self 

enrolment in Settings > Course administration > Users > Enrolled users 

 

 This capability is allowed for the default roles of manager and teacher 

Capabilities/enrol/self:unenrolself 

 This allows a user to unenrol themselves from a course which they self-

enrolled in 

 This capability is allowed for the default role of student 

3.3.1.2.9.Course 
Capabilities/moodle/course:enrolconfig 

 This allows a user to set the order of enrolment methods in a course and 

add/delete and enable/disable enrolment methods in Settings > Course 

administration > Users > Enrolment methods 

 This capability is allowed for the default roles of manager and teacher 

Capabilities/moodle/course:enrolconfig 

 This allows a user to view the course enrolment methods in Settings > 

Course administration > Users > Enrolment methods 

 This capability is allowed for the default roles of manager and teacher 

3.3.1.3.See also 
 Enrolment FAQ 

3.3.2.Manual enrolment 
The manual enrolments plugin allows users to be enrolled manually via a 

link in the course administration settings. The plugin has to be enabled by 

the site administrator (see Enrolment plugins) and should normally be 

enabled as certain other enrolment plugins, such as self enrolment, require 

it. 

3.3.2.1.Course settings 
3.3.2.1.1.Checking you have manual enrolment in 
your course 
 In a course, go to Settings > Course administration > Users > Enrolment 

methods 

Возможность Capabilities/enrol/self:manage 

 Позволяет пользователю управлять пользователями, зачисленные посредством 

самоЗачисления (п. 3.3.3) в AdministrationCourse administrationUsersEnrolled 

users. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/enrol/self:unenrol 

 Позволяет пользователю отчислять других пользователей, зачисленных посредством 

самоЗачисления (п. 3.3.3) в AdministrationCourse administrationUsersEnrolled 

users. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/enrol/self:unenrolself 

 Позволяет пользователю отчислить самого себя с Курса, на который он самозачислился 

(п. 3.3.3). 

 Эта Возможность по умолчанию предоставлена Роли Студента. 

3.3.1.2.9.Курс 
Возможность Capabilities/moodle/course:enrolconfig 

 Позволяет пользователю установить порядок методов зачисления на Курс и 

добавить/удалить, и включить/отключить методы зачисления (п. 4.7.2) в 

AdministrationCourse administrationUsersEnrolment methods. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Возможность Capabilities/moodle/course:enrolconfig 

 Позволяет пользователю просмотреть методы зачисления (п. 4.7.2) в 

AdministrationCourse administrationUsersEnrolment methods. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

3.3.1.3.См. также 
 Часто задаваемые вопросы о зачислении. 

3.3.2.Зачисление вручную 
Плагин зачислений вручную позволяет пользователям быть зачисленными 

вручную через ссылку в настройках управления Курсом. Этот плагин должен быть 

разрешён Администратором Сайта (см. 3.3.1) и должен быть обычно включён, как того 

требуют и некоторые другие плагины зачисления, такие как самоЗачисление. 

 

3.3.2.1.Настройки Курса 
3.3.2.1.1.Проверка того, есть ли у вас на Курсе зачисление 
вручную 
 Находясь в Курсе, перейдите в 

AdministrationCourse administrationUsersEnrolment methods. 

http://docs.moodle.org/24/en/Enrolment_FAQ
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 Make sure Manual enrolments has its "eye" opened: 

 

3.3.2.1.2.Editing manual enrolment settings 
 
Managers (and any other users with the capability enrol/manual:config) 

can edit the manual enrolment method in the course and set the default 

enrolment period and default role in Settings > Course administration > 

Users > Enrolment methods. 

Screenshot «The manual enrolment screen». 

It is possible also for students and/or teachers to be notified when 

enrolments expire by selecting either "Enroller only" or "Enroller and 

enrolled user" from the dropdown "Notify before enrolment expires" and a 

time in "Notification threshold". 

 

3.3.2.2.Enrolling users 
3.3.2.2.1.Method 1 
 Go to Administration > Course administration > Users > Enrolled users 

 Click the 'Enrol users' button at the top right or bottom left of the page 

 

 Use the 'Assign roles' dropdown if you wish to change the role 

 

 Select enrolment options as appropriate 

 Browse or search for the user 

 Click the Enrol button opposite the user. The user will indent in the list 

and the enrol button will disappear, indicating that the user is enrolled. 

 When you have finished, click the 'Finish enrolling users' button (or 

simply close the enrol users box) 

The user will then appear in the list of enrolled users. 

 

Note: The enrolment option 'Recover user's old grades if possible' is not 

ticked by default and is easy to miss. An admin can make it so that the 

checkbox is ticked for all courses on the site by enabling the setting 

'Recover grades default' in Administration > Site administration > Grades 

> General settings. 

Screenshot «Enrolling users method 1». 

 

 

 

 

 Убедитесь, что Manual enrolments (зачисления вручную) 

имеют их «глаз» открытым. 

3.3.2.1.2.Редактирование настроек 
зачисления вручную 

Менеджеры (и любые другие пользователи с 

возможностью enrol/manual:config – п. 3.3.3) могут редактировать метод зачисления 

вручную в Курсе и устанавливать период зачисления и Роль по умолчанию в 

AdministrationCourse administrationUsersEnrolment methods. 

Снимок с экрана «Экран зачисления вручную». 

Можно также, чтобы Студенты и/или Преподаватели извещались об окончании 

зачисления посредством выбора либо «Enroller only (только зачисляющий)», либо 

«Enroller and enrolled user (зачисляющий и зачисляемый пользователь)» из ниспадающего 

списка «Notify before enrolment expires (известить перед окончанием зачисления)» и время 

в «Notification threshold (срок окончания зачисления)». 

3.3.2.2.Зачисление пользователей 
3.3.2.2.1.Метод 1 
 Перейдите в AdministrationCourse administrationUsersEnrolled users  

 Щёлкните кнопку «Enrol users (зачислить пользователей)» вверху справа или внизу 

слева на странице. 

 Используйте ниспадающий список «Assign roles (назначить Роли)», если нужно 

изменить Роль. 

 Выберите подходящие опции зачисления. 

 Просмотрите или отыщите пользователя. 

 Щёлкните кнопку Enrol напротив нужного пользователя. Этот пользователь будет 

внесён в список и кнопка Enrol исчезнет, указывая, что пользователь зачислен. 

 По окончании щёлкните кнопку «Finish enrolling users (окончить зачисление 

пользователей)» (или просто закройте окно зачисления пользователей). 

После этого данный пользователь появится в списке зачисленных пользователей. 

Замечание: Опция зачисления «Recover user's old grades if possible (восстановить 

старые оценки пользователя, если возможно)» не помечена по умолчанию, и её легко 

пропустить. Администратор может сделать, чтобы это окошко-флажок было помечено для 

всех Курсов на Сайте, включив настройку «Recover grades default (по умолчанию оценки 

восстанавливать)» в AdministrationSite administrationGradesGeneral settings. 

Снимок с экрана «Зачисление пользователей методом 1». 

http://docs.moodle.org/24/en/File:enrolmenexpirynotification.png
http://docs.moodle.org/25/en/File:Enrolledusers.png
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3.3.2.2.2.Method 2 
 Go to Administration > Course administration > Users > Enrolment 

methods 

 Click the 'Enrol users' icon in the edit column opposite manual 

enrolment 

 Select users from the not enrolled users list, using Ctrl + click to select 

multiple users 

 Click the add button to add the users to the enrolled users list 

Screenshot «Enrolling users method 1». 

3.3.2.2.3.Editing individual enrolment start and 
end dates 
Enrolment start and end dates may be edited for individual students as 

follows: 

 Go to Administration > Course administration > Users > Enrolled users 

 Click the edit icon in the enrolment methods column for a particular 

user. 

 Edit dates as required, then click the 'Save changes' button. 

Screenshot «Editing enrolment start and end dates». 

3.3.2.3.Admin settings 
The manual enrolment plugin may be enabled or disabled throughout the 

site in Settings > Site administration > Plugins > Enrolments > Manage 

enrol plugins. 

Site-wide settings, including default settings for manual enrolment in new 

courses, may be set via Administration > Site administration > Plugins > 

Enrolments > Manual enrolments. 

 Enrolment expiration action - specifies what happens when user 

enrolments reach expiration date. Please note that option "Unenrol user 

from course" purges grades, group memberships, preferences and other 

user related data from the courses. 

 

 Hour to send enrolment expiry notifications - specify hour for sending 

expiration notifications. 

 Add instance to new courses- if this is enabled, then whenever a new 

course is created, manual enrolments will automatically added to new 

courses. 

 Default role assignment - this sets the default role, which is normally 

student and may be altered by a teacher in a course. 

 

 

3.3.2.2.2.Метод 2 
 Перейдите в AdministrationCourse administrationUsers Enrolment methods. 

 

 Щёлкните иконку «Enrol users (зачислить пользователей)» в колонке редактирования 

напротив зачисления вручную. 

 Выберите пользователей из числа незачисленных, нажав клавишу Ctrl и щёлкая для 

выбора нескольких пользователей. 

 Щёлкните кнопку Add, чтобы добавить пользователей в список зачисленных. 

Снимок с экрана «Зачисление пользователей методом 2». 

3.3.2.2.3.Редактирование индивидуальных дат начала и 
конца зачисления 

Можно отредактировать даты начала и конца зачисления для отдельного Студента 

следующим образом: 

 Перейдите в AdministrationCourse administrationUsersEnrolled users  

 Щёлкните по иконке редактирования в колонке Enrolment methods (методы зачисления) 

для конкретного пользователя. 

 Отредактируйте даты, как нужно, затем щёлкните кнопку «Save changes». 

Снимок с экрана «Редактирование дат начала и конца зачислений».  

3.3.2.3.Настройки Администратора 
Плагин Зачисления Вручную может быть включён или отключён для всего Сайта в 

AdministrationSite administrationPluginsEnrolmentsManage enroll plugins. 
 

Настройки для всего Сайта, включая настройки по умолчанию для зачисления 

вручную на новые Курсы, могут быть установлены через 

AdministrationSite administrationPluginsEnrolmentsManual enrolments. 

 Enrolment expiration action (действие по окончании зачислений) указывает, что 

случится, когда зачисления пользователей достигнет даты окончания. Пожалуйста, 

заметьте, что опция «Unenrol user from course (отчислить пользователя с Курса)» 

стирает оценки, членов Групп, предпочтения и другие относящиеся к пользователю 

данные с Курсов. 

 Hour to send enrolment expiry notifications (час отправлять извещения об окончании 

зачислений) указывает час для отправки извещений об истечении срока. 

 Add instance to new courses (добавлять плагин самоЗачисления во все Курсы) – если 

это разрешено, то, когда бы ни создавался новый Курс, зачисления вручную 

автоматически добавляются к новым Курсам. 

 Default role assignment (назначение Роли по умолчанию) – устанавливает Роль по 

умолчанию, которой обычно является Роль Студента, и она может быть изменена 

Преподавателем в Курсе. 

http://docs.moodle.org/25/en/File:manually_enrolling_users.png
http://docs.moodle.org/25/en/File:individualenrolment24.png
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 Enrolment duration - this sets the default length of enrolment in new 

courses. 

 Notify before enrolment expires - specifies if teacher or optionally 

students should be notified before the expiration. 

 Notification threshold - specify how many days should be users notified 

before the enrolment expiration. 

 Enable existing enrolments – Enable self enrolment method in new 

courses. 

 Allow new enrolments - Allow users to self enrol into new courses by 

default. 

 Use group enrolment keys - Use group enrolment keys by default. 

 

 Unenrol inactive after - If users haven't accessed a course for a long 

time, then they are automatically unenrolled. This parameter specifies 

that time limit. 

 Max enrolled users - Specifies the maximum number of users that can 

self enrol. 0 means no limit. 

 

 Send course welcome message - If enabled, users receive a welcome 

message via email when they self-enrol in a course. 

 

3.3.2.4. Manual enrolment capabilities 
3.3.2.4.1.Configure manual enrol instances 
 
Capabilities/enrol/manual:config 

 This allows a user to edit the Manual enrolment method and set the 

default enrolment period and default role in Settings > Course 

administration > Users > Enrolment methods 

 This capability is allowed for the default role of manager only 

 

3.3.2.4.2.Enrol users 
Capabilities/enrol/manual:enrol 

 This allows a user to enrol other users into a course manually via 

Settings > Course administration > Users > Enrolled users 

 The default roles of manager and teacher have this capability set to 

allow. 

 

 

 Enrolment duration (период зачисления) – устанавливает длительность периода 

зачисления на новые Курсы по умолчанию. 

 Notify before enrolment expires (известить об окончаниях зачислений) – указывает, что 

Преподаватель или, возможно, Студенты должны извещаться до окончания. 

 Notification threshold (период извещения) – указывает, за сколько дней пользователь 

должен извещаться об окончании зачислений. 

 Enable existing enrolments (разрешить существующие зачисления) – включает метод 

самоЗачисления в новые Курсы. 

 Allow new enrolments (разрешить новые зачисления) – разрешить пользователям 

самозачисляться на новые Курсы по умолчанию. 

 Use group enrolment keys (использовать ключи зачисления по Группам) – использовать 

ключи зачисления по Группам по умолчанию. 

 Unenrol inactive after (отчисление неактивно после) – если пользователи не давали 

доступа к Курсу долгое время, тогда они автоматически отчисляются. Этот параметр 

указывает ограничение времени. 

 Max enrolled users (максимальное зачисляемых пользователей) – указывает 

максимальное число пользователей, которое может само себя зарегистрировать. 0 – нет 

ограничений. 

 Send course welcome me (отправить приветственное сообщение) – если включено, 

пользователи получают приветствующее их сообщение по э-почте, когда они 

саморегистрируются в Курсе. 

3.3.2.4.Возможности зачисления вручную 
3.3.2.4.1.Изменить установки экземпляров зачисления 
вручную 

Возможность Capabilities/enrol/manual:config 

 Позволяет пользователю редактировать метод зачисления вручную и установить 

период зачисления по умолчанию, и Роль по умолчанию в AdministrationCourse 

administrationUsersEnrolment methods. 

 Эта Возможность предоставляется по умолчанию только Роли 

Менеджера. 

3.3.2.4.2.Зачислить пользователей 
Возможность Capabilities/enrol/manual:enrol 

 Позволяет пользователю зачислить других пользователей на Курс вручную через 

AdministrationCourse administrationUsersEnrolled users. 

 Роли по умолчанию Менеджера и Преподавателя эту Возможность имеют 

установленной в «разрешено». 

http://docs.moodle.org/24/en/Manual_enrolment


 

40 

3.3.2.4.3.Manage user enrolments 
Capabilities/enrol/manual:manage 

 This allows a user to manage enrolled users in Settings > Course 

administration > Users > Enrolled users 

 This capability is allowed for the default roles of Manager and Teacher 

3.3.2.4.4.Unenrol users from the course 
Capabilities/enrol/manual:unenrol 

 This allows a user to unenrol other users manually in Settings > Course 

administration > Users > Enrolled users 

 This capability is allowed for the default roles of Manager and Teacher 

3.3.2.4.5.Unenrol self from the course 
Capabilities/enrol/manual:unenrolself 

 This allows a user to manually unenrol themselves from a course in 

which they were previously manually enrolled via Settings > Course 

administration > Users > Unenrol me from this course 

 This capability is not set for any of the default roles 

 To allow students to unenrol themselves from courses which they were 

previously manually enrolled in, the capability must be set to "allow" 

for the student role via Settings > Site Administration > Users > 

Permissions > Define roles. 

3.3.3.Self enrolment 
Self enrolment - a user can choose to enrol him/herself into a course. Self 

enrolment is the method whereby users can choose to enrol themselves into 

a course, either immediately by clicking "enrol me in this course" or by 

typing in an enrolment key they have been given. The enrolment plugin 

needs to be enabled by the site admin in enrolment plugins and has to be 

enabled within the course. The manual enrolment plugin has to be enabled 

in the same course as well. 

3.3.3.1.Course settings for self enrolment 
3.3.3.1.1.Checking self enrolment is enabled 
 In a course, go to Administration > Course administration > Users > 

Enrolment methods and ensure the "eye" is opened for self enrolment. 

 

 

 

 

 

 

3.3.2.4.3.Управлять зачислениями пользователей 
Возможность Capabilities/enrol/manual:manage 

 Позволяет пользователю управлять зачисляемыми пользователями в 

AdministrationCourse administrationUsersEnrolled users. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

3.3.2.4.4.Отчислить пользователей с Курса 
Возможность Capabilities/enrol/manual:unenrol 

 Позволяет пользователю отчислить других пользователей вручную в 

AdministrationCourse administrationUsersEnrolled users. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

3.3.2.4.5.Отчислить себя самого с Курса 
Возможность Capabilities/enrol/manual:unenrolself 

 Позволяет пользователю отчислить вручную себя самого из Курса, на который он ранее 

был зачислен вручную посредством 

AdministrationCourse administrationUsersUnenrol me from this course. 

 Эта Возможность устанавливается не для всех Ролей по умолчанию. 
 Чтобы разрешить Студентам самом себя исключать из Курсов, в которые они ранее 

были зачислены вручную, эта Возможность должна быть установлена в «Allow 

(разрешить)» для Роли Студента через 

AdministrationSite administrationUsersPermissionsDefine roles 

3.3.3.СамоЗачисление 
СамоЗачисление – пользователь может выбрать зачисление самого себя на Курс. 

СамоЗачисление – это метод, посредством которого пользователи могут выбрать 

зачисление самих себя на Курс, либо немедленно щелчком по «enrol me in this course 

(зачислить меня на этот Курс)», либо вписыванием Enrolment key (ключ зачисления), 

который им был дан. Плагин Зачисления должен быть разрешённым Администратором 

Сайта в разделе Enrolment plugins, а также быть дополнительно разрешённым в том же 

самом Курсе. 

3.3.3.1.Настройки Курса для самоЗачисления 
3.3.3.1.1.Проверка, разрешено ли самоЗачисление 
 Находясь в Курсе, перейдите к Administration 

Course administrationUsers Enrolment methods и 

убедитесь, что «глаз» открыт для самоЗачисления. 
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3.3.3.1.2.Adding an enrolment key to a course 
If you wish only a certain group of users to self enrol (and not anyone) 

then you can set an enrolment key which you then tell them to use when 

they access the self-enrolment screen. See section 1 of enrolment key for 

how to do this. 

3.3.3.1.3.Adding a group enrolment key to a 
course 
If you wish your users to enrol themselves directly into a group in the 

course then you can set a group enrolment key which you then tell them to 

use when they access the self-enrolment screen. See section 2 of enrolment 

key for how to do this. 

See also this screencast "Group enrolment keys in Moodle 2.0". 

The following settings may be changed by clicking the edit (hand/pen) 

icon to the right of the self-enrolment option in Administration > Course 

administration > Users > Enrolment methods: 

3.3.3.1.4.Setting the enrolment period 
Tick the "enable" box to the right of Enrolment period and then choose 

your dates. 

3.3.3.1.5.Enrolment duration 
Set the amount of time a user enrolment is valid, starting with the moment 

the user enrols themselves. 

If disabled, the enrolment duration will be unlimited. 

3.3.3.1.6.Notifying users when their enrolment 
expires 
It is possible also for students and/or teachers to be notified when 

enrolments expire by selecting either "Enroller only" or "Enroller and 

enrolled user" from the dropdown "Notify before enrolment expires" and a 

time in "Notification threshold". 

Screenshot «Settings for notifiying users before enrolment expires». 

 

Editing individual enrolment times 
It is possible to edit the date and hour of an individual's enrolment from 

Administration>Course administration>Users>Enrolled users by clicking 

the edit icon in the enrolment methods column for the user in question. 

This then brings up a screen where the date and time can be modified. 

 

Screenshot «Click the edit icon in the enrolment methods column for the 

user». 

 

3.3.3.1.2.Добавление Ключа Зачисления в Курс 
Если вы хотите, чтобы только определённая Группа пользователей 

самозачислялась (и никто другой), тогда вы может установить ключ для доступа к экрану 

самоЗачисления, который вы сообщите им. См. раздел 1 из «Ключ зачисления (п. 4.7.3)» – 

как это делать. 

3.3.3.1.3. Добавление Ключа Зачисления Группы в Курс 
 

Если вы хотите, чтобы пользователи самозачисляли себя прямо в Группу на Курс, 

тогда вы можете установить Ключ Зачисления Группы, который вы сообщаете им, для 

доступа к экрану самоЗачисления. См. раздел 2 из «Ключ Зачисления (п. 4.7.3)» – как это 

делать.  

См. Также этот фильм с экрана «Ключи Зачисления Группы в Moodle 2.0»:. 

Следующие настройки могут быть изменены щелчком по иконке редактирования 

(шестерёнка) справа от опции самоЗачисления в AdministrationCourse 

administrationUsers Enrolment methods. 

3.3.3.1.4.Настройка периода зачисления 
Отметьте окно «Enable (разрешено)» справа от «Enrolment period (период 

зачисления)» и затем выберите ваши даты. 

3.3.3.1.5.Продолжительность зачисления 
Установите продолжительность времени, в течение которого зачисление 

пользователя действительно, начиная с момента, когда пользователь сам себя зачислил. 

Если отключена, продолжительность зачисления не ограничена. 

3.3.3.1.6.Извещение пользователей, когда оканчивается 
зачисление 

Можно также известить Студентов и/или Преподавателей, когда оканчиваются 

зачисления выбором либо «Enroller only (только зачисляющий)», либо «Enroller and 

enrolled user (зачисляющий и зачисляемый пользователь)» в ниспадающем меню «Notify 

before enrolment expires (извещать перед окончаниями зачислений)» 

Снимок с экрана «Настройки для извещения пользователей перед окончаниями 

зачислений». 

Редактирование индивидуальных времён зачисления 
Можно отредактировать дату и час зачисления индивидуума из 

AdministrationCourse administrationUsersEnrolled users щелчком по иконке 

редактирования в колонке Enrolment methods (методы зачисления) для пользователя, 

вызывающего сомнение. Это приведёт к появлению экрана, где дата и время могут быть 

модифицированы. 

Снимок с экрана «Щёлкните иконку редактирования в колонке Enrolment methods 

для пользователя». 

http://www.youtube.com/watch?v=4xzF7xerle0
http://docs.moodle.org/25/en/File:selfenrolmenexpirynotification.png
http://docs.moodle.org/25/en/File:selfenrolmenexpirynotification.png
http://docs.moodle.org/25/en/File:selfenrolment241.png
http://docs.moodle.org/25/en/File:selfenrolment241.png
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Screenshot «Modifying the date and time». 

3.3.3.1.7.Unenrolling students who haven't been 
active on the course 
Choose from the dropdown to the right of "Unenrol inactive after..." 

 

3.3.3.1.8.Deciding the maximum number of users 
in your course 
Type the maximum number of users you want in your course in "Max 

enrolled users". When this limit is reached, nobody will be able to self-

enrol. If you leave the number at 0 then there will be no maximum number. 

3.3.3.1.9.Allowing only cohort members to self-
enrol 
If you have cohorts set up, then you can restrict self enrolment to particular 

cohorts by selecting the name of the cohort from the drop down box, A 

member of the cohort can self-enrol as normal; whereas a non-member 

gets a message telling them they are not able to self-enrol. 

Screenshot «Restricting self enrolment to members of a particular cohort». 

Screenshot «Message seen by a user not in a cohort who is attempting to 

self-enrol». 

3.3.3.1.10.Sending a welcome message to new 
users 
If enabled, users receive the following message via email when they self-

enrol in a course: 

Welcome to {Course name} 

If you have not done so already, you should edit your profile page so that 

we can learn more about you: {link to profile page} 

If you want to send a different message, simply type it in the custom 

welcome message text box. 

Note: An admin can customise the message for the whole site by editing 

the welcometocoursetext language string. See Language customization for 

further details. 

3.3.3.2.Admin settings 
The self enrolment plugin may be enabled or disabled throughout the site 

in Administration > Site administration > Plugins > Enrolments > Manage 

enrol plugins. 

 

 

 

Снимок с экрана «Модифицирование даты и времени». 

3.3.3.1.7.Отчисление Студентов, которые не были 
активными на Курсе 

Выберите из ниспадающего списка справа от «Unenrol inactive after... (отчислить 

неактивных после)» 

3.3.3.1.8.Решение о максимальном числе Студентов на 
вашем Курсе 

Наберите максимальное число пользователей на вашем Курсе в «Max enrolled users 

(Максимум зачисляемых пользователей)». Когда этот предел достигнут, никто больше не 

сможет самозачислиться. Если вы оставите это число равным 0, тогда предела не будет. 

3.3.3.1.9.Разрешение самозачисляться только членам 
Когорты 

Если у вас Когорты установлены, тогда вы можете ограничить самоЗачисление в 

отдельные Когорты, выбрав имя нужной Когорты из ниспадающего списка. Член Когорты 

может самозачислиться как обычно, в то время как не член получает сообщение о том, что 

он не может самозачислиться. 

Снимок с экрана «Ограничение самоЗачисления членами конкретной Когорты». 

Снимок с экрана «Сообщение, явленное пользователю не из Когорты, который 

пытается самозачислиться». 

3.3.3.1.10.Отправка приветственного сообщения новым 
пользователям 

Если разрешена, пользователи получат следующее сообщение по э-почте, когда 

самозачисляются на Курс: 

«Добро пожаловать на курс {название Курса}». 

Если вы ещё не сделали этого, вам следует отредактировать вашу страницу 

Профиля, чтобы мы могли больше узнать о вас: {ссылка на страницу Профиля} 

Если вы хотите отправить другое сообщение, просто наберите его в текстовом 

окошке Custom welcome message (приветственное сообщение клиенту). 

Замечание. Администратор может настроить под клиента это сообщение для всего 

Сайта редактированием зависящей от языка строки Welcometocoursetext (язык текста 

приглашения на Курс). См. подробности в «Настройка языка (п. 3.9.2)». 

3.3.3.2.Настройки Администратора 
Плагин СамоЗачисления может быть включён или отключён для всего Сайта в 

AdministrationSite administrationPluginsEnrolmentsManage enroll plugins. 

http://docs.moodle.org/25/en/File:selfenrolment242.png
http://docs.moodle.org/25/en/File:cohortselfenrol.png
http://docs.moodle.org/25/en/File:noncohortmember.png
http://docs.moodle.org/25/en/File:noncohortmember.png
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3.3.3.2.1.Shared settings for all courses 
The page Administration > Site administration > Plugins > Enrolments > 

Self enrolment. contains options for defaults that admin can set: 

 Require an enrolment key - if this box is ticked then all courses with 

self-enrolment enabled will need to have an enrolment key. The setting 

won't save until the teacher adds a key - something to be aware of as 

this can cause confusion:) 

 

 Use password policy - tick this box if you want enrolment keys set by 

teachers to follow the password policy of the site. 

 

 Show hint - tick this box if you are prepared to allow the first letter of a 

key to be given as a "hint" 

 Enrolment expiration action - specifies what happens when user 

enrolments reach expiration date. Please note that option "Unenrol user 

from course" purges grades, group memberships, preferences and other 

user related data from the courses. 

 

 Hour to send enrolment expiry notifications - specify hour for sending 

expiration notifications. 

3.3.3.2.2.Default enrolment settings in new 
courses 
These can be set in Administration > Site administration > Plugins > 

Enrolments > Self enrolment but teachers in individual courses can alter 

them to suit their needs: 

 Add instance to new courses - if admin selects this, then any new course 

created will include the self enrolment plugin 

 

 Enable self enrolments- if this is enabled then users by default can self 

enrol into a course. 

 Use group enrolment keys - the setting for group enrolment keys in a 

course will be set to "yes" by default 

 Default role assignment - normally, when users self enrol, they have the 

student role. If necessary that role can be changed by default here - for 

example - if your Moodle has a dedicated role you wish to use instead. 

 

 Enrolment duration - this sets the default enrolment length for new 

courses (but again, may be altered by the course teacher.) 

 

3.3.3.2.1.Совместные настройки для всех Курсов 
Страница AdministrationSite administrationPluginsEnrolmentsSelf enrolment 

содержит опции для значений по умолчанию, которые Администратор может установить: 

 Require an enrolment key (потребовать ключ зачисления) – если это окошко помечено, 

тогда все Курсы с возможностью самоЗачисления будут нуждаться в наличии ключа 

зачисления. Эта настройка не может быть сохранена до тех пор, пока Преподаватель не 

добавит ключ – что-нибудь, что будет осознаваться как то, что может вызвать 

замешательство. 

 Use password policy (использовать политику паролей) – пометьте это окошко, если вы 

хотите, чтобы ключи зачислений, устанавливаемые Преподавателями, следовали 

политике паролей всего Сайта. 

 Show hint (показать подсказку) – пометьте это окошко, если вы готовы разрешить 

первую букву ключа давать в качестве «подсказки». 

 Enrolment expiration action (действие окончания зачисления) – укажите, что случится, 

когда зачисления пользователей достигнут даты окончания. Пожалуйста, заметьте, что 

опция «Unenrol user from course (отчислить пользователя с Курса)» сотрёт Оценки, 

членство в Группах, предпочтения и другие относящиеся к пользователю данные из 

Курсов. 

 Hour to send enrolment expiry notifications (час отправки извещений об окончании 

зачислений) – указывает час отправки извещений об окончании. 

3.3.3.2.2.Настройки по умолчанию зачислений на новые 
Курсы 

Они могут быть установлены в 

AdministrationSite administrationPluginsEnrolmentsSelf enrolment, 

но Преподаватели в отдельных Курсах могут изменить их по своему усмотрению. 

 Add instance to new courses (добавить экземпляр в новые Курсы) – если 

Администратор выберет это, тогда любой вновь созданный Курс включает плагин 

самоЗачисления. 

 Enable self enrolments (разрешить самоЗачисление) – если это разрешено, тогда 

пользователи могут по умолчанию самозачисляться на Курс. 

 Use group enrolment keys (использовать ключи зачисления Группы) – эта настройка 

ключей зачислений Групп на Курс будет установлена в «Yes» по умолчанию. 

 Default role assignment (назначение Роли по умолчанию) – обычно, когда пользователи 

самозачисляются, они имеют Роль Студента. Если нужно, здесь эта Роль по умолчанию 

может быть изменена – например – если ваша Moodle имеет другую 

специализированную Роль, которую вы захотите использовать. 

 Enrolment duration (продолжительность зачислений) – устанавливает длительность 

зачислений по умолчанию для новых Курсов (но тоже может быть изменена 

Преподавателем этого Курса). 
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 Notify before enrolment expires - specifies if teacher or optionally 

students should be notified before the expiration. 

 Notification threshold - specify how many days should be users notified 

before the enrolment expiration. 

 Unenrol inactive after- this sets the default time after which a student 

will be unenrolled if they haven't accessed the courses. (Teachers may 

change this) 

 Max enrolled users - adding a number here will specify the maximum 

number of users who can self-enrol into new courses. Teachers in the 

course can change this. If it is left at 0, there will be no maximum. 

 

 Send course welcome message- if this box is checked then newly 

enrolled users will receive a welcome message by default. 

 

3.3.3.3.Self enrolment method options 
One course may contain multiple self enrolment methods. User may be 

enrolled once in each instance only. 

 Custom instance name - specify custom enrolment method name. 

 

 Enable self enrolments - if disabled all users enrolled via this plugin can 

not access course. If you want to prevent new enrolments only change 

the key or set end date instead. 

 

 Enrolment key - specify key required for enrolment. 

 Use group enrolment keys - optionally use group keys for enrolment 

too. 

 Default assigned role - specify role to be assigned to suers during 

enrolment, this can be manually after user enrolment. 

 

 Enrolment duration - specify enrolment length, this can be manually 

after user enrolment. 

 Notify before enrolment expires - specifies if teacher or optionally 

students should be notified before the expiration. 

 

 Notification threshold - specify how many days should be users notified 

before the enrolment expiration. 

 Unenrol inactive after- specify time after which a student will be 

unenrolled if they haven't accessed the courses. 

 

 Notify before enrolment expires (извещать до окончаниями зачислений) – указывает, 

нужно ли Преподавателей или по выбору Студентов извещать до окончания. 

 Notification threshold (граница извещения) – указывает, за сколько дней пользователи 

должны извещаться перед завершением зачислений. 

 Unenrol inactive after (отчислить неактивных после) – устанавливает время по 

умолчанию, после которого Студент будет отчислен, если он не приступал к Курсу. 

(Преподаватели могут изменить это) 

 Max enrolled users (максимум зачисляемых пользователей) – добавление сюда числа 

укажет максимальное число пользователей, которые могут самозачислиться на новые 

Курсы. Преподаватели этих Курсов могут изменить это число. Если число оставить 0, 

ограничения по максимуму не будет. 

 Send course welcome message (послать приветственное сообщение Курсу) – если это 

окошко помечено, тогда новые зачисленные пользователи получат приветственное 

сообщение по умолчанию. 

3.3.3.3.Опции метода самоЗачисления 
Один Курс может содержать несколько методов самоЗачисления. Пользователь 

может быть зачислен только один раз в каждом экземпляре плагина зачислений. 

 Custom instance name (наименование экземпляра плагина зачислений клиента) – 

указывает название Метода Зачислений Клиента. 

 Enable self enrolments (разрешить самоЗачисления) – если отключена, все 

пользователи, зачисленные через этот плагин, не могут иметь доступа к Курсу. Если вы 

хотите предотвратить новые зачисления, измените только ключ или установите дату 

окончания вместо этой опции. 

 Enrolment key (ключ зачисления) – указывает ключ, требуемый для зачисления. 

 Use group enrolment keys (использовать ключи зачисления Группы) – по выбору 

используйте также ключи Группы для зачисления. 

 Default assigned role (роль, назначаемая по умолчанию) – указывает Роль, которая 

будет назначена истцам во время зачисления, это может быть сделано вручную после 

зачисления пользователя. 

 Enrolment duration (продолжительность зачисления) – указывает длительность 

зачисления, это может быть сделано вручную после зачисления пользователя. 

 Notify before enrolment expires (извещать об окончаниях зачислений перед) – 

указывает будет ли Преподаватель или по выбору Студенты извещаться перед 

окончанием зачислений. 

 Notification threshold (граница извещения) – указывает, за сколько дней пользователи 

должны извещаться перед завершением зачисления. 

 Unenrol inactive after (отчисление неактивных) – указывает время, после которого 

Студент будет отчислен, если он не приступил к Курсу. 
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 Max enrolled users - adding a number here will specify the maximum 

number of users who can self-enrol into this course. 

 

 Only cohort members - optionally restrict this enrolment method to 

members of specified cohort. 

 Send course welcome message- if this box is checked then newly 

enrolled users will receive a welcome message by default. 

 

 Custom welcome message - specify custom message if necessary. 

 

3.3.3.4.Self enrolment capabilities 
3.3.3.4.1.Configure self enrol instances 

 
Capabilities/enrol/self:config 

 This capability allows a user to configure Self enrolment for a course in 

Settings > Course administration > Users > Enrolment methods 

 This capability is allowed for the default roles of Manager and Teacher 

3.3.3.4.2.Manage enrolled users 
Capabilities/enrol/self:manage 

 This capability allows a user manage users enrolled through Self 

enrolment in Settings > Course administration > Users > Enrolled users 

 This capability is allowed for the default roles of manager and teacher 

3.3.3.4.3.Unenrol users from course 
Capabilities/enrol/self:unenrol 

 This allows a user to unenrol other users who were enrolled via Self 

enrolment in Settings > Course administration > Users > Enrolled users 

 This capability is allowed for the default roles of manager and teacher 

3.3.3.4.4.Unenrol self from the course 
Capabilities/enrol/self:unenrolself 

 This allows a user to unenrol themselves from a course which they self-

enrolled in 

 This capability is allowed for the default role of student 

3.3.4.Cohort sync 
Cohorts, or site-wide groups, enable all members of a cohort to be enrolled 

in a course in one action, either manually or synchronised automatically. 

 

 

 Max enrolled users (максимум зачисляемых пользователей) – добавлению сюда числа 

укажет максимальное число пользователей, которые могут самозачислиться на этот 

Курс. 

 Only cohort members (только члены Когорты) – по выбору ограничивает этот метод 

зачисления только членами указанной Когорты. 

 Send course welcome message (послать приветственное сообщение Курсу) – если это 

окошко отмечено, тогда вновь зачисленные пользователи получат приветственное 

сообщение по умолчанию. 

 Custom welcome message (приветственное сообщение клиенту) – конкретизирует 

сообщение клиенту, если необходимо. 

3.3.3.4.Возможности самоЗачисления 
3.3.3.4.1.Конфигурировать экземпляры 
Плагинов СамоЗачислений 

Возможность Capabilities/enrol/self:config 

 Позволяет пользователю конфигурировать самоЗачисление на Курс в 

AdministrationCourse administrationUsers Enrolment methods. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

3.3.3.4.2.Управлять зачисленными пользователями 
Возможность Capabilities/enrol/self:manage 

 Позволяет пользователю управлять пользователями, зачисленными посредством 

самоЗачисления в AdministrationCourse administrationUsersEnrolled users. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

3.3.3.4.3.Отчисление пользователей с Курса 
Возможность Capabilities/enrol/self:unenrol 

 Позволяет пользователю отчислять пользователей, которые были зачислены через 

самоЗачисление в AdministrationCourse administrationUsersEnrolled users. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

3.3.3.4.4.Самоотчисление с Курса  
Возможность Capabilities/enrol/self:unenrolself 

 Позволяет пользователю отчислять самого себя с Курса, на который он 

самозачислился. 

 Эта Возможность предоставляется по умолчанию Роли Студента. 

3.3.4.Синхронизация Когорты 
Когорты, или Группы уровня Сайта, позволяют всем членам Когорты зачисляться 

на Курс одним действием либо вручную, либо синхронно автоматически. 
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3.3.4.1.Enrolling a cohort in a course 
In order to actually enrol users from a Cohort into courses the Cohort-Sync 

Enrollment plugin needs to be added to the enrollment methods for the 

course. The Administrator will first need to enable the Cohort-Sync 

enrolment plugin site wide (Administration > Site administration > 

Plugins > Enrolments) and then add it to the required Course: 

(Administration> Course administration > Users > Enrolment Methods). 

Screenshot «Adding the cohort sync enrolment method». 

At this stage the Cohort-Sync instance for the course is edited and the 

appropriate Cohort selected. The role to which the Cohort users are 

assigned is also selected at this point (typically Student). 

3.3.4.2.Adding a cohort to a group 
The cohort members can be added to a pre-made group at this stage also if 

desired. If any members are added or removed from the cohort, they are 

automatically added or removed from the group. Note that such members 

cannot be unenrolled manually from the groups screen and that 

additionally, there is information about their cohort below their name on 

the group screen. 

Screenshot «Adding a cohort to a group». 

Visiting the Administration > Course administration > Users > Enrolled 

Users page will show users enrolled via the Cohort-Sync plugin. 

Note that, by default, a teacher cannot add this plugin to their course. It 

needs to be configured by an Administrator or a user with the Manager 

role. Also note, that the user should be a Manager on a site level, not on the 

category or course level, otherwise the user will not see the option. If you 

want the user with the Manager role on the category level to see this enrol 

option, then you must add some cohorts on the category level, not on the 

site level. 

The required capabilities for setting up a cohort sync are: 

 moodle/course:enrolconfig in the course context 

 moodle/cohort:config in the course context 

 moodle/cohort:view in the same context as category 

The required capabilities for manually enrolling cohort members are: 

 the same as cohort sync (note: this is a bug MDL-28431) 

 enrol/manual:enrol in course context 

 moodle/course:enrolreview in course context 

3.3.4.3.Enrolling a cohort in a category 
This is not supported by Moodle at the moment. 

 

3.3.4.1.Зачисление Когорты в Курс 
Для того чтобы действительно зачислить пользователей из Когорты в Курсы 

нужно, чтобы Плагин Зачислений Cohort-Sync был добавлен к методам зачислений 

для этого Курса. Администратору сначала нужно разрешить плагин зачислений Cohort-

Sync на всём Сайте (AdministrationSite administrationPluginsEnrolments), а затем 

добавить его к требуемому Курсу: (AdministrationCourse administrationUsers 

Enrolment methods). 

Снимок с экрана «Добавление метода зачислений Cohort-Sync». 

На этой стадии экземпляр плагина Cohort-Sync для Курса редактируется и 

выбирается подходящая Когорты. Роль, на которую будут назначены пользователи из 

Когорты (обычно Студента), также выбирается в этот момент. 

3.3.4.2.Добавление Когорты в Группу 
Члены Когорты могут быть добавлены в предварительно созданную Группу также 

на этой стадии, если нужно. Если любые члены добавляются или удаляются из Когорты, 

они автоматически добавляются или удаляются из этой Группы. Заметьте, что такие члены 

не могут быть отчислены вручную с экрана Групп и, что дополнительно, есть информация 

о их Когорте ниже их имени на экране Группы. 

 

Снимок с экрана «Добавление Когорты в Группу». 

Посещение страницы AdministrationCourse administrationUsersEnrolled users 

покажет пользователей, зачисленных посредством плагина Cohort-Sync. 

Заметьте, что по умолчанию Преподаватель не может добавить этот плагин в 

свой Курс. Нужно, чтобы это было сконфигурировано Администратором или 

пользователем с Ролью Менеджера. Заметьте также, что этот пользователь должен быть 

Менеджером на уровне Сайта, не уровня Категории или Курса, в противном случае этот 

пользователь не увидит этой опции. Если вы хотите, чтобы пользователь с Ролью 

Менеджера на уровне Категории видел эту опцию зачисления, тогда вы должны добавить 

некоторые Когорты на уровень этой Категории, НЕ на уровень Сайта. 

Требуемые Возможности для установки плагина Cohort-Sync: 

 moodle/course:enrolconfig в Контексте Курса. 

 moodle/cohort:config в Контексте Курса. 

 moodle/cohort:view в том же самом Контексте, что и Категория. 

Требуемые Возможности для ручного зачисления членов Когорты: 

 та же, что у Cohort-Sync (замечание: это – ошибка MDL-28431). 

 enrol/manual:enrol в Контексте Курса. 

 moodle/course:enrolreview в Контексте Курса. 

3.3.4.3.Зачисление Когорты в Категорию 
В данный момент это в Moodle не поддерживается. 

http://docs.moodle.org/25/en/File:Cohortsync.png
http://docs.moodle.org/25/en/File:24cohortsync.png
http://tracker.moodle.org/browse/MDL-28431
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3.3.4.4.See also 
 Cohorts for information on how to create a cohort 

3.3.5.Course meta link 
The Course meta link plugin makes it possible for one course, called a 

metacourse, to bring in enrolments from other courses. The Course meta 

link plugin needs to be enabled both on the site level by the site admin and 

has to be enabled within the course. 

3.3.5.1.Metacourse examples 
 

Screenshot «Created - a child course and a meta course». 

 

 

Screenshot «Associating one child course and one meta course». 

 

 

Screenshot «2 child courses and a meta course». 

 

Screenshot «1 child course and 2 meta courses». 

 

Screenshot «3 child course and 2 meta courses». 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.4.4.См. также 
 Раздел «Когорты (п. 4.8.4)» содержит информацию о том, как создавать Когорты. 

3.3.5.Ссылка на мета-Курс 
Плагин Course meta link делает это возможным для одного Курса, называемого 

мета-Курсом, чтобы внести зачисления из других Курсов. Нужно разрешить плагин 

Course meta link как на уровне Сайта Администратором Сайта, так и внутри этого Курса. 

 

3.3.5.1.Примеры мета-Курсов 
Справа: 

Снимок с экрана «Создано: дочерний Курс и мета-Курс A»: 

Дочерний Курс – 15 зачислений. 

Мета-Курс A – 0 зачислений. 

Снимок с экрана «Связывание одного дочернего Курса и  

одного мета-Курса A»: дочерний Курс – 15 зачислений. 

Мета-Курс A – 15 зачислений. 

Внизу: 
Снимок с экрана 1 «2 дочерний Курс A и B и мета-Курс A»: 

дочерний Курс: A – 15 зачислений, B – 12 зачислений. 

Снимок с экрана 2 «1 дочерний Курс и 2 мета-Курса»: дочерний Курс – 15 

зачислений, 2 мета-Курса: A – 15 зачислений, B – 15 зачислений. 

Снимок с экрана 3 «3 дочерний Курс и 2 мета-Курса»: Курсы: A – 15 зачислений, B 

– 12 зачислений, C – 10 зачислений; 2 мета-Курса: A – 27 зачислений, B – 22 зачисления. 

 

 

 

 

 

 

 

 

 

 

         1            2     3 
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Examples: one "child" course (a course linked to a meta course) can be 

associated with many meta courses. Or one meta course can have many 

child courses associated with it. Both the child courses (non-meta courses) 

and the meta courses are independent and can be recycled many times, that 

is, each can be associated with many of the other. 

3.3.5.2.Course settings for Course meta link 
 In a course, go to Settings > Course administration > Users > Enrolment 

methods. 

 Click the dropdown menu under the enrolment methods and select 

'Course meta link'. 

 In the screen that comes up next, select from the dropdown box the 

course you wish to bring enrolments from and then click 'Add method'. 

Note 1: A teacher in a course will only be able to choose from courses 

they are teachers in elsewhere. 

Note 2: To add more courses, add another instance of the course meta 

link. 

 The users from the child course will now be enrolled in the current 

course - see the numbers in the screenshot below: 

 When new users are enrolled to the child course, they will be 

automatically brought into the current metacourse. 

 

 

3.3.5.3.Site settings for Course meta link 
The Course meta link plugin may be enabled or disabled throughout the 

site in Settings > Site administration > Plugins > Enrolments > Manage 

enrol plugins. 

The page Settings > Site administration > Plugins > Enrolments > Course 

meta link contains options for defaults that admin can set. (It can be also be 

accessed by clicking the Settings link on on the course meta link section of 

Settings > Site administration 

> Plugins > Enrolments > Manage enrol plugins) 

By default all role assignments from child courses are synchronised to 

meta courses. However, the "Roles that are not synchronised to 

metacourses" setting enables administrators to exclude particular roles. 

3.3.5.4.Course meta link capabilities 
3.3.5.4.1.Configure meta enrol instances 
 This capability allows a user to configure a Course meta link enrolment 

method 

 This capability is allowed for the default roles of Manager and Teacher 

Примеры выше: один Курс «дочерний» (Курс, связываемый с мета-Курсом) может 

быть связан со многими мета-Курсами. Или один мета-Курс может иметь много дочерних 

Курсов, связанных с ним. И дочерний Курс (не мета-Курсы) и мета-Курсы – независимы и 

могут повторно использоваться много раз, т.е. каждый может быть связан со многими 

другими. 

3.3.5.2.Настройки Курса для ссылки на мета-Курс 
 Находясь в Курсе, перейдите в AdministrationCourse 

administrationUsers Enrolment methods. 

 Щёлкните ниспадающее меню Add method на экране Enrolment 

methods и выберите «Course meta link (ссылка на мета-Курс)». 

 На появившемся экране выберите из ниспадающего окошка Курс, 

из которого вы хотите взять сведения о зачислениях, и затем 

щёлкните «Add method (добавить метод)».  

Замечание 1: Преподаватель в Курсе может выбрать только из 

тех Курсов, где он является Преподавателем. 

Замечание 2: Чтобы добавить больше Курсов, добавьте другой 

экземпляр Course meta link. 

 Пользователи из дочернего Курса сейчас будут зачислены в текущий Курс – см. числа 

на снимке с экрана справа. 

 Когда новые пользователи зачисляются в дочерний Курс, они 

будут автоматически перенесены в текущий Мета-курс. 

3.3.5.3.Настройки Сайта для ссылки на 
мета-Курс 

Плагин Course meta link может быть включён или отключён для всего Сайта в 

AdministrationSite administrationPluginsEnrolmentsManage enroll plugins. 
 

Страница AdministrationSite administrationPluginsEnrolmentsCourse meta 

link содержит опции для значений по умолчанию, которые может установить 

Администратор. (Они также доступны щелчком по ссылке Settings в разделе Course meta 

link из AdministrationSite administrationPluginsEnrolmentsManage enroll plugins.) 

По умолчанию все назначения Ролей из дочерних Курсов синхронизируются с 

мета-Курсами. Однако, настройка «Roles that are not synchronised to metacourses (Роли, 

которые не синхронизируются с мета-Курсами)» позволяет администраторам исключать 

отдельные Роли. 

3.3.5.4.Возможности ссылки на мета-Курс 
3.3.5.4.1.Конфигурировать экземпляры мета-зачислений 
 Позволяет пользователю конфигурировать метод зачисления Course meta link. 

 

 Эта Возможность предоставлена по умолчанию Ролям Менеджера и Преподавателя. 
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3.3.5.4.2.Select course as meta linked 
 This capability allows a user to choose courses for a Course meta link 

 This capability is allowed for the default role of Manager only and is 

not set for the default Teacher role 

 To enable a teacher to choose courses for a Course meta link, they need 

to have this capability set to "allow" via Settings>Site 

Administration>Users>Permissions>Define roles, alongside the 

capability enrol:meta:config 

3.3.5.5.Enabling teachers to add meta links 
 
An administrator can enable teachers to add course meta links as follows: 

 

 Go to Site Administration > Users > Permissions > Define Roles 

 Select the Teacher Role and click on the Edit button 

 Scroll down to Course Meta Link as shown in the images below: 

 

 

 

 

 

 

 

Screenshot «The default setting is "Not Set"». 

 

 

 

 

 

 

 

Screenshot «When the Edit button is clicked, the panel changes to "Allow" 

and a checkbox». 

 

 

 

 

Screenshot «Change to "Allow" by a click on the checkbox.». 

 

 Scroll to the bottom of the page to save your changes. 

3.3.5.4.2.Выбрать Курс в качестве мета-связанного 
 Позволяет пользователю выбрать Курсы для ссылки на мета-Курс. 

 Эта Возможность предоставлена по умолчанию только Роли Менеджера и не 

установлена по умолчанию для Роли Преподавателя. 

 Чтобы разрешить Преподавателю выбирать Курсы для ссылки на мета-Курс, ему 

необходимо иметь эту Возможность, установленную в «Allow» через 

AdministrationSite administrationUsersPermissionsмDefine roles рядом с 

Возможностью enrol:meta:config. 

3.3.5.5.Разрешение Преподавателям добавлять мета-
ссылки 

Администратор может разрешить Преподавателям добавлять ссылки на мета-

Курсы следующим образом: 

 Перейдя на AdministrationSite administrationUsersPermissionsмDefine roles. 

 Выбирает Teacher Role (Роль Преподавателя) и щёлкает кнопку Edit (редактировать). 

 Прокручивает страницу вниз к Course Meta Link, как показано на снимках с экрана 

ниже: 

 

 

 

 

 

 

Снимок с экрана «Настройка по умолчанию «Not Set (не устанавлены)». 

 

 

 

 

 

 

 

Снимок с экрана «После щелчка кнопки Edit панель изменяется на Allow и 

окошко-флажок». 

 

 

Снимок с экрана 

«Измените на Allow 

щелчком по окошку-

флажку». 

 Прокрутите страницу вниз, чтобы Save сохранить ваши результаты 

http://docs.moodle.org/25/en/Capabilities/enrol/meta:config
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3.3.5.6.See also 
 A workaround in the tracker for adding more than one course at a time 

 Screencast showing how to use the Course meta link plugin to make a 

Metacourse 

 Metacourse examples of use 

 

 Enrolment expiration in child course doesn't unenrol student from meta-

course - tracker issue 

3.3.6.Guest access 
The Guest access plugin allows users with the Guest role to view the 

contents of a course. This might be used, for example, if a Moodle site 

serves as a website where certain courses contain publicly available 

information, or else with a commercial Moodle site where courses with 

guest access can offers a "taster" of the kind of courses which may be 

purchased. (Note that the guest cannot participate in any activities; they 

can only view content.) 

3.3.6.1.Course settings for guest access 
 In Administration > Course administration > Users > Enrolment 

methods, first ensure that you have added "guest access" as an 

enrollment method, and that it has its eye open. 

 Ensure that self enrolment is also enabled. 

 In Administration > Course administration > Edit settings, scroll to 

"Guest access" 

 Set the drop down to "Yes" 

 If you wish guests to use a password to access the course then add it 

here. 

3.3.6.2.Admin settings for guest access 
 In Administration > Site administration > Plugins > Enrolments > 

Manage enrol plugins, ensure Guest access is enabled (has its eye 

open.) This enables Guest access. 

 In Administration > Site administration > Plugins > Manage 

authentication set the Guest login button to Show if you want the button 

on the Frontpage. 

 Also Guest accounts can be logged - check the Administration> Site 

administration > Server > Cleanup > Log guest access setting. 

 

 

 

3.3.5.6.See also 
 Искусственный приём в Средстве Слежения для добавления более одного Курса за раз. 

 Фильм с экрана, показывающий как использовать плагин Course meta link, чтобы 

сделать мета-Курс. 

 Примеры использования мета-Курса: 

http://docs.moodle.org/25/en/Metacourse_examples_of_use 

 Окончание зачисления в дочерний Курсе не отчисляет Студента из мета-Курса – вопрос 

Средства Слежения. 

3.3.6.Доступ Гостя 
Плагин Guest access (доступ Гостя) позволяет пользователям с Ролью «Гость» 

просматривать содержимое Курса. Это может быть использовано, например, если Сайт 

Moodle служит в качестве веб-Сайта, на котором определённые Курсы содержат 

общественно доступную информацию, или коммерческого Сайта, где Курсы с доступом 

Гостю могут предлагать «пробный» сорт Курсов, которые могут быть куплены. (Заметьте, 

что Гость не может участвовать ни в каких Интерактивных Действиях, он может только 

просматривать содержимое.) 

3.3.6.1.Настройки Курса для доступа Гостя 
 В AdministrationCourse administrationUsersEnrolment methods сначала убедитесь, 

что вам добавлен метод зачисления «Guest access (доступ Гостя)», против него иконка 

«глаз» открыта. 

 Убедитесь, самоЗачисление также разрешено. 

 В AdministrationCourse administrationEdit settings прокрутите страницу до «Guest 

access». 

 Установите в ниспадающем меню «Yes». 

 Если хотите, чтобы Гости пользовались паролем для доступа к Курсу, тогда добавьте 

его здесь. 

3.3.6.2.Настройки Администратора для доступа Гостя 
 В AdministrationSite administrationPluginsEnrolmentsManage enroll plugins, 

убедитесь, что «Guest access» разрешён (его «глаз» открыт). Это разрешает доступ 

Гостю. 

 В AdministrationSite administrationPluginsAuthenticationManage authentication 

установите кнопку Guest login (войти как Гость) в «Show», если хотите, чтобы эта 

кнопка была на первой странице. 

 Учётные записи Гостей могут быть также запротоколированы – отметьте настройку 

Log guest access в AdministrationSite administrationServerCleanup. 

https://tracker.moodle.org/browse/MDL-27628
http://www.youtube.com/watch?v=hA5QcTb13no&feature=player_embedded
http://www.youtube.com/watch?v=hA5QcTb13no&feature=player_embedded
http://docs.moodle.org/25/en/Metacourse_examples_of_use
https://tracker.moodle.org/browse/MDL-38916
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3.3.6.2.1.Default settings for guest access 
 Clicking on Administration > Site administration > Plugins > 

Enrolments > Guest access brings up the screen where admin can set 

defaults for guest access in courses. Guest access can be turned on by 

default in all new courses and you can also: 

 require each course with guest access to have a password for guests. 

(Note: this can confuse teachers who are not aware of the 

requirement.) 

 use or ignore your Moodle's standard password policy for guest 

access passwords 

 offer if needed the first letter of the password as a hint. 

3.3.6.2.2.Auto-login guests 
 In Administration > Site administration > Users > Permissions > User 

policies, you can tick the box so that visitors are automatically logged 

in as guests when accessing a course with guest access (i.e. they don't 

have to click the "login as guest button". 

 In Administration > Site administration > Plugins > Authentication > 

Manage Authentication, you must have "Guest login button" set to 

"Show". 

 In Administration > Site administration > Security > Site policies you 

can check "Open to Google" setting so that the Google search robot will 

be allowed to enter your site as a Guest. In addition, people coming in 

to your site via a Google search will automatically be logged in as a 

Guest. 

3.3.6.3.See also 
 Guest role 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.3.6.2.1.Настройки по умолчанию для доступа Гостя 
 Щелчок по AdministrationSite administrationPluginsEnrolmentsGuest access 

вызовет экран, где Администратор может установить значения по умолчанию для 

доступа Гостя в Курсы. Доступ Гостя может быть включён по умолчанию во всех 

Курсах и вы можете также: 

 Потребовать, чтобы каждый Курс с доступом Гостю имел пароль для Гостей. 

(Замечание: Это может сконфузить Преподавателей, которые не знают об этом 

требовании.) 

 Использовать или проигнорировать стандартную политику паролей Moodle при 

установке паролей для доступа Гостю. 

 Предложить, если необходимо, первую букву пароля в качестве подсказки. 

3.3.6.2.2.Авто-вход в Систему Гостей 
 В AdministrationSite administrationUsersPermissionsUser policies вы можете 

отметить окошко, чтобы посетители автоматически входили в Систему как Гости, когда 

организация доступа в Курс с доступом Гостя разрешена (т.е. они не должны щёлкать 

по кнопке Login as guest). 

 В AdministrationSite administrationPluginsAuthenticationManage authentication у вас 

должна быть кнопка Guest login установлена в «Show (показывать)». 

 

 В AdministrationSite administrationSecuritySite policies вы можете отметить 

настройку «Open to Google», чтобы поисковику Google было позволено входить на 

ваш Сайт как Гостю. В дополнение, люди, входящие на ваш Сайт посредством 

поисковика Google, автоматически будут регистрироваться как Гости. 

 

3.3.6.3.См. также 
«Роль Гостя» (п. 3.4.5.7). 

http://docs.moodle.org/25/en/Guest_role
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3.3.7.Category enrolments 
The category enrolments plugin allows users to be enrolled in a category as 

opposed to individual courses. The plugin has to be enabled by the site 

administrator (see Enrolment plugins). The category enrolment plugin will 

synchronise any role assignments at category context with the capability 

enrol/category:synchronised set to allow. 

Note: It is recommended that Cohort sync is used in preference to category 

enrolments. There are performance issues with category enrolments. 

See http://tracker.moodle.org/browse/MDL-23840. 

3.3.7.1.Settings for category enrolment 
 Go to the category into which you wish to enrol users. Note: You need 

to have category rights (manager or administrator) 

 In the Administration block, click Assign roles. The list of possible 

roles you can assign will appear: 

 

 

 

3.3.7.2.Settings for category enrolment 
The category enrolment plugin may be enabled or disabled throughout the 

site in Administration > Site administration > Plugins > Enrolments> 

Manage enrol plugins. 

3.3.7.2.1.Settings for category enrolment 
 By default, only managers and course creators can be assigned 

category-wide. If you want to add teachers or students then the site 

administrator needs to tick the "category" box in their role in 

Administration > Site administration > Users > Permissions > Define 

roles. 

 
To ensure they will be automatically assigned as teachers/students in any 

new courses you make, the administrator needs to set to "allow" the 

capability enrol/category:synchronised for the role in question in 

Administration > Site Administration > Users > Permissions > Define 

roles. 

 

 

 

 

 

 

3.3.7.Зачисления в Категорию 
Плагин Category enrolments (зачисление в категорию) позволяет пользователям 

быть зачисленными в Категорию в отличие от зачисления на отдельные Курсы. Плагин 

должен быть разрешён Администратором Сайта (см. п. 3.3.1). Плагин Category enrolments 

синхронизирует любые назначения Ролей в контекст Категорий, если разрешена 

Возможность enrol/category:synchronized. 

Замечание: Рекомендуется, предпочтение отдавалось Синхронизации Когорты 

по сравнению с зачислениям в Категорию, поскольку имеются вопросы по выполнению 

при зачислениях в Категорию. 

См. http://tracker.moodle.org/browse/MDL-23840. 

3.3.7.1.Настройки для зачисления в Категорию 
 Перейдите в Категорию, в которую вы хотите зачислить пользователей. Замечание: для 

работы с Категориями Вам нужны права 

(Менеджера Курсов или Администратора). 

 В блоке Administration щёлкните Assign roles 

(назначить Роли). Появится список возможных 

Ролей, которые вы можете назначить.  

3.3.7.2.Настройки для зачисления в Категорию 
Плагин Зачисления в Категорию может быть включён или отключён по всему 

Сайту в AdministrationSite administrationPluginsEnrolmentsManage enroll plugins. 

 

3.3.7.2.1.Настройки для зачисления в Категорию 
 По умолчанию только Менеджеры Курсов и создатели Курсов могут быть назначены 

для работы по всей Категории. Если вы хотите добавить Преподавателей или 

Студентов, тогда Администратору Сайта нужно пометить окошко «Category» в их Роли 

в AdministrationSite administrationUsersPermissionsDefine roles: щёлкнуть в левом 

столбце по названию Роли, т.е. по «Teacher (Преподаватель)» и/или «Student (Студент)», и в опции 

«Context types where this role may be assigned (типы контекстов, где эта роль может быть назначена)» 

пометьте окошко «Category (категория)». См. снимок с экрана справа: 

 Чтобы убедиться, что они будут автоматически 

назначаться как Преподаватели/Студенты в любых 

новых Курсах, которые вы создадите в Категории, 

Администратору нужно для обсуждаемой Роли 

установить Возможность enrol/category:synchronized в 

«Allow (разрешить)», щёлкнув по кнопке редактирования напротив обсуждаемой Роли, 

перейти к таблице в AdministrationSite administrationUsersPermissionsDefine roles  

http://docs.moodle.org/25/en/Capabilities/enrol/category:synchronised
http://tracker.moodle.org/browse/MDL-23840
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3.3.8.External database enrolment 
 

3.3.9.Flat file 
 

3.3.10.IMS Enterprise 
 

3.3.11.LDAP enrolment 
 

3.3.12.MNet remote enrolments 
 

3.3.13.Paypal enrolment 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

и, найдя строчки, 

Category enrolments 

Role assignments synchronised to course 

enrolment 

пометить окошко «Allow». См. снимок с экрана ниже: 

 

 

 

 
 

3.3.8.Зачисление из внешней базы данных 
См. http://docs.moodle.org/25/en/External_database_enrolment 

3.3.9.Плоский файл 
См. http://docs.moodle.org/25/en/Flat_file 

3.3.10.По стандарту IMS Enterprise 
См. http://docs.moodle.org/25/en/IMS_Enterprise 

3.3.11.LDAP-Зачисление 
См. http://docs.moodle.org/25/en/LDAP_enrolment 

3.3.12.Удалённые зачисления по MNet 
См. http://docs.moodle.org/25/en/MNet_remote_enrolments 

3.3.13.Зачисления с оплатой по Paypal 
См. http://docs.moodle.org/25/en/Paypal_enrolment 

http://docs.moodle.org/25/en/External_database_enrolment
http://docs.moodle.org/25/en/Flat_file
http://docs.moodle.org/25/en/IMS_Enterprise
http://docs.moodle.org/25/en/LDAP_enrolment
http://docs.moodle.org/25/en/MNet_remote_enrolments
http://docs.moodle.org/25/en/Paypal_enrolment
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3.4.Roles and permissions 
How to add or remove permissions from students, teachers and other users 

on your Moodle. A role is a collection of permissions defined for the whole 

system that you can assign to specific users in specific contexts. The 

combination of roles and context define a specific user's ability to do 

something on any page. The most common examples are the roles of 

student and teacher in the context of a course. 

 

3.4.1.Managing roles 
Managing overall role capabilities can be done by an administrator using 

Administration > Site administration > Users > Permissions > Define roles. 

This is the place to add custom roles or modify existing roles. The 

"Manage roles" tab, allows the system administrator to edit any one of over 

350 different capabilities associated with any role. The "Allow role 

assignments", "Allow role overrides" and "Allow role switches" contain a 

matrix which give the ability for a specific role to work with other specific 

roles. 

 

3.4.1.1.Manage roles 
The 'Manage roles' tab contains a list of roles on your site. The edit column 

contains icons for editing, deleting roles and copying roles, and for moving 

them up or down in the list (affecting the way that roles are listed around 

Moodle). 

To edit a role: 

 Go to Administration > Site administration > Users > Permissions > 

Define roles. 

 

 Click the edit icon opposite the role you want to edit. For example 

"student". 

 

 

 On the editing role page, change permissions as required for each 

capability. 

 

 Scroll to the bottom of the page and click the "Save changes" button. 

See Creating custom roles for information about adding a new role and 

creating a duplicate role. 

 

 

3.4.Роли и Полномочия 
Как предоставлять или слагать Полномочия со Студентов, Преподавателей и 

других пользователей в вашей Системе Moodle. Роль – это коллекция Полномочий, 

определённая для всей Системы в целом, которые вы можете назначить конкретным 

пользователям в конкретных Контекстах. Комбинация Ролей и Контекста определяет 

возможность конкретного пользователя делать что-то на любой странице. Наиболее 

распространёнными примерами являются Роли Студента и Преподавателя в Контексте 

Курса. 

3.4.1.Управление Ролями 
Управление Возможностями Ролей в целом может осуществлять Администратор, 

используя AdministrationSite administrationUsersPermissions Define roles. Это 

место, где добавляют клиентские Роли и модифицируют существующие. Этикетка 

«Manage roles (управлять Ролями)» разрешает Системному администратору 

редактировать 520 (для версии 2.5) различных Возможностей, связанных с любой 

ролью. «Allow role assignments (разрешить назначения Ролей)», «Allow role overrides 

(разрешить отменять Роли)» и «Allow role switches (Разрешить переключать Роли)» 

содержат матрицу, которая делает возможным для конкретной Роли работать с другими 

конкретными Ролями. 

3.4.1.1.Управлять Ролями 
Этикетка «Manage roles» содержит перечень ролей на вашем Сайте. Колонка 

«Edit» содержит иконки для редактирования, удаления, копирования или перемещения 

Ролей вниз или вверх по этому списку (имитирование способа, которым Роли 

перечисляются вокруг Moodle). 

Чтобы отредактировать Роль: 

 Перейдите к Administration 

Site administrationUsers 

Permissions Define roles. 

 Щёлкните Edit – иконку 

редактирования против Роли, 

которую хотите отредактировать. 

Например «student». 

 На странице редактирования Роли 

измените как нужно Полномочия 

для каждой Возможности. 

 Прокрутите страницу вниз и щёлкните кнопку «Save changes (сохранить изменения)». 

См. «Создание клиентских Ролей» (п. 3.4.6), где дана информация о добавлении 

новой Роли и создании дубликата Роли. 
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3.4.1.2.Role name localisation 
If a standard role name or description is empty Moodle uses a default 

string from the current language pack. Custom roles can be customised 

using multilang syntax. 

You may also override the role names separately in each course. 

3.4.1.3.Resetting a role 
To reset a role back to the default permissions: 

 Go to Administration > Site administration > Users > Permissions > 

Define roles. 

 Click on the name of the role, for example "student". 

 Click the 'Reset to defaults' button. 

Note that if you have students who have been given extra permissions at 

course and/or activity levels (such as forum ratings), then they will no 

longer be able to do this once the role has been reset to its default. A 

teacher would need to go back and set up these extra permissions in the 

course/activity levels again. 

3.4.1.4.Allow role assignments 
The "Allow role assignments" tab allows (or does not allow) a specific role 

to be able to assign specific roles to a user. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.4.1.2.Локализация названия Роли 
Если стандартное название Роли или описание пусты, Moodle по умолчанию 

использует строку из текущего языкового пакета. Клиентские Роли могут быть настроены 

с использованием многоязычного синтаксиса. 

Вы также можете отменить названия Ролей отдельно в каждом Курсе. 

3.4.1.3.Возврат Роли в исходное состояние 
Чтобы вернуть Роль обратно к Полномочиям по умолчанию: 

 Перейдите в AdministrationSite administrationUsersPermissionsDefine roles. 

 

 Щёлкните наименование Роли, например, «student». 

 Щёлкните кнопку «Reset to defaults (вернуть к значениям по умолчанию)». 

Заметьте, что если у вас есть Студенты, которым даны экстра Полномочия на 

уровнях Курса и/или Интерактивного Действия (таких как рейтинги Форума), то они 

дольше будут не в состоянии делать то, что делали до сброса Роли к состоянию по 

умолчанию. Преподавателю потребуется вернуться назад и снова установить те экстра 

Полномочия на уровнях Курса/Интерактивного Действия. 

3.4.1.4.Разрешить назначения Ролей 
Этикетка «Allow role 

assignments» разрешает (или не 

разрешает) конкретной Роли 

иметь возможность назначать 

конкретные Роли 

пользователю. 
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3.4.1.4.1.Enabling teachers to assign other 
teachers 
By default, teachers can only assign other users the roles of non-editing 

teachers, students and guests. If you want teachers to be able to assign 

other teachers in their course, you can allow the role assignment: 

 

 Click on Administration > Site administration > Users > Permissions > 

Define roles. 

 Click the Allow role assignments tab. 

 Click the checkbox where the teacher row and column intersect. 

 

 Click the "Save changes" button. 

3.4.1.5.Allow role overrides 
The "Allow role overrides" tab allows (or does not allow) a specific role to 

be able to override specific roles for a user. For example, it might allow a 

teacher role to override a student's role to a non-editing teacher's role. 

 

Note that the settings only apply to roles that have the capabilities 

moodle/role:override or moodle/role:safeoverride allowed. 

3.4.1.6.Allow role switches 
The "Allow role switches" tab allows (or does not allow) a specific role to 

be able to temporarily change their role to another specific role. For 

example, this might allow a users assigned to a custom role in a course to 

see "Student" in the Settings > Switch role list. 

Note: the selected role must also have the moodle/role:switchroles 

capability to be able to switch. 

3.4.1.7.Roles capabilities 
3.4.1.7.1.Create and manage roles 
Capabilities/moodle/role:manage 
 This allows a user to manage roles i.e. create, edit, delete, change base 

role definitions, allow role assignments and allow role overrides. 

 

 

 

 

 

 

 

3.4.1.4.1.Разрешение Преподавателям назначать других 
Преподавателей 

По умолчанию Преподаватели могут назначать другим пользователям только роли 

не Редактирующих Преподавателей, Студентов и Гостей. Если вы хотите, чтобы 

Преподаватели в своём Курсе были способны назначать других Преподавателей, вы 

можете разрешить назначение этой Роли. 

 Щёлкните по AdministrationSite administrationUsersPermissionsDefine roles. 

 

 Щёлкните по этикетке «Allow role assignments (разрешить назначение ролей)». 

 Щёлкните кнопку-флажок, где строка и столбец «teacher (Преподаватель)» 

пересекаются. 

 Щёлкните кнопку «Save changes». 

3.4.1.5.Разрешить замены Ролей 
Этикетка «Allow role overrides (разрешить замены ролей)» разрешает (или не 

разрешает) конкретной Роли быть способной заменять конкретные Роли других 

пользователей. Например, она может разрешить Роли Преподавателя заменять Роль 

Студента на Роль не Редактирующего Преподавателя. 

Заметьте, что эти настройки применимы только к Ролям, которым предоставлена 

Возможность moodle/role:override или moodle/role:safeoverride. 

3.4.1.6.Разрешить переключения Ролей 
Этикетка «Allow role switches (разрешить переключения ролей)» разрешает (или 

не разрешает) конкретной Роли быть способной временно изменить свою роль на другую 

конкретную Роль. Например, она может разрешить пользователям, назначенным на 

клиентскую Роль увидеть «Student» в списке SettingsSwitch role. 

Замечание: выбранная Роль также должна иметь Возможность 

moodle/role:switchroles, чтобы быть способной к переключению. 

3.4.1.7.Возможности Ролей 
3.4.1.7.1.Создавать и управлять Ролями 

Возможность Capabilities/moodle/role:manage 

 Позволяет пользователю управлять Ролями, т.е. создавать, редактировать, удалять, 

изменять определения базовых Ролей, разрешает назначения и замены Ролей. 



 

57 

 This capability is allowed for the default role of manager only. It may 

only be applied in the site/system context i.e. as a system role. 

3.4.1.7.2.Assign roles to users 
Capabilities/moodle/role:assign 

 This allows a user to assign roles in a given context (system, front page, 

course category or course). 

 Note that to assign a role A to another user, the user doing the 

assignment has to hold a role B so that role B is permitted to assign role 

A. This is controlled in 'Allow role assignments' in Settings > Site 

administration > Users > Permissions > Define roles. This is logical 

because even though a teacher might have moodle/role:assign, in most 

situations we only want them to be able to assign users the student role, 

and not the manager role in their course. 

 This capability is allowed for the default roles of manager and teacher. 

3.4.1.7.3.Switch to other roles 
Capabilities/moodle/role:switchroles 

 This allows a user to switch temporarily to another role in 

Administration > Switch role to... so that they can see what the course 

would look like to someone with that role. 

 The "Switch role to..." list is set in the "Allow role switches" tab of 

"Site Administration > Users > Permissions > Define role" page. 

WARNING! This facility does not always give you a true picture of what 

the course would look like to someone with that role. It is recommended 

you have a "test" user with the appropriate role who can be used to give a 

more accurate view. 

 

3.4.2.Assign roles 
3.4.2.1.Context and roles 
 In Moodle, apart from the site administrator, users do not normally have 

a global, site-wide role. In other words, even though you may be a tutor 

offline, when you are in Moodle you could have a tutor role in the 

course you teach in but a student role in another course where you are 

studying for a diploma. There are a few exceptions but this is generally 

the case. 

 

 

 

 

 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера Курсов. Она 

может быть применена только в Контексте Сайта/Системы, т.е. как Системная Роль. 

3.4.1.7.2.Назначать Роли пользователям 
Возможность Capabilities/moodle/role:assign 

 Позволяет пользователю назначать Роли (п. 3.4.2) в данном Контексте (Системы, 

Главной страницы, Категории Курса или Курса). 

 Заметьте, чтобы назначить Роль А другому пользователю, пользователь 

осуществляющий назначение, должен иметь Роль В, которой позволено назначать Роль 

А. Это контролируется в «Allow role assignments (разрешить назначения Ролей)» в 

AdministrationSite administrationUsersPermissionsDefine roles. Это логично 

потому, что, даже если Преподаватель может иметь Возможность moodle/role:assign, в 

большинстве ситуаций мы хотим, чтобы он был способен назначить пользователям 

Роль Студента, а не Роль Менеджера в своём Курсе. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

3.4.1.7.3.Переключать к другим Ролям 
Возможность Capabilities/moodle/role:switchroles 

 Позволяет пользователю временно переключиться на другую Роль в 

AdministrationSwitch role to…, чтобы он смог увидеть, как выглядит данный Курс для 

обладателя такой Роли. 

 Список «Switch role to...», устанавливается в этикетке «Allow role switches» в 

AdministrationSite administrationUsersPermissionsDefine roles. 

ПРЕДУПРЕЖДЕНИЕ! Эта возможность не всегда даёт вам 

истинную картину того, как этот Курс для кого-то с такой Ролью 

будет выглядеть. Рекомендуется, чтобы вы имели «тестового» 

пользователя с подходящей Ролью, который мог бы дать более 

точное представление. 

3.4.2.Назначать Роли 
3.4.2.1.Контекст и Роли 
 В Moodle, не считая Администратора Сайта, пользователи обычно не имеют 

глобальной, действенной для всех Курсов Сайта, Роли. Другими словами, даже если вы 

автономный наставник, когда вы находитесь в Moodle, вы можете иметь Роль 

наставника в том Курсе, в котором вы обучаете, но Роль Студента в другом Курсе, где 

вы обучаетесь для получения диплома. Имеется несколько исключений, но это – 

типичный вариант. 
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 Because of the way Moodle works, assigning roles is done for a 

particular context. A site and course are examples of two different 

contexts. When you create a new role or tweak a pre-existing role via 

Administration > Site Administration > Users > Permissions > Define 

roles, you are asked in which context(s) you want the role to be 

assigned: 

 Here are some examples of contexts; how to get to the assign roles 

screen, and when/why you would assign roles here: 

 

3.4.2.1.1.System context 
 Administration > Site Administration > Users > Permissions > Assign 

system roles 

 Any roles assigned here apply to the whole Moodle site. It makes sense 

therefore that only roles that need this functionality can be assigned 

here. The Manager role and Course creator role are examples of two 

such roles. Assigning a teacher or student here would result in their 

being able to teach/study in every single course on the site, which is not 

usually desirable. 

If you really feel your Moodle needs to have teachers or students 

assigned in the system context, go to the teacher/student role in 

Administration > Site administration > Users > Permissions > Define 

roles and check the "system" box. Then search for and allow the 

capability moodle/course:view 

3.4.2.1.2.Front page context 
 Administration > Site Administration > Front Page > Front Page roles 

 Those with a role in the system context do not need to be assigned a 

role here as well. 

 However you might want to allow a teacher to manage items on the 

front page; in this instance, you would assign them the role on the Front 

page. 

3.4.2.1.3.Course Category context 
 See Category enrolments 

 Users may be enrolled in the category to save enrolling them in each 

individual course in that category. 

3.4.2.1.4.Course context 
 Go to Administration > Course administration > Enrolled users 

 

 Click the "Enrol users" button and click those users you wish to enrol 

 

 Из-за способа работы Moodle, назначение Ролей осуществляется для конкретного 

Контекста. Сайт и Курс – примеры двух конкретных Контекстов. Когда вы создаёте 

новую Роль или модифицируете предварительно существующую Роль через 

AdministrationSite administrationUsersPermissionsDefine roles, вас спросят, в 

каком контексте (ах) вы хотите назначить эту Роль ▬►. 

 

 Здесь несколько примеров Контекстов; как выходить на 

экран назначения Ролей, а также когда/почему вы могли 

бы назначать Роли здесь. 

3.4.2.1.1.Контекст Системы 
 AdministrationSite administrationUsersPermissionsAssign system roles. 

 

 Любые Роли, назначенные здесь, применяются по Сайту Moodle в целом. Это, 

следовательно, означает, что только Роли, которым нужна такая функциональность, 

могут назначаться здесь. Роль Менеджера Курсов и роль Создателя Курсов являются 

примерами двух таких ролей. Назначение Преподавателя или Студента здесь приведёт 

к возможности преподавать/обучаться в каждом отдельном Курсе на этом Сайте, что 

обычно не желательно. 

Если вы всё же думаете, что ваша Moodle нуждается в Преподавателях или Студентах, 

назначаемых в Контексте Системы, перейдите к роли teacher/student в 

AdministrationSite administrationUsersPermissionsDefine roles, и пометьте 

окошко «system». Затем отыщете и разрешите Возможность moodle/course:view. 

 

3.4.2.1.2.Контекст Главной Страницы 
 AdministrationSite administrationFront PageFront Page roles. 

 Тем, кто имеет Роль в Контексте Системы, не требуется назначать Роль также и здесь. 

 

 Однако, вы можете захотеть разрешить Преподавателю управлять элементами 

Главной Страницы; в этом случае вам следует назначить ему эту роль на 

Главной Странице. 

3.4.2.1.3.Контекст Категории Курса 
 См. Зачисления в Категорию. 

 Пользователи могут быть зачислены в Категорию, чтобы сохранять их зачисление в 

каждом индивидуальном Курсе в этой Категории. 

3.4.2.1.4.Контекст Курса 
 Перейдите к AdministrationCourse administration 

Enrolled users. 

 Щёлкните кнопку «Enrol users (зачислить пользователей)» 

и щёлкните тех пользователей, которых хотите зачислить. 
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The dropdown menu at the top shows roles for which you are allowed to 

enrol; typically those users with lower roles than you. See Enrolled users 

for more details. 

3.4.2.1.5.Block context 
 (Within the block) Administration > Assign roles 

 You may wish to assign roles to a block if, for instance you want 

specific people to see the block but for it to be hidden from others 

3.4.2.1.6.Activity Module context 
 (Within the activity settings) Administration > Locally assigned roles 

 An example of this is assigning a student the teacher role locally in an 

individual activity like a forum so they can moderate their classmates' 

posts while still retaining the student role in the rest of the course. 

 

3.4.2.1.7.User context 
 The most common use of this is for the Parent role. 

 When the Parent role is created via Administration > Site 

administration > Users > Permissions > Define roles the "user" context 

box is checked. 

 To assign a parent the role in the context of their child (so they can see 

their child's grades etc) click the child's profile and then go to 

Administration>Roles>Assign roles relative to this user 

 See Parent role for more information. 

The assign roles page lists the names of users assigned to each role (unless 

there are more than 10 users, in which case this is stated). 

3.4.2.2.Hierarchy 
By assigning a role to a user in a certain context, you grant them the 

permissions contained in that role for the current context and all lower 

contexts. 

The list of contexts in hierarchical order is as follows: 

 System (no parent) 

 Front page (parent = system) - 

 Course category (parent = parent category or system) 

 Course (parent = category or system) 

 Module (parent = course or system) 

 Block (parent = course or system) 

 User (parent = system) 

 

 

 

Ниспадающее меню вверху покажет Роли, на которые вам разрешается зачислить; 

обычно это пользователи с Ролями более низкого уровня, чем ваша. Больше подробностей 

приведено в Enrolled users (зачисленные пользователи, см. п. 4.7.1). 

3.4.2.1.5.Контекст Блока 
 (Внутри конкретного Блока) перейти в AdministrationAssign roles. 

 Вы можете пожелать назначить Роли в Блоке, если, например, вы хотите, чтобы 

конкретные люди видели этот Блок, а от других он был скрыт. 

3.4.2.1.6.Контекст модуля Действия 
 (Внутри настроек Действия) Activity module AdministrationLocally assigned roles. 

 Примером этого может служить назначение Студенту Роли Преподавателя 

локально в индивидуальном Действии, подобном Форуму, чтобы он мог сдерживать, 

умерять (moderate) поток почтовой корреспонденции своих сокурсников, оставаясь с 

обычной Ролью Студента в оставшейся части этого Курса. 

3.4.2.1.7.Контекст пользователя 
 Наиболее часто это используется для Роли Родителя Студента (Студентки). 

 Когда Роль Родителя создаётся посредством отметки окошка Контекста «User» 

посредством 

AdministrationSite administrationUsersPermissionsDefine roles. 

 Чтобы назначить Роль Родителя в Контексте его ребёнка (чтобы они могли видеть 

оценки своего ребёнка и т.д.), щёлкните Профиль ребёнка, и затем перейдите к 

AdministrationRolesAssign roles относительно этого пользователя. 

 

 Больше информации приведено в «Роль Родителя» (п. 3.4.7). 

Страница назначения Ролей перечисляет имена пользователей, назначенных на 

каждую Роль (если их не более 10, иначе это указывается). 

3.4.2.2.Иерархия 
Назначением Роли пользователю в определённом Контексте, вы гарантируете ему 

Полномочия, содержащиеся в этой Роли для текущего Контекста и во всех более низких 

Контекстах. 

Список Контекстов в иерархическом порядке: 

 System – Система (нет более высокой Родительской иерархии) 

 Front page – Главная страница (Родитель = Система) 

 Course category – Категория Курса (Родитель = Категория Родителя или Система) 

 Course – Курс (Родитель = Категория или Система) 

 Module – модуль (Родитель = Курс или Система) 

 Block – блок (Родитель = Курс или Система) 

 User – пользователь (Родитель = Система) 
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Roles can be inherited. For example if a user is assigned a Teacher role in a 

specific course category then the user will have this role in ALL courses 

within the category. Tip: use the override feature in a specific context for 

exceptions. Roles will only work if the role assignment is made in the 

correct context. Some examples: a Teacher role should be assigned to a 

user in the course or course category context, a Forum moderator for a 

particular forum should be assigned in that specific forum. 

3.4.2.3.Assigning someone the role of Site 
Administrator 
 Although this is a system role, the site administrator role cannot be 

assigned via Administration>Site 

Administration>Users>Permissions>Assign system roles because it 

would be too easy to mistakenly enrol or unenrol administrators and be 

left with nobody in charge of your Moodle. 

 For this reason, administrators are assigned via a special page: 

Administration>Site Administration>Users>Permissions>Site 

Administrators and you are asked to think twice before you give 

someone this role. Select the name from the right and move it over to 

the left: 

 Note also that the original (primary) administrator cannot be deleted. 

 

3.4.2.4.Hidden roles 
If you want to provide users with access to the course, but don't want them 

to be visible in the participants list, use the Other users link in the course 

administration menu (Administration > Course Administration > Users > 

Other Users). Assigning roles here provides course access, and editing 

rights according to the permissions set for the role assigned without 

actually enrolling the user in the course. This is similar to the functionality 

of the "hidden user" check box in previous versions of Moodle. 

 

Note: By default, the only role which can be assigned to other users is the 

manager role. To enable other roles, such as teacher to be assigned, the 

capability moodle/course:view should be allowed for the role. 

 

 

 

 

 

 

Роли могут быть унаследованы. Например, если пользователю назначена Роль 

Преподавателя в конкретной Категории Курсов, тогда этот пользователь будет иметь эту 

Роль во ВСЕХ Курсах этой Категории. Совет: Используйте средства замены в конкретном 

Контексте для исключений. Роли будут работать, если только назначение каждой из них 

сделано в правильном Контексте. Некоторые примеры: Роль Преподавателя должна быть 

назначена пользователю в Контексте Курса или Категории Курсов; Модератор Форума для 

конкретного Форума должен назначаться в этом конкретном Форуме. 

3.4.2.3.Назначение кому-то Роли Администратора Сайта 
 
 Хотя это Системная Роль, Роль Администратора Сайта не может быть назначена через 

AdministrationSite administrationUsersPermissionsAssign system roles, потому 

что слишком легко ошибочно зачислить или отчислить Администраторов и остаться ни 

с кем по контролю за Системой Moodle. 

 

 По этой причине Администраторы назначаются посредством специальной страницы: 

AdministrationSite administrationUsersPermissionsSite Administrator и 

рекомендуется дважды подумать, прежде чем кому-то предоставить эту Роль. Выберите 

имя справа и переместите его влево. 
 

 Заметьте также, что оригинальный (первич-

ный) Администратор не может быть удалён. 

3.4.2.4.Скрытые Роли 
Если вы хотите предоставить пользователям доступ к Курсу, но не хотите, чтобы 

они были представлены в списке Участников Курса, используйте ссылку Other users 

(другие пользователи) в меню Administration (управление) этого Курса 

(AdministrationCourse administrationUsersOther Users). Назначение Ролей здесь 

обеспечивает доступ к Курсу и права редактирования в соответствии с Полномочиями, 

установленными для назначаемой Роли, без действительно зачисления этого пользователя 

на этот Курс. Это похоже на функциональность окошка-флажка «Hidden user (скрытый 

пользователь)» в предыдущих версиях Moodle. 

Замечание: По умолчанию единственная Роль, которая может быть назначена в 

«Других пользователях» является Роль Менеджера. Чтобы назначать другие Роли, такие 

как Преподаватель, для этой Роли должна быть разрешена Возможность 

moodle/course:view. 
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3.4.2.5.Enabling teachers to assign the role of 
teacher 
By default, teachers are only allowed to assign the roles of non-editing 

teacher, student and guest. To enable teachers to assign the role of teacher: 

 

 Access Administration > Users > Permissions > Define roles. 

  

 Click the tab "Allow role assignments". 

 Click the checkbox where the teacher row and column intersect. 

 Click the "Save changes" button. 

3.4.2.6.Beware of assignments that don't make 
sense 
There are many role assignments that do not make sense as the underlying 

functionality does not exist. Just because you give someone the "right" to 

do something does not guarantee that the interface or facility actually 

exists within the context that you have assigned that right. For example, 

you can assign a user the right to create new categories in the category 

context. However there is no interface within Moodle to do that (category 

creation is only available at the system level). 

3.4.2.7.Multiple assignments 
A significant part of the roles infrastructure is the ability to assign a user 

into multiple roles (at the same time). The capabilities of each role are 

merged to produce the effective set of capabilities. For example, a user 

could be both a Teacher and Student in the same course. You should be 

careful to ensure that if you change a user's role that you remove them 

from any other roles as required as this will no longer be done 

automatically. 

3.4.2.8.See also 
 Creating custom roles 

 Enrolment 

 Managing roles - for administrators 

 Useful things a teacher can do with roles 

3.4.3.Roles settings 
3.4.3.1.User policies 
The following settings may be changed by an administrator in 

Administration > Site administration > Users > Permissions > User 

policies. 

3.4.2.5.Разрешение Преподавателям назначать Роль 
Преподавателя 

По умолчанию Преподавателям разрешено назначать Роли: 

неРедактирующего Преподавателя, Студента и Гостя. Чтобы разрешить Преподавателям 

назначать Роль Преподавателя: 

 Получите доступ к AdministrationSite administrationUsersPermissionsDefine 

roles. 

 Щёлкните этикетку «Allow role assignments (разрешить назначения ролей)». 

 Щёлкните окошко-флажок на пересечении строки и колонки «Teacher». 

 Щёлкните кнопку «Save changes». 

3.4.2.6.Остерегайтесь неразумных назначений 
 

Существует много назначений Ролей, которые не имеют смысла, поскольку не 

существует подразумеваемой функциональной Возможности. Именно потому, что когда 

вы даёте кому-то «право» делать что-то, то это ещё не гарантирует, что действительно 

существуют интерфейс или Возможность внутри Контекста, в котором вы выполнили это 

назначение. Например, вы можете назначить пользователю право создавать новые 

Категории в контексте конкретной Категории. Однако, внутри Moodle нет интерфейса, 

который бы делал это (создание Категории доступно только на Системном уровне). 

3.4.2.7.Разнородные назначения 
Значительная часть инфраструктуры Ролей есть способность назначать 

Пользователю различные Роли (в одно и то же время). Возможности каждой Роли 

сливаются и образуют эффективный набор Возможностей. Например, пользователь может 

быть в одном и том же Курсе Преподавателем и Студентом. Вы должны самым 

тщательным образом убедиться, что если вы измените Роль пользователя, то удалите 

её из любых других Ролей, как требуется, так как это не будет больше делаться 

автоматически. 

3.4.2.8.См. также 
 Создание клиентских Ролей (п. 3.4.6). 

 Назначения (п.3.3). 

 Управление Ролями (п. 3.4.1) – для Администратора. 

 Полезные вещи, которые Преподаватель может делать с Ролями (п. 3.4.4). 

3.4.3.Настройки Ролей 
3.4.3.1.Политики пользователей 

Следующие настройки могут быть изменены Администратором в 

AdministrationSite administrationUsersPermissionsUser policies. 
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3.4.3.1.1.Role for visitors 
Users who are not logged in to the site will be treated as if they have the 

role specified here, granted to them at the site context. The role of Guest is 

the default and the recommended setting for standard Moodle sites. The 

user will still be required to login to participate in an activity. 

3.4.3.1.2.Role for guest 
This option specifies the role that will automatically be assigned to the 

guest user. This role is also temporarily assigned to non enrolled users 

when they enter a course that allows guests without password. 

 

3.4.3.1.3.Deny Guest Access to a site altogether 
Go to Site administration ► Plugins ► Authentication ► Manage 

authentication and there is a switch there that allows you to turn the Guest 

Access button off altogether. 

3.4.3.1.4.Default role for all users 
It is recommended that the default role for all users is set to Authenticated 

user. To set it to a custom role, the custom role must be assignable in the 

system context and have role archetype set to none. 

 

Note: It is not recommended that the default role for all users is set to 

student, for reasons given in MDL-26805. 

3.4.3.1.5.Auto-login guest 
If not set, then visitors must click the "Login as a guest" button before 

entering a course which allows guest access. 

Note: If auto-login guest is set, the guest login button also need 

s to be set to show (in Administration > Site administration > Plugins > 

Authentication > Manage authentication), even though visitors won't 

necessarily use it. 

3.4.3.1.6.Hide user fields 
The following user fields appear on users' profile pages. Certain user fields 

are also listed on the course participants page. You can increase student 

privacy by hiding selected user fields. 

 

Description, city/town, country, web page, ICQ number, Skype ID, Yahoo 

ID, AIM ID, MSN ID, last access, My courses and first access and groups 

 

 User fields on users' profile pages are hidden from all users with the 

capability moodle/user:viewhiddendetails not set. 

 

3.4.3.1.1.Роли для посетителей 
С пользователями, которые не зарегистрированы на Сайте, будут обращаться так, 

как если бы они имели Роль, указанную здесь, допускающую их в Контекст Сайта. Роль 

Гостя даётся по умолчанию и рекомендуемая установка для стандартных Сайтов Moodle. 

Однако от пользователя всё равно потребуют авторизации для участия в работе на Сайте. 

3.4.3.1.2.Роль для Гостя 
Эта опция указывает Роль, которая будет автоматически назначена Гостевому 

пользователю. Эта Роль также временно назначается не зачисленным на Курсы 

пользователям, когда они заходят на Курс, который разрешает заходить Гостям без 

пароля. 

3.4.3.1.3.Запретить доступ на Сайт всем Гостям 
Перейдите к Site administrationPluginsAuthenticationManage authentication и 

там есть переключатель, который позволяет вам совсем отключить кнопку «Guest Access 

(Гостевой доступ)». 

3.4.3.1.4.Роль по умолчанию для всех пользователей 
Рекомендуется, чтобы по умолчанию Ролью для всех пользователей была Роль 

Authenticated user (аутентифицированный пользователь, см. п. 3.4.5.8). Чтобы установить 

её какой-либо клиентской Роли, эта клиентская Роль должна быть назначена в Контексте 

Системы и иметь архетип Роли установленный в «None». 

Замечание: Не рекомендуется, чтобы по умолчанию эта Роль для всех 

пользователей устанавливалась Студенту по причине, указанной в MDL-26805. 

3.4.3.1.5.Авто-регистрация Гостя 
Если не установлена, тогда посетители должны щёлкнуть кнопку Login as a guest 

перед тем, как войти в Курс, разрешающий Гостевой допуск. 

Замечание: Если установлено Auto-login guest, кнопку Guest login также нужно 

установить, чтобы она появилась на экране, даже если Гости не хотят ею пользоваться (в 

AdministrationSite administrationPlugins AuthenticationManage authentication). 

 

3.4.3.1.6.Скрыть поля пользователя 
Следующие поля пользователя появляются на страницах Профиля Пользователя. 

Определённые поля пользователя также перечисляются на странице Участников Курса. 

Вы можете повысить неприкосновенность частной жизни Студента, скрыв выбранные 

поля пользователя. 

Описание, город/посёлок, страна, веб-страница, идентификатор ICQ, 

идентификатор Skype, идентификатор Yahoo, идентификатор AIM, идентификатор MSN, 

последний доступ, мои курсы и первый доступ, и Группы. 

 Поля пользователя на страницах Профиля пользователя скрываются от всех 

пользователей с неустановленной Возможностью moodle/user:viewhiddendetails. 

http://docs.moodle.org/25/en/Guest
https://tracker.moodle.org/browse/MDL-26805
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 User fields on the course participants page are hidden from all users 

with the capability moodle/course:viewhiddenuserfields not set. 

3.4.3.1.7.Show user identity 
Any of the following fields may be shown to users with the capability 

moodle/site:viewuseridentity when searching for users and displaying lists 

of users. 

 ID number 

 Email address 

 Phone number 

 Mobile phone 

 Department 

 Institution 

This setting is useful for sites with large number of users, where the 

likelihood of users with the same name is high. 

Locations where user identity fields are shown are as follows: 

 User selectors (Assign roles in some places, groups, forum subscribers) 

 

 Browse list of users 

 Course participants 

 Grader report 

 Quiz reports 

 SCORM reports 

 Assignment submissions 

 Course completion report 

 Activity completion report 

 Enroling users 

Tip: Select only one or two fields that are mandatory at your institution. Do 

not select more than two field otherwise tables become very wide. 

 

3.4.3.1.8.Maximum users per page 
You can choose here the maximum number of users to be displayed when 

searching in courses, groups, cohorts etc. The default is 100 but if your 

Moodle site is very large you can increase the number here.  

New feature in Moodle 2.5! 

3.4.3.1.9.Enable Gravatar 
Gravatar (an abbreviation for globally recognized avatar) is a service for 

providing globally unique avatars. 

 

 

 Поля пользователя на странице Участников курса скрываются от всех пользователей с 

неустановленной Возможностью moodle/course:viewhiddenuserfields. 

3.4.3.1.7.Установить подлинность пользователя 
Любые из следующих полей могут быть показаны пользователям с Возможностью 

moodle/site:viewuseridentity при поиске пользователей и отображении списков 

пользователей. 

 ID number  номер идентификатора 

 Email address адрес э-почты 

 Phone number номер телефона 

 Mobile phone мобильный телефон 

 Department  отдел 

 Institution  учреждение 

Эта настройка полезна для Сайтов с большим числом пользователей, где высока 

вероятность встретить пользователей с одинаковыми именами. 

Места, где нужны поля идентифицирующие пользователя, показаны ниже: 

 Там, где выбирают пользователей (назначение Ролей в некоторых местах, Группы, 

подписчики Форумов). 

 Список просмотра пользователей. 

 Участники Курса. 

 Отчёт Оценивающего. 

 Отчёты по Экзамену. 

 Отчёты по работе в пакетах SCORM. 

 Переданные на рассмотрение готовые ответы по Заданию. 

 Завершающий отчёт по Курсу. 

 Завершающий отчёт по Интерактивному Действию. 

 Зачисление пользователей. 

Совет: Выберите только одно или два поля, которые обязательны в вашем 

учреждении. Не выбирайте более двух полей, в противном случае таблица станет очень 

широкой. 

3.4.3.1.8.Максимальное число пользователей на страницу 
Вы можете выбрать здесь максимальное количество пользователей для 

отображения при просмотре в Курсах, Группах, Когортах и т.д. По умолчанию оно равно 

100, но если ваш Сайт Moodle очень большой, вы можете увеличить это число. 

Новое средство в Moodle 2.5! 

3.4.3.1.9.Разрешить граватара 
Граватар (аббревиатура от глобально распознаваемого аватара-картинки) является 

сервисом для обеспечения глобально по всему интернету уникальных аватар. 
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An administrator can enable the use of gravatars in Administration > Site 

administration > Users > Permissions > User policies. If a user has not 

uploaded a user picture, Moodle will check whether the user's email 

address has an associated gravatar and if so, will use the gravatar as the 

user's picture. 

3.4.3.1.10.Gravatar default image URL 
In Moodle 2.3.3 onwards, if gravatars are enabled, an alternative 

default user picture may be specified. The options are: 

 A gravatar default image - by entering a code such as mm. See 

https://en.gravatar.com/site/implement/images/ for codes of other 

gravatar default images. 

 A specified image - by entering the image URL 

If the field is left empty then the theme's default user picture is 

used. 

3.4.3.2.Unsupported role assignments 
Unsupported role assignments are role assignments in contexts that make 

no sense for that role, such as the course creator role in the course or 

activity context, or the teacher role in the user context. 

 

Prior to Moodle 2.0, there was no 'Context types where this role may be 

assigned' setting in the edit role form, and so any role could be assigned in 

any context. Upon upgrading a site from 1.9, any role assignments in 

contexts that make no sense for that role are listed as unsupported role 

assignments in Settings > Site administration > Users > Permissions > 

Unsupported role assignments. 

In general, it is safe to delete all unsupported role assignments. In doing so, 

the worst that can happen is for a user to be unassigned a custom role; no 

other data loss will occur. 

3.4.3.2.1.Is it possible to remove the open door 
with green arrow icon that represents Self 
enrolment? Disable Self enrolment altogether? 
 
Yes, as an Administrator, go into 

 Site Administration > Plugins > Authentication > Manage Authentication 

In Common Settings, turn Self Registration to Disable and then if you do 

not want the Guest login button to show, turn it to Hide. Consider also the 

Authentication methods you want to use, you can set them on by clicking 

on any closed eye. This removes the self enrolment option completely. 

 

Администратор может включить использование граватар в Administration 

Site administrationUsersPermissionsUser policies. Если пользователь не загрузил 

картинки пользователя, Moodle проверит, существует ли пользовательский адрес э-почты, 

который связан с граватаром и, если есть, использует граватара в качестве изображения 

пользователя. 

3.4.3.1.10.URL изображения граватара по умолчанию 
Начиная с Moodle 2.3.3, если граватары разрешены, может быть указана 

альтернативная картинка по умолчанию. Опциями являются: 

 Изображение граватара по умолчанию задаётся вводом кода типа mm. Коды других 

изображений граватар по умолчанию см. в https://en.gravatar.com/site/implement/images/. 

 

 Конкретное изображение задаётся вводом URL этого изображения. 

Если это поле оставлено пустым, тогда используется картинка пользователя по 

умолчанию, предусмотренная для темы фона. 

3.4.3.2.Назначения неподдерживаемых ролей 
Назначения неподдерживаемых Ролей являются назначениями Ролей в Контексте, 

который не имеет смысла для этой Роли, такой как Роль создателя Курсов в Контексте 

конкретного Курса или Интерактивного Действия, или Роль Преподавателя в Контексте 

пользователя. 

Вплоть до версии Moodle 2.0 не существовало настройки «Типы контекстов, где 

эта роль может быть назначена» в форме редактирования Роли и, таким образом, любая 

Роль могла быть назначена в любом Контексте. После модернизации Сайта с 1.9 любые 

назначения Ролей, не имеющих смысла в Контекстах, перечисляются как 

назначения неподдерживаемых Ролей в 

SettingsSite administrationUsersPermissionsUnsupported role assignments. 

В общем, совершенно безопасно удалять все назначения неподдерживаемых Ролей. 

Сделав так, худшее что может случиться заключается в том, что какому-то пользователю 

не будет назначена клиентская Роль; никаких потерь других данных не случится. 

3.4.3.2.1.Можно ли убрать открытый доступ по иконке 
зелёная стрелочка, которая представляет собой 
самоЗачисление на Курс? Вообще отключить 
самоЗачисление? 

Да, как Администратор перейдите в 

AdministrationSite administrationPluginsAuthenticationManage  authentication. 

В Common Settings (общие настройки) переключите Self Registration в Disable 

(отключено) и затем, если вы не хотите, чтобы Гость видел кнопку Login, 

переключите её в Hide (скрыть). Рассмотрите также Методы Аутентификации, которые 

вы хотите использовать, вы можете установить их щелчками по любому закрытому глазу. 

Это полностью исключает самоЗачисление. 

https://en.gravatar.com/site/implement/images/
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If you just want to remove/hide the icon and not remove the ability to self 

enrol then you can take one of a couple of different options. 

 

The Self Enrolment icon itself is theme dependent which means it is not 

always an open door with a green arrow. One way would be to replace it in 

whichever theme you are using with a transparent png of the same size. If 

you use something like Firebug, click on the icon to see its properties, 

(right click in Windows) you should be able to see the path to the icon and 

its name - then you replace it with a file of the same name which is 

transparent (ie, invisible, hopefully) or one pixel by one pixel. 

You can isolate the image and disable it using CSS but first you need to 

know the css path for that image. 

 

For the Front Page it is this... 

#page-site-index .enrolmenticons {visibility: hidden;} 

Depending on your theme, you can either add the CSS to your theme's 

Custom Settings page, or add that CSS rule directly into 

yourtheme/style/core.css or whatever name your CSS stylesheet is called. 

If you add the CSS to the stylesheet you need to add it at the very bottom 

of that file. 

Before you do any of this it is best enabling Theme Designer Mode from 

Site Administration > Appearance > themes > Theme settings as this will 

allow the changes to be seen. You will also need to refresh your browser 

window to using Ctrl + F5 which forces the page to reload. Or, you can 

click the Clear Theme Caches button in the Site Administration > 

Appearance > themes > Theme selector page. 

 

Thanks to Mary Cooch and Mary Evans. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Если вы хотите просто удалить/скрыть иконку, а не исключать саму по себе 

эту возможность самоЗачисления, тогда вы можете применить одну из пары различных 

опций. 

Сама иконка самоЗачисления зависит от темы фоновой картинки, это означает, 

что она не всегда открытая дверь с зелёной стрелочкой. Один способ состоит в замене в 

какой бы то не было теме, которую вы используете, прозрачным png того же самого 

размера. Если вы используете нечто похожее на Firebug, щёлкните по этой иконке, чтобы 

увидеть её свойства (прямой щелчок в Windows), вы сможете увидеть путь к этой иконке и 

его название – затем замените его на файл с тем же самым именем, который является 

прозрачным (т.е. невидимым, надо надеяться), или произведите попиксельную замену. 

Вы можете изолировать это изображение и отключить его, используя CSS 

(Cascading Style Sheets – каскадные таблицы стилей), но сначала вам требуется узнать 

CSS-путь для этого изображения… 

Для главной страницы Сайта это 

#page-site-index .enrolmenticons {visibility: hidden;}. 

В зависимости от темы вашей фоновой картинки, вы можете или добавить к вашей 

странице клиентских настроек таблицы стилей CSS темы, или добавить это правило CSS 

прямо в yourtheme/style/core.css, или какое-либо название вашей таблицы стилей CSS. 

Если вы добавляете CSS в таблицу стилей, вам потребуется добавить её на самое дно этого 

файла. 

Прежде чем сделать что-нибудь из этого, лучше включить режим «Theme Designer 

(дизайнер темы фоновой картинки)» из 

Site AdministrationAppearanceThemesTheme settings, поскольку это позволит увидеть 

изменения. Вам также потребуется обновить окно вашего браузера, используя Ctrl+F5, что 

принудит перезагрузить вашу страницу. Либо вы можете щёлкнуть кнопку 

Clear Theme Caches (очистить кэши темы фоновой картинки) на странице 

Site AdministrationAppearanceThemesTheme selector. 

Благодарности Мэри Коч и Мэри Иванс. 
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3.4.4.Using roles 
Below are just a few creative examples of uses of roles and permissions in 

various settings. 

3.4.4.1.Give a student forum moderator rights 
How: Assign the role of non-editing teacher in the module context, via the 

"Locally assigned roles" link in the forum administration section of the 

Settings block. 

 

 Enables a user to edit or delete forum posts, split discussions and move 

discussions to other forums 

 

 See Forum moderator role for more details 

 

 Consider assigning this role to two students, and guiding them in 

learning to facilitate a forum together; for example, they can share the 

"coverage" of the Forum on certain dates. 

 

3.4.4.2.Enable a student to grade assignment 
submissions 
How: Assign the role of non-editing teacher in the module context, via the 

"Locally assigned roles" link in the assignment administration section of 

the Settings block 

 A form of peer assessment/evaluation 

 Similar use: Enable a student to grade essay questions in a quiz 

3.4.4.3.Give a student the rights to approve 
database module entries 

How: Assign the role of non-editing teacher in the mo dule context, via 

the "Locally assigned roles" link in the data base administration section 

of the Settings block 

 Enables a user to approve, edit and delete database module entries 

 Similar use: Give a student the rights to approve glossary entries 

3.4.4.4.Allow a student to clean up saved chat 
sessions 
How: Assign the role of non-editing teacher in the module context, via the 

"Locally assigned roles" link in the chat administration section of the 

Settings block. 

 

3.4.4.Применение Ролей 
Ниже приведено лишь несколько творческих примеров применения Ролей и 

Полномочий в различных настройках. 

3.4.4.1.Дайте Студенту права модератора Форума 
Как: Назначьте Роль не редактирующего Преподавателя в 

Контексте модуля «Форум» через ссылку «Locally assigned roles 

(локально назначаемые роли)» в разделе Forum administration  

(управление форумом) блока «Administration (управление)». 

 Разрешает пользователю редактировать или удалять 

корреспонденции Форума, разделять дискуссии на части и 

перемещать дискуссии в другие Форумы. 

 Более подробная информация представлена в Роли модератора 

форума. 

 Рассмотрите делегирование этой Роли двум Студентам и 

проконсультируйте их, содействуя совместной работе над 

Форумом; например, они могут совместно использовать «зону действия» Форума по 

определённым датам. 

3.4.4.2.Разрешите Студентам оценивать готовые ответы 
на Задание 

Как: Назначьте Роль не Редактирующего Преподавателя в Контексте модуля 

«Задание» через ссылку «Locally assigned roles» в секции Assignment administration 

(управление Заданием) блока Administration. 

 Форма «Peer assessment/evaluation (взаимного оценивания/аттестации)». 

 Похожее применение: Разрешите Студенту оценивать Вопрос-эссе в Экзамене. 

3.4.4.3.Дайте Студентам права улучшать Записи модуля 
«База Данных» 

Как: Назначьте Роль не редактирующего Преподавателя в Контексте модуля 

«База Данных» через ссылку Locally assigned roles в Data base administration разделе блока 

Administration (управление). 

 Разрешает пользователю улучшать, редактировать и удалять Записи Баз Данных. 

 Похожее применение: Дайте Студенту права вносить новые Записи в Глоссарий. 

3.4.4.4.Разрешите Студентам приводить в порядок 
сохранённые сессии Чатов 

Как: Назначьте Роль не Редактирующего Преподавателя в Контексте модуля 

Чат через ссылку Locally assigned roles в разделе Chat administration (управление Чатом) 

блока Administration. 

http://docs.moodle.org/25/en/Forum_moderator_role
http://docs.moodle.org/25/en/Forum_moderator_role
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 Allows a user to delete chat logs for conversations which don't go 

anywhere 

 Allows a user to save chat logs for a longer period of time 

 Allows a user to put together group chat sessions 

3.4.4.5.Create an archive forum 
How: Override the student role in the module context, via the 

"Permissions" link in the forum administration section of the Settings 

block and remove the capabilities to start discussions and reply to posts 

 

 

 In an archived forum, students may no longer start new discussions, nor 

add replies, but may still read all the discussions 

 See Forum permissions for more details 

 Similar uses: Archive database, glossary or wiki 

3.4.4.6.Enable students to rate forum posts 
 
How: Override the student role in the module context, via the 

"Permissions" link in the forum administration section of the Settings 

block, and allow the capability to rate forum posts 

 A formative assessment 

 Peer evaluation 

 See Forum permissions for more details. 

 Similar uses: Enable students to rate database or glossary entries 

 

3.4.4.7.Allow students to unenrol themselves 
from a course 
How: Override the student role in the course context, via the "Permissions" 

link in the Course administration area of the settings block and allow the 

unassign own roles capability 

 Useful for taster courses, revision courses and any other courses which 

are optional 

 See Unenrolment for more details 

3.4.4.8.Hide a block from guests 
How: Override the guest role in the block context, via the "Permissions" 

link in the block administration area of the Settings block and and prevent 

the capability to view blocks 

 

 

 Разрешает пользователю удалять протоколы бесед Чата, которые никуда не 

перемещены. 

 Разрешает пользователю сохранять протоколы Чата на более длительное время. 

 Разрешает пользователю объединять сессии разных Групп Чата. 

3.4.4.5.Создайте архивный Форум 
Как: Отмените Роль Студента в Контексте 

модуля «Форум» через ссылку Permissions 

(Полномочия) в разделе Forum administration блока 

Administration и исключите возможности начинать дискуссии и 

отвечать на корреспонденцию. 

 В заархивированном Форуме Студенты более не могут начинать новые дискуссии и 

добавлять ответы, но всё ещё могут читать обсуждения. 

 Более подробную информацию ищите в «Forum permissions (Полномочия форума)». 

 Похожее применение: архивация Баз Данных, Глоссария или Вики. 

3.4.4.6.Разрешите Студентам оценивать 
корреспонденции Форума 

Как: Переопределите Роль Студента в Контексте модуля «Форум» через ссылку 

«Permissions (Полномочия)» в секции Forum administration блока Administration и 

предоставьте Возможность оценивать корреспонденции Форума. 

 Формирующее оценивание. 

 Взаимное оценивание. 

 Более подробную информацию ищи в Forum permissions (п. 4.3.7.1.12.). 

 Похожее применение: Подключение Студентов к оцениванию элементов Базы Данных 

и Глоссария. 

3.4.4.7.Разрешите Студентам отчислять себя с Курса 
 
Как: Переопределите Роль Студента в Контексте Курса через ссылку 

«Permissions (Полномочия)» в области Course administration блока Administration и 

предоставьте ему Возможность отменять собственные Роли. 

 Полезно для пробных Курсов, повторных Курсов и некоторых других Курсов, 

которые необязательны. 

 Более подробную информацию ищи в Unenrolment (отчисление, п. 4.7.4). 

3.4.4.8.Скрыть Блок от Гостей 
Как: Переопределите Guest role в Контексте этого Блока через ссылку Permissions в 

области Block administration блока Administration и предотвратите возможность 

просматривать Блоки. 

http://docs.moodle.org/25/en/Forum_permissions
http://docs.moodle.org/25/en/Guest_role
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 See Blocks FAQ for more details 

 Similar use: Hide a block from students 

3.4.4.9.Give a student unlimited time to 
complete timed quizzes 
How: Assign the role of quiz user with unlimited time in the course or 

module context (requires Quiz user with unlimited time role to be created 

by an administrator) 

 Useful for particular students who require extra time in exams 

 

 See Quiz user with unlimited time role for more details 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Более подробную информацию ищите в часто задаваемых вопросах по Блокам. 

 Похожее применение: скрыть Блок от Студентов. 

3.4.4.9.Дать Студенту неограниченное время для 
завершения Экзаменов на время 

Как: Назначьте Роль пользователя Экзамена с неограниченным временем в 

Контексте Курса или модуля Экзамен (требует создания Администратором Роли 

пользователя с неограниченным временем выполнения Экзамена). 

 Полезно для отдельных Студентов, которым требуется дополнительное время на 

Экзамене. 

 Более подробно в Роли пользователя с неограниченным временем на Экзамене. 

http://docs.moodle.org/25/en/Quiz_user_with_unlimited_time_role
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3.4.4.10.Enable a student to create questions 
How: Assign the role of question creator in the course context, via the" 

Permissions" link in the course administration area of the settings block 

(requires Question creator role to be created by an administrator) 

 Enables a student to create questions which can later be used in quizzes 

 

 See Question creator role for more details 

Warning: Capabilities with XSS risks associated to them are allowed for 

the role of question creator. Thus, this role should be assigned with care. 

3.4.4.11.Assign a student the role of calendar 
editor 
How: Assign the role of calendar editor in the course context, via the 

"Permissions" link in the calendar administration area of the Settings 

block. (requires Calendar editor role to be created by an administrator) 

 Allows a user to add course events to the calendar 

 Useful for enabling school admin staff to add term dates etc. to the 

school calendar (when role assigned in the system context) 

 See Calendar editor role for more details 

3.4.4.12.Provide temporary read-only access 
to a naughty student 
How: Assign the role in the course or module context (requires "can not 

post data" role, with selected capabilities prohibited, to be created by an 

administrator) 

 Prevents a user from entering text anywhere whilst allowing read-only 

access 

3.4.4.13.Provide temporary access to a Guest 
Speaker in a completely online class 
How: Create a non-editing teaching role blocking access to everything but 

post to forum. 

Steps to prevent guests from seeing confidential student information: 

 

 Assign a guest role without access to grades and assignments. 

 Only grant access to the guest for the minimal amount of time they need 

to be in the class. 

 

 

 

 

3.4.4.10.Разрешить Студенту создавать Вопросы 
Как: Назначьте Роль Создателя Вопросов в Контексте Курса через ссылку 

«Permissions» в области Course administration блока Administration (требует создания 

Администратором Роли Создателя Вопросов). 

 Это подключает Студента к созданию Вопросов, которые могут быть использованы в 

Тестах. 

 Более подробную информацию ищи в Question creator role. 

Предупреждение: Возможности с рисками XSS-уязвимости для Роли создателя 

Вопросов разрешаются. Поэтому эта Роль должна назначаться с осторожностью. 

3.4.4.11.Назначить Студенту Роль Редактора Календаря 
 
Как: Назначьте Роль Редактора Календаря в Контексте Курса через ссылку 

«Permissions» в области Calendar administration блока Administration (требует создания 

Администратором Роли редактора Календаря). 

 Разрешает пользователю добавлять события Курса в Календарь. 

 Полезна для разрешения административному персоналу школы добавлять даты 

семестров и пр. в школьный Календарь (когда Роль назначена в Контексте Системы). 

 Более подробную информацию ищите в Роли редактора Календаря. 

3.4.4.12.Предоставить временный доступ «только для 
чтения» сомнительному Студенту 

Как: Назначьте эту Роль в Контексте Курса или модуля (требует созданной 

Администратором Роли «без права почтовых отправлений», с запрещением выбранных 

Возможностей). 

 Предотвращает пользователя от ввода текста где-либо, предоставляя доступ «только 

для чтения». 

3.4.4.13.Предоставить временный доступ 
приглашённому лектору только в онлайн классе 

Как: Создайте Роль не редактирующего Преподавателя, блокирующего доступ ко 

всему, кроме почты на Форуме. 

Шаги, предотвращающие Гостей от просмотра конфиденциальной информации о 

Студентах: 

 Назначьте Роль Гостя без доступа к Оценкам и Заданиям. 

 Предоставьте этому Гостю только минимальное количество времени, которое им 

потребуется находиться в этом классе. 

http://docs.moodle.org/25/en/Calendar_editor_role
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3.4.4.14.Allow an administrator and teacher to 
see participants, but not a student 
How: In a course, click on "Users" and then the "Permissions" link in the 

course administration area of the Settings block. Scroll down to view 

participants and select the prevent or prohibit button next to "Student". 

 

 Allows teachers to see participants but not students. 

3.4.4.15.Add a grader to a course 
How: Use Enrolled users (if you want to allow students to see the grader) 

or Other users (if not) to add your grader with the role of "Non-editing 

Teacher". 

 The grader will be able to assign and change any grades in the class. 

 If you want to only allow the grader to grade certain quizzes and/or 

assignments, see Enable a student to grade assignment submissions. 

 If you want to only allow the grader to grade certain offline 

assignments, you can set up an assignment with no text entry 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.4.4.14.Разрешить администратору и Преподавателю 
видеть Участников, но не Студентов 

Как: В Курсе щёлкните по «Users», а затем ссылку «Permissions» в области Course 

administration блока Administration. Прокрутите вниз до строчки «View participants 

(увидеть Участников)» и выберите кнопку либо Prevent (предотвратить), либо Prohibit 

(запретить) рядом с «Student». 

 Разрешает Преподавателю видеть Участников, но не Студентов. 

3.4.4.15.Добавить Оценивающего в Курс 
Как: Используйте зачисленных пользователей (если хотите разрешить Студентам 

видеть Оценивающего) или других пользователей (если нет), чтобы добавить вашего 

Оценивающего с Ролью не редактирующего Преподавателя. 

 Оценивающий будет способен назначать и изменять любые Оценки в этом классе. 

 Если вы хотите предоставить ему оценивать только определённые Экзамены и/или 

Задания, см. Разрешить Студенту оценивать готовые ответы на Задания. 

 Если вы хотите разрешить Оценивающему оценивать только определённые офлайн-

Задания, вы можете установить Задание без ввода текста  
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and no file uploading. (See Offline activity assignment and 

Assignment_settings#Submission_types.) 

3.4.5.Standard roles 
3.4.5.1.Site administrator 
Can "do everything" on the site 

Site administrators have permissions to do anything. 

Users may be assigned the role of site administrator by another site 

administrator in Administrator > Site administration > Users > Permissions 

> Site administrators, but the role itself cannot be edited (or deleted!). 

 

 

Note: The primary administrator (created when the site was created) cannot 

be removed from the site administrator role. 

 

 

3.4.5.2.Manager 
A lesser administrator role 

The default Manager role enables users assigned the role to access courses 

and modify them, as well as perform certain administrative level tasks 

related to courses, users, grade settings, etc. 

 

Unlike the administrator role, the Manager role is a 'real role', whose 

capabilities you can edit, but is similar to Administrator (but much safer to 

use) due to its broad default powers. As a normal role, like Course Creator 

or Teacher, while the Manager role has almost very many capabilities by 

default, you can edit that role if you choose. 

 

(The way permission checks work in the Moodle code is that there is a 

function called has_capability. For admins, has_capability will always 

return true, no matter how the roles are set up. Thus there is no way to edit 

what permissions an Administrator has.) 

Adopting a best-practice based on the Principle of Least Privilege suggests 

that Admins should normally use a Manager role, and not use an 

Administrator account, similar to the way you are recommended not to log 

into Linux as root. 

The Manager role therefore allows a site Administrator to give very 

powerful roles to others who are assigned a Manager role, but without 

having to give them a full Administrator role. 

 

и пересылки файлов. (См. Назначение действия в режиме офлайн и Типы готовых 

ответов в Настройки Задания (п. 4.3.1.1)). 

3.4.5.Стандартные Роли 
3.4.5.1.Администратор Сайта 

Может «делать всё» на Сайте. 

Администратор Сайта имеет Полномочия делать всё. 

Пользователи могут быть назначены на Роль Администратора Сайта другим 

Администратором Сайта в 

AdministratorSite administrationUsersPermissionsSite administrators, но сама эта 

Роль не может быть отредактирована 

(или удалена!). 

Замечание: Первичный 

Администратор (созданный, когда был 

создан Сайт) не может быть удалён с 

Роли Администратора Сайта. 

3.4.5.2.Менеджер 
Роль меньшая по возможностям Роли Администратора. 

Роль Менеджера по умолчанию разрешает пользователям, назначенным на эту 

Роль, иметь доступ к Курсам и модифицировать их, а также выполнять определённые 

задачи административного уровня, связанные с Курсами, пользователями, настройками 

Оценок и т.д. 

В отличие от Роли Администратора, Роль Менеджера – это «реальная роль», к 

Возможностям которой относится редактирование, но она похожа на Роль 

Администратора (но более безопасна в использовании) в связи с его широкими 

Полномочиями по умолчанию. Как обычную Роль, подобную Создателю Курсов или 

Преподавателю, несмотря на то, что Роль Менеджера по умолчанию имеет едва ли не 

большинство возможностей, вы можете редактировать эту роль, если потребуется. 

(Способ проверок Полномочий работает в коде Moodle благодаря наличию 

функции, называемой has_capability (иметь возможность). Для Администраторов эта 

функция всегда возвращает True (истина), независимо от того как установлены их Роли. 

Соответственно, нет способа отредактировать никакие Полномочия Администратора.) 

Усвоивший лучшую практику, основанную на Принципе наименьших привилегий, 

в соответствии с которым Администраторы должен использовать Роль Менеджера, а не 

использовать учётную запись Администратора, подобно тому, как рекомендуется не 

регистрироваться в Linux в качестве пользователь с именем Root. 

Роль Менеджера, следовательно, позволяет Администратору Сайта давать очень 

мощные Роли другим, кто назначается на Роль Менеджера, но без возможности дать им 

полную Роль Администратора. 

http://docs.moodle.org/25/en/Offline_activity_assignment
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3.4.5.2.1.Assigning the role of Manager at the Site 
level 

You can give someone the Manager role sitewide (to enable them 

for instance to add new users) by going to Settings>Site 

Administration>Users>Permissions>Assign system roles, selecting the 

Manager role and moving over your chosen user. 

When you do so, users in that role will have access to only some of 

the items in Site administration. They do not have access to areas such as 

Security, Server, Plugins, Appearance, or Advanced Features, which are 

reserved for those in the Site administrators group. They have access to 

most of the tools for User, Course and Grade system settings and tools. 

 

Specifically the sitewide Manager role can see these in Site 

administration: 

Users 

       Accounts 

           Browse list of users 

           Bulk user actions 

           Add a new user 

           Cohorts 

           Upload users 

           Upload user pictures 

       Permissions 

           Define roles 

           Assign system role 

              Check system permissions 

        Capability overview 

Courses 

       Add/edit courses 

       Backups 

           General backup defaults 

           Automated backup setup 

Grades 

       General settings 

       Grade category settings 

       Grade item settings 

       Scales 

       Letters 

       Report settings 

 

3.4.5.2.1.Назначение Роли Менеджера на уровне Сайта 
 
Вы можете предоставить кому-то Роль Менеджера на уровне Сайта (разрешить, 

например, ему добавлять новых пользователей), перейдя в 

AdministratorSite administrationUsersPermissionsAssign system roles 

и выбирав Роль Менеджера, передать её выбранному вами пользователю. 

Когда вы так сделаете, пользователи с этой Ролью будут иметь доступ только к 

некоторым элементам по управлению Сайтом. Они не будут иметь доступ к таким 

областям, как Безопасность, Сервер, Плагины, Внешний вид или Продвинутые средства, 

которые зарезервированы только для тех, кто входит в Группу Администраторов. 

Менеджеры имеют доступ к большей части инструментов для настроек и инструментария 

для работы с Пользователями, Курсом и Системой Оценок. 

Более точно Роль Менеджера на уровне Сайта можно увидеть в Блоке управления 

Сайтом: 

Пользователи 

Учётные записи 

Просмотреть списка пользователей 

Действия со многими пользователями 

Добавить нового пользователя 

Когорты 

Пересылать (учётные записи) пользователей 

Пересылка портретов пользователей 

Полномочия 

Определить Роли 

Назначить Системную Роль 

Проверить Системные Полномочия 

Обзор Возможностей 

Курсы 

Добавить/отредактировать Курсы 

Резервные копирования 

Значения по умолчанию обычного резервного копирования 

Установка автоматического резервного копирования 

Оценки 

Обычные настройки 

Настройки Категории Оценок 

Настройки Элемента Оценивания 

Шкалы 

Буквы 

Настройки отчётов 
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Language 

       Language customisation 

Front page 

       Front page settings 

       Front page roles 

       Front page filters 

       Front page backup 

       Front page restore 

       Front page questions 

Reports 

       Comments 

       Backups 

       Config changes 

       Logs 

       Live logs 

       Performance overview 

       Question instances 

       Security overview 

       Spam cleaner 

Notes: 

 Some of these can further restricted by editing specific capabilities of 

the role, e.g., create users, upload users from a file, manual enrolments, 

managing cohorts, language customisation, et cet. 

 

 Manager has access to Front page same as with other courses (as it is 

technically a course). 

 Manager has access to most system level reports but not the 

Configuration report. 

 Manager has the ability to assign other users as a sitewide Manager 

 Also, a Manager has the ability to edit the role of Manager itself - to 

disable this, you could prohibit the Create and manage roles 

moodle/role:manage capability 

 

 

 

 

 

 

 

 

Язык 

Настройка языка под клиента 

Главная страница 

Настройки Главной страницы 

Роли Главной страницы 

Фильтры Главной страницы 

Резервное копирование Главной страницы 

Восстановление Главной страницы 

Вопросы Главной страницы 

Отчёты 
Комментарии 

Резервные копирования 

Изменения конфигурации 

Журналы регистрации 

Регистрации событий 

Обзор выполнения 

Примеры Вопросов 

Обзор безопасности 

Чистка спама 

Замечания: 

 Некоторые из приведённых выше возможностей в дальнейшем могут быть ограничены 

путём редактирования конкретных Возможностей Роли, например, по созданию 

пользователей, пересылке пользователей из файла, зачислении вручную, управлению 

Когортами, настройке языка под клиента и т.д. 

 Менеджер имеет доступ к Главной странице, также, как другим Курсам (в качестве 

технического специалиста в Курсе). 

 Менеджер имеет доступ к большинству отчётов Системного уровня, но НЕ к отчёту по 

Конфигурации. 

 Менеджер имеет возможность назначать других пользователей Менеджерами на уровне 

Сайта. 

 Кроме того, Менеджер имеет Возможность редактировать саму Роль Менеджера– 

чтобы отменить это, вы должны запретить Возможность moodle/role:manage по 

созданию и управлению Ролями. 



 

74 

3.4.5.2.2.Assigning the role of Manager at the 
Category level 
The Manager role can also be assigned in the context Category rather than 

sitewide. 

Do this if you want someone to be able to have access to all the courses in 

a single category and manage them, but do not want them to have access to 

any of Site administration tools. 

Assign this as follows: Site administration > Courses > Add/edit courses > 

(select a category) > Edit this category > Settings block: Assign roles > 

Manager > (select user) Add 

 

 
Notes: 

 A category-level manager is so only for the assigned category: to 

manage more than one category, you will need to assign them that role 

in each category separately 

 Category-level managers also manage any sub-categories beneath the 

category they are assigned, including create new subcategories and 

move courses 

 They can create courses in the their assigned categories 

 A category-level manager will not have as many capabilities as a site-

level manager, since certain capabilities can only be applied in the 

system context i.e. via a system role 

 Regarding the capability to login as another user, for courses within the 

category that they manage, a category-level manager can only login as 

another course participant and browse within that course only 

 

Note that in the new Moodle 2 interface, some commands are in the 

Settings blocks now. Managers must Turn editing on in order to have Edit 

category and Add category links/buttons both in Settings and on the main 

content area. The screenshot below is a view of the Settings block for a 

Category level Manager with Editing turned on, showing the Edit this 

category and Add a sub-category commands: 

 

 

 

 

 

 

3.4.5.2.2.Назначение Роли Менеджера на уровне Категорий 
 
Роль Менеджера также может быть назначена в Контексте Категории, что 

предпочтительнее, чем на уровне Сайта. 

Сделайте это, если хотите, чтобы кто-то имел возможность доступа ко всем 

Курсам в единственной Категории и управлял ими, но не хотите при этом, чтобы он имел 

доступ к любому из инструментов управления Сайтом. 

Назначьте эту Роль следующим образом: Site administration Courses 

Add/edit courses (выберите Категорию). Слева в блоке Administration появится раздел 

Category: имя Категории. Отредактируйте, если нужно, эту Категорию, перейдя в Блок 

AdministrationEdit this categorySettings block, затем назначьте Роль, перейдя в Блок 

Administration Assign rolesManager (выберите пользователя и нажмите) Add. 

Замечания: 

 Менеджер уровня Категории является таковым только для этой назначенной 

Категории: Чтобы управлять более, чем одной Категорией, вам потребуется 

назначить ему эту Роль в каждой Категории отдельно. 

 Менеджеры уровня Категории также управляют любыми подКатегориями уровнем 

ниже той Категории, в которую они назначены, включая создание новых подКатегорий 

и перемещение Курсов. 

 Они могут создавать Курсы в Категориях, куда назначены. 

 Менеджер уровня Категории не имеет так много Возможностей, как Менеджер уровня 

Сайта, поскольку определённые Возможности могут быть применены только в 

Контексте Системы, т.е. посредством Системной Роли. 

 Относительно Возможности зарегистрировать другого пользователя для Курсов, 

входящих в Категорию, которой он управляет, Менеджер уровня Категории может 

зарегистрировать только Участника другого Курса и осуществить просмотр только 

внутри этого Курса. 

Заметьте, что в новом интерфейсе Moodle 2 некоторые 

команды находятся сейчас в Блоках Настроек. Менеджеры должны 

включить режим редактирования (Turn editing on) для того, чтобы 

появились ссылки/кнопки Edit category (отредактировать 

Категорию) и Add category (добавить Категорию) как в 

Блоке Управления, так и в основной области содержимого Курса. 

Снимок с экрана справа есть вид Блока Управления Administration 

для Менеджера уровня Категории с включённым режимом 

редактирования, показывающий команды подКатегории Edit 

category и Add category. 
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3.4.5.3.Course creator 
Can create courses 

A user assigned the role of course creator can (as the name suggests!) 

create a course. If the setting "Creators' role in new courses" is left as 

default (teacher), then the course creator is enrolled as a teacher in the 

course they have just created and can then edit the course settings and 

enrol other users. 

A course creator can also view hidden courses. 

The role of course creator could typically be assigned to a master teacher, 

department head or program coordinator. 

3.4.5.3.1.Creating a course 
The "Add a new course" button can be found at the bottom of the page 

listing all courses. 

When a course creator creates a course, they are automatically enrolled in 

the course as a teacher, or whatever role is set in Administration > Site 

administration > Users > Permissions > User policies. 

Note (1): If a user is assigned the role of course creator in the course 

category context, the "Add a new course" button only appears when the 

course category contains at least one course. 

Note (2): Course creators are not automatically assigned the role of teacher 

in a course they have not created, even if it is in a category where they 

have course creator rights. 

3.4.5.3.2.Deleting a course 
There is no user interface for course creators to delete courses they have 

created, however they can do so by editing the URL of the course from 

http://yourmoodlesite.net/course/view.php?id=N to 

http://yourmoodlesite.net/course/delete.php?id=N (replacing 'view' with 

'delete'). 

3.4.5.3.3.Role assignment 
A user may be assigned the role of course creator as a system role (in 

Administration > Site administration > Users > Permissions > Assign 

system roles) or in the course category context. 

 

 

 

 

 

 

 

3.4.5.3.Создатель Курса 
Может создавать Курсы. 

Пользователь, назначенный на Роль Создателя Курса, может (как подсказывает её 

название) создать Курс. Если настройку «Creators' role in new courses (роль создателя в 

новых курсах)» оставить по умолчанию (Преподаватель), тогда Создатель Курса 

зачисляется как Преподаватель в Курсе, который он создал, и может затем редактировать 

настройки Курса и зачислять других пользователей. 

Создатель Курса может также видеть скрытые Курсы. 

Обычно Роль Создателя Курса назначается главному Преподавателю, 

заведующему кафедрой или координатору программ. 

3.4.5.3.1.Создание Курса 
Кнопку «Add a new course (добавить новый курс)» можно найти внизу страницы, 

перечисляющей все Курсы. 

Когда Создатель Курса создаёт Курс, он автоматически зачисляется на этот Курса 

как Преподаватель, или любую Роль, которая установлена AdministrationSite 

administrationUsersPermissionsUser policies. 

Замечание (1): Если пользователь назначается на Роль Создателя Курса в 

Контексте Категории Курсов, кнопка «Add a new course» появляется, только если 

Категория Курсов содержит, по крайней мере, один Курс. 

Замечание (2): Создатели Курсов автоматически не зачисляются на Роль 

Преподавателя в Курс, который они не создали, даже если Курс находится в Категории, 

где они имеют права создателя Курса. 

3.4.5.3.2.Удаление Курса 
Для создателей Курсов не существует интерфейса для удаления Курсов, который 

они создали, однако они могут сделать это, редактированием URL Курса от 

http://yourmoodlesite.net/course/view.php?id=N до 

http://yourmoodlesite.net/course/delete.php?id=N (заменяя «view» на «delete»). 

 

3.4.5.3.3.Назначение Роли 
Пользователь может быть назначен на Роль Создателя Курса как Системную Роль 

(в AdministrationSite administrationUsersPermissions Assign system roles) или  в 

Контексте Категории Курса. 

http://yourmoodlesite.net/course/view.php?id=N
http://yourmoodlesite.net/course/delete.php?id=N
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3.4.5.3.4.Role permissions 
If you require a course creator to have additional permissions, it is 

recommended that the Manager role is used, rather than changing the 

course creator role permissions. Otherwise, allowing additional capabilities 

for the course creator role may result in course creators having access to 

courses which they have not created. 

The role of course creator is ONLY intended for enabling users to create 

courses; it is not intended for enabling users to edit existing courses! 

 

3.4.5.4.Teacher 
Can manage and add content to courses 

Teachers can do anything within a course, including changing the activities 

and grading students. 

3.4.5.4.1.See also 
Why "teacher" discussion 

3.4.5.5.Non-editing teacher 
Can grade in courses but not edit them 

 A non-editing teacher is able within a course to view and grade 

students' work but may not alter or delete any of the activities or 

resources. 

 This role might typically be given to a classroom assistant for example. 

3.4.5.6.Student 
Can access and participate in courses 

 A user with the Student role in Moodle can participate in course 

activities and view resources but not alter them or see the class 

gradebook. They can see their own grades if the teacher has allowed 

this. 

When a student first joins Moodle they see all available courses. Once 

they have enrolled or been enrolled into at least one course they then 

only see their own courses in the My Courses section of the navigation 

block or via the My home link. 

 A student's view and navigation in Moodle will be different from the 

course teacher's or from students assigned to a different group. 

 

 

 

 

 

3.4.5.3.4.Полномочия Роли 
Если вам нужно, чтобы создатель Курса имел дополнительные Полномочия, 

рекомендуется использовать Роль Менеджера, а не изменять Полномочия Роли создателя 

Курса. В противном случае, выдача дополнительных Полномочий Роли создателя Курса 

может привести к тому, что создатели Курсов получат доступ к Курсам, которые они не 

создавали. 

Роль создателя Курса предназначена ТОЛЬКО для зачисления пользователей, 

которые создают Курсы, и не предназначена для зачисления пользователей, которые 

редактируют существующие Курсы! 

3.4.5.4.Преподаватель 
Может управлять Курсами и добавлять в них контент. 

Преподаватели могут делать внутри Курса всё, включая изменения Действий и 

оценивание Студентов. 

3.4.5.4.1.См. также 
Обсуждение «Почему «Преподаватель»». 

3.4.5.5.НеРедактирующий Преподаватель 
Может оценивать, но не редактировать в Курсе. 

 НеРедактирующий Преподаватель может внутри Курса просматривать и оценивать 

работы Студентов, но не может изменять или удалять Интерактивные Действия или 

Ресурсы. 

 Обычно эта Роль может быть дана, например, помощнику в аудитории. 

3.4.5.6.Студент 
Может иметь доступ к Курсу и участвовать в нём. 

 Пользователь с Ролью Студента в Moodle может участвовать в 

Интерактивных Действиях на Курсе и просматривать Ресурсы, но не изменять или 

просматривать Журнал Оценок класса. Он может видеть свои собственные Оценки, 

если Преподаватель разрешит это. 

Когда Студент впервые присоединяется к Moodle, он может видеть все доступные 

Курсы. Как только он самоЗачислен или зачислен хотя бы на один Курс, он потом 

может видеть только собственные Курсы в разделе My Courses (мои курсы) Блока 

навигации или посредством ссылки My home (мой дом). 

 Взгляд на Курс и навигация Студентов в Moodle, будут отличаться от 

Преподавательских в этом же Курсе или от Студентов, назначенных в другую Группу. 

http://moodle.org/mod/forum/discuss.php?d=43024
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 Administrators and Teachers determine how a student enrolls, and what 

they can do or see in a Moodle site. These permissions can vary with 

each course or with any of Moodle's many kinds of activities. For 

example, in some contexts, students may correct or grade other 

students' work, be encouraged to explore everything in a course and 

interact with other participants. In a different context, the student maybe 

guided upon a very defined path, with minimal interaction with others. 

3.4.5.7.Guest 
An view courses but not participate 

3.4.5.7.1.The guest account 
Moodle has a built-in "Guest account". Visitors can log in as guests using 

the "Login as a guest" button on the login screen and enter any courses 

which allow guest access. In addition, logged-in users can enter any 

courses which allow guest access without being required to enrol. 

 

 

Guests ALWAYS have "read-only" access - meaning they can't leave any 

posts or otherwise mess up the course for real students. 

 

They cannot: 

 Post in forums 

 Edit wiki pages 

 Participate in a chat 

 Take quizzes 

 Submit assignments 

 Add glossary or database activity entries or comments 

 Receive any scores or grades (because of the read-only access) 

This feature can be handy when you want to let a colleague in to look 

around at your work, or to let students see a course before they have 

decided to enrol. 

If you want guests to be able to take quizzes, or any of the other activities 

listed above, and have considered the security implications, you can create 

a visitor account, say with username = password = visitor, for everyone to 

share. 

3.4.5.7.2.Enabling guest access 
To allow guests into courses on your Moodle, see Guest access. 

 

 

 

 Администраторы и Преподаватели определяют, как Студент зачисляется и что он 

может делать или видеть на Сайте Moodle. Эти Полномочия могут изменяться с 

каждым Курсом или с любыми видами Интерактивных Действий Moodle. Например, в 

некоторых Контекстах Студенты могут корректировать или оценивать других 

Студентов, могут поощряться за исследования всего в Курсе и взаимодействовать с 

другими Участниками. В другом Контексте Студент может быть направлен по очень 

определённому пути с минимальным взаимодействием с другими. 

3.4.5.7.Гость 
Просматривает Курсы, но не участвует в них. 

3.4.5.7.1.Учётная запись Гостя 
Moodle имеет встроенную «Guest account (учётная запись Гостя)». Посетители 

могут зарегистрироваться как Гости, используя кнопку «Login as a guest 

(зарегистрироваться как Гость)» на экране регистрации, и войти в любой из Курсов, в 

которых разрешён доступ Гостю. Дополнительно зарегистрированные пользователи могут 

войти на любые Курсы, которые разрешают доступ Гостю, без требования зачислиться на 

них. 

Гости ВСЕГДА имеют доступ «только для чтения» – означающий, что они не 

могут оставлять никаких почтовых сообщений или иным способ испортить Курс 

Студентам. 

Они не могут 

 Отправлять сообщения на Форумы. 

 Редактировать страницы Вики. 

 Участвовать в Чатах. 

 Принимать Экзамены. 

 Передавать готовые ответы по Заданиям на рассмотрение Преподавателям. 

 Пополнять Глоссарий или Базу Данных записями или комментариями. 

 Получать любые баллы или Оценки (из-за доступа только для чтения) 

Это средство может быть удобно, когда вы хотите позволить коллеге просмотреть 

вашу работу, или позволить Студентам увидеть Курс перед тем, как они решат 

зачислиться на него. 

Если вы хотите, чтобы Гости были способны принимать Экзамены или любые 

другие действия, перечисленные выше, и рассмотрели вопросы безопасности, вы можете 

создать учётную запись посетителя, скажем, с username = password = visitor для 

совместного использования каждым. 

3.4.5.7.2.Предоставление доступа Гостю 
Разрешает Гостям входить на Курсы в вашей Moodle (см. п. 3.3.6). 
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3.4.5.7.3.Skip login page for guest account 
 
All users will be automatically logged in as guests if you enable Auto-login 

guests in Administration > Site administration > Users > Permissions > 

User policies. The standard login page is displayed after users visit page 

that requires real user login. 

3.4.5.7.4.See also 
Using Moodle forum discussions: 

 Allowing guests to post in forum? 

3.4.5.8.Authenticated user 
The role all logged in users have 

When a user logs in, they are automatically assigned the role of 

authenticated user. A user will have additional roles as well as the 

authenticated user role according to where they are in Moodle, such as 

student in a course. 

By default, authenticated users have permission to edit their own profile, 

send messages, blog and do other things outside of courses. 

 

3.4.5.9.Authenticated user on the front page 
role 
A logged in user role for the front page only 

3.4.6.Creating custom roles 
3.4.6.1.Creating a new role 
To create a custom role: 

 Go to Administration > Site administration > Users > Permissions > 

Define roles. 

 Click the "Add a new role" button. 

 Give the role a Short name e.g. 'Parent'.The short name is necessary for 

other plugins in Moodle that may need to refer to the role (e.g. when 

uploading users from a file or setting enrolments via an enrolment 

plugin). 

 You must provide a full name for all custom roles. If you need to name 

the role for multiple languages you can use multi-lang syntax if you 

wish. 

 Give the role a description (optional). 

 Select an appropriate role archetype (see below for further information). 

 

3.4.5.7.3.Пропустить страницу регистрации для учётной 
записи Гостя 

Все пользователи будут автоматически регистрироваться как Гости, если вы 

разрешите авто-регистрацию Гостей в AdministrationSite administrationUsers 

PermissionsUser policies. Стандартная страница регистрации отображается после того, 

как пользователи посетят страницу, которая требует реальной регистрации пользователя. 

3.4.5.7.4.См. также 
Обсуждения форума по использованию Moodle: 

 Разрешение Гостям сообщения на Форум?. 

3.4.5.8.Аутентифицированный Пользователь 
Каждая из Ролей всех зарегистрированных пользователей имеет этот статус. 

Когда пользователь входит в Систему, ему автоматически назначается Роль 

Аутентифицированного Пользователя. Пользователь будет иметь дополнительные Роли, 

также как и Роль зарегистрированного пользователя, в соответствии с тем, где он 

находится в Moodle, такую как Студент в Курсе. 

По умолчанию Аутентифицированные Пользователи имеют Полномочие 

редактировать их собственный Профиль, посылать сообщения, Блог и делать другие вещи 

вне Курсов. 

3.4.5.9.Роль Аутентифицированного Пользователя на 
Главной странице 

Роль зарегистрированного пользователя только для главной страницы. 

3.4.6.Создание клиентских Ролей 
3.4.6.1.Создание новой Роли 

Чтобы создать клиентскую Роль: 

 Перейдите к AdministrationSite administrationUsersPermissionsDefine roles. 

 

 Щёлкните кнопку «Add a new role (добавить новую роль)». 

 Задайте Роли краткое название, например, «Родитель». Краткое название нужно для 

других Плагинов в Moodle, которым может потребоваться сослаться на эту Роль 

(например, когда пересылают пользователей из файла или устанавливают зачисление 

на Курс посредством Плагина Зачисления). 

 Вы должны определить полное имя для каждой из клиентских Ролей. Если вам нужно 

поименовать Роль на многих языках, обращайтесь к мульти-язычному синтаксису 

(п.5.5.1.9). 

 Дайте описание Роли (при необходимости). 

 Выберите подходящий архетип Роли (подробнее см. ниже). 

http://moodle.org/mod/forum/discuss.php?d=69674
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 Select the contexts where the role may be assigned e.g. 'User' for Parent 

role. 

 Set permissions as required. 

 Scroll to the top or bottom of the page and click the "Create this role" 

button. 

Screenshot «Adding a new role and setting context types». 

Screenshot «Choose "Allow" where required». 

Screenshot «Extra options with "Show advanced" enabled». 

3.4.6.2.Role archetypes 
A role archetype 

 Is a hard-coded template for a role 

 Is used during upgrades when adding defaults for new capabilities - no 

archetype = no new capabilities during upgrade 

 Is used during when resetting a role to determine the defaults - no 

archetype = reset removes all capabilities 

There is no need to set a role archetype for custom roles used for overrides 

or if the site admin wants to specify new capabilities manually after 

upgrading. 

3.4.6.3.Creating a duplicate role 
To create a duplicate role: 

 Go to Administration > Site administration > Users > Permissions > 

Define roles. 

 In the "edit" column on the right, click the x2 icon. 

 Give a name and set permissions for your new role; scroll down and 

click "create this role". 

 The list of roles will now show the "... copy 1" at the bottom, for 

example "Guest copy 1". 

3.4.6.4.New role considerations 
A newly-created role does not have the ability to assign or override any 

other roles. This is true even when the new role is a copy of a role that had 

such abilities. If such ability is needed, the administrator must grant it 

explicitly via the 'Allow role assignments' and 'Allow role overrides' tabs. 

 

A new role is not automatically listed in course descriptions even if was 

created by copying a role that is listed, such as Teacher. If you want the 

new role to appear in the course listing, you must set it explicitly via 

Administration > Site administration > Appearance > Course managers. 

 

 

 Выберите Контексты, где Роль может быть назначена, например, «User» для Роли 

Родителя. 

 Установите нужные Полномочия. 

 Прокрутите страницу вверх или вниз и щёлкните кнопку «Create this role (создать эту 

роль)». 

Снимок с экрана «Добавление новой Роли и настройка типов Контекста». 

Снимок с экрана «Выберите «Allow (разрешить)», где требуется». 

Снимок с экрана «Дополнительные опции с разрешённой «Show advanced»». 

3.4.6.2.Архетипы Ролей 
Архетип Роли. 

 Является жёстко запрограммированным шаблоном для Роли. 

 Используется во время модернизации при добавлении значений по умолчанию для 

новых Возможностей – нет архетипа = нет новых Возможностей при модернизации. 

 Используется при возврате Роли к значениям по умолчанию – нет архетипа = возврат 

сотрёт все возможности. 

Нет необходимости устанавливать архетип Роли для клиентских Ролей, 

используемых для переопределения, или если Администратор Сайта захочет указать 

новые Возможности вручную после модернизации. 

3.4.6.3.Создание дубликата Роли 
Чтобы создать дубликат Роли: 

 Перейдите к AdministrationSite administrationUsersPermissionsDefine roles. 

 

 В колонке «Edit» справа щёлкните иконку x2. 

 Дайте имя и установите Полномочия для вашей новой Роли; прокрутите страницу вниз 

и щёлкните «Create this role (создать эту роль)». 

 Список Ролей будет сейчас показан внизу страницы «... copy 1», например, «Guest copy 

1». 

3.4.6.4.Рассмотрения новой Роли 
Вновь созданная Роль не имеет возможности назначать или переопределять любые 

другие Роли. Это справедливо даже тогда, когда новая Роль является копией Роли, 

имеющей такие Полномочия. Если такая возможность всё же нужна, Администратор 

должен установить её явно, посредством ярлычков «Allow role assignments (разрешить 

назначения Роли)» и «Allow role overrides (разрешить переопределения роли)». 

Новая Роль автоматически в описаниях Курса не перечисляется, даже если она 

создана копированием Роли, которая перечисляется, например, такая как Преподаватель. 

Если вы хотите, чтобы новая Роль появлялась в листингах Курса, вы должны установить 

это явно, через AdministrationSite administrationAppearanceCourse managers. 

http://docs.moodle.org/25/en/File:addingnewrole25.png
http://docs.moodle.org/25/en/File:permissions125.png
http://docs.moodle.org/25/en/File:permissions225.png
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3.4.6.5.Testing a new role 
Administration > Switch role to Use the "Switch role to" link to see what 

another role will see in that context. 

Since switching roles confines you to those roles you can assign in a 

course context, this method is only useful for testing course-scoped 

capabilities (i.e. it will not be useful for testing permissions that apply 

outside the course context, like moodle/user:edit). 

Tip: You can always create test user and assign the new role to them. Then 

logout as admin and login as the test user. This is really the best way to test 

a new role. 

3.4.6.6.Example custom roles 
 Parent - for providing parents/mentors/tutors with permission to view 

certain information about their children/mentees/tutees 

 Demo teacher - for providing a demonstration teacher account with a 

password which can't be changed 

 Forum moderator - for providing a user with permission in a particular 

forum to edit or delete forum posts, split discussions and move 

discussions to other forums 

 Calendar editor - for enabling a user to add site or course events to the 

calendar 

 Blogger - for limiting blogging to specific users only 

 

 Quiz user with unlimited time - for allowing a user unlimited time to 

attempt a quiz which has a time limit set 

  

 Question creator - for enabling students to create questions for use in 

quizzes 

 Course requester role - for restricting users who can make course 

requests 

 Cohort enroller - for allowing teachers to enrol category cohorts into 

their course 

 Template creator - for allowing teachers to save as "Public" a Feedback 

template. 

3.4.6.7.See also 
Using Moodle forum discussions: 

 What happens if a user has multiple roles in a course? 

 logged in: what role am I? 

 

 

3.4.6.5.Тестирование новой Роли 
AdministrationSwitch role to…. Используйте ссылку «Switch role to… 

(переключить Роль на)», чтобы увидеть то, что другая Роль увидит в этом Контексте. 

Так как переключение ролей ограничивает вас теми Ролями, которые вы можете назначить 

в Контексте Курса, этот метод полезен только для тестирования Возможностей, 

ограниченных Курсом (т.е. это не будет полезно для тестирования Полномочий, которые 

приложимы вне Контекста Курса, подобно moodle/user:edit). 

Совет: Вы всегда можете создать пользователя Тест и назначить ему новую Роль. 

Затем разрегистрируйтесь как Администратор и войдите в Систему как пользователь с 

именем «Тест». Это действительно лучший способ опробовать новую Роль. 

3.4.6.6.Возможные клиентские Роли 
 Parent (Родитель) – для обеспечения Родителей/надзирающих/наставников с 

Полномочиями просматривать определённую информацию о их 

детях/поднадзорных/опекаемых. 

 Demo teacher (Преподаватель демонстрации) – для обеспечения учётной записи 

Преподавателя демонстрации паролем, который не может быть изменён. 

 Forum moderator (модератор форума) – для обеспечения пользователя в конкретном 

Форуме Полномочиями редактировать или удалять корреспонденцию Форума, 

разделять дискуссии и перемещать дискуссии в другие Форумы. 

 Calendar editor (редактор календаря) – для разрешения пользователю добавлять события 

Сайта или Курса в Календарь. 

 Blogger (блогер) – для ограничения ведения блогов только отдельными пользователями. 

 Quiz user with unlimited time (пользователь Экзамена с неограниченным временем) – 

для предоставления пользователю неограниченного времени в попытках выполнить 

Экзамен, для которого установлены ограничения по времени. 

 Question creator (создатель вопросов) – для разрешения Студентам создавать Вопросы 

для использования в Экзаменах. 

 Course requester role (роль запрашивающего курсы) – для ограничения пользователей, 

которые могут сделать запросы на создание нового Курса. 

 Cohort enroller (зачисляющий в Когорты) – для предоставления Преподавателям 

способности зачислять Когорты Категорий в их Курс. 

 Template creator (создатель шаблонов) – для предоставления Преподавателям 

способности сохранять как «Public» шаблон Обратной Связи. 

3.4.6.7.См. также 
Обсуждения форума по использованию Moodle: 

 Что случается, если пользователь имеет много Ролей в Курсе? 

 Зарегистрировался: Какую Роль я имею? 

http://moodle.org/mod/forum/discuss.php?d=66782
https://moodle.org/mod/forum/discuss.php?d=90140
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3.4.7.Parent role 
The role of Parent may be used to provide parents/mentors/tutors with 

permission to view certain information, such as activity reports, grades, 

blog entries and forum posts, about their children/mentees/tutees. 

 

3.4.7.1.Creating a new role 
 As an administrator, go to Settings > Site administration > Users > 

Permissions > Define roles and click the "Add a new role" button. 

  

 Give the role a name (such as "Parent", but it can be anything 

appropriate, such as tutor/mentor) and assign it to the user context. 

Under the heading of Course 

 Change moodle/user:viewdetails to allow - to access the student's 

profile. 

Under the heading of Users 

 Change moodle/user:viewalldetails to allow - to view all aspects of the 

student's profile. 

 Change any/all of the following capabilities to allow 

 moodle/user:readuserblogs - to read the student's blog entries 

 moodle/user:readuserposts - to read the student's forum posts 

 moodle/user:viewuseractivitiesreport - to view the student's activity 

reports and grades 

 moodle/user:editprofile - to edit the student's profile 

 Click the "Create this role" button. 

Screenshot «Setting up the parent role». 

Screenshot «Assigning capabilities to the parent role». 

Screenshot «Saving changes to the parent role». 

Some permissions may already be set to "Allow", or the permissions 

granted here may not be the ones required for that Role. This set of 

Permissions mean that this Role allows anyone assigned to a Parent Role, 

then linked to the Student Role, to edit the profile or read the blogs of that 

Student - not everyone's profile or blogs. 

3.4.7.2.Assigning the parent to the student 
 Access the child's profile page, via Site administration ► Users ► 

Accounts ► Browse list of users 

 

 Go to 'Profile settings for [username]' > 'Roles' >'Assign roles relative 

to this user' 

 

3.4.7.Роль Родителя 
Роль Родителя может быть использована для обеспечения 

Родителей/надзирающих/наставников Полномочиями просматривать определённую 

информацию, такую как отчёты по Интерактивным Действиям, Оценки, Записи Блогов 

сообщения Форумов о их детях/поднадзорных/опекаемых. 

3.4.7.1.Создание новой Роли 
 Как Администратор перейдите в  

AdministrationSite administrationUsersPermissionsDefine roles и щёлкните кнопку 

«Add a new role (добавить новую роль)». 

 Дайте Роли наименование (такое как «Родитель», но им может быть все подходящее, 

такое как наставник/надзирающий) и назначьте её Контексту пользователя. 

Под заголовком Курса (см. список внизу страницы) 

 Измените Возможность moodle/user:viewdetails, чтобы разрешить доступ к Профилю 

Студента. 

Под заголовком пользователей 

 Измените moodle/user:viewdetails, чтобы разрешить видеть все аспекты Профиля 

Студента. 

 Измените любые/все следующие Возможности, чтобы позволить. 

 moodle/user:readuser – чтобы читать Записи Блога Студента. 

 moodle/user:readuserposts – чтобы читать сообщения Студента на Форуме. 

 moodle/user:viewuseractivitiesreport – чтобы видеть отчёты Студента по 

Интерактивному Действию и Оценки. 

 moodle/user:editprofile – чтобы редактировать Форум Студента. 

 Щёлкните кнопку «Create this role (создать эту роль)». 

Снимок с экрана «Настройка Роли Родителя». 

Снимок с экрана «Назначение Возможностей Роли Родителя». 

Снимок с экрана «Сохранение изменений Роли Родителя». 

Некоторые Полномочия могут уже быть установлены в «Allow (разрешить)» или 

Полномочия, предоставленные здесь, могут не быть таковыми для этой Роли. Этот набор 

Полномочий означает, что эта Роль разрешает всякому, назначенному на Роль Родителя, 

затем связаться с Ролью Студента, чтобы отредактировать Профиль или прочитать Блог 

этого Студента – не Профиль или Блоги каждого. 

3.4.7.2.Назначение Родителя Студенту 
 Доступ к странице Профиля ребёнка через 

AdministrationSite administrationUsersAccountsBrowse list of users. Щёлкните по 

имени нужного Студента. 

 Перейдите к «AdministrationProfile settings for [имя этого Студента]»Roles Assign 

roles relative to this use. 

http://docs.moodle.org/23/en/Capabilities/moodle/user:viewdetails
http://docs.moodle.org/23/en/File:CustomRole05.png
http://docs.moodle.org/23/en/File:CustomRole06.png
http://docs.moodle.org/23/en/File:CustomRole07.png
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 Choose the role to assign i.e. Parent 

 Select the parent in the potential users list and use the Add button to add 

it to the existing users list. 

Screenshot «Selecting the student». 

Screenshot «Assign roles relative to this use ». 

Screenshot «Assigning the parent to the student». 

At this point you can return to the "Assign roles in user:" page and you 

should see that the parent name is now in the "Users with Role" column. 

 

NOTE:The same parent may be assigned to several students, siblings or 

otherwise. 

3.4.7.2.1.Adding multiple parents/mentors at once 
If you are interested in assigning several parent roles en masse there is a 

contributed plugin (use at your own risk) here CONTRIB-3938 which 

allows you to configure automatic role assignment between users from a 

database (ex: mentor/mentee or parent/child). Here is a related blog post on 

Bulk connecting parents to students 

 

3.4.7.2.2.Adding the Mentees Block 
This block needs to be added so parents can see links to their child's 

profile. 

 On the Front Page, turn editing on. 
 

 

 Go to the Add Blocks block and select the Mentees block and when it 

appears, click on the Configuration icon. 

 Edit the configuration settings to suit the needs of the site. When 

complete, save the changes and return to the Front Page. 

Screenshot «Accessing the Add Blocks». 

Screenshot «Configuring the Mentees block». 

Screenshot «Setting the configuration values». 

3.4.7.2.3.How a parent sees their child's activities 
 
 Once the mentees block has been added, a parent/mentor sees the link 

to any children/mentees they are responsible for. 

 They click on a name and will be taken to the profile page of that user. 

 They then click - next to "Course profiles" - the name of a course the 

user is enrolled in. 

 

 Выберите Роль для назначения, т.е. «Родитель». 

 Выберите Родителя в списке потенциальных пользователей и используйте кнопку 

«Add», чтобы добавить его в список существующих пользователей.  

Снимок с экрана «Выбор Студента». 

Снимок с экрана «Назначить Роли относительно этого пользователя». 

Снимок с экрана «Назначение Родителя Студенту». 

В этой точке вы можете вернуться к странице «Assign roles in user:» и должны 

увидеть, имя Родителя находится сейчас в колонке «Users with Role (пользователи с 

ролью)». 

Замечание: Один и тот же Родитель может быть назначен нескольким Студентам, 

нескольким элементам одного уровня или иным образом. 

3.4.7.2.1.Добавление многих Родителей/надзирающих сразу 
Если вы заинтересованы в назначении нескольких Ролей Родителей совместно 

существует предлагаемый независимыми разработчиками плагин (используйте на ваш 

собственный риск) здесь CONTRIB-3938, который позволяет вам конфигурировать 

назначение Роли автоматически между пользователями из базы данных (например: 

надзирающий/поднадзорный или Родитель/ребёнок). Здесь связанные сообщения Блога 

«Связывание сразу многих Родителей и Студентов». 

3.4.7.2.2.Добавление Блока поднадзорных 
Этот Блок нужно добавить, чтобы Родители смогли увидеть ссылки на Профиль их 

ребёнка. 

 В Роли Администратора на Главной странице включите режим редактирования (2 шага): 

AdministrationSite administrationFront pageFront page settings, а затем к 

AdministrationFront page settingsTurn editing on. 

 Перейдите к Блоку Add Blocks (добавить блоки) и выберите Блок поднадзорных, а 

когда он появится, щёлкните иконку конфигурирования (шестерёнка). 

 Отредактируйте настройки конфигурации, чтобы устраивали требования Сайта. После 

завершения сохраните изменения и вернитесь на Главную страницу. 

Снимок с экрана «Доступ к Добавить Блоки». 

Снимок с экрана «Конфигурирование Блока Поднадзорных». 

Снимок с экрана «Настройка значений конфигурации». 

3.4.7.2.3.Как Родитель видит Интерактивные Действия его 
ребёнка 
 Как только Блок Поднадзорных добавлен, Родитель/надзирающий видит ссылку на 

любого ребёнка/поднадзорного, за которого они в ответственности. 

 Они щёлкают на имени и получают страницу Профиля этого пользователя. 

 Затем они щёлкают – следующий «Course profiles (профили курсов» – название Курса, 

на который зачислен этот пользователь. 

http://docs.moodle.org/23/en/File:CustomRole08.png
http://docs.moodle.org/23/en/File:CustomRole09.png
http://docs.moodle.org/23/en/File:CustomRole10.png
http://tracker.moodle.org/browse/CONTRIB-3938
http://www.moodleblog.net/2012/11/05/bulk-add-parents-to-children-in-moodle-parent-role/
http://docs.moodle.org/23/en/File:CustomRole12.png
http://docs.moodle.org/23/en/File:CustomRole13.png
http://docs.moodle.org/23/en/File:CustomRole14.png
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 Grades may then be viewed by clicking in the user's profile "Activity 

reports>Grades" 

 Forum posts may also be viewed from the user's profile. 

Screenshot «Click the name of a course in the profile». 

Screenshot «Only then choose an item in the Navigation block». 

Screenshot «The course grades are now visible». 

 To view activity in another course, the parent needs to click back to the 

user's main profile and then select another course link. 

3.4.7.3.See also 
 The Parent role in Moodle 2.0 video 

 Create a custom role 

Using Moodle forum discussions: 

 Create a Parent of a student role 

 Parent Role Report: Who belongs to whom? 

 Improving navigation: 

One small hack that can make the course list a bit more readable, 

especially for long course lists, is to change the format to a vertical list: 

 

 Edit the moodle/user/view.php file and look for these lines (around line 

302-304 in my 2.3.2 installation): 

. $cfullname . "</a>, "; 

                } else { 

                    $courselisting .= $cfullname . ", "; 

 and change that to : 

$cfullname . "</a>,<br />"; 

                } else { 

                    $courselisting .= $cfullname . "<br />";; 

 Then save 

This will affect the profile view in a course. 

 

Edit the moodle/user/profile.php file and look for these lines (around line 

3332 in my 2.3.2 installation): 

$courselisting .= "<a href=\"{$CFG->wwwroot}/user/view.php?id={$user-

>id}&amp;course={$mycourse->id}\" $class >" . 

format_string($mycourse->fullname) . "</a>, "; 

 and change that to : 

$courselisting .= "<a href=\"{$CFG->wwwroot}/user/view.php?id={$user-

>id}&amp;course={$mycourse->id}\" $class >" . 

format_string($mycourse->fullname) . "</a>,<br />"; 

 

 Оценки могут быть увидены щелчком в Профиле пользователя по «Activity 

reportsGrades». 

 Сообщения Форума также могут быть увидены из Профиля пользователя. 

Снимок с экрана «Щёлкните имя Курса в Профиле». 

Снимок с экрана «Только потом выберите элемент в Блоке навигации». 

Снимок с экрана «Оценки сейчас видимы». 

 Чтобы увидеть Интерактивное Действие в другом Курсе, Родителю нужно щёлкнуть 

снова Главный Профиль Пользователя и затем выбрать другую ссылку на Курс. 

3.4.7.3.См. также 
 Роль Родителя в Moodle 2.0 на видео. 

 Создать клиентскую Роль. 

Обсуждения Форума по использованию Moodle: 

 Создать Родителя из Роли Студента 

 Отчёт по Роли Родителя: Кто кому принадлежит? 

 Улучшая навигацию: 

Небольшая хакерская работёнка, которая поможет создать список Курсов более 

читабельным, особенно для длинных списков Курсов, и заключается в изменении формата 

вертикального списка: 

 Отредактируйте файл moodle/user/view.php и взгляните на эти строки (строки в районе 

302-304 в моей инсталляции 2.3.2): 

$cfullname . "</a>,"; 

} else { 

$courselisting = $cfullname .", "; 

 и измените это на: 

$cfullname . "</a>,<br />"; 

} else { 

$courselisting .= $cfullname . "<br />";; 

 Затем сохраните. 

Это возымеет действие на вид Профиля в Курсе. 

 

Отредактируйте файл moodle/user/profile.php и взгляните на эти строки (строки в 

районе 3332 в моей инсталляции 2.3.2): 

$courselisting .= "<a href=\"{$CFG->wwwroot}/user/view.php?id={$user-

>id}&amp;course={$mycourse->id}\" $class >" . format_string($mycourse->fullname) . "</a>, 

"; 

 и измените эта на: 

$courselisting .= "<a href=\"{$CFG->wwwroot}/user/view.php?id={$user-

>id}&amp;course={$mycourse->id}\" $class >" . format_string($mycourse->fullname) . 

"</a>,<br />"; 

http://docs.moodle.org/23/en/File:selectacourse.png
http://docs.moodle.org/23/en/File:parentchildreports.png
http://docs.moodle.org/23/en/File:userreportparentrole.png
http://www.youtube.com/watch?v=Gk_TRi_N00o
http://docs.moodle.org/23/en/Create_custom_roles
https://moodle.org/mod/forum/discuss.php?d=57812
http://moodle.org/mod/forum/discuss.php?d=199269
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 Then save 

This will affect the profile view from the main page. 

3.4.8.Permissions 
Moodle allows specific roles to be able to change other specific role 

capabilities based on the context. For example, a teacher in a course may 

want all students (users with a student role) to be able to edit all forums in 

that course. Or a teacher may want all students in a specific forum to be 

able to edit that forum. 

If you want to give a specific student the ability to edit a specific activity, 

see Override permissions. 

3.4.8.1.Course and activity permissions 
Role permissions for a course can be changed in Administration > Course 

administration > Users > Permissions and for a particular activity in 

Administration > Activity administration > Permissions. 

 

Click the Allow icon (+) opposite a capability to give permission to 

additional roles or the Prevent icon (X) to take away permission. 

3.4.8.2.Block permissions 
Block permissions can be changed by: 

 Turn editing on in the course 

 Click the assign roles icon (a face and mask) in the header of the block 

 

 Scroll down to the settings block and click the Permissions link 

3.4.8.3.Checking permissions 
The check permissions feature provides a method to view all roles both in 

the current context and higher contexts (in Moodle 2.3.2 onwards) and 

capabilities for a selected user based on their role assignments. These 

capabilities determine whether or not the selected user is allowed to 

perform associated tasks within the system or course. A teacher can check 

permissions for their course in Administration > Course administration > 

Users > Permissions> Check permissions and for a particular activity in 

Administration > Activity administration > Check permissions. 

An administrator can check system permissions in Administration > Site 

administration > Users > Permissions > Check system permissions. 

The review permissions for others capability (allowed for the default roles 

of manager, teacher and non-editing teacher) controls whether a user can 

check permissions. 

 

 

 Затем сохраните. 

Это возымеет действие на вид Профиля из Главной Страницы. 

3.4.8.Полномочия 
Moodle предоставляет отдельным Ролям способность изменять Возможности 

другой конкретной Роли в зависимости от Контекста. Например, Преподаватель Курса 

может захотеть, чтобы все Студенты (пользователи с Ролью Студента) могли 

редактировать все Форумы этого Курса. Или Преподаватель может захотеть, чтобы все 

Студенты конкретного Форума могли редактировать этот Форум. 

Если вы хотите дать конкретному Студенту способность редактировать конкретное 

Интерактивное Действие, см. п. 3.4.9 «Переопределить Полномочия». 

3.4.8.1.Полномочия Курса и Действия 
Полномочия Роли для Курса могут быть изменены в 

AdministrationCourse administrationUsersPermissions, а для конкретного Действия в 

Administrationимя Действия administrationPermissions. 

Снимок с экрана «Полномочия Курса». 

Щёлкните иконку Allow (+) напротив Возможности, чтобы дать разрешение 

дополнительным Ролям, или иконку Prevent (x), чтобы убрать Полномочие. 

3.4.8.2.Полномочия Блока 
Полномочия Блока могут быть изменены посредством: 

 Включения режима редактирования «Turn editing on» в Курсе, 

 Щелчка по иконке «Assign roles (назначь роли)» (лицо и маска) в заголовке нужного 

Блока, 

 Прокрутки блока настроек «Block: Administration» и щелчка по ссылке Permissions. 

3.4.8.3.Проверка Полномочий 
Средство проверки Полномочий обеспечивает метод просмотра всех Ролей, как в 

текущем Контексте, так и в более высоких Контекстах (начиная с Moodle 2.3.2), и 

Возможностей для выбранного пользователя, основанные на Полномочиях его Роли. Эти 

Возможности определяют, будет или нет разрешено выбранному пользователю выполнять 

соответствующие задачи внутри Системы или Курса. Преподаватель может проверить 

Полномочия для своего Курса в 

AdministrationCourse administrationUsersPermissions Check permissions, а для 

конкретного Действия в AdministrationActivity administration Check permissions. 
Администратор может проверить Системные Полномочия в 

AdministrationSite administrationUsersPermissionsCheck system permissions. 

Возможность Полномочия просматривать других (разрешённая по умолчанию 

Ролям Менеджера, Преподавателя и не редактирующего Преподавателя), контролирует, 

может ли пользователь проверять Полномочия. 

http://docs.moodle.org/25/en/File:Permissions.png
http://docs.moodle.org/25/en/Capabilities/moodle/role:review
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3.4.8.4.Capability overview report 
An administrator can generate a capability overview report in Site 

Administration > Users > Permissions > Capability report. 

The report allows the administrator to select a capability and one or more 

roles. The report will show the role and its permission level for that 

capability. And if that capability was overridden for the role where in the 

site. For example, it might show that the gradereport:user view capability 

for a student role is set at the system level as "Allow" and for Course 1 it is 

set to "Prohibit". 

3.4.8.5.See also 
 List of all capabilities 

3.4.9.Risks 
Careful consideration should be given to the risks involved in allowing 

different capabilities. 

3.4.9.1.Configuration 
Certain capabilities are intended for administrators and managers only, as 

they enable users to change the site configuration and behaviour. 

 

3.4.9.2.XSS (Cross-Site Scripting) 
Certain capabilities enable users to add non-checked files and HTML code 

containing JavaScript etc. This may be misused for cross-site scripting 

(XSS) purposes, with the potential to gain full admin access. These 

capabilities are intended for administrators and teachers only. 

 

Tip: The Security overview report (Administration > Reports > Security 

overview) lists all XSS trusted users. 

 

3.4.9.3.Privacy 
Certain capabilities enable users to gain access to private information of 

other users, for example non-public information in a user's profile. These 

capabilities are intended for administrators and teachers only. 

 

3.4.9.4.Spam 
Certain capabilities enable users to add content to site, for example forum 

posts, account creation, and send messages to other users. These 

capabilities may be misused for spamming purposes. 

 

 

3.4.8.4.Обзорный отчёт по Возможностям 
Администратор может сгенерировать Обзорный отчёт по возможностям в 

AdministrationSite administrationUsersPermissionsCapability overview. 

Этот отчёт позволяет Преподавателю выбрать Возможность и одну или более 

Ролей (выбирая Роли, держите клавишу Ctrl нажатой). Этот Отчёт покажет Роль и уровень 

её Полномочий для данной Возможности. И если эта Возможность была переопределена 

для этой Роли на Сайте. Например, этот отчёт может показать, что Возможность 

просмотра gradereport:user для Роли Студента установлена на Системном уровне как 

«Allow (разрешить)», а для Курса 1 – как «Prohibit (запретить)». 

3.4.8.5.См. также 
 Список всех возможностей. 

3.4.9.Риски 
Следует тщательно рассмотреть риски, связанные с предоставлением различных 

Возможностей. 

3.4.9.1.Конфигурация 
Определённые Возможности предназначаются только для Администраторов и 

Менеджеров, так как они позволяют пользователям изменять конфигурацию и поведение 

Сайта. 

3.4.9.2.XSS-уязвимость (межСайтовый скриптинг) 
Определённые Возможности позволяют пользователям добавлять непроверенные 

файлы и HTML-код, содержащие JavaScript и т.д. Это может быть употреблено во зло для 

программирования межСайтовых сценариев (XSS) атак через Интернет с целью получения 

полного административного доступа. Эти возможности предназначены только для 

Администраторов и Преподавателей. 

Совет: Обзорный отчёт по безопасности (п. 3.5.2) перечисляет всех 

(AdministrationSite administrationReportsSecurity overview) заслуживающих XSS-

доверия пользователей (п. 3.5.2). 

3.4.9.3.Конфиденциальность 
Определённые Возможности позволяют пользователям получать доступ к личной 

информации других пользователей, например, к не публичной информации в Профиле 

пользователя. Эти возможности предназначены только для администраторов и 

Преподавателей. 

3.4.9.4.Спам 
Определённые Возможности позволяют пользователям добавлять содержимое на 

Сайт, например, корреспонденции Форумов, создание учётных записей и отправка 

сообщений другим пользователям. Эти Возможности могут быть употреблены во зло в 

целях спаминга (непрошенной рассылки большого числа одинаковых посланий). 

http://docs.moodle.org/25/en/Category:Capabilities
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3.4.9.5.Risks for predefined roles 
 Guest - only capabilities without any risks are allowed 

 Student - certain capabilities with spam risks are allowed 

 Teacher - certain capabilities with XSS and privacy risks are allowed 

 

 Administrator - all capabilities are allowed 

3.4.9.6.See also 

 Development:Hardening new Roles system 

 Capabilities/moodle/site:trustcontent 

3.4.10.Roles FAQ 
3.4.10.1.What is the definition of a... 
Capability 

A configurable aspect of program behavior. Moodle has 100s of 

capabilities. Each capability has a computer friendly name like 

mod/forum:rate and a human-friendly name like "Rate posts." 

 

Permission 

Permissions are paired with each capability. There are four possible 

permission values: Allow, Prevent, Prohibit and Not set/Inherit. (It is 

called not-set when defining roles and inherit when overriding 

permissions.) 

Role 

A named set of permissions that are associated with each capability. For 

example. the "Teacher" and "Student" roles come with the standard 

Moodle install. 

Context 

A functional area of Moodle. Contexts have a hierarchy. Examples of 

contexts include a course, activity module, or resource. 

3.4.10.2.Why isn't my role change taking 
effect? 
Certain capabilities e.g. moodle/user:changeownpassword may only be 

applied in the system context, so giving such permissions by assigning a 

role in the course context will have no effect. 

 

 

 

 

 

3.4.9.5.Риски для встроенных Ролей 
 Гость – разрешены только Возможности без какого-либо риска. 

 Студент – разрешены определённые Возможности с риском спама. 

 Преподаватель – разрешены определённые Возможности с XSS-риском и риском 

нарушения конфиденциальности. 

 Администратор – все возможности разрешены. 

3.4.9.6.См. также 
 Развитие: Ужесточение новой Системы Ролей. 

 Возможность Capabilities/moodle/site:trustcontent. 

3.4.10.См. также 
3.4.10.1.Что есть определение... 

Возможности 
Конфигурируемый аспект поведения программы. Moodle имеет сотни (для версии 

Moodle 2.5 их более 500) Возможностей. Каждая Возможность имеет компьютерное 

наименование, подобное mod/forum:rate, и для человека, подобное «Rate posts (оценивать 

корреспонденции)». 

Полномочие 

Полномочия соединены попарно с каждой Возможностью. Существуют четыре 

возможных значения Полномочия: Allow (разрешить), Prevent (препятствовать), Prohibit 

(запретить) и Not-set/Inherit (не устанавливать/унаследовать). (Последнее называется Not-

set при определении Ролей и Inherit при переопределении Полномочий). 

Роль 

Поименованный набор Полномочий, которые связаны с каждой Возможностью. 

Например, Роли «Преподаватель» и «Студент» приходят со стандартной инсталляцией 

Moodle. 

Контекст 

Функциональная область Moodle. Контексты имеют иерархию. Примеры 

контекстов включают Курс, Интерактивное Действие или Ресурс. 

3.4.10.2.Почему изменение моей Роли не имеет 
эффекта? 

Определённые Возможности, например, moodle/user:changeownpassword могут 

быть применены только в Контексте Системы, так что давать такие Возможности путём 

назначения Роли в Контексте Курса эффекта не принесёт. 

http://docs.moodle.org/dev/Hardening_new_Roles_system
http://docs.moodle.org/25/en/Capabilities/moodle/site:trustcontent
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3.4.10.3.Why do some users I know are in my 
course not appear in Participants? 
 
Users assigned roles in a higher context, for example users assigned the 

role of teacher in the course category are technically not enrolled in the 

course and so will not appear in the Participants link in the Navigation 

block but can be found via Administration>Course 

administration>Users>Other users 

3.4.10.4.How can I prevent a user from 
changing their own password? 
To prevent a user from changing their own password, you must make sure 

they do not have moodle/user:changeownpassword = Allow in the System 

context. The Authenticated user role (which is assigned to users in the 

System context) has moodle/user:changeownpassword = Allow by default, 

so you have two choices: 

Edit Authenticated user, setting moodle/user:changeownpassword = Not 

set 

Create a new role CannotChangeOwnPassword with 

moodle/user:changeownpassword = Prevent and all other permissions Not 

set. Choose "system" for the context type and assign the role to selected 

users in the System context via Administration>Site administration -> 

Users -> Permissions -> Assign system roles). 

Choice (1) will prevent all users from changing their passwords (except for 

the administrator, who can do anything). To selectively allow selected 

users (say teachers) to change their passwords, you could create a new role 

CanChangeOwnPassword with moodle/user:changeownpassword = Allow 

and all other permissions not set and assign the role to selected users in the 

System context (Site administration -> Users -> Permissions -> Assign 

system roles). 

Choice (2) allows you to be selective, but if you have a lot of users that 

you want to prevent (say, all students), you will have to make a lot of role 

assignments in the System context. There is currently no convenient way to 

do this, so you might consider choice (1). 

Note that you MUST deal with this permission in the System context. 

 

 

 

 

 

3.4.10.3.Почему некоторые пользователи, о которых я 
знаю, что они есть в моём Курсе, не появляются в 
Участниках? 

Пользователи, назначенные на Роли в высшем Контексте, например, пользователи, 

назначенные на Роль Преподавателя в Категории Курса, технически не зачисляются на 

Курс, а значит и не появятся по ссылке Participants (Участники) в Блоке навигации, но 

могут быть найдены через 

AdministrationCourse administrationUsersOther users. 

3.4.10.4.Как можно помешать пользователю изменить 
его собственный пароль? 

Чтобы помешать пользователю изменить его собственный пароль, вам следует 

убедиться, что он не имеет установки moodle/user:changeownpassword = Allow в Контексте 

Системы. Роль Аутентифицированного Пользователя (которая назначается пользователям 

в Контексте Системы) имеет эту moodle/user:changeownpassword = Allow установку по 

умолчанию, так что у вас есть два варианта: 

Отредактировать аутентифицированного пользователя, установив 

moodle/user:changeownpassword = Not set. 

Создать новую Роль CannotChangeOwnPassword (не может изменять собственный 

пароль) с moodle/user:changeownpassword = Prevent и все другие Полномочия в Not set. 

Выбрать тип Контекста «system» и назначить эту Роль выбранным пользователям в 

Контексте Системы через 

AdministrationSite administrationUsersPermissionsAssign system roles. 

Вариант 1: помешает всем пользователям изменять свои пароли (исключая 

Администратора, который может делать всё). Чтобы избирательно разрешить выбранным 

пользователям (скажем, Преподавателям) изменять их пароли, вы можете создать новую 

Роль CanChangeOwnPassword (может изменять собственный пароль) с 

moodle/user:changeownpassword = Allow, а все другие Полномочия – в Not set и назначить 

эту Роль выбранным пользователям в Контексте Системы через 

AdministrationSite administrationUsersPermissionsAssign system roles. 

Вариант 2: разрешит вам быть избирательным, но если вы имеете много 

пользователей, которым вы хотите помешать (скажем, всем Студентам), тогда вы должны 

сделать много назначений Ролей в Контексте Системы. В настоящее время нет удобного 

способа сделать это, так что вам следует остановиться на первом варианте. 

Заметьте, что вы ДОЛЖНЫ работать с этим разрешением в Контексте Системы. 
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3.4.10.5.How can I prevent a user from editing 
their own profile? 
See How can I prevent a user from changing their own password? The 

answer to this question is the same if you substitute edit their own profile 

for change their own password and moodle/user:editownprofile for 

moodle/user:changeownpassword. 

3.4.10.6.How do I change the name for 
"teacher" in the course description? 
Either 

Edit the role of Teacher via Administration > Users > Permissions > 

Define roles and rename it. The new name will apply site-wide. 

 

Or 

Create a duplicate teacher role with an alternative name and assign users 

the duplicate teacher role as appropriate in the course context. In 

Administration > Appearance > Course contact select the alternative name 

for teacher that you wish to be displayed in the course description when 

courses are listed. For example, copy the standard teacher role and call it 

Instructor and only show that role as the course contact. 

Or 

Create a new "dummy" role (no capabilities) with those names and assign 

them to teachers along with the real roles. select the alternative name for 

teacher that you wish to be displayed in the course description when 

courses are listed. For example, copy the guest role, call it Lead Teacher 

and make this the course contact. You may have 5 teachers in the course 

but only one name will appear as Lead Teacher. If nobody is assigned the 

role Lead Teacher, no course contact will show. 

Or 

Names for different roles in a course may be changed in the Course 

administration > edit settings "Role renaming" fields. For example, some 

courses the teacher wants the title "Professor", or "Chief" or "Mentor". 

 

Or 

Edit the language files and change any word you want. 

 

 

 

 

 

3.4.10.5.Как можно помешать пользователю 
редактировать свой Профиль? 

См. п. 3.4.10.4 «Как можно помешать пользователю изменить его собственный 

пароль?». Ответ на этот вопрос тот же самый, подставите edit their own profile на место 

change their own password и moodle/user:editownprofile на место 

moodle/user:changeownpassword. 

3.4.10.6.Как изменить название «Teacher» в описании 
Курса? 

Либо 

Отредактируйте Роль Teacher через 

AdministrationSite administrationUsersPermissionsAssign system roles и измените её. 

Новое название будет применено ко всему Сайту. 

Или 

Создайте дубликат Роли Teacher с альтернативным названием и назначьте 

пользователям дубликат Роли Teacher подходящим образом в Контексте Курса. В 

AdministrationSite administrationAppearanceCourses замените в Course contact 

название «Teacher» на то, которое вы желаете, чтобы отображалось в описании Курса, 

когда Курсы перечисляются. Например, скопируйте стандартную Роль Teacher и назовите 

её Инструктор и просто покажите эту Роль как контакт Курса. 

Или 

Создайте новую Роль-«макет» (без Возможностей) с этими названиями и назначьте 

их Преподавателям с реальными Ролями. Выберите альтернативное название для Teacher, 

которое вы желаете, чтобы отображалось в описании Курса, когда Курсы перечисляются. 

Например, скопируйте Роль Гостя, назовите её Ведущий Преподаватель и сделайте его 

контактом Курса. Вы можете иметь пять Преподавателей в Курсе, но только одно название 

появится как Ведущий Преподаватель. Если никто не назначен на Роль Ведущего 

Преподавателя, контакт Курса показан не будет. 

Или 

Имена для различных Ролей могут быть изменены в полях «Role renaming 

(переименование роли)» в Course administrationEdit settings. Например, некоторые 

Курсы, в которых Преподаватель хочет иметь титул «Профессор», или «Шеф», или 

«Надзирающий». 

Или 

Отредактируйте файлы языкового пакета и измените любое слово, как хотите. 
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3.4.10.7.How do I enable teachers to set role 
overrides? 
 Access Site administration > Users > Permissions > Define roles. 

 Edit the teacher role and change the capability moodle/role:safeoverride 

to allow. 

 Click the button "Save changes". 

 Click the tab "Allow role overrides" (in Site administration > Users > 

Permissions > Define roles). 

 Check the appropriate box(s) in the teacher row to set which role(s) 

teachers can override. Most likely it will just be the student role (you 

don't want teachers to be able to override admins!), so check the box 

where the teacher row intersects with the student column. 

  

 Click the button "Save changes". 

3.4.10.8.How do I enable teachers to assign 
other teachers in a course? 
This is disabled by default but it can be switched on by modifying the 

teacher's role. In Siite administration > Users > Permissions > Define roles 

select the "Allow role assignments" tab and tick the checkbox where 

Teacher and Teacher intersect. 

3.4.10.9.Why doesn't "Switch role to.." within a 
course seem to work properly? 
This feature is intended for teachers so that they can see how their course 

appears for students. It isn't a reliable view however, as some features do 

not display correctly when viewed by a teacher who has switched their role 

to a student. For that reason it is always preferable where possible to have 

a "test" student log in to use. 

3.4.10.10.Are there any example roles? 
Yes, as follows: 

 Parent - for providing parents/mentors/tutors with permission to view 

certain information about their children/mentees/tutees 

 

 Demo teacher - for providing a demonstration teacher account with a 

password which can't be changed 

 Forum moderator - for providing a user with permission in a particular 

forum to edit or delete forum posts, split discussions and move 

discussions to other forums 

3.4.10.7.Как позволить Преподавателям проводить 
переопределения Ролей? 
 Войдите на AdministrationSite administrationUsersPermissionsDefine roles. 

 Отредактируйте Роль Преподавателя и измените Возможность moodle/role:safeoverride 

в Allow. 

 Щёлкните кнопку «Save changes». 

 Щёлкните ярлычок «Allow role overrides (разрешить переопределения ролей)» (в 

AdministrationSite administrationUsersPermissionsDefine roles). 

 Отметьте соответствующее окошко (и) в строке Teacher, чтобы установить, какую Роль 

(и) Преподаватели могут переопределять. Наиболее вероятно это будет только Роль 

Студента (вы же не хотите, чтобы Преподаватели были способны переопределять 

Администраторов!), так что отметьте окошко на пересечение строки Teacher с колонкой 

Student. 

 Щёлкните кнопку «Save changes». 

3.4.10.8.Как позволить Преподавателям назначать 
других Преподавателей на Курс? 

Это по умолчанию отключено, но может быть включено модификацией Роли 

Преподавателя. В AdministrationSite administrationUsersPermissionsDefine roles 

выберите ярлычок «Allow role assignments (разрешить назначения ролей)» и пометьте 

окошко-флажок на пересечении Teacher и Teacher. 

3.4.10.9.Почему «Переключить Роль на..» внутри Курса 
не в состоянии работать правильно? 

Это средство предназначено для Преподавателей, чтобы они могли видеть, как их 

Курс предстанет перед Студентами. Однако, этот вид не надёжен, так как некоторые 

средства не отображаются корректно при просмотре Преподавателем, переключившимся 

на Роль Студента. По этой причине всегда предпочтительнее, где возможно, иметь 

зарегистрированного Студента с именем «Тест» для использования. 

3.4.10.10.Существуют какие-нибудь примеры Ролей? 
Да, следующие: 

 Parent (Родитель) – для обеспечения Родителей/надзирающих/наставников 

Полномочием просматривать определённую информацию о их 

детях/поднадзорных/наставляемых. 

 Demo teacher (демонстрирующий Преподаватель) – для обеспечения учётной записи 

демонстрирующего Преподавателя с паролем, который не может быть изменён. 

 Forum moderator (модератор форума) – для обеспечения пользователя Полномочием в 

конкретном Форуме редактировать или удалять корреспонденцию Форума, разделять 

обсуждения и перемещать их в другие Форумы. 
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Calendar editor - for providing a user with permission to add site events to 

the calendar 

 Blogger - for limiting blogging to specific users only 

 

 Question creator - for enabling students to create questions for use in 

quizzes 

 Course requester role - for restricting users who can make course 

requests 

 Cohort enroller -for allowing teachers in courses to enrol cohorts 

 

3.4.10.11.Logged-in users can't read the site 
news. What can I do? 
See News forum for details. 

3.4.10.12.How do I enable logged-in users to 
participate in front page activities? 
 
Either: 

 Access Site administration > Front Page > Users > Permissions> 

Assigned roles 

 Select the role you wish to add individual users to 

 Select all or some of the users in the potential users list 

 Use the left-facing arrow button to add them to the existing users list 

 

Or: 

 Access Site Administration > Front Page > Front Page settings 

 Set the default front page role to student. 

Note: Setting the default front page role to student is not sufficient to 

enable logged-in users to participate in a Front Page "Choice activity". A 

permissions override should be used instead. 

3.4.10.13.How can I prevent students from 
editing their profile? 
If you only want students to be prevented from editing their profile, and 

not all users, you can create a new role, such as Restricted user as 

described in the Demo teacher role, with moodle/user:editownprofile set to 

prevent, and assign it to all students in the system context. 

 

 

 Calendar editor (редактор календаря) – для обеспечения пользователя Полномочием 

добавлять события Сайта в Календарь. 

 Blogger (блоггер) – для ограничения по ведению блогов только конкретными 

пользователями. 

 Question creator (создатель вопросов) – для позволения Студентам создавать Вопросы, 

чтобы использовать в Экзаменах. 

 Course requester role (роль запрашивающего курс) – для ограничения пользователей, 

которые могут запрашивать (у администрации создать новый) Курс. 

 Cohort enroller (зачисливающий в когорту) – для разрешения Преподавателям в Курсы 

зачислять Когорты. 

3.4.10.11.Зарегистрированные пользователи не могут 
читать новости Сайта. Что делать? 

Подробности см. п. 4.3.7.2.9 «Форум новостей». 

3.4.10.12.Как позволить зарегистрированным 
пользователям участвовать в действиях на Главной 
странице? 

Либо: 

 Перейдите на  

AdministrationSite administrationFront PageUsersPermissionsAssign roles 

 Выберите Роль, которую желаете добавить отдельным пользователям. 

 Выберите вех или некоторых пользователей из списка потенциальных пользователей. 

 Используйте кнопку со стрелкой влево, чтобы добавить их в список существующих 

пользователей. 

Или: 

 Перейдите на AdministrationSite administrationFront PageFront Page settings. 

 Установит Роль Студента для Главной страницы по умолчанию. 

Замечание: Установки Роли Студента для Главной страницы по умолчанию не 

достаточно, чтобы позволить зарегистрированным пользователям участвовать в «Выборе 

действий» на Главной странице. Вместо этого должны быть переопределены Полномочия. 

3.4.10.13.Как помешать Студентам редактировать их 
Профиль? 

Если вы хотите только Студентам помешать редактировать их Профиль, а не всем 

пользователям, вы можете создать новую Роль, такую как Ограниченный пользователь, 

как описано в Роли демонстрирующего Преподавателя с установкой 

moodle/user:editownprofile в Prevent и назначения её всем Студентам в Контексте Системы. 

http://docs.moodle.org/25/en/Demo_teacher_role
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Alternatively, you could change moodle/user:editownprofile to not set for 

the Authenticated user role, then create a new role for teachers with 

moodle/user:editownprofile set to allow. 

 

3.4.10.14.Why can't I add teachers or students 
site wide in Moodle? 
You can, but it is not best practice. 

 Teachers and students typically work in one or more individual courses. 

It is unusual for a student to be studying every single course on your 

Moodle and unusual for a teacher to be teaching every single course. 

Therefore, the default Moodle does use these as system wide roles. The 

Manager role might be one that makes sense to assign on a system or 

category context. 

 To assign a teacher or student sitewide, go to Administration>Site 

administration>Users>Permissions> Define roles and edit the role to 

include the system context. 

 Then search for and allow the capability moodle/course:view 

 Then assign users to this role via Administration>Site 

administration>Users>Permissions>Assign system roles 

 It might be preferable to create a new role based on the teacher or 

student and assign this in the System context. Then assign individuals 

to that role. 

3.4.10.15.How can I make a role available as a 
front page role? 
 Go to Settings > Site administration > Users > Permissions > Define 

roles and edit the role 

 For 'Context types where this role may be assigned' tick the Course 

checkbox 

 Scroll to the bottom of the page and click the 'Save changes' button 

3.4.10.16.How can I allow a non-editing 
teacher to "switch role to " a student? 
In Settings > Site administration > Users > Permissions > Define roles, edit 

the non-editing teacher role and set the capability 

"moodle/role:switchroles" to "allow". This will then allow them to switch 

their role to a student or a guest (as defined on the Allow role switches 

screen.) 

 

 

Альтернативно, можно изменить moodle/user:editownprofile в Not set для Роли 

аутентифицированного пользователя (http://docs.moodle.org/25/en/Authenticated_user_role), 

затем создать новую Роль для Преподавателей с moodle/user:editownprofile, установленной 

в Allow. 

3.4.10.14.Почему невозможно добавить Студентов или 
Преподавателей на весь Сайт Moodle? 

Вы можете, но это не лучшая практика. 

 Преподаватели и Студенты обычно работают в одном или более отдельных Курсах. Это 

необычно для Студента обучаться сразу на всех Курсах в Moodle, и необычно для 

Преподавателя преподавать все Курсы. Следовательно, по умолчанию Moodle не 

использует их как Роли на уровне Системы. Роль Менеджера может быть одной, 

которая имеет смысл назначать в Контексте Системы или Категории. 

 

 Чтобы назначить Преподавателя или Студента для всего Сайта, перейдите в 

AdministrationSite administrationUsersPermissionsDefine roles и 

отредактируйте эту Роль, чтобы включить её в Контекст Системы. 

 Затем найдите и разрешите Возможность moodle/course:view. 

 Затем назначьте пользователей на эту Роль через 

AdministrationSite administrationUsersPermissionsAssign system roles. 

 Может быть предпочтительнее создать новую Роль на базе Роли Преподавателя или 

Студента и назначить её в Контексте Системы. Затем назначить отдельных людей на 

эту Роль. 

3.4.10.15.Как сделать Роль, подходящей на Роль на 
Главной странице? 
 Перейдите на AdministrationSite administrationUsersPermissionsDefine roles и 

отредактируйте эту Роль. 

 Пометьте на этой странице те окошки-флажки в поле «Context types where this role may 

be assigned (типы контекста, где эта роль может быть назначена)». 

 Прокрутите эту страницу вниз и щёлкните кнопку «Save changes». 

3.4.10.16.Как можно разрешить не редактирующему 
Преподавателю переключаться на роль Студента? 

В AdministrationSite administrationUsersPermissionsDefine roles 

отредактируйте Роль не редактирующего Преподавателя и установите Возможность 

moodle/role:switchroles в Allow. Это потом позволит им переключать себя на Роль 

Студента или Гостя (как определено на экране Allow role switches – разрешить 

переключения Ролей). 

http://docs.moodle.org/25/en/Authenticated_user_role
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3.4.10.17.How can I set a role back to its 
default permissions? 
 Go to Administration> Site administration > Users > Permissions > 

Define roles and click on the name of the role 

 Click the 'Reset to defaults' button and then answer yes to confirm 

 

Note that if you have students who have been given extra permissions 

(such as forum ratings), then they will no longer be able to do this once the 

role has been reset to its default. 

3.4.10.18.Permissions don't seem to be 
working correctly. What can I do? 
It is recommended that permissions for each role are reviewed and set 

according to the role archetype. 

 Go to Administration > Site administration > Users > Permissions > 

Define roles and click the edit icon opposite a role 

 Click the 'Show advanced' button to reveal the different permission 

settings 

 Review permissions (filtering for particular permissions as appropriate) 

and, unless there is a good reason to do otherwise, change permissions 

so that all are set to the highlighted value 

 Click the 'Save changes' button 

 Repeat steps 1 to 4 for each role 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3.4.10.17.Как вернуть Роль к Полномочиям по 
умолчанию? 
 Перейдите к AdministrationSite administrationUsersPermissionsDefine roles и 

щёлкните на названии Роли. 

 Щёлкните кнопку «Reset to defaults (восстановить значения по умолчанию)» и затем 

ответьте Yes на Confirm (подтвердите). 

Заметьте, что если вы имеете Студентов, которым даны экстра Полномочия (такие 

как оценивание Форума), тогда они не смогут делать это дальше сразу, как только этой 

Роли будут возвращены значения по умолчанию. 

3.4.10.18.Полномочия не в состоянии работать 
правильно. Что делать? 

Рекомендуется, чтобы Полномочия для каждой Роли рецензировались и 

устанавливались в соответствии с архетипом этой Роли. 

 Перейдите к AdministrationSite administrationUsersPermissionsDefine roles и 

щёлкните иконку редактирования напротив Роли. 

 Щёлкните кнопку «Show advanced (показать продвинутые)», чтобы обнаружить 

настройки различных Полномочий. 

 Прорецензируйте Полномочия (фильтруя отдельные Полномочия подходящим 

образом) и, если нет веской причины делать противное, измените Полномочия так, 

чтобы всем им были установлена подсветка значения. 

 Щёлкните кнопку «Save changes». 

 Повторите шаги с 1 по 4 для каждой Роли. 
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3.4.10.19.What is the "none" role? 
It is possible to enrol users into a course so they appear as participants, but 

since they do not have a standard role such as student, they do not have any 

particular permissions. They cannot for example, engage in course 

activities. For discussion about the "none" role, see MDL-29599. 

3.4.10.20.See also 
Using Moodle Roles and Capabilities forum. 

3.4.11.Override permissions 
Overrides are specific permissions designed to override a role in a specific 

context, allowing you to "tweak" your permissions as required. 

 

Overrides may be used to "open up" areas by giving users extra 

permissions. For example, an override may be used to enable students to 

rate forum posts (see Forum settings for details). 

 

Overrides may also be used to prevent actions, such as starting new 

discussions in an archived forum. 

3.4.11.1.Permissions 
There are four settings for each permission capability: 

3.4.11.1.1.Inherit 
The default setting. If a capability is set to inherit, the user's permissions 

remain the same as they are in a less specific context, or another role where 

the capability is defined. For example, if a student is allowed to attempt 

quiz questions at the course level, their role in a specific quiz will inherit 

this setting. Ultimately, if permission is never allowed at any level, then 

the user will have no permission for that capability. 

 

3.4.11.1.2.Allow 
This enables a user to use a capability in a given context. This permission 

applies for the context that the role gets assigned plus all lower contexts. 

For example, if a user is assigned the role of student in a course, they will 

be able to start new discussions in all forums in that course (unless a forum 

contains an override with a prevent or prohibit value for the capability). 

 

 

 

 

 

 

3.4.10.19.Что такое «никакая» Роль? 
Возможно зачисление пользователей на Курс, которые появятся как Участники, но 

при этом они не будут иметь стандартной Роли, такой как Студент, они не будут иметь 

каких-либо конкретных Полномочий. Они не смогут, например, заниматься в 

Интерактивных Действиях Курса. Обсуждение «никакой» Роли см. MDL-29599. 

3.4.10.20.См. также 
Использование Moodle, форум «Роли и Возможности». 

3.4.11.Переопределить Полномочия 
Переопределения – это специфические Полномочия, разработанные для коррекции 

Роли в определённом Контексте, что даёт возможность «настроить» свои Полномочия в 

соответствии с необходимостью. 

Переопределения могут быть использованы, чтобы «открыть» области, 

предоставлением пользователям дополнительных Полномочий. Например, коррекция 

может быть использована, чтобы позволить Студентам оценивать корреспонденции 

Форума (см. дополнительные сведения в «Настройки форума» в п. 4.3.7). 

Переопределения также могут быть использованы для предотвращения действий, 

таких как запуск новых обсуждений в заархивированном Форуме. 

3.4.11.1.Полномочия 
Есть четыре настройки для каждой Возможности Полномочий: 

3.4.11.1.1.Наследовать 
Настройка по умолчанию. Если Возможность установлена в «Наследовать», 

Полномочия пользователя остаются теми же, что и в менее специфическом Контексте, или 

другой Роли, где Возможность определена. Например, если Студент имеет право попыток 

ответить на вопросы Экзамена на уровне Курса, его Роль в определённом Экзамене 

унаследует эту настройку. В конечном счёте, если Полномочие не предоставляется 

никогда на любом уровне, то пользователь не будет иметь Полномочие для этой 

Возможности. 

3.4.11.1.2.Позволить 
Эта опция позволяет пользователю использовать Возможность в данном 

Контексте. Это Полномочие применяется для Контекста, который получает назначаемая 

Роль, плюс для Контекстов нижних уровней. Например, если пользователю назначается 

Роль Студента в Курсе, он будет способен инициировать новую дискуссию во всех 

Форумах в этом Курсе (если только Форум не содержит отмены посредством опции 

«Предотвратить» или «Запретить» для этой Возможности). 

http://tracker.moodle.org/browse/MDL-29599
http://moodle.org/mod/forum/view.php?id=6826
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3.4.11.1.3.Prevent 
By choosing this you are removing permission for this capability, even if 

the users with this role were allowed that permission in a higher context. 

3.4.11.1.4.Prohibit 
This is rarely needed, but occasionally you might want to completely deny 

permissions to a role in a way that can NOT be overridden at any lower 

context. An example of when you might need this is when an admin wants 

to prohibit one person from starting new discussions in any forum on the 

whole system. In this case they can create a role with that capability set to 

“Prohibit” and then assign it to that user in the system context. 

 

3.4.11.2.Conflict resolution of permissions 
Permissions at a “lower” context will generally override anything at a 

“higher” context (this applies to overrides and assigned roles). The 

exception is PROHIBIT which can not be overridden at lower levels. 

 

If two roles are assigned to a person in the same context, one with 

ALLOW and one with PREVENT, then ALLOW will win. 

3.4.11.2.1.Special exceptions 
Note that the guest user account will generally be prevented from posting 

content (eg forums, calendar entries, blogs) even if it is given the capability 

to do so. 

3.4.11.3.Locations for overriding permissions 
 Front page context: Administration > Front Page settings > Users > 

Permissions 

 Course category context (when used): 

Category>Administration>Permissions 

 Course context: Administration > Course administration > Users > 

Permissions 

 Module context: (from the chosen module) Administration > Module 

administration > Permissions 

 Block context: (from the chosen block) Administration > Block 

administration > Permissions 

 User context: (from the user's profile) Administration > Roles > 

Permissions 

 

 

 

 

3.4.11.1.3.Предотвратить 
Выбором этой опции вы удаляете Полномочие для этой Возможности, даже если 

пользователям с этой Ролью было дано это Полномочие в более высоком Контексте. 

3.4.11.1.4.Запретить 
Эта опция требуется редко, но иногда вы можете захотеть полностью отказаться от 

Полномочий этой Роли способом, который НЕ может быть переопределён в любом 

нижнем Контексте. Примером того, когда это может потребоваться, служит случай, когда 

Администратор захочет запретить одной персоне инициировать новые дискуссии в любом 

Форуме во всей Системе. В этом случае он может создать Роль с этой Возможностью, 

установленной в «Запретить», и затем назначить её этому пользователю в Контексте 

Системы. 

3.4.11.2.Разрешение конфликта Полномочий 
Полномочия в «нижнем» Контексте, как правило, переопределяют что-либо с 

"высшего" Контекста (это относится к переопределениям и назначенным Ролям). 

Исключением является ЗАПРЕТИТЬ, которое не может быть отменено на более низких 

уровнях. 

Если в одном том же Контексте назначаются две роли одному лицу, одна с опцией 

ПОЗВОЛИТЬ, а одна с ПРЕДОТВРАТИТЬ, тогда ПОЗВОЛИТЬ выигрывает. 

3.4.11.2.1.Специальные исключения 
Заметьте, что учётная запись пользователя «Гость», как правило, предотвращается 

от содержимого почтовой корреспонденции (например, Форумов, записей Календаря, 

Блогов), даже если дана Возможность делать это. 

3.4.11.3.Места для переопределения Полномочий 
 Контекст Главной Страницы: 

Administration→Front Page settings→Users→Permissions. 

 Контекст Категории Курсов (когда используется): 

Category→Administration→Permissions. 

 Контекст Курса: Administration→Course administration→Users→Permissions. 

 

 Контекст модуля: (из выбранного модуля) 

Administration→Module administration→Permissions. 

 Контекст Блока: (из выбранного Блока) 

Administration→Block administration→Permissions. 

 Контекст пользователя: (из выбранного Профиля Пользователя) 

Administration→Roles→Permissions. 
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3.4.11.4.Ability to override permissions 
Users who have the capability moodle/role:override allowed or the 

capability moodle/role:safeoverride allowed) can override permissions for 

selected roles (as set in Allow role overrides). 

The default manager role has the capability moodle/role:override allowed, 

and can override permissions for all other roles. 

The default teacher role has the capability moodle/role:safeoverride 

allowed, and can override permissions for the roles of non-editing teacher, 

student and guest. 

3.4.11.5.Enabling non-editing teachers to 
override safe permissions 
1. Access Administration > Site Administration > Users > Permissions > 

Define roles. 

2. Edit the non-editing teacher role and change the capability 

Capabilities/moodle/role:safeoverride to allow. 

3. Click the button "Save changes". 

4. Click the tab "Allow role overrides" (in Administration > Site 

administration > Users > Permissions > Define roles). 

5. Check the appropriate box(s) in the non-editing teacher row to set 

which role(s) they can override. Most likely it will just be the student 

role (you don't want non-editing teachers to be able to override 

managers), so check the box where the non-editing teacher row 

intersects with the student column. 

 

6. Click the button "Save changes". 

If preferred, a new role for overriding permissions may be created and 

selected non-editing teachers assigned to it. 

3.4.11.6.Overriding permissions for selected 
students 
Sometimes a teacher will want to override permissions for selected 

students. Typically they will assign a student a role locally. For example, 

assign a student as a non-editing teacher. However, managers can override 

specific permission in a role. This does not create a new role. It modifies 

an existing specific role and affects all users assigned to that role in the 

context. 

Sometimes the administrator (or someone with the permissions to) will 

create a new role. For example, the administrator will copy all the student 

permissions to a new role, then change specific permissions. The teacher 

then assigns specific students to this role without having to worry about 

3.4.11.5.Позволение переопределять Полномочия 
Пользователи, которые имеют разрешённую Возможность moodle/role:override или 

Возможность moodle/role:safeoverride, могут переопределить Полномочия для выбранных 

Ролей (как установлено в «Разрешить переопределения Ролей»).  

Роли Менеджера по умолчанию позволена Возможность moodle/role:override 

позволительно и Менеджер может переопределять Полномочия для всех других Ролей. 

Роли Преподавателя по умолчанию позволена Возможность 

moodle/role:safeoverride, и Преподаватель может переопределить Полномочия для Ролей 

неРедактирующего Преподавателя, Студента и Гостя. 

3.4.11.4.Позволение неРедактирующим Преподавателям 
переопределять безопасные Полномочия 
1. Перейдите в Administration→Site Administration→Users→Permissions→Define roles. 

 

2. Отредактируйте Роль неРедактирующего Преподавателя и изменить Возможность 

Capabilities/moodle/role:safeoverride в Allow. 

3. Щёлкните кнопку «Save changes (сохранить изменения)». 

4. Щёлкните ярлычок «Allow role overrides (разрешить переопределения ролей)» (в 

Administration→Site Administration→Users→Permissions→Define roles). 

5. Пометьте подходящее(ие) окошко(и) в строке Non-editing teacher (нередактирующего 

преподавателя), чтобы установить, какие Роли он может переопределять. Наиболее 

вероятно это будет только Роль Студента (вы же не захотите, чтобы 

неРедактирующие Преподаватели были способны переопределять Менеджеров), 

поэтому пометьте окошко, где строка неРедактирующего Преподавателя пересекается с 

колонкой Студента. 

6. Щёлкните кнопку «Save changes (сохранить изменения)». 

Если предпочитаете, можно создать новую Роль для переопределения 

Полномочий, и назначить её выбранным неРедактирующим  Преподавателям. 

3.4.11.6.Переопределение Полномочий для выбранных 
Студентов 

Иногда Преподаватель может захотеть отменить Полномочия для выбранных 

Студентов. Как правило, он назначит Студенту роль локально. Например, назначит 

Студенту Роль нередактирующего Преподавателя. Тем не менее, Менеджеры могут 

переопределить конкретное Полномочие в Роли. Это не создаёт новой Роли. Это изменяет 

существующую конкретную Роль и влияет на всех пользователей, которым назначена эта 

Роль в определённом Контексте. 

Иногда администратор (или кто-то с соответствующими Полномочиями) может 

создать новую Роль. Например, администратор скопирует все Полномочия Студента в 

новую Роль, а затем изменит определённые Полномочия. Затем Преподаватель назначит 

конкретным Студентам эту Роль, не беспокоясь о проверке 
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checking off the correct role permissions. 

3.4.11.7.See also 
 Using Moodle Course role which revokes capability granted in a 

sitewide role forum discussion 

3.5.Security 
3.5.1.Security recommendations 
Advice on how best to keep your site secure. 

 

3.5.2.XSS trusted users 
Users, which do not add non-checked files and HTML code containing 

JavaScript etc for cross-site scripting (XSS) purposes, with the potential to 

gain full admin access. 

 

3.5.3.Security overview report 
Checks for all kinds of potential security problems that you might have in 

your configuration 

3.5.4.Site policies 
Settings affecting the security and privacy of your site. 

 

3.5.5.Notifications 
Information about update and login failure notifications. 

 

3.5.6.Password salting 
Details of the way of making passwords more secure by adding a random 

string of characters to passwords before their hash is calculated 

 

3.5.7.Moodle security procedures 
Reporting a security issue 

 

3.5.8.Increasing privacy 
Suggestions for settings changes to increase privacy of users. 

 

3.5.9.Reducing spam 
Advice on how to minimize the risk of spam on your site. 

 

 

корректности Полномочий этой Роли. 

3.4.11.7.См. также 
 Обсуждения форума по использованию Moodle «Роль уровня Курса, которая отменяет 

Возможность Роли уровня Сайта». 

3.5.Безопасность 
3.5.1.Рекомендации по безопасности 

Совет, как наилучшим образом сохранить ваш Сайт в безопасности. 

См. http://docs.moodle.org/25/en/Security_recommendations. 

3.5.2.XSS-надёжные пользователи 
Пользователи, которые не добавляют не проверенных файлов и HTML кода, 

содержащих JavaScript и т.д. для программирования межСайтовых сценариев (XSS) с 

целью получения полного административного доступа. 

См. http://docs.moodle.org/25/en/XSS_trusted_users. 

3.5.3.Обзорный отчёт по безопасности 
Проверяет все типы потенциальных проблем безопасности, которые вы можете 

иметь в вашей конфигурации. См. http://docs.moodle.org/25/en/Security_overview_report. 

3.5.4.Политики Сайта 
Настройки, действующие на безопасность и конфиденциальность вашего Сайта. 

См. http://docs.moodle.org/25/en/Site_policies. 

3.5.5.Извещения 
Информация об обновлениях и ошибках входа в Систему. 

См. http://docs.moodle.org/25/en/Notifications. 

3.5.6.Добавление случайных чисел к паролю 
Подробности способа создания безопасных паролей добавлением строки 

случайных символов к паролям перед тем, как они будут включены в хэшированную 

память. См. http://docs.moodle.org/25/en/Password_salting. 

3.5.7.Процедуры безопасности Moodle 
Сообщение о состоянии безопасности. 

См. http://docs.moodle.org/25/en/Moodle_security_procedures. 

3.5.8.Усиление конфиденциальности 
Предложения по изменению настроек, для усиления конфиденциальности 

пользователей. См. http://docs.moodle.org/25/en/Increasing_privacy_in_Moodle. 

3.5.9.Сокращение спама 
Совет по тому, как минимизировать риск спама на вашем Сайте. 

См. http://docs.moodle.org/25/en/Reducing_spam_in_Moodle. 

http://moodle.org/mod/forum/discuss.php?d=199435
http://moodle.org/mod/forum/discuss.php?d=199435
http://docs.moodle.org/25/en/Security_recommendations
http://docs.moodle.org/25/en/XSS_trusted_users
http://docs.moodle.org/25/en/Security_overview_report
http://docs.moodle.org/25/en/Site_policies
http://docs.moodle.org/25/en/Notifications
http://docs.moodle.org/25/en/Password_salting
http://docs.moodle.org/25/en/Moodle_security_procedures
http://docs.moodle.org/25/en/Increasing_privacy_in_Moodle
http://docs.moodle.org/25/en/Reducing_spam_in_Moodle
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3.5.10.See also 
 Security FAQ 

 

3.6.Performance 
3.6.1.Performance recommendations 
Moodle can be made to perform very well, at small usage levels or scaling 

up to many thousands of users. The factors involved in performance are 

basically the same as for any PHP-based database-driven system. When 

trying to optimize your server, try to focus on the factor which will make 

the most difference to the user. For example, if you have relatively more 

users browsing than accessing the database, look to improve the webserver 

performance. 

 

3.6.2.Performance settings 
 

3.6.3.Performance overview 
The performance overview report in Administration > Site administration 

> Reports > Performance overview lists issues which may affect 

performance of the site. 

 

3.6.4.Caching 
A cache is a collection of processed data that is kept on hand and re-used 

in order to avoid costly repeated database queries. 

Moodle 2.4 saw the implementation of MUC, the Moodle Universal 

Cache. This new system allows certain functions of Moodle (eg string 

fetching) take advantage of different installed cache services (eg files, ram, 

memcached). 

In future versions of Moodle we will continue expanding the number of 

Moodle functions that use MUC, which will continue improving 

performance, but you can already start using it to improve your site. 

 

3.6.5.Performance FAQ 
 

 

 

 

 

3.5.10.См. также 
 Часто задаваемые вопросы по безопасности См. 

http://docs.moodle.org/25/en/Security_FAQ. 

3.6.Качество работы 
3.6.1.Рекомендации по работе Системы 

Moodle можно настроить на очень хорошую работу как с набольшим числом 

пользователей, так и со многими тысячами их. Факторы, влияющие на характер работы, в 

основном те же самые, что и для любой Системы управляемой базы данных, основанной 

на PHP. При попытках оптимизации вашего сервера постарайтесь сфокусироваться на 

факторе, который более всего важен для пользователей. Например, если вы имеете больше 

пользователей только просматривающих, чем получивших доступ к работе с базой 

данных, улучшайте соответствующие характеристики веб-сервера. 

См. http://docs.moodle.org/25/en/Performance_recommendations. 

3.6.2.Настройки режима работы 
См. http://docs.moodle.org/25/en/Performance_settings. 

3.6.3.Обзор характеристик режима работы 
Обзорный отчёт по характеристикам работы в AdministrationSite 

administrationReportsPerformance overview перечисляет факторы, которые могут 

влиять на характеристики работы Сайта. 

См. http://docs.moodle.org/25/en/Performance_overview. 

3.6.4.Кэширование 
Кэш – это набор обрабатываемых данных, который многократно используется и 

постоянно хранится под рукой, чтобы избежать дороГостоящих запросов к базе данных. 

Moodle 2.4 заботится о реализации MUC (Moodle Universal Cache – универсальный кэш 

Moodle). Эта новая Система позволяет определённым функциям Moodle (например, 

выбору строк) использовать достоинства различных инсталлированных кэш-сервисов 

(например, файлы, оперативную память, Системы кэширования памяти). 

В будущих версиях Moodle мы продолжим расширение числа функций Moodle, 

которые используют MUC, что ещё больше улучшит характеристики Системы, но вы уже 

можете начать его применение, чтобы улучшить ваш Сайт.  

См. http://docs.moodle.org/25/en/Caching. 

3.6.5.Часто задаваемые вопросы по характеристикам 
работы 

См. http://docs.moodle.org/25/en/Performance_FAQ. 

http://docs.moodle.org/25/en/Security_FAQ
http://docs.moodle.org/25/en/Performance_recommendations
http://docs.moodle.org/25/en/Performance_settings
http://docs.moodle.org/25/en/Performance_overview
http://docs.moodle.org/25/en/Caching
http://docs.moodle.org/25/en/Performance_FAQ
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3.7.Backup 
 

3.7.1.Site backup 
A site backup allows a site administrator to save everything associated 

with a moodle site. These backups can be restored to bring a site back to 

the point in time when the backup was made. 

 

Performing regular backups are highly recommended to reduce the amount 

of lost information in the event of a problem on the site and to speed the 

overall recovery process. 

3.7.2.Course backup 
A course can be saved with some or all of its parts by using the course 

backup. Typically, the site administrator will set a schedule of automated 

course backups for the whole site. A teacher with editing privileges can 

create a backup or download an existing backup for safe keeping, or for 

use on another Moodle site. 

 

 

3.7.3.Course restore 
 

3.7.4.Automated course backup 
A site administrator can configure a schedule for automated course 

backups in Settings > Site administration > > Courses > Backups > 

Automated backup setup. 

Automated course backups runs the same functions as individual course 

backups. It's a good idea to schedule backups for when your server isn't 

usually busy. Running the backup tool over all the courses can be 

processor-intensive, so you shouldn't run it when there are a lot of students 

trying to access the server. You should always alert users with an 

announcement on the first page that if they log on during the backup hours 

they may notice a decrease in performance. 

 

In order to make scheduled backups, you have to set up CRON to run 

periodically. Please refer to the cron instructions. 

 

 

 

 

3.7.Резервное копирование 
См. http://docs.moodle.org/25/en/Backup. 

3.7.1.Резервное копирование Сайта 
Резервное копирование Сайта позволяет Администратору Сайта сохранить всё, 

связанное с Сайтом Moodle. Эти резервные копии могут быть сохранены, чтобы вернуть 

Сайт к тому времени, когда резервное копирование было сделано. 

См. http://docs.moodle.org/25/en/Site_backup. 

Регулярное создание резервных копий весьма рекомендуется для уменьшения 

количества потерянной информации при возникновении проблемы на Сайте и для 

ускорения общего процесса восстановления. 

3.7.2.Резервное копирование Курса 
Некоторые или все части Курса могут быть сохранены путём использования 

Резервной Копии Курса. Обычно, Администратор Сайта составляет график 

автоматического создания Резервных Копий Курсов (п. 3.7.4) для Сайта в целом. 

Преподаватель с привилегиями редактирования может создать Резервную Копию или 

скачать существующую Резервную Копию для сохранения безопасности или для 

использования на другом Сайте Moodle. 

См. http://docs.moodle.org/25/en/Course_backup. 

3.7.3.Восстановление Курса 
См. http://docs.moodle.org/25/en/Course_restore. 

3.7.4.Автоматическое резервное копирование Курсов 
Администратор Сайта может сконфигурировать график для автоматического 

создания Резервных Копий Курсов в AdministrationSite administrationCourses 

BackupsAutomated backup setup. 

Автоматическое создание резервных копий Курсов выполняет же функции, что и 

индивидуальные резервные копирования Курсов. Хорошей идеей является создание 

резервных копий, когда ваш сервер обычно не занят. Запуск инструмента резервного 

копирования для всех Курсов может интенсивно задействовать процессор, так что вам не 

следует запускать его, когда много Студентов пытаются получить доступ к серверу. Вы 

должны всегда предупреждать пользователей объявлением на первой странице, что если 

они войдут вСистему в время резервного копирования, они могут заметить снижение 

характеристик. 

Для того, чтобы запланировать резервные копирования, вам нужно установить 

CRON запускаться периодически. Пожалуйста, обратитесь к инструкциям по CRON (п. 

2.3). См. http://docs.moodle.org/25/en/Automated_course_backup. 

http://docs.moodle.org/25/en/Backup
http://docs.moodle.org/25/en/Site_backup
http://docs.moodle.org/25/en/Course_backup
http://docs.moodle.org/25/en/Course_restore
http://docs.moodle.org/25/en/Automated_course_backup
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3.7.5.Year-end procedures 
Where Moodle is used in an academic environment, such as a school or 

university, it is useful to have procedures in place for removing students 

and teachers who have left and moving current students "up" a year while 

ensuring all essential work is preserved. While we talk about "year end 

procedures", the approach of preparing for the next intake of students for 

one or more courses may have nothing to do with a year-end. Some 

organisations might run two-week online courses every month; others 

might complete a qualification each term/semester, while yet others might 

have a self-paced, rolling programme with enrolment at any time. 

 

Below are some suggested procedures and aspects to be taken into 

consideration. (Thanks to Gavin Henrick whose End of Year rollover blog 

post provided much of the content below.) 

 

3.7.6.IMS Common Cartridge import and 
export 
 

3.7.7.Backup and restore FAQ 
 
 

3.8.Site appearance 
There are many ways to customise the appearance of your Moodle site so 

that it blends in with, for example, your college site or your company's 

corporate brand. The links below provide more information on 

personalising the appearance of Moodle: 

 Front page - how best to display the entry page to your Moodle. 

 My home - a personalised "dashboard" page for each user 

 

 User profiles 

 Navigation - control how users find their way around Moodle 

 Course list - control who appears in the list of courses 

 Themes - change the "skin" of your Moodle for the whole site or just 

sections. 

 Header and footer - add information to the top and bottom areas of your 

Moodle. 

 

3.7.5.Процедуры конца года 
Поскольку Moodle используется в академической среде, такой как школа или 

университет, полезно иметь в наличии процедуры для удаления Студентов и 

Преподавателей, которые покинули учебное заведение, и перемещения текущих 

Студентов на следующий год, с гарантией того, что вся существенная работа сохраняется. 

Хотя мы говорим о «процедурах конца года», процесс подготовки следующего набора 

Студентов для одного или более Курсов, может выполняться не в конце года. Некоторые 

организации могут запускать двухнедельные онлайн Курсы каждый месяц; другие могут 

выполнять оценивание каждую сессию/семестр, а некоторые могут предоставить 

обучающимся самостоятельный выбор скорости изучения материала, скользящую 

программу с зачислением в любое время. 

Ниже приведены некоторые предполагаемые процедуры и аспекты, которые нужно 

рассмотреть. (Благодарим Гейвина Хенрика, чья Корреспонденция Блога Прокрутки 

Конца Года обеспечила многое из приведённого ниже содержания.) 

См. http://docs.moodle.org/25/en/Year-end_procedures. 

3.7.6.Импорт и экспорт общего картриджа IMS 
 

См. http://docs.moodle.org/25/en/IMS_Common_Cartridge_import_and_export. 

3.7.7.Часто задаваемые вопросы по резервному 
копированию и восстановлению 

См. http://docs.moodle.org/25/en/Backup_and_restore_FAQ. 

3.8.Внешний вид Сайта 
Существует много способов настроить внешний вид вашего Сайта Moodle под 

клиента так, что он будет гармонировать, например, с Сайтом вашего колледжа или 

корпоративным брендом вашей компании. Ссылки ниже предоставляют больше 

информации о персонализации внешнего вида вашей Moodle: 

 Front page (главная страница) – как лучше отобразить входную страницу в вашу 

Moodle. 

 My home (домашняя страница) – персонализированная страница «инструментальной 

панели» для каждого пользователя. 

 User profiles (профили пользователей). 

 Navigation (навигация) – управление тем, как пользователи находят свой путь в Moodle. 

 Course list (перечень курсов) – управление тем, кто появляется в перечне Курсов. 

 Themes (темы фоновой картинки) – изменяет «фоновую картинку» вашей Moodle для 

всего Сайта или только разделов. 

 Header and footer (верхний и нижний колонтитулы) – добавляет информацию в 

верхнюю и нижнюю области вашей Moodle. 

http://www.somerandomthoughts.com/blog/2012/09/14/end-of-year-rollover/
http://www.somerandomthoughts.com/blog/2012/09/14/end-of-year-rollover/
http://docs.moodle.org/25/en/Year-end_procedures
http://docs.moodle.org/25/en/IMS_Common_Cartridge_import_and_export
http://docs.moodle.org/25/en/Backup_and_restore_FAQ
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3.9.Language 
Language settings - including the default language for the site 

Language customization - for changing any word or phrase (in any 

language) used in Moodle 

Language packs - for making the Moodle interface available in other 

languages 

Translation - for anyone interested in helping translate Moodle 

 

 

3.10.Server settings 
 

3.11.Site-wide reports 
 

3.12.Admin tools 
 

3.12.1.What kind of technical skills do I 
need to take on Moodle Administration? 
Reading and writing are handy skills, and probably the most useful. This is 

something of a loaded question, and the answer is actually, depends on 

what you want to do, and what skills you already have. 

Do you have any HTML, CSS and PHP skills? Do you have any SQL 

database skills. If you do, then you have a good start, if you do not, then do 

not worry about it. If you need them, you will pick these skills up as you 

go, and if you already have any programming skills, it is going to be fairly 

easy to do so. If you have never done any programming before, it is a little 

more difficult, but once you have the idea, it becomes a lot easier. Unless 

you intend on developing your Moodle, e.g. build your own home made 

theme, alter code to reflect your own organization, then you can get away 

without any of these skills. What you need is a way of developing a quick 

understanding of how Moodle works. With the introduction of Moodle v2, 

the learning curve has steepened somewhat, but it is still not that difficult. 

 

Installing and setting up a new Moodle is not as difficult as it used to be. 

Some servers and service providers do have problems, from time to time, 

but if you work with your ISP, and 

 

 

См. http://docs.moodle.org/25/en/Site_appearance. 

3.9.Язык 
Language settings (настройки языка) – включение языка по умолчанию для Сайта. 

Language customization (настройка языка, привычного клиенту) – для изменения 

любого слова или фразы (в любом языке), используемых в Moodle. 

Language packs (языковые пакеты) – для создания интерфейса Moodle, доступного 

в других языках. 

Translation (перевод) – для каждого заинтересованного в помощи по переводу 

Moodle. 

См. http://docs.moodle.org/25/en/Language. 

3.10.Настройки сервера 
См. http://docs.moodle.org/25/en/Server_settings. 

3.11.Отчёты по всему Сайту 
См. http://docs.moodle.org/25/en/Site-wide_reports. 

3.12.Инструментарий Администратора 
См. http://docs.moodle.org/25/en/Admin_tools. 

3.12.1.Какие технические навыки мне нужны, чтобы 
стать администратором Moodle? 

Пожалуй, наиболее полезны навыки чтения и письма. А вообще-то ответ на этот 

вопрос зависит от того, что вы намерены делать, и какие навыки вы уже имеете. 

 

Имеете ли вы какие-нибудь навыки работы с HTML, CSS и PHP? Имеете вы какие-

нибудь навыки работы с SQL базами данных? Если имеете, тогда вы хорошо стартуете, 

если нет, не беспокойтесь об этом. Если они вам потребуются, вы приобретёте эти навыки 

в ходе работы, а если вы уже имеете какие-нибудь навыки в программировании, то это 

произойдёт достаточно быстро. Если вы никогда прежде не имели дела ни с каким 

программированием, то это будет немного труднее, но как только вы поймёте идею, всё 

станет намного легче. Если вы не собираетесь развивать ваш Moodle, например, построить 

свою собственную домашнюю тему фоновой картинки, ввести код, чтобы отразить вашу 

организацию, тогда вы обойдётесь и без этих навыков. Что вам необходимо, так это 

выработать свой собственный способ быстрого понимания, как работает Moodle. С 

внедрением Moodle версии 2 линия обучения стала немного круче, но всё же не намного 

труднее. 

Инсталляция и настройка новой Moodle не так трудны, как раньше. Некоторые 

поставщики серверов и сервисов время от времени имеют проблемы, но если вы работаете 

в вашим интегрированным пакетом прикладных программ (ISP) и 

http://docs.moodle.org/25/en/Site_appearance
http://docs.moodle.org/25/en/Language
http://docs.moodle.org/25/en/Server_settings
http://docs.moodle.org/25/en/Site-wide_reports
http://docs.moodle.org/25/en/Admin_tools
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 the Moodle Community, you will get your Moodle up and running. Once 

it is going, start looking at it. You won't break anything, unless you start 

deleting things. Your best bet would be to read the documents. Look at the 

page you are working on. Somewhere on that page is a link that points to 

"Moodle Docs for this page". That is your best, most readily available, 

clues on how to do things. Once familiar with the environment, and how to 

get around it, how to get information on it, then the major steps have been 

taken, the rest is a continual refinement of that. 

Tip: As a newbie Administrator, it is easy to get overwhelmed with all the 

different things available, useful plugins and extra blocks and so on, but 

the majority of those things are third-party made, not Moodle.org in origin. 

Be aware that, as a general rule of thumb, the further you move away from 

the standard Moodle, the greater your risks of things going wrong. This 

does not mean the plugins are badly written, and some are really handy, 

just sometimes things go wrong. If you are going to use them, be deliberate 

in your choice, do not use them just because it might be a good idea. 

 

Perhaps the best thing is that you create a Moodle on your desktop, or 

laptop, and you use that as a testbed. It should be the same version as your 

production site, to make things easy. Try things there first, if there is no 

problems, then you can replicate it on your production site. 

 

3.13.Developer tools 
 

3.14.Web services 
 

3.15. Moodle for mobile 
Moodle can be used on a mobile device by downloading a native app, such 

as the official Moodle Mobile app. 

 

 

 

 

 

 

 

 

 

 

сообществом Moodle, вы получите и запустите в работу вашу Moodle. После запуска 

начните присматриваться к ней. Вы ничего не разрушите, если только не начнёте что-

нибудь удалять. Лучше всего начать с чтения документов.  Внимательно изучите 

страницу, с которой работаете. Где-нибудь на этой странице есть ссылка «Moodle Docs for 

this page (документация Moodle для этой страницы)». Это лучшие, наиболее легко 

доступные подсказки по тому, как действовать. После знакомства со средой и способами 

её посещения и получения информации о ней, можно предпринимать главные шаги, а 

дальше остаётся постоянно совершенствоваться в работе с ней. 

Совет: Как новичку Администратору легко получить шок от обилия 

разнообразных доступных вещей, полезных плагинов, дополнительных блоков и т.д., но 

большинство из этих вещей сделано независимыми разработчиками, не Moodle.org 

источник. Будьте уверены, что общим железным правилом является то, что чем дальше вы 

уходите от стандартной Moodle, тем больше риска сделать что-то неправильно. Это не 

означает, что каждый из плагинов написан плохо, и некоторые из них, действительно, 

весьма хороши, но иногда что-то идёт не так. Если вы собираетесь использовать их, 

хорошенько обдумайте ваш выбор, не используйте их только потому, что это неплохая 

идея. 

Возможно, лучшим будет то, что вы создадите Moodle на вашем настольном 

компьютере или портативном компьютере, и будете использовать её как 

экспериментальную Систему. Ради удобства, та же самая версия должна быть установлена 

на вашем рабочем Сайте. Всё старайтесь попробовать сначала у себя, и только, если 

проблем не возникло, повторите их на производственном Сайте. 

3.13.Инструментарий разработчика 
См. http://docs.moodle.org/25/en/Developer_tools. 

3.14.Веб-сервисы 
См. http://docs.moodle.org/25/en/Web_services. 

3.15.Moodle для мобильных устройств 
Moodle может быть использована на мобильных устройствах путём загрузки 

«родных» приложений, таких как официальное мобильное приложение Moodle (Moodle 

Mobile). 

http://docs.moodle.org/25/en/Developer_tools
http://docs.moodle.org/25/en/Web_services
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See Mobile Moodle FAQ for links to more mobile apps. 

 
An administrator can also set a theme for mobile devices in Settings > Site 

administration > Appearance > Themes > Theme selector. The MyMobile 

theme is especially designed for mobile devices. The Simple theme is multi 

device optimized. The Standard fluid theme is a good start if you like to 

code your own responsive web design theme in Moodle, or if you use the 

'standard' theme and would like to make it ready for smartphones and 

tablets. 

3.16.Community hubs 
A community hub provides a directory of courses for public use or for 

private communities. 

 

3.17.More features 
3.17.1.Blogs 
 

3.17.2.Comments 
 

3.17.3.Tags 
 

3.17.4.Messaging 
 

3.17.5.Notes 
 

3.17.6.RSS feeds 
 

3.17.7.Calendar 
 

 

 

 

 

 

 

 

 

См. ссылки на «Часто задаваемые вопросы по мобильным приложениям», о 

дополнительных моюильных приложениях. 

Администратор может также ознакомиться с темой мобильных устройств в 

SettingsSite administrationAppearanceThemesTheme selector. Тема MyMobile 

специально разработана для мобильных устройств. Тема Simple оптимизирована для 

многих устройств. Тема https://moodle.org/plugins/view.php?plugin=theme_standard_fluid 

хороша для тех, кто предпочитает самостоятельно кодировать свои собственные чутко 

реагирующие темы веб-дизайна в Moodle, или если вы используете «стандартную» тему и 

предпочитаете сделать её для смартфонов и планшетов. 

3.16.Социальные хабы 
Социальный хаб предоставляет оглавление курсов для публичного использования 

или для личных коммуникаций. 

См. http://docs.moodle.org/25/en/Community_hubs. 

3.17.Дополнительные средства 
3.17.1.Блоги 
http://docs.moodle.org/25/en/Blogs, 

3.17.2.Комментарии 
http://docs.moodle.org/25/en/Comments, 

3.17.3.Теги 
http://docs.moodle.org/25/en/Tags, 

3.17.4.Обмен сообщениями 
http://docs.moodle.org/25/en/Messaging, 

3.17.5.Заметки 
http://docs.moodle.org/25/en/Notes, 

3.17.6.Рассылка RSS 
http://docs.moodle.org/25/en/RSS_feeds, 

3.17.7.Календарь 
http://docs.moodle.org/25/en/Calendar. 

http://docs.moodle.org/25/en/Mobile_Moodle_FAQ
http://docs.moodle.org/25/en/MyMobile_theme
https://moodle.org/plugins/view.php?plugin=theme_simple
https://moodle.org/plugins/view.php?plugin=theme_standard_fluid
http://docs.moodle.org/25/en/Community_hubs
http://docs.moodle.org/25/en/Blogs
http://docs.moodle.org/25/en/Comments
http://docs.moodle.org/25/en/Tags
http://docs.moodle.org/25/en/Messaging
http://docs.moodle.org/25/en/Notes
http://docs.moodle.org/25/en/RSS_feeds
http://docs.moodle.org/25/en/Calendar
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Полное оглавление 
3.Управление Сайтом Moodle 

3.1.Аутентификация 
3.1.1.Плагины Аутентификации 

3.1.1.1.Учётные записи, созданные вручную 
3.1.1.2.Не пускать в Систему 

3.1.1.2.1.См. также 
3.1.1.3.Саморегистрация по э-почте 

3.1.1.3.1.Разрешение саморегистрации по э-почте 
3.1.1.3.2.Разрешить тест CAPTCHA 
3.1.1.3.3.Контакт поддержки 
3.1.1.3.4.См. также 

3.1.2.Управление аутентификацией 

3.1.2.1.Установка метода(ов) аутентификации 
3.1.2.2.Общие настройки аутентификации 

3.1.2.2.1.Саморегистрация 
3.1.2.2.2.Кнопка входа в Систему Гостя 
3.1.2.2.3.Альтернативный URL для входа в Систему 
3.1.2.2.4.URL забытого пароля 
3.1.2.2.5.Инструкции 
3.1.2.2.6.Разрешённые и запрещённые домены э-почты 
3.1.2.2.7.Ограничить домены при изменении э-почты 
3.1.2.2.8.Относительно CAPTCHA 

3.1.2.3.Отображение и блокирование данных полей Профиля 
3.2.Управление учётными записями 

3.2.1.Просмотреть список пользователей 

3.2.1.1.Обзор 
3.2.1.1.1.Сортировка таблицы 
3.2.1.1.2.Фильтры 

3.2.1.2.См. также 
3.2.2.Действия с массовым пользователем 

3.2.2.1.Чтобы выполнить действие с массовым пользователем 
3.2.3.Добавить нового пользователя 

3.2.3.1.Общие настройки 
3.2.3.1.1.Идентифицирующее имя пользователя 
3.2.3.1.2.Метод аутентификации 
3.2.3.1.3.Приостановленная учётная запись 
3.2.3.1.4.Пароль 
3.2.3.1.5.Имя 
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3.2.3.1.6.Фамилия 
3.2.3.1.7.Адрес э-почты 
3.2.3.1.8.Отображение э-почты 
3.2.3.1.9.Формат э-почты 
3.2.3.1.10.Тип почтового дайджеста 
3.2.3.1.11.Автоподписка на Форумы 
3.2.3.1.12.Отслеживание Форума 
3.2.3.1.13.При редактировании текста 
3.2.3.1.14.Читатель экрана 
3.2.3.1.15.Город/посёлок 
3.2.3.1.16.Страна 
3.2.3.1.17.Временная зона 
3.2.3.1.18.Предпочитаемый язык 
3.2.3.1.19.Описание 

3.2.3.2.Портрет пользователя 
3.2.3.3.Интересы 
3.2.3.4.По выбору 

3.2.4.Загрузить пользователей 

3.2.4.1.Процесс загрузки пользователя 
3.2.4.2.Предварительный просмотр обновления пользователей 

3.2.4.2.1.Обновление существующих учётных записей 
3.2.4.2.2.Дополнительные опции 
3.2.4.2.3.Установить значения пользователя по умолчанию 

3.2.4.3.Результаты пересылки пользователей 
3.2.4.4.File formats for upload users file 

3.2.4.4.1.Действительный файл пересылки для тестирования 
3.2.4.4.2.Поля, которые могут быть включены 

3.2.4.5.Продвинутые возможности пересылки пользователя 
3.2.4.5.1.Шаблоны 
3.2.4.5.2.Удаление учётных записей 

3.2.4.6.Формат кодировки файла 
3.2.4.7.Советы 

3.2.4.7.1.Электронная таблица 
3.2.4.7.2.Страна 
3.2.4.7.3.Ограничения размера поля 
3.2.4.7.4.Все поля перечислены здесь 

3.2.4.8.См. также 
3.2.5.Изображения пользователей 

3.2.5.1.Изображения пользователей 
3.2.5.2.Просмотр изображений всех пользователей 
3.2.5.3.Обновление изображений пользователей 
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3.2.5.4.Загрузка изображений пользователей оптом 
3.2.5.5.Граватары 
3.2.5.6.См. также 

3.2.6.Поля Профиля Пользователя 

3.2.6.1.Обзор 
3.2.6.2.Общие настройки 
3.2.6.3.Специфические настройки 
3.2.6.4.Примеры использования 

3.2.6.4.1.Домашняя Система 
3.2.6.4.2.Американские штаты 

3.2.6.5.См.также 
3.2.7.Часто задаваемые вопросы по учётным записям 

3.2.7.1.Как подписать моих Студентов на мой Сайт Moodle 
3.2.7.2.Как приостановить действие учётных записей пользователей? 
3.2.7.3.Может Moodle автоматически послать извещение по э-почте новому пользователю, когда для него создана учётная запись? 
3.2.7.4.Как я могут зарегистрировать другого пользователя? 
3.2.7.5.Как помешать пользователям редактировать элементы их Профиля? 
3.2.7.6.Окошко поиска пользователей ограничено 100 отображаемыми пользователями. Можно это изменить? 

3.3.Зачисления на Курсы 

3.3.1.Плагины зачислений 

3.3.1.1.Установка метода(ов) зачисления 
3.3.1.2.Возможности зачислений 

3.3.1.2.1.Зачисления по Категориям 
3.3.1.2.2.Синхронизация Когорты 
3.3.1.2.3.Доступ Гостя 
3.3.1.2.4.LDAP-зачисления 
3.3.1.2.5.Зачисления вручную: 
3.3.1.2.6.Ссылка на мета-Курс 
3.3.1.2.7.Оплата Курса онлайн по PayPal 
3.3.1.2.8.СамоЗачисление 
3.3.1.2.9.Курс 

3.3.1.3.См. также 
3.3.2.Зачисление вручную 

3.3.2.1.Настройки Курса 
3.3.2.1.1.Проверка того, есть ли у вас на Курсе зачисление вручную 
3.3.2.1.2.Редактирование настроек зачисления вручную 

3.3.2.2.Зачисление пользователей 
3.3.2.2.1.Метод 1 
3.3.2.2.2.Метод 2 
3.3.2.2.3.Редактирование индивидуальных дат начала и конца зачисления 

3.3.2.3.Настройки Администратора 
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3.3.2.4.Возможности зачисления вручную 
3.3.2.4.1.Изменить установки экземпляров зачисления вручную 
3.3.2.4.2.Зачислить пользователей 
3.3.2.4.3.Управлять зачислениями пользователей 
3.3.2.4.4.Отчислить пользователей с Курса 
3.3.2.4.5.Отчислить себя самого с Курса 

3.3.3.СамоЗачисление 

3.3.3.1.Настройки Курса для самоЗачисления 
3.3.3.1.1.Проверка, разрешено ли самоЗачисление 
3.3.3.1.2.Добавление Ключа Зачисления в Курс 
3.3.3.1.3. Добавление Ключа Зачисления Группы в Курс 
3.3.3.1.4.Настройка периода зачисления 
3.3.3.1.5.Продолжительность зачисления 
3.3.3.1.6.Извещение пользователей, когда оканчивается зачисление 
3.3.3.1.7.Отчисление Студентов, которые не были активными на Курсе 
3.3.3.1.8.Решение о максимальном числе Студентов на вашем Курсе 
3.3.3.1.9.Разрешение самозачисляться только членам Когорты 
3.3.3.1.10.Отправка приветственного сообщения новым пользователям 

3.3.3.2.Настройки Администратора 
3.3.3.2.1.Совместные настройки для всех Курсов 
3.3.3.2.2.Настройки по умолчанию зачислений на новые Курсы 

3.3.3.3.Опции метода самоЗачисления 
3.3.3.4.Возможности самоЗачисления 

3.3.3.4.1.Конфигурировать экземпляры Плагинов СамоЗачислений 
3.3.3.4.2.Управлять зачисленными пользователями 
3.3.3.4.3.Отчисление пользователей с Курса 
3.3.3.4.4.Самоотчисление с Курса 

3.3.4.Синхронизация Когорты 

3.3.4.1.Зачисление Когорты в Курс 
3.3.4.2.Добавление Когорты в Группу 
3.3.4.3.Зачисление Когорты в Категорию 
3.3.4.4.См. также 

3.3.5.Ссылка на мета-Курс 

3.3.5.1.Примеры мета-Курсов 
3.3.5.2.Настройки Курса для ссылки на мета-Курс 
3.3.5.3.Настройки Сайта для ссылки на мета-Курс 
3.3.5.4.Возможности ссылки на мета-Курс 

3.3.5.4.1.Конфигурировать экземпляры мета-зачислений 
3.3.5.4.2.Выбрать Курс в качестве мета-связанного 

3.3.5.5.Разрешение Преподавателям добавлять мета-ссылки 
3.3.5.6.See also 
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3.3.6.Доступ Гостя 

3.3.6.1.Настройки Курса для доступа Гостя 
3.3.6.2.Настройки Администратора для доступа Гостя 

3.3.6.2.1.Настройки по умолчанию для доступа Гостя 
3.3.6.2.2.Авто-вход в Систему Гостей 

3.3.6.3.См. также 
3.3.7.Зачисления в Категорию 

3.3.7.1.Настройки для зачисления в Категорию 
3.3.7.2.Настройки для зачисления в Категорию 

3.3.7.2.1.Настройки для зачисления в Категорию 
3.3.8.Зачисление из внешней базы данных 

3.3.9.Плоский файл 

3.3.10.По стандарту IMS Enterprise 

3.3.11.LDAP-Зачисление 

3.3.12.Удалённые зачисления по MNet 

3.3.13.Зачисления с оплатой по Paypal 

3.4.Роли и Полномочия 

3.4.1.Управление Ролями 

3.4.1.1.Управлять Ролями 
3.4.1.2.Локализация названия Роли 
3.4.1.3.Возврат Роли в исходное состояние 
3.4.1.4.Разрешить назначения Ролей 

3.4.1.4.1.Разрешение Преподавателям назначать других Преподавателей 
3.4.1.5.Разрешить замены Ролей 
3.4.1.6.Разрешить переключения Ролей 
3.4.1.7.Возможности Ролей 

3.4.1.7.1.Создавать и управлять Ролями 
3.4.1.7.2.Назначать Роли пользователям 
3.4.1.7.3.Переключать к другим Ролям 

3.4.2.Назначать Роли 

3.4.2.1.Контекст и Роли 
3.4.2.1.1.Контекст Системы 
3.4.2.1.2.Контекст Главной Страницы 
3.4.2.1.3.Контекст Категории Курса 
3.4.2.1.4.Контекст Курса 
3.4.2.1.5.Контекст Блока 
3.4.2.1.6.Контекст модуля Действия 
3.4.2.1.7.Контекст пользователя 

3.4.2.2.Иерархия 
3.4.2.3.Назначение кому-то Роли Администратора Сайта 
3.4.2.4.Скрытые Роли 
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3.4.2.5.Разрешение Преподавателям назначать Роль Преподавателя 
3.4.2.6.Остерегайтесь неразумных назначений 
3.4.2.7.Разнородные назначения 
3.4.2.8.См. также 

3.4.3.Настройки Ролей 

3.4.3.1.Политики пользователей 
3.4.3.1.1.Роли для посетителей 
3.4.3.1.2.Роль для Гостя 
3.4.3.1.3.Запретить доступ на Сайт всем Гостям 
3.4.3.1.4.Роль по умолчанию для всех пользователей 
3.4.3.1.5.Авто-регистрация Гостя 
3.4.3.1.6.Скрыть поля пользователя 
3.4.3.1.7.Установить подлинность пользователя 
3.4.3.1.8.Максимальное число пользователей на страницу 
3.4.3.1.9.Разрешить граватара 
3.4.3.1.10.URL изображения граватара по умолчанию 

3.4.3.2.Назначения неподдерживаемых ролей 
3.4.3.2.1.Можно ли убрать открытый доступ по иконке зелёная стрелочка, которая представляет собой самоЗачисление на Курс? Вообще отключить 

самоЗачисление 
3.4.4.Применение Ролей 

3.4.4.1.Дайте Студенту права модератора Форума 
3.4.4.2.Разрешите Студентам оценивать готовые ответы на Задание 
3.4.4.3.Дайте Студентам права улучшать Записи модуля «База Данных» 
3.4.4.4.Разрешите Студентам приводить в порядок сохранённые сессии Чатов 
3.4.4.5.Создайте архивный Форум 
3.4.4.6.Разрешите Студентам оценивать корреспонденции Форума 
3.4.4.7.Разрешите Студентам отчислять себя с Курса 
3.4.4.8.Скрыть Блок от Гостей 
3.4.4.9.Дать Студенту неограниченное время для завершения Экзаменов на время 
3.4.4.10.Разрешить Студенту создавать Вопросы 
3.4.4.11.Назначить Студенту Роль Редактора Календаря 
3.4.4.12.Предоставить временный доступ «только для чтения» сомнительному Студенту 
3.4.4.13.Предоставить временный доступ приглашённому лектору только в онлайн классе 
3.4.4.14.Разрешить администратору и Преподавателю видеть Участников, но не Студентов 
3.4.4.15.Добавить Оценивающего в Курс 

3.4.5.Стандартные Роли 

3.4.5.1.Администратор Сайта 
3.4.5.2.Менеджер 

3.4.5.2.1.Назначение Роли Менеджера на уровне Сайта 
3.4.5.2.2.Назначение Роли Менеджера на уровне Категорий 

3.4.5.3.Создатель Курса 
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3.4.5.3.1.Создание Курса 

3.4.5.3.2.Удаление Курса 

3.4.5.3.3.Назначение Роли 

3.4.5.3.4.Полномочия Роли 

3.4.5.4.Преподаватель 
3.4.5.4.1.См. также 

3.4.5.5.НеРедактирующий Преподаватель 
3.4.5.6.Студент 
3.4.5.7.Гость 

3.4.5.7.1.Учётная запись Гостя 

3.4.5.7.2.Предоставление доступа Гостю 

3.4.5.7.3.Пропустить страницу регистрации для учётной записи Гостя 

3.4.5.7.4.См. также 

3.4.5.8.Аутентифицированный Пользователь 
3.4.5.9.Роль Аутентифицированного Пользователя на Главной странице 

3.4.6.Создание клиентских Ролей 

3.4.6.1.Создание новой Роли 
3.4.6.2.Архетипы Ролей 
3.4.6.3.Создание дубликата Роли 
3.4.6.4.Рассмотрения новой Роли 
3.4.6.5.Тестирование новой Роли 
3.4.6.6.Возможные клиентские Роли 
3.4.6.7.См. также 

3.4.7.Роль Родителя 

3.4.7.1.Создание новой Роли 
3.4.7.2.Назначение Родителя Студенту 

3.4.7.2.1.Добавление многих Родителей/надзирающих сразу 

3.4.7.2.2.Добавление Блока поднадзорных 

3.4.7.2.3.Как Родитель видит Интерактивные Действия его ребёнка 

3.4.7.3.См. также 
3.4.8.Полномочия 

3.4.8.1.Полномочия Курса и Действия 
3.4.8.2.Полномочия Блока 
3.4.8.3.Проверка Полномочий 
3.4.8.4.Обзорный отчёт по Возможностям 
3.4.8.5.См. также 

3.4.9.Риски 

3.4.9.1.Конфигурация 
3.4.9.2.XSS-уязвимость (межСайтовый скриптинг) 
3.4.9.3.Конфиденциальность 
3.4.9.4.Спам 
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3.4.9.5.Риски для встроенных Ролей 
3.4.9.6.См. также 

3.4.10.См. также 

3.4.10.1.Что есть определение... 
3.4.10.2.Почему изменение моей Роли не имеет эффекта? 
3.4.10.3.Почему некоторые пользователи, о которых я знаю, что они есть в моём Курсе, не появляются в Участниках? 
3.4.10.4.Как можно помешать пользователю изменить его собственный пароль? 
3.4.10.5.Как можно помешать пользователю редактировать свой Профиль? 
3.4.10.6.Как изменить название «Teacher» в описании Курса? 
3.4.10.7.Как позволить Преподавателям проводить переопределения Ролей? 
3.4.10.8.Как позволить Преподавателям назначать других Преподавателей на Курс? 
3.4.10.9.Почему «Переключить Роль на..» внутри Курса не в состоянии работать правильно? 
3.4.10.10.Существуют какие-нибудь примеры Ролей? 
3.4.10.11.Зарегистрированные пользователи не могут читать новости Сайта. Что делать? 
3.4.10.12.Как позволить зарегистрированным пользователям участвовать в действиях на Главной странице? 
3.4.10.13.Как помешать Студентам редактировать их Профиль? 
3.4.10.14.Почему невозможно добавить Студентов или Преподавателей на весь Сайт Moodle? 
3.4.10.15.Как сделать Роль, подходящей на Роль на Главной странице? 
3.4.10.16.Как можно разрешить не редактирующему Преподавателю переключаться на роль Студента? 
3.4.10.17.Как вернуть Роль к Полномочиям по умолчанию? 
3.4.10.18.Полномочия не в состоянии работать правильно. Что делать? 
3.4.10.19.Что такое «никакая» Роль? 
3.4.10.20.См. также 

3.4.11.Переопределить Полномочия 

3.4.11.1.Полномочия 

3.4.11.1.1.Наследовать 

3.4.11.1.2.Позволить 

3.4.11.1.3.Предотвратить 

3.4.11.1.4.Запретить 

3.4.11.2.Разрешение конфликта Полномочий 

3.4.11.2.1.Специальные исключения 

3.4.11.3.Места для переопределения Полномочий 

3.4.11.5.Позволение переопределять Полномочия 

3.4.11.4.Позволение неРедактирующим Преподавателям переопределять безопасные Полномочия 

3.4.11.6.Переопределение Полномочий для выбранных Студентов 

3.4.11.7.См. также 

3.5.Безопасность 

3.5.1.Рекомендации по безопасности 

3.5.2.XSS-надёжные пользователи 

3.5.3.Обзорный отчёт по безопасности 

3.5.4.Политики Сайта 
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3.5.5.Извещения 

3.5.6.Добавление случайных чисел к паролю 

3.5.7.Процедуры безопасности Moodle 

3.5.8.Усиление конфиденциальности 

3.5.9.Сокращение спама 

3.5.10.См. также 

3.6.Качество работы 

3.6.1.Рекомендации по работе Системы 

3.6.2.Настройки режима работы 

3.6.3.Обзор характеристик режима работы 

3.6.4.Кэширование 

3.6.5.Часто задаваемые вопросы по характеристикам работы 

3.7.Резервное копирование 

3.7.1.Резервное копирование Сайта 

3.7.2.Резервное копирование Курса 

3.7.3.Восстановление Курса 

3.7.4.Автоматическое резервное копирование Курсов 

3.7.5.Процедуры конца года 

3.7.6.Импорт и экспорт общего картриджа IMS 

3.7.7.Часто задаваемые вопросы по резервному копированию и восстановлению 

3.8.Внешний вид Сайта 

3.9.Язык 

3.10.Настройки сервера 

3.11.Отчёты по всему Сайту 

3.12.Инструментарий Администратора 

3.12.1.Какие технические навыки мне нужны, чтобы стать администратором Moodle? 

3.13.Инструментарий разработчика 

3.14.Веб-сервисы 

3.15.Moodle для мобильных устройств 

3.16.Социальные хабы 

3.17.Дополнительные средства 

3.17.1.Блоги 

3.17.2.Комментарии 

3.17.3.Теги 

3.17.4.Обмен сообщениями 

3.17.5.Заметки 

3.17.6.Рассылка RSS 

3.17.7.Календарь 
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Центральным понятием системы Moodle является учебный Курс, который Преподаватели готовят средствами Moodle и предлагают 

изучить в среде этой системы. Курс сначала нужно создать. Это делается по запросу либо Администратором Сайта, либо Менеджером 

Курсов, либо Создателем Курсов. 

Только после создания Курса Преподаватели могут добавлять необходимое по учебной программе содержимое в Курс. Чтобы все 

Участники (Студенты, Преподаватели и пр.) могли участвовать в учебном процессе, организуемом внутри Курса, они должны быть 

вначале зарегистрированы в системе Moodle (для них создаётся учётная запись), а затем зачислены на соответствующие Курсы под 

соответствующими Ролями. 

Основная техническая работа в Moodle выполняется с помощью так называемого текстового редактора, известного также как 

редактор HTML. Формат Markdown делает возможным довольно легко набирать хорошо отформатированные страницы XHTML, используя 

только текстовый формат, мало отличающийся от того, каким вы пользуетесь при написании обычного почтового сообщения. Язык 

гипертекстовой разметки позволяет с помощью этого «текстового» редактора вставлять в Курсы Moodle не только текст, веб-страницы, но 

и смайлики, изображения, аудио и видео, математические формулы, уравнений и пр. 

Moodle предлагает великое множество средств по добавлению содержимого в Курсы и работе в них. Все средства делятся на две 

части: Ресурсы и Интерактивные Действия (общее название для тех и других: Действия). Ресурсы – это Файлы, Папки, Ссылки на 

интернет-страницы и пр., с материалом которых должны ознакомиться Студенты. А Интерактивные Действия – это Уроки, Семинары, 

Задания, Форумы, Вики, Экзамены и пр., в которых Студенты должны принять Интерактивное участие, вплоть до оценивания друг друга, 

Преподавателей и их Курсов, обмена Ролями с Преподавателями и т.д. 

Система Moodle предлагает также средства по оформлению страниц, отслеживанию и регулированию внутренней работы Курсов – 

Блоки. Блоки являются информационными элементами, могут быть добавлены слева, справа или в центральную колонку любой страницы 

Moodle. Они также могут добавляться в центр страницы My Home (My Moodle). Блоки могут быть помещены в Док: на боковой край 

экрана, где их не видно (если ваша тематическая фоновая картинка поддерживает это). 

В среде системы Moodle работу со Студентами, распределёнными по группам, позволяет лучше выявлять индивидуальный уровень 

обучения, организовывать соревнования между группами и пр., а также перезачислять сразу всех членов Группы с одного Курса на другой, с текущего 

семестра – на следующий. 

Любой технологии обучения нужны средства отслеживания хода обучения. Очень важно вовремя среагировать на огрехи преподавания, на 

плохую базовую подготовку Студентов, на пропуски занятий и т.д. Moodle предлагает 6 основных средств отслеживания: Оценки, Обусловленные 

Действия, Завершение Действия, Завершение Курса, Символы отличия и, наконец, всевозможные Отчёты по Курсу. 

И, в заключение, несомненным подспорьем преподавателю являются предлагаемые системой Moodle средства повторного использования 

Действий и Курсов, их резервного копирования и восстановления при необходимости. 

 

 Перевод на русский язык  В.А. Тунда, Ф.П. Тарасенко, 2014 
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4.Managing a Moodle course 
A course in Moodle is an area where a teacher will add resources and 

activities for their students to complete. It might be a simple page with 

downloadable documents or it might be a complex set of tasks where 

learning progresses through interaction. Progress can be tracked in a 

number of ways. 

The course page is made up of central sections which contain the tasks and 

(if desired) blocks to the side. The course teacher has control over the 

layout of the course homepage and can change it at any time. 

Students can be enrolled manually by the teacher, automatically by the 

administrator, or they can be allowed to enrol themselves. Students can 

also be added to groups if they need to be separated from classes sharing 

the same course or if tasks need to be differentiated. 

 

4.1.Courses 
How to set up your courses. 

Courses are the spaces on Moodle where teachers add learning materials 

for their students. Courses are created by admins, course creators or 

managers. Teachers can then add the content and re-organise them 

according to their own needs.  

 

4.1.1.Adding a new course 
How to create a new course on your Moodle site. 

By default a regular teacher can't add a new course. To add a new course to 

Moodle you need to have either Adminstrator, Course Creator or Manager 

rights. 

4.1.1.1.Adding a course 
To add a course: 

 Go to Settings>Site Administration>Courses>Add/edit courses 

 Choose the category where you want your course to be. For more 

information see Course categories 

 Click the "Add a new course" button 

 Enter the course settings, then click the "Save changes" button. 

 On the next screen, choose your students/teachers to assign to the 

course. 

 

 

 

4.Управление Курсом Moodle 
Курс в Moodle – это область, куда Преподаватель будет добавлять Ресурсы и 

Интерактивные Действия, необходимые Студентам для использования и исполнения в 

процессе обучения. Это может быть просто Страница с загружаемыми документами, или 

это может быть сложный набор Заданий, когда обучение идёт в интерактивном режиме. 

Ход обучения можно контролировать несколькими способами. 

Страница Курса состоит из Разделов в центральной её части, содержащих задачи, 

и (если нужно) Блоки по сторонам. Преподаватель Курса определяет компоновку 

Домашней Страницы Курса и может изменять её в любое время. 

Студенты могут быть зачислены на Курс вручную Преподавателем, 

автоматически Администратором, или им может быть разрешено зачислять себя 

самостоятельно. Студенты могут быть также распределены по Группам, если класс, 

изучающий данный Курс, нужно разделить, или если в разных Группах надо решать 

разные задачи. 

4.1.Курсы 
Как установить ваши Курсы. 

Курсы – это области в Moodle, куда Преподаватели (п. 3.4.5.4) вкладывают 

обучающие материалы для своих Студентов. Области Курсов создаются 

Администраторами (п. 3.4.5.1), Создателями Курсов (п. 3.4.5.3) или Менеджерами (п. 

3.4.5.2). Преподаватели могут затем вносить туда конкретное содержимое и 

реорганизовывать его в соответствии с его собственными потребностями. 

4.1.1.Добавление нового Курса 
Как создать новый Курс на вашем Сайте Moodle. 

По умолчанию обычный Преподаватель не может добавить новый Курс. Чтобы 

добавить новый Курс в Moodle, вам нужно иметь права или Администратора, или 

Создателя Курсов или Менеджера. 

4.1.1.1.Добавление Курса 
Чтобы добавить Курс: 

 Перейдите в Administration Site Administration>Courses>Add/edit courses. 

 Выберите Категорию, в которую бы вы хотели поместить ваш Курс. Больше 

информации об этом приведено в «Категории Курсов (п. 4.1.2)». 

 Щёлкните кнопку «Add a0 new course (добавить новый курс)». 

 Войдите в «Настройки Курса (п. 4.1.3)», затем щёлкните кнопку «Save changes». 

 На следующем экране выберите ваших  Студентов/Преподавателей, чтобы назначить на 

Курс. 
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4.1.1.2.Deleting a course(s) 
A regular teacher can't delete a course. Administrators and managers (i.e. 

users with a role for which the capability moodle/course:delete is allowed) 

can delete courses. A Course creator can delete courses they have created 

themselves. 

To delete a course (as an administrator or manager): 

 Go to Settings > Site Administration > Courses > Add/edit courses 

 Click the course's category (to drill down the category tree) and find the 

course you wish to delete. Or use the "Search course" textbox at the 

bottom of the category list. 

 Click the "X" icon to the right of the course's name to delete it. 

You can delete multiple courses by: 

 Creating a new (temporary) category. You can name it "To be deleted". 

 

 Select and move the "About to be deleted" courses to that category ("To 

be deleted"). 

 Delete the category ("To be deleted") and choose "Delete ALL - cannot 

be undone". 

There is no user interface for course creators to delete courses they have 

created, however they can do so by editing the URL of the course from 

http://yourmoodlesite.net/course/view.php?id=N to 

http://yourmoodlesite.net/course/delete.php?id=N (replacing 'view' with 

'delete'). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.1.1.2.Удаление Курса(ов) 
Обычный Преподаватель не может удалить Курс. Администраторы и Менеджеры 

(т.е. пользователи с Ролью, для которой разрешена Возможность moodle/course:delete) 

могут удалять Курсы. Создатель Курса может удалить им самим созданные Курсы. 

 

Чтобы удалить Курс (в качестве Администратора или Менеджера): 

 Перейдите в AdministrationSite Administration>Courses>Add/edit courses. 

 Щёлкните по Категории Курса (чтобы проникнуть внутрь дерева Категорий) и отыщите 

тот Курс, который хотите удалить. Или используйте текстовое окошко «Search course 

(отыскать курс)» в самом низу списка Категорий. 

 Щёлкните иконку «Х» с именем нужного Курса, чтобы удалить его. 

Вы можете удалить несколько Курсов сразу путём: 

 Создания новой (временной) Категории. Вы можете назвать её «To be deleted (подлежит 

удалению)». 

 Выбора и перемещения предназначенных к удалению Курсов в Категорию «Подлежит 

удалению». 

 Удаления Категории «To be deleted (подлежит удалению)» и выбора «Delete ALL – 

cannot be undone (удалить всё – не может быть не выполнено)» 

Не существует интерфейса пользователя для Создателей Курсов, чтобы удалять 

Курсы, которые они создали, однако, они могут это сделать путём редактирования URL 

Курса (в поисковой строке своего браузера) с http://ваш Сайт moodle/course/view.php?id=N на 

http://ваш Сайт moodle/course/delete.php?id=N (т.е. замещая «view» на «delete» после входа в 

удаляемый Курс с Ролью Создателя Курсов). 

http://ваш/
http://ваш/
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4.1.1.3.Course requests 
The course request feature can be enabled by an administrator in Settings > 

Site administration > Courses > Course request. 

An admin can set the default category for course requests, whether users 

can select a category when requesting a course, and who can receive 

notification of course requests (from a list of users with the capability 

moodle/site:approvecourse). 

A 'Request a new course' button will then appear on the 'All courses' page. 

The All courses page can be accessed via a link in the Courses block. 

 

If course requests are enabled, by default all authenticated users can make 

course requests. See Course requester role for details of how to restrict 

users who can make course requests. 

 

4.1.1.4.Bulk course creation 
It is not yet possible to create courses in bulk, however this feature is 

coming in Moodle 2.6 (MDL-13114). 

4.1.1.5.See also 
 Using Moodle Hide Courses from some users or students forum 

discussion 

4.1.2.Course categories 
How to organise your courses into a hierarchy suitable for your 

establishment. 

Course categories organize courses for all Moodle site participants. The 

default course category on a new Moodle site is "Miscellaneous" (although 

this can be renamed) A Course creator, Administrator or Manager can put 

all courses in the Miscellaneous category. However, teachers and students 

will find it easier to find their classes if they are organized in descriptive 

categories. 

The list of courses within a category by default shows the teachers and the 

summary of each course. If the number of courses within a category 

exceeds 9 (10 or more), then a short list without teachers and summary is 

shown. 

 

 

 

 

 

 

4.1.1.3.Заявки на создание Курсов 
Средство Заявки на создание Курса может быть включено Администратором в 

AdministrationSite AdministrationCoursesCourses request. 

Администратор может установить Категорию по умолчанию для заявок на 

создание Курсов, либо пользователи могут выбрать Категорию при заявке на создание 

Курса и тех, кто может получить извещение о заяках на создание Курсов (из списка 

пользователей с Возможностью moodle/site:approvecourse). 

Затем на странице «All courses (все курсы)» появится кнопка «Request a new course 

(затребовать новый курс)». На страницу All courses можно попасть по ссылке в Блоке 

Courses. 

Если заявки на создание Курсов включены, по умолчанию все 

Аутентифицированные Пользователи могут подавать заявки на создание Курсов. См. Роль 

запрашивающего создание новых Курсов для получения информации, как ограничить 

пользователей, которые могут сделать заявки на создание Курсов. 

4.1.1.4.Создание Курсов оптом 
Пока невозможно создавать Курсы оптом, однако, это средство придёт в Moodle 

2.6 (MDL-13114). 

4.1.1.5.См. также 
 Обсуждения форума «Скрыть Курсы от некоторых пользователей и Студентов» по 

использованию Moodle. 

4.1.2.Категории Курсов 
Как встроить ваши Курсы в иерархическую систему учебных материалов, 

принятую в вашем учреждении. 

Категории Курсов систематизируют Курсы для вех участников Сайта Moodle. 

Категория Курсов на новом Сайте Moodle по умолчанию называется «Miscellaneous 

(Разное)» (хотя её можно назвать и по-другому). Создатель Курса, Администратор или 

Менеджер могут поместить все Курсы в Категорию Miscellaneous. Однако 

Преподавателям и Студентам будет легче найти свои учебные Курсы, если они 

организованы в описательные Категории. 

Список Курсов внутри Категории показывает по умолчанию Преподавателей и 

аннотацию каждого Курса. Если число Курсов внутри Категории превышает 9 (10 или 

более), тогда показывается краткий список, без имён Преподавателей и аннотаций. 

http://docs.moodle.org/25/en/Course_requester_role
http://docs.moodle.org/25/en/Course_requester_role
https://tracker.moodle.org/browse/MDL-13114
http://moodle.org/mod/forum/discuss.php?d=83830
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4.1.2.1.Adding a category 
Most people organize their courses by department and college or by topic. 

Be sure to test the organizational scheme with a few users before entering a 

large number of courses, to save time in moving them later. 

 

Adding categories is very simple: 

 Go to Settings > Site Administration > Courses > Add/edit courses 

 Click the "Add a new category" button. 

 Type the name of your new category and a description (optional) and 

click the 'Create category' button. 

4.1.2.2.Editing or moving a category 
 You can edit the details of a course category by clicking the edit icon 

next to its name in Settings>Site Administration>Courses>Add/edit 

courses. (1) 

 You can move categories up or down by clicking the up/down arrow 

next to the category you wish to move (2) 

 You can make one category a subcategory of another by selecting from 

the drop down menu "Move category to" (3) 

If the category is visible, the course category description will be displayed 

to users when they enter the category, above the list of courses. 

 

 

4.1.2.3.Adding sub course categories 
 Sometimes it might be useful to have a sub-category of a course. For 

example, you might have a category "Science" and wish to have sub-

categories "Biology", "Chemistry" and "Physics". 

 Course sub-categories may be created by adding a new course category 

then using the "move category to" drop-down menu to move the 

category inside another category. Similarly, sub-sub-categories etc. may 

be created. 

 

 

 

 

 

 

 

 

 

4.1.2.1.Добавление Категории 
Большинство людей организуют свои Курсы по департаментам (кафедрам) и 

колледжам (факультетам), или по тематике. Прежде чем вводить большое число Курсов, 

протестируйте схему организации работы с несколькими пользователями; впоследствии 

это сэкономит время на их перемещения. 

Добавление Категорий дело очень просто: 

 Перейдите в AdministrationSite AdministrationCoursesAdd/edit courses. 

 Щёлкните кнопку «Add a new category(добавить новую категорию)». 

 Наберите имя новой Категории и описание (необязательно) и щёлкните кнопку «Create 

category (создать категорию)». 

4.1.2.2.Редактирование или перемещение Категории 
 Вы можете отредактировать детали Категории Курсов, щёлкнув рядом с её именем 

иконку редактирования в AdministrationSite Administration Courses 

Add/edit courses (1). 

 Вы можете переместить Категорию вверх или вниз щелчком по стрелочке вверх/вниз 

рядом с той Категорией, которую вы хотите переместить (2). 

 Вы можете создать Категорию, как подКатегорию другой, выбором из ниспадающего 

меню «Move category to (переместить категорию в)» (3). 

Если эта Категория видима, описание 

Категории курса будет отображаться 

пользователям над списком Курсов, когда они 

войдут в эту Категорию. 

4.1.2.3.Добавление подКатегорий Курсов 
 Иногда бывает полезно иметь подКатегории Курса. Например, вы можете иметь 

Категорию «Наука» и пожелать иметь подКатегории «Биология», «Химия» и «Физика». 

 

 ПодКатегории Курса могут быть созданы путём добавления новой Категории Курсов 

при использовании ниспадающего меню «Move category to (переместить категорию в)», 

чтобы переместить эту Категорию внутрь другой Категории. Подобным образом могут 

быть созданы под-подКатегории и т.д. 
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 You can also add sub-categories directly in the category you want it in. 

With the editing turned on, enter the course category, and click 'Add a 

sub-category': 

4.1.2.4.Hiding categories 
 Categories may be easily hidden or shown via Settings > Site 

Administration > Courses > Add/edit courses. 

 Click on the eye icon to show or hide a category. Hidden categories are 

only visible to site administrators or those with the capability to "view 

hidden courses". 

4.1.2.5.Setting category depth 
You can limit the number of categories that are displayed in the front page 

'List of Categories' or 'Combo List' by adding the following line to your 

config.php: 

$CFG->max_category_depth = n; 

Where n is the maximum number of categories you wish to display. 

4.1.2.6.Assigning users a role in a course 
category 
To assign users a role in a course category, see Category enrolments. 

 

4.1.2.7.See also 
Using Moodle forum discussions: 

 Course Summary Sometimes Not Appearing 

 Allowing teachers to put courses in categories 

4.1.3.Course settings 
How to control how your course appears to participants. 

A teacher, or other user with the update course settings capability, can 

change course settings in Settings > Course administration > Edit settings. 

 

4.1.3.1.General 
4.1.3.1.1.Course full name 
This is the name of the course. It is displayed as a link on course lists on 

the Front page and on My home and in reports. It is also used in the 

browser title bar when the course is viewed. 

 

 

 

 

 Вы можете также добавить подКатегории непосредственно в нужную вам Категорию. 

Включив режим редактирования, войдите в Категорию Курсов и щёлкните «Add a sub-

category (добавить подкатегорию)» 

4.1.2.4.Сокрытие Категорий 
 Категории могут быть легко скрыты или показаны через AdministrationSite 

AdministrationCoursesAdd/edit courses. 

 Чтобы показать или скрыть Категорию, щёлкните по иконке «глаз». Скрытые 

Категории видны только Администраторам Сайта или тем, у кого есть Возможность 

«View hidden courses (просмотр скрытых курсов)». 

4.1.2.5.Настройка глубины Категорий 
Вы можете ограничить число Категорий, которые отображаются на первой 

странице «List of Categories (список категорий)» или «Combo List (комбинированный 

список)», добавлением следующей строки в ваш config.php: 

$CFGmax_category_depth = n; 

где n есть максимальное число Категорий, которое вы хотите отображать. 

4.1.2.6. Назначение пользователям Роли в Категории 
Курсов 

Чтобы назначить пользователям Роль в Категории Курсов, см. «Category enrolments 

(зачисление в категорию, п. 3.3.7)». 

4.1.2.7.См. также 
Обсуждения на форуме по использованию Moodle: 

 Обзор курса иногда не появляется. 

 Разрешение Преподавателям помещать Курсы в Категории. 

4.1.3.Настройки Курсов 
Как управлять внешним видом вашего Курса для его участников. 

Преподаватель или другой пользователь с Возможностью обновлять настройки 

Курсов может изменить настройки Курса в 

AdministrationCourse administrationEdit settings. 

4.1.3.1.Обычные настройки 
4.1.3.1.1.Полное название Курса 

Это название Курса. Оно отображается как ссылка в списках Курсов, на Главной 

странице, на Домашней Странице и в отчётах. Оно также используется в строке заголовка 

браузера, когда этот Курс просматривается. 

http://moodle.org/mod/forum/discuss.php?d=47954
http://moodle.org/mod/forum/discuss.php?d=102803
http://docs.moodle.org/25/en/Capabilities/moodle/course:update
http://docs.moodle.org/25/en/Capabilities/moodle/course:update
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The capability moodle/course:changefullname controls whether a user can 

edit the course full name. 

4.1.3.1.2.Short name 
Many institutions have a shorthand way of referring to a course, such as 

BP102 or COMMS. Even if you do not already have such a name for your 

course, make one up here. It will be used in several places where the long 

name is not appropriate, such as the Navigation block. 

The capability moodle/course:changeshortname controls whether a user 

can edit the short name field. 

By default, only course full names are displayed in the list of courses. 

However an administrator can enable short names to be displayed too if 

required by ticking the checkbox in Settings > Site administration > 

Appearance > Courses. 

4.1.3.1.3.Course category 
The site administrator may have created course categories to help teachers 

and students find their courses easily. Course categories may be reflected 

in the Navigation block. 

The capability moodle/course:changecategory controls whether a user can 

edit the course category. 

4.1.3.1.4.Course start date 
This setting affects the display of logs and the weekly format topic dates. 

 

If you use the "Weekly" course format, the start date will appear in the first 

section of the course. For example selecting 27 July, will display "27 July - 

2 August" in the first section (when default display is selected for that 

section). 

This setting will have an effect on the display of logs. This will be the 

earliest possible date the log activity will display. 

 

 

 

 

 

 

 

 

 

 

 

Возможность moodle/course:changefullname управляет тем, может ли пользователь 

редактировать полное название Курса. 

4.1.3.1.2.Краткое название 
Многие организации имеют условное обозначение способа ссылки на Курс, такое 

как BP102 или COMMS. Если вы ещё не имеете такого имени для вашего Курса, создайте 

его здесь. Оно будет использовано в различных местах, где длинное название не подходит, 

в таких как «Блок Навигации». 

Возможность moodle/course:changeshortname управляет тем, может ли пользователь 

редактировать краткое название Курса. 

По умолчанию только полные имена Курсов отображаются в списке Курсов. 

Однако если потребуется, Администратор может позволить отображать и краткие имена 

тоже, пометив соответствующее окошко-флажок в 

AdministrationSite administrationAppearanceCourses. 

4.1.3.1.3.Категория Курсов 
Администратор Сайта может иметь созданные Категории Курсов, чтобы помочь 

Преподавателям и Студентам легко находить их курсы. Категории Курсов могут быть 

отображены в Блоке Навигации (п. 4.5.27). 

Возможность moodle/course:changecategory управляет тем, может ли пользователь 

редактировать Категорию Курса. 

4.1.3.1.4.Дата начала Курса 
Эта настройка влияет на отображение дат записей регистраций и Тем недельного 

формата. 

Если вы используете формат Курса «Еженедельный», дата начала появится в 

первом Разделе Курса. Например, выбор даты начала 27 июля отобразится как «27 июля –

 2 августа» в первом Разделе (когда отображение по умолчанию выбирается для этого 

Раздела). 

Эта настройка повлияет на отображение записей регистрации. Эта дата будет 

самой ранней возможной датой отображения записи регистрации 

Интерактивного Действия. 

http://docs.moodle.org/25/en/Capabilities/moodle/course:changefullname
http://docs.moodle.org/25/en/Capabilities/moodle/course:changeshortname
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This setting will not affect courses using the 'social' or 'topics' formats. 

 

TIP: If your institution runs on a weekly schedule, you may want to 

consider setting the start date for courses on the first day of the week, like a 

Monday. 

TIP: In general, if your course does not have a real starting date then set 

the date to yesterday and use the availability setting to reveal the course to 

students. 

TIP: See self enrolment course settings to prevent students from entering 

the course before a certain date/time. 

4.1.3.1.5.Visible 
Here you can "hide" your course completely. It will not appear on any 

course listings, except for managers, course creators, teachers and any 

other users with the view hidden courses capability. Even if students try to 

access the course URL directly, they will not be allowed to enter. 

4.1.3.1.6.Course ID number 
The ID number is an alphanumeric field. It has several potential uses. 

Generally, it is not displayed to students. However, it can be used to match 

this course against an external system's ID, as your course catalogue ID or 

can be used in the certificate module as a printed field. 

The capability moodle/course:changeidnumber controls whether a user can 

edit the ID number. 

4.1.3.2.Description 
4.1.3.2.1.Course summary 
The summary appears on the course listings page. This field is searched 

when searching for a course and also appears in the Course/Site description 

block. 

The capability moodle/course:changesummary controls whether a user can 

edit the course summary. 

4.1.3.2.2.Course summary files 
An image (and if allowed by the administrator, other file types) may be 

attached to the course summary. They will be accessible 

by anyone from outside of the course just like the course name and/or 

summary. Only users with permission moodle/course:changesummary are 

able to upload/change course summary files. Note that if this is not allowed 

by the administrator, then no box will appear to upload course summary 

files. 

 

 

Эта настройка не влияет на Курсы, использующие форматы «Социальный» или 

«Тематический». 

Совет: Если ваша организация осуществляет еженедельное планирование, вы 

можете захотеть рассмотреть настройку даты начала для Курсов на первый день недели, 

понедельник. 

Совет: В общем, если ваш Курс не имеет реальной даты начала, тогда установите 

дату на «вчера» и используйте настройку доступности, чтобы открыть этот Курс 

Студентам. 

Совет: Просмотрите настройки Курса по самозачислению, чтобы помешать 

Студентам войти в Курс до определённой даты/времени. 

4.1.3.1.5.Видимый 
Здесь вы можете «скрыть» ваш Курс полностью. Он не появится в любых 

листингах Курсов, кроме тех, что для Менеджеров, Создателей Курсов, Преподавателей и 

любых других пользователей с Возможностью просмотра скрытых Курсов. Даже если 

Студенты постараются попасть на Курс прямо по URL, им не будет разрешено войти. 

4.1.3.1.6.ID-номер Курса 
ID-номер – это буквенно-цифровое поле. Он имеет несколько потенциальных 

применений. Обычно он не отображается Студентам. Однако он может быть использован 

для согласования этого Курса с ID внешних систем, как ID каталога ваших Курсов или 

может быть использован модулем сертификации в качестве распечатываемого поля. 

Возможность moodle/course:changeidnumber управляет тем, может ли пользователь 

редактировать ID-номер. 

4.1.3.2.Описание 
4.1.3.2.1.Краткое изложение Курса 

Краткое изложение появляется на странице распечаток Курса. Это поле 

просматривается при поиске Курса и также появляется в Блоке Описания Курса/Сайта». 

Возможность moodle/course:changesummary управляет тем, может ли пользователь 

редактировать краткое изложение Курса. 

 

4.1.3.2.2.Файлы с кратким изложением Курса 
Изображение (и, если позволено Администратором, другие типы файлов) может 

быть присоединено к краткому изложению Курса. Оно станет доступно любому вне Курса 

точно так же, как и название Курса и/или краткое изложение. Только пользователи с 

Возможностью moodle/course:changesummary способны переслать/изменить файлы с 

кратким изложением Курса. Заметьте, что, если эти файлы не разрешены 

Администратором, то и не появится окошко для пересылки файлов с кратким изложением 

Курса. 

http://docs.moodle.org/25/en/Capabilities/moodle/course:changeidnumber
http://docs.moodle.org/25/en/Capabilities/moodle/course:changesummary
http://docs.moodle.org/25/en/Capabilities/moodle/course:changesummary
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4.1.3.3.Course format 
4.1.3.3.1.Format 
See Course formats. 

4.1.3.3.2.Number of sections 
This setting is only used by the 'weekly' and 'topics' course formats. In the 

'weekly' format, it specifies the number of weeks that the course will run 

for, starting from the course starting date. In the 'topics' format, it specifies 

the number of topics in the course. Both of these translate to the number of 

"boxes" down the middle of the course page. 

If the number of weeks/topics is changed for an existing course so that the 

number is less than the number of course sections containing activities (for 

example the course contains activities in 3 sections and the number or 

weeks/topics is set to 2) then when editing is turned on section(s) at the 

bottom of the course page will be shown with the title 'Orphaned activities'. 

The number of weeks/topics may be set to 0, so that only the top general 

section is displayed on the course page and there are no numbered sections. 

 

By default, the maximum number of weeks/topics is 52, but an 

administrator can set a different maximum number which will apply to all 

courses on the site (see below). 

4.1.3.3.3.Hidden sections 
This option allows you to decide how the hidden sections in your course 

are displayed to students. By default, a small area is shown (in collapsed 

form, usually grey) to indicate where the hidden section is, though they 

still cannot actually see the hidden activities and texts. This is particularly 

useful in the Weekly format, so that non-class weeks are clear, or if you 

have quizzes you don't want your students to see. 

TIP: If you choose, these non-available items can be completely hidden, so 

that students do not even know that sections or an activity in the course are 

hidden. 

 

 

 

 

 

 

 

 

 

4.1.3.3.Формат Курса 
4.1.3.3.1.Формат 

См. «Форматы Курсов» в п.4.1.4. 

4.1.3.3.2.Число Разделов 
Эта настройка используется только форматами Курсов «Еженедельный» и 

«Тематический». В «Еженедельном» формате она указывает число недель, на которое этот 

Курс будет запущен, начиная с даты начала Курса. В формате «Тематический» она 

указывает число тем в этом Курсе. Обе они транслируются в число «окон», 

расположенных сверху вниз в середине страницы Курса. 

Если число недель/тем изменится для существующего Курса так, что станет 

меньше числа Разделов Курса, содержащих Действия (например, Курс содержит Действия 

в 3 Разделах, а число недель/тем установлено равны 2), тогда во время  редактирования 

при обращении к последним Разделам, внизу страницы Курса они будут показаны под 

заголовком «Orphaned activities (безнадзорные действия)». 

Число недель/тем могут быть установлены в 0, так что только верхний общий 

Раздел отобразится на странице Курса и не будет существовать пронумерованных 

Разделов. 

По умолчанию максимальное число недель/тем равно 52, но Администратор может 

установить другое максимальное число, которое будет применено ко всем Курсам этого 

Сайта (см. ниже). 

4.1.3.3.3.Скрытые Разделы 
Эта опция позволяет вам решить, как скрытые в вашем Курсе Разделы 

отображаются Студентам. По умолчанию показывается маленькая область (свёрнутая 

форма, обычно, серого цвета), чтобы указать, где находится скрытый Раздел, хотя они по-

прежнему не могут на самом деле видеть скрытые Действия и тексты. Это, в частности, 

полезно в Еженедельном формате, чтобы внеклассные недели оставались чистыми, или, 

если у вас есть Экзамены, которые вы не хотите, чтобы Студенты видели. 

Совет: Если вы выберите, эти недоступные элементы могут быть полностью 

скрыты так, чтобы Студенты даже не узнали, что какие-то Разделы или Действия в этом 

Курсе скрыты. 
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4.1.3.3.4.Course layout 
The Course layout setting determines whether the whole course is 

displayed on one page or split over several pages. The setting currently 

applies to the topics and weekly core course formats and contributed 

collapsed topics course format only. 

Teachers choose from the dropdown whether they wish to "show all 

sections on one page" in the familiar scrolling format, or "show one section 

per page". 

If one section per page is selected, the course page is abbreviated to a list 

of links to individual sections. If an individual section is shown, next and 

previous sections may be accessed via links above and below the section. 

 

4.1.3.4.Appearance 
4.1.3.4.1.Force theme 
If the site administrator has allowed the teacher to set a course theme, this 

pull down menu will appear with a list of themes on the site. Teachers can 

use this to choose a different look for the course from the rest of the 

Moodle site. 

4.1.3.4.2.Force language 
If you force a language in a course, the interface of Moodle in this course 

will be in this particular language, even if a student has selected a different 

preferred language in his/her personal profile. 

4.1.3.4.3.News items to show 
How many news items should show the Latest news block. Set it to 0 and 

Latest news block will not appear. 

The Latest News block relies on the use of the associated News Forum. 

News posted in other forums do not display in the latest News block 

 

 

 

 

 

 

 

 

 

 

 

 

4.1.3.3.4.Компоновка Курса 
Настройка компоновки Курса определяет, целиком ли весь Курс отображается на 

одной странице или разделяется на несколько страниц. В настоящее время эта настройка 

применяется только к основным форматам Курсов «Тематический» и «Еженедельный» и к 

предлагаемому формату «Свёрнутые темы Курса». 

Преподаватели выбирают из ниспадающего меню, желают ли они «Show all 

sections on one page (показать все разделы на одной странице)» в известном формате 

прокрутки или «Show one section per page (показать один раздел на странице)». 

Если выбран «show one section per page», страница Курса сокращается до списка 

ссылок на отдельные Разделы. Если показывается отдельный Раздел, следующий и 

предыдущий Разделы могут быть доступны через ссылки, расположенные выше и ниже 

данного Раздела. 

4.1.3.4.Внешний вид 
4.1.3.4.1.Принудительная Фоновая Картинка Курса  

Если Администратор Сайта разрешил Преподавателю устанавливать фон (см. 

п. 3.8) Курса, появится выпадающее меню со списком фоновых картинок на Сайте. 

Преподаватели могут использовать его, чтобы выбрать вид для их Курса, отличный от 

остального Сайта Moodle. 

4.1.3.4.2.Принудительный язык Курса 
Если вы устанавливаете принудительный язык Курса, тогда интерфейс Moodle для 

этого Курса будет на этом конкретном языке, даже если Студент(ка) выбрал(а) отличный 

от этого языка предпочитаемый им(ею) язык в его(её) персональном Профиле. 

4.1.3.4.3.Показ Элементов новостей 
Сколько Элементов новостей должен показывать Блок Последних Новостей 

(п. 4.5.18). Установите эту настройку равной 0 и Блок Последних Новостей не появится. 

Блок Последних Новостей зависит от использования связанного Форума Новостей. 

Новости, отправляемые в другие Форумы, не отображаются в Блоке Последних Новостей. 
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4.1.3.4.4.Show gradebook to students 
Here you can decide whether to allow students to see the link to grades in 

the Administration block. If your course doesn't use graded activities, it 

makes sense to disable this. If grades are used and this link is disabled, 

students can still see their grade from the actual activity itself, such as an 

assignment 

4.1.3.4.5.Show activity reports 
Here you can decide whether to show students their activity reports. Doing 

so places a load on the server however, which is why the setting is disabled 

by default. 

4.1.3.5.Files and uploads 
4.1.3.5.1.Maximum upload size 
Here you can decide the largest size of file that students can upload to a 

course. The site administrator can determine sizes available for the teacher 

to select. 

Editing teachers or other users may be allowed to upload files larger than 

the maximum size by giving them the capability 

moodle/course:ignorefilesizelimits 

4.1.3.6.Completion tracking 
Completion tracking must be enabled for Activity completion. Course 

completion criteria may also be based upon Activity completion values 

found in the activity's settings. 

 

4.1.3.7.Guest access 
Here you can decide whether to allow logged in users to access the course 

as a guest, and whether or not they need to enter a password. See Guest 

role for more information. 

4.1.3.8.Groups 
4.1.3.8.1.Group mode 
Here you can define the group mode at the course level by a pull down 

menu. "No groups", "Separate groups" and "Visible 

 

 

 

 

 

 

 

4.1.3.4.4.Показать Журнал Оценок Студентам 
Здесь вы можете решить, разрешить ли Студентам видеть ссылку на Оценки 

(п. 4.9.1) в Блоке Управления. Если ваш Курс не использует оцениваемых 

Интерактивных Действий, имеет смысл отключить эту ссылку. Если Оценки используются 

и эта ссылка отключена, Студенты по-прежнему смогут увидеть их Оценку изнутри 

самого Интерактивного Действия, такого как Задание (п. 4.3.1) 

4.1.3.4.5.Показать Отчёты по Интерактивным Действиям 
Здесь вы можете решить, показывать ли Студентам Отчёты по их 

Интерактивным Действиям (п. 4.9.6.2). Такая работа занимает пространство на сервере, 

вот почему эта настройка отключена по умолчанию. 

4.1.3.5.Файлы и пересылки 
4.1.3.5.1.Максимальный Размер пересылки 

Здесь вы можете решить, каков самый большой размер файла, который Студенты 

могут переслать в Курс. Администратор Сайта может определить размеры, доступные (п. 

3.5.3) для выбора Преподавателем. 

Редактирующим Преподавателям или другим пользователям может быть 

позволено пересылать файлы большего размера, чем максимальный, предоставлением 

Возможности moodle/course:ignorefilesizelimits. 

4.1.3.6.Отслеживание Завершения 
Отслеживание Завершения должно быть разрешено для Завершения 

Интерактивных Действий (п. 4.9.3). Критерии завершения Курса (п. 4.9.4) также могут 

быть основаны на значениях Завершения Интерактивных Действий, которые находятся в 

настройках этих Интерактивных Действий. 

4.1.3.7.Доступ Гостя 
Здесь вы можете решить, разрешить ли пользователям вход в систему для доступа 

к Курсу в качестве Гостя, а также нуждаются они или нет во вводе пароля. 

Дополнительную информацию ищите в «Роль Гостя» (п. 3.4.5.7). 

4.1.3.8.Группы 
4.1.3.8.1. Групповой Режим 

Здесь вы можете определить Групповой Режим (п. 4.8.1) на уровне Курса 

посредством ниспадающего меню. «Нет Групп», «Раздельные Группы» и «Видимые 

http://docs.moodle.org/25/en/Capabilities/moodle/course:ignorefilesizelimits
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groups" are the choices. The selected setting will be the default group 

mode for all activities defined within that course. The group setting can 

affect what users see in the Participants list and who they can interact with 

in activities. 

4.1.3.8.2.Force 
If the group mode is "forced" at a course-level, then this particular group 

mode will be applied to every activity in that course. This will override any 

activities that may have a special group setting. 

 

4.1.3.8.3.Default grouping 
If groupings are enabled, a default grouping for course activities and 

resources may be set. 

 

4.1.3.9.Role renaming 
You can rename the roles used in your course. For example, you may wish 

to rename the Teacher role as "Facilitator", "Tutor" or "Guide". These new 

role names will appear within the course. For example on the participants 

and the override permissions pages. 

Please note that the site administrator or a course manager may have 

changed the names or added new roles. These names will appear and the 

teacher may rename them. 

4.1.3.10.Site administration settings 
An administrator can set course default settings in Administration > Site 

administration > Courses > Course default settings. 

The maximum number of weeks/topics may be set for all courses on the 

site. The default value is 52. 

4.1.3.11.Preventing teachers from editing 
course settings 
Any/all of the following fields - course full name, short name, ID number 

and category, summary - may be locked to prevent teachers from editing 

them. To do so: 

 Access Site Administration > Users > Permissions > Define roles. 

 Click the edit icon opposite the teacher role. 

 

 

 

 

 

Группы» (п. 4.8.1) являются альтернативами. Выбранная здесь настройка станет 

Групповым Режимом по умолчанию внутри данного Курса. Эта настройка Группы может 

повлиять на то, что увидят пользователи в списке Участников и с кем они смогут 

взаимодействовать внутри Интерактивных Действий. 

4.1.3.8.2.Принуждение 
Если Групповой Режим «Forced (принудительный)» на уровне Курса, тогда этот 

конкретный Групповой Режим будет применён к каждому Интерактивному Действию в 

этом Курсе. Это может переопределяться любыми Интерактивными Действиями, которые 

могут иметь специальную настройку Группы. 

4.1.3.8.3.Распределение по Группам по умолчанию 
Если позволено распределение по Группам (п. 4.8.3), то может быть установлено 

распределение по Группам по умолчанию для Ресурсов и Интерактивных Действий 

Курсов. 

4.1.3.9.Переименование Роли 
Вы можете переименовать Роли (п. 3.4), используемые в вашем Курсе. Например, 

вы можете пожелать переименовать Роль «Преподаватель» (п. 3.4.5.4) на «Фасилитатор», 

«Наставник» или «Руководитель». Эти новые наименования Ролей появятся внутри Курса. 

Например, на страницах перечисления Участников и переопределения полномочий. 

Пожалуйста, заметьте, что Администратор Сайта или Менеджер Курсов могли уже 

изменить имена или добавить новые Роли. Эти имена появятся, и Преподаватель может 

переименовать их. 

4.1.3.10.Настройки Администратора Сайта 
Администратор может установить настройки Курса по умолчанию в 

AdministrationSite administrationCoursesCourse default settings. 

Максимальное число недель/тем может быть установлено для всех Курсов на 

Сайте. Значение по умолчанию – 52. 

4.1.3.11.Предотвращение редактирования настроек 
Курса Преподавателями 

Любое/все из следующих полей (полное название Курса, краткое название, ID-

номер и Категория, краткое изложение) могут быть локализованы, чтобы помешать 

Преподавателям их редактировать. Чтобы сделать так: 

 Перейдите к Site Administration→Users→Permissions→Define roles. 

 Щёлкните иконку редактирования напротив Роли Преподавателя. 

http://docs.moodle.org/25/en/Participants
http://docs.moodle.org/25/en/Participants
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 Change any/all of the capabilities  

moodle/course:changefullname, 

moodle/course:changeshortname, 

moodle/course:changeidnumber, 

moodle/course:changecategory, 

moodle/course:changesummary from allow to not set. 

 Click the "Save changes" button at the bottom of the page. 

4.1.4.Course formats 
The different ways your course sections might be laid out. 

A course format refers to the layout of a course. The course format can be 

selected in Administration > Course administration > Edit settings. 

An administrator can enable, disable or delete course formats for courses in 

Administration > Site administration > Plugins > Course formats > 

Manage course formats. They can also change the order in which available 

course formats are displayed to teachers in the course settings. 

4.1.4.1.Standard course formats 
4.1.4.1.1.Weekly format 
The course is organized week by week, with a clear start date and a finish 

date. Moodle will create a section for each week of your course. You can 

add content, forums, quizzes, and so on in the section for each week. 

TIP: If you want all your students to work on the same materials at the 

same time, this would be a good format to choose. 

NOTE: Make sure your course start date is correct. If it is not your weeks 

will have the wrong date on it. This is especially important if you are 

restoring a course to use with a new section of students. 

4.1.4.1.2.Topics format 
The course is organised into topic sections that a teacher can give titles to. 

Each topic section consists of activities, resources and labels. 

 

 

 

TIP: This is great to use if your course is objective based and each 

objective may take different amounts of time to complete. An example of 

this would be scaffolding where the students are building upon the 

knowledge from earlier topics. 

 

 

 

 

 Измените любую/все из Возможностей 

moodle/course:changefullname, 

moodle/course:changeshortname, 

moodle/course:changeidnumber, 

moodle/course:changecategory, 

moodle/course:changesummary из позволенных не устанавливать. 

 Щёлкните кнопку «Save changes» внизу страницы. 

4.1.4.Форматы Курсов 
Существуют различные способы представления вашего Курса. 

Формат Курса определяет компоновку Курса. Нужный вам формат Курса может 

быть выбран в AdministrationCourse administrationEdit settings. 

Администратор может разрешить, отменить или удалить форматы Курсов через 

AdministrationCourse administrationPluginsCourse formatsManage course formats. 

Он может также изменить порядок, в котором доступные форматы Курсов отображаются 

Преподавателям в настройках Курса. 

4.1.4.1.Стандартные форматы Курсов 
4.1.4.1.1.Формат Еженедельный 

Курс, организуется по-недельно, с чёткой датой начала и датой конца. Moodle 

создаст Раздел для каждой недели вашего Курса. Вы можете добавить содержимое, 

Форумы, Экзамены и пр. в Раздел каждой недели. 

Совет: Этот формат очень удобен, если вы хотите, чтобы все ваши Студенты 

работали над одними и теми же материалами в одно и то же время,  

Замечание: Убедитесь, что дата начала вашего Курса правильна. Если это не так, 

ваши недели будут иметь неправильные для них даты. Это особенно важно, если вы 

сохраняете Курс, чтобы использовать его с новой Группой Студентов. 

4.1.4.1.2.Формат Тематический 
Курс организуется в виде тематических Разделов, которым Преподаватель может 

дать заголовки. Каждый тематический Раздел состоит из Интерактивных Действий, 

Ресурсов и Меток (метка служит в качестве разделителя на странице Курса в Moodle. Она может быть 

использована для добавления текста, изображений, мультимедиа или кода между Ресурсами и 

Интерактивными Действиями). 

Совет: Использовать этот формат особенно удобно, если ваш Курс состоит из 

задач, и каждая задача может потребовать разного времени для завершения. Примером 

этого могло бы служить «обустраивание лесами», где Студенты достраивают своё знание 

на основе предыдущих тем. 
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"Show only one section" 
With the Weekly, Topics and any contributed format that implements the 

functionalty, it is possible via Administration > Course administration > 

Edit settings to "show one section per page". 

 

Notes: 

 The course home page shows just the section names and any text in the 

section description along with activity and resource numbers, with the 

names being click-able. 

 If editing is ON, then the Main course page will display all the content 

in all the sections. New feature in Moodle 2.5! 

 There is a 'Jump to...' menu at the bottom of each single section page 

(new in 2.5). 

4.1.4.1.3.Social format 
This format is oriented around one main forum, the social forum, which 

appears listed on the main page. It is useful for situations that are more free 

form. They may not even be courses. The Moodle Lounge is an example of 

a social format course. 

The social forum can be edited by clicking the 'Update this forum' button 

on the social forum page. The forum introduction is displayed at the top of 

the course page. 

4.1.4.1.4.SCORM format 
SCORM - Sharable Content Object Reference Model. 

 

The SCORM format only has 1 section, and allows teacher to insert a pre-

built SCORM package. Moodle can use SCORM packages as a content 

type (see SCORM module), or as a course format. 

An example of SCORM format is the New Staff Induction course on the 

School demo site 

Note: If you have a large SCORM object you want to use as an entire 

course, then you can select this course format and students will only be 

able to interact with the SCORM object, not the rest of the Moodle tools. 

 

 

 

 

 

 

 

«Показывать только один Раздел» 
С недельной или тематической организацией и любым предлагаемым кем-то 

форматом, использующим эту функциональность, посредством 

AdministrationCourse administrationEdit settings можно отображать только один Раздел 

на странице. 

Замечания: 

 Домашняя Страница Курса показывает только имена Разделов и любой текст из 

описания Разделов наряду с номерами Интерактивных Действий и Ресурсов, с 

наименованиями, щелчок по которым открывает соответствующее Действие. 

 Если режим редактирования включён (ON), тогда Главная Страница Курса будет 

отображать всё содержимое во всех Разделах. 

 Существует меню «Jump to... (переход к…)» внизу каждой страницы отдельного 

Раздела (новое в 2.5). 

4.1.4.1.3.Социальный формат 
Этот формат ориентирован на один главный Форум (п. 4.3.8) – Социальный Форум 

–  который появляется в перечне на Главной Странице. Это полезно для ситуаций, 

организуемых в более свободной форме. Они могут быть даже не Курсами. Примером 

Курса в Социальном формате может служить Moodle Lounge. 

Социальный Форум может быть отредактирован щелчком по кнопке «Update this 

forum (обновить этот форум)» на странице этого Социального Форума. Введение в этот 

Форум отображается вверху страницы этого Курса. 

4.1.4.1.4.Формат SCORM 
SCORM – рекомендованная объектная модель содержимого для совместного 

использования. 

Формат SCORM имеет только один Раздел и разрешает Преподавателю вставить 

предварительно созданный SCORM-пакет. Moodle может использовать SCORM-пакеты 

как вид содержимого (см. Модуль SCORM: п. 4.3.12) или как формат Курса. 

Пример формата SCORM представлен на Сайте Курс для новых сотрудников на 

демонстрационном Сайте Школы. 

Замечание: Если вы имеете большой пакет SCORM, который захотите 

использовать как целый Курс, то можете выбрать этот формат Курса, и тогда Студенты 

будут способны взаимодействовать только с пакетом SCORM, но не с остальным 

инструментарием Moodle. 

http://moodle.org/course/view.php?id=55
http://school.demo.moodle.net/course/view.php?id=112
http://school.demo.moodle.net/course/view.php?id=112
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4.1.4.2.Contributed Course Formats 
The Moodle community has developed a number of course formats, 

available in the plugins directory. If you plan to create a new one, see 

Developers documentation. 

See MDL-27646 and MDL-28555 and maybe the discussion 

http://moodle.org/mod/forum/discuss.php?d=175758#p770737 

4.1.4.2.1.Collapsed Topics 
This is a format that is essentially the same as the standard Topic and 

Weekly formats but with a 'toggle' for each section except '0'. The toggles' 

purpose is to reduce the amount of initial information presented to the user 

thus reducing the 'scroll of death' that can plague courses with a lot of 

content. The 'state' of the toggles is remembered on a per course per user 

basis. For more information, please visit Collapsed_Topics_course_format. 

 

Overview 
For an overview of 'Collapsed Topics' please see this video: 

https://www.youtube.com/watch?v=c9NaEAPPC5E. 

4.1.4.2.2.Daily format 
The daily format is a modification of the weekly format that shows 

sections by day rather than by week. 

4.1.4.2.3.Grid format 
The grid format is a modular and visual course format. Hides all topics and 

creates a grid of icons (one for each topic) with short titles. Clicking on an 

icon brings up the content from the corresponding topic in a "lightbox" 

style display. 

4.1.4.2.4.Menutopic format 
The menutopic format allows you to display the topics/sections in a menu. 

4.1.4.2.5.Noticeboard format 
The Noticeboard format presents the latest post in the news forum at the 

top of the course. 

 

 

 

 

 

 

 

 

4.1.4.2.Предлагаемые кем-то форматы Курсов 
Сообщество Moodle разработало ряд форматов Курсов, доступных в Оглавлении 

Плагинов. Если вы планируете создать новый формат, обратитесь к Документации 

Разработчика. 

См. также MDL-27646, MDL-28555 и, возможно, обсуждение в 

http://moodle.org/mod/forum/discuss.php?d=175758#p770737. 

4.1.4.2.1.СвёрнутыеТемы 
Это, по существу, тот же формат, что и стандартные форматы с разбивкой по 

темам или неделям, но с переключателем («триггером») для каждого Раздела, кроме «0 

(нулевого)». Цель переключателя состоит в уменьшении количества начальной 

информации, предоставляемой пользователю и снижении тем самым «прокруток в 

глубину», что может быть настоящим бедствием для Курсов с большим содержимым. 

«Состояние» переключателей запоминается по Курсам и по пользователям. За дальнейшей 

информацией обращайтесь, пожалуйста, к формату Курсов «СвёрнутыеТемы». 

Общий обзор 
Для знакомства с общим представлением по «Свёрнутым Темам» см. видео: 

https://www.youtube.com/watch?v=c9NaEAPPC5E. 

4.1.4.2.2. Формат Ежедневный – с разбивкой Курса по дням 
Формат «Ежедневный» является модификацией формата Курсов с разбивкой по 

неделям, который показывает Разделы по дням, а не по неделям. 

4.1.4.2.3.Сетевой формат 
Сетевой формат – модульный и визуальный формат Курса. Прячет все Темы и 

создаёт сеть иконок (одну для каждой Темы) с кратким заголовком. Щелчок по иконке 

приводит к содержимому соответствующей Темы в стиле «подсвеченное окно». 

 

4.1.4.2.4.Формат Меню Тем 
Формат Меню тем позволяет вам отобразить Темы/Разделы в меню. 

4.1.4.2.5.Формат Доски Объявлений 
Формат Доски Объявлений представляет последние корреспонденции в Форуме 

новостей вверху Курса. 

https://moodle.org/plugins/browse.php?list=category&id=19
https://moodle.org/plugins/browse.php?list=category&id=19
http://docs.moodle.org/dev/Course_formats
http://docs.moodle.org/dev/Course_formats
http://tracker.moodle.org/browse/MDL-27646
http://tracker.moodle.org/browse/MDL-28555
http://moodle.org/mod/forum/discuss.php?d=175758#p770737
http://docs.moodle.org/25/en/Collapsed_Topics_course_format
https://www.youtube.com/watch?v=c9NaEAPPC5E
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4.1.4.2.6.Onetopic format 
The onetopic format shows each topic in a tab, keeping the current tab 

between calls to resources, in such a way that when it returns from a 

module as the blog or the glossary it returns to tab from where you started. 

This format is based on the Moodle standard format: “Topics”. 

4.1.4.2.7.Topic format (colors) 
The colored topic format is based on the 'Topics' standard format and 

allows a teacher to specify the foreground and background colours for each 

course section. 

4.1.4.2.8.Flexible sections format 
The flexible sections format for Moodle 2.4+ allows to have nested 

sections and each section may be displayed expanded (with all content on 

the parent section page) or collapsed (as a link to a separate page) 

4.1.4.2.9.Single activity format 
The single activity format for Moodle 2.4+ does not have a course main 

page and immediately redirects to the activity. It is similar to SCORM 

format except that it can have any activity type. 

 

Other contributed course formats are available from the modules and 

plugins database. 

4.1.4.3.See also 
 Using Moodle Course formats forum 

 Getting the most out of course design blog post describing various 

contributed course formats 

Using Moodle forum discussions: 

 Social format: where to put an introduction 

 RSS Feed for forum in a Social Format course 

 

 

 

 

 

 

 

 

 

 

 

4.1.4.2.6.Формат Одной Темы 
Формат Одной Темы показывает каждую Тему в Этикетке, сохраняя текущую 

Этикетку между запросами Ресурсов таким способом, что когда происходит возврат из 

модуля, такого как Блог или Глоссарий, он возвращается к Этикетке, откуда стартовал. 

Этот формат основан на стандартном формате «Темы» Moodle. 

4.1.4.2.7.Формат Цветовой Темы 
Формат Цветовой Темы основан на стандартном формате «Тематический» и 

позволяет Преподавателю указать цвета переднего и заднего фона для каждого Раздела 

Курса. 

4.1.4.2.8.Гибкий формат Разделов 
Гибкий формат Разделов для Moodle 2.4 и выше позволяет иметь вложенные 

Разделы, и каждый Раздел может быть отображён расширенным (со всем содержимым на 

странице родительского Раздела) или свёрнутым (как ссылка на отдельной странице). 

4.1.4.2.9.Формат Единственного Интерактивного Действия 
Формат Единственного Интерактивного Действия для Moodle 2.4 и выше не имеет 

Главной Страницы Курса и сразу перенаправляет к Интерактивному Действию. Он похож 

на формат SCORM за исключением того, он может иметь тип любого 

Интерактивного Действия. 

Другие предлагаемые кем-то форматы Курсов доступны из Базы данных модулей и 

плагинов. 

4.1.4.3.См. также 
 Форум по использованию Moodle «Форматы Курсов». 

 Корреспонденция блога «Получить больше о дизайне Курса», описывающая различные 

предлагаемые кем-то форматы Курсов. 

Обсуждения форума по использованию Moodle: 

 Социальный формат: куда поместить введение. 

 RSS-рассылка для форума в курсе Социального формата. 

http://moodle.org/plugins
http://moodle.org/plugins
http://moodle.org/mod/forum/view.php?id=47
http://www.moodleman.net/archives/47
http://moodle.org/mod/forum/discuss.php?d=116428
http://moodle.org/mod/forum/discuss.php?d=136453
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4.1.5.Course homepage 
An overview of a typical course home page. 

4.1.5.1.Standard view of a blank course 
Our examples will be for a course homepage that is the standard default for 

a new install on a site. There are many course options that determine a 

course's appearance and make it look very different from our examples. 

The example course has a header, a footer (both content largely determined 

by a theme) and 3 columns in the middle. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.1.5.Домашняя Страница Курса 
Общее представление о типичных Домашних Страницах Курсов. 

4.1.5.1.Стандартный вид незаполненного Курса 
Наши примеры будут о Домашней Странице Курса, которая по умолчанию 

является стандартом для новой инсталляции на Сайт. Существует много опций Курса, 

которые определяют его внешний вид и заставляют выглядеть совершенно не так, как в 

наших примерах. Наш тестовый Курс имеет верхний, нижний колонтитулы (содержание 

обоих значительно определяется темой фоновой картинки, см. п. 3.8) и 3 колонки в 

середине. 

 
Пример Еженедельного формата, вид Преподавателя, режим редактирования выключен 
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4.1.5.1.1.Parts of a course homepage 
Using the above image, here are the parts of a typical course homepage. It 

is possible to move and hide parts of the page and different themes display 

blocks in different regions, so not all courses will look like this. 

 

 

 

 

4.1.5.2.Course sections 
Course sections are displayed in the centre of the course page. 

To edit a course section: 

 Turn editing on 

 Click the edit icon after the section title 

If Conditional activities are enabled for the site, access to the section 

(including all activities and resources within it) may be restricted. 

 

The number of course sections in the centre column may be changed in 

Settings > Course administration > Edit settings or by clicking the plus or 

minus icons at the bottom of the course page when editing is turned on. 

 

To move a course section: 

 Turn editing on 

 Click the up/down arrow or the crosshairs icon to move the section 

  

 Drag the section to where you want to position it and let go 

Note: The ability to move course sections is controlled by the capability 

moodle/course:movesections, which is allowed for the default role of 

teacher. 

 

 

 

 

4.1.5.1.1.Части Домашней Страницы Курса 
К изображению выше здесь приведены части типичной Домашней Страницы 

Курса. Можно переместить и скрыть части этой страницы и блоки отображения различных 

фоновых тематических картинок (см. п. 3.8) в разных областях так, что не все Курсы будут 

выглядеть одинаково. 
 

Левая колонка Центральные разделы – центр Правая колонка 

1 Полное название Курса 6 Заголовок Раздела и Тема 

новостей 

9 Информация о регистрации 

2 Панель Навигации 7 Текущая неделя – Первый 

Раздел 

10 Кнопка включения режима 

редактирования 

4 Блок Навигации 8 Будущая неделя – Второй 

Раздел 

11 Последние новости 

5 Блок управления 14 «Показать только этот Раздел» 12 Предстоящие события 

15 «Переключиться на Роль»  13 Недавняя деятельность 

16 Настройки 

Профиля Пользователя 

  

17 Управление Сайтом   

4.1.5.2.Разделы Курса 
Разделы Курса отображаются в центре страницы Курса. 

Чтобы отредактировать Раздел Курса: 

 Включите режим редактирования 

 Щёлкните иконку редактирования за заголовком Раздела 

Если Обусловленные Действия (п. 4.9.2) разрешены для Сайта, доступ к такому 

Разделу (включая все Интерактивные Действия и Ресурсы внутри него) может быть 

ограничен. 

Число Разделов Курса в центральной колонке может быть изменено в 

AdministrationCourse administrationEdit settings или щелчком по иконкам «Plus 

(плюс)» или «Minus (минус)» внизу страницы Курса, когда режим редактирования 

включён. 

Чтобы переместить Раздел Курса: 

 Включите режим редактирования. 

 Щёлкните стрелочку «Up/down (вверх/вниз)» или иконку перекрестия, чтобы 

переместить этот Раздел. 

 Отбуксируйте этот Раздел, куда вам нужно. 

Замечание: Способность перемещать Разделы Курса контролируется 

Возможностью moodle/course:movesections, которая по умолчанию предоставлена для 

Роли Преподавателя. 

Column left Course sections - Center Column right 

1 Course full name 6 Section header & News topic 9 Login information 

2 Navigation bar 7 Current week - First section 10 Turn editing on 

button 

4 Navigation block 8 Future week/Second section 11 Latest news 

5 Administration block 14 "Show only this section" 12 Upcoming events 

15 "Switch role to"  13 Recent activity 

16 User profile settings   

17 Site Administration   

http://docs.moodle.org/25/en/Capabilities/moodle/course:movesections
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4.1.5.3.Blocks 
Blocks are displayed in the right and/or left columns of the course page. 

To add a block to the course page 

 Turn on the editing by clicking the button top right or the link in 

Settings > Course administration 

 Select a block from the "Add block" dropdown menu (usually situated 

bottom right of the page) 

To move a block 

 Ensure editing is turned on then click onto the block title until the 

crosshair icon appears 

 While keeping the block selected, drag it to where you want to position 

it and let go. 

Alternatively 

 Click on the up/down arrow 

 Click on the place holder (a zone with a dashed border) where you want 

the block to appear. 

4.1.5.4.Activities and resources 
To add an activity or resource to the course 

 Turn on the editing by clicking the button top right or the link in 

Administration > Course administration. 

 Click 'Add an activity or resource' to open the new activity chooser. 

Select an activity or resource then click the Add button, or simply 

double-click on the activity or resource name. 

  

If desired, the activity chooser can be switched off via Administration > 

Course administration > Activity chooser off. Activities and resources can 

then be added using dropdown menus. (The setting appears only when 

editing is turned on.) 

Note: The Moodle admin can switch this off by default in Administration > 

Site administration > Appearance > AJAX and Javascript. 

 

 

 

 

 

 

 

 

4.1.5.3.Блоки 
Блоки отображаются в правой и/или левой колонке страницы Курса. 

Чтобы добавить Блок на страницу Курса: 

 Включите режим редактирования щелчком по кнопке вверху справа или ссылке в 

AdministrationCourse administration. 

 Выберите Блок из ниспадающего меню «Add block (добавить блок)» (обычно 

размещается внизу страницы справа). 

Чтобы переместить Блок: 

 Убедитесь, что режим редактирования включён, затем щёлкните по заголовку Блока и 

держите кнопку мыши, пока не появится иконка перекрестия. 

 Сохраняя этот Блок выбранным, отбуксируйте его, куда вам нужно. 

 

Альтернативно: 

 Щёлкните стрелочку «Up/down (вверх/вниз)». 

 Щёлкните по месту размещения (зона с пунктирной границей), где вы хотите, чтобы 

Блок появился. 

4.1.5.4.Интерактивные Действия и Ресурсы 
Чтобы добавить Интерактивное Действие или Ресурс в Курс: 

 Включите режим редактирования щелчком по кнопке вверху справа или ссылке в 

AdministrationCourse administration. 

 Щёлкните «Add an activity or resource (добавить интерактивное действие или ресурс)», 

чтобы открыть селектор нового Действия. Выберите Интерактивное Действие или 

Ресурс, затем щёлкните кнопку Add или просто сделайте двойной щелчок по имени 

Интерактивного Действия или Ресурса. 

Если нужно, селектор Действий может быть отключён через 

AdministrationCourse administrationActivity chooser off, Интерактивные Действия и 

Ресурсы могут быть добавлены посредством ниспадающего меню (эта настройка 

появляется только при включённом режиме редактирования). 

Замечание: Администратор Moodle может сделать селектор отключённым по 

умолчанию в AdministrationSite administrationAppearanceAJAX and Javascript. 
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Alternatively, certain resources and activities may be added using drag and 

drop: 

 To add a file, simply drag and drop it onto the course section where 

you'd like it to appear 

 To add a folder of files, simply zip the folder then drag and drop it onto 

the course section where you'd like it to appear, answer 'Unzip files and 

create folder' to the popup dialogue, then click the upload button 

 

 To add a SCORM package, simply drag and drop it onto the course 

section where you'd like it to appear, answer 'Add a SCORM package' 

to the popup dialogue, then click the upload button 

4.1.5.5.Editing elements on your course 
homepage 
With the editing turned on, each item on your course homepage and each 

section/block will have icons next to it which all perform different 

functions such as edit/move/copy/delete/hide. 

Note: Your theme may have icons different from these below: 

 

Quickrename - the pencil icon allows to rename your item directly on the 

course page without entering the settings for that item. 

Edit - the edit icon allows you to change the wording or settings of the 

item. 

Duplicate - the duplicate icon allows you to copy an activity or resource 

within your course 

Hide - the open-eye icon means an item is visible to students. It will close 

when you click on it 

Closedeye - the eye with a strike through icon means an item is hidden 

from students. It will open when you click on it 

Indent - the right arrow icon is used to indent course elements (there is also 

a left icon) 

Moveajax - the move icon allows you to move items or sections by 

dragging and dropping. 

 

 

 

 

 

 

 

Альтернативно, определённые Ресурсы и Интерактивные Действия могут быть 

добавлены буксировкой. 

 Чтобы добавить Файл (п. 4.4.2), просто отбуксируйте его в тот Раздел Курса, где бы вы 

хотели, чтобы он появился. 

 Чтобы добавить Папку Файлов (п. 4.4.3), просто zip-заархивируйте её, затем 

отбуксируйте в тот Раздел Курса, где бы вы хотели, чтобы она появилась, ответьте 

«Unzip files and create folder (разархивировать файлы и создать папку)» во 

всплывающем диалоге, затем щёлкните кнопку Upload (переслать). 

 Чтобы добавить пакет SCORM (п. 4.3.12), просто отбуксируйте его в тот Раздел Курса, 

где бы вы хотели, чтобы он появился, ответьте «Add a SCORM package (добавить пакет 

SCORM)», затем щёлкните кнопку Upload (переслать). 

4.1.5.5.Редактирование элементов на Домашней 
Странице вашего Курса 

При включённом режиме редактирования каждый элемент на Домашней Странице 

вашего Курса и каждый Раздел/Блок будут рядом иметь иконки, которые выполняют 

разные функции, такие как редактировать/переместить/скопировать/удалить/спрятать. 

Замечание: Ваша фоновая тематическая картинка (п. 3.8) может иметь иконки, 

отличные от тех, что приведены ниже: 

Быстро переименовать – иконка карандаша позволяет переименовать ваш элемент 

прямо на странице Курса, без входа в настройки для этого элемента. 

 

Редактировать – иконка редактирования позволяет вам изменить стиль 

формулировок или настройки элемента. 

Дублировать – иконка дублирования позволяет вам копировать 

Интерактивное Действие или Ресурс внутри вашего Курса. 

Скрыть – иконка открытого глаза означает, что элемент видим Студентам. Если он 

закрыт, щёлкните по нему. 

Закрытый глаз – глаз с линией через иконку означает, что элемент скрыт от 

Студентов. Он откроется, когда вы щёлкнете по нему. 

Отступить – иконка стрелки вправо используется для отступа элементов Курса 

(существует также стрелка влево). 

Ajax-переместить – иконка перемещения позволяет вам перемещать элементы или 

Разделы буксировкой. 
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Movenoajaz - this move icon appears if you don't have Ajax enabled. 

 

Movenoajax - the move here icon appears when moving a course element 

without Ajax. Click into the box to re-locate your item. 

Topicmove - the up/down arrows allow you to move course sections up or 

down and appear if you do not have Ajax enabled. 

Delete - the delete icon will permanently delete something from the course 

Groups - the groups icon allows you to change between no groups or 

separate/visible groups 

Assignroles - the roles icon allows you to assign roles locally in the item. 

The following icon only applies to sections 

Lightbulb - the highlight icon allows you to highlight a section as current. 

4.1.5.6.Tips and tricks 
 Make your course home page look more like a webpage - see Course 

FAQ 

 Activity and resource descriptions can be displayed on the course page 

just below the link to the activity or resource by clicking the 'Display 

description on course page' checkbox in the activity or resource 

settings. 

4.1.5.7.Course homepage capabilities 
4.1.5.7.1.Control section visibility 
Capabilities/moodle/course:sectionvisibility. 

 This allows a user to hide/unhide course sections on the Course 

homepage 

 This capability is allowed for the default roles of manager and teacher 

4.1.5.7.2.Set current section 
Capabilities/moodle/course:setcurrentsection 

 This allows a user to set the current section on the Course homepage 

 This capability is allowed for the default roles of manager and teacher 

 

 

 

 

 

 

 

 

 

Нет Ajax-перемещения – эта иконка перемещения появляется, если вы не имеете 

подключённого Ajax. 

Перемещение не с Ajax – иконка перемещения здесь появляется, когда перемещение 

элемента без Ajax. Щёлкните в окошке, чтобы повторно переместить ваш элемент. 

Переместить Тему – стрелочка вверх/вниз позволяет вам переместить Разделы Курса 

вверх или вниз и появляется, если у вас нет подключённого Ajax. 

Удалить – иконка удаления навсегда удалит что-нибудь из Курса. 

Группы – иконка «группы» позволяет вам выбрать режим либо «нет групп», либо  

«раздельные/видимые группы». 

Назначить Роли – иконка Роли позволяет вам назначить Роли локально в элементе. 

Следующая иконка применяется только к Разделам. 

Лампочка – иконка подсветки позволяет вам подсветить Раздел как текущий. 

4.1.5.6.Советы и трюки 
 Сделайте Домашнюю Страницу вашего Курса более похожей на веб-Сайт – см. «Часто 

задаваемые вопросы по Курсу» в п. 4.1.6. 

 Описания Интерактивных Действий и Ресурсов могут быть отображены на странице 

Курса чуть ниже ссылки на них щелчком по окошку-флажку «Display description on 

course page (отобразить описание на странице курса)» в настройках 

Интерактивного Действия и Ресурса. 

4.1.5.7.Возможности Домашней Страницы Курса 
4.1.5.7.1.Управлять видимостью Раздела 

Возможность Capabilities/moodle/course:sectionvisibility. 

 Позволяет пользователю скрыть/открыть Разделы Курса на Домашней Странице Курса. 

 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

4.1.5.7.2.Установить текущий Раздел 
Возможность Capabilities/moodle/course:setcurrentsection. 

 Позволяет пользователю установить текущий Раздел на Домашней Странице Курса. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 
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4.1.5.8.See also 
 A useful Prezi from a student teacher on designing an effective Moodle 

course 

 How to quickly rename activities and use the activity chooser 

screencast 

4.1.6.Course FAQ 
A list of frequently asked questions about Moodle courses. 

4.1.6.1.How do I get rid of the teachers' names 
on my course descriptions? 
 By default Moodle will show names of teachers on course descriptions. 

If you don't want this, uncheck the role in Settings>Site 

Administration>Appearance>Course contacts 

4.1.6.2.How do I add the names of non-editing 
teachers to my course descriptions? 
By default Moodle will only show names of teachers on course 

descriptions. If you want to add other roles, check the role in Settings>Site 

Administration>Appearance>Course contacts 

4.1.6.3.Some of my courses have the course 
summaries showing but some only have an 
information icon. Why? 
 Categories which have fewer than ten courses will show the full 

summary but those with more will only show the information icon. If 

you want them all to show the full summary then change the value of 

the Courses with summaries limit (courseswithsummarieslimit) setting 

in Settings>Site Administration>Appearance>Courses. 

 

4.1.6.4.Why can I only add one hyperlink to a 
page or label? 
You are probably using Internet Explorer 8 or later. Try either switching to 

Firefox or click the icon to change to Compatibility mode (which is in 

effect Internet Explorer 7) and then you will be able to make more than one 

link. 

4.1.6.5.How can I prevent teachers from being 
able to duplicate course activities? 
 Edit teacher role 

4.1.5.8.См. также 
 Полезная штучка от Преподавателя-Студента по разработке эффективного Курса 

Moodle. 

 Как быстро переименовать Действия и использовать снимок с экрана «Селектор 

Действий». 

4.1.6.Часто задаваемые вопросы по Курсу 
Перечень часто задаваемых вопросов о Курсах Moodle. 

4.1.6.1.Как избавиться от имён Преподавателей в 
описаниях моих Курсов? 
 По умолчанию Moodle покажет имена Преподавателей в описаниях Курсов. Если вы 

этого не хотите, снимите пометку с Role в 

AdministrationSite administrationAppearanceCourse contacts. 

4.1.6.2.Как добавить имена неРедактирующих 
Преподавателей в описания моих Курсов? 

По умолчанию Moodle покажет только имена Преподавателей в описаниях Курсов. 

Если вы хотите добавить другие Роли, пометьте каждую из них в 

AdministrationSite administrationAppearanceCourse contacts. 

4.1.6.3.Некоторые из моих Курсов демонстрируют 
краткое изложения Курса, но некоторые имеют только 
информационную иконку. Почему? 
 Категории, которые имеют менее 10 Курсов, будут показывать полное краткое 

изложение, но те, в которых более 10, будут показывать только информационную 

иконку. Если вы хотите, чтобы они все показывали полное краткое изложение, тогда 

измените значение настройки по ограничению «Courses with summaries (курсы с 

кратким изложением)» (courseswithsummarieslimit) в 

AdministrationSite administrationAppearanceCourses. 

4.1.6.4.Почему можно добавить только одну 
гиперссылку на Страницу или в Этикетку? 

Вы, вероятно, используете Internet Explorer 8 или более поздний. Постарайтесь 

либо переключиться на Firefox, либо щёлкните иконку, чтобы изменить режим 

Compatibility (совместимость) (который действует в Internet Explorer 7) и тогда вы сможете 

создавать более одной ссылки. 

4.1.6.5.Как помешать Преподавателям дублировать 
Действия Курсов? 
 Отредактируйте Роль Преподавателя. 

http://prezi.com/oays--oappai/making-my-moodle/
http://prezi.com/oays--oappai/making-my-moodle/
http://youtu.be/Je9udHLCIv0
http://youtu.be/Je9udHLCIv0
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 Untick 'allow' on capabilities: ** moodle/backup:backuptargetimport ** 

moodle/restore:restoretargetimport 

 See forum post here 

http://moodle.org/mod/forum/discuss.php?d=204488#p891807 

4.1.6.6.I don't want the new activity chooser. 
How can I get the old dropdowns back? 
While the activity chooser is very helpful, it could cause confusion to users 

who are coming straight from Moodle 1.9 to 2.3. A teacher can temporarily 

disable it in Settings>Course administration and (since 2.3.2) an admin can 

disable it sitewide via Settings>Site administration>Appearance>Ajax and 

Javascript 

4.1.6.7.How can I make my course home page 
look more like a webpage? 
Often when a course has a lot of content, students and teachers find the 

long scrolling tedious and would prefer a 'neater' appearance with 

hyperlinks to sections in a similar way to the way pages on websites work. 

 See Course formats for a way to show only one section per page. 

 Anchors/section links can help. But the course page can still be long. 

 

 Hiding the activities shortens the list for students, but then they can not 

be selected by students. 

One method which might be useful is to put the activities into sections 

which are then made 'unseen' to the student. 

Basic Example 

 Set the number of topics in the course setting to 1 more than students 

will see. 

 For example, you plan on the students being able to see 6 topics, set 

it for 7. 

 Add activities in topic 7, such as a quiz (in our example) 

 Get the url of your quiz 

 Copy it and keep it somewhere (such as notepad) for later use 

 

 Go back to course admin>settings and change your topic/weeks to 6 

 

 Or one fewer than you had before 

 The section with your quiz will no longer be on the page that the 

student sees 

 

 Снимите отметку «Allow» в Возможностях: moodle/backup:backuptargetimport 

moodle/restore:restoretargetimport 

 Просмотрите корреспонденцию форума здесь: 

http://moodle.org/mod/forum/discuss.php?d=204488#p891807. 

4.1.6.6.Я не хочу нового селектора Действий. Как 
вернуть старые ниспадающие списки? 

В то время, как селектор Действий весьма полезен, он может вызывать смущение у 

пользователей, которые пришли из Moodle 1.9 в 2.3. Преподаватель может временно 

отключить его в AdministrationCourse administration и (начиная с 2.3.2) Администратор 

может отключить его по всему Сайту через 

AdministrationSite administrationAppearanceAJAX and Javascript. 

4.1.6.7.Как сделать Домашнюю Страницу моего Курса 
выглядящей более похожей на веб-Сайт? 

Часто, когда Курс имеет большое содержимое, Студенты и Преподаватели находят 

длинную прокрутку нудной и предпочли бы «лаконичные» появления гиперссылок на 

Разделы, в манере, подобной переходу на страницы при работе с веб-Сайтами. 

 См. в «Форматы Курсов» (п. 4.1.4) о способе показать только один Раздел на странице. 

 Ссылки на Закладки/Раздел могут помочь. Но страница Курса может всё ещё 

оставаться длинной. 

 Сокрытие Действий сокращает список для Студентов, но тогда эти Действия не могут 

быть выбраны Студентами. 

Один метод, который может быть полезен, состоит в том, чтобы вставить Действия 

в Разделы, которые затем сделать «невидимыми» для Студентов. 

Основной пример 

 Установите число тем в настройках Курса на 1 больше, чем Студенты будут видеть. 

 

 Например, вы планируете, чтобы Студенты могли видеть 6 тем, установите её 

равной 7. 

 Добавьте Действия в тему 7, такую как Экзамен (в нашем примере). 

 Получите URL вашего Экзамена. 

 Скопируйте и сохраните его где-нибудь (например в Блокноте) для использования 

позже. 

 Вернитесь к AdministrationCourse administrationSettings и измените вашу 

тему/неделю на 6. 

 Или на 1 меньше, чем вы имели до этого. 

 Раздела с вашим Экзаменом больше не будет на странице, которую видят Студенты. 

http://moodle.org/mod/forum/discuss.php?d=204488#p891807
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 In another section, make a hyperlink to the quiz using its url 

 You can also put it in a topic summary, label or 

 as a resource (link to a file or website) 

You will find that the quiz is accessible to students even though the section 

does not physically appear on the course page for the students. You have 

shortened the page. 

More advanced example 

 There is a youtube video that gives an example of how to do this here. 

The video is of a Moodle 1.9 course but the principle still applies. 

 You can actually set up your whole course using this method. 

 Set your course to have two topics (or more if you wish) 

 Ignore topic 1 - do not place anything in it. 

 In topic 2, use the resource: Page to make pages relating to your units of 

work/topics 

 Add all your resources to topic 2 

 Copy the resources urls into the relevant webpage as hyperlinks 

 In topic 0, the course summary make hyperlinks -or better- images 

hyperlinked - to each webpage which contains the activities of that 

unit/topic 

 Go back to course settings and set the number of visible topics to 1. 

The teacher will see the hidden sections as "orphaned" items on their 

course page. However; the student will only see the top of the page. When 

they click on a link in the header, they are taken to the hidden webpage 

resources, where they select the resource or activity they wish. This creates 

a very short visual page but keeps all the course material within the course. 

4.1.6.8.I am unable to edit a topic summary: 
the edit icon doesn't work any more (is not 
clickable) 
 This often happens if something copied and pasted from another source, 

such as MS Word has corrupted your topic summary. This forum post 

suggests three possible solutions. 

4.1.6.9.Where can I find a list of all course 
resources? 
http://yourmoodlesite.net/course/resources.php?id=x where x is the course 

ID number, for example 

http://school.demo.moodle.net/course/resources.php?id=115. 

 

 

 В другом разделе создайте гиперссылку на ваш Экзамен, используя его URL. 

 Вы можете также вставить его в краткое изложение Темы, Метку или 

 Как Ресурс (ссылка на файл или веб-Сайт). 

Вы можете обнаружить, этот Экзамен доступен Студентам, даже если Раздел 

физически не появляется на странице Курса для Студентов. Вы сократили страницу. 

 

Более продвинутый пример 

 Существует Youtube-видео, которое подаёт пример того, как это сделать здесь. Это 

видео Курса в Moodle 1.9, но его принципы всё ещё применимы. 

 Вы на самом деле можете установить весь ваш Курс целиком, используя этот метод. 

 Установите, чтобы ваш Курс имел две Темы (или больше, если захотите) 

 Проигнорируйте Тему 1 – ничего в неё не помещайте. 

 В Теме 2 используйте Ресурс: Page (страница, п. 4.4.6), чтобы создать страницы, 

относящиеся к вашим блокам работы/тем. 

 Добавьте все ваши Ресурсы в Тему 2. 

 Скопируйте URL Ресурсов в подходящую Page как гиперссылки. 

 В Теме 0, краткого изложения Курса, создайте гиперссылки (или лучше) изображения с 

возможностью гиперссылок, – на каждую веб-страницу, которая содержит Действия 

этого блока/темы. 

 Вернитесь в настройки Курса и установите число видимых Тем равным 1. 

Преподаватели будут видеть скрытые Разделы как «зависшие» элементы на своей 

странице Курса. Однако Студенты увидят только верхушку этой страницы. Когда они 

щёлкнут по ссылке в верхнем колонтитуле, они обретут Ресурсы скрытой веб-страницы, 

где они выберут Ресурс или Интерактивное Действие, которое пожелают. Это создаёт 

страницу краткой для просмотра, но сохраняет все материалы Курса внутри Курса. 

4.1.6.8.Я не могу отредактировать аннотацию Темы: 
иконка редактирования больше не работает (не 
щёлкается) 
 Это часто случается при копировании и вклеивании из других источников, таких как 

MS Word, которые повредили краткое изложение Темы. Этот форум предлагает три 

возможных решения проблемы. 

4.1.6.9.Где можно найти список всех Ресурсов Курса? 
 

http://yourmoodlesite.net/course/resources.php?id=x, где x есть ID-номер Курса, 

например, http://school.demo.moodle.net/course/resources.php?id=115. 

http://www.youtube.com/watch?hl=en-GB&v=XtHPUh_BaxM&gl=GB
http://moodle.org/mod/forum/discuss.php?d=194072&parent=845434
http://yourmoodlesite.net/course/resources.php?id=x
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4.1.6.10.Is it possible to download all files 
from a course? 
It is possible, but not easy. See 

http://moodle.org/mod/forum/discuss.php?d=208003#p907058. 

4.1.6.11.I get an error message "paging_bar 
requires a perpage value" 
I had the same problem I just change the numbers of the courses in front 

page and now it is working. 

4.1.6.12.Can I put a course in more than one 
category? 
Currently this is not possible. There are workarounds however. One 

suggested workaround (from the 2012 French speaking Moodle Moot and 

hightlighted here https://moodle.org/mod/forum/discuss.php?d=214514) 

needs access to course/view.php. Use at your own risk: 

Add the following code to course/view.php before the  

preload_course_contexts function: 

$is_admin = has_capability('moodle/site:config', 

get_context_instance(CONTEXT_SYSTEM)); 

 if (!$is_admin && $course->idnumber) { 

 redirect($CFG->wwwroot.'/course/view.php?id='.$course->idnumber);} 

Then get the ID of the course you want to point to. Make a second course, 

and in its ID field add the ID of the course you want to point to. 

When a user clicks the link to the second course, the first course will open 

up instead EXCEPT if you are the administrator (so you can edit if 

necessary) 

4.1.6.13.Is there a shortcut URL to a course? 
 
Try this using the course shortname: URL 

(Moodlesite)/course/view.php?name=shortname to navigate directly to a 

course. 

Check out the tracker item for clean URL's: 

https://tracker.moodle.org/browse/MDL-28030. 

 

 

 

 

 

4.1.6.10.Можно загрузить все файлы из Курса? 
 

Это возможно, но не легко. См. 

http://moodle.org/mod/forum/discuss.php?d=208003#p907058. 

4.1.6.11.Я получил сообщение об ошибке «Панель 
разбиения на страницы требует значения Perpage» 

Я имел ту же самую проблему и просто изменил Maximum number of courses 

(максимальное число курсов) в настройках Главной Страницы, и сейчас всё работает. 

4.1.6.12.Могу я разместить Курс более, чем в одной 
Категории? 

В настоящее время это невозможно. Однако существуют обходные способы 

сделать это. Один из предложенных (с 2012 года Дискуссия по Moodle говорящих на 

французском и подсвечена здесь https://moodle.org/mod/forum/discuss.php?d=214514) 

нуждается в доступе к course/view.php. Используйте на собственный страх и риск: 

Добавьте следующий код к course/view.php перед функцией preload_course_contexts: 

$is_admin = has_capability('moodle/site:config', 

get_context_instance(CONTEXT_SYSTEM)); 

 if (!$is_admin && $course->idnumber) { 

 redirect($CFG->wwwroot.'/course/view.php?id='.$course->idnumber);} 

 

Затем получите ID Курса, на который вы хотите указать. Создайте второй Курс и в 

его поле ID добавьте ID Курса, на который вы хотите указать. 

Когда пользователь щёлкнет по второму Курсу, вместо него откроется первый 

Курс, ИСКЛЮЧАЯ случай, когда вы Администратор (тогда вы можете редактировать, 

если необходимо). 

4.1.6.13.Существует ли быстрая клавиша URL для 
перехода к Курсу? 

Попробуйте такое применение краткого названия Курса: URL для перехода 

непосредственно к Курсу (Moodlesite)/course/view.php?name=shortname. 

 

Пометьте элемент Средства Слежения для чистки указателей URL: 

https://tracker.moodle.org/browse/MDL-28030. 

http://moodle.org/mod/forum/discuss.php?d=208003#p907058
https://tracker.moodle.org/browse/MDL-28030
http://moodle.org/mod/forum/discuss.php?d=208003#p907058
https://moodle.org/mod/forum/discuss.php?d=214514
https://tracker.moodle.org/browse/MDL-28030
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4.2.Editing text 
How to use the text editor and what the icons mean. 

The usual way to edit or create text that is part of the visual content of a 

course is using the Text editor (also known as the HTML editor). 

The way to edit the text in the content area, depends the current role or 

permissions of the user in a context. 

 

 A teacher will see many Editicon.PNG ("edit hand") icons on a course's 

home page when "Turn editing on" button has been clicked. Or they 

will see the HTML editor and content area within many activities and 

resources. For example, a teacher can edit the text that appears at the 

top of a section in a course by clicking on the edit hand icon. 

 

 A student and a teacher will see the HTML tool when they reply to a 

forum post but will not have the ability of changing a topic heading in 

the course. 

Editing text example 
Screenshot "Typical content area. Shows HTML editor on top with text 

and emoticon in content". 

 

 

 

 

 

 

 

Screenshot "Here is what students will see". 

 

 

 

 

 

 

 

 

 

 

 

 

4.2.Редактирование текста 
Как использовать текстовый редактор, и что означают иконки. 

Обычный способ редактировать или создавать текст, который является визуальным 

содержимым Курса, это использование текстового редактора Text editor (известного также 

как редактор HTML). 

Способ редактирования текста в области содержимого зависит от текущей Роли (п. 

3.4) и Полномочий пользователя в Контексте (п. 6.2). 

 Когда Преподаватель щёлкнет кнопку «Turn editing on (включить режим 

редактирования)», он увидит много Editicon.PNG-иконок редактирования на 

Домашней Странице Курса. Или он увидит редактор HTML и область содержимого 

внутри многих Интерактивных Действий и Ресурсов. Например, Преподаватель может 

отредактировать текст, который появляется вверху Раздела в Курсе щелчком по 

шестерёнке – иконке редактирования (раньше была «рука»). 

 Студент и Преподаватель могут увидеть инструмент HTML при ответе на 

корреспонденцию Форума, но не будут иметь возможности изменить заголовок Темы в 

Курсе. 

Пример редактирования текста 
Снимок с экрана «Типичная 

область содержимого. Показывает 

HTML-редактор вверху с текстом и 

смайликами ниже в содержимом». 

 

 

 

 

 

Снимок с экрана «Здесь то, 

что увидят Студенты». 
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Text editing on a Moodle site 
Teachers and administrators should be aware that the Moodle code 

contains "strings" of text that can be edited though customizing the 

language on a site wide basis. 

See also 
 Text editor FAQ 

4.2.1.Text editor 
The text editor (sometimes referred to as the 'HTML editor') has many 

icons to assist the user in entering content. Many of these icons and 

functions should be familiar to anyone who uses a word processor. Some 

examples of where you will see the text editor include: Editing Section 

headings, description of an activity, writing an answer to a quiz question or 

editing the content of many blocks. 

Note: It's possible to disable the HTML editor and only use a plain text 

editor from Administration>Site administration>Plugins>Text 

editors>Manage editors. 

4.2.1.1.The collapsed editor 
Since Moodle 2.5, the text editor appears collapsed with no formatting in 

many places to save space. To access the full editor, click "Show editing 

tools" as in (1) in the screenshot below. You can use keyboard shortcuts 

for quick formatting as in (2) in the screenshot below. (See Text editor 

FAQ for a list of shortcuts.) To increase the size of the editor, drag the 

bottom right once you have clicked "Show editing tools" as in (3) in the 

screenshot below. 

1, 2. Screenshot "The collapsed editor". 

3. Screenshot "The expanded editor". 

4. Screenshot "The standard version of the full text editor tool bar". 

 

 

 

 

 

 

 

 

 

 

 

 

Редактирование текста на Сайте Moodle 

Преподаватели и Администраторы должны быть осведомлены, что код Moodle 

содержит «строки» текста, которые могут быть отредактированы, несмотря на настройку 

языка (п. 3.9.2) по требованию клиента для всего Сайта. 

См. также 
 Часто задаваемые вопросы по текстовому редактору (п. 4.2.3).  

4.2.1.Текстовый редактор 
Текстовый редактор (иногда упоминаемый как HTML-редактор) имеет много 

иконок для помощи пользователю по входу в содержимое. Многие из этих иконок и 

функций должны быть знакомы любому, кто использует Word-процессор. Некоторые 

примеры, где вы увидите текстовый редактор включают: Редактирование заголовков 

Разделов, Описание Действия, Запись ответа на Вопрос Экзамена или Редактирование 

содержимого многих Блоков. 

Замечание: Можно отключить HTML-редактор и использовать только простой 

текстовый реактор из AdministrationSite administrationPluginsText editors 

Manage editors. 

4.2.1.1.Свёрнутый редактор 
Начиная с Moodle 2.5, текстовый редактор во многих местах появляется свёрнутым 

без панели форматирования для экономии пространства. Для доступа к полному редактору 

щёлкните «Show editing tools (показать инструменты редактирования)» как на 1 снимке с 

экрана ниже. Вы можете использовать «быстрые» клавиши для быстрого форматирования 

как на 2 снимке экрана ниже. (См. список «быстрых» клавиш в п. 4.2.3) Чтобы увеличить 

размер редактора, перетащите правый нижний уголок области содержимого сразу после 

щелчка по «Show editing tools» как на 3 снимке с экрана ниже. 

1,2. Снимок с экрана «Свёрнутый редактор». 

3. Снимок с экрана «Развёрнутый редактор». 

4.Снимок с экрана «Стандартная версия панели инструментов полного текстового 

редактора». 

http://docs.moodle.org/25/en/File:collapsededitor1.png
http://docs.moodle.org/25/en/File:expandeditor.png
http://docs.moodle.org/25/en/File:HTMLeditor_tools_M2_1.png
http://docs.moodle.org/25/en/File:HTMLeditor_tools_M2_1.png
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4.2.1.2.List of groups 
For those who are not familiar with the tool bar, here are the functions 

listed by group using the above example. Remember that the site 

administrator can edit or provide additional toolbars. 

Row 1 

1.Font, size and heading group 

2.Undo and Redo group 

3.Find and Replace group 

4.Full screen toggle 

Row 2 

1.Text effect group 

2.Line format group 

3.Formatting group 

4.Color group 

5.Paragraph group 

Row 3 

1.Number and Bullets and indents 

2.Link group 

3.Insert group 

4.HTML source toggle and spellchecker (IE 9/8 only) 

4.2.1.3.Special features 
4.2.1.3.1.Color pickers 
There are four levels of selecting a font or background color, 

 A quick pick 5x8 matrix of colors 

 "More colors" that links to Picker, Pallet and Named tabs 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.2.1.2.Список групп 
Для тех, кто не знаком с панелью инструментов, здесь перечислены функции по 

группам, используя пример выше. Помните, что Администратор Сайта может 

отредактировать или предоставить дополнительные инструментальные панели. 

 

Строка 1 
 

 

 

 

Строка 2 

 
Строка 3 
 

 

 

 
 

4.2.1.3.Специальные средства 
4.2.1.3.1.Средства выбора цвета 

Существует 4 уровня выбора цвета шрифта и фона: 

 Матрица 5x8 быстрого выбора цветов (рис. ниже слева). 

 «Дополнительные цвета»: Выбор цветов радуги, Палитра и Поименованные таблицы. 
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4.2.1.3.2.Insert images and media 
1 Insert Image - uses File picker 

2 Insert Emoticon 

3 Insert Media - uses File picker 

4 Insert Equation - uses java script editor 

5 Insert Nonbreaking space 

6 Insert Custom character - Special keyboard characters 

7 Insert Table 

 

 

 

 

 

 

 

 

 

 

 

 

 

File picker Upload file screen 

 

 

 

 

 

 

 

 

 

 

 

 

 

Equation editor 

 

 

 

 

4.2.1.3.2.Вставить изображения и медиа 
1.Вставить изображение – использует средство выбора файлов. 

2.Вставить смайлик. 

3.Вставить медиа – использует средство выбора файлов. 

4.Вставить уравнение – использует JavaScript-редактор. 

5.Вставить неразрывный пробел. 

6.Вставить пользовательский символ – специальные символы клавиатуры. 

7.Вставить таблицу. 

 
Экран пересылки файлов средства выбора файлов 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Редактор уравнений 
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Custom character selector 

 

Insert table 
 

 

 

 

 

 

General tab 

 

 

 

 

 

 

 

 

 

Advanced tab 

 

 

 

 

 

 

 

 

 

 
Селектор пользовательских символов 

 

Вставить таблицу 
 

 

 

 

 

 

Обычная таблица 

 

 

 

 

 

 

 

 

Продвинутая таблица 
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To add borders to a table 
Cell borders are crucial for helping readers to follow the rows across the 

screen. If they aren’t showing already you can add them as follows: 

 

 In the Wiki page containing your table, click its Edit tab 

 Carefully select all the cells of the table 

 Then right click (Macs: Command+click or Ctrl+Click) over any part of 

your selection to get a context menu; from it select Cell > Table Cell 

Properties; the cell properties dialog box then loads. 

 Click on its Advanced tab, set Border Color to black (for instance), then 

click Apply, and then click Update. 

 Click Save; the Wiki page containing your table will then load 

displaying its borders. 

4.2.1.4.Site administration settings 
4.2.1.4.1.Manage editors 
A site administrator can enable / disable text editors in Settings > Site 

administration > Plugins > Text editors > Manage editors. By default the 

TinyMCE HTML editor and plain text area are enabled. 

4.2.1.4.2.TinyMCE editor settings 
The TinyMCE HTML editor has its own settings page Administration>Site 

administration>Plugins>Text editors>TinyMCE HTML editor>General 

settings with the following options: 

Plugins 
Buttons for equations, emoticons, images, media, automatic linking, and 

legacy spell-checking may be enabled, disabled or uninstall here by 

clicking on their eye. 

Additionally the equation, emoticon and spell check buttons have links to 

their Settings screens. 

The TinyMCE editor plugins screen 

 

 

 

 

 

 

 

 

 

Чтобы добавить границы к таблице 
Границы ячейки являются решающими факторами для помощи читателям 

следовать по строкам экрана. Если они уже не показываются, вы можете добавить их 

следующим образом: 

 На странице Вики, содержащей вашу таблицу, щёлкните ярлычок её редактирования. 

 Тщательно выберите все ячейки таблицы. 

 Затем щёлкните правой кнопкой мыши (Macs: Command+click или Ctrl+Click) по любой 

части вашего выбора, чтобы получить контекстное меню; из него выберите 

CellTable Cell Properties; затем загрузится окошко диалога свойств ячейки. 

 Щёлкните на его Advanced tab, установите чёрным (например) Border Color (цвет 

границы), затем щёлкните Apply (применить) и затем щёлкните Update (обновить). 

 Щёлкните Save (сохранить); страница Вики, содержащая вашу таблицу, затем загрузит 

отображение её границ. 

4.2.1.4.Настройки управления Сайта 
4.2.1.4.1.Управлять редакторами 

Администратор Сайта может включить/отключить текстовые редакторы в 

AdministrationSite administrationPluginsManage editors. По умолчанию разрешены 

редактор TinyMCE HTML и область простого текста. 

4.2.1.4.2.Настройки TinyMCE редактора 
Редактор TinyMCE HTML имеет свою собственную страницу настроек 

AdministrationSite administrationPluginsText editorsTinyMCE HTML editor 

General settings со следующими опциями: 

Плагины 
Кнопки для уравнений, смайликов, изображений, медиа, автоматического 

связывания и унаследованной проверки орфографии могут быть подключены, отключены, 

деинсталлированы здесь щелчком по их «глазу». 

Кроме того, кнопки уравнения, смайлика и проверки орфографии имеют ссылки на 

их экраны настройки. 

Экран 

Плагинов 

редактора 

TinyMCE 
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Insert equation 
Accessed from Administration>Site administration>Plugins>Text 

editors>TinyMCE HTML editor>Edit equation, this allows you to enable 

or disable the TeX filter in the editor context and thereby display the 

Dragmath button. If you have a global custom TeX filter, then disable this 

setting. 

Insert emoticon 
Accessed from Administration>Site administration>Plugins>Text 

editors>TinyMCE HTML editor>Insert emoticon, this allows you to 

enable or disable the emoticon filter in the editor context and thereby 

display the emoticon button. 

Legacy spell checker 
The legacy spell checker is visible in IE9 and lower only, but not in other 

browsers. If you want to disable it and rely on browser spell checker 

functionality instead, you can do this by disabling the legacy spellchecker 

plugin by clicking its eye in Administration > Site administration > Plugins 

> Text editors > TinyMCE HTML editor > General settings 

To spell-check via your browser, type your word (which if incorrectly spelt 

will have red lines under it) and press right click + CTRL. 

 

You can select a different spell engine from Administration>Site 

administration > Plugins > Text editors > TinyMCE HTML editor>Check 

spelling 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Вставить уравнение 
Доступно из 

AdministrationSite administrationPluginsText editorsTinyMCE HTML editorEdit eq

uation, это позволяет вам подключить или отключить TeX-фильтр в Контексте редактора и 

около отобразить кнопку Dragmath (отбуксировать математические символы). Если у вас 

глобальный пользовательский TeX-фильтр, тогда отключите эту опцию. 

Вставить смайлик 
Доступно из 

AdministrationSite administrationPluginsText editorsTinyMCE HTML editorInsert em

oticon, это позволяет вам подключить или отключить фильтр смайликов в Контексте 

редактора и таким образом отобразить кнопку смайлика. 

Унаследованный Блок орфографического контроля 
Унаследованный блок орфографического контроля видим только в IE9 и ниже, но 

не в других браузерах. Если вы хотите отключить его и полагаться вместо этого на 

функции проверки орфографии браузера, вы можете это сделать отключением Плагина 

проверки орфографии посредством щелчка по его «глазу» в Administration 

Site administrationPluginsText editorsTinyMCE HTML editor General settings. 

Чтобы проверить орфографию через ваш браузер, наберите ваше слово (которое, 

будучи написано некорректно, будет подчёркнуто красной линией) и нажмите правую 

кнопку мыши  одновременно с клавишей CTRL. 
Вы можете выбрать различные орфографические машины из Administration 

Site administrationPluginsText editorsTinyMCE HTML editorCheck spelling. 
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Screenshot «Choosing a different spell engine». 

According to: http://php.net/manual/en/book.pspell.php 

"As of php 5.3. Pspell is no longer supported/bundled. Instead you can use 

the enchant which is bundled by default in 5.3." 

 
NOTE: While the default spell engine is Google spell which can be 

changed in Administration>Site administration>Plugins>Text 

editors>TinyMCE HTML editor, this is no longer supported by Google 

and will not work. (Note that it is only visible in IE9 and lower) It is due to 

be removed. See MDL-38867. In browser spell check is recommended. 

 
If PSpell is selected then aspell 0.50 or later must be installed on your 

server and the path to aspell set in Administration > Site administration > 

Server > System Paths. 

4.2.1.4.3.Customising the editor toolbar 
An administrator can remove or add buttons to the TinyMCE editor toolbar 

by altering the Editor toolbar box in Administration>Site 

administration>Plugins>Text editors>TinyMCE HTML editor>General 

settings as demonstrated in the screencast Customise the text editor in 2.4 

Screenshot «The Editor toolbar box». 

Screenshot « Example of simpler toolbar with added horizontal rule 

button». 

Screenshot «An "insert time" button has been added». 

Available fonts list 
In addition to the default fonts, a site administrator can add extra fonts by 

typing their name and string in the box in Administration > Site 

administration > Plugins > Text editors > TinyMCE HTML editor>General 

settings as demonstrated in the screencast How to add extra fonts. 

 

Screenshot «Example of custom font». 

 

 

 

 

 

 

 

 

 

 

Снимок с экрана «Выбор другой орфографической машины». 

В соответствии с http://php.net/manual/en/book.pspell.php  

«Поскольку php 5.3. Pspell не поддерживается больше/не поставляется в комплекте. 

Вместо этого вы можете использовать Enchant, который поставляется по умолчанию в 

5.3.» 

Замечание: Пока орфографической машиной по умолчанию является 

орфографическая машина Google, которая может быть изменена в Administration 

Site administrationPluginsText editorsTinyMCE HTML editor, она больше не 

поддерживается Google и не работает. (Заметьте, она видима только в IE9 и ниже). Это 

потому, что она была удалена. См. MDL-38867. Рекомендуется использовать 

орфографическую проверку браузера. 

Если выбирается PSpell, тогда aspell 0.50 или более поздняя версия должна быть 

инсталлирована на вашем сервере и должен быть прописан путь к aspell в 

AdministrationSite administrationSystem Paths. 

4.2.1.4.3.Настраивание панели редактора под клиента 
Администратор может удалить или добавить кнопки в панель редактора TinyMCE 

посредством изменения информации в окошке панели редактора в 

AdministrationSite administrationPluginsText editorsTinyMCE HTML editorGeneral

 settings, как демонстрируется в фильме с экрана «Настройка текстового редактора в 2.4». 

Снимок с экрана «http://docs.moodle.org/25/en/File:editortoolbar.png». 

Снимок с экрана «Пример простейшей панели с добавленной кнопкой 

горизонтального прокручивания». 

Снимок с экрана «Кнопка «Вставить время» была добавлена». 

Доступный список шрифтов 
В дополнение к шрифтам по умолчанию Администратор Сайта может добавить 

дополнительные шрифты, набрав их название и строку в окошке 

AdministrationSite administrationPluginsText editorsTinyMCE HTML editorGeneral

 settings, как демонстрируется в фильме с экрана «Как добавить дополнительные 

шрифты». 

Снимок с экрана «Пример пользовательского шрифта». 

http://docs.moodle.org/25/en/File:Spellengine.png
http://php.net/manual/en/book.pspell.php
http://tracker.moodle.org/browse/MDL-38867
http://www.youtube.com/watch?v=vTW1DImro9c&feature=youtu.be
http://docs.moodle.org/25/en/File:editortoolbar.png
http://docs.moodle.org/25/en/File:horizontalrule.png
http://docs.moodle.org/25/en/File:horizontalrule.png
http://docs.moodle.org/25/en/File:inserttime.png
http://youtu.be/udP7Bnur30Y
http://youtu.be/udP7Bnur30Y
http://docs.moodle.org/25/en/File:comicsans.png
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Custom configuration 
A setting in Administration>Site administration>Plugins>Text 

editors>TinyMCE HTML editor>General settings provides a box in which 

an administrator can apply custom formats. See MDL-37186 for more 

details with examples, and see also the TinyMCE configuration page. 
Screenshot «Example 1: Toolbar at the bottom». 

Screenshot «Example 2: Custom styles». 

 Example: Moving the toolbar to the bottom: 

Add the following: 
{"theme_advanced_toolbar_location" : "bottom"} 

 Example: Adding your own custom styles. 

(This might be useful for example if you want a "house style" for important 

notes, key points or similar) In the editor toolbar, enter "styleselect" and 

then in the custom box add the following code, changing it to suit your 

purposes: 

{"style_formats" : [ 

 {"title" : "Bold text", "inline" : "b"}, 

 {"title" : "Red text", "inline" : "span", "styles" : {"color" : "#ff0000"}}, 

 {"title" : "Red header", "block" : "h1", "styles" : {"color" : "#ff0000"}} ]} 

The following will let you use bootstrap CSS classes if you use a bootstrap 

based theme: 

   {"style_formats" : [ 

       {"title" : "Well", "block" : "div", "classes" : "well"}, 

       {"title" : "Label", "inline" : "span", "classes" : "label"}, 

       {"title" : "Label - success", "inline" : "span", "classes" : "label label-

success"}, 

       {"title" : "Label - warning", "inline" : "span", "classes": 

"label label-warning"}, 

       {"title" : "Label - important", "inline" : "span", "classes" : "label label-

important"}, 

       {"title" : "Label - info", "inline" : "span", "classes" : "label label-

info"}, 

 

 

 

 

 

 

 

 

Конфигурация под клиента 
Настройка в AdministrationSite administrationPluginsText editors 

TinyMCE HTML editorGeneral settings предоставляет окошко, в котором Администратор 

может применить форматы клиента. См. MDL-37186 для дополнительной информации о 

примерах, а также см. страницу конфигурации редактора TinyMCE. 

Снимок с экрана «Пример 1. Панель внизу». 

Снимок с экрана «Пример 2. Стили клиента». 

 Пример: Перемещение панели вниз: 

Добавьте следующее: 
{"theme_advanced_toolbar_location" : "bottom"} 

 Пример: Добавление ваших собственных стилей клиента. 

(Это может быть полезно, например, если вы хотите общего стиля» для важных 

заметок, стратегических пунктов  или подобного.) В панели редактора введите «Styleselect 

(выбор стиля)» и затем в окошке клиента добавьте следующий код, изменив его, чтобы 

приспособить его к вашим целям: 

{"style_formats" : [ 

 {"title" : "Bold text", "inline" : "b"}, 

 {"title" : "Red text", "inline" : "span", "styles" : {"color" : "#ff0000"}}, 

 {"title" : "Red header", "block" : "h1", "styles" : {"color" : "#ff0000"}} ]} 

Следующее позволит вам использовать компенсирующие классы CSS, если вы 

используете тему, основанную на компенсации. 

   {"style_formats" : [ 

       {"title" : "Well", "block" : "div", "classes" : "well"}, 

       {"title" : "Label", "inline" : "span", "classes" : "label"}, 

       {"title" : "Label - success", "inline" : "span", "classes" : 

"label label-success"}, 

       {"title" : "Label - warning", "inline" : "span", "classes": 

"label label-warning"}, 

       {"title" : "Label - important", "inline" : "span", "classes" : 

"label label-important"}, 

       {"title" : "Label - info", "inline" : "span", "classes" : "label label-info"}, 

http://tracker.moodle.org/browse/MDL-37186
http://docs.moodle.org/25/en/File:bottomtoolbar.png
http://docs.moodle.org/25/en/File:customstyles.png
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       {"title" : "Label - inverse", "inline" : "span", "classes" : "label label-

inverse"}, 

       {"title" : "Button", "inline" : "a", "classes" : "btn btn"}, 

       {"title" : "Button - primary", "inline" : "a", "classes" : "btn btn-

primary"}, 

       {"title" : "Button - info", "inline" : "a", "classes" : "btn btn-info"}, 

       {"title" : "Button - success", "inline" : "a", "classes" : "btn btn-

success"}, 

       {"title" : "Button - warning", "inline" : "a", "classes" : "btn btn-

warning"}, 

       {"title" : "Button - danger", "inline" : "a", "classes" : "btn btn-

danger"}, 

       {"title" : "Button - inverse", "inline" : "a", "classes" : "btn btn-

inverse"} 

   ]} 

Example: Enabling copy of rich content with styles from MS Word (tm) 

and paste into TineMCE without removing important styles: 

{"paste_retain_style_properties" : "margin, padding, width, height, font-

size,  

  font-weight, font-family, color, text-align, ul, ol, li,  

  text-decoration, border, background, float, display"} 

4.2.1.5.See also 
 Text editor FAQ 

4.2.2.Formatting text 
When writing text in Moodle there are several formats you can choose to 

produce your text. 

4.2.2.1.Formatting text options 
By default, the Text editor is available for all text areas in Moodle and the 

format is automatically set to HTML format. 

However, if the setting 'When editing text' in Settings > My profile settings 

> Edit profile is set to 'Use standard web forms', then various format 

options are available in a dropdown menu below the text area. 

 

 

 

 

 

 

 

       {"title" : "Label - inverse", "inline" : "span", "classes" : "label label-inverse"}, 

 

       {"title" : "Button", "inline" : "a", "classes" : "btn btn"}, 

       {"title" : "Button - primary", "inline" : "a", "classes" : "btn btn-primary"}, 

 

       {"title" : "Button - info", "inline" : "a", "classes" : "btn btn-info"}, 

       {"title" : "Button - success", "inline" : "a", "classes" : "btn btn-success"}, 

 

       {"title" : "Button - warning", "inline" : "a", "classes" : "btn btn-warning"}, 

 

       {"title" : "Button - danger", "inline" : "a", "classes" : "btn btn-danger"}, 

 

       {"title" : "Button - inverse", "inline" : "a", "classes" : "btn btn-inverse"} 

 

   ]} 

Пример: Разрешение копирования полного содержимого со стилями от MS Word 

(tm) и вклеивания в редактор TineMCE без удаления важных стилей. 

{"paste_retain_style_properties" : "margin, padding, width, height, font-size, 

 

  font-weight, font-family, color, text-align, ul, ol, li,  

  text-decoration, border, background, float, display"} 

4.2.1.5.См. также 
 Часто задаваемые вопросы по текстовому редактору. 

4.2.2.Форматирование текста 
При записи текста в Moodle существует несколько форматов, которые вы можете 

выбрать, чтобы произвести ваш текст. 

4.2.2.1.Опции форматирования текста 
По умолчанию текстовый редактор доступен для всех текстовых областей в Moodle 

и его формат автоматически устанавливает формат HTML. 

Однако, если настройка «When editing text (при редактировании текста)» (в 

NavigationMy profile, а затем AdministrationMy profile settingsEdit profile) 

устанавливается в «Use standard web forms (использовать стандартные веб-формы)», тогда 

различные опции формата становятся доступными в ниспадающем меню ниже области 

текста. 

http://docs.moodle.org/25/en/Text_editor_FAQ
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4.2.2.2.HTML format 
When writing HTML in Moodle, you are free to use almost any HTML 

tags you like to produce the effect you want. 

Note that scripting (eg Javascript or VB Script) is not allowed, and will be 

removed automatically. 

Your code will normally be printed on the page within a table cell, so: 

 There is no need to use any <HEAD> or <BODY> tags 

 Be careful about unmatched </TABLE> tags that may mess up the 

display. 

Anything starting with www. or http:// will automatically be turned into a 

clickable link, for example www.moodle.org (assuming the Convert URLs 

into links filter is enabled by an administrator). 

 

This format assumes the text is pure HTML. If you are using the text editor 

to edit text then this is the default format - all the commands in the toolbar 

are producing HTML for you. 

Even if you are not using the text editor, you can use HTML code in your 

text and it should come out exactly as you intended. 

4.2.2.3.Moodle auto-format 
This format is best for when you are using normal web forms for entry 

(instead of using the text editor). Just type text normally, as if you were 

sending an email. 

When you save your text, Moodle will do a number of things to 

automatically format your text for you. 

As for HTML format, websites will automatically be turned into a 

clickable link (assuming the Convert URLs into links filter is enabled by 

an administrator). 

Smiley characters such as :-) will automatically become their graphical 

equivalents (assuming the Display emoticons as images filter is enabled by 

an administrator). 

 

 

 

 

 

 

 

 

 

4.2.2.2.Формат HTML 
При записи HTML в Moodle вы свободны в использовании почти любых тэгов 

HTML, которые вам понравятся для образования эффекта, который вам нужен. 

Заметьте, что написание сценария (например, Javascript или VB сценария) не 

разрешается и будет удалено автоматически. 

Ваш код нормально будет распечатан на странице внутри ячейки таблицы так: 

 Нет необходимости использовать любые тэги <HEAD> или <BODY>. 

 Позаботьтесь о тэгах </TABLE> без пары, которые могут помешать отображению. 

 

Всё начинающееся с www. или http:// автоматически будет превращено в 

активируемую щелчком мыши ссылку, например, www.moodle.org (допущение 

«Конвертировать указатели URL в фильтр ссылок» (см. п. 5.5.1) разрешается 

Администратором). 

Этот формат предполагает, что текст является чистым HTML. Если вы используете 

текстовый редактор для редактирования текста, тогда это формат по умолчанию – все 

команды в инструментальной панели образуют HTML для вас. 

Даже если вы не используете текстовый редактор, вы можете использовать код 

HTML в вашем тексте и это должно привести вас точно к тому, к чему вы стремились. 

4.2.2.3.Авто-формат Moodle 
Этот формат лучше всего подходит, когда вы используете обычные веб-формы для 

ввода (вместо использования текстового редактора). Просто наберите текст обычным 

образом, как если бы вы отправляли почту. 

Когда вы сохраните ваш текст, Moodle автоматически отформатирует ваш текст. 

 

Так для формата HTML веб-Сайты будут автоматически превращаться в 

активируемую щелчком мыши ссылку (позволение «Конвертировать URLs в фильтр 

ссылок» (см. п. 5.5.1) разрешается Администратором). 

Символы смайликов, такие как :-), автоматически превращаются в свои 

графические эквиваленты (предложение «Отображать смайлики аналогично фильтру 

изображений» (см. п. 5.5.1) разрешается Администратором). 

 

http://docs.moodle.org/25/en/Convert_URLs_into_links_filter
http://docs.moodle.org/25/en/Display_emoticons_as_images_filter
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Your line breaks will be retained, and blank lines will start new 

paragraphs. 

You can even embed HTML code if you want to and it will be retained. 

 

 

 

 

 

 

 

 

4.2.2.4.Plain text format 
This format is useful when you need to include lots of code or HTML that 

you want to be displayed exactly as you wrote it. 

It still translates spaces and new lines, but otherwise your text isn't 

touched. 

4.2.2.5.Markdown text format 
Markdown format tries to make it easy as possible to type well-formatted 

XHTML pages using nothing but text written more or less like you would 

write an email. 

It's very good for writing clean text pages with some headings and some 

lists but without many links or images. It is an excellent choice when 

accessibility of the generated page is important. 

An unordered list may be created with asterisks (*). 

For complete syntax description, see: 

http://daringfireball.net/projects/markdown/syntax Moodle 1.6 has 

extended features called Markdown Extra: for additional features see 

http://www.michelf.com/projects/php-markdown/extra/ 

4.2.2.6.Tips and Tricks 
 Wrong Characters Showing - If some users do not see the same 

characters or figures, have them check their browser settings for their 

character settings. At Moodle.org, the recommended default character 

decoding set is UTF-8. On a Firefox browser, this can be found in 

Tools>Options>Fonts & colors>advanced>default character decoding 

pull down menu. 

 If that doesn't work you can try installing a UTF-8 Unicode font from: 

http://titus.fkidg1.uni-frankfurt.de/unicode/tituut.asp. (This has at least 

helped XP users that weren't seeing stars in the ratings.) 

 

Ваши переносы строк будут сохранены, а пустые строки будут начинать новые 

параграфы. 

Вы можете встроить код HTML, если вы хотите этого, и он будет сохранён. 

 

4.2.2.4.Формат простого текста 
Этот формат полезен, когда вам нужно включить много кода или HTML, которые 

вы бы хотели, чтобы отображались точно так, как вы это написали. 

Он по-прежнему транслирует пробелы и новые строки, но в других отношениях к 

вашему тексту не прикасается. 

4.2.2.5.Формат, позволяющий делать вставки в текст  
Формат Markdown делает насколько возможно лёгким набирать хорошо 

отформатированные страницы XHTML, используя только написанный текст, более или 

менее похожий на то, как вы могли бы написать почтовое сообщение. 

Это очень удобно при заполнении пустых страниц текста с какими-то заголовками 

или неполных списков, без многих ссылок или изображений. Весьма хорошим выбором 

этот формат является, когда важна доступность генерируемой страницы. 

Неупорядоченный список может быть создан со звёздочками (*). 

Полное описание синтаксиса можно увидеть в: 

http://daringfireball.net/projects/markdown/syntax. Moodle 1.6 имеет расширенные средства, 

называемые Markdown Extra: о дополнительных средствах сказано в 

http://www.michelf.com/projects/php-markdown/extra/. 

4.2.2.6.Советы и трюки 
 Показ неправильных символов – Если некоторые пользователи не видят какие-то 

символы или рисунки, проверьте параметры их браузера, касающиеся настройки их 

символов. На Moodle.org рекомендованным набором декодирования символов по 

умолчанию является UTF-8. В браузере Firefox это может быть найдено в 

ToolsOptionsFonts & colorsadvanceddefault character decoding pull down menu. 

 

 Если это не сработает, вы можете попробовать инсталляцию шрифта UTF-8 Unicode с: 

http://titus.fkidg1.uni-frankfurt.de/unicode/tituut.asp. (это помогло, по крайней мере, 

пользователям XP, которые не видят звёздочки в Рейтингах.) 

http://daringfireball.net/projects/markdown/syntax%20Moodle%201.6
http://www.michelf.com/projects/php-markdown/extra/
http://titus.fkidg1.uni-frankfurt.de/unicode/tituut.asp
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4.2.3.Markdown 
See http://docs.moodle.org/25/en/Markdown 

4.2.4.Text editor FAQ 
 
4.2.4.1.I can't find the option to do...... 
Click the computer screen icon at the far right of the top row. 

It will say "Toggle fullscreen mode" when you hover over it. The editor 

will now appear in a pop-up with the full range of options available (e.g. 

tables). 

4.2.4.2.Can I customize the text editor or add 
other icons like an anchor or horizontal rule? 
 
Yes - see the section on customising the editor toolbar in Text editor. 

 

4.2.4.3.The Text editor does not appear 
Check the following points (in no particular order); 

 Is the TinyMCE HTML editor enabled in Administration > Site 

administration > Plugins > Text editors > Manage editors? 

 Is 'Use HTML editor' set in Administration > My profile settings > Edit 

profile? 

 Is JavaScript enabled for my browser? 

4.2.4.4.How can I enable a spell-check? 
NOTE: While the default spell engine is Google spell which can be 

changed in Administration>Site administration>Plugins>Text 

editors>TinyMCE HTML editor, this is no longer supported by Google 

and will not work. (Note that it is only visible in IE9 and lower) It is due to 

be removed. See MDL-38867. In browser spell check is recommended. 

 

It is possible also to use PSpell or PspellShell. To use spell checking you 

need to install aspell 0.50 or later on your server, and enter the correct path 

to access the aspell binary in Administration > Server > System paths. 

4.2.4.5.How to use Firefox spell-check 
 
TinyMCE HTML editor replaces Right Click with their own menu, but if 

you do CTRL + Right Click, you 

4.2.3.Формат Markdown 
См. http://docs.moodle.org/25/en/Markdown. 

4.2.4.Часто задаваемые вопросы по текстовому 
редактору 
4.2.4.1.Я не могу найти опцию, чтобы сделать...... 

Щёлкните иконку экрана компьютера в правой крайней позиции верхней строки. 

Это покажет «Toggle fullscreen mode (переключить полноэкранный режим)», когда 

вы нависните курсором мыши над ней. Редактор тотчас же появится во всплывающем 

меню с полной областью доступных опций (например, таблицы). 

4.2.4.2.Можно ли настроить текстовый редактор или 
добавить другие иконки, подобные закладке или 
линейке горизонтальной прокрутки? 

Да – см. раздел по настройке инструментальной панели редактора в текстовом 

редакторе (п. 4.2.1). 

4.2.4.3.Текстовый редактор не появляется 
Проверьте следующие пункты (в любом порядке). 

 Разрешён ли редактор TinyMCE HT в AdministrationSite administrationPluginsText 

editorsManage editors? 

 Установлена ли «Use HTML editor (использовать редактор HTML)» в 

NavigationMy profile, затем AdministrationMy profile settingsEdit profile. 

 Разрешён ли в моём браузере JavaScript. 

4.2.4.4.Как включить проверку орфографии? 
Замечание: Пока машиной проверки орфографии по умолчанию является машина 

Google, которая может быть изменена в 

AdministrationSite administrationPluginsText editorsTinyMCE HTML editor, она 

больше не поддерживается Google и работать не будет. (Заметьте, что она видима только в 

IE9 и ниже). Это потому, что она была удалёна. См. MDL-38867. Рекомендуется проводить 

проверку орфографии браузером. 

Можно также использовать PSpell или PspellShell. Чтобы использовать проверку 

орфографии, вам необходимо установить Aspell 0.50 или выше на вашем сервере и ввести 

правильный путь доступа к Aspell binary в AdministrationServerSystem paths. 

4.2.4.5.Как использовать проверку орфографии 
браузером Firefox 

Редактор TinyMCE HTML заменяет щелчок правой кнопкой мыши его 

собственным меню, но если вы сделаете правый щелчок с нажатой клавишей CTRL, вы  

http://docs.moodle.org/25/en/Markdown
http://docs.moodle.org/25/en/Markdown
http://tracker.moodle.org/browse/MDL-38867
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got the old menu,or in case it's active the helper from TinyMCE that points 

to this shortcut. 

4.2.4.6.How we can disable the spell check 
button for specific instances in a quiz? 
The spell check is very handy for most circumstances but a quiz where you 

are looking at spelling and punctuation in student responses kind of defeats 

the purpose of the question. You can use the theme CSS files to disable the 

button on a specific question type. Try: 

 .essay div[title='Spell-check'] { 

 display:none; 

 } 

The spell check button should be displayed everywhere except on the essay 

question type response box. 

Suggested by Joshua Westerway. 

4.2.4.7.What is the biggest chunk of text you 
can edit? 
Maximum size of the forum post text (mysql) is 65535 characters or less if 

you use multibyte characters. From a forum post, 

http://moodle.org/mod/forum/discuss.php?d=203023#p885758 

4.2.4.8.Are there any keyboard shortcuts? 
 
Here are some TinyMCE keyboard shortcuts 

(particularly useful when using the 

collapsed editor) 

 

 

 

 

 

 

 

4.2.4.9.See also 
 Using Moodle Text editor forum 

 

 

 

 

 

получите старое меню, или, в случае его активности, помощник из TinyMCE укажет на 

этот ярлык. 

4.2.4.6.Как отключить кнопку проверки орфографии для 
особых примеров в Экзамене? 

Проверка орфографии очень удобна в большинстве обстоятельств, но Экзамен, где 

вы просматриваете орфографию и пунктуацию в ответах Студентов, несколько 

противоречит цели Вопроса. Вы можете использовать основные файлы CSS, чтобы 

отключить эту кнопку для конкретного типа Вопросов. Попытайтесь: 

.essay div[title='Spell-check'] { 

 display:none; 

 } 

Кнопка проверки орфографии должна быть отображена повсюду, за исключением 

окошка ответа на Вопрос типа Эссе. 

Предложено Джошуа Вестервэем. 

4.2.4.7.Какую наибольшую порцию текста вы можете 
редактировать? 

Максимальный размер текста почтовых корреспонденций Форума (mysql) равен 

65535 символам или меньше, если вы используете многобайтовые символы. Из почтовых 

корреспонденций Форума http://moodle.org/mod/forum/discuss.php?d=203023#p885758. 

4.2.4.8.Существуют какие-нибудь клавиши быстрого 
доступа? 

Здесь приведены некоторые клавиши 

быстрого доступа TinyMCE (особенно 

полезны при использовании свёрнутого 

редактора). 

 

 

 

 

 

 

4.2.4.9.См. также 
 Форум по использованию Moodle «Текстовый редактор». 

Клавиша 

быстрого 

доступа 

 

Значение 

Ctrl+z Отменить 

Ctrl+y Повторить 

Ctrl+b Полужирный 

Ctrl+i Курсив 

Ctrl+u Подчёркнутый 

Ctrl+k Ссылка вставить/отредактировать 

Ctrl+1 – 6 h1 – h6 

Ctrl+p p 

Ctrl+div div 

Ctrl+address Адрес 

http://moodle.org/mod/forum/discuss.php?d=203023#p885758
http://moodle.org/mod/forum/view.php?f=224
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4.3. Activities 
How to involve students actively in their learning. 

An activity is a general name for a group of features in a Moodle course. 

Usually an activity is something that a student will do that interacts with 

other students and or the teacher. 

There are 14 different types of activities in the standard Moodle that can be 

found on the "add an activity" drop down menu. 

4.3.0.Managing activities 
4.3.0.1.Manage activities 
An administrator can manage Moodle's activity modules for the site in 

Settings > Site administration > Plugins > Activity modules > Manage 

activities, including any contributed modules (add-ons) that have been 

added. 

4.3.0.1.1.Number of activities 
The activities column lists how many activities for each module there are 

on your Moodle site. If you click on a number, the list of courses 

containing that activity will be displayed. 

4.3.0.1.2.Version 
Screemshot «Activity modules administration». 

The numbers against the modules tell you the version (or age) of the 

module. It is useful to know how up to date each module is and, 

particularly with contributed modules, it is important to ensure you have 

the most up to date version that matches your version of Moodle. The first 

four digits relate to the year of the module. 

4.3.0.1.3.Hiding a module 
The hide/show column allows selected modules to be hidden i.e. they do 

not appear in any course "Add an activity" dropdown menu and cannot be 

used in any course. To hide a module, click the eye icon so that it changes 

to a closed eye. 

The Feedback module (which will eventually be replaced by a newer 

survey module) is hidden by default. 

4.3.0.1.4.Module deletion 
Apart from the Forum module, any module can be deleted using the link in 

the delete column. There is no reason for standard modules to be deleted, 

however contributed modules may need to be deleted before upgrading. 

 

 

 

4.3.Интерактивные Действия 
Как вовлечь Студентов в активное обучение. 

Интерактивное Действие – это общее название для группы средств в Курсе Moodle. 

Обычно, Интерактивное Действие есть нечто, что Студент будет делать во 

взаимодействии с другими Студентами и/или с Преподавателем. 

В стандартном Moodle имеется 14 разных типов Интерактивных Действий, 

которые можно отыскать в ниспадающем меню «Add an activity (добавить действие)». 

4.3.0.Управление Интерактивными Действиями 
4.3.0.1.Управлять Интерактивными Действиями 

Администратор может управлять модулями Интерактивных Действий Moodle для 

Сайта в AdministrationSite administrationPluginsActivity modulesManage activities, 

включая любые предлагаемые кем-то (сторонними поставщиками) модули 

(дополнительные), которые включены в вашу систему Moodle. 

4.3.0.1.1.Число Интерактивных Действий 
Колонка Интерактивных Действий перечисляет, сколько на вашем Сайте Moodle 

существует Интерактивных Действий для каждого модуля. Если вы щёлкнете по Number, 

будет отображён список Курсов, содержащих это Интерактивное Действие. 

4.3.0.1.2.Версия 
Снимок с экрана «Управление модулями Интерактивных Действий». 

Цифры против модулей сообщают вам код версии (или поколения) каждого из 

модулей. Полезно знать, насколько современен каждый модуль, особенно это касается 

предлагаемых кем-то модулей, важно убедиться, что вы имеете наиболее современную 

версию, которая соответствует версии вашей Moodle. Первые четыре цифры относятся к 

году создания модуля. 

4.3.0.1.3.Сокрытие модуля 
Колонка скрыть/показать позволяет выбранным модулям быть скрытыми, т.е. они 

не появятся в ниспадающем меню «Add an activity» любого Курса и не смогут быть 

использованы в любом другом Курсе. Чтобы скрыть модуль, щёлкните иконку «глаз», 

после чего она изменится на «закрытый глаз». 

Модуль «Обратная Связь (п. 4.3.6)» (который со временем будет замещён более 

современным модулем «Опрос (п. 4.3.12)») по умолчанию скрыт. 

4.3.0.1.4.Удаление модуля 
Любой модуль, кроме модуля «Форум (п. 4.3.7)», может быть удалён посредством 

использования ссылки в колонке Delete (удалить). Удалять стандартные модули причин 

нет, однако предлагаемые кем-то модули могут нуждаться в удалении перед 

модернизацией системы. 

http://docs.moodle.org/25/en/File:activity_modules_admin.png
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Note: To delete a module completely, in addition to deleting it on the 

manage activities page, you also need to remove/delete the actual module 

folder from the moodle/mod folder, otherwise Moodle will reinstall it next 

time you access the site administration. 

4.3.0.1.5.Module settings 
Many of the modules have additional settings, mostly enabling default 

values to be set, which can be accessed via the links in the settings column. 

 

4.3.0.2.Reducing the number of activities 
listed in the activity chooser 
By default, managers and teachers can add any activity module enabled on 

the site to a course. However, the list of activities in the activity chooser 

(or 'Add an activity' dropdown menu) may be reduced in number by 

preventing the capability to add instances of particular activity modules. 

 

Note for admins of sites upgrading from 2.2: The set of addinstance 

capabilities replaces the module security functionality in Moodle 2.2, 

allowing for finer-grained control of activity module availability. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Замечание: Чтобы совершенно удалить модуль, в дополнение к удалению его на 

странице управления Интерактивными Действиями, вам нужно переместить/удалить 

папку реального модуля из папки moodle/mod, иначе Moodle его инсталлирует повторно в 

следующий раз, когда вы войдёте в Блок Site administration (управление Сайтом). 

4.3.0.1.5.Настройки модуля 
Многие из модулей имеют дополнительные настройки, главным образом, 

разрешающие установку значений по умолчанию, которые могут быть достигнуты через 

ссылки в колонке Settings (настройки). 

4.3.0.2.Уменьшение числа Интерактивных Действий, 
перечисляемых в окне выбора Действий 

По умолчанию Менеджеры и Преподаватели могут добавить в Курс модуль 

Интерактивного Действия, разрешённый на Сайте. Однако список 

Интерактивных Действий в окне выбора Действий (или ниспадающем меню «Add an 

activity (добавить интерактивное действие)») может быть сокращён, предотвращая 

возможность добавлять экземпляры конкретных модулей Интерактивных Действий.  

Замечание для Администраторов Сайта, модернизирующих систему с версии 2.2 на 

более свежую. Набор Возможностей Addinstance заменяет функциональность 

безопасности модулей в Moodle 2.2, разрешая мелкошаговое управление доступностью 

модуля Интерактивного Действия. 
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4.3.1.Assignments 
Enable teachers to grade and give comments on uploaded files and 

assignments created on and off line 

Assignment module 
The assignment module allows teachers to collect work from students, 

review it and provide feedback including grades. The work students submit 

is visible only to the teacher and not to the other students unless a group 

assignment is selected. 

Students can submit any digital content (files), including, for example, 

word-processed documents, spreadsheets, images, audio and video clips. 

Assignments don't necessarily have to consist of file uploads. 

Alternatively, teachers can ask students to type directly into a text field in 

Moodle. Or they can ask student to do both, upload a file or files and type 

text directly into Moodle. An assignment activity can also be set up to not 

accept any student submissions and serve as a reminder to students of a 

'real-world' assignment they need to complete and to record grades in 

Moodle for activities that don't have an online component. 

 

An assignment has an 'available from' date before which no students can 

submit anything, and a due date, after which teachers can choose not to 

accept submissions any more. 

Markers can choose to be notified every time a student submits an 

assignment, or only for late submissions. Markers can choose to give 

students feedback in the form of text or uploaded files. 

 

4.3.1.1.Assignment settings 
4.3.1.1.1.Adding and editing an Assignment 
activity 
 To add a new Assignment activity to your course, login with the 

appropriate access rights (e.g. editing teacher, course creator or 

administrator) and Turn Editing On. Within the required Week or Topic 

Block click Add and Activity or Resource link. 

 

 In the Add an activity or resource dialogue box that appears, select 

Assignment and click Add. 

 

 

 

4.3.1.Задания 
Предоставляют Преподавателям возможность оценивать и комментировать 

пересылаеме файлы и Задания, созданные в режиме онлайн и офлайн. 

Модуль Задание 
Модуль Задание позволяет Преподавателям получать работы от Студентов, 

просматривать их, и предоставлять им Обратную Связь, включая оценивание. Готовые 

ответы Студентов видны только Преподавателю и никому из Студентов, кроме случая, 

когда это Задание было групповым. 

Студенты могут передавать на рассмотрение любое цифровое содержимое 

(файлы), включая, например, обработанные в Word документы, электронные таблицы, 

изображения, аудио- и видео-клипы. Задания не должны непременно состоять из 

пересылаемых файлов. В качестве альтернативы, Преподаватели могут попросить 

Студентов набрать информацию непосредственно в текстовом поле Moodle. Они также 

могут попросить Студента сделать параллельно и пересылку файла или файлов, и набор 

текста непосредственно в Moodle. Интерактивное Действие «Задание» можно установить 

так, чтобы оно не требовало от Студентов давать ответы, а служило в качестве 

напоминания Студентам о практическом Задании, которое им надлежит выполнить, и 

чтобы занести Оценки в Moodle для тех Действий, которые не имеют онлайн-компоненты. 

Задание имеет дату «доступно с», до наступления которой никто из Студентов не 

может ничего присылать, и дату, после которой Преподаватели могут отказаться 

принимать ответы. 

Оценивающие могут выбрать, чтобы их уведомляли либо каждый раз, когда 

Студент представляет им ответы на Задание, либо только о последних отправлениях. 

Оценивающие могут представить Студентам Обратную Связь в виде текста или 

пересылаемых файлов. 

4.3.1.1.Настройки Задания 
4.3.1.1.1.Добавление и редактирование 
Интерактивного Действия «Задание» 
 Чтобы добавить новое Интерактивное Действие «Задание» в ваш Курс, войдите в 

систему с подходящими правами доступа (например, Редактирующий Преподаватель, 

Создатель Курсов или Администратор) и включите режим редактирования (Turn Editing 

On). Внутри нужного Блока Недели или Темы щёлкните ссылку Add (добавить) и 

Activity или Resource. 

 В диалоговом окошке Add an activity or resource, которое появится, выберите 

Assignment и щёлкните Add. 
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  To edit an existing Assignment activity, login to your course with 

the appropriate access rights (e.g. editing teacher, course creator or 

administrator) and Turn Editing On. Select the Update icon against 

the relevant Assignment item. 

 Alternatively, after logging into your course simply click on the 

name of the Assignment activity you wish to edit and then click the 

Edit Settings link under Assignment administration within the Edit 

settings block. 

The following configuration options are available when creating or 

editing/updating any Assignment activity. Only General, Availability and 

Submission types are open by default; the others are collapsed. To expand 

everything, click the "Expand all" link top right. Click on any screenshot to 

see it full size. 

 

4.3.1.1.2.General 
The General section allows you to give your assignment a name and 

description. 

Screenshot «General settings for an assignment». 

Assignment name 
Give your Assignment a name (e.g. “Report on Topic 1 Content”). The 

title entered here will be the name that learners see in the course content 

area. Learners will click on this name to view the details of the assignment 

and, if applicable, submit their work. 

Description 
Provide instructions for your students here so they are clear what they have 

to do. Click "Show editing tools" to display the rich text editor and drag the 

bottom right of the text box out to expand it. You can also provide 

information or resources related to the assignment, such as a video clip, an 

image, or a link to a webpage. 

 

Display description on course page 
Enabling this will display the description on the course page just below the 

link to the assignment activity. 

4.3.1.1.3.Availability 
Screenshot «Availability settings for an assignment». 

 

 

 

 

 Чтобы отредактировать существующее Интерактивное Действие «Задание», 

зарегистрируйтесь в вашем Курсе с подходящими правами доступа (например, 

Редактирующий Преподаватель, Создатель Курсов или Администратор) и включите 

режим редактирования. Выберите иконку Update (обновить) напротив 

соответствующего элемента Задание. 

 В качестве альтернативы, после входа в ваш Курс просто щёлкните по названию 

Интерактивного Действия «Задание», которое хотите отредактировать, и затем 

щёлкните ссылку Edit Settings внутри блока Edit settings в Assignment administration. 

Следующие опции конфигурации доступны при создании или 

редактировании/обновлении любого Интерактивного Действия «Задание». По умолчанию 

развёрнуты только опции General (обычные), Availability (доступность) и Submission 

(готовый ответ Студента), другие свёрнуты. Чтобы развернуть все, щёлкните ссылку 

«Expand all (развернуть все)» справа вверху. Щёлкните по любому снимку с экрана, чтобы 

увидеть его в полном размере. 

4.3.1.1.2.Обычные настройки 
Раздел General позволяет дать наименование и описание вашему Заданию. 

 

Снимок с экрана «Обычные настройки для Задания». 

Наименование Задания 
Дайте вашему Заданию наименование (например, «Отчёт по содержанию Темы 

1»). Введённый здесь заголовок будет тем наименованием, которое обучающиеся увидят в 

данной  области Контента Курса. Щёлкнув по этому имени, обучающиеся увидят детали 

Задания и, если требуется, отправят готовый результат их работы. 

Описание Задания 
Предоставьте здесь инструкции для ваших Студентов так, чтобы они уяснили, что 

они должны сделать. Щёлкните «Show editing tools (показать инструменты 

редактирования)», чтобы отобразить полный текстовый редактор и перетащите правый 

нижний уголок текстового окошка, чтобы его расширить. Вы также можете предоставить 

информацию или Ресурсы, относящиеся к этому Заданию, такие как видео-клип, 

изображение или ссылка на веб-страницу. 

Отобразить описание на странице Курса 
Разрешение данной опции будет отображать это описание на каждой из страниц 

Курса прямо под ссылкой на данное Интерактивное Действие «Задание». 

4.3.1.1.3.Доступность 
Снимок с экрана «Настройки доступности для Задания». 

http://docs.moodle.org/25/en/File:AssignGeneral.png
http://docs.moodle.org/25/en/File:AssignAvailability.png
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Allow submissions from 
The Allow submissions from setting prevents students from submitting 

their assignment before the shown date. A teacher can to set a day, month, 

year and time (24 hour clock) from which learners can begin to submit 

their assignments. Please note that this setting does not hide the activity 

from the learners. Instead, the learner will see the activity, be able to view 

the instructions and use any materials you have included in the description, 

but the learner will not be able to submit or complete the assignment until 

the Allow submissions from date. 

 

This setting is enabled (ticked/checked) by default and is set at the day and 

time you added the assignment. To disable this, remove the tick/check. 

Due date 
The Due date setting prevents students from submitting their assignment 

after the shown date. This option allows an teacher to set a day, month, 

year and time (24 hour clock) before which learners must submit their 

assignment. By default the Due date is Enabled (ticked) and is set at 7 days 

ahead of the day and time you selected Add Assignment. To disable this 

feature, simply ensure the Enable checkbox is not marked. For more 

information on using the Due Date see Assignment FAQ. 

Note: Assignments without a Due date will appear on the My home page 

with “No Due date” displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Разрешить отправлять готовые ответы с данного момента 
Опция «Allow submissions from (разрешить отправлять готовые ответы)» из 

настроек помешает Студентам отправлять готовый ответ на их Задание до указанной даты. 

Преподаватель может установить день, месяц, год и время (по 24 часовому циферблату), 

начиная с которого учащиеся могут отправлять готовые ответы по своим Заданиям. 

Пожалуйста, заметьте, что эта настройка не скрывает Интерактивное Действие от 

учащихся. Наоборот, учащийся увидит это Интерактивное Действие, сможет просмотреть 

инструкции и использовать любые материалы, которые вы включили в описание; но 

учащийся не сможет отослать готовый ответ или завершить Задание до даты, заданной в 

«Allow submissions from». 

Эта настройка разрешается (галочкой/меткой) по умолчанию и устанавливается в 

день и время, когда вы добавили Задание. Чтобы отменить это, удалите галочку/метку. 

Срок завершения 
Настройка Due date не позволяет Студентам отсылать готовые ответы на их 

Задание после указанной даты. Эта опция позволяет Преподавателю установить день, 

месяц, год и время (по 24 часовому циферблату), до истечения которого учащиеся должны 

отправить готовые ответы на свои Задания. По умолчанию Due date разрешена (помечена) 

и установлена на 7 дней раньше времени, выбранного вами в Add Assignment. Чтобы 

отключить это средство, просто удостоверьтесь, что окошко-флажок Enable не помечено. 

Дополнительная информация по использованию Due date приведена в Assignment FAQ. 

Замечание: Задания без Due date будут появляться на страничке My home 

(домашняя страница) с пометкой «No Due date (без срока окончания)». 

http://docs.moodle.org/25/en/Assignment_settings#Allow_submissions_from
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Cut-off date 
The Cut-off date is the date beyond which students will not be able to send 

in their assignment as the button for doing so will no longer be displayed. 

After that date (or time) a teacher may, on request, grant an extension by 

going to the class assignment grading screen, clicking the "Edit" column 

and choosing "grant extension" for the relevant student. 

 

For more details, see this Youtube screencast «Assignment Extensions». 

 

Always show description 
This setting is used in conjunction with the Allow submissions from 

setting. If it is set to Yes, the assignment Description will become visible 

to students at the Allow submissions from date. If it is set to No, the 

assignment Description will be hidden from students until the Allow 

submissions from date, only the assignment Name will be displayed. 

Screenshot « Always show description». 

If Allow submissions from is disabled, then this setting has no meaning: 

the assignment description will always be visible to students. 

4.3.1.1.4.Submission types 
Screenshot «Select the type of submission here» 

Here you can decide how you wish students to submit their work to you. 

 

Online text 
Learners can type their response directly in Moodle using the text editor. 

 

File submissions 
Learners can upload and edit one or more files of any type the teacher can 

open. 

Submission comments 
If enabled, students may leave comments into a text area associated with 

the assignment. Comments can be used for communication with the 

grading person, assignment progress description, to let students alert the 

marker about which file is the master file (in case of inter-linked files), or 

any other type of communication between student and marker. (Note that if 

Blind marking is enabled, student comments display as from "Participant 

01 etc" to avoid revealing identities.) 

 

 

 

Дата прекращения 
Дата Cut-off является датой, после которой Студенты не смогут что-либо добавлять 

в свои Задания, так как кнопка для совершения этого больше не будет отображаться. 

После этой даты (или времени) Преподаватель может по запросу предоставить 

дополнительное время, перейдя на экран оценивания Задания классу, щёлкнув колонку 

«Edit (редактировать)» и выбрав «Grant extension (предоставить дополнительное время)» 

для соответствующего Студента. 

Дополнительные подробности см. в фильме с экрана по Youtube «Расширения 

Заданий» по Youtube. 

Всегда показывать описания 
Эта настройка используется совместно с опцией Allow submissions (разрешить 

отправку готовых ответов) из настроек. Если она установлена в Yes (да), описание Задания 

станет видимым для Студентов, начиная с даты Allow submissions from. Если она 

установлена в No, описание Задания будет скрыто от Студентов до даты Allow submissions 

from, будет отображаться только наименование Задания. 

Снимок с экрана «Всегда показывать описание». 

Если Allow submissions отключено, тогда эта настройка не имеет смысла: описание 

Задания всегда будет видимо Студентам. 

4.3.1.1.4.Типы готовых ответов 
Снимок с экрана «Выберите тип готового ответа здесь». 

Здесь вы можете решить, как вы хотите, чтобы Студенты отправляли вам готовые 

ответы по своей работе. 

Текст в режиме онлайн 
Учащиеся могут набрать свой ответ непосредственно в Moodle, используя 

текстовый редактор. 

Готовый ответ в виде файла 
Учащиеся могут пересылать и редактировать один или более файлов любого типа, 

которые Преподаватель может открыть. 

Комментарии Студентов к готовому ответу 
Если разрешено, Студенты могут оставлять комментарии в текстовой области, 

связанной с этим Заданием. Комментарии могут быть использованы для связи с 

производящим оценивание, описания хода выполнения Задания, позволения Студентам 

предупредить Оценивающего о том, какой из файлов главный (в случае файлов с 

перекрёстными ссылками), или осуществления любой другой связи Студента с 

Оценивающим его работу. (Заметьте, что если разрешено «Blind marking (оценивание 

вслепую)», студенческие комментарии отображаются под псевдонимами «Участник 01, и 

т.д.», что позволяет избежать идентификации автора.) 

http://www.youtube.com/watch?v=UaL0LzZwyYI&feature=share&list=UUCRg_EbhU9tdpLdiGGN1Mgg
http://www.youtube.com/watch?v=UaL0LzZwyYI&feature=share&list=UUCRg_EbhU9tdpLdiGGN1Mgg
http://www.youtube.com/watch?v=UaL0LzZwyYI&feature=share&list=UUCRg_EbhU9tdpLdiGGN1Mgg
http://docs.moodle.org/25/en/File:always_show_description.jpg
http://docs.moodle.org/25/en/File:SubmissionTypes.png
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Submission comments will appear in the grading table (click on the 

assignment activity, then click on the View/Grade all Submission button), 

in the Submission comments column. Submission comments allow two-

way communication between the student and teacher. 

Maximum number of uploaded files 
Here you can decide the maximum number of files which may be uploaded 

by each learner. (It might be helpful to display the number in the 

assignment description.) 

Maximum submission size 
This setting specifies the maximum size per file of each of the files that the 

students can upload as part of their submission. 

This maximum upload size may only be equal to or less than the course 

limit (which in turn may only be equal to or less than the site limit). The 

maximum size of each file is displayed to students at the point where they 

upload files. 

Screenshots «Submission comments» и «Maximum file size». 

 

4.3.1.1.5.Feedback types 
Screenshot « Feedback types». 

Feedback comments 
Setting this to yes means that markers can leave feedback comments for 

each submission. It enables the Feedback Comments column in the grading 

table. 

(To access the grading table, click on the assignment activity and then 

View/Grade all Submissions). Feedback comments are also accessible by 

clicking on the green tick in the grade column on the grading table. 

 

Screenshots «The Feedback comments column» и «Type feedback 

comments into the box ». 

Offline grading worksheet 
If set to yes, the teacher will have a link to download the grading list as a 

spreadsheet. They will then be able to enter grades and feedback comments 

offline: 

Screenshots «The empty gradebook on Moodle», «The dropdown to 

download the list» and «Editing the grades offline». 

When the teacher has completed their grading offline, they can then upload 

the spreadsheet, confirm the changes and the grades and comments will be 

transferred over into Moodle's gradebook: 

 

Комментарии к ответам появляются в таблице оценок (щёлкните по 

Интерактивному Действию «Задание», затем щёлкните по кнопке «View/Grade all 

Submission (просмотреть/оценить все готовые ответы)» в колонке «Submission comments 

(комментарии к готовым ответам)». Это обеспечит возможность двустороннего общения 

Студента и Преподавателя. 

Максимальное число пересылаемых файлов 
Здесь вы можете задать максимальное число файлов, которые могут быть 

пересланы одним учащимся. (Полезно отобразить данное число в описании Задания.) 

Максимальный размер готового ответа 
Эта настройка указывает максимальный размер каждого из файлов, которые 

Студенты могут пересылать как части их готового ответа. 

Этот максимальный размер пересылки может быть равным или меньше такого же 

ограничения для Курса (которое, в свою очередь, может быть равным или меньше такого 

же ограничения для Сайта). Максимальный размер каждого из файлов отображается 

Студентам там, откуда они пересылают файлы. 

Снимки с экрана «Комментарии к готовому ответу» и «Максимальный размер 

файла». 

4.3.1.1.5.Типы Обратной Связи 
Снимок с экрана «Типы обратной связи». 

Комментарии к Обратной Связи 
Установка этой опции в «Yes (да)» означает, что Оценивающий может оставить 

комментарий Обратной Связи по каждому готовому ответу. Это включает колонку 

комментариев Обратной Связи «Feedback Comments» в таблицу Оценок. 

(Для доступа к таблице Оценок щёлкните Интерактивное Действие «Задание» и 

затем «View/Grade all Submissions (просмотреть/оценить все готовые ответы)»). 

Комментарии Обратной Связи также доступны щелчком по зелёной «галочке» в колонке 

«Grade (оценка)» таблицы Оценок. 

Снимки с экрана: «Колонка Комментариев Обратной Связи» и «Набери 

комментарии Обратной Связи в окошке». 

Электронная таблица оценивания в режиме офлайн 
Если эта опция установлена в Yes, Преподаватель будет иметь ссылку для 

скачивания списка Оценок в виде электронной таблицы. Затем он сможет ввести Оценки и 

комментарии Обратной Связи в режиме офлайн. 

Снимки с экрана «Пустой Журнал Оценок Moodle», «Ниспадающее Меню Для 

Скачивания Списка Оценок» и «Редактирование Оценок в режиме офлайн». 

Когда Преподаватель закончит своё оценивание в режиме офлайн, он может 

переслать электронную таблицу, подтвердить исправления и Оценки, а комментарии 

будут переданы в Журнал Оценок Moodle: 

http://docs.moodle.org/25/en/File:submission_comments.jpg
http://docs.moodle.org/25/en/File:maximum_file_size.jpg
http://docs.moodle.org/25/en/File:maximum_file_size.jpg
http://docs.moodle.org/25/en/File:feedbacktypes.png
http://docs.moodle.org/25/en/File:feedback_comments.jpg
http://docs.moodle.org/25/en/File:feedback_comments_2.jpg
http://docs.moodle.org/25/en/File:feedback_comments_2.jpg
http://docs.moodle.org/25/en/File:emptygradebook.png
http://docs.moodle.org/25/en/File:downloadgradingworksheet.png
http://docs.moodle.org/25/en/File:downloadgradingworksheet.png
http://docs.moodle.org/25/en/File:excelgrades.png
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Screenshots «Starting the upload process», «Uploading the grading 

worksheet», «Confirming the changes» и «Grades and feedback transferred 

into Moodle». 

See also «Offline grading worksheet» blog post by Gavin Henrick. 

 

Feedback files 
This allows markers to upload files with feedback when marking. These 

files may be the marked up student assignments, documents with 

comments, a completed marking guide, or spoken audio feedback. It 

enables the Feedback Files column in the grading table. (To access the 

grading table click on the assignment activity and then View/Grade all 

Submissions) 

 

To upload feedback files, click on the green tick in the grade column on 

the grading table and then upload either with drag and drop or using the 

File picker. 

Feedback is displayed to students on the assignment submission page. 

Screenshots «The Feedback files column», «Upload files here» and 

«Student view with comments and file feedback both enabled». 

 

Uploading multiple feedback files 
It is also possible to upload multiple feedback files as a zip, from the 

dropdown above the grading list: 

 Download the students' assignments using the "Download all 

submissions" link from the same dropdown menu; 

 Extract the folder offline and add your comments to the student's 

submissions. Keep the names the same. 

 Select the students' submissions and zip them into a new folder. 

Important: Don't just edit them inside their original folder and re-zip 

this; it will not work. The folder name does not matter as long as the 

feedback files have the same names as before. 

 Upload this newly zipped folder. 

 You will be presented with a confirmation screen displaying your 

feedback files. 

Screenshots «Choose from the dropdown menu», «Confirmation screen 

displaying the feedback files to be uploaded» and «Screen confirming 

uploaded feedback». 

4.3.1.1.6 Submission settings 
Screenshot «Submission settings». 

 

Снимки с экрана «Начало процесса пересылки», «Пересылка электронной таблицы 

оценивания», «Подтверждение изменений» и «Оценки и Обратная Связь, переданные в 

Moodle». 

Смотрите также сообщение блога «Электронная таблица оценивания офлайн» от 

Гевина Хенрика. 

Файлы Обратной Связи 
Эта опция позволяет Оценивающим пересылать файлы с Обратной Связью при 

оценивании. Эти файлы могут быть оценёнными Заданиями Студентов, документами с 

комментариями, руководством по итоговому оцениванию или голосовая Обратная Связь в 

виде аудио. Эта опция включает колонку «Feedback Files (файлы обратной связи)» в 

таблицу оценивания. (Для доступа к таблице оценивания щёлкните по 

Интерактивному Действию «Задание», а затем по «View/Grade all Submissions 

(просмотреть/оценить все готовые ответы)".) 

Чтобы переслать файлы Обратной Связи, щёлкните по зелёной «галочке» в 

колонке «Grade (оценка)» таблицы оценивания, и затем перешлите буксировкой или 

используя Меню файлов. 

Обратная связь отображается Студентам на странице «Assignment submission 

(готовый ответ на задание)». 

Снимки с экранов: «Колонка файлов Обратной связи», «Переслать файлы здесь» и 

«Включены и вид Студента с комментариями, и файл Обратной Связи». 

Пересылка многих файлов Обратной Связи 
Можно также пересылать сразу несколько файлов Обратной Связи, 

заархивированных в zip-файл, из ниспадающего меню над списком оценивания: 

 Скачайте Задания Студентов, используя ссылку «Download all submissions (скачать все 

готовые ответы)» из того же самого ниспадающего меню. 

 Извлеките папку в режиме офлайн и добавьте свои комментарии к готовым ответам 

Студентов. Сохраняйте эти наименования неизменными. 

 Выберите готовые ответы Студентов и заархивируйте их zip-архиватором в новую 

папку. Важно: только не редактировать их в первоначальной папке и повторно не 

архивировать её, это не сработает. Имя папки не имеет значения до тех пор, пока файлы 

Обратной Связи имеют те же наименования, как и прежде. 

 Перешлите вновь заархивированную zip-архиватором папку. 

 Вам придёт экран подтверждения, отображающий ваши файлы Обратной связи. 

 

Снимки с экранов «Выберите из ниспадающего меню», «Экран подтверждения, 

отображающий пересланные файлы с обратной связью» и 

«http://docs.moodle.org/25/en/File:multiplezip2.png». 

4.3.1.1.6.Настройки готового ответа 
Снимок с экрана «Настройки готового ответа». 

http://docs.moodle.org/25/en/File_picker
http://docs.moodle.org/25/en/File:Offline_grading_upload.png
http://docs.moodle.org/25/en/File:uploadgradingworksheet.png
http://docs.moodle.org/25/en/File:uploadgradingworksheet.png
http://docs.moodle.org/25/en/File:confirmchanges.png
http://docs.moodle.org/25/en/File:fullgradebook.png
http://docs.moodle.org/25/en/File:fullgradebook.png
http://www.somerandomthoughts.com/blog/2012/11/19/offline-grading-worksheet-in-moodle-2-4-assignment/
http://docs.moodle.org/25/en/File:feedback_files.jpg
http://docs.moodle.org/25/en/File:feedback_files_2.jpg
http://docs.moodle.org/25/en/File:feedback_view_for_students.jpg
http://docs.moodle.org/25/en/File:mutiplefeedbackzip.png
http://docs.moodle.org/25/en/File:multiplezip1.png
http://docs.moodle.org/25/en/File:multiplezip1.png
http://docs.moodle.org/25/en/File:multiplezip2.png
http://docs.moodle.org/25/en/File:submissionsettings.png
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Require students click submit button 
 
Students can upload draft versions of the assignment until such time as 

they are ready to submit. Once they click the submit button they indicate to 

the teacher that they have finished working on the assignment. (In earlier 

versions of Moodle this was called "Send for marking".) 

They can then longer edit their submission. If they need to change it, they 

must ask the teacher who can revert the assignment to draft status. 

 

To revert to the draft stage, click on the assignment activity and then 

View/Grade all Submissions. Locate the student and click the action icon 

in the Edit column. Select Revert the submission to draft. 

 

If this setting is No, then students do not have to click a submit button and 

are able to make changes to uploaded files at any time. 

If this setting is No but the teacher wishes to grade students work, then you 

can stop students from making further changes by using Prevent 

submission changes. Prevent submission changes can also be used in cases 

where students have neglected to click the Submit button and grading has 

commenced. To prevent submission changes, click on the assignment 

activity, then click on the View/Grade all submissions button. On the 

grading table, locate the student and click the action icon in the Edit 

column. Select Prevent submission changes. 

To do either of these with a number of students, use the With selected 

menu at the bottom of the grading table. 

Screenshots «Reverting to draft», «Prevent submission changes» and 

«With selected»… 

Require that students accept the Submission 
statement 
An administrator can define a "Submission statement", ie, a statement 

where students promise the work is their own and which they must agree to 

before submitting their work. This may be done via Settings>Site 

administration>Plugins>Activity modules>Assignment. 

 

If preferred, the available default statement which may be used instead: 

This assignment is my own work, except where I have acknowledged the 

use of the works of other people 

 

 

Потребуйте, чтобы Студенты щёлкнули кнопку передачи 
готового ответа 

Студенты могут пересылать черновые версии Задания до тех пор, пока они не 

будут готовы послать окончательный ответ. Щёлкнув  по кнопке Submit (передать готовый 

ответ), они сообщают Преподавателю, что они закончили работу над Заданием. (В более 

ранних версиях Moodle она называлась «Send for marking (послать для оценивания)»). 

Затем они могут продолжить редактировать свой готовый ответ. Если им нужно 

изменить его, они должны попросить Преподавателя, который может вернуть Заданию 

статус чернового. 

Чтобы вернуться в черновую стадию, щёлкните Интерактивное Действие 

«Задание» и затем View/Grade all Submissions. Найдите нужного Студента и щёлкните 

иконку «Action (действие)» в колонке Edit. Выберите «Revert the submission to draft 

(вернуть готовый ответ к состоянию черновика)». 

Если эта настройка установлена в No, то Студенты не должны щёлкать кнопку 

Submit, и могут делать изменения в пересланных файлах в любое время. 

Если эта настройка установлена в No, но Преподаватель хочет оценить работу 

Студентов, то вы можете остановить выполнение Студентами дальнейших изменений, 

используя «Prevent submission changes (предотвратить изменения готовых ответов)». 

Prevent submission changes может быть также использована в тех случаях, когда Студенты 

не щёлкнули кнопку Submit, а оценивание началось. Чтобы предотвратить изменения 

готовых ответов, щёлкните Интерактивное Действие «Задание» и затем кнопку 

View/Grade all Submissions. В таблице оценивания найдите нужного Студента и щёлкните 

иконку Action в колонке Edit. Выберите Prevent submission changes. 

Чтобы сделать любое из перечисленного с рядом Студентов, используйте меню 

«With selected (с выбранными)» внизу таблицы оценивания. 

Снимки с экрана «Возвращение к черновику», «Предотвращение изменений 

готовых ответов» и «С Выбранными»… 

Потребуйте, чтобы Студенты признали Заявление об отсутствии 
плагиата в их готовом ответе 

Администратор может составить текст «Заявления об отсутствии плагиата в 

предоставленном готовом ответе», т.е. документ, в котором Студенты подтверждают, что 

работа является их собственной, и который они должны прислать прежде, чем отправлять 

готовый ответ о выполненной работе. Это можно сделать через 

AdministrationSite administrationPluginsActivity modulesAssignment. 

При желании может быть использован стандартный текст, доступный по 

умолчанию: Это Задание является моей собственной работой, за исключением мест, где 

я процитировал работы других людей. 

http://docs.moodle.org/25/en/File:revert_to_draft.jpg
http://docs.moodle.org/25/en/File:prevent_submission_changes.jpg
http://docs.moodle.org/25/en/File:prevent_submission_changes.jpg
http://docs.moodle.org/25/en/File:with_selected.jpg
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If the administrator has given teachers the option of using a submission 

statement or not, then it will be available in the assignment settings screen. 

The section #Submission_Statement explains how an administrator can set 

this up. 

For more details, see this blog post "All my own work" 

When this setting is enabled, students will have to check a button before 

they can submit their assignment: 

If the administrator has forced the statement throughout the site, a teacher 

will not have this option in the settings but a student will see the statement 

when accessing their assignment. 

Attempts reopened 
This setting allows the teacher to decide how submissions are reopened. 

The default is "Never", in that students may only submit once. However, a 

teacher can set this to "Manually" and reopen it themselves for the student 

to resubmit, or to "Automatically until pass". The student must then keep 

trying and resubmitting until they get a pass grade. 

 

 

Maximum attempts 
If a student is allowed to resubmit, this setting will determine how many 

times they can resubmit before they are no longer allowed to do so. 

 

(For example, if a student has to keep trying until they get a pass grade, the 

teacher might decide that ten attempts is enough even though they have not 

yet passed!) 

4.3.1.1.7.Groups submission settings 
Screenshot «Group submission settings». 

Students submit in groups 
If this box is ticked, then students are able to collaborate on an assignment. 

This might involve for example, working in the same online text area, or 

one student uploading an MS Powerpoint which another student 

downloads, improves and re-uploads to the common assignment area. 

When grading, the teacher may choose to give a common grade and 

feedback to all students in the group or to give individual grades and 

feedback to each member. 

If no groups have been made, then Moodle will make a default group of 

every student in the course. 

For more details see this Youtube video Group Assignment 2.4 

 

 

Если Администратор предоставит Преподавателям возможность либо 

использовать Заявление о готовом ответе, либо нет, тогда эта настройка будет доступна на 

экране настройки Задания. Раздел 4.3.1.1.14 «Заявление об отсутствии плагиата в готовом 

ответе» объясняет, как Администратор может установить его. 

Больше подробностей приведено в сообщении блога «Всё моя собственная 

работа». Когда эта настройка разрешена, Студенты должны пометить кнопку прежде, чем 

отправить готовый ответ на их Задание: 

Если Администратор установил это Заявление для всего Сайта, Преподаватель не 

будет иметь этой опции в настройках, но Студент увидит Заявление, когда выйдет на своё 

Задание. 

Возобновление попыток    Новое средство в Moodle 2.5 
Эта настройка позволяет Преподавателю решить, каким образом возобновляются 

готовые ответы. По умолчанию установлено «Never (никог)», т.е. Студенты могут 

отправить готовый ответ только однажды. Однако Преподаватель может установить эту 

настройку в «Manually (вручную)» и возобновить её сам для того, чтобы Студент мог 

заново отправить готовый ответ, или в «Автоматически до тех пор, пока не пройдёт». 

Студент затем должен делать попытки и пересылать готовые ответы до тех пор, пока не 

получит положительную оценку. 

Максимум попыток     Новое средство в Moodle 2.5 
Если Студенту разрешены повторные отправки готового ответа, эта настройка 

определяет, как много раз можно отправлять повторно, но не дольше, чем им это 

позволено. 

(Например, если Студент должен делать попытки, пока не получит положительную 

оценку, Преподаватель может решить, что 10 попыток достаточно, даже если они все не 

прошли!) 

4.3.1.1.7.Настройки готового ответа Группы 
Снимок с экрана «Настройки готового ответа группы». 

Студенты готовят ответ в Группах 
Если это окошко отмечено «галочкой», тогда Студенты могут работать над 

Заданием совместно. Это может включать, например, работу в одной и той же области 

текста онлайн, или случай, когда один Студент пересылает MS Powerpoint файл, другой 

Студент скачивает, улучшает и пересылает в общую область Задания. 

При оценивании Преподаватель может выбрать, дать ли общую Оценку и 

Обратную Связь всем Студентам в Группе, или дать индивидуальные Оценки и 

Обратную Связь каждому члену Группы. 

Если Групп не создано, тогда Moodle сделает Группу по Умолчанию из каждого 

Студента Курса. 

Большие подробности см. в видео «Групповое задание в версии Moodle 2.4» по 

Youtube. 

http://docs.moodle.org/25/en/Assignment_settings#Submission_Statement
http://ourlearning.co.uk/2012/10/moodle-assignment-all-my-own-work/
http://www.youtube.com/watch?v=G16gYZJFCrM&feature=share&list=UUCRg_EbhU9tdpLdiGGN1Mgg
http://ourlearning.co.uk/2012/10/moodle-assignment-all-my-own-work/
http://ourlearning.co.uk/2012/10/moodle-assignment-all-my-own-work/
http://docs.moodle.org/25/en/File:groupsubmissionsettings.png
http://www.youtube.com/watch?v=G16gYZJFCrM&feature=share&list=UUCRg_EbhU9tdpLdiGGN1Mgg
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Require all group members submit 
This setting will only appear if the teacher has ticked the "Require students 

click submit button" earlier. The assignment will not be classed as 

"submitted" until all members of the group have made a contribution. 

When one student has submitted, the other members of the group will be 

able to see who still has to submit. 

 

Grouping for student groups 
If a particular grouping is selected here, then the gradebook will display 

any other groups and non-grouped students in the "default group", while 

naming the group(s) that are in the chosen grouping. If "none" is selected, 

then the gradebook will display the names of all groups and put any non-

grouped students in the "default group". See this forum post on grouping 

for student groups for examples of how this might be used. 

 

4.3.1.1.8.Notifications 
Screenshot «Notifications». 

Notify graders about submissions 
Teachers will receive a message (of a type they choose) whenever a 

student submits an assignment. 

Notify graders about late submission 
Teachers will receive a message (of a type they choose) whenever a 

student submits a late assignment. 

4.3.1.1.9.Grade 
Screenshot «Grade». 

Grade 
Specify the maximum grade or Scale to be applied to the assignment. If 

you will not be giving a grade for the assignment, choose No Grade. 

 

Grading method 
There are 3 options: 

 Simple direct grading (entering a grade or scale item) 

 Marking guide 

 Rubric 

Grade Category 
Any custom Grade Categories that have been created within your site or 

course will be listed here and will be available for selection. Select the 

required Grade Category to add this assignment as a Grade item within this 

Category. 

Потребовать от всех членов Группы выслать готовый ответ 
Эта настройка появится, если только Преподаватель ранее пометит «галочкой» 

«Require students click submit button (студентам требуется щёлкнуть кнопку передачи 

готового ответа)». Задание не рассматривается как «представленный готовый ответ» до 

тех пор, пока все члены Группы не внесут в ответ свою лепту. Когда один Студент 

передал ответ, другие члены Группы могут увидеть, кто ещё должен передать готовый 

ответ. 

Распределение Студентов по Группам 
Если здесь выбирается конкретное распределение по Группам, тогда 

Журнал Оценок отобразит остальные Группы и несгруппированных Студентов под 

заголовком «default group (группа по умолчанию)», присвоив при этом наименования 

выбранным здесь Группам. Если выбрано «None (нисколько)», тогда Журнал Оценок 

отобразит наименования всех Групп, а несгруппированных Студентов разместит под 

заголовком «default group». Примеры того, как это может использоваться приведены на 

форуме «Сообщение форума по распределению Студентов по группам»: 

4.3.1.1.8.Извещения 
Снимок с экрана «Извещения». 

Извещение Оценивающих о поступлении готовых ответов 
Преподаватели будут получать сообщение (выбранного ими типа), как только 

Студент отправит отчёт о выполнении Задания. 

Извещение Оценивающих о последнем предоставлении ответа 
Преподаватели будут получать сообщение (выбранного ими типа), как только 

поступит ответ Студента по последнему Заданию. 

4.3.1.1.9.Оценка 
Снимок с экрана «Оценка». 

Оценка 
Указывает максимальную Оценку или Шкалу (п. 4.9.1.4), которые применимы к 

этому Заданию. Если вы не собираетесь оценивать Задание, выберите «No Grade (не 

оценивать)». 

Метод оценивания 
Имеются  опции: 

 Простое прямое оценивание (введение Оценки или элемента Шкалы). 

 Руководство по Проставлению Отметок. 

 Рубрика. 

Категория оценок 
Любая пользовательская «Категория Оценок», которая была создана внутри 

вашего Сайта или Курса, будет здесь включена в список для выбора. Выберите требуемую 

КатегориюОценок, чтобы добавить это Задание как «Элемент Оценки» внутрь этой 

Категории. 

http://docs.moodle.org/25/en/Grade_categories
http://docs.moodle.org/25/en/Grade_items
https://moodle.org/mod/forum/discuss.php?d=216399#p942913
http://docs.moodle.org/25/en/File:notifications25.png
http://docs.moodle.org/25/en/File:grade25.png
http://docs.moodle.org/25/en/Marking_guide
http://docs.moodle.org/25/en/Rubric
http://docs.moodle.org/25/en/Grade_categories
http://docs.moodle.org/25/en/Grade_items
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Blind marking 
If this setting is enabled, then a teacher will not see the names of students 

who have submitted their assignments. Instead, they will see randomly 

generated Participant numbers. (The student view of the assignment does 

not change.) This is also the case if student comments have been enabled. 

Once they have graded the assignment, it is however possible for teachers 

to see who submitted what by clicking on "Reveal student identities" in the 

Assignment settings. 

Returning Marks to Students 
Because of the nature of blind marking, the students cannot see the final 

grade until all of the students names have been revealed. This is found in 

Assignment Settings > Reveal Student Names. However, feedback 

comments will appear. 

Note: Because of this, the level of anonymity might not suit the privacy 

requirements of your establishment. See this tracker entry MDL-35390 - 

"Blind Marking is not so blind" 

For more details on this feature, see this Youtube video Blind marking in 

2.4. 

4.3.1.1.10.Common module settings 
See Common module settings 

4.3.1.1.11.Restrict access settings 
The Restrict access area becomes visible in Moodle activities and resource 

settings if Conditional Activities have been enabled. 

4.3.1.1.12.Locally assigned roles 
In Settings > Assignment administration > Locally assigned roles selected 

users can be given additional roles in the activity. See the Using Moodle 

Custom role for 'Course Monitor' forum discussion for an example. 

 

4.3.1.1.13 Assignment capabilities 
 Export own submission 

 Grade assignment 

 Submit assignment 

 View assignment 

Role permissions for the activity can be changed in Settings > Assignment 

administration > Permissions. 

 

 

 

Оценивание вслепую 
Если эта настройка разрешена, тогда Преподаватель не будет видеть имена 

Студентов, которые передали готовые ответы на их Задания. Вместо этого они увидят 

только случайным образом сгенерированные номера участников. (Вид этого Задания для 

Студента не изменится.) То же происходит и в случае, когда Студентам разрешены 

комментарии. Однако после оценивания Задания Преподавателям можно увидеть, кто 

послал им готовые ответы, по щелчку «Reveal student identities (открыть личности 

Студентов)» в настройках Задания. 

Возвращение Оценок Студентам 
Из-за сущности природы слепого оценивания Студенты не могут видеть 

Итоговую Оценку до тех пор, пока все имена Студентов не открыты. Это находится в 

Assignment SettingsReveal Student Names. Однако комментарии Обратной Связи появятся. 

 

Замечание: Из-за этого уровень анонимности может не соответствовать 

требованиям конфиденциальности вашего образовательного заведения. Смотрите об этом 

элемент MDL-35390 – «Слепое оценивание не так слепо». 

Более подробно об этом средстве можно увидеть в видео по Youtube «Слепое 

оценивание в версии Moodle 2.4». 

4.3.1.1.10.Общие настройки модулей 
См. «Приложения» (п. 6.1) «Общие настройки модулей». 

4.3.1.1.11.Настройки ограниченности доступа 
Область настроек «Ограниченности доступа» становится видимой в настройках 

модуля Интерактиного Действия или Ресурса, если разрешены Обусловленные  Действия. 

4.3.1.1.12.Локально назначенные Роли 
В AdministrationAssignment administrationLocally assigned roles некоторым 

пользователям могут быть предоставлены дополнительные Роли в 

Интерактивных Действиях. Посмотрите, например, обсуждение форума по использованию 

в Moodle «Роль клиента для мониторинга Курса». 

4.3.1.1.13 Возможности Задания 
 Экспортировать собственные готовые ответы. 

 Оценить Задание. 

 Переслать готовые ответы по Заданию. 

 Просмотреть Задание. 

Полномочия Роли для каждого Интерактивного Действия могут быть изменены в 

AdministrationAssignment administrationPermissions. 

http://tracker.moodle.org/browse/MDL-35390
http://youtu.be/Biiw3E13mgM
http://youtu.be/Biiw3E13mgM
http://docs.moodle.org/25/en/Common_module_settings
http://docs.moodle.org/25/en/Capabilities/mod/assign:exportownsubmission
http://docs.moodle.org/25/en/Capabilities/mod/assign:grade
http://docs.moodle.org/25/en/Capabilities/mod/assign:submit
http://docs.moodle.org/25/en/Capabilities/mod/assign:view
https://tracker.moodle.org/browse/MDL-35390
http://www.youtube.com/watch?v=Biiw3E13mgM&feature=youtu.be
http://www.youtube.com/watch?v=Biiw3E13mgM&feature=youtu.be
http://docs.moodle.org/25/en/Restrict_access_settings
http://moodle.org/mod/forum/discuss.php?d=98208
http://docs.moodle.org/25/en/Capabilities/mod/assign:exportownsubmission
http://docs.moodle.org/25/en/Capabilities/mod/assign:grade
http://docs.moodle.org/25/en/Capabilities/mod/assign:submit
http://docs.moodle.org/25/en/Capabilities/mod/assign:view
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4.3.1.1.14.Site administration settings 
The following configuration options are available for an administrator 

under Settings > Site administration > Plugins > Activity modules > 

Assignment. 

Feedback plugin 
The comments that are pushed to the gradebook from the assignment are 

limited to a single text only comment. An Administrator can specify which 

of the feedback plugins will be push comments to the gradebook. On a 

standard Moodle install the choices are "Feedback comments" (default) or 

"Feedback file" but there may be additional options if your Moodle install 

contains additional feedback plugins. 

Show recent submissions 
This option allows everyone to see notifications of submissions in Recent 

activity reports and the Recent Activity Block, within a course context. 

Note that the default for this option is No which means students will not be 

able to see when classmates have submitted or updated any Assignments. 

 

Send submission receipt to students 
This switch will enable submission receipts for students. Students will 

receive a notification every time they successfully submit an assignment. 

 

Screenshot «Submission receipts settings». 

Submission Statement 
An administrator can enter text in the box here which will appear when 

students are about to submit their assignment. 

Screenshots «Admin view of Submission statement set up screen», 

«Student view when about to submit». 

Require that students accept the Submission 
statement 
If this is enabled then every assignment on the site will display the 

statement for students to agree to. The option will not appear in the 

assignment settings for a teacher. 

If it is left as the default "No", then teachers will have the choice within 

their own assignments to force this or not. 

The following configuration options are available for an administrator 

under Settings > Site administration > Plugins > Assignment plugins. 

There are two main sections Submission plugins and Feedback plugins. 

 

 

4.3.1.1.14.Настройки управления Сайта 
Администратору доступны следующие опции конфигурации: 

AdministrationAssignment administrationPluginsActivity modulesAssignment. 

 

Плагин Обратной Связи 
Комментарии, которые вставляются в Журнал Оценок из Задания, могут быть 

только текстовыми. Администратор может указать, который из Плагинов будет вставлять 

комментарии в Журнал Оценок. Стандартная инсталляция Moodle предоставляет выбор из 

«Feedback comments (комментарии обратной связи) – по умолчанию» или «Feedback file 

(файл обратной связи)», но возможны дополнительные опции, если ваша инсталляция 

Moodle содержит дополнительные Плагины Обратной Связи. 

Показать недавние готовые ответы 
Эта опция позволяет каждому увидеть извещения о готовых ответах в Отчётах по 

недавним Интерактивным Действиям и в Блоке недавних Интерактивных Действий 

внутри Контекста Курса. Заметьте, что по умолчанию для этой опции стоит No, которое 

означает, что Студенты не смогут увидеть, когда однокурсник передал готовый ответ или 

обновил любые Задания. 

Известить Студентов о получении от них готового ответа 
Этот переключатель позволит извещать Студентов о получении от них готовых 

ответов. Студенты будут получать извещения каждый раз, когда они успешно передадут 

готовый ответ на Задание. 

Снимок с экрана «Настройки извещений о получении готовых ответов». 

Заявление об отсутствии плагиата в готовом ответе 
Администратор может ввести здесь в окошко текст, который появится, когда 

Студенты займутся отправкой готового ответа на их Задание. 

Снимки с экрана «Вид Администратора на экран установки Заявления о готовом 

ответе», «Вид Студента при отправке готового ответа». 

Потребовать, чтобы Студенты предоставили Заявление об 
отсутствии плагиата в готовом ответе 

Если это разрешено, тогда каждое Задание на этом Сайте будет отображать 

Заявление, которое Студенты должны написать. Эта опция не появится в настройках 

Задания для Преподавателя. 

Если настройка оставлена как по умолчанию No, тогда Преподаватели сами внутри 

их собственных Заданий решат, требовать ли это от Студентов, или нет. 

Следующая конфигурация опций доступна для Администратора в 

AdministrationAssignment administrationPluginsAssignment plugins. Имеются два 

основных раздела «Submission plugins (плагины готовых ответов)» and «Feedback plugins 

(плагины обратной связи)». 

http://docs.moodle.org/25/en/Recent_activity
http://docs.moodle.org/25/en/Recent_activity
http://docs.moodle.org/25/en/File:ass_settings.jpg
http://docs.moodle.org/25/en/File:newsubmissionstatement.png
http://docs.moodle.org/25/en/File:newsubmissionstatement.png
http://docs.moodle.org/25/en/File:submissionstatement.png
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Submission plugins 
File submissions 
Enabled by default If set, this submission method will be enabled by 

default for all new assignments. 

Maximum submission size An Administrator can specify the maximum 

size of any individual file uploaded within the assignment module across 

all courses on the site. This limit may be equal to or less than course file 

upload limit. 

Online text submissions 
Enabled by default If set, this submission method will be enabled by 

default for all new assignments. 

Submission comments 
Enabled by default If set, this submission method will be enabled by 

default for all new assignments. 

Feedback plugins 
Feedback comments 
Enabled by default If set, this submission method will be enabled by 

default for all new assignments. 

File feedback 
Enabled by default If set, this submission method will be enabled by 

default for all new assignments. 

Offline grading worksheet 
Enabled by default If set, this will be enabled by default for all new 

assignments. 

Screenshot «Managing assignment feedback plugins». 

4.3.1.1.15.See also 
Synergy Learning blog post: Assignment resubmissions 

4.3.1.2.Using Assignment 
4.3.1.2.1.Different Submission options 
The standard assignment submission options available are: 

 File submissions (students submit a file for assessment) 

  

 Online text (students can type their responses directly in Moodle) 

 Submission comments 

It is also possible to use the assignment module for grading an "offline 

assignment", ie, one where work is done outside of Moodle. This is done 

by simply unchecking the above three options. 

Плагины готовых ответов 
Готовые ответы в виде файлов 

Разрешено по умолчанию. Если установлена, этот метод отправки готового 

ответа будет разрешён по умолчанию для всех новых Заданий. 

Максимальный размер готового ответа. Администратор может указать 

максимальный размер для любого индивидуального файла, пересылаемого внутри модуля 

«Задание» во всех Курсах на этом Сайте. Это ограничение может быть равно или меньше 

ограничения, установленного на пересылаемые в Курсе файлы. 

Готовые ответы в виде текста в режиме онлайн 
Разрешено по умолчанию. Если установлена, этот метод отправки готового 

ответа будет разрешён по умолчанию для всех новых Заданий. 

Комментарии к готовому ответу 
Разрешено по умолчанию. Если установлена, этот метод отправки готового 

ответа будет разрешён по умолчанию для всех новых Заданий. 

Плагины обратной связи 
Комментарии Обратной Связи 

Разрешено по умолчанию. Если установлена, этот метод отправки готового 

ответа будет разрешён по умолчанию для всех новых Заданий. 

Обратная Связь в виде файла 
Разрешено по умолчанию. Если установлена, этот метод отправки готового 

ответа будет разрешён по умолчанию для всех новых Заданий. 

Электронная таблица оценивания в режиме офлайн 
Разрешено по умолчанию. Если установлена, по умолчанию будет разрешена 

таблица для всех новых Заданий. 

Снимок с экрана «Плагины, управляющие Обратной Связью Заданий». 

4.3.1.1.15.См. также 
Сообщение блога «Обучение совместной деятельностью»: «Повторные готовые 

ответы на Задания». 

4.3.1.2.Применение Задания 
4.3.1.2.1.Различные опции готовых ответов 

Доступными опциями готовых ответов на стандартные Задания являются: 

 Готовые ответы в виде файлов (Студенты передают готовый ответ по Заданию в виде 

файла). 

 Текст онлайн (Студенты могут набрать их ответы непосредственно в Moodle). 

 Комментарии к готовым ответам. 

Модуль «Задание» можно также использовать для оценивания «Задания офлайн», 

т.е. Задания, работа по которому выполняется вне Moodle. Это осуществляется простым 

снятием отметок «галочкой» у трёх приведённых выше опций. 

http://www.synergy-learning.com/blog/moodle/moodle-2-5-improvements-assignment-resubmissions/
http://docs.moodle.org/25/en/File:24assignmentfeedbackplugins.png
http://www.synergy-learning.com/blog/moodle/moodle-2-5-improvements-assignment-resubmissions/
http://www.synergy-learning.com/blog/moodle/moodle-2-5-improvements-assignment-resubmissions/
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4.3.1.2.2.Which submission type suits you best? 
You want students to type shorter or longer 
responses directly online 
 Set Online text to Yes. This works well for younger children who will 

only manage a sentence or two and works just as well for higher 

education students who write more. 

 Advantage - quick for the student to get started; no need to use a 

word-processing program and upload the file. 

 Disadvantage - potential worries that if the internet goes down, the 

work students have typed in and not yet saved might be lost. If the 

word count is expected to be large, setting Online text to No and File 

submission to Yes might be a better option. 

You want students to submit work you can download 
in a specified program 
 
 Set File submission to Yes, set the number of files you will allow using 

the Maximum number of uploaded files setting and the file sizes by 

using the Maximum submission size setting. 

 Advantage - better than students emailing work as the whole class's 

work is collated in one space on your course. Markers can provide 

comments directly on the student work. 

 Advantage - with "Attempts reopened" enabled, teachers can see the 

progression through various drafts of a student's work. 

 

 Disadvantage - assignments must downloaded to be viewed (but 

they can be downloaded in bulk) and the teacher needs the 

appropriate program to open them. 

You want students to submit files at different times 
for a project 
 Set File submission to Yes, and use Maximum number of uploaded files 

to set the maximum number of separate files they can upload 

 Advantage - all project files are in one assignment area for grading 

so they get a single grade. 

 Disadvantage - all project files are in one assignment area for 

grading - so they can only have a single grade! 

 

 

 

4.3.1.2.2.Какой тип готового ответа подходит вам лучше? 
Вы хотите, чтобы Студенты набирали готовые ответы в виде 
текстов любой длины непосредственно в режиме онлайн 
 Установите Online text в Yes. Это хорошо работает для школьников, которые могут 

справиться лишь с одним-двумя предложениями, и так же хорошо работает для 

Студентов высшего образования, которые пишут много. 

 Преимущество – быстрый способ для Студентов начать работу; не нужно 

использовать текстовые процессоры и пересылать файл. 

 Недостаток – потенциальное беспокойство о том, что если откажет интернет, работы 

Студентов, набранные, но ещё не сохранённые, могут быть потеряны. Если 

предполагаются ответы с большим количеством слов, то установка Online text в No, 

а File submission в Yes могут быть лучшим выбором. 

Вы хотите, чтобы Студенты предоставляли на рассмотрение 
работу, которую вы можете загрузить в определённую 
программу 
 Установите File submission в Yes, установите число файлов, которое вы разрешаете 

использовать, посредством настройки Maximum number of uploaded files, и размеры 

файлов посредством настройки Maximum submission size. 

 Преимущество – лучше, чем отправка работы Студентами по почте, поскольку 

работа класса в целом собирается в одном месте на вашем Курсе. Проверяющие 

могут оставить свои комментарии прямо внутри работы Студента. 

 Преимущество – с разрешённой «Attempts reopened (возобновление попыток, 

п. 4.3.1.1.6)» Преподаватели могут увидеть течение учебного процесса через 

черновики студенческой работы. 

 Недостаток – Задания нужно загрузить, чтобы просмотреть (но они могут быть 

загружены оптом), и Преподаватель нуждается в подходящей программе, чтобы 

открыть их.  

Вы хотите, чтобы Студенты передавали файлы на рассмотрение 
в разные времена в течение проекта 
 Установите File submission в Yes, и используйте Maximum number of uploaded files, 

чтобы установить максимальное число отдельных файлов, которые они могут 

переслать. 

 Преимущество – все файлы проекта находятся в одной области Задания для 

оценивания, так что они получат одну общую Оценку. 

 Недостаток – все файлы проекта находятся в одной области Задания для оценивания 

– так что они могут иметь только одну общую Оценку. 
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You want students to write a response to a 
video/sound file/image 
 Set up an assignment allowing Online text submission and get students 

to use the Moodle media icon to add video/sound/image files. 

  

You want students to answer a series of questions on 
a video/sound file/image 

 Investigate the Quiz module. Assignments are really just for a single 

question. 

You want to view, comment on and send back 
students' assignments 
 Set up an assignment allowing file submissions which allows you to 

download the assignment, add your comments and then re-upload back 

to the student. 

 Advantage: useful for teachers who like using the "comment" 

options in word-processing programs for example 

 Disadvantage: the files have to be downloaded, saved and re-

uploaded. They can't be edited online. 

You want students to send you a comment or note 
along with their uploaded work 
 In the settings, set Submission comments to Yes. 

You want to allow students to redraft and decide 
when to submit the work 
 In the settings set Require students click submit button to Yes. Students 

can then control when their draft work is submitted to the teacher. 

 

You want students to keep an ongoing journal or do 
an iterative assignment 
 In the settings set Require students click submit button to No. Students 

can continue to make changes to their assignment and at no point do 

they 'submit'. If the work will be graded at some point it is 

recommended that either Prevent late submissions is set to Yes to 

ensure that no changes can be made after the due date, or all 

submissions are locked when grading commences to ensure that the 

work is not altered during grading. 

 

 

Вы хотите, чтобы Студенты подготовили ответ в виде 
видео/звукового файла/изображения 
 Установите Задание, разрешающее готовый ответ в виде текста онлайн и убедите 

Студентов использовать медиа иконку Moodle, чтобы добавлять файлы 

видео/звуковых/изображений. 

Вы хотите, чтобы Студенты отвечали на серию Вопросов, 
подготовленных в виде видео/звукового файла/изображения 

 Изучите модуль «Экзамен» (п. 4.3.10). Задания создаются, на самом деле, ради одного 

Вопроса. 

Вы хотите просматривать, комментировать и отсылать обратно 
студенческие Задания 
 Установите Задание, разрешающее готовые ответы в виде файлов, которые позволят 

вам загружать Задание, добавлять ваши комментарии и затем повторно пересылать 

обратно Студенту. 

 Преимущество: полезно для Преподавателей, которым, например, нравится 

использование опций «комментирования» в текстовых процессорах. 

 Недостаток: файлы должны быть загружены, сохранены и повторно пересланы. Они 

не могут редактироваться в режиме онлайн. 

Вы хотите, чтобы Студенты отправляли вам комментарий или 
замечание наряду с пересылаемой ими работой 
 В настройках установите Submission comments в Yes. 

Вы хотите позволить Студентам переписывать заново и решать, 
когда отправлять на рассмотрение их работу 
 В настройках установите Require students click submit button в Yes. Студенты смогут 

тогда сами решать, когда отправлять их черновую работу на рассмотрение 

Преподавателю. 

Вы хотите, чтобы Студенты сохраняли происходящее в 
дневнике или выполняли Задание итеративно 
 В настройках установите Require students click submit button в No. Студенты смогут 

продолжить делать изменения к их Заданию, и момент, когда им следует «передать 

готовый ответ на рассмотрение», не фиксирован. Если эта работа будет оценена в 

некоторый момент времени, рекомендуется, либо их Prevent late submissions установить 

в Yes, чтобы гарантировать, что никакие изменения не могут быть сделаны после срока 

окончания, либо заблокировать все готовые ответы, когда начнётся оценивание, так что 

их работа не изменится во время оценивания. 
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 Advantage: the work remains in one place and is constantly 

improved, graded (if needed) and improved again. 

 Disadvantage: there is no record/history of previous attempts (such 

as with the Wiki). The online text assignment does not replicate the 

display of a journal or blog where each new entry is additional to the 

previous ones. 

You want students to submit work in groups 
 
 In the settings, set "Students submit in groups" to Yes. If you just do 

this, then once one student has submitted, the assignment will be 

flagged as submitted even if the others haven't contributed. If you want 

to ensure everyone has an input, set "Require students click submit 

button" to Yes and then change "Require all group members to submit" 

to Yes. 

The assignment will only be classed as submitted when each member has 

contributed, and once one student has submitted, the remaining members's 

names will be displayed for the group to see who still needs to add their 

input. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Преимущество: работа останется в одном месте и будет постоянно улучшаться, 

оцениваться (если нужно) и снова улучшаться. 

 Недостаток: отсутствие записи/истории предыдущих попыток (таких как с Вики). 

Задание с ответом в виде текста онлайн не воспроизводит отображения дневника 

или Блога, где каждый новая запись является дополнением к предыдущей. 

 

Вы хотите, чтобы Студенты передавали на рассмотрение работу 
в Группах 
 В настройках установите Students submit in groups в «Yes». Если вы просто сделаете 

это, тогда как только некий Студент передаст готовый ответ, его Задание будет 

помечено флажком, как получившее ответ, даже если другие Студенты ещё свои не 

предлагали. Если вы хотите обеспечить, чтобы каждый мог вводить информацию, 

установите «Require students click submit button» в «Yes», и затем измените «Require all 

group members to submit» в «Yes». 

Это Задание будет аттестовано как получившее ответ, только когда каждый член 

предложит свой ответ, и как только какой-либо Студент передаст ответ, имена оставшихся 

членов этой Группы будут отображены, чтобы видеть, кому ещё нужно ввести свою 

информацию в качестве ответа на Задание. 
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You want to grade students' work anonymously 
 In the settings, choose "Blind marking". When students submit 

assignments, their names will be replaced by radomly generated 

participant numbers so you will not know who is who. Note that this is 

not totally Italic text blind marking because you can reveal their 

identities in the assignment settings and you can work out identities 

from the logs - so this might not be suitable if your establishment has 

very precise privacy requirements. 

 

You want to read and grade student assignments 
offline 
 In the settings, choose "Offline grading worksheet". When students 

have submitted, click "View/grade all submissions" and you can 

download their assignments from the link "Download all submission" 

and download the grading sheet from the link "Download grading 

worksheet". You can then edit grades and re-upload the grading 

worksheet. You can also upload multiple feedback files in a zip from 

this drop down menu. See Assignment settings for an explanation of 

how to use the "upload multiple feedback files as zip" feature. 

4.3.1.2.3.How do students submit their 
assignments? 
The first page students will see when they click on the assignment activity 

link from the course page will display the assignment name, description 

and the submission status. 

The submission status section includes: 

 Submission status 

 Grading status 

 Due date 

 Time remaining 

 Last modified 

 Submission details 

As they progress through the assignment the Submission status and 

Grading status will update and the Last modified date will appear. 

 

 

 

 

 

Вы хотите оценивать работу Студентов анонимно 
 В настройках выберите «Blind marking (оценивание вслепую)». Когда Студенты 

передают готовый ответ на Задания, их имена будут замещены случайно 

сгенерированными номерами участников, так что вы не узнаете, кто есть кто. Заметьте, 

что это не полностью оценивание вслепую курсивным текстом, из-за того, что вы 

можете индивидуализировать их в настройках этого Задании, и вы можете 

индивидуализировать их по Журналам Регистрации, – так что это может не подходить 

вашей организации, если она нацелена на строгое соблюдение требований 

конфиденциальности. 

Если вы хотите читать и оценивать Задания Студентов в режиме 
офлайн 
 В настройках выберите «Offline grading worksheet». Когда Студенты передали готовые 

ответы, щёлкните «View/grade all submissions» и вы можете загрузить их Задания по 

ссылке «Download all submission» и загрузить таблицу оценивания по ссылке 

«Download grading worksheet». Потом вы можете отредактировать Оценки и повторно 

переслать таблицу Оценок. Вы можете также переслать много файлов Обратной Связи 

zip-заархивированных из этого ниспадающего меню. См. Assignment settings, 

объясняющие как использовать средство «Upload multiple feedback files as zip». 

 

4.3.1.2.3.Как Студентам переслать готовые ответы по их 
Заданиям? 

Студенты на первой странице увидят, когда они щёлкнут по ссылке 

Интерактивного Действия «Задание», что страница Курса отображает название Задания, 

описание и состояние передачи готового ответа на рассмотрение. 

Раздел состояния передачи готового ответа включает: 

 Состояние передачи готового ответа. 

 Состояние оценивания. 

 Срок окончания. 

 Оставшееся время. 

 Последняя модификация. 

 Подробности готового ответа. 

Поскольку на протяжении выполнения Задания состояние передачи готового 

ответа и состояние оценивания будут обновляться и дата Последней модификации 

появится. 
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Submission statuses include: 

 Nothing submitted for this assignment 

 Draft (not submitted) 

 Submitted for grading 

Grading statuses include: 

 Not graded 

 Graded 

File submission 
To submit a file submission, students complete the following steps: 

 

 Click the ‘Add submission’ button to bring up the file upload page. 

  

 Upload the relevant file into the submission. They are able to ‘drag and 

drop’ the file into the submission box. 

 Click ‘Save Changes’. 

 There should now be a Last modified date and the file(s) uploaded will 

also be displayed. 

 Depending on how the assignment is setup the status will either read 

‘Submitted for grading’ - in which case no further action is need, or 

‘Draft (not submitted)’. 

 

 If changes are required, click on ‘Edit my submission’. 

 

 Once ready to submit, click ‘Submit assignment’. Note that once the 

assignment is 'submitted’ no further changes are allowed. 

 

Note: Depending on how the assignment is setup students may see both a 

file submission page and an online text editor. 

Online text 
To submit online text, students complete the following steps: 

 

 Click the ‘Add submission’ button to bring up the online text editor 

page 

 Type the relevant text into the text editor, or paste from a previously 

written file. 

 Click ‘Save Changes’. 

 There should now be a Last modified date and the first 100 characters 

entered will also be displayed. 

 

Состояния передачи готового ответа включают: 

 Ничего не передано на рассмотрение по этому Заданию. 

 Черновики (не переданные на оценивание). 

 Переданные готовые ответы для оценивания. 

Состояния оценивания включают: 

 Не оценено. 

 Оценено. 

Передача готовых ответов в виде файлов 
Чтобы передать на рассмотрение готовый ответ в виде файла, Студенты 

выполняют следующие шаги: 

 Щёлкают кнопку «Add submission (добавить готовый ответ)», чтобы вызвать страницу 

пересылки файлов. 

 Пересылают релевантный файл в готовый ответ. Это можно сделать «буксировкой» 

файла в окошко передачи готового ответа. 

 Щёлкают «Save Changes (сохранить изменения)». 

 Здесь появляется дата Последней модификации, а также отображаются пересылаемые 

файлы. 

 В зависимости от того, как установлено Задание, состояние будет читаться либо как 

«Submitted for grading (переданные для оценки готовые ответы)» – в этом случае 

никаких дальнейших действий не требуется, либо как «Draft – черновик (не 

переданные)». 

 Если требуются изменения, щёлкните «Edit my submission (редактировать мои готовые 

ответы)». 

 При готовности передачи готового ответа щёлкните «Submit assignment (передать 

задание на рассмотрение)». Заметьте, что после передачи Задания на рассмотрение 

никакие дальнейшие изменения не разрешаются. 

Замечание: В зависимости от того, как установлено Задание, Студенты могут 

видеть и страницу передачи готового ответа в виде файла, и редактор текста онлайн. 

Текст онлайн 
Чтобы отправить готовый ответ в виде текста онлайн Студенты выполняют 

следующие шаги: 

 Щёлкают кнопку «Add submission», чтобы вызвать страницу редактора текста онлайн. 

 

 Набирают нужный текст в текстовом редакторе или вклеивают из предварительно 

записанного файла. 

 Щёлкают «Save Changes». 

 Здесь должна появиться дата Последней модификации, а также отображены первые 100 

введённых символов. 
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 Depending on how the assignment is setup the status will either read 

‘Submitted for grading’ - in which case no further action is need, or 

‘Draft (not submitted)’ 

 If changes are required, click on ‘Edit my submission’. 

 

 Once ready to submit, click ‘Submit assignment’. Note that once the 

assignment is 'submitted’ no further changes are allowed. 

 

Submission comments 
Depending on how the assignment has been setup, there may be a section 

where students can leave submission comments. 

4.3.1.2.4.Submission notifications 
Moodle allows the sending of a notification to the student when a student 

submits an assignment. This feature provides reassurance to the students 

that they have correctly submitted their assignments, especially when using 

features like draft submissions and file uploads. Moodle also allows 

notifications to teachers either when students submit assignments, or when 

students submit assignments late, or both. This feature notifies markers of 

the presence of assignments, or provides a reminder to access assignments 

submitted after the due date. 

 

Why is this useful? 
 Provides a receipt for student that the assignment has been successfully 

submitted 

 Provides notification to marker that assignment are submitted 

 

 Notifies of any changes to submission - for student’s record and to 

notify marker 

 Provides notification to student that assignment feedback is available 

When is it sent? 
 If ‘Require students to hit submit button’ is enabled within the 

assignment (formerly ‘enable send for marking button’ in 2.2), which 

requires students to click a final submit button and prevents further 

changes, only one notification will be sent upon hitting the submit 

button. 

 

 

 

 

 В зависимости от того, как установлено Задание, его состояние будет читаться либо 

«Submitted for grading (переданные для оценки готовые ответы)» – в этом случае 

никаких дальнейших действий не требуется, либо «Draft (черновик – не переданные)». 

 Если требуются изменения, щёлкают «Edit my submission (редактировать мои готовые 

ответы)». 

 При готовности передачи готового ответа щёлкают «Submit assignment». Заметьте, что 

после передачи Задания на рассмотрение никакие дальнейшие изменения не 

разрешаются. 

Комментарии готовых ответов 
В зависимости от того, как установлено Задание, возможен раздел, где Студенты 

могут оставить комментарии к готовому ответу. 

4.3.1.2.4.Извещения о передаче готовых ответов 
Moodle позволяет отправлять извещение Студенту, когда Студент отправит 

готовый ответ на Задание. Это средство предоставляет подтверждение Студентам о их 

корректно переданных на рассмотрение готовых ответах на Задания, особенно когда 

используются средства, подобные черновикам готовых ответов и пересылкам файлов. 

Moodle также позволяет извещать Преподавателей, когда Студенты отправляют готовые 

ответы на Задания, либо когда Студенты передают готовые ответы с опозданием, или в 

обоих случаях. Это средство  извещает Оценивающих о наличии Заданий или делает 

напоминание об оценивании Заданий, готовые ответы на которые переданы после срока 

окончания. 

Чем это полезно? 
 Предоставляет Студенту документальное подтверждение о том, что он вовремя 

выполнил Задание. 

 Предоставляет извещение Оценивающему о том, что на Задание получен готовый 

ответ. 

 Извещает о любых изменениях в готовом ответе – для дневника Студента и для 

сведения Оценивающего. 

 Извещает Студента, что поступила Обратная Связь на его ответ по Заданию. 

Когда оно отправлено? 
 Если разрешена опция «Require students to hit submit button (потребовать от студентов 

нажимать кнопку передачи готовогво ответа)» внутри Задания (ранее в версии 2.2 

«разрешить отправку для кнопки оценивания»), которая требует, чтобы Студенты 

щёлкнули кнопку окончательного готовогво ответа, и предотвращает дальнейшие 

изменения, как только одно извещение будет отправлено по нажатию кнопки передачи 

готового ответа. 
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If ‘Require students to hit submit button’ is not enabled, and students are 

allowed to make alterations or add/remove files from their submission, this 

receipt will be sent every time the file is altered - ie once on adding the 

file, once on adding a second file, once on removal of file, once on 

uploading a new file. 

Where are these settings? 
Submission Notification for Grader - Assignment > Edit Settings The 

grader is given two options: 

 Notify Graders about Submissions - YES/NO 

 Notify Graders about Late Submissions - YES/NO 

The first option will notify the grader on any/all submissions made. The 

second will only send a notification for assignments submitted after the 

‘Due Date’. 

The Late Submissions option will be greyed out unless ‘Notify Graders 

about Submissions’ is selected as NO because ‘Notify Graders about 

Submissions’ will also send receipts for assignments submitted after the 

due date. To fully disable the grader receiving notifications, change both 

options to NO. 

 

Submission Notification for Students - My Profile Settings > Messaging 

Tickboxes on the messaging page can be set by the student depending on 

their preference. A student can opt to receive notification via email, popup 

message or both. 

Assignment notification - On submission of an assignment, the student will 

receive a notification that their assignment has been successfully received. 

Essay graded notification - Once a grader has provided a mark/feedback 

for assignments, students will be notified (within the hour) that this 

feedback is available. 

4.3.1.2.5.Viewing and grading submitted 
assignments 
When students have submitted their assignments, they can be accessed by 

clicking on the assignment activity. This will bring up the Grading 

Summary page. 

The Grading Summary page displays a summary of the assignment, 

including; number of participants, number of drafts, number of submitted 

assignments, due date and time remaining. 

Clicking on the the ‘View/grade all submissions’ link will bring up the 

Grading Table. 

 

Если опция «потребовать от Студентов наживать кнопку передачи готововых 

ответов» не разрешена, а Студентам позволено делать изменения или добавлять/удалять 

файлы с их переданными на рассмотрение готовыми ответами, эта квитанция будет 

отправляться каждый раз, когда файл изменяется – т.е. при добавлении файла, при 

добавлении второго файла, при удалении файла, при пересылке нового файла. 

Где находятся эти настройки? 
Извещение о передаче готового ответа для Оценивающего – 

AdministrationAssignment administration Edit Settings. Оценивающему даны две опции: 

 Извещать Оценивающих о передачах готовых ответов – YES/NO. 

 Извещать Оценивающих о запоздавших передачах готовых ответов – YES/NO. 

Первая опция известит Оценивающего по любому/всем сделанным передачам 

готовых ответов. Вторая только отправит извещение для Заданий, получивших готовые 

ответы после «срока  окончания». 

Опция «Late Submissions (запоздавшие передачи готовых ответов)» будет 

подсвечена серым цветом, если только опция «Notify Graders about Submissions» не 

установлена в NO, поскольку опция «Notify Graders about Submissions» также будет 

отправлять квитанции для Заданий, переданных на рассмотрение после даты окончания. 

Чтобы полностью оградить Оценивающего от получения извещений, измените обе опции 

в NO. 

Извещение о передаче готового ответа для Студентов – 

AdministrationMy Profile SettingsMessaging Tickboxes на странице сообщений может 

быть установлено Студентом, в соответствии с его предпочтениями. Студент может 

выбрать получение извещений по э-почте, всплывающих сообщений, или их обоих. 

Извещение о Задании – по отправке готового ответа на Задание Студент получит 

извещение, что его Задание успешно получено. 

Извещение об оцененном Эссе – как только Оценивающий предоставит 

Оценку/Обратную Связь по Заданиям, Студенты будут извещены (в течение часа), что им 

доступна Обратная Связь. 

4.3.1.2.5.Просмотр и оценивание Заданий, на которые 
переданы готовые ответы 

Когда Студенты передали готовые ответы по их Заданиям, они могут быть 

допущены к просмотру посредством щелчка по Интерактивному Действию «Задание». Это 

вызовет страницу Итоговое Оценивание. 

Страница «Итоговое Оценивание» отображает краткое изложение Задания, 

включая количество Участников, число черновиков, число Заданий, на которые 

отправлены готовые ответы, срок окончания и оставшееся до него врея. 

Щелчок по ссылке «View/grade all submissions (просмотреть/оценить все готовые 

ответы)» приведёт к появлению Таблицы оценивания. 



 

64 

The Grading Table contains columns of information about the student, the 

status of their submission, a link to grade their submission, a link to each 

submission and feedback comments and files (if enabled). 

Submission status 
If you will be assigning grades to student work, you may want to take note 

of the submission status before you begin the marking process. If you have 

required students click the Submit button, you may find that some 

submissions are still marked as Draft (not submitted), meaning the student 

has either uploaded a file(s) or entered some text, but has not clicked 

‘Submit assignment’. 

 

If it's after the due date and you are about to commencing marking that you 

use ‘Prevent submission changes’ to stop students from making changes to 

their assignment. You can do this one by one by using the icon in the Edit 

column. 

Or you can select two or more students by putting a tick in the select 

column and going to 'Lock submissions’ from the With selected menu 

under the grading table. 

Likewise you can also revert a student's submission to draft if they have 

uploaded the incorrect file. Instead of selecting ‘Prevent submission 

changes’ select ‘Revert the submission to draft’, or place ticks against 

selected students and choose 'Revert the submission to draft status' from 

the With selected menu under the grading table. 

 

Quick grading 
Under Options (scroll to bottom of the page) you can determine your 

preferences for the number of assignments you wish to display per page. 

You can also filter assignments either to show all (no filter), submitted, or 

requires grading. This is also where you can turn on quick grading. 

 

Quick grading allows you to enter grades and a feedback comment (if 

enabled in Assignment settings) directly into the grading table. Quick 

grading is not compatible with advanced grading and is not recommended 

when there are multiple markers. 

 You can enter grades and feedback comments using quick grading. It is 

now possible to enter grades in decimal format. You will not be able 

to return a feedback file to your students (if enabled in the Assignment 

settings). 

 Enter the grades 

 

Таблица оценивания содержит колонки информации о Студенте, состояние 

передачи им готового ответа, ссылку, чтобы оценить его готовый ответ, ссылку на каждую 

передачу готового ответа, комментарии Обратной Связи и файлы (если они разрешены). 

Состояние готового ответа 
Если вы будете назначать Оценки работе Студента, вы можете захотеть получить 

перед началом процесса оценивания запись о состоянии готового ответа. Если вы 

потребовали от Студентов щёлкнуть кнопку Submit (передать готовый ответ на 

рассмотрение), вы сможете обнаружить, что некоторые готовые ответы всё ещё помечены 

как черновики (не переданные на рассмотрение), означающее, что Студенты либо 

переслали файл(ы), либо ввели некоторый текст, но не щёлкнули «Submit assignment 

(передать на рассмотрение готовый ответ по заданию)». 

Если это происходит после даты окончания, и вы начинаете оценивание, то вы 

используете «Prevent submission changes (предотвратить изменения готовых ответов)», 

чтобы остановить внесение Студентами изменений в их Задания. Вы можете сделать это 

одно за другим, используя иконку в колонке Edit (редактирование). 

Или вы можете выбрать двух или более Студентов, пометив их в колонке Select 

(выбор) и перейдя к «Lock submissions (заблокировать передачу готовых ответов)» из 

меню With selected (с выбранными), находящемся под таблицей оценивания. 

Более того, вы можете также вернуть готовый ответ Студента в состояние 

черновика, если он переслал некорректный файл. Вместо выбора «Prevent submission 

changes» выберите «Revert the submission to draft (Вернуть ответ в состояние черновика)» 

или пометьте отобранных Студентов и выберите «Revert the submission to draft status 

(вернуть ответу статус черновика)» из меню With selected (с выбранными), находящемся 

под таблицей оценивания. 

Быстрое оценивание 
Ниже опций (прокрутить вниз страницы) вы можете определить ваши 

предпочтения для ряда Заданий, которые хотите отображать на странице. Вы можете 

также отфильтровать Задания, чтобы либо показать всё (не фильтруя), либо полученные 

ответы, либо требующие оценивания. Это также возможно там, где вы можете включить 

быстрое оценивание. 

Быстрое оценивание позволяет вам вводить Оценки и комментарии 

Обратной Связи (если разрешено в настройках Задания, см. п. 4.3.1.1) прямо в Таблицу 

оценивания. Быстрое оценивание не совместимо с продвинутым оцениванием и не 

рекомендуется, когда существует много Оценивающих. 

 Вы можете ввести Оценки и комментарии Обратной Связи, используя быстрое 

оценивание. Сейчас можно вводить Оценки в десятичном формате. Вы не сможете 

вернуть файл Обратной Связи вашим Студентам (если разрешено в настройках 

Задания, см. п. 4.3.1.1). 

 Введите Оценки. 
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 Scroll to the bottom of the grading table and click 'Save all quick 

grading changes' 

 A confirmation screen will appear. 

Student grading page 
If you have enabled File Feedback in the Assignment settings and wish to 

upload either the marked student assignment, a 

completed text based feedback document or audio feedback, click on the 

green tick in the Grade column (or use the icon in the Edit column and 

select Grade). 

Here you can enter grades, feedback comments and feedback files (if 

enabled in the Assignment settings). You can use drag and drop to upload 

feedback files. 

Downloading student submissions 
You can download a zip file containing all of the assignment submissions 

by selecting the ‘Download all submissions’ options from the Choose 

menu at the top of the grading table, or in the settings menu. 

File submissions will be downloaded in the format uploaded by the 

student. Online text submissions will be downloaded as html files. Each 

file in the zip will include the student first and lastname at the 

beginning of the filename for identification purposes. 

4.3.1.2.6.Keeping records (archiving, exporting, 
backing up) 
When students unenrol from a Moodle area, their records become invisible 

through the Gradebook interface. In order to have the information to hand, 

departments or course teaching teams may need systems in place to keep 

their own records for the data retention period required in their particular 

context. There are two separate procedures for exporting student 

submissions and marks. 

To export marks (with or without feedback): 

 Go to your course area 

 From its front page Settings block, select Grades; the Grader Report 

loads. 

 From the Grader Report Settings block, select Export; a menu displays. 

 From the menu, if you need easy viewing and running calculations you 

probably want to select one of the spreadsheet formats; a page of export 

settings loads 

 Use the Visible Groups pull down menu to limit the export to specific 

groups, as required 

 

 Прокрутите вниз Таблицу оценивания и щёлкните «Save all quick grading changes 

(сохранить все изменения быстрого оценивания)». 

 Появится экран подтверждения. 

Страница оценивания Студента 
Если вы разрешили Обратную Связь в виде файла в настройках Задания и хотите 

переслать либо оценённое Задание Студента, либо завершённый текст, основанный на 

документе Обратной Связи, либо Обратную Связь в виде аудио, щёлкните по зелёной 

птичке в колонке Grade (или используйте иконку в колонке Edit и выберите Grade). 

 

Здесь вы можете ввести Оценки, комментарии и файлы Обратной Связи (если 

разрешено в настройках Задания, см. п. 4.3.1.1). Для пересылки файлов Обратной Связи вы 

можете воспользоваться буксировкой. 

Загрузка готовых ответов Студентов 
Вы можете загрузить zip-файл, содержащий все готовые ответы на Задание 

выбором опций «Download all submissions (загрузить все готовые ответы)» из меню Choose 

(выбрать) вверху Таблицы оценивания или в меню настроек. 

Готовые ответы в виде файла будут загружены в формате, пересланном Студентом. 

Готовые ответы в виде текста онлайн будут загружены как html-файлы. Каждый файл в 

формате zip будет включать имя и фамилию Студента в начале названия файла с 

целью идентификации. 

4.3.1.2.6.Сохранение записей (архивирование, 
экспортирование, резервное копирование) 

Когда Студенты отчисляются из Moodle, их записи становятся невидимыми через 

интерфейс Журанала Оценок. Для того чтобы иметь эту информацию под рукой, 

обучающим командам учебного заведения или Курса может потребоваться в наличии 

система, поддерживающая свои собственные записи на период сохранения этих данных, 

требующийся в их собственном контексте. Имеются две отдельные процедуры для 

экспортирования готовых ответов и отметок Студентов. 

Чтобы экспортировать отметки (с или без Обратной Связи): 

 Перейдите в область вашего Курса. 

 Из Блока настроек его Главной Страницы выберите Grades; загрузится Отчёт 

Оценивающего. 

 Из Блока настроек Отчёта Оценивающего выберите Export; отобразится меню. 

 Из этого меню, если нужен лёгкий просмотр и запуск вычислений, вы, возможно, 

захотите выбрать один из форматов электронных таблиц; загрузится страница настроек 

экспорта. 

 Используйте ниспадающее меню Visible Groups (видимые группы), чтобы ограничить 

экспорт отдельных Групп, как требуется. 



 

66 

 In Options, you indicate whether feedback comments are included 

 In Grade Items To Be Included lists you can, if required, omit particular 

Activities from the report 

 

 When you've finished with the settings, click on Submit; a preview of 

your export displays 

 Click on Download to export to the format you chose, and save the file. 

 

To download the original student submissions: 

 In your course area, click the link to the Assignment whose submissions 

you want to download. 

 Click on the link to View/Grade all submissions; the Grading Table will 

load. 

 Click the link to 'Download all submissions' (either from the Choose 

menu or from the Settings block), and save the file. 

4.3.1.2.7.Tips and Tricks 
 Want to use an Assignment activity again in another Moodle site? Use 

the backup and restore options. 

 Want to use an Assignment activity in another course you teach? Use 

the Import function in the course administration block. 

 Moodle will sometimes appear not to be uploading a resubmitted 

assignment - you seem to be downloading the original assignment. This 

is a cache issue, in short, go to "Tools > Clear Recent History" in 

Firefox or "Tools > Delete Browsing History > Delete Temporary 

Files" in Windows Explorer. The newer file will then appear. 

4.3.1.2.8.See also 
One approach to group project grading Blog post by Gavin Henrick. 

 

Examples from School demo site 
 Student view of an assignment. Log in with username 'student' and 

password 'moodle'. Scroll down to see the rubric and feedback. 

 

 Student view of a student submission statement. Log in with username 

'student' and password 'moodle' 

 Student view of group assignment grading screen. Log in with 

username 'student' and password 'moodle' 

 Teacher view of a group assignment grading screen. Log in with 

username 'teacher' and password 'moodle'. 

 

 В Options (оации) укажите, включаются ли комментарии Обратной Связи. 

 В списках Grade Items To Be Included (оцениваемые элементы, которые должны быть 

включены) вы можете, если требуется, не включить в отчёт отдельные 

Интерактивные Действия. 

 Когда вы закончите с настройками, щёлкните по Submit; отобразится предварительный 

просмотр вашего экспорта. 

 Щёлкните по Download, чтобы экспортировать в выбранном вами формате, и сохраните 

этот файл. 

Чтобы загрузить оригинальные студенческие готовые ответы: 

 В области вашего Курса щёлкните ссылку того Задания, ответы на которое вы хотите 

загрузить. 

 Щёлкните ссылку View/Grade all submissions (просмотреть/оценить все готовые 

ответы); загрузится таблица оценивания. 

 Щёлкните ссылку Download all submission (или из меню Choose, или из Блока Settings) 

и сохраните этот файл. 

4.3.1.2.7.Советы и трюки 
 Хотите снова использовать Интерактивное Действие «Задание» на другом Сайте 

Moodle? Используйте опции резервного копирования и восстановления (пп. 4.10.1-2). 

 Хотите использовать Интерактивное Действие «Задание» в другом Курсе вашего 

обучения? Используйте функцию импорта в Блоке Управления этого Курса. 

 Moodle иногда появляется, не пересылая повторно оценённое Задание, – вам кажется, 

что было загружено оригинальное Задание. Это вопрос кэширования; если кратко, 

перейдите к «ToolsClear Recent History» в браузере Firefox или к «ToolsDelete 

Browsing HistoryDelete Temporary Files» в проводнике Windows. Тогда появится 

самый новый файл. 

4.3.1.2.8.См. также 
«Один подход к оцениванию проекта Группы» предоставлен Гэвином Хенриком в 

сообщениях Блога. 

Примеры с демонстрационного Сайта Школы (http://school.demo.net/) 

 «Студент просматривает задание». Зарегистрируйтесь под именем «student» с паролем 

«moodle». Прокрутите пример вниз до «rubric and feedback (рубрикация и обратная 

связь)». 

 «Студент просматривает формулировку студенческого готового ответа». 

Зарегистрируйтесь под именем «student» с паролем «moodle». 

 «Студент просматривает экран оценивания группового Задания». Зарегистрируйтесь 

под именем «student» с паролем «moodle». 

 «Преподаватель просматривает экран оценивания группового Задания». 

Зарегистрируйтесь под именем «teacher» с паролем «moodle». 

http://docs.moodle.org/25/en/Import_course_data
http://www.somerandomthoughts.com/blog/2013/07/07/one-approach-for-group-project-grading/
http://school.demo.net/
http://moodle.org/mod/forum/discuss.php?d=201307Advantages
http://school.demo.moodle.net/mod/assign/view.php?id=1457&action=editsubmission
http://school.demo.moodle.net/mod/assign/view.php?id=1501
http://schoolmaster.demo.moodle.net/mod/assign/view.php?id=1501
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 Teacher view of blind marking grading screen. Log in with username 

'teacher' and password 'moodle' 

Other 

 Using Moodle of using Assignment upload over emailing a document 

forum discussion 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 «Преподаватель просматривает экран оценивания методом слепого оценивания»:. 

Зарегистрируйтесь под именем «teacher» с паролем «moodle». 

Другое 
 Обсуждения форума по использованию Moodle «Использование пересылки Задания 

вместо пересылки документа по э-почте». 

http://school.demo.moodle.net/mod/assign/view.php?id=1500&action=grading
http://moodle.org/mod/forum/discuss.php?d=201307Advantages
http://moodle.org/mod/forum/discuss.php?d=201307Advantages
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4.3.1.3.Assignment FAQ 
4.3.1.3.1.How can I find assignments which have 
not yet been graded? 
To find ungraded submissions for a particular assignment, click on the 

assignment, then beneath the Grading Summary table, click the 

View/grade all submissions link. A table that includes a Grade column is 

displayed. Sort the table rows by clicking on the column title, in this case 

Grade. Assignment submissions will then be ordered according to their 

given grade, with ungraded submissions displayed at the top of the column. 

4.3.1.3.2.Why can't I edit grades for assignment 
submissions? 
If you edit assignment grades directly in the gradebook, an "overridden" 

flag is set, meaning that the grade can no longer be edited from the 

Grading summary page. 

If required, the flag can be removed by turning editing on in the grader 

report, then clicking the edit grade icon, unchecking the overridden box 

and saving the changes. 

4.3.1.3.3.How can a selected outcome be removed 
from an assignment? 
To remove previously selected outcomes (which appear greyed out on the 

update assignment page): 

 Follow the Grades link from the Settings block in the course. 

 On the Grader report page, select the Categories and items tab. 

 Locate the assignment for which the outcome is to be removed. The 

outcome is listed directly below it. 

 Click the delete icon opposite the outcome. 

4.3.1.3.4.Can students receive confirmation of 
submission via email? 
Moodle allows the sending of a notification to the student when a student 

submits an assignment. This feature provides reassurance to the students 

that they have correctly submitted their assignments, especially when using 

features like draft submissions and file uploads. 

 

Students can also return to the relevant Assignment and see confirmation 

in the Assignment's Submission status page. 

 

 

4.3.1.3.Часто задаваемые вопросы по Заданию 
4.3.1.3.1.Как найти ещё неоценённые Задания? 
 

Чтобы найти неоценённые готовые ответы по конкретному Заданию, щёлкните по 

этому Заданию, затем ниже Таблицы Итогового Оценивания щёлкните ссылку View/grade 

all submissions. Отобразится таблица, которая включает колонку Grade. Отсортируйте 

строки этой таблицы щелчком по заголовку этой колонки, в данном случае Grade. Готовые 

ответы по Зданию будут упорядочены в соответствии с данными им Оценками. Вверху 

таблицы расположатся неоценённые готовые ответы. 

4.3.1.3.2.Почему невозможно отредактировать Оценки за 
готовые ответы по Заданию? 

Если вы редактируете Оценки (п. 4.9.1) прямо в Журнале Оценок, устанавливается 

флажок «Overridden (отменённый)», означающий, что Оценка не может далее 

редактироваться со страницы Итогового Оценивания. 

Если требуется, этот флажок может быть удалён посредством включения режима 

редактирования в Отчёте Оценивающего (п. 4.9.1.1), затем щелчка по иконке Edit grade 

(п.4.9.1.11), снимающего метку в окошке Overridden и сохранения изменений. 

4.3.1.3.3.Как можно удалить выбранный Показатель из 
Задания? 

Чтобы удалить предварительно выбранные Показатели (которые появляются 

подсвеченные серым цветом на странице обновления Задания): 

 Следуйте по ссылке Grades из Блока Управления в вашем Курсе. 

 На странице отчёта Оценивающего выберите этикетку Categories and items. 

 Определите местонахождение Задания, для которого этот Показатель должен быть 

удалён. 

 Щёлкните иконку Delete напротив этого Показателя. 

4.3.1.3.4.Могут ли Студенты получать подтверждение о 
передаче готового ответа через э-почту? 

Moodle разрешает отправку извещения (п. 4.3.1.2.4) Студенту, когда Студент 

передаёт готовый ответ по Заданию. Это средство предоставляет Студентам 

подтверждение того, что они корректно передали готовые ответы по их Заданиям, 

особенно когда используются средства, подобные передаче черновых ответов и пересылки 

файлов. 

Студенты также могут вернуться к соответствующему Заданию и увидеть 

подтверждение на странице Assignment's Submission status (состояние ответа на задание.) 
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4.3.1.3.5.Can I download all submitted 
assignments at once? 
Users with the required permissions (e.g. those with a Teacher role) can 

click on the assignment and from the Settings block on the Grading 

summary page, access the 'Download all Submissions' link under 

'Assignment administration'. 

4.3.1.3.6.How can I export the rubric levels and 
criteria along with students' submissions? 
There is a tracker entry for this if you'd like to vote! MDL-32089. 

 

4.3.1.3.7.Why do I not see the upload button when 
I switch my role to student to test out the 
assignment I made? 
This feature is intended for teachers so that they can see how their course 

appears for students. It isn't a reliable view however, as some features do 

not display correctly when viewed by a teacher who has switched their role 

to a student. For that reason it is always preferable where possible to have 

a "test" student log in to use. 

 

4.3.1.3.8.What happens if I restore a backup 
containing Assignment (2.2) activities? 
If you have a site with Assignment (2.2) disabled/hidden, when somebody 

restores a backup with a Assignment (2.2) activity, it will show up in the 

restore process, saying it will be restored, but when the restore is finished, 

it won't be available. See MDL-33952 for a workaround and proposed 

solution for Moodle 2.3.1. 

4.3.1.3.9.What's the point of the "Due date"? 
Your use of the Allow submissions from and Due date settings will 

probably be dependent on the overall structure of your course. If you are 

facilitating an open ended course or a course with rolling enrolment, then 

you might find it easier to not apply the Allow submissions from and Due 

date settings. This arrangement will allow the learners to access the 

assignment according to their own schedule and progress within the 

course. 

Alternatively, if you are working within a more structured format or 

adhering to a timeline, the Allow submissions from and Due date settings 

are useful for keeping learners on schedule. 

4.3.1.3.5.Можно ли загрузить сразу все Задания, по которым 
переданы ответы? 

Пользователи с необходимыми Полномочиями (например, с Ролью Преподавателя) 

могут щёлкнуть по Заданию и из Блока настроек на странице Итогового Оценивания 

получить доступ к ссылке «Download all Submissions (загрузить все переданные готовые 

ответы)» в Блоке «Assignment administration (управление заданием)». 

4.3.1.3.6.Как экспортировать уровни Рубрикации и критерии 
наряду с готовыми ответами Студентов? 

Для этого есть средства отслеживания, если хотите участвовать в голосовании! 

MDL-32089. 

4.3.1.3.7.Почему не видно кнопки Upload при переключении 
моей Роли на Роль Студента, чтобы протестировать 
Задание, которое я сделал? 

Это средство предназначено для Преподавателей, так что только они могут видеть, 

как их Курс появляется перед Студентами. Однако этот вид ненадёжен, поскольку 

некоторые средства не могут отображаться корректно, когда просматриваются 

Преподавателем, переключившим свою Роль на Роль Студента. По этой причине всегда 

предпочтительно, где только возможно, иметь зарегистрированного «тестового» Студента 

для использования. 

4.3.1.3.8.Что произойдёт, если я восстановлю резервную 
копию Интерактивных Действий «Задание» (версия 2.2)? 

Если у вас есть Сайт с отключённым/скрытым Заданием (версия 2.2), когда кто-

нибудь восстанавливает резервную копию Интерактивное Действие «Задание (версия 

2.2)», в процессе восстановления обнаружится фраза о том, что оно будет восстановлено, 

но когда восстановление закончится, оно не будет доступно. См. о связанных с этим 

работах в MDL-33952 и предлагаемом решении в Moodle 2.3.1. 

4.3.1.3.9.Что это за момент – «Дата окончания»? 
Ваше использование настроек Allow submissions from and Due date (разрешить 

передачу готовых ответов от… и до даты окончания), возможно, будет зависеть от общей 

структуры вашего Курса. Если вы проводите Курс с открытой датой окончания или Курс с 

продлеваемым сроком зачисления, тогда вам может быть легче не применять настройки 

Allow submissions from and Due date. Это соглашение разрешит обучающимся доступ к 

Заданию в соответствии с их собственным планом прохождения Курса. 

 

Кроме того, если вы работает внутри более структурированного формата или 

придерживаетесь временной Шкалы, настройки Allow submissions from и Due date 

submissions from полезны для поддержания работы обучающихся в соответствии с планом. 

http://tracker.moodle.org/browse/MDL-32089
http://tracker.moodle.org/browse/MDL-33952
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Using the Allow submissions from setting will make it possible for 

learners to preview upcoming activities, while at the same time, prevent 

them from finishing the course in the first week and not returning for 

additional activities or information. Likewise, the Due dates help keep the 

learners from lagging too far behind and decrease the likelihood that the 

learner will become overwhelmed by having to complete several weeks 

worth of work at once. 

4.3.1.3.10.I can't access assignment submission 
comments from the grading screen 
Do you have javascript disabled? You should be able to access comments 

from each individual user's grading page. See MDL-37770 

4.3.1.3.11.See also 
 Using Moodle Assignment module forum 

Using Moodle forum discussions: 

 Set Assignments for Specific Groups 

 How to delete uploaded files? 

 Make default setting "no" re notifying graders 

4.3.1.4.Assignment upgrade tool 
The Assignment upgrade tool is an administrator tool for upgrading old 

assignment types to the new assignment module in Moodle 2.3 onwards. 

Note: It is recommended that admins upgrade all existing assignments to 

use the new assignment module as soon as possible, then disable the old 

assignment module, to avoid the confusion of having two assignment 

modules. 

4.3.1.4.1.Upgrading assignments 
To upgrade existing assignments to use the new assignment module 

 

 Go to Settings > Site Administration > Assignment Upgrade Helper. 

 Click List assignments that have not been upgraded to display a list of 

assignments created in a previous version of Moodle. This page lists the 

assignments created with an older version of Moodle that have not been 

upgraded to the new assignment module in Moodle 2.3. Not all 

assignments can be upgraded - if they were created with a custom 

assignment subtype, then that subtype will need to be upgraded to the 

new assignment plugin format in order to complete the upgrade. 

 Select the assignment(s) you wish to upgrade and click the Upgrade 

selected assignments button in the Batch operations box at the bottom 

of the screen. Or click the Upgrade all assignments button in the 

Использование настройки Allow submissions (позволить передачу готовых ответов) 

сделает возможным для обучающихся предварительно просматривать предстоящие 

Интерактивные Действия, в то же время, предотвращая их от завершения Курса в первую 

неделю и от обращения к дополнительным Интерактивным Действиям или информации. 

Более того, даты окончания помогают обучающимся не слишком отстать, и уменьшить 

вероятность того, что обучающийся будет перегружен необходимостью сделать работу, 

рассчитанную на несколько недель. 

4.3.1.3.10.У меня нет доступа к комментариям готового 
ответа на Задание с экрана оценивания 

У вас Javascript отключен? Вы должны иметь доступ к комментариям с каждой 

страницы оценивания индивидуального пользователя. См. MDL-37770. 

4.3.1.3.11.См. также 
 Использование Moodle, форум «Модуль Задания». 

Обсуждения форума по использованию Moodle: 

 «Установить Задания для специальных Групп». 

 «Как удалить пересланные файлы?». 

 «Сделать настройку по умолчанию равной No для повторно извещаемых Оценок». 

4.3.1.4.Средство обновления Задания 
Средство обновления Задания является средством Администратора для обновления 

Заданий старых типов до возможностей нового модуля «Задание» в Moodle 2.3 и далее. 

Замечание: Рекомендуется, чтобы Администраторы обновляли все существующие 

Задания, чтобы использовать новый модуль «Задание», как можно быстрее, тогда 

отключение старого модуля «Задание» не приведёт к неразберихе существования двух 

модулей «Задание». 

4.3.1.4.1.Обновление Заданий 
Чтобы обновить существующие Задания для использования нового модуля 

«Задание»: 

 Перейдите в AdministrationSite AdministrationAssignment Upgrade Helper. 

 Щёлкните List assignments (перечислить задания), чтобы иметь не обновлённое при 

отображении списка Заданий, созданных в предыдущей версии Moodle. Эта страница 

перечислит Задания, созданные в наиболее старой версии Moodle, которые ещё не 

обновлялись до нового модуля «Задание» в Moodle 2.3. Не все Задания могут быть 

обновлены – если они были созданы на основе клиентского подтипа Задания, тогда этот 

подтипа нужно обновить до нового формата плагина «Задание» для того, чтобы 

завершить обновление. 

 Выберите Задание(я), которые вы желаете обновить, и щёлкните кнопку Upgrade 

selected assignments (обновить выбранные задания) в окошке Batch operations 

(групповые операции) внизу экрана. Или щёлкните кнопку Upgrade all assignments в 

http://tracker.moodle.org/browse/MDL-3777
http://moodle.org/mod/forum/view.php?f=117
http://moodle.org/mod/forum/discuss.php?d=138484
https://moodle.org/mod/forum/discuss.php?d=221550
https://moodle.org/mod/forum/discuss.php?d=221550
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Batch operations box. 

 Confirm by clicking Continue. 

A confirmation screen will appear. From here you can view the courses 

with the converted assignments. 

4.3.1.4.2.Settings Mapping 
The following table maps the settings in the old assignment module to the 

settings in the new assignment module. 
New setting Old setting Comments 

Assignment name No change  

Description No change  

Display description on 

course page 
No change 

This was a new setting in Moodle 2.2. The upgrade tool will 

set this to off if the assignment version being upgraded 

doesn't contain it 

Allow submissions from 

 
Available from Nomenclature change* 

Due date No change  

Always show description 
Hide description before 

available date 
Nomenclature change* 

 

Prevent late submissions 

 

No change  

Require students click 

submit button 

 

Enable "Send for 

marking" button 
Nomenclature change* 

Notify graders about 

submissions 

 

Email alerts to teachers 

 

Nomenclature change* 

 

Notify graders about late 

submissions 

 

New setting Will upgrade to the value from Email alerts to teachers 

Online text 

 

New setting 

 

Replaces old subtype. For an Online Text assignment this 

setting will upgrade to Yes. For all other subtypes it will 

upgrade to No 

 

File submission 

 

 

New setting 

Replaces old subtype. For a Single File Upload or Advanced 

Uploading of Files assignment type this setting will upgrade 

to Yes. For all other subtypes it will upgrade to No 

Max number of uploaded 

files 

 

No change 
For an Online Text or Offline Assignment this setting will be 

disabled 

Max submission size 

 
Max size Nomenclature change* 

Submission comments 

 
Allow notes Nomenclature change* 

Feedback comments New setting 
Will upgrade to Yes for single file and advanced file and No 

for the others 

Feedback files New setting 
Will upgrade to Yes for single file and advanced file and No 

for the others 

* Implies no change in functionality, ie. the equivalent setting will be maintained. 

окошке Batch operations. 

 Подтвердите щелчком по Continue. 

Появится экран подтверждения. С него вы можете просмотреть конвертированные 

Задания. 

4.3.1.4.2.Отображение Настроек 
Следующая таблица отображает настройки старого модуля «Задание» относительно 

настроек нового модуля «Задание». 
Новая настройка Старая настройка Комментарии 

рAssignment name (имя задания) Нет изменения  

Description (описание) Нет изменения  

Display description on course page 

(отобразить описание на 

странице курса) 

Нет изменения Это была новая настройка в Moodle 2.2. 

Инструмент обновления отключит её, если 

версия обновляемого Задания не содержит её 

Allow submissions from 

(разрешить передачу ответов с) 

Available from (доступно 

с) 

Изменение номенклатуры* 

Due date (срок окончания) Нет изменения  

Always show description (всегда 

показывать описание) 

Hide description before 

available date 

Изменение номенклатуры* 

Prevent late submissions 

(предотвратить опоздание 

ответов) 

Нет изменения  

Require students click submit 

button (заставить Студентов 

щёлкать кнопку Submit) 

Enable "Send for marking" 

button 

Изменение номенклатуры* 

Notify graders about submissions 

(извещать Оценивающих о 

передаче готовых ответов) 

Email alerts to teachers Изменение номенклатуры* 

Notify graders about late 

submissions (об опоздании ответа 

извещать Оценивающего) 

Новая настройка Обновит до значения даты отправки 

Преподавателю почтового извещения по э-

почте 

Online text (текст онлайн) 

 

Новая настройка Заменит старый подтип. Для Задания с ответом 

текстом онлайн эта настройка обновится в Yes. 

Для всех других подтипов она обновится в No. 

File submission (ответ в виде 

файла) 

 

 

Новая настройка 

Заменит старый подтип. Для Заданий типа 

Single File Upload или Advanced Uploading of 

Files эта настройка  обновится в Yes. Для всех 

других подтипов она обновится в No. 

Max number of uploaded files 

(макс. число пересылаемых 

файлов) 

Нет изменения Для Заданий с ответом текстом онлайн или 

офлайн эта настройка будет отключена. 

Max submission size (макс. 

размер ответа) 

Max size Изменение номенклатуры* 

Submission comments 

(комментарии к ответу) 

Allow notes Изменение номенклатуры* 

Feedback comments 

(комментарии к обратной связи) 

Новая настройка Обновится в Yes для Single File и Advanced 

File, для других файлов в No. 

Feedback files (файлы обратной 

связи) 

Новая настройка Обновится в Yes для Single File и Advanced 

File, для других файлов в No. 

(Предполагает, что нет изменений в функциональности, т.е. эквивалентная настройка поддерживается). 
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New grading options 
Versions of Moodle older than 2.2 did not contain Advanced Grading 

Methods. Likewise all versions of Moodle older than 2.3 did not contain 

the Marking Guide type of grading method included in Advanced Grading 

Methods. Owners of any upgraded assignments may wish to investigate the 

use of the Advanced Grading Methods feature. 

4.3.1.4.3.Disabling the old assignment module 
Once all existing assignments have been upgraded, the old assignment 

module can be disabled. 

 Go to Settings > Site administration > Plugins > Activity modules > 

Manage activities 

 Hide the Assignments 2.2 module by clicking on the eye in the 

hide/show column 

Teachers will then have only the new assignment module available for 

selection in the activity chooser. 

4.3.1.4.4.Restoring Assignments (2.2) into a later 
site 
Currently, if a course with an old (2.2) type assignment is restored into a 

site which has the old assignment module disabled, it will appear in the 

restore process but not then appear for the users, causing potential 

confusion. See the tracker issue here MDL-33952. 

One temporary workaround if you are going to be restoring courses with 

old-type assignments is to NOT disable the old assignment module but 

instead to revoke the capability mod/assignment:addinstance from all 

users. In this way, the assignment will appear in its original form and may 

be used, but teachers will not be able to create any new Assignment 2.2 

instances. 

 

 

 

 

 

 

 

 

 

 

 

 

Новые опции оценивания 
Версии Moodle старше 2.2 не содержат методов продвинутого оценивания. Более 

того, все Версии Moodle старше 2.3 не содержат метода оценивания «Руководство по 

оцениванию», включённого в методы продвинутого оценивания. Собственники любых 

обновляемых Заданий могут пожелать исследовать использование средства методов 

продвинутого оценивания. 

4.3.1.4.3.Отключение старого модуля «Задание» 
Как только все существующие Задания будут обновлены, старый модуль 

«Задание» может быть удалён. 

 Перейдите в 

AdministrationSite administrationPluginsActivity modulesManage activities. 

 Скройте модуль Заданий версии 2.2 щелчком по глазу в колонке hide/show. 

 

После этого Преподаватели будут иметь только новый модуль «Задание», 

доступный для выбора в Окне выбора Действия. 

4.3.1.4.4.Восстановление Заданий (версии 2.2) на более 
поздний Сайт 

В настоящее время, если Курс с Заданием старого (версии Moodle 2.2) типа 

восстанавливается на Сайт, у которого отключён старый модуль «Задание», он появится в 

процессе восстановления, но не появится затем для пользователей, вызывая 

потенциальную неразбериху. Вывод средства слежения см. в MDL-33952. 

Одна связанная с этим временная работа, если вы собираетесь восстанавливать 

Курсы с Заданиями старых типов, НЕ отключать старый модуль «Задание», а вместо этого 

аннулировать Возможность mod/assignment:addinstance для всех пользователей. При таком 

образе действий Задание появится в оригинальной форме и может быть использовано, но 

Преподаватели не будут способны создавать какие-либо новые экземпляры Заданий 

версии 2.2. 

http://tracker.moodle.org/browse/MDL-33952
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4.3.2.Chat 
Chat module 
The chat activity module allows participants to have a real-time 

synchronous discussion in a Moodle course. 

 

This is a useful way to get a different understanding of each other and the 

topic being discussed – the mode of using a chat room is quite different 

from the asynchronous forums. The Chat module contains a number of 

features for managing and reviewing chat discussions. 

4.3.2.1.Chat settings 
4.3.2.1.1.Adding a Chat to your course 
 With the editing turned on, in the section you wish to add your chat, 

click the "Add an activity or resource" link (or, if not present, the "Add 

an activity" drop down menu) and choose Chat. All settings may 

expanded by clicking the "Expand all" link top right. 

Name of this chat room 
 Whatever you type here will form the link learners click on to enter the 

chat so it is helpful to give it a name that suggests its purpose - for 

example "Student council discussion" or "Field trip planning meeting". 

 

Description 
Type the description of the chat here. Include precise instructions for 

students regarding the subject of the chat. Click "Show editing tools" to 

display the rich text editor, and drag the bottom right of the text box out to 

expand it. 

Display description on course page 
If this box is ticked, the description will appear on the course page just 

below the name of the Chat. 

4.3.2.1.2.Chat sessions 
Next chat time 
 The day and hour of the next chat session. This will appear in the 

calendar so students know the schedule but it doesn't stop them 

accessing the chat room at any other time. 

 If you don't want them in the chat room at other times, then hide it (with 

the eye icon) or use Conditional activities to restrict access. 

 If you don't wish to schedule chat times then ignore this and choose 

from the next settings. 

4.3.2.Чат 
Модуль «Чат» 

Модуль Интерактивного Действия «Чат» позволяет 

Участникам проводить синхронные дискуссии по Курсу 

Moodle в режиме реального времени. 

Это полезный способ понять разницу позиций друг 

друга по обсуждаемому вопросу – режим использования чат-класса сильно отличается от 

асинхронных Форумов. Модуль «Чат» содержит ряд средств для управления и пересмотра 

обсуждений в Чате. 

4.3.2.1.Настройки Чата 
4.3.2.1.1.Добавление Чата в ваш Курс 
 При включённом режиме редактирования в разделе, в который вы желаете добавить 

ваш Чат, щёлкните ссылку «Add an activity or resource» (или, если не присутствует, 

ниспадающее меню «Add an activity») и выберите Chat. Все настройки могут быть 

развёрнуты щелчком по ссылке «Expand all» вверху справа. 

Наименование этого чат-класса 
 Всё, что вы наберёте здесь, сформирует ссылку, щелчком по которой обучающиеся 

войдут в Чат, поэтому полезно дать чат-классу наименование, соответствующее 

назначению, например, «Заседание студенческого совета» или «Совещание по 

планированию командировки». 

Описание 
Наберите описание Чата. Включите чёткие инструкции для Студентов, касающиеся 

предмета этого Чата. Щёлкните «Show editing tools (Показать инструменты 

редактирования)», чтобы отобразить полный текстовый редактор и перетащите правый 

нижний уголок текстового окошка, чтобы расширить его. 

Отображать описание на странице Курса 
Если это окошко помечено, описание появится на странице Курса сразу под 

наименованием Чата. 

4.3.2.1.2.Сессии Чата 
Расписание Чата 
 День и час следующей сессии Чата. Это появится в Календаре, чтобы Студенты знали 

график, но это не препятствует их доступу в чат-класс в любое другое время. 

 

 Если вы не хотите их в чат-классе в другие сроки, тогда скройте его (иконкой глаза) 

или используйте Обусловленные Интерактивные Действия с ограниченным доступом. 

 Если вы не желаете планировать сроки проведения Чата, тогда проигнорируйте эту 

опцию и выберите из следующих настроек. 
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 Note: For courses involving users across different time zones, it is useful 

to know that the time you set here will be adjusted to match the time zone 

of the user viewing it. 

Repeat/publish sessions 
 There are four options for scheduling future chat sessions: 

 Don't publish any chat times- there are no set times and students 

are welcome to chat at any time. 

 No repeats - publish the specified time only- only the Next chat 

time will be published. This could be used to schedule special events 

or meetings or simply to help learners identify a common time in 

which they can expect to find other learners in the chat room. 

 

 At the same time every day- Daily chats are useful for scheduling 

daily office hours or work sessions with learners. 

 At the same time every week--This setting will schedule a chat for 

the same day and time every week, which could be useful for 

instance for meeting and reviewing key ideas and questions related 

to the week’s content/assessment. 

Save past chat sessions 
 Choose from the dropdown how many days to save - or save everything 

by selecting Never delete messages 

 If you have any concerns about discussions that might take place in 

your chat room, you may want to keep transcripts to check the 

suitability of what is discussed. If your learners are using the chatroom 

to collaborate on a group project you won't want to delete the messages 

until the project is complete. 

Everyone can view past sessions 
Decide here whether or not allow everyone to view past chat sessions. 

(Teachers can always view past sessions) 

4.3.2.1.3.Common module settings 
See Common module settings. 

4.3.2.1.4.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.3.2.1.5.Locally assigned roles 
 In Administration > Chat administration > Locally assigned roles 

selected users can be given additional roles in the activity, such as the 

capability to delete chat logs. 

Замечание: Для Курсов, включающих пользователей из разных временных зон, 

полезно знать, что время, которые вы установите здесь, будет подстроено, чтобы 

соответствовать поясному времени пользователя, просматривающего его. 

Повторить/опубликовать сессии 
 Имеются четыре опции для планирования расписания будущих сессий Чата. 

 Не публиковать никакие сроки Чата – сроки не устанавливаются, и Студенты 

приглашаются на Чат в любое время. 

 Не повторять – публиковать только в указанное время – публикуется только 

срок следующей сессии Чата. Это может быть полезно, чтобы спланировать 

специальные события или встречи, или просто помочь обучающимся определить 

общее время, в течение которого они могут надеяться найти других обучающихся в 

чат-классе. 

 В одно и тоже время каждый день – Ежедневные Чаты полезны для планирования 

времени консультаций или рабочих сессий с обучающимися. 

 В одно и тоже время каждую неделю – Эта настройка спланирует расписание Чата 

в один и тот же день и время на каждую неделю, что может  полезно, например, для  

проведения совещаний или обзора ключевых идей и вопросов, относящихся к 

содержанию, и недельных Заданий. 

Сохранить прошедшие сессии Чата 
 Выбрать из ниспадающего меню, за сколько дней сохранять – или сохранить всё, 

выбрав Never delete messages (никогда не удалять сообщения). 

 Если у вас есть какие-либо вопросы по обсуждениям, которые могут быть размещены в 

вашем чат-классе, вы можете захотеть сохранить копии, чтобы проверить 

приемлемость того, что обсуждается. Если ваши обучающиеся используют чат-класс 

для работы над совместным проектом, сообщения не следует удалять, пока проект не 

будет завершён. 

Каждый может просмотреть прошедшие сессии 
Решите здесь, позволить или нет каждому просматривать прошедшие сессии Чата. 

(Преподаватели могут всегда просматривать прошедшие сессии.) 

4.3.2.1.3.Общие настройки модуля 
См. п. 6.1. 

4.3.2.1.4.Ограничить Завершения Доступа/Действия 
Эти настройки видимы, если на Сайте и в Курсе разрешено завершение 

Обусловленных Действий и завершение Действий. 

4.3.2.1.5.Локально назначенные Роли 
 В AdministrationChat administrationLocally assigned roles выбранным пользователям 

могут быть даны дополнительные Роли в Действии, такие как Возможность удалять 

записи Чата. 
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 Role permissions for the activity can be changed in Administration > 

Chat administration > Permissions. 

4.3.2.1.6.Site administration settings 
The chat module has additional settings which may be changed by an 

administrator in Administration > Site administration > Plugins > Activity 

modules > Chat. They depend on the chat method which has been selected: 

Ajax 
 This is the default method. It works everywhere but if many people are 

chatting it can put a large load on the server. Its particular settings are: 

 Refresh user list - choose the number of seconds after which the user 

list is refreshed 

 Disconnect timeout - choose the number of seconds after which we 

detect a user has disconnected. 

Normal method 

 The particular settings for this method are: 

 Refresh room - choose the number of seconds after which the room 

is refreshed 

 Update method - choose how to update the chatroom - "Keep alive" 

or "Stream" strategy. Stream works better but your sever might not 

support it. 

Chat server daemon 
 A daemon is a program that runs all the time in the background. In this 

case it's a PHP script, listening to a particular port on your server, 

accepting and giving out chat information. If you intend to use the chat 

activity a lot, then you should consider using a chat server daemon to 

reduce server load. Its particular settings are: 

 

 Server name 

 Server IP address 

 Server port 

 Max users 

Then you need to start the chat daemon script from the command line: 

cd moodle/mod/chat 

php chatd.php --start & 

4.3.2.1.7.Chat capabilities 
Access a chat room 
Capabilities/mod/chat:chat 

 This allows a user to participate in a chat 

 Полномочия Роли могут быть изменены в AdministrationChat administration 

Permissions. 

4.3.2.1.6.Настройки управления Сайта 
Модуль «Чат» имеет дополнительные настройки, которые могут быть изменены 

Администратором в AdministrationSite administrationPluginsActivity modulesChat. 

Они зависят от выбранного метода диалогового взаимодействия пользователей. 

Ajax 
 Это метод по умолчанию. Он работает везде, но если в Чате много людей, он может 

привести к большой загрузке сервера. Его специфическими настройками являются: 

 Обновить список пользователей – выберите число секунд, после которых список 

пользователей обновляется. 

 Тайм-аут отсоединения – выберите число секунд, после которого мы обнаружим 

пользователя, который отсоединился. 

Стандартный метод 
 Специфическими настройками для этого метода являются: 

 Обновить класс – выберите число секунд, через которые данный класс обновляется. 

 

 Метод обновления – выберите, как обновлять чат-класс – стратегия «Keep alive 

(сохранять)» или «Stream (вытекать)». Stream работает лучше, но ваш сервер может 

не поддерживать его. 

Демон «Чат-сервера» 
 Демон – программа, которая запускает всё по времени в фоновом режиме. В каждом из 

случаев она является PHP-сценарием, наблюдающим за конкретным портом на вашем 

сервере, принимающим и передающим информацию Чата. Если вы намерены 

использовать Интерактивное Действие «Чат» много, тогда вам нужно рассмотреть 

Демона чат-сервера, чтобы уменьшить загрузку сервера. Его специфическими 

настройками являются: 

 Наименование сервера. 

 IP адрес сервера. 

 Порт сервера. 

 Максимум пользователей. 

Затем вам необходимо запустить чат-сценарий Демона из командной строки: 

cd moodle/mod/chat 

php chatd.php --start & 

4.3.2.1.7.Возможности Чата 
Доступ к чат-классу 

Возможность Capabilities/mod/chat:chat 

 Позволяет пользователю участвовать в Чате. 
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 This capability is allowed for the default roles of manager, teacher, non-

editing teacher and student 

Delete chat logs 
Capabilities/mod/chat:deletelog 

 This allows a user to delete chat logs 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Export chat session which you took part in 
Capabilities/mod/chat:exportparticipatedsession 

 This allows the user to export or download the logs for any chat session 

they participated in 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Export any chat session 
Capabilities/mod/chat:exportsession 

 This allows the user to export or download all chat sessions 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Read chat logs 
Capabilities/mod/chat:readlog 

 This allows a user to read chat logs 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher and student 

Add a new chat 

Capabilities/mod/chat:addinstance 

 This allows a user to add a new chat activity to the course 

 This capability is allowed for the default roles of manager and teacher 

4.3.2.2.Using Chat 
4.3.2.2.1.Entering the chat 
 As you click the chat link on the course page you see two or three 

options: 

 Click here to enter the chat now - this takes you to the chat using the 

chosen site default chat method - for example Ajax. 

 Use more accessible interface - this gives a simpler chat room 

without frames and javascript. 

 View past sessions - if this has been enabled and the user is allowed 

to view past chat sessions, this takes them to a list 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера, Преподавателя, 

неРедактирующего Преподавателя и Студента. 

Удалить записи Чата 
Возможность Capabilities/mod/chat:deletelog 

 Позволяет пользователю удалить записи Чата. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Экспорт сессии Чата, в которой вы приняли участие 
Возможность Capabilities/mod/chat:exportparticipatedsession 

 Позволяет пользователю экспортировать или загрузить записи для любой сессии Чата, 

в котором он принял участие. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Экспорт любой сессии Чата 
Возможность Capabilities/mod/chat:exportsession 

 Позволяет пользователю экспортировать или загрузить записи для любой сессии Чата, 

в котором он принял участие. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Читать записи Чата 
Возможность Capabilities/mod/chat:readlogsession 

 Позволяет пользователю читать записи. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера, Преподавателя, 

неРедактирующего Преподавателя и Студента. 

Добавить новый Чат 

Возможность Capabilities/mod/chat:addinstance 

 Позволяет пользователю добавить новое Интерактивное Действие «Чат» в Курс. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

4.3.2.2.Применение Чата 
4.3.2.2.1.Вхождение в Чат 
 Как только вы щёлкните по ссылке Чата на странице Курса, вы увидите две или три 

опции: 

 Щёлкните здесь, чтобы войти в Чат сейчас – это приведёт вас в Чат, используя 

выбранный метод Чата, принятый по умолчанию для Сайта – например, Ajax. 

 Используйте более доступный интерфейс – это предоставляет простую чат-комнату 

без фреймов и Javascript. 

 Просмотреть прошедшие сессии – если это будет включено и позволено 

пользователю просматривать прошедшие сессии Чата, это приведёт его к списку 
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of past sessions with links to the chat. 

4.3.2.2.2.Joining in a chat session 
 In normal view, the screen is in two parts with the participants on the 

right, the messages on the left and a box at the bottom into which users 

type their message and press "Send" to make their contribution: 

 Users can change the appearance of the messages by clicking on 

"Themes" next to the "Send" button. Bubbles appears thus: The chat 

module contains some features to make chatting a little nicer. 

 

Smilies 
Any smiley faces (emoticons) that you can type elsewhere in Moodle can 

also be typed in here and they will be displayed correctly. 

Links 
Internet addresses will be turned into links automatically. 

Emoting 
You can start a line with /me to emote. For example, if your name is Kim 

and you type /me laughs! then everyone will see "Kim laughs!" 

Beeps 
You can send a sound to other people by hitting the "beep" link next to 

their name. A useful shortcut to beep all the people in the chat at once is to 

type "beep all". 

HTML 
If you know some HTML code, you can use it in your text to do things like 

insert images, play sounds or create different coloured and sized text. 

 

4.3.2.2.3.Chat reports 
 To view previous chats (if you have permission) click on the 'View past 

chat sessions' link. Teachers can also access past chat sessions from the 

Chat administration in the Settings block. 

 

 

 This will bring up a listing of each chat session under the current chat 

topic. The listings include the time the chat started and ended, which 

users participated, and how many messages each user sent. In order for 

students to see past sessions, the teacher or an administrator must setup 

the chat to allow everyone to view past chat sessions. Please refer to the 

Chat settings page. 

 

прошедших сессий со ссылками на Чат. 

4.3.2.2.2.Присоединение к сессии Чата 
 В стандартном виде этот экран появляется в двух частях с участниками справа, 

сообщениями слева и окном внизу, в котором пользователи набрали своё сообщение и 

нажали «Send (отправить)», чтобы представить своё предложение. 

 Пользователи могут изменить внешний вид сообщений щелчком по «Themes (фоновые 

тематические картинуи)» рядом с кнопкой «Send (отправить)». Появятся «Bubbles»,  

таким образом: модуль «Чат» содержит некоторые средства, чтобы сделать чатинг 

немножко симпатичнее. 

Смайлики 
Любые физиономии смайликов (эмотиконы), которые вы можете применять где-

либо в Moodle, можно применить и здесь, и они будут отображены корректно. 

Ссылки 
Адреса интернета будут превращены в ссылки автоматически. 

Проявление эмоций 
Вы можете начать строку с /me, чтобы проявить эмоции. Например, если ваше имя 

Kim и вы наберёте /me laughs!, тогда каждый увидит «Kim laughs!». 

Звуковые сигналы 
Вы можете отправить звуковой сигнал другому человеку посредством щелчка по 

ссылке «Beep»,следующей за его именем. Полезным быстрым вызовом всех участников 

Чата сразу является набор «Beep all (звуковой сигнал всем)». 

HTML 
Если вам известен какой-то код HTML, вы можете использовать его в вашем 

тексте, чтобы осуществить нечто подобное вставке изображений, проигрывания звуков 

или создания разноцветных текстов разного размера. 

4.3.2.2.3.Отчёты по Чату 
 Чтобы просмотреть предыдущие Чаты (если у вас есть 

Полномочия), щёлкните по ссылке «View past chat sessions 

(просмотреть предыдущие сессии чатов)». Преподаватели могут 

иметь доступ к прошлым сессиям Чатов также из «Chat 

administration (управление чатом)» в Блоке «Administration».  

 Это принесёт листинг каждой сессии Чата под темой текущего Чата. 

Листинги включают время начала и конца Чата, в котором 

участвовали пользователи, и как много сообщений каждый 

пользователь посылает. Для того, чтобы Студенты увидели прошлые 

сессии, Преподаватель или Администратор должны установить, что Чат позволяет 

каждому просмотреть прошлые сессии Чата. Пожалуйста, обратитесь к странице 

настроек Чата. 

http://docs.moodle.org/25/en/File:Bubbleschat.png
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4.3.2.2.4.Exporting chat sessions 
Users with the capabilities to export chat session which they took part in or 

export any chat session can download or export past chat sessions to any 

portfolio enabled by the administrator. If Portfolios have not been enabled, 

then users will not see a link to "Export" chat sessions. 

 

4.3.2.2.5.Why use chat? 
 Chat has an advantage over a Forum in that it takes place in Real Time. 

It is especially beneficial when the group chatting is not able to meet 

face to face. Examples might be: 

 Regular meetings of staff on large or split campuses to discuss 

student or curriculum issues; 

 Regular meetings of students doing online courses to enable them to 

share experiences with others on the same course but potentially in a 

different city (or country) 

 A teacher working with his students even though he is out of school 

 A student temporarily unable to attend in person chatting with their 

tutor to catch up with work. 

 Students out on work experience getting together to discuss their 

experiences with each other and their tutor 

 Younger children using chat at home in the evenings as a 

controlled(monitored) introduction to the world of social networking 

4.3.2.2.6.Why NOT use chat? 
 Unless a tutor/moderator is permanently present in the chatroom - or 

unless the chat is hidden and revealed at certain times, it is difficult to 

control what is said once a chat has started. 

 Younger students particularly may find it difficult to stay on task and be 

prone to adding non-useful comments or "beeping" others for the sake 

of it. 

 In some situations, a forum might be preferred as it allows for reflection 

before posting and gives a period of time where the post might be 

edited. 

4.3.2.2.7.See also 
Working example of Chat from the School demo site. Log in with 

username "student" and password "moodle" to try out the chat. You might 

be chatting to yourself though:) 

 Using Moodle Chat module forum. 

 Using Moodle Positive use of Chat forum discussion 

4.3.2.2.4.Экспортирование сессий Чата 
Пользователи с Возможностями экспортировать сессию 

Чата, в которой они принимают участие, или экспортировать 

любую сессию Чата, которую можно переслать, или экспортировать прошлые сессии Чата 

в любые Портфели, разрешённые Администратором. Если Портфели не разрешены, тогда 

пользователи не увидят ссылку на «Export» сессий Чата. 

4.3.2.2.5.Зачем использоватьЧат? 
 Чат имеет то преимущество над Форумом, что он происходит в реальном времени. Это 

особенно полезно, когда общение Группы в реальном времени невозможно вести лицом 

к лицу. Примерами могут служить: 

 Регулярные встречи руководства больших или малых кампусов (университетских 

городков) по обсуждению любых вопросов учебного Курса. 

 Регулярные встречи Студентов, работающих над онлайн Курсами, позволяют им 

совместно делиться опытом друг с другом на тех же самых Курсах, даже находясь в 

другом городе (или стране). 

 Преподаватель может работать со Студентами, даже если он не находится в школе. 

 Студент, временно неспособный посещать школу лично, может общаться в Чате со 

своим наставником, чтобы наверстать учебный процесс. 

 Студенты, проходящие практику, могут обсуждать получаемый опыт между собой и 

с наставником. 

 Юные дети, использующие Чат дома по вечерам как управляемое (наблюдаемое) 

введение в мир социального сетевого общения. 

4.3.2.2.6.Почему НЕ следует использовать Чат? 
 Если наставник/модератор постоянно не присутствует в чат-классе, или если Чат не 

скрыт и открывается в определённые сроки, трудно управлять тем, что когда-то сказано 

в Чате, который стартовал. 

 Особенно Студенты младших Курсов могут посчитать трудным оставаться в работе над 

уроком и склонны к добавлению бесполезных комментариев или других «Звуковых 

сигналов» ради этого. 

 В некоторых ситуациях Форум может быть предпочтительней, т.к. он позволяет 

поразмыслить перед отправкой почтовых сообщений, и предоставляет промежуток 

времени, в течение которого почтовое сообщение может быть отредактировано. 

4.3.2.2.7.См. также 
Работающий пример Чата с демонстрационного Сайта Школы. Зарегистрируйтесь 

под именем «Student» и паролем «Moodle», чтобы опробовать Чат. 

 

 Использование Moodle: Форум по модулю Чат. 

 Обсуждение форума по использовани. Moodle «Позитивное использование Чат». 

http://school.demo.moodle.net/mod/chat/view.php?id=881
http://moodle.org/mod/forum/view.php?id=734
http://moodle.org/mod/forum/discuss.php?d=4792
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4.3.2.3.Chat FAQ 
4.3.2.3.1.How can I enable guests to participate in 
a chat activity? 
Create a visitor role with the capability mod/chat:chat allowed, then create 

an account and assign it the role of visitor. Guests can then share this 

visitor account. 

(The guest role has some special functionality, for example when a guest 

attempts to participate in a chat, they obtain the message "The chat is not 

open to guests. Would you like to log in now with a full user account?". 

Despite the permissions interface suggesting otherwise, it's not possible to 

modify the guest role to allow guests to participate in chat activities.) 

 

4.3.2.3.2.How can I use audio chat? 
Moodle itself does not yet include an audio chat solution, due to the large 

server requirements to implement a standalone solution. 

However, there is a choice of free third party modules that you can install 

into your Moodle to achieve this: 

 Big Blue Button - FREE audio and video conferencing 

http://moodle.org/plugins/view.php? plugin=mod_bigbluebuttonbn 

 OpenMeetings - FREE full audio/video conferencing 

http://code.google.com/p/openmeetings/. 

4.3.2.3.3.How can I restrict Chat so certain users 
cannot access it? 

You need to create a new role -such as "NoChat" and apply it in the system 

context to the student(s) you want to prevent from chatting. 

 Go to Settings>Site administration>Users>Permissions> Define Roles 

 Click Add a new role - name it for example "NoChat" 

 In the context types, select "system" 

 Type "chat" in the filter box. 

 Set the button for Access a Chat room (mod/chat:chat) to Prohibit and 

save. 

 Go to Settings>Site administration>Users>Permissions>Assign system 

roles 

 Click on the new "NoChat" role and assign your chosen student(s) this 

role 

 When they try to go into a chat room they will get a message that they 

cannot access the Chat. 

 

4.3.2.3.Часто задаваемые вопросы по Чат 
4.3.2.3.1.Как я могу позволить Гостям участвовать в 
деятельности Чата? 

Создайте Роль посетителя (п. 3.4.1) с разрешённой Возможностью mod/chat:chat, 

затем создать учётную запись и назначьте ей Роль посетителя. Гости могут потом 

совместно использовать эту учётную запись. 

(Роль Гостя (п. 3.4.5.7) имеет некоторую специфическую функциональность, 

например, когда Гость пытается участвовать в Чате, он получит сообщение «Чат не открыт 

Гостям. Намерены ли вы зарегистрироваться сейчас с полной учётной записью 

пользователя?» Вопреки интерфейсу Полномочий, предполагающему противоположное, 

невозможно модифицировать Роль Гостя так, чтобы позволить Гостям участвовать в 

Интерактивных Действиях «Чат».) 

4.3.2.3.2.Как можно использовать аудио Чат? 
Сама по себе Moodle не включает метода решения аудио Чата из-за больших 

требований к серверу по реализации автономного решения. 

Однако имеется выбор модулей, свободно распространяемых независимыми 

разработчиками, которые вы можете установить в вашу Moodle, чтобы достичь этого. 

 Большая голубая кнопка – СВОБОДНАЯ аудио и видео конференц-связь 

http://moodle.org/plugins/view.php?, плагин = mod_bigbluebuttonbn. 

 OpenMeetings – проведение полной СВОБОДНОЙ аудио и видео конференции 

http://code.google.com/p/openmeetings/. 

4.3.2.3.3.Как ограничить Чат таким образом, чтобы 
определённые пользователи не могли на него попасть? 

Вам необходимо создать новую Роль – такую как «БезЧата» и применить её в 

Контексте системы к Студенту(ам), которым вы хотите помешать общаться в Чате. 

 Перейдите к AdministrationSite administrationUsersPermissionsDefine Roles. 

 Щёлкните Add a new role (добавить новую роль) – поименуйте её, например, «БезЧата». 

 В Context types (типы контекстов) выберите «System». 

 Наберите «Чат» в окошке Filter. 

 Установите кнопку для доступа к чат-комнате (mod/chat:chat) в Prohibit (запретить) и 

сохраните. 

 Перейдите к 

AdministrationSite administrationUsersPermissionsAssign system Roles. 

 Щёлкните по новой роли «БезЧата», и назначьте её выбранному(ым) Студенту(ам). 

 

 Когда они попытаются войти в чат-комнату, то получат сообщение, что у них нет 

доступа к этому Чату. 

http://docs.moodle.org/25/en/Capabilities/mod/chat:chat
http://moodle.org/plugins/view.php
http://code.google.com/p/openmeetings/
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4.3.2.3.4.See also 

 Using Moodle Chat module forum 

4.3.3.Choice 
A teacher asks a question and specifies a choice of multiple responses 

Choice module 
A choice activity is very simple – the teacher asks a question and specifies 

a choice of multiple responses. It can be useful as a quick poll to stimulate 

thinking about a topic; to allow the class to vote on a direction for the 

course; or to gather research consent. 

 

Choice requires some preparation time for creating your activity and 

thinking about what results you would like to achieve, but your 

participation with activity itself is likely to be minimal. 

 

4.3.3.1.Choice settings 
4.3.3.1.1.Choice administration settings 
 With the editing turned on, choose from the"Add an activity or 

resource" link (or, if not present, the "Add an activity" drop down 

menu) the option Choice. To see all the settings expanded, click 

"Expand all" top right. 

4.3.3.1.2.General 
Choice name 
A short name of the choice (e.g. "Favourite colour"). This will be displayed 

on the course's homepage. 

Description 
Type the description of the choice activity here. Click "Show editing tools" 

to display the rich text editor and drag the bottom right of the text box out 

to expand it. It should contain the question that you want your students to 

answer. An example of the choice text could be "What is your favourite 

colour?" There is also an option to display the choice description on the 

course page below the link to the activity. 

Display mode for the options 
 Choose "horizontally" if you only have three or four choices maximum; 

choose "vertically if you have a large number of choices. 

 

 

 

4.3.2.3.4.См. также 
 Использование Moodle: форум по модулю «Чат». 

4.3.3.Выбор 
Преподаватель задаёт вопрос и определяет альтернативу из множества ответов. 

Модуль «Выбор» 
Интерактивное Действие «Выбор» очень простое – Преподаватель задаёт вопрос и 

указывает альтернативу из множества ответов. Это может быть полезно при быстром 

опросе для стимулирования обдумывания изучаемой темы; что позволяет классу 

голосованием решать вопросы по ходу учебного Курса; достигать согласованности в 

изучении. 

«Выбор» требует некоторого времени на подготовку к созданию вашего 

Интерактивного Действия и обдумывание того, каких результатов вы хотели бы достичь, 

но время вашего участия в самом Интерактивном Действии, вероятно, будет 

минимальным. 

4.3.3.1.Настройки Выбора 
4.3.3.1.1.Настройки управления Выбором 
 При включённом режиме редактирования выберите по ссылке «Add an activity or 

resource» (или, если лна не присутствует, из ниспадающего меню «Add an activity») 

опцию «Choice». Чтобы увидеть все настройки развёрнутыми, щёлкните вверху справа 

по «Expand all». 

4.3.3.1.2.Обычные настройки 
Выберите название 

Краткое название Выбора (например, «Любимый цвет»). Оно будет отображаться 

на Домашней Странице Курса. 

Описание 
Наберите здесь описание Интерактивного Действия «Выбор». Щёлкните «Show 

editing tools», чтобы отобразить полный текстовый редактор и перетащите правый нижний 

уголок текстового окошка, чтобы его расширить. Оно должно содержать вопрос, на 

который должны ответить Студенты. Примером такого текста Выбора может быть «Каков 

ваш любимый цвет?» Существует также опция по отображению этого описания Выбора на 

странице Курса ниже ссылки на это Интерактивное Действие. 

Режим отображения для опций 
 Выберите «Horizontally», если имеете максимум три или четыре варианта ответа; 

выберите «Vertically» если предлагается большое количество ответов для выбора. 

http://moodle.org/mod/forum/view.php?f=118
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4.3.3.1.3.Options 
Allow choice to be updated 
 If this is set to "Yes", students can change their mind after they have 

voted. If it's set to "No", students cannot change their choice. 

  

Limit the number of responses 
 Enabling this option allows you to limit the number of participants who 

can select each particular choice. When that number has been reached, 

no one else can select that choice. 

Warning!! If you unintentionally check this box but don't add a number 

then your students won't be able to select any choices and will get 

confused. 

Option 
 Specify here the options that participants have to choose from. They 

will become radio buttons when the choice is saved. 

 You can leave other options blank or click "Add 3 fields to form" to add 

more options. 

 If Limits is disabled, then any number of participants can select any of 

the options. 

4.3.3.1.4.Availability 
Restrict answering 
 If you check this box you can set an "open and close" date for your 

choice. 

 If you leave it, they can respond at any time. 

4.3.3.1.5.Results 
Publish results 
 This determines whether (and when) the students will be able to view 

the results of the choice activity. They may: 

 never see the results of the choice 

 see the results only after they have given the answer themselves 

 see the results only after the closing date of the choice 

 always see the results 

Privacy of results 
 If "Publish" was chosen above, then this dropdown in unlocked. You 

can decide whether to show names of students or merely the number 

who responded but without names. 

 

4.3.3.1.3.Опции 
Разрешить обновлять Выбор 
 Если вы установите «Yes», Студенты смогут менять своё мнение после того, как они 

выбрали. Если эта опция установлена в «No», Студенты не смогут изменять свой 

выбор. 

Ограничить число ответов 
 Включение этой опции позволяет ограничить число Участников, каждый из которых 

может сделать конкретный выбор. Когда это число достигается, никто больше не 

сможет делать выбор. 

Предупреждение!! Если вы неумышленно пометите это окошко, но не укажете 

число, тогда ваши Студенты не смогут выбирать и будут смущены. 

 

Альтернатива 
 Укажите здесь альтернативы, из которых Участники должны выбрать. Они превратятся 

в переключатели, когда это Интерактивное Действие «Выбор» будет сохранёно. 

 Вы можете оставить другие альтернативы пустыми или щёлкнуть «Add 3 fields to form 

(добавить три поля в форму)», чтобы добавить больше альтернатив. 

 Если Ограничения отключены, тогда любое количество Участников может выбирать 

любые альтернативы. 

4.3.3.1.4.Доступность 
Ограничить подачу ответов 
 Если вы пометите это окошко, вы сможете установить дату «Open and close (открыть и 

закрыть)» для вашего Выбора. 

 Если вы оставите его, Участники смогут отвечать в любое время. 

4.3.3.1.5.Результаты 
Опубликовать результаты 
 Это определяет, будут ли (и когда) Студенты способны просмотреть результаты 

Интерактивного Действия «Выбор». Варианты: 

 никогда не увидят результаты Выбора, 

 увидят результаты только после того, как они сами дадут ответы, 

 увидят результаты только после даты закрытия этого Выбора, 

 всегда будут видеть результаты. 

Конфиденциальность результатов 
 Если выше была выбрана Publish, тогда будет разблокировано ниспадающее меню. Вы 

можете решить, показывать ли имена Студентов, или ограничиться только числом 

ответивших без указания имён. 
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Show column for unanswered 
 If set to "Yes", this will display a column showing how many 

participants have not answered the choice activity yet. If set to "No", 

the results will only include the participants who have already voted. 

 

4.3.3.1.6.Common module settings 
These settings are collapsed by default. See Common module settings for 

more information. 

4.3.3.1.7.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.3.3.1.8.Choice module capabilities 
Download choice responses 
Capabilities/mod/choice:downloadresponses 

 This enables a user to download choice responses 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Delete choice responses 
Capabilities/mod/choice:deleteresponses 

 This enables a user to delete choice responses 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Read choice responses 
Capabilities/mod/choice:readresponses 

 This allows a user to view choice responses. 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Record a choice 
Capabilities/mod/choice:choose 

 This allows a user to record a choice option 

 This capability is allowed for the default roles of teacher, non-editing 

teacher and student. 

Add a new choice 
Capabilities/mod/choice:addinstance 

 This allows a user to add a new choice activity to the course 

 This capability is allowed for the default roles of manager and teacher 

 

Показывать колонку для неответивших 
 Если установить в «Yes», будет отображаться колонка, показывающая, сколько 

Участников ещё не ответили на Интерактивное Действие «Выбор». Если установить в 

«No», результаты Выбора будут включать только Участников, которые уже выбрали 

альтернативу. 

4.3.3.1.6.Общие настройки модуля 
Эти настройки по умолчанию свёрнуты. Дополнительная информация приведена в 

п. 6.1. 

4.3.3.1.7.Ограничить Доступ/Завершение Действия 
Эти настройки видимы, если Обусловленные Действия (п. 4.9.2) и завершение 

Действия (п. 4.9.3) включены на уровне Сайта и Курса. 

4.3.3.1.8.Возможности модуля «Выбор» 
Загружать ответы Выбора 

Возможности Capabilities/mod/choice:downloadresponses 

 Позволяет пользователю загружать ответы Выбора. 

 Эта Возможность по умолчанию предоставлена для Ролей Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Удалять ответы Выбора 
Возможности Capabilities/mod/choice:deleteresponses 

 Позволяет пользователю удалять ответы Выбора. 

 Эта Возможность по умолчанию предоставлена для Ролей Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Читать ответы Выбора 
Возможность Capabilities/mod/choice:readresponses 

 Позволяет пользователю читать ответы Выбора. 

 Эта Возможность по умолчанию предоставлена для Ролей Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Записывать альтернативу 
Возможность Capabilities/mod/choice:choose 

 Позволяет пользователю записывать опцию «Альтернатива». 

 Эта Возможность по умолчанию предоставлена для Ролей Преподавателя, 

неРедактирующего Преподавателя и Студента. 

Добавлять новый Выбор 
Возможность Capabilities/mod/choice:addinstance 

 Позволяет пользователю добавлять новое Интерактивное Действие «Выбор» в Курс. 

 Эта Возможность предоставлена по умолчанию для Ролей Менеджера и Преподавателя. 
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4.3.3.2.Using Choice 
4.3.3.2.1 What the student sees 
 When a teacher has created a Choice activity, the student is presented 

with a number of radio buttons. They click one to make their selection. 

 

 Depending on the teacher's settings, the student may then be able to see 

the results either anonymously or with names (via the "View xxx 

responses" link) or not see anything. 

4.3.3.2.2 What the teacher sees 
 Regardless of how it's been set for students, a teacher will always see 

user names and choices, via the "View xxx responses" link. 

 The teacher is also able to delete selected choices or download them in 

various formats as in the screenshot below: 

4.3.3.2.3 Some ways to use Choice 
Thinking about existing knowledge 
Pedagogically, the choice activity can be used to provide an opportunity to 

share starting points through which learners are encouraged to think about 

and articulate existing knowledge and understandings of a topic. For 

example, you can ask students to make ‘choices’ about a statement such as 

“in learning to become a teacher, the most significant issue for me is” 

(giving the following choices): trust, theoretical underpinnings, 

communication or delivering materials to students. 

 

This has two benefits: firstly, it forces participants to engage with their 

choice and think, in advance of a further related activity (you might wish to 

follow up such a choice activity with a forum discussion or a reflective 

activity like the online text assignment), about the context and 

consequences of this choice. Secondly, it allows tutors and students to gain 

a better understanding of existing views/understandings/knowledge related 

to the question, idea or concept at hand in the Choice activity. 

 

Assessing understanding 
For younger students, the choice activity is a secure way to gauge their 

understanding of a topic without asking them in public: with a question 

such as "how well did you understand this module?" students can honestly 

select from "very well", "OK" or "I stil don't get it", safe in the knowledge 

only their teacher knows their response and they will not be shamed in 

front of their peers. 

4.3.3.2.Применение Выбора 
4.3.3.2.1.Что видит Студент 
 Когда Преподаватель создал Интерактивное Действие «Выбор», Студенту 

предоставляется несколько переключателей. Щелчок по одному из них и есть его выбор 

из предложенных альтернатив. 

 В зависимости от настроек Преподавателя Студенты могут увидеть результаты либо 

анонимные, либо с именами (посредством ссылки «View xxx responses (просмотреть 

ххх ответов)») или не увидеть ничего. 

4.3.3.2.2.Что видит Преподаватель 
 Безотносительно к тому, как это установлено для Студентов, Преподаватель всегда 

увидит имена пользователей и альтернативы через ссылку View xxx responses. 

 Преподаватель также способен удалить выбранные альтернативы или загрузить их в 

различных форматах, как показано на снимке с экрана. 

4.3.3.2.3.Некоторые способы применения Выбора 
Размышление о существующем знании 

С точки зрения педагогики Интерактивное Действие «Выбор» может быть 

использовано, чтобы предоставить возможность обмена отправными позициями, с 

которых обучающимся рекомендуется обдумывать и оглашать существующее знание и 

понимание Темы. Например, вы можете попросить Студентов выбрать утверждение о том, 

что «при обучении тому, как стать Преподавателем, для меня самое важное это…», 

(предлагая следующие альтернативы: научиться завоёвывать доверие, получить 

теоретический фундамент, научиться успешно общаться и преподносить материал 

Студентам). 

Это имеет двоякую пользу: во-первых, это принуждает Участников заняться их 

выбором и размышлением о Контексте и последствиях своего Выбора перед тем, как 

приступить к следующим, связанным с Выбором, Интерактивным Действиям (вы можете 

пожелать далее заняться обсуждением на Форуме или рефлективным 

Интерактивным Действием, вроде Задания с ответом в виде текста онлайн). Во-вторых, 

это позволяет наставникам и Студентам достичь лучшего понимания существующих 

взглядов/пониманий/знаний, относящихся к данному вопросу, идеи или концепции в этом 

Интерактивном Действии «Выбор». 

Оценивание понимания 
Для Студентов младших курсов Интерактивное Действие «Выбор» – надёжный 

способ оценить их понимание Темы без огласки: на такой вопрос, как «Насколько хорошо 

вы понимаете этот модуль?», Студенты могут честно выбрать из «Очень хорошо», 

«Хорошо» или «Я всё ещё не понимаю», будучи уверенными, что только Преподаватель 

знает их ответ, и они не будут пристыжены перед своими сверстниками. 

http://docs.moodle.org/25/en/File:Choiceresponses.png
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The choice activity in Moodle only allows a participant to select one 

choice from a variety of options (that you provide), but you may set the 

activity so that participants can change their choices - thus, as students 

make progress and gain confidence, they might want to update their choice 

to reflect this. You can also set the activity so that it ‘closes’ or ‘locks 

down’ on a specific date, making all choices final from that point on. This 

allows participants to change their minds several times before a final date. 

 

 

Selecting groups 
Using the choice activity is one way of getting students to put themselves 

into groups. However in its standard form, it does not add them to the 

gradebook as a group. There is a contributed module that does this here: 

Choicegroup 

4.3.3.2.4 Examples of using choice 
The following examples are mostly taken from a Using Moodle forum 

discussion Creative Uses?. 

Gather pre-event comments 
 A simple question to answer, to kick start - the beginning of a lesson. 

 Gather initial comments, reasons for taking course, participating in 

event 

Bus & roommate, menu choices 
Every spring, our school sends 180 students and our fine arts faculty to a 3 

or 4 day event. Students invited to participate are enrolled in a Moodle 

course for the event. 

We use the new forum to communicate with students. The forum is open to 

anyone, so parents can read it, too. 

We use the choice module to gather the initial commitment from students 

to attend, and then later their bus choices and hotel roommates. In years 

that the bus rides are long enough, students pre-select boxed meals. 

 

I modified the Choice module to allow me to easily make selections for 

students who do not respond in a timely manner. We also use the feedback 

module to gather student cell phone numbers, a list of events that each 

student will attend, and t-shirt requests. 

I wrote a PHP program to gather all of this info and create an Excel file 

with all of the info in various arrangements. 

 

 

Интерактивное Действие «Выбор» в Moodle позволяет Участнику выбрать только 

одну альтернативу из множества возможных (которые вы представили), но вы можете 

установить Интерактивное Действие так, что Участники смогут изменять их выборы – 

таким образом, что Студенты, прогрессируя и обретая уверенность, смогут захотеть 

обновить свой прежний выбор, чтобы отразить повышение своей компетентности. Вы 

можете также установить этот Выбор так, чтобы он «закрывался» или «блокировался» при 

наступлении конкретной даты, делая все альтернативы окончательными с этого момента. 

Это позволяет Участникам изменять их мнения несколько раз до даты завершения 

Выбора. 

Распределение по Группам 
Использование Интерактивного Действия «Выбор» – один из способов 

предоставить формирование Групп самим Студентам. Однако в существующей 

стандартной форме это не помещает их в Журнал Оценок как Группу. Существует 

предлагаемый модуль, который осуществляет это: Choicegroup. 

4.3.3.2.4.Примеры использования Выбора 
Следующие примеры взяты, главным образом, из обсуждений на форуме по 

использованию Moodle «Творческие применения?». 

Накопление комментариев к предстоящему событию 
 Задать простой вопрос только для того, чтобы начать Урок. 

 Собрать начальные комментарии, причины для изучения Курса, участия в событии. 

 

Выбор меню и соседей по комнате и автобусу 
Каждую весну наше высшее учебное заведение отправляет 180 Студентов и 

Преподавателей искусств на 3-ёх или 4-ёх дневное мероприятие. Студенты, приглашённые 

участвовать в мероприятии, зачисляются на Курс Moodle для этого мероприятия. 

Мы используем новый Форум для общения со Студентами. Этот Форум открыт 

для каждого, так что родители также могут читать его. 

Мы используем модуль «Выбор», чтобы выяснить причины желания учащихся 

участвовать, а затем каков их выбор автобуса и соседей по комнате в Гостинице. В те 

годы, когда эти поездки на автобусе достаточно продолжительны, Студенты 

предварительно заказывают упакованную в коробки еду. 

Я модифицировал модуль «Выбор» так, чтобы я мог легко сделать выбор вместо 

Студентов, которые не ответили в срок. Мы также используем модуль «Обратная связь», 

чтобы собрать номера сотовых телефонов Студентов, составить перечень событий, в 

которых будет участвовать каждый Студент, и их требований на приобретение футболок. 

Я написал PHP-программу, чтобы собирать всю эту информацию и создать Excel-

файл с систематизацией этой информации в различных ракурсах. 

http://moodle.org/mod/data/view.php?d=13&rid=4704
http://moodle.org/mod/forum/discuss.php?d=145882
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Memo tracking 
I have made some minor changes to the Choice code (only requiring one 

"choice") so that we in the Business world can use the Choice module for 

Memo tracking. 

Each Memo is a new Choice, the memo is entered, and the choice is "I 

have read and understand this memo". Then our Managers can track who 

has or has not read the memo, and follow up with those who have not read 

them. 

Feedback from students about course or activity 
A question left unanswered from a lesson - that needs an answer. Now 

home study. As feedback about a lesson, as assessment for learning. 

Polling tool 
As they are so fast to set up - they can even be used as a polling tool, 

although there are other tools out there. A colleague used them for student 

voice polling. 

Registrar and Administration uses 
Currently Moodle Choices is offering a far greater contribution to our 

admin functions than our teaching.(remember not to use groups in this 

function) 

Elective courses: students are given a list of choices that they can choose 

from. 

Sign up for an activity 
Sign up for a specific activity eg Rosetta Stone, cycle rental - Students self-

enrol to a moodle coursepage then click to say 'please sign me up' - we use 

choices in order to set course limits 

 

 

Student confirm pathways 
Choice of degree specialism - students are away on stage, and change their 

mind frequently, so we set a choices activity with the pathways and instead 

of emailing us every time they change their minds, they indicate the 

change on choices, which are left open. 

 

Use with podcasts and videos 
Include podcasts or videos as well as images in the choice activity 

 

Elections 
It is possible to run student union elections using choice module. 

 

Отслеживание меморандума 
Я сделал некоторые небольшие изменения в коде Выбора (требующие только 

одного «выбора»), так что мы в мире бизнеса можем использовать модуль «Выбор» для 

отслеживания работы с меморандумом (обобщающим обзором некоторого события). 

Каждый меморандум – это новый Выбор, меморандум вводится, и Выбор – это «Я 

прочитал и понял этот меморандум». Далее наши Менеджеры могут проследить, кто 

прочитал или не прочитал этот документ, и далее работать с теми, кто не прочитал его. 

 

Обратная Связь от Студентов о Курсе или Действии 
Вопросы по Уроку, оставленные без ответов, – нуждаются в ответе. Требуется 

домашняя работа. Обратная Связь по Уроку – это оценивание освоения учебного Курса. 

Инструмент опроса 
Поскольку Выбор быстро устанавливается – он может быть использован даже как 

инструмент опроса, хотя существуют и другие инструменты для этого. Коллега 

использовал это для голосования Студентов. 

Применение секретарём и администрацией учебного заведения 
В настоящее время Выборы системы Moodle предлагаются для обеспечения 

Административных функций много чаще, чем для потребностей преподавания (запомните, 

что для этих функций не следует применять распределение по Группам). 

Курсы по выбору: Студентам предлагается список альтернативных Курсов, из 

которого они могут выбирать. 

Записаться на Интерактивное Действие 
Запись на специфическое Интерактивное Действие, например, «Розеттский 

камень» (курс иностранного языка) с периодической оплатой, – Студенты само-

зачисляются на странице Курса Moodle, затем щёлкают по кнопке, чтобы сказать 

«Пожалуйста, запишите меня» – мы используем Выбор для того, чтобы установить 

ограничения Курса. 

Студент подтверждает направления 
Выбор степени специализации: – Студенты-заочники часто изменяют своё мнение, 

поэтому мы устанавливаем Интерактивное Действие альтернатив по направлениям 

обучения, и вместо отправки нам по э-почте своего мнения каждый раз, когда они его 

меняют, они указывают альтернативу в Интерактивном Действии «Выбор», который 

остаётся открытым. 

Использовать с телепрограммами и видео из интернета 
Включает в Интерактивное Действие «Выбор» телепрограммы и видео из 

интернета так же, как и изображения. 

Голосование 
Используя модуль «Выбор», можно выполнить выборы профсоюза Студентов. 
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4.3.3.2.5 See also 
Working example of a choice activity from School demo site. Log in with 

username "student" and password "moodle" and enrol yourself into the 

course to make your choice and see others' responses. 

 Choice module video (older version of Moodle) 

Using Moodle forum discussions: 

 Have Your Students "Sign" an Agreement 

 Creative Uses? 

4.3.3.3.Choice FAQ 
4.3.3.3.1.How can I enable users to participate in 
a front page choice activity? 
To enable logged-in users to participate in a front page choice activity: 

 Click the edit icon of the Choice. 

 In the Settings block for the Choice, click Permissions. 

 From the dropdown Advanced role override, choose "authenticated 

user" 

 

 Set the capability mod/choice:choose to allow. 

 Click the 'Save changes' button. 

 

4.3.3.3.2.Can I allow users to make more than one 
choice? 
It is not currently possible to do this; however, they can be allowed to 

change their mind if you set the choice to be updated. 

4.3.3.3.3.Can I use images or other file types as 
choice options instead of text? 
To do this, first upload your images or sound files (mp3) or video files to 

the internet. 

 Copy the URL (web address) of the files you want to display. 

 Paste it into a text editor like notepad (This is not essential but makes it 

easier to add the code) 

 To display an image, add this code either side of your image URL: 

<img src="YOUR_IMAGE_.jpg"> 

 To display a sound or video file -first ensure your site admin has 

multimedia plugins/filters enabled 

 Add this code either side of your sound or video file: 

<a href="YOUR_SOUND_FILE.mp3"></a> 

4.3.3.2.5.См. также 
Работающий пример Интерактивного Действия «Выбор» с демонстрационного 

сайта Школы. Зарегистрируйтесь под именем пользователя «student» с паролем «moodle» 

и самозачислитесь на этот Курс, чтобы выбрать свою альтернативу и увидеть ответы 

других. 

 Видео модуль «Выбор» (старшие версии Moodle). 

Обсуждения на форуме по использованию Moodle: 

 Получите «Подпись» ваших Студентов под Соглашением. 

 Творческие традиции? 

4.3.3.3.Часто задаваемые вопросы по Выбору 
4.3.3.3.1.Как можно позволить пользователям участвовать в 
Главной странице Интерактивного Действия «Выбор»? 

Чтобы позволить зарегистрированным пользователям участвовать в Главной 

странице Интерактивного Действия «Выбор»: 

 Щёлкните иконку редактирования Choice. 

 В Блоке настроек для Выбора, щёлкните Permissions (полномочия). 

 Из ниспадающего меню «Advanced role override (продвинутое ручное корректирование 

роли)» выберите «Authenticated user (аутентифицированный пользователь)». 

 УстановитеВозможность mod/choice:choose, чтобы позволить. 

 Щёлкните кнопку «Save changes (сохранить изменения)». 

4.3.3.3.2.Можно позволить Студентам делать более одного 
выбора? 

В настоящее время это сделать невозможно; однако им может быть позволено 

изменять своё мнение, если установить Выбор, который может обновляться. 

4.3.3.3.3.Можно ли использовать изображения в качестве 
альтернатив Выбора вместо текста? 

Чтобы сделать это, сначала перешлите ваши файлы с изображениями и звуком 

(mp3) или видео файлы в интернет. 

 Скопируйте URL (веб-адрес) тех файлов, которые вы хотите отображать. 

 Перенесите их в текстовый редактор, подобный Notepad (это несущественно, но 

облегчает добавление кода). 

 Чтобы отобразить изображение, добавьте этот код с любой стороны от URL вашего 

изображения: <img src="YOUR_IMAGE_.jpg"> 

 Чтобы отобразить звуковой или видео файл – сначала убедитесь, что ваш 

Администратор Сайта подключил мультимедиа Плагины/Фильтры. 

 Добавьте этот код с любой стороны вашего звукового или видео файла: 

<a href="YOUR_SOUND_FILE.mp3"></a> 

http://school.demo.moodle.net/mod/choice/view.php?id=1194
http://school.demo.moodle.net/mod/choice/view.php?id=1194
http://www.youtube.com/watch?v=shkelQDKbtM
http://moodle.org/mod/forum/discuss.php?d=43536
https://moodle.org/mod/forum/discuss.php?d=145882
http://docs.moodle.org/25/en/Capabilities/mod/choice:choose
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 Set up your choice as normal and in the options boxes, paste the 

relevant code+URL. 

Beware! Double check before you paste - any extra or missing space or bit 

of code and it won't work. 

4.3.3.3.4.See also 

 Using Moodle Choice module forum 

Using Moodle forum discussions: 

 Remove teacher from Choice 

4.3.4.Database 
Enables participants to create, maintain and search a bank of record entries. 

 

Database activity module 
The database activity module allows the teacher and/or students to build, 

display and search a bank of record entries about any conceivable topic. 

The format and structure of these entries can be almost unlimited, 

including images, files, URLs, numbers and text amongst other things. 

Screenshot. 

4.3.4.1.Database settings 
4.3.4.1.1.Adding a database activity 
 
To add a database activity: 

1. With the editing turned on, in the section you wish to add your 

database, click the "Add an activity or resource" link (or, if not present, 

the "Add an activity" drop down menu) and choose Database All 

settings may expanded by clicking the "Expand all" link top right. 

 

2. Give your new database a name and a description. 

3. Select your options (see below). 

4. Click the "Save and display" button at the bottom of the page. 

5. Define the fields or use a preset. 

6. Define the templates. 

7. Add one or two same entries then edit the templates as appropriate. 

 

 

 

 

 

 

 Установите ваш Выбор как обычно и в окошках опций вставьте релевантный код+URL. 

 

Остерегайтесь! Дважды проверьте перед вставкой – любые лишние или 

пропущенные пробелы или кусочки кода, и это не будет работать. 

4.3.3.3.4.См. также 
 Использование Moodle: форум по модулю «Выбор». 

Обсуждения на форуме по использованию Moodle: 

 Удалить Преподавателя из Выбора. 

4.3.4.База Данных 
Предоставляет Участникам возможность создавать, поддерживать и осуществлять 

поиск Записей в Банке Записей. 

Модуль Интерактивного Действия «База Данных» 
Модуль Интерактивного Действия «База Данных» позволяет Преподавателю и/или 

Студентам строить, отображать и осуществлять поиск Записей БД в хранилище по любой 

задуманной теме. Формат и структура этих Записей БД почти неограниченны, включая 

изображения, файлы, адреса URL, числа, тексты, и др. 

Снимок с экрана «База Данных по результатам биометрических исследований». 

4.3.4.1.Настройки Базы Данных 
4.3.4.1.1.Добавление Интерактивного Действия 
«База Данных» 

Чтобы добавить Интерактивное Действие «База Данных»: 

1. С включённым режимом редактирования в том Разделе, куда вы хотите добавить вашу 

Базу Данных, щёлкните ссылку «Add an activity or resource (добавить 

Интерактивное Действие или Ресурсы)» (или, если она не присутствует, ниспадающее 

меню «Add an activity») и выберите Database. Все настройки можно развернуть 

щелчком по ссылке «Expand all» вверху справа. 

2. Задайте вашей новой Базе Данных наименование и описание. 

3. Выберите ваши опции (см. ниже). 

4. Щёлкните кнопку «Save and display (сохранить и отобразить)» внизу страницы. 

5. Определите поля или используйте предустановленные. 

6. Определите Шаблоны. 

7. Добавьте одну или две одинаковых Записи, затем отредактируйте Шаблоны 

подходящим образом. 

http://moodle.org/mod/forum/view.php?id=735
http://moodle.org/mod/forum/discuss.php?d=102125
http://docs.moodle.org/25/en/File:Databaseexample.png
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4.3.4.1.2.General 
Screenshot «General settings expanded by default». 

Name 

Choose a helpful name as this will form the link students will click on to 

access your database. 

Description 

Type the description of the database here. Click "Show editing 

tools" to display the rich text editor, and drag the bottom right of the text 

box out to expand it. 

Display description on course page 

If this box is ticked, the description will appear on the course page just 

below the name of the Database. 

4.3.4.1.3.Entries 
Screenshot «Entries settings expanded» 

Approval required? 

If set to "yes", the entry will only be visible once a teacher has checked and 

approved it. 

Allow comments on entries 

If set to "yes", users will be able to comment on database entries. 

 

Entries required befor completion 

Select here how many entries you wish the student to add before the 

activity can be considered "complete". 

Entries required before viewing 
Select here how many entries you wish the student to add before they are 

allowed to see entries by other people. Note: If entries are required before 

viewing, the database auto-linking filter should be disabled. This is 

because the database auto-linking filter can't determine whether a user has 

submitted the required number of entries. 

Maxiumum number of entries 

Select here the maximum number of entries you wish students to make. 

 

 

 

 

 

 

 

 

 

4.3.4.1.2.Обычные настройки 
Снимок с экрана «Общие настройки, развёрнутые по умолчанию». 

Наименование 

Выберите полезное наименование, которое создаст ссылку, по которой Студенты 

получат доступ к вашей Базе Данных. 

Описание 

Наберите здесь описание Базы Данных. Щёлкните «Show editing tools (показать 

инструменты редактирования)», чтобы отобразить полный текстовый редактор и 

перетащите за правый нижний угол текстовое окошко, чтобы расширить его. 

Отображать описание на странице Курса 

Если это окошко отмечено «галочкой», это описание появится на странице Курса 

как раз под наименованием этой Базы Данных. 

4.3.4.1.3.Записи Базы Данных 
Снимок с экрана «Развёрнутые настройки Записей Базы Данных». 

Одобрение обязательно? 

Если установить в «Yes», каждая из Записей Базы Данных будет видна только 

после того, как Преподаватель проверит и подтвердит её. 

Позволить комментировать Записи Базы Данных 

Если установить в «Yes», пользователи смогут комментировать 

Записи Базы Данных. 

Записи Базы Данных, обязательные перед завершением 
Выберите здесь, сколько Записей вы хотите, чтобы внёс Студент прежде, чем 

Интерактивное Действие может рассматриваться как «завершённое». 

Записи Базы Данных, обязательные до просмотра 

Выберите здесь, сколько Записей вы хотите, чтобы Студент внёс перед тем, как 

ему позволят просматривать Записи других людей. Замечание: Если требуются Записи до 

просмотра, Фильтр Авто-Связывания Базы Данных должен быть отключён. Это нужно 

потому, что Фильтр Авто-Связывания Базы Данных не может определить, подал ли 

Студент на рассмотрение требуемое число Записей Базы Данных. 

Максимальное число Записей Базы Данных 

Выберите здесь максимальное число Записей Базы Данных, которые должны быть 

созданы Студентами. 

http://docs.moodle.org/25/en/File:databasegeneral25.png
http://docs.moodle.org/25/en/File:databasentries25.png
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4.3.4.1.4.Availability 
Screenshot «Availability settings expanded». 

Available from/to 
Select here the dates you want the database to be visible to students. 

 

Read only from/to 
If you wish, select here the dates you want students to be able to see entries 

in the database but not be able to add their own. 

For example you could make a database 'available from' January 1st until 

March 1st, but 'read only' from January 1st to February 1st. This means 

students can only view entries for a month before being able to add their 

own. 

The 'available from/to' settings override the 'read only from/to' settings. So 

if a database has 'read only' from 1st January, and "available from" 1st 

February, students will not be able to view its content during January. 

4.3.4.1.5.RSS 
 

 

Select the number of entries you wish to appear in the RSS feed here. 

 

4.3.4.1.6.Grade 
 (This setting is collapsed by default) Choose the category in which this 

database will appear if ratings are enabled. 

4.3.4.1.7.Ratings 
Screenshot «Ratings settings expanded». 

Roles with permissions to rate 
Database entries can be rated using a scale. By default, only teachers can 

rate database entries, though students can be given permission to do so if 

desired from Administration>Database administration. This is a useful tool 

for giving students participation grades. Any ratings given are recorded in 

the gradebook. 

 

 

 

 

 

 

 

 

4.3.4.1.4.Доступность 
Снимок с экрана «Развёрнутые настройки доступности». 

Доступно с/до 
Выберите здесь даты, по которым вы хотите, чтобы эта База Данных могла быть 

видима Студентам. 

Читать только с/до 
Если вы желаете, здесь можно задать даты, с/до которых Студенты смогут увидеть 

Записи в этой Базе Данных, но не смогут добавлять свои. 

Например, вы можете сделать Базу Данных «доступной с» 1 января до 1 марта, но 

«только чтение» с 1 января до 1 февраля. Это означает, что Студенты в течение месяца 

смогут только просматривать Записи, прежде чем смогут добавлять и свои собственные. 

 

Настройки «доступно с/до» перекрывают настройки «только чтение с/до». Так, 

если База Данных имеет режим «только чтение» с 1 января и режим «доступно до» 1 

февраля, то Студенты не будут способны просматривать её содержимое в течение января. 

4.3.4.1.5.RSS 

Семейство XML-форматов, предназначенных для описания лент новостей, анонсов 

статей, изменений в блогах и т.п. 

Выберите здесь число Записей Базы Данных, которые вы бы хотели, чтобы 

появлялись в RSS-рассылке. 

4.3.4.1.6.Оценка 
(Эта настройка по умолчанию свёрнута) Выберите Категорию, в которой эта 

База Данных будет появляться, если разрешены Рейтинги. 

4.3.4.1.7.Рейтинги 
Снимок с экрана «Развёрнутые Настройки Рейтингов». 

Роли с полномочиями оценивать 
Записи Базы Данных могут быть ранжированы с использованием Шкалы. По 

умолчанию только Преподаватели могут ранжировать Записи Базы Данных, хотя 

Студентам может быть дано полномочие делать это, если нужно, из 

AdministrationDatabase administration. Это полезный инструмент для дружеского 

оценивания Студентами друг друга. Любые данные Рейтинги записываются в 

Журнал Оценок. 

http://docs.moodle.org/25/en/File:databaseavailability25.png
http://ru.wikipedia.org/wiki/XML
http://ru.wikipedia.org/wiki/%D0%9D%D0%BE%D0%B2%D0%BE%D1%81%D1%82%D0%BD%D0%B0%D1%8F_%D0%BB%D0%B5%D0%BD%D1%82%D0%B0
http://ru.wikipedia.org/wiki/%D0%90%D0%BD%D0%BE%D0%BD%D1%81
http://ru.wikipedia.org/wiki/%D0%91%D0%BB%D0%BE%D0%B3
http://docs.moodle.org/25/en/File:ratings25.png
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4.3.4.1.8.Common module settings 
 (These settings are collapsed by default.) 

See Common module settings 

4.3.4.1.9.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.3.4.1.10.Site administration settings 
Database activity defaults and additional settings may changed by an 

administrator in Administration > Site administration > Plugins > Activity 

modules > Database. 

4.3.4.1.11.Database activity capabilities 
 
Approve unapproved entries 
Capabilities/mod/data:approve 

 This allows a user to approve Database activity module entries 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Write comments 
Capabilities/mod/data:comment 

 This allows a user to add comments to Database activity module entries 

 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher and student 

Export all database entries 
Capabilities/mod/data:exportallentries 

 This allows a user to export all Database activity module entries 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Export a database entry 
Capabilities/mod/data:exportentry 

 This allows a user to export a Database activity module entry 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

 

4.3.4.1.8.Общие настройки модуля 
(Эти настройки по умолчанию свёрнуты). 

См. п. 6.1. 

4.3.4.1.9.Ограничить Доступ/Завершение Действия 
Эти настройки видимы, если Обусловленные Действия и Завершения Действия 

разрешены на Сайте и в Курсе. 

4.3.4.1.10.Настройки управления Сайтом 
Настройки Интерактивного Действия «База Данных» по умолчанию и 

дополнительные настройки могут изменяться Администратором в 

AdministrationSite administrationPluginsActivity modulesDatabase. 

4.3.4.1.11.Возможности Интерактивного Действия 
«База Данных» 
Одобрить не получившие одобрения Записи Базы Данных 

Возможность Capabilities/mod/data:approve 

 Позволяет пользователю одобрять Записи модуля Интерактивного Действия 

«База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Писать комментарии 
Возможность Capabilities/mod/data:comment 

 Позволяет пользователю добавлять комментарии к Записям модуля 

Интерактивного Действия «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя и Студента. 

Экспортировать все Записи Базы Данных 
Возможность Capabilities/mod/data:exportallentries 

 Позволяет пользователю экспортировать все Записи модуля Интерактивного Действия 

«База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Экспортировать Запись Базы Данных 
Возможность Capabilities/mod/data:exportentry 

 Позволяет пользователю экспортировать Запись модуля Интерактивного Действия 

«База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 
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Export own database entry 
Capabilities/mod/data:exportownentry 

 This allows a user to export the or own Database activity module entries 

 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher and student. 

Manage database activity comments 
 
Capabilities/mod/data:managecomments 

 This allows a user to edit and delete database activity module comments 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Manage database activity entries 
Capabilities/mod/data:manageentries 

 This allows a user to add, edit and delete database activity module 

entries 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Manage templates 
Capabilities/mod/data:managetemplates 

 This allows a user to manage database templates 

 This capability is allowed for the default roles of manager and teacher 

Manage all template presets 
Capabilities/mod/data:manageuserpresets 

 This allows a user to manage database presets 

 This capability is allowed for the default role of manager only 

Rate entries 
Capabilities/mod/data:rate 

 This allows a user to rate database activity module entries 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

 

 

 

 

Экспортировать Запись собственной Базы Данных 
Возможность Capabilities/mod/data:exportownentry 

 Позволяет пользователю экспортировать чужие или Записи модуля 

Интерактивного Действия собственной «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Управлять комментариями Интерактивного Действия 
«База Данных» 

Возможность Capabilities/mod/data:managecomments 

 Позволяет пользователю редактировать и удалять комментарии модуля 

Интерактивного Действия «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Управлять Записями Интерактивного Действия «База Данных» 
Возможность Capabilities/mod/data:managetemplates 

 Позволяет пользователю добавлять, редактировать и удалять Записи модуля 

Интерактивного Действия «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Управлять Шаблонами 
Возможность Capabilities/mod/data:managetemplates 

 Позволяет пользователю управлять Шаблонами Базы Данных 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподаввателя. 

Управлять всеми заранее установленными Шаблонами 
Возможность Capabilities/mod/data:manageuserpresets 

 Позволяет пользователю управлять заранее установленными Шаблонами Базы Данных 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера. 

Оценивать Записи Базы Данных 
Возможность Capabilities/mod/data:rate 

 Позволяет пользователю оценивать Записи модуля Интерактивного Действия 

«База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 
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View all raw ratings given by individuals 
 
Capabilities/mod/data:viewallratings 

 This allows a user to view all ratings given to database activity module 

entries 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View presets from all users 
 
Capabilities/mod/data:viewalluserpresets 

 This allows a user to view database presets from all users 

  

 This allows also a user to export entries 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View total ratings that anyone received 
Capabilities/mod/data:viewanyrating 

 This allows a user to view total ratings for database activity module 

entries 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View entries 
Capabilities/mod/data:viewentry 

 This allows a user to view database activity module entries 

  

 This capability is moderated by any submission requirements in the 

database set-up, such as the number of entries required before viewing 

 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher, student and guest 

View the total rating you received 
Capabilities/mod/data:viewrating 

 This allows a user to view all ratings which they have received for 

database activity module entries 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

 

 

Просматривать все Исходные Рейтинги, данные отдельными 
лицами 

Возможность Capabilities/mod/data:viewallratings 

 Позволяет пользователю просматривать все Рейтинги, установленные Записям модуля 

Интерактивного Действия «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Просматривать заранее установленные Базы Данных по всем 
пользователям 

Возможность Capabilities/mod/data:viewalluserpresets 

 Позволяет пользователю просматривать заранее установленные Базы Данных по всем 

пользователям. 

 Эта опция также позволяет пользователю экспортировать Записи Базы Данных. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Просматривать итоговые Рейтинги, полученные каждым 

Возможность Capabilities/mod/data:viewanyrating 

 Позволяет пользователю просматривать итоговые Рейтинги для Записей модуля 

Интерактивного Действия «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Просматривать Записи Базы Данных 

Возможность Capabilities/mod/data:viewentry 

 Позволяет пользователю просмотр Записей модуля Интерактивного Действия 

«База Данных». 

 Эта Возможность модерируется любыми установленными в Базе Данных требованиями 

к готовым ответам, такими как «Entries required before viewing (Записи Базы Данных 

обязательные перед просмотром)». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя, 

неРедактирующего Преподавателя, Студента и Гостя. 

Просматривать Итоговый Рейтинг, который вы получили 

Возможность Capabilities/mod/data:viewrating 

 Позволяет пользователю просматривать все Рейтинги, которые он получил для Записей 

модуля Интерактивного Действия «База Данных». 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 
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Write entries 
Capabilities/mod/data:writeentry 

 This allows a user to add entries to a database activity and edit or delete 

any entries which they have previously added 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher and student 

Add a new database activity 
Capabilities/mod/data:addinstance 

 This allows a user to add a new database activity to the course 

 

 This capability is allowed for the default roles of manager and teacher 

4.3.4.2. Building Database 
After creating a database, as explained in Database activity settings... 

 

 Next you define the kind of fields that define the information you wish 

to collect. For example a database of famous paintings may have a 

picture field called painting, for uploading an image file showing the 

painting, and two text fields called artist and title for the name of the 

artist and the painting. Alternatively, you can use a database preset (see 

below). 

 It is then optional to edit the database templates to alter the way in 

which the database displays entries. 

4.3.4.2.1. Database fields 
A field is a named unit of information. Each entry in a database activity 

module can have multiple fields of multiple types e.g. a text field called 

'favourite color' which allows you to type in your favourite shade, or a 

menu called 'state' that lets you choose one from a list of the 50 that make 

up the United States of America. By combining several fields with 

appropriate names and types you should be able to capture all the relevant 

information about the items in your database. 

Note that if you later edit the fields in the databases you must use the Reset 

template button, or manually edit the template, to ensure the new fields are 

added to the display. 

Field name and description 
The name is what is shown when an entry is added. It must be unique and 

short. The description is for your benefit to help identify that field. 

 

 

Записывать Записи (в Базу Данных) 

Возможность Capabilities/mod/data:writeentry 

 Позволяет пользователю добавлять Записи в Интерактивное Действие «База Данных» и 

редактировать или удалять любые Записи Базы Данных, которые он ранее добавил. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя, 

неРедактирующего Преподавателя и Студента. 

Добавлять новое Интерактивное Действие «База Данных» 

Возможность Capabilities/mod/data:addinstance 

 Позволяет пользователю добавлять новое Интерактивное Действие «База Данных» в 

Курс. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

4.3.4.2.Разработка Базы Данных 
После создания Базы Данных, как это объяснено в настройках 

Интерактивного Действия «База Данных» (см. п. 4.3.1)… 

 Далее вы определяете типы полей, которые определяют информацию необходимую вам 

для сбора. Например, База Данных известных картин может иметь поле рисунка, 

называемое «живопись», для пересылки файла с изображением этой картины, и двух 

текстовых полей, называемых «художник» и «название», для имени живописца и 

названия картины. В качестве альтернативы вы можете использовать заранее 

установленную Базу Данных (см. ниже). 

 Только после этого можно редактировать Шаблоны Баз Данных, чтобы изменить 

способ отображения Базой Данных своих Записей. 

4.3.4.2.1.Поля Базы Данных 
Поле является поименованной единицей информации. Каждая Запись в модуле 

Интерактивного Действия «База Данных» может иметь много полей разных типов, 

например, текстовое поле с названием «любимый цвет», которое разрешает вам печатать в 

любимом тоне, или меню, называемое «штат», которое позволяет вам выбрать один из 50 

Соединённых штатов Америки. Составив комбинацию из нескольких полей с 

подходящими названиями и типами, вы сможете извлечь всю релевантную информацию о 

статьях в вашей Базе Данных. 

Заметьте, что, если вы позже отредактируете эти поля в Базе Данных, вы должны 

использовать кнопку «Reset template (сбросить шаблон)» или вручную отредактировать 

этот Шаблон, чтобы гарантировать, что эти новые поля добавлены в отображение. 

Название поля и описание 
Название поля – это то, что показывается, когда в Базу Данных добавляется 

Запись. Оно должно быть уникальным и кратким. Описание полезно тем, что помогает 

идентифицировать это поле. 
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Field types 
The following screenshots show "before" and "afters" of setting up fields. 

The selection in orange shows the field as it is displayed for the user when 

they add an entry. 

Checkbox 
This allows you to offer checkboxes for the user to select. Add the options 

one under the other. The word will appear next to a 

checkbox when the user clicks to add an entry. They can check more than 

one box. 

Screenshot. 

Date 
This allows a user to enter a date by picking a day, month and year from a 

drop down list. 

Screenshot. 

File 
Users can upload a file from their computer. If it is an image file then the 

picture field may be a better choice. 

Screenshot. 

Latitude/longitude 
Users can enter a geographic location using latitude and longitude. For 

example, Moodle HQ is at latitude -31.9545, longitude 115.877. When 

viewing the record, links are automatically generated linking to geographic 

data services such as Google Earth, OpenStreetMap, GeaBios,Mapstars 

and more. (The teacher can choose which of those links appear, if any.) 

 

Screenshot. 

Menu 
The text entered in the options area will be presented as a drop-down list 

for the user to choose from. Each line become a different option. 

 

Screenshot. 

Menu (Multi-select) 
The text entered in the options area will be presented as a list for the user 

to choose from and each line become a different option. By holding down 

control or shift as they click, users will be able to select multiple options. 

This is a fairly advanced computer skill so it may be wise to use multiple 

checkboxes instead. 

 

Screenshot. 

Типы полей 
Следующие снимки с экранов показывают установки полей «перед» и «после». 

Вариант в оранжевом цвете показывает это поле так, как оно отображается для 

пользователя, когда он добавляет Запись (Запись в Базу Данных – Запись Базы Данных). 

Окошко-флажок 
Это помогает вам предлагать пользователю окошки-флажки для выбора. 

Добавляйте опции одну под другой. Следом за окошком-флажком появится слово, когда 

пользователь щёлкнет, чтобы добавить Запись. Он может пометить более чем одно 

окошко. 

Снимок с экрана: Поле окошка-флажка 1. 

Дата 
Эта опция позволяет пользователю вводить дату, выбирая день, месяц и год из 

ниспадающего списка. 

Снимок с экрана: Поле даты 1. 

Файл 
Пользователи могут переслать файл со своего компьютера. Если это файл с 

изображением, тогда поле рисунка может быть лучшим выбором. 

Снимок с экрана: Поле файла. 

Широта/долгота 
Пользователи могут ввести географические координаты, используя широту и 

долготу. Например, координаты штаб-квартиры Moodle: широта -31.9545, долгота 115.877. 

При просмотре Записи Базы Данных автоматически генерируются ссылки, связывая со 

службами географических данных, такими как Google Earth, OpenStreetMap, GeaBios, 

Mapstars и другими. (Преподаватель может выбрать, какая из этих ссылок появится, если 

это надо.) 

Снимок с экрана: Поле широты-долготы. 

Меню 
Текст, введённый в область опций, будет воспроизводиться как ниспадающий 

список, из которого пользователь может выбрать любую опцию. Каждая строка 

становится отдельной опцией. 

Снимок с экрана: Поле меню. 

Меню (множественный выбор) 
Текст, введённый в область опций, будет представляться как список, из которого 

пользователь может выбрать любую опцию, и каждая строка становится отдельной 

опцией. Удерживая нажатой кнопку мышки или щелчком по первой и щелчком по 

последней опции с нажатой клавишей «Shift», пользователи смогут выбрать несколько 

подряд расположенных опций. Это довольно продвинутый компьютерный навык, так что, 

может быть, вместо него разумнее использовать несколько окошек-флажков. 

Снимок с экрана: Поле меню с множественным выбором. 

http://docs.moodle.org/25/en/File:Checkboxfield1.png
http://docs.moodle.org/25/en/File:Datefield1.png
http://docs.moodle.org/25/en/File:Filefield.png
http://docs.moodle.org/25/en/File:Latlongfield.png
http://docs.moodle.org/25/en/File:Multiselectfield.png
http://docs.moodle.org/25/en/File:Multiselectfield.png
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Number 
This allows users to enter any number. For example: 

 42 

 -1000 

 0 

 0.123 

 3.0e8 

(For those who care about the technical details, the field stores floating 

point numbers.) 

Screenshot. 

Picture 
This allows a user to upload and display an image file. "Single view" is 

when the image is viewed on its own; "list view" is when it is viewed in 

with other images. Single view can be larger than list view. 

 

Screenshot. 

Radio buttons 
The user gets radio buttons and can choose only one. They can only submit 

the entry when they have clicked on one button. (Note:If you only have 

two options and they are opposites (true/false, yes/no) then you could 

simply use a single checkbox instead. However checkboxes default to their 

unchecked status and so people could submit without actively selecting one 

of the options. This may not always be appropriate.) 

 

Screenshot. 

Text 
Users can enter text up to 60 characters in length. For longer text, or for 

text that requires formatting such as headers and bullet points, you can use 

a text area field. 

Screenshot. 

Text area 
This allows users to enter a long piece of text using the text editor. 

 

Screenshot. 

 

 

 

 

 

Число 
Эта опция позволяет вводить любое число. Например: 

 42 

 -1000 

 0 

 0.123 

 3.0e8 

(К сведению тех, кого интересуют технические детали: каждое такое поле 

содержит число с плавающей точкой.) 

Снимок с экрана: Поле числа. 

Рисунок 
Эта опция позволяет пользователю пересылать и отображать файл с изображением. 

«Single view (одиночное представление)» – это когда изображение просматривается 

отдельно, «List view (вид списком)» – это когда изображение просматривается в ряду 

других изображений. Одиночное представление может быть больше спискового. 

Снимок с экрана: Поле рисунка. 

Переключатели 
Пользователь получает переключатели и может выбрать только один из них. Он 

может представить только одну Запись Базы Данных, когда щёлкнет по одной кнопке. 

(Замечание: Если вы имеете только две опции, и они противоположны (истина/ложь, 

да/нет), тогда вам может быть вместо них проще использовать единственное окошко-

флажок. Однако, по умолчанию окошки-флажки находятся в непомеченном «галочкой» 

состоянии, так что и без действительного выбора одной из опций можно переслать 

Запись Базы Данных. Это не всегда подходит.) 

Снимок с экрана: Поле переключателей. 

Текст 
Пользователь может ввести текст длиной до 60 символов. Для более длинного 

текста или текста, требующего форматирования, такого как выделение заголовков или 

наиболее важных пунктов, вы можете использовать поле типа «Текстовая область». 

Снимок с экрана: Поле текста. 

Область текста 
Эта опция позволяет пользователю ввести длинный кусок текста, используя 

текстовый редактор. 

Снимок с экрана: Поле текстовой области. 

http://docs.moodle.org/25/en/File:Numberfield.png
http://docs.moodle.org/25/en/File:Picturefield.png
http://docs.moodle.org/25/en/File:Radiofield.png
http://docs.moodle.org/25/en/File:Textfield.png
http://docs.moodle.org/25/en/File:Textareafield.png
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URL     New feature in Moodle 2.5! 
The user can add a link to a website here. If you select autolink then the 

URL becomes clickable. If you also enter a forced name for the link then 

that text will be used for the hyperlink. For example in a database of 

authors you may wish people to enter the author's website. If you enter the 

text 'homepage' as a forced name then clicking on text "homepage" will 

take you to the entered URL. 

 

You can choose to have the URL open in a new window if so desired. 

Screenshot. 

4.3.4.2.2. Presets 
To avoid the necessity of always having to create a new database from 

scratch, the database activity module has a presets feature. An image 

gallery preset is currently included in the database module to help get you 

started. You can create your own presets as well and share them with 

others. 

 

Importing a preset 
Screenshot «Database presets page». 

To use a preset: 

1. On the database page, click the Presets tab. 

2. The usual way to import a preset is clicking the "Choose file" button 

and browsing to the ZIP file containing the preset (eg. "preset.zip") 

stored on the server. If there does not yet exist a preset ZIP file on the 

server, upload it from your local machine. Choose the desired preset file 

by clicking on its action "Choose". Finally, press the "Import" button. 

 

3. Alternatively, you can choose a previously loaded preset. 

 

4. After the import, you can start to add or import entries. All the hard 

work of setting up the fields and templates has been done for you. If 

you desire, you can still customize the fields and templates. 

You will see a "Overwrite current settings" checkbox after the "Import" 

button has been pressed. 

If checked, the database activity overwrites some of its current general 

settings by those stored in the preset: 

 

 The "Introduction" HTML text 

 "Required entries" 

 

URL        Новое средство в Moodle 2.5! 
Здесь пользователь может добавить ссылку на веб-Сайт. Если вы выберете авто-

связывание, тогда URL становится активизируемым щелчком мыши. Если вы также 

введёте принудительное наименование для каждой ссылки, тогда текст будет использован 

для гиперссылки. Например, в Базе Данных авторов вы можете захотеть, чтобы люди 

входили на веб-Сайт соответствующего автора. Если вы введёте текст «домашняя 

страница» в качестве принудительного имени, тогда щелчок по тексту «домашняя 

страница» представит вам введённый URL. 

Вы также можете выбрать, чтобы URL открывал страницу Сайта в новом окне. 

Снимок с экрана: Поле URL. 

4.3.4.2.2.Заранее установленные (Базы Данных) 
Чтобы избежать необходимости всегда устанавливать новую Базу Данных с нуля, 

модуль Интерактивного Действия «База Данных» имеет средства предварительной 

установки Баз Данных. В настоящее время в модуль «База Данных» включена 

предварительная установка галереи изображений, чтобы помочь вам стартовать. Вы 

можете создать ваши собственные заранее установленные Базы Данных и совместно 

использовать их с другими. 

Импортирование заранее установленной Базы Данных 
Снимок с экрана «Страница заранее установленных Баз Данных». 

Чтобы использовать заранее установленную (Базу Данных). 

1. На странице Базы Данных щёлкните ярлычок «Presets». 

2. Обычный способ импортировать заранее установленную Базу Данных – это щёлкнуть 

по кнопке «Choose file (выбрать файл)» и найти ZIP-файл, содержащий заранее 

установленную БД (например, ZIP), сохранённую на сервере. Если на сервере ещё нет 

заранее установленного ZIP-файла, перешлите его с вашей локальной машины. 

Выберите нужный заранее установленный файл щелчком по вызывающей его кнопке 

«Choose (выбрать)». В заключение нажмите кнопку «Import (импортировать)». 

3. Альтернативно вы можете выбрать предварительно загруженный файл с заранее 

установленной Базы Данных. 

4. После импорта вы можете начать добавлять или импортировать Записи Базы Данных. 

Вся тяжёлая работа по установке полей и Шаблонов уже сделана для вас. Если хотите, 

можете ещё и настроить эти поля и Шаблоны по-своему. 

Вы увидите окошко-флажок «Overwrite current settings (перезаписать текущие 

установки)» после нажатия кнопки «Import». 

Если окошко помечено «галочкой», деятельность Базы Данных заменит некоторые 

из его текущих общих настроек на те, которые сохранены в заранее установленной 

Базы Данных: 

 «Введение» (HTML-текст) 

 «Необходимые Записи Базы Данных» 

http://docs.moodle.org/25/en/File:Urlfield.png
http://docs.moodle.org/25/en/File:databasepresetsnew.png
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 "Entries required before viewing" 

 "Maximum entries" 

 "Comments" 

 "Require approval?" 

 RSS-articles 

Exporting a preset 
If you wish to share your database presets with others, you have two 

options: 

1. Export as a ZIP file, which can then be imported to another course or 

Moodle site. 

2. Save as a preset, which publishes the database for other teachers on 

your site to use. It will then appear in the preset list. (You can delete it 

from the list at any time.) 

 

Note: Only the fields and templates of the database are copied when 

exporting or saving it as a preset, not the entries. 

 

Presets for download 
The Activity Examples course on the School demo site has a number of 

database activities with presets for download. 

 

4.3.4.3.Database templates 
Templates for the Database activity module allow you to control the visual 

layout of information when listing, viewing or editing database entries. It is 

a similar to the technique used to mail merge letters in word processors 

such as Open Office Writer or Microsoft Word. 

 

4.3.4.3.1.Tag usage 
The content of each field you create for your database and some special 

tags (listed below) can be inserted into the output template by the use of 

tags. 

Fields have the format [[fieldname]]. All other tags have the format 

##sometag##. 

To use the tags in the box on the left of the page, use the HTML viewer, 

place your cursor in the text area of your target edit and then click on the 

tag you want to place. Alternatively, you may simply type the appropriate 

name within the required symbols like ##this## or [[this]], respectively. 

 

 

 «Элементы, обязательные перед просмотром» 

  «Максимальное число Записей Базы Данных» 

 «Комментарии» 

 «Потребовать одобрение?» 

 RSS-статьи 

Экспортирование заранее установленной Базы Данных 
Если вы желаете использовать вашу Базу Данных совместно с другими, у вас есть 

две опции: 

1. Экспортировать её как ZIP-файл, который может затем быть импортирован в другой 

Курс или на Сайт Moodle. 

2. Сохранить как заранее установленную Базу Данных, которая опубликует эту 

Базу Данных для других Преподавателей на вашем Сайте для использования. Она затем 

появится в списке заранее установленных Баз Данных. (Вы можете удалить её из этого 

списка в любое время.) 

Замечание: Только поля и Шаблоны Базы Данных, а не Записи Базы Данных, 

копируются при экспортировании или сохранении её как заранее установленной 

Баз Данных. 

Заранее установленные Базы Данных для скачивания 
Курс с примерами Интерактивных Действий на демонстрационном Сайте Школы 

имеет ряд Интерактивных Действий с заранее установленными Базами Данных для 

скачивания. 

4.3.4.3.Шаблоны Баз Данных 
Шаблоны для модуля Интерактивного Действия «База Данных» позволяет вам 

управлять визуальной компоновкой информации при распечатке, просмотре или 

редактировании Записей Базы Данных. Это похоже на технику автоматического 

составления стандартных писем (с использованием фиксированных форм, подлежащих 

заполнению) в текстовых процессорах, таких как Open Office Writer или Microsoft Word. 

4.3.4.3.1.Применение тегов 
Содержимое каждого поля, которое вы создаёте для вашей Базы Данных, и 

некоторые специальные теги (перечисленные ниже) могут быть вставлены в выходной 

Шаблон применением тегов. 

Поля имеют формат [[имя поля]]. Все другие теги имеют формат ##некоторый 

тег##. 

Чтобы применить теги в окошке слева на странице, используйте просмотрщик 

HTML, поместите ваш курсор в текстовой области редактирования вашего тега и затем 

щёлкните по тому тегу, который хотите разместить. Альтернативно вы можете просто 

набрать подходящее наименование внутри требуемых символов подобных ##это## или 

[[это]], соответственно. 

http://docs.moodle.org/25/en/Database_templates#Tag_usage
http://school.demo.moodle.net/course/view.php?id=127
http://docs.moodle.org/25/en/Database_templates#Tag_usage
http://school.demo.moodle.net/course/view.php?id=127
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##edit## creates a clickable icon link that allows you to edit the current 

entry (only appears if you have the rights to do this) 

 

##delete## creates a link that lets you delete the current entry (only appears 

if you have the rights to do this) 

##approve## create a link that lets you approve the current database entry 

(only appears if you have the rights to do this) 

##more## creates a link to the single view, which may contain more 

detailed info 

##moreurl## creates just the URL for the above link, useful for creating 

your own links. You can click on the link icon and type ##moreurl## into 

URL field or in source view type 

<a href="##moreurl##">[[fieldname]]</a> 

##comments## creates a link to the view/edit comments page, the link text 

is the current number of comments (only appears if comments are turned 

on) 

##user## creates a link to the user page of the user who submitted the 

entry, link text is their name 

 

##timeadded## 

##timemodified## 

4.3.4.3.2.List template 
This template allows you to control the fields used and their layout when 

viewing multiple entries at once (e.g. search results). It is possible that this 

view may simply provide an overview with more detailed information 

available by clicking on an entry to access the single view of the entry. 

 

See Designing a list view in Moodle database activity for instructions on 

how to create a list template table. 

 

The list template can also be used as a way to export your database as a 

CSV file. 

4.3.4.3.3.Single template 
This is used to display a single entry at a time and so has more space for 

display and can use, for example, larger versions of images or optionally 

provide more information than shown in the list view. 

 

Screenshot. 

 

 

##edit## создаст активизируемую щелчком мыши иконку, которая позволит вам 

редактировать текущую Запись Базы Данных (появится, только если у вас есть права 

делать это). 

##delete## создаст ссылку, которая позволит вам удалить текущую Запись Базы Данных 

(появится, только если у вас есть права делать это). 

##approve## создаст ссылку, которая позволит вам одобрить эту Запись Базы Данных 

(появится, только если у вас есть права делать это). 

##more## создаст ссылку на одиночное изображение, которое может содержать больше 

подробностей. 

##moreurl## создаст только URL для вышеприведённой ссылки, полезен для создания 

ваших собственных ссылок. Вы можете щёлкнуть по иконке этой ссылки и набрать 

##moreurl## в поле URL или в исходно набранное изображение  

<a href="##moreurl##">[[наименование поля]]</a> 

##comments## создаст ссылку на страницу для просмотра/редактирования комментариев, 

текст ссылки является текущим номером комментариев (появится, только если у вас 

есть права делать это). 

##user## создаст ссылку на пользовательскую страницу того пользователя, который 

передал эту Запись Базы Данных на рассмотрение Преподавателю, текст ссылки 

является её наименованием. 

##timeadded## – добавленное время. 

##timemodified## – модифицированное время. 

4.3.4.3.2.Шаблон списка 
Этот Шаблон позволяет вам управлять используемыми полями и их компоновкой 

при просмотре сразу нескольких Записей Базы Данных (например, поиск результатов). 

Возможно, что этот просмотр может просто обеспечить обзор с более подробной 

информацией доступной по щелчку на Запись Базы Данных для доступа к одиночному 

изображению этой Записи Базы Данных. 

См. Проектирование изображения списка в Интерактивном Действии 

«База Данных» системы Moodle для получения инструкций по тому, как создавать таблицу 

Шаблонов списка. 

Этот Шаблон списка может также быть использован в качестве способа 

экспортирования вашей Базы Данных в виде CSV-файла. 

4.3.4.3.3.Одиночный Шаблон 
Он используется для отображения по одной Записи Базы Данных за раз, а также 

имеет больше пространства для отображения и может использоваться, например, для 

изображений большого размера или, по выбору, для предоставления более подробной 

информации, чем показано в изображении списка. 

Снимок с экрана: Одиночный Шаблон Базы Данных. 

http://docs.moodle.org/25/en/Database_templates#List_template
http://docs.moodle.org/25/en/Database_templates#Single_template
http://docs.moodle.org/25/en/Database_templates#List_template
http://tracker.moodle.org/secure/attachment/23333/moodle_databse_activity_list_formatting.pdf
http://tracker.moodle.org/secure/attachment/23333/moodle_databse_activity_list_formatting.pdf
http://docs.moodle.org/25/en/Database_export
http://docs.moodle.org/25/en/Database_export
http://docs.moodle.org/25/en/Database_templates#Single_template
http://docs.moodle.org/25/en/File:Databasesingletemplate.png


 

99 

4.3.4.3.4.Advanced search template 
An advanced search template is for creating the interface form used in the 

advanced search. 

4.3.4.3.5.Add template 
This template creates the interface form used when adding or editing 

database entries. 

4.3.4.3.6.RSS template 
Lets you control the content of the RSS feed for database entries. 

4.3.4.3.7.CSS template 
If any of the HTML in your other templates requires CSS to provide visual 

style you can specify it here. 

4.3.4.3.8.Javascript template 
You can use javascript to manipulate the way elements are displayed in 

either the List, Single or Add templates. Basically you need to enclose the 

part you want to manipulate in some named html element. The naming is 

essential as it allows you to identify the element for manipulation. 

 

Let's say, for example, you have a field in your database that stores a 

person's name and when you display the names in the List View you want 

to count the times a name matches some criteria and display the result. 

Your database will contain a field which we will call "name". In your List 

template you will be able to display the contents of that field by using the 

[[name]] construct at the place where you want that information displayed. 

For example in the Repeated entry on the list template you will have 

 <table> 

   <tr> 

     <td>Name: [[name]]</td> 

   </tr> 

 <table>   

You now need to modify that entry to ensure that the part you want to 

manipulate is a named element. 

 

 <table> 

   <tr> 

     <td name="named">Name: [[name]]</td> 

   </tr> 

 <table>   

 

 

4.3.4.3.4.Шаблон расширенного поиска 
Шаблон расширенного поиска предназначен для создания формы интерфейса, 

используемой при расширенном поиске. 

4.3.4.3.5.Добавить Шаблон 
Этот Шаблон создаёт форму интерфейса, используемую при добавлении или 

редактировании Записей Базы Данных. 

4.3.4.3.6.Шаблон RSS 
Позволяет вам управлять содержимым RSS-рассылки Записей Базы Данных. 

4.3.4.3.7.Шаблон CSS 
Если какой-либо из HTML в ваших других Шаблонах требует CSS для обеспечения 

визуального стиля, вы можете указать его здесь. 

4.3.4.3.8.Шаблон Javascript  
Вы можете использовать Javascript, чтобы манипулировать способом отображения 

Записей Базы Данных в их шаблонах: «Список», «Одиночная» и «Добавить». По существу 

вам нужно заключить в круглые скобки ту часть, которой вы хотите манипулировать, в 

некоторый поименованный HTML-элемент. Присвоение имени существенно, поскольку 

позволяет вам идентифицировать этот элемент для манипуляции. 

Пусть, например, в вашей Базе Данных есть поле, сохраняющее имя пользователя, 

и когда вы отображаете эти имена в Виде Списком, вам нужно подсчитать, сколько раз 

имя соответствует некоторому критерию и отобразить результат. 

Ваша База Данных содержит поле, которое мы будем называть «name». В вашем 

Шаблоне списка вы можете отобразить содержимое этого поля, используя конструкцию 

[[name]] в том месте, где вы хотите отображать эту информацию. Например, в 

Записи Базы Данных «Repeated (повторяемая)» в Шаблоне списка вы будете иметь 

<table> 

   <tr> 

     <td>Name: [[name]]</td> 

   </tr> 

 <table> 

Сейчас вам может потребоваться модифицировать эту Запись Базы Данных, чтобы 

гарантировать, что та часть, которой вы хотите манипулировать, является поименованным 

элементом. 

<table> 

   <tr> 

     <td name="named">Name: [[name]]</td> 

   </tr> 

 <table> 

http://docs.moodle.org/25/en/Database_templates#Advanced_search_template
http://docs.moodle.org/25/en/Database_templates#Add_template
http://docs.moodle.org/25/en/Database_templates#RSS_template
http://docs.moodle.org/25/en/Database_templates#CSS_template
http://docs.moodle.org/25/en/Database_templates#Javascript_template
http://docs.moodle.org/25/en/Database_templates#Advanced_search_template
http://docs.moodle.org/25/en/Database_templates#Add_template
http://docs.moodle.org/25/en/Database_templates#RSS_template
http://docs.moodle.org/25/en/RSS
http://docs.moodle.org/25/en/Database_templates#CSS_template
http://docs.moodle.org/25/en/Database_templates#Javascript_template
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The footer of your list view can then contain another named element to 

display the result. 

  <div name="result"></div> 

Your javascript template can now look as follows 

var cnt = 0; 

 var re = /foo|Foo/; 

  function init(){ 

   var namedElements = document.getElementsByName("named"); 

   for (i=0; i < namedElements.length; i++) { 

       if(re.test(namedElements[i].innerHTML)) cnt++; 

     } 

   var namedResult = document.getElementsByName("result"); 

   namedResult[0].innerHTML = cnt; 

   } 

window.onload = init; 

This will display a table of names as is usual in the list view. Now at the 

bottom there will also be the count of the names that matched foo or Foo. 

 

4.3.4.3.9.Reset templates button 
When you first create a database the templates will be pre-filled with 

appropriate HTML. If you later add fields then you can press the reset 

templates button and it will add HTML for the new fields in a similar 

fashion. If you have edited any of the templates in the meantime then your 

changes will be lost. It is recommended that you finalize the database 

fields before changing the template code. 

4.3.4.3.10.See also 
 Database presets 

 Video demonstrating tag usage 

Using Moodle forum discussions: 
 Look of the database module 

 How can I list database information horizontally instead of vertically? 

 For those who want the display of Moodle Site's Modules and plugins 

 Can't get columns to line up in list view 

 Time stamp for database entries? 

 

 

 

 

 

Нижний колонтитул вашего Вид Списком может затем содержать другой 

поименованный элемент для отображения результата. 

  <div name="result"></div> 

Ваш Javascript-Шаблон сейчас может выглядеть следующим образом 

var cnt = 0; 

 var re = /foo|Foo/; 

  function init(){ 

   var  namedElements = document.getElementsByName("named"); 

   for (i=0; i < namedElements.length; i++) { 

       if(re.test(namedElements[i].innerHTML)) cnt++; 

     } 

   var namedResult = document.getElementsByName("result"); 

   namedResult[0].innerHTML = cnt; 

   } 

window.onload = init; 

Это отобразит таблицу имён так, как это обычно отображается в Вид Списком. 

Сейчас внизу будет также находиться счётчик имён, который соответствует критерию 

«foo» или «Foo». 

4.3.4.3.9.Кнопка восстановления шаблонов 
Когда вы создаёте Базу Данных первый раз, Шаблоны будут предварительно 

заполнены подходящим HTML. Если вы позднее добавите поля, вы можете нажать кнопку 

восстановления Шаблонов и в Шаблон будет добавлен HTML для новых полей схожим 

образом. Если вы тем временем отредактировали любой из этих Шаблонов, тогда ваши 

изменения будут утрачены. Рекомендуется, чтобы вы придавали окончательную форму 

полям Базы Данных перед изменением кода Шаблона. 

4.3.4.3.10.See also 
 Заранее установленные Базы Данных. 

 Видео, демонстрирующее применение тегов. 

Использование обсуждений в форумах Moodle 
 Взгляд на модуль «База Даннх». 

 Как вертикальное перечисление информации о базе данных заменить горизонтальным? 

 К сведению тех, кому нужно отображение модулей и плагинов Сайта Moodle. 

 Невозможно трансформировать колонки в строки в Вид Списком. 

 Можно ли ставить временные отметки для Записей Базы Данных? 

http://docs.moodle.org/25/en/Database_templates#Reset_templates_button
http://docs.moodle.org/25/en/Database_templates#See_also
http://docs.moodle.org/25/en/Database_templates#Reset_templates_button
http://docs.moodle.org/25/en/Database_templates#See_also
http://docs.moodle.org/25/en/Database_presets
http://docs.moodle.org/25/en/Database_presets
http://moodle.org/mod/forum/discuss.php?d=55338
http://moodle.org/mod/forum/discuss.php?d=74243
http://moodle.org/mod/forum/discuss.php?d=61179
http://moodle.org/mod/forum/discuss.php?d=84050
http://moodle.org/mod/forum/discuss.php?d=86927
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4.3.4.4.Using Database 
4.3.4.4.1.Views 
View list 
The list view shows multiple entries, possibly in a more abbreviated form 

to ensure all the information fits. You may use the controls at the bottom of 

the screen to search and sort the contents. 

 

 View single: one item at a time 

 View list (red arrow): several items at a time (number is user defined) 

 

 Add entry (green arrows): add an item to the database 

The icons highlighted in yellow are for editing, viewing and deleting an 

item in the database. 

View single 
Alternatively, you may view only one entry at a time. This might allow 

you to view more detailed information than the list view. 

 

Add comment 
If comments have been enabled, you may add a comment. 

Rate entries 
If ratings have been enabled, and made viewable, by the database editor, 

you may grade other database entries, and view these ratings. 

4.3.4.4.2.Adding an entry 
Go to the "Add entry" tab and fill in the form. 

 

4.3.4.4.3.Automatically linking database entries 
If the Database auto-linking filter is enabled, any entries in a database will 

be automatically linked to where the concept words and/or phrases appear 

within the same course. This includes forum postings, internal resources, 

week summaries etc. 

Note: If you do not want particular text to be linked (in a forum posting, 

say) then you should add <nolink> and </nolink> tags around the text. 

Alternatively the filter can be disabled for a particular activity. 

 

 

 

 

 

4.3.4.4.Использование Базы Данны 
4.3.4.4.1.Представления Баз Данных 
Просмотр списком 

Представление списком показывает сразу несколько Записей Баз Данных, 

возможно в несколько сокращённой форме, чтобы гарантировать все информационные 

соответствия. Вы можете использовать иконки управления внизу экрана для поиска и 

сортировки содержимого. 

 Одиночное представление: показывает элементы на экране по одному. 

 Список представлений (красная стрелка): несколько элементов за один раз (их число 

определяется пользователем). 

 Добавить Запись Базы Данных (зелёная стрелка): добавить элемент в Базу Данных. 

Подсвеченные жёлтым цветом иконки предназначены для редактирования, 

просмотра и удаления объекта в Базе Данных. См. снимок с экрана «Вкладки Баз Данных». 

Поочерёдный просмотр 
Вы можете выбрать режим поочерёдного просмотра Записей Базы Данных по 

одной. Это может позволить вам увидеть более детальную информацию, чем при 

просмотре списком. 

Добавить комментарий 
Если комментарии разрешены, вы можете добавить комментарий. 

Оценивать записи 
Вы можете оценивать другие Записи Базы Данных и просматривать эти Рейтинги, 

если ранжирование и просмотр разрешены редактором Базы Данных, 

4.3.4.4.2.Добавление Записи Базы Данных 
Перейдите по ярлычку «Add entry (добавить Запись Базы Данных)» и заполните 

форму. 

4.3.4.4.3.Автоматическое Связывание Записей Базы Данных 
Если Фильтр Автоматического Связывания Базы Данных включён, любые 

Записи Базы Данных будут автоматически связываться с использующимися внутри 

данного Курса концептуальными словами и/или фразами. Это включает корреспонденции 

Форумов, внутренние Ресурсы, подведение еженедельных итогов и т.д. 

Замечание: Если вы не хотите, чтобы конкретный текст (скажем, корреспонденция 

форума) автоматически связывался, то вам нужно добавить теги <nolink> и </nolink> 

вокруг этого текста. Либо можно отключить соответствующий фильтр для конкретного 

Интерактивного Действия. 

http://docs.moodle.org/25/en/Using_Database#Views
http://docs.moodle.org/25/en/Using_Database#Adding_an_entry
http://docs.moodle.org/25/en/Using_Database#Automatically_linking_database_entries
http://docs.moodle.org/25/en/Using_Database#Views
http://docs.moodle.org/25/en/File:Dbasetabs.gif
http://docs.moodle.org/25/en/Using_Database#Adding_an_entry
http://docs.moodle.org/25/en/Using_Database#Automatically_linking_database_entries


 

102 

4.3.4.4.4.Importing many entries 
You can import entries via a CSV file if you click the "Import entries" link 

in the Database activity administration block. CSV means Comma-

Separated-Values and is a common format for text interchange. 

 

Screenshot. 

The easiest way to determine the format of the text file is to manually add 

an entry to the database and then export it. The resulting export text file 

may then be edited and used for importing entries. Here's a sample of what 

a very simple file will look like. 

 

The expected file format is a plain text file with a list of field names as the 

first record. The data then follows, one record per line. 

 

The field delimiter defaults to a comma character and the field enclosure is 

not set by default (field enclosures are characters that surround each field 

in each record). 

Records should be delimited by new lines (usually generated by pressing 

RETURN or ENTER in your text editor). Tabs can be specified using \t 

and newlines by \n. 

Sample file: 

name,height,weight 

Kai,180cm,80kg 

Kim,170cm,70kg 

Koo,190cm,90kg 

Note: Certain field types may not be supported. 

Do not put spaces after your commas or upload will fail! 

After upload page import.php comes back blank if it failed. If successful 

you'll read a message like, "1 entries saved". 

 

4.3.4.4.5.Exporting entries 
You can export entries either in CSV (comma separated values) or ODS 

(OpenOffice Calc) formats by clicking the tab at the top or by clicking the 

"Export entries" link in the Database Activity administration block. (Both 

CSV and ODS formats can be opened with MS Excel.) 

 

Screenshot. 

 

 

 

4.3.4.4.4.Импортирование многих Записей Базы Данных 
Вы можете импортировать Записи Базы Данных через CSV-файл, если щёлкнете по 

ссылке «Import entries (импортировать Записи Базы Данных)» в Блоке Управления 

Интерактивным Действием «База Данных». CSV означает «Значения, разделённые 

запятыми», и является общепринятым форматом для обменов текстами. 

Снимок с экрана: Добавить CSV файл. 

Наиболее лёгкий способ установить формат текстового файла, состоит в том, 

чтобы добавить Запись в Базу Данных вручную, и затем экспортировать её. 

Результирующий текстовый файл экспорта может быть затем отредактирован и 

использован для импортирования Записей Базы Данных. Приводится пример того, как 

будет выглядеть очень простой файл. 

Ожидаемый формат файла – файл с обычным текстом, в котором список имён 

полей является первой Записью Базы Данных. Затем следуют данные по одной записи в 

строке. 

Разделитель полей по умолчанию – символ запятой, а символы ограждения поля по 

умолчанию не установлены (символами ограждения поля служат символы, которые 

окружают каждое поле в каждой записи). 

Записи должны быть ограждены символами «новой строки» (обычно генерируются 

по нажатию клавиш RETURN или ENTER в вашем текстовом редакторе). Ярлычки могут 

быть обозначены  тегами \t и символом «новой строки» \n. 

Пример Файла: 

name,height,weight 

Kai,180cm,80kg 

Kim,170cm,70kg 

Koo,190cm,90kg 

Замечание: Некоторые типы полей не могут быть поддержаны. 

Не ставьте пробелы после ваших запятых, иначе пересылка не состоится! 

Import.php после пересылки страницы возвращает пустой бланк, если пересылка не 

произошла. Если пересылка успешна, вы прочитаете сообщение типа «Одна 

Запись Базы Данных сохранена». 

4.3.4.4.5.Экспортирование Записей Баз Данных 
Вы можете экспортировать Записи БД либо в CSV (Comma Separated Values), либо 

в ODS (OpenOffice Calc) форматы, щелчком по иконке в верху или щелчком по ссылке 

«Export entries (экспортировать Записи Базы Данных)» в Блоке Управления 

Интерактивным Действием «База Данных». (Оба формата CSV и ODS могут быть открыты 

MS Excel.). 

Снимок с экрана: Экспорт Баз Данных. 

http://docs.moodle.org/25/en/Using_Database#Importing_many_entries
http://docs.moodle.org/25/en/Using_Database#Exporting_entries
http://docs.moodle.org/25/en/Using_Database#Importing_many_entries
http://docs.moodle.org/25/en/File:Databaseupload.png
http://docs.moodle.org/25/en/File:Upload_csv_sample.png
http://docs.moodle.org/25/en/Using_Database#Exporting_entries
http://docs.moodle.org/25/en/File:Databasexport.png
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When using the CSV format, the user can select either the comma, 

semicolon, or tab to separate the fields. The selection of the proper 

character is important. If users select to use a comma to separate the fields 

and some of the fields contain data with commas then the number of 

columns is going to be misaligned and likely cause confusion. 

Users can select which fields from the database they wish to have 

exported. By default, all fields are checked to be included. Choose the 

fields that you wish to have included in the export. 

Once the export type and the fields to be exported have been selected, 

clicking on the Export entries pushbutton will generate the file. The user 

will usually have the option of either opening or saving the file. 

 

For information on converting the date export (and import) format, see the 

discussion Standard Database Module – Dates. 

4.3.4.4.6.Exporting to an external portfolio 
If an external portfolio such as Mahara has been enabled by the 

administrator then users have the option to export individual entries to that 

portfolio. They will see at the bottom of a database entry an "export" icon 

to click on and select the portfolio to export to 

Screenshot. 

4.3.4.4.7.Example databases 
Moodle.org has two good examples of the database module in action: 

 Moodle Buzz, a database of the titles, authors and web links to news 

articles mentioning Moodle. 

 Themes, a database with screenshots, download links and user 

comments about Moodle themes. 

4.3.4.4.8.Creative uses 
You could use the database module to: 

 allow collaboration on building a collection of web links/books/journal 

references related to a particular subject 

 display student created photos/posters/websites/poems for peer 

comment and review 

 gather comments and votes on a shortlist of potential logos/mascot 

names/project ideas 

 provide a student file storage area 

 maintain a log of what was done in a face-to-face class each day, so that 

absent students can get caught up themselves. Example. 

 

 

При использовании CSV-формата пользователь может выбрать разделитель полей: 

запятую, двоеточие или ярлычок. Правильный выбор надлежащего символа важен. Если 

пользователи выбирают запятую для разделения полей, а некоторые из полей содержат 

данные с запятой, тогда число колонок становится неправильным и может вызвать 

путаницу. 

Пользователи могут выбирать, какие поля из Базы Данных они хотят 

экспортировать. По умолчанию все поля помечены для экспорта. Пометьте те поля, 

которые вы хотите включить в экспорт. 

Выбрав тип экспорта и поля для экспортирования, щёлкните по кнопочному 

выключателю «Export entries (экспортировать Записи Базы Данных)», который 

сгенерирует файл. Пользователю обычно будет предоставлена опция либо открытия, либо 

сохранения этого файла. 

Информация по изменению даты экспорта (или импорта) есть в обсуждении 

Standard Database Module – Dates. 

4.3.4.4.6.Экспортирование во внешний Портфель 
Если внешний Портфель, такой как Mahara, разрешён Администратором, тогда 

пользователи имеют опцию по экспорту индивидуальных Записей Базы Данных в этот 

Портфель. Они увидят внизу Записи Базы Данных иконку «Export», чтобы щёлкнуть по 

ней и выбрать Портфель для экспорта. 

Снимок с экрана: Экспортировать Записи Базы Данных. 

4.3.4.4.7.Возможные Базы Данных 
На Сайте Moodle.org есть два хороших примера модуля «База Данных» в действии. 

 Moodle Buzz – база данных заголовков, авторов и веб-ссылок на статьи новостей, 

упоминающие Moodle. 

 Themes – База Данных со снимками с экранов, ссылками для скачивания и 

комментариями пользователей по фоновым картинкам в Moodle. 

4.3.4.4.8.Творческие применения 
Вы можете использовать модуль «База Данных», чтобы 

 Вести совместную работу по созданию коллекции веб-ссылок/книг/ссылок на журналы, 

относящихся к конкретному предмету. 

 Отображать созданные Студентом фото/плакаты/веб-Сайты/поэмы для 

комментирования сокурсниками и рецензирования. 

 Накапливать комментарии и результаты голосований при обсуждении списка 

потенциальных логотипов/наименований талисманов/проектных идей. 

 Предоставить Студенту файловую область памяти. 

 Вести журнал того, что было сделано в классе каждый день с тем, чтобы 

отсутствовавшие Студенты могли включаться в работу со всеми. Пример. 

http://docs.moodle.org/25/en/Using_Database#Exporting_to_an_external_portfolio
http://docs.moodle.org/25/en/Using_Database#Example_databases
http://docs.moodle.org/25/en/Using_Database#Creative_uses
https://moodle.org/mod/forum/discuss.php?d=220505
http://docs.moodle.org/25/en/Using_Database#Exporting_to_an_external_portfolio
http://docs.moodle.org/25/en/Using_Database#Exporting_to_an_external_portfolio
http://docs.moodle.org/25/en/Portfolios
http://docs.moodle.org/25/en/Mahara_portfolio
http://docs.moodle.org/25/en/File:Exportdatabasentry.png
http://docs.moodle.org/25/en/Using_Database#Example_databases
http://moodle.org/mod/data/view.php?id=6140
http://moodle.org/mod/data/view.php?d=26
http://docs.moodle.org/25/en/Using_Database#Creative_uses
http://moodle.org/mod/forum/discuss.php?d=52699
http://moodle.org/mod/forum/discuss.php?d=115047
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4.3.4.4.9.See also 
 Examples of databases in the School demo site (available for download) 

 Dataform module, which is a major enhancement of the Database 

module with improved browsing, editing, searching and other features. 

 

 Glossary module, which performs a similar though more specialised, 

text-based role 

 Using Moodle book Chapter 12: Databases 

 Using Moodle Database activity module forum 

 Screencast introducing the Database Module and walking through 

creating a database 

 Tracking Students' Reading with the Moodle Database Module 

presentation 

Using Moodle forum discussions: 
Database Module: Each learner Private DB? 

Database for Dummies please! 

Restricting access to database content by user? 

How to use the database activity module? 

4.3.4.5.Database activity FAQ 
 
4.3.4.5.1.Where can I download additional 
database presets? 
See the Presets and See also sections in Building Database for various 

places with presets for download. 

 

4.3.4.5.2.How can I add to the list of database 
presets available for users to choose from? 
Screenshot. 

There is one default preset, Image Gallery. It is possible to create your own 

presets. 

When you have created your database that you desire to set as a preset; go 

to the "Presets" tab of the database and choose "Save as preset". Give the 

preset a name and the database fields and templates will now be available 

as a preset for the rest of the site. You will need site admin rights to do 

this. 

 

 

4.3.4.4.9.См. также 
 Примеры баз данных на демонстрационном Сайте школы (доступны для скачивания). 

 Модуль «Форма Данных», который является главным усовершенствованием 

предыдущих версий модуля «База Данных», с улучшением просмотра, редактирования, 

поиска и других возможностей. 

 Модуль «Глоссарий», который выполняет похожую, хотя более специализированную 

работу с текстами. 

 Книга Дж  Коул и Хю Фостер «Использование Moodle». Глава 12. Базы данных. 

 Использование Moodle: Форум по модулю Интерактивного Действия «База Данных». 

 Фильм с экрана по введению в модуль «База Данны» и путешествию по процессу 

создания Базы Данных. 

 Слежение за чтением Студентов через презентацию модуля «База Данных» Moodle. 

 

Дискуссии на форуме по использованию Moodle: 
Модуль База Данных: Каждому обучающемуся личную базу данных? 

Нужна База Данных для макетов! 

Ограничивать ли пользователям доступ к содержимому Базы Данных? 

Как использовать модуль Интерактивного Действия «База Данных»? 

4.3.4.5.Часто задаваемые вопросы по 
Интерактивному Действию «База Данных» 
4.3.4.5.1.Откуда я могу скачать дополнительные заранее 
установленные Базы Данных? 

Различные места, откуда можно скачать заранее установленные Базы Данных, 

ищите в «Presets (заранее установленные базы данных)» и в п. 4.3.4.2. «Разработка 

Базы Данных». 

4.3.4.5.2.Как увеличить список заранее установленных 
Баз Данных, доступных пользователям для выбора 

Снимок с экрана «Заранее установленные Базы Данных». 

Существует одна заранее установленная База Данных, «Галерея изображений». 

Можно создавать ваши собственные заранее установленные Базы Данных. 

Когда вы создали вашу собственную Базу Данных, которую вы хотите объявить 

заранее установленной, перейдите по ярлычку «Presets» этой Базы Данных и выберите 

«Save as preset (сохранить как заранее установленную)». Задайте этой заранее сохранённой 

Базе Данных имя, поля Базы Данных и Шаблоны, которые теперь станут доступными, как 

заранее установленные, для всего Сайта. Для этого Вам нужны права Администратора 

Сайта. 

http://docs.moodle.org/25/en/Using_Database#See_also
http://docs.moodle.org/25/en/Using_Database#See_also
http://school.demo.moodle.net/course/view.php?id=127&section=3
http://docs.moodle.org/25/en/Dataform_module
http://docs.moodle.org/25/en/Glossary_module
http://docs.moodle.org/25/en/Using_Moodle_book
http://moodle.org/mod/forum/view.php?id=3505
http://treadwell.cce.cornell.edu/moodle_doc/database_moodle/index.html
http://treadwell.cce.cornell.edu/moodle_doc/database_moodle/index.html
http://moodle.org/mod/data/view.php?rid=2424
http://moodle.org/mod/forum/discuss.php?d=72260
http://moodle.org/mod/forum/discuss.php?d=84487
http://moodle.org/mod/forum/discuss.php?d=89117
http://moodle.org/mod/forum/discuss.php?d=139137
http://docs.moodle.org/25/en/File:databasepresetsnew.png
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Please see the Database presets for other available presets you can import 

into your system. 

4.3.4.5.3.How can I create a database in which 
students can only view their own entries? 
Either: 

Set up the database so that entries require approval. If the entries are never 

approved, then only the student that added a particular entry and the 

teachers can view it. 

 

Or: 

Set the group mode of the database to "Separate groups" and assign each 

student to a separate group. 

4.3.4.5.4.How can I enable a sort function by 
clicking on the field headings? 
For sorting, you need to manually create the link in the template around 

that heading. To find the URL you need, you can do a sort using the menus 

and then look in the URLs. Take out everything but the d, sort and order 

parameters. For example, 

http://moodle.org/mod/data/view.php?d=13&sort=44&order=ASC 

http://moodle.org/mod/data/view.php?d=13&sort=44&order=DESC 

4.3.4.5.5.How can I add highlighting like on the 
Module and plugins page? 
In the repeated part of the template (note onmouseover and onmouseout to 

change the classes): 

<tr onmouseover="this.className='trhighlight'" 

onmouseout="this.className='trnormal'"> 

 <td class="c0"><b><a href="##MoreURL##">[[Name]]</a></b></td> 

 <td class="c1">[[Type]]</td> 

 <td class="c2">[[Requirement]]</td> 

 <td class="c3">[[Status]]</td> 

 <td class="c4">[[Summary]]</td> 

 <td align="center" class="c5">##Edit## ##Delete## ##More## 

##Approve## </td> 

 

 

 

 

 

Пожалуйста, просмотрите «Заранее установленные Базы Данных», чтобы другие 

доступные заранее установленные Базы Данных вы могли импортировать в вашу систему. 

4.3.4.5.3.Как создать Базу Данных, в которой Студенты 
могли бы просматривать только свои Записи БД 

Либо: 

Установить Базу Данных так, чтобы Записи Базы Данных требовали одобрения. 

Если эти Записи Базы Данных никогда на получат одобрения, тогда только тот Студент, 

который добавил в Базу Данных конкретную Запись, и его Преподаватель смогут её 

увидеть. 

Или: 

Установите Групповой Режим этой Базы Данных в «Separate groups (раздельные 

группы)» и поместите каждого Студента в отдельную Группу. 

4.3.4.5.4.Как включить функцию сортировки щелчком по 
заголовкам полей? 

Для сортировки вам нужно вручную создать ссылку в Шаблоне этого заголовка. 

Чтобы найти нужный вам URL, вы можете сделать сортировку, используя меню, и затем 

глянуть на URLs. Заберите всё кроме d, отсортируйте и упорядочьте параметры. 

Например, 

http://moodle.org/mod/data/view.php?d=13&sort=44&order=ASC 

http://moodle.org/mod/data/view.php?d=13&sort=44&order=DESC 

4.3.4.5.5.Как добавить подсветку такую, как на странице 
Module и странице Плагинов? 

В повторяющейся части Шаблона (отметьте onmouseover и onmouseout, чтобы 

изменить классы): 

<tr onmouseover="this.className='trhighlight'" onmouseout="this.className='trnormal'"> 

 

   <td class="c0"><b><a href="##MoreURL##">[[Name]]</a></b></td> 

 

   <td class="c1">[[Type]]</td> 

   <td class="c2">[[Requirement]]</td> 

   <td class="c3">[[Status]]</td> 

   <td class="c4">[[Summary]]</td> 

   <td align="center" class="c5">##Edit## ##Delete## ##More## ##Approve## </td> 

http://docs.moodle.org/25/en/Database_presets
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</tr> 

In the CSS template there are two styles: 

.trnormal td { 

   background-color: #FFFFFF; 

 } 

 .trhighlight td { 

   background-color: #EEEEEE; 

 } 

4.3.4.5.6.How can I list database information 
horizontally instead of vertically? 
How can I list database information horizontally instead of vertically? 

Forum discussion 

4.3.4.5.7.Can't get columns to line up in list view 
 
Can't get columns to line up in list view forum discussion including 

moodle.org presets for download 

 

4.3.4.5.8.How can I make an Encyclopedia 
database preset? 
Encyclopedia database preset forum discussion including encyclopedia-

style preset for download. 

4.3.4.5.9.Is there a Time stamp for database 
entries? 
##timeadded## 

4.3.4.5.10.How can I make the title of an entry into 
a link? 
To make the title of an entry in list view link to the single view, add the 

following code to the list template: 

<a href="##moreurl##">[[Title]]</a> 

4.3.4.5.11.How can I make email addresses 
clickable? 
To make email addresses clickable, add the following code to the single 

template: 

<a href="mailto:[[Email]]">[[Email]]</a> 

where 'Email' is the text field for inputting email addresses. 

 

 

</tr> 

В CSS-шаблоне есть два стиля: 

.trnormal td { 

   background-color: #FFFFFF; 

 } 

 .trhighlight td { 

   background-color: #EEEEEE; 

 } 

4.3.4.5.6.Как представить информацию Базы Данных не 
вертикально, а горизонтально? 

Обсуждение на форуме «Как представить информацию о Базе Данных 

вертикально, а не горизонтально?». 

4.3.4.5.7.Невозможно вывести колонки в представлении 
списком построчно 

Обсуждение на форуме невозможности вывести в представлении списком колонок 

построчно, включая заранее установленные Базы Данных для скачивания на Сайте 

moodle.org. 

4.3.4.5.8.Как создать заранее установленную Базу Данных 
«Энциклопедия»? 

Обсуждение на форуме заранее установленной Базы Данных «Энциклопедия», 

включающее заранее установленный стиль энциклопедий для скачивания. 

4.3.4.5.9.Существует ли маркировка времени для 
Записей Базы Данных? 
##timeadded## 

4.3.4.5.10.Как внести заголовок Записи Базы Данных в 
ссылку? 

Чтобы внести заголовок Записи Базы Данных в представление списком, сошлитесь 

на одиночное представление, добавьте следующий код в шаблон списка: 

<a href="##moreurl##">[[Title]]</a> 

4.3.4.5.11.Как создать вызываемый по щелчку мыши адрес 
электронной почты? 

Чтобы создать вызываемый по щелчку мыши адрес э-почты, добавьте следующий 

код в одиночный Шаблон:  

<a href="mailto:[[Email]]">[[Email]]</a> 

где «Email» является текстовым полем для введения адресов э-почты. 

http://moodle.org/mod/forum/discuss.php?d=74243
http://moodle.org/mod/forum/discuss.php?d=74243
http://moodle.org/mod/forum/discuss.php?d=84050
http://moodle.org/mod/forum/discuss.php?d=84050
http://moodle.org/mod/forum/discuss.php?d=87560
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4.3.4.5.12.How can I hide a database entry which 
was previously approved? 
There is currently no user interface for hiding a database entry which was 

previously approved i.e. setting it to require approval again. However, an 

entry can be hidden using MySQL Admin by editing it in the data_records 

table and changing the approved value from 1 to 0. 

 

4.3.4.5.13.How can I add a default sort order of 
entries? 
In the Fields tab, select a default sort field, choose ascending or descending 

then click the Save button. 

4.3.4.5.14.Why is my database so slow to show 
each page? 
Try to go to "Administration > Miscellaneous > XMLDB editor" and 

choose "Check Indexes". If you have any missing indexes found; upgrade 

your Moodle to the latest weekly build of your version; re-run the test; 

backup your site database and then run the suggested SQL from the test on 

your site database. This should speed up your database activity load times. 

4.3.4.5.15.How can I prevent students from 
adding entries? 
An override may be used to close/archive a database activity, or have a 

database in which only teachers can add entries, but students can view the 

entries. 

 

1. Follow the Permissions link in the settings block under Database 

activity administration 

2. Remove Student from the capability mod/data:writeentry by clicking 

the 'X' next to it. 

3. Click the continue button to confirm. 

4.3.4.5.16.How can I empty a database / remove 
records from a database en masse? 
If your clearance is part of a general course clear-out e.g. at rollover time, 

you may be better off using Reset to clear all student activity (which 

Moodle calls 'user data') in one go. 

 

But if you just have one database to clear, read on. 

 

4.3.4.5.12.Как скрыть Запись Базы Данных, которая была 
предварительно одобрена? 

В настоящее время не существует пользовательского интерфейса для сокрытия 

Записи Базы Данных, которая была ранее одобрена, т.е. установки её в режим, требующий 

одобрения заново. Однако, Запись Базы Данных может быть скрыта путём использования 

MySQL Admin посредством редактирования её в таблице data_record и изменения 

значения одобрения с 1 на 0. 

4.3.4.5.13.Как добавить по умолчанию упорядочение 
Записей Баз Данных? 

В ярлычке «Fields (поля)» выберите поле сортировки по умолчанию, затем 

возрастание или убывание и, наконец, щёлкните кнопку «Сохранить». 

4.3.4.5.14.Почему моя База Данных так медленно показывает 
каждую страницу? 

Постарайтесь войти в «AdministrationMiscellaneousXMLDB editor» и выбрать « 

Check Indexes (выбрать индексы)». Если вы не найдёте каких-то индексов, обновите вашу 

Moodle на самую последнюю еженедельно обновляемую версию; перезапустите тест; 

восстановите Базу Данных вашего Сайта; и затем запустите предполагаемый SQL из теста 

на Базе Данных вашего Сайта. Это ускорит время пересылки вашей Базы Данных. 

4.3.4.5.15.Как предотвратить Студентов от добавления 
Записей в Базу Данных? 

Запрет может быть использован для того, чтобы закрыть/архивировать 

Интерактивное Действие «База Данных», или создать Базу Данных, в которую только 

Преподаватели могут добавлять Записи, а Студенты могут только просматривать эти 

Записи. 

1. Следуйте ссылке «Permissions (полномочия)» в Блоке Настроек, внутри 

Блока Управления Интерактивным Действием «База Данных» 

2. Избавьте Студента от Возможности mod/data:writeentry щелчком по следующей за ней 

«X». 

3. Щёлкните кнопку «Continue», чтобы подтвердить. 

4.3.4.5.16.Как Опустошить Базу Данных/Удалить Записи из 
многих Баз Данных? 

Если ваша расчистка является частью общей чистки Курса, например, во время 

прокрутки, вам может быть лучше использовать чистку всех следов деятельности 

Студентов (которуюв  Moodle называют «данные пользователя»), используя Reset, за один 

шаг. 

Но если вы должны очистить только одну Базу Данных, читайте далее. 
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Just one database to clear 
Log in, go to the Moodle area containing the database you want to clear 

out and Turn Editing On 

From the array of icons adjacent to your database to click the Duplicate 

icon (if in doubt, hover your mouse pointer over the icon to display a 

tooltip indicating what the icon does) 

Click through to Edit your duplicate, giving it a distinctive name to avoid 

confusion with the original. Then Save and return to the course area front 

page. 

You can then - assuming you have used Export to save all you need - 

delete the original. 

Save some database records but delete others 
Log in, go to the area containing the database you want to clear out and 

Turn Editing On 

Click on the link to the database you want to clear 

From its Settings, click on Export to export all the records from your 

database into a CSV file; save that somewhere secure where you can find it 

again. 

Open the CSV file in e.g. a spreadsheet package, delete the records you 

don't want (easiest way may be to select all, unselect the ones you want to 

keep, then press delete) and remember to save. 

 

Then return to your Moodle area and use the Duplicate icon on the existing 

database to create an empty copy n.b. give it a distinctive name to avoid 

confusion with the original. 

Open up the new database, and from its Settings use Import to import the 

records you need into that. 

Test out (both viewing and adding). 

Once you're satisfied everything is working and you have saved all you 

need, you can delete the original copy. 

4.3.4.5.17.I get an error message when importing 
a CSV of entries 
One thing to try is to open up the csv file in Excel and save it again as a 

csv file - with another name - and then try importing it agin. Sometimes 

this just works. 

 

 

 

 

Очистить только одну Базу Данных 
Зарегистрируйтесь, перейдите в область Moodle, содержащую Базу Данных, 

которую вы хотите очистить, и включите режим редактирования (Turn Editing On). 

Из массива иконок, расположенных рядом с вашей Базой Данных, щёлкните 

иконку «Duplicate (дублировать)» (если сомневаетесь, наведите указатель вашей мышки на 

иконку отображения подсказки, указывающей, что делает данная иконка). 

В продолжение щёлкните «Edit», чтобы отредактировать ваш дубликат, задавая 

ему отличительное имя, чтобы избежать путаницы с оригиналом. Затем «Save» и 

возвращайтесь на Главную страницу области Курса. 

Затем вы можете, предполагая, что сохранили всё, что вам нужно, удалить 

оригинал. 

Сохранить некоторые Записи Базы Данных, но удалить другие 
Зарегистрируйтесь, перейдите в область, содержащую Базу Данных, которую вы 

хотите очистить, и включите режим редактирования (Turn Editing On). 

Щёлкните ссылку на Базу Данных, которую вы хотите очистить. 

Из её настроек щёлкните «Export», чтобы экспортировать все Записи из вашей 

Базы Данных в CSV-файл; сохраните его где-нибудь в безопасном месте, откуда вы 

сможете взять его снова. 

Откройте этот CSV-файл, например, в пакете электронных таблиц, удалите 

ненужные Записи (легчайший способ заключается в выборе опции All (все), отмене 

выбора тех, которые хотите сохранить, затем нажатии Delete) и не забудьте Save 

(сохранить). 

Затем вернитесь в вашу область Moodle и используйте иконку «Duplicate» в 

существующей Базе Данных, чтобы создать пустую копию n.b., не забыв дать ей 

различительное имя, чтобы не путать её с оригиналом. 

Откройте новую Базу Данных, и из её настроек используйте «Import» для импорта 

в неё нужных вам Записей БазДанных. 

Протестируйте (как просмотр, так и добавление). 

Удаляйте оригинальную копию только после того, как вы убедитесь, что всё 

работает нормально, и что вы сохранили всё нужное. 

4.3.4.5.17.Я получил сообщение об ошибке при 
импортировании Записей Базы Данных из CSV-файла 

Один из путей – открыть CSV-файл в Excel и сохранить его снова как CSV-файл 

(под другим именем), а затем попытаться импортировать его снова. Иногда это 

срабатывает. 
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4.3.4.5.18.See also 
Using Moodle forum discussions: 
 New preset, please review, and make suggestions! including FAQ 

preset for download 

 

 Design a Database Preset for Document Sharing including preset for 

download 

 Look of the database module 

 For those who want the display of Moodle Site's Modules and plugins 

 Looking for some stellar examples of Moodle courses including book 

reviews preset for download 

4.3.5.External tool 
Allows participants to interact with LTI compliant learning resources and 

activities on other web sites. 

 

 

 
 

4.3.6.Feedback 
For creating and conducting surveys to collect feedback. 

Feedback module 
The Feedback module allows you to create and conduct surveys to collect 

feedback. Unlike the Survey tool it allows you to write your own 

questions, rather than choose from a list of pre-written questions and unlike 

the Quiz tool, you can create non-graded questions. The Feedback activity 

is ideal for the likes of course or teacher evaluations. 

 

 

Screenshot «Course evaluation». 

4.3.6.1.Feedback settings 
4.3.6.1.1.Enabling Feedback Module 
 Feedback is disabled by default. To use it in a course, it must first be 

enabled by an administrator. 

 As an administrator, go to Administration > Site Administration > 

Plugins > Activity modules > Manage activities 

 Turn on the (open) eye of "Feedback" 

 

 

4.3.4.5.18.См. также 
Обсуждения использования Moodle на форуме: 
 Пожалуйста, просмотрите новую заранее установленную Базу Данных, и сделайте 

предложение, включая часто задаваемые вопросы по заранее установленным 

Базам Данных для скачивания. 

 Сконструируйте заранее установленную Базу Данных для совместно используемых 

документов, включая данные для скачивания. 

 Взгляните на модуль «База Данных». 

 Для тех, кому нужны отображения модулей Сайта Moodle и плагинов. 

 Поиск некоторых лучших примеров Курсов Moodle, включая рецензии на книги. 

 

4.3.5.Внешнее приложение 
Разрешает участникам взаимодействовать с ресурсами обучения, совместимыми с 

LTI (Learning Tools Interoperability – интерактивный инструментарий обучения, развиваемый фирмой IMS, 

чтобы сделать возможной интеграцию удалённого инструментария и контента в Систему управления 

обучением LMS [Learning Management Syste]), и Интерактивными Действиями на других веб-

Сайтах. 
См. раздел документации о внешних приложениях. 

4.3.6.Обратная Связь 
Для создания и проведения Опросов для Обратной Связи. 

Модуль «Обратная Связь» 
Модуль «Обратная Связь» позволяет вам создавать и проводить опросы Студентов, 

чтобы получить от них Обратную Связь. В отличие от инструмента «Survey (анкета)» см. 

п. 4.3.12, он позволяет вам написать ваши собственные Вопросы, вместо выбора Вопросов 

из заранее составленного списка, а, в отличие от инструмента «Quiz  (Экзамен)» см. 

п. 4.3.10, вы можете создать неоцениваемые Вопросы. Интерактивное Действие 

«Обратная Связь» идеально для сбора «лайков (симпатий)» к Курсу или характеристик 

Преподавателя Студентами. 

Снимок с экрана «Оценка Курса». 

4.3.6.1.Настройки Обратной Связи 
4.3.6.1.1.Включение модуля «Обратная Связь» 
 По умолчанию Обратная Связь отключена. Чтобы использовать её в Курсе, она сначала 

должна быть включена Администратором. 

 В Роли Администратора Сайта перейдите в 

AdministrationSite AdministrationPluginsActivity modulesManage activities 

 Включите (откройте) глаз «Feedback (Обратная Связь)»: 

http://moodle.org/mod/forum/discuss.php?d=87005
http://moodle.org/mod/forum/discuss.php?d=87005
http://moodle.org/mod/forum/discuss.php?d=88727
http://moodle.org/mod/forum/discuss.php?d=88727
http://moodle.org/mod/forum/discuss.php?d=55338
http://moodle.org/mod/forum/discuss.php?d=61179
http://moodle.org/mod/forum/discuss.php?d=94854#p457252
http://docs.moodle.org/25/en/External_tool
http://docs.moodle.org/25/en/File:Feedbackexample.png
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4.3.6.1.2 Enabling Feedback Block 
When added to a course, the Feedback block will display a list of all global 

Feedback activities associated with a course. This is helpful for when you 

want to draw the user's attention to completing the Feedback activity. 

Global Feedback activities can be set up on the front page and can be site 

wide, or mapped to specific courses. See the section on mapping feedback 

to courses below. To enable this block, as an admin, go to Administration 

> Site Administration > Plugins > Blocks > Manage blocks. 

 

 

4.3.6.1.3 Feedback administration settings 
With the editing turned on, in the section you wish to add your feeback, 

click the "Add an activity or resource" link (or, if not present, the "Add an 

activity" drop down menu )and choose Feedback. All settings may 

expanded by clicking the "Expand all" link top right. 

4.3.6.1.4.General 
Screenshot «General settings expanded by default». 

Name 
Whatever you type here will form the link learners click on to view the 

Feedback, so it is helpful to give it a name that suggests its purpose. 

Description 
Add a description of your Feedback instance here. Click "Show editing 

tools" to display the rich text editor, and drag the bottom right of the text 

box out to expand it. 

Display description on the course page 
If this box is ticked, the description will appear on the course page just 

below the name of the Feedback. 

4.3.6.1.5.Availability 
Screenshot «Availability settings expanded». 

Here you can choose when users can complete feedback. 

4.3.6.1.6.Question and submission settings 
Screenshot « Question and submission settings expanded». 

Record User Names 
Choose here whether to show the names of users who complete the 

feedback or not. 

Allow multiple submissions 
Choose here whether or not to allow users to complete the feeback more 

than once. This is important when using Feedback for anonymous surveys  

4.3.6.1.2.Включение Блока «Обратная Связь» 
Будучи добавленным в Курс, Блок Feedback block (п. 4.5.16) будет отображать 

список всех общих Интерактивных Действий «Обратная Связь», связанных с Курсом. Это 

полезно, когда вы хотите привлечь внимание пользователя к Завершению 

Интерактивного Действия «Обратная Связь». Общие Интерактивные Действия 

«Обратная Связь» могут быть установлены на Главной Странице и могут быть доступны 

на всём Сайте или отображены для конкретных Курсов. См. раздел по отображению 

Обратной Связи для Курсов ниже. Чтобы включить этот блок, как 

Администратор перейдите в AdministrationSite AdministrationPluginsBlocksManage 

blocks. 

4.3.6.1.3.Настройки управления Обратной Связью 
Включив режим редактирования в Разделе Курса, куда хотите добавить вашу 

Обратную Связь, щёлкните ссылку «Add an activity or resource» (или, если её нет, 

ниспадающее меню «Add an activity») и выберите Feedback. Щелчком по ссылке вверху 

справа «Expand all» можно развернуть все настройки. 

4.3.6.1.4.Обычные настройки 
Снимок с экрана «Обычные настройки, развёрнутые по умолчанию». 

Наименование 
Всё, что наберёте здесь, сформирует ссылку, после щелчка по которой учащиеся 

увидят Обратную Связь, так что полезно дать ей наименование, соответствующее её цели. 

Описание 
Здесь добавляйте описание вашего экземпляра Обратной Связи. Щёлкните «Show 

editing tools», чтобы отобразить полный текстовый редактор, и перетащите нижний 

правый уголок текстового окна, что расширить его. 

Отображать описание на странице Курса 
Если это окошко помечено «галочкой», описание будет появляться на каждой из 

страниц Курса непосредственно под именем Обратной Связи. 

4.3.6.1.5.Доступность 
Снимок с экрана «Развёрнутые настройки доступности». 

Здесь вы можете выбрать, когда пользователи могут завершить Обратную Связь. 

4.3.6.1.6.Настройки вопроса и готового ответа 
Снимок с экрана «Развёрнутые настройки вопроса и ответа». 

Записать имена пользователей 
Выберите здесь, показывать ли имена пользователей, которые завершили 

Обратную Связь, или нет. 

Разрешить многократность готовых ответов 
Выберите позволять или нет пользователям завершать Обратную Связь более 

одного раза. Это важно при использовании Обратной Связи для анонимных опросов 

http://docs.moodle.org/25/en/File:feedbackgeneral25.png
http://docs.moodle.org/25/en/File:feedbackavailability25.png
http://docs.moodle.org/25/en/File:feedbackquestionsubmission25.png
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on the front page as it will allow non-logged in users to complete the 

feedback. 

Enable notification of submissions 
If set to 'Yes' then teachers will receive notifications when users submit 

feedback. 

Auto-number questions 
If set to 'Yes' then the questions will be automatically numbered. 

4.3.6.1.7.After submission 
Screenshot «After submission settings expanded». 

Show analysis page 
The summary results can be shown to respondents, or shown only to 

teachers. 

Completion message 
This allows you to present users with apersonalised message after they 

have answered the questions. 

Link to next activity 
This allows you to add a URL to another activity or webpage which you 

would like them to go to once they have answered the questions. 

 

Note: Neither of the above fields is required for a student to answer the 

questions, but they must click the Answer the questions... link to start the 

Feedback activity. 

4.3.6.1.8.Common module settings 
See Common module settings. 

4.3.6.1.9.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.3.6.1.10.Map feedback to courses 
If a feedback instance is added to the front page there is an option, when 

'Save and display" is clicked, to map the feedback to courses. All courses 

or certain courses may be selected. (In other words, if you only want the 

feedback to be available in certain courses but not all, you would choose 

just those courses.) The Feedback block can then be added to those courses 

and it provides a quick link to the Feedback activity. 

 

Screenshot « Steps to map front page feedback to a course». 

 

 

на Главной Странице, так как это разрешит незарегистрированным пользователям 

завершить каждую из Обратных Связей. 

Разрешить извещения о готовых ответах 
Если установить в «Yes», тогда Преподаватели будут получать извещения, когда 

пользователи отправят Обратную Связь. 

Автонумерация вопросов 
Если установить в «Yes», тогда вопросы будут нумероваться автоматически. 

4.3.6.1.7.После отправки готового ответа 
Снимок с экрана «Развёрнутые настройки «После отправки готового ответа»». 

Показать страницу анализа 
Итоговые результаты могут быть показаны Респондентам или только 

Преподавателям. 

Сообщение о Завершении 
Это позволяет вам передавать пользователям не персонализированное сообщение 

после того, как они ответили на вопросы. 

Ссылка на следующее Интерактивное Действие 
Это позволяет вам добавить URL на такое Интерактивное Действие или веб-

страницу, на которуе вы бы хотели, чтобы они перешли сразу после того, как они ответили 

на вопросы. 

Замечание: Ни одно из приведённых выше полей не требуется Студенту, чтобы 

отвечать на вопросы, но он должен щёлкнуть ссылку «Answer the questions... », чтобы 

запустить Интерактивное Действие «Обратная Связь». 

4.3.6.1.8.Общие настройки модуля 
См. п. 6.1 «Общие настройки модулей». 

4.3.6.1.9.Ограничить Доступ/Завершение Действия 
Эти настройки видны, если на Сайте или в Курсе разрешено Завершение 

Обусловленных Действий и Действий. 

4.3.6.1.10.Отобразить Обратную Связь в Курсах 
Если образец Обратной Связи добавляется на Главную Страницу, имеется опция, 

когда по щелчку на «Save and display (сохранить и освободить)» можно отобразить 

Обратную Связь в Курсах. Могут быть выбраны все Курсы или конкретные Курсы. 

(Другими словами, если вы хотите чтобы Обратная Связь была доступна только в 

определённых Курсах, но не во всех, то вам нужно выбрать только эти Курсы) Этот 

Блок Обратная Связь может быть затем добавлен в такие Курсы, и это предоставляет 

быструю ссылку на Интерактивное Действие «Обратная Связь». 

Снимок с экрана «Шаги по отображению Обратной Связи к Курсу на Главной 

Странице». 

http://docs.moodle.org/25/en/Feedback_block
http://docs.moodle.org/25/en/File:feedbackaftersubmission25.png
http://docs.moodle.org/25/en/File:mapcourses25.png
http://docs.moodle.org/25/en/File:mapcourses25.png
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To map to a course, first type in the name of a course and press the Search 

button. You will then be presented with a drop down menu from which you 

may choose your course. Click the 'map feedback' button to add it. Repeat 

this to add another course. If you don't choose a course then the feedback 

will be mapped to all courses by default. 

4.3.6.1.11.Site administration settings 
The feedback module has additional settings which may be changed by an 

administrator in Administration > Site administration > Plugins > Activity 

modules > Feedback. 

Allow full anonymous 
Changing this setting to "yes" permits non-logged in users on the front 

page to complete a feedback activity. 

 

4.3.6.1.12 Feedback capabilities 
 Complete a feedback 

 Create private template 

 Create public template 

 Delete completed submissions 

 Delete template 

 Edit items 

 Map courses to global feedbacks 

 Receive email notification 

 View a feedback 

 View the analysis page after submit 

 View reports 

 Add a new feedback 

4.3.6.2.Building Feedback 
After setting a new Feedback you design it by adding questions. Select 

the type of question from the drop down list and then click the Add 

question to activity button. 

Screenshot «Add question to activity». 

4.3.6.2.1.Standard options 
The following apply to all or most question types. 

Position 
This number controls the order of the questions. Position 1 is the question 

nearest the top of the page, so when you create or edit a question, you can 

choose from the dropdown of available positions (which will vary 

depending on how many other questions there are). You can also rearrange 

Чтобы отобразить Курс, сначала наберите имя Курса и нажмите кнопку «Search 

(искать)». Вам будет предоставлено ниспадающее меню, в котором вы можете выбрать 

ваш Курс. Щёлкните кнопку «Map feedback (отобразить обратную связь)», чтобы добавить 

её. Повторите это, чтобы добавить её в другой Курс. Если вы не выбрали Курс, тогда 

Обратная Связь будет отображаться по Умолчанию во всех Курсах. 

4.3.6.1.11.Настройки управления Сайта 
Модуль Обратной Связи имеет дополнительные настройки, которые могут быть 

изменены Администратором Сайта в 

AdministrationSite administrationPluginsActivity modulesFeedback. 

Разрешить полную анонимность 
Изменение этой настройки на «Yes» позволяет пользователям, не 

зарегистрированным на Главной Странице, завершить Интерактивное Действие 

«Обратная Связь». 

4.3.6.1.12.Возможности Обратной Связи 
 Завершить Обратную Связь 

 Создать частные шаблоны 

 Создать публичные шаблоны 

 Удалить завершённые готовые ответы 

 Удалить шаблон 

 Отредактировать элементы 

 Отобразить Курсы в глобальных Обратных Связях 

 Получить извещение по электронной почте 

 Просмотреть Обратную Связь 

 Просмотреть страницу анализа после передачи готового ответа на рассмотрение  

 Просмотреть отчёты 

 Добавить новую Обратную Связь 

4.3.6.2.Построение Обратной Связи 
После установки новой Обратной Связи вы строите её добавлением Вопросов. 

Выберите тип Вопроса из ниспадающего списка и затем щёлкните кнопку «Add question 

to activity (добавить вопрос в интерактивное действие)». 

Снимок с экрана: «Добавить Вопрос в Интерактивное Действие». 

4.3.6.2.1.Стандартные опции 
Следующие опции применимы ко всем или большинству типов Вопросов. 

Позиция 
Эта нумерация определяет очерёдность Вопросов. Позиция 1 – Вопрос у самого 

верха страницы, так что, когда вы создаёте или редактируете Вопрос, вы можете выбрать 

его номер из ниспадающего списка свободных позиций (который будет изменяться по 

мере появления других Вопросов). Вы также можете переупорядочить 

http://docs.moodle.org/25/en/Capabilities/mod/feedback:complete
http://docs.moodle.org/25/en/Capabilities/mod/feedback:createprivatetemplate
http://docs.moodle.org/25/en/Capabilities/mod/feedback:createpublictemplate
http://docs.moodle.org/25/en/Capabilities/mod/feedback:deletesubmissions
http://docs.moodle.org/25/en/Capabilities/mod/feedback:deletetemplate
http://docs.moodle.org/25/en/Capabilities/mod/feedback:edititems
http://docs.moodle.org/25/en/Capabilities/mod/feedback:mapcourse
http://docs.moodle.org/25/en/Capabilities/mod/feedback:receivemail
http://docs.moodle.org/25/en/Capabilities/mod/feedback:view
http://docs.moodle.org/25/en/Capabilities/mod/feedback:viewanalysepage
http://docs.moodle.org/25/en/Capabilities/mod/feedback:viewreports
http://docs.moodle.org/25/en/Capabilities/mod/feedback:addinstance
http://docs.moodle.org/25/en/Capabilities/mod/feedback:complete
http://docs.moodle.org/25/en/Capabilities/mod/feedback:createprivatetemplate
http://docs.moodle.org/25/en/Capabilities/mod/feedback:createpublictemplate
http://docs.moodle.org/25/en/Capabilities/mod/feedback:deletesubmissions
http://docs.moodle.org/25/en/Capabilities/mod/feedback:deletetemplate
http://docs.moodle.org/25/en/Capabilities/mod/feedback:edititems
http://docs.moodle.org/25/en/Capabilities/mod/feedback:mapcourse
http://docs.moodle.org/25/en/Capabilities/mod/feedback:receivemail
http://docs.moodle.org/25/en/Capabilities/mod/feedback:view
http://docs.moodle.org/25/en/Capabilities/mod/feedback:viewanalysepage
http://docs.moodle.org/25/en/Capabilities/mod/feedback:viewreports
http://docs.moodle.org/25/en/Capabilities/mod/feedback:addinstancehttp:/docs.moodle.org/25/en/Capabilities/mod/feedback:viewreports
http://docs.moodle.org/25/en/File:Feedbackeditquestions.png
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questions by clicking the position up and down arrows on the main add 

questions screen. 

Required 
These questions are required to be answered and will prompt the user if 

they are left unaswered. These questions are highlighted with a red star for 

users, and have a yellow exclamation point beside them when editing 

Feedback questions. 

4.3.6.2.2.Available question types 
Captcha 
A test to make sure a real person is filling in the form and not an automatic 

spamming program of some sort. Asks a person to write out some distorted 

text which is displayed on screen. You normally won't need this unless you 

find you are getting spammed a lot. 

Information 
This allows you to choose to display one of three types of information: the 

time of responding; the course and/ or the category where the feedback is 

located. 

Label 
Like a standard Moodle label, this allows you to add arbitrary text between 

questions allowing for extra explanation or to divide the Feedback into 

sections. 

Longer Text Answer 
This option is for creating a text box (you specify how big it will appear in 

rows and columns) which people can write a long answer into. 

Multiple choice – multiple answers 
This will give you a series of options with a checkbox next to each one. 

The respondent can check as many as they want and there is currently no 

way to specify a limit to how many they can choose which is lower than 

the total. 

Multiple choice – single answer allowed 
(dropdownlist) 
This will give you a dropdown list from which only one answer can be 

selected 

Dropdown list (rated) 
This is similar to the dropdownlist option, except that each option has a 

numerical value associated with it. This means that if asking a question 

like:  

 

Вопросы щелчком по стрелочке вверх или вниз на позицию на главном экране добавления 

Вопросов. 

Обязательный для ответа 
На эти Вопросы требуется ответить обязательно, и об этом будет подсказано 

пользователю, если он на них не ответил. Эти Вопросы выделяются красной звёздочкой 

для пользователей, и имеют жёлтый восклицательный знак рядом с ними при 

редактировании Вопросов Обратной Связи. 

4.3.6.2.2.Возможные типы Вопросов 
Проверка на виртуальность корреспондента 

Тест, чтобы убедиться, что форму заполняет реальная персона, а не какая-нибудь 

автоматическая спаминг-программа. Попросите собеседника набрать обычным шрифтом 

предложенный ему на экране текст, отображённый искривлёнными символами. Обычно в 

этом нет необходимости, если только вы не обнаружили, что получаете много спама. 

Информация 
Эта опция позволяет вам выбрать для отображения один из трёх типов 

информации: время ответа; Курс и/или Категорию, куда разместится Обратная Связь. 

 

Метка 
Подобно стандартной метке Moodle, данная опция позволяет добавить 

произвольный дополнительно объясняющий текст между двумя Вопросами, или разделить 

Обратную Связь на разделы. 

Удлинённый текстовый ответ 
Эта опция для создания текстового окошка (вы указываете, сколько в нём будет 

строк и колонок), в которое можно вписать длинный ответ. 

Множественный выбор – множество ответов 
Этот тип даёт вам серию опций с окошками-флажками около каждого. Респондент 

может отметить столько из них, сколько захочет, и в настоящее время нет способа 

ограничить этот выбор, кроме общего количества предоставленных опций. 

 

Множественный выбор – позволен один ответ из ниспадающего 
списка 

Эта опция предоставляет ниспадающий список, из которого только один ответ 

может быть выбран. 

Ниспадающий список (оцениваемый) 
Это похоже на опцию ниспадающего списка, но в нём каждый элемент имеет 

числовое значение, связанное с ним. Это означает, что если задаваемый Вопрос имеет 

следующий вид: 
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How much do you enjoy being in class? 

 I love it 

 I like it 

 I don't like it 

 I hate it 

it's not possible to (easily) get out an "average" score - particularly if you're 

asking the same question before and after an event or course. If the 

Dropdownlist (rated) option is used, then numerical values are associated 

with each option, allowing an average or other measurements of any 

responses. The above question might look like: 

How much do you enjoy being in class? 

 [4] I love it 

 [3] I like it 

 [2] I don't like it 

 [1] I hate it 

which might allow for an average (e.g. "3.5 this term, up from 2.9 last 

term") to be calculated. 

Numeric answer 
Here, you ask a question which must have a number as an answer and 

specify the acceptable range e.g. "How many arms would you like, if more 

than 2 were possible? (please specify 0-10)" with a range of 0-10 set in the 

options. It helps if you specify the acceptable range in the question text. 

 

Multiple choice – single answer 
This will give you a series of ratio buttons, which starts on 'Not selected' 

and then has your options afterwards. Only one can be chosen and 'Not 

selected' is a valid answer if the question is not set to 'required'. 

 

Multiple choice (Rated) 
This is similar to the other multiple choice options, except that each option 

has a numerical value associated with it. You have the choice of using 

radio buttons or a drop-down list to display the answers. 

For example: 

How much do you enjoy being in class? 

 I love it 

 I like it 

 I don't like it 

 I hate it 

 

Насколько вам нравится заниматься в классе? 

 Я люблю это 

 Мне нравится это 

 Мне не нравится это 

 Я ненавижу это, 

невозможно (легко) получить «среднюю» Оценку – особенно, если вы задаёте один и тот 

же вопрос до и после события или Курса. Если же используется опция «Dropdownlist 

(rated)», то числовым значениям, связанным с каждой опцией, позволяется усреднять или 

выполнять другие измерения любых ответов. Вышеприведённый Вопрос может иметь 

следующий вид: 

Насколько вам нравится заниматься в классе? 

 [4] Я люблю это 

 [3] Мне нравится это 

 [2] Мне не нравится это 

 [1] Я ненавижу это 

который может позволить определить среднее (например, «3,5 в этой четверти выше, чем 

2,9 – в прошлой четверти»). 

Числовой ответ 
Здесь вы задаёте Вопрос, который должен иметь числовой ответ, и указываете 

возможный диапазон чисел, например, «Сколько рук вам хотелось бы иметь, если бы 

можно было иметь их больше двух? (пожалуйста, укажите число от 0 до 10)» с областью 

0-10, установленной в каждой из опций. Неплохо, если вы укажете приемлемый диапазон 

в тексте Вопроса. 

Множественный выбор – единственный ответ 
Эта опция даёт вам серию кнопок соответствия, которая начинается с «Not selected 

(не выбрано)», и далее следуют варианты для выбора. Может быть выбран только один из 

них, а «Not selected» является правильным, только если Вопрос не установлен «Ответ 

требуется». 

Множественный выбор (Оцениваемый) 
Это похоже на другие опции множественного выбора, исключая то, что каждая 

опция имеет числовое значение, связанное с нею. Вы имеете выбор, использовать 

переключатели или ниспадающий список при отображения ответов. 

Например: 

Насколько вам нравится заниматься в классе? 

 Я люблю это 

 Мне нравится это 

 Мне не нравится это 

 Я ненавижу это 
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It's not possible to (easily) get out an "average" score - particularly if 

you're asking the same question before and after an event or course. If the 

Drop-down List (rated) option is used, then numerical values are 

associated with each option, allowing an average or other measurements of 

any responses. 

The above question might look like: 

How much do you enjoy being in class? 

 [5] I love it 

 [4] I like it 

 [3] Its OK 

 [2] I don't like it 

 [1] I hate it 

Which might allow for an average (e.g. "4.5 this term, up from 3.9 last 

term") to be calculated. 

Short Text Answer 
This option lets you specify a single line answer, with an input box which 

is a set number of characters long (you choose). You also specify the 

maximum number of characters you will accept, so that the answer is not 

too long and/or does not run over the length of the box on screen. 

4.3.6.2.3.See also 
Feedback Templates 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Невозможно (по крайней мере, легко) дать «среднюю» оценку – в частности, если 

вы задаёте один и тот же вопрос до и после события или Курса. Если же используется 

опция «Dropdownlist (rated) (ниспадающийсписок (оценённый))», то числовые значения 

связываются с каждой опцией, позволяя вычислять среднее или выполнять другие 

действия над ответами. 

Вышеприведённый Вопрос может выглядеть подобно следующему: 

Насколько вам нравится заниматься в классе? 

 [5] Я люблю это 

 [4] Мне нравится это 

 [3] Это хорошо 

 [2] Мне не нравится это 

 [1] Я ненавижу это 

Это может позволить вычислить среднее (например, «4,5 в этой четверти выше, 

чем 3,9 в прошлой четверти»). 

Краткий текстовый ответ 
Эта опция позволяет вам указать ответ одной строкой с входным окошком, в 

котором установлено определённое число символов (по вашему выбору). Вы также 

указываете максимальное число символов, которые вы примете, с тем чтобы этот ответ не 

был слишком длинен и/или не превышал длину окошка на экране. 

4.3.6.2.3.См. также 
Шаблоны ОбратнойСвязи. 

http://docs.moodle.org/25/en/Feedback_templates
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4.3.6.3.Using Feedback 
4.3.6.3.1.What the student sees 

 When first clicking on a feedback activity, the student will be presented 

with an entry page with description and link to the feedback questions 

 

 Clicking the link takes them to the feedback questions which they 

complete and then submit by clicking the "Submit your answers" 

button. 

 On submitting their responses, they will be directed to a particular URL 

or a "thank you" page whose message can be personalised in the 

Feedback_settings 

4.3.6.3.2.What the teacher sees 
Overview 
 When a feedback survey has been completed the teacher will see, via 

the Overview tab, the number of students who have responded so far: 

Screenshot «Course evoluation». 

Edit questions 
 The Edit Questions tab will allow them to tweak their questions 

 

Template 
 The Template tab allows them to save this particular survey's questions 

as a template for future use, or to use a template that has already been 

created. See Feedback_templates for more detailed information. 

 An administrator(or other user with system permissions) can save a 

template as "public" to allow it to be reused in different courses. A 

regular editing teacher does not have this capability. See Template 

creator for how to allow teachers the ability to save templates as 

"public" 

Screenshot «Saving feedback questions as "public"». 

Analysis 

 This screen shows a graphical summary of the results of each question, 

along with the option to download the results to Excel: 

Show responses 
 This screen allows for the teacher to see and then delete individual 

responses. (In the screenshot below the responses are anonymous) 

 

 

 

4.3.6.3.Использование Обратной Связи 
4.3.6.3.1.Что видит Студент 
 При щелчке по Интерактивному Действию «Обратная Связь» первый раз Студенту 

предоставляют входную страницу с описанием и ссылкой на 

Вопросы Студента Обратной Связи. 

 Щелчок по этой ссылке приведёт его к Вопросам Обратной Связи, на которые он 

должен ответить, и затем отослать щелчком по кнопке «Отправить готовые ответы на 

ваши вопросы». 

 После отправки своих ответов, они будут направлены по конкретному URL или на 

страницу «Благодарим вас», сообщение которой может быть персонифицировано в 

п. 4.3.6.1 «Настройки ОбратнойСвязи». 

4.3.6.3.2.Что видит Преподаватель 
Обзор 
 Когда опрос Обратной Связи завершён, Преподаватель увидит через итоговую таблицу 

число Студентов, которые ответили к настоящему времени: 

Снимок с экрана «Оценка Курса». 

Редактировать Вопросы 
 Таблица «Edit Questions (редактировать вопросы)» позволяет им корректировать их 

Вопросы. 

Шаблон 
 Таблица Template (шаблон) позволяет им сохранить эти конкретные Вопросы опроса в 

качестве Шаблона для будущего использования или использовать Шаблон, созданный 

раньше. Больше подробностей приведено в «Шаблоны Обратной Связи». 

 Администратор Сайта (или другой пользователь с системными полномочиями) может 

сохранить Шаблон как «публичный», чтобы позволить его повторно использовать в 

различных Курсах. Обычные Преподаватели не имеют такой возможности. См. в 

«Создатель Шаблонов» то, как предоставить Преподавателям возможность сохранять 

шаблоны как «публичные». 

Снимок с экрана «Сохранение вопросов Обратной Связи как «публичные»». 

Анализ 
Этот экран показывает графический итог результатов каждого Вопроса наряду с 

опцией скачивания этих результатов в Excel. 

Показать ответы 
 Этот экран позволяет Преподавателю увидеть и затем удалить индивидуальные ответы. 

На снимке с экрана – Анонимные Ответы. 

http://docs.moodle.org/25/en/Feedback_templates
http://docs.moodle.org/25/en/Template_creator
http://docs.moodle.org/25/en/Template_creator
http://docs.moodle.org/25/en/File:Feedbackstudententry.png
http://docs.moodle.org/25/en/File:Studentfeedbackquestions.png
http://docs.moodle.org/25/en/File:Studentfeedbackquestions.png
http://docs.moodle.org/25/en/File:Teachertabs.png
http://docs.moodle.org/25/en/Feedback_templates
http://docs.moodle.org/25/en/Template_creator
http://docs.moodle.org/25/en/File:publicfeedbacktemplate.png
http://docs.moodle.org/25/en/File:Analysis.png
http://docs.moodle.org/25/en/File:Showresponses.png.
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Show non-respondents 
Unless the responses are set to anonymous, there will also be a "Show non-

respondents" tab where the Teacher or Feedback activity administrator can 

select some or all users who have not yet completed the feedback and send 

them a reminder message. 

Note: users may be able to control when or how they receive this message, 

depending on the configuration of Messaging Outputs on your particular 

site. See here for details. 

4.3.6.3.3.Why use Feedback? 
 Apart from the obvious use here of evaluating a course, feedback 

surveys have a variety of uses, both within a course and for non-logged 

in users on the front page. The ability to set them as "anonymous" 

means also that sensitive issues can be surveyed without students 

worrying who might see their responses. Some ideas: 

Guest surveys 
Anonymously, on the front page, non-logged in users such as parents can 

be questioned on their opinions about, eg, the website design, school 

policies, school meals. 

Sign up! 

Guests can be invited to sign up for events/courses via the feedback 

module. 

Contact us 

Non-logged in users can use an instance of the feedback module as a 

"contact us" form. 

Anti-bullying surveys 

Students can be asked to highlight anonymously any incidences of 

bullying, along with their location and type. 

Making choices 

Students can select course modules or subjects they wish to study in a 

subsequent year/semester. The results can be exported and easily collated 

to match availability. 

Use of Moodle! 

Staff can be surveyed on which Moodle modules they use/would like more 

training in 

IT Skills audit 

Staff - or students - can be surveyed to discover their IT skills and 

weaknesses to highlight training needs. 

 

 

 

Показать не давших ответы 
Если не установлены анонимные ответы, тогда будет показана таблица «Unless the 

responses», где Преподаватель или Администратор Интерактивного Действия 

Обратная Связь могут выбрать некоторых или всех пользователей, которые ещё не 

предоставили Обратную Связь, и послать им напоминающее сообщение. 

Замечание: пользователи могут управлять тем, когда и как они получат это 

сообщение, в зависимости от конфигурации «Messaging Outputs (передача сообщений о 

результатах)». Подробности см. подробности, а также снимок. 

4.3.6.3.3.Почему используют Обратную Связь? 
 Кроме очевидного использования для оценивания Курса опросы Обратной Связи 

имеют различное применение как внутри Курса, так и для незарегистрированных 

пользователей на Главной Странице. Возможность придать им статус «анонимных» 

означает также, что могут задаваться деликатные Вопросы без опасения Студентов, что 

кто-то увидит их ответы. Некоторые идеи: 

Опросы Гостей 

В анонимном режиме могут быть заданы Вопросы не зарегистрированным на 

Главной Странице пользователям, таким как родители, например, о том, каковы, по их 

мнению, дизайн Сайта, политика школы, школьное питание. 

Зарегистрируйтесь! 

Гости могут быть приглашены записаться на события/Курсы через модуль 

«Обратная Связь». 

Свяжитесь с нами 

Не зарегистрированные пользователи могут использовать экземпляр модуля 

«Обратная Связь», такой как форма «Свяжитесь с нами». 

Опросы против травли однокурсниками 

Студентов можно попросить анонимно сообщать о любых хулиганских 

происшествиях с указанием места и вида. 

Совершение выбора 

Студенты могут выбрать модули Курса или предметы, которые они желают 

изучать в следующем году/семестре. Результаты могут быть экспортированы и легко 

сопоставлены для согласования доступности. 

Использлвание Moodle! 
Персонал может быть опрошен по теме, какие модули Moodle они используют, по 

каким хотели бы пройти лучшую подготовку. 

Проверка навыков в информационных технологиях 

Персонал или Студенты могут быть опрошены с целью выявления их навыков в 

информационных технологиях и слабых мест, чтобы выявить необходимость повышения 

квалификации. 

http://docs.moodle.org/25/en/Messaging_settings#List_of_message_types
http://docs.moodle.org/25/en/Messaging_settings#List_of_message_types
http://docs.moodle.org/25/en/File:feeback-non-respondents-25.png
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4.3.6.3.4.See also 
 Student feedback captured within Moodle blog post with video 

 

4.3.6.4.Feedback FAQ 
4.3.6.4.1.How can I allow non-logged in users to 
give feedback? 
 As an adminstrator, go to Settings>Site 

Administration>Plugins>Activity Modules>Feedback. 

 Change "Allow full anonymous" to "yes" 

 Note that this only works for the front page, and NOT for courses with 

guest access. 

Screenshot «Feedback». 

4.3.6.4.2.How do I create a Feedback activity and 
add questions? 
 From the Add an activity... drop down, select Feedback. 

 Complete the Name, Description, and other options then save. 

 To add questions to your Feedback activity, click the link for the 

feedback activity, click the Edit questions tab, and add questions. 

 

4.3.6.4.3.How can a teacher make a feedback 
template public for use elsewhere? 
 See Template creator 

4.3.6.4.4.I do not see the Edit Questions tab. What 
should I do? 
 This does happen sometimes. Usually, logging out of the course and 

then logging back in will take care of this problem. 

4.3.6.4.5.See also 
 Using Moodle Feedback module forum 

 The Feedback module is disabled by default. 

 The long term plan is to replace Feedback with a new module 

combining the best of Questionnaire, Feedback and Survey. 

See Development:Survey 2 brainstorm 

4.3.6.5.See also 
Feedback block. 

 

 

4.3.6.3.4.См. также 
Сообщение блога с видео «Обратная связь Студента, почерпнутая изнутри 

Moodle». 

4.3.6.4.Часто задаваемые вопросы по Обратной Связи 
4.3.6.4.1.Как можно разрешить не зарегистрированным 
пользователям давать Обратную Связь? 
 Как Администратор Сайта перейдите в 

AdministrationSite AdministrationPluginsActivity ModulesFeedback. 

 Измените «Allow full anonymous (разрешить полную анонимность)» на «Yes». 

 Заметьте, что это работает только для Главной Страницы, а НЕ для Курсов с доступом 

Гостя. 

Снимок с экрана «Обратная Связь». 

4.3.6.4.2.Как создать Интерактивное Действие 
«Обратная Связь» и добавить Вопросы? 
 Из ниспадающего меню «Add an activity...» выберите Feedback (обратная связь). 

 Заполните Name, Description и другие опции, а затем сохраните. 

 Чтобы добавить Вопросы в ваше Интерактивное Действие «Обратная Связь», щёлкните 

ссылку для этого Интерактивного Действия Обратная Связь, щёлкните вкладку «Edit 

questions (редактировать вопросы)» и добавьте Вопросы. 

4.3.6.4.3.Как Преподаватель может создать публичный 
Шаблон для использования в другом месте? 
 См. «Создатель шаблонов». 

4.3.6.4.4.Я не вижу таблицы «Редактировать Вопросы». Что 
делать? 
 Это иногда случается. Обычно, разрегистрирование из Курса, а затем регистрирование 

обратно убирает эту проблему. 

4.3.6.4.5.См. также 
 Использование Moodle. Форум «Модуль «ОбратнаяСвязь»». 

 Модуль «Обратная Связь» по умолчанию заблокирован. 

 В долговременных планах – заменить Обратную Связь модулем, комбинирующим 

лучшее от Опросника, Обратной Связи и Опроса. См. «Развитие: Мозговой штурм по 

Опросу 2». 

4.3.6.5.См. также 
Блок Обратной Связи. 

http://wodongatafe.wordpress.com/2011/03/09/student-feedback-captured-within-moodle/
http://docs.moodle.org/25/en/Template_creator
http://docs.moodle.org/en/Development:Survey_2_brainstorm
http://wodongatafe.wordpress.com/2011/03/09/student-feedback-captured-within-moodle/
http://wodongatafe.wordpress.com/2011/03/09/student-feedback-captured-within-moodle/
http://docs.moodle.org/25/en/File:Anonymousfeedback.png
http://docs.moodle.org/25/en/Template_creator
https://moodle.org/mod/forum/view.php?id=7152
http://docs.moodle.org/dev/Survey_2_brainstorm
http://docs.moodle.org/dev/Survey_2_brainstorm
http://docs.moodle.org/25/en/Feedback_block


 

119 

4.3.7.Forum 
Allows participants to have asynchronous discussions 

Forum module 
The forum module is an activity where students and teachers can exchange 

ideas by posting comments. There are four basic forum types. Forum posts 

can be graded by the teacher or other students. 

 

Screenshot. 

A forum can contribute significantly to successful communication and 

community building in an online environment. You can use forums for 

many innovative purposes in educational settings, but teaching forums and 

student forums are arguably the two more significant distinctions. 

4.3.7.1.Forum settings 
4.3.7.1.1.Adding and editing a forum 
1. With the editing turned on, in the section you wish to add your forum, 

click the "Add an activity or resource" link (or, if not present, the "Add 

an activity" drop down menu )and choose Forum. 

 

2. This will take you to the forum settings page titled "Adding a new 

forum". 

You can access an existing forum by clicking the configure icon or 

clicking on the forum and then Administration > Forum administration > 

Edit settings. 

4.3.7.1.2.General 
Screenshot «The General settings, expanded by default.». 

Forum name 
A short name of the forum (e.g. "Favourite colour"), which will be 

displayed on the course homepage. 

Description 
Provide instructions for your students here so they are clear what they have 

to do. Click "Show editing tools" to display the rich text editor and drag the 

bottom right of the text box out to expand it. 

 

 

 

 

 

 

4.3.7.Форум 
Позволяет Участникам Курса проводить асинхронные обсуждения. 

Модуль «Форум» 
Модуль «Форум» является Интерактивным Действием, где Студенты и 

Преподаватели могут обмениваться идеями посредством посылки комментариев. 

Существует четыре основных типа Форумов. Корреспонденции Форумов могут быть 

оценены Преподавателем или Студентами. 

Снимок с экрана: «Простой Форум». 

Форум может внести значительный вклад в успешную коммуникацию и создание 

сообществ в онлайн среде. Форумы можно использовать для многих новаторских целей в 

образовательных мероприятиях, но Форумы Преподавателей и Форумы Студентов, 

вероятно, имеют наибольшее значение. 

4.3.7.1.Настройки Форума 
4.3.7.1.1.Добавление и редактирование Форума 
1. При включённом режиме редактировании, в Разделе, в который вы хотите добавить 

Форум, щёлкните ссылку «Add an activity or resource (добавить ИнтерактивноеДействие 

или Ресурс)» (или, если она не присутствует, ниспадающее меню «Add an activity 

(Добавить Интерактивное  Действие)») и выберите «Forum». 

2. Это приведёт вас на страницу настроек Форума, озаглавленную «Adding a new forum 

(добавление нового Форума)». 

Вы можете посетить существующий Форум щелчком по иконке «Configure» или 

щелчком на этот Форум и затем AdministrationForum administrationEdit settings. 

 

4.3.7.1.2.Обычные настройки 
Снимок с экрана: «Общие настройки, развёрнутые по умолчанию». 

Наименование Форума 
Краткое наименование Форума (например, «Любимый цвет»), которое будет 

отображено на домашней странице Курса. 

Описание 
Эта опция – для предоставления инструкций для ваших Студентов так, чтобы они 

ясно представляли себе, что они должны делать. Щёлкните «Show editing tools (показать 

инструменты редактирования»), чтобы отобразить полный текстовый редактор и 

перетащите нижний правый угол текстового окошка, чтобы расширить его. 

http://docs.moodle.org/25/en/File:Forumexample.png
http://docs.moodle.org/25/en/File:forumgeneral25.png
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Display description on course page 
Enabling this will display the description on the course page just below the 

link to the forum. 

Forum type 
There are five forum types to choose from: 

 A single simple discussion - A single topic discussion developed on one 

page, which is useful for short focused discussions (cannot be used with 

separate groups) 

 Standard forum for general use - An open forum where anyone can start 

a new topic at any time; this is the best general-purpose forum 

 

 Each person posts one discussion - Each person can post exactly one 

new discussion topic (everyone can reply to them though); this is useful 

when you want each student to start a discussion about, say, their 

reflections on the week's topic, and everyone else responds to these 

 Q and A Forum - Instead of initiating discussions participants pose a 

question in the initial post of a discussion. Students may reply with an 

answer, but they will not see the replies of other Students to the 

question in that discussion until they have themselves replied to the 

same discussion. 

 Standard forum displayed in a blog-like format 

Note: News forum is a special type of forum that is automatically created 

with a new course. 

4.3.7.1.3. Attachments and word count 
Screenshot «Attachments and word count settings expanded». 

Maximum attachment size 
The maximum file size that may be attached to a forum post will first be 

determined by the Moodle site settings. The teacher may want a smaller 

size limit for the forum. Server file capacity, student downloading speeds 

and discouraging images in a document centered discussion are a few 

reasons to limit file size. 

 

 

 

 

 

 

 

 

Отобразить описание на странице Курса 
Применив эту опцию, вы отобразите описание на странице Курса сразу под 

ссылкой на этот Форум. 

Тип Форума 
Существует пять типов Форумов на выбор: 

 Одноразовая простая дискуссия – обсуждение единственной темы, развиваемое на 

одной странице; это полезно для проведения коротких узконаправленных обсуждений 

(не может быть использовано раздельными Группами). 

 Стандартный Форум для общего пользования – открытый Форум, на котором 

каждый в любое время может поднять новую тему, это лучшая форма для дискуссий на 

общие темы. 

 Каждый представляет одно суждение – Участник может представить на обсуждение 

только одну тему (но откликнуться на неё может каждый); это полезно, когда вы 

хотите, чтобы каждый Студент представил на обсуждение, скажем, его мнение по теме 

недели, а остальные отреагировали на это мнение. 

 Форум Q и A (вопрос – ответ) – Перед развёртыванием дискуссии, участники вначале 

ставят конкретный вопрос для обсуждения. Студенты могут принять участие в 

дискуссии, но они не увидят откликов других Студентов на этот вопрос до тех пор, 

пока сами не ответят на него. 

 

 Стандартный Форум, отображаемый в формате, подобном блогу. 

Замечание: Форум с новостями – это специальный тип Форума, который создаётся 

автоматически в новом Курсе. 

4.3.7.1.3.Присоединения и подсчёт слов 
Снимок с экрана «Развёрнутые настройки присоединений и подсчёта слов». 

Максимальный размер присоединения 
Максимальный размер файла, который может быть присоединён к 

корреспонденции Форума, – изначально определён настройками Сайта Moodle. 

Преподаватель может захотеть уменьшить предельный размер для данного Форума. 

Файловая ёмкость сервера, скорости скачивания у Студентов, устрашающий объём 

информации в главном обсуждаемом документе, – таковы лишь некоторые из причин 

ограничить размер файла. 

http://docs.moodle.org/25/en/News_forum
http://docs.moodle.org/25/en/File:attachmentsandwordcount.png
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Maximum number of attachments 
The maximum number of attachments a user can add to their forum post 

(from 0 to 100) can be specified here. 

Display word count New feature in Moodle 2.5! 

If "Display word count" is enabled, then the number of words in forum 

posts will be shown at the bottom of each post. 

4.3.7.1.4.Subscription and tracking 
Screenshot « Subscription and tracking settings expanded». 

Subscription mode 
When a user is subscribed to a forum it means that they will receive 

notification (via popup and/or email, depending on the user’s messaging 

settings preferences) of each new posting. By default, posts are recorded 

about 30 minutes after the post was first written. Depending upon the email 

settings of each forum member, they may be sent an email immediately 

after the 30 minute edit window is closed, or in a batch at a time fixed by 

the site administrator (see below). 

People can usually choose whether or not they want to be subscribed to 

each forum. However, the teacher can choose to force subscription on a 

particular forum then all course users will be subscribed automatically, 

even those that enroll at a later time. 

There are 4 subscription mode options: 
 Optional subscription - Participants can choose whether to be 

subscribed 

 Forced subscription - Everyone is subscribed and cannot unsubscribe 

 Auto subscription - Everyone is subscribed initially but can choose to 

unsubscribe at any time 

 Subscription disabled - Subscriptions are not allowed. 

The subscription mode and subscribe or unsubscribe links appear in 

Navigation>Forum administration when viewing the forum. Teachers can 

quickly change the mode via the 'Subscription mode' options and view the 

current subscribers via the 'Show/edit current subscribers' link. 

 

Tips: 
Forcing everyone to subscribe is especially useful in the news forum and in 

forums towards the beginning of the course (before everyone has worked 

out that they can subscribe to these emails themselves). 

Changing the setting from "Yes, initially" to "No" will not unsubscribe 

existing users; it will only affect those who enrol in the course in the 

 

Максимальное число присоединений 
Здесь может быть определено максимальное (от 0 до 100) число присоединений, 

которые пользователь может добавить в своих корреспонденциях на Форум. 

Отобразить подсчёт слов           Новое средство в Moodle 2.5! 
Если включена опция «Display word count (отобразить подсчёт слов)», то число 

слов в корреспонденциях Форума будет показано внизу каждой корреспонденции. 

4.3.7.1.4.Подписка и слежение 
Снимок с экрана «Развёрнутые настройки по подписке и слежению». 

Режим подписки 
Когда пользователь подписывается на Форум, это означает, что он будет получать 

извещение о каждой новой корреспонденции (через высвечивание на экране и/или 

электронную почту, в зависимости от предпочтения пользователя). По умолчанию 

корреспонденции записываются в пределах 30 минут после их отправки. В зависимости от 

настроек электронной почты каждого члена Форума, корреспонденция ему может быть 

отправлена сразу после закрытия 30-минутного окна редактирования, или в пакете во 

время, установленное Администратором Сайта (см. ниже). 

Обычно можно выбирать, подписываться ли на все Форумы. Однако, 

Преподаватель может выбрать обязательную подписку на конкретный Форум, и тогда все 

пользователи Курса будут подписаны автоматически, даже те, которые зачислятся 

позднее. 

Существуют 4 опции режима подписки: 
 Подписка по желанию – участники могут выбрать, подписываться или нет. 

 

 Принудительная подписка – каждый подписывается в обязательном порядке. 

 Авто-подписка – Первоначально подписывается каждый, но может в любое время 

отказаться от подписки. 

 Подписка отключена – подписки не разрешены. 

Режим подписки и ссылки «подписаться» и «не подписаться» появляются в 

навигации по управлению Форумом при просмотре Форума. Преподаватели могут быстро 

изменить режим посредством опции «Subscription mode (режим подписки)» и просмотреть 

перечень подписавшихся посредством ссылки «Show/edit current 

subscribers (показать/отредактировать подписки)». 

Советы: 
Принуждение подписываться каждого особенно полезно для Форума новостей и 

для Форумов в начале Курса (до того, как каждый решил, что он сам может подписаться 

на них). 

Изменение настройки с «предварительного Yes» на «No» не отменит подписку 

пользователей текущего Курса; это сработает только для тех, кто зачислится на 

http://docs.moodle.org/25/en/File:subscriptionandtracking.png
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future. Similarly changing "Yes, initially" will not subscribe existing 

course users but only those enrolling later. 

There is also a "Subscriptions not allowed" setting which prevents Students 

from subscribing to a Forum. Teachers may choose to subscribe to a forum 

if they wish. 

Read tracking for this forum? 
"Read tracking" for a forum allows users to track read and unread forum 

posts. 

Screenshot «Don't track unread posts link». 

There are three options for this setting: 

 Optional (default) - Students can turn tracking on or off for the forum 

via a link 'Track / Don't track unread posts' in Administration > Forum 

administration 

 

 On - Tracking is always on in this forum (so no link in Administration 

> Forum administration) 

 Off - It is not possible to track unread forum posts 

 

Note: The first two options require users to also have forum tracking set to 

yes in their profile settings. Currently the forum tracking profile setting 

overrides the read tracking forum setting. This problem has been reported 

in the tracker as MDL-29663. 

4.3.7.1.5.RSS 
(This setting is collapsed by default and will only appear if RSS has been 

enabled sitewide and for forums) 

Screenshot «RSS settings expanded». 

RSS feed for this activity 
This turns RSS on or off for this forum. When set to “None,” RSS is 

disabled. When set to “Discussions,” the RSS feed will send out new 

discussions to subscribers. When set to “Posts,” the RSS feed will send out 

any new posts to subscribers. 

 

Number of RSS recent articles 
This number sets the number of articles that go out via RSS. If this number 

is set to 5, then the 5 most recent articles will be sent to subscribers. As 

new posts (or discussions) get added, the oldest post/discussion gets 

replaced on the RSS feed. If your forum gets a lot of posts every day, you 

will want to set this number high. 

 

будущий Курс. И изменение «No» на «изначальное Yes» не подпишет пользователей 

существующего Курса, но повлияет только на тех, кто зачисляется позднее. 

Существует также настройка «Subscriptions not allowed (подписки не 

разрешаются)», которая не позволяет Студентам подписаться на Форум. Преподаватели 

могут выбрать подписку на Форум, если пожелают. 

Прочитывать результаты отслеживания для этого Форума? 
«Read tracking» (прочитывать отслеживание) для Форума позволяет пользователям 

отслеживать прочитанные и не прочитанные корреспонденции. 

Снимок с экрана «Ссылка на не отслеживать непрочитанные корреспонденции». 

У этой настройки есть три опции: 

 Optional (по выбору – задана по умолчанию) – Студенты могут включить или 

выключить отслеживание для данного Форума посредством ссылки «Track/Don't track 

unread posts (отслеживать/не отслеживать непрочитанные корреспонденции)» в 

AdministrationForum administration. 

 On (включено) – Всегда отслеживать корреспонденцию на этом Форуме (так что нет 

ссылки в AdministrationForum administration). 

 Off (отключено) – отслеживать непрочитанную корреспонденцию на этом Форуме 

невозможно. 

Замечание: Первые две опции требуют от пользователей установить в «Yes» 

отслеживание на этом Форуме в настройках их Профилей. В настоящее время настройка 

Профиля отслеживания Форума перекрывает настройку Форума по отслеживанию 

прочитанного. Эта проблема сообщалась в средстве отслеживания как MDL-29663. 

4.3.7.1.5.RSS 
(Эта настройка по умолчанию свёрнута и появится, если только RSS-рассылка 

разрешена для Форумов на всём Сайте). 

Снимок с экрана «Развёрнутые настройки RSS». 

RSS-рассылка для данного интерактивного действия 
Эта настройка включает или отключает RSS для этого Форума. Когда установлена 

на «None», RSS невозможна. Когда установлена на «Discussions (обсуждения)», будет 

выполнена RSS-рассылка новые обсуждения для подписчиков. Когда установлена на 

«Posts (корреспонденции)», RSS-рассылка будет выполняться для новых корреспонденций 

подписчикам Форума. 

Число последних статей RSS 
Это число устанавливает число статей, которые проходят через RSS. Если это 

число установлено в 5, тогда 5 самых последних статей будет разослано подписчикам. По 

мере поступления новых корреспонденций (или обсуждений), более старые 

корреспонденции/обсуждения будут заменены в RSS-рассылке. Если ваш Форум каждый 

день получает много корреспонденций, вы захотите увеличить это число. 

http://docs.moodle.org/25/en/File:forum_administration.png
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The administrative cron (admin/cron.php) must run after the forum is 

created and posts or discussions have been made. Otherwise the user will 

receive an error "Error reading RSS data" 

 

4.3.7.1.6.Post threshold for blocking 
Screenshot «Post threshold for blocking settings expanded». 

 

Time period for blocking  
Choose here the time period in which can be blocked from posting more 

than a given number of posts. (To make a user exempt, give them the 

capability mod/forum:postwithoutthrottling) 

 

Post threshold for blocking 
Set the number of posts here that users may add before they are blocked. 

 

Post threshold for warning 
Set the number of posts here after which users will be warned they are 

about to be blocked. 

4.3.7.1.7.Grade 
(This setting is collapsed by default) Choose the category in which this 

forum will appear if ratings are enabled. 

4.3.7.1.8.Ratings 
(This setting is collapsed by default) 

Screenshot «Ratings settings expanded». 

Roles with permissions to rate 
Forum posts can be rated using a scale. By default, only teachers can rate 

forum posts, though students can be given permission to do so if desired 

(see Forum permissions below). This is a useful tool for giving students 

participation grades. Any ratings given in the forum are recorded in the 

gradebook. 

 

Aggregate type 
You can set an aggregate type, in other words, decide how all the ratings 

given to posts in a forum are combined to form the final grade (for each 

post and for the whole forum activity). Some scales do not lend themselves 

to certain types of aggregates. 

 

 

Административный Хрон (admin/cron.php) должен осуществлять рассылку после 

запуска Форума и создания корреспонденций или обсуждений. В противном случае 

пользователь получит сообщение об ошибке «Error reading RSS data (ошибка при чтении 

данных RSS)». 

4.3.7.1.6.Пороговая величина для блокирования почты 
Снимок с экрана «Развёрнутые настройки пороговой величины для блокирования 

почты». 

Временной период для блокирования 
Эта опция позволяет выбрать интервал времени, в течение которого можно 

заблокировать отправку пользователем  почтовых сообщений больше заданного их числа. 

(Чтобы сделать пользователю исключение, дайте ему эту привилегию через Возможность 

mod/forum:postwithoutthrottling). 

Пороговое число для блокирования корреспонденций 
Эта опция устанавливает число корреспонденций, которое пользователи могут 

отправить на Форум, прежде чем их заблокируют. 

Пороговая величина для предупреждения о блокировке почты 
Здесь установите число корреспонденций, после которого пользователи будут 

предупреждены, что их заблокируют. 

4.3.7.1.7.Оценка 
(Эта настройка по умолчанию свёрнута). Выберите Категорию, к которой будет 

отнесён этот Форум, если разрешены Рейтинги. 

4.3.7.1.8.Рейтинги 
(Эта настройка по умолчанию свёрнута). Снимок с экрана «Развёрнутые Настройки 

Рейтингов». 

Роли с Полномочиями оценивать 
Корреспонденции Форума могут быть ранжированы с использованием Шкалы (см. 

п. 6.2.6 в разделе «Приложения»). По умолчанию только Преподаватели могут их 

оценивать, хотя, если нужно, и Студентам могут быть даны Полномочия делать это (см. 

Полномочия Форума ниже). Это полезный инструмент для оценивания их активности как 

Участников Форума. Все Оценки, данные в Форуме, заносятся в Журнал Оценок (см. п. 

6.2.1 в «Приложения»). 

Тип Агрегирования 
Вы можете установить тип Агрегирования, другими словами, решить как все 

Рейтинги, данные корреспонденциям в Форуме, комбинируются в форму 

Итоговой Оценки (за каждую корреспонденцию и за работу на Форуме в целом). 

Некоторые Шкалы годятся не для всякого типа Агрегирования. 

http://docs.moodle.org/25/en/File:postthresholdforblocking.png
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There are five options: 

 Average of ratings (default) - This is the mean of all the ratings given to 

posts in that forum. It is especially useful with peer grading when there 

are a lot of ratings being made. 

 Count of ratings - The counts the number of rated posts which becomes 

the final grade. This is useful when the number of posts is important. 

Note that the total can not exceed the maximum grade allowed for the 

forum. A count may be used if the teacher simply wants to 

acknowledge that a reply was given in the case students being required 

to make a certain number of posts in the discussion. Note: Count of 

ratings does not work for the "Separate or Connected Ways of 

Knowing" scale or custom scales due to the limitation imposed by the 

max grade. 

 Maximum rating - The highest rating is returned as the final grade. This 

method is useful for emphasising the best work from participants, 

allowing them to post one high-quality post as well as a number of 

more casual responses to others. 

 Minimum rating - The smallest rating is returned as the final grade. 

This method promotes a culture of high quality for all posts. 

 

 Sum of ratings - All the ratings for a particular user are added together. 

Note that the total is not allowed to exceed the maximum grade for the 

forum. Note: Sum of ratings does not work for the "Separate or 

Connected Ways of Knowing" scale or custom scales due to the 

limitation imposed by the max grade. 

Restrict ratings to items with dates in this range 
The teacher can allow only posts within a certain date range to be rated. 

This is useful if the teacher wants to keep students focused on the most 

recent content and maintain a specific pace within the forum or course. 

 

Number of RSS recent articles 
This number sets the number of articles that go out via RSS. If this number 

is set to 5, then the 5 most recent articles will be sent to subscribers. As 

new posts (or discussions) get added, the oldest post/discussion gets 

replaced on the RSS feed. If your forum gets a lot of posts every day, you 

will want to set this number high. 

The administrative cron (admin/cron.php) must run after the forum is 

created and posts or discussions have been made. Otherwise the user will 

receive an error "Error reading RSS data" 

Существует пять опций: 

 Средний из Рейтингов (по умолчанию) – то есть вычисляется средняя величина из 

всех Рейтингов. данных корреспонденциям этого Форума. Это особенно полезно при 

ранжировванием сокурсниками друг друга, когда его делается много. 

 Подсчёт Рейтингов – подсчитывается число положительно ранжированных 

корреспонденций, что и становится Итоговой Оценкой. Это полезно, когда важна доля 

таких корреспонденций. Отметьте, что сумма не может превышать максимальную для 

этого Форума Оценку. Подсчёт можно использовать, если Преподаватель просто хочет 

отметить, что отклик был дан в случае, когда от Студентов требовалось создать 

определённое число корреспонденций в этом обсуждении. Замечание: Подсчёт 

Рейтингов не работает в случае Шкалы «Отдельные или связанные способы осознания» 

или в случае Пользовательских Шкал из-за ограничения на Максимальную Оценку. 

 

 Максимальный Рейтинг – наивысший Рейтинг принимается в качестве 

Итоговой Оценки. Этот метод полезен для акцентирования внимания на лучшем из 

ответов Участников, позволяя предоставить ему одну высококачественную 

корреспонденцию наряду с более слабыми ответами  на другие Вопросы. 

 Минимальный Рейтинг – В качестве Итоговой Оценки принимается наименьший из 

рейтингов. Этот метод стимулирует стремление к высокому качеству всех 

корреспонденций. 

 Сумма Рейтингов – Все Рейтинги для конкретного пользователя суммируются. 

Заметьте, что сумма не должна превышать Максимальную Оценку для этого Форума. 

Замечание: Суммирование Рейтингов не работает в случае Шкалы «Отдельных или 

связанных способов осознания» или Пользовательских Шкал из-за ограничения на 

Максимальную Оценку. 

Ограничить Рейтинги элементам с датами в заданном интервале 
Преподаватель может решить ранжировать корреспонденции только внутри 

определённой области дат. Это полезно, если Преподаватель хочет держать Студентов 

сфокусированными на наиболее недавнем содержимом и сохранять определённый темп 

работы внутри этого Форума или Курса. 

Число недавних статей, рассылаемых по RSS 
Это число устанавливает количество статей, рассылаемых по RSS. Если это число 

установить равным 5, то подписчикам будет отправлено 5 наиболее недавних статей по 

мере поступления новых корреспонденций (или обсуждений), более старые 

корреспонденции/обсуждения будут заменены в этой RSS-рассылке. Если ваш Форум 

получает много корреспонденций каждый день, вы захотите увеличить это число. 

Административный Хрон (admin/cron.php) должен запускаться после завершения 

корреспонденций или обсуждений и закрытия Форума. В противном случае пользователь 

получит сообщение об ошибке «Error reading RSS data (ошибка при чтении данных RSS)». 
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Note: RSS feeds must be enabled for the site and for forums in order for 

the RSS settings to appear. 

4.3.7.1.9.Common module settings 
 (These settings are collapsed by default) 

Screenshot «Common module settings expanded». 

See Common module settings for more information, but note the details 

below relating specifically to use of forums with groups. 

Group mode 
The group mode setting has three options: 

1. No groups 

2. Separate groups - each group can only see their own group; others are 

invisible 

3. Visible groups - each group works in their own group, but can also see 

other groups 

If the group mode is set to separate groups: 

Screenshot «Adding a new discussion topic to a forum set to separate 

groups». 

 Teachers are given the option of adding a new discussion topic for all 

participants or for a selected group. If a teacher adds a new discussion 

topic for a selected group, then only group members can reply to it. If a 

teacher adds a new discussion topic for all participants, then students 

can't reply to it. (This is to ensure that groups are kept separate.) 

 

 Students can only start discussions for their own group. 

 Students can only reply to discussions started by other group members 

or discussions for their own group started by a teacher. 

If the group mode is set to visible groups: 

 Teachers are given the option of adding a new discussion topic for all 

participants or for a selected group. If a teacher adds a new discussion 

topic for a selected group, then only group members can reply to it. 

 

 Students can only start discussions for their own group. 

 Students can only reply to discussions started by other group members 

or teachers. 

Teachers, and other users with the capability moodle/site:accessallgroups 

set to allow, can view and post in all forum discussions, regardless of the 

group mode setting. 

 

 

Замечание: Для появления настроек RSS, должны быть активированы RSS-

рассылки для Сайта и для Форумов. 

4.3.7.1.9.Общие настройки модуля 
(Эти настройки по умолчанию свёрнуты). Рисунок с экрана «Развёрнутые Общие 

настройки модуля». 

Дополнительную информацию ищите в п. 6.1, но отметьте приведённые ниже 

детали, специфические для использования Форумов с Группами. 

Групповой Режим 
Настройка Группового Режима имеет три опции: 

1. No groups (нет групп). 

2. Separate groups (обособленные группы) – каждая Группа может видеть только свою 

собственную Группу; другие не видимы. 

3. Visible groups (видимые группы) – каждая Группа работает в своей собственной 

Группе, но может также видеть другие Группы. 

Если Групповой Режим установлен в Separate groups: 

Рисунок с экрана «Добавление новой темы обсуждения на Форум, установленный 

в «Обособленные Группы». 

 Преподавателям предоставлена возможность добавления новой темы обсуждения для 

всех Участников или для выбранной Группы. Если Преподаватель добавляет новую 

тему обсуждения для выбранной Группы, тогда только члены Группы могут отвечать 

на неё. Если Преподаватель добавляет новую тему обсуждения для всех Участников, 

тогда Студенты не могут на неё ответить. (Это гарантирует сохранность 

обособленности Групп.) 

 Студенты могут начать обсуждения только для своей собственной Группы. 

 Студенты могут отвечать только на суждения, начатые членами другой Группы, или на 

обсуждения своей собственной Группы, начатые Преподавателем. 

Если Групповой Режим установлен в Visible groups: 

 Преподавателям предоставлена возможность добавления новой темы обсуждения для 

всех Участников или для выбранной Группы. Если Преподаватель добавляет новую 

тему обсуждения для выбранной Группы, тогда только члены Группы могут отвечать 

на неё. 

 Студенты могут начать обсуждения только для своей собственной Группы. 

 Студенты могут отвечать только на суждения, начатые членами другой Группы или 

Преподавателями. 

Преподаватели и другие пользователи с установленной в Allow Возможностью 

moodle/site:accessallgroup), могут просматривать и отправлять корреспонденции во все 

обсуждения Форума, не взирая на настройку Группового Режима. 
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Note: Single simple discussions cannot be set to separate groups (as this 

feature is not implemented). Instead, a standard forum should be used, with 

the teacher copying and pasting the same discussion topic for each separate 

group. If required, a permissions override may be set to prevent students 

from starting new discussions. 

4.3.7.1.10.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.3.7.1.11.Locally assigned roles 
In Administration > Forum administration > Locally assigned roles 

selected users can be given additional roles in the activity. 

 

Forum moderator 
A student can be given the rights to moderate a forum by assigning them 

the role of non-editing teacher in the forum. 

In Settings > Forum administration > Locally assigned roles click on 

student 

Select the student from the potential users list on the right, and use the Add 

button to add them to the existing users list on the left. Multiple users may 

be selected by holding down the Apple or Ctrl key whilst clicking on the 

users' names. 
 

See also Forum moderator role. 

4.3.7.1.12.Forum permissions 
Role permissions for the activity can be changed in Administration > 

Forum administration > Permissions. 

 

 

 

 

 

Common permissions changes include: 

 

Enabling students to rate posts 
Click the Allow icon (+) opposite the capability to rate posts and allow the 

role of student. 

 

 

 

Замечание: Одиночные простые обсуждения не могут быть установлены для 

Обособленных Групп (так как это средство не реализовано). Вместо этого следует 

использовать стандартный Форум, где Преподаватель копирует и вставляет одну и ту же 

тему обсуждения в каждую обособленную группу. Если требуется, можно установить 

Полномочия, предотвращающие начинания новых обсуждений Студентами. 

4.3.7.1.10.Ограничить Доступ/Завершение Действия 
Эти настройки видимы, если Обусловленные Действия и завершение Действия 

разрешены на Сайте и в Курсе. 

4.3.7.1.11.Локально назначаемые Роли 
В AdministrationForum administrationLocally assigned roles выберите 

пользователей, которым могут быть даны дополнительные Роли в этом 

Интерактивном Действии. 

Модератор Форума 
Студенту могут быть даны права модерировать Форум путём назначения ему Роли 

не-редактирующего Преподавателя на этом Форуме. 

В AdministrationForum administrationLocally assigned roles щёлкните по Student. 

 

Выберите конкретных Студентов из Potential users list (список потенциальных 

пользователей) справа и используйте кнопку Add, чтобы добавить их в Existing users list 

(список существующих пользователей) слева. Можно выбрать сразу несколько 

пользователей, удерживая нажатой клавишу Ctrl во время щёлканья по именам 

пользователей.  

См. также Роль модератора Форума. 

4.3.7.1.12.Полномочия Форума 
Полномочия Роли могут быть изменены в: 

AdministrationForum administrationPermissions. 

 

 

 

 
 

Общие изменения Полномочий 

включают: 

Разрешение Студентам оценивать корреспонденции 
Щёлкните иконку (+) Allow (разрешить) напротив Возможности Rate posts 

(оценивать корреспонденции) и предоставьте её Роли Студента. 

http://docs.moodle.org/25/en/Conditional_activities
http://docs.moodle.org/25/en/Activity_completion
http://docs.moodle.org/25/en/Forum_moderator_role
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Archiving a forum 
A forum can be closed / archived so that students may no longer start new 

discussions, nor add replies, but can still read all the discussions by 

clicking the Prevent icon (X) for the student role for the capabilities 'Start 

new discussions' and 'Reply to posts'. 

Guests and posting in a forum 
There are certain things, such as posting in a forum, that guests are never 

allowed to do, despite the permissions interface suggesting otherwise. 

 

The guest role has some special functionality, for example when a guest 

user attempts to post in a forum, they obtain the message "Sorry, guests are 

not allowed to post. Would you like to log in now with a full user 

account?" 

(Note: If guests don't obtain the "Sorry, guests are not allowed to post" 

message because they have no reply link, then self enrolment needs 

enabling in Settings > Course administration > Users > Enrolment 

methods.) 

If you wish guests to be able to post in a forum, you can create a similar 

role, say "visitor" with very few permissions allowed, then create an 

account and assign it the role of visitor. Guests can then share this visitor 

account. 

4.3.7.1.13.User administration settings 
Users can choose whether or not to track unread posts in their profile 

settings under 'Forum tracking'. The settings are: 

 Yes: highlight new posts for me 

 No: don't keep track of posts I have seen 

If the user chooses 'Yes: highlight new posts for me' and the forum 

administrator has set the 'Read tracking for this forum?' to On or Optional 

then the user will have new posts highlighted for them. The posts will be 

highlighted in the following places: 

 My home page 

 Course page 

 Within the forum itself 

 In forum discussion threads 

Screenshot «Show unread on forum page». 

4.3.7.1.14.Site administration settings 
The forum module has additional settings which may be changed by an 

administrator in Administration > Site administration > Plugins > Activity 

modules > Forum and, for 'Maximum time to edit posts', in 

Архивирование Форума 
Форум может быть Закрыт/Заархивирован так, что Студенты не смогут больше ни 

начать новые обсуждения, ни добавить ответы, но всё ещё смогут читать все обсуждения, 

если щёлкнуть по иконке (Х) Prevent (не допустить) для Роли Студента для Возможностей 

Start new discussions (начать новые обсуждения) и Reply to posts (отвечать на сообщения). 

Гости и отправка корреспонденций на Форуме 
Существуют определённые вещи, такие как отправка сообщений на Форум, 

которые Гостям не разрешается делать, несмотря на интерфейс Полномочий, содержащий 

иное. 

Роль Гостя имеет специальную функциональность, например, когда пользователь-

Гость пытается послать сообщение на Форум, он получает сообщение «Простите, Гостям 

не разрешается отправлять сообщения на Форум. Не желаете ли зарегистрироваться 

сейчас с полной учётной записью пользователя?» 

(Замечание: Если Гости не получают этого сообщения, потому что у них нет 

ссылки для ответа, то самозачисление нужно разрешить в 

AdministrationCourse administrationUsers Enrolment methods.) 

 

Если вы хотите, чтобы Гости могли отправлять сообщения на Форум, вы можете 

создать похожую роль, скажем, «Посетитель» с очень небольшим числом разрешённых 

Полномочий, а затем создайте учётную запись и назначьте ей Роль Посетителя. После 

этого Гости смогут совместно использовать эту учётную запись Посетителя. 

4.3.7.1.13.Настройки управления пользователем 
Пользователи могут выбрать, отслеживать или нет непрочитанные сообщения в 

настройках их профиля под заголовком «Forum tracking (отслеживания Форума)»:  

 Yes: подсвечивать новые сообщения для меня. 

 No: не продолжать отслеживание сообщений, которые я просмотрел. 

Если пользователь выбрал Yes, а Администратор Форума установил «Read tracking 

for this forum? (читать отслеживание для этого Форума?)» в On (включить) или в Optional 

(по выбору), то пользователь будет получать новые сообщения подсвеченными. 

Сообщения будут подсвечиваться в следующих местах: 

 My home page (моя домашняя страница). 

 Course page (страница Курса). 

 Within the forum itself (внутри самого Форума) 

 In forum discussion threads (по ходу обсуждений в Форуме). 

Рисунок с экрана «Показать не прочитанное на странице Форума». 

4.3.7.1.14.Настройки управления Сайтом 
Модуль «Форум» имеет дополнительные настройки, которые могут быть изменены 

Администратором в AdministrationSite administrationPlugins Activity modulesForum  

и «Maximum time to edit post (максимальное время на редактирование сообщений)» в 

http://docs.moodle.org/25/en/File:MoodleDocs_forum_show_unread_behaviour.png
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Administration > Site administration > Security > Site policies. 

Use email address in reply 
By default, a user's email is set as the 'From' address for forum 

notifications (unless the user has hidden their email address in their profile) 

so that recipients can choose to reply personally rather than via the forum. 

To set noreply@yourmoodlesite.org as 'From' address for all forum 

notification emails, untick the forum_replytouser checkbox. 

Long and short posts 
The long and short post setting determine how forum posts on the site front 

page, social format course pages, and user profiles are displayed. (Note: 

There is currently an unresolved issue - "Site news - forum length setting 

has no effect for certain users" - MDL-4781.) 

 

Enabling timed posts 
Timed forum posts may be enabled i.e. having the option to set a display 

start and end date for a new discussion. Timed posts can then be created by 

users with the capability to view hidden timed posts (normally admins and 

teachers). 

 

Maximum time to edit posts 
This specifies the amount of time people have to re-edit forum postings, 

glossary comments etc. Usually 30 minutes is a good value. The setting 

may be changed by an administrator in Administration > Site 

administration > Security > Site policies. 

Mark post read after 'X' days 
This setting is forum_oldpostdays and specifies the number of days after 

which any post is considered to be read. E.g. If this is set to 14 days then 

any post older than 14 days will be considered read. If you set this to 0 

then ALL posts are instantly considered to be read. If you don't want any 

posts to be considered read without the user reading them then set a high 

figure (e.g. 1000) 

4.3.7.2. Using Forum 
The teacher can set the format of what the student sees under the 

introduction by selecting the forum type in Forum settings. 

4.3.7.2.1.Views 
A single simple discussion 
Students will see the text you have placed in the Forum introduction setting 

as the first post of the discussion. Below you will find 

AdministrationSite administrationSecurity Site policies. 

Используйте адрес э-почты в ответе 
По умолчанию электронная почта пользователя установлена как адрес «From (от)» 

для извещений Форума (если только пользователь не скрыл адрес своей почты в своём 

профиле), так что получатели могут выбрать, получать ли ответ персонально или через 

Форум. Чтобы установить noreply@yourmoodlesite.org как адрес «From» для всех почтовых 

извещений Форума, уберите птичку в окошке-флажке forum_replytouser. 

Длинные и короткие почтовые сообщения 
Длинные и короткие почтовые сообщения определяют, как Форум отправляет 

почтовые сообщения на Главную Страницу Сайта, страницы Курса социального формата, 

и как отображаются пользовательские профили. (Замечание: В настоящее время есть 

нерешённый вопрос – «Новости Сайта – настройка длины Форума не действует для 

определённых пользователей» – MDL-4781.) 

Разрешение спланированных по времени сообщений 
Могут быть разрешены спланированные по времени сообщения Форума, 

поскольку есть опция, устанавливающая дату начала и конца обсуждения. Затем 

спланированные по времени сообщения могут создаваться пользователями (обычно 

Администраторами и Преподавателями) с правом просматривать скрытые 

спланированные по времени сообщения.  

Максимальное время для редактирования сообщений 
Эта опция позволяет задать количество времени на повторное редактирование 

сообщений на Форуме, комментариев Глоссария и т.д. Обычно 30 мин – хорошее 

значение. Эта настройка может быть изменена Администратором в 

AdministrationSite administrationSecurity Site policies. 

Пометить сообщение, читаемое по прошествии «Х» дней 
Эта настройка – forum_oldpostdays – указывает число дней, после которых любое 

почтовое сообщение является подлежащим прочтению. Например, если она установлена в 

14 дней, то любое сообщение старше 14 дней будет считаться читаемым. Если вы 

установите эту настройку в 0, то ВСЕ сообщения могут читаться немедленно. Если вы 

хотите, чтобы любые сообщения читались только после прочтения их пользователем, 

установите большое число (например, 1000). 

4.3.7.2.Применение Форума 
Преподаватель, выбрав тип Форума в настройках Форума, может установить 

формат того, что Студент увидит под Введением. 

4.3.7.2.1.Представления Форума 
Одиночная простая дискуссия 

Студенты увидят текст, который вы разместили в настройке введения в Форум в 

качестве начального сообщения для обсуждения. Ниже вы будете находить 

mailto:noreply@yourmoodlesite.org
http://tracker.moodle.org/browse/MDL-4781
http://docs.moodle.org/25/en/Adding/editing_a_forum#Forum_introduction
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the replies that have been posted. In the example below, the student sees 

that their reply was rated. 

Screenshot «Student view of "A single simple discussion" forum type». 

Each person posts one discussion 
The view will be basically the same as in the previous case, the only 

difference being the 'Add a new discussion' option. Viewing a forum page, 

the student will see the text you have written at the 'Forum introduction' 

space while creating the forum, and, if there are any, the discussions that 

have been started. 

Screenshot «Student view of "Each person posts one discussion" forum 

type». 

Standard forum for general use 
In this forum type, students will see the introduction text in a separate 

space above the discussion field, in which you will see the information 

such as the title of the discussion (which means the forum's title), its 

author, the number of replies and the date of the last post. 

Screenshot «Student view of "Standard forum" type». 

Question and Answer forum 
The Q & A forum is best used when you have a particular question that 

you wish to have answered. In a Q and A forum, teachers post the question 

and students respond with possible answers. By default a Q and A forum 

requires students to post once before viewing other students' postings. 

More details here 

Screenshot «Inital view of Q&A forum». 

Screenshot «Students cannot see posts until they post». 

Screenshot «Other posts visible when editing time is over». 

 

Standard forum displayed in blog-like format 
Screenshot «Blog like forum». 

In the upper right corner of the home forum screen (above the 

introduction), the student may see the options the teacher has set 

for subscriptions to the forum, and the 'Jump to' field, with which you can 

'jump' to any part of the course. This is also place where the teacher will 

find the "Update this forum" button. 

4.3.7.2.2.Display options 
A discussion thread may be displayed in four ways. Use the pull down 

menu at the top of each forum discussion to select a display type. 

 

 

отправленные ответы. В примере ниже Студент видит, что его ответ оценён. 

 

Снимок с экрана «Вид Студентом форума типа «Одиночная простая дискуссия»». 

Каждый человек отправляет одно суждение 
Вид будет в основном таким же, как и в предыдущем случае, с единственным 

отличием – опцией «Add a new discussion (добавить новое суждение)». Просматривая 

страницу Форума Студент увидит текст, который вы написали в качестве введения в 

Форум при создании Форума, и обсуждения, которые начаты, если они есть. 

 

Снимок с экрана «Вид Студентом Форума типа «Каждый человек отправляет одно 

суждение»»». 

Стандартный Форум для обычного использования 
В этом типе Форума Студенты увидят текст введения в отдельном месте, выше 

поля обсуждения, в котором вы увидите информацию, такую как заголовок дискуссии 

(который обозначает название Форума), его автора, число ответов и дату последнего 

сообщения. 

Снимок с экрана «Вид Студентом Форума типа «Стандартный Форум»». 

Форум типа «Вопрос–Ответ» 
Форум «Вопрос-Ответ» лучше использовать, когда вы имеет конкретный Вопрос, 

на который хотите получить ответ. В Форуме «Вопрос-Ответ» Преподаватели отправляют 

Вопрос, а Студенты шлют возможные ответы. По умолчанию Форум «Вопрос-Ответ» 

требует от Студентов отправки ответа до просмотра ответов других Студентов. Больше 

информации здесь. 

Снимок с экрана «Начальный вид Форума «Вопрос-Ответ»». 

Снимок с экрана «Студенты не могут видеть сообщений, пока не отошлют своё». 

Снимок с экрана «Другие сообщения видимы после окончания времени 

редактирования». 

Стандартный Форум в формате, подобном Блогу 
Снимок с экрана «Форум, подобный Блогу». 

В правом верхнем углу домашнего экрана Форума (выше введения) Студент может 

увидеть опции, которые Преподаватель установил для подписки на Форума и поле 

«Перейти к», с которого вы можете «перепрыгнуть» в любую часть Курса. Это также 

место, где Преподаватель найдёт кнопку «Update this forum (обновить этот Форум)». 

 

4.3.7.2.2.Опции отображения 
Поток сообщений обсуждения может быть отображён четырьмя способами. 

Используйте ниспадающее меню в верхней части каждого обсуждения Форума, чтобы 

выбрать тип отображения. 

http://docs.moodle.org/25/en/Adding/editing_a_forum#Force_everyone_to_be_subscribed.3F
http://docs.moodle.org/25/en/File:Forum_homepage_view_Simple_student_mu.png
http://docs.moodle.org/25/en/File:Forum_homepage_view_Single_student_mu.png
http://docs.moodle.org/25/en/File:Forum_homepage_view_Single_student_mu.png
http://docs.moodle.org/25/en/File:Forum_homepage_view_student_mu.png
http://docs.moodle.org/25/en/Using_Forum#Question_and_Answer_forum_2
http://docs.moodle.org/25/en/Using_Forum#Question_and_Answer_forum_2
http://docs.moodle.org/25/en/File:QA1.png
http://docs.moodle.org/25/en/File:QA2.png)
http://docs.moodle.org/25/en/File:QA3.png
http://docs.moodle.org/25/en/File:QA3.png
http://docs.moodle.org/25/en/File:Bloglikeforum.png
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Screenshot «Reply display options». 

 Display replies flat, with oldest first 

 Display replies flat, with newest first - The discussion will be displayed 

in one line and the chronological order from the newest to the oldest. 

This is the same as the above, just a different sort order. 

 Display replies in threaded form - Only the post starting the discussion 

will be displayed in its full form; replies will be reduced to the 

headlines (including information about its author and date of release) 

and organized chronologically; moreover, replies will be shifted 

towards the right so that only replies to the same post were in the same 

line. 

 Display replies in nested form - All posts are displayed in their full 

forms; replies will be reduced to the headlines (including information 

about its author and date of release) and organized chronologically; 

moreover, replies will be shifted towards the right so that only replies to 

the same post were in the same line. 

Screenshot "Flat Forum discussion, example from middle" 

 

Screenshot "Posts in threaded form" 

Screenshot "Nested reply example" 

4.3.7.2.3.Forum posting 
The default content of Subject is usually 'Re: <the name of the 'parent' 

post>'. You can change it though. 

When writing text in Moodle there are several formats you can choose to 

produce your text, depending on your expertise and the type of browser 

you are using. Please refer to Formatting text for further information. 

 

Sharing images through forums 
 When an image is "attached" as a file to a forum message, it is 

immediately displayed full size after the message (i.e. no need to click 

on an attachment). This an excellent way of sharing images without 

having to go through the process of uploading them as files and linking 

them from within web pages. 

Images may be dragged and dropped into the box as well as uploading via 

the "add" link and the File picker. 

Screenshot "Forumdragdrop". 

 

 

 

Снимок с экрана «Опции отображения ответа». 

 Отображать ответы подряд, начиная со старейших. 

 Отображать ответы подряд, с наиболее новыми вначале – суждения будут отображаться 

по очереди в хронологическом порядке от новейших к старейшим. Это то же, что и 

выше, только с другим типом порядка перечисления. 

 Отображать ответы в отфильтрованном виде – только сообщение, начинающее 

обсуждение, будет отображено в его полной форме; ответы будут сокращены до 

заголовков (включающих информацию о его авторе и дате выпуска) и организованы 

хронологически; более того, ответы будут смещены вправо так, что на одной линии 

будут ответы только на одно и то же сообщение. 

 

 Отображать ответы в гнездовой (иерархически вложенной) форме – все сообщения 

отображаются в их полных формах; ответы будут сокращены до заголовков 

(включающих информацию о его авторе и дате выпуска) и организованы 

хронологически; более того, ответы будут смещены вправо так, что на одной линии 

будут ответы только на одно и то же сообщение. 

Снимок с экрана «Пороядковое представление обсуждения Форума, пример из 

середины». 

Снимок с экрана «Сообщения в отфильтрованном виде», 

Снимок с экрана «Пример вложенных ответов». 

4.3.7.2.3.Отправка сообщений Форума 
По умолчанию содержимое Предмета обычно такое: «Re: <имя 'родителя' 

сообщения>». Хотя вы можете изменить это представление. 

При записи текста в Moodle существует несколько форматов, которые вы можете 

выбрать для образования вашего текста в зависимости от вашего опыта и типа браузера, 

который вы используете. За дальнейшей информацией обращайтесь, пожалуйста, к 

«Форматирование текста». 

Совместное использование изображений внутри Форумов 
 Когда изображение «прикрепляется» как файл к сообщению Форума, оно немедленно 

отображается в полный размер после этого сообщения (т.е. нет нужды щёлкать по 

прикреплению). Это отличный способ расположения изображений без прохождения 

процесса пересылки их как файлов и связывания их внутри веб-страниц. 

 

 Изображения могут быть захвачены и перетащены в окошко, а также загружены с 

помощью ссылки «Add (добавить)» и файлового меню». 

Снимок с экрана. 

http://docs.moodle.org/25/en/File:forumviewoptions.jpg
http://docs.moodle.org/25/en/File:Forum_Flat_form_mu.png
http://docs.moodle.org/25/en/File:Forum_Flat_form_mu.png
http://docs.moodle.org/25/en/File:Forum_threaded_form_mu.png
http://docs.moodle.org/25/en/File:Forum_nested_form_mu.png
http://docs.moodle.org/25/en/Formatting_text
http://docs.moodle.org/25/en/File_picker
http://docs.moodle.org/25/en/File:forumdragdrop.png


 

131 

Sharing sound and video through forums 
 If multimedia filters are enabled, a sound file (mp3) or accepted video 

file can be attached and it will be embedded into the forum post in an 

appropriate player. 

 As with images in the previous section, multimedia files may be 

dragged and dropped from the desktop instead of uploaded via the File 

picker. 

Post length 
Extra-long posts cause problems when doing a forum search and can be 

difficult to read on screen. Rather than creating a very long post, consider 

copying and pasting the text into a text file and add it as an attachment to 

your forum post. 

Post editing time limit 
There is a time limit for editing posts, usually 30 minutes. It is set by an 

administrator in Administration > Security > Site policies. 

The Using Moodle forum discussion The philosophy underlying "no 

editing after 30 minutes" includes reasons why it is a good idea to have a 

time limit for editing posts. 

Mail now 
A mail now checkbox is available for anyone with the capability to manage 

course activities, normally teachers and admins. 

 

Checking the "Mail now" box results in a notification being sent 

immediately (i.e. when the cron next runs) to everyone subscribed to the 

forum, rather than after the post editing time limit. 

Note: For users who have enabled email digests in their profile, the 

notification is NOT sent separately from other forum post notifications. 

4.3.7.2.4.Exporting forum posts 
Users with the mod/forum:exportdiscussion or mod/forum:exportownpost 

or mod/forum:exportpost permission can export forum posts to any 

portfolio the administrator has enabled: 

Screenshot. 

4.3.7.2.5.Moving a discussion 
Teachers and other users with the capability to move discussions can move 

a discussion to any other forum in the course for which they have 

appropriate rights. 

1. Click on the arrow in the 'Move this discussion to...' dropdown menu in 

the top right corner of the page and select a destination forum. 

2. Click the Move button. 

Совместное использование аудио и видео внутри Форумов 
 Если разрешены фильтры мультимедиа, то можно прикреплять звуковой файл (mp3) 

или общепринятый видео-файл, и он будет встроен в сообщение Форума в 

соответствующем проигрывателе. 

 Как и с изображениями в предыдущем разделе, мультимедиа-файлы могут быть 

отбуксированы с рабочего стола, вместо пересылки через файловое меню. 

 

Длина сообщения 
Сверхдлинные сообщения создают проблемы при выполнении поиска в Форуме и 

их трудно читать на экране. Вместо создания очень длинного сообщения, рассмотрите 

копирование и вклеивание этого текста в текстовый файл, и прикрепление этого файла к 

вашему сообщению на Форуме. 

Ограничение времени редактирования сообщений 
Вводится ограничение по времени для редактирования сообщений, обычно 30 

минутами. Это устанавливается Администратором в AdministrationSecuritySite policies. 

Причины, по которым хороша идея иметь ограничение по времени для 

редактирования сообщений, обсуждены при рассмотрении на Форуме «Использование 

Moodle» принципа «не редактировать более 30 минут». 

Почта в настоящий момент 
Окошко-флажок «Mail now» доступно для всех обладателей Возможности 

управлять Интерактивными Действиями Курса, обычно это Преподаватели и 

Администраторы. 

Отметка «галочкой» окошка-флажка «Mail now» ведёт к немедленной отправке 

извещения (точнее, когда очередной раз Хрон запустится) каждому подписанному на этот 

Форум, а не после истечения срока редактирования сообщения. 

Замечание: Для пользователей, которым в их профиле разрешены дайджесты по 

почте, это извещение НЕ посылается отдельно от других почтовых извещений Форума. 

4.3.7.2.4.Экспортирование сообщений Форума 
Пользователи с полномочием mod/forum:exportdiscussion или 

mod/forum:exportownpost, или mod/forum:exportpost могут экспортировать сообщения 

Форума в любой разрешённый Администратором Портфель. 

Снимок с экрана. 

4.3.7.2.5.Перемещение обсуждения 
Преподаватели и другие пользователи с Возможностью перемещать обсуждения 

могут переместить обсуждение на любой другой Форум в Курсе, для которого они имеют 

соответствующие права. 

1. Щёлкните по стрелочке «Move this discussion to... (переместить это обсуждение в…)» в 

ниспадающем меню в верхнем правом углу страницы и выберите Форум назначения. 

2. Щёлкните кнопку «Move». 

http://docs.moodle.org/25/en/Site_policies
http://docs.moodle.org/25/en/Site_policies
http://moodle.org/mod/forum/discuss.php?d=5367
http://docs.moodle.org/25/en/Capabilities/moodle/course:manageactivities
http://docs.moodle.org/25/en/Capabilities/moodle/course:manageactivities
http://docs.moodle.org/25/en/File:Exportforum.png
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NOTE: Moving a forum post will display incorrect results in the course 

participation report for the affected forums. For example, take a student 

who posted in forum A and had their post moved to forum B. In the course 

participation report the student will still be listed has having made a post in 

forum A, but will not be listed as having made a post yet in forum B. 

 

4.3.7.2.6.Guidelines for Teaching and Learning 
Forums 
When you decide to use a discussion forum as an activity in an e-learning 

environment, it is important to be aware that your time will be needed in 

some sense in order to make the activity successful. If your goal is to 

encourage discussion, the forum will only work if: 

a) participants feel there is a need/reason to participate and they will 

gain something from the experience. Incentives for learning, gathering 

support, etc. should be explored and encouraged early on in order to clearly 

convey the purpose of the forum to others. Anyone considering offering 

grades or marks for participation is advised to think very carefully about 

the difference between quantity and quality of discussions in forums. 

b) a sense of community and purpose can be fostered amongst participants. 

This sense of community can be fostered through tutor/teacher initiative 

and scaffolding, or primarily through the students/participants themselves 

depending on the intentions of the activity. 

4.3.7.2.7.Selecting forum type 
Moodle has four kinds of forums each with a slightly different layout and 

purpose. 

Which of the forums will best suit your needs for a particular activity? In 

order to answer this question, it is useful to think how you might lead such 

a discussion in a face-to-face environment. Would you throw the question 

out to the class and sit back to observe them in their answers? Or would 

you break them up into smaller groups first and ask them to have 

discussions with a partner before bringing them back to the main group? 

Or perhaps you would like to keep them focused on a particular aspect of a 

question and ensure that they do not wander away from the topic at hand? 

All of the above approaches are both valid and useful, depending on your 

learning outcomes, and you can replicate all of them in Moodle forums. 

 

 

 

 

ЗАМЕЧАНИЕ: Перемещение сообщения Форума будет отображать в отчёте по 

участию в Курсе неправильные результаты о желательных Форумах. Например, возьмём 

Студента, который отослал сообщение на Форум А, и его сообщение переместили на 

Форум Б. В отчёте по участникам Курса этот Студент всё ещё будет числиться как 

сделавший сообщение в Форум А, но не будет считаться сделавшим сообщение ещё и в 

Форум Б. 

4.3.7.2.6.Рекомендации по использованию Форумов 
Преподавателями и Студентами 

Когда вы решаете применить Форум обсуждения как Интерактивное Действие в 

среде интернет-образования, важно помнить, что ваше время потребуется в некотором 

смысле для того, чтобы сделать это Интерактивное Действие успешным. Если ваша цель 

состоит в поощрении дискуссии, Форум сработает, только если: 

a) Участники чувствуют, что существует необходимость/причина участвовать, и что 

они что-то получат от этого опыта. Стимулы к изучению, обретение поддержки и т.п. 

должны быть нащупаны быстро и поощрены, чтобы ясно донести до всех цели Форума. 

Каждому, кому предстоит ставить Оценки или баллы за участие, следует посоветовать 

очень тщательно продумать разницу между количественными и качественными 

характеристиками  обсуждений в Форумах. 

b) среди Участников возникнет чувство общей целеустремлённости. Это чувство 

содружества может быть создано через инициативу и поддержку 

наставника/Преподавателя, но главным образом самими Студентами/Участниками, с 

опорой на цели данного Интерактивного Действия. 

4.3.7.2.7.Выбор типа Форума 
Moodle имеет четыре вида Форумов, каждый с несколько отличающейся 

компоновкой и целью. 

Какой из Форумов будет лучше соответствовать вашим потребностям в ходе 

конкретной деятельности? Для того, чтобы ответить на этот вопрос, полезно подумать о 

том, как бы вы вели такое обсуждение при личном общении. Вы бы подкинули вопрос 

классу и стали бы просто наблюдать, как они отвечают? Или вы сначала разбили бы их на 

маленькие Группы и попросили бы их обсудить вопрос с партнёрами, прежде чем вновь 

собрать их в основную Группу? Или, может быть, вы предпочли бы сосредоточить их 

внимание на конкретном аспекте Вопроса, и постараться, чтобы они не отклонялись от 

данной им темы? Каждый из перечисленных выше подходов правилен и полезен в 

зависимости от ваших образовательных целей, и вы можете каждый из них 

воспроизводить в Форумах Moodle. 
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A standard forum for general use 
The standard forum probably most useful for large discussions that you 

intend to monitor/guide or for social forums that are student led. This does 

not mean that you need to make a new posting for each reply in each topic, 

although, in order to ensure that the discussion does not get 'out of control', 

you may need to be prepared to spend a significant amount of time finding 

the common threads amongst the various discussions and weaving them 

together. Providing overall remarks for particular topics can also be a key 

aspect of your responsibilities in the discussion. Alternatively, you could 

ask students to summarize discussion topics at agreed points, once a week 

or when a thread comes to an agreed conclusion. Such a learner-centred 

approach may be particularly useful once the online community has been 

established and, perhaps, when you have modeled the summarizing 

process. 

A single simple discussion 
The simple forum is most useful for short/time-limited discussion on a 

single subject or topic. This kind of forum is very productive if you are 

interested in keeping students focused on a particular issue. 

Each person posts one discussion 
This forum is most useful when you want to achieve a happy medium 

between a large discussion and a short and focused discussion. A single 

discussion topic per person allows students a little more freedom than a 

single discussion forum, but not as much as a standard forum where each 

student can create as many topics as he or she wishes. Successful forums of 

this selection can be active, yet focused, as students are not limited in the 

number of times they can respond to others within threads. 

 

Question and Answer forum 
The Q & A forum is best used when you have a particular question that 

you wish to have answered. In a Q and A forum, tutors post the question 

and students respond with possible answers. By default a Q and A forum 

requires students to post once before viewing other students' postings. 

After the initial posting and once the editing time (usually 30 minutes) has 

elapsed, students can view and respond to others' postings. This feature 

allows equal initial posting opportunity among all students, thus 

encouraging original and independent thinking. 

 

Note: Students do not see the "add a new question" button in the Q & A 

forum. If you wish students to be able 

Стандартный Форум для общего применения 
Стандартный Форум, вероятно, наиболее полезен для широких дискуссий, которые 

намерены направлять вы, или для социальных Форумов, которые ведут Студенты. Это не 

означает, что вам потребуется отправлять новое сообщение на каждый ответ по каждой 

теме, хотя, для того чтобы гарантировать, что обсуждение не выйдет из под контроля, вам 

может понадобиться затратить значительное количество времени на нахождение общих 

нитей в потоке различных суждений и сплетение их воедино. Подведение итоговых 

замечаний по конкретным темам может также быть ключевым аспектом вашей 

ответственности за дискуссию. А с другой стороны, вы можете попросить Студентов 

время от времени подытоживать темы обсуждения, раз в неделю или когда ход 

рассуждений придёт к согласованному заключению. Такой сконцентрированный на 

обучающихся подход может быть особенно полезен, когда онлайн-сообщество 

сформировалось и, может быть, когда вы уже отшлифовали процесс подытоживания. 

 

Одиночное простое обсуждение 
Простой Форум наиболее полезен для краткого/ограниченного временем 

обсуждения по отдельному предмету или теме. Форум этого рода очень продуктивен, если 

вы хотите сосредоточить внимание Студентов на конкретном Вопросе. 

Каждый отправляет только одно суждение 
Этот Форум наиболее полезен, когда вы хотите достичь счастливой середины 

между широкой дискуссией и кратким сфокусированным обсуждением. Отдельная тема на 

каждого человека предоставляет Студентам несколько больше свободы, чем Форум 

единого обсуждения, но не так много, как стандартный Форум, где каждый Студент может 

выдвигать столько тем, сколько он или она пожелает. Успешные форумы этого выбора 

могут быть активны, но всё же сфокусированы, так как Студенты не ограничены в 

количестве раз, которое они могут отвечать другим в развитие тех или иных тем, 

возникших в ходе обсуждений. 

Форум «Вопрос и Ответ» 
Форум «Вопрос и Ответ» лучше использовать, когда у вас есть конкретный вопрос, 

на который хотите получить ответ. В Форуме «Вопрос и Ответ» Преподаватели 

отправляют вопрос, а Студенты отвечают возможными ответами. По умолчанию Форум 

«Вопрос и Ответ» требует от Студентов отправить свой Ответ перед тем, как он сможет 

просмотреть Ответы других Студентов. После начальной отправки сообщения и как 

только закончится время редактирования (обычно 30 минут), Студент может просмотреть 

и ответить на сообщения других. Это средство предоставляет равные шансы для  

начальной отправки всем Студентам, поощряя таким образом оригинальное и независимое 

мышление. 

Замечание: Студенты не видят кнопку «Add a new question (добавить новый 

вопрос)» в Форуме Вопрос и Ответ. Если вы желаете, чтобы Студенты были способны 
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to add new questions, they need to be given the capability 

mod/forum:addquestion 

Standard forum displayed in blog-like format 
This forum behaves in the same way as the default standard forum for 

general use, allowing users to start their own discussions. However, it 

displays differently in that the first post of each discussion is displayed (as 

in a blog) so that users can read it and then choose to respond by clicking 

the "Discuss this topic" button bottom right of the post. 

 

Tips for Question and Answer 
When the Question and Answer mode is selected, Moodle hides the replies 

to the initial thread post by the teacher but not the entire forum itself. 

Tip: Post each question as a thread in the forum and then have students 

post replies to the question. In this fashion, Moodle will protect the 

replies from being viewable (subject to the caveat above) by other 

students but allow the initial post/thread visible for reply by all students. 

 

Tip: Do not post the question in the forum summary because every 

student answer will become a thread and visible to all students. In this 

scenario, it may appear as if the Question and Answer forum is not 

working correctly, since the new initial posts in the thread are 

intentionally designed not to be hidden, just their replies. 

 

Tip: If you have set up groups for your forum the facilitator needs to 

post a question to each of the groups and not to 'all participants' as 

questions asked of all participants (students) are able to be read by ALL 

students. Questions posed to group members are only visible to those 

group members and replies are only visible once a group member has 

posted a message. 

4.3.7.2.8.Forum subscription 
When a person is subscribed to a forum it means that they will be notified 

(according to their Messaging settings preferences) of every subsequent 

post in that forum. Posters have 30 minutes by default to edit their post 

before it is sent though this time limit can be changed by an administrator. 

 

People can usually choose whether or not they want to be subscribed to 

each forum. However, if a teacher forces subscription on a particular forum 

then this choice is taken away and everyone in the class will get notified. 

This is especially useful in the News forum and in forums towards the 

beginning of the course (before everyone has worked out that they can 

добавлять новые Вопросы, им необходимо предоставить Возможность 

mod/forum:addquestion. 

Стандартный Форум в формате блога 
Этот Форум ведёт себя также, как и по умолчанию стандартный Форум общего 

применения, позволяя пользователям начинать их собственные суждения. Однако 

отображает он по-другому в том, что первое сообщение каждого обсуждения 

отображается (как в блоге) так, что пользователи могут прочитать его, и затем сделать 

выбор своего Ответа, щелчком по кнопке «Discuss this topic (обсудить эту тему)» в правом 

нижнем углу сообщения. 

Советы для Вопроса и Ответа 
Когда выбран режим Вопроса и Ответа, Moodle скрывает ответы на отправку 

начального сообщения Преподавателем, но не остальные Ответы на всём Форуме. 

Совет: Отправляйте каждый Вопрос как «направляющую нить» рассуждений в этом 

Форуме, и пусть Студенты затем отправляют Ответы на этот Вопрос. При таком образе 

действий Moodle защитит Ответы от просматривания (повод для совета выше) другими 

Студентами, но позволит всем Студентам видеть начальное сообщение/нить сообщений 

для Ответа. 

Совет: Не отправляйте Вопрос в сводку по Форуму, потому что ответ каждого 

Студента станет нитью сообщений и видим всем Студентам. В этом сценарии он может 

появиться как если бы Форум «Вопрос и Ответ» не работал корректно, поскольку 

новые начальные сообщения в этом потоке умышленно конструируются так, чтобы не 

быть скрытыми, а только Ответы на них. 

 

Совет: Если вы распределили по группам для вашего Форума, методисту нужно 

отправлять Вопрос каждой Группе, а не «All participants (всем Участникам)», так как 

вопросы, задаваемые всем Участникам (Студентам), способны прочитать ВСЕ 

Студенты. Вопросы, адресованные членам Группы, видны членам этих Групп, а Ответы 

видны только когда член Группы отправит сообщение. 

 

4.3.7.2.8.Подписка на Форум 
Когда человек подписан на Форум, это означает, что он будет извещён (в 

соответствии с его предпочтениями настроек отправки сообщений) о каждом 

последующем сообщении в этом Форуме. Отправители имеют 30 минут по умолчанию, 

чтобы отредактировать своё сообщение перед тем, как оно будет отослано, хотя это 

ограничение по времени может быть изменено Администратором. 

Обычно люди могут выбирать, хотят ли они быть подписаны на каждый Форум. 

Однако, если Преподаватель объявляет подписку на конкретный Форум обязательной, то 

этого выбора нет, и каждый в классе будет подписан. Это особенно полезно в Форуме 

новостей и в Форумах в начале Курса (до того, как каждый решит, что он может  

http://docs.moodle.org/25/en/Messaging_settings
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 subscribe to these emails themselves). 

Note that even if you force subscriptions every user can elect not to be 

notified in Messaging settings, or elect to have all email sent once a day in 

a digest contain either all posts or simply the subject headings. 

 

Choosing Everyone can choose to be subscribed enables you to check (and 

modify) the number of subscribers (Settings > Forum administration > 

Show/edit current subscribers) and to subscribe to (or unsubscribe from) 

the forum ('Subscribe to this forum' / 'Unsubscribe from this forum'). 

An overview of your forum subscriptions is available on the forums index 

page e.g. http://moodle.org/mod/forum/index.php?id=5. 

4.3.7.2.9.Concepts for use in forums 
Participation and Scaffolding 
Whilst one of the great advantages of e-learning is the flexibility it affords 

participants, this does not mean that days or weeks should pass without 

response and discussion in a forum (unless it is appropriate for it to do so). 

This is perhaps most especially true at the beginning of a course or 

programme when students and tutors are new to each other and in need of 

welcome messages/encouragement. Whilst e-learning, and discussions in 

particular, can support learning that is not always tutor/teacher-centred, 

your role will be important, especially as an online community begins to 

develop. It is during these initial stages of introductory material that a 

group of students can become a community of participants who begin to 

grow in their understandings of course material and individual 

contributions to the knowledge construction process. 

As the discussions progress and learners become accustomed to the 

mechanics and the tone of the forums then there are key ways in which 

your input can be reduced, thereby helping to foster a community that is 

less dependent on the tutor/teacher. Even then, however, you will probably 

want to be a presence in the discussions although you may choose to be 

one of many contributors rather than the font of all wisdom. 

Commitment and Participation 
Ask yourself if 

1. you wish to have involvement in the forum or if you want the students 

to lead and own the space 

2. you want the forum to add value to the face to face environment or have 

a life of its own in its own right outside the lecture theatre/classroom or 

seminar room 

3. you are prepared to make appropriate contributions to the discussion in 

order to: 

подписатся на эту электронную почту сам). 

Заметьте, что даже если вы объявили подписку обязательной, каждый 

пользователь может выбирать в настройках отправки сообщений режим не получать 

извещений, или выбрать получение всей почты раз в лень в виде дайджеста, содержащего 

все сообщения или только предметные заголовки. 

Опция свободной подписки позволяет вам отмечать (и модифицировать) число 

подписчиков (AdministrationForum administrationShow/edit current subscribers) и 

подписаться (или отказаться от подписки) на Форум («Subscribe to this 

forum»/«Unsubscribe from this forum»). 

Общее представление о подписках на ваш Форум доступно на индексной странице 

Форумов, например, на http://moodle.org/mod/forum/index.php?id=5. 

4.3.7.2.9.Концепции, используемые в Форумах 
Участие и поддержка 

Хотя одно из самых больших преимуществ интернет-образования состоит в его 

большом удобстве для Участников, это не означает, что должны проходить дни или 

недели без активного участия в обсуждениях в каком-нибудь Форуме (когда это нужно). 

Пожалуй, это особенно необходимо в начале Курса или программы, когда Студенты и 

Преподаватели ещё не знакомы друг с другом, и нуждаются в приветственных словах и 

подбадривании. Несмотря на то, что интернет-обучение, и в особенности – онлайн-

дискуссии, могут поддерживать обучение, в котором Наставник/Преподаватель не всегда 

играет центральную роль, ваша роль будет особенно важной во время начала развития 

онлайн-сообщества. Именно в течение этих начальных стадий вводного материала, группа 

Студентов может стать сообществом участников, которые начинают расти в своём 

осознании материала Курса и собственного вклада в процесс познания. 

 

По мере того, как ход обсуждений и сами обучающиеся адаптируются, привыкнут 

к технике и стилю Форумов, появляются ключевые возможности сокращать ваши 

воздействия, помогая тем самым расти сообществу, менее зависимому от 

Наставника/Преподавателя. Но и после этого вы, скорее всего, захотите участвовать в 

обсуждениях, причём – в роли одного из Участников, а не обладателя всей мудрости. 

 

Приверженность и соучастие 
Задайтесь вопросом о том, каковы ваши собственные намерения: 

1. вы желаете сами влиять на Форуме, или вы хотите, чтобы Студенты лидерствовали и 

были собственниками пространства Форума, 

2. вы хотите, чтобы Форум повышал ценность личного общения, или чтобы Форум жил 

самостоятельно вне классных, лекционных или семинарских помещений, 

 

3. вы намереваетесь вносить свой вклад  в обсуждение для того, чтобы: 

http://moodle.org/mod/forum/index.php?id=5
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1. encourage discussion if students are quiet 

2. help shape ideas if students begin to wander off-task 

3. your role will be defined as discussions/a course progresses 

4. you will explicitly but gradually relinquish control of the discussions 

5. you will encourage and support learners to share control of 

discussions (for example you might ask a learner/group of learners 

to summarise contributions to a discussion thread/topic or you might 

ask learners to initiate discussion topics) 

Student Centered Forums 
With the growing popularity of social networking software like Facebook, 

Bebo, MySpace and the like, students are leaving schools and coming to 

Higher and Further Education with a new technological sophistication and 

with new expectations for communication. And as school, colleges and 

universities recognise that reflective and life long learning are significant 

goals in education, student centered learning and the creation of student 

centered spaces online are also gaining credence in educational settings. 

We know that effective learning requires access to social and academic 

networks for both study material and emotional support; as such, online 

communities can offer a holistic knowledge construction and support 

mechanism and recognize that affective activity is effective. 

 

Social forums, often called ‘Virtual Cafes’ or ‘Common Rooms’ can be set 

up for courses or for programmes, depending on the student need. Such 

spaces provide a common area for students to come together and discuss 

unlimited topics, including social activities and educational ideas. They are 

supportive spaces for students, most successful with large first and second 

year courses where students would not otherwise have the opportunity to 

communicate with others outside their own tutorial group. 

 

It is arguable that students will experience a greater sense of community 

within and a sense of belonging to an educational institution or individual 

department having had the experience and convenience of the social forum 

on their course; this could arguably have implications for retention. These 

spaces are typically highly active, especially in first term. 

 

Depending on your institution, they are usually self monitored by students, 

who understand that the same ‘rules’ and ‘netiquette’ that apply to them 

within any computing space, also apply in Moodle. 

 

1. возбуждать дискуссию, когда Студенты проявляют пассивность, 

2. помогать формировать идеи, если Студенты начнут отклоняться от сути, 

3. ваша Роль будет определяться тем, как будет обсуждение/Курс развиваться, 

4. вы будете открыто, но постепенно ослаблять свой контроль над обсуждениями, 

5. вы будете побуждать и поощрять учащихся к участию в контроле обсуждений 

(например, вы можете попросить учащегося/группу учащихся подытожить вклады 

в обсуждение разделов темы или всей темы; или вы можете предложить учащимся 

самим инициировать темы обсуждений). 

Форумы, ориентированные на Студента 
Благодаря росту популярности программного обеспечения социальных сетей, 

такого как Facebook, Bebo, MySpace и т.п., окончившие школы ученики поступают в 

высшие заведения с новыми технологическими изысками и с новыми надеждами на 

коммуникацию. И по мере того, как школы, колледжи и университеты осознают, что 

рефлективное и пожизненное обучение являются значимыми целями всей системы 

образования, «Студентоцентричное» обучение и создание онлайн-пространств, 

сосредоточенных на Студентах, тоже быстро набирают размах и значение в 

образовательных учреждениях. Известно, что для эффективного обучения необходим 

доступ к социальным и академическим сетям, – и для получения изучаемого материала, и 

для получения эмоциональной поддержки; и онлайн-сообщества на самом деле могут 

предложить и построение холистического знания, и механизмы поддержки, и понимание, 

что деятельность, сопровождаемая эмоциями, эффективнее. 

Социальные Форумы, часто называемые «виртуальными кафе» или «общими 

пространствами» могут быть использованы для Курсов или для программ, в зависимости 

от нужд Студента. Такие пространства предоставляют Студентам общую площадку для 

совместных обсуждений любых тем, включая общественные процессы и  идеи 

образования. Социальные Форумы являются благоприятным пространством для успеха 

студенческой деятельности, особенно при изучении объёмных дисциплин на первом и 

втором годах обучения, где Студенты не имеют другой возможности общения с другими 

вне их собственной учебной Группы. 

Можно утверждать, что Студенты будут испытывать большее чувство внутреннего 

товарищества и чувство принадлежности к образовательному учреждению или 

индивидуальному департаменту, получив опыт и удобства социального Форума по их 

Курсу; это сильно способствует укреплению чувства принадлежности к сообществу. Эти 

пространства Социальных Форумов обычно высоко действенны, особенно в первом 

семестре. 

В зависимости от вашей организации, они, как правило, самостоятельно 

контролируется Студентами, которые понимают, что те же самые «правила» и «сетевой 

этикет», которые применяют к ним внутри любого компьютерного пространства, также 

применяются в Moodle. 
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The News Forum 
Moodle courses automatically generate a News forum which defaults to 

automatically subscribe all participants in a course. The name of the News 

Forum can be changed to something more appropriate, such as ‘Important 

Announcements’ or the like. This is a useful feature and many use this 

forum in a Moodle course to announce exam dates, times or changes to 

exams, lectures or seminars, as well as important information about course 

work throughout a term or special announcements relating to events. 

Teacher/Tutor forums 
A teacher/tutor-only forum may be added to a course by creating a hidden 

forum. Teachers are able to view hidden course activities whereas students 

cannot. 

4.3.7.2.10.Some forum suggestions to consider 
1. If your course is at a distance, if your face to face time is limited, or if 

you just wish to foster a sense of community in your Moodle course 

which supplements your face to face course, it is good practice to begin 

with a welcome or introductory message or thread in one of your 

forums. This welcome or introduction from you invites participants, for 

example, to post some specific details to introduce themselves to you 

and their peers. This can be your icebreaker or you can have an 

icebreaker separately. 

2. If you have two questions for participants to answer, starting the two 

strands or topics within the forum itself will both help learners to see 

where to put their responses, and remind them to answer all parts of 

your question. 

3. Remember that you are communicating in an environment that does not 

have the benefit of verbal tone, eye contact, body language and the like. 

Careful consideration of your communication is, therefore, necessary. 

4. Postings to a forum are always written but they can take different forms 

and you may wish to consider what form best suits the activity. For 

instance, you might choose to articulate a form of contribution in order 

to be explicit. Thus you might say, 'This is a think-aloud forum in 

which, together, we will try to tease out ideas and possibilities' or 'This 

is a formal forum in which you are invited to share your ideas on 

(topic)' and, where you select the latter, you might have already 

suggested learners plan those ideas offline or in another kind of activity 

within Moodle.. 

 

 

 

Форум новостей 
Курсы Moodle автоматически генерируют Форум новостей, на который по 

умолчанию подписываются все участники Курса. Название Форума новостей может быть 

изменено на нечто более подходящее, такое как «Важные объявления», и т.п. Это полезное 

средство, и многие используют этот Форум в Курсе Moodle для объявления дат и времени 

Экзаменов или изменений в Экзаменах, Лекциях или Семинарах, заодно и важную 

информацию о работе Курса на протяжении семестра или специальные объявления о 

событиях. 

Форум Преподавателя/наставника 
Форум только для Преподавателя/наставника может быть добавлен в Курс 

созданием скрытого Форума. Преподаватели могут просматривать скрытые 

Интерактивные Действия Курса, что недоступно для Студентов. 

4.3.7.2.10.Некоторые потенциальные возможности Форума 
1. Если ваш Курс дистанционный, если личное общение в нём ограничено, или если вы 

просто желаете поддержать чувство содружества в вашем Курсе Moodle, который 

дополняет ваши очные занятия, хорошей практикой является начать с приветствия или 

вводного сообщения или какой-то темы в одном из ваших Форумов. Ваше приветствие 

или введение призовёт Участников, например, в письме на Форум представить себя с 

некоторыми подробностями вам и сокурсникам. Это может быть одним из ваших 

приёмов-«ледоколов» для преодоления холодка в отношениях. 

 

2. Если вы имеете два вопроса к Участникам, само начинание двух подтем или тем внутри 

Форума, поможет учащимся понять, куда следует отправлять их ответы, и напомнит 

им, что нужно отвечать на все части вашего Вопроса. 

 

3. Помните, что вы общаетесь в среде, которая не использует достоинств личного 

общения – интонаций  голоса, обмена взглядами, языка жестов и т.п. Поэтому 

потребуется тщательное обдумывание техники вашей коммуникации. 

Сообщения в Форум только письменные, но они могут иметь различные формы, и вы 

можете рассмотреть, какая форма лучше всего подходит к данному 

ИнтерактивномуДействию. Например, вы можете выбрать устную форму изложения 

выступлений ради полной ясности. Тогда вы, может быть, скажете: «Это Форум 

размышлений вслух, мы попытаемся причесать идеи и возможности», или «Это 

формальный Форум, в который вы приглашены поделиться идеями по (такой-то теме)», 

и там, где вы выбираете последнее, вы, наверное, уже предложили учащимся 

спланировать эти идеи в режиме офлайн или в другом типе работы внутри Moodle. 
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5. Create a forum where only the teacher can start discussions, but the 

students can only reply. Each thread you start contains an essay 

question (or several similar ones). The students make a bullet point plan 

for the essay and post it as a reply. This works well as a revision 

strategy as the students can see how others have approached the same 

task. Once everyone has posted their plan, you can start a discussion as 

to which plans seem better and why. Creating a scale to use for rating 

the posts can be useful so that the students can see how helpful other 

people think their effort were. (Note: At this time, there is no option to 

hide the "Add new discussion topic" button, so you need to tell your 

students not to start discussion threads, but to only reply to threads 

started by the teacher. If you only need one thread, then you can use the 

"a single simple discussion" format and the "Add new discussion topic" 

button is not available to the students.) 

 

Grading forums 
The teacher can use the ratings scales to grade student activities in a forum. 

There are several methods for calculating the grade for a forum that can be 

found in the Forum settings under grades. There are 5 ways to aggregate 

ratings automatically to calculate a forum grade for the Gradebook. These 

include: Average, Max, Min, Count and Sum. 

4.3.7.2.11.Forum ratings allow users to evaluate 
posts in a forum 
Forum ratings use Scales to standardize the reporting of performance. A 

forum rating can be included as part of a student's grade. For example, a 

teacher might use a custom rating scale in a forum and allow students to 

rate forum posts. 

Forum ratings must be allowed and the potential rater must have role 

permission. Teachers by default have this ability. The teacher role is also 

able to give permission to a student role in a specific forum to be able to 

assign a rating to a post. Forum settings and Enabling student ratings has 

more information. 

How to use 
When rating is allowed, the qualified user will see "Rate this post" and a 

pull down menu after an entry (not their own). The menu displays a scale 

that the forum creator selected in the Forum grade settings. The user can 

rate more than one post at a time. When finished they should click the 

"submit my ratings" button at the bottom of the page. 

 

5. Создайте Форум, где только Преподаватель может инициировать обсуждения, а 

Студенты могут только отвечать. Каждое русло рассуждений, которое вы начинаете, 

содержит вопрос-эссе (или несколько таких вопросов). Студенты составляют сжатый 

план основных мыслей в этом эссе и отправляют их в качестве ответа. Это хорошо 

работает при стратегии ревизии, так как Студенты могут видеть, как другие подошли к 

той же самой задаче. После того, как каждый отправил свой план, вы можете начать 

обсуждение того, какой из планов кажется лучше и почему. Создание шкалы для 

ранжирования сообщений может быть полезно тем, что Студент сможет увидеть, 

насколько полезной, по мнению других, была его попытка. (Замечание: В это время нет 

возможности скрыть кнопку «Add new discussion topic (добавить новую тему 

обсуждения)», так что вам нужно сказать вашим Студентам, чтобы они не начинали 

других линий обсуждения, а отвечали только на инициированные Преподавателем. 

Если вам нужна только одна нить суждений, то вы можете использовать формат 

«Одиночное простое обсуждение», а кнопка «Add new discussion topic (добавить новую 

тему обсуждения)» недоступна Студентам.) 

Оценивание Форумов 
Преподаватель может использовать Рейтинговые Шкалы (п. 6.2.6), чтобы оценить 

деятельность Студента в Форуме. Существует несколько методов для вычисления Оценки 

для Форума, которые могут быть найдены в п. 4.3.7.1. Существует 5 способов 

Агрегирования Рейтингов автоматически для вычислении Оценки за Форум для 

Журнала Оценок. Они включают Average, Max, Min, Count и Sum. 

4.3.7.2.11.Рейтинги Форума позволяют пользователям 
оценивать сообщения в Форуме 

Оценки Форума используют Шкалы, чтобы стандартизовать составление отчётов о 

выполнении. Оценка Форума может быть частью Итоговой Оценки Студента. Например, 

Преподаватель может использовать привычную клиенту Шкалу оценивания в Форуме и 

позволить Студентам оценивать сообщения Форума. 

Оценки Форума должны быть разрешены, и потенциальный Оценивающий должен 

иметь Полномочие Роли. Преподаватели имеют это полномочие по умолчанию. Роль 

Преподавателя также позволяет ему предоставить Студенту полномочие оценивать 

сообщения в конкретном Форуме. Настройки Форума и разрешение Студенту оценивать 

(п. 4.3.7.1) содержат больше информации. 

Как этим пользоваться 
Когда оценивание разрешено, полномочный пользователь увидит «Rate this post 

(оцените это сообщение)» и ниспадающее меню после записи (не своей собственной). 

Меню отобразит Шкалу, которую выбрал создатель Форума в настройках Оценки Форума 

(п. 4.3.7.1). Пользователь может оценить более одного сообщения за раз. По окончании он 

должен щёлкнуть кнопку «Submit my ratings (передайте на рассмотрение мои рейтинги)» 

внизу страницы. 

http://docs.moodle.org/25/en/Using_Forum#Grading_forums
http://docs.moodle.org/25/en/Using_Forum#Grading_forums
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Screenshot «Teacher view of a previously rated student post». 

 

AJAX forum rating 
Forum rating can be made more user-friendly with the use of AJAX. Users 

can rate forum posts almost instantly without needing to scroll to the 

bottom of the page and click the "Send in my latest ratings" button. 

 

AJAX forum rating requires AJAX to be enabled by an administrator in 

Settings > Site administration > Appearance > AJAX and Javascript and by 

users in their user profile. 

Separate and connected knowing 
You can rate forum posts with the Separate and Connected Knowing scale 

here. 

Good Practice and shared discussions 
There are lots of discussions about Forum good use and Forum assessment 

in the Teaching Strategies Forum. 

4.3.8.Glossary 
The glossary activity module allows participants to create and maintain a 

list of definitions, like a dictionary. 

Glossary can be used in many ways. The entries can be searched or 

browsed in different formats. A glossary can be a collaborative activity or 

be restricted to entries made by the teacher. Entries can be put in 

categories. The auto-linking feature will highlight any word in the course 

which is located in the glossary. 

Screenshot «Glossary example». 

4.3.8.1.Glossary settings 
4.3.8.1.1.Adding a glossary 
To add a glossary: 

1. With the editing turned on, in the section you wish to add your glossary, 

click the "Add an activity or resource" link (or, if not present, the "Add 

an activity" drop down menu) and choose Glossary. All settings may 

expanded by clicking the "Expand all" link top right. 

4.3.8.1.2.General 
Screenshot «General settings expanded by default». 

Name 

Give your new glossary a descriptive name. 

 

Снимок с экрана «Вид Преподавателем предварительно оценённого Студентом 

сообщения». 

AJAX-ранжирование Форума  
Ранжирование Форума можно сделать более дружественным к пользователю с 

использованием AJAX. Пользователи могут ранжировать сообщения Форума почти 

мгновенно без необходимости прокручивать страницу до конца и щёлкать по кнопке 

«Send in my latest ratings (отослать мои самые последние рейтинги)». 

AJAX-ранжирование Форума требует, чтобы AJAX был разрешён 

Администратором в AdministrationSite administrationAppearanceAJAX and Javascript 

и пользователями в их Профиле пользователя. 

Раздельное и связное познание 
Вы можете оценить сообщения Форума по Шкале раздельного и связного познания 

здесь. 

Хорошая практика и совместные обсуждения 
Имеется много обсуждений о хорошем использовании и оценивании Форума в 

Форуме по стратегиям обучения. 

4.3.8.Глоссарий 
Модуль Интерактивного Действия «Глоссарий» позволяет участникам создавать и 

поддерживать список определений, наподобие словаря. 

Глоссарий может использоваться многими способами. Его записи можно искать и 

просматривать в различных форматах. Глоссарий может создаваться либо коллективно, 

либо доступ к введению новых записей может быть предоставлен только Преподавателю. 

Записи могут быть распределены по Категориям. Средство авто-связывания будет 

подсвечивать любое слово в Курсе, которое размещено в Глоссарии. 

Снимок с экрана «Пример Глоссария». 

4.3.8.1.Настройки Глоссария 
4.3.8.1.1.Добавление Глоссария 

Чтобы добавить Глоссарий: 

1. Включив режим редактирования в разделе, в который вы хотите добавить ваш 

Глоссарий, щёлкните ссылку «Add an activity or resource» (или, если не присутствует, 

ниспадающее меню «Add an activity») и выберите Glossary. Все настройки можно 

развернуть щелчком по ссылке «Expand all» вверху справа. 

4.3.8.1.2.Обычные настройки 
Снимок с экрана «Обычные настройки, развёрнутые по умолчанию». 

Наименование 

Задайте вашему новому Глоссарию описательное наименование. 

http://docs.moodle.org/25/en/File:Forum_rating_example1_mu.png
http://docs.moodle.org/25/en/File:Forum_rating_example1_mu.png
http://docs.moodle.org/25/en/Separate_and_Connected_Knowing
http://docs.moodle.org/25/en/Separate_and_Connected_Knowing
http://moodle.org/mod/forum/view.php?id=41
http://docs.moodle.org/25/en/File:Glossaryexample.png
http://docs.moodle.org/25/en/File:glossarygeneral25.png
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Description 
Describe the purpose of the glossary and provide instructions or 

background information, links etc. Click "Show editing tools" to display 

the rich text editor, and drag the bottom right of the text box out to expand 

it. 

Display description on course page 

If this box is ticked, the description will appear on the course page just 

below the name of the glossary. 

Is this glossary global? 

Administrators can make a global glossary, with entries linking throughout 

the whole Moodle site. Any course may contain a global glossary, though 

the best practice is to place a global glossary on the site front page. 

Glossary type 

Here you can decide whether the glossary will be main or secondary. The 

glossary system allows you to export entries from any secondary glossary 

to the main one of the course. In order to do this, you should specify which 

glossary is the main one. You can only have one main glossary per course. 

4.3.8.1.3.Entries 
Screenshot «Entries settings expanded». 

Approved by default 
If set to "yes" then new entries appear automatically. If not, then the 

teacher must approve each one first. 

Always allow editing 
If set to "yes", students can edit their entries at any time. If not, then they 

can only edit for a certain period (defined in Site Policies). 

 

Duplicate entries allowed 
This allows the entry of more than one definition for a given word. 

Allow comments on entries 

Students and teachers can leave comments on glossary definitions. The 

comments are available through a link at the bottom of the definition. 

Automatically link glossary entries 
If the Glossary auto-linking filter is enabled by an administrator (see 

Filters for further details), then turning this on allows individual entries in 

this glossary to be automatically linked whenever the concept words and 

phrases appear throughout the rest of the same course. This includes forum 

postings, internal resources, week summaries and so on. 

Screenshot «An auto-linked word in a forum». 

 

Описание 
Опишите цель Глоссария и предоставьте инструкции или справочную 

информацию, ссылки и т.д. Щёлкните «Show editing tools (показать инструменты 

редактирования)», чтобы отобразить полный текстовый редактор, и перетащите нижний 

правый уголок текстового окошка, чтобы расширить его. 

Отобразить описание на странице Курса 

Если это окошко отмечено «галочкой», описание будет появляться на странице 

Курса как раз под наименованием Глоссария. 

Этот Глоссарий глобальный? 

Администраторы могут сделать Глоссарий глобальным, со связыванием записей по 

всему Сайту Moodle. Каждый Курс может содержать глобальный Глоссарий, хотя лучшая 

практика состоит в размещении глобального Глоссария на Главной Странице Сайта. 

Тип Глоссария 
Здесь вы можете определить, будет ли Глоссарий основным или вторичным. 

Система Глоссариев позволяет вам экспортировать записи из вторичного словаря в 

основной словарь Курса. Чтобы сделать это, нужно указать, какой Глоссарий является 

основным. Можно иметь только один основной Глоссарий на Курс. 

4.3.8.1.3.Записи 
Снимок с экрана «Развёрнутые настройки записей». 

Утверждённые по умолчанию 
Если установить в «Yes», тогда новые Записи вносятся автоматически. Если нет, 

тогда Преподаватель должен сначала утвердить каждую Запись. 

Всегда разрешать редактирование 
Если установить в «Yes», Студенты могут редактировать их Записи в любое время. 

Если нет, тогда они могут редактировать только в определённый период (определённый в 

Политиках Сайта). 

Разрешение дополнять Записи 
Эта опция разрешает введение более одного определения для данного слова. 

Разрешить комментарии к Записям 
Студенты и Преподаватели могут оставлять комментарии к определениям 

Глоссария. Комментарии доступны через ссылку внизу определения. 

Автоматически ссылаться на Записи Глоссария 
Если фильтр авто-связывания Глоссария разрешён Администратором (см. 

дополнительные сведения в «Фильтры»), тогда включение его позволит индивидуальным 

записям в этом Глоссарии автоматически связываться всякий раз, когда слова понятий и 

фразы появляются где-либо в Курсе. Это включает корреспонденции Форумов, 

внутренние Ресурсы, еженедельные резюме, и т.д. 

Снимок с экрана «Авто-связывание слова в форуме». 

http://docs.moodle.org/25/en/Glossary_auto-linking_filter
http://docs.moodle.org/25/en/Filters
http://docs.moodle.org/25/en/File:glossaryentries25.png
http://docs.moodle.org/25/en/Glossary_auto-linking_filter
http://docs.moodle.org/25/en/Filters
http://docs.moodle.org/25/en/File:Glossaryautolink.png
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Note: Enabling linking for the glossary does not automatically turn on 

linking for each entry - linking needs to be set for each entry individually. 

If you do not want particular text to be linked (in a forum posting, say) 

then you should add <nolink> and </nolink> tags around the text. 

 

Note that category names are also linked. 

4.3.8.1.4.Appearance 
Screenshot «Appearance settings expanded». 

Display format 
That specifies the way that each entry will be shown within the glossary. 

The default formats are: 

 Simple, dictionary style - This looks like a conventional dictionary with 

separate entries. No authors are displayed and attachments are shown as 

links. 

 Continuous without author - Like the simple style. Shows the entries 

one after other without any kind of separation but the editing icons if 

your theme supports it. 

 Full with author - A forum-like display format showing author's data. 

Attachments are shown as links. 

 Full without author - A forum-like display format that does not show 

author's data. Attachments are shown as links. 

 Encyclopedia - Like 'Full with author' but attached images are shown 

inline. 

 Entry list - This lists the concepts as links. 

 FAQ - Useful for displaying lists of frequently asked questions. It 

automatically appends the words QUESTION and ANSWER in the 

concept and definition respectively. 

See Glossary FAQ for more information on the code for the different 

display formats. 

Approval display format 
It is possible to set an alternative display format for when entries are 

approved that can differ from the display format on the course page. This 

could be useful for instance if a tutor wants to see who made a particular 

glossary entry before approving it but doesn't want the students' name to be 

displayed for others on the course page. 

Entries shown per page 
Decide here how many entries to show per page. 

 

 

Замечание: Разрешение связывания для Глоссария автоматически не включает 

связывание для любой записи – связывание нуждается в установке каждой записи 

индивидуально. Если вы не хотите, чтобы конкретный текст был связан (в 

корреспонденциях Форума, скажем), тогда вы должны добавить тэги <nolink> и </nolink> 

вокруг этого текста. 

Заметьте, что имена Категорий также связываются. 

4.3.8.1.4.Внешний вид 
Снимок с экрана «Развёрнутые настройки Появления». 

Формат отображения 
Эта опция определяет способ, которым каждая Запись будет показана в Глоссарии. 

Форматами по умолчанию являются: 

 Простой словарный стиль – Это выглядит подобно обычному словарю с отдельными 

записями. Авторы не отображаются, и вложенные файлы показываются как ссылки. 

 

 Непрерывный без автора – Подобен простому стилю. Показывает Записи одну за 

другой без какого-либо выделения, кроме иконок редактирования, если ваша фоновая 

картинка их поддерживает. 

 Полный с автором – формат отображения подобный Форуму, показывающий данные 

автора. Вложенные файлы показывается как ссылки. 

 Полный без автора – формат отображения подобный Форуму, не показывающий 

данные автора. Вложенные файлы показывается как ссылки. 

 Энциклопедия – Похож на «Полный с автором», но присоединяемые изображения 

показываются встроенными. 

 Список записей – понятия перечисляются как ссылки. 

 Часто задаваемые вопросы – Полезен для отображения списков часто задаваемых 

вопросов. Автоматически добавляет слова QUESTION и ANSWER к понятию и 

определению, соответственно. 

См. п. 4.3.8.3 «Часто задаваемые вопросы по Глоссарию» для получения 

дополнительной информации по коду для различных форматов отображения. 

Формат отображения одобрения 
Можно установить альтернативный формат отображения для тех случаев, когда 

одобренные Преподавателем записи Глоссария могут отличаться от формата отображении 

на странице Курса. Это может быть полезным, например, если наставник хочет знать, кто 

создал конкретную запись Глоссария, перед тем, как одобрить её, но не хочет, чтобы имя 

этого Студента отображалось на странице Курса. 

Показывать записей на странице 
Определите здесь, сколько записей показывать на странице. 

http://docs.moodle.org/25/en/Glossary_FAQ
http://docs.moodle.org/25/en/File:glossaryappearance25.png
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Show alphabet links 
If set to "yes", users can browse the glossary by letters of the alphabet. 

 

Show 'ALL' link 
If set to "yes", users can browse all the entries at once. 

Show 'Special' link 
If set to "yes", users can browse the glossary by special characters, such as 

@ and #. 

Allow print view 
This provides a printer-friendly version link for students. (Teachers are 

always provided with a printer-friendly version link.) 

4.3.8.1.5.RSS 
 (These settings are collapsed by default and only visible if RSS has been 

enabled on the site and for the glossary.) 

Screenshot «RSS settings expanded». 

RSS feed for this activity 
This turns RSS on or off. When set to “None,” the RSS feed is disabled. 

When set to “Concepts with authors,” the RSS feed will send out the 

glossary entries with the name of the author. When set to “Concepts 

without authors,” the RSS feed sends out glossary entries without the name 

of the author. 

Number of RSS recent articles 
This number sets the number of entries that go out via RSS. If this number 

is set to 5, then the 5 most recent articles will be sent to subscribers. As 

new entries get added, the oldest entry gets replaced on the RSS feed. If 

your glossary gets a lot of posts every day, you will want to set this number 

high. 

When RSS is enabled for your glossary, an orange RSS button appears on 

the main page (in the upper right-hand side). When a user clicks on the 

RSS button, they see the XML code displayed, needed by the news-reader. 

Once a user has the RSS news-feed link, adding it to a reader is simple and 

will then display Glossary aggregated information, along with other 

information they subscribe to. 

4.3.8.1.6.Grade 
Choose the category in which this glossary will appear if ratings are 

enabled. 

4.3.8.1.7.Ratings 
Screenshot «Ratings settings expanded». 

Показать ссылки на буквы алфавита 
Если установить в «Yes», пользователи смогут просматривать отсортированный в 

алфавитном порядке Глоссарий, начиная с любой из букв алфавита. 

Показать ссылку «ВСЕ» 
Если установить в «Yes», пользователи смогут просматривать все записи сразу. 

Показать ссылку «специальные» 
Если установить в «Yes», пользователи смогут просматривать Глоссарий по 

специальным символам таким, как @ и #. 

Показать вид для печати 
Это предоставляет Студентам ссылку на версию Глоссария для печати. 

(Преподавателям всегда предоставлена ссылка на версию для печати.) 

4.3.8.1.5.RSS 
(Эти настройки свёрнуты по умолчанию и видимы, если только RSS разрешена на 

Сайте и для Глоссария.) 

Снимок с экрана «Развёрнутые настройки RSS». 

RSS-рассылка для этого Интерактивного Действия 
Эта опция включает или отключает RSS. Когда она установлена в «None», RSS-

рассылка отключена. Когда она установлена в «Concepts with authors (понятия с их 

авторами)», RSS-рассылка отсылают записи Глоссария с именем автора. Когда она 

установлена в «Concepts without authors (понятия без авторов)», RSS-рассылка отсылают 

записи Глоссария без имени автора. 

Число новых статей RSS 
Это число устанавливает количество записей, которые распространяются через 

RSS. Если это число установлено равным 5, тогда 5 наиболее свежих статей будет послано 

подписчикам на RSS. Когда появляются новые записи, самая старая запись заменяется в 

RSS-рассылке. Если ваш Глоссарий получает ежедневно много корреспонденций, вы 

захотите установить это число большим. 

Когда RSS разрешена для вашего Глоссария, появляется оранжевая кнопка RSS на 

ГлавнойСтранице (вверху на правой боковой стороне). Когда пользователь щёлкнет эту 

кнопку, он увидит отображённый код XML, необходимый читателю новостей. Как только 

пользователь получит ссылку на RSS рассылку новостей, добавить её в программу чтения 

просто, и затем можно отображать агрегированную информацию Глоссария наряду с 

другой информацией, на которую он подписан. 

4.3.8.1.6.Оценка 
Выберите Категорию, в которой этот Глоссарий будет появляться, если 

ранжирование позволено. 

4.3.8.1.7.Рейтинги 
Снимок с экрана «Развёрнутые настройки ранжирования». 

http://docs.moodle.org/25/en/File:glossaryrss25.png
http://docs.moodle.org/25/en/File:ratings25.png
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Roles with permissions to rate 

Glossary entries can be rated using a scale. By default, only teachers can 

rate glossary entries, though students can be given permission to do so if 

desired from Administration>Glossary administration. This is a useful tool 

for giving students participation grades. Any ratings given are recorded in 

the gradebook. 

 

4.3.8.1.8.Common module settings 

See Common module settings. 

4.3.8.1.9.Restrict access/Activity completion 
 
The Restrict access and Activity completion settings are visible if 

Conditional activities and Activity completion have been enabled in the 

site and the course. 

4.3.8.1.10.Adding a new glossary entry 
See Using Glossary. 

4.3.8.1.11.Glossary permissions 
Role permissions for the activity can be changed in Settings > Glossary 

administration > Permissions. 

4.3.8.1.12.Site administration settings 

The glossary module has additional settings which may be changed by an 

administrator in Settings > Site administration > Plugins > Activity 

modules > Glossary. 

Glossary level default settings 
 glossary_entbypage - Number of Glossary entries shown per page. 

Default is set to 10. 

 glossary_dupentries - Whether or not the Glossary will allow duplicate 

entries. Default is set to "No". 

 glossary_allowcomments - Whether or not the Glossary will accept user 

comments on its entries. Default is set to "No". 

 glossary_linkbydefault - Whether or not a glossary should be 

automatically linked. Default is set to "Yes". 

 glossary_defaultapproval - Whether or not the Glossary will define the 

approval status of an entry posted by a student. Default is set to "Yes". 

 glossary_enablerssfeeds - Enabling of RSS feeds for all glossaries. 

Default is set to "No". Note: feeds will still need to be turned on 

manually in the settings for each glossary. 

 

Роли с полномочиями ранжировать 
Записи Глоссария могут быть ранжированы с использованием Шкалы (см. п. 6.2.6). 

По умолчанию только Преподаватели могут ранжировать Записи Глоссария, хотя 

Студентам может быть дано разрешение делать это, если нужно, через 

AdministrationGlossary administration. Это полезный инструмент для выполнения 

Студентами совместного оценивания. Любые данные Рейтинги заносятся в 

Журнал Оценок (см. п. 6.2.1). 

4.3.8.1.8.Общие настройки модуля 
См. п. 6.1. 

4.3.8.1.9.Ограничить доступ/завершение 
ИнтерактивногоДействия 

Настройки ограниченного доступа и завершения Интерактивного Действия 

видимы, если на Сайте и в Курсе разрешены Обусловленные Действия (п. 4.9.2) и 

Завершения Действий (п. 4.9.3). 

4.3.8.1.10.Добавлление новой Записи в Глоссарий 
См. п. 4.3.8.2. 

4.3.8.1.11.Полномочия Глоссария 
Полномочия Роли для этого Интерактивного Действия могут быть изменены в 

AdministrationGlossary administrationPermissions. 

4.3.8.1.12.Настройки управления Сайта 
Модуль «Глоссарий» имеет дополнительные настройки, которые могут изменяться 

Администратором в 

AdministrationSite administrationPluginsActivity modulesGlossary. 

Настройки уровня Глоссария по умолчанию  
 glossary_entbypage – Число Записей Глоссария на странице. По умолчанию равно 10. 

 

 glossary_dupentries – Допускается или нет копирование Записей из Глоссария. По 

умолчанию – «No». 

 glossary_allowcomments – Может или нет пользователь комментировать Записи в 

Глоссарии. По умолчанию – «No». 

 glossary_linkbydefault – Может или нет Глоссарий автоматически связываться. По 

умолчанию – «Yes». 

 glossary_defaultapproval – Может или нет Глоссарий определять статус одобрения 

Записи, присланной Студентом. По умолчанию – «Yes». 

 glossary_enablerssfeeds – Разрешение RSS-пересылок для всех Глоссариев. По 

умолчанию – «No». Замечание: Пересылки всё ещё нужно будет разрешить вручную в 

настройках каждого Глоссария. 

http://docs.moodle.org/25/en/Scales
http://docs.moodle.org/25/en/Gradebook
http://docs.moodle.org/25/en/Common_module_settings
http://docs.moodle.org/25/en/Conditional_activities
http://docs.moodle.org/25/en/Activity_completion
http://docs.moodle.org/25/en/Using_Glossary
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Entry level default settings 
 glossary_linkentries - Whether or not glossary entries should be 

automatically linked. Default is set to "No". 

 glossary_casesensitive - Whether or not an entry is case sensitive when 

linked. Default is set to "No". 

 glossary_fullmatch - Whether or not an entry should match the case in 

the target text by default when linked. Default is set to "No". 

Display Formats Setup 
To hide or show any of these entries, simply click on the "eye" icon next to 

the entry. Clicking on the "writing hand" icon will take you to the settings 

page for that entry. 

4.3.8.2.Using Glossary 
4.3.8.2.1.Adding a glossary entry 
To add a glossary entry: 

 When you first create a glossary, click "Save and display" to be taken to 

the "Add a new entry" screen. 

 Alternatively, click on the glossary link and click the "Add a new entry" 

button in the centre of the screen or the Administration block. 

 Enter the word you want to define in the Concept text field. 

 Add the definition of the word or concept. 

 If you want to add an attachment, such as a picture or an article, you 

can either drag/drop it or click the "Add" button to upload via the File 

picker 

Screenshot «Adding a new entry. 1». 

Screenshot «Adding a new entry. 2». 

 You can add or edit categories by clicking the "Browse by category" 

tab: 

Screenshot «Browse by category tab». 

 If there are synonyms you want to include with the entry, add them to 

the Keyword(s) text area. Enter one word per line. 

 

 Select the auto-linking options (see below) and save the changes. 

This entry should be automatically linked 
If site-wide glossary auto-linking has been enabled by an administrator and 

this is set to "yes", the entry will be automatically linked wherever it 

appears. 

 

 

Настройки по умолчанию уровня Записи 
 glossary_linkentries – должны или нет Записи Глоссария быть автоматически 

связанными. По умолчанию – «No». 

 glossary_casesensitive – Может или нет Запись, которая чувствительна к регистру 

(размеру шрифта), быть автоматически связанной. По умолчанию – «No». 

 glossary_fullmatch – Может или нет Запись, когда связывается, соответствовать 

регистру целевого текста, установленному по умолчанию. По умолчанию – «No». 

Установка форматов отображения 
Чтобы скрыть или показать любую из этих Записей, просто щёлкните по иконке 

«Глаз» рядом с ней. Щелчок по иконке «Writing hand (написание вручную)» вызовет 

страницу настроек для этой Записи. 

4.3.8.2.Использование Глоссария 
4.3.8.2.1.Добавление Записи в Глоссарий 

Чтобы добавить Запись в Глоссарий: 

 Когда вы создаёте Глоссарий первый раз, щёлкните «Save and display (сохранить и 

отобразить)», чтобы получить экран «Add a new entry (добавить новую запись)». 

 Альтернативно, щёлкните ссылку на Глоссарий и щёлкните кнопку «Add a new entry» в 

центре экрана или в блоке «Administration». 

 Введите слово, которое вы хотите определить, в текстовое поле «Понятие». 

 Добавьте определение этого слова или понятия. 

 Если вы хотите добавить файл вложения (рисунок или статью), вы можете либо 

перетащить/оставить его или щёлкнуть кнопку «Add», чтобы переслать его через меню 

файлов. 

Снимок с экрана «Добавление новой Записи. 1». 

Снимок с экрана «Добавление новой Записи. 2»:. 

 Вы можете добавить или отредактировать Категории щелчком по ярлычку «Browse by 

category (просмотреть по категориям)». 

Снимок с экрана «Просмотреть по ярлычкам Категорий». 

 Если существуют синонимы, которые вы хотите включить в Запись, добавьте их в 

текстовую область «Keyword (ключевое слово)». Каждому слову отведите отдельную 

строку. 

 Выберите опции авто-связывания (см. ниже) и сохраните изменения. 

Эта Запись должна быть автоматически связана 
Если Глоссарий разрешён Администратором для всего Сайта, и эта опция 

установлена в «Yes», тогда эта запись будет автоматически связана, где бы она не 

появилась. 

http://docs.moodle.org/25/en/File_picker
http://docs.moodle.org/25/en/File_picker
http://docs.moodle.org/25/en/File:glossaryaddentry25.png
http://docs.moodle.org/25/en/File:newglossart.png
http://docs.moodle.org/25/en/File:browsebycategory.png
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This entry is case sensitive 
This setting specifies whether matching exact upper and lower case is 

necessary when performing automatic linking to these entries. For 

example, if this is turned on, then a word like "html" in a forum posting 

will NOT be linked to a glossary entry called "HTML". 

Match whole words only 
If automatic linking is enabled, then turning this setting on will force only 

whole words to be linked. For example, a glossary entry named "construct" 

will not create a link inside the word "constructivism". 

4.3.8.2.2.Editing glossary entries/Adding 
categories 
Categories may be created to help organize your glossary entries. If you've 

enabled auto linking, the category names can be linked along with 

individual entries. 

To create a glossary category: 

1. Click the "Browse by category" tab in the main page of the glossary. 

 

2. Click the "Edit categories" button on the left side of the page. 

 

3. Click the "Add category" button on the resulting Categories page. 

 

4. Give the category a name. 

5. Choose whether you want the category name autolinked as well. 

6. Click the "Save changes" button. 

If you autolink the category name, any occurrence of those words will be 

linked. When a student clicks on the link, they will be taken to the "Browse 

by category" page of the glossary. 

4.3.8.2.3.Browse options 
You can browse glossaries according to the following options: 

 

 

 

 

 Browse by alphabet 

 Browse by category (if there are any categories added) 

 Browse by date (you can sort entries by last update or by creation date) 

 

 Browse by author 

 

Эта Запись чувствительна к регистру 
Эта настройка определяет, нужна ли точность соответствия верхнего и нижнего 

регистра при выполнении автоматического связывания этих Записей. Например, если она 

включена, тогда слово, подобное «html», в корреспонденции форума не будет связано с 

записью Глоссария, названной «HTML». 

Соответствовать только целым словам 
Если разрешено автоматическое связывание, тогда эта настройка будет вынуждать 

связывать только целые слова. Например, запись Глоссария, названная «construct», не 

создаст ссылки внутри слова «constructivism». 

4.3.8.2.2.Редактирование Записей Глоссария/Добавление 
Категорий 

Категории могут быть созданы, чтобы помочь структурировать Записи вашего 

Глоссария. Если вам разрешено авто-связывание, имена Категории могут быть связаны 

наряду с индивидуальными Записями. 

Чтобы создать Категорию Глоссария: 

1. Щёлкните иконку «Browse by category (просмотреть по категориям)» на главной 

странице Глоссария. 

2. Щёлкните кнопку «Edit categories (редактировать категории)» на левой боковой стороне 

этой страницы. 

3. Щёлкните кнопку «Add category (добавить категорию)» на результирующей странице 

Категории. 

4. Дайте наименование Категории. 

5. Выберите, хотите ли вы, чтобы наименование Категории авто-связывалось. 

6. Щёлкните кнопку «Save changes (сохранить изменения)». 

Если вы авто-связываете наименование Категории, любые встретившиеся такие 

слова будут авто-связываться. Когда Студент щёлкнет по такой ссылке, перед ним 

появится страница Глоссария «Browse by category». 

4.3.8.2.3.Просматривать опции 
Вы можете просматривать Глоссарии в соответствии со следующими опциями. 

 
 Просматривать по алфавиту 

 Просматривать по Категории (если Категории добавлены) 

 Просматривать по дате (можно сортировать Записи по дате последнего обновления или 

по дате создания) 

 Просматривать по автору. 
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4.3.8.2.4.Search options 
You can also search for a given word using the Search field. Checking the 

'Search full text' option (on the right side of the Search box) allows 

searching for a given word in any position in the text. This can take longer 

and return more entries than you might wish, but it is thorough. If you do 

not check the "Search full text" box, the search only looks for the term 

names. The index below lets you browse the glossary according to a given 

letter. 

4.3.8.2.5.Waiting approval 
If entries require teacher approval before being publicly posted, this is 

where those entries are approved. 

4.3.8.2.6.Printing a glossary 
At the top right of the main glossary page, you'll see a little printer icon. If 

you click the icon, Moodle will open a new browser window and present 

all the words and definitions in a printer-friendly format. 

To print the glossary: 

 Click the printer icon at the top of the main glossary page. 

 From the newly opened window, choose Print from the File menu of 

your browser. 

 Once the word list has printed, close the printer-friendly format 

window. 

Note: Teachers are always provided with a printer-friendly format link. To 

enable students to print a glossary, set "Allow print view" to Yes on the 

edit glossary page. 

4.3.8.2.7.Glossary comments 
If you enabled comments on the glossary entries, users can annotate the 

definitions in the word list. When you look at a word in the glossary list, 

you'll see a blue "Comments" link in the lower left-hand corner: … 

When you click the link, a comments box opens up. Add your comment 

then click the "Save changes" button. 

Once you've saved your comment, Moodle will display all of the 

comments for the entry. When you return to the main glossary page, you'll 

see a new message next to the speech balloon telling you how many 

comments there are for the entry. 

4.3.8.2.8.Exporting glossary entries to another 
glossary 
Glossary entries can be exported and then imported into another glossary. 

 

4.3.8.2.4.Опции Поиска 
Вы можете также искать по заданному слову, используя поле «Search (искать)». 

Отметка «галочкой» опции «Search full text (искать полный текст)» (в правой боковой 

стороне окошка «Search») позволяет искать по заданному слову в любой позиции в тексте. 

Это может занять больше времени и отыскать больше записей, чем бы вы хотели, но зато 

будет исчерпывающим поиском. Если вы не пометите «галочкой» опцию «Search full text», 

поиск будет искать только наименования терминов. Индекс внизу позволит вам 

просматривать Глоссарий в соответствии с заданной буквой. 

4.3.8.2.5.Ожидание одобрения 
Если Записи требуют одобрения Преподавателя до их опубликования, это то место, 

где такие Записи получают одобрение. 

4.3.8.2.6.Распечатка Глоссария 
Вверху справа на главной странице Глоссария вы можете видеть иконку «Printer». 

Если щёлкнуть эту иконку, Moodle откроет новое окно браузера и представит все слова и 

определения в печатном формате. 

Чтобы распечатать Глоссарий: 

 Щёлкните иконку «Printer» вверху главной страницы Глоссария. 

 Во вновь открытом окне выберите иконку «Print» в меню вашего браузера. 

 

 Как только список слов распечатается, закройте окно печатного формата. 

 

Замечание: Преподавателям всегда предоставляется ссылка на печатный формат. 

Чтобы разрешить Студентам распечатывать Глоссарий, установите «Allow print view 

(разрешить просмотр печати)» в «Yes» на странице редактирования Глоссария. 

4.3.8.2.7.Комментарии Глоссария 
Если вы разрешили комментировать Записи Глоссария, пользователи могут 

аннотировать определения в списке слов. Когда вы взглянете на слово из списка 

Глоссария, вы увидите голубую ссылку «Comments (комментарии)» в нижнем левом углу. 

Когда вы щёлкнете эту ссылку, откроется окошко комментариев. Добавьте ваш 

комментарий, затем щёлкните кнопку «Save changes (сохранить изменения)». 

Как только вы сохраните ваш комментарий, Moodle отобразит все комментарии 

для этой Записи. Когда вы вернётесь на главную страницу Глоссария, вы увидите новое 

сообщение рядом с речевым комментарием, заключённым в круг, сообщающим вам, как 

много комментариев существует для этой Записи. 

4.3.8.2.8.Экспортирование записей Глоссария в другой 
Глоссарий 

Записи Глоссария могут быть экспортированы и затем импортированы в другой 

Глоссарий. 

http://docs.moodle.org/25/en/File:Glossarycomments.png
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1. In Settings > Glossary administration > Export entries click the "Export 

entries to file" button. 

2. Save the automatically generated XML file on your computer. 

When the entries are imported into another glossary, the user performing 

the import will be listed as author of all the entries. 

A copy of a glossary may also be made by backing up the activity. To 

include glossary entries in the backup, 'Include enrolled users' must be 

ticked in the initial backup settings. When the glossary is restored, the 

authors of the entries will be the same as in the original glossary. 

 

4.3.8.2.9.Exporting glossary entries to a portfolio 
Users with permissions to export glossary entries to a portfolio such as 

Mahara or Google Docs can do this via the export icon at the bottom of 

each glossary entry. 

4.3.8.2.10.Importing glossary entries 
Glossary entries can be imported via XML file in Settings > Glossary 

administration > Import entries. 

See Import glossary entries for details. 

4.3.8.2.11.Why use a Glossary? 
While a basic glossary is important, creatively applying the glossary can 

really make an impact on your class. 

Collaborative glossaries 
Instead of creating a glossary on your own, why not have the students 

create them as they encounter unfamiliar terms? A collaborative glossary 

can serve as a focal point for collaboration in a course. Each member of the 

class could be assigned to contribute a term, a definition, or comments on 

submitted definitions. Multiple definitions can be rated by you and by the 

students, with the highest-rated definitions accepted for the final class 

glossary. 

When students are responsible for creating the definitions, they are much 

more likely to remember the word and the correct definition. Engaging in 

the process of learning, debating, and refining a glossary can go a long way 

toward helping students begin using new terms. 

You can also structure multiple glossaries over the course of a semester. 

Break them up by unit, chapter, week, or any other organizational 

structure. 

If you have a large class, assign student teams to come up with definitions 

and answers. One strategy for managing large courses is to make each 

team responsible for one week’s worth of definitions, while 

1. В AdministrationGlossary administrationExport entries щёлкните кнопку «Export 

entries to file (экспортировать записи в файл)». 

2. Сохраните автоматически сгенерированный файл XML на своём компьютере. 

Когда Записи импортируются в другой Глоссарий, пользователь, выполняющий 

импорт, будет упоминаться, как автор этих Записей. 

Копия Глоссария может быть также сделана посредством резервного копирования 

этого Интерактивного Действия. Чтобы включить Записи Глоссария в резервную копию, в 

начальных настройках резервного копирования должно быть помечено «галочкой» 

окошко «Include enrolled users (включить зачисленных пользователей)». Когда Глоссарий 

сохраняется, авторами Записей будут те же, кто был в оригинальном Глоссарии. 

4.3.8.2.9. Экспортирование записей Глоссария в Портфель 
Пользователи с полномочиями экспортирования записей Глоссария в Портфель, 

такой как Mahara или Google Docs, могут это делать посредством иконки «Export 

(экспортировать)» внизу каждой записи Глоссария. 

4.3.8.2.10.Импортирование записей Глоссария 
Записи Глоссария могут быть импортированы через файл XML в 

AdministrationGlossary administrationImport entries. 

См. Импортирование записей Глоссария. 

4.3.8.2.11.Как использовать Глоссарий? 
Базисный Глоссарий очень важен, его творческое применение действительно 

поможет вам воздействовать на ваш класс. 

Совместные Глоссарии 
Вместо создания Глоссария Преподавателем только для себя, почему бы не 

позволить всем Студентам создать его, когда они столкнуться с незнакомыми терминами? 

Совместный Глоссарий может сфокусировать сотрудничество в Курсе. Каждому члену 

класса можно разрешить вносить термин, определение или комментарии на 

представленные на рассмотрение определения. Разные определения могли бы оцениваться 

вами и Студентами, а определения с наивысшими Оценками могли бы составить итоговый 

Глоссарий класса. 

Когда Студенты ответственны за создание определений, намного более вероятно, 

что они запомнят это слово и его корректное определение. Вовлечение в процесс 

обучения, обсуждения и усовершенствования Глоссария может очень существенно помочь 

Студентам продвинуться к тому, чтобы начать употреблять новые термины. 

Вы можете также структурировать несколько Глоссариев по всему семестровому 

Курсу. Разнесите их по разделам, по главам, неделям или на основе другой 

организационной структуры. 

Если у вас большой класс, создайте несколько команд Студентов для работы с 

определениями и ответами. Одна стратегия по управлению большим Курсом состоит в 

том, чтобы поручить каждой команде собрать определения в течение одной недели, а 

http://docs.moodle.org/25/en/File:Glossaryexport.png
http://docs.moodle.org/25/en/File:Glossaryexport.png
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all the other teams must rate and comment. Alternatively, each team could 

be responsible for one definition per chapter and then rate and comment on 

the other teams’ work. 

Credit for word use 
This is a combination strategy using the forum and the auto-linking feature 

of the glossary. After you and your students have defined the glossary 

terms, it’s important for students to begin practising using the words in 

realistic contexts. Students, however, are usually reluctant to experiment 

with new terms. With the auto-linking feature, it’s easy to spot when a 

glossary word has been used in a forum or in a posting on the web site. To 

encourage word use, assign a portion of the credit students receive for their 

forum postings for correct use of glossary terms. As you or other students 

rate posts, you can quickly scan for highlighted glossary words and award 

points for usage. You may even want to break the score down further. 

Perhaps award one point for using the word and two points for using it 

correctly. 

"Getting to know you" 
Make a glossary into which new students add their photo and personal 

details. Add this glossary to the Random glossary block on the side of 

your course page and - at intervals you choose- details about a different 

new student are highlighted. 

Thought for the Day 
In addition to adding vocabulary and key terms glossaries to the Random 

glossary block why not add a glossary containing pertinent "thoughts for 

the day", ethical, spiritual, motivational -you decide! 

Simple peer assessment 
Have students add pieces of work with descriptions to a glossary and allow 

their classmates to comment on each others' entries to create a basic 

framework for peer assessment. While this can be done in a Forum or more 

thoroughly in aWorkshop, a glossary is a fast and effective solution. 

4.3.8.2.12.Turning off links to glossary terms 
 In places such as forum posts and quizzes, terms will be automatically 

highlighted and linked if they are in the glossary. Sometimes, this may 

be unwanted. To avoid this on a case-by-case basis, click on the blue 

Filters link in the activity's Settings block. There you will be able to 

turn off the glossary auto-linking feature for that particular activity 

while keeping it enabled elsewhere on the course: 

 

 

остальным командам их оценивать и комментировать. Другим вариантом может быть 

ответственность каждой команды за одно определение на часть Курса и за оценку и 

комментирование такой работы других команд. 

«Кредит» за использование слов 
Это комбинированная стратегия по использованию Форума и средств авто-

связывания Глоссария. После того, как вы и ваши Студент определили термины 

Глоссария, для Студентов важно начать их практическое применение в реальных 

Контекстах. Однако, обычно Студенты неохотно экспериментируют с новыми терминами. 

Со средством авто-связывания легко опознать, когда слово из Глоссария было 

использовано на Форуме или в сообщениях на веб-Сайте. Для поощрения использования 

слова, назначьте долю «Кредитов», которую Студенты получат за их корреспонденции на 

Форуме при корректном использовании терминов Глоссария. Поскольку вы или другие 

Студенты оцениваете корреспонденции, вы можете быстро просмотреть подсвеченные 

слова Глоссария и назначить наградные баллы за их применение. Вы можете даже 

захотеть помельче разделить каждую из Оценок. Например, присуждать один балл за 

использование каждого из слов. и два балла за его корректное использование. 

"Знакомство с вами" 
Создайте Глоссарий, в который новые Студенты поместят свои фото и 

персональные данные. Добавьте этот Глоссарий в «Блок глоссариев со случайным 

доступом» сбоку страницы вашего Курса, и – с выбранными вами интервалами – чтобы 

подсвечивались детали о разных новых Студентах. 

Размышления об итогах дня 
Почему бы в дополнение к добавлению словарных и ключевых терминов 

Глоссариев в «Random glossary block» не добавить Глоссарий, содержащий уместные 

«размышления за день», этические, духовные, мотивационные – решите сами! 

Простое оценивание сокурсниками 
Пусть Студенты добавляют части своей работы как Записи в Глоссарий, и 

позвольте их однокурсникам комментировать Записи друг друга, чтобы создать основу 

для взаимного оценивания. Для осуществления этого на Форуме (см. п. 4.3.7) или более 

основательно на Семинаре (см. п. 4.3.14) Глоссарий – быстрое и эффективное решение. 

4.3.8.2.12.Отключение ссылок на термины Глоссария 
 В таких местах, как корреспонденции Форумов или Экзамены, термины, если они есть 

в Глоссарии, будут автоматически подсвечиваться и связываться. Иногда это может 

быть нежелательно. Чтобы избежать этого в каждом отдельном случае, щёлкните 

голубую ссылку «Filters» в блоке настроек Интерактивного Действия. Там вы можете 

отключить средство авто-связывания Глоссария для данного конкретного 

Интерактивного Действия, сохраняя его включённым в 

Курсе. 

http://docs.moodle.org/25/en/Random_glossary_entry_block
http://docs.moodle.org/25/en/Random_glossary_entry_block
http://docs.moodle.org/25/en/Forum
http://docs.moodle.org/25/en/Workshop
http://docs.moodle.org/25/en/Random_glossary_entry_block
http://docs.moodle.org/25/en/Random_glossary_entry_block
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4.3.8.2.13.See also 
 Random glossary entry block - display glossary entries 

 The Glossary Module: Moodle's Swiss Army Knife presentation by 

Michelle Moore 

4.3.8.3.Glossary FAQ 
4.3.8.3.1.How can I turn on glossary auto-linking? 
 The glossary auto-linking filter should be enabled by an administrator 

in Settings > Site administration > Plugins > Filters > Manage filters. 

 Each glossary entry should have the "This entry should be 

automatically linked" box checked. 

4.3.8.3.2.How can I make glossary entries auto-
link to the first instance on a page ONLY? 
To stop the linking of every instance, an administrator can enable either 

'Filter match once per page' or 'Filter match once per text' in Settings > Site 

administration > Plugins > Filters > Common filter settings. 

 

4.3.8.3.3.How can I delete a glossary entry 
attachment? 
Simply delete the glossary entry and add a new one. 

4.3.8.3.4.How can I enable glossary auto-linking 
in uploaded HTML files? 
In Settings > Site administration > Plugins > Filters > Common filter 

settings, set filteruploadedfiles to "All files" or "HTML files only". 

 

4.3.8.3.5.How can I exempt individual words from 
auto-linking to a Glossary entry? 
If you don't want particular text to be linked (in a Forum post, say) then: 

 

 In Edit mode, locate and click the Toggle HTML Source button on the 

formatting toolbar (appears as '<>' symbol) 

 

 Locate the piece of text you want to exempt from autolinking 

 Before and after the text respectively, add <nolink> and </nolink>. 

 Save and check. 

 

 

 

4.3.8.2.13.См. также 
 Блок Записей Глоссария со случайным доступом – отображает записи Глоссария. 

 Модуль Глоссария: «Швейцарский армейский нож Moodle» – презентация Мишеля 

Мура. 

4.3.8.3.Часто задаваемые вопросы по Глоссарию 
4.3.8.3.1.Как включить авто-связывание по Глоссарию? 
 Должен быть разрешён Администратором Фильтр авто-связывания Глоссария в 

AdministrationSite administrationPluginsFiltersManage filters. 

 Каждая запись Глоссария должна иметь отмеченное «галочкой» окошко «This entry 

should be automatically linked (эта запись должна быть автоматически связана)». 

4.3.8.3.2.Как авто-связывать записи Глоссария ТОЛЬКО с 
первым элементом на странице? 

Чтобы остановить связывание каждого элемента, Администратор может включить 

либо «Filter match once per page (фильтр применяется один раз на страницу)», или «Filter 

match once per text (фильтр применяется один раз на текст)» в 

AdministrationSite administrationPluginsFiltersCommon filter settings. 

4.3.8.3.3.Как удалить вложенный файл из записи Глоссария? 
 

Просто удалите такую запись Глоссария и добавьте новую. 

4.3.8.3.4.Как включить авто-связывание Глоссария в 
пересылаемых файлах HTML? 

В AdministrationSite administrationPluginsFiltersCommon filter settings 

установите « filteruploadedfiles» в «All files (все файлы)» или «HTML files only (только 

файлы HTML». 

4.3.8.3.5.Как освободить отдельные слова от авто-
связывания с записью Глоссария? 

Если вы хотите, чтобы конкретный текст не был связан (скажем, с сообщением в 

Форуме), тогда: 

 В режиме редактирования разместите и щёлкните кнопку «Toggle HTML Source 

(переключите источник HTML)» на панели форматирования (появляется как символ 

«<>»). 

 Обозначьте ту часть текста, которую хотите исключить из авто-связывания. 

 До и после текста добавьте соответственно <nolink> и </nolink>. 

 Сохраните и проверьте. 

http://docs.moodle.org/25/en/Random_glossary_entry_block
http://www.slideshare.net/michelledmoore/the-glossary-module-moodles-swiss-army-knife
http://docs.moodle.org/25/en/Random_glossary_entry_block
http://www.slideshare.net/michelledmoore/the-glossary-module-moodles-swiss-army-knife
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 4.3.8.3.6.How can I prevent glossary auto-linking 
in a quiz? 
 In Settings > Quiz administration > Filters turn the glossary auto-

linking filter off 

 Click the 'Save changes' button 

4.3.8.3.7.How can I make a glossary "read only" 
for students? 

 In Settings > Glossary administration > Permissions, set the Create new 

entries capability for Student to Prevent.  

4.3.8.3.8.How do I import entries from another 
glossary? 

See Import glossary entries. 

4.3.8.3.9.I am frustrated trying to import my old 
images glossary into my new glossary with 
XML 

Here is a workaround, there has to be an easier way but 

 Create a webfolder that you can link to. For example call it "images" 

 

 Add images to that folder 

 Export your XML file and edit it 

 Change the src="@@PLUGINFILE@@/ to something line 

src="Mydomain.edu/images/ for every entry in the file. 

 Save the XML file with a different name 

 Import that new XML file into your new glossary 

Now when you use the course import feature, your glossary will work in 

the new course. 

4.3.8.3.10.How can I make a glossary global? 
See this forum thread on making a glossary global. 

 

 

 

 

 

 

 

 

 

4.3.8.3.6.Как предотвратить авто-связывание Глоссария в 
Экзамене? 
 В AdministrationQuiz administrationFilters отключите авто-связывание Глоссария. 

 

 Щёлкните кнопку «Save changes». 

4.3.8.3.7.Как сделать, чтобы Студенты могли Глоссарий 
только читать? 
 В AdministrationGlossary administrationPermissions установите возможность «Create 

new entries (создать новые записи)» в «Prevent (не позволять)».  

4.3.8.3.8.Как импортировать Записи из другого Глоссария? 
 

См. Импортировать записи Глоссария. 

4.3.8.3.9.Я отчаялся, пытаясь импортировать мой старый 
Глоссарий изображений в новый Глоссарий с XML 
 

Здесь приведён искусственный приём того, как это легче сделать: 

 Создайте веб-папку, на которую вы можете сослаться. Назовём её, например, 

«изображения». 

 Поместите изображения в эту папку. 

 Экспортируйте ваш файл XML и отредактируйте его. 

 Измените «src="@@PLUGINFILE@@/» на некую строку «src=Mydomain.edu/images/» 

для каждой записи в этом файле. 

 Сохраните файл XML под другим именем. 

 Импортируйте новый файл XML в ваш Глоссарий. 

Теперь, когда вы используете средство импортирования Курса, ваш Глоссарий 

будет работать в новом Курсе. 

4.3.8.3.10.Как сделать Глоссарий глобальным? 
См. Этот форум по созданию глобального Глоссария. 

http://docs.moodle.org/25/en/Import_glossary_entries
https://moodle.org/mod/forum/discuss.php?d=222800&parent=968960#p969057
http://docs.moodle.org/25/en/Import_glossary_entries
https://moodle.org/mod/forum/discuss.php?d=222800&parent=968960#p969057
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4.3.8.3.11.What is the code for the different 
display formats? 

The table below summarizes the different display formats. 

 

 

 

 

 

 

 

 

 

 
 

* Attached images are shown inline. 

4.3.8.3.12.See also 
 Using Moodle Glossary module forum 

 Import and export FAQ 

 XML FAQ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.3.8.3.11.Какова кодировка различных форматов 
отображения? 

Таблица ниже подводит итог различным форматам отображения. 

* Вложенные изображения показываются в строке. 

4.3.8.3.12.См. также 
 Использование Moodle: форум «Модуль ‘Глоссарий’». 

 Часто задаваемые вопросы по экспорту и импорту. 

 Часто задаваемые вопросы по XML. 

Формат Запись Автор Дата Определение 
Изображени

я 
Вложения 

Список записей x - - x x Ссылка 

Простой словарь x - - x x Ссылка 

Непрерывный x - - x x Ссылка 

Часто задаваемые 

вопросы 
x - x x x Ссылка 

Полный без автора x - x x x Ссылка 

Полный с автором x x x x x Ссылка 

Энциклопедия x x x x x x* 

http://moodle.org/mod/forum/view.php?f=126
http://docs.moodle.org/25/en/Import_and_export_FAQ
http://docs.moodle.org/25/en/XML_FAQ
https://moodle.org/mod/forum/view.php?f=126
http://docs.moodle.org/25/en/Import_and_export_FAQ
http://docs.moodle.org/25/en/XML_FAQ
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4.3.9.Lesson 
For delivering content in flexible ways. 

Lesson module 
The lesson module presents a series of HTML pages to the student who is 

usually asked to make some sort of choice underneath the content area. 

The choice will send them to a specific page in the Lesson. In a Lesson 

page's simplest form, the student can select a continue button at the bottom 

of the page, which will send them to the next page in the Lesson. 

There are 2 basic Lesson page types that the student will see: question 

pages and content pages. There are also several advanced navigational 

pages which can meet more specialized needs of the Teacher. The Lesson 

module was designed to be adaptive and to use a student's choices to create 

a self directed lesson. 

 

The main difference between a Lesson and other activity modules available 

in Moodle comes from its adaptive ability. With this tool, each choice the 

students makes can show a different teacher response/comment and send 

the student to a different page in the lesson. Thus with planning, the 

Lesson module can customize the presentation of content and questions to 

each student with no further action required by the teacher. 

4.3.9.1.Lesson settings 
4.3.9.1.1.Lesson administration settings 
This page explains the settings involved when first creating a lesson. To 

add a lesson to your Moodle course page: 

With the editing turned on, in the section you wish to add your lesson, 

click the "Add an activity or resource" link (or, if not present, the "Add an 

activity" drop down menu) and choose Lesson All settings may expanded 

by clicking the "Expand all" link top right. 

General 
Screenshot «General settings expanded by default. 

Name 
Whatever you type here will form the link learners click on to view the 

lesson so it is helpful to give it a name that suggests its purpose. 

 

 

 

 

 

4.3.9.Урок 
Для предъявления материалов по обучению разнообразными способами. 

Модуль «Урок» 
Модуль «Урок» предоставляет серию страниц HTML Студенту, и обычно 

предлагает ему сделать какой-либо выбор внизу содержательной части. Этот выбор 

отправит его на конкретную страницу в Уроке. Внизу начальной страницы Урока Студент 

может выбрать кнопку «Continue (продолжить)», которая отправит его на следующую 

страницу в этом Уроке. 

Имеется два базисных типа страниц Урока, которые могут увидеть Студенты: 

страницы вопросов и страницы контента (содержимого). Существует также несколько 

продвинутых навигационных страниц, которые могут удовлетворить более 

специализированные потребности Преподавателя. Модуль «Урок» был разработан так, 

чтобы его можно было адаптировать и использовать Студентами для создания уроков по 

своему выбору. 

Основное различие между Уроком и другими модулями Интерактивных Действий 

в Moodle, связано с его адаптивностью. С этим инструментом, каждый выбор Студента 

может показывать различные ответы/комментарии Преподавателя и отсылать Студента на 

различные страницы в этом Уроке. С таким планированием модуль «Урок» может 

настроить презентацию содержимого и вопросов для каждого Студента, без 

дополнительных действий со стороны Преподавателя. 

4.3.9.1.Настройки Урока 
4.3.9.1.1.Настройки управления Уроком 

Эта страница объясняет настройки, включённые при первом создании Урока. 

Чтобы добавить Урок на страницу вашего Курса Moodle, сделайте следующее: 

При включённом режиме редактирования в Разделе, в который вы хотите 

поместить ваш Урок, щёлкните ссылку «Add an activity or resource» (или, если она не 

присутствует, ниспадающее меню «Add an activity») и выберите «Lesson». Все настройки 

могут быть развёрнуты щелчком по ссылке «Expand all» вверху справа. 

Обычные настройки 
Снимок с экрана «Общие настройки, развёрнутые по умолчанию». 

Наименование 
Что бы вы ни напечатали здесь, оно сформирует ссылку, щёлкнув которую 

учащиеся увидят этот Урок; поэтому полезно дать ему имя, выражающее его цель. 

http://docs.moodle.org/25/en/File:Lessonexample.png
http://docs.moodle.org/25/en/File:Lessonexample.png
http://docs.moodle.org/25/en/File:lessongeneral25.png
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Appearance 
Screenshot «Appearance settings expanded». 

File pop 

If you want to include a link to a file on the lesson page for students to 

refer to, upload it here. 

Progress bar 

Choose this to show a bar at the bottom of the page showing how far into 

the lesson the student has got. 

Display ongoing score 

Choose this to let students see their score as they work through the lesson. 

 

Display left menu 

Choose this if you want to show a list of the pages in the Lesson so a 

student can see what is coming up. 

Minimum grade to display menu 

Choose this if you want the student to go through the lesson once and get a 

grade before they can (on review) see and navigate through all the different 

pages. 

Slideshow 

Please note that slideshow mode currently does not work for Moodle 2. 

There is a tracker issue and patch here MDL-36673 

Maximum Number of Answers 

Here you can set the default number of answer boxes available when you 

add your question or content pages. For instance, if you are only going to 

use True/False, you would only need 2. You can change this at any time so 

it's not crucial. 

Use default feedback 

Choose this if you want to show a set phrase regardless of their answer. If 

you have set your own default feedback such as "well done; correct" or 

"never mind; better luck next time" etc it will appear. If you have not, then 

Moodle's default feedback will appear. 

Link to next activity 

Choose this to give students a link to another activity when they reach the 

end of the lesson. (Note: this can also be achieved using Conditional 

activities) 

Availability 
Screen «Availability settings expanded». 

Available from/Deadline 

Here you can set a start and end date and time for your Lesson. 

 

Внешний вид 
Снимок с экрана «Развёрнутые настройки Внешнего вида». 

Вызов файла 

Если вы хотите включить ссылку на файл на странице Урока, чтобы Студенты 

ссылались на него, сделайте это здесь. 

Индикатор выполнения хода задания 

Выберите это, чтобы показать индикатор внизу страницы, показывающий 

насколько далеко Студент продвинулся в освоении Урока. 

Отобразить текущее итоговое оценивание 

Выберите это, чтобы позволить Студентам видеть их оценку того, как они 

работают на протяжении Урока. 

Отобразить меню слева 

Выберите это, если хотите показать список страниц в Уроке, чтобы Студенты 

могли видеть, что ещё предстоит делать. 

Меню Минимальных Оценок для отображения  

Выберите это, если хотите, чтобы Студент прошёл одну порцию урока и получил 

оценку за это, прежде чем он начнёт (в режиме рецензии) работать над другими 

страницами. 

Слайд-шоу 

Пожалуйста, отметьте, что режим слайд-шоу в настоящее время не работает для 

Moodle 2. Имеется выпуск следящей системы и патч в MDL-36673. 

Максимальное число ответов 

Здесь вы можете установить число доступных по умолчанию окошек, когда вы 

добавляете вопрос или страницы с контентом. Например, если вы собираетесь 

использовать только True/False, вам нужно только 2. Вы можете изменить это в любое 

время, поэтому это не критично. 

Использовать обратную связь по умолчанию 

Выберите это, если хотите показать заданную фразу для любых ответов. Если вы 

установили по умолчанию вашу собственную Обратную Связь, такую как «хорошо 

сделано; правильно» или «ничего, в следующий раз повезёт» и т.д., она и появится. Если 

вы её не установили, появится Обратная Связь по умолчанию системы Moodle. 

Ссылка на следующее Интерактивное Действие 

Выберите эту опцию, чтобы дать Студентам ссылку на следующее 

Интерактивное Действие, когда они достигнут конца Урока. (Замечание: Этот же 

результат можно достичь с помощью Обусловленных Действий, см. п. 4.9.2) 

Доступность 
Снимок с экрана «Развёрнутые настройки доступности». 

Доступно с/Срок окончания 

Здесь можно установить дату и время начала и конца вашего Урока. 

http://docs.moodle.org/25/en/File:lessonappearance25.png
http://docs.moodle.org/25/en/File:lessonavailability25.png
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Time limit 

This allows you to set a time limit on the lesson. Students will see a 

countdown counter as they work. The timer does not stop them doing the 

lesson when the time is up, but correct answers are no longer scored. 

 

Password protected lesson 

Change to "Yes" and enter the password if you want students only to 

access it when they know the password. 

Prerequisite lesson 
Screen «Prerequisite lesson settings expanded». 

Dependent on 

This allows access to the lesson to be dependent on students' performance 

in another lesson in the same course. (Note: this can also be achieved 

with Conditional activities) 

Time spent 

Decide here how long you want the student to have spent in the chosen 

previous lesson 

Completed 

Check this box if you want the student to have completed a previous lesson 

(according to Activity completion settings). 

Grade better than 

Enter the grade from the previous lesson which you want the student to 

have exceeded before they can attempt the current lesson. 

Flow control 
Screen «Flow control settings expanded». 

 

Allow Student Review 

This puts a "Review Lesson" button on the last screen of the lesson to 

encourage the student to navigate through the lesson again from the start. 

Be sure to check other settings to allow them to change their answers. 

Provide option to try a question again 

This displays a button after an incorrectly answered question so that the 

student can try again (but not get credit for it) 

TIP: Leave this off if you are using essay questions. 

Maximum Number of Attempts 

Decide here how many times you want students to be able to attempt each 

question. When they reach the maximum, they will be taken automatically 

to the next page. 

 

 

Ограничение времени 

Эта опция позволяет установить ограничение Урока по времени. 

Студенты увидят циферблат с обратным отсчётом времени их работы. 

Таймер не останавливает их работу над Уроком по истечении времени, но правильные 

запоздавшие ответы не включается в Итоговую Оценку. 

Пароль защиты Урока 

Включите «Yes» и введите пароль, если вы хотите, чтобы Студенты имели доступ 

к Уроку, только если они знают этот пароль. 

Необходимый предварительный Урок 
Снимок с экрана «Развёрнутые настройки предварительного Урока». 

Зависимый от 

Эта опция разрешает доступ к данному Уроку в зависимости от выполнения 

Студентами другого Урока в этом же Курсе. (Замечание: Это же может быть достигнуто с 

помощью Обусловленных Действий, см. п. 4.9.2) 

Затраченное время 

Определите здесь, сколько времени должен потратить Студент на предварительно 

выбранный Урок. 

Завершённый 

Пометьте это окошко, если вы хотите, чтобы Студент завершил предыдущий Урок 

(в соответствии с настройками Завершения Действий, см. п. 4.9.3). 

Улучшить Оценку 
Введите Оценку за предыдущий Урок, если желаете, чтобы Студент её повысил, 

прежде чем он начнёт выполнять текущий Урок. 

Управление последовательностью работ 
Снимок с экрана «Развёрнутые настройки управления последовательностью 

работ». 

Разрешить Студентам рецензировать 

Это расположит кнопку «Review Lesson (Рецензировать Урок)» на последнем 

экране этого Урока, чтобы поощрить Студентов снова пройтись по Урокам с самого 

начала. Пометьте другие настройки, чтобы разрешить им изменять их ответы. 

Задать опцию повторных попыток ответить на Вопрос 

Это отобразит кнопку после неправильного ответа на Вопрос так, что каждый из 

Студентов может попытаться ответить снова (но не получить за это «кредит»). 

Совет: Не делайте этого, если используете Вопросы, требующие написания Эссе. 

Максимальное число попыток 

Определите здесь, сколько раз Студентам можно пытаться ответить на каждый 

Вопрос. Когда они достигнут максимума, то автоматически перейдут на следующую 

страницу. 

http://docs.moodle.org/25/en/Conditional_activities
http://docs.moodle.org/25/en/Activity_completion
http://docs.moodle.org/25/en/File:prerequisitelesson25.png
http://docs.moodle.org/25/en/File:lessonflowcontrol25.png
http://docs.moodle.org/25/en/File:lessonflowcontrol25.png
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Action after a Correct Answer 

Choose here where you want a student to be sent to if they get a question 

right. See Using Lesson for more details on this setting. The options are: 

 the next part of the Lesson (default setting) 

 a random, unexpected page 

 a random page which they have not yet answered. 

Number of pages to show 

You only need this if you have set "Action after a correct answer" to show 

an unseen or unanswered page. Otherwise, all pages will be seen 

 

Grade 
Screen «Grade settings expanded». 

Set a grade and grade category here. 

Practice lesson 

Use this if you don't need the lesson to be scored/graded but just need 

students to work through some pages. Set this to Yes to have the same 

ungraded type Lesson in earlier versions of Moodle. 

 

Custom Scoring 

Use this to give a particular number score (negative or positive) to each 

answer. 

Re-takes allowed 

Choose this if you want your students to be able to do the lesson more than 

once. 

Handling of re-take 

If you allow your students to re-take the lesson, then decide here if the 

grade for all lesson attempts is the mean or the maximum. 

 

Note that the Question Analysis always uses the answers from the first tries 

of the lesson. Re-takes by students are ignored. 

Minimum Number of Questions 

Set here the minimum number of questions that will be used to calculate a 

student's score. Students will be told how many they have answered and 

how many more they need to answer. 

 If you are using Content pages, then set this to 0. 

 If you use this setting, then add some explanatory text at the start of the 

lesson so the student knows how many questions they must answer as a 

minimum. (They may answer more.) 

 

 

Действие после правильного ответа 

Выберите здесь, куда отправить Студентов после того, как они правильно ответили 

на Вопрос. См. п. 4.3.9.2 для получения подробностей по этой настройке. Опции: 

 следующая часть Урока (настройка по умолчанию) 

 случайная, неожиданная страница 

 случайная страница, на которую они ещё не отвечали. 

Сколько страниц показывать 

Вам это потребуется, только если вы установили «Action after a correct answer», 

чтобы показать невидимые или не отвеченные страницы. Иначе будут видны все 

страницы. 

Оценка 
Снимок с экрана «Развёрнутые настройки Оценки». 

Установите здесь Оценку и Категорию Оценки. 

Обычный Урок 

Используйте это, если вам не нужно, чтобы этот Урок получил 

итоговое/качественное оценивание, но нужно, чтобы Студенты поработали на некоторых 

страницах. Установите эту опцию в «Yes», чтобы иметь тот же неоцениваемый тип Урока, 

что и в более ранних версиях Moodle. 

Пользовательское оценивание 

Используйте это, чтобы дать конкретную Числовую Итоговую Оценку 

(негативную или позитивную) каждому ответу. 

Повторное выполнение разрешено 

Выберите это, если вы хотите, чтобы ваши Студенты могли выполнять Урок более 

одного раза. 

Обработка повторного выполнения 

Если вы позволите вашим Студентам повторно выполнять этот Урок, то 

определите здесь, будет Оценка за все попытки выполнения всех Уроков Средняя или 

Максимальная. 

Заметьте, что Анализ Вопросов всегда использует ответы из первых попыток 

выполнения этого Урока. Повторные выполнения игнорируются. 

Минимальное число вопросов 

Установите здесь минимальное число Вопросов, которые будут использоваться для 

вычисления Итоговой Оценки. Студентам будет сообщено, на сколько Вопросов они уже 

ответили, и на сколько ещё Вопросов им надо ответить. 

 Если вы используете страницы с контентом, тогда установите эту опцию в 0. 

 Если вы используете эту настройку, то добавьте некоторый объяснительный текст в 

начале этого Урока, чтобы Студенты знали, минимум на сколько Вопросов они должны 

ответить. (Они могут ответить больше.) 

http://docs.moodle.org/25/en/File:lessongrade25.png
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Common module settings 
See Common module settings. 

Restrict access/Activity completion 
The Restrict access and Activity completion settings are visible if 

Conditional activities and Activity completion have been enabled in the 

site and the course. 

Site administration settings 
The lesson module has additional settings which may be changed by an 

administrator in 

Settings>Site administration>Plugins>Activity modules> Lesson. 

NOTE: The slideshow settings below do not work. See MDL-36673 

 

Slideshow width 

Sets the width of the slideshow only when this feature is enabled in a 

Lesson's "Change settings". 

 Variable name: lesson_slideshowwidth, Default 640. 

Slideshow height 

Sets the height of the slideshow only when this feature is enabled in a 

Lesson's "Change settings". 

 Variable name: lesson_slideshowheight, Default 480. 

Slideshow background colour 

Background colour to for the slideshow if it is enabled. 

 Variable name: lesson_slideshowbgcolor, Default #FFFFFF. 

Popup window width 

Sets the width of the popup displayed for a linked media file 

 

 Variable name: lesson_mediawidth, Default 640. 

Popup window height 

Sets the height of the popup displayed for a linked media file 

 

 Variable name: lesson_mediaheight, Default 480. 

Show close button: 

Displays a close button as part of the popup generated for a linked media 

file 

 Variable name: lesson_mediaclose, Default No. 

Number of high scores displayed 

Sets the number of high scores to display 

 Variable name: lesson_maxhighscores, Default: 10 

 

Общие настройки модуля 
См. п. 6.1. 

Ограничить Доступ/Завершение Действия 
Настройки ограниченного доступа и завершения Действия видимы, если на Сайте 

или в Курсе разрешены Обусловленные Действия и Завершение Действий. 

 

Настройки управления Сайта 
Модуль «Урок» имеет дополнительные настройки, которые могут быть 

изменены Администратором в 

AdministrationSite administrationPluginsActivity modulesLesson. 

Замечание: Настройки слайд-шоу, приведённые ниже, не работают. См. MDL-

36673. 

Ширина слайд-шоу 

Устанавливает ширину слайд-шоу только тогда, когда это средство разрешено в 

«Изменить настройки» Урока. 

 Имя переменной: lesson_slideshowwidth – ширина слайд-шоу по умолчанию: 640. 

Высота слайд-шоу 

Устанавливает высоту слайд-шоу только тогда, когда это средство разрешено в 

«Изменить настройки» Урока. 

 Имя переменной: lesson_slideshowheight – высота слайд-шоу по умолчанию: 480. 

Цвет фона слайд-шоу 

Цвет фона для слайд-шоу, если это разрешено. 

 Имя переменной: lesson_slideshowbgcolor – цвет фона по умолчанию: #FFFFFF. 

Ширина всплывающего окна 

Устанавливают ширину всплывающего окна, отображаемого для связанного 

медиа-файла. 

 Имя переменной: lesson_mediawidth – ширина слайд-шоу по умолчанию: 640. 

Высота всплывающего окна 

Устанавливают высоту всплывающего окна, отображаемого для медиа-файла, 

вызываемого по ссылке. 

 Имя переменной: lesson_mediaheight – высота слайд-шоу по умолчанию: 480. 

Показать кнопку закрытия 

Отображает кнопку закрытия как часть генерируемых средств для отображения 

связанного медиа-файла. 

 Имя переменной: lesson_mediaclose – по умолчанию: «No». 

Число отображаемых самых высоких накопленных баллов 

Устанавливает число самых высоких накопленных баллов для отображения. 

 Имя переменной: lesson_maxhighscores – по умолчанию: 10. 

http://docs.moodle.org/25/en/Common_module_settings
http://tracker.moodle.org/browse/MDL-36673
https://tracker.moodle.org/browse/MDL-36673
https://tracker.moodle.org/browse/MDL-36673
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Maximum number of answers 

Default maximum number of answers per page for site 

 Variable name: lesson_maxanswers, Default: 4. 

Action after correct answer 

The default action to take after a correct answer 

 Variable name: lesson_defaultnextpage, Default: Normal - follow 

lesson path 

4.3.9.2.Building Lesson 
This page is about how to structure a Moodle lesson once you have created 

it with the Lesson settings. For information on how best to use a Moodle 

lesson and how students approach it, see Using Lesson 

4.3.9.2.1.Planning your lesson 
 A lesson is made up of pages which may have content for the student to 

read or questions for them to answer. The questions can be created by 

the teacher or imported. The teacher decides the order in which these 

pages appear. You need to have a clear idea beforehand of what you 

want to do with this lesson. Is it to be a graded, linear learning 

experience? 

 Or an ungraded, non-linear practice session? Will students be able to go 

back and revisit areas or is it just a once-only opportunity? 

 

 Even those who are very comfortable working directly online might 

find it useful to note down on paper the direction they want their lesson 

pages to go in, rather than having to remember and visualize the 

navigation in their head. 

 For hints and ideas about using the Lesson module, look at Using 

Lesson and Lesson FAQ 

 

 

 

 

 

 

 

 

 

 

 

 

Максимальное число ответов 

Максимальное число ответов на страницу по умолчанию для Сайта. 

 Имя переменной: lesson_maxanswers, по умолчанию: 4. 

Действие после правильного ответа 

Предпринимаемое по умолчанию действие после правильного ответа. 

 Имя переменной: lesson_defaultnextpage, по умолчанию: Normal (нормально) – 

следовать далее по Уроку. 

4.3.9.2.Разработка Урока 
Эта страница о том, как структурировать Урок Moodle сразу после его создания в 

п. 4.3.9.1. О том, как лучше использовать Урок Moodle, и как Студентам обращаться с ним, 

см. в п. 4.3.9.3. 

4.3.9.2.1.Планирование вашего Урока 
 Урок состоит из страниц, которые могут содержать контент, который Студенту нужно 

прочитать, или вопросы, на которые нужно ответить. Вопросы могут быть созданы 

Преподавателем или импортированы. Преподаватель определяет порядок, в котором 

появляются эти страницы. Вам нужно заранее ясно представлять себе, что вы хотите 

делать с этим уроком. Должен ли он быть традиционным линейным обучением с 

оценкой? 

 Или неоцениваемой нелинейной практической сессией? Будут ли Студенты способны 

вернуться и повторно посетить какие-то области, или это только однократная 

возможность? 

 Даже те, кто очень комфортабельно работает непосредственно в режиме онлайн, могут 

найти полезным делать заметки на бумаге о том, в каком направлении они хотят 

следовать по страницам этого Урока, вместо запоминания и визуализации этой 

навигации в их голове. 

 О советах и идеях по использованию модуля «Урок» см. «Использование Урока» 

(п. 4.3.9.3) и «Часто задаваемые вопросы по Уроку» (п. 4.3.9.4). 

http://docs.moodle.org/25/en/Lesson_settings
http://docs.moodle.org/25/en/Using_Lesson
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4.3.9.2.2.Adding content and questions to your 
lesson 
 When you have set up your lesson with the Lesson settings, click "Save 

and display" and you will be taken to the screen in the screenshot 

below. 

 If you click "Save and return to course" instead, then click the "update" 

icon next to the lesson on the page and click "edit" in the Settings 

block>Lesson Administration 

Screenshot. 

Import questions 

 If you have some questions in the following formats, you can import 

them to use in your lesson by clicking the Import questions link. For 

general information about these question types, see Import questions. 

Screenshot "Import questions". 

Add a cluster 

 A cluster is a group of question pages which will be offered randomly 

to a student as they work through the lesson. It is best if you have made 

the question pages beforehand and can then decide where to mark the 

start and end of the cluster. The start is marked by a "cluster" page and 

the end by an "end of cluster" page. See Clusters for more information. 

Add a content page 

 This is a page where a teacher can provide information to move the 

lesson forward but without requiring the student to answer specific 

questions. 

 The student sees the page's title, some information and then one or more 

buttons at the bottom to select. 

 When the student clicks on a button, they go to the next page but their 

choice is not scored. 

Title 

 The title of a content page appears to the student at the top of the page. 

 A teacher will also see the title in the collapsed edit mode when they are 

working on the Lesson, and they will also be able to choose the title 

(and hence this page) from the drop down "jump" lists. Тhe teacher will 

have their titles appear in this dropdown, allowing them to be selected. 

 The title in a content page is also used with the "display left menu" 

setting. 

 

 

 

4.3.9.2.2.Добавление содержимого и Вопросов к вашему 
Уроку 
 Когда вы установили ваш Урок с помощью «Настройки Урока» (п. 4.3.9.1), щёлкните 

«Save and display», и перед вами предстанет снимок с экрана ниже. 

 

 Если вы вместо этого щёлкнете «Save and return to course», то щёлкните и иконку 

«Update» рядом с этим Уроком на этой странице и щёлкните «Edit» в блоке 

AdministrationLesson Administration. 

Снимок с экрана. 

Импортировать вопросы 

 Если у вас есть вопросы в следующих форматах, вы можете импортировать их, чтобы 

использовать в вашем Уроке, щелчком по ссылке «Import questions». Общая 

информация об этих типах Вопросов см. в Импортировать Вопросы. 

Снимок с экрана «Импорт вопросов». 

Добавить кластер 

 Кластер является группой страниц Вопросов, которые случайным образом предлагают 

Студенту в процессе работы над Уроком. Лучше, если вы заранее создадите страницы 

Вопросов, и решите, где обозначить начало и конец этого кластера. Начало отмечается 

страницей «Cluster», а конец – страницей «End of cluster». См. подробности о кластерах. 

 

Добавить страницу с содержанием 

 Это страница, на которой Преподаватель может предоставить информацию, нужную 

чтобы продвинуться по Уроку, не требуя от Студента ответа на конкретные Вопросы. 

 

 Студент видит заголовок страницы, некоторую информацию, и затем одну (или более) 

кнопку внизу для выбора. 

 Когда Студент щёлкнет по кнопке, он перейдёт на следующую страницу, но их выбор 

не оценивается. 

Заголовок 

 Заголовок страницы контента предстаёт перед Студентом вверху странице. 

 Преподаватель также увидит этот заголовок в режиме свёрнутого редактирования, 

когда он работает по этому Уроку, и он также будет способен, выбрать этот заголовок 

(и, следовательно, эту страницу) из ниспадающего списка «Jump». Преподаватель 

получит свои заголовки в ниспадающем меню, позволяющем им быть выбиранными. 

 Заголовок на странице с оглавлением также используется с настройкой «Display left 

menu (отобразить меню с левой стороны)». 

http://docs.moodle.org/25/en/Lesson_settings
http://docs.moodle.org/25/en/File:lessonppt1810.png
http://docs.moodle.org/25/en/Import_questions
http://docs.moodle.org/25/en/File:importquestions.png
http://docs.moodle.org/25/en/Clusters
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Page contents 

 This is where the teacher can add information for the student, making 

use of the Text editor and its multimedia features. 

Content 

 Here the teacher writes the words they want the student to click on to 

get to the next part of the lesson. 

 These words will appear to the student as a button. 

 The teacher can check the box to have the buttons appear horizontally, 

or uncheck it for them to appear centered vertically. 

Format 

 There are 4 format types to choose from when editing text in the 

content description box. If you wish to have the usual rich text editing 

icons, choose HTML format. (Note - once you have selected an option, 

you cannot then go back and change your mind!) However, if you DO 

choose HTML format, be warned that the student will not see the 

changes (such as bold or different colours) in the button. 

Screenshot. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Содержимое страницы 

 Это то место, куда Преподаватель может добавить информацию для Студентов, 

используя текстовый редактор и его мультимедийные средства. 

Содержание 

 Здесь Преподаватель пишет те слова, которые для Студентов будут ссылками для 

перехода к следующей части Урока. 

 Эти слова предстанут перед Студентом в виде кнопок. 

 Преподаватель может пометить «галочкой» это окошко, чтобы кнопки выстроились 

горизонтально, или уберите «галочку», чтобы они расположились вертикально. 

Формат 

 Существует 4 типа форматов для выбора при редактировании текста в окошке описания 

оглавления. Если вы хотите иметь иконки обычного полного текстового редактора, 

выберите формат HTML. (Заметьте, что после того, как вы выбрали эту опцию, вы не 

сможете затем вернуться и изменить ваше намерение!) Однако, если вы выберете 

формат HTML, знайте, что Студент не увидит изменения (такие как полужирный текст 

или различные цвета) по этой кнопке. 

Снимок с экрана. 

http://docs.moodle.org/25/en/File:lessoncontentbuttons.png.
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Number of options available 

 How many of these you have depends on your choice in the Maximum 

Number of Answers setting in Lesson settings. 

The Jump 

 Each Description in a Content page has a Jumps menu. "Jumps" take a 

student from one page to another. 

 A "relative jump" is "next page" or "end of lesson" whereas an 

"absolute jump" gives the actual name of a page. 

 The teacher chooses from the dropdown the correct page to send the 

student to if they click on the button that will be made from this 

particular description. Any pages created by the teacher will have their 

titles appear in this dropdown,  

allowing them to be selected. 

 When a student clicks on a description button, they are sent to the page 

defined in the Jump associated with the button. 

 See Jumps for more detailed information. 

Add a question page 

From this link you can choose from a variety of question types which will 

then be added as pages to your lesson: 

Screenshot. 

 (Note: These question types are not the same as for the Quiz and are in 

no way connected with quiz questions.) 

 The format of question pages is similar to content pages outlined 

in Section 2.4 above. 

 A typical question page could include: 

 Title - the name the student sees at the top of the question page. 

 Page contents - the actual question. 

Screenshot. 

 Answer/Response/Format/Jump/Score as in the screenshot below 

Question types 

Multichoice 

 The student is given a question and a list of answers. The answer list 

will be shuffled every time the question is view by a student. By default 

they choose one answer but you can check the box "multiple answer" to 

allow them to choose more than one answer. 

Essay 

 Students can write a longer answer as part of the lesson and this can be 

graded manually by the teacher. If the main purpose of your lesson is 

for students to write an essay, consider the Assignment module instead. 

Число доступных опций 

 Сколько их у вас, будет зависеть от вашего выбора в настройке «Maximum Number of 

Answers (максимальное число ответов)» в «Настройки Урока» (п. 4.3.9.1). 

Переход на другую страницу 

 Каждое описание на странице с оглавлением имеет меню «Jumps». «Jumps» переводит 

Студента с одной страницы на другую. 

 «Relative jump» есть «Next page» или «End of lesson», тогда как «Absolute jump» даёт 

реальное имя страницы. 

 Преподаватель выбирает из ниспадающего меню правильную страницу, на которую 

отправить Студента, если он щёлкнет по этой кнопке, что будет сделана на основе 

этого описания. Любые страницы, созданные Преподавателем, появятся в этом 

ниспадающем меню, разрешая их выбирать. 

 

 Когда Студент щёлкнет по кнопке описания, его переведут на страницу, определённую 

в «Jumps», связанной с этой кнопкой. 

 См. «Jumps» для более подробной информации. 

Добавить страницу Вопросов 

По этой ссылке вы можете выбрать из различных типов Вопросов те, которые 

будут затем добавлены в качестве страниц в ваш Урок:  

Снимок с экрана. 

 (Замечание: Эти типы вопросов не те же самые, что и для Экзамена, и никоим образом 

не связаны с вопросами Экзамена.) 

 Формат страниц Вопросов похож на страницы с оглавлением, обведённые рамочкой 

выше в п. 4.3.9.2.2 под заголовком «Добавить страницу с оглавлением». 

 Типичная страница вопросов может включать: 

 Заголовок – наименование, которое Студент увидит вверху страницы Вопросов. 

 Содержимое страницы – реальный вопрос. 

Снимок с экрана. 

 Ответ/Отклик/Формат/Скачок/ИтоговаяОценка, как на снимке с экрана. 

Типы вопросов 

Множественный выбор 

 Студенту задаётся Вопрос и список ответов. Список ответов будет перетасовываться 

каждый раз, когда Вопрос просматривается Студентом. По умолчанию он выбирает 

один ответ, но вы можете пометить «галочкой» окошко «Multiple answer», чтобы 

позволить ему выбрать более одного ответа. 

Эссе 

 Студенты могут написать длинный ответ, как часть Урока, и он может быть вручную 

оценён Преподавателем. Если основная цель вашего Урока в том, чтобы Студенты 

написали Эссе, возьмите вместо Урока модуль «Задание». 

http://docs.moodle.org/25/en/Lesson_settings
http://docs.moodle.org/25/en/Jumps
http://docs.moodle.org/25/en/Quiz
http://docs.moodle.org/25/en/Building_Lesson#Add_a_content_page
http://docs.moodle.org/25/en/Jumps
http://docs.moodle.org/25/en/File:addquestionpage.png
http://docs.moodle.org/25/en/File:examplequestion.png
http://docs.moodle.org/25/en/File:exampleanswer.png
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Matching 

 This allows you to set up lists which must be matched against other 

lists, for instance, words, pictures, numbers etc. The student must match 

all correctly to receive the score. 

Numerical 

 This requires a number as an answer. A number within a range may also 

be accepted as correct. The range separator to be used is the colon : For 

example, to accept as correct any number between 10 and 12 (10, 11 

and 12) you would type 10:12 in the Answer box. 

 

Short answer 

 A student must provide a single word or short phrase answer. The 

teacher must anticipate the possible answers and enter them in the Jump 

dropdown boxes, using ** wild cards if appropriate. 

 

True/false 

 The student is given a sentence and must decide if it is true or false.  

4.3.9.2.3.Moving your lesson forward 
 Once you have added your first content or question page, you reach the 

next screen which displays your page title/type/jumps (ie where the 

responses take the student to) and actions you can take next: 

 

Screenshot: 

 The Actions icons allow you to move (if you have more than one), edit, 

preview or delete your pages. 

 

 The drop down allows you to create another page of your choice: 

Screenshot. 

 Note the different view options. 

Collapsed view 
 This gives a brief outline of the lesson structure as in the two 

screenshots above. 

Expanded view 
 This shows more detail as in the screenshot below: 

4.3.9.2.4.Ending your lesson 
 To bring the lesson to a close, select the "End of Lesson" 

option from the Jump menu on any relevant pages. 

 The student will then see a generic message as in the next screenshot, 

with a direction back to the main course page or to view their grades: 

Сопоставление 

 Эта опция позволяет вам установить списки, которые должны быть сопоставлены с 

другими списками, например, слов, рисунков, чисел и т.д. Студент должен сопоставить 

всё правильно, чтобы получить Итоговую Оценку. 

Числовой 

 Эта опция требует числа в качестве ответа. Число внутри области значений может быть 

также принято в качестве правильного. Разделитель значений области, который должен 

использоваться, – двоеточие. Например, чтобы в качестве правильного ответа принять 

любое число между 10 и 12 (10, 11 и 12) вам нужно набрать 10:12 в окошке «Answer 

(ответ)». 

Краткий ответ 

 Студент должен обеспечить ответ из единственного слова или краткой фразы. 

Преподаватель должен предусмотреть возможные ответы и ввести их в окошки с 

ниспадающим меню «Jump», используя, если потребуется, подстановочные символы 

«**». 

Да/Нет 

 Студенту даётся высказывание и ему нужно решить, правда это или ложь. 

4.3.9.2.3.Продвижение вперёд в вашем Уроке  
 Сразу, как только вы добавите первую страницу с содержимым или Вопросами, вы 

попадёте на следующий экран, который отображает вашу страницу title/type/jumps (т.е. 

куда отклики доставят Студента) и те действия, которые должны быть предприняты 

далее. 

См. снимок с экрана. 

 Иконка «Actions (ИнтерактивныеДействия)» позволяет вам переместить 

отредактировать, предварительно просмотреть или удалить ваши страницы (если вы 

имеете их больше, чем одну). 

 Ниспадающее меню позволяет вам создать другую страницу по вашему выбору. 

Снимок С Экрана. 

 Заметьте различные опции просмотра. 

Свёрнутый просмотр 
 Это даёт краткий очерк структуры Урока, как на двух снимках с экранов выше. 

 

Развёрнутый вид 
 Эта опция показывает больше подробностей, как на снимке с экрана. 

4.3.9.2.4.Окончание вашего Урока 
 Чтобы привести этот Урок к завершению, выберите опцию «End of Lesson (конец 

Урока)» из меню «Jump» на любых релевантных страницах. 

 Студент затем увидит универсальное сообщение, как на следующем снимке с экрана с 

обратным направлением на Основную страницу Курса или на просмотр их снимка. 

http://docs.moodle.org/25/en/File:lessonactions.png
http://docs.moodle.org/25/en/File:lessonactionsdropdown.png
http://docs.moodle.org/25/en/File:expandedview.png
http://docs.moodle.org/25/en/File:endoflesson1.png
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4.3.9.3.Using Lesson 
This page outlines how students and teachers interact with Moodle lessons 

once they have been created. For details on how to set up and then organise 

a lesson, see Lesson settings and Building Lesson 

4.3.9.3.1 What the student sees 
 A student clicking on a Lesson will see an introductory page with one 

or more buttons which they choose from to select the path they wish to 

take. 

 The display may vary according to how the teacher has set up the lesson 

in Lesson settings. For example; there may or may not be a list of pages 

down the side; there may or may not be an ongoing score. 

 

 Students progress through the lesson with either content pages (of 

information, which is not graded) or various types of question 

pages(which may be graded) When a question page is used, the 

following page gives the answer and feedback if offered: screenshot. 

 The lesson is ended when the student has met the criteria set by the 

teacher. This could be answering a certain number of questions 

correctly, accessing a certain number of pages with content (text, audio 

or video) or following a certain navigational path. A final page appears 

where the student can check their score, if applicable, and return to the 

main course page. 

4.3.9.3.2 What the teacher sees 
A teacher clicking on a lesson will see tabs at the top offering them the 

chance to preview, edit, view reports or grade essays in the lesson: 

screenshot. 

Preview 

 The lesson opens up in preview mode for the teacher. However, it will 

not show the score unless the teacher switches their role to a student. 

 

Edit 

 The Edit tab allows teachers to alter the lesson once it has been set up. 

There are two views - Collapsed and Expanded. See Building Lesson 

for more details on editing the lesson. 

 

Reports 

 The reports tab shows the performance of students taking the lesson. 

There is a general "Overview" and a "Detailed Statistics" tab. 

 

4.3.9.3.Использование Урока 
Эта страница обрисовывает то, как Студенты и Преподаватели взаимодействуют с 

Уроками Moodle после их создания. Подробности того, как установить и затем 

организовать Урок, см. в «Настройки Урока» (п. 4.3.9.1) и «Разработка Урока» (п. 4.3.9.2). 

4.3.9.3.1.Что видят Студенты 
 Студент, щёлкнув по Уроку, увидит вводную страницу с одной или более кнопками, 

выбирая которые, он задаёт путь по Уроку, который он хочет пройти. 

 

 Отображение на экране может изменяться в соответствии с тем, как Преподаватель 

распорядился настройками в «Настройки Урока» в п. 4.3.9.1. Например, Урок может 

представлять или не представлять собой список страниц вдоль боковой стороны 

страницы; он может представлять или нет текущую накопленную Итоговую Оценку. 

 Студенты могут продвигаться по Уроку, содержащему страницы с контентом 

(информацией, которая не оценивается), или страницы разного типа Вопросов (которые 

могут быть оценены). Когда используется страница Вопросов, следующая страница 

даёт ответ и Обратную Связь, если она предлагается. См. снимок с экрана. 

 Урок заканчивается, когда Студент удовлетворяет всем критериям, которые установил 

Преподаватель. Это может быть правильными ответами на какие-то из Вопросов, 

оцениванием ряда страниц с контентом (текстом, аудио, видео), или следованием 

определённому навигационному пути. Итоговая страница появляется тогда, когда 

Студент сможет узнать свою Оценку, если ему позволено это, и вернуться на Основную 

страницу Курса. См. снимок с экрана. 

4.3.9.3.2.Что видят Преподаватели 
Преподаватель, щёлкнув по Уроку, увидит ярлычки вверху, дающие ему возможность 

предварительного просмотра, редактирования, просмотра отчётов или оценки Эссе в 

этом Уроке. 

Предварительный просмотр 

 Урок открывается в режиме предварительного просмотра для Преподавателя. Однако, 

он не покажет итогового оценивания, если только Преподаватель не переключит свою 

Роль на Роль Студента. 

Редактировать 

 Ярлычок «Edit» позволяет Преподавателям внести изменения в Урок сразу после  

того, как он был установлен. Существуют два просмотра: Сжатый и Расширенный. О 

дополнительных подробностях по редактированию см. в «Разработка Урока» 

(п. 4.3.9.2). 

Отчёты 

 Ярлычки отчётов показывают выполнение Студентами Урока. Имеются ярлычки 

«Обзор» и «Детализированная статистика». 

http://docs.moodle.org/25/en/File:studentviewoflesson.png/
http://docs.moodle.org/25/en/File:studentendoflesson.png.
http://docs.moodle.org/25/en/File:teacherviewoflesson.png
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Overview 

Screenshot. 

By clicking on the specific attempt, the teacher can view the student's 

answers to specific questions. It is also possible to delete a student attempt 

by checking the attempt and using the pull down menu to change "Choose" 

to "Delete". 

 Below the "Overview" can also be seen general statistics: Average 

score, Average time, High score, Low score, High time, Low time. 

 

Detailed Statistics 

 More detailed reports on individual questions are available from this 

tab, as in the following screenshot: … 

Grade essays 

 Any essay questions which have been set in the lesson can be accessed 

and graded here. 

4.3.9.3.3 Grading lessons 
 Note that for a lesson to be graded, it must have at least one question 

where a student can receive a score and the lesson can not be a practice 

lesson. Grades are calculated when the student has completed a lesson. 

Grades are kept for every student attempt. 

4.3.9.3.4.Understanding Flow control 
 Settings > Lesson administration > Edit settings > Flow control group 

 Here are some examples to help you understand the Lesson flow control 

settings. Please note: 

 "Allow student review" setting applies to the review of a whole Lesson, 

whereas "Provide option to try a question again" setting applies to the 

review of an individual question page. When the student does not select 

the correct answer, 'Provide option to try a question again" setting will 

display 2 buttons. One will direct the student back to the question and 

the other to continue. 

"Maximum number of attempts" is designed to prevent a student from 

being stuck on "This page" where they continually put or select the wrong 

answer. It will override other settings, such as review or the option to try 

the question again. When exceeded, it will not allow a score to be recorded 

for that question. 

Case 1 

The teacher wants the student to be able to attempt any question no more 

than 3 times and be given the chance to answer the question again. The 

teacher wants the student to see the response attached to their answer. 

Обзор 

См. снимок с экрана. 

Щелчком по конкретной попытке Студентов ответить на Вопрос, Преподаватель 

может просмотреть ответы Студентов на конкретные Вопросы. Также можно удалить 

попытку Студента, проверив попытку, и используя ниспадающее меню, чтобы изменить 

«Choose (выбрать)» на «Delete (удалить)». 

 Ниже «Overview» можно также увидеть общую статистику: Среднюю 

Итоговую Оценку, Среднее время, Высшая Итоговая Оценка, Низшая Итоговая Оценка, 

Наибольшее время, Наименьшее время. Снимок с экрана. 

Детализированная статистика 

 Более детализированные Отчёты по индивидуальным вопросам доступны по этому 

ярлычку, как на следующем снимке с экрана. 

Оценить эссе 

 Любые Вопросы-эссе, которые были установлены в этом Уроке, могут быть доступны и 

оценены здесь. 

4.3.9.3.3.Оценивание Уроков 
 Заметьте, что Урок, который должен быть оценён, должен иметь, по крайней мере, 

один Вопрос, за который Студент может получить Итоговую Оценку, а этот Урок не 

может быть практическим Уроком. Оценки вычисляются после завершения Урока 

Студентом. Оценки сохраняются по каждой попытке Студента. 

4.3.9.3.4.Понимание последовательности действий 
 AdministrationLesson administrationEdit settingsFlow control group. 

 Здесь некоторые примеры для помощи вам понять настройки последовательности 

действий в Уроке. Пожалуйста, заметьте: 

 Настройка «Allow student review (позволить Студенту пересмотр)» разрешает 

пересмотр всего Урока, в то время как настройка «Provide option to try a question  

again (обеспечить возможность попытки ответить на вопрос снова)» применяется для 

пересмотра отдельной страницы с Вопросом. Когда Студент выбирает неправильный 

ответ на Вопрос, настройка «'Provide option to try a question again» отобразит 2 кнопки. 

Одна будет отправлять Студента обратно на вопрос, а другая на продолжение. 

«Максимальное число попыток» предназначено, чтобы не дать Студенту застрять 

на одной странице, без конца вводя или выбирая неправильный ответ. Эта опция 

перекрывает другие настройки, такие как «Review (пересмотр)» или «Try the question again 

(повторная попытка ответить на вопрос)». При превышении эта опция не позволит 

начислять баллы в Итоговую Оценку за этот Вопрос. 

Вариант 1 

Преподаватель хочет, чтобы Студент мог пытаться ответить на любой Вопрос 

снова, но такая возможность ему даётся не более 3 раз. Преподаватель хочет, чтобы 

Студент увидел отклики на свои ответы. 

http://docs.moodle.org/25/en/File:lessonreportsoverview1.png
http://docs.moodle.org/25/en/File:lessonreportstatistics.png
http://docs.moodle.org/25/en/File:lessonreportsdetailed.png
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Flow control settings 

Allow student review Yes 

Provide option to try a question again No 

Maximum number of attempts 3 

Display default feedback No 

Number of pages to show 0 

Slideshow No 

Student selects wrong answer and will see: 

"Response for the wrong answer" (if any is shown) 

"Yes, I'd like to try again" button 

"Continue" button. 

Student selects correct answer and will see: 

"Response for the correct answer" (if any is shown) 

"Continue" button 

Case 2 

The teacher wants to allow the student 3 attempts at all questions but not 

see any feedback except the site default feedback for wrong answers. 

 

Flow control settings 

 Allow student review No 

Provide option to try a question again Yes 

Maximum number of attempts 3 

Display default feedback No 

Number of pages to show 0 

Slideshow No 

 Student selects wrong answer and will see: 

Not quite. Would you like to try again? as text over the 

"Yes, I'd like to try again" button 

'"No, I just want to go on to the next question" button 

Note: If the wrong answer jump is set to "This page" and the number of 

attempts is under the maximum, then the student will return to the 

question, regardless if they select "No, I just want to go on". 

 Student selects correct answer and will see: 

"Your answer: {gives the student's answer)" 

Response attached to the correct answer (if any) 

Case 3 

"Speed bump for speed clickers". Teacher only wants the student to get 

once chance to record an answer on any question. They will only see the 

response the teacher provides for any question, or the default feedback if 

no response has been set for the answer the student selected. 

Настройки последовательности действий по Уроку 

Позволить Студенту выполнить пересмотр   Yes 

Обеспечить опцию «повторной попытки ответа на Вопрос» No 

Максимальное число попыток     3 

Отобразить Обратную Связь по умолчанию   No 

Число страниц для показа      0 

Слайд-шоу        No 

Студент выбирает неправильный ответ и увидит: 

«Отклик на неправильный ответ» (если ответ был) 

Кнопка «Да, мне бы хотелось попытаться снова» 

Кнопка «Продолжить». 

Студент выбирает правильный ответ и увидит: 
«Отклик на правильный ответ» (если ответ был) 

Кнопка «Продолжить». 

Вариант 2 
Преподаватель хочет позволить Студенту позволить 3 попытки на все Вопросы, но 

не видеть никакую Обратную Связь, за исключением Обратной Связи по умолчанию для 

всего Сайта для неправильных ответов. 

Настройки текущего контроля 

 Разрешить Студенту пересмотр     No 

Предоставить опцию повторных попыток ответа   Yes 

Максимальное число попыток     3 

Отобразить Обратную Связь по умолчанию   No 

Число страниц для показа      0 

Слайд-шоу        No 

 Студент выбирает неправильный ответ, и увидит: 

«Не вполне. Вы хотите попытаться снова?» как текстовое сообщение над 

кнопкой «Да, я хотел бы повторить попытку» и 

кнопкой «Нет, я хочу перейти к следующему Вопросу» 

Замечание: Если переход по неправильному ответу установлен в «This page (эта 

страница)» и число попыток меньше максимума, то Студент вернётся к этому вопросу, 

даже если он выбрал «No, I just want to go on (Нет, я просто хочу продолжить)». 

 Студент выбирает правильный ответ, и видит: 

«Ваш ответ: {приводится ответ Студента}» 

Отклик, присоединённый к правильному ответу (если есть). 

Вариант 3 
«Быстрый дамп для быстрых переходов по щелчку». Преподаватель хочет, чтобы 

Студент получил только один шанс записать ответ на любой Вопрос. Он увидит только 

отклик, который Преподаватель сделает на Вопрос, или Обратную Связь по умолчанию, 

если на выбранный Студентом ответ не было отклика. 
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 Flow control settings 

Allow student review No 

Provide option to try a question again No 

Maximum number of attempts 1 

Display default feedback Yes 

Number of pages to show 0 

Slideshow No 

 Student selects wrong answer and will see: 

"Response for the wrong answer" (if any is shown) 

"Yes, I'd like to try again" button 

"Continue" button. 

 Note: When teacher sets the Jump to "This page" for a wrong answer, 

they will return to the page but their score will not change. 

 Student selects correct answer and will see: 

"Response for the correct answer" (if any is shown) 

"Continue" button 

4.3.9.3.5 Ideas for using Lessons 
 Because of its "branching" nature, the lesson module lends itself to a 

wide variety of activities, not all of which need to be graded. In addition 

to merely working through a list of question pages, here are some other 

suggestions: 

Self-directed learning of a new topic 

 Use the lesson to introduce a new topic. The learner starts out knowing 

nothing but can progress at his own pace, reviewing what he is not sure 

of and moving on when he feels ready. This can be much enhanced by... 

 

Allow for different learning styles 

 When using the lesson to introduce a new topic, offer pages that deliver 

the content in different ways, according to how the students prefer to 

learn. For example the button "do you prefer to read?" goes to a page of 

text; "do you prefer to watch a video?" goes to a screencast ; "do you 

prefer to listen to instructions?" - goes to a podcast and so on. 

 

Role play simulations/Decision-making exercises 

 Use the lesson to set up situations where the learner has to make a 

choice each time and the scenario changes according to their selection. 

This could be a medical emergency for example, deciding upon the 

correct treatment, or a customer relations exercise, learning how best 

to deal with an awkward client. In an educational establishment  

 Настройки текущего контроля: 

Позволить Студенту пересмотр     No 

Предоставить опцию повторных попыток ответа на Вопрос No 

Максимальное число попыток     1 

Отобразить Обратную Связь по умолчанию   Yes 

Число страниц для показа      0 

Слайд-шоу        No 

 Студент выбирает неправильный ответ, и видит: 

«Отклик на неправильный ответ» (если показан) 

Кнопка «Да, мне бы хотелось попытаться снова» 

Кнопка «Продолжить». 

 Замечание: Если переход по неправильному ответу установлен на «This page (эта 

страница)», то Студент вернётся к этому Вопросу, но его Оценка не будет изменяться. 

 Студент выбрал правильный ответ, и видит: 

«Отклик на правильный ответ» (если показан) 

Кнопка «Продолжить». 

4.3.9.3.5.Идеи по использованию Уроков 
 Из-за своей «ветвящейся» природы, модуль «Урок» подходит широкому множеству 

Действий, не все из которых нужно оценивать. Кроме опции работы над рядом страниц 

с Вопросами, существуют ещё и другие возможности: 

 

Само-направленное обучение новой теме 

 Используйте Урок, чтобы ввести новую тему. Учащийся начинает с того, что ничего не 

знает, но может прогрессировать в своём темпе, повторяя то, в чём он не уверен, и 

двигаясь вперёд, когда почувствует готовность. Это может быть значительно улучшено 

путём следующих опций… 

Разрешить различные стили обучения 

 При использовании Урока для введения новой темы, предлагайте страницы, которые 

доносят содержимое разными способами, соответствующими тому, как Студенты 

предпочитают учиться. Например, кнопка «do you prefer to read? (вы предпочитаете 

читать?)» ведёт на страницу текста; «do you prefer to watch a video? (вы предпочитаете 

смотреть видео?)» ведёт на просмотр фильма с экрана; «do you prefer to listen to 

instructions? (вы предпочитаете слушать указания?)» – ведёт к аудио-фрагменту и т.д. 

Ролевые игры и упражнения по принятию решений 

 Используйте Урок для создания ситуаций, где обучающийся должен каждый раз делать 

выбор, а сценарий меняется в соответствии с его выбором. Например, это может быть 

ситуацией выбора правильных действий при неотложной медицинской помощи, или 

упражнением по отношениям с клиентом для изучения того, как надо работать с 

трудным клиентом. В учебном заведении 
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it could serve well in Humanities subjects considering moral/ethical 

issues. 

Interactive fiction 

For younger (and not so younger!) students, the lesson can be used to 

create a "choose your own ending" type of story where the student reads a 

page (or even watches a video/listens to an audio file) and then decides 

upon the character's next move. Apart from the entertainment value of this, 

it could be used to help guide pre-teens to behave responsibly by taking 

decisions for a character who is in a potentially dangerous situation. 

 

Differentiated revision guides 

 Students can be taken to different sets of revision questions according 

to their answers, allowing them to progress from basic to intermediate 

to advanced according to their prior knowledge. 

More! 

 Have any other good ideas? Please add them here! 

4.3.9.4.Jumps 
 

4.3.9.5.Lesson FAQ 
4.3.9.5.1.What's a Branch Table? 
Older versions of Moodle called Lesson module Content pages "Branch 

tables". 

4.3.9.5.2.Import PowerPoint does not work 
More often than not, importing PowerPoints, especially later than MS 

Office 2003, will simply not work. 

Please read Import PowerPoint. 

Inserting_content_into_a_lesson_activity for alternatives to the import 

problem 

4.3.9.5.3.Jumps not working in a question 
A wrong answer should go to "this page" in my lesson. But after the 

student answers it, the student goes to the next page. 

 

 See adding/editing a lesson and Maximum Attempts in Lesson settings. 

If maximum attempt is set to 1, then the student will be advanced to the 

next page after they choice a wrong answer that is sent to "this page". If 

it is set to 2, after the student selects the wrong answer the 2nd time 

they will be sent to the next page. This can be used to keep the student 

out of an endless loop when than can not answer a question correctly. 

это может хорошо послужить при изучении гуманитарных дисциплин, 

рассматривающих моральные/этические проблемы. 

Интерактивный вымысел 

Для молодых (и не очень молодых!) Студентов Урок может быть использован, 

чтобы они создавали рассказ по типу «придумайте ваше собственное завершение 

истории», когда Студент читает страницу (или наблюдает видео/слушает аудио-файл), и 

затем решает, какими будут дальнейшие действия персонажа этой истории. Не говоря уж о 

развлекательном значении этого, это может быть использовано, чтобы прививать 

подросткам навыки ответственного поведения при принятии решений на месте персонажа, 

который оказался в потенциально опасной ситуации. 

Отсылки к отличающимся просмотрам 

 Студентам можно предлагать разные наборы Вопросов для просмотра, в зависимости 

от их ответов, позволяя им продвигаться от простого к среднему и повышенному 

уровню соответственно их исходным знаниям. 

Более! 

 Имеете какие-нибудь другие хорошие идеи? Пожалуйста, добавьте их здесь! 

4.3.9.4.Переходы 
См. 

4.3.9.5.Часто задаваемые вопросы по Уроку 
4.3.9.5.1.Что такое Таблица переходов? 

Старые версии Moodle называли «Таблицами перехода» страницы с Содержанием 

в модуле «Урок». 

4.3.9.5.2.Импорт PowerPoint не работает 
Более часто импортирование PowerPoints, особенно более поздние, чем MS Office 

2003 версии, просто не работают. 

Пожалуйста, прочитайте Import PowerPoint. 

«Inserting_content_into_a_lesson_activity» для альтернатив к проблеме импорта. 

 

4.3.9.5.3.Переходы по страницам не работают в Вопросе 
Неправильный ответ должен перевести на «эта страница» в моём Уроке. Но после 

ответов Студентов на это, каждый из Студентов переходит к следующей странице. 

 См. добавление/редактирование Урока и Максимум попыток в настройках Урока. Если 

максимум попыток установлен в 1, тогда Студент продвинется к следующей странице 

после выбора им неправильного ответа, который направит его на «эта страница». Если 

он установлен в 2, а Студент выберет неправильный ответ во второй раз, он будет 

отправлен на следующую страницу. Это может быть использовано, чтобы уберечь 

Студента от бесконечного цикла неправильных ответов. 

http://docs.moodle.org/25/en/Jumps
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4.3.9.5.4.Edits of answers or branch buttons are 
not saved 
I have a 4 answer multiple choice question. I can only seem to save the 

first two answers, their jumps and feedback. Any edits on the last answers, 

their jumps and feedbacks are not saved. 

Moodle does not tell me there is anything wrong. Same thing happened 

with a Content page. I can not seem to get the last two 

descriptions change after I save an edit. GRRRRR! 

 Go back to your lesson settings. Maximum number of answers is 

probably set to 2; change it to 4 or the maximum number of answers or 

descriptions in your lesson. Now the edits can be saved. 

Tip: Changing the "Maximum number" as a teacher builds a lesson is a 

trick used to limit scrolling passed unused answers or branch choices to 

get to the save button. For example, 15 pages have 4 choices but one 

page will have 8 choices. The teacher will use "Maximum number" at 8 

setting only when they initially create that page, then switch it back to 

4. They (and their students) will always see all 8 answers but the lesson 

setting will prevent them from editing some of them. 

 

4.3.9.5.5.What is a Branch? 
Many Moodlers call a series of pages in their lesson "a branch". Usually 

the student will enter the series by jumping from a page that is not directly 

before the "branch". Thus, a student will "branch" off the lesson path from 

a missed question and visit a series of pages for review before they are 

returned to the main lesson path again. 

Lesson also have special pages that create a cluster. These are also a series 

of page. 

Confused yet? Maybe Branch structures will help. 

4.3.9.5.6.Multiple Choice and Multianswer issues 
When I check the multianswer box in a multiple choice question, it does 

not work. It makes random jumps and does not put the teacher's response 

with the students choice. 

In a Lesson module multianswer question, all the correct choices must 

have the same jump and teacher response. All the wrong choices must also 

have the same jump and teacher response. 

The lesson was completed but it does not record it 

 Every lesson must have one question that a student must answer in 

order for it to show up in some reports. This can affect Grades and a 

Lesson's dependency setting (see other FAQs below). 

4.3.9.5.4.Редактирования ответов или кнопки переходов не 
сохраняются 

Я имею 4 ответа на Вопрос с Множественным Выбором. Я могу сохранить только 

первые два ответа, переходы по ним и Обратную Связь. Любые редактирования по 

последним ответам, их переходам и Обратным Связям не сохраняются.  

Moodle не сообщает мне, что есть что-то неправильное. То же самое случается со 

страницей Содержания. Я не могу представить, как изменить два последних 

описания после того, как я сохранил отредактированное. БРРРРР! 

 Вернитесь к настройкам вашего Урока. Максимальное число ответов, возможно, 

установлено в 2, измените его на 4 или максимальное число ответов или описаний в 

вашем Уроке. Теперь редактирование может быть сохранено. 

Совет: Изменение «Максимального числа» во время разработки Преподавателем 

Урока является приёмом, применяемым для ограничения прокрутки не используемых 

очередных ответов или выбираемых разветвлений для получения кнопки сохранения. 

Например, 15 страниц имеют 4 выбора, но одна страница будет иметь 8 выборов. 

Преподаватель будет использовать «Максимальное число», равное 8, только во время 

создания этой страницы, а затем переключит эту опцию назад в 4. Он и его Студенты 

будут всегда видеть все 8 ответов, но настройка Урока не позволит им редактировать 

некоторые из них. 

4.3.9.5.5.Что такое Ветвь? 
Многие пользователи Moodle называют серию страниц в их Уроке «Ветвь». 

Обычно Студенты проходят эту серию, прыгая со страницы, которая стоит не сразу перед 

очередной развилкой «Ветви». Таким образом, Студент отойдёт от маршрута Урока из-за 

пропущенного Вопроса, и посетит серию страниц для рецензирования, прежде чем он 

снова вернётся на основной маршрут Урока. 

Урок также имеет специальные страницы, которые образуют кластер, также 

являющийся серией страниц. 

Всё ещё смущены? Может быть, опция «Структуры Ветвей» поможет. 

4.3.9.5.6.Множественный Выбор и проблемы Мультиответа 
Если отметить «галочкой» окошко мультиответов в 

Вопросе с Множественным выбором, это не сработает. Это даст случайные переходы и не 

помещает отклик Преподавателя на выбор Студентов. 

В мультиответном Вопросе модуля «Урок» все правильные выборы должны иметь 

один и тот же переход и отклик Преподавателя. Все неправильные выборы также должны 

иметь один и тот же переход и отклик Преподавателя. 

Урок завершён, но это не регистрируется 

 В каждом Уроке Студент должен отвечать на Вопросы по одному в порядке 

очерёдности, что и будет показано в некоторых отчётах. Это может влиять на Оценки 

(п. 6.2) и настройки Уроков (см. ниже другие Часто задаваемые Вопросы). 

http://docs.moodle.org/25/en/Lesson_clusters
http://docs.moodle.org/25/en/Branch_structures


 

168 

Tip: There are lots of creative ways to put in a question, such as setting a 

multiple choice question so that all answers are correct and the answers act 

like a content page. Or put in content and then award 1 point for "next 

page" as the answer and do not include the score in grades. 

 

Tip: Due to a specific Lesson's design, some students can complete the 

lesson without answering one or more questions which have been placed in 

the Lesson. When Lesson can not record any scores for a student, no grade 

is pushed to the gradebook. It may appear therefore that Lesson is being 

inconsistent in recording grades. 

Dependency in Lesson does not work 

The second lesson tells the student they must complete the first one. They 

did - what is wrong? 

 For dependency to work, you need to have at least 1 question page in 

the lesson. The student may not need a minimum score, but Lesson 

needs to know that the student tried a question. You can always put a 

question as the first or last page, You don't need to ask a question but 

do put in an answer of "continue" with a jump of the next page. 

 

 Also for dependency to work, the lesson can not be a practice lesson. 

4.3.9.5.7.Are there some examples of Lessons I 
can see? 
There are many examples of lessons on the School demo site 

http://school.demo.moodle.net/ which you can access as a guest or log in to 

use it more interactively. To name but two: there is an example in the 

World of Water course here and the Basic Moodle and Mountaineering 

course 

4.3.9.5.8.The lesson was completed but it does 
not record it 
 Every lesson must have one question that a student must answer in 

order for it to show up in some reports. This can affect Grades and a 

Lesson's dependency setting (see other FAQs below). 

 

Tip: There are lots of creative ways to put in a question, such as setting a 

multiple choice question so that all answers are correct and the answers act 

like a content page. Or put in content and then award 1 point for "next 

page" as the answer and do not include the score in grades. 

 

 

Совет: Существует множество творческих способов представления Вопроса; 

например, настройка Вопроса с Множественным Выбором так, чтобы все варианты 

ответов были правильными, и каждый акт ответов выглядел страницей контента. Или 

разместить контент (содержимое), и затем присудить 1 балл за переход к «next page 

(следующая страница)», но не включать эти Накопленные Баллы в Оценки. 

Совет: Благодаря специальной конструкции Урока, некоторые Студенты могут 

завершить Урок, не ответив ни на один из Вопросов, которые размещены в этом Уроке. 

Когда Урок не может зарегистрировать хоть какие-то накопленные баллы для Студента, 

никакая Оценка не попадёт в Журнал Оценок. Следовательно, может оказаться, что 

оценивание этого Урока является не состоявшимся. 

Опция Взаимозависимости в Уроке не работает 

Второй Урок говорит Студенту, что он должен завершить первый Урок. А он уже 

сделал это, – в чём же дело? 

 Для того, чтобы взаимозависимость Уроков действовала, вам необходимо иметь, по 

крайней мере, 1 страницу вопросов в этом Уроке. Студент может не нуждаться в 

минимальном накопленном балле, но Уроку нужно знать, что Студент пытался 

ответить на Вопрос. Вы всегда можете поместить Вопрос на первую или последнюю 

страницу. Вам нет нужды задавать Вопрос, но нужно принять ответ «Continue 

(продолжить)», чтобы перейти на другую страницу. 

 Также для работы взаимозависимости, Урок не должен быть практическим Уроком. 

4.3.9.5.7.Есть ли примеры Уроков, которые можно 
посмотреть? 

Существует много примеров Уроков на демонстрационном Сайте Школы, на 

который можно зайти Гостем или, зарегистрировавшись, использовать его более 

интерактивно. Дадим только пару названий Курсов: есть пример в Курсе «Мир воды» по 

адресу и Курс «Основы Moodle и альпинизм». 

 

4.3.9.5.8.Урок был завершён, но это не запротоколировано 
 
 Каждый Урок должен иметь один Вопрос, на который Студент должен ответить для 

того, чтобы отразить это в некоторых отчётах. Это может оказать воздействие на 

Оценки и настройку зависимости доступа к этому Уроку (см. другие часто задаваемые 

вопросы ниже). 

Совет: Существует много творческих путей вставить Вопрос в Урок, таких как 

установка Вопроса с выбором из предложенных вариантов так, что все ответы являются 

корректными, и ответы действуют как страница содержимого. Или установить контент и 

затем присудить 1 балл за переход к «следующей странице», и не включать этот балл в 

Итоговую Оценку за этот Вопрос. 

http://school.demo.moodle.net/
http://school.demo.moodle.net/course/view.php?id=115
http://school.demo.moodle.net/course/view.php?id=128
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Tip: Due to a specific Lesson's design, some students can complete the 

lesson without answering one or more questions which have been placed in 

the Lesson. When Lesson can not record any scores for a student, no grade 

is pushed to the gradebook. It may appear therefore that Lesson is being 

inconsistent in recording grades. 

4.3.9.5.9.Dependency in Lesson does not work 
The second lesson tells the student they must complete the first one. They 

did - what is wrong? 

 For dependency to work, you need to have at least 1 question page in 

the lesson. The student may not need a minimum score, but Lesson 

needs to know that the student tried a question. You can always put a 

question as the first or last page, You don't need to ask a question but 

do put in an answer of "continue" with a jump of the next page. 

Also for dependency to work, the lesson can not be a practice lesson. 

4.3.9.5.10.How to add sound to a lesson page 
Audio in Moodle  has an overview and tool recommendations. 

4.3.9.5.11.Can I turn off the answer shuffle in a 
lesson? 
In short, no. Turning off the page and answer shuffle are Quiz options, but 

neither is found in Lesson. A minor hack to the Lesson code is possible but 

that would impact  entire Moodle site. 

TIP: If you don't need to score students answers in a question, then 

consider using a Content page instead of a Multiple Choice or a True/False 

question. 

4.3.9.5.12.Can I change standard words used by 
Lesson? 
 Yes. You or your site administrator can edit the language file called 

Lesson.php. This will impact the whole site. Your site administrator 

might create a language just for you and then in Lesson settings use the 

force language option. 

4.3.9.5.13.Grrr something happened – lesson list 
is not right – I can't move things 
Try a backup and restore of your course to solve some of those "quirky" 

issues. 

 Example: I was building a course, started adding lessons to topic 2 and 

then realized I should move it up to become Topic 1. Did that and 

continue to add lessons to topic 1, then lessons to topic 2 etc. Later I 

had to add lessons to topic 1. 

Совет: Благодаря специфической конструкции Урока, некоторые Студенты могут 

завершить этот Урок, не отвечая на один или более Вопросов, которые были размещены в 

Уроке. Когда Урок не может записать никакие накопленные баллы для Студента, Оценка 

не проставляется в Журнал Оценок. Может оказаться, следовательно, что Урок не 

попадает в протоколирование Оценок. 

4.3.9.5.9.Зависимость в Уроке не работает 
Второй Урок говорит Студенту, что он должен завершить первый Урок. Он 

завершил – что не так? 

 Чтобы Зависимость работала, вам нужно иметь, по крайней мере, 1 страницу Вопросов 

в этом Уроке. Студенту может не требоваться минимальная Итоговая Оценка, но Уроку 

нужно знать, что Студент делал попытку ответить на Вопрос. Вы всегда можете задать 

Вопрос как первую или последнюю страницу. Вам не нужно формулировать Вопрос, но 

вложите в Ответ «Continue (продолжить)» с переходом на следующую страницу Урока. 

Кроме того, для работы Зависимости Урок не может быть практическим Уроком. 

4.3.9.5.10.Как добавить звук на страницу Урока 
Обзор и советы по установке. 

4.3.9.5.11.Можно отключить перемешивание ответов в 
Уроке? 

Вкратце, нет. Отключение страницы и перемешивание ответов являются опциями 

Экзамена, но ни та, ни другая не присутствует в Уроке. Незначительные поправки в коде 

Урока возможны, но это отразится на всём Сайте Moodle. 

Совет: Если вам не нужно накапливать баллы за студенческие Ответы на Вопрос, 

тогда вместо Вопросов с выбором из предложенных вариантов обсудите применение 

страницы Содержимого или Вопроса типа да/нет. 

4.3.9.5.12.Можно заменить стандартные слова, 
используемые Уроком 
 Да. Вы или ваш Администратор Сайта могут отредактировать языковый файл, 

называемый Lesson.php. Это отразится на всём Сайте. Ваш системный Администратор 

может создать язык только для вас и затем в настройках Урока использовать опцию 

принудительного языка. 

4.3.9.5.13.Бррр, что-то произошло – список Уроков не 
правилен – невозможно ничего переместить 

Возьмите резервную копию и восстановите ваш Курс, чтобы решить некоторые из 

этих «заковыристых» проблем. 

 Пример: я создал Курс, начал добавление Уроков в Тему 2 и затем осознал, что мне 

нужно пополнение, чтобы соответствовать Теме 1. Сделал это и продолжил добавлять 

Уроки в Тему 1, затем Уроки в Тему 2 и т.д. Позднее я должен добавить Уроки в Тему 

1. 

http://docs.moodle.org/25/en/Audio_in_Moodle
http://docs.moodle.org/25/en/Audio_in_Moodle
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I did but could not move them between those first lessons I created. 

Every time I tried to move them they went to the bottom of topic 2! I 

also noticed that my list of just lessons, showed those first lessons as 

being in the correct course display order but showed they were in Topic 

2!. 

 Moral: Sometimes a backup and a restore will re-establish harmony and 

fix things. 

4.3.9.5.14.What happened to my HTML code on a 
Lesson page? 
I had the lesson page formatted just the way I wanted by using the HTML 

source toggle on the tool bar. I went back in to tweak my code and some of 

my code was missing! 

 Lesson will "clean" up your HTML code every time you toggle into 

HTML text. This can be frustrating, especially if you are trying to get a 

flash file to display just right. Save you work in a text editor, so the next 

time you tweak it, you can paste all your code back in. 

4.3.9.5.15.Pages are not displayed in the lesson's 
left menu 
The Lesson module's left menu navigation feature, only displays content 

(branch table) pages. 

If your lesson only has question pages, it will not display any pages. Use a 

content page before a series of question pages, so your students will know 

where the series starts. Alternative, use the same content page and put links 

to each of the question using descriptions and jumps. Remember, you can 

effectively have the student jump past (not view) this content page as they 

go through the lesson and only reach it via the left menu. 

 

4.3.9.5.16.Students are not returning to where 
they left the lesson 
A student has left the lesson after looking at 10 pages. The next time they 

return to the lesson they start at the beginning again. How can the student 

return to the same place? 

You have seen more than one page of this lesson already. Do you want 

to start at the last page you saw? 

Several things must be met before this will happen. First make sure your 

lesson settings allow the student to retake the lesson and that this lesson is 

not a "practice" lesson. The important thing is that the above words are not 

exactly correct. They are correct only when the student left immediately 

Я это сделал, но не могу переместить их между теми первыми мной созданными 

Уроками. Каждый раз, когда я пытался их переместить, они уходили вниз Темы 2! Я 

также заметил, что мой список лишь Уроки, показанные теми первыми Уроками как 

находящиеся в правильном порядке отображения Курса, но показанные, какими они 

были в Теме 2!. 

 Мораль: Иногда резервное копирование и восстановление перевосстанавливают 

гармонию и поправляют дела. 

4.3.9.5.14.Что случилось с моим HTML-кодом на странице 
Урока? 

У меня была страница Урока, отформатированная так, как мне нужно, посредством 

переключателя HTML source на панели инструментов. Я вернулся к настройке моих кодов, 

а некоторые из них исчезли. 

 Урок «подчищает» ваш HTML-код каждый раз, когда вы переключаетесь в HTML-

текст. Это может расстраивать, особенно если вы работаете в текстовом редакторе, 

поскольку при следующей вашей настройке кода, вы можете вклеить симуляцию всего 

вашего кода. 

4.3.9.5.15.Страницы не отображаются в меню Уроков слева 
 

Средство навигации Меню модуля «Урок» слева отображает только содержание 

(таблицу переходов) страниц. 

Если ваш Урок содержит только Страницы Вопросов, он не будет отображать 

никакие страницы. Используйте Страницу Содержимого перед серией Страниц Вопросов, 

чтобы ваши Студенты знали, где начинается серия. В качестве альтернативы используйте 

ту же самую Страницу Содержимого и поместите ссылки на каждый Вопрос, используя 

описания и переходы. Помните, что вы можете иметь прошлый переход Студента (не 

просмотр) на эту Страницу Содержимого, поскольку они прошли Урок насквозь и 

достигли её посредством меню слева. 

4.3.9.5.16.Студенты не возвращаются туда, где оставили 
Урок 

Студент оставил Урок после просмотра 10 страниц. Следующий раз, когда он 

вернётся к Уроку, он начинает всё сначала. Как можно вернуть Студента на то же самое 

место? 

Вы уже видели более одной страницы этого Урока. Вы хотите начать видеть с 

последней просмотренной страницы? 

Несколько вещей должно произойти, прежде чем это случится. Во-первых, 

убедитесь, что настройки вашего Урока позволяют Студенту повторить этот Урок, и что 

этот Урок не «практический». Самое важное заключается в том, что приведённые выше 

слова не совсем точны. Они точны только сразу же после того, как Студент вернётся после  
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after answering a question in a Lesson. For the purposes of returning to the 

same place, Lesson only remembers question pages as benchmarks. So 

lastly, make sure you have questions scattered in your Lesson for this 

feature to work and tell students. 

TIPs: Use a content page at the start of the lesson as a table of contents, 

so the student are forced to remember where they are but can jump to 

your teaching points. Or put a question at the start or end of every 

"teaching point". And of course, you can tell your students how it is 

going to work. 

4.3.9.5.17.See also 
Using Moodle Lesson module forum. 

4.3.9.6.Short answer analysis 
In a Lesson, the short answer question type has two methods of anaysis of 

a student's answer. This kind of analysis in NOT available for Quiz short 

answer questions. In a short answer question the student is expected to 

answer with one word or a few words. Short-Answer question type page 

give more information about this question type. 

There are two different student answer analysis systems available for the 

Short Answer type of question: the simple system is used by default; the 

Regular Expressions system is used if it has been installed (it is an 

optional plugin) and the "Use Regular Expressions" option box has been 

checked on the Edit Question Page screen. 

4.3.9.6.1.Simple analysis 
In the (default) simple system of analysis, the comparisons ignore the case 

of the text and the asterisk (*) character can be used in answers as a "wild 

card" character. The evaluation process goes through the answers in the 

order they appear on the Edit screen. When a match is found the process 

stops and that becomes the student's answer. 

The asterisk stands for any number of characters (including no characters 

at all). For example, the expected answer "Long*" will match "longer", 

"longest" and "long". Please note, however, that the expected answer 

"Long*" will also match "longing", "longer than yours" and so forth. 

If a "wild card" type of student answer analysis is required, it is strongly 

recommended to use the regular expressions analysis system explained 

below. 

The matching process goes through the expected answers in the order they 

appear on the Edit screen. Once a match is found the process stops and the 

corresponding result (and response message, if present) is returned. So, if 

for example the expected answers are "Longest", 

ответа на Вопрос в этом Уроке. В целях возвращения на то же самое место Урок 

запоминает в качестве критерия возврата только Страницы Вопросов. Так что в 

заключение убедитесь, что у вас Вопросы размещены в вашем Уроке под действием 

данного средства, и сообщите это Студентам. 

Советы: Используйте Страницу Содержания в начале Урока в качестве оглавления, что 

принудит Студентов запомнить, где они, но могут и перейти к вашим пунктам 

обучения. Или поместите Вопрос в начало или конец каждой пункта обучения. И, 

конечно, вы можете сообщить вашим Студентам, как это будет работать. 

 

4.3.9.5.17.См. также 
Использование Moodle. Форум по модулю «Урок». 

4.3.9.6.Анализ кратких ответов 
Вопросы с Кратким Ответом в Уроке имеют два метода анализа студенческого 

ответа. Такой тип анализа НЕДОСТУПЕН в Вопросах с Кратким Ответом в Экзамене. В 

Вопросе с Кратким Ответом от Студента ожидается ответ одним или несколькими 

словами. В п. 4.6.8.1.9 «Краткий Ответ» приведена дополнительная информация об этом 

типе Вопроса. 

Есть две различные системы анализа студенческого ответа, доступные для 

Вопросов с Кратким ответом: Простая система используется по умолчанию; Система 

регулярных выражений используется, если она была инсталлирована (это 

дополнительный Плагин) и было помечено окошко опции «Use Regular Expressions 

(использовать регулярные выражения)» на экране страницы редактирования Вопроса. 

4.3.9.6.1.Простой анализ 
В (по умолчанию) Простой системе анализа сравнения игнорируют регистр текста, 

и символ звездочка (*) может быть использован в ответах в качестве Шаблона 

подстановки. Процесс вычисления Оценки ответов проходит в порядке, в котором они 

появляются на экране редактирования. При достижении совпадения процесс 

останавливается, и это становится ответом Студента. 

Звёздочка означает любое количество символов (в том числе отсутствие символов 

вообще). Например, ожидается ответ «Длин*» будет соответствовать "Длиннее", 

"Длинный" и "Длинные". Пожалуйста, обратите внимание, однако, что ожидаемый ответ: 

«Длин*» будет также соответствовать «длиннющий», «длиннее, чем у вас» и так далее. 

Если требуется тип Шаблона подстановки анализа студенческого ответа, 

настоятельно рекомендуется использовать регулярные выражения системного анализа, 

объяснённые ниже. 

Процесс сопоставления обрабатывает ожидаемые ответы в порядке их появления 

на экране редактирования. Как только совпадение найдено, процесс останавливается и 

соответствующий результат (и сообщение с откликом Преподавателя, если он есть) 

возвращается. Итак, если, например, ожидаемыми ответами являются «Длиннейший», 

http://docs.moodle.org/25/en/Short-Answer_question_type
http://moodle.org/mod/forum/view.php?f=333
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"Long*" and "*" (in that order), the student's answer "longer" will match 

the second expected answer and, in this case, the third expected answer, 

although a match, is ignored. 

If one of the expected answers is just "*" (a single *) this expected answer 

will match anything. This is used as the last "catch-all" expected answer. 

You will use this "catch-all" asterisk if you want to provide the student 

with your own "wrong answer" feedback message instead of the default 

system "That's the Wrong Answer" message (or the equivalent in your own 

language pack). 

If an asterisk (*) is actually needed in an expected answer, you'll have to 

use the Regular Expressions analysis system and enter the asterisk as \*, 

backslash asterisk. 

4.3.9.6.2.Regular Expressions analysis 
This system gives you access to a more powerful but more complicated 

system for analysing the student's answers. For a complete introduction to 

Regular Expressions, see these sites 

http://www.zend.com/zend/tut/tutorial-delin2.php regular-expressions or 

http://rezeau.org/eao/developpement/expandRegexpToString.htm. 

Correct answer matching a regular expression pattern 
It is not possible to give complete examples of the vast possibilities offered 

by this system, and the following are just some possibilities. 

Example 1. 
Suppose your question is "What are the colors of the French flag?". 

In the Answer 1 field you type this regular expression: "it’s blue, white(,| 

and) red/i". This will match any of those four student answers: 

it’s blue, white, red 

it’s blue, white and red 

It’s blue, white, red 

It’s blue, white and red 

Note.- By default a regular expression match is case sensitive; to make the 

match case insensitive you must add the /i parameter right at the end of 

your expression. 

Example 2. 
Question: "What is blue, or red, or yellow?". 

Answer: "(|it's )a colou?r". This will match: 

 a colour 

 a color 

 it's a colour 

 it's a color 

«Длин*» и «*» (в этом порядке), студенческий ответ «Длиннее»будет соответствовать 

второму ожидаемому ответу и, в этом случае, третий ожидаемый ответ, хотя и 

соответствует, проигнорируется. 

Если один из ожидаемых ответов «*» (единственная *), этот ожидаемый ответ 

будет соответствовать всему. Это используется в качестве последнего ожидаемого ответа 

«ловушка». Используйте эту звёздочку «ловушку», если вы хотите дать Студенту ваше 

собственное сообщение «неправильный ответ» вместо системного сообщения по 

умолчанию «That's the Wrong Answer (это неправильный ответ)» (или его эквивалент в 

вашем собственном языковом пакете). 

Если звёздочка (*) является действительно необходимым ожидаемым ответом, вы 

должны использовать Система анализа регулярных выражений и введите звёздочку ввиде 

\* (обратный слэш, звёздочка). 

4.3.9.6.2.Анализ регулярных выражений 
Эта система предоставляет доступ к более мощноой, но более сложной системе для 

анализа студенческих ответов. Для более детального введения в регулярные выражения, 

см. эти Сайты регулярных выражений http://www.zend.com/zend/tut/tutorial-delin2.php или 

http://rezeau.org/eao/developpement/expandRegexpToString.htm. 

 

Правильный ответ, соответствующий образцу регулярного выражения 
Невозможно дать все примеры огромных возможностей, предлагаемых этой 

системой, и следующее – это лишь некоторые из возможностей. 

Пример 1. 
Предположим ваш Вопрос «Какие цвета у французского флага?». 

В поле «Ответ 1» набираете регулярное выражение «это голубой, белый (,| и 

красный/i». Оно будет соответствовать любому из тех четырёх студенческих ответов 

это голубой, белый, красный 

это голубой, белый и красный 

Это голубой, белый, красный 

Это голубой, белый и красный 

Замечание. По умолчанию сопоставление регулярного выражения является 

чувствительным к регистру; чтобы сделать его нечувствительным, добавьте параметр /i 

справа в конце вашего выражения. 

Пример 2 (это не перевод примера 2, а некий аналог его на русском). 
Вопрос: «Что такое голубой или красный, или жёлтый?». 

Ответ: «(|Это) цв?т». Он соответствует: 

 цвет 

 цвт 

 это цвет 

 это цвт 

http://www.zend.com/zend/tut/tutorial-delin2.php
http://rezeau.org/eao/developpement/expandRegexpToString.htm
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Note.- The beginning of this regular expression "(|it's )" will match either 

nothing or "it's " (i.e. "it's" followed by a space). The ? (question-mark) 

means: preceding character zero or one time; it is used here to match 

British English as well as US spelling. 

Example 3. 
Question: "Name an animal whose name is made of 3 letters and the 

middle letter is the vowel a". 

Answer: "[bcr]at". This will match: 

bat 

cat 

rat 

Detecting missing required words or character strings 
Regular expressions alone cannot detect absent character strings, so you 

have to add a little code in your Answer field to take care of this. Any 

expected answer which begins with a double hyphen will analyse the 

student’s answer to find out whether the following string is present or 

absent. If present, the analysis continues to the next question; if absent, the 

analysis stops and the relevant Response message is displayed. 

 

Example 4. 
Question: "What are the colors of the French flag?" 

Answer 2: --.*blue.*/i 

student answer: "it's red and white" 

Response 2: The color of the sky is missing! 

Jump 2: this page 

Here, the . (dot character) stands for “any character” and the * (asterisk) 

means “preceding special character repeated any number of times”. The 

Answer 2 regular expression above means: check whether the character 

string “blue”, preceded by anything and followed by anything is absent 

from the student's answer. Please note that the use of the asterisk is 

different in the Simple analysis system and in the Regular Expressions 

system. 

Example 5. 
Question: "Name an animal whose name is made of 3 letters and the 

middle letter is the vowel a". 

Answer: "--[b|c|r]". Response: "Your answer should start with one of these 

letters: b, c or r" 

 

 

 

Замечание. Начало этого регулярного выражения «(|Это)» будет соответствовать 

либо ничему, либо «Это» (т.е. «Это» с последующим пробелом). ? (знак вопроса) означает: 

впереди либо нет символов, либо только один символ, это используется здесь, чтобы 

соответствовать орфографии Британского и Американского английского. 

Пример 3 (это не перевод примера 3, а некий аналог его на русском). 
Вопрос: «Назовите уменьшительное женское имя из трёх букв, причём средняя 

буква – согласная л». 

Ответ: «[уою]оя». Это будет соответствовать: 

уля 

оля 

юля 

Обнаружение пропуска необходимых слов или строк символов 
Одни регулярные выражения не могут обнаружить отсутствующие строки 

символов, так что вам придётся добавить немного кода в свою область ответа, чтобы 

позаботиться об этом. Любой ожидаемый ответ, который начинается с двойного дефиса 

проанализирует ответ Студента, чтобы выяснить, присутствует или отсутствует 

следующая строка. Если присутствует, анализ переходит к следующему Вопросу, если 

отсутствует, то анализ прекращается и отображается соответствующее сообщение 

отклика. 

Пример 4. 
Вопрос: «Какие цвета у французского флага?» 

Ответ 2: --.*голубой.*/i 

Студенческий ответ: «Это красный и белый» 

Отклик Преподавателя 2: «Цвет неба пропущен» 

Переход 2: эта страница 

Здесь . (символ точки) расшифровывается как «любой символ» и * (звёздочка) 

означает «перед особый характер повторяться любое число раз». Регулярное выражение 

Ответа 2 выше означает: проверить, отсутствует ли строка символов «голубой»,  

предваряемая чем-либо и за которой следуют что-либо, в ответе Студента. Пожалуйста, 

обратите внимание, что использование звёздочки в Простой системе анализа и в Системе 

регулярных выражений отличается. 

 

Пример 5 (это не перевод примера 5, а некий аналог его на русском). 
Вопрос: «Назовите уменьшительное женское имя из трёх букв, причём средняя буква – 

согласная л». 

Ответ: «--[у|о|ю]». 

Отклик: «Ваш ответ должен начинаться с одной из букв: у, о или ю». 
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Detecting unwanted (incorrect) words or character strings 

 
You may want to detect, in the student's answer, the presence of one or 

several words which should be not be there (because they are wrong) and 

to single them out with a specific response. To do this, just start the 

expected answer in the Answer field with a double plus sign (++). 

Example 6. 
Answer: ++(yellow|black|orange|green|white|pink)/i 

student answer: "it's blue, orange and white" 

Response: One or more colors are wrong! 

Jump: this page 

Note.- If any of these (wrong) color names is detected in the student’s 

answer, then the negative feedback message (Response) will be displayed 

and the wrong strings will be colored red (or the color of the .incorrect 

class will be used if it exists in a CSS stylesheet of your current theme). 

Example 7. 
Question: "Name an animal whose name is made of 3 letters and the 

middle letter is the vowel a". 

Answer: "++hat". 

Response: "You might wear one made of an animal's skin, but a hat can't 

be considered as an animal." 

Escaping special characters 
If you need to use characters which are part of the regular expressions set 

of special characters, you need to "escape" them (i.e. precede them with a 

backslash). E.g. if you want to accept the answer "My computer cost 

1000$", you must write the regular expression as "My computer cost 

1000\$". 

The special characters which must be escaped are .^$*()[]+?| 

Order of the expected answers 
Because the program tries to match the student's answer with the teacher's 

expected answers in the order of the Answer fields, the order of those 

expected answers is of the greatest importance. The best analysis system 

will be achieved by a careful combination of regular expressions and order 

of expected answers. Of course, any question programed with the Regular 

expressions system will have to be thoroughly tested by the teacher before 

being released in a Lesson. 

 

 

 

Обнаружение нежелательных (неправильных) слов или строки 

символов 
Вы можете захотеть обнаружить в студенческом ответе наличие одного или 

нескольких слов, которых там не должно быть (потому что они не правильны) и выделить 

их с определённым откликом. Чтобы сделать это, просто начните ожидаемый ответ в поле 

ответа с двойного знака плюс (++). 

Пример 6. 
Ответ: ++(жёлтый|чёрный|оранжевый|зелёный|белый|розовый)/i 

Студенческий ответ: «Это голубой, оранжевый и белый» 

Отклик: Один или более цветов неправильны 

Переход: эта страница 

Замечание: Если любое из этих (неправильных) названий цветов обнаружится в 

студенческом ответе, тогда будет отображено сообщение с негативной Обратной Связью 

(отклик), а неправильные строки будут подсвечены красным (или будетцвет из класса 

.incorrect, если он существует в таблице стилей CSS вашей). 

Пример 7 (это не перевод примера 7, а некий аналог его на русском). 
Вопрос: «Назовите уменьшительное женское имя из трёх букв, причём средняя 

буква – согласная л». 

Ответ: «++для». 

Отклик: «Вы можете использовать этот предлог в письме к любой из девушек, но 

это не уменьшительное имя». 

Избавление от специальных символов 
Если вам нужно использовать символы, которые являются частью набор 

специальных символов регулярных выражений, вам нужно «избавиться» от них (т.е. 

поставить перед ними обратный слэш \). Например, если вы хотите принять ответ «Мой 

компьютер стоит 1000$», вы должны написать регулярное выражение в виде «Мой 

компьютер стоил 1000\$». 

Специальными символами, от которых нужно избавляться, являются ^ $ * () [] +.?| 

Порядок ожидаемых ответов 
Поскольку программа пытается сопоставить ответ Студента с ожидаемыми 

Преподавателем ответами в порядке полей ответа, порядок этих ожидаемых ответов имеет 

огромное значение. Самая лучшая система анализа достигается путём тщательной 

комбинации регулярных выражений и порядка ожидаемых ответов. Конечно, любой 

Вопрос запрограммирован с системой регулярных выражений, которые должны быть 

тщательно проверены Преподавателем, прежде чем реализовать в Уроке. 
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4.3.9.6.3.Tips and tricks 
The teacher should make some sort of provision for the student who does 

not know the answer to a question. This is true for all questions and 

especially the short answer and numeric questions. The most common way 

is to prevent these students from getting stuck in a loop by making sure the 

"Maximum number of attempts" setting in the Lesson is less than the 

frustration point of the students. 

Another way is to use a wildcard that will accept any answer as the last 

line of the analysis. The teacher can give a hint in the response for this 

answer. 

Be aware that as teacher, the maximum number of attempts will not apply 

when a teacher previews the lesson. So it is possible for non-editing 

teacher or co-teachers to get stuck in an endless loop. And for a student to 

get bumped to another page after the maximum number of attempts. 

 

4.3.9.6.4.See also 
 Short-Answer question type 

 Question Bank page 

 Quiz module 

4.3.9.7.See also 
 Using Moodle Difference between Lesson and Book    

4.3.10.Quiz 
 Allows the teacher to design and set quiz tests, which may be 

automatically marked and feedback and/or to correct answers shown 

 

Quiz module 
 The Quiz activity module allows the teacher to design and build quizzes 

consisting of a large variety of Question types, including multiple 

choice, true-false, and short answer questions. These questions are kept 

in the Question bank and can be re-used in different quizzes. 

 

4.3.10.1.Quiz settings 
Creating a new quiz is a two-step process. In the first step, you create the 

quiz activity and set its options which specify the rules for interacting with 

the quiz. In the second step you add questions to the quiz. This page 

describes the options you can set for the quiz activity. The page Building 

Quiz describes how to set up the questions for the quiz. 

 

4.3.9.6.3.Советы и трюки 
Преподаватель должен чем-то обеспечить Студента, который не знает ответа на 

Вопрос. Это верно для всех Вопросов и особенно для Вопросов с Кратким ответом и 

Числовых. Наиболее распространенным способом является предотвращение этих 

Студентов от попадания в замкнутый круг, приняв меры по установке «Maximum number 

of attempts (максимальное число попыток)» в Уроке уменьшим точки краха Студентов. 

 

Другой способ заключается в использовании Шаблона подстановки, который 

примет любой ответ в соответствии с последней строкой анализа. Преподаватель может 

дать подсказку в своём отклике для этого ответа. 

Имейте ввиду, что к Преподавателю не будет применяться максимальное число 

попыток, когда Преподаватель предварительно просматривает этот Урок. Так что 

нередактирующий Преподаватель или соПреподаватель могут застрять в бесконечном 

цикле. Это же может случиться и со Студентом, при попытке перейти на другую страницу 

после максимального числа попыток. 

4.3.9.6.4.См. также 
 Вопросы с Кратким ответом: п. 4.6.8.1.9. 

 Страница Банка Вопросов: п.4.6.3. 

 Модуль «Экзамен»: п. 4.3.10. 

4.3.9.7.See also 
 Использование Moodle, разница между Уроком и Книгой. 

4.3.10.Экзамен 
 Позволяет Преподавателю разработать и установить экзаменационные тесты, которые 

могут быть автоматически оценены и на которые может быть дана Обратная Связь, 

и/или скорректировать показываемые ответы. 

Модуль «Экзамен» 
 Модуль Интерактивного Действия «Экзамен» позволяет Преподавателю 

сконструировать и построить экзамены, состоящие из большого разнообразия типов 

Вопросов (п. 4.6.3), включающих выбор из множества альтернатив, бинарный выбор 

(истина-ложь) и Вопросы, требующие дать краткий ответ. Эти Вопросы сохраняются в 

Банке Вопросов (п. 4.6.1.1) и могут повторно использоваться в различных Экзаменах. 

4.3.10.1.Настройки Экзамена 
Создание нового Экзамена – процесс двухшаговый. На первом шаге вы создаёте 

Интерактиввное Действие «Экзамен» и устанавливаете его опции, которые определяют 

правила взаимодействия с этим Экзаменом. В данном разделе описываются опции, 

которые вы можете установить для Интерактивного Действия «Экзамен». На втором шаге 

вы добавляете Вопросы в этот Экзамен. Раздел «Построение Экзамена» описывает то, как 

внести Вопросы в Экзамен. 

https://moodle.org/mod/forum/discuss.php?d=207365&parent=910023#p910107
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4.3.10.1.1.Quiz administration 
When you first set up your quiz from Add an activity or resource > Quiz, 

(or, if you don't have this link, the dropdown Add an activity>Quiz) you 

will get the following settings, (which can also be changed later in the Edit 

Settings link of the Quiz administration settings block) All settings may 

expanded by clicking the "Expand all" link top right. 

4.3.10.1.2.General 
Name 
This is the standard name field. This name will appear on the home page of 

the course, navigation menu and other places which will show or provide 

links to this quiz. 

Description 
Describe the purpose of the glossary and provide instructions or 

background information, links etc. Click "Show editing tools" to display 

the rich text editor, and drag the bottom right of the text box out to expand 

it. 
 

Display description on course page 
If ticked, the quiz description will appear on the course page directly under 

the quiz name. 

4.3.10.1.3.Timing 
Open the quiz 
You can specify times when the quiz is accessible for people to make 

attempts. Before the opening time the quiz will be unavailable to students. 

They will be able to view the quiz introduction but will not be able to view 

the questions. Quizzes with start times in the future display both the open 

and close date for students. 

Note: You can make the quiz available at different times for different 

groups or users in the Group or User override sections of the Quiz 

Administration settings block. 

 

 
Существует большое число опций, и ваш Администратор должен был уже 

выбрать значения по умолчанию для большинства из них, чтобы вам не нужно 

было модифицировать их для тех типов Тестов, которые вы используете наиболее часто. Администратор 

мог бы также объявить некоторые настройки как «Advanced – продвинутые», что означало бы, что они по 

умолчанию будут скрыты на экране. Это помогает сохранить простоту экрана. Вы можете включить их 

отображение, щёлкнув по кнопке «Отобразить продвинутые опции». Они будут оставаться видимыми до 

тех пор, пока вы не щёлкнете по кнопке «Скрыть продвинутые опции». Все опции распределены по 

разделам.  

4.3.10.1.1.Управление Экзаменом 
Когда вы впервые устанавливаете Экзамен из Add an activity or resourceQuiz 

(или, если у вас нет этой ссылки, из ниспадающего меню Add an activityQuiz), вы 

получвете следующие настройки (которые также могут быть изменены позднее по ссылке 

Edit Settings из Блока настроек Quiz administration). Все настройки могут быть развёрнуты 

щелчком по ссылке «Expand all» вверху справа. 

4.3.10.1.2.Обычные настройки 
Название 

Это стандартное поле наименования. Это название будет появляться на 

Домашней Странице Курса, в меню навигации и других местах, которые будут показаны 

или на которые будут предоставлены ссылки в этом Экзамене. 

Описание 
Описывает цель Экзамена и предоставляет инструкции или фоновую информацию, 

ссылки и т.д. Щёлкните по «Show editing tools (Показать инструменты редактирования)», 

чтобы отобразить полнотекстовый редактор, и перетащите правый нижний угол 

текстового окошка, чтобы его расширить. 
Студент увидит это описание сразу же после щелчка по наименованию Экзамена. Студент  будет 

видеть его, пока не щёлкнет по ссылке «Attempt quiz (попытаться сдать экзамен)». 

Отображать описание на странице Курса 
Если пометить эту опцию, описание этого Экзамена будет появляться на странице 

Курса непосредственно под названием этого Экзамена. 

4.3.10.1.3.Планирование времени Экзамена 
Открыть Экзамен 

Вы можете указать сроки, когда Экзамен доступен людям для попыток сдать его. 

До момента начала Экзамен будет недоступен Студентам. Они могут просмотреть 

введение в Экзамен, но не смогут просмотреть Вопросы. Экзамены со сроками начала в 

будущем будут отображать как дату открытия, так и дату закрытия для Студентов. 

 

Замечание: Вы можете создать Экзамен, доступный в разное время для различных 

Групп или пользователей в Группе, или разделах с ручной коррекцией пользователем в 

Блоке настроек Quiz Administration. 
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Close the quiz 
After the closing time, the students will not be able to start new attempts. 

Answers that the student submits after the quiz closing date will be saved 

but they will not be marked. 

Even after the quiz has closed students will still be able to see the quiz 

description and review their attempts. What exactly they will see depends 

on the settings you choose for review options (see below). 

Time limit 
By default, quizzes do not have a time limit, which allows students as 

much time as they need to complete the quiz. If you do specify a time 

limit, several things are done to try and ensure that quizzes are completed 

within that time: 

Navigation block showing quiz timer 

 A countdown timer is shown in the quiz navigation block 

 

 When the timer has run out, the quiz is submitted automatically with 

whatever answers have been filled in so far 

 

 If a student manages to cheat and goes over the allotted time, no marks 

are awarded for any answers entered after the time ran out 

Note: You can make the quiz available last a different period of time for 

different groups or users in the Group or User override sections of the Quiz 

Administration settings block (see below). 

When time expires… 
There are three options as to what will happen when the time limit is up. 

Choose the one you need from the dropdown menu. 

 

If you select "there is a grace period..." then you can check the box to 

enable the "Submission grace period" and specify a period of time during 

which learners may still submit the quiz after the time is up. 

 

 

Examples of how timing is handled 
 A student starts a quiz at noon. The quiz has a one-hour time-limit, and 

a 1 hour delay between attempts. The student gets distracted, and so 

actually does not submit (using the overdue handling) until 1:30pm. 

They are allowed to start their second attempt at 2. Pm. 

 

 

Закрыть Экзамен 
После времени завершения Студенты не смогут осуществить новые попытки сдать 

Экзамен. Ответы, которые Студент передаёт на рассмотрение Преподавателю после даты 

завершения Экзамена будут сохранены, но они не будут оценениваться. 

Даже после того, как Экзамен закрыт, Студенты смогут видеть описание Экзамена 

и просматривать свои попытки его сдать. Что именно они смогут увидеть, зависит от 

настроек, которые вы выбрали для опций обзора (см. ниже). 

Ограничение времени 
По умолчанию Экзамены не имеют ограничения по времени, что позволяет 

Студентам отводить Экзамену столько времени, сколько они пожелают. Если вы укажете 

ограничение времени, делается несколько вещей, чтобы постараться гарантировать 

завершение Экзаменов в течение этого времени: 

Блок навигации, показывающий таймер Экзамена:  

 В Блоке навигации Экзамена будет показан таймер обратного 

отсчёта. 

 Когда таймер отсчитает заданный срок, Экзамен автоматически 

будет передан на рассмотрение, с теми ответами, какие были 

внесены к этому времени. 

 Если какой-либо Студент попытается сжульничать и перейдёт за отведённое время, его 

запоздалые ответы оцениваться не будут. 

Замечание. Вы можете задать Экзамену различное время окончания для разных 

Групп или пользователей в конкретной Группе, или разделах с ручной коррекцией 

пользователя в Блоке настроек Quiz Administration (управление экзаменом). 

По истечении времени… 
Существует три возможных варианта того, что произойдёт по истечении 

установленного ограничения времени по выполнению Экзамена. Выберите нужную вам 

опцию из ниспадающего меню. 

Если вы выберете «There is a grace period... (есть период отсрочки)», тогда вы 

можете пометить окошко, чтобы позволить «Submission grace period (льготный период 

отправки на рассмотрение)», и указать период времени, в течение которого обучающиеся 

всё ещё смогут осуществлять отправку на рассмотрение своих попыток выполнения 

данного Экзамена, после завершения времени. 

Примеры того, как обрабатывается согласование по времени 
 Студент начинает выполнять Экзамен в полдень. Экзамен имеет ограничение на время 

его выполнения один час, и один час отсрочки ограничения между попытками. Студент 

растерян и не отправляет на рассмотрение свою попытку (используя предоставленный 

льготный период) до 13.30. Ему разрешается повторить свою вторую попытку в 2 ч. 
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 The quiz count-down timer submits a student's quiz attempt at the last 

second when time expires. Because the server is heavily loaded, it takes 

30 seconds to process the student's attempt. The submission is accepted 

nonetheless. 

 Same situation as above but with a 120 second delay: The submission is 

rejected. 

 The delay is not because of server load but because the student found a 

way to cheat the timer. Moodle cannot know what causes a delay.The 

behaviour is controlled by the admin setting (quiz | graceperiodmin), 60 

seconds by default. 

 A student is a member of 3 groups,all of which have different override 

settings. Which limits will apply to this student? If there is any user-

specific override, then that is used, and the group overrides for that 

setting are not used at all. Otherwise, if there are multiple group 

overrides, the most generous values are used (the earliest open date, the 

latest close date, the longest time limit, the most number of attempts, 

and the student can type any of the passwords). 

4.3.10.1.4.Grade 
Grade category 
If you have categories in your gradebook, select the one you wish the quiz 

to be in here. 

Attempts allowed 
Students may be allowed to have multiple attempts at a quiz. This can help 

make the process of taking the quiz more of an educational activity rather 

than simply an assessment. If the quiz is randomized then the student will 

get a new version for each attempt. This is useful for practice purposes. 

Note: You can change the allowed number of attempts for different groups 

or users in the Group or User override sections of the Quiz Administration 

settings block. 

Grading method 
When multiple attempts are allowed, there are different ways you can use 

the grades to calculate the student's final grade for the quiz. 

 Highest grade - the final grade is the highest (best) grade in any attempt 

 

 Average grade - the final grade is the average (simple mean) grade of 

all attempts 

 First grade - the final grade is the grade earned on the first attempt 

(other attempts are ignored) 

 

 Таймер обратного отсчёта Экзамена отправляет на рассмотрение попытку Студента 

выполнить Экзамен в последнюю секунду перед моментом времени окончания. Из-за 

большой загруженности сервера в это время, он тратит 30 секунд на обработку ответов 

Студентов. Однако эта попытка принимается. 

 Та же ситуация, что и выше, но с 120-секундной задержкой. Попытка не принимается. 

 Задержка не из-за загруженности сервера, а из-за того, что Студент нашёл способ 

сжульничать с таймером. Moodle не может знать причин задержки. Её поведение 

контролируется настройкой Администратора «quiz | graceperiodmin (льготный период 

отправки)», которая по умолчанию равна 60 секундам. 

 Студент является членом трёх Групп, каждая из которых имеет различные настройки 

замещения (настроек Администратора). Какие ограничения будут применяться к 

данному Студенту? Если существует какое-либо замещение для конкретного Студента, 

тогда оно и используется, а замещения группы не используются совсем. В противном 

случае, если имеются множественные замещения группы, применяются наиболее 

приемлемые из них (с более ранней датой начала или более поздней датой окончания, с 

наибольшим временем ограничения, с большим числом попыток и когда Студент 

может набрать любой из паролей). 

4.3.10.1.4.Оценка 
Категория оценки 

Если в вашем Журнале Оценок есть Категории, выберите одну из них по своему 

желанию. 

Разрешены повторные попытки 
Студентам может быть позволено повторять попытки сдать Экзамен много раз. 

Это может помочь сделать процесс сдачи Экзамена больше процессом обучения, чем 

просто актом контроля знаний. Если Экзамен рандомизирован, то Студент будет получать 

новые Вопросы при каждой попытке. Это полезно для приобретения практического опыта. 

Замечание. Вы можете изменить разрешённое число попыток для разных Групп 

или пользователей в Группе или в разделах с ручной корректировкой пользователя из 

Блока настроек Quiz Administration. 

Метод оценивания 
Когда разрешены многие попытки выполнения Экзамена, существуют разные 

способы для вычисления Итоговой Оценки Студента за данный Экзамен. 

 Высшая оценка – Итоговая Оценка является высшей (наилучшей) оценкой из всех 

попыток. 

 Средняя оценка – Итоговая Оценка является Средней (среднеарифметической) 

Оценкой из всех попыток. 

 Первая оценка – Итоговая Оценка является Оценкой, полученной за первую попытку 

выполнить данный Экзамен (все прочие попытки не учитываются). 
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 Last grade - the final grade is the grade earned on the most recent 

attempt only 

4.3.10.1.5.Layout 
Question order 
If 'Shuffled randomly' is selected, then the order of questions in the quiz 

will be randomly shuffled each time a student starts a new attempt at the 

quiz. The intention is to make it a little harder for students to copy from 

each other. 

New page 
For longer quizzes it makes sense to stretch the quiz over several pages by 

limiting the number of questions per page. When adding questions to the 

quiz, page breaks will automatically be inserted according to the setting 

you choose here. However, you will also be able to move page breaks 

around by hand later on the editing page. 

Note that changing this setting has no effect on questions you have already 

added to the quiz. The setting will only apply to questions you add 

subsequently. To change the page breaks in an existing quiz, you need to 

go to the quiz editing screen, tick the 'Show page breaks' checkbox, then 

use the repaginate control. 

 

Navigation method 
Available by clicking Show More. By choosing Sequential instead of Free, 

the teacher is forcing the student to progress through the questions in order 

without being able to go back to a previous question or skip to a later one. 

 

4.3.10.1.6.Question behaviour 
Shuffle within questions 
If set to 'yes', then each time the student takes a quiz the parts of the 

question will be shuffled randomly. 

How questions behave 
 Deferred feedback - Students must enter an answer to each question and 

then submit the entire quiz, before anything is graded or they get any 

feedback. 

 Adaptive mode and Adaptive mode (no penalties) - Allows students to 

have multiple attempts at the question before moving on to the next 

question. 

 

 

 

 Последняя оценка – Итоговая Оценка является Оценкой, полученной за последнюю 

попытку выполнить данный Экзамен (все прочие попытки не учитываются). 

4.3.10.1.5.Компоновка 
Порядок Вопросов 

Если выбрано «Shuffled randomly (случайное перемешивание)», тогда порядок 

Вопросов в тесте будет случайным образом изменяться каждый раз, когда Студент будет 

делать новую попытку выполнить данный Экзамен. Это делает более трудным для 

Студентов списывать ответы друг у друга. 

Новая страница 
Для длинных Экзаменов имеет смысл разбивать Экзамен на несколько страниц с 

ограниченным числом Вопросов на каждой. При добавлении Вопросов в Экзамен, 

разрывы страниц будут добавляться автоматически в соответствии с этой настройкой. В 

дальнейшем разрывы страниц могут быть перемещены вручную на странице 

редактирования. 

Заметьте, что при изменении этой настройки все добавленные ранее Вопросы 

сохраняются. Эта настройка применяется только к Вопросам, которые вы добавляете 

впоследствии. Чтобы изменить разрывы страниц в существующем Экзамене, вам нужно 

перейти на экран редактирования Экзамена, отметить «галочкой» окошко-флажок «Show 

page breaks (покажи разрывы страниц)», а затем использовать «Repaginate control 

(управление разбивкой на страницы)». 

Метод навигации 
Доступен щелчком по Show More (показать больше) 

При выборе Sequential (последовательный), вместо Free (свободный), Преподаватель 

заставляет Студента пройти весь Экзамен по порядку расположения в нём Вопросов, он не 

может вернуться к предыдущим страницам или перескочить на один из следующих. 

4.3.10.1.6.Поведение Вопросов 
Перемешать Вопросы внутри 

Если установить в «Yes», тогда каждый раз, когда Студент принимается за 

Экзамен, части Вопроса будут перемешаны случайным образом. 

Каково поведение Вопросов 
 Отложенный Отзыв – Студенты должны ввести ответ на каждый Вопрос и затем 

передать на рассмотрение весь Экзамен целиком до какого-либо оценивания или 

получения Обратной Связи. 

 Адаптивный режим и Адаптивный режим (без штрафов) – позволяет Студентам 

осуществлять много попыток ответить на Вопрос перед тем, как перейти к следующему 

Вопросу. 
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 Interactive mode - After submitting one answer, and reading the 

feedback, the student has to click a 'Try again' button before they can 

try a new response. Once the student has got the question right, they can 

no longer change their response. Once the student has got the question 

wrong too many times, they are just graded wrong (or partially correct) 

and get shown the feedback and can no longer change their answer. 

There can be different feedback after each try the student makes. 

 Immediate feedback - Similar to interactive mode in that the student can 

submit their response immediately during the quiz attempt, and get it 

graded. However, they can only submit one response, they cannot 

change it later. 

 Deferred feedback or Immediate feedback with Certainty-based 

marking (CBM) - With CBM, the student does not only answer the 

question, but they also indicate how sure they are they got the question 

right. The grading is adjusted by the choice of certainty, so that students 

have to reflect honestly on their own level of knowledge in order to get 

the best mark. See the See Also section below for an example quiz 

using CBM and a blog post explaining the philosophy. 

 

Note: There is also an option "Manual grading" which can be enabled from 

Administration>Site administration>Plugins>Question behaviour This 

causes all questions in the quiz to require manual grading. 

Certainty-based marking 
When a student answers a question they also have to state how sure they 

are of the answer: not very (less than 67%); fairly 

(more than 67%) or very (more than 80%). Their grading is then ajusted 

according to how certain they are, which means that for example if they 

answered correctly but were only guessing, their mark is adjusted from 1 to 

0.33. If they answered wrongly but were very sure, their mark is adjusted 

from 0 to -2. 

(See also the forum discussion: CBM too harsh?) 

 

Screenshot «Correct answer; very sure». 

 

Screenshot «Correct answer; fairly sure». 

 

Screenshot «Correct answer; not very sure». 

 

Screenshot «Wrong answer; very sure». 

 

 Интерактивный Режим – после передачи на рассмотрение одного ответа и чтения 

Отзыва Студент должен щёлкнуть кнопку «Try again (постараться снова)» перед тем, 

как он сможет постараться дать новый ответ. Как только Студент ответит на Вопрос 

правильно, он не сможет больше изменить свой ответ. Если Студент ответит на Вопрос 

неправильно слишком много раз, ему просто будет дана Оценка «плохо (или частично 

правильно)» и показан Отзыв, и он не сможет далее изменять свой ответ. На каждую 

попытку Студента дать ответ может быть дана разная Обратная Связь. 

 Немедленный Отзыв – подобен Интерактивному Режиму в том, что Студент может 

передать на рассмотрение свой ответ немедленно в течение попытки выполнения 

Экзамена и получить свою оценку. Однако он может передать только один ответ и не 

может изменить его позднее. 

 Отложенный Отзыв или Немедленный Отзыв с оцениванием уверенности в 

ответе – с оцениванием уверенности в ответе Студент не только отвечает на Вопрос, но 

также указывает, насколько он уверен в правильности своего ответа на Вопрос. 

Итоговая Оценка выносится с учётом этих весовых коэффициентов уверенности, так 

что Студенты должны честно отражать степень своей уверенности, чтобы Оценка 

лучше отражала качество его знаний. См. ниже раздел «См. также» с примером 

Экзамена, использующего оценивание уверенности в ответе, а также сообщения блога, 

поясняющие эту философию. 

Замечание: Имеется также опция «Manual grading (оценивание вручную)», которая 

может быть позволена из AdministrationSite administrationPluginsQuestion behaviour. 

Это приведёт к необходимости оценивать все Вопросы Экзамена вручную. 

Оценивание уверенности в ответе 
Когда Студент отвечает на Вопрос, он также должен указать, насколько он уверен 

в правильности своего ответа: «Не очень» (менее 67%), «Достаточно уверен» 

(более 67%) или «Очень уверен» (более 80%). Их итоговая Оценка в дальнейшем 

уточняется в соответствии с тем, насколько уверенно они отвечали. Это означает, что, 

например, если они ответили правильно, но путём догадки, их оценка отрегулируется с 1 

до 0.33. Если они ответили неверно, но были очень уверены в правильности, их оценка 

отрегулируется с 0 до -2. 

(См. также обсуждения форума «Оценивание уверенности в ответе слишком 

сурово?») 

Снимок с экрана «Правильный ответ, очень уверен в ответе» – оценка 

отрегулируется с 1 до 1; 

Снимок с экрана «Правильный ответ, достаточно уверен в ответе» – оценка 

отрегулируется с 1 до 0,67; 

Снимок с экрана «Правильный ответ, не очень уверен в ответе» – оценка 

отрегулируется с 1 до 0,33; 

Снимок с экрана «Неправильный ответ, очень уверен в ответе»: – оценка 

отрегулируется с 0 до -2; 

https://moodle.org/mod/forum/discuss.php?d=225920
https://moodle.org/mod/forum/discuss.php?d=225920
http://docs.moodle.org/25/en/File:cbm03.png
http://docs.moodle.org/25/en/File:cbm05.png
http://docs.moodle.org/25/en/File:cmb04.png
http://docs.moodle.org/25/en/File:cbm01.png
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Screenshot «Wrong answer; not very sure». 

 

 

 
 

Each attempt builds on the last (available by clicking "Show more") 

 

If multiple attempts are allowed and this setting is set to Yes, then each 

new attempt contains the results of the previous attempt. This allows the 

student on the new attempt to concentrate on just those questions that 

were answered incorrectly on the previous attempt. If this option is 

chosen then each attempt by a particular student uses the same 

questions in the same order, independent of randomization settings. To 

show a fresh quiz on every attempt, select No for this setting. 

4.3.10.1.7.Review options 
This section controls what information students will be shown when they 

review their past attempts at the quiz, and during the attempt in adaptive 

mode. It is a matrix with check boxes. The various pieces of information 

that can be controlled are: 

The attempt 

Will show how the student responded to each question. 

Whether correct 

Displays whether the students response to each question is correct or 

incorrect. 
 

Marks 

Reveals the marks awarded to the student and the grade for the quiz. 

 

Specific feedback 

Will show the feedback for the response to the answer as set when adding 

the question to the quiz. Each response to a question can have feedback for 

both correct and incorrect answers. 

General feedback 

Displays the general feedback for the whole question as set when adding 

the question to the quiz. You can use the general feedback to give students 

some background to what knowledge the question was testing. 

 

 

Right answer 

Reveals the correct answer to each question, whether the student answered 

correctly or not (See note below). 

Снимок с экрана «Неправильный ответ, не очень уверен в ответе» – оценка 

отрегулируется с 0 до 0; 
Так что Студенты должны честно отражать их собственный уровень знаний, чтобы получить лучший 

балл. В этой системе трудно пройти тест, если вы не уверены в том, что вы делаете, или вы не 

знаете ответа. 

Каждая попытка ответа строится на последней попытке (доступна щелчком по 

«Show more») 

Если разрешены множественные попытки ответа и эта настройка установлена в «Yes», 

тогда каждая новая попытка содержит результаты предыдущей попытки. Это позволяет 

каждому из Студентов при новой попытке сконцентрироваться только на тех Вопросах, 

на которые он ответил некорректно в предыдущей попытке. Если выбрана эта опция, 

тогда каждая попытка, предпринятая конкретным Студентом, использует те же самые 

Вопросы, в том же самом порядке независимо от настроек рандомизации. Чтобы 

показать новый Экзамен для каждой попытки, выберите «No» для этой настройки. 

4.3.10.1.7.Опции просмотра 
Этот раздел управляет тем, какая информация будет показана Студентам, когда 

они просматривают их прошлые попытки выполнить Экзамен, и в течение выполнения 

попытки в Адаптивном режиме. Это матрица с окошками-флажками. Различные порции 

информации, которыми можно управлять: 

Попытка 

Покажет, как Студент ответил на каждый Вопрос. 

Правилен ли ответ 

Отображает, правильно или неправильно ответил Студент на каждый Вопрос. 
Предусматривает текстовое описание «Правильно», «Частично правильно» или «Неправильно» и ещё 

цветовую подсветку, которая передаёт ту же информацию. 

Баллы 

Показывает баллы, присуждённые Студенту за каждый ответ, и Итоговую Оценку 

за Экзамен. 

Отзыв на конкретный ответ 

Покажет Отзыв в качестве отклика на ответ, который установлен, при добавлении 

этого Вопроса в Экзамен. Каждый отклик на Вопрос может быть Отзывом как для 

правильных, так и неправильных ответов. 

Обычная Обратная Связь 

Отображает обычную Обратную Связь на весь Вопрос, которая установлена при 

добавлении этого Вопроса в Экзамен. Вы можете использовать обычную Обратную Связь 

для того, чтобы пояснить Студенту, какие знания тестируются этим Вопросом. Можно 

использовать общий отзыв, чтобы показать Студенту правильный ответ или ссылку на дополнительную 

информацию, которую они могут использовать для осознания Вопроса. 
Правильный ответ 

Сообщает правильный ответ на каждый Вопрос, независимо от того, правильно 

или нет ответил на него Студент (см. замечание ниже). 

http://docs.moodle.org/25/en/File:cbm99.png
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Overall feedback 

Displays feedback for the entire quiz as set in the quiz settings (See note 

below). 

For each of the above items, you can determine the timeframe when the 

students will see them: 

During the attempt  

is only available when ‘How questions behave’ has been set to 

‘Immediate feedback’, ‘Immediate feedback with CBM’ and 

‘Interactive with multiple tries’. If set to one of these options then a 

‘Check’ button will appear below the answer and when clicked the 

student will submit that response and then receive immediate feedback. 

Immediately after the attempt 

means within 2 minutes of the student clicking "submit all and finish". 

 

Later, while the quiz is still open  

means after 2 minutes, but before the close date (if the quiz does not 

have a close date, this phase never ends). 

After the quiz is closed  

means what it says (you never get here for quizzes without a close 

date). 

Tip: Checking any of the boxes in the timeframe row, will reveal the test to 

the student. For example, to allow students to see their quiz immediately 

after taking it but not later, make sure none of the boxes in "Later" or 

"After" rows are checked. The student will be able to see their grade but 

not get into the quiz. 

Note: Currently, the Answers display is a bit inconsistent between different 

question types. For example, the matching question type shows students 

which of their responses are correct, but does not tell them the right answer 

for the ones they got wrong. The short answer and multiple choices 

question types do tell the student what the correct answer is. 

Users with the capability 'View hidden grades' moodle/grade:viewhidden 

(typically teachers and administrators) are not affected by these settings 

and will always by able to review all information about a student's attempt 

at any time. 

In your list of review options, you must have 'The attempt' (the first option 

in the lists) selected before you can enable the options to show 'Whether 

correct', 'Specific feedback', 'General feedback', and 'Right answer'. If you 

choose not to let the students review the attempt, your only options are to 

display 'Marks' and 'Overall feedback'. 

 

Общая Обратная Связь 

Отображает Обратную Связь по Экзамену в целом, которая установлена в 

настройках этого Экзамена. 

Для каждого из приведённых выше элементов вы можете определить временные 

рамки того, когда Студенты будут их видеть. 

Во время выполнения попытка 

доступна только когда параметр «How questions behave» установлен в «Immediate 

feedback», «Immediate feedback with CBM» и «Interactive with multiple tries». Если 

установлен в одну из этих опций, тогда ниже каждого ответа будет появляться 

фиксирующая кнопка Check, щелчком по которой Студент будет отправлять на 

рассмотрение этот ответ и затем получать немедленную Обратную Связь. 

Сразу после попытки 

Означает, что только в течение первых двух минут после нажатия Студентом кнопки 

«Submit all and finish (отправить всё на рассмотрение и закончить)». 

Позже, но только пока Экзамен открыт 

Означает, что после 2 минут, но до даты закрытия (если Экзамен не имеет даты 

закрытия, то эта фаза никогда не кончается). 

После того, как Экзамен будет закрыт 

Означает то, что говорит её название (вы никогда не попадёте в эту колонку для 

Экзаменов, не имеющих даты закрытия). 

Совет. Щелчок в любом окошке строки ограничения временных рамок 

воспроизведёт Студенту весь Экзамен. Например, чтобы разрешить Студентам увидеть их 

Экзамен сразу после его выполнения, но не позднее, убедитесь в том, что ни одно окошко 

в строках «Later» или «After» не помечено. Каждый из Студентов сможет увидеть свою 

Оценку, но не получит доступа в этот Экзамен. 

Замечание. В настоящее время отображение ответов немного отличается для 

разных типов Вопросов. Например, тип «Вопрос на согласование» показывает Студентам, 

какие из их ответов верны, но не сообщает им правильный ответ на Вопрос, отвеченный 

неверно. Типы Вопросов «Краткий ответ» и «Вопрос с множественным выбором» 

сообщают Студентам, какой ответ правильный. 

На пользователей с Возможностью «Просматривать скрытые Оценки: 

moodle/grade:viewhidden» (обычно это Преподаватели и Администраторы) эти настройки 

не действуют, и они всегда могут просматривать всю информацию о попытках Студентов 

в любое время. 

В вашем перечне опций просмотра вы должны выбрать настройку «The attempt» 

(первая опция в списках) до того, как будете включать настройки «Правилен ли ответ», 

«Отзыв на конкретный ответ», «Общий отзыв» и «Правильный ответ». Если вы 

предпочтёте не разрешать Студентам просматривать каждую из попыток, вашими 

единственными опциями для отображения являются «Баллы» и «Общая Обратная Связь». 
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4.3.10.1.8.Display 
Show the user's picture 

If enabled, the student's name and picture will be shown on-screen 

during the attempt, and on the review screen, making it easier to check that 

the student is logged in as themself in an invigilated (proctored) exam. 

Decimal places in grades 

This option determines how many digits will be shown after the decimal 

point when the grade is displayed. A setting of 0 for example means that 

the grades are displayed as integers. This setting is only used for the 

display of grades, not for the display or marking of answers. 

Decimal places in question grades 

This setting specifies the number of digits shown after the decimal point 

when displaying the grades for individual questions. 

Show blocks during quiz attempts 

If set to yes then normal blocks will be shown during quiz attempts 

 

4.3.10.1.9.Extra restrictions on attempts 
Require password 

This field is optional. 

If you specify a password in here then participants must enter the same 

password before they are allowed to make an attempt on the quiz. This 

is useful to give only a selected group of students access to the quiz. 

Require network address 

This field is optional. 

You can restrict access for a quiz to particular subnets on the LAN or 

Internet by specifying a comma-separated list of partial or full IP 

address numbers. This is especially useful for a proctored (invigilated) 

quiz, where you want to be sure that only people in a certain room are 

able to access the quiz. For example: 192.168. , 231.54.211.0/20, 

231.3.56.211 

There are three types of numbers you can use (you can not use text 

based domain names like example.com): 

 Full IP addresses, such as 192.168.10.1 which will match a single 

computer (or proxy). 

 Partial addresses, such as 192.168 which will match anything 

starting with those numbers. 

 CIDR notation, such as 231.54.211.0/20 which allows you to specify 

more detailed subnets. 

Spaces are ignored. 

4.3.10.1.8.Отображение 
Показать фотографию пользователя  

Если включена, то имя и фотография Студента будут отображаться на экране во 

время попытки и на странице просмотра, облегчая проверку того, что именно этот Студент 

зарегистрировался на Экзамен, за которым ведётся слежение (надзор) против списывания. 

Десятичные разряды в оценках  

Эта опция определяет, сколько цифр будет показано после десятичной точки при 

отображении Оценки. Установка 0, например, означает, что Оценки будут отображаться 

как целые числа. Эта настройка используется только для отображения числовых Оценок, а 

не для отображения ответов. 

Десятичные разряды в оценках Вопросов 

Эта опция указывает число цифр, показываемых после десятичной точки при 

отображении Оценок за отдельные Вопросы. 

Отображать блоки во время прохождения Экзамена  

Если установлено значение "Yes", то Стандартные Блоки будут отображаться во 

время попыток выполнения Экзамена. 

4.3.10.1.9.Дополнительные ограничения на попытки 
Потребовать пароль 

Это поле необязательное. 

Если пароль всё-таки задан, то участники должны ввести его перед тем, как им будет 

позволена попытка прохождения Экзамена. Пароль полезно задавать отдельной группе 

Студентов для доступа к каждому из Экзаменов. 

Необходим сетевой адрес 

Это поле необязательное. 

Вы можете ограничить доступ к Экзамену только из определённым подсетям 

локальной сети (LAN) или Интернета, задав разделённый запятыми список чисел 

частичных или полных IP-адресов. Это особенно полезно для инспекторуемого 

(надзираемого) Экзамена, когда вы хотите быть уверены, что к Экзамену допущены 

люди только из определённой аудитории. Например, 192.168, 231.54.211.0/20, 

231.3.56.211. 

Существует три типа чисел, которые вы можете использовать (вы не можете 

использовать текст, основанный на имени домена): 

 Полный IP-адрес, такой как 192.168.10.1, который соответствует единственному 

компьютеру (или прокси). 

 Частичный IP-адрес, такой как 192.168, который будет соответствовать всем 

адресам, начинающимся с этих чисел. 

 CIDR-нотация, такая как 231.54.211.0/20, которая позволяет вам указать более 

детализированные подсети. 

Пробелы игнорируются. 
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 Enforced delay between attempts 

These two fields are optional. 

You can set a time (from seconds to weeks) between the first and 

second attempt of a quiz. You can also (or alternatively) set a time from 

seconds to weeks for subsequent attempts after the second attempt. 

Thus, you might allow a student to take the quiz twice immediately 

with no delay, but if they want to improve their score with a third 

attempt, they are forced to wait a week and use the time for extra 

revision. 

Browser security 

This is by default an advanced field, visible by clicking "Show 

advanced". 

The options in this section offer various ways to try to restrict how 

students may try to 'cheat' while attempting a quiz. However, this is not 

a simple issue, and what in one situation is considered 'cheating' may, in 

another situation, just be effective use of information technology. (For 

example, the ability to quickly find answers using a search engine.) 

 

Note also that this is not just at problem of technology with a 

technical solution. Cheating has been going on since long before 

computers, and while computers make certain actions, like copy and 

paste, easier, they also make it easier for teachers to detect cheating - 

for example using the quiz reports. The options provided here are 

not fool-proof, and while they do make some forms of cheating 

harder for students, they also make it more inconvenient for students 

to attempt the quizzes, and they are not fool-proof. 

 

Full screen pop-up with some JavaScript security 

There is a limit to what the quiz, which runs on a web server, can do to 

restrict what the student sitting at their computer can do while 

attempting the quiz. However, this option does what is possible: 

 The quiz will only start if the student has a JavaScript-enabled web-

browser. 

 The quiz appears in a fullscreen popup window that covers all the 

other windows and has no course navigation controls. 

 

 

 

 

 

Принудительная задержка между попытками 

Эти два поля необязательные. 

Вы можете установить время (от секунд до недель) между первой и второй попыткой 

пройти Экзамен. Вы можете также (или в качестве альтернативы) установить время от 

секунд до недель для последующих попыток после второй попытки. Таким образом вы 

можете позволить Студенту пройти Экзамен дважды немедленно без задержки, но если 

он хочет улучшить свою оценку с третьей попытки, он принудительно ждёт неделю и 

использует это время для дополнительного просмотра материалов. 

 

Безопасность браузера 

Эта опция по умолчанию относится к полю продвинутых опций, которое становится 

видимым после щелчка по «Show advanced (показать продвинутые)». 

Каждая из опций в этом разделе предлагает способы ограничения того, что Студенты 

могут постараться «Cheat (сжульничать)» при попытках выполнения Экзамена. Однако, 

это не простой вопРос, и что в одной ситуации может рассматриваться как 

«жульничество», в другой ситуации – просто эффективное применение 

информационной технологии. (Например, способность быстро находить ответы, 

используя поисковые машины.) 

Заметьте также, что это не просто проблема технологии с техническим решением. 

Жульничество появилось задолго до компьютеров, и наряду с тем, что компьютеры 

легче выполняют некоторые действия, подобные копированию и вклеиванию, они 

также облегчают Преподавателю обнаружение жульничества – например, 

посредством использования отчётов по Экзаменам. Каждая из предоставляемых 

здесь опций не защищена от неправильного использования, и наряду с тем, что 

делает некоторые формы жульничества для Студентов труднее, они также делают 

много менее удобными для Студентов попытки выполнения Экзаменов, и они не 

защищены от неправильного использования. 

Всплывающий полный экран с некоторой JavaScript безопасностью 

Существует ограничение на то, что Экзамен, запускаемый на веб-сервере, может делать 

во время попытки выполнения этого Экзамена. Однако эта опция делает, что возможно: 

 

 Экзамен будет запущен, только если Студент имеет подключённый JavaScript к веб-

браузеру. 

 Экзамен появляется во всплывающем полноэкранном окне, которое перекрывает 

все остальные окна и не имеет средств управления навигацией по Курсу. 
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Screenshot «Student view of quiz question with full screen popup» 

 The students are prevented, as far as is possible, from using facilities 

like copy and paste. 

 This setting does not work well with the MyMobile theme for 

mobile devices included in the standard installation. In particular, 

quiz time limits do not function correctly (MDL-32047). 

4.3.10.1.10.Overall feedback 
Overall feedback is shown to a student after they have completed an 

attempt at the quiz. The text that is shown can depend on the grade the 

student got. Click "Show editing tools" to display the rich text editor, and 

drag the bottom right of the text box out to expand it. 

 

For example, if you entered: 

Grade boundary: 100% 

Feedback: "Well done" 

Grade boundary: 40% 

Feedback: "Please study this week's work again" 

Grade boundary: 0% 

Then students who score between 100% and 40% will see the "Well done" 

message, and those who score between 39.99% and 0% will see "Please 

study this week's work again". That is, the grade boundaries define ranges 

of grades, and each feedback string is displayed to scores within the 

appropriate range. 

Grade boundaries can be specified either as a percentage, for example 

"31.41%", or as a number, for example "7". If your quiz is out of 10 marks, 

a grade boundary of 7 means 7/10 or better. 

Note that the maximum and minimum grade boundaries (100% and 0%) 

are set automatically. 

You can set as many or as few grade boundaries as you wish. The form 

allows you up to 5 ranges at first, but you can add more by clicking the 

"Add 3 fields to form" button underneath. 

If you're getting confusing error messages about a boundary being out of 

sequence (when it's obviously *in* sequence), or "boundaries must be 

between 0% and 100%" (and they are) -- check that the Maximum Grade 

for this quiz is set to something greater than zero. 

 

 

 

 

 

Снимок с экрана «Студент видит Вопрос Экзамена на всплывающем полном экране». 

 Студенты предотвращаются, насколько возможно, от использования средств, 

подобных копированию и вклеиванию. 

 Эта настройка не работает хорошо с фоновой картинкой MyMobile для мобильных 

устройств, включённых в стандартную инсталляцию. В частности, не работает 

правильно ограничения времени Экзамена (MDL-32047). 

4.3.10.1.10.Общая Обратная Связь 
Общая Обратная Связь показывается Студенту после того, как он завершит 

попытку сдать Экзамен. Текст, который показывается, может зависеть от полученной 

Студентом Оценки. Щёлкните по «Show editing tools», чтобы отобразить полный 

текстовый редактор и перетащите нижний правый уголок текстового окошка, чтобы 

расширить его. 

Например, если вы ввели: 

Grade boundary (граница оценки): 100%. 

Feedback (обратная связь): «Хорошо сделано». 

Grade boundary: 40%. 

Feedback: «Пожалуйста, изучите работу этой недели снова». 

Grade boundary: 0%. 

Тогда Студенты, чьи Оценки лежат между 100% и 40%, увидят сообщение «Well 

done», а те, чьи Оценки – между 39.99% и 0%, увидят «Please study this week's work again». 

Т.е. границы Оценок определяют области значений Оценок, а каждая строка 

Обратной Связи отображается для Оценок внутри подходящей области значений. 

 

Границы Оценок могут быть указаны либо в процентах, например, «31.41%», либо 

числом, например, «7». Если ваш Экзамен оценивается по 10 бальной шкале, оценка 7 

означает 7/10 или лучше. 

Заметим, что максимальная и минимальная границы оценок (100% и 0%) 

устанавливаются автоматически. 

Вы можете установить столь много или мало границ Оценок, сколько пожелаете. 

Данная форма позволяет сначала установить 5 областей значений, но вы можете добавлять 

больше, щёлкая внизу кнопку «Add 3 fields to form (добавить 3 поля в форму)». 

Если вы получили смущающие сообщения об ошибках последовательности границ 

(когда, очевидно, что они *в* последовательности), или «границы д.б. между % и 100%» (а 

они таковы) – проверьте, что максимальная Оценка для этого Экзамена установлена 

больше нуля. 

http://docs.moodle.org/25/en/File:seb24.png
http://tracker.moodle.org/browse/MDL-32047
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4.3.10.1.11.Common module settings 
See Common module settings 

4.3.10.1.12.Restrict access/Activity completion 
The Restrict access and Activity completion settings are visible if 

Conditional activities and Activity completion have been enabled in the 

site and the course. 

4.3.10.1.13.Group and User overrides 
Dates, timing and number of allowed attempts may be changed for 

individual users or groups by following the links Group Overrides or User 

Overrides in the Quiz Administration settings block. 

 

Group overrides 
To change a quiz setting for a particular group, click the "add group 

override" button in Quiz Administration>Group overrides, make the 

changes you wish and save or enter another override 

 

User overrides 
To change a quiz setting for a particular user or users, click the "add user 

override" button in Quiz Administration> User overrides, make the 

changes you wish and save or enter another override. 

4.3.10.1.14.Site administration settings 
The quiz module has additional settings which may be changed by an 

administrator in Administration > Site administration > Plugins > Activity 

modules > Quiz. 

Autosave period         New feature in Moodle 2.5! 

If enabled, student responses will be saved every minute/two 

minutes/five minutes (according to selection) This is useful so that 

students don't lose work but does increase the load on the server. 

How questions behave can be configured in Administration>Site 

administration>Plugins>Question behaviours>Manage question behaviours 

 

4.3.10.1.15.See also 
School demo example of a quiz with CBM Log into with username 

"parent" and password "moodle" 

Forum thread: Certainty based marking - too harsh? 

Blog post on CBM (Certainty Based Marking) in Moodle 

 

 

4.3.10.1.11.Общие настройки модулей 
См. «Общие настройки модулей» в п. 6.1. 

4.3.10.1.12.Ограничить доступ/завершение Действия 
Настройки ограничения доступа и завершения ИнтерактивногоДействия видимы, 

если позволены Обусловленные Действия и Завершение Действий на Сайте и в Курсе. 

 

4.3.10.1.13.Переопределения Группы и пользователя 
Даты, согласование времени и число разрешённых попыток 

могут быть изменены для индивидуальных пользователей или 

Групп следующей ссылкой Group Overrides или User Overrides в 

Блоке настроек Quiz Administration.  

Переопределения Группы 
Чтобы изменить настройку Экзамена для конкретной 

Группы, щёлкните кнопку «Add group override (добавить переопределение группы)» в 

Quiz administrationGroup overrides, сделайте нужные изменения и сохраните или 

переопределите другую запись. 

Переопределения пользователя 
Чтобы изменить настройку Экзамена для конкретного пользователя(ей), щёлкните 

кнопку «Add user override» в Quiz AdministrationUser overrides, сделайте нужные 

изменения и сохраните или переопределите другую запись. 

4.3.10.1.14.Настройки управления Сайтом 
Модуль «Экзамен» имеет дополнительные настройки, которые могут быть 

изменены Администратором в AdministrationSite administrationPluginsActivity 

modulesQuiz. 

Период авто-сохранения               Новинка в Moodle 2.5! 

Если позволено, ответы Студентов будут сохраняться каждую минуту/две/пять минут 

(в соответствии с выбором). Это полезно, чтобы Студенты не потеряли сделанного, но 

увеличивает нагрузку на сервер. 

Поведение Вопросов может быть сконфигурировано в 

AdministrationSite administrationPluginsQuestion behavioursManage question behavi

ours. 

4.3.10.1.15.См. также 
Школьный демонстрационный пример Экзамена с оцениванием уверенности в 

ответе. Зарегистрируйтесь под именем «parent» с паролем «moodle». 

Цепочка форумов: Оценивание уверенности в ответе – слишком жёстко? 

Сообщения блога по Оцениванию уверенности в ответе в Moodle. 

http://docs.moodle.org/25/en/Common_module_settings
https://moodle.org/mod/forum/discuss.php?d=225920
http://helderenwijzer.nl/2011/10/certainty-based-marking-in-moodle/
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4.3.10.2.Building Quiz 
4.3.10.2.1.How a Moodle quiz works 
The word “quiz” might conjure up for some images of TV game shows, 

but a Moodle quiz is basically a set of questions presented to the learner 

which may be automatically marked by Moodle or graded later by the 

teacher. The questions may be in sentence or number form or contain 

various media such as video or sound. They do not all need to be the same 

type of questions: a quiz may contain multiple choice, matching, essays 

(teacher-graded) and calculated. Feedback may be given at any or all 

stages of the process. 

Once a quiz is made, that’s not the end of it. A Moodle quiz is 

environmentally friendly: its questions are saved in a Question bank and 

may be recycled for use elsewhere. Thus, Mr Brown could create a Physics 

Quiz with 20 questions for his class, Class Brown, and his colleague Mr 

Smith sharing the course could save himself valuable time by reusing 5 of 

Mr Brown’s questions in his own General Science quiz for Class Smith. 

(See also Question Sharer role for sharing questions across the site) 

 

If a quiz is a book, the Quiz settings are equivalent to the front cover; the 

quiz itself is contained within when the questions are created. (Be careful: 

once you have chosen the Quiz Settings, it will be “live” on your course 

page, unless you hide it, so your learners could potentially see a quiz with 

no questions, like a front cover with no content.) 

 

Once a quiz has been added to the course and the Quiz settings established, 

the teacher can start to build the quiz. The teacher can access the quiz to 

edit the questions by clicking directly on the Quiz name on the course 

home page and then "Edit quiz" or by clicking the "info" link in the 

Navigation block. The "Edit quiz" link can also be accessed from 

Settings>Quiz administration. 

 

 

 

4.3.10.2.2.Adding questions 
Once you have accessed the quiz editing screen as above, you can add 

questions from a number of locations: 

 

 Click the "Add question" button to begin a new question (1 below) 

 

4.3.10.2.Построение Экзамена 
4.3.10.2.1.Как работает Экзамен системы Moodle 

Слово «quiz» может воскресить в памяти показ некоторых изображений в ТВ-игре, 

но Экзамен Moodle, по существу, – набор Вопросов, представляемый обучающемуся, 

который может быть автоматически оценён Moodle или оценён позднее Преподавателем. 

Эти вопросы могут быть в форме высказываний или числовой, или содержать различные 

медиа, такие как видео или звук. Нет необходимости им быть всем одного типа: Экзамен 

может содержать Вопросы со Множественным Выбором, на соответствие, типа эссе 

(оцениваемые лично Преподавателем) и вычисляемыми. Обратная Связь может быть дана 

на любой или всех стадиях процесса. 

Создание Экзамена – это ещё далеко не всё. Экзамен Moodle является контекстно 

дружественным: его Вопросы сохраняются в Банке Вопросов и могут быть повторно 

использованы ещё где-либо. Таким образом, мистер Браун мог бы создать Экзамен по 

физике с 20 Вопросами для его класса, класса Брауна, а его коллега мистер Смит, 

совместно использующий этот Курс, мог бы сохранить своё драгоценное время путём 

повторного использования 5 вопросов мистера Брауна в его собственном Экзамене по 

общей науке для класса Смита. (См. также «Роль совладельца Вопросов» в п. 4.6.4 по 

совместному использованию Вопросов на уровне Сайта.) 

Если Экзамен сравнить с книгой, настройки Экзамена эквивалентны передней 

обложке, сам по себе Экзамен есть её внутреннее содержимое, где создаются Вопросы. 

(Будьте осторожны: как только вы выбрали настройки Экзамена, он будет «жить» на 

странице вашего Курса, если только вы не скроете его, так что ваши обучающиеся 

потенциально смогут увидеть Экзамен без Вопросов, подобно передней обложке без 

содержания.) 

Как только Экзамен добавлен в Курс и 

установлены настройки Экзамена, Преподаватель может 

начать строить Экзамен. Преподаватель может войти в 

Экзамен, чтобы отредактировать Вопросы щелчком 

непосредственно по названию Экзамена на Домашней 

странице Курса, а затем по «Edit quiz» или щелчком по 

ссылке «Info» в Блоке навигации. Ссылка «Edit quiz» 

может быть также доступна из Administration 

Quiz administration. 

4.3.10.2.2.Добавление Вопросов 
Как только вы попали на экран редактирования 

Экзамена, как выше, вы можете добавлять Вопросы из 

ряда местоположений: 

 Щёлкните кнопку «Add question», чтобы начать новый Вопрос (1). 
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 Click "Show" (2a) to reveal the contents of the question bank (2b) and 

then choose a pre-made question or click "Create new question" (3) 

 

 

 

 

 Click "Add a random question" to add a random question, providing 

there are questions in the question bank already. 

 

Creating a new question 

 To make a brand new question, click "Add a question". 

 From the next screen, choose the question type you want to add and 

click "Next" 

NOTE: When you click on a question type on the left, helpful information 

appears on the right. 

 Fill in the question form, making sure to give a grade to the correct 

answer. 

 Click "Save changes" 

Screenshot «Selecting a question type». 

Screenshot «A question when it has been created». 

Adding responses and feedback 
When you add responses and feedback you can hide or display the text 

editor:         New feature in Moodle 2.5! 

Screenshot «Without the editing tools». 

Screenshot «With the editing tools». 

Note that when a question has been created, an icon and words display its 

type (eg multiple choice) and a magnifiying glass icon allows you to 

preview it. 

You can continue adding questions this way, clicking the "Add a question" 

button each time. 

Choosing a pre-made question 
If other teachers in the course have made questions, or if a teacher made 

questions in an earlier quiz, these can be added to the current quiz by 

clicking the arrows next to them in the question bank (1 below) or by 

checking/ticking the box of several and then clicking the button "add to 

quiz" (2). To ensure all previously made questions are available, make sure 

to tick the boxes "also show questions from sub-categories/old questions". 

 

 

 Щёлкните кнопку «Show» (2a), 

чтобы воспроизвести содержимое 

Банка Вопросов (2b) и затем 

выберите предварительно созданный 

Вопрос или щёлкните «Create new 

question» (3). 

 Щёлкните кнопку «Add a random 

question», чтобы добавить Вопрос случайным образом, из Вопросов, предоставляемых, 

уже существующих в Банке Вопросов. 

Создание нового Вопроса 
 Чтобы создать новый брендовый Вопрос, щёлкните «Add a question». 

 Из последующего экрана выберите тип Вопроса, который вы хотите добавить и 

щёлкните «Next». 

Замечание: Когда вы щёлкнете по типу Вопроса слева, справа появится полезная 

информация. 

 Заполните форму Вопроса, не забыв дать Оценку правильному ответу. 

 

 Щёлкните «Save changes». 

Снимок с экрана «Выбор типа Вопроса». 

Снимок с экрана «Вопрос после его создания». 

Добавление ответов и Обратной Связи 
После добавления ответов и Обратной Связи вы можете скрыть или отобразить 

текстовый редактор:                Новое средство в Moodle 2.5! 

Снимок с экрана «Без инструментария редактирования». 

Снимок с экрана «С инструментарием редактирования». 

Заметим, что когда Вопрос создан, иконка и слова отображают его тип (например, 

Multiple choice) и иконка увеличительного стекла позволяет вам предварительно 

просмотреть его. 

Вы можете продолжить добавление Вопросов этим способом, каждый раз щёлкая 

кнопку «Add a question». 

Выбор предварительно созданного Вопроса 
Если другие Преподаватели в этом Курсе создали Вопросы или если 

Преподаватель создал Вопросы в более раннем Экзамене, они могут быть добавлены в 

текущий Экзамен щелчками по стрелочкам, следующим за ним в Банке Вопросов (1), или 

пометкой «галочкой»/отметкой одного или нескольких окошек и затем щелчком по кнопке 

«Add to quiz (добавить в экзамен)» (2). Чтобы убедиться, что все предварительно 

созданные Вопросы доступны, потрудитесь отметить окошки «Also show questions from 

sub-categories/old questions (также показать вопросы из подкатегорий/старых вопросов)». 

http://docs.moodle.org/25/en/File:questionpicker.png
http://docs.moodle.org/25/en/File:questionadded.png
http://docs.moodle.org/25/en/File:quizform1.png
http://docs.moodle.org/25/en/File:quizform2.png
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Adding a random question 
As long as you have questions in the question bank, you can add random 

questions to your quiz. This might be useful if you have students in a class 

taking a quiz at the same time, because they are unlikely to get the same 

questions at the same time. The same question will never appear twice in a 

quiz. If you include several random questions then different questions will 

always be chosen for each of them. If you mix random questions with non-

random questions then the random questions will be chosen so that they do 

not duplicate one of the non-random questions. This does imply that you 

need to provide enough questions in the category from which the random 

questions are chosen, otherwise the student will be shown a friendly error 

message. The more questions you provide the more likely it will be that 

students get different questions on each attempt. 

The grade for the randomly chosen question will be rescaled so that the 

maximum grade is what you have chosen as the grade for the random 

question. 

You can add one or more random questions by choosing the number and 

category in the question bank. Note the die icon to highlight random 

question selection. 

Quiz question tags 
Note that although it is possible to tag questions, the feature does not 

currently work. See forum discussion: 

https://moodle.org/mod/forum/discuss.php?d=194119. 

Question categories 
Questions can be stored and retrieved from categories in the Question 

bank. When you make a new question it defaults to the category with the 

course name. So if you make a quiz in the Senior Physics course, questions 

will automatically be added to "Default for Senior Physics". You can opt to 

have your quiz questions in a category of their own ("Quizname") or to add 

a subcategory. 

To add a subcategory, go to Settings>Quiz administration>Question 

bank>Categories For more information on question contexts and 

categories, see Question bank 

Users will have access to different categories according to their 

permissions. For example, a regular teacher might only have access to 

question categories in his own Physics course whereas his Faculty Head of 

Science with permissions in all science courses might have access to 

question categories in Biology and Chemistry as well. 

 

 

Добавление случайного Вопроса 
До тех пор, пока у вас есть Вопросы в Банке Вопросов, вы можете добавлять в 

Экзамен Вопросы случайным образом. Это может быть полезно, если у вас есть Студенты 

в классе, сдающие Экзамен в одно и то же время, потому что они менее вероятно получат 

одинаковые Вопросы в одно и тоже время. Один и тот же Вопрос никогда не появится 

дважды в Экзамене. Если вы включили несколько Вопросов случайным образом, тогда 

различные Вопросы будут всегда выбраны для каждого из них. Если вы смешаете 

случайные Вопросы с неслучайными, тогда случайные Вопросы будут выбраны так, что 

они не сдублируют ни один из неслучайных Вопросов. Это не подразумевает, что вам 

нужно предоставить достаточно вопросов в этой Категории, из которой Вопросы будут 

выбираться случайным образом, вместо этого Студентам будет показаны дружеское 

сообщение об ошибке. Чем больше Вопросов вы предоставите, тем более вероятно, что 

Студенты получат различные вопросы при каждой попытке сдать Экзамен. 

Оценка для случайным образом выбранного Вопроса будет повторно 

масштабирована так, чтобы выбранная вами максимальная Оценка стала Оценкой за этот 

случайный Вопрос. 

Вы можете добавить один или более случайных Вопросов выбором числа и 

Категориив  Банке Вопросов. Заметьте трафаретную иконку для подсвечивания выбора 

случайного Вопроса. 

Теги в Вопросах Экзамена 
Заметьте, что хотя можно снабдить Вопросы тегами, это средство в настоящее 

время не работает. См. обсуждение форума. 

 

Категории Вопросов 
Вопросы могут сохраняться и извлекаться из Категорий в Банке Вопросов. Когда 

вы создаёте новый Вопрос, он по умолчанию попадает в Категорию с названием Курса. 

Так что, если вы создадите Вопрос в Курсе Senior Physics, тогда Вопросы автоматически 

будут добавляться в «Default for Senior Physics». Вы можете предпочесть иметь Вопросы 

вашего Экзамена в их собственной Категории («НазваниеЭкзамена») или добавлять их в 

подКатегорию. 

Чтобы добавить подКатегорию, перейдите в Administration 

Course administrationQuiz administrationQuestion bankCategories. Дальнейшую 

информацию по Контекстам Вопросов и Категориям см. в БанкеВопросов (п. 4.6.1.1). 

Пользователи будут иметь доступ к различным Категориям в соответствии с их 

Полномочиями. Например, обычный Преподаватель может иметь доступ только к 

Категориям Вопросов в его собственном Курсе физики, в то время как его 

уполномоченный факультета по науке с Полномочиями во всех научных Курсах может 

также иметь доступ к Категориям Вопросов в биологии и химии. 

https://moodle.org/mod/forum/discuss.php?d=194119
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4.3.10.2.3.Quiz layout 
 You can choose in Settings>Quiz administration>Edit settings>Layout 

whether to have a new page for every question or after a certain number 

of questions. 

 You can click the "Add a page here" button to add a page at selected 

intervals and move questions up and down by clicking the arrow button. 

 

 You can also set the pages by clicking the tab "Order and paging" on 

the Edit quiz screen. 

 Questions may be moved up and down with the arrows, or you can 

check the boxes to their left and then click "reorder questions" 

  

 You can check a box to select a question and then click "Add new 

pages after selected questions" 

 You can "repaginate" by setting the number of questions per page. After 

setting the number of questions per page, you can move questions so 

that there are a different number of questions on each page. 

Screenshot «Moving questions and adding pages». 

Screenshot «Order and paging». 

Screenshot «Repaginating». 

4.3.10.2.4.Assigning points to questions 
Settings > Quiz administration > Edit quiz > Editing quiz 

You can set how many points each question is worth by changing the 

number in the box to the right of each question (1) and you can change the 

maximum grade by changing the number in the box at the top of the quiz 

(2) The default is one point per question and 100.00 maximum grade. 

 

Tip: Each save button is independent of each other. Thus if you change 

2 grade boxes and click on the "Save" button, only the grade next to 

that button will be saved. Your other changes will revert to what they 

were before. Best practice is to change the grade and save one question 

at a time. 

 

The quiz module will do any maths, so for example, a 2 point question will 

be worth 2 times more when the Quiz module determines how many point 

out of 10 to award the student. 

4.3.10.2.5.Previewing the quiz 
 You can preview individual questions by clicking the magnifying glass 

icon. 

4.3.10.2.3.Компоновка Экзамена 
 Вы можете выбрать в AdministrationCourse administrationQuiz administration 

Edit settingsLayout иметь ли новую страницу для каждого Вопроса или после 

определённого числа Вопросов. 

 Вы можете щёлкнуть кнопку «Add a page here (добавить страницу здесь)», чтобы 

добавить страницу в выбранные интервалы и переместить Вопросы вверх и вниз 

щелчком по кнопке «Стрелка». 

 Вы можете также установить страницы щелчком по этикетке «Order and paging 

(порядок и страничная организация)» на экране редактирования Экзамена. 

 Вопросы могут быть перемещены вверх и вниз с помощью стрелок или вы можете 

пометить окошки слева от них и затем щёлкнуть «Reorder questions (переупорядочить 

вопросы)». 

 Вы можете пометить окошко, чтобы выбрать Вопрос и затем щёлкнуть «Add new pages 

after selected questions (добавить новые страницы после выбранных вопросов)». 

 Вы можете «Repaginate (разбитие на страницы)» путём выбора числа Вопросов на 

странице. После выбора числа Вопросов на странице вы можете переместить Вопросы 

так, чтобы на каждой странице существовало разное число вопросов. 

Снимок с экрана «Перемещение вопросов и добавление страниц». 

Снимок с экрана «Порядок и страничная организация». 

Снимок с экрана «Разбитие на страницы». 

4.3.10.2.4.Назначение баллов за Вопросы 
AdministrationCourse administrationQuiz administration Edit quiz Editing quiz 

Вы можете установить, скольких баллов достоин каждый Вопрос, изменением 

числа в окошке справа от каждого Вопроса (1), и вы можете установить максимальную 

Оценку путём изменения числа в окошке вверху 

Экзамена (2). По умолчанию – один балл за 

один Вопрос и максимальная Оценка 100.00. 

Совет: Каждая кнопка Save (сохранить) 

независима от каждой другой. Таким 

образом, если вы измените 2 окошка Оценки 

и щёлкнете по кнопке Save, сохранится только Оценка, за которой следует эта кнопка. 

Другие ваши изменения вернутся в прежнее состояние. Лучшая практика состоит в 

изменении Оценки и сохранении одного Вопроса за один раз. 

Модуль «Экзамен» сделает любые расчёты, например, 2-х балльный Вопрос может 

быть оценён в 2 раза больше, когда модуль «Экзамен» определит, скольких баллов по 10-

бальной шкале достоин Студент. 

4.3.10.2.5.Предварительный просмотр Экзамена 
 Вы можете предварительно просмотреть конкретные Вопросы щелчком по иконке 

увеличительного стекла. 

http://docs.moodle.org/25/en/File:paging1.png
http://docs.moodle.org/25/en/File:orderandpaging.png
http://docs.moodle.org/25/en/File:repaginate.png
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 You can preview the whole quiz by clicking the "Preview" link in 

Settings>Quiz administration>Preview 

 The quiz works like a real quiz so you can see your grades and any 

feedback for correct/incorrect answers just as a student would see them. 

 

Screenshot «Previewing a single question». 

Screenshot «Click to preview the whole quiz». 

Screenshot «Quiz in preview mode». 

Screenshot «Quiz feedback for incorrect answer». 

4.3.10.2.6.After quiz has been attempted 
If one or more students have taken the quiz, you will see a list of all the 

questions in the quiz and a notice saying that you cannot add or remove 

questions. 

You can change the order of questions, regrade them, preview an 

individual question and click on an question edit link that will allow you to 

directly edit the question stored in the question bank. 

NOTE: You can delete all quiz attempts by students and then edit the quiz 

as if no students had attempted it. To do this, click the quiz name and then 

the Results link in the Navigation block. This will present a list of students 

and their scores. Click "Select all" and then "Delete selected attempts". 

 

Dealing with faulty questions 
There are several ways to deal with "bad" questions in a quiz. 

 Change the grade for the bad question to 0 in the quiz. 

 Edit the question, changing what you will accept as a correct answer, 

then regrading the exam. Remember when changing a question that the 

next time it is used it will be as it was in the last edit. Also, regrading 

will only affect one quiz at a time. 

 

 You can edit the question to explain the situation to the student and then 

you can set the grade for the question to zero. After you make such 

changes you should regrade the quiz by clicking on the Results tab and 

then the Regrade tab. This will change the grade for all students who 

have taken the quiz so far. Remember, if the question is used by another 

quiz, your "explanation" will appear as part of that quiz. 

 You can change the grade for the bad question and then move or delete 

the question from your question category. The question will still appear 

on the quiz. Some places do not like to delete any question, but will 

move them to a "dead" or "bad" question category. 

 Вы можете предварительно просмотреть Экзамен в целом щелчком по ссылке 

«Preview» в AdministrationCourse administrationQuiz administrationPreview. 

 Этот предварительный просмотр работает подобно реальному Экзамену, так что вы 

можете увидеть ваши Оценки или любую ОбратнуюСвязь для 

правильных/неправильных ответов точно так же, как Студент увидит их. 

Снимок с экрана «Предварительный просмотр единственного Вопроса». 

Снимок с экрана «Щёлкнуть, чтобы предварительно просмотреть весь Экзамен». 

Снимок с экрана «Экзамен в режиме предварительного просмотра». 

Снимок с экрана «Отзыв на Экзамен для неправильного ответа». 

4.3.10.2.6.После попытки выполнения Экзамена 
Если один или более Студентов использовали Экзамен, вы можете увидеть список 

всех Вопросов в этом Экзамене и, заметим, не можете добавить или удалить Вопросы. 

Вы можете изменить порядок Вопросов, переоценить их, предварительно 

просмотреть индивидуальный Вопрос и щёлкнуть по ссылке редактирования Вопроса, что 

позволит вам непосредственно редактировать этот Вопрос, сохранённый в 

Банке Вопросов. 

Замечание: Вы можете удалить все попытки Студентов выполнить Экзамен и затем 

отредактировать этот Экзамен, как будто Студенты и не пытались его выполнить. Чтобы 

сделать это, щёлкните название Экзамена, а затем ссылку Results в Блоке навигации. Это 

представит список Студентов и их Оценки. Щёлкните «Select all (выбрать все)» и затем 

«Delete selected attempts (удалить выбранные попытки)». 

Борьба с дефектными Вопросами 
Существует несколько способов борьбы с «плохими» Вопросами в Экзамене. 

 Измените Оценку за плохой Вопрос на 0 в этом Экзамене. 

 Отредактируйте этот Вопрос, изменяя то, что вы примете за правильный ответ, затем 

переоцените этот Экзамен. Помните, когда изменяете Вопрос, что следующий раз, 

когда он будет использоваться, он будет таким, каким был при последнем 

редактировании. Также, повторное оценивание действует только на один Экзамен за 

раз. 

 Вы можете отредактировать этот Вопрос, чтобы объяснить ситуацию Студенту, и затем 

можете установить Оценку за этот Вопрос в ноль. После того, как сделаете такие 

изменения, вы должны переоценить этот Экзамен, щёлкнув по этикетке Results, а затем 

по этикетке Regrade. Это изменит Оценку для всех Студентов, которые использовали 

этот Экзамен до настоящего времени. Помните, если этот Вопрос используется другим 

Экзаменом, ваше «объяснение» появится как часть того Экзамена. 

 Вы можете изменить Оценку за плохой Вопрос и затем переместить или удалить этот 

Вопрос из вашей Категории Вопросов. Вопрос всё ещё появится на данном Экзамене. 

Некоторые части Moodle не удаляют любые вопросы, а перемещают их в Категорию 

«мёртвых» или «плохих» Вопросов. 

http://docs.moodle.org/25/en/File:previewquestion.png
http://docs.moodle.org/25/en/File:previewquiz.png
http://docs.moodle.org/25/en/File:quizpreviewed.png
http://docs.moodle.org/25/en/File:quizincorrect.png
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 When you discover a bad question in your quiz, it may affect the 

question bank. Remember that a final might be made up of a certain 

number of random questions drawn from different question categories, 

the same categories used in a smaller subject quiz. It can be very 

important do something about bad or invalid questions in a question 

category when the categories are use in other places. 

4.3.10.2.7.See also 
 Questions in Managing a Moodle course 

4.3.10.3.Using Quiz 
This page explains how a quiz is accessed and used by students and 

teachers. It also offers some hints as to good practice in using the quiz 

module. 

4.3.10.3.1.How students take a quiz 
 Click on the quiz link on the course homepage and read the information 

to check you're in the right quiz. 

 Click on "Attempt quiz now" button. 

 Click on the "Next" button at the bottom of the page to see the next 

page of questions 

 Click on the "flag" in the box next to the question to put a temporary 

marker on it 

 Notice the Quiz navigation block in the upper right corner. You can use 

it to jump to any question. Question boxes for the current page are in 

bold. Flagged questions will have a "red corner" in their box 

 

 To finish the exam, click "Finish attempt" in the navigation block of 

"Next" on the last page of the exam. 

 The "Summary of attempt" page - reviews the questions and alerts you 

to questions not attempted. 

 

 Click on any question page number or "Return to attempt" to go back to 

the quiz. 

 Click on "Submit all and finish" to have your quiz scored. A warning 

will pop up telling you you can no longer change your answers. 

 

How students review a quiz 
 In the quiz navigation block incorrect answers are RED: partially 

correct answers are YELLOW and correct answers are GREEN. The 

flags are still visible: 

 Когда вы обнаружите плохой Вопрос в вашем Экзамене, это может подействовать на 

Банк Вопросов. Помните, что в итоге может быть составлено определённое число 

случайно выбираемых Вопросов, выбираемых из разных Категорий Вопросов, эти же 

самые Категории используются в более маленьком тематическом Экзамене. Может 

оказаться очень важным что-нибудь сделать с плохими или отдельными Вопросами в 

Категории Вопросов, когда эти Категории используются в других местах. 

4.3.10.2.7.См. также 
 Вопросы в управлении Курсом Moodle (п. 4.6). 

4.3.10.3.Использование Экзамена 
Эта страница рассказывает, как получают доступ и используют Экзамен Студенты 

и Преподаватели. Она также предлагает некоторые советы хорошей практики по 

использованию модуля «Экзамен». 

4.3.10.3.1.Как Студенты используют Экзамен 
 Щёлкните по ссылке на нужный Экзамен на Домашней странице Курса и прочитайте 

информацию, чтобы убедиться, что Экзамен выбран правильно. 

 Щёлкните кнопку «Attempt quiz now (попытаться выполнить экзамен сейчас)». 

 Щёлкните кнопку «Next» внизу страницы, чтобы увидеть другую страницу Вопросов. 

 

 Щёлкните по «флажку» в окошке, следующем за Вопросом, чтобы 

установить для него временный маркёр. 

 Обратите внимание на блок навигации Экзамена в верхнем правом углу. 

Вы можете использовать его для перехода к любому Вопросу. Окошки 

Вопросов для текущей страницы в жирной рамке. Отмеченные 

флажками Вопросы будут иметь «красный уголок» в своём окошке. 

 Чтобы завершить этот Экзамен, щёлкните «Finish attempt (завершающая попытка)» в 

Блоке навигации «Next» на последней странице этого Экзамена. 

 Страница «Summary of attempt (резюме попытки)» – просматривает 

Вопросы и предупреждает вас о Вопросах, на которые вы не 

попытались ответить. 

 Щёлкните по любому номеру страницы Вопросов или по «Return to 

attempt (вернуться к попытке)», чтобы вернуться в Экзамен. 

 Щёлкните по «Submit all and finish (передать всё на рассмотрение и 

завершить)», чтобы оценить ваш Экзамен. Всплывёт предупреждение, которое сообщит 

вам, что вы больше не можете изменять свои ответы. 

Как Студенты просматривают Экзамен 
 В Блоке навигации Экзамена неправильные ответы – КРАСНЫЕ, 

частично правильные ответы – ЖЁЛТЫЕ, а правильные ответы – 

ЗЕЛЁНЫЕ. Флажки всё ещё видимы. 
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 In the questions themselves, correct answers will be in green with a 

check mark. Incorrect answers will be in red with a cross. 

 According to your teacher's settings, you might get general feedback, 

specific feedback on each question and/or overall feedback on your 

final score. 

Saving questions and returning later to a quiz 
 If you answer a number of questions and then want to complete the quiz 

at a later time, click "Finish attempt". 

 When you return to continue the quiz, Moodle will remember which 

page you were on and allow you to continue from there, having saved 

your previous questions. 

Retaking a quiz 
If your teacher has allowed multiple attempts, when you click on the quiz 

again you will be informed how many attempts you have remaining along 

with your previous scores. 

4.3.10.3.2.How teachers view a quiz 
Note: Once a quiz has been attempted, it is not possible to add or delete 

questions unless previous scores are removed. 

 When attempts have been made on the quiz, the teacher can click the 

quiz name and access the reports by clicking the link "Attempts - (No. 

of attempts)". 

 It is then possible to filter the reports according to preference. 

 A teacher may also access quiz results by clicking on the quiz name in 

the Navigation block. This opens up other links, enabling them to view 

by grade, by correct response, by statistics and by manually graded 

responses. 

 Each individual question may be filtered in score order and individual 

student quiz responses may be viewed by clicking "Review attempt" 

next to their name. 

 

 For more information on how quiz responses are reported, see Quiz 

reports. 

Commenting on or regrading responses 
By clicking on the score of an individual question, a teacher may comment 

on it or override the grade 

 

 

 

 

 В самих Вопросах правильные ответы будут в зелёном цвете с помеченной Оценкой. 

Неправильные ответы будут в красном цвете с крестиком. 

 В соответствии с настройками вашего Преподавателя вы можете получать обычную 

Обратную Связь, специфическую Обратную Связь на каждый Вопрос и/или общую 

Обратную Связь на вашу Итоговую Оценку. 

Сохранение Вопросов и возврат к Экзамену позднее 
 Если вы ответили на ряд Вопросов и затем хотите завершить этот Экзамен позднее, 

щёлкните «Finish attempt (завершить попытку)». 

 Когда вы вернётесь, чтобы продолжить Экзамен, Moodle напомнит, на какой странице 

вы были, и позволит вам продолжить с неё, сохранив ваши предыдущие Вопросы. 

 

Пересдача Экзамена 
Если ваш Преподаватель разрешил множественные попытки, когда вы щёлкните 

по этому Экзамену снова, вы будете информированы о том, сколько попыток вам 

осталось, наряду с вашими предыдущими Оценками. 

4.3.10.3.2.Как Преподаватели видят Экзамен 
Замечание: Как только сделана попытка сдать Экзамен, невозможно добавить или 

удалить Вопросы, пока не удалены предыдущие Оценки. 

 Когда попытки сдать Экзамен сделаны, Преподаватель может щёлкнуть название 

Экзамена и получить доступ к отчётам щелчком по ссылке «Attempts (попытки) – (No 

of attempts – нет попыток)». 

 Затем можно отфильтровать отчёты в соответствии с предпочтениями. 

 Преподаватель также может получить доступ к результатам Экзамена 

щелчком по названию Экзамена в Блоке Навигации. Это откроет другие 

ссылки, позволяющие вам увидеть отчёты по Оценкам, по правильным 

ответам, по статистике и по ответам, оценённым вручную: 

 Каждый индивидуальный Вопрос может быть отсортирован в порядке 

оценок, а индивидуальные ответы по Экзамену Студента могут быть 

увидены посредством щелчка по «Review attempt (просмотреть попытку)», следующей 

за названием. 

 Дальнейшую информацию о том, как ответы по Экзамену собираются в отчёты, см. в 

«Отчёты по Экзаменам (п. 4.3.10.4)». 

Комментирование или повторное оценивание ответов 
Щёлкнув по баллу за конкретный Вопрос, Преподаватель может 

прокомментировать его или переопределить эту Оценку. 
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Messaging students who haven't completed a quiz 
 
 From your navigation block, click Reports>Course participation 

 

 From the drop down, choose your quiz. 

 In Show only, choose "Student" and in Actions, choose "post" 

 

 In the list that appears, tick/check the boxes next to those you wish to 

message. 

 In the bottom dropdown With selected users, choose "send message" 

 

 

4.3.10.3.3.Ideas for using Quiz 
(with acknowledgement to Michelle Moore) 

Quizzes may be used: 

 as unit or course exams 

 as mini-tests for reading assignments or at the end of a topic 

 as exam practice using questions from previous years' exams 

 to deliver immediate feedback for printed workbook activities 

 

 to provide feedback about performance 

 for self assessment 

 (with the use of the Quiz creator role) to allow students to generate their 

own quiz questions for a practice question bank. 

4.3.10.3.4.See also 
 Working example of a quiz on School demo site (Log in with 

username:student/password:moodle) 

 See how a teacher analyses quiz results on School demo site (Log in 

with username:teacher/password:moodle) 

 

 

 

 

 

 

 

 

 

Извещение Студентов, не завершивших 
Экзамен 
 Из вашего Блока навигации щёлкните ReportsCourse 

participation. 

 Из ниспадающего меню выберите ваш Экзамен. 

 В «Show only (показать только)» выберите «Student», а в 

Actions выберите «Post (отправить почтовое сообщение)». 

 В появившемся списке отметьте/пометьте окошки, 

следующие за теми, кого желаете известить. 

 Внизу ниспадающего меню «With selected users (с 

выбранными пользователями)» выберите «Send message 

(отправить сообщение)». 

4.3.10.3.3.Идеи по применению Экзамена 
(с признательностью Микаэлю Муру) 

Экзамен может быть использован: 

 как Экзамен по компоненту или Курсу, 

 как мини-тесты для читающих Задания или в конце Темы, 

 как экзаменационная практика, использующая Вопросы из экзаменов прошлых лет, 

 чтобы доставить немедленную Обратную Связь на распечатанные 

Интерактивные Действия «Рабочая тетрадь – устарела уже», 

 чтобы предоставить Обратную Связь о выполнении, 

 для самооценивания, 

 (в Роли создателя Экзаменов) чтобы позволить Студентам сгенерировать их 

собственные экзаменационные Вопросы для практического Банка Вопросов. 

4.3.10.3.4.См. также 
 Работающий пример Экзамена на демонстрационном Сайте Школы: 

(зарегистрируйтесь под именем student с паролем moodle). 

 См. как Преподаватель анализирует результаты Экзамена на демонстрац. Сайте Школы 

(зарегистрируйтесь под именем teacher с паролем moodle). 

http://school.demo.moodle.net/mod/quiz/view.php?id=1497
http://school.demo.moodle.net/mod/quiz/report.php?id=1497&mode=overview
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 Effective quiz practices 

 How to let teachers share questions between courses 

 Quiz results for teachers reviewing an untaken quiz 

 Quiz reports once students take a quiz, more tools are available 

 

 Quiz submission email notification 

 Friction-less Learning with Quizzes in Moodle by Joseph Thibault 

 Online Quizzes and Exams with Moodle - reflections by James Neill 

4.3.10.4.Quiz reports 
Administration> Quiz administration > Results. This will open a submenu 

that offers reports on: Grades report, Responses report, Statistics report, 

Manual grading report. 

You can also get to the quiz reports where you see a summary of the 

number of attempts that have been made like "Attempts: 123". That link 

also goes to the reports. 

4.3.10.4.1.Grades report 
The quiz grades report may be viewed by clicking on the quiz and 

accessing Administration > Quiz administration >Results > Grades 

The Results Grade link shows the grade, date/time started, completed, time 

taken for every quiz attempt. There is also a graph which shows all scores. 

 

 

Grades report shows all the students' quiz attempts, with the overall grade, 

and the grade for each question. There are links to review all the details of 

a student's attempt, just as the student would see it. 

 

Screenshot "Report showing only basic information for 2 students". 

 

 

The results can be downloaded in a variety of formats. 

There is a setting form at the top of the page that can be used to control 

what is displayed. 

At the bottom of the page is a graph showing the distribution of scores. 

There are check boxes to allow you to individually regrade or delete the 

selected attempts. 

By clicking on the score link, you are able to look at an individual student 

exam. 

 

 

 Эффективные практики Экзамена. 

 Как позволить Преподавателю совместно использовать Вопросы между Курсами. 

 Результаты Экзамена для Преподавателя, просматривающего несданный Экзамен. 

 Отчёты по Экзамену после сдачи Студентами Экзамена, больше инструментов 

доступно. 

 Извещение по э-почте о передачи на рассмотрение Экзамена. 

 Лишённое разногласий изучение с Экзаменами в Moodle от Джозефа Сиболта. 

 Онлайн Экзамены и экзамены с Moodle – размышления от Джеймса Нейла. 

4.3.10.4.Отчёты по Экзамену 
Course administrationQuiz administrationResults. Это откроет подменю, которое 

предлагает отчёты: Отчёт по оценкам, Отчёт по ответам, Отчёт по статистике, Отчёт по 

оцениванию вручную. 

Вы также можете получить отчёты по Экзамену там, где видите Summary (сводку) 

по числу попыток, которые были сделаны, подобную «Attempts: 123 (попытки: 123)». Эта 

ссылка также приведёт к отчётам. 

4.3.10.4.1.Отчёт по оценкам 
Отчёт по Оценкам за Экзамен может быть увиден щелчком по этому Экзамену и 

переходом в Course administrationQuiz administrationResultsGrades. 

Ссылка Results Grade (оценка результатов) показывает (см. снимок ниже): date/time 

started (дату время начала), completed (завершения), time taken for every quiz attempt (время, 

потраченное на каждую попытку Экзамена). Есть также график, который показывает все 

баллы. 

Отчёт по Оценкам показывает все попытки Студентов по Экзамену с 

Итоговой Оценкой и Оценкой за каждый Вопрос. Существуют ссылки для просмотра всех 

подробностей студенческой попытки, точно так 

же Студент может это видеть. 

Снимок с экрана «Отчёт, показывающий 

только основную информацию по двум 

Студентам»: 

Результаты могут быть загружены в различных форматах. 

Существует форма настроек вверху этой страницы, которая может быть 

использована для управления тем, что отображается. 

Внизу этой страницы есть график, показывающий распределение баллов. 

Существуют окошки-флажки, чтобы позволить вам индивидуально повторно 

оценивать или удалять выбранные попытки. 

Щелчком по ссылке на эти баллы вы можете увидеть экзамен индивидуального 

Студента. 

http://docs.moodle.org/25/en/Effective_quiz_practices
http://docs.moodle.org/25/en/How_to_let_teachers_share_questions_between_courses
http://docs.moodle.org/25/en/Quiz_results
http://docs.moodle.org/25/en/Quiz_reports
http://docs.moodle.org/25/en/Quiz_submission_email_notification
http://www.moodlenews.com/2011/friction-less-learning-with-quizzes-in-moodle/
http://en.wikiversity.org/wiki/User:Jtneill/Teaching/Online_Quizzes_and_Exams_with_Moodle
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Deleting attempts 
The grading report can be used to delete selected quiz attempts, which may 

sometimes be necessary. 

Note that you cannot edit the quiz after it has been attempted, so that is one 

reason you may wish to delete all attempts. 

Re-grading attempts 
The grading report allows the teacher to select quiz attempts that need to 

be regraded. The teacher can 'dry-run' a regrade. That is, see which scores 

would change if you did a real re-grade, but without actually updating the 

grades yet. 

Warning: This function does not touch automatically graded questions. 

If you have accidently set Question behaviour to "Manual grading", this 

means all questions, even usually automatically graded questions will 

not be automatically graded. Changing this setting to something like 

Deferred feedback, and them clicking Regrade will NOT change the 

state of the ungraded Multi-choice questions etc. You need to manually 

grade all the questions or hack the database. See 

https://moodle.org/mod/forum/discuss.php?d=221113 

Report options 
 Which students/attempts 

 Whether to show the individual question grades 

 How many attempts per page 

Report columns 
 First name / Surname 

 Started on - the date and time quiz was started 

 Completed - the date and time completed 

 Time taken - the amount of time it took the student to start and submit 

the quiz 

 Grade/x - the number of points students scored; 'x' is the maximum 

number of points 

 Feedback - any feed back remarks 

Screenshot «Grades report page preference settings» 

Screenshot «Grades report showing grades, feedback, start & end times» 

 

Screenshot «Grades report showing marks, grades, comments» 

 

Screenshot «Grades report chart» 

 

 

Удаление попыток 
Отчёт по оцениванию может быть использован, чтобы удалить выбранные 

попытки по Экзамену, что бывает иногда необходимо. 

Заметьте, что вы не можете редактировать тот Экзамен, который пытались сдать, 

так что это одна причина, по которой можно захотеть удалить все попытки. 

Повторное оценивание попыток 
Отчёт по оцениванию позволяет Преподавателю выбрать попытки по Экзамену, 

которые нуждаются в повторной Оценке. Преподаватель может «прорепетировать» 

переоценку. Т.е. увидеть, какие бы баллы изменились, если действительно повторить 

Оценку, но пока без реального обновления Оценок. 

Предупреждение: Эта функция не касается автоматически оцениваемых Вопросов. 

Если вы случайно установите поведение Вопросов в «Manual grading (оценивание 

вручную)», это повлечёт то, что все Вопросы, даже обычно оцениваемые 

автоматически, автоматически оцениваться не будут. Изменение этой настройки на 

что-нибудь подобное «Deferred feedback (отложенный отзыв)» и затем щелчок по 

Regrade (оценить повторно) НЕ изменит состояния неоценённых Вопросов 

множественного выбора и т.д. Вам потребуется вручную оценить все Вопросы или 

проникнуть в базу данных. См. https://moodle.org/mod/forum/discuss.php?d=221113. 

Опции отчёта 
 Какие Студенты/попытки 

 Показывать ли оценки за индивидуальные Вопросы 

 Сколько попыток располагать на странице 

Колонки отчёта 
 Имя/фамилия 

 Начато – дата и время, когда Экзамен был начат 

 Завершён – дата и время завершения 

 Затраченное время – количество времени, потребовавшегося Студенту от начала 

выполнения Экзамена до передачи его на рассмотрения Преподавателю 

 Оценка/х – число баллов, в которые оценён Студент; «х» – максимальное число баллов 

 

 Обратная Связь – любые замечания в качестве Обратной Связи. 

Снимок с экрана «Настройки предпочтения страницы отчёта по Оценкам». 

Снимок с экрана «Отчёт по Оценкам, показывающий Оценки, ОбратнуюСвязь, 

сроки начала и конца». 

Снимок с экрана «Отчёт по Оценкам, показывающий баллы, Оценки, 

комментарии». 

Снимок с экрана «График отчёта по Оценкам». 

https://moodle.org/mod/forum/discuss.php?d=221113
http://docs.moodle.org/25/en/File:Quiz_results_grades_preferences.png
http://docs.moodle.org/25/en/File:Quiz_result_report_min_6_col_report.png
http://docs.moodle.org/25/en/File:Quiz_result_report_min_6_col_report.png
http://docs.moodle.org/25/en/File:Quiz_results_grades_report_show_marks.png
http://docs.moodle.org/25/en/File:Quiz_results_grades_report_show_marks.png
http://docs.moodle.org/25/en/File:Quiz_results_grades_chart.png
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Display options 
Show / download options: 

 Participants who have attempted the quiz 

 Participants who have not attempted the quiz 

 All attempts - list all the students in the course, no matter if they took 

the quiz or not 

 All Participants who have or have not attempted the quiz 

Only show / download attempts check boxes for: 

 That are graded for each user (Highest grade) 

 That have been regraded / are marked as needing regrading 

Report preferences 
 Page size 

 Show/download marks for each question 

Tip: To sort the results by two columns, first click on the column heading 

you want to be the second key, and then click on the column heading you 

want to be the primary key. 

4.3.10.4.2.Quiz responses report 
This is very similar to the Grades report, except that it shows the responses 

the students gave, rather than the marks they earned. 

It is also possible to show the question text or the right answer, to compare 

with the student's response. This is helpful when the question is 

randomised. 

The quiz responses report may be viewed by clicking on the quiz and then 

accessing Administration > Quiz administration> Results > Responses 

 

The quiz responses report allows the teacher to see a table of answers for a 

quiz, with a row for each student. For example, it is possible to scroll down 

and see each students answer to the same question. Here are some 

examples: 

Screenshot «Preferences» 

Screenshot «Basic report, no preferences checked» 

Screenshot «Report example with 2 preferences checked» 

4.3.10.4.3.Statistics report 
The quiz statistics report may be viewed by clicking on the quiz and then 

accessing Administration > Quiz administration> Results > Statistics 

 

 

 

 

Опции Отображения 
Опции показа/загрузки: 

 Участники, которые попытались сдать Экзамен. 

 Участники, которые не пытались сдать Экзамен. 

 Все попытки – список Студентов в Курсе, безотносительно сдавали они Экзамен или 

нет. 

 Все участники, которые попытались или не пытались сдать Экзамен. 

Только окошки-флажки для показа/загрузки попыток: 

 Эта попытка оценена для каждого пользователя (Высшая Оценка). 

 Эта попытка повторно оценена/помечена как нуждающаяся в повторной Оценке 

Предпочитаемый формат отчёта 
 Размер страницы. 

 Отметки показать/загрузить для каждого Вопроса. 

Совет: Чтобы отсортировать результаты по двум колонкам, сначала щёлкните по 

заголовку той, которая будет вторичным ключом, а затем щёлкните по заголовку колонки, 

которая должна быть первичным ключом сортировки. 

4.3.10.4.2.Отчёт по экзаменационным ответам 
Этот отчёт очень похож на отчёт по Оценкам за исключением того, что он 

показывает данные Студентами ответы, а не баллы, которые они заработали. 

Можно также показать текст Вопроса или правильный ответ, чтобы сравнить с 

ответом Студента. Это полезно, когда Вопрос выбирается случайным образом. 

 

Отчёт по экзаменационным ответам может быть увиден щелчком по Экзамену, а 

затем переходу к Administration Course administrationQuiz administrationResults 

Responses. 

Отчёт по экзаменационным ответам позволяет Преподавателю увидеть таблицу 

ответов по Экзамену со строкой для каждого Студента. Например, можно прокрутить его 

вниз и увидеть ответ каждого Студента на один и тот же Вопрос. Здесь несколько 

примеров: 

Снимок с экрана «Предпочтения». 

Снимок с экрана «Базовый отчёт, предпочтения не отмечены». 

Снимок с экрана «Пример отчёта с двумя отмеченными предпочтениями». 

4.3.10.4.3.Статистический отчёт 
Статистический отчёт по Экзамену может быть увиден щелчком по этому 

Экзамену, а затем переходу к AdministrationCourse administration 

Quiz administrationResults Statistics. 

http://docs.moodle.org/25/en/File:Quiz_results_responses_preferences_area.png
http://docs.moodle.org/25/en/File:Quiz_results_responses_open_preferences.png
http://docs.moodle.org/25/en/File:Quiz_results_responses_2_preferences_checked.png
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This report gives a statistical (psychometric) analysis of the quiz, and the 

questions within it. The top section of this report gives a summary of the 

whole quiz. The next section gives an analysis showing all questions in a 

table format. There are links in this section to edit individual questions or 

drill down into a detailed analysis of a particular question. The last section 

of this report is a bar graph of the percent of correct answers (Facility 

index) and the Discriminative efficiency index. 

The full report (overview, and detailed analysis of all questions) can be 

downloaded in a variety of formats, as can the quiz structure analysis table. 

Overall quiz statistics 
Here are the details concerning information in this robust report. 

 

Quiz information 
This section gives some basic information about the test as a whole. You 

will see: 

 Quiz name 

 Course name 

 Open and close dates (if applicable) 

 Total number of first/graded attempts 

 Average grade for first/all attempts 

 Median grade 

 Standard deviation of grades 

 Skewness and Kurtosis of the grade distribution 

 

 Coefficient of internal consistency (sometimes called Cronbach Alpha) 

- This is a measure of whether all the items in the quiz are testing 

basically the same thing. Thus it measures the consistency of the text, 

which is a lower bound for the validity. Higher numbers here are better. 

 

 Error ratio - the variation in the grades comes from two sources. First 

some students are better than others at what is being tested, and second 

there is some random variation. We hope that the quiz grades will 

largely be determined by the student's ability, and that random variation 

will be minimised. The error ratio estimates how much of the variation 

is random, and so lower is better. 

 

 

 

 

Этот отчёт выдаёт статистический (психометрический) анализ Экзамена и 

Вопросов внутри него. Верхний раздел этого отчёта предоставляет резюме по Экзамену в 

целом. Следующий раздел – анализ, показывающий все Вопросы в табличном формате. В 

этом разделе есть ссылки, чтобы отредактировать индивидуальные Вопросы или вникнуть 

в подробный анализ конкретного Вопроса. Последний раздел этого отчёта является 

гистограммой, отражающей процент правильных ответов (индекс по выбору) и 

дифференциальный индекс эффективности. 

Полный отчёт (обзор и подробный анализ всех Вопросов) может быть загружен во 

множестве форматов, насколько может позволить таблица анализа структуры Экзамена. 

Итоговые статистические данные по Экзамену 
Здесь находятся подробности, касающиеся информации в этом содержательном 

отчёте. 

Информация Экзамена 
Этот раздел даёт некоторую базовую информацию об Экзамене в целом. Вы 

увидите: 

 Quiz name – Название Экзамена 

 Course name – Наименование Курса 

 Open and close dates – Даты открытия и закрытия (если применимы) 

 Total number – Общее число первых/оценённых попыток 

 Average grade – Средняя оценка за первую/все попытки 

 Median grade – Медианное значение оценок 

 Standard deviation of grades – Стандартное отклонение оценок 

 Skewness and Kurtosis of the grade distribution – Коэффициент асимметрии и 

коэффициент эксцесса распределения вероятностей оценок 

 Coefficient of internal consistency – Коэффициент внутренней связности (иногда 

называемый «альфа-коэффициентом Кронбаха»). Он является мерой того, 

действительно ли все элементы данного Экзамена тестируют фактически одно и то же. 

Таким образом, он служит мерилом последовательности, состоятельности текста, 

являющейся нижней границей значимости Экзамена. Чем он больше, тем лучше. 

 Error ratio – Коэффициент ошибки – разница в Оценках ответов Студентов на один и 

тот же вопрос может иметь двоякое происхождение. Во-первых, одни из них лучше, 

чем другие ориентируется в том, что тестируется, и, во-вторых, разница может быть 

случайной флуктуацией. Мы надеемся, что оценки по Экзамену в большей степени 

соответствуют способностям Студентов, и что случайные отклонения будут 

минимизированы. Коэффициент ошибки оценивает долю случайных отклонений, и чем 

он меньше, тем лучше. 

http://en.wikipedia.org/wiki/Skewness
http://en.wikipedia.org/wiki/Kurtosis
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 Standard error - this is derived from the error ratio, and is a measure of 

how much random variation there is in each test grade. So, if the 

Standard error is 10%, and a student scored 60%, then their real ability 

probably lies somewhere between 50% and 70%. 

 

Screenshot «Example of quiz information section» 

Quiz structure analysis 
This section lists all the questions in the quiz with various statistics in a 

table format. 

 Q# - shows the question number (position), question type icon, and 

preview and edit icons 

 Question name - the name is also a link to the detailed analysis of this 

question. 

 Attempts - how many students attempted this question. 

 Facility Index - the percentage of students that answered the question 

correctly. 

 Standard Deviation - how much variation there was in the scores for 

this question. 

 Random guess score - the score the student would get by guessing 

randomly 

 Intended/Effective weight - Intended weight is simply what you set up 

when editing the quiz. If question 1 is worth 3 marks out of a total of 10 

for the quiz, the the intended weight is 30%. The effective weight is an 

attempt to estimate, from the results, how much of the actual variation 

was due to this question. So, ideally the effective weights should be 

close to the intended weights. 

 Discrimination index - this is the correlation between the score for this 

question and the score for the whole quiz. That is, for a good question, 

you hope that the students who score highly on this question are the 

same students who score highly on the whole quiz. Higher numbers are 

better. 

 Discriminative efficiency - another measure that is similar to 

Discrimination index. 

 

 

 

 

 

 Standard error – Стандартное отклонение ошибки – это производная от коэффициента 

ошибки, и является мерой того, насколько случайно отклонение в каждой Оценке по 

Экзамену. Итак, если стандартное отклонение ошибок составляет 10%, а оценка 

Студента составляет 60%, тогда его реальная способность, возможно, лежит где-то 

между 50% и 70%. 

Снимок с экрана «Пример раздела информации Экзамена». 

Анализ структуры Экзамена 
В этом разделе перечисляются все Вопросы Экзамена с различными 

статистическими данными в табличном формате. 

 Q# – показывает номер (позицию) Вопроса, иконку типа Вопроса и иконки 

предварительного просмотра и редактирования. 

 Question name – наименование Вопроса, которое также является ссылкой на страницу 

подробного анализа этого Вопроса.  

 Attempts (попытки) – Сколько Студентов пытались выполнить этот Экзамен. 

 Facility Index (Индекс обеспеченности) – процент Студентов, которые ответили на этот 

Вопрос правильно. 

 Standard Deviation (стандартное отклонение) – насколько велик был разброс баллов по 

этому Вопросу. 

 Random guess score (баллы за угадывание ответов случайным образом) – сколько 

баллов Студент может получить случайным угадыванием. 

 Intended/Effective weight (предполагаемый/фактический вес) – предполагаемый вес – 

это просто то, что вы устанавливаете, когда редактируете Экзамен. Если вопрос 1 

оценён в 3 балла из 10 возможных для этого Экзамена, предполагаемый вес составляет 

30%. Фактический вес является попыткой по результатам оценить, каков вклад данного 

вопроса в разброс Оценок по Вопросу. Итак, в идеале фактические веса должны быть 

близки к предполагаемым. 

 Discrimination index (Показатель различимости) – является корреляцией между 

баллами, накопленными за Вопрос и за Экзамен в целом. Т.е. для хорошего Вопроса вы 

надеетесь, что Студенты, получившие высокие баллы за этот Вопрос, являются теми 

Студентами, которые получат высокие баллы и за Экзамен в целом. Чем выше это 

число, тем лучше. 

 Discriminative efficiency (различимая эффективность) – другая мера, похожая на 

Показатель различимости. 

http://docs.moodle.org/25/en/File:Quiz_results_statistics_information.png
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Where random questions are used, there is one row in the table for the 

random question, followed by further rows, one for each real question that 

was selected in place of this random question. When quiz questions are 

randomized for each quiz, the quiz module determines a default position. 

Quiz statistics calculations gives further details these on all quantities. 

 

Screenshot «Example of statistics structural analysis section» 

Quiz statistics chart 
Chart example 

Quiz question statistics 
Navigation > quiz's name > Results > Statistics (click on any question 

title). 

 

It is possible to see the statistics for one question on a single page. This 

view will also tell you what percentage of quiz takers selected each answer 

(Analysis of responses) and give you basic information about the question. 

 Question information - The basic information about the question, the 

name of the quiz, the question, the question type, the position in the 

quiz and the question itself. There are preview and edit icons in this 

page. 

 Question statistics - This repeats the information from the table row 

from the Quiz structure analysis that relates to this question. 

 

 Report options - You can choose whether to run the report on all 

attempts, or just the first attempt by each student. Some of the 

calculations used in the report are based on assumptions that may not 

apply to quizzes that allow more than one attempt. 

Tip: Computing the statistics takes some time, the report will store the 

computed values and re-use them for up to 15 minutes. Therefore, there is 

a display of how recently the statistics were calculated, with a button to 

recalculate them immediately 

Analysis of individual question responses 
This gives a frequency analysis of the different responses that were given 

to each part of the question. The details of the analysis depends on the 

question type, and not all question types support this. For example, essay 

question responses cannot be analyzed. 

 

 

 

 

Когда используются случайные Вопросы, имеется одна строка в таблице для 

каждого случайного Вопроса, за которыми следуют строки по одной на каждый реальный 

Вопрос, который был взят вместо данного случайного Вопроса. Когда вопросы Экзамена 

рандомизированы для каждого Экзамена, модуль «Экзамен» определяет позицию по 

умолчанию. Вычисления статистических показателей по тестам предоставляют 

дальнейшие детали по всем этим характеристикам (п. 4.3.10.4.6). 

Снимок с экрана «Пример раздела статистического структурного анализа». 

Статистическая диаграмма Экзамена 
Пример диаграммы: 

Статистические данные Вопросов Экзамена 
В блоке Navigation щёлкните по названию Экзамена, а затем 

перейдите к AdministrationCourse administrationQuiz administrationResults 

Statistics (щёлкните по заголовку любого Вопроса). 

Можно увидеть статистические данные для одного Вопроса на отдельной 

странице. Этот вид также расскажет о том, какой процент из выполнявших Экзамен дали 

все ответы (анализ ответов) и даст вам базовую информацию об этом Вопросе. 

 Question information (информация о вопросе) – базовая информация об этом Вопросе, 

наименование Экзамена, Вопрос, тип Вопроса, позиция в Экзамене и Вопрос сам по 

себе. Имеются иконки предварительного просмотра и редактирования на этой 

странице. 

 Question statistics (статистические данные о вопросе) – они повторяют информацию из 

строки таблицы «Quiz structure analysis (структурный анализ Экзамена)», которая 

относится к этому Вопросу. 

 Report options (опции отчёта) – вы можете выбрать, будете ли запускать отчёт по всем 

попыткам, или только по первой попытке каждого Студента. Некоторые из вычислений 

использованные в этом отчёте, базируются на предположениях, которые могут 

оказаться неприменимыми к Экзаменам, которые допускают более чем одну попытку. 

Совет: Вычисление статистических данных занимает некоторое время, каждый из 

отчётов сохранит вычисленные значения и повторно использует их где-то за 15 минут. По 

этой причине существует отображение того, насколько недавно вычислены 

статистические данные, и кнопка для их немедленного пересчёта. 

Анализ индивидуальных ответов на Вопросы 
Предоставляет частотный анализ различных ответов, которые были даны 

Студентами на каждую часть Вопроса. Подробности анализа зависят от типа Вопроса, и 

применимы не ко всем типам Вопросов. Например, ответы на Вопросы-эссе 

проанализированы быть не могут. 

http://docs.moodle.org/25/en/File:Quiz_results_statistics_structure_analysis.png
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Screenshot «Individual question's responses statistic information» 

See also 
 http://docs.moodle.org/dev/Quiz_statistics_calculations 

 A brief guide to what the statistics mean, from the Open University 

4.3.10.4.4.Manual grading report 
The manual grading report may be viewed by clicking the quiz in question 

and then accessing Administration> Quiz administration >Results > 

Manual grading 

The first screen of the report lists all the questions in the quiz that need to 

be, or have been, manually graded (for example essay questions) with the 

number of attempts. There is an option to also show the questions that have 

been automatically graded, which if useful if you ever need to edit the 

grades by hand. 

Screenshot «Needs grading opening screen» 

Screenshot «Preferences to display manual grading page» 

Screenshot «Example of student attempt ready for manual grading» 

4.3.10.4.5.See also 
 Details of the Quiz statistics calculations 

 Contributed Quiz report plugins available 

4.3.10.4.6.Quiz statistics calculations 
Introduction 
This page describes the calculations of these quiz and question statistics. 

You can find a succinct description of their meanings here Quiz report 

statistics. Also see the documentation for the Quiz statistics report itself. 

 

General issues 
Quizzes that allow multiple attempts 
For quizzes that allow multiple attempts, by default the report should only 

include data from the first attempt by each student. (The data for 

subsequent attempts probably does not satisfy the assumptions that 

underlie item analysis statistics.) However, there should be an option 

'Include data from all attempts', which should have a disclaimer that this 

may be statistically invalid either near it on screen, or possibly in the help 

file. (For small data sets, it may be better to include all data.) 

 

Using the first attempt also avoids problems caused by each attempt builds 

on last. 

 

Снимок с экрана «Статистика об индивидуальных ответах на Вопросы». 

См. также 
 http://docs.moodle.org/dev/Quiz_statistics_calculations. 

 Краткое руководство по статистическим данным от Открытого университета. 

4.3.10.4.4.Отчёт по оцениванию вручную 
Отчёт по оцениванию вручную может быть просмотрен щелчком по конкретному 

Экзамену и затем переходом к AdministrationQuiz administration Results 

Manual grading. 

На первом экране отчёта перечисляются все Вопросы в Экзамене, которые должны 

или уже оценены вручную (например, Вопросы на сочинение эссе) с рядом примеров. 

Имеется опция, чтобы также показать Вопросы, которые уже оценены автоматически, что 

полезно, если вам потребуется отредактировать Оценки вручную. 

 

Снимок с экрана «Экран открытия оценивания потребностей». 

Снимок с экрана «Предпочтения для отображения страницы оценивания вручную». 

Снимок с экрана «Пример попытки Студента готовой для оценивания вручную». 

4.3.10.4.5.См. также 
 Детали статистических вычислений по Экзаменам. 

 http://moodle.org/plugins/browse.php?list=category&id=13. 

4.3.10.4.6.Вычисление статистических данных Экзамена 
Введение 

Эта страница описывает вычисления этих статистических данных Экзаменов и 

Вопросов. Вы можете найти лаконичное описание их значений, именно статистических 

данных отчётов по Экзаменам. См. также документацию для самого статистического 

отчёта по Экзамену. 

Общие вопросы 
Экзамены, которые позволяют множественные попытки 

Для Экзаменов, которые позволяют множественные попытки, по умолчанию Отчёт 

будет включать данные только из первой попытки каждого Студента. (Данные для 

последующих попыток, могут не удовлетворить предположениям, которые лежат в основе 

статистических данных анализа оцениваемых элементов). Однако должна существовать 

опция «Include data from all attempts (включить данные из всех попыток)», которая должна 

иметь оговорку о том, что статистические данные на экране или, возможно, в файле 

помощи, могут быть неверными или близкими к этому. (Для маленьких наборов данных 

может быть лучше включать все данные.) 

Использование первой попытки также позволяет избежать проблем, вызываемых 

построением каждой попытки на предыдущей. 

http://docs.moodle.org/25/en/File:Quiz_results_statistics_individual_question_analysis_responses.png
http://docs.moodle.org/dev/Quiz_statistics_calculations
http://labspace.open.ac.uk/file.php/3484/Brief_Guide_to_iCMA_reports.pdf
http://docs.moodle.org/25/en/File:Quiz_results_manual_grading_needs_grading.png
http://docs.moodle.org/25/en/File:Quiz_results_manual_grading_options.png
http://docs.moodle.org/25/en/File:Quiz_results_manual_grading_student_attempt.png
http://docs.moodle.org/dev/Quiz_statistics_calculations
http://moodle.org/plugins/browse.php?list=category&id=13
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Within the analysis, when multiple attempts per student are included, each 

attempt is treated as an independent attempt. (That is, we pretend each 

attempt was by a different student.) 

Adaptive mode 
Adaptive mode does not pose a problem. Item Analysis just supposes that 

each item in the Quiz returns a score, and these scores are added up to get 

the Quiz score. Therefore Item Analysis does not care about adaptive/non-

adaptive mode. However, just to be clear, for an adaptive question, the 

score used in the calculation is the final score for the item, including 

penalties. 

 

Certainty based marking 
Similarly, should CBM, and/or negative scoring for multiple choice 

questions be implemented, we just use the final item score in the 

calculations, making sure that the formulae are not assuming that the 

minimum item score is zero. 

 

 

Incomplete attempts 
There is an issue about what you do when not all students have answered 

all questions. Depending on how you handle these missing items, you 

distort the statistics in different ways. 

There are basically two reasons why a student may not have answered a 

particular question: 

 they may have chosen to omit it, or 

 they may have run out of time, if the Quiz is timed. In this case, omitted 

questions tend to be towards the end of the Quiz. 

Available approaches for handling this are: 

1. treat omitted items as having a score of 0. 

2. exclude any attempt with missing scores from the analysis. 

3. Analyse each question separately - and when analysing a particular 

question, just include students who answered that question in the 

analysis. 

I think we should implement 1 for now. This is how Moodle currently 

works - a blank answer is marked and receives a score of zero, and so is 

indistinguishable from a wrong answer. Item analysis is most important for 

summative Quizzes, and the result of that question being in the Quiz is that 

it gave that student a contribution of 0 marks towards their final score. 

 

 

При анализе, когда множественные попытки ответов Студентом включены, каждая 

попытка трактуется как независимая. (Т.е. мы действуем так, будто все попытки 

выполнены разными Студентами.) 

Адаптивный режим 
Адаптивный режим не вызывает проблем. Анализ Оцениваемых Элементов просто 

предполагает, что каждый такой элемент в Экзамене вносит свой накопленный балл, и все 

такие баллы суммируются, чтобы получить баллы по Экзамену. Следовательно, анализ 

Оцениваемых Элементов не проявляет интерес к режиму адаптивный/неадаптивный. 

Однако, просто чтобы прояснить, для адаптивного Вопроса этот накопленный балл, 

используемый в вычислении, является Итоговым, включая штрафы, баллом для этого 

Оцениваемого Элемента, 

Оценивание, основанное на уверенности в ответе 
Так же, следовало бы реализовать оценивание учётом степени уверенности в 

правильности ответов и/или подсчёта отрицательных баллов для 

Вопросов с Множественным Выбором, мы просто используем Итоговый балл 

Оцениваемого Элемента в вычислениях, убедившись лишь, что в каждой из формул не 

предполагается, что минимальный балл за каждый из Оцениваемых Элементов равен 

нулю. 

Незавершённые попытки 
Существует проблема, что делать, когда не все Студенты ответили на все Вопросы. 

В зависимости от того, как вы обработаете эти пропущенные Оцениваемые Элементы, вы 

по-разному исказите статистические данные. 

Имеются две основных причины, почему Студент не ответил на конкретный 

Вопрос: 

 он предпочёл пропустить его, или 

 он запустил его после срока, если Экзамен ограничен по времени. В этом случае 

пропущенные Вопросы имеют тенденцию направляться в конец Экзамена. 

Допустимые подходы для обработки этого таковы: 

1. Обработать пропущенные оцениваемые элементы, как набравшие 0 баллов. 

2. Исключить из анализа любую попытку с пропущенными баллами.  

3. Проанализировать каждый Вопрос отдельно – и при анализе конкретного Вопроса 

просто включать в анализ только тех Студентов, которые ответили на этот Вопрос. 

 

Я думаю, сейчас нам стоит использовать 1-е. Так Moodle работает в настоящее 

время – пустой ответ помечается и получает 0 баллов, что не отличить от неправильного 

ответа. Анализ оцениваемых элементов более важен для агрегируемых Экзаменов, и 

результат решения этой проблемы, помещённый в Экзамен, даст Студенту вклад из 0 

баллов в его итоговый балл. 
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Random questions 
In a quiz with random questions not all students will have attempted the 

same set of questions. To account for this, the analysis below distinguishes 

between positions in the Quiz, and test items. 

Notation used in the calculations 
 

4.3.10.5.Grading Quiz 
4.3.10.5.1.Grading quizzes 
Some questions auto mark. Some need manual grading. 

 

Quiz overview 
This enables you to grade one question at a time. 

Manual Grading Report 
This enables you to grade all of one question on one page. 

For more information see Manual Grading Report 

4.3.10.6.Quiz FAQ 
4.3.10.6.1.Can I have different start 
times/timings/numbers of attempts for different 
groups? 
 In the Quiz administration settings block, there is a link "group 

override". 

 Click this link and you will be able to select your groups and change the 

quiz dates, times and number of attempts: 

4.3.10.6.2.What happens if students submit 
answers after the quiz closing date? 
It is possible for students to still submit answers after the quiz has closed 

(for example if they started the attempt before the closing date but then 

took a long time before submitting). These responses are stored by the quiz 

module, but the students are not given any credit for them. The teacher can 

see these answers when reviewing the student's attempts and can give the 

student credit for them by hand. Also the teacher could change the closing 

date after the fact and regrade the attempts. The students answers would 

then get graded. 

 

 

 

 

Вызываемые случайным образом вопросы 
В Экзамене со случайно вызываемыми Вопросами не все Студенты будут пытаться 

отвечать на один и тот же набор Вопросов. Чтобы учесть это, анализ, приведённый ниже, 

Экзамене и тестируемые элементы. 

Нотация, используемая в вычислениях 
См. http://docs.moodle.org/dev/Quiz_statistics_calculations#Introduction. 

4.3.10.5.Оценивание Экзамена 
4.3.10.5.1.Оценивание Экзаменов 

Некоторые Вопросы оцениваются автоматически. Некоторые нуждаются в 

оценивании вручную. 

Просмотр Экзамена 
Эта опция позволяет оценивать одни Вопрос за раз. 

Отчёт по оцениванию вручную 
Эта опция позволяет оценить всё из одного Вопроса на одной странице. 

Больше информации приведено в п. 4.3.10.4.4. 

4.3.10.6.Часто задаваемые вопросы по Экзамену 
4.3.10.6.1.Можно иметь разные времена 
начала/согласование по времени, число попыток для 
различных Групп? 
 В блоке настроек управления Экзаменом есть ссылка «Group override (переопределить 

группу)». 

 Щёлкните эту ссылку и вы сможете выбрать ваши Группы и изменить даты, время и 

число попыток сдать этот Экзамен. 

4.3.10.6.2.Что произойдёт, если Студенты предадут на 
рассмотрение ответы после даты закрытия Экзамена? 

Студентов можно успокоить, что ответы можно передавать на рассмотрение после 

закрытия Экзамена (например, если они начали попытку перед датой закрытия, но потом 

надолго прекратили передачу). Эти ответы сохраняются модулем «Экзамен», но Студенты 

не получают «кредит» (зачётная единица в высшем учебном заведении; как правило, количество кредитов за Курс 

равно количеству аудиторных занятий в неделю в течение семестра: 1 аудиторное занятие в неделю – 1 "кредит" за курс, 2 

аудиторных занятий – 2 "кредита" и т.п.) за них. Преподаватель может увидеть эти ответы при 

просмотре студенческих попыток и может дать каждому из Студентов «кредит» ручным 

способом. Также Преподаватель может изменить дату закрытия, после её завершения, и 

повторно оценить попытки. Ответы Студентов тогда могут быть оценены. 

http://docs.moodle.org/25/en/Quiz_manual_grading_report
http://docs.moodle.org/dev/Quiz_statistics_calculations#Introduction
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4.3.10.6.3.Is there a nice way to print a copy of a 
quiz? 
Not at the moment. See this tracker request: Printer-friendly (more 

compact) layout option for quiz 

 Also this discussion, where there is an unlikely hack: 

https://moodle.org/mod/forum/discuss.php?d=222565 

 Some CSS suggestions here: 

https://moodle.org/mod/forum/discuss.php?d=205969#p899667 

Also note the comments here: 

http://docs.moodle.org/en/Effective_quiz_practices#Printing_and_sharing_

questions 

4.3.10.6.4.Why am I no longer allowed to add or 
remove questions? 
Most likely it is because you have students that have already attempted the 

quiz. You will need to delete all of the attempts by selecting them and 

choosing to delete them if you need to add/remove questions from a quiz. 

If you are developing a new quiz where the attempts have just been 

trials then deleting the previous attempts will have no consequeces in 

the grade book. 

If this is not the case think carefully about how to handle the graded 

attempts. 

There are several ways of getting to the “attempts #” which you need to 

click on to delete the previous attempts. Use which ever works for you. 

 

 Click on the quiz that you want to amend. It will take you to a page 

with “attempts #" at the top. 

 If you are on a page with this message “You cannot add or remove 

questions because the quiz has been attempted (attempts #)” Click on 

"attempts #". 

 If you have navigated away from the page with the message go to the 

Settings block > Quiz Administration > Edit Quiz. 

Whichever way you find “attempts #” click on it and you will go to a page 

with a drop down menu at the top. Select “all users who have attempted the 

quiz”. There are several other click boxes select whatever applies to your 

situation. Click “Show Report” and then “select all”. Click “Delete 

selected attempts” and confirm selection. 

 

Go back to Settings > Quiz Administration > Edit Quiz and you will 

now be able to add or delete questions. 

4.3.10.6.3.Существует хороший способ напечатать копию 
Экзамена? 

В данный момент нет. См. требование этого средства отслеживания. 

 

 Также это обсуждение, где приведено невероятное незаконное проникновение. 

 

 Некоторые CSS-предложения здесь. 

 

Также обратите внимание на комментарии здесь 

 

 

4.3.10.6.4.Почему мне дольше не позволено добавлять или 
перемещать комментарии? 

Наиболее вероятно, из-за того, что ваши Студенты уже предприняли попытки 

сдать этот Экзамен. Вам может потребоваться удалить все попытки, выбрав их и задав их 

удаление. Если вам нужно добавить переместить Вопросы из Экзамена. 

Если вы развиваете новый Экзамен, где попытки были просто пробными, тогда 

удаление предыдущих попыток не повлияет на Журнал Оценок. 

 

Если это неприемлемо, тщательно продумайте то, как обработать оценённые попытки. 

 

Существует несколько способов добраться до «Attempts # (число попыток)», 

которую нужно щёлкнуть, чтобы удалить предыдущие попытки. Используйте тот, 

который вам подходит. 

 Щёлкните по Экзамену, который хотите улучшить. Это приведёт вас на страницу с 

«Attempts #» вверху. 

 Если вы на странице с таким сообщением «You cannot add or remove questions because 

the quiz has been attempted (attempts #) – вы не можете добавлять или перемещать 

Вопросы, что попытки Экзамена исчерпаны (число попыток)». 

 Если вы ушли прочь со страницы с таким сообщением, перейдите в Блок настроек 

AdministrationQuiz administrationEdit Quiz. 

Каким бы способом вы не нашли «attempts #», щёлкните по ней, и вы перейдёте на 

страницу с ниспадающим меню вверху. Выберите «All users who have attempted the quiz 

(все пользователи, которые попытались сдать экзамен)». Существует несколько других 

активных окошек, выбор какого-либо применяется к вашей ситуации. Щёлкните «Show 

Report (показать отчёт)» и затем «Select all (выбрать все)». Щёлкните «Delete selected 

attempts (удалить выбранные попытки)» и подтвердите выбор. 

Вернитесь к настройкам AdministrationQuiz administrationEdit Quiz и будете сейчас 

способны добавлять и удалять Вопросы. 

https://tracker.moodle.org/browse/MDL-348
https://moodle.org/mod/forum/discuss.php?d=222565
https://moodle.org/mod/forum/discuss.php?d=205969#p899667
http://docs.moodle.org/en/Effective_quiz_practices#Printing_and_sharing_questions
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4.3.10.6.5.How can I turn off glossary auto-linking 
in a quiz? 
 In the Quiz administration settings block there will be a link "filter". 

 Click the link and you will have the option to disable filters just for that 

particular quiz: 

4.3.10.6.6.How can I remove a problem question 
after the quiz has been taken? 
You can not remove a question once a quiz has been taken by one student 

or more. However you can change the score and flag the question so you 

know it has problems. 

Set the score for that question to 0. 

 Caution: In some versions of Moodle if you use this question in an 

other quiz, this will potentially change the question in that quiz as well. 

A trick is to score the question as 0, then regrade the just completed 

quiz. This will establish the new grade for gradebook. Now go back and 

change the score to the original value. 

Find the question in Question Bank. Maybe edit the title (Do not use in 

Bio101). Or if you do not share the question category with other teachers, 

create a sub category, move the offending question there, and perhaps 

create a better question to replace the one you just moved. Create a new 

quiz and if necessary hide the old one. 

 Caution: if other departments or teachers use a question category it 

might be wise to check with the team before moving or changing any 

question. This is one reason importing questions in a course is a good 

best practice in some situations. 

4.3.10.6.7.Can I have a quiz that is not graded? 
 
This is not a common requirement, so it may not work perfectly, but you 

can get close: 

 On the quiz editing page, set the score for each question, and the total 

score for the quiz to 0. 

 On the quiz settings page, there is a grid of check-boxes. Turn off all 

the ones in the score column. 

4.3.10.6.8.Why is my quiz not displaying in the 
gradebook? 
 Check that you have a maximum score that is more than 0, if your score 

is 0, then the quiz will not appear in the gradebook. 

Remember you can tell gradebook not to include the quiz. 

4.3.10.6.5.Как отключить автосвязывание Глоссария в 
Экзамене? 
 В Блоке настроек AdministrationQuiz administration появится ссылка «Filter». 

 Щёлкните эту ссылку, и у вас появится опция, чтобы отключать Фильтры только для 

этого конкретного Экзамена. 

4.3.10.6.6.Как можно удалить проблемный Вопрос после 
того, как Экзамен стали сдавать? 

Вы не можете удалить Вопрос после того, как один или более Студентов начали 

сдавать Экзамен. Однако вы можете изменить балл и флажок этого Вопроса, чтобы вы 

знали, что с ним проблемы. 

Установите балл за этот Вопрос в 0. 

 Предупреждение: В некоторых версиях Moodle, если вы используете этот Вопрос в 

другом Экзамене, это потенциально изменит этот Вопрос в Данном Экзамене. Трюк 

состоит в том, чтобы присвоить 0 баллов за этот Вопрос, затем повторно оценить 

только что завершённый Экзамен. Это установит новую Оценку в Журнал Оценок. 

Теперь вернитесь и установите баллы в первоначальное значение. 

Найдите этот Вопрос в Банке Вопросов. Можете отредактировать его заголовок (не 

использовать в Био101). Или, если совместно не используете его с другими 

Преподавателями, создайте подКатегорию, переместите проблемный Вопрос туда и, 

может быть, создайте лучший Вопрос, чтобы заменить тот, который вы только что 

переместили. Создайте новый Экзамен и, если нужно, скройте старый. 

 Предупреждение: Если другие отделы или Преподаватели используют Категорию 

Вопросов, возможно разумнее свериться с каждой из этих групп перед перемещением 

или изменением любого Вопроса. Это одна из причин того, что импортирование 

Вопросов в Курс является лучшей практикой в некоторых ситуациях. 

4.3.10.6.7.Можно ли иметь Экзамен, который не 
оценивается? 

Это не общая потребность, так что может работать не совершенно, но вы можете 

попробовать: 

 На странице редактирования этого Экзамена установите балл за каждый Вопрос и 

итоговый бал за Экзамен в 0. 

 На странице редактирования этого Экзамена есть сетка окошек-флажков. Снимите 

пометки со всех окошек в колонке Score. 

4.3.10.6.8.Почему мой Экзамен не отображается в 
ЖурналеОценок? 
 Убедитесь, что вы имеете максимальный балл, который больше 0, – если ваш балл 

установлен в 0, тогда этот Экзамен не появится в Журнале Оценок. 

Помните, вы можете сообщить Журналу Оценок, не включать этот Экзамен. 
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4.3.10.6.9.How do I allow a person to retake a quiz 
if I have it set for 1 attempt? 
 In the Quiz administration settings block, there is a link "user 

overrides". 

 Click this link and you can change the allowed number of attempts for 

that user. 

4.3.10.6.10.How can I give particular students 
extra time in a timed quiz? 
 In the Quiz administration settings block there is a link "user overrides" 

 

 Click this link and you will be able to choose one or more users and 

change the timing of their quiz 

4.3.10.6.11.I've entered quiz grades manually in 
the gradebook. How can I allow students to 
improve on these grades? 
When a grade is entered directly in the gradebook, an "overridden" flag is 

set, meaning that the grade can no longer be changed from within the quiz. 

 

However, the flag can be removed by turning editing on in the grader 

report, then clicking the edit grade icon, unchecking the overridden box 

and saving the changes. 

4.3.10.6.12.How can I enable notification of quiz 
submissions? 
See Quiz submission notification. 

4.3.10.6.13.Why can't people (guests) take a quiz 
without creating an account and logging in? 
This is difficult to implement for technical reasons. 

To explain: The quiz has to link all information about an attempt to a 

particular 'user' record in the database, and each user can only have one 

open quiz attempt at a time. All not-logged-in users share the same 'guest' 

user database record. Therefore, two guests could not attempt the quiz at 

the same time, and even if they could, it would be difficult to prevent one 

guest seeing another guest's attempts. 

Of course, given enough work, it would be possible to change some of 

those assumptions, and so make it possible for guests to attempt quizzes. 

Indeed, some of the obstructions to implementing this 

4.3.10.6.9.Как мне позволить пересдать экзамен человеку, 
которому я установил 1 попытку? 
 В Блоке настроек AdministrationQuiz administration есть ссылка «User overrides 

(переопределения пользователей)». 

 Щёлкните эту ссылку, и вы сможете изменить разрешённое число попыток для этого 

пользователя. 

4.3.10.6.10.Как задать конкретным Студентам 
дополнительное время в синхронизированном Экзамене? 
 В Блоке настроек AdministrationQuiz administration есть ссылка «User overrides 

(переопределения пользователей)». 

 Щёлкните эту ссылку, и вы сможете выбрать одного или более пользователей и 

изменить синхронизацию времени их Экзамена. 

4.3.10.6.11.Я вручную ввёл Оценки за Экзамен в 
Журнал Оценок. Как позволить Студентам улучшить эти 
Оценки? 

Когда Оценка введена непосредственно в Журнал Оценок, устанавливается флажок 

«Overridden (переопределён)», означающий, что эта Оценка не может быть больше 

изменена изнутри этого Экзамена. 

Однако, этот флажок может быть снят путём включения режима редактирования в 

Отчёте Оценивающего, затем щелчка по иконке Edit grade (редактировать оценку), 

отменой пометки окошка Overridden и сохранения изменений. 

4.3.10.6.12.Как позволить извещать о передаче на 
рассмотрение Экзамена? 

См. «Извещение о передаче на рассмотрение Преподавателю Экзамена». 

4.3.10.6.13.Почему люди (Гости) не могут сдавать Экзамен 
без создания учётной записи и регистрации? 

Это трудно организовать по техническим причинам. 

Объяснение: Экзамен должен связать всю информацию о попытке с конкретной 

записью «пользователя» в Базе Данных, а каждый пользователь может иметь только одну 

открытую попытку сдать Экзамен за раз. Все не зарегистрированные пользователи 

совместно используют одну и ту же пользовательскую запись Базы Данных «Гость». 

Следовательно, два Гостя не смогут одновременно сдать Экзамен, но даже, если они 

смогут, будет трудно помешать одному Гостю видеть попытки сдачи другого Гостя. 

Конечно, при определённых усилиях станет возможным изменить некоторые из 

тех предположений и, таким образом сделать возможным для Гостей предпринимать 

попытки сдать Экзамены. В действительности некоторые препятствия к реализации этого  

http://docs.moodle.org/25/en/Quiz_submission_notification
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have already been removed while doing other work on the quiz, but there is 

still some way to go. 

If you would like to see this implemented, please vote for MDL-17892. A 

workaround is to create a visitor account, say with username = password = 

visitor, for everyone to share. 

 

4.3.10.6.14.Can you explain the error The number 
of random questions required is more than are 
still available in the category! 
Review your quiz and verify Moodle has enough questions from each 

category of questions it will be pulling from. You may have inadvertently 

selected more questions than what exists in the category. Also make sure 

you're not pulling questions from a category that has zero questions. 

Because you are picking random questions, rather than a specific question, 

it may not be apparent at first that you have run out of questions to ask! 

4.3.10.6.15.How do I send a bulk message to all 
students who haven't completed a quiz? 
 From your navigation block, click Reports>Course participation 

 

 From the drop down, choose your quiz. 

 In Show only, choose "Student" and in All actions, choose "post" 

 In the list that appears, tick/check the boxes next to those you wish to 

message. 

 In the bottom dropdown With selected users, choose "send message" 

4.3.10.6.16.How do random questions work? 
See the section on adding random questions in Building quiz. 

 

4.3.10.6.17.Can I download the quiz questions in a 
non-Moodle format? 
You might want to keep a local copy of quiz questions as evidence. While 

Moodle doesn't offer a built-in method of doing this, suggestions include: 

 previewing the quiz, getting to the review page and from your 

computer, choosing "Save as...webpage complete" and 

 exporting the question as Moodle XML, or GIFT format. If you open 

either of those files in a text-editor, you should be able to see most 

details of each question. Not very pretty, but accurate. 

 

уже удалены, пока идёт другая работа по Экзамену, но всё равно остаётся некоторый путь 

для них. 

Если вы заинтересованы, посмотрите это реализованное, пожалуйста, 

проголосуйте на MDL-17892. Работа связана с созданием учётной записи посетителя, 

скажем, с именем пользователя visitor, совпадающим с его паролем, для каждого 

желающего. 

4.3.10.6.14.Можете объяснить ошибку «Требуемое число 
случайным образом вызываемых Вопросов больше, чем 
доступно в этой Категории!»? 

Обзор вашего Экзамена и верификация Moodle, которая имеет достаточно 

Вопросов из каждой Категории Вопросов, снимет эту проблему. Вы же, возможно, 

неосторожно выбрали больше Вопросов, чем существовало в вашей Категории. Убедитесь 

также, что вы не извлекали Вопросы из Категории, в которой нет Вопросов. 

Поскольку вы извлекаете Вопросы случайным образом, а не конкретный Вопрос, 

сначала может быть не очевидно, что у вас больше нет Вопросов, которые можно задать. 

4.3.10.6.15.Как послать сообщение сразу всем Студентам, 
которые не завершили Экзамен? 
 Из вашего Блока управления Экзаменом AdministrationQuiz administration щёлкните 

ReportsCourse participation 

 Из ниспадающего меню выберите ваш Экзамен. 

 В Show only выберите «Student», а в All actions – «Post». 

 В списке, который появится, пометьте/отметьте окошки, следующие за тему, кому вы 

хотите отправить сообщение. 

 Внизу ниспадающего меню «With selected users» выберите «Send message». 

4.3.10.6.16.How do random questions work? 
См. раздел по добавлению случайно выбираемых Вопросов в «Построение 

Экзамена (п.4.3.10.2)». 

4.3.10.6.17.Можно загрузить Вопросы Экзамена не в формате 
Moodle? 

Вы, очевидно, можете захотеть сохранить локальную копию Вопросов Экзамена. 

Пока Moodle не предлагает встроенного метода делать это, предложения следующие: 

 предварительно просматриваете этот Экзамен для получения обзора страницы и из 

вашего компьютера выбираете «Save as...webpage complete» и 

 экспортируете каждый из Вопросов как Moodle XML или GIFT формат. Если вы 

откроете любой из этих файлов текстовом редакторе, вы сможете увидеть большинство 

подробностей каждого Вопроса. Не очень приятно, но точно. 

https://tracker.moodle.org/browse/MDL-17892
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4.3.10.6.18.How can I turn off question flagging? 
 
By default, flags are available in quiz questions. 

There is a capablity attached to this: Capabilities/moodle/question:flag. 

Remove this capability from roles that you don't want to see the flags. You 

can either do that by editing the role definitions globally, or by overriding 

the permissions in just one quiz or course. 

 

4.3.10.6.19.How do I create system-wide question 
categories? 
 As an administrator or user with system permissions, go to Question 

bank>categories in any course. 

 Using the "Add category form" at the bottom of the page, set the parent 

of the new category to be the system context. 

4.3.10.6.20.How can I prevent a student from 
reviewing or jumping around questions in a quiz? 
You can block the quiz navigation block and the summary of quiz page 

with CSS code in a theme. However, if a student fails to answer a question, 

they will not know if you implement this "solution". Also if others on the 

site do not want this patch, make sure the theme you select for the course is 

not used by others. 

For example using the Afterburner theme: Site Administration 

>Appearance >Themes >Afterburner and enter this in the CSS code area: 

 

div#mod_quiz_navblock {visibility:hidden;} 

table.quizsummaryofattempt {visibility:hidden;} 

There are other css solutions. 

4.3.10.6.21.How can I minimise the load on the 
server while using quizzes? 
 Try to avoid a lot of students starting a quiz at the same time 

 Check these discussions: 

 https://moodle.org/mod/forum/discuss.php?d=213259 

 https://moodle.org/mod/forum/discuss.php?d=215641 

 https://moodle.org/mod/forum/discuss.php?d=215130 

For other notes on performance with quizzes, see the section 'Performance 

of different Moodle modules' in Performance recommendations. 

 

 

4.3.10.6.18.Как отключить отметку Вопросов 
флажками? 

По умолчанию флажки доступны в Вопросах Экзамена. 

Кроме этого существует Возможность 

Capabilities/moodle/question:flag. Удалите эту Возможность из Ролей, которые вы не 

хотите, чтобы видели эти флажки. Вы можете сделать это либо путём редактирования 

определения каждой из Ролей глобально, либо переопределением Полномочий просто в 

одном Экзамене или Курсе. 

4.3.10.6.19.Как создать Категории Вопросов на уровне 
системы? 
 Как Администратор или пользователь с системными полномочиями перейдите в 

Банке Вопросов к Категориям: Question bankcategories в любом Курсе. 

 Используя «Add category form (добавить форму категории)» внизу этой страницы, 

установите, чтобы родителем этой новой Категории был Контекст системы. 

4.3.10.6.20.Как помешать Студентам просматривать или 
переходить от Вопроса к Вопросу в Экзамене? 

Вы можете заблокировать Блок навигации Экзамена и резюме страницы Экзамена 

в CSS-коде в тематической фоновой картинке. Однако, если Студент ошибётся в ответе на 

Вопрос, он не узнает об этом, если вы реализуете это «решение». А также, если другие на 

этом Сайте не захотят такой заплаты, убедитесь, что тематическая фоновая картинка, 

которую вы выбрали для этого Курса, не используется другими. 

Например, использование тематической фоновой картинки Afterburner (форсажная 

камера): Site AdministrationAppearanceThemesAfterburne и ввод этого в область CSS-

кода: 

div#mod_quiz_navblock {visibility:hidden;} 

table.quizsummaryofattempt {visibility:hidden;} 

Существуют и другие CSS-решения. 

4.3.10.6.21.Как минимизировать загрузку сервера при 
использовании Экзамена? 
 Постарайтесь избежать начала сдачи Экзамена многими Студентами одновременно. 

 Просмотрите эти обсуждения: 

 https://moodle.org/mod/forum/discuss.php?d=213259 

 https://moodle.org/mod/forum/discuss.php?d=215641 

 https://moodle.org/mod/forum/discuss.php?d=215130 

В качестве других комментариев по использованию Экзаменов, см. раздел 

«Выполнение различных модулей Moodle» в «Рекомендации по работе системы (п. 3.6.1)». 

https://moodle.org/mod/forum/discuss.php?d=213259
https://moodle.org/mod/forum/discuss.php?d=215641
https://moodle.org/mod/forum/discuss.php?d=215130
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4.3.10.6.22.How can I make the quiz timer "float" 
or move down the page? 
See this forum thread: How to make the quiz timer float for one 

suggestion. 

4.3.10.6.23.See also 
Using Moodle forum discussions: 

 Removing "Submit all and Finish" button 

 How do you keep people from cheating while taking a quiz? 

 Scientific notation in quiz answers 

 Quiz answers appear in wrong language 

 Random Order Override 

Related FAQs: 

 Import and export FAQ - for hints on importing questions 

 XML FAQ - for information on creating and importing questions in 

Moodle XML format 

4.3.10.7.Features 
 Quizzes can be configured to allow multiple attempts. Each attempt at a 

question is automatically marked, and the teacher can choose whether 

to give feedback and/or show the correct answers. 

 

There are many ways to use a quiz. 

 Feedback about performance and self-assessment are important parts of 

a learning environment. There are several ways to give feedback to 

students: on each question or overall. The quiz module can display 

feedback and scores at different times during the quiz, using the review 

options in the Quiz settings. 

 A wide variety of Quiz reports (in addition to Grades) are available for 

use by the teacher. Quiz reports not only can focus on a single student's 

attempt to answer each question, but also can perform a robust item 

analysis of a question's validity based upon aggregated student 

responses. 

 A single quiz can automatically select random and/or specific questions 

from different categories of questions. 

 There are different options for scoring (marks-grades) individual 

questions in a specific quiz, grading attempts for a quiz and each 

question type. 

 

 

4.3.10.6.22.Как сделать таймер Экзамена «плавающим» или 
переместить вниз страницы? 

См. одно из предложений в потоке сообщений этого форума: «Как сделать таймер 

Экзамена плавающим». 

4.3.10.6.23.См. также 
Обсуждения форума по использованию Moodle: 

 Удаление кнопки «Submit all and Finish (передать всё на рассмотрение и завершить)». 

 Как удержать людей от мошенничества во время сдачи Экзамена? 

 Научная нотация в ответах на Экзамене. 

 Ответы Экзамена появляются не на том языке. 

 Отмена случайного порядка. 

Относящиеся к этому часто задаваемые вопросы (ЧЗВ)? 

 ЧЗВ по импорту и экспорту – в порядке советов по импортированию вопросов. 

 ЧЗВ по XML – в качестве информации по созданию и импортированию вопросов в 

формате Moodle XML. 

4.3.10.7.Возможности 
 Экзамены могут быть сконфигурированы (п. 4.3.10.1) так, чтобы разрешить 

множественные попытки их сдачи. Каждая попытка ответа на Вопрос автоматически 

оценивается, а Преподаватель может выбрать, предоставлять ли Обратную Связь и/или 

показывать правильные ответы. 

Существует много путей применения Экзамена (п. 4.3.10.3). 

 Отзыв на выполнение и само оценивание – важные части среды обучения. Существует 

несколько способов предоставить Студентам Обратную Связь: на каждый Вопрос или 

на Экзамен в целом. Модуль «Экзамен» может отображать Обратную Связь и оценки в 

разное время в течение Экзамена, используя опции просмотра в настройках Экзамена 

(п. 4.3.10.1). 

 Широкое разнообразие отчётов по Экзамену (п. 4.3.10.4, в дополнение к Оценкам – п. 

4.9.1) доступно для использования Преподавателем. Отчёты по Экзамену могут не 

только сфокусировать на единственной попытке Студента ответить на каждый Вопрос, 

но также могут выполнить содержательный поэлементный анализ достоверности 

Вопросов, основанный на агрегированных студенческих ответах. 

 Отдельный Экзамен может автоматически выбрать случайные и/или конкретные 

вопросы из различных Категорий Вопросов (п. 4.6.1.2). 

 Существуют различные опции для оценивания (п. 4.3.10.2 – частные оценки разных 

уровней) индивидуальных Вопросов в конкретном Экзамене, оценивания попыток для 

Экзамена и каждого типа Вопросов (п. 4.6.1.3). 

https://moodle.org/mod/forum/discuss.php?d=210049
https://moodle.org/mod/forum/discuss.php?d=210049
http://moodle.org/mod/forum/discuss.php?d=96326
http://moodle.org/mod/forum/discuss.php?d=141003
http://moodle.org/mod/forum/discuss.php?d=131325
http://moodle.org/mod/forum/discuss.php?d=158846
http://moodle.org/mod/forum/discuss.php?d=196206
http://docs.moodle.org/25/en/Import_and_export_FAQ
http://docs.moodle.org/25/en/XML_FAQ
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 The quiz settings allow different display methods. They can randomize 

the questions for each student and or randomize the answers for each 

student. 

 The teacher can determine the number of questions on each page of 

questions the student sees. The teacher can change the position of any 

question in the quiz. It is possible to put a label with information any 

place between questions. 

 The teacher can choose how questions behave during the quiz. It can be 

like a classic test, where the student gets no feedback while attempting 

the test, only later. Alternatively, Moodle can reveal the grades and/or 

feedback to the student during the quiz, and perhaps even give them 

another chance to answer the question (for fewer marks) having read 

the feedback. 

The about list only mentions a few features of the quiz module and how 

it works with the question bank. Please follow the links on this page to 

learn more. 

4.3.10.8.See also 
 Quiz in Moodle 2.0 video 

 Microsoft Word table format add-on 

4.3.10.9.Question permissions explained with 
diagrams 
4.3.10.9.1.A simple story 
1.Setting the scene 
For this explanation, we will imagine we have this very simple Moodle 

site. There are three courses, all in the Miscellaneous category. The courses 

have a few activities in them. 

 

 

 

2.Introducing Fred 
We will focus on a particular user: Fred. Fred is a teacher in two of the 

courses. In Moodle, everyone gets some permissions throughout the whole 

Moodle site because they are logged in. Additionally, Fred gets more 

permissions in the courses he teaches, and all the activities in those 

courses, because he has the teacher role there. 

 

 

 

 Настройки Экзамена позволяют разные методы отображения (п. 4.3.10.1). Они могут 

рандомизировать Вопросы для каждого Студента и/или рандомизировать ответы для 

каждого Студента. 

 Преподаватель может определить число Вопросов на каждой странице Вопросов, 

которую видит Студент. Преподаватель может изменить положение каждого Вопроса в 

Экзамене. Можно установить метку с информацией в любое место между вопросами. 

 

 Преподаватель может выбрать (п. 4.3.10.1) поведение Вопросов во время Экзамена. Это 

может быть похоже на классический тест, где Студент не получает Обратной Связи при 

попытке выполнения теста, а только позднее. В качестве альтернативы Moodle может 

показывать Студенту Оценки и/или Обратную Связь во время Экзамена, и, может быть, 

даже предоставить ему шанс ответить на Вопрос (с понижением баллов) после 

прочтения Обратной Связи. 

Приведённый список упоминает только несколько возможностей модуля 

«Экзамен» и то, как он работает с Банком Вопросов. Пожалуйста, следуйте ссылкам на 

этой странице, чтобы изучить больше. 

4.3.10.8.См. также 
 Видео «Экзамен в Moodle 2.0». 

 Встроенный формат таблицы Microsoft Word. 

4.3.10.9.Полномочия Вопросов, объясняемые 
диаграммами 
4.3.10.9.1.Простая история 
1.Настройка сцены 

Для объяснения этого 

представим, что у нас есть очень 

простой Сайт Moodle. Имеется три 

Курса, все – в Категории «Смешанные». 

В Курсах присутствуют несколько  

Интерактивных Действий. 

2.Внедрение Фреда 
Сфокусируемся на конкретном 

пользователе – Фреде. Фред 

Преподаватель в двух Курсах. В Moodle каждый получает некоторые Полномочия 

повсюду на всём Сайте Moodle, поскольку он зарегистрировался. В дополнение Фред 

получает больше Полномочий в Курсах, где он преподаёт и во всех 

Интерактивных Действиях в этих Курсах, потому что у него там Роль Преподавателя. 

http://www.youtube.com/watch?v=sfGlV5WaZE8
http://docs.moodle.org/25/en/Word_table_format
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3.Using questions in a course 
Fred creates some questions in his maths course and adds them to the quiz. 

Why does this work? 

 

 

By default, questions are created in the question bank in a category that 

belongs to that course. Fred is a teacher in the course. Teachers are allowed 

to create questions. Therefore Fred can create the questions, and they get 

stored linked to the course. 

 

 

 

 

The quiz is in the course. Fred is a teacher in the course, so Fred has 

permission to add questions to the quiz. The quiz is in the course, so the 

course questions are potentially available. Fred is a teacher in the course, 

so he is allowed use the questions in the course question bank. Therefore 

Fred can add the questions to his quiz. 

 

 

 

 

 

4.Trying to share questions 
Fred now wants to reuse some of his questions in his biology course. 

However, the biology quiz is not in the maths course, so the questions are 

not available. 

 

So Fred's friendly Moodle administrator Annie moves the questions into 

the part of the question bank associated with the category Miscellaneous. 

Disaster! now Fred can't see his questions at all. Why not? 

 

 

 

 

Now the questions are outside the course. Fred has no extra permissions 

outside the course, so he cannot access the questions there. 

 

 

 

3.Использование Вопросов в Курсе 
Фред создаёт некоторые 

Вопросы в его Курсе математики и 

добавляет их в Экзамен. Почему это 

работает? 

По умолчанию Вопросы 

создаются в Банке Вопросов, в 

Категории, которая принадлежит 

этому Курсу. Фред является 

Преподавателем в этом Курсе. 

Преподавателям разрешается 

создавать Вопросы. Следовательно, 

Фред может создавать Вопросы и они сохраняются связанными с Курсом. 

Экзамен находится в Курсе. Фред является Преподавателем в этом Курсе, так что 

Фред имеет Полномочие добавлять 

Вопросы в этот Экзамен. Экзамен 

находится в Курсе, так что Вопросы 

Курса потенциально доступны. Фред 

является Преподавателем в Курсе, так 

что ему позволено использовать 

Вопросы в Банке Вопросов Курса. 

Слеловательно, Фред может 

добавлять Вопросы в этот Экзамен. 

4.Попытка совместно 
использовать Вопросы 

Фред сейчас хочет повторно использовать некоторые из этих Вопросов в его Курсе 

по биологии. Однако Экзамен по биологии не находится в Курсе по математике, так что 

Вопросы не доступны. 

Затем Энни – Администратор 

Moodle, дружественно настроенная к 

Фреду, перемещает эти Вопросы в ту 

часть Банка Вопросов, которая связана с 

категорией «Смешанные». Беда! Теперь 

Фред не может видеть эти Вопросы 

совсем. Почему? 

Сейчас Вопросы – вне Курса. 

Фред не имеет экстра Полномочий вне 

Курса, так что он не может получить 

доступ к Вопросам там. 
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5.Successfully sharing questions 
Annie creates a new role 'Question user' that allows all the permissions 

needed to access the question bank. Annie assigns Fred that role in the 

whole system. Now Fred can see his questions from within both courses, 

edit them, and add them to his quizzes. Why? 

The questions are linked to category Miscellaneous. Miscellaneous is 

inside the system. Fred is a Question user in the system. Question users can 

access the question bank. So Fred can access this part of the question bank. 

 

The quizzes are in courses where Fred is a teacher, so Fred is has 

permission to add questions to the quizzes. The quizzes are in the 

Miscellaneous category, so the questions in that part of the question bank 

are potentially available. We have just seen that Fred has permission to 

access these question. Therefore Fred can add these questions to his 

quizzes. 

 

4.3.10.9.2.Summary of the rules 
 
Questions are stored in the question bank linked to some part of your 

Moodle system (technically a context). The part of the system might be 

(and most often is) a course, or a course category, the whole system, or an 

individual activity. 

 

 

 

 

 

To create and editing questions 
you must have the appropriate capability in the part of the system where 

the questions are stored, to have permission to do the corresponding 

operation (add, edit, ...). 

To add questions to a quiz 
three checks have to pass: 

 You must have the mod/quiz:manage capability in that quiz, to have 

permission to add questions to it. 

 The quiz must be inside the part of the system where the questions are 

stored, in order for the questions to be available in the quiz. 

 

 

5.Успешное совместное использование Вопросов 
Энни создаёт новую Роль «Пользователь Вопросов», которая предоставляет все 

Полномочия, необходимые для доступ а к Банку Вопросов. Энни назначает Фреду эту 

Роль во всей системе. Теперь Фред может видеть его Вопросы изнутри обоих Курсов, 

редактировать их и добавлять их в его Экзамены. Почему? 

Вопросы связаны с Категорией «Смешанные». «Смешанные» находится внутри 

системы. Фред является Пользователем Вопросов в системе. Пользователи Вопросов 

могут иметь доступ к Банку Вопросов. Так что Фред может иметь доступ к этой части 

БанкаВопросов. 

Экзамены находятся в Курсах, где Фред является Преподавателем, так что Фред 

имеет Полномочие добавлять Вопросы в Экзамены. Экзамены находятся в Категории 

«Смешанные», так что Вопросы в этой части Банка Вопросов являются потенциально 

доступными. Мы только что увидели, что Фред имеет Полномочие для доступа к этим 

Вопросам. Следовательно, 

Фред может добавить эти 

Вопросы в его Экзамены. 

4.3.10.9.2.Краткое 
изложение правил 

Вопросы сохраняются 

в Банке Вопросов, связанном 

с некоторой частью вашей 

системы Moodle (формально 

Контекста). Эта часть может 

быть (и очень часто является) 

Курсом или Категорией 

Курсов, целой системой или 

индивидуальным Интерактивным Действием. 

Чтобы создать и редактировать Вопросы 
Вы должны иметь подходящую Возможность (п. 4.6.4) в этой части системы, где 

Вопросы сохраняются, чтобы иметь Полномочие выполнять соответствующую операцию 

(добавить, отредактировать, …). 

Чтобы добавить Вопросы в Экзамен 
Нужно пройти три проверки: 

 Вы должны иметь Возможность mod/quiz:manage в этом Экзамене, чтобы иметь 

Полномочие добавлять Вопросы в него. 

 Экзамен должен быть внутри той части системы, где Вопросы сохраняются, для того 

чтобы быть доступными в Экзамене. 
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 You must have the moodle/question:use(all/mine) capability in the part 

of the system where the questions are stored, to have permission to use 

those questions. 

4.3.10.9.3.See also 
 Question bank 

 How to let teachers share questions between courses 

4.3.11.SCORM 
Enables SCORM packages to be included as course content 

SCORM (Sharable Content Object Reference Model) is a collection of 

specifications that enable interoperability, accessibility and reusability of 

web-based learning content. 

4.3.12.Survey 
For gathering data from students to help teachers learn about their class 

and reflect on their own teaching. 

Survey module 
The Survey module is a course activity that provides a number of verified 

survey instruments, including COLLES (Constructivist On-Line Learning 

Environment Survey) and ATTLS (Attitudes to Thinking and Learning 

Survey), which have been found useful in assessing and stimulating 

learning in online environments. Teachers can use these to gather data 

from their students that will help them learn about their class and reflect on 

their own teaching. 

4.3.12.1.Survey settings 
Note: Moodle's survey module uses pre-made questions. If you wish to 

create your own questions, use the Feedback module or contributed 

Questionnaire module. 

 

4.3.12.1.1.Adding a survey 
With the editing turned on, in the section you wish to add your survey, 

click the "Add an activity or resource" link (or, if not present, the "Add an 

activity" drop down menu) and choose Survey. All settings may expanded 

by clicking the "Expand all" link top right. 

4.3.12.1.2.General 
Name 
Whatever you type here will form the link learners click on to do the 

survey so it is helpful to give it a name that suggests its purpose. 

 

 Вы должны иметь Возможность moodle/question:use(all/mine) в той части системы, где 

Вопросы сохраняются, для того чтобы иметь Полномочие использовать те Вопросы. 

 

4.3.10.9.3.См. также 
 Банк Вопросов (п. 4.6.3). 

 Как позволить Преподавателям совместно использовать Вопросы между Курсами. 

4.3.11.Формат СДО SCORM 
Разрешает включить пакеты SCORM в качестве контента Курса. 

SCORM (Sharable Content Object Reference Model – рекомендованная модель 

объекта содержимого для совместного использования) – сборник спецификаций и 

стандартов, разработанный для Систем Дистанционного Обучения. 

4.3.12.Опрос 
Операция сбора данных от Студентов предназначена для помощи Преподавателю 

узнать о своём классе и поразмышлять о своём собственном преподавании. 

Модуль «Опрос» 
Модуль «Опрос» – это Интерактивное Действие Курса, которое предоставляет ряд 

проверенных инструментов опроса, включающих COLLES (Constructivist On-Line Learning 

Environment Survey – конструктивистский опрос среды обучения в режиме онлайн) и 

ATTLS (Attitudes to Thinking and Learning Survey– обзор подходов к мышлению и 

обучению), которые признаны полезными в оценивании и стимулировании обучения в 

среде онлайн. Преподаватели могут использовать это для сбора данных от Студентов, что 

поможет им узнать о их классе и поразмышлять о своём собственном преподавании. 

4.3.12.1.Настройки Опроса 
Замечание: Модуль «Опрос» системы Moodle использует предварительно 

составленные Вопросы. Если вы желаете создать свои собственные Вопросы, используйте 

модуль Feedback («Обратная связь») или предложенный (сторонними организациями) Модуль 

Questionnaire («Опросник или анкета»). 

4.3.12.1.1.Добавление Опроса 
При включённом режиме редактирования в разделе, куда вы желаете добавить ваш 

Опрос щёлкните ссылку «Add an activity or resource (добавить интерактивное действие или 

ресурс)» (или, если не присутствует, ниспадающее меню «Add an activity») и выберите 

Survey. Все настройки могут быть развёрнуты щелчком ссылки Expand all вверху справа. 

4.3.12.1.2.Обычные настройки 
Наименование 

Что бы вы ни набрали здесь, сформируется ссылка обучающимся, щелчок по 

которой выполнит этот Опрос, так что полезно дать ему наименование, подразумевающее 

его цель. 

http://docs.moodle.org/25/en/How_to_let_teachers_share_questions_between_courses
http://docs.moodle.org/25/en/SCORM_module
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Survey type 
Choose your survey type here. See #Types of survey below for an 

explanation of the items in this drop down menu. 

Description 
Add a description of your survey here. Click "Show editing tools" to 

display the rich text editor, and drag the bottom right of the text box out to 

expand it. 

Display description on the course page 
If this box is ticked, the description will appear on the course page just 

below the name of the survey. 

4.3.12.1.3.Common module settings 
See Common module settings. 

4.3.12.1.4.Restrict access/Activity completion 
 
(These settings are collapsed by default) 

These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

Types of survey 
The available surveys have been chosen as being particularly useful for 

evaluating online learning environments that use a constructivist pedagogy. 

They are useful to identify certain trends that may be happening among 

your participants. (To see a paper where these are used in a detailed 

analysis, see: http://dougiamas.com/writing/herdsa2002) 

COLLES - Constructivist On-Line Learning Environment 
Survey 

The COLLES comprises an economical 24 statements grouped into six 

scales, each of which helps us address a key question about the quality of 

the on-line learning environment: 

 Relevance How relevant is on-line learning to students' professional 

practices? 

 Reflection Does on-line learning stimulate students' critical reflective 

thinking? 

 Interactivity To what extent do students engage on-line in rich 

educative dialogue? 

 Tutor Support How well do tutors enable students to participate in on-

line learning? 

 Peer Support Is sensitive and encouraging support provided on-line by 

fellow students? 

Тип Опроса 
Выберите ваш тип Опроса здесь. См. «Типы Опроса» ниже, объясняющие 

элементы этого ниспадающего меню. 

Описание 
Добавьте описание вашего Опроса здесь. Щёлкните «Show editing tools (показать 

инструменты редактирования)», чтобы отобразить полнотекстовый редактор, и 

перетащите нижний правый уголок текстового окошка, чтобы расширить его.  

Отображать описание на странице Курса 
Если это окошко помечено, данное описание будет появляться на странице Курса 

как раз под наименованием Опроса. 

4.3.12.1.3.Общие настройки модуля 
См. «Общие настройки модуля» в п. 6.1. 

4.3.12.1.4.Ограничить доступ/завершение 
ИнтерактивногоДействия 

(Эти настройки по умолчанию свёрнуты) 

Эти настройки видимы, если Обусловленные Действия (п. 4.9.2) и 

Завершение Действия (п. 4.9.3) разрешены на Сайте и Курсе. 

Типы Опроса 
Доступные Опросы выбраны как чрезвычайно полезные для оценивания в 

условиях обучения в режиме онлайн, которое использует конструктивистскую педагогику 

(см. п. 1.2). Они полезны для идентификации определённых тенденций, которые могут 

случиться среди её участников. (Чтобы увидеть статью, где это применяется с подробным 

анализом, см. http://dougiamas.com/writing/herdsa2002) 

COLLES – конструктивистский опрос среды обучения в режиме 
онлайн 

COLLES заключает в себе 24 экономических утверждения, сгруппированных в 

шесть шкал, каждая из которых помогает нам ответить на ключевой Вопрос о качестве 

среды обучения в режиме онлайн: 

 Релевантность. Насколько существенно обучение Студентов в режиме онлайн для 

приобретения ими профессиональных навыков и умений? 

 Размышление. Стимулирует ли обучение в режиме онлайн критическое мышление у 

Студентов? 

 Согласованность действий. В какой степени Студенты используют режим онлайн в 

общем образовательном диалоге? 

 Поддержка наставника. Насколько хорошо наставники обеспечивают Студентам 

участие в онлайн-обучении? 

 Поддержка ровесников. Насколько ощутима и поощрительна поддержка, 

предоставляемая в режиме онлайн сокурсниками? 

http://dougiamas.com/writing/herdsa2002
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 Interpretation Do students and tutors make good sense of each other's 

on-line communications? 

Underpinning the dynamic view of learning is a new theory of knowing: 

social constructivism, which portrays the learner as an active 

conceptualiser within a socially interactive learning environment. Social 

constructivism is an epistemology, or way of knowing, in which learners 

collaborate reflectively to co-construct new understandings, especially in 

the context of mutual inquiry grounded in their personal experience. 

Central to this collaboration is the development of students' communicative 

competence, that is, the ability to engage in open and critical discourse 

with both the teacher and peers. This discourse is characterised by an 

empathic orientation to constructing reciprocal understanding, and a 

critical attitude towards examining underlying assumptions. 

The COLLES has been designed to enable you to monitor the extent to 

which you are able to exploit the interactive capacity of the World Wide 

Web for engaging students in dynamic learning practices. 

(This information has been adapted from the COLLES page. You can find 

out more about COLLES and the authors of it at: 

http://surveylearning.moodle.com/colles/) 

ATTLS - Attitudes to Thinking and Learning Survey 
The theory of 'ways of knowing', originally from the field of gender 

research (Belenky et al., 1986) provides us with a survey tool to examine 

the quality of discourse within a collaborative environment. 

The Attitudes Towards Thinking and Learning Survey (ATTLS) is an 

instrument developed by Galotti et al. (1999) to measure the extent to 

which a person is a 'connected knower' (CK) or a 'separate knower' (SK). 

People with higher CK scores tend to find learning more enjoyable, and are 

often more cooperative, congenial and more willing to build on the ideas of 

others, while those with higher SK scores tend to take a more critical and 

argumentative stance to learning. 

Studies have shown that these two learning styles are independent of each 

other (Galotti et al., 1999; Galotti et al., 2001). Additionally, they are only 

a reflection of learning attitudes, not learning capacities or intellectual 

power. 

Belenky, M. F., Clinchy, B. M., Goldberger, N. R., & Tarule, J. M. (1986). 

Women's Ways of Knowing: The Development of Self, Voice, and Mind. 

New York: Basic Books, Inc. 

 

 

 

 Интерпретация. Насколько хорошо понимают друг друга Студенты и наставники при 

коммуникации в режиме онлайн? 

Подкреплением динамичного представления об обучении является новая теория 

познания: социальный конструктивизм (п. 1.1), который рассматривает обучающегося как 

активного мыслителя в социально интерактивной среде обучения. Социальный 

конструктивизм является теорией или методикой познания, в котором обучающиеся 

сотрудничают, обмениваясь мнениями, чтобы совместно построить новое понимание, 

особенно в контексте обоюдного расспроса с использованием их личного опыта. 

Главным в этом сотрудничестве является развитие у Студентов коммуникативной 

компетенции, т.е. способности участвовать в открытой и критической беседе и с 

Преподавателями, и со сверстниками. Такой разговор характеризуется сопереживательной 

ориентацией на создание взаимопонимания, и критическим подходом к проверке 

исходных предположений. 

COLLES разработана, чтобы дать вам возможность увидеть, в какой степени вы 

способны использовать мощность Всемирной паутины для вовлечения Студентов в 

динамические методы обучения. 

(Эта информация адаптирована со страницы COLLES. Вы можете отыскать больше 

о COLLES и её авторах в: http://surveylearning.moodle.com/colles/) 

 

ATTLS – подходы к обзору мышления и обучения 
Теория «методов познания», пришедшая из области гендерных исследований 

(Беленький и пр., 1986), предоставляет нам инструмент Опроса для проверки качества 

бесед в условиях сотрудничества. 

Опрос отношений к мышлению и обучению (ATTLS) – это инструмент, развитый 

Галотти и пр. (1999) для измерения степени «совместности (CK) или обособленности 

познающего (SK)» 

Люди с высоким CK имеют тенденцию находить обучение более приятным и, 

зачастую, более кооперабельны, благожелательны и более склонны использовать идеи 

других, в то время как люди с высоким SK имеют тенденцию к принятию позиции 

критичности и аргументированности в обучении. 

Исследования показали, что эти два стиля изучения независимы друг от друга 

(Галотти и пр.,1999; Галотти и пр., 2001). Более того, они являются только отражением 

отношений к изучению, а не способностей к изучению или интеллектуальной мощи. 

 

Belenky, M. F., Clinchy, B. M., Goldberger, N. R., & Tarule, J. M. (1986). Женские пути 

познания: Развитие себя, голоса и мысли. New York: Basic Books, Inc. 

 

http://surveylearning.moodle.com/colles/
http://surveylearning.moodle.com/colles/
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Galotti, K. M., Clinchy, B. M., Ainsworth, K., Lavin, B., & Mansfield, A. 

F. (1999). A New Way of Assessing Ways of Knowing: The Attitudes 

Towards Thinking and Learning Survey (ATTLS). Sex Roles, 40(9/10), 

745-766. 

Galotti, K. M., Reimer, R. L., & Drebus, D. W. (2001). Ways of knowing 

as learning styles: Learning MAGIC with a partner. Sex Roles, 44(7/8), 

419-436. 

4.3.12.1.5.Locally assigned roles 
In Administration > Survey administration > Locally assigned roles, 

selected users can be given additional roles in the activity. 

4.3.12.1.6.Survey permissions 
Role permissions for the activity can be changed in Administration > 

Survey administration > Permissions. 

4.3.12.2.Using Survey 
Once students have begun to answer the survey questions, the teacher may 

track the survey results via the "View xx survey responses" link at the top 

right of the page. 

The teacher may also download the results from the survey, from the View 

Survey Responses page, by following the Download link. Results may be 

downloaded in .ODS, excel or Text formats. 

4.3.12.2.1.Survey report 
The survey report section in each survey allows you to view the data by 

course, by student, or by question. You can also download the data as a 

spreadsheet or text file. 

Note: Moodle surveys are not anonymous. While students cannot see each 

other's results, you can view each student's survey. There is no way to 

assure anonymity. If you are using these results for research, you must 

develop a scheme to download the data and assign participant numbers. 

You should also inform students of this limitation. 

 The COLLES and ATTLS questions are five-point scales that range in 

responses from Almost Always to Almost Never. These results are 

reported in graphical form when you view them. 

 The Critical Incidents survey is a free-response survey where students 

must type their answers. You can see what students have typed for each 

answer. 

 

 

 

 

Galotti, K. M., Clinchy, B. M., Ainsworth, K., Lavin, B., & Mansfield, A. F. (1999). Новый 

способ оценивания путей познания: Опрос отношений в мышлению и изучению (ATTLS). 

Роли полов, 40(9/10), 745-766. 

 

Galotti, K. M., Reimer, R. L., & Drebus, D. W. (2001). Пути познания как стили изучения: 

Изучение МАГИИ с партнёром. Роли полов, 44(7/8), 419-436. 

 

4.3.12.1.5.Локально назначаемые Роли 
В AdministrationSurvey administrationLocally assigned roles выбранным 

пользователям могут быть даны дополнительные Роли в Интерактивном Действии. 

4.3.12.1.6.Полномочия Опроса 
Полномочия Роли для ИнтерактивногоДействия могут быть изменены в 

AdministrationSurvey administration Permissions. 

4.3.12.2.Применение Опроса 
Как только Студенты начнут отвечать на Вопросы, Преподаватель сможет 

отследить результаты Опроса через ссылку «View xx survey responses (просмотреть хх 

ответов на опрос)» вверху справа на этой странице. 

Преподаватель может также загрузить эти результаты из этого Опроса со страницы 

View Survey Responses (просмотреть ответы на Опрос), следуя ссылке Download 

(загрузить). Результаты могут быть загружены в .ODS, Excel или текстовом форматах. 

4.3.12.2.1.Отчёт по Опросу 
Раздел Отчёта по Опросам в каждом Опросе позволяет вам просмотреть данные по 

Курсу, по Студенту или по Вопросу. Вы можете также загрузить эти данные как 

электронную таблицу и текстовый файл. 

Замечание: Опросы Moodle не анонимны. В то время, как Студенты не могут 

увидеть результаты друг друга, вы можете просмотреть Опрос каждого Студента. Нет 

способа гарантировать анонимность. Если вы используете эти результаты для 

исследования, вам нужно разработать схему загрузки данных и назначить номера 

участникам. Вы должны также информировать Студентов об этом ограничении. 

 Вопросы COLLES и ATTLS являются пятибалльными Шкалами, область значений 

которых в ответах простирается от Почти всегда до Почти никогда. Эти результаты 

сообщаются в графической форме, в которой вы можете их просмотреть. 

 Опрос критических происшествий является Опросом с ответом в свободной форме, в 

которой Студенты набрать их ответы. Вы можете увидеть, что Студенты набрали в 

качестве каждого ответа. 
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4.3.12.2.2.See also 
 Using Moodle Using COLLES with younger students forum discussion 

 

 Using Moodle book Chapter 14: Surveys and Choices 

 http://dougiamas.com/writing/herdsa2002 - A paper in which surveys 

are used in a detailed analysis 

4.3.12.3.Survey FAQ 
4.3.12.3.1.How can I create custom surveys? 
Custom surveys can be created using either the Feedback module (which is 

hidden by default) or the Questionnaire module (which is a contributed 

module). 

Hopefully a core module combining the best features of the Feedback, 

Questionnaire and Survey modules will be available some time in the 

future. 

4.3.12.4.See also 
 Using Moodle Survey module forum 

4.3.13.Wiki 
A collection of web pages that anyone can add to or edit. 

Wiki module 
A wiki is a collection of collaboratively authored web documents. 

Basically, a wiki page is a web page everyone in your class can create 

together, right in the browser, without needing to know HTML. A wiki 

starts with one front page. Each author can add other pages to the wiki by 

simply creating a link to a page that doesn't exist yet. 

Wikis get their name from the Hawaiian term "wiki wiki," which means 

"very fast." A wiki is indeed a fast method for creating content as a group. 

It's a hugely popular format on the Web for creating documents as a group. 

There is usually no central editor of a wiki, no single person who has final 

editorial control. Instead, the community edits and develops its own 

content. Consensus views emerge from the work of many people on a 

document. 

In Moodle, wikis can be a powerful tool for collaborative work. The entire 

class can edit a document together, creating a class product, or each student 

can have their own wiki and work on it with you and their classmates. 

 

Wiki in Moodle 2.0 video: 

 

 

4.3.12.2.2.См. также 
 Использование Moodle. Обсуждение форума «Использование COLLES со Студентами 

младших курсов». 

 Книга по использованию Moodle. Часть 14: Опросы и Выборы. 

 http://dougiamas.com/writing/herdsa2002 – Статья, в которой Опросы используются в 

детализированном анализе. 

4.3.12.3.Часто задаваемые вопросы по Опросу 
4.3.12.3.1.Как можно создать пользовательские Опросы? 

Пользовательские Опросы могут быть созданы посредством либо модуля Feedback 

«Обратная связь» (который скрыт по умолчанию) или модуля Questionnaire «Опросник 

или анкета» (который является внесённым модулем). 

Будем надеяться, что модуль ядра, объединяющего лучшие средства модулей  

Обратной связи, Опросника и Опроса, будет доступен через некоторое время в будущем. 

 

4.3.12.4.См. также 
 Использование Moodle. Форум «Модуль Опроса». 

4.3.13.Вики 
Коллекция веб-страниц, которую каждый может пополнить или отредактировать. 

Модуль «Вики» 
Вики – это веб-Сайт – коллекция совместно созданных веб-документов. По 

существу, страница Вики является веб-страницей, которую каждый в вашем классе может 

создавать что-то вместе с другими, прямо в браузере, без необходимости знать HTML. 

Вики начинается с одной Главной страницы. Каждый автор может добавить другие 

страницы в Вики простым созданием ссылки на ещё не существующую страницу. 

Вики получил своё название от гавайского термина «wiki wiki», который означает 

«очень быстро». Вики действительно является быстрым методом для создания 

содержимого группой. Это весьма популярный формат в Сети для создания документов в 

группе. Обычно центрального редактора Вики не существует, нет единственного человека, 

который осуществляет итоговый редакторский контроль. Вместо этого, сообщество 

редактирует и развивает своё собственное содержимое. Единодушие взглядов возникает 

во время работы многих людей над документом. 

В Moodle Вики может быть мощным инструментом для совместной работы. Целый 

класс может редактировать документ вместе, создавая продукт всего класса, либо каждый 

Студент может иметь свой собственный Вики, и работать на нём с вами или своими 

соклассниками. 

Видео «Вики в Moodle 2.0». 

http://moodle.org/mod/forum/discuss.php?d=11980
http://moodle.org/mod/forum/discuss.php?d=11980
http://docs.moodle.org/25/en/Using_Moodle_book
http://dougiamas.com/writing/herdsa2002
http://moodle.org/mod/forum/view.php?id=739
http://www.youtube.com/watch?v=TfkunrqQVS8
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4.3.13.1.Wiki settings 
4.3.13.1.1.Adding a wiki 
 With the editing turned on, in the section you wish to add your wiki, 

click the "Add an activity or resource" link (or, if not present, the "Add 

an activity" drop down menu) and choose Wiki. 

 This will take you to the wiki settings page titled "Adding a new wiki". 

All settings may expanded by clicking the "Expand all" link top right. 

 

 In an existing wiki, the wiki settings can be found in Administration > 

Wiki administration > Edit settings. 

4.3.13.1.2.General 
Wiki name 
 The name you give to your wiki here will appear as the link on the 

course page for your students to click. 

Wiki description 
 Explain the purpose of your wiki here. (This description may or may 

not be compulsory depending on your admin's settings.) 

Display description on course page 
If this box is checked, then the description you added above will appear 

with the wiki link on the course page. 

Wiki mode 
 Choose between "Individual wiki" where each student gets their own, 

or "Collaborative wiki" where students work together on a single wiki. 

 

First page name 
 The name you add here will form the first page of your new wiki. It is a 

required field and once a name has been entered, it can't be changed. 

 

4.3.13.1.3.Format 
Default format 
 Set the default type of editing your wiki will use. Chooose from 

 

 HTML - editing using the normal text editor 

 Creole - a popular wiki editing language. If this is selected, a small 

editing toolbar will appear. 

 NWiki – a wiki editing language used in the contributed NWiki 

module. 

4.3.13.1.Настройки Вики 
4.3.13.1.1.Добавление Вики 
 При включённом режиме редактирования в разделе, куда хотите добавить Вики, 

щёлкните ссылку «Add an activity or resource» (или, если не присутствует, ниспадающее 

меню «Add an activity») и выберите Wiki. 

 Это приведёт вас на страницу настроек Вики, озаглавленную «Adding a new wiki 

(добавление нового Вики)». Все настройки могут быть развёрнуты щелчком по ссылке 

справа вверху «Expand all». 

 В существующем Вики настройки можно найти в 

AdministrationWiki administrationEdit settings. 

4.3.13.1.2.Обычные настройки 
Название Вики 
 Название, которое вы здесь дадите Вики, появится как ссылка на странице Курса для 

ваших Студентов, чтобы щёлкать. 

Описание Вики 
 Объясните здесь назначение Вики. (Это описание может быть или не быть 

обязательным, в зависимости от настроек вашего Администратора.) 

Отображать описание на странице Курса 
Если это окошко помечено, тогда описание, которое вы добавили выше, появится 

со ссылкой на Вики на странице Курса. 

Режим Вики 
 Выберите между «Individual wiki», где каждый Студент получает свой собственный 

Сайт, и «Collaborative wiki», когда Студенты работают вместе над единственным 

Сайтом Вики. 

Наименование первой страницы 
 Наименование, которое вы здесь добавите, будет представлять первую страницу вашего 

нового Вики. Это обязательное поле, и, как только оно заполнено, оно не может быть 

изменено. 

4.3.13.1.3.Формат 
Формат по умолчанию 
 Установите тип редактирования вашего Вики, который будет использоваться по 

умолчанию. Выберите из: 

 HTML – редактирование, использующее стандартный текстовый редактор. 

 Creole – популярный язык редактирования Вики, 

появится маленькая панель редактирования. 

 NWiki – язык редактирования Вики, 

используемый в прелагаемом модуле «NWiki». 
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Force format 
If you check this box then students cannot choose their own method of 

editing the wiki. 

4.3.13.1.4.Common module settings 
See Common module settings 

4.3.13.1.5.Restrict access/Activity completion 
 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.3.13.1.6.Locally assigned roles 
In Administration> Wiki administration > Locally assigned roles selected 

users can be given additional roles in the activity. 

4.3.13.1.7.Wiki permissions 
Role permissions for the activity can be changed in Administration > Wiki 

administration > Permissions. 

4.3.13.2.Using Wiki 
This section outlines how to use wikis after the teacher has added a wiki 

activity. To set up a wiki in your course, see Wiki settings 

 

4.3.13.2.1.Creating the first page 
 Once the wiki is set up, a user will click the link and reach the 

following screen: 

4.3.13.2.2.Adding more pages 
 
 Type the name of your page inside double brackets. (1 in screenshot 

below) You can preview it by clicking the "preview" button towards the 

bottom of the screen. 

 

 

 Press the "save" button. 

 Now click the (red) link for one of the pages (2 in screenshot below) 

and you will be prompted to create it in the same way you create the 

first page: 

 

 A page once created has a blue link. 

 

 

Принудительный формат 
Если вы отметите это окошко, тогда Студенты не смогут выбирать свой 

собственный метод редактирования Вики. 

4.3.13.1.4.Общие настройки модуля 
См. п. 6.1. 

4.3.13.1.5.Ограничить доступ/завершение 
ИнтерактивногоДействия 

Эти настройки видимы, если Обусловленные Действия (п. 4.9.2) и 

Завершение Действия (п. 4.9.3) разрешены на Сайте и в Курсе. 

4.3.13.1.6.Локально назначаемые Роли 
В AdministrationWiki administrationLocally assigned roles выбранным 

пользователям могут быть даны дополнительные Роли в этом Интерактивном Действии. 

4.3.13.1.7.Полномочия Вики 
Полномочия Роли для этого Интерактивного Действия могут быть назначены в 

AdministrationWiki administrationPermissions. 

4.3.13.2.Применение Вики 
Этот раздел в общих чертах обрисовывает, как использовать Вики после того, как 

Преподаватель добавил Интерактивное Действие «Вики». Чтобы установить Вики в ваш 

Курс см. «Настройки Вики (п. 4.2.13.1)». 

4.3.13.2.1.Создание первой страницы 
 Как только Вики установлен, пользователь может щёлкнуть его 

ссылку и достичь следующего экрана: 

4.3.13.2.2.Добавление дополнительных 
страниц 
 Наберите наименование вашей страницы в 

квадратных скобках. (1 на снимке с экрана 

ниже.) Вы можете предварительно 

просмотреть его, щёлкнув кнопку «Preview» 

внизу экрана. 

 Нажмите кнопку «Save». 

 Теперь щёлкните (красную) ссылку на одной 

из страниц (2 на снимке с экрана ниже) и вас 

пригласят создать это тем же способом, 

которым вы создали первую страницу. 

 Как только страница создана, ссылка на неё 

имеет голубой цвет. 
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Hint: 
If you use the New option from the navigation block you will still need to 

copy and paste the name of the new page onto the immediate parent page 

and surround it with double brackets. This creates a link to your new page 

and makes it accessible from the main Wiki page. Otherwise nobody will 

recognise the so called lost new page. 

4.3.13.2.3.Wiki editing in general 
Depending on the type of the wiki, there are several ways to edit your 

page. But don't worry: The best thing of a wiki is, that nothing is lost. The 

old version will be there - and if someone changes your version of the page 

- your version will also be there. Note that the options for editing, 

commenting viewing history, map and files may all be accessed both from 

tabs at the top (1 in screenshot below) and links in the navigation block (2 

in screenshot below): 

4.3.13.2.4.View 
 The View tab at the top or link in the navigation block allows users to 

display and view the wiki page. 

 

4.3.13.2.5.Edit 
 The Edit tab at the top or link in the navigation block allows users to 

edit the wiki page. 

4.3.13.2.6.Comments 
 The Comments tab at the top or link in the navigation block allows 

users to see and add comments about the wiki. 

4.3.13.2.7.History 
 The History tab at the top or link in the navigation block allows users to 

see what has been altered in the wiki. 

 Compare edits by clicking the "Compare Selected" button. 

 

 Click the "Restore" button of the version you wish to restore if the latest 

edit is unsuitable: 

 

4.3.13.2.8.Map 
 The Map tab at the top or link in the navigation block allows users to 

view areas of the wiki such as a list of pages (as in the following 

screenshot), updated or orphaned pages etc. (Orphaned pages are pages 

not linked to anywhere.) 

 

Совет: 
Если вы используете опцию New из Блока Навигации, вам всё ещё нужно 

копировать и вклеивать это название новой страницы на непосредственную родительскую 

страницу и заключать его в квадратные скобки. Это создаёт ссылку на вашу новую 

страницу и делает её доступной с Главной Страницы Вики. Иначе никто не узнает о так 

называемой потерянной новой странице. 

4.3.13.2.3.Редактирование Вики в общем 
В зависимости от типа Вики, существует несколько способов отредактировать 

вашу страницу. Но не волнуйтесь. Лучшее, что есть в Вики, это то, что ничего не теряется. 

Каждая из старых версий будет там – и, если кто-то изменит вашу версию этой страницы – 

ваша версия также будет там. Заметьте, что опции для редактирования, комментирования 

истории просмотра, карты и файлов могут иметь доступ как с этикетки вверху (1 на 

снимке с экрана ниже), так и по ссылкам в Блоке Навигации (2 на снимке с экрана ниже). 

 

4.3.13.2.4.Видеть 
 Этикетка View вверху или ссылка в Блоке 

Навигации позволяет пользователям отображать и 

видеть страницу Вики. 

4.3.13.2.5.Редактировать 
 Этикетка Edit вверху или ссылка в 

Блоке Навигации позволяет пользователям редактировать страницу Вики. 

4.3.13.2.6.Комментарии 
 Этикетка Comments вверху или ссылка в Блоке Навигации позволяет пользователям 

осматривать и добавлять комментарии о Вики. 

4.3.13.2.7.История 
 Этикетка History вверху или ссылка в Блоке Навигации позволяет пользователям 

увидеть, что было изменено в Вики. 

 Сравните редактирования посредством кнопки «Compare Selected (сравнить 

выбранное)». 

 Щёлкните кнопку «Restore (восстановить)» той версии, которую хотите восстановить, 

если самое последнее редактирование является неподходящими. 

См. снимок с экрана. 

4.3.13.2.8.Отобразить 
 Этикетка Map вверху или ссылка в Блоке Навигации позволяет пользователям 

просматривать области Вики, такие как список страниц (как на следующем снимке с 

экрана), обновлённых или зависших страниц и т.д. (Зависшие страницы – это страницы, 

не связанные с чем-нибудь) 

http://docs.moodle.org/25/en/File:comparewiki.png
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 To select what you want to see, click the Map menu dropdown box. 

 

 

4.3.13.2.9.Files 
 The Files tab at the top or link in the navigation block allows users to 

access any files which have been added to the wiki. 

 By default, the Teacher role can add and manage files to the Files tab, 

but the Student role can only view them. You could change this though 

with a permissions override to the Manage wiki files capability 

(mod/wiki:managefiles) in any particular wiki. 

4.3.13.2.10.Administration 
The Administration tab at the top or link in the navigation block is 

available to editing teachers in the course so they can delete page versions 

or selected pages. Clicking the "list all" button will list available pages to 

delete. The first page of the wiki cannot be deleted. 

 

 

4.3.13.2.11.Deleting pages 
Teachers and other users with the mod/wiki:managewiki capability can 

delete any page or page version, with the exception of the first page, via 

the Administration link in the navigation block or the Adminstration tab. 

See the section Administration above. 

4.3.13.2.12.Markup language 
You miss all the formatting you know from other moodle activities? That's 

because the wiki-type of your wiki is e.g. nwiki. See Nwiki markup 

 

4.3.13.2.13.Why use a wiki? 
Wikis are a simple, flexible tool for collaboration. They can be used for 

everything from simple lists of web links to building entire encyclopedias. 

As an example, Wikipedia is the largest wiki in the world. In your own 

class it's important to have a plan for your wiki so students know how it 

fits in with their learning. If it's a individual wiki, will they be graded? Is it 

simply a staging area for group work that will be submitted as assignments 

later? Will you let the students be completely responsible for the work? 

How will you deal with offensive content? The great advantage of a wiki is 

that all edits are clearly visible and reversible. 

 

 

 

 Чтобы выбрать то, что вы хотите увидеть, щёлкните окошко Map menu с ниспадающим 

списком. 

См. снимок с экрана. 

4.3.13.2.9.Файлы 
 Этикетка Files вверху или ссылка в Блоке Навигации предоставляет пользователям 

доступ к любым файлам, которые были добавлены к Вики. 

 По умолчанию Роль Преподавателя может добавлять и управлять файлами в таблице 

Files, но Роль Студента может только просматривать их. Однако, Вы можете изменить 

это, применив Полномочия Переопределять к Возможности управлять файлами Вики 

(mod/wiki:managefiles) в любом конкретном Вики. 

4.3.13.2.10.Управление 
Этикетка «Administration» вверху или ссылка в Блоке Навигации доступны 

редактирующим Преподавателям в Курсе для того, чтобы они 

могли удалять версии страниц или выбранные страницы. 

Щелчок по кнопке «List all (составить весь список)» 

предоставит список доступных для удаления страниц. Первая 

страница Вики удалена быть не может. 

4.3.13.2.11.Удаление страниц 
Преподаватели и другие пользователи с Возможностью mod/wiki:managewiki могут 

удалить любую страницу или версию страницы, за исключением первой страницы, 

посредством ссылки Administration в Блоке Навигации или этикетки Administration. См. 

«Управление» выше. 

4.3.13.2.12.Язык разметки 
Вы не видите всех средств форматирования, наличие которых наблюдается в 

других модулях Интерактивных Действий? Это потому, что тип вашего Вики есть, 

например, nwiki. См. разметку Nwiki. 

4.3.13.2.13.Зачем использовать Вики? 
Вики является простым, гибким инструментом для коллективной работы. Он может быть 

использован для чего угодно: от составления простых списков веб-ссылок до построения 

целых энциклопедий. Например, Википедия является самым большим Вики в мире. В 

вашем собственном классе важно спланировать создание вашего Вики так, чтобы 

Студенты знали, как он встроен в их обучение. Будет ли это индивидуальный Вики, и 

будет ли он оценён? Или это просто площадка для групповой работы, результаты которой 

будут переданы на рассмотрение как выполненные задания позднее? Позволите ли вы 

Студентам работать самостоятельно, полностью на их собственную ответственность за их 

работу? Как вы поступите с оскорбительным содержимым? Большим достоинством Вики 

является то, что любое редактирование ясно видимо и обратимо. 

http://docs.moodle.org/25/en/File:wikimap.png
http://docs.moodle.org/25/en/Nwiki_markup
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4.3.13.2.14.Ideas for using wikis 
Group lecture notes 
Creating a wiki for group lecture notes after a lecture gives students a 

chance to combine all their notes. Those that missed information can get it 

from their peers. The group can also decide what information is critical and 

give it proper emphasis. Group lecture notes could be done with the entire 

class, if it is small enough, or with small working groups. Groups can also 

compare notes for further discussion and refinement. 

 

Group Project management 
A teacher assigning a group project can give students a place to work by 

creating a wiki with the group mode enabled. This will give each group 

their own space to record research, to develop outlines and to create the 

final product. 

Brainstorming 
Brainstorming is a non-judgmental group creative process in which group 

members are encouraged to give voice to any ideas they personally 

consider relevant to the group exercise. In a face-to-face meeting, a 

brainstorming facilitator will usually stand in front of a big piece of paper 

and elicit ideas from the participants in the room. A teacher can create an 

online version of this process by setting up a wiki for the entire class or for 

smaller student groups and asking people to submit ideas  

Contribute to other wikis 
A teacher might assign his or her class the task of contributing to 

Wikipedia, Wikiversity, or to another wiki on the Web, on any class topic, 

perhaps by assigning students to groups (or making it a class project if the 

class is small enough and the topic broad enough) and challenging them to 

collaboratively create an article they would feel confident posting to a 

public-information space. Students will use the course wiki to create drafts 

of the article they will eventually publish to the community at the end of 

the semester. 

Collaborative story-telling 
Younger students could be encourage to work together on a wiki to build 

up a story -each adding a sentence following on from the previous 

contribution. 

4.3.13.2.15.See also 
 Using Moodle Wiki module forum 

 Creole format 

 

4.3.13.2.14.Идеи по использованию Вики 
Групповой конспект лекций 

Создание Вики после лекции для составления коллективного конспекта лекции 

даёт Студентам возможность объединить все их заметки. Те, кто пропустил информацию, 

могут получить её от своих сокурсников. Группа также может решить, какая информация 

является критической, и сделать на ней особый акцент, подчеркнуть её значение. 

Групповой конспект лекции может быть сделан всем классом, если число Студентов в нём 

невелико, либо небольшими подгруппами по отдельности. Группы также могут сравнить 

свои заметки для дальнейшего обсуждения и уточнения. 

Управление групповым проектом 
Преподаватель, назначая групповой проект, может дать Студентам площадку для 

работы, создав Вики с позволением групповой работы. Это предоставит каждой Группе 

своё собственное пространство для записи результатов исследований, создания 

черновиков и оформления окончательного продукта. 

Мозговой штурм 
Мозговой штурм – это групповой творческий процесс без критики выдвигаемых 

идей, в котором члены Группы поощряются к предложению любых идей, которые они 

считают подходящими для рассматриваемой ими проблемы. На заседании с личным 

присутствием членов Группы модератор фиксирует идеи, генерируемые участниками 

мозгового штурма, на большом листе бумаги. Преподаватель может создать онлайн 

версию этого процесса установкой Вики для всего класса или для более мелких 

студенческих Групп, попросив всех предлагать свои идеи в Вики. 

Участие в других Вики 
Преподаватель может назначить своему классу задачу внесения пополнений в 

Википедию, Викиверсите́т или другой Вики в Сети, по любой теме класса, возможно, 

распределяя Студентов по Группам (или делая это проектом всего класса, если этот класс 

достаточно малочислен, а тема достаточно широка) и стимулируя их к совместному 

созданию статьи, которую они сочтут пригодной к размещению в публичном 

информационном пространстве. Студенты будут использовать Вики этого Курса, чтобы 

создать рабочий вариант статьи, которую они опубликуют в конце семестра. 

 

Совместное повествование 
Студенты младших курсов могут поощряться к совместной работе с помощью 

Вики путём создания истории, когда каждый добавляет предложение, исходя из 

предложенных ранее. 

4.3.13.2.15.См. также 
 Форум по обсуждению Moodle «Модуль Вики». 

 Формат Creole. 

http://moodle.org/mod/forum/view.php?f=366
http://docs.moodle.org/25/en/Creole_format
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4.3.13.3.Wiki FAQ 
4.3.13.3.1.Can I make a wiki that my students can 
read but not edit? 
 Although you used to be able to do this in older versions of Moodle, it's 

not really in the "spirit" of a wiki and is no longer possible without 

tweaking permissions. A Book might do the job just as well, or a simple 

Page. 

 However, if you really need to do this then remove the student role 

from mod/wiki:editpage and mod/wiki:createpage when you create your 

wiki. See forum discussion here: [1] 

4.3.13.3.2.Students can't see each others wikis 
If you have set the wiki to "individual", then only you the teacher and each 

individual student can see them. If you would like them to collaborate on a 

wiki, choose the collaborative option. However, this will just give one wiki 

for all the students. 

4.3.13.3.3.How can I grade my students' wikis? 
There is no in-built grading facility in the wiki but you can manually add a 

grade item in the Gradebook called (for example) "yourwikiname" and 

enter your grades there. 

4.3.13.3.4.Can I export a wiki? 
While it was possible in earlier versions of Moodle to export wikis, for 

instance as zipped files, this is not the case in 2+. There is a tracker entry 

here MDL-24439 

4.3.13.3.5.See also 
 Using Moodle Wiki module forum 

 Using Moodle Nwiki and Creole parsers in Moodle 2.0 forum 

discussion 

4.3.14.Workshop 
Workshop is a peer assessment activity with many options. Students 

submit their work via an on line text tool and attachments. There are two 

grades for a student: their own work and their peer assessments of other 

students' work. 

 

Screenshot «Workshop example». 

Workshop module 
 

 

4.3.13.3.Часто задаваемые вопросы по Вики 
4.3.13.3.1.Можно ли создать Вики, который мои Студенты 
смогут читать, но не редактировать? 
 Хотя в старых версиях Moodle вы могли использовать Вики для этого, но в это не «в 

духе» Вики, и теперь это больше невозможно без тонкой настройки Возможностей. 

Ресурсы «Книга (п. 4.4.1)» или простая «Страница (п. 4.4.6)» могут выполнять эту 

работу с тем же успехом. 

 Однако если вам действительно нужно сделать это в Вики, тогда удалите Роль 

Студента из mod/wiki:editpage и mod/wiki:createpage, когда вы создаёте ваше Вики. 

Обсуждение Форума см. здесь. 

4.3.13.3.2.Студенты не могут видеть Вики других 
Если вы установили Вики в «Individual», тогда только вы Преподаватель и каждый 

индивидуальный Студент могут его видеть. Если вы предпочитаете совместное 

использование Вики, выберите опцию «Collaborative». Однако это просто предоставит 

одно Вики для всех Студентов. 

4.3.13.3.3.Как оценивать Вики моих Студентов? 
Встроенного в Вики средства оценивания не существует, но вы можете вручную 

добавить элемент оценки в Журнал Оценок (п. 4.9.1.1), назвав (например) 

«имявашеговики» и введите туда ваши оценки. 

4.3.13.3.4.Можно ли экспортировать Вики? 
В то время как в ранних Moodle можно было экспортировать Вики, например, как 

заархивированные zip-файлы, то, начиная с версии 2, это невозможно. Здесь имеется 

запись средства отслеживания MDL-24439. 

4.3.13.3.5.См. также 
 Форум «Модуль Вики» по использованию Moodle. 

 Обсуждение форума по использованию Moodle «Синтаксические анализаторы Nwiki и 

Creole в Moodle 2.0». 

4.3.14.Семинар 
Семинар – является Интерактивным Действием по оцениванию сокурсниками друг 

друга, со многими опциями. Студенты могут отправить готовые ответы по их работе с 

помощью инструмента Line text (линейный текст) и файловых вложений. Студент должен 

представить две оценки: свою оценку собственной работы, и свои оценивания работ 

других Студентов. 

Снимок с экрана «Пример Семинара». 

Модуль «Семинар» 

http://moodle.org/mod/forum/discuss.php?d=195179#p856311
http://tracker.moodle.org/browse/MDL-24439
http://moodle.org/mod/forum/view.php?f=366
http://moodle.org/mod/forum/discuss.php?d=154927
http://docs.moodle.org/25/en/File:Workshopexample.png
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4.3.14.1.Key features 

Workshop is similar to the Assignment module and extends its 

functionality in many ways. However, it is recommended that both course 

facilitator (teacher) and course participants (students) have at least some 

experience with the Assignment module before the Workshop is used in 

the course. 

As in the Assignment, course participants submit their work during the 

Workshop activity. Every course participant submits their own work. The 

submission may consist of a text and attachments. Therefore, Workshop 

submission merges both Online text and Upload file types of the 

Assignment module. Support for team work (in the sense of one 

submission per group of participants) is out of scope of Workshop module. 

The submissions are assessed using a structured assessment form defined 

by the course facilitator (teacher). Workshop supports several types of 

assessment forms. All of them allows multi-criteria assessment in 

comparison to the Assignment module where only one grade is given to a 

submission. 

Workshop supports peer assessment process. Course participants may be 

asked to assess selected set of their peers' submissions. The module 

coordinates the collection and distribution of these assessments. 

Course participants get actually two grades in a single Workshop activity - 

grade for their submission (that is how good their submitted work is) and 

grade for assessment (that is how well they assessed their peers). 

Workshop activity creates two grade items in the course Gradebook and 

they can be aggregated there as needed. 

The process of peer assessment and understanding the assessment form can 

be practised in advance on so called example submissions. These examples 

are provided by the facilitator together with a reference assessment. 

Workshop participants can assess these examples and compare their 

assessment with the reference one. 

The course facilitator can select some submissions and publish them so 

they are available to the others at the end of Workshop activity (in 

comparison to the Assignment module where submitted work is available 

only to the author and the facilitator). 

Workshop in Moodle 2.0 video: 

http://www.youtube.com/watch?v=8QypkOcAEaE. 

 

 

 

 

4.3.14.1.Ключевые возможности 
Семинар похож на модуль «Задание» (см. п. 4.3.1) и расширяет его 

функциональность многими способами. Поэтому рекомендуется, чтобы и Куратор 

(Преподаватель), и участники Курса (Студенты) имели некоторый опыт работы с модулем 

«Задание» перед тем, как они начнут в Курсе использовать Семинар. 

Как и в Задании, в течение работы Семинара участники Курса отправляют готовые 

ответы по своей работе. Каждый участник Курса отправляет свой готовый ответ по работе. 

Готовые ответы могут состоять из текста и файловых включений. Следовательно, готовый 

ответ по Семинару объединяет обе компоненты из модуля «Задание»: как текст в режиме 

онлайн, так и пересылку файлов. Поддержка групповой работы в команде (в смысле 

одного готового ответа на всю Группу участников) не входит в функции модуля 

«Семинар». 

Готовые ответы оцениваются путём использования конкретной формы оценивания, 

определяемой Куратором (Преподавателем) Курса. Семинар поддерживает несколько 

типов форм оценивания. Все они допускают многокритериальное оценивание, в отличие 

от модуля «Задание», где даётся только одна оценка готового ответа. 

 

«Семинар» поддерживает процесс взаимного оценивания. Участникам Курса 

может быть предложено оценить некоторую совокупность готовых ответов своих 

сокурсников. Данный модуль координирует сбор и рассылку этих текстов для оценивания. 

Участники Курса получают сразу две оценки за одно Интерактивное Действие «Семинар»: 

– оценку за их собственный готовый ответ (т.е. насколько хороша переданная ими на 

рассмотрение работа) и оценку за оценивание (т.е. насколько они хорошо оценили своих 

сокурсников). Интерактивное Действие «Семинар» создаёт две оценки в Журнале Оценок 

Курса (см. п. 4.9.1.1), где они могут быть агрегированы, как требуется. 

Этот процесс взаимного оценивания и понимания форм оценивания может быть 

заранее опробован практически, путём рассмотрения  примеров прошлых готовых ответов. 

Эти примеры предоставляются Куратором вместе с теми Оценками, которые были даны 

этим работам. Участники семинара могут сами оценить эти примеры, и сравнить своё 

оценивание с Оценкой Преподавателя. 

Куратор Курса может выбрать некоторые представленные готовые ответы и 

опубликовать их с тем, чтобы они были доступны другим в конце работы Семинара (в 

отличие от модуля «Задание», где готовый ответ на работу доступен только Автору и 

Куратору). 

Семинар в видео по версии Moodle 2.0: 

http://www.youtube.com/watch?v=8QypkOcAEaE. 

http://docs.moodle.org/25/en/Assignment_module
http://docs.moodle.org/25/en/Gradebook
http://www.youtube.com/watch?v=8QypkOcAEaE
http://www.youtube.com/watch?v=8QypkOcAEaE
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4.3.14.2.Workshop settings 
4.3.14.2.1. Adding a new workshop 
With the editing turned on, in the section you wish to add your workshop, 

click the "Add an activity or resource" link (or, if not present, the "Add an 

activity" drop down menu) and choose Workshop. All settings may 

expanded by clicking the "Expand all" link top right. 

4.3.14.2.2. General 
The "Adding a new workshop" screen will be displayed 

Screenshot «General settings expanded by default». 

Name 
Whatever you type here will form the link learners click on to view the 

workshop, so it is helpful to give it a name that suggests its purpose. 

 

Description 
Add a description of your workshop here. Click "Show editing tools" to 

display the rich text editor, and drag the bottom right of the text box out to 

expand it. 

Display description on the course page 
If this box is ticked, the description will appear on the course page just 

below the name of the workshop. 

4.3.14.2.3.Grading settings 
Screenshot «Grading settings expanded». 

Grading Strategy 
What you choose here determines the assessment form students will use 

and also the strategy for grading submissions. For more detailed 

descriptions see Grading Strategies. Note: Grading strategies can't be 

changed once we have entered the submission phase of a workshop. 

Accumulative grading: Comments and a grade are given regarding the 

aspects of the workshop specified. 

Comments: Comments are given but no grade can be given to the 

specified aspects 

Number of Errors: A yes/no assessment is used and comments are given 

for specified assertions 

Rubric: A level assessment is given regarding specified criteria 

Grade for Submission 
This sets the maximum grade a student can attain from a teacher for a 

given submission. It is scaled between 0-100. 

 

4.3.14.2.Настройки Семинара 
4.3.14.2.1.Добавление нового Семинара 

Включив режим редактирования в разделе, куда вы хотите добавить ваш Семинар, 

щёлкните ссылку «Add an activity or resource» (или, если не присутствует, ниспадающее 

меню «Add an activity») и выберите Workshop. Все настройки могут быть развёрнуты 

щелчком по кнопке «Expand all» вверху справа. 

4.3.14.2.2.Общие настройки 
Будет отображён Экран «Adding a new workshop (добавление нового семинара)». 

Снимок с экрана «Общие настройки, развёрнутые по умолчанию». 

Наименование 
Всё, чтобы вы ни напечатали здесь, сформирует ссылку, щелчком по которой 

учащиеся увидят «Семинар», поэтому полезно дать ей наименование, которое обозначало 

бы её цель. 

Описание 
Добавьте описание вашего Семинара этой настройкой. Щёлкните «Show editing 

tools», чтобы отобразить редактор обогащённого текста, и перетащите за правый нижний 

угол текстового окошка, чтобы расширить его. 

Отобразить описание на странице Курса 
Если это окошко отмечено, описание будет появляться на странице Курса ниже 

наименования Семинара. 

4.3.14.2.3.Настройки Аттестации 
Снимок с экрана «Развёрнутые настройки Аттестации». 

Стратегия Аттестации 
То, что вы здесь выберете, определит форму оценивания, которую Студенты будут 

использовать, а также стратегию оценивания готовых ответов. Больше подробностей 

приведено в «Стратегии оценивания». Замечание: Стратегии Аттестации не могут быть 

изменены после вхождения в фазу подачи готового ответа Семинара. 

Накапливающееся оценивание: Комментарии и оценка даются отдельно для каждого из 

аспектов, определённых для данного Семинара. 

Комментарии: Комментарии по указанным аспектам даются, но оценка им не даётся. 

 

Число ошибок: Используется оценивание типа «yes/no», и даются комментарии к 

конкретным утверждениям . 

Рубрика: Применяется уровень оценивания, заданный критериями. 

Оценка готового ответа 
Эта опция устанавливает максимальную оценку, которую Студент может получить 

от Преподавателя за данный ответ. Она масштабируется между 0 и 100. 

http://docs.moodle.org/25/en/Workshop_settings
http://docs.moodle.org/25/en/Workshop_grading_strategies
http://docs.moodle.org/25/en/File:workshopgeneral25.png
http://docs.moodle.org/25/en/File:workshopgradingsettings25.png
http://docs.moodle.org/25/en/Workshop_grading_strategies
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Grade for Assessment 
Sets the maximum grade a student can receive for assessing other students’ 

work. It is also scaled between 0-100 

Decimal places in grade 
Decide here how many decimal places are allowed in the grade. 

4.3.14.2.4. Submission settings 
Screenshot «Submission settings expanded». 

Instructions for submission 
Explain here what students must submit. 

Maximum number of submission attachments 
If you wish students to attach files, select how many here, up to a 

maximum of 7. If you leave it at 0 then they can only enter text. 

Maximum File Size 
Decide here how large a file students can upload. The size will depend on 

the course upload limit. 

Late Submissions 
Ticking this box will allow students to submit after the deadline. 

 

Once the workshop has been made we can then set more settings relating 

to submissions. This is done through clicking on the menu highlighted 

below which is found when you click on the workshop’s link or after 

clicking “Save and Display” on completion of the workshop. To access the 

menu simply click on “Allocate Submissions”. It is highlighted in the 

picture by the red box. See the section Submission phase. 

Screenshot «Submission settings for allocating reviewers to submissions». 

 

4.3.14.2.5.Assessment settings 
Screenshot «Assessment settings expanded». 

Teachers can write instructions for assessments online. This is very useful 

to help students have a better understanding about the important points of a 

task before assessing their classmates’ submissions. 

After the workshop has been made, teachers can set more settings related 

to assessments. See the section Set up phase. 

4.3.14.2.6.Feedback 
Screenshot «Feedback settings expanded». 

Overall feedback mode 
If this is enabled, a text box appears at the bottom of each assessment form 

for reviewers to give an overall comment about 

Оценка оценивания 
Устанавливает максимальную оценку, которую Студент может получить за 

оценивание работы других Студентов. Она тоже масштабируется между 0 и 100. 

Десятичные разряды в оценке 
Определите, сколько десятичных разрядов указывается в каждой из оценок. 

4.3.14.2.4.Настройки готового ответа 
Снимок с экрана «Развёрнутые настройки готового ответа». 

Инструкции для готового ответа 
Объясните здесь, что Студенты должны представлять в качестве готового ответа. 

Максимальное число файловых вложений в готовых ответах 
Если вы хотите, чтобы Студенты присоединяли файлы, выберите здесь, сколько 

(максимум 7). Если вы оставите эту опцию равной 0, они смогут вводить только текст. 

Максимальный размер файла 
Определите, какой величины файлы могут пересылать Студенты. Размер будет 

зависеть от ограничения по пересылаемым файлам для Курса. 

Запоздалые готовые ответы 
Отметка «галочкой» этого окошка позволит Студентам отправлять готовые ответы 

и после срока окончания. 

После того, как Семинар был закончен, мы можем установить дополнительные  

настройки, относящиеся к готовым ответам. Это делается путём щелчка по меню, 

подсвеченному ниже, которое появляется, когда вы щёлкнете по ссылке на Семинар, или 

после щелчка «Save and Display (сохранить и отобразить)» по завершении Семинара. Для 

доступа к этому меню просто щёлкните по «Allocate Submissions (распределить готовые 

ответы)». Оно выделяется красным окошком. См. п. 4.3.14.2.12 «Фаза готового ответа». 

Снимок с экрана «Настройки готового ответа для распределения рецензентов по 

готовых ответов». 

4.3.14.2.5.Настройки оценивания 
Снимок с экрана «Развёрнутые настройки оценивания». 

Преподаватели могут написать инструкции по оцениванию в режиме онлайн. Это 

весьма полезно для помощи Студентам лучше понять наиболее важные моменты задачи 

оценивания готовых ответов их однокурсников. 

После того, как Семинар закончен, Преподаватели могут установить больше 

настроек, относящихся к оцениваниям. См. «Установить фазу» в п. 4.3.14.2.11. 

4.3.14.2.6.Обратная связь 
Снимок с экрана «Развёрнутые настройки Обратной Связи». 

Режим общей Обратной Связи (с оценкой группы ответов) 
Если эта опция включена, внизу каждой формы оценивания появится текстовое 

окошко для рецензентов, чтобы они могли дать свой комментарий по заданной Группе  

http://docs.moodle.org/25/en/Workshop_settings#Submission_phase
http://docs.moodle.org/25/en/Workshop_settings#Set_up_phase
http://docs.moodle.org/25/en/File:workshopsubmissionsettings25.png
http://docs.moodle.org/25/en/File:submission_advanced.jpg
http://docs.moodle.org/25/en/File:submission_advanced.jpg
http://docs.moodle.org/25/en/File:workshopassessment25.png
http://docs.moodle.org/25/en/File:workshopfeedback25.png
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the submission. Depending on whether is it set to "Enabled and optional" 

or "Enabled and required", reviewers will either have the choice of leaving 

overall feedback or they will be forced to do so. 

 

Maximum number of overall feedback attachments 
 
Choose here how many (if any) files you wish reviewers to attach to their 

overall feedback, up to a maximum of 7. 

Maximum overall feedback attachment size 
Decide here how large a feedback file students can upload. The size will 

depend on the course upload limit. 

Conclusion 
It is possible to add some custom text which the students will see once they 

reach the end of the workshop process. This might be a general summary 

or suggestions on what should be done next, such as writing a blog post to 

reflect on the experience. 

4.3.14.2.7.Example submissions 
Screenshot «Example submissions settings expanded». 

There are three options in this drop down menu: The first option means 

that the assessment of the example submission is voluntary, while the 

second and the third ones make it mandatory, which either requires 

students to assess example submissions before submitting their own work 

or after their own submission but before peer-assessment. 

4.3.14.2.8.Availability 
Screenshot «Availability settings expanded». 

This section deals with setting submission times and assessment times for 

the workshop. That is the time when students can start submitting as well 

as the deadline for submitting, and similarly the time assessments for other 

students’ work start and when they must finish assessing other students 

work. 

All dates - open for submissions from, submissions deadline, open for 

assessment from and assessment deadline - are displayed in the course 
Calendar. 

Availability lets teacher decide if they want a workshop with a closed 

schedule or one that is open ended. Setting an opening time but leaving the 

deadline open makes it an ongoing activity. To set the opening time and 

deadline for either submissions or assessments teachers must click the 

enable button next to the option they want to set. 

 

готовых ответов. В зависимости от того, установлена ли опция «Enabled and optional 

(включена и по выбору)» или «Enabled and required (включена и обязательна)», рецензенты 

могут либо по своему желанию не выполнять такого оценивания, либо они будут обязаны 

сделать это.                 Новое средство в Moodle 2.5 

Максимальное число файловых вложений в общей 
Обратной Связи 

Выберите здесь, сколько файлов рецензенты могут присоединять к своей общей 

Обратной Связи (от нуля до максимум 7). 

Максимальный размер файлов-вложений общей обратной связи 
Определите здесь, насколько большой файл Обратной Связи могут пересылать 

Студенты. Размер будет зависеть от ограничения на пересылаемые файлы этого Курса. 

Заключение 
Можно добавить некоторый пользовательский текст, который Студенты увидят 

сразу по окончании процесса «Семинар». Это может быть общий итог или предложения о 

том, что должно быть сделано дальше, например, написание сообщения на Блог с 

обсуждением опыта, приобретённого в ходе Семинара. 

4.3.14.2.7.Возможные готовые ответы 
Снимок с экрана «Развёрнутые настройки возможных готовых ответов». 

В этом ниспадающем меню имеются три опции. Первая опция означает, что 

оценивание набора готовых ответов добровольно, в то время как вторая и третья опции 

делают его обязательным, требуя от Студентов либо оценить возможные готовые ответы 

до отправки собственного готового ответа, либо после отправки своего готового ответа, 

перед оцениванием комплекта работ сокурсников. 

4.3.14.2.8.Доступность 
Снимок с экрана «Развёрнутые настройки по доступности». 

Этот раздел посвящён настраиванию для данного Семинара моментов времени 

подачи готовых ответов и оценивания. Т.е. моментов времени, когда Студенты могут 

начать отправку своих готовых ответов, и когда должны её закончить, и подобные же 

моменты времени, когда следует начинать и когда завершать оценивание работ других 

Студентов. 

Все даты, – начала и завершения готовых ответов, и начала и конца оценивания, – 

отображаются в Календаре Курса. 

 

Преподаватель имеет Возможность решать, будет ли Семинар иметь график с 

установленным или открытым сроком окончания. Настройка начала на определённое 

время, но оставление срока окончания открытым, делает Интерактивное Действие 

продлеваемым Интерактивным Действием. Чтобы установить время начала и срок 

окончания для отправки готовых ответов или оценивания, Преподаватели должны 

щёлкнуть кнопку разрешения «Enable» той опции, которую они хотят установить. 

http://docs.moodle.org/25/en/Calendar
http://docs.moodle.org/25/en/File:examplesubmissions25.png
http://docs.moodle.org/25/en/File:workshopavailability25.png
http://docs.moodle.org/25/en/Calendar
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Once the enabled has been checked the 5 drop down boxes will be 

activated and available for change. 

The first three boxes correspond to the date and we can either set this box 

by box or by selecting the date in the calendar that pops up when any of the 

date boxes are selected. The last two boxes correspond to the time in 24 

hour time, the first of the two being hours and the second being minutes. 

Teachers simply set the desired time for each of the sections they wish to 

activate. 

If teachers check the box "switch to the next phase after the submissions 

deadline", the workshop will automatically switch to the assessment phase 

after the next cron job. (Note that since MDL-37781, the phase switching 

no longer requires cron to be executed. This will apply to your Moodle if it 

is the latest weekly after February 8th, or if it is Moodle 2.4.2 onwards.) 

 

4.3.14.2.9.Common module settings 
See Common module settings. 

4.3.14.2.10.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity 

completion have been enabled in the site and the course. 

4.3.14.2.11.Set up phase 
Screenshot «Setup assessment form». 

In order to set the criteria for an assignment, teachers need to fill out an 

assessment form during the setup phase. Students can view this assessment 

form in the submission phase and focus on what is important about the task 

when working on their assignment. In the next phase-the assessment phase, 

students will assess their peers’ work based on this assessment form. 

According to the grading strategy chosen in the grading settings, teachers 

will get corresponding original assessment form to edit by clicking ‘Edit 

assessment form’ button in the first page of the workshop setup for the 

assignment. The grading strategy can be one of Accumulative grading, 

Comments, Number of errors or Rubrics. Teachers can set each criterion in 

detail in the assessment form. 

 

 

 

 

 

 

 

Сразу после отметки «галочкой» включаемой опции, активируются и становятся 

доступными для изменения 5 окошек ниспадающего меню. 

Первые три окошка соответствуют дате, и мы можем либо установить значения в 

одном окошке за другим, либо выбором даты в Календаре, который всплывает, когда 

выбирается любое из окошек с датой. Последние два окошка соответствуют времени по 24 

часовому календарю, первое – часы, второе – минуты. Преподаватели просто 

устанавливают желаемое время для каждого из разделов, который они хотят активировать. 

 

Если Преподаватели отметят «галочкой» окошко «switch to the next phase after the 

submissions deadline (переключить к следующей фазе после срока окончания отправки 

готовых ответов)», Семинар автоматически переходит в фазу оценивания после 

следующей Хрон-работы. (Заметьте, что начиная с MDL-37781, переключение фазы 

больше не требует выполнения Хрона. Это применимо к вашей Moodle, если она 

выпущена после 8 февраля, или если версия Moodle 2.4.2 и старше.) 

4.3.14.2.9.Общие настройки модуля 
См. «Общие настройки модулей» в п. 6.1. 

4.3.14.2.10.Ограничить доступ/Завершение Действия 
Эти настройки видимы, если «Обусловленные Действия» (п. 4.9.2) и 

«Завершение Действия» (п. 4.9.3) разрешены на Сайте и Курсе. 

4.3.14.2.11.Установить фазу 
Снимок с экрана «Установить форму оценивания». 

Для того, чтобы установить критерии для Задания, Преподавателям требуется во 

время фазы установки заполнить форму оценивания. Студенты могут просмотреть эту 

форму оценивания на фазе отправки готовых ответов, и при работе над своим Заданием 

сфокусироваться на том, что важно в задаче. В следующей фазе, – фазе оценивания, 

Студенты будут оценивать работы своих сокурсников на основе формы оценивания. 

В соответствии со стратегией оценивания, выбранной в настройках оценивания, 

Преподаватели получат (по щелчку кнопки «Edit assessment form» на первой странице 

установки Семинара для этого Задания) соответствующую оригинальную форму 

оценивания, чтобы редактировать. Стратегия оценивания может быть одной из 

следующих: Accumulative grading (Накапливающееся оценивание), Comments 

(Комментирование), Number of errors or Rubrics (Число ошибок или рубрикация 

материала). Преподаватели могут подробно определить каждый критерий в форме 

оценивания. 

http://tracker.moodle.org/browse/MDL-37781
http://docs.moodle.org/25/en/Conditional_activities
http://docs.moodle.org/25/en/Activity_completion
http://docs.moodle.org/25/en/Activity_completion
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
https://tracker.moodle.org/browse/MDL-37781
http://docs.moodle.org/25/en/File:Setup_assessment_form.png
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4.3.14.2.12.Submission phase 
Once the workshop has been made we can then set more settings relating 

to submissions. This is done through clicking on the menu highlighted 

below which is found when you click on the workshop’s link or after 

clicking “Save and Display” on completion of the workshop. To access the 

menu simply click on “Allocate Submissions”. It is highlighted in the 

picture by the red box. 

Screenshot «Submission settings for allocating reviewers to submissions». 

 

Screenshot «Manual Allocation Menu». 

Screenshot «Random Allocation Menu» 

Manual Allocation 
Here, a teacher can manually choose which students review whose work. A 

student can review work even if they have not submitted anything 

themselves. 

Random Allocation 
The teacher is given 5 settings that determine how the random allocation 

will work. 

Number of reviews: Here the teacher picks between 0 and 30 reviews for 

either each submission or per reviewer. That is the teacher may choose to 

either set the number of reviews each submission must have or the number 

of reviews each student has to carry out 

Prevent Reviews: If the teacher wishes for students of the same group to 

never review each other’s work, as most likely it is their work too in a 

group submission, then they can check this box and moodle will ensure 

that they are only allocated other students out of their group’s work to 

access 

Remove current allocations: Checking this box means that any manual 

allocations that have been set in the Manual Allocation menu will be 

removed 

Can access with no submission: Having this box checked allows students 

to assess other students’ work without having already submitted their own 

work. 

Add self assessments: This options when checked make sure that as well 

as assessing other students’ work they must also assess their own. This is a 

good option to teach students how to be objective to their own work. 

 

 

 

 

4.3.14.2.12.Фаза предоставления готового ответа 
Когда Семинар завершён, мы можем установить больше настроек, относящихся к 

отправке готовых ответов. Это осуществляется путём щелчка по меню, подсвеченному 

ниже, которое появится, когда вы щёлкнете по ссылке на Семинар или после щелчка по 

«Save and Display» по завершению Семинара. Чтобы попасть в это меню, просто щёлкните 

по «Allocate Submissions». Оно подсвечивается красным окошком. 

 

Снимок с экрана «Настройки отправки готового ответа для распределения 

рецензентам готовых ответов». 

Снимок с экрана «Меню распределения вручную». 

Снимок с экрана «Меню распределение случайным образом». 

Распределение вручную 
Здесь Преподаватель может вручную определить, какие Студенты рецензируют 

чьи работы. Студент может рецензировать работы, даже если он не отправил своего 

готового ответа. 

Распределение случайным образом 
Преподавателю предоставляется 5 настроек, которые определяют, как будет 

работать случайное распределение. 

Число рецензий: Здесь Преподаватель выбирает от 0 до 30 работ для рецензирования 

либо по отдельности, либо в совокупности на каждого рецензента. Т.е. Преподаватель 

может выбрать, либо сколько Студентов должны дать рецензии на один отчёт, либо 

сколько рецензий должен подготовить каждый Студент. 

Воспрепятствовать обзорам: Если Преподаватель желает, чтобы Студенты одной и той 

же Группы не рецензировали работы друг друга (что весьма вероятно, если их работы 

входят в единый групповой ответ), то он может отметить «галочкой» это окошко, и 

Moodle обеспечит, чтобы в данной Группе для взаимного оценивания распределялись 

только работы Студентов из других Групп. 

Устранить текущие распределения: Отметка этого окошка «галочкой» означает, что 

любые распределения, установленные в меню Распределение Вручную, будут 

отменены. 

Возможен доступ без отправки готового ответа: Наличие «галочки» в этом окошке, 

разрешает Студенту оценивать работы других Студентов без предоставления  

собственного готового ответа. 

Добавить самооценивание: Когда эти опции помечены «галочкой», они обеспечивают, 

чтобы наряду с оцениванием работ других Студентов была также оценена своя 

собственная. Эта опция хороша, чтобы научить Студентов быть объективным к своей 

собственной работе. 

http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/File:submission_advanced.jpg
http://docs.moodle.org/25/en/File:submission_advanced.jpg
http://docs.moodle.org/25/en/File:Manual_allocate.jpg
http://docs.moodle.org/25/en/File:Random_allocate.jpg
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4.3.14.2.13.Assessment phase 
Examples: 

Students can assess example submissions for practice before assessing 

their peers' work if this feature is enabled. They can compare their 

assessments with reference assessments made by the teacher. The grade 

will not be counted in the grade for assessment. 

Teachers need to upload one or more example submissions and the 

corresponding reference assessment to support this function. 

Teachers can also edit the reference assessment later by clicking the ‘re-

assess’ button in the first page. 

Peer assessment: 
If this feature is enabled, a student will be allocated a certain amount of 

submissions from his peers to assess. He will receive a grade for each 

assessment, which will be added together with the grade for his own 

submission and this will be used as his final grade for this assignment. 

This is the key feature of workshop: To encourage students to assess the 

work of their peers and learn from each other. Through this, they will see 

the strengths of their classmates’ submissions and have a better 

understanding about how to do a good job. In addition, the advices they get 

from their peers will give them a more comprehensive view of their own 

work: The comments from their peers will point out the weakness of their 

work, which is generally difficult to find out by themselves. 

Self-assessment: 
If this option is turned on, a student may be allocated his own work to 

assess. The grade he receives from assessment of his own work will be 

counted into the grade for assessment, which will be added together with 

the grade for submission and used to calculate his final grade for this 

assignment. 

This setting enables teachers to see whether students can find out the 

strength and weakness of their own submissions and judge them 

objectively. It is a good way to help students think more comprehensively. 

4.3.14.2.14.Grading evaluation phase 
Grading evaluation settings 
Screenshot «Grading evaluation settings». 

Here you can choose your settings for calculation of the grade for 

assessments. 

Grade calculation method 
This setting determines how to calculate grade for assessments. Currently 

there is only one option - comparison with the best assessment. 

4.3.14.2.13.Фаза оценивания 
Примеры: 

Если опция «Примеры» включена, Студенты могут оценить примеры оценённых 

готовых ответов для практики перед оцениванием работы их сокурсников. Они могут 

сравнить свои оценки со сделанными Преподавателем. Эта оценка не будет включена в 

Оценку за оценивания. 

Чтобы поддержать эту функцию, Преподавателям нужно переслать один или 

больше примеров готовых ответов вместе с выданными им Оценками. 

Преподаватели также могут отредактировать выданные раньше Оценки щелчком 

по кнопке «re-assess (переоценить)» на первой странице. 

Взаимное оценивание: 

Если это средство разрешено, Студенту будет предложено оценить определённое 

количество готовых ответов его сокурсников. Он получит Оценку за каждое своё 

оценивание, и это будет объединено с Оценкой его собственного готового ответа, и всё это 

вместе будет использовано для подведения Итоговой Оценки для его Задания. 

Это ключевая особенность Семинара: стимулирование Студентов оценивать 

работы их сокурсников и учиться друг у друга. Посредством этого они увидят сильные 

стороны готовых ответов их сокурсников, и лучше поймут, как делать хорошую работу. 

Кроме того, советы, которые они получат от своих сокурсников, дадут им гораздо более 

разносторонний взгляд на их собственную работу. Комментарии от их сокурсников 

укажут на слабые места их работы, которые обычно трудно обнаружить у себя самому. 

 

Самооценивание: 

Если эта опция включена, Студенту будет предложено оценить его собственную 

работу. Оценка, которую он получит за оценивание его собственной работы, будет 

включена в его Оценку за оценивание работ сокурсников, которая, в свою очередь, будет 

включена в Оценку за его готовый ответ и использована для вычисления Итоговой Оценки 

за его задание в целом. 

Эта настройка разрешает Преподавателям увидеть, способны ли Студенты найти 

сильные и слабые стороны их собственных готовых ответов, и судить о них объективно. 

Это хороший способ помочь Студентам думать более разностороннее. 

4.3.14.2.14.Фаза определения стоимости оценивания 
Настройки определения стоимости оценивания  

Снимок с экрана «Настройки определения стоимости оценивания». 

Здесь можно выбрать настройки для вычисления Оценки за оценивания. 

 

Метод вычисления Оценки 
Эта настройка определяет, как вычислять оценку за оценивания. В настоящее 

время существует только одна опция «Comparison with the best assessment (сравнение с 

http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/File:gradingevaluation25.png
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The Comparison with the best assessment tries to imagine what a 

hypothetical absolutely fair assessment would look like. 

For example, a teacher uses Number of errors as grading strategy to peer-

assess one assignment. This strategy uses a couple of assertions and 

assessors just need to check if the given assertion is passed or failed. That 

is, they only need to choose ‘yes’ or ‘no’ for each criterion in the 

assessment form. In this case, there are three assessors, Alice, Bob and 

Cindy. And the assessment form contains three criteria. The author will get 

100% grade if all the criteria are passed, 75% if two criteria are passed, 

25% if only one criterion is passed and 0% if the assessor gives ‘no’ for all 

three assertions. Here are the assessments they give to one certain work: 

Alice: yes/yes/no  

Bob: yes/yes/no  

Cindy: no/yes/yes 

Then the best assessment will be: 

Yes/yes/no 

Second, the workshop will give the best assessment 100% grade. Next it 

will measure the ‘distance’ from other assessments to this best assessment. 

The farther the distance, the lower grade the assessment will receive. 

And Comparison of assessments setting, next to the Grade evaluation 

setting, will determine how quickly the grade falls down if the assessment 

differs from the best one. 

Note: Comparison with the best assessment method will compare 

responses to each individual criterion instead of comparing the final 

grades. In the example above, all of the three assessors give 75% to the 

submission. However, only Alice and Bob will get 100% grade for their 

assessments, while Cindy will get a lower grade. Because Alice and Bob 

agree in individual responses too, while the responses in Cindy’s 

assessment are different. 

Comparison of assessments: 
This setting has 5 options: very lax, lax, fair, strict and very strict. It 

specifies how strict the comparison of assessment should be. By 

using comparison with the best assessment method, all assessments will be 

compared with the best assessment picked up by workshop. The more 

similar one assessment is with the best assessment, the higher grade this 

assessment will get, and vice versa. This setting determines how quickly 

the grades fall down when the assessments differ from the best assessment. 

Workshop toolbox 
Screenshot «Workshop toolbox». 

 

наилучшим оцениванием)». «Comparison with the best assessment» пытается представить, 

как могло бы выглядеть гипотетическое абсолютно справедливое оценивание. 

Например, Преподаватель использует «Number of errors (число ошибок)» в 

качестве стратегии оценивания сокурсниками одного задания. Эта стратегия использует 

пару высказываний, и Оценивающим просто нужно отметить «галочкой», верно или нет 

каждое из них. Т.е. им нужно только выбрать «Yes» или «No» для каждого критерия в 

Форме оценивания. Пусть в нашем случае имеется три Оценивающих: Алиса, Боб и 

Синди. И Форма оценивания имеет три критерия. Автор получит оценку 100%, если по 

всем трём критериям Оценивающие посчитают задание выполненным, 75% – если по двум 

критериям, 25% – если по одному критерию, и 0% – если ни по одному. Здесь приведены 

оценивания данные ими по одной определённой работе: 

Алиса: Yes/Yes/No, 

Боб: Yes/Yes/No, 

Синди: No/Yes/Yes. 

В этом случае наилучшим оцениванием будет: 

 Yes/Yes/No 

Наш Семинар назначит наилучшему оцениванию 100%. Далее, Семинар будет 

измерять «дистанцию» других оцениваний до наилучшего. Чем больше дистанция, тем 

меньшую оценку получит оценивание. А настройка «Comparison of assessments 

(сопоставление оцениваний)», вслед за «Grade evaluation setting (настройка 

количественного оценивания оценки)», определит степень снижения Оценки за 

оценивание, отличающееся от наилучшего. 

Замечание: Метод сопоставления с наилучшим оцениванием (Comparison with the 

best assessment) сравнит ответы по каждому индивидуальному критерию вместо сравнения  

итоговых оценок. В примере выше каждый из трёх Оценивающих дал 75% готовому 

ответу. Однако только Алиса и Боб получат оценку 100% за их оценивание, в то время, как 

Синди получит оценку ниже. Потому что индивидуальные ответы Алисы и Боба 

совпадают, в то время как ответы в оценивании Синди отличаются. 

 

Сопоставление оцениваний: 

Эта настройка имеет 5 опций: очень неточно, неточно, хорошо, точно, очень 

точно. Она указывает, как оценивается точность оцениваний. Путём использования 

метода сопоставления с наилучшим оцениванием, все оценивания будут сопоставляться с 

наилучшим оцениванием, выбранным Семинаром. Чем больше оценивание похоже на 

наилучшее, тем более высокую оценку оно получит, и наоборот. Эта настройка 

определяет степень снижения Оценки за оценивания, отличающиеся от наилучшего. 

 

Инструментарий Семинара 
Снимок с экрана «Workshop toolbox». 

http://docs.moodle.org/25/en/File:Workshop_toolbox.png.
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Clear all aggregated grades 
Clicking this button will reset aggregated grades for submission and grades 

for assessment. Teachers can re-calculate these grades from scratch in 

Grade evaluation phase. 

Clear assessments 
By clicking this button, grades for assessments along with grades for 

submission will be reset. The assessment form will remain the same but all 

the reviewers need to open the assessment form again and re-save it to get 

the given grades calculated again. 

4.3.14.2.15.Site administration settings 
The workshop module has additional settings which may be changed by an 

administrator in 

Administration > Site administration > Plugins > Activity modules > 

Workshop. The settings enable default values to be set for all edit 

workshop settings. 

4.3.14.2.16.See also 
http://rubistar.4teachers.org/ - a free tool to help teachers create rubrics. 

4.3.14.3.Using Workshop 
4.3.14.3.1.Workshop phases 
The work flow for the Workshop module can be viewed as having five 

phases. The typical workshop activity can cover days or even weeks. The 

teacher switches the activity from one phase to another. 

 

The typical workshop follows a straight path from Setup to, Submission, 

Assessment, Grading/Evaluation, and ending with the Closed phased. 

However, an advanced recursive path is also possible. 

The progress of the activity is visualized in so called Workshop planner 

tool. It displays all Workshop phases and highlights the current one. It also 

lists all the tasks the user has in the current phase with the information of 

whether the task is finished or not yet finished or even failed. 

Setup phase 
In this initial phase, Workshop participants cannot do anything (neither 

modify their submissions nor their assessments). Course facilitators use 

this phase to change workshop settings, modify the grading strategy of 

tweak assessment forms. You can switch to this phase any time you need 

to change the Workshop setting and prevent users from modifying their 

work. 

 

 

Очистка всех агрегированных оценок 
Щелчок по этой кнопке сбросит оценки за готовый ответ и оценки за оценивание. 

Преподаватели могут вычислить их оценки заново, начиная с Фазы количественного 

оценивания оценки. 

Очистка оцениваний 
Щелчком по этой кнопке сбрасываются оценки за оценивания наряду с оценками за 

готовые ответы. Форма оценивания остаётся той же самой, но всем Оценивающим 

потребуется открыть эту Форму оценивания снова, и повторно сохранить её, чтобы 

данные оценки вычислить снова. 

4.3.14.2.15.Настройки управления Сайта 
Модуль «Семинар» имеет дополнительные настройки, которые может изменить 

Администратор в 

AdministrationSite administrationPluginsActivity modulesWorkshop. Значения 

разрешённых по умолчанию настроек будут установлены для всех редактирований 

Семинара. 

4.3.14.2.16.См. также 
Бесплатный инструмент в помощь Преподавателям, создающим Рубрики. 

4.3.14.3.Использование Семинара 
4.3.14.3.1.Фазы Семинара 

Последовательность работ модуля «Семинар» может рассматриваться как 

состоящая из пяти фаз. Типичное Интерактивное Действие «Семинар» может 

продолжаться дни и даже недели. Преподаватель переключает это 

Интерактивное Действие с одной фазы на другую. 

Типичный Семинар следует по прямому пути, от Установки к Готовому ответу к 

Оцениванию, Качественное/Количественное оценивание, и заканчивается Постепенным 

закрытием. Однако, возможен и продвинутый рекурсивный путь с возвратами. 

Ход Семинара визуализируется так называемым Дизайнером Семинара. Он 

отображает все фазы Семинара и подсвечивает текущую. Он также перечисляет все задачи 

пользователя в текущей фазе, с информацией о том, завершена данная задача или пока нет, 

или её выполнение вообще ещё не начиналось. 

Фаза установки 
В этой начальной фазе участники Семинара не могут ничего делать (ни 

модифицировать их готовые ответы, ни их оценивание). Кураторы Курса используют эту 

фазу, чтобы изменить настройки Семинара, модифицировать стратегию оценивания в 

настраиваемых формах оценивания. Вы можете переключиться в эту фазу в любое время, 

когда вам требуется изменить настройку Семинара и не дать пользователям 

модифицировать их работу. 

http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Using_Workshop
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#General
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://docs.moodle.org/25/en/Workshop_settings#Feedback
http://rubistar.4teachers.org/
http://docs.moodle.org/25/en/Using_Workshop
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Submission phase 
In the submission phase, Workshop participants submit their work. Access 

control dates can be set so that even if the Workshop is in this phase, 

submitting is restricted to the given time frame only. Submission start date 

(and time), submission end date (and time) or both can be specified. 

 

Assessment phase 
If the Workshop uses peer assessment feature, this is the phase when 

Workshop participants assess the submissions allocated to them for the 

review. As in the submission phase, access can be controlled by specified 

date and time since when and/or until when the assessment is allowed. 

Grading evaluation phase 
The major task during this phase is to calculate the final grades for 

submissions and for assessments and provide feedback for authors and 

reviewers. Workshop participants cannot modify their submissions or their 

assessments in this phase any more. Course facilitators can manually 

override the calculated grades. Also, selected submissions can be set as 

published so they become available to all Workshop participants in the 

next phase. 

Closed 
Whenever the Workshop is being switched into this phase, the final grades 

calculated in the previous phase are pushed into the course Gradebook. 

This will result in the Workshop grades appearing in the Gradebook and in 

the workshop (new in Moodle 2.4 onwards). Participants may view their 

submissions, their submission assessments and eventually other published 

submissions in this phase. 

Screenshot «A closed workshop». 

4.3.14.3.2.Workshop grading 
The grades for a Workshop activity are obtained gradually at several stages 

and then they are finalized. The following scheme illustrates the process 

and also provides the information in what database tables the grade values 

are stored. 

Screenshot «The scheme of grades calculation in Workshop». 

As you can see, every participant gets two numerical grades into the course 

Gradebook. During the Grading evaluation phase, course facilitator can let 

Workshop module to calculate these final grades. Note that they are stored 

in Workshop module only until the activity is switched to the final 

(Closed) phase. Therefore it is pretty safe to play with grades unless you 

are happy with them and then close the Workshop and push the grades into 

the Gradebook. You can even switch the phase back, recalculate or 

Фаза готового ответа 
В фазе готового ответа участники Семинара отправляют готовый ответ на их 

работу. Даты управления доступом могут быть установлены так, чтобы даже если 

Семинар в этой фазе, отправка готового ответа ограничивается только по отношению к 

данному отрезку времени. Дата начата готового ответа (и время), дата окончания готового 

ответа (и время) или оба могут быть указаны.  

Фаза оценивания 
Если Семинар использует средство оценивания сокурсниками, это та фаза, когда 

участники Семинара получают доступ к распределённым им для рецензирования готовым 

ответам. В фазе готового ответа доступ может контролироваться указанием даты и 

времени, в пределах которых позволено оценивание. 

Фаза оценивания разными методами 
Главная задача в течение этой фазы – вычислить итоговые Оценки за готовые 

ответы и за оценивания, и обеспечить Обратную Связь между авторами и рецензентами. 

Участники Семинара в этой фазе уже не могут модифицировать их готовые ответы или их 

оценивания. Кураторы Курса могут вручную переоценить вычисленные оценки. Кроме 

того, выбранные готовые ответы могут быть опубликованы и доступны всем участникам 

Семинара в следующей фазе. 

 

Фаза закрытия 
Всякий раз, когда Семинар переключается в эту фазу, итоговые оценки, 

вычисленные в предыдущей фазе, передаются в Журнал Оценок Курса. Это приведёт к 

появлению оценок за этот Семинар в этом Журнале Оценок и в Семинаре (новое в Moodle 

2.4 и далее). Участники могут просмотреть их готовые ответы, их оценивания готовых 

ответов и, в конечном счёте, и другие опубликованные в этой фазе готовые ответы. 

 

Снимок с экрана «Закрытие Семинара». 

4.3.14.3.2.Оценивание Семинара 
Оценки для Интерактивного Действия «Семинар» формируются постепенно, в 

несколько стадий и затем объединяются в Итоговую Оценку. Следующая схема 

иллюстрирует этот процесс, а также предоставляет информацию из тех таблиц 

Базы Данных, в которых сохраняются значения Оценок. 

Снимок с экрана «Схема вычисления оценок на Семинаре». 

Как видите, каждый участник получает две числовых Оценки в Журнал Оценок 

Курса. Во время фазы Оценивания куратор Курса может с помощью модуля «Семинар» 

вычислить эти Итоговые Оценки. Заметьте, что они сохраняются в модуле «Семинар» 

только до тех пор, пока это Интерактивное Действие не переключится в финальную фазу 

Закрытия. Поэтому вполне безопасно играть с Оценками до тех пор, пока они вас не 

устроят, и только после этого закрыть Семинар и передать их в Журнал Оценок. Вы 

можете даже переключить фазу назад, повторно вычислить или 

http://docs.moodle.org/25/en/File:workshop_final_grades.png
http://docs.moodle.org/25/en/File:workshop_grades_calculation.png
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override the grades and close the Workshop again so the grades are 

updated in the Gradebook again (should be noted that you can override the 

grades in the Gradebook, too) 

During the grading evaluation, Workshop grades report provides you with 

a comprehensive overview of all individual grades. The report uses various 

symbols and syntax: 

Value Meaning 

- (-) < 

Alice 

There is an assessment allocated to be done by Alice, but it 

has been neither assessed nor evaluated yet 

68 (-) < 

Alice 

Alice assessed the submission, giving the grade for 

submission 68. The grade for assessment (grading grade) has 

not been evaluated yet. 

23 (-) > 

Bob 

Bob's submission was assessed by a peer, receiving the grade 

for submission 23. The grade for this assessment has not been 

evaluated yet. 

76 (12) < 

Cindy 

Cindy assessed the submission, giving the grade 76. The 

grade for this assessment has been evaluated 12. 

67 (8) @ 

4 < David 

David assessed the submission, giving the grade for 

submission 67, receiving the grade for this assessment 8. His 

assessment has weight 4 

80 

(20 /17) > 

Eve 

Eve's submission was assessed by a peer. Eve's submission 

received 80 and the grade for this assessment was calculated 

to 20. Teacher has overridden the grading grade to 17, 

probably with an explanation for the reviewer. 

Grade for submission 
The final grade for every submission is calculated as weighted mean of 

particular assessment grades given by all reviewers of this submission. The 

value is rounded to a number of decimal places set in the Workshop 

settings form. 

Course facilitator can influence the grade for a given submission in two 

ways: 

 by providing their own assessment, possibly with a higher weight than 

usual peer reviewers have 

 by overriding the grade to a fixed value 

 

отменить Оценки и закрыть Семинар снова, с обновлёнными Оценками в Журнале Оценок 

(нужно заметить, что вы также можете отменить Оценки в Журнале Оценок). 

 

Во время фазы Оценивания разными методами отчёт по Оценкам за Семинар 

предоставляет вам полный обзор всех индивидуальных Оценок. Этот отчёт использует 

различные символы и синтаксис: 

Обозначение Смысл 

- (-) < 

Алиса 

Оценивание, предложенное для выполнения Алисе, не было пока ещё 

оценено ни качественно, ни количественно 

68 (-) < 

Алиса 

Алиса оценила готовый ответ, дав ему оценку 68. Оценка за 

оценивание (качественная оценка по шкале) пока ещё не вычислена. 

 

23 (-) > 

Боб 

Готовый ответ Боба был оценён сокурсником, получив оценку 23. 

Оценка за это оценивание ещё не вычислена. 

 

76 (12) < 

Синди 

Синди оценила готовый ответ, дав ему оценку 76. Оценка за это 

оценивание вычислена и равна 12. 

67 (8) @ 4 < 

Давид 

Давид оценил готовый ответ, дав ему оценку 67, и сам получил оценку 

за это оценивание равную 8. Его оценивание имеет вес 4. 

 

80 (20 /17) > 

Ева 

Готовый ответ Евы был оценён сокурсником, получив оценку 80, и 

оценка за это 20. Преподаватель понизил оценку за качественное 

оценивание до 17, возможно, с объяснением для рецензента. 

Оценка за готовый ответ 
Итоговая Оценка за каждый готовый ответ вычисляется как взвешенное среднее 

конкретных Оценок за оценивание, данных всеми Оценивающими этот готовый ответ. 

Значение округлено до числа десятичных разрядов, установленного в форме настроек 

Семинара. 

Куратор Курса может повлиять на Оценку за данный готовый ответ двумя 

способами: 

 предоставив своё собственное оценивание, возможно, с большим весом, чем у 

остальных Оценивающих сокурсников, 

 заменив эту Оценку на исправленное значение. 
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Grade for assessment 
Grade for assessment tries to estimate the quality of assessments that the 

participant gave to the peers. This grade (also known as grading grade) is 

calculated by the artificial intelligence hidden within the Workshop 

module as it tries to do typical teacher's job. 

 

During the grading evaluation phase, you use a Workshop subplugin to 

calculate grades for assessment. At the moment, only one subplugin is 

available called Comparison with the best assessment. The following text 

describes the method used by this subplugin. Note that more grading 

evaluation subplugins can be developed as Workshop extensions. 

 

Grades for assessment are displayed in the braces () in the Workshop 

grades report. The final grade for assessment is calculated as the average of 

particular grading grades. 

There is not a single formula to describe the calculation. However the 

process is deterministic. Workshop picks one of the assessments as 

the best one - that is closest to the mean of all assessments - and gives it 

100% grade. Then it measures a 'distance' of all other assessments from 

this best one and gives them the lower grade, the more different they are 

from the best (given that the best one represents a consensus of the 

majority of assessors). The parameter of the calculation is how strict we 

should be, that is how quickly the grades fall down if they differ from the 

best one. 

To demonstrate it on example, let us say you use grading strategy Number 

of errors to peer-assess research essays. 

 

If there are just two assessments per submission, Workshop can not decide 

which of them is 'correct'. Imagine you have two reviewers - Alice and 

Bob. They both assess Cindy's submission. Alice says it is a rubbish and 

Bob says it is excellent. There is no way how to decide who is right. So 

Workshop simply says - ok, you both are right and I will give you both 

100% grade for this assessment. To prevent it, you have two options: 

Either you have to provide an additional assessment so the number of 

assessors (reviewers) is odd and workshop will be able to pick the best one. 

Typically, the teacher comes and provide their own assessment of the 

submission to judge it 

 

 

 

Оценка за оценивание 
Оценка за оценивание пытается количественно оценить качество оцениваний, 

которые участники дали сокурсникам. Эта Оценка (известная также как Оценка 

качественного оценивания по Шкалам) вычисляется средствами искусственного 

интеллекта, скрытого внутри модуля «Семинар», по мере того, как он пытается делать 

работу обычного Преподавателя. 

В течение фазы количественного оценивания качественных оцениваний, вы 

используете подплагин «Семинара» для вычисления Оценок за оценивание. В настоящее 

время доступен только один подПлагин, который называется «Сравнение с наилучшим 

оцениванием». Следующий текст описывает метод, используемый этим подПлагином. 

Заметьте, что дополнительные подПлагины, количественно Оценивающие качественные 

суждения могут быть созданы как расширения Семинара. 

Оценки для оценивания отображаются в круглых скобках в отчёте по Оценкам за 

Семинар. Итоговая Оценка за оценивание вычисляется как среднее Оценок за конкретные 

качественные оценивания. 

Нет единой формулы для описания вычисления. Однако этот процесс 

детерминистичен. Семинар выбирает одно из оцениваний как «лучшее» – это есть 

ближайшее к среднему всех Оценок – и даёт ему Оценку 100%. Далее он измеряет 

«дистанцию» разных оцениваний от наилучшего и даёт Оценки ниже тем, которые 

отличаются от него (предполагая, что лучшая является консенсусом большинства 

Оценивающих). Параметром вычисления является то, насколько точными мы должны 

быть, т.е. как быстро понижаются Оценки, если они отличаются от наилучшего 

оценивания. 

 

Чтобы продемонстрировать это на примере, давайте предложим вам использовать 

стратегию оценивания Number of errors, чтобы исследовать эссе оцениваний, проведённых 

сокурсниками. 

Если существует только два оценивания на один готовый ответ, Семинар не может 

решить, какой из них является «корректным». Представьте, вы имеете две рецензии – 

Алисы и Боба. Они оба оценивают готовый ответ Синди. Алиса говорит, что это никуда не 

годно, а Боб говорит – это отлично. Нет способа решить, кто из них прав. Подобным 

образом Семинар просто скажет – хорошо, вы оба правы, я вам дам обоим 100% Оценку за 

это оценивание. Чтобы предотвратить такую ситуацию, вы имеете две опции: 

Либо вы должны предоставить дополнительное оценивание, чтобы число 

Оценивающих (рецензентов) стало нечётным, и Семинар стал способен выбрать 

наилучшее. Обычно Преподаватель предоставляет своё оценивание этого готового ответа, 

чтобы разрулить ситуацию. 
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Or you may decide that you trust one of the reviewers more. For example 

you know that Alice is much better in assessing than Bob is. In that case, 

you can increase the weight of Alice's assessment, let us say to "2" (instead 

of default "1"). For the purposes of calculation, Alice's assessment will be 

considered as if there were two reviewers having the exactly same opinion 

and therefore it is likely to be picked as the best one. 

Backward compatibility note 
In Workshop 1.x this case of exactly two assessors with the same weight is 

not handled properly and leads to wrong results as only the one of them is 

lucky to get 100% and the second get lower grade. 

It's not final grades what is compared 
It is very important to know that the grading evaluation subplugin 

Comparison with the best assessment does not compare the final grades. 

Regardless the grading strategy used, every filled assessment form can be 

seen as n-dimensional vector of normalized values. So the subplugin 

compares responses to all assessment form dimensions (criteria, assertions, 

...). Then it calculates the distance of two assessments, using the variance 

statistics. 

It is strategy uses a simple list of assertions and the reviewer (assessor) just 

checks if the given assertion is passed or failed. Let us say you define the 

assessment form using three criteria: 

 Does the author state the goal of the research clearly? (yes/no) 

 Is the research methodology described? (yes/no) 

 Are references properly cited? (yes/no) 

Let us say the author gets 100% grade if all criteria are passed (that is 

answered "yes" by the assessor), 75% if only two criteria are passed, 25% 

if only one criterion is passed and 0% if the reviewer gives 'no' for all three 

statements. 

Now imagine the work by Daniel is assessed by three colleagues - Alice, 

Bob and Cindy. They all give individual responses to the criteria in order: 

Alice: yes / yes / no 

Bob: yes / yes / no 

Cindy: no / yes / yes 

As you can see, they all gave 75% grade to the submission. But Alice and 

Bob agree in individual responses, too, while the responses in Cindy's 

assessment are different. The evaluation method Comparison with the best 

assessment tries to imagine, how a hypothetical absolutely fair assessment 

would look like. In the Development:Workshop 2.0 specification, David 

refers to it as "how would Zeus assess this submission?" and we estimate it 

would be something like this (we have no other way): 

Или вы можете определить, из рецензентов более прав. Например, вы знаете, что 

Алиса намного лучше оценивает, чем Боб. В этом случае, вы можете увеличить вес 

Алисиного оценивания, скажем, пусть до 2 (вместо определённого по умолчанию 1). Для 

целей вычисления. Алисино оценивание будет рассматриваться, как если бы существовало 

два рецензента, имеющих одинаковое мнение, и, следовательно, оно пригодно стать 

наилучшим. 

Замечание о совместимости с предыдущими версиями 
В Семинаре версий 1.х этот вариант точно из двух Оценивающих с одинаковыми 

весами правильно не обрабатывался и приводил в неверным результатам, так как только 

один имел счастье получить 100%, а второй получал Оценку ниже. 

Это не окончательные оценки, с которыми сверяются 

Важно знать, какие количественно Оценки качественных оцениваний подПлагин 

Comparison with the best assessment не сверяет с окончательными оценками. Несмотря на 

используемую стратегию оценивания, каждая заполненная форма оценивания может 

рассматриваться как n-мерный вектор нормализованных значений. Так что подПлагин 

сравнивает ответы по всем измерениям формы оценивания (критериям, высказываниям, 

…). Затем он вычисляет дистанцию между двумя оцениваниями, используя исперсионную 

статистику. 

Эта стратегия использует простой список высказываний, а рецензент 

(Оценивающий) просто проверяет, верны они или нет. Давайте предложим вам определить 

форму оценивания, используя три критерия: 

 Указал ли автор цель исследования ясно? (да/нет) 

 Описана ли методология исследования? (да/нет) 

 Правильно ли процитированы ссылки? (да/нет) 

Давайте ставить автору 100% оценку, если все три критерия верны (т.е. 

Оценивающий ответил «да»), 75%, если верны только два критерия, и 0%, если рецензент 

дал «нет» за все три высказывания. 

 

Сейчас вообразим, что работа Даниэля оценена тремя коллегами: Алисой, Бобом и 

Синди. Все они дают индивидуальные ответы по каждому из критериев по порядку: 

Алиса:  да/да/нет 

Боб:  да/да/нет 

Синди: нет/да/да 

Как вы можете видеть, все они поставили оценку 75% за готовый ответ. Но ответы 

Алиса и Боба совпадают, в то время как ответы Синди отличаются. Метод 

количественного оценивания Comparison with the best assessment попытается вообразить, 

как бы выглядело гипотетическое абсолютно справедливое оценивание. В спецификации 

Семинара версии 2.0 Давид говорит об этом, как «Как бы Зевс оценил этот готовый 

ответ?», и мы оцениваем это предположительно таким образом (мы не имеем другого 

способа): 

http://docs.moodle.org/25/en/Development:Workshop_2.0_specification
http://docs.moodle.org/dev/Workshop_2.0_specification
http://docs.moodle.org/dev/Workshop_2.0_specification
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Zeus 66% yes / 100% yes / 33% yes 

Then we try to find those assessments that are closest to this theoretically 

objective assessment. We realize that Alice and Bob are the best ones and 

give 100% grade for assessment to them. Then we calculate how much far 

Cindy's assessment is from the best one. As you can see, Cindy's response 

matches the best one in only one criterion of the three so Cindy's grade for 

assessment will not be as high. 

The same logic applies to all other grading strategies, adequately. The 

conclusion is that the grade given by the best assessor does not need to be 

the one closest to the average as the assessment are compared at the level 

of individual responses, not the final grades. 

4.3.14.3.3.Groups and Workshop 
When a workshop is used in a course using separate or visible groups and 

groupings, it is possible to filter by group in a drop-down menu at the 

Assessment phase, manual allocation page, grades report and so on. 

Screenshot «Group filtering drop down». 

4.3.14.3.4.See also 
 Research paper Moodle Workshop activities support peer review in 

Year 1 Science: present and future by Julian M Cox, John Paul Posada 

and Russell Waldron 

 Using Moodle Workshop module forum 

 Using Moodle forum discussion [1] where David explains a particular 

Workshop results 

 Moodle Workshop 2.0 - a (simplified) explanation presentation by 

Mark Drechsler 

 Development:Workshop for more information on the module 

infrastructure and ways how to extend provided functionality by 

developing own Workshop subplugins 

 

 

 

 

 

 

 

 

 

 

 

Зевс: 66% да / 100% да / 33% да 

Затем мы постараемся найти оценивания, которые ближе к этому теоретически 

объективному оцениванию. Мы понимаем, что Алиса и Боб лучшие и даём 100% Оценку 

за их оценивания. Затем мы вычисляем, насколько далеко оценивание Синди от 

наилучшего. Как вы можете видеть, ответ Синди соответствует наилучшему только по 

одному критерию из трёх, так что Оценка Синди за оценивание не будет так высока. 

 

Такая же логика применяется и к другим стратегиям оценивания адекватно. В 

заключение можно сказать, что Оценка, данная наилучшим Оценивающим, не обязана 

быть близка к средней Оценке, так как это оценивание сравнивается на уровне 

индивидуальных ответов, а не итоговых оценок. 

4.3.14.3.3.Группы и Семинар 
Когда Семинар применяется в Курсе, использующем обособленные или видимые группы и 

группировки, возможна фильтрация по группам в ниспадающем меню на фазе 

Оценивания, странице распределения вручную, отчёте по оценкам и т.д. 

Снимок с экрана «Ниспадающий список фильтрации по группам». 

4.3.14.3.4.См. также 
 Научно-исследовательская статья «ИнтерактивныеДействия «Семинар» в Moodle 

поддерживают взаимное рецензирование сокурсников на 1 году обучения», написанная 

Джулианом М. Коксом, Паулем Посадой и Раселом Волдроном. 

 Использование Moodle, форум по модулю «Семинар». 

 Использование Moodle, обсуждения форума, где Дэвид объясняет результаты 

конкретного Семинара. 

 Презентация Марка Дречслера «Семинар Moodle 2.0 – упрощённое объяснение». 

 

 «Развитие Семинара» – дополнительная информация по инфраструктуре модуля и 

способах расширения функциональности путём создания собственных подплагинов 

Семинар. 

http://www.ascilite.org.au/conferences/wellington12/2012/images/custom/cox,_julian_moodle.pdf
http://moodle.org/mod/forum/view.php?id=740
http://moodle.org/mod/forum/discuss.php?d=153268
http://www.slideshare.net/mark.drechsler/moodle-workshop-20-a-simplified-explanation
http://docs.moodle.org/25/en/Development:Workshop
http://docs.moodle.org/25/en/File:workshopdropdown.png
http://www.ascilite.org.au/conferences/wellington12/2012/images/custom/cox,_julian_moodle.pdfhttp:/www.ascilite.org.au/conferences/wellington12/2012/images/custom/cox,_julian_moodle.pdf
http://www.ascilite.org.au/conferences/wellington12/2012/images/custom/cox,_julian_moodle.pdfhttp:/www.ascilite.org.au/conferences/wellington12/2012/images/custom/cox,_julian_moodle.pdf
https://moodle.org/login/index.php
https://moodle.org/mod/forum/discuss.php?d=153268
http://www.slideshare.net/mark.drechsler/moodle-workshop-20-a-simplified-explanation
http://docs.moodle.org/dev/Workshop_2.0_specification
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4.3.14.4.Grading strategies 
Simply said, selected grading strategy determines how the assessment form 

may look like and how the grade for a submission given by a certain 

assessment is calculated based on the assessment form. Workshop ships 

with four standard grading strategies. More strategies can be developed as 

pluggable extensions. 

4.3.14.4.1.Accumulative grading strategy 
In this case, the assessment form consists of a set of criteria. Each criterion 

is graded separately using either a number grade (eg out of 100) or a scale 

(using either one of site-wide scale or a scale defined in a course). Each 

criterion can have its weight set. Reviewers can put comments to all 

assessed criteria. 

When calculating the total grade for the submission, the grades for 

particular criteria are firstly normalized to a range from 0% to 100%. Then 

the total grade by a given assessment is calculated as weighted mean of 

normalized grades. Scales are considered as grades from 0 to M-1, where 

M is the number of scale items. 

 

where  is the grade given to the i-th criterion,  is 

the maximal possible grade of the i-th criterion,  is the weight of 

the i-th criterion and  is the number of criteria in the assessment 

form. 

It is important to realize that the influence of a particular criterion is 

determined by its weight only, not the grade type or range used. Let us 

have three criteria in the form, first using 0-100 grade, the second 0-20 

grade and the third using a three items scale. If they all have the same 

weight, then giving grade 50 in the first criteria has the same impact as 

giving grade 10 for the second criteria. 

Take the case above as an example. Suppose that the third criterion 

uses scale: 6 levels. An assessor gives grade 90 for the first criterion (or 

aspect 1), grade 16 for the second criterion and grade 9 very good for the 

last criterion. And the weights of the three criteria are 1, 2, and 3, 

respectively. Because for the third criterion, the scale has 6 items and grade 

9 very good is the second one of the grade sequence ordered from highest 

to lowest, grade 9 will be mapped to 4. That is, in the formula above, g3 = 

4 and max3 = 5. 

4.3.14.4.Стратегии оценивания 
Проще говоря, выбранная стратегия оценивания определяет, как может выглядеть 

Форма Оценивания и как Оценка за готовый ответ, данная определённым оцениванием, 

вычисляется на базе Формы Оценивания. «Семинар» поставляется с четырьмя 

стандартными стратегиями оценивания. Дополнительные стратегии могут быть 

созданы как встраиваемые расширения. 

4.3.14.4.1.Стратегия накапливающегося оценивания 
В этом случае Форма Оценивания состоит из набора Критериев. Каждый Критерий 

оценивается отдельно, с использованием либо Числовой Оценки (например, из 100), или 

Шкалы (применяя Шкалу, установленную либо для всего Сайта, либо для Курса). Каждый 

Критерий может иметь свой установленный Вес. Рецензенты могут поместить 

Комментарии по всем оцениваемым Критериям. 

При вычислении Суммарной Оценки для готового ответа, Оценки по конкретным 

Критериям сначала нормализуются в области значений от 0% до 100%. Затем данным 

оцениванием вычисляется Суммарная Оценка как 

Взвешенное Среднее Нормализованных Оценок. Шкалы рассматриваются как Оценки 

от 0 до М-1, где М – число элементов Шкалы. 

 

где  является оценкой данной по i-му критерию.  – максимально 

возможная оценка по i-му критерию,  – вес i-го критерия и  – число 

критериев в данной форме оценивания. 

 

 

Важно понимать, что влияние конкретного Критерия определяется только его 

Весом, а не типом Оценки или используемой областью значений. 

Пусть в нашей форме имеется три Критерия, первый использует Оценки 0-100, 

второй – 0-20, а третий использует трёхэлементную Шкалу. Если они все имеют 

одинаковый Вес, тогда оценка 50 по первому критерию имеет тот же эффект, что и оценка 

10 по второму Критерию. 

Примем этот вариант в качестве примера. Предположим, что третий Критерий 

имеет 6-уровневую шкалу. Оценивающий даёт 90 по первому Критерию (или аспекту 1), 

оценку 16 по второму критерию и оценку 9 (очень хорошо) по последнему критерию. И 

Веса этих трёх Критериев равны соответственно 1, 2 и 3. Из-за того, что для третьего 

Критерия Шкала имеет 6 элементов (отлично=5, очень хорошо=4, хорошо=3, 

удовлетворительно=2, плохо=1, очень плохо=0) и оценка 9 (очень хорошо) является 

вторым элементом из последовательности Оценок, упорядоченных от высшей к низшей, 

Оценка 9 будет соответствовать 4. Т.е. в формуле выше g3 = 4 и max3 = 5. Тогда 

http://docs.moodle.org/25/en/Workshop_grading_strategies
http://docs.moodle.org/25/en/Workshop_grading_strategies
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Then the final grade given by this assessment will be: 

 

 

4.3.14.4.2.Comments 
The assessment form is similar to the one used in accumulative grading 

strategy but no grades can be given, just comments. The total grade for the 

assessed submission is always set to 100%. This strategy can be effective 

in repetitive workflows when the submissions are firstly just commented 

by reviewers to provide initial feedback to the authors. Then Workshop is 

switched back to the submission phase and the authors can improve it 

according the comments. Then the grading strategy can be changed to 

another one using proper grading and submissions are assessed again using 

a different assessment form. 

4.3.14.4.3.Number of errors 
In Moodle 1.x, this was called Error banded strategy. The assessment form 

consists of several assertions, each of them can be marked as passed or 

failed by the reviewer. Various words can be set to express the pass or 

failure state - eg Yes/No, Present/Missing, Good/Poor, etc. 

The grade given by a particular assessment is calculated from the weighted 

count of negative assessment responses (failed assertions). Here, the 

weighted count means that a response with weight w_i is counted w_i-

times. Course facilitators define a mapping table that converts the number 

of failed assertions to a percent grade for the given submission. Zero failed 

assertion is always mapped to 100% grade. 

This strategy may be used to make sure that certain criteria were addressed 

in the submission. Examples of such assessment assertions are: Has less 

than 3 spelling errors, Has no formatting issues, Has creative ideas, Meets 

length requirements etc. This assessment method is considered as easier for 

reviewers to understand and deal with. Therefore it is suitable even for 

younger participants or those just starting with peer assessment, while still 

producing quite objective results. 

 

Screenshot «Assessment form using Number of Errors». 

You can edit the original assessment form by following the steps below: 

 

1. Write down the corresponding description for each assertion in the 

blank. Then fill in the blanks of word for the error and word for the. 

Итоговая Оценка, данная этим оцениваем, будет 

 

4.3.14.4.2.Комментарии 
Эта форма оценивания похожа на форму, используемую в стратегии 

накапливающегося оценивания, но не даёт Оценок, только комментарии. Итоговая оценка 

для оцениваемого готового ответа всегда устанавливается в 100%. Эта стратегия может 

быть эффективна для повторяющихся действий в работе, когда готовые ответы сначала 

только комментируются рецензентами, чтобы обеспечить первоначальную 

Обратную Связь с авторами. Затем Семинар переключается обратно на фазу Готового 

ответа, и авторы могут улучшить его с учётом комментариев. Затем данная стратегия 

оценивания может быть заменена на другую, использующую нужные Оценки, и готовые 

ответы оцениваются снова с использованием другой формы оценивания. 

 

4.3.14.4.3.Число ошибок 
В Moodle 1.x это называлось Стратегией объединения ошибок. Форма оценивания 

состоит из нескольких высказываний, каждое из них может быть помечено рецензентом 

как верное или неверное. Для того, чтобы выразить верно или неверно, могут быть взяты 

различные слова, например, Да/Нет, Предъявлен/Отсутствует, Хорошо/Плохо и т.д. 

Оценка, даваемая конкретным оцениванием, вычисляется взвешенным подсчётом 

отрицательных ответов (ошибочных высказываний). Здесь взвешенный подсчёт означает, 

что ответ с весом w_i подсчитывается w_i раз. Кураторы Курсов определяют таблицу 

соответствия, которая конвертирует число ошибочных высказываний в процентную 

Оценку для данного готового ответа. Высказывание с нулём ошибок всегда соответствует 

100% оценке. 

Эта стратегия может быть использована, чтобы убедиться, что определённые 

критерии были применены для данного готового ответа. Примерами высказываний такого 

оценивания являются: Имеет меньше 3 орфографических ошибок, Не имеет проблем 

форматирования, Имеет творческие идеи, Соответствует требованиям длины, и т.д. Этот 

метод оценивания считается самым лёгким для понимания и использования рецензентами. 

Следовательно, он подходит даже для самых младших участников или тех, кто только что 

столкнулся с оцениванием сокурсниками друг друга, и в то же время даёт достаточно 

объективные результаты. 

Снимок с экрана «Форма оценивания, использующая Число ошибок». 

Вы можете отредактировать первоначальную форму оценивания, следуя шагам, 

перечисленным ниже: 

1. Запишите соответствующее описание для каждого высказывания на бланке. Затем 

заполните пустые поля для слов, выражающих  ошибочность или правильность 

http://docs.moodle.org/25/en/File:Accumulative_formula.png
http://docs.moodle.org/25/en/File:Accumulative_formula.png
http://docs.moodle.org/25/en/File:Numoferror_assessment_form.png
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Success. Set the weight for each assertion. As you can see, the grade 

mapping table is still blank now. 

2. Click the ‘save and close’ button at the end of this page. 

3. Click the ‘Edit assessment form’ link at the shade area titled setup 

phase in the upper part of this page and view the assessment form again. 

At this time, you can see that the grade mapping table has already been 

set. (Note: Initially all the field are blank. You need to choose the right 

value from each list to make this grading strategy work properly.) 

 

Screenshot «Grade mapping table». 

For example, if an assessment form contains three assertions: 

 

 

 

 

 

In the example above, suppose that a reviewer gives one certain work 

Yes/Miss/Yes as the assessment. Since the submission only fails to meet 

the second criterion and the weight of the second criterion is 2, the total 

number of errors will be 2. Thus the grade for submission given by this 

assessment is 66%. Suppose that the maximum grade for submission set in 

grade settings is 100, therefore the final grade for this submission given by 

this assessment is grade 66. 

4.3.14.4.4.Rubric 
See the description of this scoring tool at Wikipedia. The rubric assessment 

form consists of a set of criteria. For each criterion, several ordered 

descriptive levels is provided. A number grade is assigned to each of these 

levels. The reviewer chooses which level answers/describes the given 

criterion best. 

The final grade is aggregated as 

 
where  is the grade given to the i-th criterion,  is the 

minimal possible grade of the i-th criterion,  is the maximal 

possible grade of the i-th criterion and is the number of criteria in 

the rubric. 

Screenshot «Assessment form in grid mode». 

Example of a single criterion can be: Overall quality of the paper with the 

levels 5 - An excellent paper, 3 - A mediocre paper, 0 - A weak paper 

высказывания. Установите веса для каждого высказывания. Как видите, таблица 

отображения оценок пока пуста. 

2. Щёлкните кнопку «Save and close (сохранить и закрыть)» в конце этой страницы. 

3. Щёлкните ссылку «Edit assessment form (редактировать форму оценивания)» в 

затенённой области, озаглавленной «фаза Установки» в верхней части этой страницы, и 

просмотрите форму оценивания снова. Теперь вы можете увидеть, таблица 

отображения оценок уже установлена. (Замечание: Первоначально все поля пусты. Вам 

необходимо выбрать правильное значение из каждого списка, чтобы эта стратегия 

сработала правильно). 

Снимок с экрана «Таблица соответствия оценок». 

Например, если форма оценивания содержит три высказывания: 

П

редполо

жим, 

что в 

примере 

выше рецензент даёт одной определённой работе  оценки Да/Нет/Да. Поскольку этот 

готовый ответ не проходит только по критерию 2, который имеет вес 2, суммарным 

числом ошибок будет 2. Таким образом, Оценка для готового ответа, данная этим 

оцениванием, будет равна 66%. Предположим, что максимальная Оценка для готового 

ответа, установленная в настройках Оценки равна 100, следовательно, Итоговая Оценка 

для этого готового ответа, данная этим оцениванием, есть Оценка 66. 

4.3.14.4.4.Рубрика 
См. описание этого инструмента оценивания в Википедии. Форма оценивания 

Рубрика состоит из набора Критериев. Для каждого Критерия предоставляется несколько 

упорядоченных Уровней Описания. Каждому из этих уровней назначается числовая 

Оценка. Рецензенты выбирают, какой Уровень отвечает/описывает этот Критерий лучше. 

 

Итоговая Оценка вычисляется как 

 
где  – оценка, данная по i-му критерию,  – минимально возможная 

оценка по i-му критерию,  – максимально возможная Оценка по i-му критерию 

и  – число критериев в Рубрике. 

Снимок с экрана «Форма оценивания в виде таблицы». 

Примером единственного критерия может быть: Общее качество отчёта со следующими 

уровнями: 5 – отличный отчёт, 3 – посредственный отчёт, 0 – слабый отчёт(the number 

represent the grade). There are two modes how the assessment form can be rendered - either in 

common grid form or in a list form. It is safe to switch the representation of the rubric any time. 

# Content Pass or failure state Weight 

1 Has the suitable title Yes/No 1 

2 Has creative ideas Present/Miss 2 

3 The abstract is well-written Yes/No 3 

№ Высказывание Верно/неверно Вес 

1 Имеет подходящий заголовок Да/Нет 1 

2 Имеет творческие идеи Принять/Пропустить 2 

3 Аннотация написана хорошо Да/Нет 3 

http://en.wikipedia.org/wiki/Rubric_(academic)
http://docs.moodle.org/25/en/File:Numberoferrors_grade_mapping_table.png
http://en.wikipedia.org/wiki/Rubric_(academic)
http://docs.moodle.org/25/en/File:Rubric_assessmentform_grid.png
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Screenshot «Assessment form in list mode». 

Example of calculation: let us have a rubric with two criteria, which both 

have four levels 1, 2, 3, 4. The reviewer chooses level with the grade 2 for 

the first criterion and the grade 3 for the second criterion. Then the final 

grade is: 

 
Note that this calculation may be different from how you intuitively use 

rubric. For example, when the reviewer in the previous example chose both 

levels with the grade 1, the plain sum would be 2 points. But that is 

actually the lowest possible score so it maps to the grade 0. To avoid 

confusion, it is recommended to always include a level with the grade 0 in 

the rubric definition. 

4.3.14.5.Workshop FAQ 
4.3.14.5.1.How can I get the workshop to switch 
phase automatically? 
In Settings > Workshop Administration > Edit settings tick the box 'Switch 

to the next phase after the submissions deadline' in the access control 

section. The workshop will then automatically switch to the assessment 

phase - after the next time cron is run on your Moodle. (Depending on your 

Moodle administration, you might be able to run it manually by typing into 

your browser YOURMOODLE.com/admin/cron.php (where 

YOURMOODLE.com is the name of your Moodle site). 

 

4.3.14.5.2.How can I make reviewing anonymous? 
If you do not want your students to know whose work they are reviewing 

and who is reviewing their work, go to Settings>Workshop 

administration>Permissions and click the X next to student to prevent 

"view author names" mod/workshop:viewauthornames and "view reviewer 

names" mod/workshop:viewreviewernames 

 

4.3.14.5.3. Can I use Workshop for students to 
peer assess an offline activity? 
You can, although they will have to submit something, even though that 

might be a blank document. See this forum post for more information: 

https://moodle.org/mod/forum/discuss.php?d=220054#p958145 

(число представляет оценку). Существует два вида представления 

формы оценивания: либо в виде матрицы Оценок, либо в форме 

списка. Переключение представления Рубрики безопасно в любое время. 

Снимок с экрана «Форма оценивания в виде списка». 

Пример вычисления. Пусть наша Рубрика имеет два критерия, каждый с четырьмя 

уровнями 1, 2, 3, 4. Рецензент выбирает уровень с Оценкой 2 по первому критерию и 

Оценку 3 по второму критерию. Тогда Итоговая Оценка будет: 

 

 
Заметьте, что это вычисление может отличаться от того, как вы интуитивно 

используете Рубрику. Например, когда рецензент в предыдущем примере выбирает оба 

Уровня с оценкой 1, простая сумма будет 2 балла. Но, на самом деле, это самый низкий 

возможный балл, так что он соответствует оценке 0. Чтобы избежать путаницы, 

рекомендуется всегда включать уровень с оценкой 0 в определение Рубрики. 

 

4.3.14.5.Часто задаваемые вопросы по Семинару 
4.3.14.5.1.Как автоматически переключать фазы Семинара? 
 

В AdministrationWorkshop AdministrationEdit settings пометьте «галочкой» 

окошко «Switch to the next phase after the submissions deadline (Переключить к следующей 

фазе после окончания срока Готовых ответов)» в разделе управления доступом. После 

этого Семинар будет автоматически переключён в фазу Оценивания – после истечения 

времени запуска следующего хрона в Moodle. (В зависимости от администрации вашей 

Moodle, вы можете быть способны запускать это вручную, набрав в вашем браузере 

YOURMOODLE.com/admin/cron.php, (где YOURMOODLE.com – имя Сайта вашей 

Moodle.)) 

4.3.14.5.2.Как сделать рецензирование анонимным? 
Если вы не хотите, чтобы ваши Студенты знали, чьи работы они рецензируют и 

кто рецензирует их работу, перейдите к 

AdministrationWorkshop AdministrationPermissions, и щёлкните х рядом со Студентом, 

чтобы не позволить «View author names (просмотреть имена авторов)» – 

mod/workshop:viewauthornames и чтобы не позволить «View reviewer names (просмотреть 

имена рецензентов)» – mod/workshop:viewreviewernames. 

4.3.14.5.3.Можно ли использовать Семинар, чтобы Студенты 
оценивали работы друг друга в режиме офлайн? 

Можете, хотя они будут должны отправлять что-то в качестве готовых ответов, 

даже если это будет пустой документ. См. сообщения. 

http://docs.moodle.org/25/en/Workshop_module_FAQ
https://moodle.org/mod/forum/discuss.php?d=220054#p958145
http://docs.moodle.org/25/en/File:Rubric_assessmentform_list.png
http://docs.moodle.org/25/en/Workshop_module_FAQ
этого%20форума%20для%20дополнительной%20информации
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4.3.14.6. See also 
 Using Moodle Workshop forum 

4.4.Resources 
How to add static materials to your course. 

A resource is an item that a teacher can use to support learning, such as a 

file or link. Moodle supports a range of resource types which teachers can 

add to their courses. In edit mode, a teacher can add resources via a drop 

down menu. Resources appear as a single link with an icon in front of it 

that represents the type of resource. 

 

4.4.1.Book 
Multi-page resources with a book-like format. Teachers can export their 

Books as IMS CP (admin must allow teacher role to export IMS) 

 

Book module 
The Book module makes it easy to create multi-page resources with a 

book-like format. 

Previously created websites can be imported directly into the Book 

module. Books can be printed entirely or by chapter. 

 

The book module allows you to have main chapters and sub chapters, but it 

goes no deeper. In other words, sub chapters cannot have their own sub 

chapters, as the module is intended to be a simple resource for teachers and 

students. 

The book module is not interactive. You can, however, link to choices, 

forums etc., from within a book. Also, Flash movies and other multimedia 

may be included in a book 

Screenshot «Book example from moodle.tokem.fi». 

4.4.1.1.Book settings 
4.4.1.1.1.Adding a book 

A teacher can add a book by choosing it from the "Add an activity 

or resource" link (or, if not present, the "Add a resource" drop down menu 

in course.) All settings may expanded by clicking the "Expand all" link top 

right. 

 

 

 

 

4.3.14.6.См.также 
 Использование Moodle, форум Семинар. 

4.4.Ресурсы 
Как добавлять статичные материалы в ваш Курс. 

Ресурс – это элемент, который Преподаватель может использовать в качестве 

помощи в обучении, такой как Файл или Ссылка. Moodle поддерживает диапазон типов 

Ресурсов, которые Преподаватели могут добавлять в свои Курсы. В режиме 

редактирования Преподаватель может добавлять Ресурсы через ниспадающее меню. 

Ресурсы предстают в виде одиночных ссылок с иконками перед ними, представляющими 

тип Ресурса. 

4.4.1.Книга 
МноГостраничные Ресурсы в похожем на книгу формате. Преподаватели могут 

экспортировать эти Книги как IMS CP (Администратор должен позволить Роли 

Преподавателя экспортировать IMS). Подробнее об IMS CP см. в п. 4.4.4. 

Модуль «Книга» 
Модуль Книга позволяет легко создавать мноГостраничные Ресурсы в формате 

книги. 

Предварительно созданные веб Сайты могут быть импортированы 

непосредственно в модуль «Книга». Книги могут быть распечатаны целиком или по 

частям. 

Модуль «Книга» разрешает вам иметь основные Главы и подГлавы, но не глубже. 

Другими словами, подГлавы не могут иметь их собственных подГлав, т.к. этот модуль 

предназначен в качестве простого Ресурса для Преподавателей и Студентов. 

 

Модуль «Книга» не интерактивен. Однако вы можете из Книги подключиться к 

Выборам, Форумам и т.д. Также в Книгу могут быть включены Flash-фильмы и другие 

мультимедиа. 

Снимок с экрана «Пример Книги». 

4.4.1.1.Настройки Книги 
4.4.1.1.1.Добавление Книги 
Преподаватель может добавить Книгу, выбрав её (Book) по ссылке «Add an activity or 

resource» (или, если она не присутствует, из ниспадающего меню «Add a resource» в 

Курсе). Все настройки могут быть развёрнуты щелчком по ссылке «Expand all» вверху 

справа. 

http://moodle.org/mod/forum/view.php?id=740
https://moodle.org/mod/forum/view.php?id=740
http://docs.moodle.org/25/en/File:book.png
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4.4.1.1.2.General 
Screenshot «General settings expanded by default». 

Name 
Use a descriptive name for your book as it will form the link the students 

will click on to access it. 

Description 
Provide information for your students here so they are clear what the book 

is about. Click "Show editing tools" to display the rich text editor and drag 

the bottom right of the text box out to expand it. 

 

Display description on course page 
Enabling this will display the description on the course page just below the 

link to the book. 

4.4.1.1.3.Appearance 
Screenshot «Appearance settings expanded». 

Chapter formatting 
The options are: 

 None - chapter and subchapter titles are not formatted at all, use if you 

want to define special numbering styles. For example letters: in chapter 

title type "A First Chapter", "A.1 Some Subchapter",... 

 Numbers - chapters and subchapters are numbered (1, 1.1, 1.2, 2, ...) 

 Bullets - subchapters are indented and displayed with bullets. 

 Indented - subchapters are indented. 

Custom titles 
If you disallow custom titles, the chapter title (the one that appears on the 

table of contents) will appear as a header at the top of your content (1 

below) If you enable custom titles, you will be able to create a title 

different from the one that appears in the ToC or display no title at all (2 

below) If you enable custom titles, you will need to enter the chapter title 

as part of the page content. 

 

 

Screenshot «Example of a custom title». 

 

4.4.1.1.4.Common module settings 
See Common module settings 

 

 

4.4.1.1.2.Обычные настройки 
Снимок с экрана. 

Название 
Используйте наглядное название для вашей Книги, так как оно сформирует 

ссылку, которую будут щёлкать Студенты, чтобы получить доступ к этой Книге. 

Описание 
Обеспечьте информацию для ваших Студентов здесь так, чтобы они ясно 

представили, о чём эта Книга. Щёлкните «Show editing tools (показать инструменты 

редактирования)», чтобы отобразить полный текстовый редактор, и перетащите нижний 

правый уголок текстового окошка, чтобы расширить его. 

Отображать описание на странице Курса 
Включение этой настройки будет отображать описание на странице Курса сразу 

под ссылкой на эту Книгу. 

4.4.1.1.3.Внешний вид 
Снимок с экрана «Внешний вид развёрнутых настроек». 

Форматирование глав 
Есть опции: 

 None (нет)  – заголовки глав и подГлав не форматируются совсем, 

используйте, если хотите использовать специальные стили нумерации. Например, буквы: 

в заголовке главы напечатают «А. Первая глава», «А.1. Первая подГлава»… 

 Numbers (числа)  – главы и подГлавы нумеруются (1, 1.1, 1.2, 2. …) 

 Bullets (выделения) – главы и подГлавы отображаются выделенными 

 Indented (отступами) – подГлавы отображаются с отступом. 

Заголовки, настроенные под клиента 
Если вы отмените заголовки, настроенные под клиента, заголовок Главы (тот, 

который появляется в оглавлении) появится как заголовок над содержимым главы (1 

ниже). Если вы разрешите заголовки, настроенные под клиента, вы будете способны 

создать заголовок отличный от заголовка, который появится в оглавлении, или отобразит, 

что нет заголовка совсем (2 ниже). Если вы 

разрешите заголовки, настроенные под клиента,  

вам потребуется ввести заголовок Главы как часть 

содержимого страницы. 

Снимок с экрана «Пример пользовательского 

заголовка». 

4.4.1.1.4.Общие настройки модуля 
См. «Общие настройки модуля» в п. 6.1. 

http://docs.moodle.org/25/en/File:bookgeneral252.png
http://docs.moodle.org/25/en/File:bookappearance.png
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4.4.1.1.5.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.4.1.1.6.Site administration settings 
The administrator can set the default values for chapter formatting, the 

available options for chapter numbering and whether or not to require a 

description from Administration > Site administration > Plugins > Activity 

modules > Book. 

4.4.1.1.7.Adding chapters and subchapters 
Titles of chapters appear as links in the table of contents to the left of your 

content. Keep your titles short. 

To add another chapter, click on the red cross in the Table of Contents or 

first chapter. The new chapter will be inserted directly after the chapter 

whose title is on the same line as the red cross you click (Screenshot 1). 

 

Note that the sub chapter box is checked. A chapter may have many sub 

chapters, but sub chapters cannot have subchapters. In order to keep this 

resource simple, you are limited to two levels (Screenshot 2). 

You now see a chapter and a sub chapter. Because we did not elect to 

number chapters, the fact that the second chapter is a sub chapter cannot be 

seen in the table of contents. Note that you do, however, see this in the title 

above the content. 

By the way, the items in the table of contents are neither numbered nor are 

they indented only because that is the option we chose when setting up the 

book. We can always go back and change that (Screenshot 3). 

Screenshots: 

1. Adding a new chapter 

2. Adding a subchapte 

3. View of subchapter 

 

4.4.1.1.8.Importing chapters 
To import chapters 

 Create a zip file of HTML files and optional multimedia files and 

folders. If you wish to upload subchapters, add "_sub" to the end of 

HTML file or folder names. 

 Go to Administration > Book administration > Import chapter 

 Choose whether each HTML file or folder represents one chapter 

 Browse for and select the zip file, either using the Add button or the 

drag and drop method: 

4.4.1.1.5.Ограничить доступ/Завершение Действия 
Эти настройки видимы, если Обусловленные Действия и Завершение Действия 

разрешены на Сайте и в Курсе. 

4.4.1.1.6.Настройки управления Сайтом 
Администратор может установить значения по умолчанию форматирования Глав, 

доступные опции для нумерации Глав и требовать или нет описание из 

AdministrationSite administrationPluginsActivity modulesBook. 

 

4.4.1.1.7.Добавление глав и подГлав 
Заголовки Глав появляются как ссылки в оглавлении слева от вашего содержимого 

Книги. Сохраняйте ваши заголовки короткими. 

Чтобы добавить другую Главу, щёлкните по красному крестику в оглавлении или 

первой Главе. Новая Глава будет вставлена непосредственно после той Главы, чей 

заголовок находится на одной линии, что и красный крестик, который вы щёлкнули 

(Снимок с экрана 1). 

Заметьте, что окошко подГлавы помечается. Глава может иметь много подГлав, но 

подГлавы не могут иметь подГлав. Для того чтобы этот Ресурс сохранить простым, вы 

ограничены двумя уровнями (Снимок с экрана 2). 

Вы видите сейчас главу и подГлаву. Поскольку мы не выбираем число Глав, в 

действительности вторая глава является подГлавой, которая не может быть увидена в 

оглавлении. Заметьте, однако, то, что вы делаете, видно в заголовке выше содержимого 

Книги. 

Кстати, элементы в оглавлении не пронумерованы, и не расположены с отступом 

только потому, что есть опция, которую мы выбрали при установке этой Книги. Мы всегда 

можем вернуться и изменить это (Снимок с экрана 3). 

 
1 – добавление новой Главы,       2 – добавление подГлавы,    3 – вид подГлавы. 

4.4.1.1.8.Импортирование Глав 
Чтобы импортировать Главы 

 Создайте zip-файл из HTML-файлов и, если нужно, мультимедийных файлов и папок. 

Если вы хотите переслать подГлавы, добавьте «_sub» к концу имён HTML-файлов или 

папок. 

 Перейдите в AdministrationBook administrationImport chapter. 

 Выберите, представляет одну Главу: каждый HTML-файл или папка. 

 Отыщите и выберите zip-файл, используя либо кнопку Add, либо метод буксировки. 



 

245 

4.4.1.1.9.Book capabilities 
Edit book chapters 
Capabilities/mod/book:edit 

 This allows a user to add, edit and delete chapters of a book 

 This capability is allowed for the default roles of manager and teacher 

Read book 
Capabilities/mod/book:read 

 This allows a user to read a book 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher, student and guest 

View hidden book chapters 
Capabilities/mod/book:viewhiddenchapters 

 This allows a user to view hidden chapters of a book 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Export book as IMS content package 
Capabilities/booktool/exportimscp:export 

 This allows a user to export a book as an IMS content package 

 This capability is not set for any of the default roles 

Import chapters 
Capabilities/booktool/importhtml:import 

 This allows a user to import chapters of a book 

 This capability is allowed for the default roles of manager and teacher 

Print book 
Capabilities/booktool/print:print 

 This allows a user to print a book 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher, student and guest 

Add a new book 
Capabilities/mod/book:addinstance 

 This allows a user to add a new book to a course 

 This capability is allowed for the default roles of manager and teacher 

4.4.1.2.Using Book 
4.4.1.2.1.Navigate your book 
In addition to the links in the table of contents, you may move through the 

book using the arrows located to the top-left and bottom-left of the content. 

4.4.1.1.9.Возможности Книги 
Редактировать Главы Книги 

Возможность Capabilities/mod/book:edit 

 Позволяет пользователю добавлять, редактировать и удалять Главы Книги 

 Эта возможность предоставлена по умолчанию Ролям Менеджера и Преподавателя. 

Читать Книгу 
Возможность Capabilities/mod/book:read 

 Позволяет пользователю читать Книгу. 

 Эта возможность предоставлена по умолчанию Ролям Менеджера, Преподавателя, 

неРедактирующего Преподавателя, Студента и Гостя. 

Просмотреть скрытые Главы Книги 
Возможность Capabilities/mod/book:viewhiddenchapters 

 Позволяет пользователю просмотреть скрытые Главы Книги. 

 Эта Возможность предоставлена по умолчанию Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Экспорт Книги как пакет с IMS-содержимым  
Возможность Capabilities/booktool/exportimscp:export 

 Позволяет пользователю экспортировать Книгу как пакет с IMS-содержимым. 

 Эта возможность не устанавливается по умолчанию ни одной Роли. 

Импорт глав 
Возможность Capabilities/booktool/exporthtml:import 

 Позволяет пользователю импортировать Главы Книги. 

 Эта Возможность предоставлена по умолчанию Ролям Менеджера и Преподавателя. 

Печать Книги 
Возможность Capabilities/booktool/print:print 

 Позволяет пользователю печатать Книгу. 

 Эта Возможность предоставлена по умолчанию Ролям Менеджера, Преподавателя, 

неРедактирующего Преподавателя, Студента и Гостя 

Добавить новую Книгу 
Возможность Capabilities/mod/book:addinstance 

 Позволяет пользователю добавить новую Книгу в Курс 

 Эта Возможность предоставлена по умолчанию Ролям Менеджера и Преподавателя 

4.4.1.2.Применение Книги 
4.4.1.2.1.Перемещаться по вашей Книге 

В дополнение к ссылкам в оглавлении вы можете перемещаться по Книге, используя 

стрелочки, расположенные в верхнем и нижнем левых углах содержимого Книги. 

http://docs.moodle.org/25/en/Book_module
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4.1.2.2.Uses of the book module 
You can use the book module to present information in a well-structured, 

user-friendly format. But there are other possibilities. Because this module 

allows one to import individual web pages or folders of web pages, it is 

useful for group work. Example: Each student creates a simple web page 

about your school and the teacher, (that's you!) uploads the pages to the 

book. Voila! You and your students have created a useful, interesting 

resource for new students and their parents. You could do this to create a 

class cook book and nutrition guide, a resource about local civic 

organizations, triangles in our daily lives, world leaders, you name it. 

Alternatively, you could enable students to upload pages to the book - see 

Book FAQ for details. 

 

4.4.1.2.3.Printing a book 
Whole books and individual chapters may be printed by selecting the 

relevant link in Administration > Book administration. 

If you do not wish certain roles to be able to print books (e.g. students) 

then you can remove the capability booktool/print:print in Administration 

> Book administration > Permissions. 

4.4.1.2.4.Exporting a book as an IMS content 
package 
Any user with the export a book as an IMS content package capability (by 

default nobody except admins) can do so via Administration > Book 

administration > Generate IMS CP. 

4.4.1.2.5.See also 
Review:Book Module by Gavin Henrick. 

4.4.1.3.Book FAQ 
4.4.1.3.1.How can I enable students to edit a 
book? 
Students are not supposed to be able to edit book, allowing it would be a 

serious security issue. The capability to edit book chapters is intended 

strictly for trusted users. 

4.4.1.3.2.How can I enable students to import web 
pages? 
Do not allow students to import or edit books! Only trusted users should 

have the capability to edit book chapters and the capability to import 

chapters. 

4.4.1.2.2.Применения модуля «Книга» 
Вы можете использовать модуль «Книга», чтобы представить информацию в 

хорошо структурированном, удобном для пользователя формате. Но существуют и другие 

возможности. Поскольку этот модуль позволяет вам импортировать индивидуальные веб-

страницы или папки веб-страниц, это полезно для групповой работы. Пример: Каждый 

Студент создаёт простую веб-страницу о своей школе и его учителе (это вы!), пересылает 

каждую из страниц в Книгу. Вот! Вы и ваши Студенты имеете полезный, интересный  

Ресурс для новых Студентов и их родителей. Вы можете сделать это же, чтобы создать 

поваренную книгу своего класса и рекомендации по питанию, Ресурс о местных 

гражданских организациях, треугольниках в нашей ежедневной жизни, мировых лидерах, 

присвоив имена этому. Другой вариант – вы можете разрешить Студентам пересылать 

страницы в эту Книгу – см. подробности в «Часто задаваемые вопросы о Книгах (п. 

4.4.1.3)». 

4.4.1.2.3.Печатание Книги 
Целые книги и отдельные страницы могут быть напечатаны посредством выбора 

подходящей ссылки в AdministrationBook administration. 

Если вы не желаете, чтобы Определённые Роли были способны распечатывать 

Книги (например, Студенты), тогда удалите Возможность booktool/print:print в 

AdministrationBook administrationPermissions. 

4.4.1.2.4.Экспортирование Книги в формате пакета с IMS-
содержимым 

Любой пользователь с возможностью (п. 4.4.1.1.9) экспорта Книги в формате 

пакета с IMS-содержимым (по умолчанию никто, кроме Администратора) может сделать 

это через AdministrationBook administration Generate IMS CP. 

4.4.1.2.5.См. также 
Обзор модуля «Книга» от Гейвин Хенрик. 

4.4.1.3.Часто задаваемые вопросы о Книге 
4.4.1.3.1.Как позволить Студентам редактировать Книгу? 
 

Не предполагается, чтобы Студенты были способны редактировать Книгу, 

позволение этого столкнётся с серьёзным вопросом безопасности. Возможность 

редактировать Главы Книги предназначена только для доверенных пользователей. 

4.4.1.3.2.Как позволить Студентам импортировать веб-
страницы? 

Не позволяйте Студентам импортировать или редактировать Книги! Только 

доверенные пользователи должны иметь Возможность редактировать Книгу и 

Возможность импортировать главы. 

http://www.somerandomthoughts.com/blog/2011/05/13/review-book-module-for-moodle-2-0/
http://docs.moodle.org/25/en/Capabilities/mod/book:edit
http://docs.moodle.org/25/en/Capabilities/mod/book:edit
http://docs.moodle.org/25/en/Capabilities/booktool/importhtml:import
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4.1.3.3.How can I enable teachers to export a 
book to IMS content package? 
Allow the capability to export to IMS CP for the role of teacher then go to 

Settings > Book administration > Generate IMS CP. 

 

4.4.1.3.4.Why only two levels? 
Two levels are generally enough for all books, three levels may lead to 

poorly structured documents. The Book module is designed for the 

creation of short multi-page study materials. Consider uploading a file in 

PDF format for longer documents. 

4.4.1.3.5.How do I search within a book resource? 
There is no internal search facility, though you can always use your web 

browser's search capability in print page view. 

 

4.4.1.3.6.Can I import a powerpoint into a book? 
 
See the forum post Semi-automated Powerpoint to Book import macro for 

one possible method. 

4.4.1.3.7.Can I change the font of the print view 
for Book? 
Not easily. In book view your theme controls how is your book is 

displayed, where as during printing, book/tool/print/print.css determines 

the font, which is defaulted to Times New Roman. See 

https://moodle.org/mod/forum/discuss.php?d=220147#p972743 

A hack: you can in Print view use some utility like Firebug to change the 

font. 

4.4.1.3.8.See also 
 Using Moodle Moving Book from One Course to Another forum 

discussion 

4.4.1.4.See also 
 Book FAQ 

 Using Moodle Book module forum 

 Using Moodle Using a Lesson to simulate a Book forum discussion 

 

 Using Moodle What's the difference between a Book and a Lesson? 

 

 

4.4.1.3.3.Как позволить Преподавателям экспортировать 
Книгу в формате пакета с IMS содержимым? 
Разрешите для Роли Преподавателя Возможность экспортировать в IMS CP (пакет с IMS 

содержимым, просмотрите), затем перейдите в 

AdministrationBook administrationGenerate IMS CP. 

4.4.1.3.4.Почему только два уровня? 
Двух уровней обычно достаточно для всех книг, третьи уровни ведут к плохо 

структурированным документам. Модуль «Книга» сконструирован для создания коротких 

многостраничных материалов в процессе изучения. Для более длинных документов 

рассмотрите загрузку файла в формате PDF. 

4.4.1.3.5.Как осуществлять поиск внутри Книги? 
Возможность внутреннего поиска отсутствует, хотя вы всегда можете 

использовать возможность поиска своего браузера в страницах, подготовленных для 

печати. 

4.4.1.3.6.Можно импортировать Powerpoint-презентацию в 
Книгу? 

См. корреспонденцию форума «Макрос полуавтоматического импорта Powerpoint-

презентации в Книгу» в качестве одного из методов. 

4.4.1.3.7.Можно изменить шрифт печатного вида Книги? 
 

Не легко. Выбранная тема фоновой картинки управляет видом Книги, т.е. тем, как 

ваша Книга отображается во время распечатки, другими словами, таблица стилей 

book/tool/print/print.css определяет шрифт, который по умолчанию является шрифтом 

Times New Roman. См. 

Нелегально (по-хакерски): вы можете к печатному виду применить некоторую 

утилиту, наподобие Firebug (http://getfirebug.com/), чтобы изменить шрифт. 

4.4.1.3.8.См. также 
 Обсуждения форума «Перемещение Книги из одного Курса в другой» по 

использованию Moodle. 

4.4.1.4.См. также 
 Часто задаваемые вопросы по Книге. 

 Использование Moodle. Форум по модулю «Книга». 

 Использование Moodle. Обсуждение в Форуме «Использование Урока для 

моделирования Книги». 

 Использование Moodle. Какая разница между Книгой и Уроком? 

http://docs.moodle.org/25/en/Capabilities/booktool/exportimscp:export
https://moodle.org/mod/forum/discuss.php?d=218473
https://moodle.org/mod/forum/discuss.php?d=218473
https://moodle.org/mod/forum/discuss.php?d=220147#p972743
http://getfirebug.com/
http://moodle.org/mod/forum/discuss.php?d=208324
http://docs.moodle.org/25/en/Book_FAQ
http://moodle.org/mod/forum/view.php?id=2633
http://moodle.org/mod/forum/discuss.php?d=76092
http://moodle.org/mod/forum/discuss.php?d=76092
http://moodle.org/mod/forum/discuss.php?d=207365&parent=910023#p910107
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4.4.2.File 
A picture, a pdf document, a spreadsheet, a sound file, a video file. 

 

File resource 
When you wish to share with your students a simple file such as a Word-

processed document or slideshow (eg created in MS Word, Powerpoint, or 

Open Office) you use the file resource type. It allows you to upload and 

display a variety of resources on your course. How your students access 

them depends on your choices in File resource settings. Note also that they 

will only be able to open your files if they have the appropriate software on 

their own computers. 

4.4.2.1.File resource settings 
4.4.2.1.1.Adding a file 
To add a file to your course 

Quick method: (Note - does not work with Internet Explorer 9 or lower) 

1. Click the 'Turn editing on' button at the top right of the course page 

 

2. Drag and drop the file onto the course section where you'd like it to 

appear 

3. If necessary, edit the title of the file by clicking the pencil icon, or edit 

other options (see below) by clicking the editing icon 

Longer method: 

1. Click the 'Turn editing on' button at the top right of the course page 

2. Click 'Add an activity or resource' link, then in the activity chooser, 

select file then click the Add button (or select file from the "Add a 

resource" dropdown menu) All settings may expanded by clicking the 

"Expand all" link top right. 

 

3. Select your options as below: 

4.4.2.1.2.General 
Name 
Whatever you type here will form the link learners click on to view the file 

so it is helpful to give it a name that suggests its purpose. 

Description 
Add a description of your file here if desired (or required.) Click "Show 

editing tools" to display the rich text editor, and drag the bottom right of 

the text box out to expand it. 

 

4.4.2.Файл 
Файл – это картинка, документ в формате pdf, электронная таблица, звуковой 

Файл, видео-файл. 

Ресурс «Файл» 
Когда вы хотите совместно использовать со Студентами простой Файл, такой как 

обработанный в Word документ или слайд-шоу (например, созданные в MS Word, 

Powerpoint или Open Office), вы используете тип Ресурса «Файл». Он позволяет вам 

переслать и отобразить множество Ресурсов в вашем Курсе. Как ваши Студенты получат к 

ним доступ, зависит от вашего выбора в настройках Ресурса «Файл». Заметьте также, что 

они смогут открыть ваши Файлы, только если на их собственных компьютерах 

установлено подходящее для открытия программное обеспечение. 

4.4.2.1.Настройки Ресурса «Файл» 
4.4.2.1.1.Добавление Файла 

Чтобы добавить Файл в ваш Курс 

Быстрый метод: (Замечание: не работает с Internet Explorer 9 или ниже) 

1. Щёлкните кнопку «Turn editing on (включить редактирование)» вверху справа на 

странице Курса 

2. Отбуксируйте нужный Файл в тот раздел Курса, где хотите, чтобы он появился 

 

3. Если необходимо, отредактируйте заголовок Файла, щёлкнув иконкой «шестерёнка», 

или отредактируйте другие опции (см. ниже), щелчком по иконке редактирования. 

Более длинный метод: 

1. Щёлкните кнопку «Turn editing on (включить редактирование)» вверху справа на 

странице Курса. 

2. Щёлкните ссылку «Add an activity or resource», затем в меню выбора деятельности 

выберите File, затем щёлкните кнопку Add (или выберите File из ниспадающего меню 

«Add a resource»). Все настройки могут быть развёрнуты щелчком по ссылке «Expand 

all» вверху справа. 

3. Выберите ваши опции из представленных ниже. 

4.4.2.1.2.Обычные настройки 
Название 

То, что вы наберёте здесь, сформирует ссылку, щёлкнув на которую учащиеся 

увидят Файл, поэтому полезно дать название, которое отражает его назначение. 

Описание 
Добавьте описание вашего Файла здесь, если хотите (или требуется). Щёлкните 

«Show editing tools», чтобы отобразить полный текстовый редактор, и перетащите правый 

нижний уголок текстового окошка, что расширить его. 
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Display description on the course page 
If this box is ticked, the description will appear on the course page just 

below the name of the file. 

4.4.2.1.3.Content 
Either  drag and drop your file onto the arrow if you are using an 

appropriate browser, or click on "Add" and use the File picker to upload 

your file. 

(Note that if legacy files were used there will be a setting "Migration of old 

course file") 

4.4.2.1.4.Appearance 
Display 
 Automatic - Make the best guess at what should happen (probably what 

is wanted 99% of the time). 

 Embed - Show the Moodle page with heading, blocks and footer. Show 

the title/description of the item and display the file directly in the page 

as well (good for images, flash animations, videos, PDFs). 

 Force download - user clicks on the file, then the web browser pops up 

with the 'where do you want to save this file' box. 

 

 Open - No Moodle heading, blocks, footer or description - just show the 

file in the web browser (e.g. shows image, PDF, flash animation, taking 

up the whole browser window) 

 In pop-up - Same as 'Open', but opens a new browser window to show 

this file (without the Moodle heading, blocks, etc) - this browser 

window also does not have all the menus and address bar in it. 

 The following additional options are only there if you enable them via 

Site administration > Plugins > Activity modules > File: 

 In frame - show the Moodle heading and the file description, with the 

file displayed in a resizable area below (images, PDF, flash, etc. 

supported). 

 New window - very much like 'in pop-up', but the new window is a full 

browser window, with menus and address bar, etc. 

All of the above is true of items that can be displayed inside the browser 

directly (e.g. images, text files, PDFs (with plugin)). If the file cannot be 

displayed within the browser (e.g. word documents, without a suitable 

plugin, or other files that need to be loaded by an external program), then 

the pop-ups or frames, etc. will be created, but then the browser will take 

over and ask if you want to save the file. 

 

Отображать описание на странице Курса 
Если это окошко отмечено, описание будет появляться на странице Курса как раз под 

именем Файла. 

4.4.2.1.3.Содержимое 
Либо отбуксируйте ваш Файл по стрелке, если у вас подходящий браузер, либо 

щёлкните Add и используйте меню файлов, чтобы переслать ваш Файл. 

 

(Заметьте, что если использовался наследуемый Файл, появится настройка 

«Migration of old course file (перемещение файла из старого Курса)».) 

4.4.2.1.4.Внешний вид 
Отображать 
 Automatic (автоматический) – вырабатывает лучшее предсказание того, что может 

произойти (возможно, это потребует 99% времени). 

 Embed (встроенный) – показывает страницу Moodle с заголовком, блоками и 

подвалом. А также показывает заголовок/описание и отображает Файл в этой странице 

(хорошо для изображений, флэш-анимации, видео, PDF-файлов). 

 Force download (принудительно загруженный) – пользователь щёлкает по Файлу, 

затем в веб-браузере всплывает окошко «where do you want to save this file (где бы вы 

хотели сохранить этот файл?)». 

 Open (открывать) – нет заголовка Moodle, блоков и подвала. Просто показывает файл 

в веб-браузере (например, показывает изображение, флэш-анимацию, занимая окно 

браузера целиком). 

 In pop-up (во всплывающем окне) – то же самое, что и Open, но открывает новое 

окно браузера, чтобы показать этот Файл (без заголовка Moodle, блоков и т.д.) – это 

окно браузера также не имеет всех меню и панели адресов в нём. 

 Следующие дополнительные опции появляются здесь, только если вы разрешите их 

через AdministrationSite administrationPluginsActivity modulesFile: 

 In frame (в рамке) – показывает заголовок Moodle и описание Файла с отображением 

Файла в области, заключённой в рамку, ниже (изображения, PDF-файлы, флэш и т.д. 

поддерживаются). 

 New window (новое окно) – очень сильно похоже на In pop-up, но новое окно – это 

полноценное окно браузера с меню, панелью адресов и т.д. 

Всё сказанное выше относится к элементам, которые могут быть отображены 

непосредственно внутри браузера (например, изображения, текстовые файлы, PDF-файлы 

(если есть Плагин для чтения)). Если файл не может быть отображён внутри браузера 

(например, Word-документы без подходящего Плагина, или другие файлы, которым 

необходимо загружаться внешней программой), то будет создано всплывающее окно или 

область в рамке, но затем браузер перехватит управление и спросит, хотите ли вы 

сохранить этот Файл. 
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To summarise: 

 Do you want Moodle to sort it all out for you? - Automatic 

 Do you want to force the user to save the file (or open it in a program 

on their desktop)? - Force download 

 Do you want to show the file as part of the Moodle page (images, PDFs, 

videos)? - Embed 

 Do you want to show the file in the browser, but without the Moodle 

page decorations (images, PDFs, videos)? - Open 

 Do you want that, but in a new window? - In Pop-up (or possibly 'New 

window') 

 Do you want to use a horrible bit of non-strict HTML that should never 

be allowed in polite company? - In frame 

Show size.type 
To show the file size and/or type on the course page and also on the 

resource page, simply tick the appropriate checkboxes. 

Display resource name/description 
To show the resource name and/or description when clicking to access the 

file, simply tick the appropriate checkboxes. 

Pop-up width/height 
(This setting is visible when "Show more" is clicked.) 

If your file is to be displayed in a pop-up, specify the width and height 

here. 

Use filters on file content 
(This setting is visible when "Show more" is clicked.) 

If you wish included media such as images and mp3 to appear embedded 

in the files then select "all files" or "HTML files only", according to your 

file types. (Note that this setting may cause problems for some Flash and 

Java applets.) 

4.4.2.1.5.Common module settings 
See Common module settings 

4.4.2.1.6.Restrict access/Activity completion 
(These settings are collapsed by default) 

These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.4.2.1.7.Displaying a website index page 
The file module may be used if you have a folder with linked files such as 

a website with an index.html file or a flash activity with xml/swf and index 

file. 

Чтобы подытожить: 

 Хотите, чтобы Moodle решала все проблемы за вас – Automatic 

 Хотите заставить пользователя сохранять Файл (или открывать его в программе на 

своём рабочем столе)? – Force download 

 Хотите показывать Файл как часть страницы Moodle (изображения, PDF-файлы, 

видео)? – Embed 

 Хотите показывать Файл в браузере, но без декораций страницы Moodle (изображения, 

PDF-файлы, видео)? – Open 

 Хотите того же, но в новом окне? – In pop-up (или, возможно, New window) 

 

 Хотите использовать ужасную часть нестрогого HTML, которую никогда не разрешают 

в приличной компании? – In frame. 

Показать размер/тип 
Чтобы показать размер файла и/или его тип на странице Курса, а также на 

странице Ресурса, просто отметьте подходящие окошки-флажки. 

Отобразить название/описание Ресурса 
Чтобы показать название/описание Ресурса при щелчке по средству доступа к 

Файлу, просто отметьте подходящие окошки-флажки. 

Ширина/высота всплывающего окна 
(Эта настройка видна, когда щёлкнута «Show more (показать больше)».) 

Если ваш Файл должен отображаться во всплывающем окне, укажите здесь ширину и 

высоту этого окна. 

Использовать Фильтры к содержимому Файла 
(Эта настройка видна, когда щёлкнута «Show more (показать больше)».) 

Если вы хотите, чтобы включённые медиа, такие как изображения и mp3, представали 

встроенными в эти Файлы, затем выберите «All files (все файлы)» или «HTML files only 

(только HTML-файлы)», в соответствии с вашими типами файлов. (Отметьте, что эта 

настройка может вызвать проблемы для некоторых Flash- и Java-приложений.) 

4.4.2.1.5.Общие настройки модуля 
См. п. 6.1. 

4.4.2.1.6.Ограничить доступ/Завершение Действия 
(Эти настройки по умолчанию свёрнуты) 

Эти настройки видимы, если Обусловленные Действия и Завершение Действия разрешено 

на Сайте и в Курсе. 

4.4.2.1.7.Отображение индексной страницы веб-Сайта 
Модуль «Файл» может быть использован, если у вас есть папка с файлами, 

вызываемыми по ссылкам, таким как веб-Сайт с index.html-файлом или flash-

Интерактивное Действие с xml/swf- и index-файлом. 
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1. Click the 'Turn editing on' button at the top right of the course page 

 

2. Drag and drop the zipped folder onto the course section where you'd 

like it to appear, answer 'Create file resource' to the popup dialogue, 

then click the upload button 

3. Clicking the editing icon (hand with a pen) then click on the zip file and 

unzip it 

4. Click on the index.html file or the file you want to start displaying your 

linked files from then in the popup dialogue click the button 'Set main 

file'. This ensures this file is the one that appears on the course page for 

students to click on. The main file is then indicated with a title in bold. 

 

5. Click the button 'Save and display' at the bottom of the page 

4.4.2.1.8.File module capabilities 
View file resource 
Capabilities/mod/resource:view 

 This allows the user to view a File resource 

 This capability is allowed for the default roles of authenticated user and 

guest 

In Moodle 2.5.2 onwards, file resource links on the course page and in the 

navigation are only displayed for users who have this capability. 

(Previously links were displayed for all users, and users without the 

capability obtained an error message when they clicked on a link.) 

See also 
Capabilities/mod/folder:view. 

Add a new file resource 
Capabilities/mod/resource:addinstance 

 This allows a user to add a new file resource to the course 

 This capability is allowed for the default roles of manager and teacher 

4.4.2.1.9.Site administration settings 
The file module has additional settings which may be changed by an 

administrator in Settings > Site administration > Plugins > Activity 

modules > File. 

Frame height 
Here you can specify the height of the top frame (containing the 

navigation) if you choose the "in frame" display option. Note: If your 

theme has a large header then the resource_framesize variable should be 

increased to prevent horizontal and vertical scrollbars. 

 

1. Щёлкните кнопку «Turn editing on (включить редактирование)» вверху справа на 

странице Курса. 

2. Отбуксируйте zip-заархивированную папку в раздел Курса, где бы вы хотели, чтобы 

она появилась, ответьте «Create file resource (создать Ресурс «Файл»)» во всплывшем 

диалоге, затем щёлкните кнопку пересылки Upload. 

3. Щёлкните иконку редактирования (шестерёнка), затем щёлкните по zip-файлу и 

разархивируйте (unzip) его. 

4. Щёлкните по index.html-файлу или файлу, который вы хотите, чтобы отображался 

первым среди Файлов, вызываемых по ссылке, затем во всплывшем диалоге щёлкните 

кнопку «Set main file (установить главный файл)». Это гарантирует, что Студенты, 

щёлкнув по нему, увидят этот Файл первым на странице Курса. Главный Файл затем 

обозначается с полужирным заголовком. 

5. Щёлкните кнопку «Save and display (сохранять и отображать)» внизу страницы. 

4.4.2.1.8.Возможности модуля «Файл» 
Просмотреть Ресурс «Файл» 

Возможность Capabilities/mod/resource:view 

 Позволяет каждому из пользователей просматривать Ресурс «Файл». 

 Эта Возможность предоставляется по умолчанию Ролям 

Аутентифицированного Пользователя и Гостя. 

В Moodle 2.5.2 и далее ссылки на Ресурс «Файл» на странице Курса и в Навигации 

отображаются только для тех пользователей, которым предоставлена эта Возможность. 

(Предварительно ссылки отображаются для всех пользователей, но пользователи не 

имеющие этой Возможности, получают сообщение об ошибке, когда щёлкают по ссылке.) 

См. также 
Возможность Capabilities/mod/folder:view. 

Добавить новый Ресурс «Файл» 
Возможность Capabilities/mod/resource:addinstance: 

 Позволяет пользователю добавлять новый Ресурс «Файл» в Курс. 

 Эта Возможность предоставляется по умолчанию Ролям Менеджера и Преподавателя. 

4.4.2.1.9.Настройки управления Сайтом 
Модуль «Файл» имеет дополнительные настройки, которые могут быть изменены 

Администратором в AdministrationSite administrationPluginsActivity modulesFile. 

Высота окошка с рамкой 
Здесь вы можете указать высоту окошка с рамкой (содержащего средства 

навигации), если вы выберите опцию отображения «In frame (в рамке)». Замечание: Если 

ваша тема фоновой картинки имеет больший заголовок, тогда переменная 

resource_framesize должна быть увеличена, чтобы убрать горизонтальные и вертикальные 

линейки прокрутки. 

http://docs.moodle.org/25/en/Capabilities/mod/folder:view
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Require activity description 
This setting allows you to turn off the requirement for users to type 

something into the description box. 

Available display options 
This setting allows you to add different ways the resource may 

be displayed on the course page. By default Moodle doesn't enable "New 

window" or "In frame", so you need to set them available here if required, 

and you can also disable other options if not applicable. 

Default values for activity settings 
Here you can set the defaults for this resource. You can also choose which 

setting(s) to class as "Advanced". These settings will only then appear if 

the user clicks "Show More" in the settings. 

4.4.2.2.File resource FAQ 
4.4.2.1.1.My students cannot open the file I 
uploaded for them 
Check that the students have the appropriate software to open your file. 

While Moodle will accept different types of files, it relies on the user to 

read them with the relevant program. If you uploaded a MS Word 2010 

document for instance, make sure your class is able to access Office 2010, 

or provide them with alternatives such as links to Open Office, a "reader" 

or a pdf version of your file. If your teaching involves the use of subject-

specific proprietary software, you should ensure your students are given 

the means to open the files at home as well as in your establishment. 

 

 

4.4.2.1.2.Why is it possible to select multiple files 
in the file settings? 
Because you might be uploading a set of HTML pages with resources. You 

make the index.HTML page the main one, and can reference the other 

resources. 

4.4.2.1.3.How can I upload a lot of files in one go? 
 
You can use the Folder resource to display multiple files. Put all your files 

into a folder, zip(compress) the folder and upload it to the Folder resource. 

Click the icon to the right of its name to unzip it and then save. All the files 

will then display. 

 

 

Потребовать описание Действия 
Эта настройка позволяет вам отключить требование пользователям набирать что-

нибудь в окошке «Description (описание)». 

Доступные опции отображения 
Эта настройка позволяет вам добавить разные способы, которыми Ресурс может 

быть отображён на странице Курса. По умолчанию Moodle не разрешает «New window» 

или «In frame», так что вам нужно сделать их доступными здесь, если требуется, и вы 

также можете отключить другие опции, если требуется. 

Значения по умолчанию для настроек Действия 
Здесь вы можете установить значения по умолчанию для этого Ресурса. Вы также 

можете выбрать, какую(ие) настройку(и) считать «Advanced (продвинутой(ыми))». Эти 

настройки появятся только тогда, когда пользователь щёлкнет «Show More» в настройках. 

4.4.2.2.Часто задаваемые вопросы по Ресурсу «Файл» 
4.4.2.1.1.Мои Студенты не могут открыть файл, который я им 
переслал 

Проверьте, имеют ли Студенты (на своих компьютерах) подходящее программное 

обеспечение, чтобы открыть ваш Файл. Пока система Moodle сможет принимать 

различные типы Файлов, она уверена, что и пользователь прочитает их посредством 

соответствующих программ. Если, например, вы переслали MS Word 2010 документ, 

убедитесь, что ваш класс имеет доступ к Office 2010, или предоставьте им альтернативу, 

такую как ссылку на Open Office (бесплатный аналог MS Office 2010), «читалку» или pdf-

версию вашего Файла. Если ваше преподавание требует использования подходящего 

предметно-ориентированного программного обеспечения, вы должны убедиться, что 

вашим Студентам даны средства, чтобы открыть такие Файлы дома также, как и в вашем 

учебном заведении. 

4.4.2.1.2.Зачем дана возможность выбирать множество 
файлов в настройках Файла? 

Чтобы вы смоли пересылать множество HTML-страниц в качестве Ресурсов. Вы 

создаёте index.HTML-страницу как главную, из которой можно сослаться на другие 

Ресурсы. 

4.4.2.1.3.Как я могу переслать множество файлов за один 
шаг? 

Вы можете использовать Ресурс «Папка» (п. 4.4.3), чтобы отображать множество 

файлов. Поместите все ваши Файлы в папку, zip-заархивируйте эту папку и перешлите её в 

Ресурс «Папка». Щёлкните иконку справа от её имени, что разархивирует её, и затем 

сохраните. Тогда все эти Файлы будут отображаться. 
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4.4.2.1.4.How can I change the top frame size 
when displaying a file in a frame? 
1. Login as an admin and go to Settings > Site administration > Plugins > 

Activity modules > File. 

2. Change the 'Frame height' setting. 

3. Click the 'Save changes' button. 

4.4.2.1.5.If I upload a file in one course, can I use 
it in another course as well? 
Yes. From the file picker, choose Server files and then navigate to the 

course where you uploaded the file initially and select it there. 

4.4.2.1.6.How can I make ppt files open within 
Moodle rather than downloading? 
You need to convert the ppt to something else, for example a swf file 

(using Open/Libre Office). See also Embedding PowerPoint into Moodle 

via Google Docs video. 

4.4.2.1.7.How can I show the size of a file on the 
course page? 
Students who need to download files appreciate being able to see its size 

especially if they have a slow Internet connection. Simply tick the 'Show 

size' checkbox in the file settings. 

4.4.2.1.8.If students can link to uploaded files as 
aliases, how can I stop them changing their 
assignments? 
Don't worry! Students are not allowed to link to files in their private files 

when uploading assignments, forum attachments, workshop submissions or 

quiz essays. See Working with files. 

4.4.2.1.9.I've uploaded a video file, but it's too 
small. How do I change the default video size? 
The default size for Moodle video and flash replay is 400 x 300 pixels. If 

you want the default video size to be larger, add the 

following code to your config.php file. Another method is to add the same 

code to the bottom of theme/themename/config.php file (where themename 

is the name of the theme or themes you are using). Note set the number to 

the size in pixels you want, common sizes being 800 x 600 or 700 x 525 or 

600 x 450 or 500 x 375. 

 

 

4.4.2.1.4.Как изменить высоту окошка в рамке, при 
отображении в нём Файла 
1. Зарегистрируйтесь как Администратор и перейдите в 

AdministrationSite administrationPluginsActivity modulesFile. 

2. Измените настройку «Frame height». 

3. Щёлкните кнопку «Save changes». 

4.4.2.1.5.Если я переслал файл в один Курс, могу ли я 
использовать его также и в другом Курсе? 

Да. Из меню Файлов выберите файлы Сервера и затем перейдите в тот Курс, куда 

переслали этот Файл первоначально, и выберите его там. 

4.4.2.1.6.Как сделать ppt-презентации открывающимися в 
Moodle, а не после загрузки в свой компьютер? 

Вам нужно конвертировать ppt-файл во что-нибудь ещё, например, в swf-файл 

(используя Open/Libre Office).  

См. также видео. 

4.4.2.1.7.Как показать размер Файла на странице Курса? 
 

Студенты, которым нужно загрузить Файлы, будут признательны за возможность 

увидеть размеры этих Файлов, особенно если у них скорость интернета медленная. Просто 

пометьте окошко флажок «Show size (показать размер)» в настройках Файла. 

4.4.2.1.8.Если Студенты могут ссылаться на пересланные 
файлы по их псевдонимам, как остановить замены 
Студентами имён Файлов на псевдонимы в их Заданиях? 

Не беспокойтесь! Студентам не разрешается ссылаться на Файлы из своих личных 

Файлов при пересылке в Заданиях, файловых вложениях в Форумах, отправке готовых 

ответов на Семинарах или эссе на Экзаменах. См. работу с файлами в п. 5.1. 

4.4.2.1.9.Я переслал видео Файл, но размер его окна показа 
очень мал. Как изменить размер по умолчанию этого видео? 

По умолчанию размер для проигрывания видео и flash в Moodle – 400 x 300 

пикселей. Если вы хотите сделать размер по умолчанию для видео больше, добавьте 

приведённый ниже код в ваш config.php-файл. Другой метод состоит в добавлении того же 

кода в конец theme/themename/config.php-файла (где themename – имя темы фоновой 

картинки или тем, которые вы используете). Отметьте, что задание нужного вам размера 

видео в пикселях делается не произвольно, а исходя из общепринятых форматов видео: 

800 x 600 or 700 x 525 or 600 x 450 or 500 x 375. 

http://www.youtube.com/watch?v=MOzAulw8-6E
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4.4.3.Folder 
For helping organize files and one folder may contain other folders. 

 

Folder resource 
A folder allows a teacher to display several course resources together. The 

resources may be of different types and they may be uploaded in one go, as 

a zipped folder which is then unzipped, or they may be added one at a time 

to an empty folder on the course page. 

Using a folder to display resources is neater than displaying files one by 

one in a list. It takes up less space on the course page. 

 

The downside is that at present you are forced to download files stored in a 

folder resource. You cannot have (for example) a folder of pictures where 

the user can view the pictures in Moodle without a download. 

 

4.4.3.1.Folder resource settings 
4.4.3.1.1.Adding a folder to your course 
Note: Folders you wish to upload to Moodle have to be "zipped" or 

"compressed" first. The way you do this depends on your computer and 

operating system. 

If you already have a folder of files you would like to display, there are 

two methods: 

 

 

... if (!defined('CORE_MEDIA_VIDEO_WIDTH')) { 

    // Default video width if no width is specified; some players may do 

something 

    // more intelligent such as use real video width. 

    // May be defined in config.php if required. 

    define('CORE_MEDIA_VIDEO_WIDTH', 800); 

} 

if (!defined('CORE_MEDIA_VIDEO_HEIGHT')) { 

    // Default video height. May be defined in config.php if required. 

    define('CORE_MEDIA_VIDEO_HEIGHT', 600); 

} 

if (!defined('CORE_MEDIA_AUDIO_WIDTH')) { 

    // Default audio width if no width is specified. 

    // May be defined in config.php if required. 

    define('CORE_MEDIA_AUDIO_WIDTH', 400); 

}... 

4.4.3.Папка 
Для помощи в организации файлов, и чтобы одна Папка могла содержать другие 

папки. 

Ресурс «Папка» 
Папка позволяет Преподавателю отобразить несколько Ресурсов Курса вместе. Эти 

Ресурсы могут быть разных типов, и они могут быть пересланы за один шаг, как zip-

заархивированная Папка, которая затем разархивируется, или они могут добавляться по 

одному за раз в пустую Папку на странице Курса. 

Использование Папки для отображения Ресурсов более 

удобно, чем отображение одного файла за другим поочерёдно. 

При этом занимается меньше места на странице. 

Нижняя сторона показывает то, что в настоящее время вы 

должны скачать файлы, сохранённые в Ресурсе «Папка». Вы не 

можете иметь (например) Папку рисунков, которые пользователь 

сможет увидеть, как рисунки в Moodle без загрузки. 

4.4.3.1.Настройки Ресурса «Папка» 
4.4.3.1.1.Добавление паки в ваш Курс 

Замечание: Папки, которые вы хотите переслать в Moodle, во-первых, должны 

быть «zipped (зазипованы)» или «заархивированы в формате zip». Способ, которым вы это 

делаете, зависит от вашего компьютера и операционной системы. 

Если у вас уже есть Папка файлов, которую вы хотите отобразить, есть два метода: 
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Quick method 
1. Click the 'Turn editing on' button at the top right of the course page 

2. Drag and drop the folder onto the course section where you'd like it to 

appear 

3. Click the button of the action you would like to take with the folder (in 

our case, "Unzip") and click "Upload" 

4. If necessary, edit the title of the folder by clicking the pencil icon. 

Longer method 
1. Click the 'Turn editing on' button at the top right of the course page 

 

2. Click 'Add an activity or resource' link, then in the activity chooser; 

select folder then click the "Add" button (or select folder from the "Add 

a resource" dropdown menu) All settings may expanded by clicking the 

"Expand all" link top right. 

Screenshot «General settings expanded by default». 

Screenshot «Content settings expanded by default». 

1. For General, add name and a description (which may be required 

or optional according to the admin settings). Click "Show editing tools" to 

display the rich text editor and drag the bottom right of the text box out to 

expand it. Enabling 'Display description on course page' will show it just 

below the link to the folder. 

 

2. For Content, either drag and drop a zipped/compressed folder into the 

box with an arrow or click the Add button to open the File picker menu 

in order to choose a file from your computer or a repository. 

3. When the folder thumbnail appears, click on it and select "Unzip" 

 

Screenshot «Unzipping a folder». 

1. Click the original (zipped) folder and click the "Delete" button to delete 

it if you wish 

2. Select how you want to display your folder contents, your Common 

module settings and, if enabled, Conditional activities settings and 

Activity completion and click "Save and return to course" 

3. Click the button 'Save and return to course' at the bottom of the page 

4.4.3.1.2.Creating and uploading to a new folder 
Use this method if you want to create a folder on your Moodle course and 

then upload files into it. 

1. Click the 'Turn editing on' button at the top right of the course page 

 

 

Быстрый метод 
1. Щёлкните кнопку «Turn editing on (включить редактирование)» вверху справа на 

странице Курса 

2. Отбуксируйте нужную Папку в тот раздел Курса, где вы хотите, чтобы она появилась 

3. Щёлкните кнопку того действия, которое вы хотите предпринять по отношению к этой 

Папке (в нашем случае – «Unzip (разархивировать)») и щёлкните «Upload (переслать)» 

4. Если нужно, отредактируйте заголовок Папки, щелчком по иконке «шестерёнка». 

Более длинный метод 
1. Щёлкните кнопку «Turn editing on (включить редактирование)» вверху справа на 

странице Курса 

2. Щёлкните ссылку «Add an activity or resource», затем в меню выбора деятельности 

выберите Folder, затем щёлкните кнопку Add (или выберите Folder из ниспадающего 

меню «Add a resource»). Все настройки могут быть развёрнуты щелчком по ссылке 

«Expand all» вверху справа. 

Снимок с экрана «Общие настройки, развёрнутые по умолчанию». 

Снимок с экрана «Настройки содержимого, развёрнутые по умолчанию»:. 

1. В общие настройки добавьте имя и описание (которые могут потребоваться или, по 

своему выбору, оставьте настройки Администратора). Щёлкните «Show editing tools 

(показать инструменты редактирования)», чтобы отобразить полный текстовый 

редактор и перетащите правый нижний уголок текстового поля, чтобы его расширить. 

Разрешение «Display description on course page (отобразить описание на странице 

Курса)» покажет его сразу под ссылкой на эту Папку. 

2. В настройках содержимого либо отбуксируйте зазипованную/zip-заархивированную 

Папку в окошко со стрелочкой, либо щёлкните кнопку Add для открытия меню файлов, 

чтобы выбрать файл из вашего компьютера или репозитория. 

3. Когда появится миниатюра Папки, щёлкните по ней и выберите «Unzip 

(разархивировать)». 

Снимок с экрана «Разархивировать Папку». 

1. Щёлкните оригинальную (zip-архив) Папку и щёлкните кнопку «Delete (удалить)», 

чтобы удалить её, если хотите. 

2. Выберите, как вы хотите отображать содержимое вашей Папки, ваши Общие настройки 

модуля и, если разрешено, настройки Обусловленных Действий и Завершения Действия 

и щёлкните «Save and return to course (сохранить и вернуться к Курсу)». 

3. Щёлкните кнопку «Save and return to course» внизу страницы. 

4.4.3.1.2.Создание и пересылка в новую Папку 
Используйте этот метод, если хотите создать Папку в вашем Курсе Moodle, и затем 

перешлите в неё файлы. 

1. Щёлкните кнопку «Turn editing on (включить редактирование)» вверху справа на 

странице Курса 

http://docs.moodle.org/25/en/File:foldergeneral.png
http://docs.moodle.org/25/en/File:foldercontent.png
http://docs.moodle.org/25/en/File:newfolderupload.png
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2. Click 'Add an activity or resource' link, then in the activity chooser; 

select folder then click the "Add" button (or select folder from the "Add 

a resource" dropdown menu) 

3. Enter a name and a description (which may be required or optional 

according to the admin settings) 

4. Click the "Create folder" link as below; choose a name for your new 

folder and then click "Create folder" 

5. Click INTO the folder 

6. You can then add individual files into the folder either by dragging and 

dropping into the box (1 below) or clicking the "Add" (2 below) to 

upload files from the File picker 

7. Choose how you want to display your folder contents, your Common 

module settings and, if enabled, Conditional activities settings 

8. Click "Save and return to course" 

Screenshot «Creating a folder». 

Screenshot « Adding files to a folder». 

9. 4.4.3.1.3.Display folder contents 
Decide here whether to have the folder displayed on a separate page (the 

default) or inline with or without subfolders expanded or collapsed. 

New feature in Moodle 2.5! 

Screenshot «Folder displayed on separate page». 

Screenshot «Folder displayed inline». 

Screenshot «Folder displayed inline with subfolders expanded». 

In Moodle 2.5.2 onwards, all folder names are shown on the course page. 

(Previously the name was not displayed for folders displayed inline.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Щёлкните ссылку «Add an activity or resource», затем в меню выбора Действий 

выберите Folder, затем щёлкните кнопку Add (или выберите Folder из ниспадающего 

меню «Add a resource»). 

3. Введите имя и описание (которые могут потребоваться или, по своему выбору, оставьте 

настройки Администратора). 

4. Щёлкните ссылку «Create folder (создать Папку)», как на снимке ниже; выберите 

название для вашей новой Папки и затем щёлкните «Create folder». 

5. Щёлкните INTO (во) для входа внутрь этой Папки. 

6. Вы можете затем добавить отдельные файлы в эту Папку либо буксировкой в окошко 

(1 на снимке ниже) или щелчком «Add» (2 на снимке ниже), чтобы переслать файлы из 

Сборщика файлов. 

7. Выберите, как вы хотите отображать содержимое вашей Папки, ваши Общие настройки 

модуля и, если разрешено, настройки Обусловленных Действий. 

8. Щёлкните «Save and return to course». 

Снимок с экрана «Создание Папки». 

Снимок с экрана «Добавление файлов в Папку». 

4.4.3.1.3.Отобразить содержимое Папки 
Решите здесь, отображать ли эту Папку на отдельной странице (по умолчанию), 

или встраивать с или без вложенных Папок, а также развёрнутыми или свёрнутыми. 

Новое средство в Moodle 2.5! 

Снимок с экрана «Папка, отображаемая на отдельной странице». 

Снимок с экрана «Папка, отображаемая встроенной». 

Снимок с экрана «Папка, отображаемая с развёрнутыми вложенными Папками». 

В Moodle 2.5.2 и выше все имена Папок показываются на странице Курса. (Ранее 

имя не отображалось для Папок, отображаемых встроенными.) 

http://docs.moodle.org/25/en/File:createfolder.png
http://docs.moodle.org/25/en/File:addtofolder.png
http://docs.moodle.org/25/en/File:folder1.png
http://docs.moodle.org/25/en/File:folder2.png
http://docs.moodle.org/25/en/File:folder3.png
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4.4.3.1.4.Folder capabilities 
Capabilities/mod/folder:view 
 This allows the user to view the contents of a Folder 

 This capability is allowed for the default roles of authenticated user and 

guest 

In Moodle 2.5.2 onwards, folder links on the course page and in the 

navigation are only displayed for users who have this capability. 

(Previously links were displayed for all users, and users without the 

capability obtained an error message when they clicked on a link.) 

See also 
Capabilities/mod/folder:managefiles 
 This allows the user to add, delete, update and move files in a Folder 

 This capability is allowed for the default roles of teacher only 

See also 
Capabilities/mod/folder:view 

Capabilities/mod/folder:addinstance 

 This allows a user to add a new folder to the course 

 This capability is allowed for the default roles of manager and teacher 

4.4.3.1.5.Site administration settings 
The folder module has additional settings which may be changed by an 

administrator in Settings > Site administration > Plugins > Activity 

modules > Folder. 

Require activity description 
This setting allows you to turn off the requirement for users to type 

something into the description box. 

4.4.3.2.Folder resource FAQ 
4.4.3.2.1.I have a folder with linked files in. How 
do I display it on Moodle? 
If you have a folder with linked files such as a website with an index.html 

file or a flash activity with xml/swf and index file then you use the file 

resource instead of the folder resource. See File module settings for details. 

 

4.4.3.2.2.How do I link to a folder in a repository? 
You can add a folder to your course by either creating a folder or 

uploading a zipped file. It is not possible to link to a folder in a repository. 

 

 

4.4.3.1.4.Возможности Папки 
Возможность Capabilities/mod/folder:view 

 Позволяет пользователю просматривать содержимое Папки. 

 Эта Возможность разрешена по умолчанию для Ролей 

Аутентифицированного Пользователя и Гостя. 

В Moodle 2.5.2 и выше ссылки на Папки на странице Курса и в Навигации 

отображаются только для пользователей, которые имеют эту возможность. (Ранее ссылки 

отображались для всех пользователей, но пользователи без этой Возможности получают 

сообщение об ошибке, когда щёлкают по такой ссылке.) 

См. также 
Возможность Capabilities/mod/folder:managefiles 

 Позволяет пользователю добавлять, удалять и перемещать файлы в Папке. 

 Эта Возможность разрешена по умолчанию только для Роли Преподавателя. 

См. также 
Возможность Capabilities/mod/folder:view 
Возможность Capabilities/mod/folder:addinstance 

 Позволяет пользователю добавлять новую Папку в Курс. 

 Эта Возможность разрешена по умолчанию для Ролей Менеджера и Преподавателя. 

4.4.3.1.5.Настройки управления Сайтом 
Модуль «Папка» имеет дополнительные настройки, которые может изменить 

Администратор в AdministrationSite administrationPluginsActivity modulesFolder. 

 

Потребовать описания Ресурса 
Эта настройка позволяет отключить требование для пользователей что-то набирать 

в окошке «Description (описание)» 

4.4.3.2.Часто задаваемые вопросы по Ресурсу «Папка». 
4.4.3.2.1.У меня есть Папка файлами-ссылками в ней. Как 
отобразить это в Moodle? 

Если вы имеет папку с файлами, вызываемыми по ссылке, такую как веб-Сайт с 

index.html-файлом, или Интерактивное Действие, содержащее flash, с xml/swf- и index-

файлом, тогда вы используйте Ресурс «Файл» (п. 4.4.2) вместо Ресурса «Папка». 

Подробности смотрите в настройках модуля «Файл» (п. 4.4.2.1). 

4.4.3.2.2.Как сослаться на Папку в репозитории? 
Вы можете добавить Папку в ваш Курс либо путём создания Папки, либо путём 

пересылки zip-файла. Невозможно сослаться на папку в репозитории.
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See the forum discussion How do we link to an existing directory in 2.0? 

for more details. 

4.4.3.2.3.Can I prevent forcedownload behaviour 
in files in a folder? 
Not at present. See this discussion:  

See this tracker item. 

4.4.3.2.4.How can I allow students to upload to a 
folder I have displayed? 
[See this forum post on allowing students to add files to folders|. 

4.4.4.IMS content package 
The acronym IMS originally stood for Instructional Management Systems; 

but the full term was quickly dropped and now only IMS is used. 

IMS is a body which helps to define technical standards for various things, 

including e-learning material. 

The IMS Content Packaging specification makes it possible to store chunks 

of material in a standard format which can be re-used in different systems, 

without having to convert the material into new formats. 

The IMS content package in Moodle enables such content packages to be 

uploaded and included in Moodle courses. 

There are various options for displaying content with a navigation menu or 

buttons etc. 

4.4.4.1.IMS content package settings 
4.4.4.2.IMS content package FAQ 

4.4.5.Label 
A label serves as a spacer on a Moodle course page. It can be used to add 

text, images, multimedia or code in between other resources in the 

different sections. It is a very versatile resource and can help to improve 

the appearance of a course if used thoughtfully. Banners or descriptions 

may be added to labels to distinguish between and highlight different areas. 

 

On the other hand, over-use of multimedia (sound,video) in labels can slow 

down the loading of a course page. 

(Example of a label with an embedded mp3 file) 

Text, images and URLs can be embedded into labels by drag and drop See 

Using Label. 

 

 

Больше подробностей можно почерпнуть из обсуждения на форуме «Как нам 

сослаться на существующий каталог в 2.0?». 

4.4.3.2.3.Можно предотвратить режим принудительного 
скачивания файлов в Папку? 

Пока нет. См. это обсуждение. 

См. этот элемент средства отслеживания. 

4.4.3.2.4.Как разрешить Студентам пересылать в Папку, 
которую я отобразил? 

[См. сообщение этого форума о разрешении Студентам добавлять файлы в Папки] 

4.4.4.Пакет с IMS содержимым 
Акроним IMS первоначально означал Системы управления Образованием; но 

полный термин был быстро отброшен и сейчас используется только IMS. 

IMS – это основа, которая помогает определять технические стандарты для разных 

вещей, включая материалы интернет-обучения. 

Спецификация пакетирования IMS содержимого делает возможным сохранять 

большое количество материала в стандартном формате, который может быть повторно 

использован в различных системах без конвертирования в новые форматы. 

Пакет с IMS содержимым в Moodle позволяет переслать по сети и включить в Курс 

Moodle пакеты с таким содержимым. 

Существуют различные опции для отображения содержимого с навигационным 

меню или кнопками и т.д. 

4.4.4.1.Настройки пакета с IMS содержимым  См. 
4.4.4.2.Часто задаваемые вопросы о пакетах IMS См. 

4.4.5.Этикетка 
Этикетка служит в качестве разделителя на странице Курса Moodle. Она может 

быть использована для вставки текста, изображений, мультимедиа или кода между 

другими Ресурсами в разных разделах Курса. Это очень разносторонний Ресурс и может 

помочь улучшить внешний вид Курса, если использован вдумчиво. Баннеры и описания 

могут вставляться в Этикетки, чтобы провести различия между разными областями и 

подсветить их. 

С другой стороны, чрезмерное использование мультимедиа (звук, видео) в 

Этикетках могут замедлить загрузку страниц Курса. 

(Пример Этикетки с встроенным mp3-файлом) 

Текст, изображения и адреса URL могут быть 

встроены в Этикетки посредством буксировки. См. п. 4.4.5.2 (применение Этикетки). 

http://moodle.org/mod/forum/discuss.php?d=172245
http://moodle.org/mod/forum/discuss.php?d=172245
https://moodle.org/mod/forum/discuss.php?d=184088
https://tracker.moodle.org/browse/MDL-28501
https://moodle.org/mod/forum/discuss.php?d=226831#p985008
http://docs.moodle.org/25/en/IMS_content_package_module_settings
http://docs.moodle.org/25/en/IMS_content_package_FAQ
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 4.4.5.1.Label module settings 
4.4.5.1.1.Adding a label 
With the editing turned on to a course by choosing Label from the "Add an 

activity or resource" link (or, if not present, the "Add a resource" drop 

down menu) in the section where you want to add your menu. Click 

"Expand all" top right to see all the settings expanded. 

4.4.5.1.2.General 
Screenshot «Collapsed view of editor». 

Screenshot «Click to display the editing tools and drag the bottom right to 

enlarge the editor». 

 Type your chosen words or add your resources. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.4.5.1.Настройки модуля «Этикетка» 
4.4.5.1.1.Добавление Этикетки 
При включённом режиме редактирования в Курсе посредством выбора Label из ссылки 

Add an activity or resource (или, если не присутствует, из ниспадающего меню Add a 

resource) в разделе, куда вы хотите добавить ваше меню. Щёлкните «Expand all» вверху 

справа, чтобы увидеть все настройки развёрнутыми. 

4.4.5.1.2.Общие настройки 
Снимок с экрана «Сжатый вид редактора». 

Снимок с экрана «Щёлкни, чтобы отобразить инструменты редактирования, и перетащи 

правый нижний уголок, чтобы увеличить редактор». 

 Наберите ваши выбранные слова или добавьте ваши Ресурсы. 

http://docs.moodle.org/25/en/File:labelcollapsed.png
http://docs.moodle.org/25/en/File:labelexpanded.png
http://docs.moodle.org/25/en/File:labelexpanded.png
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 Note: Because the label has the TinyMCE text editor, it is possible not 

just to type words but also to add images, links, media or code from 

within the labels' editor. See here for suggestions about using labels in 

your course. 

4.4.5.1.3.Common module settings 
 Leave Common Module settings as "show" for the label to be visible. 

  

4.4.5.1.4.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

 Click "Save and return to course". 

 You can now use the move icon (crosshair or up/down arrow) to move 

your label to where you wish it to display. 

 

4.4.5.1.5.Label capabilities 
Capabilities/mod/label:addinstance 

 This allows a user to add a new label to a course 

 This capability is allowed for the default roles of manager and teacher 

Screenshot. 

4.4.5.2.Using Label 
4.4.5.2.1.Adding images to a label 
Drag and drop images 
Note: this does not work with IE 9, Safari 6 or below or earlier versions of 

Firefox)     New feature in Moodle 2.5! 

 Media drag and drop must be enabled in Administration > Site 

administration > Plugins > Activity modules > Label 

 With the editing turned on, drag your image into the section you want it 

to appear. 

 In the box that follows, choose "add image" 

 It will appear embedded in a label. 

Screenshot «Drag an image onto your course page». 

Screenshot «Choose "add image.."». 

Screenshot «And here it is!».  

Conventional method 

 Follow the instructions for adding a label 

 Click the image icon in the text editor 

 Click "Find or upload an image" 

 Замечание: Из-за того, что Этикетка имеет TinyMCE-текстовый редактор, можно не 

просто набрать слова, но также вставить изображения, ссылки, медиа или код изнутри 

этого редактора Этикетки. См. здесь предложения по применению Этикеток в вашем 

Курсе. 

4.4.5.1.3.Общие настройки модуля 
 Оставьте общие настройки модуля как «Show (показать)» для Этикетки, чтобы она 

была видимой. 

4.4.5.1.4.Ограничить доступ/Завершение Действия 
Эти настройки видимы, если Обусловленные Действия и Завершение Действия 

разрешены на Сайте и в Курсе. 

 Щёлкните «Save and return to course (сохранить и вернуться в Курс)». 

 Вы можете теперь использовать иконку перемещения (перекрестие или стрелочка 

вверх/вниз), чтобы переместить вашу Этикетку туда, где бы вы хотели, чтобы она 

отображалась. 

4.4.5.1.5.Возможности Этикетки 
Возможность Capabilities/mod/label:addinstance 

 Позволяет пользователю добавить новую Этикетку в Курс. 

 Эта Возможность разрешена по умолчанию для Ролей Менеджера и Преподавателя. 

Снимок с экрана. 

4.4.5.2.Применение Этикетки 
4.4.5.2.1.Добавление изображений в Этикетку 
Буксировка изображений 

Замечание: Это не работает с IE 9, Safari 6 или ниже или ранними версиями Firefox. 

Новое средство в Moodle 2.5! 

 Буксировка медиа должна быть разрешена в 

AdministrationSite administrationPluginsActivity modulesLabel. 

 При включённом режиме редактирования перетащите ваше изображение в раздел, где 

бы вы хотели, чтобы оно появилось. 

 В окошке, которое за этим последует, выберите «Add image (добавить изображение)». 

 Оно появится встроенным в Этикетку. 

Снимок с экрана «Перетащите изображение на страницу вашего Курса». 

Снимок с экрана «Выберите "Add image.."». 

Снимок с экрана «И оно здесь!». 

Обычный метод 
 Следуйте инструкциям по добавлению Этикетки. 

 Щёлкните иконку Image в текстовом редакторе. 

 Щёлкните «Find or upload an image (Найти и переслать изображение)». 

http://docs.moodle.org/25/en/HTML_editor
http://docs.moodle.org/25/en/Using_Label
http://docs.moodle.org/25/en/File:newlabel25.png
http://docs.moodle.org/25/en/File:dragdrop1.png
http://docs.moodle.org/25/en/File:dragdrop2.png
http://docs.moodle.org/25/en/File:dragdrop3.png
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 Choose and upload your image using the filepicker. (Details on how to 

do this here) 

 Leave Common module settings at "show" if you wish the label to be 

visible 

 Click "Save and return to course" 

4.4.5.2.2.Adding text to a label 
Conventional method 
As the label uses the Text editor it is straightforward to enter text and other 

required symbols and equations. It is however possible also to drag and 

drop text directly into a label. 

Drag and drop text 
Note: this does not work with IE, Safari 6 or below and is unreliable with 

Firefox New feature in Moodle 2.5! 

 Drag and drop upload of text/links must be enabled in Administration > 

Site administration > Development > Experimental > Experimental 

settings 

 Select the text you wish to use, for example in a Word document. 

 With the editing turned on, drag the text over to the section you want it 

to appear. 

 From the box that appears, choose "add a label" and then "upload". 

 

Screenshot «Text selected from a Word document is dragged over». 

Screenshot «Choose "add a label" (or page if you prefer)». 

Screenshot «And here it is!». 

4.4.5.2.3.Adding a link to a label 
Conventional method 
As the label uses the Text editor it is straightforward to click the "link" 

icon and enter your linked URL. It is however possible also to drag and 

drop links directly into a label. 

Drag and drop links 
Note: this does not work with IE, Safari 6 or below and is unreliable with 

Firefox 

 Drag and drop upload of text/links must be enabled in Administration > 

Site administration > Development > Experimental > Experimental 

settings 

 Open up a new window with the URL you wish to link to. Select the 

link in the browser bar. 

 With the editing turned on, drag the URL over to the section you want it 

 Выберите и перешлите ваше изображение, используя файловое меню. (Как это делать 

см. здесь) 

 Оставьте общие настройки модуля в «Show», если вы хотите, чтобы Этикетка была 

видима. 

 Щёлкните «Save and return to course». 

4.4.5.2.2.Добавление текста в Этикетку 
Обычный метод 

Поскольку Этикетка использует текстовый редактор, просто введите текст и 

другие символы и уравнения. Однако также можно отбуксировать текст прямо в Этикетку. 

 

Буксировка текста 
Замечание: Это не работает с IE 9, Safari 6 или ниже и ненадёжно с Firefox.  

Новое средство в Moodle 2.5! 

 Пересылка буксировкой текста/ссылок должна быть разрешена в 

AdministrationSite administrationDevelopmentExperimentalExperimental settings. 

 

 Выберите текст, который хотите использовать, например, в Word-документе. 

 При включённом режиме редактирования перетащите текст в раздел, где бы вы хотели, 

чтобы он появился. 

 В окошке, которое за этим последует, выберите «Add label (добавить Этикету)» и 

затем «Upload (переслать)». 

Снимок с экрана «Отбуксированный выбранный из Word-документе текст». 

Снимок с экрана «Выберите "Add label" (или Page, если предпочитаете)». 

Снимок с экрана «И он – здесь!». 

4.4.5.2.3.Добавление ссылки в Этикетку 
Обычный метод 
Поскольку Этикетка использует текстовый редактор, просто щёлкните иконку «Link 

(ссылка)» и введите ваш соответствующий URL. Однако также можно отбуксировать 

ссылки прямо в Этикетку. 

Буксировка текста 
Замечание: Это не работает с IE 9, Safari 6 или ниже и ненадёжно с Firefox. 

 

 Пересылка буксировкой текста/ссылок должна быть разрешена в 

AdministrationSite administrationDevelopmentExperimentalExperimental settings. 

 Откройте новое окно с тем URL, на которое хотите сослаться. Выберите ссылку в 

панели браузера. 

 При включённом режиме редактирования перетащите её в раздел, где бы вы хотели,  

http://docs.moodle.org/25/en/File_picker
ht%20http:/docs.moodle.org/25/en/File:textdragdrop1.png
http://docs.moodle.org/25/en/File:textdragdrop2.png
http://docs.moodle.org/25/en/File:textdragdrop3.png
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to appear. 

 From the box that appears, name the link and then click "upload". 

 

Screenshot «Select your URL ». 

Screenshot «Name the link». 

Screenshot «Here it is! ». 

4.4.5.2.4.Adding sound or video to a label 
If multimedia filters are enabled, a label is a neat way of displaying sound 

or video in an inline player on the course page. 

 Follow the instructions for adding a label 

 Click the media icon in the text editor 

 Click "Find or upload an sound, video or applet" 

 

 Choose and upload your sound or video file using the filepicker.(Details 

on how to do this here) 

 Note: You can search youtube for a video to embed if your admin has 

enabled the youtube repository. 

 Leave Common module settings at "show" if you wish the label to be 

visible. 

 Click "Save and return to course"  

4.4.5.2.5.Adding code to a label 
An example of this is the ability to embed a Google map into a label. 

 

 Follow the instructions for adding a label 

 Click the HTML icon in the text editor 

 This brings up the screen in code (HTML) view. 

 Paste the code you grabbed from Google maps into this screen 

 

 Scroll down and click "Update" 

 Leave Common module settings at "show" if you wish the label to be 

visible. 

 Click "Save and return to course" 

4.4.5.2.6.See also 
Using Moodle forum discussions: 

Right align not behaving as desired 

 

 

 

чтобы она появилась. 

 В окошке, которое за этим последует, выберите имя этой ссылки и затем щёлкните 

«Upload (переслать)». 

Снимок с экрана «Выберите ваш URL». 

Снимок с экрана «Поименуйте вашу ссылку». 

Снимок с экрана «И она – здесь!». 

4.4.5.2.4.Добавление звука или видео в Этикетку 
Если мультимедиа фильтры разрешены, Этикетка – изящный способ воспроизведения 

звука или видео посредством встроенного плейера на странице Курса. 

Следуйте инструкциям по добавлению Этикетки. 

 Щёлкните иконку Media в текстовом редакторе. 

 Щёлкните «Find or upload sound, video or applet (Найти 

или переслать звук, видео или приложение)». 

 Выберите и перешлите ваш звуковой или видео-файл, используя файловое меню. (Как 

это делать см. здесь) 

 Замечание: Вы можете отыскать в Youtube видео для встраивания, если ваш 

Администратор разрешил использовать репозиторий Youtube. 

 Оставьте общие настройки модуля в «show», если хотите, чтобы ваша Этикетка была 

видима. 

 Щёлкните «Save and return to course». 

4.4.5.2.5.Добавление кода в Этикетку 
Примером этого является возможность встроить в Этикетку Google 

map (карту Google). 

 Следуйте инструкциям по добавлению Этикетки. 

 Щёлкните иконку HTML в текстовом редакторе. 

 Это переведёт вид экрана в коды (HTML). 

 Вставьте код, который вы захватили из Google map в этот 

экран. 

 Прокрутите экран вниз и щёлкните «Update (обновить)». 

 Оставьте общие настройки модуля в «show», если хотите, чтобы 

ваша Этикетка была видима. 

 Щёлкните «Save and return to course». ▬► 

4.4.5.2.6.См. также 
Использование обсуждений форума Moodle «Выравнивание 

вправо ведёт себя не так как желательно». 

http://docs.moodle.org/25/en/File:linkdragdrop1.png
http://docs.moodle.org/25/en/File:linkdragdrop2.png
http://docs.moodle.org/25/en/File:linkdragdrop3.png
http://docs.moodle.org/25/en/File_picker
http://moodle.org/mod/forum/discuss.php?d=165626
http://moodle.org/mod/forum/discuss.php?d=165626
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4.4.5.3.Label FAQ 
4.4.5.3.1.I am no longer able to edit a label. What 
can I do? 
If you add something to a label that Moodle doesn't like or recognise, it can 

sometimes disfigure your page such that you lose the label editing icon. To 

remove the offending item without having access to the editing icon: 

 

1. Log in to your Moodle 

2. Right click on your page to see the source code. 

3. Find where your label's code is(if it has text, look for the text) 

4. You should have something like class="activity label" id="module-310. 

The number will be the number of the label you want to edit - so 

remember its number and then: 

5. Open a new tab or new window in your browser and type this in 

http://yourmoodle/course/modedit.php?update=310&return=0 where 

the number is the number of the label you want to edit. It should take 

you straight to editor to edit the label. 

6. Delete the contents, save and start again 

4.4.5.3.2.See also 
"How to edit a label with no edit icon video" and  

PDF "Moodle 1.9 How to fix corrupted Labels Moodle" - by Maryel 

Mendiola (PDF, 1.84 MB, Sep 2009) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.4.5.3.Часто задаваемые вопросы по Этикетке 
4.4.5.3.1.Я больше могу редактировать Этикетку. Что мне 

делать? 
Если вы что-нибудь добавили в Этикетку, что не нравится или не распознаётся 

Moodle, это может иногда испортить вашу страницу так, что вы потеряете иконку 

редактирования Этикетки. Чтобы удалить бракованный элемент, не имеющий иконки 

редактирования: 

1. Зарегистрируйтесь в вашей Moodle. 

2. Щёлкните правой клавишей мышки на вашей странице, чтобы увидеть исходный код. 

3. Отыщите, где код вашей Этикетки (если это текст, просмотрите текст). 

4. Вы должны отыскать нечто подобное class="activity label" id="module-310. Число будет 

номером Этикетки, которую вы хотите отредактировать – так что запомните это число, 

а затем: 

5. Откройте в вашем браузере новую таблицу или новое окно и наберите в нём: 

http://yourmoodle/course/modedit.php?update=310&return=0, где число – номер Этикетки, 

которую вы хотите отредактировать. Это должно привести вас прямо в редактор, чтобы 

отредактировать Этикетку. 

6. Удалите содержимое, сохраните и начните сначала. 

4.4.5.3.2.См. также 
«Как редактировать Этикетку, не имеющую иконки редактирования видео» и  

PDF-файл «Moodle 1.9. Как исправить испорченную Этикетку Moodle» от Мариеля 

Мендиолы (PDF, 1.84 MB, сентябрь 2009). 

http://yourmoodle/course/modedit.php?update=310&return=0,%20где
http://www.youtube.com/watch?v=DXIhDt5rCmc
http://groups.google.com/group/moodlersLA/files
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4.4.6.Page 
The student sees a single, scrollable screen that a teacher creates with the 

robust HTML editor 

Page resource 
A page resource creates a link to a screen that displays the content created 

by the teacher. The robust Text editor allows the page to display many 

different kinds of content such as plain text, images, audio, video, 

embedded code or a combination of all these. 

Screenshot. 

In certain cases it might be preferable to use the page resource instead of 

uploading a word-processed document, particularly if the document 

contains text that is just to be read and not downloaded. 

 

4.4.6.1.Page resource settings 
4.4.6.1.1.Adding a new page to your course 
 From the the "Add an activity or resource" link (or, if not present, the 

"Add a resource" drop down menu), choose Page All settings may 

expanded by clicking the "Expand all" link top right. 

 In the "Adding a new page" screen that follows, give your page a name 

and a description (which may or may not be required according to 

admin settings) 

 Add your content to the Page content section. 

4.4.6.1.2.General 
Name 
Whatever you type here will form the link learners click on to view the 

page so it is helpful to give it a name that suggests its purpose. 

Description 
Add a description of your page here. Click "Show editing tools" to display 

the rich text editor, and drag the bottom right of the text box out to expand 

it. 

Display description on the course page 
If this box is ticked, the description will appear on the course page just 

below the name of the page. 

4.4.6.1.3.Content 
Screenshot «Content settings expanded by default». 

Add your page content here. You can use the features of the Text editor to 

add media, images, links and more. 

4.4.6.Страница 
Каждый из Студентов видит единственный прокручиваемый экран, который 

Преподаватель создаёт посредством полноценного HTML-редактора. 

Ресурс «Страница» 
Ресурс «Страница» создаёт ссылку на экран, который отображает содержимое, 

созданное Преподавателем. Полноценный HTML-редактор позволяет отображать на 

Странице много различных типов содержимого, таких как простой текст, изображения, 

аудио, видео, встроенный код или комбинацию из всего этого. 

Снимок с экрана. 

В определённых случаях может оказаться предпочтительнее использовать 

Ресурс «Страница», вместо пересылки подготовленного в Word документа, в 

частности, если документ содержит текст, который должен просто читаться, но не 

скачиваться. 

4.4.6.1.Настройки Ресурса «Страница» 
4.4.6.1.1.Добавление новой Страницы в ваш Курс 
 По ссылке «Add an activity or resource» (или, если не присутствует, из ниспадающего 

меню «Add a resource») выбираем Page. Все настройки могут быть развёрнуты щелчком 

по ссылке «Expand all» вверху справа. 

 На экране «Adding a new page (добавление новой Страницы)», который последует, 

задайте вашей странице наименование и описание (которое может быть, а может и 

не быть затребовано, в соответствии с настройками Администратора). 

 Добавьте содержимое в раздел содержимого Страницы. 

4.4.6.1.2.Обычные настройки 
Наименование 

Всё, что вы наберёте здесь, сформирует ссылку, щёлкнув которую учащиеся 

увидят эту Страницу, так что полезно дать ей наименование, отражающее её назначение. 

Описание 
Добавьте описание вашей Страницы здесь. Щёлкните «Show editing tools», чтобы 

отобразить полный текстовый редактор и перетащите за правый нижний уголок текстовое 

окошко, чтобы расширить его. 

Отображать описание на странице Курса 
Если это окошко отмечено, описание появится на странице вашего Курса как раз 

под наименованием вашей Страницы. 

4.4.6.1.3.Содержимое 
Снимок с экрана «Настройки содержимого, развёрнутые по умолчанию». 

Добавьте содержимое вашей страницы здесь. Вы можете использовать средства Редактора 

текста (п. 4.2) для добавления медиа, изображений, ссылок и другого. 

http://docs.moodle.org/25/en/File:Pageexample.png
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4.4.6.1.4.Appearance 
Choose here whether or not to display the page name and/or description 

along with the page content when a user clicks on the page. 

If the administrator has allowed both 'open' and 'pop-up' as display options 

(from Administration>Site administration>Plugins>Activity 

modules>Page), you will have additonal display settings here. 

4.4.6.1.5.Common module settings 
See Common module settings 

4.4.6.1.6.Restrict access/Activity completion 
These settings are visible if Conditional activities and Activity completion 

have been enabled in the site and the course. 

4.4.6.1.7.Page module capabilities 
Capabilities/mod/page:view 

 This allows the user to view a Page resource 

 This capability is allowed for the default roles of authenticated user and 

guest 

In Moodle 2.5.2 onwards, page resource links on the course page and in the 

navigation are only displayed for users who have this capability. 

(Previously links were displayed for all users, and users without the 

capability obtained an error message when they clicked on a link.) 

 

Capabilities/mod/page:addinstance 
 This allows a user to add a new page resource to the course 

 This capability is allowed for the default roles of manager and teacher 

4.4.6.1.8.Site administration settings 
The page module has additional settings which may be changed by an 

administrator in Administration > Site administration > Plugins > Activity 

modules > Page. 

Require activity description 
This setting allows you to turn off the requirement for users to type 

something into the description box. 

Available display options 
This setting allows you to add different ways the resource may be 

displayed on the course page. 

Default values for activity settings 
Here you can set the defaults for this resource. You can also choose which 

setting(s) to class as "Advanced". These settings will only then appear if 

the user clicks "Show advanced" in the settings. 

4.4.6.1.4.Внешний вид 
Выберите здесь отображать или нет наименование Страницы и/или описание 

наряду с содержимым Страницы, когда пользователь щёлкнет по этой Странице. 

У вас здесь будут дополнительные опции отображения, если Администратор 

разрешил обе опции отображения «Open (открывать)» и «Pop-up (всплывающий)» (из 

AdministrationSite administrationPluginsActivity modulesPage), 

4.4.6.1.5.Общие настройки модуля 
См. п. 6.1. 

4.4.6.1.6.Ограничить доступ/Завершение Действия 
Эти настройки видимы, если Обусловленные Действия и Завершение Действия 

разрешены на Сайте и в Курсе. 

4.4.6.1.7.Возможности модуля «Страница» 
Возможность Capabilities/mod/page:view 

 Позволяет пользователю просматривать Ресурс «Страница». 

 Эта Возможность по умолчанию предоставлена Ролям 

Аутентифицированного Пользователя и Гостя. 

В Moodle 2.5.2 и выше ссылки на Ресурс «Страница», которые есть на странице 

Курса, при навигации отображаются только для тех пользователей, которые имеют эту 

Возможность. (Предыдущие ссылки отображались для всех пользователей, но 

пользователи без Возможности доступа получали сообщение об ошибке, когда щёлкали по 

ссылке.) 

Возможность Capabilities/mod/page:addinstance 
 Позволяет пользователю добавлять новый Ресурс «Страница» в Курс. 

 Эта Возможность разрешена по умолчанию Ролям Менеджера и Преподавателя. 

4.4.6.1.8.Настройки управления Сайтом 
Модуль «Страница» имеет дополнительные настройки, которые могут быть изменены 

Администратором в 

AdministrationSite administrationPluginsActivity modulesPage. 

Потребовать описание Действия 
Эта настройка позволяет вам отключить требование для пользователей набирать 

что-нибудь в окошке описания. 

Доступные опции отображения 
Разрешают вам добавлять различные способы того, как этот Ресурс может 

отображаться на странице Курса. 

Значения по умолчанию для настроек Действия 
Здесь вы можете установить значения по умолчанию для этого Ресурса. Вы можете 

также выбрать какие настройки классифицировать как «Advanced». Эти настройки будут 

появляться только после щелчка пользователя по «Show advanced» в настройках. 
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4.4.6.2.Using Page 
4.4.6.2.1.Why a page and not a file? 
1. Opens seamlessly - no clunky attempts to launch third party software 

(e.g. Microsoft Word) which some users may not be able to access. 

 

2. Can be accessed by mobile devices e.g. smartphones (again, not all 

smartphones can handle word-processed documents). 

3. Much easier for the Teacher to edit (i.e. saves time) 

4. Much more accessible, and readily configurable for reading (easier to 

resize text, change colours, etc, in the web browser) 

5. Can contain links - e.g. to files, to web pages, or to Glossary entries 

 

When to use a page rather than a file 
Use a page if: 

 The document doesn't need to be printed 

 You need to update it fairly often 

 You don't need to impose strict control over the way it looks (for 

accessibility reasons you should, if educationally appropriate, avoid 

taking control) 

 Your students may need to refer to it (on their smartphone for example) 

frequently for reference e.g. timetable, schedule, tutorial groups, 

reading list. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.4.6.2.Применение Страницы 
4.4.6.2.1.Почему Страница, а не Файл? 
1. Открывается сразу – без неуклюжих попыток запуска программного обеспечения 

третьей стороны (например, Microsoft Word), к которому некоторые пользователи не 

имеют доступа. 

2. Может быть доступна с мобильных устройств, например смартфонов (опять же не все 

смартфоны могут обрабатывать документы, подготовленные в Word). 

3. Много легче Преподавателю редактировать (например, время сохранения). 

4. Намного более доступна и конфигурируема для чтения (легче изменить размер текста, 

изменить цвета, и т.д. в веб-браузере). 

5. Может содержать ссылки – например, на Файлы, Веб-страницы или на Записи 

Глоссария. 

Когда использовать Страницу, а не Файл? 
Используйте Страницу, если: 

 Документ не нужно распечатывать. 

 Вам необходимо обновлять его довольно часто. 

 Вам не нужно навязывать строгий контроль способам его просмотра (основанием 

поступить так являются педагогические принципы по избеганию излишнего контроля). 

 

 Ваши Студенты могут нуждаться в частом обращении к ней (с их смартфона, 

например) для получения справки, скажем, о расписании, графике, об учебных группах, 

списке литературы. 
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4.4.6.2.2.How to create a page 
Typing directly into the Editor 
See Page module settings 

Drag and drop text into a page 
It's possible to select text from a website or a word processed document 

and create a page by drag and drop. 

Note: this does not work with IE, Safari 6 or below and is unreliable with 

Firefox 

 Drag and drop upload of text/links must be enabled in Administration > 

Site administration > Development > Experimental > Experimental 

settings 

 Select the text you wish to use, for example in a Word document. Note: 

Pasting from MS Word is fraught with danger. See #Pasting from 

another document below. 

 With the editing turned on, drag the text over to the section you want it 

to appear. 

 From the box that appears, choose "Create a new page resource" 

 

 Give it a name and then click "upload". 

Screenshot «Select your text and drag into the course page». 

Screenshot «Give your page a name». 

Screenshot «The page is created». 

Screenshot «View of the page created from dragged and dropped text». 

Pasting from another document 
To safeguard against unpredictable, ugly, and inaccessible results, it's 

important to take some easy extra steps when pasting word processed and 

other text into web authoring software including Moodle. 

 

1. Open the document containing the text you want to paste into your new 

Page, and copy that text ready to paste. 

 

2. Follow steps 1-6 for the section above on 'Typing directly into the 

editor'. 

3. When you are ready to paste the content into Moodle, you have two 

choices: 

4. If you want to keep the original formatting then click the Paste From 

Word icon; a pane loads containing an empty text field and you can 

press your keyboard's Control and V keys to paste what you copied into 

the text field; then click the Insert button; your text appears 

4.4.6.2.2.Как создать Страницу 
Набор прямо в редакторе 

См. настройки модуля «Страница» в п. 4.4.6.1.1 – 4.4.6.1.6. 

Отбуксировать текст на Страницу 
Есть возможность выбрать текст с веб-Сайта или Word-документа и создать 

Страницу посредством буксировки. 

Замечание: это не работает с IE, Safari 6 или ниже и ненадёжно с Firefox. 

 

 Пересылка буксировки текста/ссылок должна быть разрешена в 

AdministrationSite administrationDevelopmentExperimentalExperimental settings. 

 

 Выберите текст, который вы желаете использовать, например из Word-документа. 

Замечание: Вклеивание из MS Word полно опасности. См. «Вклеивание из другого 

документа» ниже. 

 При включённом режиме редактирования отбуксируйте текст в раздел Курса, в 

котором вы хотите, чтобы он появился. 

 Из окошка, которое появится, выберите «Create a new page resource (создать новый 

Ресурс «Страница»)» 

 Дайте ей наименование и затем щёлкните «Upload (переслать)». 

Снимок с экрана «Выберите ваш текст и перетащите на страницу Курса». 

Снимок с экрана «Задайте вашей Странице наименование» 

Снимок с экрана «Страница создана». 

Снимок с экрана «Просмотрите страницу, созданную буксировкой текста». 

Вклеивание из другого документа 
Чтобы обезопасить себя от непредсказуемых, неприятных и недоступных 

результатов, важно предпринять некоторые дополнительные шаги при вклеивании 

обработанного Word или другого текста в специализированное программное обеспечение, 

позволяющее разрабатывать интерактивные мультимедийные приложения, включая 

систему Moodle. 

1. Откройте документ, содержащий текст, который вы хотите вклеить в вашу новую 

Страницу, и скопируйте этот текст (выделите нужное, нажмите правую клавишу мыши 

и пункт ниспадающего меню «копировать») готовый для вклеивания. 

2. Следуйте шагам 1-6 вышеприведённого раздела «Набор прямо в редакторе». 

3. Когда вы готовы вклеить это содержимое в Moodle, вы имеете два варианта: 

 

4. Если вы хотите сохранить первоначальное форматирование, тогда щёлкните иконку 

«Paste From Word (вклеить из Word)»; Окошко Вклеивания загрузит имеющееся пустое 

текстовое поле, и вы можете нажать на клавиатуре клавиши Ctrl и V, чтобы вклеить то, 

что вы скопировали, в это текстовое поле; затем щёлкните кнопку Insert; появится ваш  

http://docs.moodle.org/25/en/File:pagedragdrop1.png
http://docs.moodle.org/25/en/File:pagedragdrop2.png
http://docs.moodle.org/25/en/File:pagedragdrop3.png
http://docs.moodle.org/25/en/File:pagedragdrop4.png
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and can be edited within learn.gold. N.b. if the original formatting does 

not conform to Web accessibility requirements, it won't be transferred. 

 

5. Alternatively, if you want to strip away all formatting, rather than the 

Paste From Word icon you instead click the Paste As Plain Text icon 

and proceed to paste directly. 

6. Follow steps 8-9 for the section above on 'Typing directly into the 

editor'. 

4.4.6.3.Page FAQ 
4.4.6.3.1.I've finished my page but it won't let me 
save it. Why not? 
The most common reason for this is that you added all your content to the 

description and not the page itself - go back and look in the Page content 

section and make sure you have content there 

Screenshot. 

4.4.6.3.2. How do I make my page open in a pop-
up? 

An administrator can enable page resources to open in a pop-up by 

selecting the display option 'In pop-up' in Administration > Site 

administration > Plugins > Activity modules > Page. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

текст, и он может быть отредактирован внутри learn.gold. N.b, если первоначальное 

форматирование не отражает требований доступа в веб-систему, это не может быть 

перенесено. 

5. С другой стороны, если вы хотите удалить всё форматирование, вместо иконки Paste 

From Word щёлкните иконку «Paste As Plain Text (вклеить как простой текст)» и 

выполните само вклеивание. 

6. Следуйте шагам 8-9 вышеприведённого раздела «Набор прямо в редакторе». 

 

4.4.6.3.Часто задаваемые вопросы по Странице 
4.4.6.3.1.Я завершил свою Страницу, но она не позволяет 
мне её сохранить. Почему не? 

Наиболее общей причиной этого является то, что вы добавили всё ваше 

содержимое в окошко описания, а не в саму Страницу – вернитесь и просмотрите раздел 

содержания Страницы, и убедитесь, что содержимое в нём. 

Снимок с экрана. 

4.4.6.3.2.Как сделать мою страницу открываемой во 
всплывающем окошке? 

Администратор может разрешить открывать Ресурсы «Страница» во всплывающем 

окошке выбором опции отображения «In pop-up (во всплывающем окошке)» в 

AdministrationSite administrationPluginsActivity modulesPage. 

http://docs.moodle.org/25/en/File:Pagecontent.png
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4.5.Blocks 
How to add extra items and information to the sides of your course page. 

 

Blocks are items which may be added to the left or right or centre column 

of any page in Moodle. They may also be added to the centre of the My 

Home (My Moodle) page. You can theme the position of blocks in the 

centre of pages as well. 

Any block can be made 'sticky' so that it appears in all the contexts below, 

such as throughout a course or a particular activity - see Block settings. 

 

Blocks can be placed on the side of the screen (if your theme supports it) 

via the Dock icons (Dock to block.png and Block to dock.png ). 

4.5.1.Standard blocks 
Available blocks include: 

Activities 

Admin bookmarks 

Administration (new name for Settings block) 

Blog menu 

Blog tags 

Calendar 

Comments 

Community finder 

Course completion status 

Course overview 

Course/site summary 

Courses 

Feedback 

Flickr 

 

HTML 

Latest news 

Logged in user 

Login 

Main menu 

Mentees block 

Messages 

My latest badges 

My private files 

Navigation 

4.5.Блоки 
Как добавлять дополнительные элементы и информацию на боковые поля 

страницы вашего Курса. 

Блоки являются элементами, которые могут быть добавлены слева, справа или в 

центральную колонку любой страницы Moodle. Они также могут добавляться в центр 

страницы My Home (My Moodle – моя домашняя страница, моя Moodle). Кроме того, вы 

можете расположить блоки в центре страниц. 

Любой Блок можно сделать «прилипчивым», чтобы он появлялся во всех 

Контекстах нижних уровней, например, на всём протяжении Курса или конкретного 

Интерактивного Действия – см. «Настройки Блока» (п. 4.5.3). 

Блоки могут быть помещены в док, на боковой край экрана (если ваша 

тематическая Фоновая Картинка поддерживает это) через иконки Dock (док, см. здесь). 

4.5.1.Стандартные Блоки 
К доступным Блокам относятся: 

Activities (Действия: Интерактивные Действия и Ресурсы) 

Admin bookmarks (Закладки Администратора) 

Administration (Управление – новое название для Блока Настроек) 

Blog menu (Меню Блога) 

Blog tags (Тэги Блога) 

Calendar (Календарь) 

Comments (Комментарии) 

Community finder (Поисковик сообществ) 

Course completion status (Состояние Завершения Курса) 

Course overview (Обзор Курса) 

Course/site summary (Резюме Курса/Сайта) 

Courses (Курсы) 

Feedback (ОбратнаяСвязь) 

Flickr (сервис, предназначенный для хранения и дальнейшего использования 

пользователем цифровых фотографий и видеороликов) 

HTML (Hyper Text Markup Language – «язык гипертекстовой разметки») 

Latest news (Самые последние новости) 

Logged in user (Зарегистрированный пользователь) 

Login (Вход в систему) 

Main menu (Главное меню) 

Mentees block (Блок поднадзорных) 

Messages (Сообщения) 

My latest badges (Мои последние Символы Отличия – новое в 2.5) 

My private files (Мои личные файлы) 

Navigation (Навигация) 

http://docs.moodle.org/25/en/Dock
http://docs.moodle.org/25/en/Blocks
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Network servers 

Online users 

People 

Quiz results 

Random glossary entry 

Recent activity 

Recent blog entries 

Remote RSS feeds 

Search forums 

Section links 

Self completion 

Social activities 

Tags 

Upcoming events 

Youtube 

There are also many contributed blocks available for download from the 

plugins 

4.5.2.Managing blocks 
4.5.2.1.Manage blocks 

An administrator can manage Moodle's blocks for the site in Settings > 

Site administration > Plugins > Blocks > Manage blocks, including any 

contributed blocks that have been added. 

4.5.2.1.1.Instances 
The blocks page lists the number of instance for each block. Clicking on a 

number results in the list of courses containing that block being displayed. 

See Block settings for configuration settings that might be of interest to a 

site administrator or someone with Front Page editing permissions. 

4.5.2.1.2.Version 
Listed with each block is its version number — in the format 2012061700. 

This is helpful to ensure that you have the latest version of each block. 

4.5.2.1.3.Hiding a block 
The hide/show column allows selected blocks to be hidden i.e. they do not 

appear in any course "Add a block" dropdown menu and cannot be used in 

any course. To hide a block, click the eye icon so that it changes to a 

closed eye. 

To reduce the length of course "Add a block" dropdown menus, you should 

hide blocks which will not be used, such as mentees (unless you have 

added a mentor role) and network servers 

 

Network servers (Сетевые серверы) 

Online users (Онлайн пользователи) 

People (Люди с разными Ролями, участвующие в данной области Курса) 

Quiz results (Результаты Экзамена) 

Random glossary entry (Запись Глоссария со случайным доступом) 

Recent activity (Недавняя деятельность) 

Recent blog entries (Недавние записи Блога) 

Remote RSS feeds (Рассылка новостной информации с удалённых Сайтов) 

Search forums (Форумы поиска Курсов) 

Section links (Ссылки на разделы Курсов) 

Self completion (Самостоятельное завершение Курса Студентами) 

Social activities (Социальные Интерактивные Действия) 

Tags (Теги) 

Upcoming events (Предстоящие события) 

Youtube (сервис, предоставляющий услуги видео-хостинга) 

Существует также много других, предлагаемых независимыми разработчиками, 

блоков, доступных для загрузки из Плагинов. 

4.5.2.Управляющие Блоки 
4.5.2.1.Работа с блоками 

Администратор может управлять Блоками системы Moodle для Сайта в 

SettingsSite administrationPluginsBlocksManage blocks, включая любые 

предлагаемые Блоки, которые добавлены в вашу Moodle. 

4.5.2.1.1.Повторяемость блока 
Страница Блоков показывает число использований каждого Блока. Щелчок по 

Number (числу) вызывает список Курсов, в которых этот блок был отображён. О 

конфигурировании настроек, могущих заинтересовать Администратора Сайта или кого-то 

с Полномочиями редактирования Главной страницы, см. в «Настройки Блока». 

4.5.2.1.2.Версия 
Каждый Блок сопровождается номером версии в формате 2012061700. Это 

полезно, так как позволяет вам иметь самую последнюю версию каждого блока. 

4.5.2.1.3.Сокрытие Блока 
«Скрыть/показать колонку» позволяет выбранным Блокам быть скрытыми, т.е. они 

не появятся в любом ниспадающем меню Курса «Add a block (добавить блок)» и не могут 

быть использованы в любом Курсе. Чтобы скрыть Блок, щёлкните иконку «глаз», чтобы 

она изменилась на «закрытый глаз». 

Чтобы уменьшить длину ниспадающего меню «Add a block (добавить блок)» 

Курса, вы должны скрыть Блоки, которые не будут использоваться, такие как 

«Поднадзорные» (если только вы не добавили Роль надзирателя) и «Сетевые серверы»  

http://docs.moodle.org/25/en/Parent_role
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(unless you are using Moodle Network|Moodle Networking). 

4.5.2.1.4.Protecting blocks from deletion 
By clicking the padlock against a block in this column, you are preventing 

it from being deleted on the site. The Settings block and Navigation block 

are already padlocked, as major difficulties arise if these blocks are 

deleted. Only unlock them if you are absolutely sure you understand the 

consequences and have alternative settings and navigation features in 

place. 

4.5.2.1.5.Block deletion 
Blocks can be deleted using the link in the delete column (but see 

comments about the Settings block and Navigation block in the previous 

section) There is usually no reason for standard blocks to be deleted (they 

are usually hidden) However, non-standard blocks may need to be deleted 

before upgrading. 

Note: To delete a block completely, in addition to deleting it on the blocks 

page, you also need to remove/delete the actual block folder from the 

moodle/blocks folder, otherwise Moodle will reinstall it next time you 

access the site administration. 

4.5.2.1.6.Block settings 
Certain blocks have additional settings, which can be accessed via the links 

in the settings column. 

4.5.2.2.Block capabilities 
4.5.2.2.1.Manage My home page blocks 
Capabilities/moodle/my:manageblocks 

 This allows a user to manage blocks (edit, add, delete, etc.) in the 

context this capability applies to (system, front page or course context) 

 

 For example, a user assigned to the default "editing teacher" role will 

have this capability set in the course context, thus enabling them to 

manage blocks in the course context 

 This capability is allowed for the default roles of manager and teacher 

See also 

 Capabilities/moodle/my:manageblocks 

 

 

 

 

 

(если только вы не используете Moodle Network|Moodle Networking). 

4.5.2.1.4.Защита Блоков от удаления 
Щёлкнув «Замок» напротив Блока в этой колонке, вы предотвратите его от 

удаления на Сайте. Блок настроек и Блок навигации уже заперты на замок, так как главные 

трудности возникают, если Блоки удаляются. Разблокируйте их только в том случае, если 

вы абсолютно уверены, что вы понимаете последствия и имеете альтернативные 

настройки и средства навигации взамен. 

 

4.5.2.1.5.Удаление Блока 
Блок может быть удалён путём использования ссылки в колонке удаления (но см. 

комментарии о Блоке настроек и Блоке навигации в предыдущем разделе). Обычно причин 

для удаления стандартных Блоков нет (они обычно скрыты). Однако нестандартные Блоки 

могут нуждаться в удалении перед модернизацией. 

 

Замечание: Чтобы удалить Блок полностью, в дополнение к его удалению на странице 

Блоков вам также необходимо переместить/удалить реальную папку Блока из папки 

moodle/blocks, в противном случае Moodle повторно инсталлирует его в следующий 

раз, когда вы войдёте в Блок Site administration (управление Сайтом). 

4.5.2.1.6.Настройки Блока 
Некоторые Блоки имеют дополнительные настройки, которые могут быть 

применены посредством ссылок в колонке настроек. 

4.5.2.2.Возможности Блока 
4.5.2.2.1.Управлять Блоками моей домашней страницы 

Возможность Capabilities/moodle/my:manageblocks 

 Позволяет пользователю управлять Блоками (редактировать, добавлять, удалять и т.д.) 

в том Контексте, в котором эта Возможность применяется (Контекст системы, 

титульной страницы или Курса). 

 Например, пользователь с назначенной по умолчанию Ролью «редактирующего 

Преподавателя» будет иметь эту Возможность, установленную в Контексте Курса, что 

позволит ему управлять Блоками в Контексте Курса. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

См. также 

 Capabilities/moodle/my:manageblocks. 

http://docs.moodle.org/25/en/MNet
http://docs.moodle.org/25/en/Capabilities/moodle/my:manageblocks
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4.5.2.2.2.Edit blocks in tags pages 
Capabilities/moodle/tag:editblocks 

 This allows a user to edit blocks in tag pages 

 The default manager, teacher and non-editing teacher roles have this 

capability set to allow 

 This capability may only be applied in the system context i.e. as a 

system role 

4.5.2.2.3.Manage blocks on own public user 
profile 
Capabilities/moodle/user:manageownblocks 

 This allows a user to manage blocks (edit, add, delete, etc.) on their 

public profile page. 

 The default authenticated user role has this capability set to allow. 

 This capability can only be applied in the system context i.e. as a 

system role. 

See also 

 User profiles 

4.5.2.2.4.Manage blocks on user profile of other 
users 
Capabilities/moodle/user:manageblocks 

 This allows a user to manage the blocks which appear on the user 

profile page of other users 

 By default only the Administrator can do this; the capability is not set 

for any other role 

See also 

 User profiles 

4.5.2.2.5.Edit a block's settings 
Capabilities/moodle/block:edit 

 This allows a user to edit a block's settings 

 This capability is allowed for the default role of teacher. In new installs 

of Moodle 2.3 it is allowed for the role of manager at site level. 

4.5.2.2.6.View block 
Capabilities/moodle/block:view 

 This allows a user to view a block 

 This capability is allowed for the default roles of teacher, student, guest 

and authenticated user 

 

4.5.2.2.2.Редактировать Блоки на страницах тегов 
Возможность Capabilities/moodle/tag:editblocks 

 Позволяет пользователю редактировать Блоки на страницах тегов. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя имеют. 

 Эта Возможность может быть применена только в Контексте системы, т.е. аналогично 

системной Роли. 

4.5.2.2.3.Управлять Блоками в своём собственном 
публичном Профиле пользователя 
Возможность Capabilities/moodle/user:manageownblocks 

 Позволяет пользователю управлять Блоками (редактировать, добавлять, удалять и т.д.) 

на странице его публичного Профиля. 

 По умолчанию Роль Аутентифицированного Пользователя имеет эту Возможность. 

 Эта Возможность может быть применена только в Контексте системы, т.е. аналогично 

системной Роли. 

См. также 

 Профили пользователей. 

4.5.2.2.4.Управлять Блоками в пользовательских Профилях 
других пользователей 
Возможность Capabilities/moodle/user:manageownblocks 

 Позволяет пользователю управлять Блоками, которые появляются на странице 

Профиля пользователя других пользователей. 

 По умолчанию только Администратор может сделать это, эта Возможность не 

устанавливается для любой другой Роли. 

См. также 

 Профили пользователей. 

4.5.2.2.5.Редактировать настройки Блока 
Возможность Capabilities/moodle/block:edit 

 Позволяет пользователю редактировать настройки Блоков. 

 Это Возможность по умолчанию предоставлена для Роли Преподавателя. В новых 

инсталляциях Moodle 2.3 она предоставлена для Роли Менеджера на уровне Сайта. 

4.5.2.2.6.Просмотреть Блок 
Возможность Capabilities/moodle/block:view 

 Позволяет пользователю просматривать Блок. 

 Эта Возможность по умолчанию предоставлена Ролям Преподавателя, Студента, Гостя 

и Аутентифицированного Пользователя. 

http://docs.moodle.org/25/en/User_profiles
http://docs.moodle.org/25/en/User_profiles
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4.5.2.2.7.Manage blocks on a page 
Capabilities/moodle/site:manageblocks 

 This allows a user to manage blocks (edit, add, delete, etc.) in the 

context this capability applies to (system, front page or course context) 

 For example, a user assigned to the default "editing teacher" role will 

have this capability set in the course context, thus enabling them to 

manage blocks in the course context 

 

 This capability is allowed for the default roles of manager and teacher 

See also 

 Capabilities/moodle/my:manageblocks 

In addition, every block has an addinstance capability (e.g. 

block/comments:addinstance) and most blocks also have a myaddinstance 

capability (e.g. block/comments:myaddinstance) for controlling whether a 

user with a particular role can add the block to a page or to their My home 

page respectively. 

4.5.2.3.Contributed blocks 
In addition to using the blocks included in the standard download, other 

Moodlers have developed their own blocks which they share with the 

Moodle community. You can download these contributed blocks from the 

Moodle.org Moodle Plugins directory. See Installing plugins for details of 

how to install a block. 

4.5.2.4.See also 
 Block layout 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.5.2.2.7.Управлять Блоками на странице 
Возможность Capabilities/moodle/site:manageblocks 

 Позволяет пользователю управлять Блоками (редактировать, добавлять, удалять и т.д.) 

в том Контексте, в котором эта Возможность применена (контексте системы, 

Титульной Страницы или Курса). 

 Например, пользователь, которому по умолчанию предоставлена Роль 

«редактирующего Преподавателя», будет иметь эту Возможность установленной в 

Контексте Курса, позволяя ему управлять Блоками в контексте Курса. 

 Эта Возможность по умолчанию предоставляется Ролям Менеджера и Преподавателя. 

См. также 

 Capabilities/moodle/my:manageblocks. 

В дополнение, каждый Блок имеет Возможность «Addinstance (добавочный 

экземпляр)» (например, block/comments:addinstance) и большинство Блоков также имеют 

Возможность «Myaddinstance (мой добавочный экземпляр)» (например, 

block/comments:myaddinstance) для управления тем, может ли пользователь с конкретной 

Ролью добавлять Блок на страницу или на свою Домашнюю Страницу, соответственно. 

4.5.2.3.Предлагаемые кем-то Блоки 
В дополнение к использованию Блоков, включённых в стандартную загрузку, 

другие работающие с Moodle, разрабатывают их собственные Блоки, которыми они 

делятся с сообществом Moodle. Вы можете загрузить эти предлагаемые блоки из каталога 

плагинов Moodle на Moodle.org. Подробности об установке Блоков см. «Установка 

плагинов». 

4.5.2.4.См. также 
 Компоновка Блока. 

http://docs.moodle.org/25/en/Capabilities/moodle/my:manageblocks
http://moodle.org/plugins
http://moodle.org/plugins
http://docs.moodle.org/25/en/Installing_plugins
http://docs.moodle.org/25/en/Installing_plugins
http://docs.moodle.org/25/en/Block_layout
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4.5.3.Block settings 
4.5.3.1.Adding a block to a page 
Blocks can be added to a page by turning editing on then using the 'Add a 

block' drop-down menu. 

 

Please see Blocks for a list of all the blocks in a standard Moodle install. 

Your site may have added contributed blocks and or your site administrator 

has disabled specific blocks on your site. 

Note: The ability to add a particular block to a page is controlled by an 

addinstance capability (e.g. block/comments:addinstance), which is 

allowed for the default role of teacher. 

4.5.3.2.Block configuration 
After adding a block, click the edit icon in the block header to configure it. 

 

4.5.3.2.1.Block settings 
Certain blocks, such as the HTML block, allow a block title and more to be 

set. 

4.5.3.2.2.Where this block appears 
Depending upon the context and users permissions, this area determines 

where this block will appear. 

 Original block location: provides information about where the block 

was initially created. 

 Display on page types: allows the user to set the context that the block 

can appear in. These options will vary depending upon the permissions 

of the user. For example a site administrator might see a setting that will 

allow the block to appear on Any page, or any type of course main 

page, while a teacher may only see the option to place it on every page 

in the course. 

 Default region: Usually a right column or left column option 

 Default weight: Where in the column do you want it to appear if there 

are other blocks in that column. -10 will put it at the top, 10 will put it 

at the bottom. A zero is neutral. 

See User profiles for instructions on how to make a block appear on all 

user profile pages. 

 

 

 

4.5.3.Настройки Блока 
4.5.3.1.Добавление Блока на страницу 

Блоки могут быть добавлены на страницу путём включения режима 

редактирования, а затем использования ниспадающего меню «Add a block (добавить 

блок)». 

Пожалуйста, ищите список всех Блоков стандартной инсталляции Moodle в 

«Блоки». Ваш Сайт может иметь предлагаемые независимыми разработчиками Блоки и 

или Администратор вашего Сайта отключил специфические блоки на вашем Сайте. 

Замечание: Способность добавлять конкретный Блок на страницу управляется 

Возможностью Addinstance (например, block/comments:addinstance), который 

предоставляется по умолчанию Роли Преподавателя. 

4.5.3.2.Конфигурация Блока 
После добавления щёлкните иконку редактирования в заголовке Блока, чтобы 

сконфигурировать его. 

4.5.3.2.1.Настройки Блока 
Определённые Блоки, такие как Блок HTML, позволяют установить заголовок 

Блока и больше. 

4.5.3.2.2.Где этот Блок появится 
В зависимости от Контекста и Полномочий пользователя эта область определяет, 

где этот Блок появится. 

 Original block location (начальное место блока): предоставляет информацию о том, где 

этот Блок был создан впервые. 

 Display on page types (Отображать типы на странице): позволяет пользователю 

устанавливать Контекст, в котором этот Блок может появиться. Эти опции будут 

разными, в зависимости от Полномочий пользователя. Например, Администратор 

Сайта увидит настройку, которая позволит этому Блоку появиться на любой странице 

или на Главной странице любого типа Курса, в то время как Преподаватель может 

увидеть только опцию для размещения Блока на каждой странице в Курсе. 

 Default region (область по умолчанию): обычно правая или левая колонка. 

 Default weight (весовой коэффициент по умолчанию): где в колонке вы хотите, чтобы 

Блок появился, если в колонке есть другие Блоки. «-10» поместят его вверх, «10» 

переместят вниз. Ноль – нейтрален. 

См. «Профили пользователей» (п. 3.8), чтобы получить инструкции того, как 

заставить Блок появиться на всех страницах Профиля Пользователя. 

http://docs.moodle.org/25/en/Blocks
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4.5.3.2.3.On this page 
 Visible - Yes or No. 

 Region - Here you can override the column preference on this page. 

 

 Weight - Here you can override the default setting on this page. 

 

4.5.3.3.'Sticky blocks' 
The term 'sticky' block was used in older versions of Moodle to mean 

blocks which the admin added either site-wide or to the My home page and 

which could not be deleted by regular users. Although the term is no longer 

used, it is still possible to make blocks 'sticky' and in a wider variety of 

locations. 

In Moodle 2.4.2 onwards, if an admin deletes a "sticky" block in a course, 

they receive a warning of the site-wide consequences of this action before 

it is deleted. 

Here are a few examples: 

4.5.3.3.1.Making a block sticky throughout the 
whole site 
The Moodle administrator might wish for example to display support 

contact details sitewide using an HTML block called 'Helpdesk': 

 As an administrator, turn on the editing on the front page and add the 

block you wish to make sticky. 

 

 For Where this block appears>Page contexts, choose 'Display 

throughout the entire site'. 

 

 Decide other settings according to your preference and save. 

 

 The block will now appear on all pages of your Moodle. 

4.5.3.3.2.Making a block sticky throughout a 
course 
The teacher might wish for example to display the Messages block 

everywhere in the course. This would allow students easily to message 

each other and their tutors not only on the course from the main page but 

also on individual activities. The block would be available on admin pages 

too. 

 

 

4.5.3.2.3.На этой странице 
 Visible (видимый) – Yes (да) или No (нет). 

 Region (область) – Здесь вы можете переопределить предпочитаемую для размещения 

Блока колонку на этой странице. 

 Weight (весовой коэффициент) – Здесь вы можете переопределить настройки по 

умолчанию для этой страницы. 

4.5.3.3.«Прилипчивые Блоки» 
Термин «прилипчивый» Блок был использован в старых версиях Moodle, чтобы 

обозначить Блоки, которые Администратор добавил либо для всего Сайта, либо для «Моя 

домашняя страница», и которые не могли бы быть удалены обычными пользователями. 

Хотя термин больше не используется, всё ещё можно сделать Блоки «прилипчивыми» и в 

многообразных местах. 

В Moodle 2.4.2 и далее, если Администратор удаляет «прилипчивый» Блок в Курсе, 

он получает предупреждение о распространении этого действия на весь Сайт, перед тем, 

как Блок удалится. 

Здесь несколько примеров: 

4.5.3.3.1.Создание Блока, прилипчивого по всему Сайту 
 

Администратор Moodle может пожелать, например, отображать по всему Сайту 

подробности контактов помощи, используя Блок HTML, называемый «Доска помощи»: 

 Как Администратор включите режим редактирования на Главной Странице 

(AdministrationFront page settingsTurn editing on) и добавьте Блок HTML, который 

желательно сделать прилипчивым, внизу: «Add a block»HTML. 

 В появившемся окне (new HTML block) щёлкните «шестерёнку», затем в разделе 

«Where this block appears (где этот блок появится)» в окошке «Page contexts (на каких 

страницах)» выберите «Display throughout the entire site (отображать по всему Сайту)». 

 Выберите другие нужные вам настройки и щёлкните кнопку внизу «Save changes 

(сохранить изменения)». 

 Теперь этот Блок будет появляться на всех страницах вашей Moodle. 

4.5.3.3.2.Создание Блока, прилипчивого по всему Курсу 
 

Преподаватель может пожелать, например, отображать Блок сообщений (п. 4.5.24) 

везде в Курсе. Это позволит Студентам легко передавать сообщения друг другу и своим 

наставникам не только из Главной Страницы Курса, но также и со страниц конкретных 

Интерактивных Действий. Этот Блок также будет доступен и на страницах 

Администратора. 

http://docs.moodle.org/25/en/My_home
http://docs.moodle.org/25/en/My_home
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 As a teacher in the course, turn on the editing on the course main page 

and add the block you wish to make sticky. 

 

 For Display on page types, choose 'Any page' 

 

 

 Decide other settings according to your preferences and save. 

 The block will now appear on all pages of the course. 

4.5.3.3.3.Making a block sticky in a category 
A user with category rights might for instance wish to display a Remote 

RSS feeds block in all of the courses within a particular category, such as a 

Head of Science adding Science news feeds to the Physics, Biology and 

Chemistry courses. While this should be possible, there are currently 

problems with blocks on category pages not saving the required page 

context. See MDL-31616. 

4.5.3.3.4.Making a block sticky in a resource or an 
activity 
A teacher might wish to display a block in one particular resource or 

activity, for example a Head of Faculty might make create a Book for 

departmental policies and wish to add the comments block to every 

chapter/page of a book so colleagues can give quick feedback. (Note that 

such a comments block would be the same block on each chapter/page) 

 As a teacher in the course, turn on the editing and click into the 

resource/activity - in this case a Book and add the block for Display on 

page types, you will see (for example) 'mod-book' 

 

 

 Decide other settings according to your preferences and save. 

 The block will now appear on all related screens. 

4.5.3.3.5.Adding a block to all user profile pages 
 
See User profiles 

4.5.3.3.6.Adding a block to My home page for all 
users 
See My home Note that such a block would not be truly 'sticky', in that 

users can customise their My home page and could, if wished, delete the 

block. 

 Как Преподаватель Курса включите режим редактирования на Главной странице Курса 

(NavigationMy coursesваш Курс, щёлкнуть «Turn editing on») и добавьте желаемый 

Блок (внизу: «Add a block»Messages), который нужно сделать прилипчивым. 

 В появившемся окне (new Messages block) щёлкните «шестерёнку», затем в разделе 

«Where this block appears (где этот блок появится)» в окошке «Display on page types 

(отображать на типах страниц)» выберите «Any page (любая страница)». 

 Выберите другие нужные вам настройки и щёлкните кнопку внизу «Save changes». 

 Теперь этот Блок будет появляться на всех страницах вашего Курса. 

4.5.3.3.3.Создание Блока, прилипчивого в Категории 
Пользователь с правами Категорий может, например, пожелать отображать Блок 

удалённых лент новостей (п. 4.5.35) во всех Курсах конкретной Категории, так старший по 

естественны наукам добавляет рассылку научных новостей в Курсы по физике, биологии и 

химии. В то время, как это должно быть возможно, в настоящее время существуют 

проблемы с Блоками на страницах Категорий, не сохраняющих требуемый Контекст 

страниц. См. MDL-31616. 

4.5.3.3.4.Создание Блока, прилипчивого в Ресурсе или 
Интерактивном Действии 

Преподаватель может пожелать отображать Блок в одном конкретном Ресурсе или 

Интерактивном Действии, например, декан факультета может создать Книгу (п. 4.4.1) с 

установками по факультету и пожелать добавить Блок Комментариев к каждой 

главе/странице Книги, чтобы коллеги могли дать Обратную Связь. (Заметьте, что такой 

Блок Комментариев будет тем же самым Блоком в каждой главе/странице.) 

 Как Преподаватель в Курсе включите режим редактирования 

(NavigationMy coursesваш Курс, щёлкнуть «Turn editing on») и щёлкните по 

Ресурсу/Интерактивному Действию (в нашем случае по Книге) и добавьте Блок для 

Отображения на типах страниц, которые вы будете видеть (например) 

«ультрасовременная книга». 

 Выберите другие нужные вам настройки и щёлкните кнопку внизу «Save changes». 

 Этот Блок будет появляться на всех имеющих отношение экранах. 

4.5.3.3.5.Добавление Блока ко всем страницам 
Профиля Пользователя 

См. «Профили Пользователей» (п. 3.8). 

4.5.3.3.6.Добавление Блока на Домашнюю Страницу для 
всех пользователей 

См. «Моя Домашняя Страница» (п. 3.8). Заметьте, что такой Блок не будет в 

самом деле «прилипчивым», поскольку, пользователи могут настраивать свою 

Домашнюю Страницу и смогут, если пожелают, удалить этот Блок. 

http://tracker.moodle.org/browse/MDL-31616
http://docs.moodle.org/25/en/My_home
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4.5.3.4.Block permissions 
To change role permissions for a block 

 Turn editing on in the course 

 Click the Assign roles icon (a face and mask) in the header of the block 

 In the administration block, go to Block administration > Permissions 

(ignore the message 'You are not able to assign any roles here', which is 

to be expected, since roles are not generally assigned in the block 

context) 

See Blocks FAQ for details of how to hide front page blocks from non-

logged-in users. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.5.3.4.Полномочия Блока 
Чтобы изменить Полномочия Роли для Блока 

 Включите режим редактирования в нужном Курсе. 

 Щёлкните иконку (лицо и маска) «Assign roles (назначить роли)» в заголовке нужного 

Блока. 

 Перейдите в AdministrationBlockPermissions (проигнорируйте сообщение «You are 

not able to assign any roles here (здесь невозможно назначить любые роли)», которое 

следует ожидать, поскольку Роли обычно не назначаются в Контексте Блока). 

Подробности того, как скрыть Блоки Главной Страницы от незарегистрированных 

пользователей, см. в «Часто задаваемые вопросы о Блоках». 

http://docs.moodle.org/25/en/Blocks_FAQ
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4.5.4.Activities 
An activity is generally an interactive learning segment for a student in a 

course. The teacher adds activities by a pull down menu found in their 

course's sections when the edit mode is turned on. 

The Activities block lists and allows navigation between the different 

activities available in your course (Forums, Quizzes, Assignments, Lesson 

module and so forth). The activities list will grow as you add activities to 

your course. Therefore, the first time you enter your course, the only 

category that is listed is Forums. This is because one forum exists by 

default – the news forum. 

Whenever you add a different activity or resource to your course, an icon 

will appear in this block representing the specific Moodle module. These 

icons will link to a list of all instances of that modules activity that appear 

throughout the course. 

4.5.5.Admin bookmarks 
The intent of this block is to bookmark pages so that an administrator role 

can see them as a list of links. For the Teacher role, must be turned on for 

this block to appear, 

otherwise it is hidden. (As of Moodle 2.2.1+, testing indicates that while 

the Teacher role can see the block, it cannot see any of the links saved 

therein.) 

Note: Only administration setting pages such as 'Browse list of users' or 

'Add/edit courses' can be added to Admin bookmarks. Pages such as a 

course homepage or calendar cannot be linked. 

 

Site administration > Plugins > Blocks > Manage Blocks > instances 

number of instances will display a list of courses where the block has been 

installed. The front page will not appear on this list. 

It is possible to set the block display properties, just as any other block. 

 

4.5.6.Administration 
The Administration block provides context-sensitive links to settings 

pages. 

What appears in the Administration block depends upon the Context (Page 

being shown and user's permissions). For example, a site administrator on 

the front page will have Front page settings while a teacher in a course will 

have more options in Course administration than a student. 

Here are examples of the Administration block: 

 

4.5.4.Действия 
Интерактивное Действие – это обычно сегмент интерактивного обучения для 

Студентов Курса. Преподаватель добавляет Действия посредством ниспадающего меню, 

которое находит в разделах Курса, когда включён режим редактирования. 

Блок Activities перечисляет Действия, доступные в вашем Курсе (Форумы, 

Экзамены, Задания, модуль «Урок» и так далее), и позволяет перемещаться между ними. 

Список Действий будет расти по мере того, как вы будете добавлять Действия в ваш Курс. 

Следовательно, первый раз, когда вы войдёте в ваш Курс, единственная Категория, 

которая будет перечислена, это Форумы. Это потому, что один Форум существует по 

умолчанию – Форум Новостей. 

Всякий раз, когда вы добавите новое Интерактивное Действие или Ресурс в ваш 

Курс, будет появляться иконка в этом Блоке, представляющая специфический модуль 

Moodle. Эти иконки будут ссылаться на список тех экземпляров этих модулей Действий, 

которые появляются на протяжении Курса. 

4.5.5.Закладки Администратора 
Замысел этого Блока состоит в обеспечении возможности делать закладки страниц, 

чтобы человек с Ролью Администратора мог увидеть их как список ссылок. Для Роли 

Преподавателя, чтобы видеть этот Блок, должно быть разрешено появление этого Блока, 

иначе Блок будет скрыт. (Так, начиная с Moodle 2.2.1 и дальше, тестирование показывает, 

что в то время как Роль Преподавателя может видеть этот Блок, она не может видеть 

какие-либо ссылки, сохранённые в нём.) 

Замечание: Только страницы настроек Администратора, такие как «Browse list of 

users (просмотреть список пользователей)» или «Add/edit courses 

(добавить/отредактировать курсы)» могут быть добавлены в закладки Администратора. На 

страницы, такие как Домашняя Страница Курса или Календарь, сослаться нельзя. 

Перейдя в Site administrationPluginsBlocksManage BlocksInstances в 

столбце «Instances (экземпляры)» таблицы Blocks отобразится список Курсов, в которых 

этот Блок инсталлирован. Главная Страница не появится на этом списке. 

Можно установить свойства отображения Блока точно так же, как для любого 

другого Блока. 

4.5.6.Управление 
Блок Управления предоставляет контекстно-зависимые ссылки на страницы 

настроек. 

Что появится в Блоке Управления, зависит от Контекста (будут показаны страница 

и полномочия пользователя). Для примера, Администратор Сайта на Главной Странице 

будет иметь настройки Главной Страницы, в то время как Преподаватель в Курсе будет 

иметь больше опций в Course administration (управление курсом), чем Студент. 

Здесь примеры Блока Управления. 
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 Screenshot «Admin view from Front page (collapsed)» 

 Screenshot «Teacher view in a course (expanded)» 

 Screenshot «Student view in a course (collapsed)» 

4.5.7.Blog menu 
The blog menu block provides links to 

 View all my entries 

 Add a new entry 

plus context-sensitive links for adding an entry about the course or a 

particular activity (if blog associations are enabled for the site and if a user 

has appropriate permissions). 

4.5.7.1.See also 
 Blogs 

 Blog settings 

4.5.8.Blog tags 
A Blog Tags block displays a list of blogs where font size visually 

indicates each blog's use. The more frequently used blogs appear in a 

larger font size and least used in smaller fonts. This format is sometimes 

called a "tag cloud". 

 

4.5.8.1.Adding a Blog Tags block to a course 
page 
 Click the "Turn editing on" button. 

 Select Blog Tags from the Add blocks menu. 

 

 If appropriate, move the Blog Tags block up and/or left, using the arrow 

icons under the block title. 

4.5.8.2.Block configuration 
To configure a Blog Tags block, click on the edit icon in the block header. 

 

 Blog tags block title - You can change the title of the block. 

 

 Number of tags display - Here you specify how many tags you want to 

display in the block. 

 Display tags used within this many days - You can specify here how 

recent the tags that you want to appear are. For example, if it is 90 days 

then only tags that have been used in the last 90 days will be used. 

 

 Снимок с экрана «Администратор видит с Главной страницы (свёрнуто)». 

 Снимок с экрана «Преподаватель видит в Курсе (развёрнуто)». 

 Снимок с экрана «Студент видит в Курсе (свёрнуто)». 

4.5.7.Меню Блога 
Блок «Меню Блога» предоставляет ссылки на 

 Просмотреть все мои записи. 

 Добавить новую запись. 

Плюс контекстно-зависимые ссылки для добавления записи о Курсе или 

конкретном Действии (если связи Блога включены на Сайте и если пользователь имеет 

подходящие Полномочия). 

4.5.7.1.См. также 
 Блоги (п. 3.17). 

 Настройки Блогов. 

4.5.8.Теги Блогов 
Блок «Теги Блогов» отображает список Блогов, где размер 

шрифта визуально указывает использование Блога. Более часто 

используемые Блоги представляются более крупным шрифтом, а более 

редко – более мелкими шрифтами. Этот формат иногда называется 

«облаком тегов». 

4.5.8.1.Добавление Блока «Теги Блогов» на страницу 
Курса 
 Щёлкните кнопку «Turn editing on (включить редактирование)». 

 Выберите Блок «Теги Блогов (blog tags)» из меню Add blocks (добавить блоки) внизу 

страницы. 

 Если нужно, переместите Блок «Теги Блогов» вверх и/или влево, используя иконки 

«Стрелочка» под заголовком Блока. 

4.5.8.2.Конфигурация Блока 
Чтобы сконфигурировать Блок «Теги Блогов», щёлкните по иконке 

редактирования в заголовке Блока. 

 Blog tags block title (заголовок блока «Теги Блогов») – Вы можете изменить заголовок 

Блока. 

 Number of tags display (число отображаемых тегов) – Здесь вы указываете, сколько 

тегов вы хотите отображать в этом Блоке. 

 Display tags used within this many days (отображать теги, используемые внутри этого 

множества дней) – Вы можете указать здесь, насколько свежими должны быть теги, 

которые вы хотите, чтобы появлялись здесь. Например, если это 90 дней, тогда будут 

использованы только те теги, которые были использованы в течение последних 90 дней. 

http://docs.moodle.org/25/en/File:25frontpageadmin.png
http://docs.moodle.org/25/en/File:25teacheradmin.png
http://docs.moodle.org/25/en/File:25studentadmin.png
http://docs.moodle.org/25/en/Blog_settings
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 Sort the tag display by - Here you can specify in what order you want 

the tags to appear. You can choose to sort the tag according to tag 

name. So the tags will be sorted in alphabetical order. Or you can 

choose to sort them according to last date used. So the most recent tag 

would appear first. 

4.5.8.3.See also 
 Blogs 

 Using Moodle Blogging tags don't show in Blog Tags block forum 

discussion 

4.5.9.Calendar 
The Calendar block displays the following events: 

 Site (event viewable in all courses - created by admin users) 

 Course (event viewable only to course members - created by teachers) 

 

 Groups (event viewable only by members of a group - created by 

teachers) 

 User (personal event a student user can create - viewable only by the 

user) 

4.5.10.Comments 
The comments block can be added to any page to allow users to add 

comments. 

4.5.10.1.Site administration settings 
The number of comments displayed may be set by a site administrator in 

Administration > Site administration > Front Page > Front Page settings. 

 

Comments may be turned off on the site by a site administrator via 

Administration>Advanced Features. 

NOTE: A site administrator can also check which comments have been 

made (and delete inappropriate ones) via Administration>Site 

administration>Reports>Comments 

4.5.11.Community finder 
The community finder block enables users to access public community 

hubs, such as Moodle.net, and search for courses to download or enrol in. 

 

 Downloadable courses may be immediately restored to your Moodle 

site 

 Links to enrollable courses are saved in the community finder block 

 Sort the tag display by (отсортировать отображаемые теги по) – Здесь вы указываете, в 

каком порядке вы хотите, чтобы теги появлялись. Вы можете выбрать, чтобы теги 

сортировались по имени. Тогда эти теги будут отсортированы в алфавитном порядке. 

Или вы можете выбрать их сортировку в соответствии с последней датой 

использования. Тогда первым появится последний тег. 

4.5.8.3.См. также 
 Блоги (п. 3.17). 

 Обсуждение форума по использованию Moodle «Теги по ведению Блога не 

показываются в Блоке “Теги Блога”». 

4.5.9.Календарь 
Блок «Календарь» отображает следующие события: 

 Сайт (событие, видимое во всех Курсах, – создаваемое Администраторами). 

 Курс (событие, видимое только членам Курса, – создаваемое 

Преподавателями). 

 Группы (событие, видимое только членам Группы, – создаваемое 

Преподавателями). 

 Пользователь (персональное событие, которое Студент может 

создать, – видимое только этим пользователем). 

4.5.10.Комментарии 
Блок «Комментарии» может быть добавлен на любую 

страницу, чтобы позволить пользователям добавлять комментарии.  

4.5.10.1.Настройки управления Сайтом 
Число отображаемых комментариев может быть установлено 

Администратором Сайта в AdministrationSite administrationFront 

PageFront Page settings. 

Комментарии на Сайте могут быть отключены Администратором через 

AdministrationAdvanced Features. 

Замечание: Администратор Сайта может также проверить, какие комментарии 

были созданы (и удалить ненужные), через  

AdministrationSite administrationReportsComments. 

4.5.11.Поисковик сообществ 
Блок «Поисковик сообществ» предоставляет пользователям доступ к хабам общего 

пользования социальных сообществ, таким как Moodle.net, и отыскивает Курсы для 

загрузки или зачисления. 

 Копируемые Курсы могут быть немедленно установлены на вашем Сайте Moodle. 

 

 Ссылки на Курсы с зачислением сохраняются в Блоке «Поисковик сообществ». 

http://moodle.org/mod/forum/discuss.php?d=65907
http://moodle.org/mod/forum/discuss.php?d=65907
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4.5.11.1.Downloading courses from a hub 
 In the community finder block click Search 

 Select a hub, such as Moodle.net 

 Select 'Courses I can download' and then click the Search button 

  

 For any courses of interest, click 'Visit demo' then if you're happy with 

the course, click 'Download' 

 The course backup will then be downloaded and saved in your private 

files. Click Yes to immediately restore the course 

4.5.11.2.Finding courses to to enrol in 
 In the community finder block click Search 

 Select a hub, such as Moodle.net 

 Select 'Courses I can enrol in' and then click the Search button 

 

 For any courses of interest, click 'Visit site' then if you're happy with 

the course, click 'Save a link to this course' 

 

The link to the course will then be displayed in the community finder 

block. 

If you wish to remove any saved links, click the X icon after the link. 

 

4.5.11.3.Capabilities 
By default, users with the role of manager or teacher can use the 

community finder block. 

The following capabilities control access to the block: 

 moodle/community:add - allows a user to use the Community block to 

search for courses on a hub 

 moodle/community:download - allows a user to use the Community 

block to download courses from a hub 

4.5.11.4.See also 
 Community hub 

 Restoring file aliases for details of what happens when restoring a 

course which has been downloaded from a hub and which contains file 

aliases 

 

 

 

 

4.5.11.1.Загрузка Курсов из хаба 
 В Блоке «Поисковик сообщества» щёлкните Search (поиск). 

 Выберите хаб, такой как Moodle.net. 

 Выберите «Courses I can download (курсы, которые я могу загрузить)» и затем щёлкните 

кнопку Search. 

 Для любых заинтересовавших вас Курсов щёлкните «Visit site», затем, если вам этот 

Курс понравился, щёлкните «Save a link to this course». 

 Резервная копия Курса будет затем загружена и сохранена в ваших личных файлах. 

Щёлкните Yes, чтобы немедленно восстановить этот Курс. 

4.5.11.2.Отыскание Курсов, чтобы зачислиться на них 
 В Блоке «Поисковик сообществ» щёлкните Search (поиск). 

 Выберите хаб, такой как Moodle.net. 

 Выберите Курс «Courses I can enrol in (курс, на который я могу зачислиться)» и затем 

щёлкните кнопку «Search (поиск)». 

 Для любых заинтересовавших вас Курсов щёлкните «Visit site (посетить Сайт)», затем, 

если вам этот Курс понравился, щёлкните «Save a link to this course (сохранить ссылку 

на этот курс)». 

После этого ссылка на этот Курс будет отображена в Блоке «Поисковик 

сообществ». 

Если вы желаете удалить любые сохранённые ссылки, щёлкните иконку x рядом со 

ссылкой. 

4.5.11.3.Возможности 
По умолчанию пользователи с Ролью Менеджера или Преподаватели могут 

использовать Блок «Поисковик сообщества». 

Следующие Возможности управляют доступом к этому Блоку: 

 moodle/community:add – позволяет пользователю использовать Блок «Поисковик 

сообществ», чтобы отыскать Курсы на хабе. 

 moodle/community:download – позволяет пользователю использовать Блок «Поисковик 

сообществ», чтобы загружать Курсы с хаба. 

4.5.11.4.См. также 
 Хаб сообществ. 

 Сайт «Восстановление псевдонимов файлов» содержит подробности того, что 

случается при восстановлении Курса, который был загружен с хаба и который 

содержит псевдонимы. 

http://docs.moodle.org/25/en/Community_hub
http://docs.moodle.org/25/en/Restoring_file_aliases
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4.5.12.Course completion status 
The course completion status block shows what has been done towards 

completing the course. The student and teacher will both see this block. 

The "More information" link will lead to a more detailed report. This 

report can have some interactive elements in the form of check boxes for 

the student and teacher. 

Note: The course completion status block will only appear if completion 

tracking criteria are set in Settings > Course administration > Completion 

tracking. This is what the teacher sees: 

4.5.12.1.Student view of Course completion 
status block 
The student can see their progress in the course by looking at the content of 

the block or clicking on the "More details" link to see a report. 

The student, if required, can mark an activity as completed on the course's 

homepage. 

4.5.12.2.Teacher view of Course completion 
status block 
This block shows the status for each student. It is also the place where the 

teacher (or others) can mark the course as complete. 

Note: The course completion status block will only appear if completion 

tracking criteria are set in Settings > Course administration > Completion 

tracking. This is what the teacher sees: 

4.5.12.3.Capabilities 
Be shown on completion reports 

4.5.12.4.See also 
 Course completion 

4.5.13.Course overview 
The Course overview block is visible on a user's My home page and shows 

a list of all courses in which a user is enrolled/has an assigned role. By 

default this block appears in the central content block on the My home 

page but can be moved to the left or right column. 

4.5.13.1.Customising the course order 
 
When a user clicks the "customise this page" button, they can then 

rearrange their courses by dragging them into different places. They can 

also choose how many courses they wish to display: 

4.5.12.Состояние завершения Курса 
Блок «Состояние Завершения Курса» показывает, что сделано в направлении 

Завершения Курса (п. 4.9.4). Студент и Преподаватель оба увидят этот Блок. Ссылка 

«More information» приведёт к отчёту с большими подробностями. Этот отчёт может иметь 

некоторые интерактивные элементы в форме окошек-флажков для Студента и 

Преподавателя. 

Замечание: Блок «Состояние завершения Курса» появится, только если установлен 

в Yes критерий средства отслеживания завершения в 

AdministrationSite administrationCourseCourse default settingsCompletion tracking. 

4.5.12.1.Как Студент видит Блок «Состояние 
Завершения Курса» 

Студент может видеть свой прогресс в Курсе посредством просмотра содержимого 

Блока или щелчком по ссылке «More details», чтобы просмотреть отчёт. 

Студент, если требуется, может пометить Действие как Завершённое на 

Домашней Странице Курса. 

4.5.12.2.Как Преподаватель видит Блок «Состояние 
Завершения Курса» 

Этот Блок показывает состояние каждого Студента. Он также является местом, где 

Преподаватель (или другие) может пометить Курс как Завершённый. 

Замечание: Блок «Состояние Завершения Курса» появится, только если установлен 

в Yes критерий Средства Отслеживания Завершения в 

AdministrationSite administrationCourseCourse default settingsCompletion tracking. 

4.5.12.3.Возможности 
Показываются в отчётах по Завершению. 

4.5.12.4.См. также 
 Завершение Курса. 

4.5.13.Обзор Курсов 
Блок «Обзор Курсов» видим на Моей Домашней Странице пользователя и 

показывает список всех Курсов, на которые пользователь зачислен/имеет назначенную 

Роль. По умолчанию этот Блок появляется в центральном в Блоке содержимого на 

Домашней Странице, но может быть перемещён в левую или правую колонку. 

4.5.13.1.Расположение Курсов в порядке привычном 
клиенту 

Когда пользователь щёлкает кнопку «Customise this page (настроить эту 

страницу)», он может переупорядочить свои страницы, перетаскивая их в различные 

места. Они могут также выбрать, сколько Курсов желают отображать. 

http://docs.moodle.org/25/en/Course_completion
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4.5.14.Course/site summary 
The course/site summary block provides a summary and/or description for 

your course as contained in the summary text of the course settings. 

Note: The front page summary, accessed from Settings > Front page 

Settings > Edit settings, can appear as a side block similar to the course 

summary blocks. Alternatively, if you want your front page summary in 

the centre of the front page, check "include a topic section" in the Edit 

settings page. 

4.5.15.Courses 
The Courses block lists and allows navigation between all of the courses in 

which the logged in user is enrolled in. The block title shows as "My 

courses" and allows one-click access to a course's home page. 

There is a also the option to list All courses... available within the Moodle 

site. This will display a list of course types and a click on one of the types 

will reveal all the courses in that category. There is also a search all 

courses option on this page. 

A brand new user to a Moodle site, who has not enrolled in any 

course, will see the block title as "Course Categories". 

When a student enters an unassigned course using the course block, they 

will be asked to enroll. 

Note: The Navigation block also includes a list of all courses a user is 

enrolled in. 

4.5.15.1.Site administration settings 
The courses block has some settings which may be changed by an 

administrator in Settings > Site administration > Plugins > Blocks > 

Course list. 

 block_course_list_adminview - This determines what administrators see 

in the block. 

 block_course_list_hideallcourseslink - This enables you to hide the "All 

courses" link at the bottom of the block from everyone except 

administrators. 

4.5.15.2.See also 
 Using Moodle How to make users can only see their own courses? 

forum discussion 

 

 

 

 

4.5.14.Резюме Курса/Сайта 
Блок «Резюме Курса/Сайта» предоставляет обзор и/или описание для вашего 

Курса, как содержимое в тексте Резюме настроек этого Курса. 

Замечание: Резюме Главной страницы, доступное из 

Administration Front page SettingsEdit settings, может появиться как Блок на боковой 

стороне подобно Блокам Резюме Курсов. В дополнение, если вы хотите, чтобы ваше 

Резюме Главной Страницы разместилось в её центре, пометьте «Include a topic section 

(включить раздел темы)» на странице «Редактировать настройки». 

4.5.15.Курсы 
Блок «Курсы» показывает и разрешает перемещения между всеми Курсами, в 

которые зарегистрированный пользователь зачислен. Заголовок Блока показывает «My 

courses (мои курсы)» и разрешает доступ к Домашней Странице Курса по одному щелчку. 

Существует также опция (All courses...) для перечисления всех Курсов, доступных внутри 

Сайта Moodle. Это отобразит список типов Курсов и щелчок по одному из типов 

воспроизведёт все Курсы в этой Категории. Существует также опция поиска всех Курсов 

на этой странице. Своеобразие нового пользователя на Сайте Moodle, пользователя, 

который не зачислен ни на один Курс, увидит заголовок Блока как «Course Categories 

(категории курса)». 

Когда Студент входит на Курс, на который не зачислен, ему будет предложено 

зачислиться на него. 

Замечание: Блок Навигации также включает список всех Курсов, на которые 

зачислен пользователь. 

4.5.15.1.Настройки управления Сайта 
Блок «Курсы» имеет некоторые настройки, которые могут быть изменены 

Администратором в Administration→Site administration→Plugins→Blocks→Course list. 

 

 block_course_list_adminview – это определяет, что Администраторы увидят в этом 

Блоке. 

 block_course_list_hideallcourseslink – это позволяет вам скрыть ссылку «All courses 

(все курсы)» внизу этого Блока ото всех, кроме Администраторов. 

 

4.5.15.2.См. также 
 Обсуждения форума по использованию Moodle «Как сделать, чтобы пользователи 

могли видеть только свои собственные Курсы?» 

http://moodle.org/mod/forum/discuss.php?d=92190
http://moodle.org/mod/forum/discuss.php?d=92190
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4.5.16.Feedback 
The Feedback block may be added to courses to provide a quick link to 

global feedback activities which have been set up from the front page. 

 

As with the Feedback module, this block is disabled by default and must be 

enabled by the administrator from Administration>Site 

administration>Plugins>Blocks>Manage blocks. 

4.5.16.1.See also 
Feedback settings 

4.5.17.Flickr 
 
The Flickr block can only be added to a Tags page. The Flickr block 

settings allow you to change the images that are displayed in the block 

based on Relevance (default), Date Posted, Date Taken and 

Interestingness. 

 

4.5.18.HTML 
A HTML block is a standard block used to add text or images on a site or 

course page. The title bar can be left blank. 

 

The block is flexible and can incorporate a variety of functions and uses in 

the content area. It has the standard Moodle Text editor for formatting text, 

adding images or creating links, switching to code view and allows any 

valid HTML markup to be used. This enables embedding video, sounds, 

Flash, and other files which can add unique elements to a course or site 

page. 

4.5.18.1.Site administration settings 
To aid with theming an administrator can, from Settings>Site 

administration>Plugins>Blocks>HTML, toggle the ability to allow 

additional CSS classes to be set in individual block instances. If it is 

enabled, a field appears at the bottom of HTML block instance's 

configuration forms: 

 

Please note that if additional CSS classes have been added and the 

administration setting is then disabled, the form settings are saved in the 

database and will reappear if this is re-enabled. 

 

 

4.5.16.ОбратнаяСвязь 
Блок «Обратная связь» может быть добавлен в Курсы, чтобы обеспечить быструю 

ссылку на глобальные Интерактивные Действия «Обратная Связь», которые установлены 

с Главной страницы. 

Как с модулем «Обратная Связь», этот Блок отключён по умолчанию и должен 

быть разрешён Администратором из 

Administration→Site administration→Plugins→Blocks→Manage blocks. 

4.5.16.1.См. также 
Настройки Обратной Связи (п. 4.3.6). 

4.5.17.Хранение и использование цифровых 
фотографий и видеороликов 

Блок «Flickr» может быть добавлен только на страницу Тегов. 

Настройки Блока «Flickr» позволяют изменить изображения, которые 

отображаются в этом Блоке на основе Relevance (релевантность – по 

умолчанию), Date Posted (дата отсрочки), Date Taken (дата принятия) и 

Interestingness (заинтересованность). 

4.5.18.Язык гипертекстовой разметки 
Блок «HTML» является стандартным Блоком, используемым для добавления 

текста или изображений на Сайт или страницу Курса. Панель заголовка может быть 

оставлена пустой. 

Этот Блок является гибким и может включить множество функций, и используется 

в области содержимого. Он имеет стандартный редактор текста Moodle для 

форматирования текста, добавления изображений или создания ссылок, переключения в 

просмотр кода и разрешения любой правомерной разметки кода HTML для использования. 

Это позволяет встраивать видео, звуки, флэш и другие файлы, которые могут добавить 

уникальные элементы в Курс или на страницу Сайта. 

4.5.18.1.Настройки управления Сайтом 
Чтобы избежать путаницы Администратор может из 

Administration→Site administration→Plugins→Blocks→HTML 

включить способность разрешать устанавливать в 

индивидуальные экземпляры Блока дополнительные классы 

таблиц стилей CSS. Если настройка включена, внизу форм 

конфигурации экземпляров Блока HTML появляется поле  

Пожалуйста, заметьте, что если дополнительные классы CSS будут добавлены, а 

настройка Администратора затем отключена, настройки формы сохраняются в базе 

данных и повторно появятся, если это повторно будет разрешено. 

http://docs.moodle.org/24/en/Tags
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4.5.19.Latest news 
Recent posts made in the News forum are displayed in the Latest news 

block, along with a link to older archived news. By default, the Latest news 

block displays 3 news items. This may be changed in Settings > Course 

administration > Edit settings. 

4.5.19.1.See also 
 News forum 

4.5.20.Login 
The Login block provides logged out users an in-site area to enter their 

Username and Password and login, Create a new account or retrieve/reset 

their password. 

 

This block is only of use where you are not forcing users to login before 

viewing any part of your site. 

 

This block can only be added to your Moodle site via the front page but 

within the Block editing area, via the Block display page contexts option, 

you can set this block to: 

 

 display on the front page only; or 

 display on the front page and any pages added to the front page; or 

 

 display throughout the entire site 

4.5.21.Logged in user 
The logged in user block displays certain information about the user who is 

currently logged in to a Moodle course: 

 

The information which is displayed can be selected by the course teacher 

by clicking on the "configure" icon of the block. A number of dropdown 

boxes then appear for the teacher to choose which items will appear: 

 

 

 

 

 

 

 

 

4.5.19.Самые последние новости 
Самые последние корреспонденции в новостном форуме отображаются в Блоке 

самых последних новостей, наряду со ссылкой на более старые заархивированные 

новости. По умолчанию Блок самых последних новостей отображает 3 новостных 

элемента. Это может быть изменено в Administration→ Cours administration→Edit settings. 

4.5.19.1.См. также 
 Форум новостей. 

4.5.20.Вход в систему 
Блок «Вход в систему» обеспечивает незарегистрированных пользователей 

областью, в которую они могут ввести своё регистрационное имя и пароль и войти в 

систему, создать новую учётную запись или отыскать/восстановить 

пароль. 

Этот блок используется только там, где вы не принуждаете 

пользователей зарегистрироваться перед просмотром любой части 

вашего Сайта. 

Этот Блок может быть добавлен на ваш Сайт Moodle только через 

Главную Страницу, но внутри области редактирования Блока «Login», посредством опции 

«Page contexts (контексты страницы)», отвечающей за отображение Блока, вы можете 

установить, чтобы этот Блок: 

 отображался только на Главной Странице; или 

 отображался на Главной Странице и любых страницах, добавленных к Главной 

странице; или 

 отображался по всему Сайту. 

4.5.21.Пользователь, вошедший в систему 
Блок «Пользователь, вошедший в систему» отображает 

определённую информацию о пользователе, который в настоящее время 

вошёл в Курс Moodle. 

Информация, которая отображается, может быть выбрана Преподавателем Курса 

щелчком по иконке «Configure (сконфигурировать)» этого Блока. После этого появится 

ряд ниспадающих окошек, чтобы Преподаватель выбрал элементы, которые будут 

отображаться: 
 отобразить фотографию, 

 отобразить страну, 

 отобразить город, 

 отобразить э-почту, 

 отобразить имя, 

 отобразить ICQ (система интерактивного общения в интернете). 

http://docs.moodle.org/24/en/News_forum


 

286 

4.5.22.Main menu 

The main menu block can be added to the front page of the site by a site 

administrator. Resources and activities can then be added to the front page. 

 

 

4.5.23.Mentees 
A Mentees block is a frontpage block that provides mentors with quick 

access to their mentee(s) profile page(s). A mentor might be a parent for 

example who has access to their child's information through the link in the 

block. 

The mentees block may be added to the site front page or to My home. 

 

4.5.23.1.Adding the Mentees block 
To the site front page: 

 On the site front page click "Turn editing on" 

 Choose Mentees from the Add a block drop-down menu 

 If required, give the Mentees block a title by following the block 

configuration/edit link 

To My Moodle (or My home): 

 Access Settings > Site administration > Appearance > Default My 

Moodle page 

 Choose Mentees from the Add a block drop-down menu 

 If required, give the Mentees block a title by following the block 

configuration/edit link 

4.5.23.2.Block visibility 
The mentees block does not become visible until individual “mentors” 

have been assigned a role that enables them to mentor other users who 

become their "mentees" (e.g., a parent mentoring a child, or a tutor 

mentoring a student). To assign a mentor to a mentee, the mentor must first 

be assigned a role that allows that mentor permission to view relevant user 

information (moodle/user:viewdetails set to allow). After having been 

assigned a role that grants viewing permission, the mentor’s role must then 

be assigned to the mentee/user whose information they wish to view. 

 

Mentor users logging on to the site will then be presented with a mentees 

block containing names and links to information about the individual users 

the mentor has been granted authorization to view. 

 

4.5.22.Главное меню 
Блок «Главное меню» может быть добавлен на Главную 

страницу Сайта Администратором Сайта. Ресурсы и 

Интерактивные Действия могут быть добавлены на Главную 

страницу. 

4.5.23.Поднадзорные 
Блок «Поднадзорные» является Блоком Главной Страницы, который обеспечивает 

надзирающих быстрым доступом к странице(ам) Профиля их поднадзорного(ых). 

Надзирающий может быть, например, родителем, который имеет доступ к информации о 

своём ребёнке по ссылке в этом Блоке. 

Блок «Поднадзорные» может быть добавлен на Главную страницу Сайта или на 

Мою Домашнюю Страницу (п. 3.8). 

4.5.23.1.Добавление Блока «Поднадзорные» 
На Главную Страницу Сайта: 

 На Главной Странице Сайта (Home) щёлкните «Turn editing on». 

 Выберите Mentees внизу экрана из ниспадающего меню окна Add a block. 

 Если нужно, присвойте заголовок Блоку «Поднадзорные» посредством следующей за 

Блоком ссылки configuration/edit (конфигурировать/редактировать). 

На «Мою Moodle» (или мою Домашнюю Страницу): 

 Перейдите в Administration→Site administration→Appearance→Default My home page. 

 

 Выберите Mentees внизу экрана в из ниспадающего меню окна Add a block. 

 Если нужно присвойте заголовок Блоку «Поднадзорные» посредством следующей за 

Блоком ссылки configuration/edit (конфигурировать/редактировать). 

4.5.23.2.Видимость Блока 
Блок «Поднадзорные» не видим до тех пор, пока индивидуальным «надзирающим» 

не назначены Роли, которые позволяют им надзирать за другими пользователями, которые 

становятся их «поднадзорными» (например, родитель, надзирающий за ребёнком, или 

наставник, надзирающий за Студентом). Чтобы назначить надзирающего поднадзорному, 

надзирающему должна быть сначала назначена Роль, которая предоставляет Полномочие 

надзирающему просматривать релевантную информацию пользователя 

(moodle/user:viewdetails установить в Allow). После того, как назначена Роль, которая 

гарантирует Полномочие просмотра, Роль надзирающего должна быть назначена 

поднадзорному/пользователю, чью информацию он желает просматривать. 

Надзирающим пользователям после их входа на Сайт предоставляется Блок 

«Поднадзорные», содержащий имена и ссылки на информацию об индивидуальных 

пользователях, для просмотра которой этому надзирающему предоставлена санкция. 
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4.5.23.3.Example usage 
The Parent role is an example of a role which utilizes the Mentees block. 

 

4.5.23.4.See also 
 Roles. 

Using Moodle forum discussions: 

 Create a Parent of a student role 

 Re: Importing Parents to Moodle 

4.5.24.Messages 
The message block displays a list of new messages you have received, with 

a link to your Messages window. 

To add a Messages block to your course page: 

 Click on the "Turn editing on" button. 

 Select from the Add blocks menu. 

 If appropriate, move the Messages block up and/or left, using the arrow 

icons under the block title. 

To find out more about sending and receiving messages through the 

Messages block, see Using Messaging 

4.5.25.My latest badges  (new in 2.5) 
The My latest badges block can be added to the Site front page or to a 

user's My home page and will display badges earned. 

 

From Moodle 2.5.1 onwards the block may also be added to a course page. 

4.5.25.1.Capabilities 
There are two capabilities associated with this block: 

4.5.25.1.1.Add a new My latest badges block 
 
Capabilities/block/badges:addinstance 

 This allows a user to add a My latest badges block to the front page. 

New feature in Moodle 2.5! 

 This capability is allowed for the default roles of manager and teacher 

 

 

 

 

 

 

4.5.23.3.Пример применения 
Роль «Родитель» (п. 3.4.7) является примером Роли, которая использует Блок 

«Поднадзорные». 

4.5.23.4.См. также 
 Роли (п. 3.4). 

Обсуждения форума по использованию Moodle: 

 Создать родителя Роли Студента. 

 Касательно: Импортирование «родителей» в Moodle. 

4.5.24.Сообщения 
Блок «Сообщения» отображает список новых полученных сообщений со ссылкой 

на ваше окно «Сообщения». 

Чтобы добавить Блок «Сообщения» на страницу Курса: 

 Щёлкните кнопку «Turn editing on». 

 Выберите «Messages» из меню окна Add blocks. 

 Если нужно, переместите Блок «Сообщения» вверх и/или влево, используя иконки-

стрелки подзаголовком Блока. 

Чтобы отыскать больше об отправке и получении сообщений через Блок 

«Сообщения», см. «Использование Обмена сообщениями». 

4.5.25.Мои последние Символы Отличия (новое в 2.5) 
Блок «Мои последние Символы Отличия» может быть добавлен на 

Главную Страницу Сайта или на Домашнюю Страницу пользователя и будет отображать 

заслуженные Символы Отличия. 

Начиная с Moodle 2.5.1 и дальше этот Блок может быть добавлен на страницу 

Курса. 

4.5.25.1.Возможности 
Существуют две Возможности, связанные с этим Блоком: 

4.5.25.1.1.Добавить новый Блок «Мои последние 
Символы Отличия». 

Возможность Capabilities/block/badges:addinstance 

 Позволяет пользователю добавлять Блок «Мои последние Символы Отличия» на 

Главную Страницу         Новое средство в Moodle 2.5! 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

http://moodle.org/mod/forum/discuss.php?d=57812
http://moodle.org/mod/forum/discuss.php?d=70539#p345127
http://docs.moodle.org/25/en/Using_Messaging
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 4.5.25.1.2.Add a new My latest badges block to 
My home 
Capabilities/block/badges:myaddinstance 

 This allows a user to add a My latest badges block to the My home. 

New feature in Moodle 2.5! 

 This capability is allowed for the default role of authenticated user 

 

4.5.26.My private files 
The My private files block enables access to a user's private files area. 

 

4.5.27.Navigation 
The navigation block appears on every page of the site. It contains an 

expanding tree menu which includes My Home, Site Pages, My Profile, 

and Courses. What appears in the navigation block depends on the role of 

the user, where they are in the Moodle site, and any settings that have been 

applied globally. 

4.5.27.1.Overview 
The navigation block has links which can be expanded or collapsed. When 

logged in, a regular user will see the following as default: 

 

4.5.27.1.1.My home 
This takes the user directly to their personal dashboard, My home. 

 

4.5.27.1.2.Site pages 
This expands to show pages and resources available site wide, for example, 

user blogs and a calendar. Any items which have been added to the front 

page, such as resources/activities from the Main Menu block, or the Site 

News will also appear here. Other items depend on the role of the user, so 

an administrator will see reports and notes, for instance. 

 

 

4.5.27.1.3.My profile 
This expands to allow regular users to view (and, if allowed, edit) their 

profile, view their forum posts, view and add blog entries and messages 

and access their private files, providing these features 

 

 

4.5.25.1.2.Добавить новый Блок «Мои последние 
Символы Отличия» на Мою Домашнюю Страницу. 

Возможность Capabilities/block/badges:myaddinstance 

 Позволяет пользователю добавлять Блок «Мои последние Символы Отличия» на 

Мою Домашнюю Страницу    Новое средство в Moodle 2.5! 

 Эта Возможность по умолчанию предоставлена Роли 

Аутентифицированного Пользователя. 

4.5.26.Мои личные файлы 
Блок «Мои личные файлы» разрешает доступ к области личных файлов 

пользователя (п. 5.2.1.1.4). 

4.5.27.Навигация 
Блок «Навигация» появляется на каждой странице Сайта. Он содержит 

расширенное древовидное меню, которое включает Мою Домашнюю Страницу, страницы 

Сайта, Мой Профиль и Курсы. Что появится в Блоке «Навигация» зависит от Роли 

пользователя, где он находится на Сайте Moodle и от любых настроек, которые 

применяются глобально. 

4.5.27.1.Обзор 
Блок «Навигация» имеет ссылки, которые могут быть 

развёрнуты или свёрнуты. После регистрации обычный 

пользователь увидит следующее: 

4.5.27.1.1.Моя Домашняя Страница 
Это приведёт пользователя прямо на его персональную 

инструментальную панель «Моя Домашняя Страница». 

4.5.27.1.2.Страницы Сайта 
Это приводит к показу страниц и ресурсов, доступных по 

всему Сайту, например, Блоги и Календарь пользователей. Любые 

элементы, которые добавлены на Главную Страницу, такую как 

Ресурсы/Интерактивные Действия из Блока «Главное меню» или 

«Новости Сайта», также появятся здесь. Другие элементы зависят 

от Роли пользователя, поэтому Администратор увидит, например, 

отчёты заметки. 

4.5.27.1.3.Мой профиль 
Эта ссылка позволяет обычным пользователям 

просматривать (и, если разрешено, редактировать) их Профиль, 

просматривать корреспонденцию их форума, просматривать и добавлять записи Блога и 

сообщения, а также добираться до своих личных файлов, предоставляющих эти средства,  
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have been enabled by the administrator. The administrator will also have a 

link here to Notes and Activity reports. 

4.5.27.1.4.My courses 
This takes the user to their My Home page where they see the courses they 

are enrolled in. An administrator sees this link as "Courses", which 

expands to the course categories. 

4.5.27.1.5.Navigation inside a course 
Current course 
When user is in a course, this link expands to show each section of the 

current course and any activities/resources which are in that section. 

 

My courses 
When a non-admin user clicks this link in a course, it takes them to their 

My home page where they will see other courses they are enrolled in. 

Courses 
If the administrator has enabled "show all courses" in Settings>Site 

administration>Appearance>Navigation, then clicking on this link in a 

course will take the user to the courses index page course/index.php. 

4.5.27.2.Navigation block settings 
An administrator can change navigation settings, such as the default home 

page, and whether to show course categories in the navigation, in Settings 

> Site administration > Appearance > Navigation. See Navigation for 

details. 

4.5.27.3.Hiding the navigation block 
 One way to make it harder for students to see other courses they are not 

enrolled in, is to implement the My Moodle page, and then hide the 

navigation block. 

 This will push all users to the My page on login, where they will see a 

list of those courses that they are enrolled in. 

 Hiding the navigation block will make it harder for them to find the 

other courses. 

 

 

 

 

 

 

 

позволенные Администратором. Администратор также будет иметь здесь ссылку на 

отчёты по Заметкам и Интерактивным Действиям. 

4.5.27.1.4.Мои Курсы 
Эта ссылка приводит пользователя на его Домашнюю Страницу, где он видит 

Курсы, на которые сам зачислен. Администратор видит эту ссылку как «Курсы», которая 

приводит к Категориям Курсов. 

4.5.27.1.5.Навигация внутри Курса «Текущий Курс» 
Текущий Курс 

Когда пользователь находится в Курсе, эта ссылка разворачивает показ каждого 

раздела текущего Курса и любых Интерактивных Действий/Ресурсов, которые в этом 

разделе. 

Мои Курсы 
Когда пользователь-неАдминистратор щёлкнет эту ссылку в Курсе, это приведёт 

его на свою Домашнюю Страницу, где он увидит другие Курсы, на которые он зачислен. 

Курсы 
Если Администратор позволил «Show all courses (показать все курсы)» в 

Administration→Site administration→Appearance→Navigation, тогда щелчок по этой ссылке 

в Курсе приведёт пользователя к странице указателей Курсов course/index.php. 

4.5.27.2.Настройки Блока Навигации 
Администратор может изменить настройки Навигации, такие как Домашняя 

страница по умолчанию и показывать ли Категории Курсов в Блоке Навигации, в 

Administration→Site administration→Appearance→Navigation. Подробности см. в разделе 

«Навигация (п. 3.8)». 

4.5.27.3.Сокрытие Блока Навигации 
 Один из способов создать трудности для Студентов видеть Курсы, на которые они не 

зачислены, состоит в том, чтобы ввести в действие Мою Домашнюю Страницу, а затем 

скрыть Блок Навигации. 

 Это будет приводить всех пользователей после регистрации на их 

Домашнюю Страницу, где они увидят список тех Курсов, на которые зачислены. 

 Сокрытие Блока Навигации затруднит для них отыскание других Курсов. 
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4.5.27.4.FAQ 
4.5.27.4.1.Can you change what links are 
available in the navigation block? 
Currently there are no admin settings to modify what is available in this 

block except as indicated above. To do this requires a code hack. 

 

This could change. See the discussion here: 

https://moodle.org/mod/forum/discuss.php?d=218358 and the tracker item 

here to do with options to change the settings block: 

http://tracker.moodle.org/browse/MDL-36585 

Or you can always try some contrib (3rd party) Navigation blocks that 

allow you to setup what is available on the menu. 

 FN My Menu 

 Course Menu 

 Search for more... 

4.5.28.Network servers 
The Network Servers block allows you to roam to other Moodle (or 

Mahara) servers. Works in conjunction with the 'Can roam to other 

Moodles' permission which allows a user to roam to another Moodle site 

which is part of a Moodle Network. The Moodle Network (MNet) feature 

allows a Moodle administrator to establish a link with another Moodle, and 

to share some resources with the users of that Moodle. 

4.5.29.Online users 
The Online users block shows a list of users who have been logged into the 

current course. The list is updated on a regular basis (the default is every 5 

minutes but this may be changed - see below). 

Note that even though a user may have been logged into a course within 

the last 5 minutes, it does not necessarily mean that this user is still online. 

 

 If you hold the cursor over somebody's name, you will see how long 

ago that person was last "seen" in the course 

 If you click on the envelope icon next to somebody's name, you will be 

able to send a private message to that person (using Moodle's 

messaging system) 

Note: If separate groups are enabled in a course and this block is added 

onto the course page, only members of the group will be displayed in the 

list. 

 

4.5.27.4.Часто задаваемые вопросы 
4.5.27.4.1.Можете вы изменить то, какие ссылки доступны в 
Блоке Навигации? 

В настоящее время не существует настроек Администратора, чтобы 

модифицировать то, что доступно в этом Блоке, за исключением указанных выше. Чтобы 

сделать это, потребуется взламывать код. 

Это можно исправить. См. Обсуждение здесь: 

https://moodle.org/mod/forum/discuss.php?d=218358, и здесь приведён элемент средства 

отслеживания по созданию возможности изменения Блока настроек: 

http://tracker.moodle.org/browse/MDL-36585. 

Или вы всегда можете испытать некоторые предлагаемые (3-ей стороной) Блоки 

навигации, которые позволят вам установить то, что доступно из меню: 

 Моё меню FN. 

 Меню Курса. 

 Ищите больше в. 

4.5.28.Сетевые серверы 
Блок «Сетевые серверы» позволяет вам странствовать по другим серверам Moodle 

(или Mahara). Он работает в связке с Полномочием «Can roam to other Moodles (можно 

перемещаться к другим системам Moodle)», которое разрешает пользователю отправиться 

к другому Сайту Moodle, который является частью сети Moodle. Средство Moodle Network 

(MNet) позволяет Администратору установить ссылку на другую Moodle, и совместно 

использовать некоторые ресурсы с пользователями той Moodle. 

4.5.29.Онлайн-пользователи 
Блок «Онлайн-пользователи» показывает список пользователей, которые 

зарегистрированы в текущем Курсе. Этот список обновляется на регулярной основе (по 

умолчанию каждые 5 минут, но это может быть изменено – см. ниже). 

Заметьте, что, даже если пользователь смог зарегистрироваться на Курс в течение 5 

последних минут, это не обязательно означает, что этот пользователь до сих пор в режиме 

онлайн. 

 Если вы удерживаете Курсор над именем кого-либо, вы увидите, сколько времени 

назад последний раз «видели» эту личность в этом Курсе. 

 Если вы щёлкнете иконку «конверт» следом за каким-либо именем, вы сможете 

переслать личное сообщение этой личности (используя систему обмена сообщениями 

Moodle). 

Замечание: Если на Курс зачислены отдельные Группы, и этот Блок добавлен на 

страницу этого Курса, только члены этой Группы будут отображаться в данном списке. 

https://moodle.org/mod/forum/discuss.php?d=218358
http://tracker.moodle.org/browse/MDL-36585
https://moodle.org/plugins/view.php?plugin=block_fn_my_menu
https://moodle.org/plugins/view.php?plugin=block_course_menu
https://moodle.org/plugins/view.php?plugin=block_course_menu
http://docs.moodle.org/25/en/MNet
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4.5.29.1.Site administration settings 
The online users block has one setting which may be changed by an 

administrator in Settings > Site administration > Plugins > Blocks > 

Online users. 

 block_online_users_timetosee - The number of minutes after which 

users will not be displayed in the list. The default is 5 minutes. You 

may want to adjust this if the list of users displayed is too long or too 

short. 

4.5.29.2.See also 
Using Moodle forum posts: 

 The Lonely People Block forum discussion and code for combining the 

Online Users block and People block 

 tweaking code to add icon after teachers name for site administrators 

 

4.5.30.People 
The People block on a course is enabled by Turning Editing On activating 

the menu and from it selecting People. The People Block contains a link to 

the list of participants associated with that Moodle course area in various 

roles. 

The participants' profiles are available by clicking on their name or picture. 

It's possible that some participants may be uncomfortable with that (or that 

staff may be uncomfortable on their behalf). As well as emphasising the 

benefits of social presence, it may reassure them to know that, if they 

prefer, they can configure their profiles to hide their email address. 

 

The list of participants can be sorted by first name, surname, city, country 

and last access. There is a pull-down menu which can filter the list for a 

specific role (for example Tutors or Students). 

4.5.31.Quiz results 
The quiz results block displays the highest and/or lowest grades achieved 

on a quiz within a course. There must be a quiz in the course to correctly 

configure this block. 

The edit icon link allows the teacher to choose a quiz from a drop down 

menu which will display the results. 

There are other options such as the number of the lowest and highest 

grades displayed. If both the highest and lowest grades are set to zero then 

no results will be displayed. To display all grades, either of these to the 

number of participants in the course. 

4.5.29.1.Настройки управления Сайта 
Блок «Онлайн-пользователи» имеет одну настройку, которая может быть изменена 

Администратором в Administration→Site administration→Plugins→Blocks→ Online users. 

 

 block_online_users_timetosee – число минут, после которых пользователи не могут 

отображаться в этом списке. По умолчанию – это 5 минут. Вы можете отрегулировать 

это, если этот список пользователей отображается слишком долго или слишком быстро. 

 

4.5.29.2.См. также 
Используя корреспонденцию форума по использованию Moodle: 

 Обсуждения форума «Блок страдающих от одиночества людей» и код для сочетания 

онлайн-пользователей и «Блока людей». 

 «Тонкая настройка кода для добавления иконки после имён Преподавателей» для 

Администраторов Сайта. 

4.5.30.Люди 
Блок «Люди» по Курсу включается активацией меню «Add A Block (добавить блок 

А)» в режиме редактирования и выбором «Люди». Блок «Люди» содержит ссылку на 

список участников, связанных с этой областью Курса Moodle в различных Ролях. 

 

Профили Участников доступны по щелчку на их имени или фотографии. 

Возможно, чтобы некоторые Участники почувствуют неудобство в связи с этим (или 

руководство в связи с тем, что это позволено от их имени). Так же, как придание особого 

значения выгодам социального присутствия, это может побуждать их узнать, что если они 

предпочтут, они могут сконфигурировать свои Профили так, чтобы скрыть адреса их э-

почты. 

Список Участников может быть отсортирован по имени, фамилии, городу, стране и 

последнему посещению системы Moodle. Имеется ниспадающее меню, которое позволяет 

отфильтровать этот список для конкретной Роли (например, Наставников или Студентов). 

4.5.31.Результаты Экзамена 
Блок «Результаты Экзамена» отображает самые высокие и/или самые низкие 

Оценки, полученные на Экзамене внутри Курса. Чтобы правильно сконфигурировать этот 

Блок, в Курсе должен присутствовать Экзамен. 

Ссылка на иконку редактирования позволяет Преподавателю выбрать Экзамен из 

ниспадающего меню, что отобразит эти результаты. 

Существуют другие опции, такие как число отображаемых высших и низших 

Оценок. Если и высшие, и низшие Оценки установлены в 0, тогда никаких результатов 

отображаться не будет. Чтобы отобразить все Оценки, установите любую из них по числу 

Участников в Курсе. 

http://moodle.org/mod/forum/discuss.php?d=32461#151290
http://docs.moodle.org/25/en/People_block
http://moodle.org/mod/forum/discuss.php?d=33172#244755
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Grades can be displayed as percentages, fractions or absolute numbers. 

 

If the quiz supports groups you can also show group results instead of 

students. 

4.5.32.Random glossary entry 
 
The random glossary block can be used to display random entries from a 

glossary, which usually take the form of dictionary style definitions. 

However the flexibility of Moodle's HTML editor allow users to adapt this 

block for other purposes such as 'Quote of the Day' or a random picture 

gallery that changes each time the page is refreshed. 

 

Before using the random glossary entry block you have to configure it 

using the edit icon. There you will have a number of fields to complete: 

 

4.5.32.1.Title 
Here you will write the title of that block. The default is Random Glossary 

Entry. 

4.5.32.2.Take entries from this glossary 
This allows you to choose from which glossary the entries in this block 

will be chosen. 

New feature in Moodle 2.5! 

Global glossaries are also available, (thus allowing a glossary from a 

course to be displayed in a block on the front page for example) 

4.5.32.3.Days before a new entry is chosen 
This sets the number of days for how long that a given entry is displayed. 

If set to "0," a new entry displays every time the page is refreshed. 

 

4.5.32.4.How a new entry is chosen 
You have four options: Last modified entry will always display the entry 

that was last modified, and Random entry will choose a new one at random 

every time. The option Next entry will cycle through the entries in order. 

This option is especially useful when a number of days is also chosen, 

allowing you to make a Quote of the week or a Tip of the day that 

everyone sees. 

New feature in Moodle 2.5! 

Alphabetical will display the entries in strict aphabetical order. 

 

Оценки могут быть отображены как в процентах, так в дробных и абсолютных 

числах. 

Если Экзамен поддерживает Группы, вы можете также показать результаты Групп, 

вместо Студентов. 

4.5.32.Выбираемая случайным образом Запись 
Глоссария 

Блок «Рандомизированный Глоссарий» может быть использован для отображения 

случайным образом выбираемых Записей из Глоссария, который обычно имеет форму 

определений в стиле словаря. Однако приспособляемость HTML-редактора Moodle 

позволяет пользователям адаптировать этот Блок для других целей, таких как «Цитата 

дня» или галерея случайным образом выбираемых фотографий, которые каждый раз 

меняются так, что страница освежается. 

Перед использованием Блока «Выбираемая случайным образом Запись Глоссария» 

вы должны сконфигурировать его, используя иконку редактирования. Перед вами 

появится ряд полей, которые нужно заполнить. 

4.5.32.1.Заголовок 
Здесь вы записываете заголовок этого Блока. По умолчанию он – Random Glossary 

Entry. 

4.5.32.2.Принимать Записи из этого Глоссария 
Это позволяет вам выбрать, из какого Глоссария будут выбираться Записи в этот 

Блок. 

Новое средство в Moodle 2.5! 

Доступны также глобальные Глоссарии (таким образом позволяющие Глоссарию 

из Курса быть отображённым, например, на Главной странице). 

4.5.32.3.Дней до выбора новой Записи 
Это поле устанавливает число дней отображения данной Записи. Если оно 

установлено в «0», новая Запись отображается каждый раз, когда страница с Блоком 

освежается. 

4.5.32.4.Как выбирается новая Запись 
Вы имеете четыре опции. Last modified entry (последняя модифицированная 

запись) всегда будет отображать Запись, которая была модифицирована последней. 

Random entry (рандомизированная запись) всегда выберет новую Запись каждый раз 

случайным образом. Опция Next entry (следующая запись) будет по порядку циклически 

выбирать Записи. Эта опция особенно полезна, когда выбирается также и число дней, 

позволяя вам создать Цитату недели или Главную новость дня, которую увидит каждый. 

Новое средство в Moodle 2.5! 

Alphabetical (алфавитный) отобразит Записи строго в алфавитном порядке. 
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4.5.32.5.Show concept (heading) for each 
entry 
Enabling that option will show headings for each entry that appears in the 

block. 

4.5.32.6.Links 
You can display links to actions of the glossary this block is associated 

with. The block will only display links to actions which are enabled for 

that glossary. You can type texts to appear for whichever of the three 

options: Users can add entries to the glossary, Users can view the glossary 

but not add entries or Users cannot edit or view the glossary. 

 

4.5.32.7.See also 
 Glossary module 

4.5.33.Recent activity 
You know that game where everybody except one leaves a room, the 

person who's left changes just one thing, then everybody comes back and 

has to spot the thing that changed? 

Enabling the Recent Activity Block will show participants updates since 

they last accessed the course. 

Without it (unless you go out of your way to notify them) students and 

colleagues are prone to miss the changes you make e.g. modifications or 

additions, because they don't have an exact memory of that course as they 

last left it and because they have no way of knowing when to look for a 

change. 

The Recent Activity Block can relieve a lot of anxiety in students who are 

worried about missing something important. 

The Recent activity block lists course activity, such as updated resources 

and activities, forum posts and assignment submissions, since the user last 

accessed the course. 

 

4.5.33.1.Full report of recent activity 
A full report of recent activity can be accessed via a link in the recent 

activity block. This will lead to a screen which has a time filter and 

organizes activity by course sections. 

The advanced search button or link has more filter options. These include 

selecting all or a specific: participant, activity, since date. It also allows the 

list to be sorted in course order, oldest to recent or recent to oldest date. 

 

4.5.32.5.Показать идею (заголовок) для каждой Записи 
 

Включение этой опции покажет заголовки для каждой Записи, которая появится в 

этом Блоке. 

4.5.32.6.Ссылки 
Вы можете отобразить ссылки на действия Глоссария, с которым этот Блок связан. 

Блок будет отображать только ссылки на действия, которые позволены для этого 

Глоссария. Вы можете набрать текст, который появится для какой угодно из этих трёх 

опций: Пользователи могут добавлять Записи в Глоссарий, Пользователи могут 

просматривать Глоссарий, но не добавлять Записи или Пользователи не могут 

редактировать или просматривать Глоссарий. 

4.5.32.7.См. также 
 Модуль «Глоссарий» (п. 4.3.8). 

4.5.33.Недавняя деятельность 
Вы знаете такую игру, когда все, кроме одного, оставляют комнату, оставшийся 

человек меняет только одну вещь, затем все возвращаются обратно и должны указать, 

какая вещь изменена? Включение Блока «Недавняя деятельность» покажет Участникам 

обновления с тех пор, когда они последний раз посещали Курс. 

 

Без этого (если только вы не изобрели свой способ замечать это) Студенты и 

коллеги склонны пропустить изменения, которые вы сделали, например, модификации или 

добавления, потому что они не помнят точно этот Курс таким, как оставили его последний 

раз, и из-за этого у них нет способа увидеть изменения, когда будут просматривать Курс. 

 

Блок «Недавняя деятельность» может облегчить множество забот Студентов, 

которые боятся пропустить нечто важное. 

Блок «Недавняя деятельность» перечисляет действия в Курсе, такие как 

обновлённые Ресурсы или Интерактивные Действия, корреспонденции Форумов и 

передачи для рассмотрения ответов на Задания, для этого пользователя с момента его 

последнего посещения Курса. 

4.5.33.1.Полный отчёт о недавней деятельности 
Полный отчёт о недавней деятельности может быть доступен по ссылке в Блоке 

«Недавняя деятельность». Она приведёт к экрану, который имеет временной фильтр и 

систематизирует деятельность по Разделам. 

Кнопка или ссылка продвинутого поиска имеют больше опций фильтрации. Они 

включают выбор всех или конкретного: Участника, Интерактивного Действия, начиная с 

даты. Также допускается сортировка списка в порядке от старых по дате Курсов к 

недавним или от недавних к старым. 
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There is a link to return to the Normal search screen. 

4.5.33.2.Site administration setting 
The setting assignment_showrecentsubmissions in Settings > Site 

administration > Plugins > Activity modules > Assignment determines 

whether students can see other students' recent assignment submissions or 

not. Teachers can always see all recent submissions and students can 

always see their own recent submissions. 

 

4.5.33.3.See also 
 Reports 

4.5.34.Recent blog entries 
This block can be configured to display the last N blog entries, filtered by 

context. For example, if you are viewing an assignment activity, this block 

would display the last N blog entries that are associated with that 

assignment. 

4.5.34.1.See also 
 Blogs 

4.5.35.Remote RSS feeds 
The RSS feeds block enables RSS feeds from external websites to be 

displayed within Moodle. As the information on the other site (for 

example, news headlines or recently added documents) is changed the 

block will update to show the latest information. 

One or more RSS feeds can be added to a course by selecting them from an 

existing list. Site and course home pages are common places to place an 

RSS feed block(s). 

4.5.35.1.Configuring RSS feeds block 
After adding an RSS feed block, select the edit icon on the Remote News 

Feed block. The default will open up the Configure this block tab. 

 

4.5.35.1.1.Display each link's description? 
Choose yes or no from the drop-down menu to determine whether the 

block will display a description of each article, or just the title of the 

article. Both the title and description are generated by the external feed. 

4.5.35.1.2.Max number of entries to show per 
block 
Determines how many articles will be displayed. The most recent will be 

displayed first. 

Имеется ссылка для возврата на экран обычного поиска. 

4.5.33.2.Настройки управления Сайтом 
Настройка assignment_showrecentsubmissions (задание – показать недавние ответы) 

в Administration→Site administration→Plugins→Activity modules→Assignment определяет 

может или нет Студент видеть недавно переданные на рассмотрение ответы других 

Студентов на Задание. Преподаватель всегда может видеть все недавние переданные на 

рассмотрение ответы и Студенты могут видеть свои собственные недавно переданные на 

рассмотрение ответы. 

4.5.33.3.См. также 
 Отчёты. 

4.5.34.Недавние Записи Блогов 
Этот Блок может быть сконфигурирован для отображения последних N Записей 

Блогов, отфильтрованных по контексту. Например, если вы просматриваете 

Интерактивное Действие «Задание», этот Блок отобразит последние N Записей Блогов, 

которые связаны с этим Заданием. 

4.5.34.1.См. также 
 Блоги (п. 3.17.1). 

4.5.35.Удалённые RSS-рассылки 
Блок «Удалённые RSS-рассылки» позволяет рассылкам с внешних веб-Сайтов 

быть отображёнными внутри Moodle. Поскольку информация на другом Сайте (например, 

заголовки новостей или недавно добавленных документов) изменяются, этот Блок будет 

обновляться, чтобы показывать самую свежую информацию. 

Одна или более RSS-рассылок могут быть добавлены в Курс выбором их из 

существующего списка. Домашние страницы Сайта и Курса являются общими местами 

для размещения Блока(ов) «Удалённые RSS-рассылки». 

4.5.35.1.Конфигурирование Блока RSS-рассылок 
После добавления Блока RSS-рассылок выберите иконку редактирования на Блоке 

«Удалённая рассылка новостей». По умолчанию откроет ярлычок «Сконфигурировать этот 

Блок». 

4.5.35.1.1.Показать описание вызванного элемента? 
Выберите Yes или No из ниспадающего меню, чтобы определить, будет ли этот 

Блок отображать описание каждой вещи, или только её название. Как заголовок, так и 

описание генерируются внешней рассылкой. 

4.5.35.1.2.Максимальное число Записей для отображения 
 

Определяет, сколько Записей будет отображаться. Самые последние будут 

отображаться первыми. 

:%20http:/docs.moodle.org/25/en/Reports
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4.5.35.1.3.Choose the feeds to make available 
Check the box next to each feed you would displayed in this block. You 

can have more than one instance of the RSS feed block if you would like to 

break them up. 

4.5.35.1.4.Title 
Enter a title for the block. If you leave this blank a title will be taken from 

the RSS feeds, which can be confusing if there are multiple feeds in one 

block. 

4.5.35.1.5.Display a link? 
Each article headline should link to the full article, but you can also display 

a link to the original site where available. 

4.5.35.1.6.Show channel image? 
Some feeds supply an image or logo from the original site which you can 

choose to display when available. 

4.5.35.2.Add/Manage all RSS feeds 
All the Moodle site's RSS feeds can be managed on the Manage all my 

feeds tab in the RSS News Feed edit menu. The site administrator may give 

other roles permission to use this tab. This tab creates a list of RSS feeds 

that can be selected for display in every course on the Moodle site. 

 

Copy and paste (or type) the URL address of the RSS feed in the space 

provided. This the generating site's actual RSS page address. For example 

here is a Moodle RSS feed address: 

http://moodle.org/rss/file.php/1/1/forum/1/rss.xml. 

Adding a custom title will take the place of the one supplied by the 

generating site. There is a validation tool included to confirm the feed URL 

is accurate. 

When checked, the Shared Feed checkbox makes the feed available 

(although not necessarily visible) to all courses on the Moodle site. This 

would be useful, for example, when a college has an urgent 

announcements feed that would be of interest to all students, regardless of 

the Moodle course in which they are enrolled. Leave unchecked if the feed 

is of interest only to a single course. 

Click the Add button to submit the feed. 

4.5.35.3.Site administration settings 
The RSS feeds block has some settings which may be changed by an 

administrator in Settings > Site administration > Plugins > Blocks > RSS 

client. 

4.5.35.1.3.Выберите ссылки, обеспечивающие доступность 
Пометьте окошко, следующее за каждой рассылкой, которую вы хотите 

отображать в этом Блоке. Вы можете иметь более одного экземпляра Блока RSS-рассылок, 

если предпочитаете иметь их раздельно. 

4.5.35.1.4.Заголовок 
Введите заголовок для этого Блока. Если вы оставите это поле пустым, заголовок 

будет взят из RSS-рассылок, что может привести к перепутыванию, если в одном Блоке 

существует много ссылок. 

4.5.35.1.5.Отображать ссылку? 
Каждый заголовок статьи должен ссылаться на полную Запись, но вы можете 

также отображать ссылку на первоначальный Сайт, где возможно. 

4.5.35.1.6.Показать изображение канала? 
Некоторые рассылки поставляют изображение или логотип с первоначального 

Сайта, который вы можете выбрать, чтобы отображать, где возможно. 

4.5.35.2.Добавлять/управлять всеми RSS-рассылками 
Все Сайтовские RSS-рассылки Moodle могут управляться с ярлычка Manage all my 

feeds (управлять всеми моими ссылками) в меню редактирования «Ссылка RSS-новостей». 

Администратор Сайта может дать другое Полномочие Ролям, чтобы использовать этот 

ярлычок. Этот ярлычок создаёт список RSS-рассылок, который может быть который 

может быть выбран для отображения в каждом Курсе на Сайте Moodle. 

Скопируйте и вклейте (или наберите) адрес URL RSS-рассылки в предоставленное 

пространство. Это генерация адреса действительной RSS-страницы Сайта. Например, 

здесь адрес RSS-рассылки: http://moodle.org/rss/file.php/1/1/forum/1/rss.xml. 

 

Добавление заголовка клиента унаследует пространство этого заголовка, 

предоставляемое генерирующим Сайтом. Существует инструмент проверки 

достоверности, включаемый для подтверждения того, что URL рассылки является верной. 

Когда помечено, окошко-флажок «Shared Feed (разделяемая рассылка)» делает 

ссылку доступной (хотя необязательно видимой) всем Курсам на Сайте Moodle. Это может 

быть полезным, например, когда колледж имеет срочную рассылку объявлений, которая 

может быть интересна всем Студентам, независимо от Курса Moodle, на который они 

зачислены. Оставьте непомеченным, если эта рассылка интересна только для 

единственного Курса. 

Щёлкните кнопку Add (добавить), чтобы передать рассылку на рассмотрение. 

4.5.35.3.Настройки управления Сайта 
Блок RSS-рассылок имеет некоторые настройки, которые могут быть изменены 

Администратором в Administration→Site administration→Plugins→Blocks→RSS client. 

http://moodle.org/rss/file.php/1/1/forum/1/rss.xml
http://moodle.org/rss/file.php/1/1/forum/1/rss.xml
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 block_rss_client_num_entries - The default number of entries to show 

per feed shown in the block. This can be overridden when you actually 

set up a block in a course. 

 block_rss_timeout - The time in minutes between a reread of the feed 

by Moodle. Since some feeds on busy sites can take long to load, it can 

slow down the load of your course page. Therefore it is wise to set this 

time rather high, so only every now and then a visitor of your course is 

the victim of the slow remote server. Time is in minutes here. 

 

4.5.35.4.See also 
 RSS feeds and how to add them to your course video 

 victim RSS feeds on front page not working 

4.5.36.Search forums 
The Search forum block allows you to search the course forums for a word 

or phrase. Type the word or phrase you want to find in the text field space. 

 

For basic searching of one or more words anywhere in the texts, just type 

them separated by spaces. All words longer than two characters are used. If 

you want to use advanced search options you can either move to the 

Advanced Search page (clicking Advanced Search in the Search Forums 

block) or use search button without typing anything in the Search field. 

 

To force exact matching of a word, use the plus sign, and the minus sign if 

there are particular exact words you don't want included in the search. To 

search for a particular phrase, use double quotes around it. To search for 

texts by a particular user, prefix a word from their name with "user:". If 

you know the user id of a particular user, you can search for them like this. 

To search for a word within the subject or title of a text only, prefix the 

word with "subject:". 

You can also use the Advanced forum search options. 

4.5.36.1.Advanced forum search 
To use the advanced search options press the Advanced search button or 

the search button without typing anything in the Search field. You will see 

a complete form that makes it easier to do advanced searches. 

 These words can appear anywhere in the post works in the same way as 

the Search field: one or more words you type in here will be found in all 

the places in the post they appear. 

 

 

 block_rss_client_num_entries – Число записей по умолчанию к показу при ссылке на 

этот Блок. Это может быть переопределено в процессе первоначального включения 

Блока в Курс. 

 block_rss_timeout – Время в минутах между перечитыванием рассылки Moodle. 

Поскольку некоторые рассылки на загруженных посетителями Сайтах могут 

загружаться долго, это может сильно замедлить загрузку страницы вашего Сайта. 

Следовательно, лучше установить это время побольше, чтобы только изредка 

посетитель вашего курса мог оказаться жертвой медленного удалённого сервера. Здесь 

время задаётся в минутах. 

4.5.35.4.См. также 
 RSS-рассылки и как добавлять их в ваше видео по Курсу. 

 Если RSS-рассылки на Главной странице не работают. 

4.5.36.Искать Форумы 
Блок «Искать Форумы» позволяет вам искать Форумы 

Курса по слову или фразе. Наберите слово или фразу, которую 

хотите отыскать в пространстве текстового поля. 

Для базисного поиска одного или более слов где-нибудь в 

текстах, просто наберите их, разделяя пробелами. Используются все слова длиннее двух 

символов. Если вы хотите использовать опции продвинутого поиска, вы можете либо 

переместиться на страницу продвинутого поиска (щёлкнув Advanced Search (продвинутый 

поиск) в Блоке «Искать Форумы») или используйте кнопку Search (поиск), ничего не 

набирая в поле поиска. 

Для поиска по точному соответствию слову используйте знак плюс, а знак минус, 

если есть точные слова, которые вы не хотите включать в поиск. Чтобы отыскать 

конкретную фразу, заключайте её в двойные кавычки. Чтобы искать тексты конкретного 

пользователя, используйте приставку "user:" к слову из его имени. Если вы знаете 

идентификатор конкретного пользователя, вы можете искать по нему подобным образом. 

Чтобы искать слово только внутри темы или заголовка текста, используйте приставку 

"subject:" к этому слову. 

Вы можете также использовать продвинутые опции поиска Форума. 

4.5.36.1.Продвинутый поиск Форума 
Чтобы использовать продвинутые опции поиска, нажмите кнопку Advanced Search 

или кнопку Search, ничего не набирая в поле поиска. Вы увидите детальную форму, 

которая облегчит продвинутые поиски. 

 These words can appear anywhere in the post (эти слова могут появиться где угодно в 

корреспонденциях) работает тем же способом, как и поле Search (поиск): одно или 

более вами набранных здесь слов будут отыскиваться везде в корреспонденциях 

Форумов, где они образуются. 

http://www.youtube.com/watch?v=wiwSZNgXuzo
http://tracker.moodle.org/browse/MDL-31599
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 This exact phrase must appear in the post searches for an exact phrase 

in the post 

 You should use These words should NOT be included if there are any 

particular words you don't want included in the search 

 

 Posts must be newer / older than this narrows down the number of posts 

searching according to time limits. 

 

 Choose which forums to search allows searching only in one forum 

 

 These words should be in the subject narrows down the number of posts 

found to those containing a given word/phrase in the forum subject 

 

 This name should match the author allows searching for the posts by 

one author 

4.5.36.2.Firefox search plugins 
You can get some of the functions described above by using Firefox search 

plugins for searching directly from the Firefox search bar. 

4.5.37.Section links 
The Section links block helps the student or teacher to quickly navigate to 

a particular topic/week section of the course (depending on whether the 

course uses either the "Topics" or "Weekly" format. The numbered links 

displayed within the block are the numbers assigned to the course 

topic/week sections. 

Where a topic/week section is highlighted, the link to that section within 

the "Section Links" block is emboldened. In addition, a link for the 

highlighted section ("Jump to the current topic/week") is displayed. Click 

the "Jump to the current topic/week" link to display the highlighted section 

at the top of the screen. 

 If there are a large number of topic/week sections, the block displays 

every other even number i.e. 2, 4 etc. or every fifth numbered 

topic/week section. 

4.5.37.1.Site administration settings 
Settings > Site administration > Plugins > Blocks > Section links 

The section links block has some settings which may be changed by an 

administrator. There are two 'number of sections' value in the setting page, 

say numsections1 and numsections2. 

If the number of sections in the course is less than either of them, the 

section links will increase by 1. 

 This exact phrase must appear in the post (эта точная фраза должна появиться в 

корреспонденциях) ищет точную фразу в корреспонденциях. 

 Вы должны использовать These words should NOT be included (эти слова не должны 

включаться), если существуют любые конкретные слова, которые вы не хотите 

включать в поиск. 

 Posts must be newer / older than this (корреспонденции должны быть новее/старее чем 

эта) сокращает число корреспонденций для поиска в соответствии с временными 

ограничениями. 

 Choose which forums to search (выберите, в каких форумах искать) разрешает поиск 

только в одном Форуме. 

 These words should be in the subject (эти слова должны быть в такой-то теме) сокращает 

число корреспонденций для поиска до тех, которые содержат данное слово/фразу в 

теме Форума. 

 This name should match the author (это имя должно соответствовать автору) разрешает 

поиск в корреспонденциях одного автора. 

4.5.36.2.Плагины поиска Firefox 
Вы можете получить некоторые из описанных выше функций, используя Firefox 

search plugins для поиска прямо из панели поиска браузера Firefox. 

4.5.37.Ссылки на Разделы 
Блок «Ссылки на Разделы» помогает Студенту или Преподавателю быстро 

переместиться к конкретному Разделу-Теме/Неделе Курса (в зависимости от 

использованного формата Курса «Topics (темы)» или «Weekly (еженедельный)»). 

Пронумерованные ссылки внутри Блока являются номерами, 

назначенными Разделам-Темам/Неделям Курса. 

В тех случаях, когда Раздел-Тема/Неделя подсвечен, 

ссылка на этот Раздел внутри Блока «Ссылки на разделы» выделяется полужирным 

шрифтом. В дополнение отображается ссылка на подсвеченный Раздел («перейти в 

текущий Раздел-Тему/Неделю»). Щёлкните ссылку «Jump to the current topic/week», чтобы 

отобразить подсвеченный Раздел вверху экрана. 

 Если имеется большое число Разделов-Тем/Недель, этот Блок отображает каждый 

чётный номер, например, 2, 4 и т.д. или каждый пятый пронумерованный 

Раздел Темы/Недели. 

4.5.37.1.Настройки управления Сайта 
Administration→Site administration→Plugins→Blocks→Section links. 

Блок «Ссылки на Разделы» имеет некоторые настройки, которые могут быть 

изменены Администратором. На странице настроек имеется два «числа разделов», скажем, 

числоразделов1 и числоразделов2. 

Если число разделов в данном Курсе меньше любого из них, ссылки на Разделы 

будут возрастать на 1. 
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If the number of sections in the source is more than numsections1, but less 

than numsections2, the increase by value will respect numsections1's 

increase by setting. 

If the number of sections in the source is more than both of numsections1 

and numsections2, and numsections2 is more than numssections1, the 

increase by value will respect numsections2's increase by setting. 

4.5.38.Self completion 
The self completion block provides a link for students to declare that they 

have completed the course. This maybe part of the Course completion 

requirements. 

When a student believes they have completed the course, they click on the 

"Complete course" link in this block. 

4.5.38.1.Using the self completion block 
To allow a student to decide for themselves when they have completed a 

course, there are two requirements: 

 The completion tracking setting must have the "Manual Self 

Completion" box checked. 

 The Self completion block must be added to the course. 

The student may then click the "complete course link" in the block. 

 

They are then asked to confirm they have completed the course and the 

course status will change to "complete" after the next Cron job. 

Tip: Cron is an important part of the course completion process. It 

basically re-compiles all the course completion reports. 

4.5.38.2.See also 
 Course completion 

4.5.39.Social activities 
This block enables additional activities to be added to a course in social 

format. 

Note: it is not available for other course formats. 

 

 

 

 

 

 

 

 

Если число Разделов в первоисточнике больше «Numsections1 (числоразделов1)», 

но меньше «Numsections2 (числоразделов2)», возрастание будет производиться на 

значение, заданное настройкой «Numsections1». 

Если число Разделов в первоисточнике больше и Numsections1, и Numsections2, а 

Numsections2 больше чем Numsections1, возрастание будет производиться на величину, 

заданную настройкой Numsections2. 

4.5.38.СамоЗавершение 
Блок «СамоЗавершение» предоставляет ссылку для Студентов, чтобы объявлять о 

том, что они завершили этот Курс. Это может быть частью 

требований по Завершению Курса (п. 4.9.4). 

Когда Студент считает, что он завершил Курс, он щёлкает по 

ссылке «Complete course (завершить курс)» в этом Блоке. 

4.5.38.1.Использование Блока «СамоЗавершение» 
Чтобы позволить Студенту решать самому для себя, когда он завершил Курс, 

существуют два требования: 

 Настройка отслеживания Завершения (п.4.9.4.1) должна иметь помеченным окошко 

«Manual Self Completion (само завершение вручную)». 

 Блок «СамоЗавершение» должен быть добавлен в Курс. 

После этого Студент может щёлкнуть ссылку «Complete course (завершить курс)» в 

этом Блоке. 

Его попросят подтвердить, что он завершил этот Курс, и статус Курса будет 

изменён на «Complete (завершить)» после следующего выполнения Хрона (п. 2.1.3). 

Совет: Хрон является важной частью процесса Завершения Курса. Он, по 

существу, повторно собирает все отчёты по Завершению Курсов. 

4.5.38.2.См. также 
 Завершение Курса (п. 4.9.4). 

4.5.39.Социальные Интерактивные Действия 
Этот Блок позволяет быть добавленными в Курс 

дополнительным Интерактивным Действиям в 

Курс Социального Формата. 

Замечание: Он не доступен для Курсов других форматов. 
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4.5.40.Tags 
A very effective way of viewing all tags is in a tags block, or "tag cloud". 

A unique feature of tag clouds are that the size of each tag is related to the 

number of items associated with it. The larger the tag, the more items 

associated with it. 

 

4.5.40.1.Adding a tags block to a course page 
 
 Click the "Turn editing on" button. 

 Select tags from the Add blocks menu. 

 If appropriate, move the tags block up and/or left, using the arrow icons 

under the block title. 

The tags block may be configured via the edit icon in the block header. 

 

4.5.40.2.Site administration settings 
The tags block has one setting which may be changed by an administrator 

in Administration > Site administration > Plugins > Blocks > Tags. 

 Show course tags - This enables users such as students to tag courses. 

When they add the tags block to their My home page it displays the 

course tags they have created. 

4.5.40.3.See also 
 Tags 

4.5.41.Upcoming events 
The Upcoming events block displays future events in a summarized list. 

The number of days in advance is determined by the calendar_lookahead 

setting in Site Administration > Appearance > Calendar. BUT it seems the 

look-ahead has a setting in Preference on the user page when logged in. 

This setting, when logged in, seems to over-ride the setting described 

above. It is not clear if there is a way to extend Calendar > Preference 

look-ahead setting, beyond the 20 days that it offers. 

Events are generated directly from the calendar and/or activity deadlines, 

providing a link to full details or directly to the activity. 

 

There are also links to Go to calendar... and add a New Event.... 

If you click on a date, you will go to the day-view calendar for that day. If 

the title of the event is a link, and you click on it, you will be taken to that 

event. 

4.5.40.Теги 
Блок «Теги (команды форматирования)» или «Облако тегов» – очень эффективный 

способ просмотра всех тегов. 

Уникальное средство облаков тегов состоит в том, что 

размер каждого тега соотносится с числом связанных с ним 

элементов. Чем больше тег, тем больше элементов с ним связано. 

4.5.40.1.Добавление Блока «Теги» на 
страницу Курса 
 Щёлкните кнопку «Turn editing on». 

 Выберите Tags из меню Add blocks. 

 Если нужно, переместите Блок «Теги» вверх и/или влево, используя иконки стрелок 

под заголовком этого Блока. 

Блок «Теги» может быть сконфигурирован через иконку редактирования в 

заголовке этого Блока. 

4.5.40.2.Настройки управления Сайта 
Блок «Теги» имеет одну настройку, которая может быть изменена 

Администраторов в Administration→Site administration→Plugins→Blocks→Tags. 

 Показать теги Курса – это позволяет пользователям, таким как Студенты, 

промаркировать Курсы. Когда они добавляют Блок «Теги» на свою 

Домашнюю Страницу, он отображает теги Курса, которые они создали. 

4.5.40.3.См. также 
 Теги (п. 3.17.3). 

4.5.41.Наступающие события 
Блок «Наступающие события» отображает будущие события в подытоживающем 

списке. Число дней заранее определяется настройкой calendar_lookahead в 

Administration→Site administration→Appearance→Calendar. Но он покажется таким, какова 

настройка предварительного просмотра на странице пользователя после регистрации. Эта 

настройка, после регистрации, представляет предварительный просмотр таким, как эта 

настройка описана выше. Не ясно, существует ли способ расширить настройку 

Calendar→calendar_lookahead за пределы 21 дня, которые там предлагаются. 

События генерируются непосредственно из Календаря и/или 

сроков окончания Интерактивных Действий, предоставляя ссылку на 

полную детализацию или непосредственно Интерактивное Действие. 

Имеются также ссылки на Go to calendar… (перейти к календарю) 

и добавить New Event… (новое событие). Если вы щёлкнете по дате, вы 

перейдёте в Календарь просмотра этого дня. Если заголовок события – 

ссылка, и вы щёлкнете по ней, вы будете отправлены к этому событию. 
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4.5.42.Youtube 
The Youtube block can only be added to a Tags page. Once you have 

edited your Profile or made a Blog entry and provided key words in the 

”interests” portion, these words become tags. From the Tags block you can 

click any tag to be taken to that word’s Tags page, where you can edit it to 

add the Youtube block. 

This block will pull Youtube videos with the same tag words related to the 

current Tags page. The title is optional. Select the number of videos you 

would like to display in the block. You can also select the category from 

which the videos will be pulled in Youtube. In addition, you can specify 

which specific playlist you would like to pull the videos from by including 

the playlist id. This id is the alpha-numeric string of numbers at the end of 

the URL, i.e. 

http://www.youtube.com/view_play_list?p=A77EAA3A1CFA1CD8 using 

A77EAA3A1CFA1CD8 as the playlist id. 

4.5.43.Blocks FAQ 
4.5.43.1.How do I hide front page blocks from 
non-logged-in users? 
 Click the "Turn editing on" button at the top-right of the front page. 

(You need to be logged in as an administrator.) 

 Click the assign roles icon (often a face and mask) in the header of the 

block to be hidden. (NOTE: Don't worry if you get an error message 

saying you are not able to assign roles) 

 Scroll down to the settings block and click the Permissions link 

 

 In the View block section, click the X next to Guest 

 

 Click the "Save changes" button. 

4.5.43.2.How do I get rid of a link in "Site 
Pages" in the Navigation block? 
When a resource or activity (like a page, file or forum) is added to the 

Main menu block on the front page, it will appear in the Site Pages of the 

Navigation block. If you need the item but don't want it to display then go 

to Site administration>Appearance>Navigation and uncheck "show front 

page activities in the navigation". 

 

 

4.5.42.Показ видеоматериалов (Youtube) 
Блок «Youtube (сервис видеохостинга)» может быть добавлен только на страницу 

Тегов. Как только вы отредактировали свой Профиль или создали Запись Блога и 

предоставили ключевые слова в области «Interests (интересы)», эти слова становятся 

тегами. Из Блога «Теги» вы можете щёлкнуть любой тег, чтобы вас отправили на страницу 

тегов с этим словом, где вы можете отредактировать её, чтобы добавить Блок «Youtube». 

Этот Блок извлечёт Youtube-видео с теми словами тегов, которые относятся к 

текущей странице Тегов. Заголовок не обязателен. Выберите число видео, которое хотели 

бы отображать в этом Блоке. Вы также можете выбрать Категорию, из которое видео 

будут отыскиваться в Youtube. Дополнительно вы можете указать, по какому конкретному 

списку проигрывания вы предпочли бы отыскивать видео, включив идентификатор списка 

проигрывания. Этот идентификатор является буквенно-цифровой строкой чисел в конце 

указателя URL, т.е. http://www.youtube.com/view_play_list?p=A77EAA3A1CFA1CD8, 

используя A77EAA3A1CFA1CD8 в качестве идентификатора списка проигрывания. 

 

4.5.43.Часто задаваемые вопросы о Блоках 
4.5.43.1.Как скрыть Блоки Главной Страницы от 
незарегистрированных пользователей? 
 Щёлкните кнопку «Turn editing on» вверху справа на Главной Странице. (Вам 

необходимо зарегистрироваться как Администратор.) 

 Щёлкните иконку назначения Ролей (часто это лицо и маска) в заголовке Блока, 

который нужно скрыть. (Замечание: не волнуйтесь, если получите сообщение об 

ошибке, говорящее, что вы способны назначать Роли.) 

 Прокрутите Блок настроек Administration и щёлкните ссылку 

Permissions (полномочия). 

 В разделе View block (просмотреть блок) щёлкните X следом 

за Guest. 

 Щёлкните кнопку «Save changes». 

4.5.43.2.Как освободиться от ссылки на «Страницы 
Сайта» в Блоке Навигации? 

Когда в Блок «Главное меню (п. 4.5.22)» на Главной Странице добавляется Ресурс 

или Интерактивное Действие (подобные Странице, Файлу или Форуму), он появится на 

«Страницы Сайта» Блока Навигации. Если вам нужен этот элемент, но вы не хотите, 

чтобы он отображался, тогда перейдите в 

Administration→Site administration→Appearance→Navigation, и снимите пометку «Show 

front page activities in the navigation (показать действия главной страницы в навигации)». 

http://www.youtube.com/view_play_list?p=A77EAA3A1CFA1CD8
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If you no longer want the item then turn on the editing on the front page, 

go to or add the Main menu block and click to delete the item. 

 

4.5.43.3.How do I make a front page block 
visible to teachers but not students? 
It is possible to control who sees block on the front page. The following 

applies to any specified group of people, not just teachers and students. 

 Ensure you have hidden your block from non-logged in users as in the 

instructions above. 

 In Administration>Site administration>Users> Permissions> Define 

roles, click on "authenticated user on the front page" 

 

 In the context type, select "block" 

 Set moodle/block:view to "allow". Save the changes. 

 Turn editing on on your front page. 

 Click the "assign roles " icon on your block. 

Click the blue words of "authenticated user on the front page" to access 

the screen where you can choose who you want to allow to see this 

block (such as your teachers) by moving them from the right hand box 

to the left. 

 Now click "Permissions" in the Administration block. 

 Click the X next to "authenticated user" to prevent them viewing this 

block. 

 From now on, regular authenticated users will not be able to see the 

block. However, those who have been given the role of "authenticated 

user on the front page" will be able to see it. 

4.5.43.4.How can I change a Block item name 
from a list inside a block? 
You can change an item name in Settings>Site Administration > 

Language> Language customization Select the 'moodle.php' file then 

search for the words you need to alter. 

4.5.43.5.How to I make a block "sticky"? 
See Block settings. Using the edit icon in the block heading, go to the 

configuration page. Look for the "Where this block appears" group and 

"Display on page types". Depending upon your current context and 

permissions, you will see different options. One maybe "All pages" or 

"Any type of course main page", and others. 

 

Если вам дальше этот элемент не нужен, тогда включите режим редактирования на 

Главной странице, перейдите или добавьте Блок «Главное меню», и щёлкните «х» 

(крестик), чтобы удалить этот элемент. 

4.5.43.3.Как сделать Блок «Главная Страница» видимым 
для Преподавателей, но не Студентам? 

Контролировать, кто видит Блок на Главной Странице, можно. Следующее 

применяется для любой Группы людей, а не только для Преподавателей и Студентов. 

 Убедитесь, что вы скрыли ваш Блок от незарегистрированных пользователей, как 

описано выше. 

 В Administration→Site administration→Users→Permissions→Define roles щёлкните 

«Authenticated user on the front page (аутентифицированный пользователь на главной 

странице)». 

 В типе Контекста выберите «Block». 

 Установите moodle/block:view в «Allow (разрешить)». Сохраните изменения. 

 Включите режим редактирования на вашей Главной Странице. 

 Щёлкните иконку «Assign roles (назначить роли)» в вашем Блоке. 

Щёлкните голубые слова «Authenticated user on the front page», что получить доступ к 

экрану, где вы можете выбрать, кому вы хотите позволить видеть этот Блок (таким, как 

ваши Преподаватели), перемещая их из правого окошка (куда они попадают при регистрации) 

в левое. 

 Теперь щёлкните «Permissions (полномочия)» в Блоке Administration. 

 Щёлкните х рядом с «Authenticated user», чтобы предотвратить их от просмотра этого 

Блока. 

 Начиная с этого момента обычные Аутентифицированные Пользователи не смогут 

увидеть этот Блок. Однако те, кому предоставлена Роль Аутентифицированного 

Пользователя на Главной Странице, будут способны его видеть. 

4.5.43.4.Как можно изменить наименование элемента 
«Блок» из списка внутри Блока? 

Вы можете изменить наименование элемента в 

Administration→Site administration→Language→Language customization. Выберите файл 

«moodle.php», затем отыщите слова, которые вы хотите изменить. 

4.5.43.5.Как можно сделать Блок "прилипчивым"? 
См. «Настройки Блока (п. 4.5.2.1.6)». Используя иконку редактирования в 

заголовке Блока, перейдите на страницу конфигурации. Отыщите группу «Where this block 

appears (где этот блок появится)» и «Display on page types (отображать на типах страниц)». 

В зависимости от текущего Контекста и Полномочий, вы увидите различные опции. 

Одной может быть «All pages (все страницы)» или «Any type of course main page (любой 

тип главной страницы курса)» и другие. 
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4.5.43.6.Where did that block come from? I do 
not want it! 
Your site administrator or some one with more permissions than you 

decided that block should be there. It is possible to force a block to appear 

on other pages. For example, a site administrator my force a HTML block 

on every main course page and determine where it will be, so they may put 

site messages there. 

Your site administrator can tell where every instance of a block appears via 

Blocks administration. 

4.5.43.7.How can I decide the order in which 
blocks are docked? 
Blocks are "docked", from top to bottom (usually on the left) in the order 

in which you dock them. 

4.5.43.8.How can I add a block to all user 
profile pages? 
See User profiles for instructions. 

4.5.43.9.How can I prevent users from adding 
blocks to their My home page? 
See My home for instructions. 

4.5.43.10.The blocks have disappeared from 
the front page/course page! 
This can sometimes be caused by users pasting from Microsoft Word 

which corrupts the formatting. See this forum post for more details 

https://moodle.org/mod/forum/discuss.php?d=217390#p958884 

4.5.43.11.Help, I accidentally hid the 
administration block without realising the 
consequences! 
 Go to http://yourmoodlesite.org/admin/blocks.php 

 Unhide the settings block by clicking the closed eye icon opposite it 

4.5.43.12.I accidentally deleted the navigation 
(or administration) block! 
 Go to Administration > Site administration > Plugins > Blocks > 

Manage blocks (or via the URL 

http://yourmoodlesite.org/admin/blocks.php) and unprotect the 

navigation block by clicking the padlock icon 

4.5.43.6.Откуда этот Блок взялся? Я не хочу его! 
 

Ваш Администратор Сайта или любой другой с большими полномочиями, чем у 

вас, решил, что этот Блок должен быть здесь. Можно принудить, чтобы Блок появился на 

других страницах. Например, Администратор Сайта может поместить блок HTML на 

каждую страницу основного Курса и определить, где он будет, так что он может 

поместить сообщения Сайта там. 

Ваш Администратор Сайта может сообщить, где появится каждый экземпляр 

Блока через Управление Блоками. 

4.5.43.7.Как можно задать порядок, в котором Блоки 
пристыковываются? 

Блоки «пристыковываются» сверху вниз (обычно слева) в порядке, в котором вы 

их пристыковываете. 

4.5.43.8.Как можно добавить Блок на все страницы 
Профилей Пользователей? 

Инструкции – в разделе «Профили пользователей (п. 3.8.3)». 

4.5.43.9.Как предотвратить пользователей от 
добавления Блоков на их Домашнюю Страницу? 

Инструкции – в разделе «Домашняя страница (п. 3.8.2)». 

4.5.43.10.Блоки исчезли с Главной Страницы/страницы 
Курса! 

Иногда это может быть вызвано пользователями, вклеивающими из Microsoft 

Word, который повредил форматирование. См. корреспонденцию этого Форума для 

выяснения подробностей. 

4.5.43.11.Помогите, я нечаянно скрыл Блок управления, 
не понимая последствий! 
 
 Перейдите в http://yourmoodlesite.org/admin/blocks.php. 

 Откройте Блок настроек щелчком по иконке закрытого глаза, находящийся рядом. 

4.5.43.12.Я нечаянно удалил Блок Навигации (или 
управления)! 
 Перейдите в Administration→Site administration→Plugins→Blocks→Manage blocks (или 

через URL http://yourmoodlesite.org/admin/blocks.php) и освободите от защиты 

Блок Навигации щелчком по иконке «висячий замок». 

https://moodle/
https://moodle.org/mod/forum/discuss.php?d=217390#p958884
https://moodle.org/mod/forum/discuss.php?d=217390#p958884
http://yourmoodlesite.org/admin/blocks.php
http://yourmoodlesite.org/admin/blocks.php
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 Turn editing on in any course 

 Go to the front page and use the 'Add a block' dropdown menu to add a 

navigation block there, setting it to display throughout the entire site 

 

 Go back to Administration > Site administration > Plugins > Blocks > 

Manage blocks and re-protect the navigation block. 

The above method works the same for the navigation and administration 

blocks. 

4.5.43.13.My Administration block links don't 
expand! 
This has been noticed as a Javascript problem. Given the many possible 

factors behind this issue, a clear-cut solution hasn't been found. Please try 

to: 

 Use another browser or use another version of the same browser (try 

both, lower and higher versions). 

 Purge all cache (Administration > Development > Purge all caches) 

yoursite.com/admin/purgecaches.php 

 

 Change the Use slash arguments option --HTTP-- (Administration > 

Server > HTTP) yoursite.com/admin/settings.php?section=http 

 

 Try different settings at the AJAX and Javascript settings page 

(Administration > Appearance > AJAX and Javascript) 

yoursite.com/admin/settings.php?section=ajax 

 Enabling the Use online YUI libraries (useexternalyui) sometimes 

has solved the problem (see tracker.moodle.org/browse/MDL-

31678). 

 Turn off Javascript in your browser (the site shows how to enable 

Javascript, so do the opposite) 

 Turn off Java (you should have it disabled anyway, unless you really 

need it) 

 Try using another theme yoursite.com/theme/index.php 

You should also: 

 Enable Debugging (Administration > Development > Debugging) 

yoursite.com/admin/settings.php?section=debugging 

 

 Check if your browser is showing some warning or error indications 

(watch the status bar). 

 

 Включите режим редактирования в любом Курсе. 

 Перейдите на Главную Страницу и используйте ниспадающее меню «Add a block», 

чтобы добавить Блок Навигации туда, настроив его так, чтобы он отображался по всему 

Сайту. 

 Вернитесь в Administration→Site administration→Plugins→Blocks→Manage blocks и 

повторно защитите Блок Навигации. 

Вышеприведённый метод работает одинаково в Блоках Навигации и Управления. 

 

4.5.43.13.Мои ссылки Блока Управления не 
развёртываются! 

Это было отмечено как проблема Javascript. Не приводя множества факторов, 

связанных с этой проблемой, скажем, решения проблемы не было найдено. Пожалуйста, 

постарайтесь: 

 Используйте другой браузер или другую версию того же самого браузера (попробуйте 

обе, нижнюю и высшую версию). 

 Очистите все кэши: 

(Administration→Site administration→Development→Purge all caches) 

yoursite.com/admin/purgecaches.php. 

 Измените опцию Use slash arguments (в 

Administration→Site administration→Server→HTTP) 

yoursite.com/admin/settings.php?section=http. 

 Проверьте различные настройки на странице настроек AJAX и Javascript 

(Administration→Site administration→Appearance→AJAX and Javascript) 

yoursite.com/admin/settings.php?section=ajax. 

 Позволение Use online YUI libraries (useexternalyui) иногда решает проблему (см. 

tracker.moodle.org/browse/MDL-31678). 

 

 Отключите Javascript в вашем браузере (Сайт показывает, как включить Javascript, 

поэтому сделайте противоположное). 

 Отключите Java (держите его отключённым всегда, кроме случаев, когда он вам 

действительно нужен). 

 Попробуйте использование другой темы в yoursite.com/theme/index.php. 

Вы также должны: 

 Включить Отладку (см. п. 3.13.1 и 

Administration→Site administration→Development→Debugging): 

yoursite.com/admin/settings.php?section=debugging. 

 Проверить, показывает ли браузер некоторые предупреждения или указания об 

ошибках (наблюдайте панель состояния). 

http://docs.moodle.org/25/en/Purge_all_cache
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 For advice, see this forum thread 

https://moodle.org/mod/forum/discuss.php?d=166994 or this one 

https://moodle.org/mod/forum/discuss.php?d=200243. For more details, 

please see this tracker MDL-31678. 

4.5.43.14. How can I add a Twitter feed block? 
An HTML block can be used to display the latest tweets from any Twitter 

account. See HTML block for details. 

4.5.43.15.See also 
 Using Moodle Blocks forum  

Using Moodle forum discussions: 

 More problems with "Sticky" blocks in 2.2 with instructions on how to 

make blocks appear on all course pages 

4.5.44.See also 
 Managing blocks - for administrators 

 Blocks FAQ 

 Blocks in Moodle 2.0 video 

 Moodle forum discussion about which Moodle blocks are the most 

useful for teaching 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 В качестве совета, просмотрите обсуждение на форуме: 

https://moodle.org/mod/forum/discuss.php?d=166994 или другое на том же форуме: 

https://moodle.org/mod/forum/discuss.php?d=200243. Больше подробностей, пожалуйста, 

см. на Средстве Отслеживания MDL-31678. 

4.5.43.14.Как добавить Блок подачи сообщений Твиттера 
HTML блок может быть использован для отображения последних почтовых 

сообщений из любой учетной записи Twitter. Подробности в «HTML блок» (п. 4.5.1). 

4.5.43.15.См. также 
 Использование Moodle. «Форум Блоки» 

Обсуждения форума по использованию Moodle: 

 Больше проблем с «прилипчивыми» блоками в версии Moodle 2.2 с инструкциями о 

том, как сделать, чтобы Блоки появлялись на всех страницах Курса. 

4.5.44.См. также 
 Блоки управления – для Администраторов. 

 Часто задаваемые вопросы по Блокам. 

 Видео «Блоки в Moodle 2.0». 

 Обсуждение на форуме Moodle того, какие Блоки Moodle наиболее полезны для 

преподавания. 

https://moodle.org/mod/forum/discuss.php?d=166994
https://moodle.org/mod/forum/discuss.php?d=200243
http://tracker.moodle.org/browse/MDL-31678
http://moodle.org/mod/forum/view.php?id=2121
https://moodle.org/mod/forum/discuss.php?d=195874
http://docs.moodle.org/25/en/Managing_blocks
http://docs.moodle.org/25/en/Blocks_FAQ
http://www.youtube.com/watch?v=6aX1XHfBjqg
https://moodle.org/mod/forum/discuss.php?d=227772
https://moodle.org/mod/forum/discuss.php?d=227772
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4.6.Questions 
How to create questions for use in quizzes and Moodle's lesson module 

Questions can be created in Moodle for use in quizzes and for import into 

lessons. 

 

4.6.1.Managing questions 
 Questions are stored in the course Question bank in Administration > 

Course administration > Questions 

 Questions can be organised into Question categories and shared with 

other teachers 

 Moodle has a number of different formats that can be used to import or 

export questions 

4.6.1.1.Managing question types 
An administrator (or manager or any user with the capability 

moodle/question:config) can manage question types available across the 

site in Administration > Site administration > Plugins > Question types > 

Manage question types. 

Screenshot «Manage question types». 

4.6.1.1.1.No. questions 
This shows the number of questions of that type in the entire Moodle site. 

If the number is non-zero, it will be a link to a report that shows you where 

in the question bank (which contexts) those questions are. 

4.6.1.1.2.Version 
If the question type has its own database tables, then the version of those 

tables is displayed here. 

4.6.1.1.3.Requires 
Some question types rely on others to operate correctly. If so, the required 

question types are listed here. 

4.6.1.1.4.Available? 
If you make a question type unavailable, then users will no longer be able 

to create new questions of that type. However, existing questions of that 

type will continue to work, so existing quizzes will continue to work, and 

old quiz attempts can be reviewed. 

The up and down arrows let you control the order of the question types in 

the list where teachers select which type of question they wish to create. 

 

 

 

4.6.Вопросы 
Как создавать Вопросы для модулей «Экзамен» (п. 4.3.10) и «Урок» (п. 4.3.9) 

системы Moodle. 

Вопросы могут быть созданы в Moodle для использования в Экзаменах и для 

импорта в Уроки. 

4.6.1.Управление Вопросами 
 Вопросы сохраняются в Банке Вопросов Курса в 

Administration→Course administration→Questions. 

 Вопросы могут быть распределены по Категориям Вопросов (п. 4.6.2) и будут 

доступны для использования другими Преподавателями. 

 Moodle имеет ряд различных форматов, которые могут быть использованы в импорте 

(п. 4.6.1.4) или экспорте (п. 4.6.1.5) Вопросов. 

4.6.1.1.Управление типами Вопросов 
Администратор (или Менеджер, или любой пользователь с Возможностью 

moodle/question:config) может управлять типами Вопросов, доступными по всему Сайту в 

Administration→Site administration→Plugins→Question types→Manage question types. 

 

Снимок с экрана «Управлять типами Вопросов». 

4.6.1.1.1.Количество вопросов 
Эта опция показывает число Вопросов этого типа на всём Сайте Moodle. Если это 

число не нулевое, оно будет ссылкой на отчёт, который покажет вам, где в Банке Вопросов 

(в каких Контекстах) эти Вопросы находятся. 

4.6.1.1.2.Версия 
Если тип Вопроса имеет собственные таблицы баз данных, тогда версия этих 

таблиц отображается здесь. 

4.6.1.1.3.Требования 
Некоторые типы Вопросов для успешной работы с ними предполагают связь с 

другими Вопросами. Если так, требуемые типы Вопросов будут перечислены здесь. 

4.6.1.1.4.Доступно? 
Если вы сделаете какой-либо тип Вопросов недоступным, тогда пользователи 

больше не смогут создавать новые Вопросы этого типа. Однако, уже существующие 

Вопросы этого типа будут продолжат работать, так что и существующие Экзамены 

продолжат работать, и старые попытки выполнить Экзамен могут быть просмотрены. 

Стрелочки вверх и вниз позволяют вам управлять порядком типов Вопросов в 

списке, где Преподаватель выбирает тип Вопроса, который он хочет создать. 

http://docs.moodle.org/25/en/File:Manage_question_types.png
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4.6.1.1.5.Delete 
If 

 there are no questions of a particular type, and 

 if this question type is not required any other question type, and 

 if this question type is neither Random nor Missing type, which are 

required by the question type system, 

then you can uninstall it by clicking on the delete link. 

4.6.1.1.6.Settings 
Some question types have configuration options. If so, a settings link will 

appear in this column. 

4.6.1.2.See also 
 Question engine upgrade helper for sites which have been upgraded 

from a pre-Moodle 2.1 version. 

4.6.2.Question contexts 
We can share questions in different contexts. Context may be an unfamiliar 

word. Think of a context as an area within your Moodle site. Each different 

context has a separate question category hierarchy. So, now you can 

choose the 'context' within which your questions will be shared. And also 

an administrator can give their users different permissions within different 

context areas. 

See the diagram illustrating the relationship of the different contexts 

below. Different colours denote different context types (though there are 

two hues of green, both denote the same type). Notice how question 

contexts contain each other. Notice also that Course category contexts can 

be nested. In this example we have two contexts nested within each other 

'Humanities' and 'Languages'. We could have a third course category 

'English' and fourth and so on. Course categories can be nested infinitely 

and so you can set up a very flexible system of question contexts for 

sharing questions and assigning question sharing permissions. 

 

As described at Question categories, questions are stored in a hierarchical 

structure similar to folders at the file system. You can imagine question 

context as a place where the tree of question categories is actually placed. 

By default, every teacher can create new questions in the course context 

(the blue one in the diagram) and the activity module context (the white 

one). We will discuss how to allow a teacher to create questions in higher 

contexts below. 

 

 

4.6.1.1.5.Удалить 
Если 

 не существует Вопросов какого-то конкретного типа, и 

 если этот тип Вопросов не нужен никаким другим типам Вопросов, и 

 если этот тип Вопросов не относится ни к типу Случайного выбора, ни к типу 

Пропущенные слова, которые требуются системой типов Вопросов, тогда вы можете 

деинсталлировать его щелчком по кнопке «Delete». 

4.6.1.1.6.Настройки 
Некоторые типы Вопросов имеют опции конфигурации. Если так, ссылка на 

настройки появится в этой колонке. 

4.6.1.2.См. также 
 «Помощник по обновлению машины Вопросов» для Сайтов, которые обновлялись с 

предшествующей Moodle 2.1 версии. 

4.6.2.Контексты Вопросов 
Вопросы можно использовать в различных Контекстах. Слово «Контекст» может 

быть вам незнакомо. Понимайте Контекст, как область внутри вашего Сайта Moodle. 

Каждый различный Контекст имеет отдельную иерархию в Категории Вопросов. Поэтому 

теперь вы можете выбрать «Контекст», внутрь которого будут включены ваши Вопросы. 

Кроме того, Администратор может предоставить своим пользователям различные 

Полномочия внутри различных областей Контекстов. 

См. ниже диаграмму, иллюстрирующую взаимосвязь различных Контекстов. 

Различные цвета обозначают разные типы Контекстов (хотя есть два оттенка зелёного, оба 

обозначат тот же самый тип). Обратите внимание на то, как Контексты Вопросов содержат 

друг друга. Обратите также внимание на то, что Контексты Категорий Курса могут быть 

вложены. В этом примере мы имеем два Контекста, вложенных внутрь друг друга 

«Гуманитарные» и «Языки». Мы могли бы иметь третью Категорию Курсов 

«Английский» и четвёртую и т.д. Категории Курсов могут быть бесконечно вложенными и 

также вы можете установить очень гибкую систему Контекстов Вопросов для совместно 

используемых Вопросов и назначаемых Полномочиях по совместно используемым 

Вопросам. 

Как описано в Категориях Вопросов, Вопросы сохраняются в иерархической 

структуре, подобной Папкам в файловой системе. Вы можете считать Контекст 

Вопросов местом, где размещено дерево Категорий Вопросов. По умолчанию каждый 

Преподаватель может создать новые Вопросы в Контексте Курса (голубая область на 

диаграмме и контексте модуля Интерактивных Действий (белая область). Ниже мы 

обсудим, как позволить Преподавателю создавать Вопросы в высших Контекстах. 

http://docs.moodle.org/25/en/Question_engine_upgrade_helper
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Screenshot «Example diagram of question contexts: question categories 

can be stored in several nested areas» 

 

 

Question contexts are just as a subset of the Roles and Permissions 

contexts. A context contained by another context inherits the permissions 

of the containing context. You can access question categories in any 

containing context if you have permission to do so. Remember, you can 

access the question bank in two ways: from within an activity (now only 

the quiz activity), or from the link in the Course admin menu to 

'Questions'. When you access the question bank from the: 

 

 

 

 

 Activity. If you have permissions you can access question categories in: 

 

 that activity's context and containing contexts. 

 the course in which the activity module is contained. 

 the course categories in which the course that contains the activity 

module is contained. 

 the core system context. 

 Course. If you have permissions you can access question categories in: 

 

 that course. 

 the course categories in which the course is contained. 

 the core system context. 

So questions contexts are accessible as follows: 

 Activity context: questions only available to one activity module. 

 Course context: questions available to all activity modules in a course 

and within the course from the 'Questions' link in the course 

administration block. 

 Course category contexts: questions available to all activity modules 

and courses in the course category (remember one course category can 

contain other course categories, you can share your questions in any 

parent course category). 

 Core System context: questions available in all courses and activities 

on your site. 

 

Снимок с экрана «Пример диаграммы 

Контекстов Вопросов: Категории Вопросов 

могут быть сохранены в нескольких 

вложенных областях». 

Контексты Вопросов таковы же, 

как и подмножество Ролей в контексте 

Полномочий. Контекст, содержащийся в 

другом Контексте, наследует Полномочия 

содержащего Контекста. Вы будете иметь 

доступ к Категориям Вопросов в любом 

содержащем Контексте, если у вас есть 

Полномочия для этого. Помните, что вы 

можете иметь доступ к Банку Вопросов двумя путями: изнутри Интерактивного Действия 

(сейчас это только Экзамен), или по ссылке «Questions» в меню управления Курсом. Когда 

вы вошли в Банк Вопросов из: 

 Интерактивного Действия. Если вы имеет Полномочия, вы можете получить доступ к 

Категориям Вопросов в: 

 Контексте этого Интерактивного Действия и содержащихся Контекстах, 

 Курсе, в котором модуль этого Интерактивного Действия содержится, 

 Категориях Курсов, в которых содержится Курс, содержащий модуль этого 

Интерактивного Действия, 

 Контексте ядра системы. 

 Курса. Если вы имеет Полномочия, вы можете получить доступ к Категориям 

Вопросов в: 

 этом Курсе, 

 Категориях Курсов, в которых содержится этот Курс, 

 Контексте ядра системы. 

Итак, доступны следующие Контексты Вопросов: 

 Контекст Интерактивного Действия: Вопросы доступны только одному модулю 

Интерактивного Действия. 

 Контекст Курса: Вопросы доступны всем модулям Интерактивных Действий в Курсе и 

внутри Курса, доступного по ссылке «Questions» в Блоке управления Курсом. 

 Контексты Категории Курса: Вопросы доступны всем модулям 

Интерактивных Действий и Курсах в Категории Курса (запомните, что одна Категория 

Курсов может содержать другие Категории Курсов, а вы можете вставить ваши 

Вопросы в любой родительской Категории Курсов). 

 Контекст ядра системы: Вопросы доступны во всех Курсах и 

Интерактивных Действиях на вашем Сайте. 



 

308 

All Question capabilities are tested in the relevant context. So, for 

example, to add a question to a category you must have the add capability 

for that context. See roles and capability help for more info. If you don't 

have permission to do anything in a context, then the categories in that 

context will not be visible to you. 

4.6.2.1.See also 
 How to let teachers share questions between courses 

 Question permissions explained with diagrams 

4.6.3.Question bank 
This feature allows a teacher to create, preview, and edit questions in a 

database of question categories. The categories can be limited to 49being 

used on the site, course or quiz level. The questions in a category can be 

added to a Quiz or to a lesson activity via an export process. The teacher 

enters the question bank by creating or editing a quiz activity or via 

Settings > Course administration > Question bank. 

 

4.6.3.1.Select a category 
Questions are organised into categories. Initially each course has only one 

category called "Default". It is good practice to create more categories to 

organize your questions. This not only makes it easier to find questions, 

but makes the use of random questions and matching question easier. You 

can create a hierarchy of categories because you can create subcategories 

inside parent categories. To add or edit categories click on the 

"Categories" tab. 

The question editing screen shows the questions from the currently 

selected category. You choose this category from the Category: drop-

down menu. Using the tick box below that menu you determine whether to 

also show the questions from all subcategories. 

Categories are shared in contexts 
There are separate question category trees in each different 'context' in 

which questions are shared. The contexts available to you depend on 

whether you access the question bank from an activity or from a course 

and depend on the permissions assigned you for access to questions. See 

Question contexts for more information on these contexts. 

4.6.3.2.Add a new question 
1. Click the Questions tab to access the Question Bank page, if not there 

already. 

 

Все Возможности Вопросов тестируются в уместном Контексте. Так, например, 

чтобы добавить Вопрос в Категорию, вам нужно иметь Возможность добавлять в этот 

Контекст. См. помощь по Ролям и Возможностям для дополнительной информации. Если 

вы не имеете Полномочия делать что-либо в Контексте, тогда категории в этом Контексте 

для вас будут невидимы. 

4.6.2.1.См. также 
 Как позволить Преподавателям совместно использовать Вопросы в своих Курсах. 

 Полномочия Вопросов объяснены диаграммами. 

4.6.3.Банк Вопросов 
Это средство позволяет Преподавателю создавать, предварительно просматривать 

и редактировать Вопросы в базе данных Категорий Вопросов. Категории могут быть 

ограничены для использовании на уровне Сайта, Курса или Экзамена. Каждый из 

Вопросов в Категории может быть добавлен в Экзамен или в Интерактивное Действие 

«Урок» посредством процесса экспорта. Преподаватель вводит Банк Вопросов путём 

создания редактирования Интерактивного Действия «Экзамен» или через 

Administration→Course administration→Question bank. 

4.6.3.1.Выбрать Категорию 
Вопросы организуются в Категории. Первоначально каждый Курс имеет только 

одну Категорию, называемую «По умолчанию». Хорошей практикой структурирования 

Вопросов является создание нескольких Категорий. Это позволяет не только легче 

находить Вопросы, но делает более лёгким использование Вопросов со Случайным 

выбором и на Сопоставление. Вы можете создать иерархию Категорий, поскольку можете 

создать подкатегории внутри родительских Категорий. Чтобы добавить или 

отредактировать Категории, щёлкните по этикетке «Категории (п. 4.6.4)». 

Экран редактирования Вопросов показывает Вопросы из выбранной в настоящий 

момент Категории. Вы выбираете эту Категорию из «Категория: ниспадающее меню». 

Используя помечаемое галочкой окошко ниже этого меню, вы определяете, будет ли 

показаны также Вопросы из всех подКатегорий. 

Категории, совестно используемые в Контекстах 
Существуют отдельные деревья Категорий Вопросов в каждом отдельном 

Контексте, в которых Вопросы совместно используются. Доступность Контекстов зависит 

от наличия доступа к Банку Вопросов из Интерактивного Действия или из Курса и зависит 

от Полномочий, назначенных вам для доступа к Вопросам. См. Контексты Вопросов (п. 

4.6.2) для дополнительной информации об этих Контекстах. 

4.6.3.2.Добавить новый Вопрос 
1. Щёлкните этикетку «Questions (вопросы)», чтобы попасть на страницу Банк Вопросов, 

если вы ещё не там. 

http://docs.moodle.org/22/en/Category:Roles
http://docs.moodle.org/25/en/How_to_let_teachers_share_questions_between_courses
http://docs.moodle.org/25/en/Question_permissions_explained_with_diagrams
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2. From the Category drop-down menu, select a category you want to add 

a question to. 

3. The page will change to show the questions already in that category 

4. Select the question type you want to create from the Create new 

question drop-down menu. 

5. Fill in the form for the question type you are creating. Each question 

type has its own form and has its own options. 

6. Click Save Changes at the bottom of the form. 

4.6.3.3.Preview, Edit, Delete, and Move 
 
The first column in the list of questions contains a number of icons and a 

selection box. 

Clicking on the Preview icon will open a preview window in which you 

can test the question. The Edit icon allows you to edit the question via the 

same form that you used to create it. The Delete icon deletes the question, 

provided it is not already in use in some activity. The selection box allows 

you to select a subset of questions that you can then move to another 

category using the controls below the list of questions. The move icon 

allows you to move one question at a time. 

 

4.6.3.4.Tips and tricks 
 Put the answer into the question name so you can quickly see the 

answers when students are asking for answers. This is especially useful 

if you're dealing with large sets of questions! (No option yet for 

viewing category or answer of question in the list of questions.) 

 Export questions in GIFT or Moodle XML formats, then import them 

into a Lesson. (Future versions of Moodle will make Question bank 

available to both Lesson and Quiz activities.) 

 Remember that while some of the same question types can be found in 

both the Quiz and Lesson modules, they can be very different. Scoring 

and grading each student's choice is more robust in a Quiz. On the other 

hand, each Lesson question answer also has a jump associated it. 

 Use GIFT or other export modes to print questions and answers in a 

category. Hint, clever use of word processor macros, using search and 

replace, can tidy up a GIFT file for printing. 

 The question title is useful in sorting and making notes. For example, 

"ZZ remove 2010-3 Why did the Moodler cross", will put this question 

at the bottom of the list. Or where you want a 'the' questions in a 

category to appear in a specific order, use letters or numbers, knowing  

2. Из ниспадающего меню Category выберите, в какую Категорию вы хотите добавить 

Вопрос. 

3. Страница изменится и будет показывать Вопросы уже в этой Категории. 

4. Выберите тип Вопроса, который вы хотите создать, из ниспадающего меню Create new 

question (создать новый вопрос). 

5. Заполните форму для того типа Вопросов, который вы создаёте. Каждый тип Вопроса 

имеет свою собственную форму и свои собственные опции. 

6. Щёлкните Save Changes (сохранить изменения) внизу формы. 

4.6.3.3.Предварительно просмотреть, отредактировать, 
удалить и переместить 

Первая колонка в списке Вопросов содержит число иконок и окошко выбора. 

 

Щелчок по иконке «Preview (предварительно просмотреть)» откроет окно 

предварительного просмотра, в котором вы можете протестировать этот Вопрос. Иконка 

«Edit (редактировать)» позволяет вам отредактировать Вопрос через ту же самую форму, 

которую вы использовали, чтобы его создать. Иконка «Delete (удалить)» удаляет Вопрос, 

обеспечивая то, чтобы он уже не использовался в некотором Интерактивном Действии. 

Окошко выбора позволяет вам выбрать подмножество Вопросов, которые вы можете затем 

переместить в другую Категорию, используя элементы управления ниже списка Вопросов. 

Иконка «Move (переместить)» позволяет вам передвинуть один Вопрос за один раз. 

4.6.3.4.Советы и трюки 
 Вставьте ответ в название Вопроса для того, чтобы вы смогли быстро увидеть ответы, 

когда у Студентов запрашиваются ответы. Это особенно полезно, если вы имеете дело с 

большими наборами Вопросов! (Всё ещё нет опции для просмотра Категории или 

ответа на Вопрос в списке Вопросов.) 

 Экспортируйте Вопросы в форматы GIFT или Moodle XML, затем импортируйте их в 

Урок. (Будущие версии Moodle будут создавать Банк Вопросов, доступный обоим 

Интерактивным Действиям: и Уроку, и Экзамену). 

 Помните, что пока некоторые из одинаковых типов Вопросов в модулях «Экзамен» и 

«Урок» могут отличаться. Присвоение баллов и Оценивание каждого выбора Студентов 

более содержательно в Экзамене. С другой стороны, каждый ответ на Вопрос Урока 

также имеет связанный с ним переход (п. 4.3.9.4) на соответствующую страницу. 

 Используйте GIFT или другие режимы экспорта, чтобы распечатать Вопросы и ответы 

в Категории. Совет: разумным применением макросов текстового процессора, 

используя поиск и замену, можно приспособить файл GIFT для распечатки. 

 Заголовок Вопроса полезен при сортировке и создании заметок. Например, название 

«ЯЯ удалили 2010-3. Почему использующий Moodle противодействовал?» поместит 

этот Вопрос на дно списка. Или где вы хотите разместить в Категории «конкретные» 

Вопросы в конкретном порядке, используйте буквы или цифры, зная, 
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that AA will come first, AB will be second in the list. 

 Do a copy and paste from a PDF file into the question content area. 

Reduces "other" hidden code which Word, Open Office and other 

programs can insert. 

4.6.3.5.Sharing and Managing Question banks 
 
Be default, teachers can manage only the questions in the context of the 

courses they are in. You can set up a role to allow teachers to share and 

manage questions on a larger scale. 

You can also use this role to create a special system-wide "Question bank 

Manager" instead of giving admin level or site-wide Manager access to a 

person managing the Questions. 

 

See 
 How to let teachers share questions between courses 

4.6.4.Question categories 
A question category can contain individual questions or other question 

categories. They can be found by using the Question bank or when 

building a quiz. 

4.6.4.1.What are question categories? 
You can imagine a question category as a folder on your desktop 

computer. Then, questions are stored in these categories in a similar way as 

your files are stored in a file system. 

 

Screenshot «Question category as a folder». 

Each category must have a name and you can include a short description of 

the category. You can create a category hierarchy. For example, you can 

specify a parent category for each category or the 'Top' as the parent, when 

a category has no parent. 

 

Tip: Creating question categories and sub categories is a good practice. 

It is better than keeping all your questions in one big list in the quiz 

module. The hierarchy feature enables you to separate categories into 

sub categories and sub categories into sub sub categories etc. 

indefinitely. Categories and sub categories, etc., are very powerful 

when combined with random questions that can select either from one 

category or from a category or any of its sub categories. 

 

что АА разместится первым, а АБ – вторым в списке. 

 Сделайте копию и вклейте из файла PDF в область содержимого Вопроса. Сократите 

«другой» скрытый код, который Word, Open Office и другие программы могут вставить. 

 

4.6.3.5.Совместное использование и управление 
Банками Вопросов 

По умолчанию Преподаватели могут управлять только Вопросами в Контексте 

своих Курсов. Вы можете установить Роль, которая позволит Преподавателям совместно 

использовать и управлять Вопросами в большем масштабе. 

Вы можете также использовать эту Роль, чтобы создать конкретного на системном 

уровне «Менеджера Банка Вопросов» вместо предоставления Менеджеру полномочий на 

уровне Администратора или по всему Сайту для доступа к персональному управлению 

Вопросами. 

Смотрите 
 Как позволить Преподавателям разных Курсов совместно Использовать вопросы. 

4.6.4.Категории Вопросов 
Категория Вопросов может содержать индивидуальные Вопросы или другие Категории 

Вопросов. Они могут быть найдены путём использования Банка Вопросов (п. 4.6.3) или 

при построении Экзамена (п. 4.3.10). 

4.6.4.1.Что такое Категории Вопросов? 
Вы можете представить Категорию Вопросов как 

папку на рабочем столе вашего компьютера. Вопросы 

сохраняются в этих Категориях подобно тому, как файлы 

сохраняются в файловой системе. 

Каждая Категория должна иметь название, и вы 

можете включить краткое описание каждой из Категорий. 

Можно создать иерархию Категорий. Например, вы можете 

указать родительскую Категорию для каждой Категории 

или «Вершину» в качестве родителя, когда Категория не 

имеет родителя. 

Совет: Создание Категорий Вопросов и подКатегорий является хорошей практикой. 

Это лучше, чем держать все Вопросы в одном большом списке в модуле «Экзамен». 

Средство иерархии позволяет вам разделить Категории на подКатегории, а 

подКатегории – на подКатегории и т.д. неограниченно. Категории и подКатегории и 

т.д. весьма действенны в комбинации с Вопросами со Случайной выборкой, которые 

могут выбираться либо из одной Категории, либо из Категории и её подКатегорий. 

http://docs.moodle.org/25/en/How_to_let_teachers_share_questions_between_courses


 

311 

4.6.4.2.Question Sharing 
You can share questions in several different contexts. Sharing categories in 

the 'System' contex or 'Course' context has a similar effect to publishing the 

category so others can see them or hiding a question category from specific 

users. See the Question contexts page for more infromation. 

 

By default a course teacher cannot see or use any Question context above 

the course level. 

Note: "Core System" and "System" refer to the same thing when we are 

describing or showing screen shots of question categories. "System" is the 

current term you will see in 2.x releases of Moodle. 

 

4.6.4.3.Category Set Up and Management 
 Open the question bank. Either: 

 Click on the Questions link in the 'Administration' block. 

 

 Or open the Editing a quiz page - when logged in as a teacher or 

someone with appropriate permissions open a quiz and then click on 

the 'Edit' tab. 

 Click on the 'Categories' tab. 

 Below the list of current categories you will see a form to add a new 

category. 

 Choose the 'parent' category in which your new category will be placed. 

See image of 'Parent' selector image to right. 

Screenshot «Question category selector» 

 Placing your category in another category makes it a sub-category of 

the parent. 

 Choosing 'Top' means that your category is a top level category, not 

a sub category. When more than one sharing context is available you 

can place your category as a top level category in any of the 

contexts. 

 

 

 Notice you can choose to make your category a 'top level' category 

in any context (see Question contexts) that is available to you. Or 

you can choose to add your category as a sub category of another 

category in the same context as the 

 Type the name of your new question category in the text box. 

 Add an optional meaningful description in the category info area. 

4.6.4.2.Совместное использование Вопросов 
Вы можете совместно использовать Вопросы в нескольких различных Контекстах 

(п. 6.3). Совместное использование Категорий в Контексте «Система» или Контексте 

«Курс» даёт эффект, подобный опубликованию этой Категории так, что другие могут её 

видеть, или скрытию Категории Вопросов от конкретных пользователей. См. Контексты 

Вопросов (п. 4.6.2) для дальнейшей информации. 

По умолчанию Преподаватель Курса не может видеть или использовать Контекст 

Вопроса выше уровня Курса. 

Замечание: Термины «Ядро системы» и «Система» ссылаются на одну и ту же 

вещь, когда мы описываем или показываем снимки с экрана Категорий Вопросов. В 

настоящее время используется термин «Система», что вы и увидите в выпусках версий 

Moodle 2.x. 

4.6.4.3.Установка и управление Категориями 
 Откройте Банк Вопросов. Либо: 

 Щёлкните ссылку Question bank (банк вопросов) в Блоке Administration 

(управление), находясь в Интерактивном Действии «Экзамен». 

 Либо откройте страницу Editing a quiz (редактирование экзамена) – когда 

зарегистрируетесь как Преподаватель или некто с подходящими Полномочиями 

открывать Экзамен и затем щёлкните этикетку «Edit (редактировать)». 

 Щёлкните этикетку «Categories». 

 Ниже списка текущих Категорий вы увидите форму для добавления новой Категории. 

 

 Выберите Категорию «Parent (родитель)», в которую вы будете размещать новую 

Категорию. См. изображение селектора Parent, которое изображено справа. 

Снимок с экрана «Селектор Категории Вопросов»: 

 Размещение вашей Категории в другой Категории 

делает эту последнюю Категорию родительской. 

 Выбор «Top (высший)» означает, что ваша 

Категория является Категорией высшего уровня, а 

не подКатегорией. Когда более одного совместно 

используемого Контекста доступно, вы можете 

разместить вашу Категорию как Категорию 

высшего уровня в любом из Контекстов. 

 Обратите внимание, вы можете назначить вашу Категорию Категорией «высшего 

уровня» в любом Контексте (см. Контексты Вопросов), который доступен вам. Или 

вы можете назначить вашу Категорию подКатегорией другой Категории в том же 

самом Контексте. 

 Наберите название вашей новой Категории в текстовом окошке. 

 Добавьте по своему выбору значимое описание в область информации Категории. 
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 Click the 'Add Category' button. Your new question category will 

appear in the list of current categories. 

4.6.4.3.1.Deleting Categories 
Categories can also be created or deleted at will. However, if you try to 

delete a category containing questions, then you will be asked to specify 

another category to move them to. You cannot delete or move the last 

category in any context, there must always be one category in a context. 

4.6.4.3.2.Using Arrow Icons for Moving 
Categories 
You can also arrange the categories in a hierarchy so that they are easier to 

manage. 

 The up/down arrow icons lets you change the order in which category 

'peers' are displayed. 

 The up / down icons are also used to move a top-level category 

between contexts. If you move a category to be the first or last category 

in a context and then press the arrow key again then it will be moved to 

the next context. 

 The right arrow icon allows you to move a category to be a child 

category of the category listed immediately above it. 

 The left arrow icon allows you to move a category up one category 

level (to be a peer of it's parent category). 

See the tool tip that appears when you place the mouse pointer above these 

icons if you're not sure what action an icon will perform. You cannot move 

the last category in any context, there must always be at least one category 

left in all contexts. 

4.6.4.4.See also 
 Question contexts 

 Using Moodle I can see other teacher's categories forum discussion 

 

4.6.5.Import questions 
Moodle has a number of different formats that can be used to import 

questions into Question bank categories and as lesson question pages. 

These include some proprietary quiz software formats, as well as text files 

and Moodle formats. 

 

 

 

 

 Щёлкните кнопку «Add Category (добавить категорию)». Ваша новая Категория 

Вопросов появится в списке текущих Категорий. 

4.6.4.3.1.Удаление Категорий 
Категории могут быть созданы или удалены по желанию. Однако, если вы 

попробуете удалить Категорию, содержащую Вопросы, тогда вас попросят указать другую 

Категорию, чтобы переместить их туда. Вы не сможете удалить или переместить 

последнюю Категорию в любом Контексте, поскольку в Контексте всегда должна быть 

хотя бы одна Категория. 

4.6.4.3.2.Использование иконок стрелок для перемещения 
Категорий 
Вы можете также организовать Категории в иерархию, чтобы ими стало легче управлять. 

 Иконки стрелок вверх/вниз позволяют изменить порядок, в котором «равные» 

Категории отображаются. 

 Иконки стрелок вверх/вниз используются также, чтобы перемещать Категорию 

верхнего уровня между Контекстами. Если вы переместите Категорию, которая будет 

первой или последней в Контексте, и затем нажмёте клавишу стрелки рядом с ней, 

Категория будет перемещена в следующий Контекст. 

 Иконка стрелки вправо позволяет переместить Категорию, сделав её дочерней 

Категорией Категории, указанной в списке сразу над этой. 

 Иконка стрелки влево позволяет переместить Категорию вверх на один уровень 

Категорий (чтобы сделать её ровней её родительской Категории). 

См. всплывающую подсказку, которая появляется, когда вы помещаете указатель 

мышки над этими иконками, если вы не уверены, что действие иконки будет выполнено. 

Вы не можете удалить последнюю Категорию в любом Контексте, поскольку в Контексте 

всегда должна быть одна Категория. 

4.6.4.4.См. также 
 Контексты Вопросов (п. 4.6.2). 

 Обсуждение форума по использованию Moodle «Я могу увидеть Категории других 

Преподавателей». 

4.6.5.Импорт Вопросов 
Moodle имеет ряд различных форматов, которые могут быть использованы для 

импорта Вопросов в Категории Банка Вопросов и в качестве страниц Вопросов Урока. Это 

включает некоторые собственные форматы программного обеспечения Экзамена, 

вдобавок к текстовым файлом и форматам Moodle. 

http://moodle.org/mod/forum/discuss.php?d=47540
http://moodle.org/mod/forum/discuss.php?d=47540
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4.6.5.1.Importing questions from an existing 
file 
It is possible to import questions from a file on your network/computer or 

from a file that has been saved or uploaded into your course files. The 

underlying character encoding of this file is important. 

Note: Moodle XML format is the recommended import question type 

format as it enables the maximum amount of question data (such as 

question feedback) to be imported. 

4.6.5.1.1.Question bank import process 
The question bank allows you a great deal of flexibility when importing 

questions. To import questions into Moodle's Question bank, use the 

Questions link in the course administration and select the import tab. In 

most versions of Moodle it is also possible to get to this screen (produced 

by ../question/import.php) while editing an existing quiz. 

Screenshot «Import question formats from the import tab». 

 Select import tab 

 Select the question type to import 

 General: pick the category, determine if the context and category 

information that maybe contained in a GIFT or XML file should be 

used. 

 Select what should happen if there are no grades or an error is detected 

in the import process. 

 Determine the file to import 

 Import from file upload. Use the browse function to import a file 

from your computer. Use the "Upload this file" button to import the 

questions. 

 Import from file already in course files. A popup window will take 

you to the course files start page. Use the "Import from this file" 

button. 

Screenshot «General and import file parameters sections 

4.6.5.1.2.Lesson module process 
The question types that can be imported into a lesson are similar to 

question bank. 

Screenshot «Lesson screen asking which file type will be imported». 

 

Lesson can only import from a file located on the teachers computer. 

 

 

4.6.5.1.Импортирование Вопросов из существующего 
файла 

Можно импортировать Вопросы из файла вашей сети/компьютера или из файла, 

который сохранён или загружен в ваши файлы Курса. Важен формат символов 

кодирования (п. 4.6.5.4) импортируемого файла. 

Замечание: Формат XML системы Moodle – рекомендованный формат типа для 

импорта Вопросов, поскольку он позволяет импортировать максимальное количество 

данных Вопроса (таких как Обратная Связь Вопросов). 

4.6.5.1.1.Процесс импорта Банка Вопросов 
Банк Вопросов предоставляет значительную гибкость при импортировании 

Вопросов. Чтобы импортировать Вопросы в Банк Вопросов Moodle, используйте ссылку 

Questions в управлении Курсом и выберите этикетку импорта. В большинстве версий 

Moodle также можно прийти к этому экрану (образуемому посредством 

../question/import.php) во время редактирования существующего Экзамена. 

Снимок с экрана «Импорт форматов Вопросов из этикетки импорта». 

 Выберите этикетку импорта. 

 Выберите тип Вопроса для импорта. 

 Общепринято: выбрать Категорию, определить, будет ли использоваться информация о 

Контексте и Категории, которая может содержаться в GIFT или XML. 

 

 Выберите, что произойдёт, если нет Оценок или обнаружится ошибка в процессе 

импорта. 

 Определите файл для импорта: 

 Импортируйте из загрузки файлов. Используйте функцию просмотра для импорта 

файла из вашего компьютера. Используйте кнопку «Upload this file (переслать этот 

файл)», чтобы импортировать Вопросы. 

 Импортируйте из файла, который уже в файлах Курса. Всплывающее окно доставит 

вас на страницу начала файлов Курса. Используйте кнопку «Import from this file 

(импортировать из этого файла)». 

Снимок с экрана «Разделы параметров обычного и импортированного файла». 

4.6.5.1.2.Обработка модуля «Урок» 
Типы Вопросов, которые могут быть импортированы в Урок, подобны 

Банку Вопросов. 

Снимок с экрана «Экран Урока, спрашивающий, какой тип файла будет 

импортироваться». 

Урок (п. 4.3.9) может импортироваться только из файла, размещённого на 

компьютере Преподавателей. 

http://docs.moodle.org/25/en/File:Questions_import_197.png
http://docs.moodle.org/25/en/File:Question_bank_import_file_gen_import_1.png
http://docs.moodle.org/25/en/File:Lesson_Import_question_types.png
http://docs.moodle.org/25/en/File:Lesson_Import_question_types.png


 

314 

 In edit, using the expanded view 

 Select the position where questions should be inserted into the lesson 

 Click on the Import question link between the pages. 

 Select the file type 

 Use the browse function to find the file on your computer 

 Import the selected file. 

4.6.5.2.Question import formats 
4.6.5.2.1.GIFT 
Moodle 'proprietary' text format for import and export. Reasonably 

comprehensive. 

4.6.5.2.2.Moodle XML 
Moodle 'proprietary' xml format for import and export. Very 

comprehensive. 

How do you create XML files to enable import of 
images? 
Discussion: http://moodle.org/mod/forum/discuss.php?d=181211 

OPTION 1 
Check out http://www.slideshare.net/tjuly/adding-images-to-moodle-quiz-

and-import-via-xml 

This describes a use of a text to XML conversion process using 

http://vletools.com/questions/quiz 

Please add any further comments here: 

OPTION 2 

4.6.5.2.3.Aiken 
This format is an easy way of writing multiple-choice questions for import. 

 

4.6.5.2.4.Blackboard 
It's possible to import both .dat files containing just questions 

text or zip archives containing questions and associated medias (images, 

sounds, ...). 

If your questions contains images they are imported too. 

Also both Blackboard POOL and QTI files are supported. 

Questions produced with TestGen and Examview softwares and saved as 

Blackboard files are imported. 

 

If the zip archives contains several resources files all questions from all 

files are imported. "Undeployed" Blackboard quiz are also supported. 

 

 При редактировании, использующем развёрнутый вид. 

 Выберите положение, куда Вопросы должны быть вставлены в Урок. 

 Щёлкните по ссылке Import question между страницами. 

 Выберите тип файла. 

 Используйте функцию просмотра для отыскания файла на вашем компьютере. 

 Импортируйте выбранный файл. 

4.6.5.2.Форматы импорта Вопросов 
4.6.5.2.1.Текстовый формат GIFT 

«Собственный» текстовый формат Moodle для импорта и экспорта. Довольно 

всесторонний. 

4.6.5.2.2.Расширяемый язык разметки Moodle XML 
«Собственный» XML формат Moodle для импорта и экспорта. Весьма 

всесторонний. 

Как вы создаёте файлы XML, чтобы позволить импорт 
изображений 

Обсуждение: http://moodle.org/mod/forum/discuss.php?d=181211. 

Вариант 1 

Тщательно проверьте http://www.slideshare.net/tjuly/adding-images-to-moodle-quiz-

and-import-via-xml. 

Это описывает использование процесса преобразования текста в XML, 

использующего http://vletools.com/questions/quiz. 

Пожалуйста добавьте любые дальнейшие комментарии здесь: 

Вариант 2. 

4.6.5.2.3.Формат Aiken 
Этот формат – лёгкий способ составления Вопросов с множественным выбором для 

импорта. 

4.6.5.2.4.Формат Blackboard 
Можно импортировать и файлы .dat, содержащие просто текст Вопросы, или 

архивы .zip, содержащие Вопросы и связанные с ними медиа (изображения, звуки…). 

 

Если ваши Вопросы содержат изображения, они также импортируются. 

Кроме того, поддерживаются Blackboard POOL (пул рабочих областей) и файлы 

QTI (Question and Test Interoperability – унифицированные вопросы и тесты). Вопросы, 

образованные программным обеспечением TestGen и Examview и сохранённые как 

импортированные файлы Blackboard. 

Если архивы .zip, содержат несколько файлов с ресурсами, импортируются все 

Вопросы изо всех файлов. Поддерживается также Экзамен формата «свёрнутый» 

Blackboard. 

http://moodle.org/mod/forum/discuss.php?d=181211
http://www.slideshare.net/tjuly/adding-images-to-moodle-quiz-and-import-via-xml
http://www.slideshare.net/tjuly/adding-images-to-moodle-quiz-and-import-via-xml
http://vletools.com/questions/quiz
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Follow these steps to import questions: 

1. Create a quiz with questions in Examview Test Generator v. 6.2.1 or 

another question generator able to save questions as Blackboard files 

like TestGen. 

2. Export the quiz to Blackboard 6.0-7.0 format. 

3. From the Settings tab for your course choose Question bank and then 

Import. Make sure you use the Blackboard format. 

NOTE: Some tutorials on the web explain that you need to edit files to re-

link images. This is no more needed. Images are imported without any 

editing. 

Importing questions in different categories 
New feature in Moodle 2.5! 

If you check the "Get category from file" option during import, the 

category name for each resource file will be extracted for the resource file 

and created if necessary. 

If "Get category from file" is unchecked, all questions will be imported in 

the current category. 

Other alternative method to import Blackboard questions 
files 
There is an alternative to the Blackboard format to import questions saved 

as Blackboard files. MoodleXMLBuilder discussed below in See Also can 

also be used to convert ExamView exports to Moodle XML. Images are 

supported and included within the Moodle XML when using 

MoodleXMLBuilder. 

If you decide to use MoodleXMLBuilder to convert your Blackboard zip 

file to a Moodle XML file, rather than use the  

recommended method to directly import your zip file using the Blackboard 

format (see above), here is how to do it: 

1. Create a quiz with questions in Examview Test Generator v. 6.2.1 or 

another question generator able to save questions as Blackboard files 

like TestGen. 

2. Export the quiz to Blackboard 6.0-7.0 format 

3. Use the aforementioned MoodleXMLBuilder to convert from 

ExamView Export to Blackboard 6.0-7.0 into the XML format that 

Moodle accepts. 

4. From the Settings tab for your course choose Question bank and then 

Import. Make sure you use the Moodle XML format. You may also 

need to set Stop on error to No. 

 

 

Чтобы импортировать Вопросы, делайте следующие шаги: 

1. Создайте Экзамен с Вопросами в Examview Test Generator v. 6.2.1 (генератор тестов в 

формате Examview версии 6.2.1) или в другом генераторе Вопросов, способном 

сохранять Вопросы, подобно TestGen. 

2. Экспортируйте этот Экзамен в формат Blackboard 6.0-7.0. 

3. В Блоке управления для вашего Курса выберите Question bank и затем Import. 

Убедитесь, что вы используете формат Blackboard. 

Замечание: Некоторые учебные пособия в сети объясняют, что вам нужно 

отредактировать файлы, чтобы освежить ссылки на изображения. Это не является более 

необходимым. Изображения импортируются безо всякого редактирования. 

Импортирование Вопросов в различные Категории 
Новое средство в Moodle 2.5! 

Если пометить опцию «Get category from file (получить категорию из файла)» во 

время импорта, имя Категории для каждого файла с ресурсами будет извлечено для файла 

с ресурсами и создано, если необходимо. 

Если пометка «Get category from file» снята, все Вопросы будут импортированы в 

текущую Категорию. 

Другой альтернативный метод импортирования файлов Вопросов 
формата Blackboard 

Существует альтернатива формату Blackboard, чтобы импортировать Вопросы, 

сохранённые как файлы Blackboard. Обсуждаемый ниже в разделе «См также» 

MoodleXMLBuilder, может быть использован для преобразования экспорта ExamView в 

Moodle XML. Изображения поддерживаются и включаются внутрь Moodle XML при 

использовании MoodleXMLBuilder. 

Если вы решили использовать MoodleXMLBuilder для преобразования zip-файл 

формата Blackboard в Moodle XML-файл, вместо того чтобы использовать рекомендуемый 

метод прямого импортирования вашего zip-файла, используя формат Blackboard (см. 

выше), то вот как это делается: 

1. Создайте Экзамен с Вопросами в генераторе тестов Examview v. 6.2.1 или другом 

генераторе Вопросов, способном сохранять Вопросы в виде Blackboard файлов, 

подобно TestGen. 

2. Экспортируйте этот Экзамен в формат Blackboard 6.0-7.0. 

3. Используйте вышеупомянутый MoodleXMLBuilder для преобразования из «Экспорт 

ExamView в Blackboard 6.0-7.0» в формат XML, который признаёт Moodle. 

 

4. На вкладке Settings (настройки) для вашего Курса выберите Question bank (банк 

вопросов), и затем Import (импортировать). Убедитесь, что вы используете формат 

Moodle XML. Также может потребоваться установить Stop on error (останавливаться на 

ошибках) в No (нет). 

http://www.nashcc.edu/moodlexmlbuilder
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FYI To install MoodleXMLBuilder you may need to be logged into an 

administrator account or select "Run as administrator" from the right-click 

menu. You'll also need java and you will need to run the 

MoodleXMLBuilder.exe application from its install directory (the installer 

doesn't seem to create a Start menu entry). For Windows 7 it was 

C:\Program Files (x86)\MoodleXMLBuilder\MoodleXMLBuilder.exe. 

 

4.6.5.2.5.Course Test Manager 
This format enables you to import questions from the Course Test Manager 

from Course Technology. 

4.6.5.2.6.Embedded Answers (Cloze) 
This format is a multiple question, multiple answer question with 

embedded answers. They can be a bit tricky to develop, but they are a 

unique way of asking questions. 

4.6.5.2.7.Examview 
ExamView 4 supported an XML export format that Moodle can import. 

 

Follow these steps to import questions from ExamView 4.0.8 

1. Create a new test using ExamView 

2. After selecting the types of questions and how many of each Click on 

File - Export – Change Save As Type to ExamView XML 

3. After creating the export of your ExamView test login to your Moodle 

site 

4. Go to the course you wish to add the quiz to and Turn Editing On 

 

5. Scroll down to the topic or week you wish to add a Quiz Click add an 

activity – highlight quiz, Enter a name and introduction for the quiz and 

any other applicable information. 

6. Click save and display 

7. Editing quiz - click Edit then Import, click the radio button next to 

ExamView 

8. Browse to the location you saved the file highlight and click open, then 

click the upload this file button. 

9. Review the questions imported, click continue, click on Quiz, select all 

and click add to quiz. 

10. Save Changes, click on the preview tab view the test and the quiz is 

ready. 

 

 

К вашему сведению. Чтобы установить MoodleXMLBuilder, вам нужно 

зарегистрироваться с учётной записью Администратора или выбрать «Run as administrator 

(запуск от имени Администратора)» из меню, вызываемому по щелчку правой кнопки 

мыши. Вам также потребуется Java и вам нужно будет запустить приложение 

MoodleXMLBuilder.exe из его инсталляционного каталога (инсталлятору не должно 

потребоваться создавать запись стартового меню). Для Windows 7 это был C:\Program Files 

(x86)\MoodleXMLBuilder\MoodleXMLBuilder.exe. 

4.6.5.2.5.Тест-Менеджер Курсов 
Этот формат позволяет импортировать Вопросы из Тест-Менеджера Курсов от 

Course Technology. 

4.6.5.2.6.Встроенные Ответы (Учебный тест) 
Это формат Вопросов с Множественным Выбором Встроенных Ответов. Они 

могут быть несколько сложны для разработки, но являются уникальным способом задания 

Вопросов. 

4.6.5.2.7.Тесты формата Examview 
Модуль ExamView 4, поддерживающий формат экспорта XML, который Moodle 

может импортировать. 

Следуйте этим шагам, чтобы импортировать из ExamView 4.0.8: 

1. Создайте новый тест, используя ExamView. 

2. После выбора типов Вопросов и того, сколько их в каждом, щёлкните 

File→Export→Change Save As. Наберите ExamView XML. 

3. После создания экспорта вашего теста ExamView зарегистрируйтесь на вашем Сайте 

Moodle. 

4. Перейдите в тот Курс, в который вы хотите добавить этот Экзамен, и включите режим 

редактирования. 

5. Прокрутите Тему или неделю Курса, куда хотите добавить Экзамен. Щёлкните 

добавить Интерактивное Действие, подсветите Экзамен, введите название и введение в 

Экзамен, а также любую другую нужную информацию. 

6. Щёлкните «Save and display (сохранить и отобразить)». 

7. Отредактируйте Экзамен: щёлкните Edit, затем Import, щёлкните переключатель рядом 

с ExamView. 

8. Найдите местоположение сохранённого вами файла, подсветите и щёлкните Open, а 

затем щёлкните кнопку Upload this file (переслать этот файл). 

9. Просмотрите импортированные Вопросы, щёлкните Continue (продолжить), щёлкните 

по Экзамену, выберите All (все) и щёлкните Add to quiz (добавить в экзамен). 

10. Сохраните изменения, щёлкните по этикетке Preview (предварительный просмотр), 

чтобы увидеть, что тест и Экзамен уже готовы. 
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If you are using a newer version of ExamView, you should export using 

Blackboard, extract the zip archive ExamView creates, then import in 

Moodle using Blackboard format (do not use 6+ format for moodle import, 

even though exam view calls this a Blackboard6+ file--it isn't). You can 

choose one of the ".dat" files from the ExamView archive to import. Note 

that images are not currently imported. 

Any questions that included images must be edited to "re-link" those 

images. The image files can be found in the file folder that is in your item 

test bank directory of your course files. Click the edit tool next to a 

question in the question list. If one or more images files are included in the 

question, you should see a placeholder with the image file name in it 

embedded with text in the text edit window. Click on the placeholder and 

then click on the insert image tool of the text editor. Navigate to the folder 

containing the image files. (It will be in the folder you uploaded the zipped 

question bank to). Find the file with the same name as indicated in the 

image placeholder. Type the alternate text then click "okay" to re-link the 

image. Click on "okay" to return to the question list. 

 

MoodleXMLBuilder disicussed below in See Also can also be used to 

convert ExamView exports to Moodle XML. Images are supported and 

included within the Moodle XML when using MoodleXMLBuilder. In 

ExamView choose one of the two Blackboard export options and select the 

corresponding option in MoodleXMLBuilder. Either Blackboard option 

will convert questions to Moodle XML, however it is recommended to 

choose the Blackboard 7.1+ option. 

NOTE:In Moodle 2.1 (?... not sure of the server version) there exists a 

problem with MIME types that prevent Examview question banks from 

being uploaded, regardless of the export format, the extension (e.g. .txt or 

.xml) or the MIME information in the files themselves (?txt or ?xml). 

A work-around is available for ExamView Test Generator, version 6.2.1 

(perhaps also for other versions but not for 3.5.1 since it doesn't export to 

Blackboard). 

1. Create a quiz with questions in Examview Test Generator v. 6.2.1 

2. Export the quiz to Blackboard 6.0-7.0 format 

3. Use the aforementioned MoodleXMLBuilder to convert from 

ExamView Export to Blackboard 6.0-7.0 into the XML format that 

Moodle 2.1 (?) accepts. 

4. 4. From the Settings tab for your course choose Question bank and then 

Import. Make sure you use the Moodle XML format. You may also 

need to set Stop on error to No. 

Если вы используете новую версию ExamView, вам нужно экспортировать, 

используя Blackboard, извлеките zip-архив, который создаёт ExamView, затем 

импортируйте в Moodle, используя формат Blackboard (не используйте для импорта 

Moodle, даже если просмотр экзамена называет это Blackboard6 и выше – это не так). Вы 

можете выбрать один из файлов «.dat» из архива ExamView, чтобы импортировать. 

Заметьте, что изображения в настоящее время не импортируются. 

Ссылки на любые Вопросы, которые включают изображения, должны быть 

отредактированы. Файлы изображений можно найти в папке файлов, т.е. в вашем 

оглавлении банка тестовых элементов ваших файлов Курса. Щёлкните на инструменте 

Редактировать следующий на Вопрос в списке Вопросов. Если один или несколько файлов 

изображений включены в Вопрос, вы должны увидеть заполнитель с именем файла 

изображения в нём, с встроенным текстом в окне редактирования текста. Щёлкните по 

заполнителю, а затем щёлкните по инструменту вставки изображения в текстовом 

редакторе. Перейдите в папку, содержащую файлы изображений. (Это будет в папке, в 

которую вы загрузили заархивированный Банк Вопросов). Найдите файл с тем же самым 

именем, как указано в заполнителе изображения. Введите альтернативный текст затем 

нажмите кнопку «Okay (хорошо)», которая заменит ссылку на изображение. Нажмите на 

«Okay (хорошо)», чтобы вернуться к списку Вопросов. 

MoodleXMLBuilder, обсуждаемый ниже в «См. также», может быть использован 

для преобразования экспорта ExamView в Moodle XML. Изображения поддерживаются и 

включены в Moodle XML при использовании MoodleXMLBuilder. В ExamView выберите 

одну из двух опций экспорта Blackboard и выберите соответствующую опцию в 

MoodleXMLBuilder. Либо опция Blackboard будет конвертировать Вопросы в Moodle 

XML, однако рекомендуется выбрать опцию Blackboard 7.1 и выше. 

 

ЗАМЕЧАНИЕ: В Moodle 2.1 (?... возможно, в другой версии сервера) существует проблема 

с типами MIME, которые , независимо от формата экспорта, мешают банкам вопросов 

ExamView загружать расширение (например .txt или .xml) или информацию MIME в самих 

файлах ((?txt или ?xml). 

Обходной путь возможен для генератора тестов ExamView версия 6.2.1 (возможно 

также для других версий, но не для 3.5.1, так как она не экспортирует в Blackboard). 

 

1. Создайте Экзамен с Вопросами в генераторе тестов ExamView версии 6.2.1. 

2. Экспортируйте Экзамен в формат Blackboard 6.0-7.0. 

3. Используйте вышеупомянутый MoodleXMLBuilder, чтобы конвертировать из 

ExamView Export to Blackboard 6.0-7.0 в формат XML, который поддерживается в 

Moodle 2.1 (?). 

4. В Блоке Administration для вашего Курса выберите Question bank (банк вопросов), а 

затем Import. Убедитесь, что вы используете формат Moodle XML. Вам может также 

потребоваться установить Stop on error (Остановиться при ошибке) в No (нет). 



 

318 

FYI To install MoodleXMLBuilder you may need to be logged into an 

administrator account or select "Run as administrator" from the right-click 

menu. You'll also need java and you will need to run the 

MoodleXMLBuilder.exe application from its install directory (the installer 

doesn't seem to create a Start menu entry). For Windows 7 it was 

C:\Program Files (x86)\MoodleXMLBuilder\MoodleXMLBuilder.exe. 

 

Updated information: With ExamView 6.2.1, export the exam using 

"Blackboard 6.0-7.0" format. Then with Moodle 2.3.3, select "Examview 

exported as Blackboard 6.0-7.0" on the Import questions screen. 

 

4.6.5.2.8.Hot Potatoes 
A freeware program that can export questions into Moodle. 

 

Note 1.- All types of Hot Potatoes question types can be imported into 

Moodle, but JCross and JMix questions will be changed to Short Answer 

questions. 

 Can be imported into the Quiz questions bank: 

 Cloze questions (JCloze); 

 Match questions (JMatch); 

 Multiple Choice questions (JQuiz) 

 Short Answer questions (JQuiz, JCross and JMix) 

 Can be imported into Moodle's Lesson module: 

 Match questions (JMatch); 

 Multiple Choice questions (JQuiz) 

Note 2.- For Hot Potatoes' Multiple Choice question type (JQuiz), the 

Multiple-choice Short answer and Multi-select question-type will imported 

as they are. Hybrid questions will be imported as MultiChoice questions, 

i.e. they will not start as Short Answer questions and then change to 

Multiple Choice questions after several wrong responses. 

 

4.6.5.2.9.Learnwise 
This format can import multiple choice questions saved in Learnwise's 

XML format. 

4.6.5.2.10.Missing word 
This format is only used for multiple choice questions and short answer 

questions, similar to GIFT. 

 

 

К вашему сведению. Чтобы установить MoodleXMLBuilder, вам нужно 

зарегистрироваться с учётной записью Администратора или выбрать «Run as administrator 

(запуск от имени Администратора)» из меню, вызываемому по щелчку правой кнопки 

мыши. Вам также потребуется Java и вам нужно будет запустить приложение 

MoodleXMLBuilder.exe из его инсталляционного каталога (инсталлятору не должно 

потребоваться создавать запись стартового меню). Для Windows 7 это был C:\Program Files 

(x86)\MoodleXMLBuilder\MoodleXMLBuilder.exe. 

Обновлённая информация: С помощью ExamView 6.2.1 экспортируйте Экзамен, 

используя формат «Blackboard 6.0-7.0». Затем в Moodle 2.3.3 выберите «Examview exported 

as Blackboard 6.0-7.0 (Examview экспортируемый как Blackboard 6.0-7.0)» на экране 

«Import questions (импорт вопросов)». 

4.6.5.2.8.Горячая картошка 
Свободно распространяемая в сети программа, которая может экспортировать 

Вопросы в Moodle. 

Замечание 1: Все типы Вопросов для типа «Горячая картошка» могут быть 

импортированы в Moodle, но Вопросы JCross и JMix будут изменены на 

Вопросы с Кратким ответом. 

 Могут быть импортированы в Банк Вопросов Экзамена: 

 Вопросы с Учебным Тестом (JCloze); 

 Вопросы на Сопоставление (JMatch); 

 Вопросы с Множественным Выбором (JQuiz); 

 Вопросы с Кратким Ответом (JQuiz, JCross и JMix). 

 Могут быть импортированы в модуль «Урок» Moodle: 

 Вопросы на Сопоставление (JMatch); 

 Вопросы с Множественным Выбором (JQuiz). 

Замечание 2: Для типа Вопросов с Множественным Выбором типа «Горячая 

картошка» (JQuiz) краткие ответы из множественного выбора и тип 

Вопросов с Множественным Выбором будут импортировать как они есть. Гибридные 

Вопросы будут импортироваться как Вопросы со Множественным Выбором, т.н. они не 

будут начинаться как Вопросы с Кратким Ответом и затем после нескольких 

неправильных ответов изменяться в Вопросы со Множественным Выбором. 

4.6.5.2.9.Обучающие Вопросы 
Этот формат может импортировать Вопросы с Множественным Выбором в формат 

Learnwise XML. 

4.6.5.2.10.Пропущенное Слово 
Этот формат используется только для Вопросов со Множественным Выбором и 

Вопросов с Кратким Ответом, подобных GIFT. 
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4.6.5.2.11.WebCT format 
This format supports importing multiple choice and short answers 

questions from WebCT's text format. 

Caution: Keep in mind that WebCT allows more than one "blank" per 

short answer question; whereas, Moodle will only accommodate one blank 

per question. Questions that used multiple short answers in a question will 

not convert successfully. 

4.6.5.2.12.Word table format 
This format supports importing all question types (except calculated) from 

structured tables in Microsoft Word files. Further documentation is 

available at Word table format. 

The plugin is available in the Moodle Plugins Directory at Moodle2Word 

Word table import/export. 

4.6.5.3.Importing from other programs 
4.6.5.3.1.Diploma 6 
Diploma 6 also supports an XML export format that Moodle can import. If 

you are using a newer version of Diploma, here are the steps to export 

from Diploma and import to Moodle. The steps are the same as those for 

Blackboard (see above). 

Export from Diploma with the Blackboard LS 6.0 – 6.2 format. 

 Import the .zip file using the Blackboard format. The images are 

imported at the same time. 

4.6.5.3.2.Old formats 
AON -This format is the same as the missing word format, except it creates 

matching questions from the multiple choice questions. Please note that 

from Moodle 1.8 it will no longer be part of the standard Moodle. 

 

4.6.5.4.Character encoding 
It is important that the imported file is encoded in the UTF-8 standard. 

If this is not adhered to you may get import errors and/or strange characters 

in the imported materials. If the file is not UTF-8, an external tool must be 

used to change the encoding. Note that if only basic 'latin' characters are 

used, then the coding issue can generally be ignored. Be particularly 

careful when creating questions using Microsoft Word. For reasons best 

known to themselves, Microsoft used their own encoding for some 

characters (incompatible with UTF-8) and this is likely to break the import. 

 

 

4.6.5.2.11.Формат WebCT 
Этот формат поддерживает импорт Вопросов с Множественным Выбором и 

Кратким Ответом из текстового формата WebCT. 

Предупреждение: Имейте в виду, что WebCT допускает более одной 

«подстановки» в Вопросах с Кратким ответом, в то время как Moodle – только одну 

«подстановку» на один Вопрос. Вопросы, которые используют несколько коротких 

ответов в Вопросе, не будут преобразовываться успешно. 

4.6.5.2.12.Формат таблицы Word 
Этот формат поддерживает импорт всех типов Вопросов (за исключением 

вычисляемых) из структурированных таблиц в файлов Microsoft Word. Дальнейшая 

документация доступна в формате таблицы Word. 

Плагин доступен в каталоге плагинов Moodle на Moodle2Word слово таблица 

импорта/экспорта. 

4.6.5.3.Импортирование из других программ 
4.6.5.3.1.Генератор тестов Diploma 6 

Генератор «Diploma 6» также поддерживает формат экспорта XML, который 

Moodle может импортировать. Если вы используете более новую версию Diploma, это 

шаги, чтобы экспортировать из Diploma и импортировать в Moodle. Шаги являются 

такими же, как и для формата Blackboard (см. выше). 

Экспорт из Diploma в формат Blackboard LS 6.0-6.2. 

 Импорт zip-файла в формате Blackboard. Изображения импортируются одновременно. 

 

4.6.5.3.2.Старые форматы 
AON. Этот формат является таким же, что и формат с Пропущенным Словом, за 

исключением того, что он создаёт Вопросы на Сопоставление из 

Вопросов с Множественным Выбором. Пожалуйста, заметьте, что, начиная с Moodle 1.8, 

это не будет больше частью стандартной Moodle. 

4.6.5.4.Кодировка символов 
Важно, чтобы импортируемый файл кодировался в стандарте UTF-8. 

Если это не соблюдается, вы можете получить ошибки импорта и/или странные 

символы в импортированных материалах. Если файл не является UTF-8, для смены 

кодировки должны использоваться внешние средства. Заметьте, что если используются 

только основные «латинские» символы, тогда проблему кодирования, обычно, можно 

игнорировать. Будьте особенно осторожны при создании Вопросов с помощью Microsoft 

Word. По причинам, известным только им самим, Корпорация Майкрософт использовала 

свои собственные кодировки для некоторых символов (несовместимые с UTF-8) и это 

может нарушить импорт. 

http://docs.moodle.org/25/en/Word_table_format
http://en.wikipedia.org/wiki/UTF-8
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Note: If you are having problems with the first question (or category 

modifier) in the file being misinterpreted (this particularly applies to 

GIFT format) it might be your editor adding a "Byte-Order-Mark" 

character at the beginning of the file. This is particularly common in 

Windows programs (e.g. Notepad) and is another good reason to steer 

clear of Microsoft products for text editing (as apposed to word 

processing). There are plenty of free or low cost text editors available 

for download. The BOM is neither recommended or required as UTF8 

does not have byte order issues. 

4.6.5.5.Match grades 
Imported grades must exactly match one of the fixed list of valid grades, as 

follows: 

100, 90, 80, 75, 70, 66.666, 60, 50, 40, 33.333, 30, 25, 20, 16.666, 

14.2857, 12.5, 11.111, 10, 5, 0 

negative values of the above list are also permitted. 

There are two settings for this switch. They affect how the import routine 

treats values that do not exactly match one of the values in the above list 

 

 Error if grade not listed - If a question contains any grades not found in 

the list an error is displayed and that question will not be imported. 

 

 Nearest grade if not listed - If a grade is found that does not match a 

value in the list, the grade is changed to the closest matching value in 

the list 

Note: some custom import formats write directly to the database and may 

bypass this check. 

4.6.5.6.Tips and tricks 
 TIP: It may be easier and faster to type many questions into a single 

text file, than to create a series of Quiz or Lesson question pages. Some 

teachers report that once they master  creating questions in one of the 

formats to import, they do not have to wait for their Moodle site screen 

to refresh and the process of selecting the next question type to create. 

 TIP: Want to use questions from your quiz in a Lesson? Export the 

question category in say a GIFT format, then use a text editor to delete 

questions, or perhaps use a search and replace function to change names 

or places. 

 

 

 

Замечание: Если вы испытываете проблемы с первым Вопросом (или модификатором 

Категории) в неправильно интерпретируемом файле (особенно это относится к формату 

GIFT), это может быть ваш редактор, добавляющий символ «Метка порядка байтов» в 

начале файла. Это особенно часто встречается в программах Windows (например, 

Блокноте) и является ещё одной хорошей причиной, чтобы держаться подальше от 

продуктов Microsoft при редактировании текста (применительно к обработке слов). 

Есть много бесплатных или недорогих текстовых редакторов, доступных для 

скачивания. Никакого начала сообщения не рекомендуется или требуется, так как UTF-

8 не имеют проблем с порядком байтов. 

4.6.5.5.Согласовать Оценки 
Импортируемые оценки должны точно соответствовать одному из фиксированных 

списков действительных оценок, таких как следующие: 

100, 90, 80, 75, 70, 66.666, 60, 50, 40, 33.333, 30, 25, 20, 16.666, 14.2857, 12.5, 11.111, 10, 5, 

0 

отрицательные значения в списке выше также позволяются. 

Существуют две настройки для этого переключателя. Они воздействуют на то, как 

процедура импорта обрабатывает значения, которые не точно соответствуют одному из 

значений в списке, приведённом выше. 

 Ошибка, если Оценка не включена в список – Если Вопрос содержит любые Оценки, 

не входящие в список, отображается сообщение об ошибке, и этот Вопрос не 

импортируется. 

 Ближайшая Оценка, если не включена в список. – Если обнаружена Оценка, которая 

не соответствует значению в списке, эта Оценка заменяется на ближайшее подходящее 

значение в списке. 

Замечание: некоторые клиентские форматы импорта записываются 

непосредственно в базу данных и могут обойти эту проверку. 

4.6.5.6.Советы и трюки 
 Совет: Бывает проще и быстрее набрать много Вопросов в единственном текстовом 

файле, чем создавать серию страниц Вопросов Экзамена или Урока. Некоторые 

Преподаватели сообщают, что после того, как они осваивают создание Вопросов в 

одном из форматов для импорта, им не нужно ждать, чтобы освежить экран Сайта 

Moodle и создавать процесс выбора следующего типа Вопросов. 

 Совет: Хотите использовать вопросы из вашего Экзамена в Уроке? Экспортируйте 

Категорию Вопросов, скажем, в формат GIFT, а затем примените текстовый редактор, 

чтобы удалить Вопросы, или, может быть, используйте функцию поиска и замены, 

чтобы изменить названия или местоположения. 

http://en.wikipedia.org/wiki/Byte-order_mark


 

321 

4.6.5.7.See also 
 Moodle XML Converter Convert your questions online into Moodle 

XML format. Allows to create questions from existing text files that 

should to be preformatted in a simple way. Supports TeX formulas, 

HTML and image embedded questions. Also can generate *.txt file 

from Moodle XML in case you need to export your questions in 

textfile. 

 MoodleXMLBuilder converts commonly-used test generator output into 

Moodle XML. MoodleXMLBuilder currently supports converting tests 

and question banks created in Blackboard, ExamView, TestGen, and 

EZTest. Images are fully supported within all question fields where 

images are allowed within the Moodle quiz module. 

 The help button link next to the import file button gives a lot of detail 

about each format in a popup window. 

 Using Moodle escaping problem in gift import? forum discussion 

 

 Converting files to UTF-8 

 Import and export FAQ 

 Eoin Campbell is working on a XSLT based import/export module for  

 

 Word - stay tuned! 

 Website for converting Moodle Questions into tables in a Microsoft 

Word file, and vice versa. 

 Using Moodle GIFT import - default grade forum discussion 

 

4.6.6.Export questions 
Questions may be exported from the Quiz module and the Question bank 

in any one of 3 formats:  

GIFT format, Moodle XML format, XHTML format. 

In addition, questions may be exported into Word format using a 

contributed plugin, Word table format. These can then be easily used to 

create paper tests. 

4.6.6.1.Process 
 Click Settings>Quiz Administration>Question bank>Export. 

Screenshot «Export questions» 

 Select the output type required for the exported file. 

 Use the pulldown menu to select the question category you want to 

export 

4.6.5.7.См. также 
 Moodle XML Converter конвертирует ваши Вопросы в режиме онлайн в формат Moodle 

XML. Позволяет создавать вопросы из существующих текстовых файлов, которые 

должны быть предварительно отформатированы простым путём. Поддерживает 

формулы TeX, HTML и вопросы со встроенными изображениями. Также может 

сгенерировать файл *.txt из Moodle XML в случае, если вам нужно экспортировать 

ваши вопросы в текстовый файл. 

 MoodleXMLBuilder преобразует выходные данные генератора применяемого в 

настоящее время теста в Moodle XML. MoodleXMLBuilder в настоящее время 

поддерживает конвертирование тестов и Банков Вопросов, созданных в Blackboard, 

ExamView, TestGen и EZTest. Изображения полностью поддерживаются во всех полях 

Вопросов, где разрешены изображения в модуле «Экзамен» Moodle. 

 Ссылка на кнопку «Справка» возле кнопки «Import file (импортировать файл)» 

предоставляет много деталей о каждом формате во всплывающем окне. 

 Обсуждения форума по использованию Moodle «Устранение проблемы импорта в 

GIFT?». 

 Конвертирование файлов в UTF-8. 

 Часто задаваемые вопросы по импорту и экспорту. 

 Иоин Кэмпбелл, работающий с XSLT (eXtensible Stylesheet Language Transformations – 

язык преобразования XML-документов), поместил модуль импорта/экспорта для  

 Word – следите за обновлениями! 

 Веб-Сайт для преобразования Moodle вопросы в таблицах в Microsoft Word файл и 

наоборот. 

 Обсуждения форума по использованию Moodle «Импорт в формате GIFT– Оценка по 

умолчанию». 

4.6.6.Экспорт Вопросов 
Вопросы могут быть экспортированы из модуля «Экзамен» и Банка Вопросов в 

любом из трёх форматов: 

GIFT (п. 4.6.6.3), Moodle XML (п. 4.6.6.4), XHTML (п. 4.6.6.5). 

Кроме того вопросы могут быть экспортированы в формат Word, используя 

способствующий плагин, или в формат таблицы Word. Затем они могут быть легко 

использованы для создания бумажных тестов. 

4.6.6.1.Процесс 
 Щёлкните Settings→Quiz Administration→Question bank→Export. 

Снимок с экрана «Экспорт Вопросов». 

 Выберите тип выхода, требуемый для экспортируемого файла. 

 Используйте ниспадающее меню, чтобы выбрать Категорию Вопросов, которые вы 

хотите экспортировать. 

http://vletools.com/
http://www.nashcc.edu/moodlexmlbuilder
http://moodle.org/mod/forum/discuss.php?d=51316
http://docs.moodle.org/25/en/Converting_files_to_UTF-8
http://docs.moodle.org/25/en/Import_and_export_FAQ
http://moodle.org/mod/forum/user.php?id=726938&course=5
http://www.moodle2word.net/
http://www.moodle2word.net/
http://moodle.org/mod/forum/discuss.php?d=202101
http://moodle.org/mod/forum/discuss.php?d=202101
http://docs.moodle.org/25/en/File:exportquestions.png
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 Check if you want the category name to exported and/or the context to 

be included. This only applies to some formats and is used to restore 

this information on import. 

 Click on the export questions to file button 

 You are invited to download the file to your computer. 

4.6.6.2.Example uses of exported files 
 GIFT and Moodle XML formats can be imported into the Lesson 

module And Question bank via an import question process. 

 Exported question files on one server, can be imported into another 

Moodle site/server 

 GIFT and Moodle XML formats can be tweaked to create word 

processing or spreadsheet documents suitable for paper tests or vetting. 

 

 In case you want to convert your Moodle XML file into text format 

upload XML to http://moodle.heroku.com. It automatically generates 

*.txt with your questions 

4.6.6.3.GIFT format 
GIFT format allows someone to use a text editor to write multiple-choice, 

true-false, short answer, matching missing word and numerical questions 

in a simple format that can be imported. The GIFT format is also an export 

file format available in Question bank. The format has been developed 

within the Moodle Community but other software may support it to a 

greater or lesser degree. 

 When creating a large numbers of questions, GIFT can provide a quick 

way of bulk loading questions either into a question category, or into a 

Lesson. 

 Sometimes it is easier proofing questions in a question category by 

viewing them in a GIFT file. 

4.6.6.3.1.General instructions 
At least one blank line must be left between each question. 

In the simple form, the question comes first, then the answers are set in 

between brackets, with an equal sign (=) indicating the correct answer(s) 

and tilde (~) the wrong answers. A hash (#) will insert a response. 

Questions can be weighted by placing percentage signs (%..%) around the 

weight. Comments are preceded by double slashes (//) and are not 

imported. 

Here are some useful GIFT examples than can be imported or used as 

rough template. Many of the examples below used the questions in the file 

as a starting point. 

 Пометьте, если вы хотите, чтобы название Категории экспортировалось и/или чтобы 

был включён Контекст. Это относится только к некоторым форматам и используется 

для восстановления этой информации при импорте. 

 Щёлкните по кнопке «Export questions to file (экспортировать вопросы в файл)».  

 Вам предлагается скачать файл на свой компьютер. 

4.6.6.2.Возможные применения файлов экспорта 
 Форматы GIFT и Moodle XML могут быть импортированы в модуль «Урок» (п. 4.3.9) и 

Банк Вопросов (п. 4.6.3) посредством процесса импорта Вопросов (п. 4.6.5). 

 Экспортированные на один сервер файлы Вопросов могут быть импортированы на 

другой Сайт/сервер Moodle. 

 Форматы GIFT и Moodle XML могут быть модифицированы, чтобы подходящим 

образом обработать текст или табличные документы для бумажных тестов или 

контрольного просмотра. 

 В случае, если вы хотите конвертировать ваш файл Moodle XML в текстовый формат 

перешлите XML в http://moodle.heroku.com. Это автоматически сгенерирует *.txt с 

вашими вопросами. 

4.6.6.3.Формат GIFT 
Формат GIFT позволяет использовать текстовый редактор, чтобы записать 

Вопросы с Множественным Выбором, Истина/Ложь, с Кратким Ответом, на 

Сопоставление с Пропущенным Словом и Числовые в Простом Формате, пригодном для 

импорта. Формат GIFT является также форматом файлов для экспорта, доступным в 

Банке Вопросов. Этот формат был развит внутри содружества Moodle, но и другое 

программное обеспечение может поддерживать его в большей или меньшей степени. 

 При создании большого числа Вопросов GIFT может обеспечить быстрый способ 

оптовой загрузки Вопросов или в Категорию Вопросов, или в Урок. 

 

 Иногда это самой лёгкой проверкой Вопросов в Категории Вопросов является их 

просмотр в файле GIFT. 

4.6.6.3.1.Общие инструкции 
Между Вопросами необходимо оставлять, по крайней мере, одну пустую строку. 

В простой форме Вопрос идёт первым, затем ответы, заключённые скобки, с 

пометкой знак равенства (=) правильного(ых) ответа(ов) и знаком тильды (~) 

неправильных ответов. Со знака «решётка» (#) начинается отклик Преподавателя. 

Вопросы могут быть взвешенными посредством размещения знаков процента (%.%) 

вокруг веса. Комментарии предваряются двойной косой чертой (//) и не импортируются. 

 

Вот несколько полезных примеров GIFT, которые могут быть импортированы или 

использованы как черновой шаблон. Многие из приведённых ниже примеров 

использовали Вопросы в файле в качестве отправной точки. 

http://moodle.heroku.com/
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UTF-8 encoding 
Any GIFT file must be correctly encoded in UTF-8. You can use 

Microsoft's text editor Notepad which comes with Windows to save your 

file in UTF-8. 

Note: ANSI format will (only) work for languages without any special 

characters (like ä, ö, ü, æ, å, ø, œ or ß). And don't use "Unicode" as format 

as this is actually UTF-16 and won't work. See Converting files to UTF-8 

for further information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Кодировка UTF-8 
Любой файл GIFT должен быть правильно закодирован в UTF-8. Можно 

использовать текстовый редактор «Блокнот» фирмы Microsoft, который поставляется с 

Windows для сохранения вашего файла в кодировке UTF-8. 

Замечание: Формат ANSI будет работать (только) для языков без каких-либо 

специальных символов (подобных, ä, ö, ü, æ, å, ø, œ или ß). И не используйте «Unicode», 

поскольку этот формат в действительности есть UTF-16 и работать не будет. Смотрите 

«Преобразование файлов в UTF-8» для получения дополнительной информации. 

http://docs.moodle.org/25/en/Converting_files_to_UTF-8
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Format symbols 
Here are some common GIFT symbols and their use. 

Symbols Use 

// text Comment until end of line (optional) 

::title:: Question title (optional) 

text Question text (becomes title if no title 

specified) 

 

 

[...format...] 

The format of the following bit of text. Options 

are [html], [moodle], [plain] and [markdown]. 

The default is [moodle] for the question text, 

other parts of the question default to the format 

used for the question text. 

 

{ 

Start answer(s) -- without any answers, text is 

a description of following questions 

{T} or {F} True or False answer; also {TRUE} and 

{FALSE} 

 

{ ... =right ... } 

Correct answer for multiple choice, (multiple 

answer? -- see page comments) or fill-in-the-

blank 

{ ... ~wrong ... } Incorrect answer for multiple choice or 

multiple answer 

{ ... =item -> match ... } Answer for matching questions 

#feedback text Answer feedback for preceding multiple, fill-

in-the-blank, or numeric answers 

 

####general feedback General feedback 

{# Start numeric answer(s) 

answer:tolerance Numeric answer accepted within ± tolerance 

range 

low..high Lower and upper range values of accepted 

numeric answer 

=%n%answer:toleranc

e 

n percent credit for one of multiple numeric 

ranges within tolerance from answer 

} End answer(s) 

\character Backslash escapes the special meaning of ~, =, 

#, {, }, and : 

\n Places a newline in question text -- blank lines 

delimit questions 

 

Символы форматирования 
Вот некоторые общие символы GIFT и их применение. 

Символы Применение 

// text Комментарий до конца строки (необязательный) 

::title:: Заголовок Вопроса (необязательный) 

text Текст Вопроса (становится заголовком, если заголовок не 

указан) 

 

 

[...format...] 

Формат следующей порции текста. 

Опциями являются [html], [moodle], [plain] и [markdown]. 

Для текста Вопроса опцией по умолчанию – [moodle], другие 

части Вопроса по умолчанию форматируются как текст 

Вопроса. 

 

{ 

Начать ответ(ы) – без каких-либо ответов, текст является 

описанием следующих вопросов 

{T} or {F} Ответ True или False; а также {TRUE} и {FALSE} 

 

{ ... =right ... } Правильный ответ для множественного выбора 

(множественный выбор? – см. комментарии страниц) или 

заполнение стандартного бланка 

{ ... ~wrong ... } Неправильный ответ для множественного выбора или 

множественный ответ 

{ ... =item -> match ... } Ответ для Вопросов на сопоставление 

#feedback text Ответ Обратная Связь для предшествующего Вопроса с 

множественным выбором, заполнения стандартного бланка или 

числового ответа 

####general feedback Общая Обратная Связь 

{# Начало числового ответа 

answer:tolerance Числовой ответ, принятый внутри ±области допустимых 

значений 

low..high Нижнее и верхнее значения области принятого числового 

ответа 

=%n%answer:tolerance n представляет «кредит» за одну из множественных числовых 

областей внутри допустимых значений за ответ 

} Конец ответа(ов) 

\character Обратный слэш «\» отменяет специальное значение ~, =, #, {, } 

и : 

\n Места, где перевод строки в тексте Вопроса, – пустые строки 

прерывают Вопросы 
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Here are some quick examples: 

// true/false 

::Q1:: 1+1=2 {T} 

// multiple choice with specified feedback for right and wrong answers 

 

::Q2:: What's between orange and green in the spectrum?  

{ =yellow # right; good! ~red # wrong, it's yellow ~blue # wrong, it's 

yellow } 

// fill-in-the-blank 

::Q3:: Two plus {=two =2} equals four. 

// matching 

::Q4:: Which animal eats which food? { =cat -> cat food =dog -> dog food 

} 

// math range question 

::Q5:: What is a number from 1 to 5? {#3:2} 

// math range specified with interval end points 

::Q6:: What is a number from 1 to 5? {#1..5} 

// translated on import to the same as Q5, but unavailable from Moodle 

question interface 

// multiple numeric answers with partial credit and feedback 

::Q7:: When was Ulysses S. Grant born? {# 

         =1822:0      # Correct! Full credit. 

         =%50%1822:2  # He was born in 1822. Half credit for being close. 

 

} 

// essay 

::Q8:: How are you? {} 

Format symbols explained 
The multiple choice format below as a comment line // for the question, 

when Moodle exports it the question unique id number will appear here. 

 

The first set of  :: precedes the question title. 

The second :: precedes the actual question. The first { indicates the start of 

the answers. The correct answer is preceded by an = sign and wrong 

answers by a ~. Teacher responses have a # in front of them. The question 

ends with a } and then a blank line. NOTE it is { } not ( ) parenthesis! 

Usually these are obtained with help of the [AltGr] key. 

 

 

 

Вот некоторые быстрые примеры: 

// true/false 

::Q1:: 1+1=2 {T} 

// Множественный выбор с указанной Обратной Связью для правильного и неправильного 

ответов 

::Q2:: Что расположено между оранжевым и зелёным в спектре? 

{ =жёлтый # правильно; хорошо! ~красный # неправильно, это жёлтый; ~голубой # 

неправильно, это жёлтый} 

// заполнение стандартного бланка 

::Q3:: Два плюс {=два =2} равно четырём. 

// Сопоставление 

::Q4:: Какое животное ест какую пищу? {=кошка -> кошачья пища =собака -> собачья 

пища} 

// Вопрос на соответствие области значений 

::Q5:: Какое число от 1 до 5? {#3:2} 

// Область соответствия, указанная конечными точками интервала 

::Q6:: Какое число от 1 до 5? {#1..5} 

// Переведённые по импорту к тем же самым, что и Q5, но недоступные из интерфейса 

вопросов Moodle 

// Множественные числовые ответы с частичным «Кредитом» и Обратной Связью. 

::Q7:: Когда родился 18-й Президент США Улисс Симпсон Грант? {# 

         =1822:0      # Правильно! Полный «кредит». 

        =%50%1822:2  # Он родился в 1822. Половина «Кредита» за близкий к правильному 

ответ. 

} 

// Эссе 

::Q8:: Как жизнь? {} 

Объяснённые символы форматирования 
Там, где ниже строкой комментариев // обозначен Вопрос формата 

множественного выбора, появится его уникальный идентификационный номер, когда 

Moodle экспортирует этот Вопрос. 

Первый набор :: предшествует заголовку Вопроса. 

Второй :: предшествует самому Вопросу. Первая { указывает на начало ответов. 

Правильному ответу предшествует знак =, а неправильным ответам предшествует ~. 

Отклики Преподавателя предваряются знаком # перед ними. Вопрос заканчивается знаком 

}, за которым следует пустая строка. Обратите внимание, это фигурные {}, а не круглые () 

скобки! Обычно они получаются с помощью ключа [AltGr]. 
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//Comment line  

::Question title  

:: Question { 

=A correct answer 

~Wrong answer1 

#A response to wrong answer1 

~Wrong answer2 

#A response to wrong answer2 

~Wrong answer3 

#A response to wrong answer3 

~Wrong answer4 

#A response to wrong answer4 

} 

The shortest format for a multiple choice question is: 

Question{= A Correct Answer ~Wrong answer1 ~Wrong answer2 ~Wrong 

answer3 ~Wrong answer4 } 

Tip: If you don't specify a question title the WHOLE question will be used 

as the title at the time of import into Moodle. There are pros and cons to 

allowing this to happen. 

 Cons: This can add a lot of unnecessary words. This can include 

characters which might confuse the export GIFT process. 

 Pros: On the other hand. if the start of each question is different, it 

can make finding a single question easier in a category list of 

questions. It will save you typing. Having the same title for every 

question is a very bad idea. 

4.6.6.3.2.Question format examples 
There are several ways to use a text editor to write a GIFT format. We will 

try to show the simple version for example and in some formats we will 

introduce some more complex features that can be imported into many 

Moodle Question formats. 

Multiple choice 
For multiple choice questions, wrong answers are prefixed with a tilde (~) 

and the correct answer is prefixed with an equal sign (=). 

Here is a simple acceptable GIFT multiple choice format: 

Who's buried in Grant's tomb?{=Grant ~no one ~Napoleon ~Churchill 

~Mother Teresa } 

 

 

 

//Строка комментариев  

::Заголовок Вопроса  

::Вопрос { 

=Правильный ответ 

~Неправильный ответ 1 

#Отклик на неправильный ответ 1 

~Неправильный ответ 2 

#Отклик на неправильный ответ 2 

~ Неправильный ответ 3 

# Отклик на неправильный ответ 3 

~ Неправильный ответ 4 

#Отклик на неправильный ответ 4 

} 

Вот формат краткого теста для Вопроса с множественным выбором: 

Вопрос{=Правильный ответ ~Неправильный ответ 1 ~Неправильный ответ 2 

~Неправильный ответ 3 ~Неправильный ответ 4} 

Совет: Если Вы не укажете заголовок Вопроса, то ЦЕЛЫЙ Вопрос будет 

использоваться в качестве заголовка во время импорта в Moodle. Есть за и против, чтобы 

это происходило. 

 Против: Это может добавить множество ненужных слов. Это может включить 

символы, которые могут конфликтовать с процессом экспорта GIFT. 

 За: С другой стороны. Если начала Вопросов различны, это поможет легче отыскать 

единственный Вопрос в списке Вопросов Категории. Это сэкономит работу на 

клавиатуре. Наличие того же самого заголовка для каждого Вопроса является очень 

плохой идеей. 

4.6.6.3.2.Примеры форматов Вопросов 
Есть несколько способов использования редактора текста, чтобы записать формат 

GIFT. Для примера мы попытаемся показать простейшую версию, и в некоторых форматах 

мы введем некоторые более сложные особенности, которые могут быть импортированы во 

многие форматы Вопросов Moodle.  

Множественный Выбор 
Для Вопросов с Несколькими Вариантами Ответов неправильные ответы 

предваряются тильдой (~), а правильному ответу предшествует знак равенства (=). 

Вот простой приемлемый формат Множественного Выбора GIFT: 

Кто похоронен в могиле Гранта?{= Грант~никто ~Наполеон ~Черчилль ~Мать Тереза} 
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Here is a longer format that uses most of the GIFT elements: 

// question: 1 name: Grants tomb 

::Grants tomb::Who is buried in Grant's tomb in New York City? { 

=Grant 

~No one 

#Was true for 12 years, but Grant's remains were buried in the tomb in 

1897 

~Napoleon 

#He was buried in France 

~Churchill 

#He was buried in England 

~Mother Teresa 

#She was buried in India 

} 

Multiple choice with multiple right answers 
That is, using checkboxes, not radio buttons: 

What two people are entombed in Grant's tomb? { 

~%-100%No one 

~%50%Grant 

~%50%Grant's wife 

~%-100%Grant's father 

} 

True-false 
In this question type the answer indicates whether the statement is true or 

false. The answer should be written as {TRUE} or {FALSE}, or 

abbreviated to {T} or {F}. 

// question: 0 name: TrueStatement using {T} style 

::TrueStatement about Grant::Grant was buried in a tomb in New York 

City.{T} 

// question: 0 name: FalseStatement using {FALSE} style 

::FalseStatement about sun::The sun rises in the West.{FALSE} 

Short answer 
Answers in Short Answer question-type are all prefixed by an equal sign 

(=), indicating that they are all correct answers. The answers must not 

contain a tilde. 

Here are two examples using the simple method showing possible right 

answers for credit. 

Who's buried in Grant's tomb?{=Grant =Ulysses S. Grant =Ulysses Grant} 

 

Вот более длинный формат, который использует большинство элементов GIFT: 

// Вопрос: 1 имя: могила Грантов 

::могила Грантов:: Кто похоронен в могиле Гранта в городе Нью Йорк? { 

=Грант 

~Никто 

#Было верно в течение 12 лет, но останки Гранта были захоронены в этой могиле в 1897 

году 

~Наполеон 

#Он похоронен во Франции 

~Черчилльl 

#Он похоронен в Англии 

~МатьТереза 

#Она похоронена в Индии 

} 

Множественный Выбор с Несколькими Правильными Ответами 
То есть, применение окошек-флажков, а не переключателей: 

Какие два человека похоронены в могиле Гранта? { 

~%-100%Никто 

~%50%Грант 

~%50%жена Грантаe 

~%-100%отец Гранта 

} 

Истина-Ложь 
В этом типе Вопроса ответ указывает, является ли утверждение истинным или 

ложным. Ответ должен быть написан как {TRUE} или {FALSE}, или сокращенно {T} или 

{F}. 

//Вопрос: 0 имён: ИстинноеУтверждение в стиле {T} 

::ИстинноеУтверждение о Гранте::Грант похоронен в могиле в городе Нью Йорк.{T} 

 

//Вопрос: 0 имён: ЛожноеУтверждение в стиле {FALSE} 

::ЛожноеУтверждение о Солнце::Солнце восходит на Западе.{FALSE} 

Краткий Ответ 
Ответы в типе Вопросов с Кратким Ответом все предваряются знаком равно (=), 

указывая, что все они – правильные ответы. Ответы не должны содержать тильду ~. 

 

Вот два примера использования простого метода показа возможных правильных 

ответов для «Кредита». 

Кто похоронен в могиле Грантов?{=Грант =Улисс С. Грант =Улисс Грант} 
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Two plus two equals {=four =4} 

If there is only one correct Short Answer, it may be written without the 

equal sign prefix, as long as it cannot be confused as True-False. 

 

Matching 
Matching pairs begin with an equal sign (=) and are separated by this 

symbol "->". There must be at least three matching pairs. 

Match the following countries with their corresponding capitals. { 

=Canada -> Ottawa 

=Italy  -> Rome 

=Japan  -> Tokyo 

=India  -> New Delhi 

} 

Matching questions do not support feedback or percentage answer weights. 

 

Missing word 
The Missing Word format automatically inserts a fill-in-the-blank line (like 

this _____) in the middle of the sentence. To use the Missing Word format, 

place the answers where you want the line to appear in the sentence. 

 

Moodle costs {~lots of money =nothing ~a small amount} to download 

from moodle.org. 

If the answers come before the closing punctuation mark, a fill-in-the-

blank line will be inserted for the "missing word" format. All question 

types can be written in the Missing Word format. 

There must be a blank line (double carriage return) separating questions. 

For clarity, the answers can be written on separate lines and even indented. 

Some examples: 

Mahatma Gandhi's birthday is an Indian holiday on { 

~15th 

~3rd 

=2nd 

} of October. 

Since { 

~495 AD 

  =1066 AD 

  ~1215 AD 

  ~ 43 AD } 

the town of Hastings England has been "famous with visitors". 

Два плюс два равно {=четыре =4} 

Если есть только один правильный Краткий Ответ, он может быть записан без 

префиксного знака равно = до тех пор, пока он не может быть перепутан с 

Вопросом типа Истина-Ложь. 

Согласование 
Согласованные пары начинаются со знака «равно» (=) и разделяются символом «-

>». Должно быть, по крайней мере, три пары соответствия. 

Сопоставить следующие страны с их столицами { 

=Канада -> Оттава 

=Италия -> Рим 

=Япония -> Токио 

=Индия -> Нью-Дели 

} 

Вопросы на сопоставление не поддерживают Обратную Связь или веса ответов в 

процентах. 

Пропущенное Слово 
Формат «Пропущенное Слово» автоматически вставляет черту заполнения 

стандартного бланка (как эта _____) посреди предложения. Чтобы использовать формат 

Пропущенного слова, поместите ответы там, где Вы хотите, чтобы эта черта появилась в 

предложении. 

Затраты Moodle {~много денег =никаких ~небольшая сумма} на загрузку с Сайта 

moodle.org. 

Если ответы размещены до завершающей отметки пунктуации, черта заполнения 

стандартного бланка будет вставлена для формата «Пропуск слова». Все типы вопросов 

могут быть созданы в формате Пропуска слова. 

Там должна быть пустая строка (двойной возврат каретки), разделяющая Вопросы. Для 

ясности, ответы могут быть записаны на отдельных строках и даже с отступом. Вот 

некоторые примеры: 

День рождения Махатмы Ганди индийский праздник { 

~15-го 

~3-го 

=2-го 

} Октября. 

С { 

~495 года н.э. 

=1066 года н.э. 

~1215 года н.э. 

~43 года н.э. } 

город Гастингс Англии был "знаменит посетителями". 
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Numerical questions 
The answer section for Numerical questions must start with a number sign 

(#). Numerical answers can include an error margin, which is written 

following the correct answer, separated by a colon. So for example, if the 

correct answer is anything between 1.5 and 2.5, then it would be written as 

follows {#2:0.5}. This indicates that 2 with an error margin of 0.5 is  

correct (i.e., the span from 1.5 to 2.5). If no error margin is specified, it 

will be assumed to be zero. 

Here is a simple numerical format question. It will accept a range of 5 

years. 

When was Ulysses S. Grant born? {#1822:5} 

It is a good idea to check the margins of the range, 3.141 is not counted as 

correct and 3.142 is considered in the range. 

What is the value of pi (to 3 decimal places)? {#3.14159:0.0005}. 

Optionally, numerical answers can be written as a span in the following 

format {#MinimumValue..MaximumValue}. 

What is the value of pi (to 3 decimal places)? {#3.141..3.142}. 

Moodle's browser interface does not support multiple numerical answers, 

but Moodle's code can and so does GIFT. This can be used to specify 

numerical multiple spans, and can be particularly usefully when combined 

with percentage weight grades. If multiple answers are used, they must be 

separated by an equal sign, like short answer questions. 

When was Ulysses S. Grant born? {# 

   =1822:0 

   =%50%1822:2 

} 

Note that since Moodle's browser GUI didn't support multiple answers for 

Numerical questions, there's no way in older  

Moodle versions to see them or edit them through Moodle. The only way 

to change a numerical answer beyond the first, is to delete the question and 

re-import it (or use something like phpMyAdmin). But better would be to 

upgrade your Moodle to at least 1.9. 

Essay 
An essay question is simply a question with an empty answer field. 

Nothing is permitted between the curly braces at all. 

Write a short biography of Dag Hammarskjöld. {} 

 

 

Числовые Вопросы 
Раздел ответа в Числовом Вопросе должен начинаться со знака номер (#). 

Числовые Ответы могут включать Погрешность, которая пишется после правильного 

ответа и отделяется двоеточием. Так например, если правильный ответ находится в 

пределах от 1,5 до 2,5, то это будет записано так: {#2:0.5}. Это означает, что 2 с допуском 

0.5 является правильным (то есть, в промежутке от 1,5 до 2,5). Если погрешность не 

указана, она будет считаться равной нулю. 

 

Вот Вопрос Простого Числового Формата. Он принимает область из 5 лет. 

 

Когда родился Улисс Симпсон Грант? {#1822:5} 

Это хорошая идея, чтобы проверять допустимые пределы диапазона, 3,141 не 

считается правильным, а 3.142 считается принадлежащим диапазону. 

Каково значение числа Пи (до 3 десятичных знаков)? {#3.14159:0.0005}. 

По выбору Числовые Ответы могут быть записаны в виде интервала в следующем 

формате {# Минимальное значение .. Максимальное значение}. 

Каково значение числа Пи (до 3 десятичных знаков)? {#3.141..3.142}. 

Интерфейс браузера Moodle не поддерживает Множественные Числовые Ответы, 

но код Moodle может, и GIFT также. Это может использоваться, чтобы указать 

Числовые Множественные Интервалы, и может быть особенно полезным в сочетании 

Весами Оценок в процентах. Если используются Множественные Ответы, они должны 

быть разделены знаком равенства, как Краткие ответы. 

Когда родился Улисс С. Грант? {# 

   =1822:0 

   =%50%1822:2 

} 

Заметьте, что с тех пор, как графический интерфейс (GUI) браузера Moodle не 

поддерживает Множественные Ответы для Числовых Вопросов, нет никакого способа в 

более старых версиях Moodle увидеть или отредактировать их через Moodle. 

Единственный способ изменить Числовой Ответ за пределами первой версии, заключается 

в удалении Вопроса и повторного импортирования его (или использовать что-то вроде 

phpMyAdmin). Но лучше было бы обновить Moodle, по крайней мере, до версии 1,9. 

Эссе 
Вопрос типа «Эссе» – просто Вопрос с пустым полем ответа. Ничего не 

допускается между фигурными скобками вообще. 

Напишите краткую биографию Генерального секретаря ООН Дага Яльмара Агне Карла 

Хаммаршельда. {} 
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Description 
A description "question" has no answer part at all 

You can use your pencil and paper for these next math questions. 

 

4.6.6.3.3.Options 
In addition to these basic question types, this filter offers the following 

options: line comments, question name, feedback and percentage answer 

weight. 

Line Comments 
Comments that will not be imported into Moodle can be included in the 

text file. This can be used to provide headers or more information about 

questions. All lines that start with a double backslash (not counting tabs or 

spaces) will be ignored by the filter. 

// Subheading: Numerical questions below 

What's 2 plus 2? {#4} 

Comments will be exported from Moodle and will include the unique 

question id. The above question after it was imported and then exported 

from Moodle: 

// question: 914  name: What's 2 plus 2?  

::What's 2 plus 2?::What's 2 plus 2?{# 

    =4:0#} 

Question Name 
A question name can be specified by placing it first and enclosing it within 

double colons (::...::). 

::Kanji Origins::Japanese characters originally 

came from what country? {=China} 

 

::Thanksgiving Date::The American holiday of Thanksgiving is  

celebrated on the {~second ~third =fourth} Thursday of November. 

If no question name is specified, the entire question will be used as the 

name by default. 

Feedback 
Feedback can be included for each answer by following the answer with a 

number sign (# also known as a hash mark) and the feedback. 

 

 

 

 

Описание 
«Вопрос» типа «Описание» совсем не имеет части «ответ». 

Вы можете использовать свой карандаш и бумагу для последующих математических 

Вопросов. 

4.6.6.3.3.Опции 
В дополнение к этим основным типов Вопросов, этот фильтр предлагает следующие 

опции: Комментарии строк, название Вопроса, Обратную Связь и Веса Ответов в 

процентах. 

Комментарии строк 
Комментарии, которые не будут импортированы в Moodle, могут быть включены в 

текстовый файл. Это может быть использовано, чтобы обеспечить заголовки или 

дополнительную информацию о Вопросах. Все строки, начинающиеся с двойного 

обратного слэша (не считая табуляции или пробелов) будут игнорироваться фильтром. 

//Подзаголовок: Числовые Вопросы ниже 

Сколько будет 2 плюс 2? {#4} 

Комментарии будут экспортированы из Moodle и будут включать в себя уникальный 

идентификатор Вопроса. Вопрос выше после того, как он будет импортирован, а затем 

экспортирован из Moodle, будет выглядеть так: 

//Вопрос:914 название: Сколько будет 2 плюс 2? 

:: Сколько будет 2 плюс 2?::Сколько будет 2 плюс 2?{# 

    =4:0#} 

Название Вопроса 
Название Вопроса может быть указано размещением его первым и заключением 

его внутри двойных двоеточий (::..::). 

::Истоки японской иероглифической системы записи:: Японские символы сначала пришли 

из какой страны? {=Китай} 

 

::Дата Благодарения::Американский праздник «День Благодарения» отмечается в четверг 

{~второго ~третьего =четвёртого} ноября. 

Если название Вопроса не указано, весь вопрос будет использоваться в качестве 

названия по умолчанию. 

Обратная Связь 
Обратная Связь может быть включена за каждый ответ, размещением за этим 

ответом со знаком номера (# также известный как символ решетки) и обратной связью. 
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What's the answer to this multiple-choice question? { 

~wrong answer#feedback comment on the wrong answer 

~another wrong answer#feedback comment on this wrong answer 

=right answer#Very good! 

} 

//From The Hitchhiker's Guide to the Galaxy 

Deep Thought said " { 

  =forty two#Correct according to The Hitchhiker's Guide to the Galaxy! 

 

  =42#Correct, as told to Loonquawl and Phouchg 

  =forty-two#Correct! 

}  is the Ultimate Answer to the Ultimate Question of Life, The Universe, 

and Everything." 

   42 is the Absolute Answer to everything.{ 

FALSE#42 is the Ultimate Answer.#You gave the right answer.} 

 

For Multiple Choice questions, feedback is displayed only for the answer 

the student selected. For short answer, feedback is shown only when 

students input the corresponding correct answer. For true-false questions, 

there can be one or two feedback strings. The first is shown if the student 

gives the wrong answer. The second if the student gives the right answer. 

Percentage Answer Weights 
Percentage answer weights are available for both Multiple Choice and 

Short Answer questions. Percentage answer weights can be included by 

following the tilde (for Multiple Choice) or equal sign (for Short Answer) 

with the desired percent enclosed within percent signs (e.g., %50%). This 

option can be combined with feedback comments. 

Difficult question.{~wrong answer ~%50%half credit answer =full credit 

answer} 

::Jesus' hometown::Jesus Christ was from { 

   ~Jerusalem#This was an important city, but the wrong answer. 

   ~%25%Bethlehem#He was born here, but not raised here. 

   ~%50%Galilee#You need to be more specific. 

   =Nazareth#Yes! That's right! 

}. 

 

::Jesus' hometown:: Jesus Christ was from { 

   =Nazareth#Yes! That's right! 

   =%75%Nazereth#Right, but misspelled. 

   =%25%Bethlehem#He was born here, but not raised here. } 

Какой ответ на этот Вопрос со Множественным Выбором Ответов? { 

~неправильный ответ#Комментарии Обратной Связи к неправильному ответу 

~другой неправильный ответ#Комментарии Обратной Связи к этому неправильному ответу 

=правильный ответ#Очень хорошо! 

} 

//В «Автостопе по Галактике»      ?????????? 

высказана глубокая мысль «{      ?????????? 

  =сорок два#Correct according to The Hitchhiker's Guide to the  ?????????? 

Galaxy! 

  =42#Correct, as told to Loonquawl and Phouchg   ?????????? 

  =forty-two#Correct! 

} is the Ultimate Answer to the Ultimate Question of Life, The   ?????????? 

Universe, and Everything.» 

   42 is the Absolute Answer to everything.{    ?????????? 

FALSE#42 is the Ultimate Answer.#You gave the right    ?????????? 

answer.} 

Для Вопросов со Множественным Выбором, Обратная Связь отображается только 

для ответа, выбранного Студентом. Для Краткого ответа Обратная Связь отображается 

только когда Студент введёт соответствующий правильный ответ. Для вопросов 

Истина/ложь, может быть одна или две строки Обратной Связи. Первая показывается, если 

Студент даёт неправильный ответ. Вторая, если Студент даёт правильный ответ. 

Веса ответов в процентах 
Веса ответов в процентах доступны для Вопросов с Множественным Выбором и 

Кратких Ответов. Веса Ответов в процентах могут быть включены после знака тильды 

(для Множественного Выбора) или знака равенства (для Краткого ответа) с желаемым 

процентом Веса за Ответ, заключённым в знаки процента (например, %50%). Эта опция 

может быть скомбинирована с комментариями Обратной Связи. 

Сложный вопрос. {~Неправильный ответ ~%50% ответ оценивается в половину 

=полный «Кредит» за ответ} 

::Родной город Иисуса::Иисус Христос был из{ 

~Иерусалима# Это был важный город, но ответ неправилен. 

 

~%25%Вифлеем#Он здесь родился, но не вырос. 

~%50%Галиция#Вам нужно быть более конкретным. 

=Назарет#Да! Это правильно! 

}. 

::Родной город Иисуса::Иисус Христос был из{ 

=Назарет#Да! Это правильно! 

=%75%Назарет#Да, но с ошибками. 

=%25%Вифлеем#Он здесь родился, но не вырос. } 
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Note that the last two examples are essentially the same question, first as 

multiple choice and then as short answer. 

Note that it is possible to specify percentage answer weights that are NOT 

available through the browser interface. The Match Grades drop-down on 

the import page determines how these are handled. You can either request 

that an error be reported or that the answer weight be adjusted to the 

nearest valid answer weight. 

Specify text-formatting for the question. The question text (only) may have 

an optional text format specified. Currently the available formats are 

moodle (Moodle Auto-Format), html (HTML format), plain (Plain text 

format) and markdown (Markdown format). The format is specified in 

square brackets immediately before the question text. See Formatting text 

for further information. 
 

[markdown]The *American holiday of Thanksgiving* is celebrated on the 

{ 

   ~second 

   ~third 

   =fourth 

} Thursday of November. 

Multiple Answers 
The Multiple Answers option is used for multiple choice questions when 

two or more answers must be selected in order to obtain full credit. The 

multiple answers option is enabled by assigning partial answer weight to 

multiple answers, while allowing no single answer to receive full credit. 

 

What two people are entombed in Grant's tomb? { 

   ~No one 

   ~%50%Grant 

   ~%50%Grant's wife 

   ~Grant's father 

} 

Note that there is no equal sign (=) in any answer and the answers should 

total no more than 100%, otherwise Moodle will return an error. To avoid 

the problem of students automatically getting 100% by simply checking all 

of the answers, it is best to include negative answer weights for wrong 

answers. 

What two people are entombed in Grant's tomb? { 

   ~%-50%No one 

Обратите внимание, что последние два примера являются, по существу, тем же 

Вопросом, сначала в качестве Множественного Выбора, а затем, как Краткого ответа. 

Заметьте, что можно указать веса ответа в процентах, которые НЕ доступны через 

интерфейс браузера. Ниспадающее меню Равных по Силе Оценок на странице импорта 

определяет, как они обрабатываются. Вы можете либо потребовать, чтобы об ошибке было 

сообщено, или чтобы вес ответа был установлен в соответствии с ближайшим 

действительным весом ответа. 

Укажите форматирование текста для Вопроса. Тексту (только) Вопроса можно 

указать по выбору формат текста. В настоящее время доступными форматами являются 

moodle (Авто-формат Moodle), HTML (формат HTML), plain (Простой формат текста) и 

уценки (формат уценки). Формат определяется в квадратных скобках перед текстом 

Вопроса. См. «Форматирование текста» для получения дополнительной информации. 

 
[markdown – облегчённый язык разметки]. 

[markdown]*Американский праздник Благодарения* 

празднуется во { 

~второй 

~третий 

=четвёртый 

}четверг ноября. 

Множественные Ответы 
Опция «Множественные Ответы» используется для 

Вопросов с Множественным Выбором, когда два или более ответов должны быть выбраны 

для того, чтобы получить полный «кредит». Опция «Множественные Ответы» позволяется 

посредством назначения Частичного Веса Ответам с Множественным Выбором, в то же 

время не позволяя ни за какой единственный ответ получить полный «кредит». 

Какие два человека похоронены в могиле Гранта? { 

~никакие 

~%50%Грант 

~%50%Жена Гранта 

~Отец Гранта 

} 

Заметьте, что ни в одном из ответов нет знака равенства (=) и ответы в сумме не 

должны превышать 100%, в противном случае Moodle выдаст ошибку. Чтобы избежать 

проблемы автоматического получения Студентами 100%, путём пометки сразу всех 

ответов, лучше включить отрицательные веса для неправильных вариантов ответов. 

 

Какие два человека похоронены в могиле Гранта? { 

~%-50%никакие 
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   ~%50%Grant 

   ~%50%Grant's wife 

   ~%-50%Grant's father } 

Special Characters ~ = # { } 
These symbols ~ = # { } : control the operation of this filter and cannot be 

used as normal text within questions. Since these symbols have a special 

role in determining the operation of this filter, they are called "control 

characters." But sometimes you may want to use one of these characters, 

for example to show a mathematical formula in a question. The way to get 

around this problem is "escaping" the control characters. This means 

simply putting a backslash (\) before a control character so the filter will 

know that you want to use it as a literal character instead of as a control 

character. For example: 

Which answer equals 5? { 

   ~ \= 2 + 2 

   = \= 2 + 3 

   ~ \= 2 + 4 

} 

 

::GIFT Control Characters:: 

Which of the following is NOT a control character for the GIFT import 

format? { 

  ~ \~     # \~ is a control character. 

  ~ \=     # \= is a control character. 

  ~ \#     # \# is a control character. 

  ~ \{     # \{ is a control character. 

  ~ \}     # \} is a control character. 

  = \      # Correct! \ (backslash) is not a control character. BUT, 

             it is used to escape the control characters. 

} 

When the question is processed, the backslash is removed and is not saved 

in Moodle. 

Specifying Categories 
It is possible to change the category into which the questions are added 

within the GIFT file. You can change the category as many times as you 

wish within the file. All questions after the modifier up to the next modifier 

or the end of the file will be added to the specified category. Up to the first 

category modifier the category specified on the import screen will be used. 

Note that for this to work the from file: box must be 

~%50%Грант 

~%50%Жена Гранта 

~%-50%Отец Гранта } 

Специальные символы ~ = # { } 
Эти символы ~ = # {}: управляют работой этого фильтра и не могут быть использованы 

как обычный тест внутри Вопроса. С тех пор, как эти символы имеют специфическую 

роль в определении работы этого фильтра, они называются «управляющими». Но иногда 

вы можете захотеть использовать один из этих символов, например, чтобы показать 

математическую формулу в Вопросе. Способ обойти эту проблему является «пропуск» 

управляющих символов. Это означает, что простое помещение обратной косой черты (\) 

перед управляющим символом известит фильтр о том, что вы хотите использовать его как 

буквенный символ, а не как управляющий символ. Например: 

 

Какой ответ равен 5? { 

~ \= 2 + 2 

= \= 2 + 3 

~ \= 2 + 4 

} 

 

::Управляющие символы GIFT:: 

Какие из следующих символов НЕ являются управляющими для формата импорта GIFT? { 

 

~\~     #\~ – управляющий символ. 

~\=     #\= – управляющий символ. 

~\#     #\# – управляющий символ. 

~\{     #\{ – управляющий символ. 

~\}     #\} – управляющий символ. 

=\      # Правильно! \ (обратный слэш) – не управляющий символ. НО, он используется для 

того, чтобы избежать трактовки других символов управляющими. 

} 

При обработке Вопроса обратный слэш удаляется и не сохраняется в Moodle. 

 

Указание Категорий 
Можно изменить Категорию, в которую помещаются Вопросы в файл GIFT. Вы 

можете изменить Категорию столько раз, сколько вы хотите внутри файла. Все Вопросы 

после модификатора вплоть до следующего модификатора или конца файла будут 

добавлены в указанную Категорию. До модификатора первой Категории будет 

использоваться категория, указанная на экране импорта. Обратите внимание, что для этой 

работы из файла: должен быть 
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ticked on the import screen. 

To include a category modifier include a line like this (with a blank line 

before and after): 

$CATEGORY: tom/dick/harry 

or simply 

$CATEGORY: mycategory 

...the first example specifies a path of nested categories. In this case the 

questions will go into harry. The categories are created if they do not exist. 

To find out how your categories are organized, you might try exporting 

some questions including category data first and check the exported GIFT 

formatted file. The lowest level of system context might give you 

something like $CATEGORY: $system$/.... 

Making questions case sensitive 
Short Answer questions can be made case sensitive by changing "0" to "1" 

in the following line of your moodle/question/format/gift/format.php 

file: 

$question->usecase = 0; // Ignore case 

4.6.6.3.4.Hints and Tips 
 Use the ::title:: at the beginning of every question to organize your 

questions when Moodle presents a list or exports them as another GIFT 

file. When the title is left blank, Moodle will put the beginning of the 

question as the title. Some teachers want to see something like "001 

LIT101 Poe ref Purloin Letter" or "The Purloin Letter was written by 

(AmLit pg 254)" in the title. 

 You can specify markup if you need to format the question by setting 

[html], [moodle], [plain] or [markdown] just before the question text. 

See more about this in the reference pdf below. 

 In the Lesson module, in a question page, correct answers jump by 

default to Next page and incorrect answers jump to This page (i.e. 

student has to "try again"). When importing from a GIFT format file, 

this is exactly the mechanism which is used. 

 

 

 

 

 

 

 

 

помечен на экране импорта. 

Чтобы включить категорию, модификатор включает такую строку (с пустой 

строкой до и после): 

$CATEGORY: Том/Дик/Гарри 

или просто 

$CATEGORY: моя категория 

... первый пример конкретизирует путь из вложенных Категорий. В этом случае Вопросы 

будут идти к Гарри. Если Категории не существуют, они создаются, 

Чтобы узнать, как ваши Категории организованы, вы можете попробовать 

экспортировать некоторые Вопросы, включающие первые данные Категории, и проверить 

экспортированный файл в формате GIFT. Самый низкий уровень системного Контекста 

может дать вам что-то вроде $CATEGORY: $system$/.... 

Создание Вопросов, чувствительных к регистру 
Вопросы типа «Краткий ответ» можно сделать чувствительными к регистру путём 

изменения «0» на «1» в следующей строке вашего moodle/question/format/gift/format.php 

file: 

$question→usecase = 0; //Игнорировать регистр 

4.6.6.3.4.Советы и трюки 
 Используйте ::Заголовок:: в начале каждого Вопроса, чтобы организовать ваши 

Вопросы, когда Moodle представляет список или экспортирует их как ещё один файл 

GIFT. Когда заголовок оставляется пустым, Moodle устанавливает начало Вопроса в 

качестве заголовка. Некоторые Преподаватели хотят видеть в названии нечто-то 

подобное «001 Лит101 Точка входа для считывания письма» или «Считанное письмо 

было написано (АмЛит стр. 254)». 

 Вы можете указать разметку, если вам нужно отформатировать Вопрос, установив 

[html], [moodle], [plain] или [markdown] непосредственно перед текстом вопроса. 

Подробнее об этом в справочнике в формате pdf ниже. 

 В модуле Урок, на странице Вопросов, правильные ответы по умолчанию переводят на 

Следующую страницу, а неправильные ответы оставляют на Этой странице (т.е. 

Студент должен «попробовать ещё раз»). Именно этот механизм используется при 

импорте из файла формата GIFT. 
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 If you want a student to be taken directly from one question to the next 

irrespective of their answer being correct or incorrect: in the Lesson 

Settings, set Maximum number of attempts: to 1. 

 

 Please note, however, that a message "correct / incorrect" will still 

be displayed to the student upon answering each question. If you do 

not want this (default) feedback message to be displayed then enter 

your own feedback message (i.e. "continue", "---", etc.). 

 

 In case you want no visible message displayed then enter a non-

breaking space as feedback. Moodle will not put it's automatic 

response because it sees the blank space. To do this, put a # after the 

answer and write Nbsp.png (without spaces between these 

characters). 

 Need to use a special GIFT character in your question or answer? Put a 

\ in front of the GIFT character. 

 For example if you want to use curly braces, { or }, or equal sign, =, 

or # or ~ in a GIFT file (in a math question including TeX 

expressions) you must "escape" them by preceding them with a \ 

directly in front of each { or } or =. It is possible to use a replace 

program/macro/editor filter to do this conversion before importing to 

Moodle. 

 Want to change T/F type questions to multiple choice? Consider 

exporting the T/F questions as a GIFT file, then using a text editor to 

replace the (T) with (=True ~False). Perhaps change the title slightly so 

you will recognize the new questions. 

 Alphabetic case-sensitive comparison is disabled by default. If you need 

case-sensitive comparison for short answer questions (an unusual need), 

precede them with: 

  $question->usecase = 1; 

surrounded by blank lines. 

4.6.6.3.5.Word processor and spreadsheet tools 
that create GIFTs 
Several contributors have used macros to generate GIFT files from a more 

familiar popular programs. 

 There are Word macros available for easily creating GIFT files. See 

Broken link Moodle4Teachers for downloads and instructions for use. 

 

 

 Если вы хотите, чтобы Студент переходил от одного Вопроса непосредственно к 

следующему независимо от того правилен или неправилен его ответ: в настройках 

Урока установите Maximum number of attempts (максимальное количество попыток) 

равным 1. 

 Всё же, пожалуйста, обратите внимание на то, что сообщение 

«правильно/неправильно» будет по-прежнему отображаться Студенту после ответа 

на каждый Вопрос. Если вы не хотите отображения такого сообщения (по 

умолчанию) Обратной Связи, тогда введите свой текст сообщения Обратной Связи 

(например, «продолжить», «---», и т.д.). 

 В случае, если вы не хотите никакого отображения сообщений, тогда введите 

неразрывный пробел в качестве Обратной Связи. Moodle не будет автоматически 

вставлять свой ответ, потому что увидит пустое пространство. Чтобы сделать это, 

поставьте знак # после ответа и напишите Nbsp.png (без пробелов между этими 

символами). 

 Необходимо использовать специальной символ GIFT в вашем Вопросе или ответе? 

Поставьте обратный слэш «\» перед символом GIFT. 

 Например, если вы хотите использовать фигурные скобки, { или }, или знак 

равенства =, или знак номера #, или знак тильды ~ в файле GIFT (включая в 

математический Вопрос TeX выражения), вы должны «устранить» их 

специализацию, поставив непосредственно перед каждым знаком { или }, или = знак 

\. Можно использовать фильтр замены программы/макро/редактора, чтобы сделать 

это преобразование перед импортом в Moodle. 

 Хотите изменить Вопросы типа T/F на множественный выбор? Рассмотрите 

экспортирование вопросов T/F в файл GIFT, затем используйте текстовый редактор, 

чтобы заменить (T) с (=True ~ False). Может быть, слегка изменить название, чтобы вы 

распознавали новые Вопросы. 

 По умолчанию регистр букв различается. Если вам нужен учёт регистра для Вопросов с 

кратким ответом (необычная потребность), предваряйте их оператором: 

 

$question→usecase=1; 

окружённом пустыми строками. 

4.6.6.3.5.Инструментарий текстового процессора и 
электронной таблицы, который создаёт GIFTы 

Некоторые независимые разработчики используют макросы для генерации файлов 

GIFT из более известных популярных программ. 

 Существуют доступные макросы Word для создания файлов GIFT. См. Broken link 

Moodle4Teachers для загрузки  и инструкций по использованию. 

http://www.moodleschool.co.nz/mod/resource/view.php?id=83
http://www.moodleschool.co.nz/mod/resource/view.php?id=83
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 There are several Excel spreadsheets for generating GIFT files. Several 

people have built upon other contributors work. 

 The latest version was posted on 10 April 2007 and can be found in 

this thread with this file name: Excel2GIFTv1.1.zip by Timothy 

Takemoto. There is also a set of instructions 

Excel2GIFTv1.1_Instructions.rtf by Jeff Shek on the same day in 

that thread. 

 video tutorial for using Excel2GIFTv2.xls 

 An earlier version of this Excel spreadsheet for generating multiple 

choice GIFT files initially created by Olga Forlani and improved by 

A. T. Wyatt. 

 There is a project, Libre Office templates, for generating GIFT files in 

Writer. It is located in 

OOo template 2013 to write exams and convert to GIFT format 

 There are Open Office templates for generating GIFT files in Writer. 

These are located in the Quiz forum in the OOo template to write exams 

and convert to GIFT format thread. 

 The most recent for OO 2.x is "OOo2GIFT_Template_05.zip" 

posted 17 December 2005 by Enrique Castro. 

 An earlier version is "GIFT_template_OOo.zip" posted 22 March 

2005 by Enrique Castro. 

 There is an easy to use on line multiple question generator at a4esl.org. 

Here you write your question(s) without formating marks, select 

Moodle and press the generate quiz button. This creates GIFT formatted 

text that can be pasted into a file for importing into Moodle. 

 

 The initial format requires fewer keystrokes (it uses line position and 

returns) than the GIFT format, so you should save time and be less 

likely to create invalid data. 

 Quiz authoring template for Microsoft Word link 

 Moodle XML Converter [1] 

 GIFT format parser library in Ruby [2] 

4.6.6.3.6.See also 
 Here is a 2-column PDF GIFT Reference Sheet 

 Import and export FAQ 

 Aiken Format 

4.6.6.3.7.External links 
 Formatting quizzes in GIFT format 

 Google Summer of Code 2010 Proposal: GIFT Conversion 

 Существует несколько электронных таблиц Excel для генерации файлов 

GIFT.Некоторые строят на основе других предлагаемых работ. 

 Последняя версия была размещена 10 апреля 2007 года и может быть найдена в этом 

потоке с таким именем файла: Excel2GIFTv1.1.zip by Timothy Takemoto. Существует 

также набор инструкций Excel2GIFTv1.1_Instructions.rtf от Джеффа Ши в тот же 

день в этом потоке. 

 

 Видео руководство по использованию Excel2GIFTv2.xls. 

 Ранняя версия этой электронной таблицы Excel для генерации файлов GIFT 

множественного выбора первоначально созданная Ольгой Форлани и улучшена A.T. 

Вайетом. 

 Имеется проект «Шаблоны Libre Office» для генерации файлов GIFT в Writer. 

Он размещён в «Шаблон 2013 ООо для записи экзаменов и преобразования в формат 

GIFT». 

 Существуют шаблоны Open Office для генерации файлов GIFT в Writer. Они 

размещаются на форуме «Экзамен» в шаблоне OOo для записи экзаменов и 

конвертирования в поток форматов GIFT. 

 Самой последней версией для ОО 2.x является «OOo2GIFT_Template_05.zip», 

размещённой 17 декабря 2005 Энрике Кастро. 

 Более раннюю версию «GIFT_template_OOo.zip» Энрике Кастро разместил 22 марта 

2005. 

 Существует простой в использовании в режиме онлайн генератор Вопросов с 

множественным выбором на a4esl.org. Здесь вы пишете свой Вопрос(ы) без знаков 

форматирования, выбираете Moodle и нажимаете кнопку «генерировать Экзамен». Это 

создаёт форматированный текст GIFT, который может быть вставлен в файл для 

импорта в Moodle. 

 Начальный формат требует меньше раз нажать на клавиши (он использует положение 

строки и возвращается), чем формат GIFT, так что вы должны сэкономить время и с 

меньшей вероятностью создавать неверные данные. 

 Шаблон авторского Экзамена для ссылки на Microsoft Word. 

 Конвертер Moodle XML [1]. 

 Библиотека синтаксических анализаторов формата GIFT языка сценариев Ruby [2]. 

4.6.6.3.6.См. также 
 Здесь 2-х колонный перечень документов по стандартизации GIFT в формате PDF. 

 Часто задаваемые вопросы по импорту и экспорту. 

 Формат Aiken. 

4.6.6.3.7.Внешние ссылки 
 Форматирование Экзаменов в формат GIFT. 

 Свод предложений лета 2010 года от Гугол по конвертации GIFT. 

http://moodle.org/mod/forum/discuss.php?d=66660
http://video.google.com/videoplay?docid=-6612645502883459334
http://moodle.org/mod/forum/discuss.php?d=45245
http://moodle.org/mod/forum/discuss.php?d=45245
http://moodle.org/mod/forum/discuss.php?d=45245
http://a4esl.org/c/qw.html
http://moodle.org/mod/data/view.php?d=13&rid=578
http://vletools.com/
http://github.com/stuart/gift-parser
http://buypct.com/gift_reference.pdf
http://docs.moodle.org/25/en/Import_and_export_FAQ
http://docs.moodle.org/25/en/Aiken_Format
http://www.kingsley.k12.mi.us/documents/gift_format.pdf
http://en.wikiversity.org/wiki/Google_Summer_of_Code_2010_Proposal:_GIFT_Conversion
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4.6.6.4.Moodle XML format 
The XML Format is a Moodle-specific format for importing and exporting 

questions to be used with the Quiz module. The format has been developed 

within the Moodle Community but other software may support it to a 

greater or lesser degree. 

4.6.6.4.1.A word about validity (and CDATA) 
 
The XML parser assumes that the XML file is well formed and does not 

detect or report errors. If it is not you are very likely to get unexpected 

errors. If you are hand-coding the XML file it is 

strongly recommended that you pass it through some sort of XML verifier 

before importing into Moodle. A simple way to  

do this is to open the XML file using Firefox or Internet Explorer. 

Note particularly that embedded HTML fragments should be within 

CDATA sections. CDATA example: 

<questiontext format="html"> 

       <text><![CDATA[ 

Now I can include <strong>any</strong> HTML that I<br /> wish. 

Without the CDATA, the <i>HTML</i> tags would break the 

XML!! 

]]> 

        </text> 

 </questiontext> 

4.6.6.4.2.Overall structure of XML file 
The file is enclosed by tags as follows. It is important to make sure the 

xml-line is really the first line of the file. A blank first line turns your 

otherwise compliant file into a source of frustration. 

<?xml version="1.0" ?> 

<quiz> 

 . 

 . 

 . 

</quiz> 

Within the <quiz> tags are any number of <question> tags. One of these 

<question> tags can be a dummy question with a category type to specify a 

category for the import/export. 

 

 

4.6.6.4.Формат Moodle XML 
Формат XML – специфический формат Moodle для импорта и экспорта Вопросов, 

который используется модулем «Экзамен» (п. 4.3.10). Этот формат был разработан 

содружеством Moodle, но и другое программное обеспечение может поддерживать его в 

большей или меньшей степени. 

4.6.6.4.1.Слово о достоверности (и символьных данных 
CDATA) 

Синтаксический анализатор XML предполагает, что файл XML сформирован 

безошибочно, и не обнаруживает ошибки и не сообщает о них. Если это не так, вы 

наверняка получите неожиданные ошибки. Если вы кодируете файл XML вручную, 

настоятельно рекомендуется, чтобы вы пропустили его через некоторый верификатор 

XML перед тем, как импортировать в Moodle. Простой способ осуществить это 

заключается в открытии файла XML с помощью браузера Firefox или Internet Explorer. 

Заметьте, в частности, что встроенные фрагменты HTML будут внутри разделов 

символьных данных CDATA (http://en.wikipedia.org/wiki/CDATA). 

<questiontext format="html"> 

       <text><![CDATA[ 

Сейчас я могу включить<strong>любой</strong> HTML, который я <br /> желаю. Без 

CDATA, теги<i>HTML</i>будут XML выброшены!! 

 

]]> 

        </text> 

 </questiontext> 

4.6.6.4.2.Общая структура файла XML 
Это файл, заключённый в теги, как показано далее. Важно убедиться, что строка 

xml действительно первая строка этого файла. Иначе, пустая первая строка превратит ваш 

соответствующий файл в источник разочарования. 

<?xml version="1.0" ?> 

<quiz> 

 . 

 . 

 . 

</quiz> 

Внутри тегов <quiz> находится любое количество тегов <question>. Один из этих 

тегов <question> может быть макетным Вопросов с типом Категории, чтобы указать 

Категорию для импорта/экспорта. 

http://en.wikipedia.org/wiki/CDATA
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<question type="category"> 

    <category> 

        <text>$course$/XXXX</text> 

    </category> 

</question> 

Where XXXX is the new category name. If the category exists, the 

question(s) will be added to the existing course; otherwise a  

new category will be created. This only works if you have "Get category 

from file" checked. 

Multiple categories can be specified in the same file. Just add another 

dummy 'category' question each time you would like to establish a new 

category and the questions that follow it will be placed there. 

The file must be encoded in UTF8 

Moodle XML import and export are balanced in functionality, so if you 

need to understand the format you can simply create some questions and 

export them to see what it looks like. 

4.6.6.4.3.Tags common to all question types 
A question is written as follows. 

<question 

type="multichoice|truefalse|shortanswer|matching|cloze|essay|numerical|descri

ption"> 

     <name> 

         <text>Name of question</text> 

     </name> 

     <questiontext format="html"> 

         <text>What is the answer to this question?</text> 

     </questiontext> 

</question> 

"Format" selects the Formatting options for the question text. The options 

are html (the default), moodle_auto_format,  

plain_text and markdown. The choice effects the way in which the text 

will be displayed. 

Further tags, which usually include at least one <answer> tag, 

follow in the space marked with dots as child nodes to the <question> tag. 

The response-related tags are listed further down on this page. Various 

(optional?) tags are possible. 

 penalty 

 generalfeedback 

 defaultgrade 

 hidden 

<question type=”category”> 

    <category> 

        <text>$course$/XXXX</text> 

    </category> 

</question> 

Здесь XXXX – название новой Категории. Если эта Категория существует, 

Вопрос(ы) будут добавлены в существующий Курс, в противном случае, будет создана 

новая Категория. Это работает, только если помечено окошко «Get category from file 

(получить категорию из файла)». 

В одном и том же файле может быть указано несколько Категорий. Просто 

добавляйте другой макетный Вопрос «category» каждый раз, когда вы хотите установить 

новую Категорию и Вопросы, которые следуют за ним, будут размещены в ней. 

Этот файл должен иметь кодировку UTF-8. 

Импорт и экспорт Moodle XML функционально симметричны, так что если вам 

потребуется понять их формат, вам нужно просто создать некоторые Вопросы и 

экспортировать их, чтобы увидеть, как они выглядят. 

4.6.6.4.3.Общие теги ко всем типам Вопросов 
Вопрос записывается следующим образом. 

<question type=”multichoice|truefalse|shortanswer|matching|cloze|essay|numerical|description”> 

 

 

     <name> 

         <text>Название вопроса</text> 

     </Название > 

     <questiontext format=”html”> 

         <text>Каков ответ на этот вопрос?</text> 

     </questiontext> 

</question> 

«Format» выбирает Опции форматирования (п. 4.2.2) для текста Вопросов. 

Опциями являются html (по умолчанию), moodle_auto_format, plain_text и markdown. 

Выбор воздействует на способ, которым текст будет отображён. 
 

Дальнейшие теги, которые обычно включают, по крайней мере, тег <answer>, 

следуют в пространстве, помеченном точками, как дочерние узлы по отношению к тегу 

<question>. Теги, связанные с ответами, перечисляются далее вниз на этой странице. 

Возможны различные (необязательные?) теги. 

 penalty (штраф) 

 generalfeedback (общая обратная связь) 

 defaultgrade (оценка по умолчанию) 

 hidden (скрытый) 
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The <image> tag contains the URL of any included image. Nested within 

the <image> tag may be an <image_base64> tag which contains the actual 

image data encoded in base64 [1]. 

In the following question type examples the common parts of the 

question are not shown to improve clarity. It's a good idea to export 

some examples yourself to see a full example. 

4.6.6.4.4.Multiple choice 
MC questions have one <answer> tag for each choice. Each choice can 

carry feedback and score weighting (by using the fraction attribute). In 

addition, an MC question has the following tags: 

 

 single (values: true/false) 

 shuffleanswers (values: 1/0) 

 correctfeedback 

 partiallycorrectfeedback 

 incorrectfeedback 

 answernumbering (allowed values: 'none', 'abc', 'ABCD' or '123') 

 

The <single> tag is used to distinguish single response (radio button) and 

multiple response (checkbox) variants. 

<question type="multichoice"> 

 <answer fraction="100"> 

     <text>The correct answer</text> 

    <feedback><text>Correct!</text></feedback> 

 </answer> 

<answer fraction="0"> 

<text>A distractor</text> 

    <feedback><text>Ooops!</text></feedback> 

</answer> 

<answer fraction="0"> 

     <text>Another distractor</text> 

    <feedback><text>Ooops!</text></feedback> 

 < </answer> 

<shuffleanswers>1</shuffleanswers> 

<single>true</single> 

<answernumbering>abc</answernumbering> 

 

 

 

Тег <image> (изображение) содержит URL любого включённого изображения. 

Вложенным в тег <image> может быть тег <image_base64>, который содержит данные 

реального изображения, заключённые в base64 [1]. 

В следующих примерах типов Вопросов общие части Вопроса не показаны для 

улучшения ясности. Хорошо бы некоторые примеры экспортировать для себя, чтобы 

увидеть пример полностью. 

4.6.6.4.4.Множественный Выбор 
Вопросы со Множественным Выбором имеют один тег <answer> (ответ) для 

каждого выбора. Каждый Выбор может нести Обратную Связь и 

Взвешенное Накопленных Баллов (использованием дробного атрибута). В дополнение 

Вопрос с Множественным Выбором имеет следующие теги: 

 single (значения: истина/ложь) 

 shuffleanswers (перетасованные ответы, значения: 1/0) 

 correctfeedback (обратная связь на правильный ответ) 

 partiallycorrectfeedback (обратная связь на частично правильный ответ) 

 incorrectfeedback (обратная связь на неправильный ответ) 

 answernumbering (нумерация ответов, позволенные ответы: «none», «abc», «ABCD» или 

«123») 

Тег <single> (единственный) используется для того, чтобы отличить варианты 

Единственного Ответа (переключатель) и Нескольких Ответов (окошко-флажков). 

<question type="multichoice"> 

 <answer fraction="100"> 

     <text>Правильный ответ</text> 

    <feedback><text>Верно!</text></feedback> 

 </answer> 

<answer fraction="0"> 

     <text>Отвлекающий материал</text> 

    <feedback><text>Чёрт!</text></feedback> 

 </answer> 

<answer fraction="0"> 

     <text>Другой отвлекающий материал</text> 

    <feedback><text> Чёрт!</text></feedback> 

 < </answer> 

<shuffleanswers>1</shuffleanswers> 

<single>true</single> 

 <answernumbering>abc</answernumbering> 

http://www.php.net/manual/en/function.base64-encode.php
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4.6.6.4.5.True/false 
Two answer tags are given, one which is true, and one which is false. The 

fraction attribute of the answer tag identifies which option is correct (100) 

and which is false (0). Feedback is supported. The following example 

shows the format when true is the correct answer and false is wrong. 

<question type="truefalse"> 

 <answer fraction="100"> 

    <text>true</text> 

    <feedback><text>Correct!</text></feedback> 

 </answer> 

 <answer fraction="0"> 

    <text>false</text> 

    <feedback><text>Ooops!</text></feedback> 

 </answer> 

4.6.6.4.6.Short answer 
The short answer question type supports alternative correct responses, each 

with its own weighting and feedback. The Moodle XML format uses one 

<answer> tag for each of the alternative correct answers. 

The <usecase> tag toggles case-sensitivity with the values 1/0. 

<question type="shortanswer"> 

 <answer fraction="100"> 

     <text>The correct answer</text> 

     <feedback><text>Correct!</text></feedback> 

</answer> 

<question type="shortanswer"> 

 <answer fraction="100"> 

     <text>The correct answer</text> 

     <feedback><text>Correct!</text></feedback> 

 </answer> 

 <answer fraction="100"> 

     <text>An alternative answer</text> 

     <feedback><text>Correct!</text></feedback> 

 </answer> 

 

 

 

 

 

 

4.6.6.4.5.Истина/ложь 
Два тега ответов даны, один который true (истина) и один, который false (ложь). 

Дробный атрибут тега ответа идентифицирует, какая опция корректна (100), а какая ложна 

(0). Обратная Связь поддерживается. Следующий пример показывает формат, когда 

истина является корректным ответом, а ложь ложным. 

<question type="truefalse"> 

 <answer fraction="100"> 

    <text>истина</text> 

    <feedback><text>Верно!</text></feedback> 

 </answer> 

 <answer fraction="0"> 

    <text>ложь</text> 

    <feedback><text>Чёрт!</text></feedback> 

 </answer> 

4.6.6.4.6.Краткий Ответ 
Тип Вопроса с Кратким Ответом поддерживает правильные альтернативные 

ответы, каждый с его собственным Взвешиванием и Обратной Связью. Формат Moodle 

XML использует один тег <answer> для каждого из альтернативных правильных ответов. 

Тег <usecase> переключает чувствительность к регистру значениями 1/0. 

<question type="shortanswer"> 

 <answer fraction="100"> 

     <text>Правильный ответ</text> 

     <feedback><text>Верно!</text></feedback> 

</answer> 

<question type=”shortanswer”> 

 <answer fraction=”100”> 

     <text>Правильный ответ</text> 

     <feedback><text>Верно!</text></feedback> 

 </answer> 

 <answer fraction=”100”> 

     <text>Альтернативный ответ</text> 

     <feedback><text>Верно!</text></feedback> 

 </answer> 
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4.6.6.4.7.Numerical response 
The following is a simplified version of the Moodle XML format for 

numerical responses. 

<question type="numerical"> 

 <answer fraction="100"> 

     <text>23</text> 

     <feedback><text>Feedback</text></feedback> 

 </answer> 

Moodle also supports a <tolerance> tag (how accurate must the number 

be?) and one or more <unit> tags. Unit tags have names and multipliers. 

E.g. if the main answer is in kilometres, an additional answer could be the 

equivalent in metres with a multiplier of 1000. 

Note: prior to 1.7.2 the fraction was expressed as a value between 0 and 1 

in a <fraction> element and the answer value was not enclosed in <text> 

tags. This format of the numerical question type is deprecated but will still 

be correctly imported if found (for now). 

4.6.6.4.8.Matching 
Pair matching responses use the <shuffleanswers> tag to determine 

whether the order of the items should be randomized. Each pair is 

contained inside a <subquestion> tag. The first item of each pair is 

contained with a <text> tag, while the second has an <answer> tag around 

it as well. Feedback and score weighting is not supported by Moodle for 

this response type. 

<question type="matching"> 

<subquestion> 

     <text>This is the 1st item in the 1st pair.</text> 

     <answer> 

         <text>This is the 2nd item in the 1st pair.</text> 

     </answer> 

 </subquestion> 

 <subquestion> 

     <text>This is the 1st item in the 2nd pair.</text> 

     <answer> 

         <text>This is the 2nd item in the 2nd pair.</text> 

     </answer> 

 </subquestion> 

 <shuffleanswers>true</shuffleanswers> 

 

 

4.6.6.4.7.Числовой ответ 
Следующее является упрощенной версией формата Moodle XML для числовых 

ответов. 

<question type=”numerical”> 

 <answer fraction=”100”> 

     <text>23</text> 

     <feedback><text>Обратная связь</text></feedback> 

 </answer> 

Moodle также поддерживает тег <tolerance> (погрешность – насколько точным 

должно быть число в ответе?) и один или несколько тегов <unit>. Теги <unit> имеют 

название и множители. Например если главный ответ даётся в километрах, 

дополнительный ответ может быть эквивалентом в метрах с множителем 1000. 

Примечание: до версии 1.7.2 дробь выражалась значением между 0 и 1 в элементе 

<fraction> и значение ответа не было заключено в теги <text>. Этот формат 

Числового типа Вопроса устарел, но все равно будет правильно импортироваться при 

обнаружении (на данный момент). 

4.6.6.4.8.Сопоставление 
Ответы на Сопоставление Пар используют тег <shuffleanswers>, чтобы определить, 

нужно ли выбирать элементы случайным образом. Каждая пара содержится внутри тега 

<subquestion> (подвопрос). Первый элемент каждой пары содержится с тегом <text>, в то 

время как второй с таким же успехом имеет тег <answer> вокруг него. Обратная Связь и 

взвешивание накопленных баллов не поддерживается Moodle для этого типа ответа. 

 

<question type="matching"> 

<subquestion> 

     <text>Это первый элемент первой пары.</text> 

     <answer> 

         <text>Это второй элемент первой пары.</text> 

     </answer> 

 </subquestion> 

 <subquestion> 

     <text>Это первый элемент второй пары.</text> 

     <answer> 

         <text>Это второй элемент второй пары.</text> 

     </answer> 

 </subquestion> 

 <shuffleanswers>true</shuffleanswers> 
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4.6.6.4.9.Essay 
An example of the essay type question... 

<question type="essay"> 

    <answer fraction="0"> 

        <text></text> 

    </answer> 

  </question> 

There isn't an answer and there isn't a grade in this case. 

Note: prior to 1.7.2 the fraction was expressed as a value between 0 and 1 

in a <fraction> element and the answer value was not enclosed in <text> 

tags. This format of the essay question type is deprecated but will still be 

correctly imported if found (for now). 

4.6.6.4.10.Other question types 
Cloze 
It is supported, and depends on a special format for the <questiontext> tag. 

Description response type 
This response type has no further tags other than those contained in the 

question header (such as <questiontext>). 

Random matching 
Moodle has a question type which consists of taking short answer 

questions in the same quiz and displaying them as a pair  

matching exercise. However Moodle is neither able to export nor import 

this question type. 

4.6.6.4.11.Text formats 
Moodle XML files should explicity specify the text format (html, 

moodle_auto_format, plain_text and markdown - these correspond to 

the constants, FORMAT_HTML, FORMAT_MOODLE, etc used in the 

Moodle code) for each piece of content. Note that, by default, the format 

should be specified on the parent of the <text> element. This is slightly 

odd, but a remnant of history. 

If the format is not specified for the questiontext, then html is the default. 

If the format is not specified on any other part of the question, then the 

format of the questiontext is the default. 

(This default changed around November 2011. Before that, the default was 

moodle_auto_format whenever the format was not specified.) 

 

 

 

4.6.6.4.9.Эссе 
Пример Вопроса Типа «Эссе»… 

<question type="essay"> 

    <answer fraction="0"> 

        <text></text> 

    </answer> 

  </question> 

В этом случае нет ответа и нет Оценки. 

Замечание: до версии 1.7.2 дробь выражалась значением между 0 и 1 в элементе 

<fraction> и значение ответа не был заключено в теги <text>. Этот формат 

Числовоого Типа Вопроса устарел, но всё равно будет правильно импортироваться при 

обнаружении (на данный момент). 

4.6.6.4.10.Другие типы Вопросов 
Учебный тест 

Это поддерживается и зависит от специального формата для тега <questiontext>. 

Тип Описательного Отклика 
Это тип Отклика не имеет добавочных тегов отличных от тех, что содержатся в 

заголовке Вопроса (таких как <questiontext>). 

Случайное Сопоставление 
Moodle имеет тип Вопросов, который состоит из принятых 

Вопросов с Краткими Ответами в одном и том же Экзамене и отображающих их как 

упражнение на сопоставление пар. Однако Moodle не способна ни экспортировать, ни 

импортировать этот тип Вопросов. 

4.6.6.4.11.Текстовые форматы 
Файлы Moodle XML должны явно указывать текстовый формат (html, 

moodle_auto_format, plain_text и markdown – они соответствуют констант, 

FORMAT_HTML, FORMAT_MOODLE и т.д., используемые в коде Moodle) для каждого 

фрагмента содержимого. Заметьте, что по умолчанию этот формат должен быть указан 

родителю элемента <text>. Это немного странно, но это наследие истории. 

 

Если формат не указан для questiontext, то по умолчанию HTML. Если формат не 

указан в любой другой части Вопроса, тогда этот формат из questiontext по умолчанию. 

 

(Это значение по умолчанию изменено примерно в ноябре 2011 года. До этого, по 

умолчанию было moodle_auto_format всякий раз, когда формат не указывался.) 
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4.6.6.4.12.Useful utilities 
 Online Moodle XML converter Convert from existing text files 

glossaries and quizzes to Moodle XML format. Also can convert from 

Moodle XMl to text. 

 Word Template for generating Moodle XML. 

 MoodleXMLBuilder converts commonly-used test generator output into 

Moodle XML. MoodleXMLBuilder currently supports converting tests 

and question banks created in Blackboard, ExamView, TestGen, and 

EZTest. Images are fully supported within all question fields where 

images are allowed within the Moodle quiz module. 

4.6.6.4.13.See also 
 Aiken format 

 XML FAQ 

4.6.6.5.XHTML format 
The XHTML export format simply exports all the questions in the category 

as an XHTML form. In most cases the question answers are not included. 

It is intended as a basis for producing a set of questions to be used in some 

other web application and will almost certainly require further editing to be 

useful. 

Each question is clearly placed in its own <div> tag. If you want to use this 

page as-is, you will need to at least edit the <form> tag at the start of the 

<body> section to provide a suitable action (e.g. a 'mailto'). 

4.6.6.6.See also 
 Moodle XML Converter to generate in and from XML. 

 Website for converting Moodle Questions into tables in a Microsoft 

Word file, and vice versa. 

4.6.7.Question behaviours 
The following question behaviours are available when creating a quiz (also 

when previewing questions): 

Deferred feedback 

Students must enter an answer to each question and then submit the entire 

quiz, before anything is graded or they get any feedback. 

 

Adaptive mode and Adaptive mode (no penalties) 

Allows students to have multiple attempts at the question before moving 

on to the next question. 

 

 

4.6.6.4.12.Полезные утилиты 
 Онлайн конвертер Moodle XML конвертирует текстовые файлы Глоссариев и 

Экзаменов в формат Moodle XMl. Также могут конвертировать из Moodle XML в 

текстовый. 

 Текстовый шаблон для гененрирования Moodle XML. 

 MoodleXMLBuilder конвертирует выход Генератора Общеприменимого Теста Moodle 

XML. MoodleXMLBuilder в настоящее время конвертирует тесты и Банки Вопросов, 

созданные в форматах Blackboard, ExamView, TestGen и EZTest. Изображения 

полностью поддерживаются во всех полях Вопросов, где изображения разрешены 

внутри модуля «Экзамен» Moodle. 

4.6.6.4.13.См. также 
 Формат Aiken. 

 Часто задаваемые вопросы по XML. 

4.6.6.5.Формат XHTML 
Формат экспорта XHTML просто экспортирует все Вопросы в Категорию в виде XHTML. 

В большинстве случаев ответы на Вопрос не включаются. Он играет роль основы при 

производстве набора Вопросов, которые будут использоваться в некоторых других веб-

приложениях, и почти наверняка потребуют правки, чтобы быть полезными. 

Каждый Вопрос чётко помещается в свой собственный тег <div>. Если вы хотите 

использовать эту страницу так как она есть, то вам нужно будет, по крайней мере, 

отредактировать тег <form> в начале раздела <body>, чтобы обеспечить подходящее 

действие (например, «отправить по почте»). 

4.6.6.6.См. также 
 Конвертор Moodle XML, чтобы генерировать в вид XML. 

 Веб-Сайт для конвертирования Вопросов Moodle в таблицы в файл Microsoft Word, и 

наоборот. 

4.6.7.Образцы действий с Вопросами 
Следующие образцы действий с Вопросами доступны при создании Экзамена 

(также при предварительном просмотре Вопросов): 

Отложенная Обратная Связь 

Студенты должны ввести ответ на каждый Вопрос, а затем передать на рассмотрение 

весь Экзамен целиком, прежде чем всё будет оцениваться или они получат любую 

Обратную Связь. 

Адаптивный режим (без штрафных санкций) 

Позволяет Студентам иметь несколько попыток ответа на Вопрос, прежде чем перейти 

к следующему Вопросу. 

http://vletools.com/
http://finemetronome.com/moodle/
http://docs.moodle.org/25/en/Aiken_format
http://docs.moodle.org/25/en/XML_FAQ
http://moodle.heroku.com/
http://www.moodle2word.net/
http://www.moodle2word.net/
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Manual grading 

Used for essay questions (irrespective of what the quiz is set to) but you 

can now choose to have every question in the quiz manually graded, if 

you wish. 

Interactive mode 

After submitting one answer, and reading the feedback, the student has to 

click a 'Try again' button before they can try a new response. They can be 

given hints to help them. Once the student has got the question right, they 

can no longer change their response. Once the student has got the 

question wrong too many times, they are just graded wrong (or partially 

correct) and get shown the feedback and can no longer change their 

answer. There can be different feedback after each try the student makes. 

The number of tries the student gets is the number of hints in the question 

definition plus one. 

 

Immediate feedback 

Similar to interactive mode in that the student can submit their response 

immediately during the quiz attempt, and get it graded. However, they 

can only submit one response, they cannot change it later. 

 

Deferred feedback or Immediate feedback with Certainty-based marking 

(CBM) 

With CBM, the student does not only answer the question, but they also 

indicate how sure they are they got the question right. The grading is 

adjusted by the choice of certainty, so that students have to reflect 

honestly on their own level of knowledge in order to get the best mark. 

4.6.7.1.Managing question behaviours 
An administrator can manage question behaviours available across the 

site in Administration > Site administration > Plugins > Question 

behaviours > Manage question behaviours. 

4.6.7.2.See also 
 LAPT: UCL home of Certainty-Based Marking 

4.6.8.Question types 
You may add a variety of different types of questions in the Quiz and 

Lesson modules. This page is about Quiz module question types; some will 

be similar to Lesson questions types, which are fewer in number and 

function differently. 

 

 

Оценивание вручную 

Используется для Вопросов-Эссе (независимо от того, что установлено в Экзамене), но 

теперь вы можете выбрать для каждого Вопроса в Экзамене оценивание вручную, если 

хотите. 

Интерактивный Режим 

После передачи на рассмотрение одного ответа, и чтения Обратной Связи, Студент 

должен щёлкнуть кнопку «Try again (попробовать ещё раз)», прежде чем сможет 

попробовать ответить снова. Ему может быть предоставлен совет для помощи. Как 

только Студент получил правильный ответ на Вопрос, он больше не сможет изменить 

свой отклик. Если же Студент выдал неправильный ответ на Вопрос слишком много 

раз, он просто получит Оценку «неправильно» (или «частично верно») и ему покажут 

Обратную Связь, и больше он не сможет изменить свой ответ. На каждую сделанную 

Студентом попытку ответа может существовать различная Обратная Связь. Число 

попыток, которые Студент получает, равно числу советов в определении Вопроса плюс 

одна. 

Незамедлительная Обратная Связь 

Подобно Интерактивному Режиму в том, что Студент может сразу передать свой ответ 

на рассмотрение в течение попытки выполнить Экзамен, и получить свою Оценку. 

Однако, он может передать на рассмотрение только один отклик, и не может изменить 

его позже. 

Отложенная Обратная Связь или Незамедлительная Обратная Связь с указанием 

Степени Уверенности в Правильности Ответа (СУПО) 

С СУПО Студент не только отвечает на Вопрос, но он также указывает, насколько он 

уверен в правильности своего ответа на Вопрос. Оценивание ведётся С учётом 

Степени Уверенности, так что Студенты должны честно отразить свой уровень знаний 

для того, чтобы получить лучшую Оценку. 

4.6.7.1.Управление моделями поведения Вопросов 
Администратор может управлять моделями поведения Вопросов, доступных по 

всему Сайту в 

Administration→Site administration→Plugins→Question behaviours→Manage question behaviours. 

4.6.7.2.См. также 
 LAPT (London Agreed Protocol for Teaching – Лондонский согласительный протокол по 

обучению): UCL home of Certainty-Based Marking 

4.6.8.Типы Вопросов 
Вы можете добавить множество различных типов Вопросов в модули «Экзамен» и 

«Урок». Эта страница о типах Вопросов модуля «Экзамен (п. 4.3.10)»; некоторые будут 

аналогичны типам Вопросов «Урока», которых числом меньше и функционируют они 

иначе. 

http://www.ucl.ac.uk/lapt/
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The standard quiz question types are listed below with brief descriptions. 

Please use the links on the right side of this page to find more detailed 

information about standard questions types. 

4.6.8.1.Standard question types 
4.6.8.1.1.Calculated 
Calculated questions offer a way to create individual numerical questions 

by the use of wildcards (i.e you can use common variables names as x, y 

enclosed in curly braces to create the wildcards {x} and {y}) that are 

substituted with random values when the quiz is taken. 

For example, if you want to create a large number of "Calculate the area 

of a rectangle" problems to drill your students, you could create a question 

with two wildcards (i.e. {base}, {height} created from the common base, 

height variable names) and put in the "Correct Answer Formula=" input 

field {base} * {height} (* being the multiplication sign ). 

 

Correct Answer Formula={base}*{height} 

When a student takes the test, Moodle will randomly select values for 

{base} and {height} and grade the response using the result of the Correct 

Answer Formula. 

The test will very rarely appear the same way twice. 

Is this really the question type for you? 
The main purpose of the calculated question is to create multiple versions 

of a question with different numerical values. This means you must have at 

least one wildcard in one of the answers. 

If you don't need a random element, use the Numerical question type 

instead. 

Simple calculated question type 
The simple calculated question offers the most used features of 

the calculated question with a much simpler creation interface. 

Wildcards and datasets 
When Moodle delivers a Calculated question to the student, the wildcards 

are replaced with randomly-selected values. However, these values are not 

completely random - rather, they are randomly selected from a pre-defined 

dataset of possible values. This allows you some control over the possible 

values chosen - for example, in order to make sure the numbers are 

realistic. These datasets can be private or shared - private datasets are used 

by one wildcard within one calculated question; shared datasets are used 

by one wildcard within all calculated questions that use it. 

 

Стандартные типы Вопросов «Экзамена» перечислены ниже с краткими 

описаниями. Пожалуйста, используйте ссылки в правой части этой страницы, чтобы 

отыскать более подробную информацию о Стандартных типах Вопросов. 

4.6.8.1.Стандартные типы Вопросов 
4.6.8.1.1.Вычисляемые 

Вычисляемые Вопросы предлагают способ создания конкретных 

Числовых Вопросов путём использования Шаблонов Подстановки (т.е. вы можете 

использовать обычные имена переменных, такие как x, y, заключённые в фигурные 

скобки, чтобы создать Шаблоны Подстановки {x} и {y}), эти имена замещаются 

случайными значениями, когда принимается Экзамен. 

Например, если вы хотите создать большое число задач «Вычислить площадь 

прямоугольника», чтобы потренировать ваших Студентов, вы можете создать Вопрос с 

двумя Шаблонами Подстановки (т.е. {основание}, {высота}, порождённые от обычных 

имён переменных основание, высота) и вставить в поле ввода «Формула правильного 

ответа=» {основание} * {высота} (* – знак умножения). 

Формула правильного ответа={основание} * {высота} 

Когда Студент выполняет этот тест, Moodle будет случайным образом предлагать 

ему значения {основание} и {высота} и оценивать его ответ, используя результат 

вычисления по Формуле правильного ответа. 

Этот тест весьма редко появляется в одном варианте дважды. 

Нужен ли этот тип Вопросов вам на самом деле? 
Основное назначение Вычисляемого Вопроса состоит в создании многочисленных 

версий Вопроса с различными числовыми значениями. Это означает, что вы должны 

иметь, по крайней мере, один Шаблон Подстановки в одном из ответов. 

Если вам не нужен случайный элемент, используйте вместо него Числовой Вопрос (п. 

4.6.1.10). 

Простой Вычисляемый Тип Вопросов 
Простой Вычисляемый Вопрос предлагает наиболее используемые средства 

Вычисляемого Вопроса, только с намного более простым интерфейсом создания. 

Шаблоны Подстановки и наборы данных 
Когда Moodle поставляет Студенту Вычисляемый Вопрос, Шаблоны подстановки 

замещаются случайно выбранными значениями. Однако эти значения не являются 

совершенно случайными – они выбираются случайным образом из предварительно 

определённого набора данных возможных значений. Это позволяет вам как-то 

контролировать выбор возможных значений, например, для того, чтобы убедиться, что 

числа реалистичные. Эти наборы данных могут быть личными или общего пользования – 

личные наборы данных используются одним шаблоном подстановки внутри одного 

Вычисляемого Вопроса; разделяемые наборы данных совместно используются одним 

Шаблоном внутри всех Вычисляемых Вопросов, которые его используют. 
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Question set-up 
To create (or modify) a calculated question there are three pages to work 

through. The instructions below take you through the pages, step by step: 

Page 1. Editing a Calculated question 
1. Select the question category 

 

2. Any shared wildcards for this category are listed beneath. If you change 

category, you'll need to click the "Update the category" button to 

refresh this list. There may not be any shared wildcards yet - if not, you 

can create them later if you wish. 

 

3. Give the question a descriptive name - this allows you to identify it in 

the question bank. 

4. Enter the question text. This should be the question you want the 

student to answer, and it must include all the information they need to 

calculate an answer. Therefore it must contain at least one wildcard, 

inside curly braces. For example, if you wanted the student to sum 

numbers A and B, the question text might read: "What is {A} + {B}?" 

You may also include quantities computed from wildcards using the 

syntax "{=...}": for example, the question "What is {={A}+{B}} - 

{A}?" with wildcard values A=4 and B=3 would display as "What is 7 - 

4?" 

5. Select an image to display if you want to add a picture to the question. 

For the student, it appears immediately after the question text and 

before the choices. If you want more control over how the image 

appears, include it in the question text above, using the HTML editor. 

6. Set the default question grade (i.e. the maximum number of marks for 

this question). 

7. Set the Penalty factor (see Penalty factor below). 

8. Moodle 1.7+: If you wish, add general feedback. This is text that 

appears to the student after he/she has answered the question. 

 

9. Next add the formula for the answer. This formula must contain at 

least the wildcards that appear in the question text. See Correct answer 

formula syntax for further details. 

10. Choose the grade that the student will get for this question if they give 

this answer. This should be a percentage of the  

total marks available. For example, you could give 100% for a correct 

answer, and 50% for an answer that is nearly right. One of the answers 

must have a 100% grade. 

Установка Вопроса 
Чтобы создать (или модифицировать) Вычисляемый Вопрос, имеются три страницы 

инструкций, которые нужно выполнить шаг за шагом. Ниже они и приведены. 

Страница 1. Редактирование Вычисляемого Вопроса 
1. Выберите Категорию Вопроса в 

Administration→Course administration→Question bank→Question→Select a category. 

2. Любые совместно используемые Шаблоны Подстановки для этой Категории 

перечисляются ниже. Если вы измените Категорию, вам нужно щёлкнуть кнопку 

«Update the category (обновить Категорию)», чтобы освежить этот список. У вас пока 

ещё может не быть никаких Шаблонов Подстановки – если нет, вы можете создать их 

позднее, если захотите. 

3. Задайте Вопросу описательное наименование – это позволит вам идентифицировать 

его в Банке Вопросов. 

4. Введите текст Вопроса. Это должен быть Вопрос, на который вы хотите получить ответ 

Студента, и должен включать всю информацию, которая ему нужна для вычисления 

ответа. Следовательно, он должен содержать, по крайней мере, один 

Шаблон Подстановки внутри фигурных скобок. Например, если вы хотите, чтобы 

Студент просуммировал числа A и B, текст Вопроса может быть таким: «Сколько будет 

{A} + {B}? (названия переменных только на английском языке!!!)» Вы можете также включить 

числа, вычисляемые из Шаблона Подстановки, используя синтаксис «{=...}»: например, 

вопрос «Сколько будет {={A}+{B}} - {A}?» со значениями из Шаблона подстановки 

A=4 и B=3 отобразится как «Сколько будет 7 - 4?» 

5. Выберите изображение, если хотите поместить картинку в Вопрос. Для Студента оно 

появится сразу после текста Вопроса и перед альтернативами ответов. Если вы хотите 

больше управлять тем, как изображение появляется, включите его выше в текст 

Вопроса, используя редактор HTML. 

6. Установите оценку за Вопрос по умолчанию (т.е. максимальное число баллов за этот 

Вопрос). 

7. Установите Штрафной фактор (см. «Штрафной фактор» ниже). 

8. Начиная с Moodle 1.7 и далее: Если нужно, добавьте общую Обратную Связь. Это 

текст, который появится перед Студентом после того, как он/она ответит на этот 

Вопрос. 

9. Далее добавьте Формулу для ответа. Эта формула должна содержать, по крайней 

мере, Шаблоны подстановки, которые появятся в тексте этого Вопроса. Дальнейшие 

подробности см. в «Синтаксис формулы правильного ответа» (п. 4.6.1.1.5). 

10. Выберите Оценку, которую Студент получит за этот Вопрос, если он даст ответ на этот 

Вопрос. Это должен быть процент от возможных Итоговых баллов. Например, вы 

можете дать 100% за правильный ответ и ответ 50% за ответ, который близок к 

правильному. Один из ответов должен иметь Оценку 100%. 
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11. Determine the tolerance for error that you will accept in the answer. 

The tolerance and tolerance type settings combine to give a range of 

acceptable scores. So, if tolerance = t, correct answer = x and the 

difference between the user's answer and the correct answer is dx, then 

the tolerance types are as follows: 

 

1. Nominal - mark correct if dx <= t 

2. Relative - mark correct if dx / x <= t 

3. Geometric - mark correct if dx² / x² <= t² 

12. The next 2 settings, "Correct answer shows" and "Format" determine 

the precision of the answer. Use these to select the number of decimal 

places or significant figures you want to use. 

13. Add some feedback which the student will see if they enter this answer. 

 

14. You can specify as many answer formulae as you like – click “Add 

another answer blank” to add more. 

15. You can also specify units for the answers. For example, if you enter a 

unit of ‘cm’ here, and the accepted answer is 15, then the answers 

‘15cm’ and ‘15’ are both accepted as correct. If you add more than one 

unit, you can also specify a multiplier. So, if your main answer was 

5500 with unit W, you can also add the unit kW with a multiplier of 

0.001. This means that the answers ‘5500’, ‘5500W’ or ‘5.5kW’ would 

all be marked correct. Note that the accepted error is also multiplied, so 

an allowed error of 100W would become an error of 0.1kW. 

16. Finally (!) you can click “Next page” to save what you’ve done and 

move on. If you are editing an existing question, you can click “Next 

page (new question)” to create a completely new question based on an 

existing one. 

Penalty factor 
The ‘penalty factor’ only applies when the question is used in a quiz using 

adaptive mode – i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student will lose that proportion of the maximum 

grade upon each successive attempt. For example, if the default question 

grade is 10, and the penalty factor is 0.2, then each successive attempt after 

the first one will incur a penalty of 0.2 x 10 = 2 points. 

 

 

 

 

11. Определите Допустимое отклонение для ошибки, которую вы получите в ответе. 

Настройки Допустимого отклонения и типа Допустимого отклонения комбинируются, 

чтобы задать область приемлемых Накопленных баллов. Так, если Допустимое 

отклонение = t, правильный ответ = x, а разница между ответом пользователя и 

правильным ответом есть dx, тогда типами Допустимого отклонения являются 

следующими: 

1. Номинальный – балл корректируется, если dx <= t. 

2. Относительный – балл корректируется, если dx/x <= t. 

3. Геометрический – балл корректируется, если dx2/x2 <= t. 

12. Следующие 2 настройки «Correct answer shows (демонстрации правильных ответов)» и 

«Format (формат)» определяют точность ответа. Используйте их, чтобы выбрать число 

десятичных разрядов или число значащих цифр, которые хотите использовать. 

13. Добавить какую-то Обратную Связь, которую данный Студент увидит, если он введёт 

свой ответ. 

14. Вы можете указать, как много формул ответа вы предпочитаете, – щёлкните «Add 

another answer blank (добавьте другой пустой бланк ответа)», чтобы добавить больше. 

15. Вы можете также указать единицы измерения для ответов. Например, если вы введёте 

измерение в «см» здесь, а принятый ответ будет 15, тогда оба ответа «15 см» и «15» 

будут приняты как правильные. Если вы добавляете более одной единицы измерения, 

вы можете также указать множитель. Так что, если ваш главный ответ был 5500 с 

единицей измерения W, вы можете также добавить единицу измерения kW с 

множителем 0.001. Это означает, что все ответы «5500», «5500W» или «5.5kW» будут 

помечены как правильные. Заметьте, что принятая ошибка также умножается, так что 

позволенная ошибка из 100W станет ошибкой 0.1kW. 

16. В конце (!) вы можете щёлкнуть «Next page (следующая страница)», чтобы сохранить 

то, что вы сделали, или переместить. Если вы редактируете существующий Вопрос, вы 

можете щёлкнуть «Next page (New question – новый вопрос)», чтобы создать 

совершенно новый Вопрос, основанный на существующем. 

Штрафной фактор 
«Штрафной фактор» применяется только когда Вопрос применяется в Экзамене, 

использующем адаптивный режим, – т.е. когда Студенту разрешены множественные 

попытки ответа на Вопрос даже внутри одной и той же попытки на Экзамене. Если 

Штрафной фактор больше, тогда Студент потеряет пропорционально от максимальной 

оценки при каждой успешной попытке. Например, если оценка по умолчанию за Вопрос 

равна 10, а Штрафной фактор равен 0.2, тогда каждая успешная попытка после первой 

попытки подвергнется Штрафному фактору – уменьшению на 0.2 x 10 = 2 балла. 
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Tolerance 
As for numerical questions it is possible to allow a margin within which all 

responses are accepted as correct. The “Tolerance” field is used for this. 

However, there are three different types of tolerances. These are Relative, 

Nominal and Geometric. If we say that the correct answer at quiz time is 

calculated to 200 and the tolerance is set to 0.5 then the different tolerance 

types work like this: 

Relative: A tolerance interval is calculated by multiplying the 

correct answer with 0.5, ie in this case we get 100 so for this tolerance the 

correct response must be between 100 and 300. (200 ± 100) This is useful 

if the magnitude of the correct answer can differ greatly between different 

wildcard values. 

Nominal: This is the simplest tolerance type but not very powerful. The 

correct response must be between 199.5 and 200.5 (200 ± 0.5) This 

tolerance type can be useful if the differences between different correct 

answers are small. 

Geometric: The upper limit of the tolerance interval is calculated as 200 + 

0.5*200 and is the same as for the relative case. The lower limit is 

calculated as 200/(1 + 0.5). The correct response must then be between 

133.33 and 300. This is useful for complex calculation that must have great 

tolerances where relative tolerances of 1 or more would be used for the 

upper limit but clearly not acceptable for the lower limit as it would make 

zero a correct answer for all cases. 

The field Significant Figures does only relate to how the correct answer 

should be presented in the review or the reports. Examples: If it is set to 3 

then the correct answer 13.333 would be presented as 13.3; 1236 would be 

presented as 1240; 23 would be presented as 23.0 etc. 

Page 2. Choose dataset properties 
Each wildcard that you specify in the answer formula must have an 

associated set of possible values - this is its dataset. Each of the wildcards 

is listed on this page along with a choice of dataset: 

 

 private i.e. only used by this question 

 shared i.e shared with other calculated questions in the same category 

 

Using a shared dataset can save time when you are creating a lot of similar 

calculated questions. 

Note that even when creating a question for the first time, this page may 

say that your wildcard "will use the same existing private dataset as 

before." This just means that Moodle has already tentatively 

Допустимое отклонение 
Для числовых Вопросов можно задать границу, начиная с которой все ответы 

принимаются как правильные. Для этого используется поле «Допустимое отклонение». 

Однако существует три различных типа Допустимых отклонений. Это Относительное, 

Номинальное и Геометрическое. Если мы скажем, что правильный ответ за время 

Экзамена исчисляется с 200, а Допустимое отклонение установлено как 0.5, тогда 

различные типы Допустимого отклонения будут работать подобно этому: 

Относительное: Интервал Допустимого отклонения вычисляется умножением 

правильного ответа на 0.5, т.е. в этом случае мы получим 100, так что для этого 

Допустимого отклонения правильный ответ должен находиться между 100 и 300 (200 

± 100). Это полезно, если величина правильного ответа может значительно отличаться 

для различных значений Шаблона подстановки. 

Номинальное: Это простейший тип Допустимого отклонения, но не очень мощный. 

Правильный ответ должен быть между 199.5 и 200.5 (200 ± 0.5). Этот тип Допустимого 

отклонения может быть полезен, если отличия между правильными ответами малы. 

 

Геометрическое: Верхнее ограничение интервала Допустимого отклонения вычисляется 

как 200 + 0.5*200 и является таким же, как и в случае Относительного. Нижнее 

ограничение вычисляется как 200/(1 + 0.5). Правильный ответ должен быть между 

133.33 и 300. Это полезно для сложного вычисления, которое должно иметь большие 

Допустимые отклонения, где Относительные Допустимые отклонения от 1 или больше 

будут использоваться для верхнего ограничения, но совершенно не приемлемо для 

нижнего ограничения, т.к. сделает ноль правильным ответом для всех случаев. 

Поле Significant Figures (число значащих цифр) относится только к тому, как 

правильный ответ будет представлен в обзоре или отчётах. Примеры: Если оно 

установлено равным 3, тогда правильный ответ 13.333 будет представлен как 13.3; 1236 

будет представлен как 1240; 23 будет представлен как 23.0 и т.д. 

Страница 2. Выберите свойства набора данных 
Каждый Шаблон подстановки, который вы укажете в формуле ответа, должен 

иметь связанный с ним набор возможных значений – это и есть его набор данных. Каждый 

из Шаблонов подстановки перечисляется на этой странице наряду с выбором набора 

данных: 

 личный, т.е. используется только этим Вопросом, 

 совместно используемый, т.е. совместно используется с другими Вопросами в той же 

самой Категории. 

Применяя совместно используемый набор данных, можно сэкономить время, когда 

вы создаёте множество подобных Вычисляемых Вопросов. 

Заметьте, что даже при создании Вопроса первый раз, эта страница может сказать, 

что ваш Шаблон Подстановки «будет использовать тот же самый существующий Личный 

набор данных, как и прежде». Это просто означает, что Moodle уже имеет предварительно  
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created a private data set for that wildcard: if a private dataset is what you 

want, leave this choice selected. 

If there is anything in the question text that looks like a wildcard, but does 

not appear in any of the answer formulae, you can specify whether or not 

this is meant to be a wildcard. If it is, you can choose whether it should use 

a private or shared dataset. 

To continue, simply choose your preferred dataset for each wildcard, then 

click "Next Page". 

Page 3. Edit the datasets 
Now we need to create the set of possible values that each wildcard can 

take. Warning - this page is a bit confusing! 

There are two ways of creating values - you can type them in yourself and 

add them to the list, or you can have Moodle generate them for you. 

Adding/deleting your own values 
Adding individual values to the list is easy: 

 In the 'Param' field for each wildcard, enter the value you want 

 Scroll down to the 'Add' section and click the Add button (leaving the 

number of items set to 1) 

 Repeat the above steps as many times as necessary (the maximum 

number of items is 100) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

созданный Личный набор данных ля этого Шаблона Подстановки: если Личный набор 

данных тот, что нужен, оставьте этот выбор таким. 

Если в тексте Вопроса есть нечто, что выглядит подобно Шаблону Подстановки, 

но не появляется в какой-либо формуле ответа, вы можете указать, является ли оно 

Шаблоном Подстановки или нет. Если является, вы можете выбрать, должен он 

использовать Личный или Совместно используемый набор данных. 

Чтобы продолжить, просто выберите предпочитаемый вами набор данных для 

каждого Шаблона Подстановки, и затем щёлкните «Next Page (следующая страница)». 

Страница 3. Отредактируйте наборы данных 
Теперь нужно создать набор возможных значений, которые может принять каждый 

Шаблон Постановки. Предупреждение – эта страница несколько сложновата! 

Существует два способа создания значений – вы можете набрать их сами и 

поместить в список или поручить Moodle сгенерировать их для вас. 

Добавление/удаление ваших собственных значений 
Добавление отдельных значений в список осуществляется легко: 

 В поле «Param» для каждого Шаблона Подстановки введите нужное значение. 

 Прокрутите вниз до раздела «Add (добавить)» и щёлкните кнопку Add (оставляя число 

элементов установленным в 1). 

 Повторите предыдущие шаги столько раз, сколько нужно (максимальное число 

элементов равно 100). 



 

350 

Letting Moodle create values 

 Start with the "Range of Values" fields, and enter the lower and upper 

limits for the values you would accept 

 Choose a number of decimal places for the value 

 Choose the distribution of values between the limits - 'uniform' means 

any value between the limits is equally likely to be generated; 

'loguniform' means that values towards the lower limit are more likely. 

 

 

 Now move down to the 'Add' section and click on "force regeneration" 

 

 In the menu next to the Add button, choose the number of sets of 

random values (items) you wish to add to the list. 

(Note that the maximum total number of items in your list is 100.) 

Finally, click Add to append the new values to the list 

 Note: If you want more control over the items that Moodle adds, you 

can do them one at a time and preview the values before you add them. 

Click the "Get New Item to Add" button to make Moodle generate new 

values in the "Item to Add" section at the top. If you like them, click 

"Add" for 1 item; if not, click "Get New Item to Add" again to get new 

values. 

 

Finishing off 
Once your list of items (values) is complete, you are finished. It's up to you 

how many values you add - the more values you add, the more a question 

can be used by the students without them seeing the same values 

repeatedly. 

Note that if you delete values from the list, you can put them back again. 

Change the "Next Item to Add" option to "reuse previous value if 

available", then the next time you add items, Moodle will restore your 

previously-deleted items from the dataset. 

 

Once your list of values is complete, you can click 'Save changes' to finish. 

 

What does the 'Update the datasets parameters' button do? 
Warning: This button can affect several questions, so be careful before 

using it. Assume you have selected dataset parameter for {a} to be any 

value between 1-10 and generated a question. In the second question also 

you decide to use a SHARED wildcard called {a}. 

 

Позволение Moodle создавать значения 

 Начните с полей «Range of Values (область значений)» и введите нижние и верхние 

ограничения для значений, которые вы приемлете. 

 Выберите число десятичных разрядов для значения. 

 Выберите распределение значений между ограничениями – «uniform (равномерное 

распределение)» означает, что любое значение между ограничениями будет 

сгенерировано с равной вероятностью; «loguniform (логарифмически равномерное 

распределение)» означает, что значения в направлении к нижнему ограничение более 

вероятны. 

 Теперь переместитесь вниз к разделу «Add» и щёлкните «Force regeneration 

(принудительная регенерация)». 

 В меню кнопки Add выберите число наборов случайных значений (элементов), которые 

вы хотите добавить в список. 

(Заметьте, что максимальное суммарное число элементов в вашем списке равно 100.) В 

конце щёлкните Add, чтобы добавить новые значения в список. 

 Замечание: Если вы хотите большего управления элементами, которые добавляет 

Moodle, вы можете добавлять их по одному и предварительно просматривать значения, 

прежде чем добавлять. Вверху раздела «Item to Add (элемент для добавления)» 

щёлкните кнопку «Get New Item to Add (получить новый элемент для добавления)», 

чтобы заставить Moodle сгенерировать новые значения. Если они вам подходят, 

щёлкните «Add» для элемента 1, если нет, снова щёлкните «Get New Item to Add», 

чтобы получить новые значения. 

Окончание 
Как только ваш список элементов (значений) завершён, вы заканчиваете. От вас 

зависит, сколько элементов вы добавите, но, чем больше значений добавите, тем больше 

Вопрос может быть использован Студентами без повторения тех же самых значений. 

 

Заметьте, что если вы удалили значения из списка, вы можете вернуть их обратно 

снова. Измените опцию «Next Item to Add (следующий элемент для добавления)» на 

«Reuse previous value if available (повторно использовать предыдущее значение, если 

возможно)», тогда следующий раз, когда вы добавите элементы, Moodle восстановит ваши 

ранее удалённые из набора данных элементы. 

Как только ваш список значений завершён, вы можете щёлкнуть «Save changes», 

чтобы окончить. 

Что делает кнопка «Обновить параметры наборов данных»? 
Предупреждение: Эта кнопка может воздействовать на несколько Вопросов, так 

что будьте осторожны с её применением. Предположим, что вы выбрали параметр набора 

данных такой, чтобы Шаблон Подстановки {a} принимал любое значение от 1 до 10 и 

сгенерировали Вопрос. Во втором Вопросе вы также решили применить СОВМЕСТНО 

ИСПОЛЬЗУЕМЫЙ Шаблон подстановки {a}. 
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Inherently, it will show a value between 1-10. However, your need here 

changes and you want to make it 11-100 instead. Then, you change them in 

the range and click this button. Voila! the values change and you can add 

new items here using the 'Get New item to add'. However, if you go back 

to your previous question, you will see that values would change there too, 

because it is a shared dataset. If you do not update parameters, then this 

may not happen and will generate a new set of values and displays them in 

the 'Item to Add' section. 

Correct answer formula syntax 
DO NOT PUT THE = sign in the formula. 

 In the recent versions of the calculated question type, you could have 

more than one answer formula and applied a specific grading value to 

each of them as long as there is at least one 100% correct answer 

formula. 

If more than one correct answer formula input field are displayed when 

editing, your site has the multiple answer feature.  

 As a general rule, write these formulas like you would in a calculator 

e.g. 3 + 5 * sin(3/{x}) A notable exception is exponentiation, where x3 

cannot be entered as {x}^3, but instead should be entered as pow({x}, 

3). 

 Each function's placeholders and other arguments should be in 

parentheses (brackets). For example, if you want students to calculate 

the sine of one angle and cosine of two times another angle, you would 

enter sin({a}) + cos({b}*2) or sin({a}) + cos(2*{b}). 

 It's usually better to have too many parentheses (brackets) than too few. 

The server won't care, and the more specific you are about what you 

mean, the more likely it will like your complex formulas. 

 There is no implicit multiplication. To you, the human editor, "5(23)" or 

"5x" may seem perfectly obvious. To the server doing the math, it's 

crazy talk and won't be understood. Always use the "*" for 

multiplication. 

 Any special mathematical function must have parentheses around its 

values. Take the sine function in the first bullet point for instance. 

Notice that the 3 / x is wrapped in parentheses (brackets)--this is so the 

server can understand it properly. Without those parentheses, the server 

won't know if you mean "(sin 3) / x" or "sin (3 / x)" and will reject the 

entire formula accordingly. 

 

 

По наследству он будет показывать значение между 1 и 10. Однако вам потребовались 

здесь изменения, и вы захотели изменить его значения на от 11 до 100. Тогда вы изменяете 

их на такой диапазон и щёлкаете эту кнопку. УРА! Значения изменились, и вы можете 

добавлять новые элементы здесь, используя Get New Item to Add. Однако, если вы 

вернётесь к вашему предыдущему Вопросу, вы увидите, что значения изменились и здесь 

тоже, из-за того, что это совместно используемый набор данных. Если вы не обновите 

параметры, тогда этого может не случиться, а будет сгенерирован новый набор значений, 

которые будут отображаться в разделе «Item to Add». 

Скорректируйте синтаксис формулы правильного ответа 
НЕ ПОМЕЩАЙТЕ знак = в формулу. 

 В последних версиях типа Вычисляемого Вопроса вы можете иметь более одной 

формулы ответа и применять отдельное значение Оценки для каждой из них до тех пор, 

пока существует, по крайней мере, одна формула 100% правильного ответа. 

 

Если при редактировании отображается более одного поля ввода формулы правильного 

ответа, значит, ваш Сайт имеет средство многократного ответа. 

 В качестве общего правила записывайте эти формулы подобно тому, как в 

калькуляторе, например, 3 + 5 * sin(3/{x}). Примечательным исключением является 

возведение в степень, где x3 не может быть введено как {x}^3, а вместо этого должно 

быть введено как pow({x}, 3). 

 Заполнители каждой функций или других аргументов должны быть в круглых скобках 

(квадратных скобках). Например, если вы хотите, чтобы Студенты вычислили синус 

одного угла и косинус двукратного другого угла, вы должны будете ввести sin({a}) + 

cos({b}*2) или sin({a}) + cos(2*{b}). 

 Лучше иметь слишком много круглых скобок (квадратных скобок), чем слишком мало. 

Сервер не будет беспокоиться, и чем более вы конкретизируете то, что подразумеваете, 

тем более вероятно, что ему понравятся ваши сложные формулы. 

 Подразумеваемого умножения не существует. Вам, редактору с человеческими 

возможностями, может показаться совершенно очевидной разница между «5(23)», так и 

«5x». Серверу, выполняющему математические вычисления, это станет непосильной 

задачей и невозможной для понимания. Всегда используйте «*» для умножения. 

 У любой конкретной математической функции значения должны быть заключены в 

круглые скобки. Возьмите, например, функцию из этого маркированного списка. 

Извещение, что 3/х заключено в круглые скобки (квадратные скобки) – это то, что 

сервер может понять правильно. Без этих круглых скобок сервер не узнает, что вы 

подразумеваете «(sin 3) / x» или «sin (3 / x)» и, соответственно, отвергнет формулу 

целиком. 
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Available functions 
Calculated questions can use more than simple arithmetic operators. The 

following functions are allowed in versions 1.5 and newer. 
 

Function Explanation 

abs Absolute value 

acos Arc cosine -- output in radians 

acosh Inverse hyperbolic cosine -- output in radians 

asin Arc sine -- output in radians 

asinh Inverse hyperbolic sine.-- output in radians 

atan2 Arc tangent of two variables -- pass in two values 

like (y, x), and you'll get the atan(y/x), adjusted to 

the proper quadrant. (Note: The variables are in the 

reverse order to atan2(x,y) in Excel) Output is 

radians 

atan Arc tangent -- output in radians 

atanh Inverse hyperbolic tangent-- output in radians. 

bindec Binary to decimal 

ceil Round fractions up 

cos Cosine -- in radians!!! Convert your degree 

measurement to radians before you take the cos of 

it 

cosh Hyperbolic cosine -- in radians!!! Convert your 

degree measurement to radians before you take the 

cosh of it 

decbin Decimal to binary 

decoct Decimal to octal 

deg2rad Converts the number in degrees to the radian 

equivalent 

exp Calculates the exponent of e 

expm1 Returns exp(number) - 1, computed in a way that is 

accurate even when the value of number is close to 

zero 

floor Round fractions down 

fmod Returns the floating-point modulus of two numbers 

- i.e. the remainder when the first is divided by the 

Second 

is_finite Finds whether a value is a legal finite umber 

 

 

Доступные функции 
Вычисляемые Вопросы могут использовать больше, чем простые арифметические 

операции. Следующие функции разрешены в версии 1.5 и выше (названия переменных – только 

на английском языке!!!) 

Функция Объяснение 

abs Абсолютное значение 

acos Арккосинус – результат в радианах 

acosh Универсальный гиперболический косинус – результат в радианах 

asin Арксинус – результат в радианах 

asinh Универсальный гиперболический синус – результат в радианах 

atan2 Арктангенс двух переменных – передаёт два значения, подобно 

(y, x), и вы получите atan(y/x), скорректированный к правильной 

четверти. 

(Замечание: Эти переменные находятся в обратном порядке по 

отношению к atan2(x,y) в Excel) – результат в радианах 

atan Арктангенс – результат в радианах 

atanh Универсальный гиперболический тангенс – результат в радианах 

bindec Двоичный в десятичный 

ceil Округление дробных до ближайшего большего целого 

cos Косинус – в радианах!!! Конвертируйте ваше измерение угла в 

радианы, прежде чем вычислять его косинус 

 

cosh Гиперболический косинус – в радианах!!! Конвертируйте ваше 

измерение в градусах в радианы, прежде чем вычислять его 

гиперболический косинус 

decbin Десятичный в двоичный 

decoct Десятичный в восьмеричный 

deg2rad Конвертирует число градусов в эквивалентное число радианов 

 

exp Вычисляет экспоненту e 

expm1 Возвращает exp(number) - 1, вычисляется способом, который 

остаётся точным даже если число близко к нулю 

 

floor Округление дробных до ближайшего меньшего целого 

fmod Возвращает в формате с плавающей точкой модуль двух чисел, т.е. 

остаток от деления первого числа на второе 

 

is_finite Устанавливает является ли значение легальным конечным числом 
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is_infinite Finds whether a value is infinite 

is_nan Finds whether a value is not a number 

log10 Base-10 logarithm 

 

log1p 

Returns log(1 + number), computed in a  

way that is accurate even when the value  

of number is close to zero 

log Natural logarithm (ln) 

max Find highest value 

min Find lowest value 

octdec Octal to decimal 

pi() 
Get value of pi - the function does not take  

an argument, like in Excel 

pow 

(numberToRaise, 

NumberRaisedTo) 

Exponential expression 

rad2deg 
Converts the radian number to the  

equivalent number in degrees 

rand Generate a random integer 

round Rounds a float 

sin 

Sine -- in radians!!! Convert your degree  

measurement to radians before you take the 

sin of it. 

sinh 

Hyperbolic sine -- in radians!!! Convert  

your degree measurement to radians before 

you take the sinh of it. 

sqrt Square root 

tan 

Tangent -- in radians!!! Convert your  

degree measurement to radians before you  

take the tan of it. 

tanh 

Hyperbolic tangent -- in radians!!! Convert 

 your degree measurement to radians before 

 you take the tanh of it. 

Predefined constants 
Actually there is NO Predefined constant that is allowed other than pi() as a function without 

parameter. 

Synchronization 
You could use shared wild cards to get the same values across  

questions in a quiz. 

A simple example will be to use the same radius in a first question asking for the perimiter of 

a circle of {radius}cm and a second 

is_infinite Устанавливает является ли значение бесконечным числом 

is_nan Устанавливает является ли значение не числом 

log10 Десятичный логарифм 

 

log1p 

Возвращает log(1 + number), вычисляется способом, который 

остаётся точным, даже если число близко к нулю 

 

log Натуральный логарифм (ln) 

max Находит максимальное число 

min Находит минимальное число 

octdec Восьмеричное в десятичный 

pi() Получить значение π – функция не имеет аргумента, подобно Excel 

 

pow (возводимое 

в степень число, 

степень) 

 

Степенное выражение 

rad2deg Преобразует число радианов в эквивалентное число градусов 

 

rand Генерирует случайное целое 

round Округляет число с плавающей точкой 

sin 

Синус – в радианах!!! Конвертируйте ваше измерение в градусах в 

радианы, прежде чем вычислять его синус 

 

sinh 

Гиперболический синус – в радианах!!! Конвертируйте ваше 

измерение в градусах в радианы, прежде чем вычислять его 

гиперболический синус 

sqrt Квадратный корень 

tan 

Тангенс – в радианах!!! Конвертируйте ваше измерение в градусах 

в радианы, прежде чем вычислять его тангенс 

 

tanh 

Гиперболический тангенс – в радианах!!! Конвертируйте ваше 

измерение в градусах в радианы, прежде чем вычислять его 

гиперболический тангенс 

Предопределённые константы 
В действительности НЕ существует предопределённой константы, которая бы 

допускала функцию, отличную от pi() без параметра. 

Синхронизация 
Вы можете применить совместно используемые Шаблоны Подстановки, чтобы 

получать те же самые значения во всех Вопросах в Экзамене. 

Простой пример будет состоять в применении того же самого радиуса в первом 

Вопросе, предлагающем вычислить периметр окружности радиуса {radius} см. и второй 
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question asking for the surface of a circle of {radius}cm. 

When the quiz will be shown to the student the two questions will shown 

the same {radius} value. 

However the synchronization will work ONLY if the questions are kept in 

the SAME category and have the SAME NUMBER OF DATASETS. 

 

If you need to move the synchronized questions to another category, you 

need to do it by editing the questions. 

(This restriction should be released by sept. 2010). 

See also 
Using Moodle forum discussions: 

 couple questions about "edit datasets page" in calculated questions 

 

 Capital vs lower case letters with units 

4.6.8.1.2.Simple Calculated 
Simple calculated questions offer a way to create individual numerical 

questions whose response is the result of a numerical formula which 

contain variable numerical values by the use of wildcards (i.e {x} , {y}) that 

are substituted with random values when the quiz is taken. 

 

The simple calculated questions offers the most used features of the 

calculated question with a much simpler creation interface. 

My first Simple calculated question 
As a first example you will create a question asking for the surface of a 

rectangle. Here are the quick steps we will go over in detail: 

 

 Create the question content with variables shown in {} 

 Enter the formula using the variables and set the tolerance 

 Determine the range of the generated set of variables that will appear in 

the question content 

 Review the generated set of question contents 

 Since it is your first, check your work from a student's view 

Initiating the creation process 
Go to the Question bank, select "create a new question" and in the pop-up 

window select the Simple calculated. The Simple calculated question 

interface will appear. Give a name to your question in the title. 

 

 

 

Вопрос, спрашивающий о площади круга радиусом {radius} см. 

Когда Экзамен будет показан Студенту, два Вопроса предложат одно и то же 

значение радиуса {radius}. 

Однако синхронизация будет работать, ТОЛЬКО если каждый Вопрос 

сохраняется В ОДНОЙ И ТОЙ ЖЕ Категории, и имеет ОДНО И ТОЖЕ ЧИСЛО 

НАБОРОВ ДАННЫХ. 

Если вам нужно переместить синхронизированные Вопросы в другую Категорию, 

вам нужно сделать это путём редактирования этих Вопросов. 

(Это ограничение должно быть снято в сентябре 2010). 

См. также 
Обсуждения на форуме по использованию Moodle: 

 Пара вопросов о «Странице редактирования наборов данных» в 

Вычисляемых Вопросах:. 

 Заглавные в сопоставлении со строчными буквами. 

4.6.8.1.2.Простые Вычисляемые 
Простые Вычисляемые Вопросы предлагают способ создания отдельных 

Числовых Вопросов, ответ на которые является результатом вычисления по формуле, 

которая содержит значения числовых переменных путём использования 

Шаблонов Подстановки (т.е. {x} и {y} (названия переменных – только на английском языке!!!)), 

которые замещаются случайными значениями, когда принимается Экзамен. 

Простые Вычисляемые Вопросы предлагают наиболее применяемые средства в 

Вычисляемом Вопросе, но со много более простым интерфейсом создания. 

Мой первый Простой Вычисляемый Вопрос 
В качестве первого примера вы можете создать Вопрос, спросив о площади 

прямоугольника. Вот быстрые шаги, через которые мы обстоятельно пройдём в 

Administration→Course administration→Question bank→Question→Select a category. 

 Создать содержимое Вопроса с переменными, показанными в {}. 

 Ввести формулу, используя переменные, и установить Допустимое отклонение. 

 Определить область генерируемого набора переменных, которые появятся в качестве 

содержимого Вопроса. 

 Просмотреть сгенерированный набор содержимого Вопроса. 

 Поскольку это ваш первый опыт, проверьте вашу работу с точки зрения Студента. 

Инициализация процесса создания 
Перейдите в Банк Вопросов, выберите «Create a new question (создать новый 

вопрос)» и во всплывающем окне выберите «Simple calculated (простой вычисляемый)». 

Появится интерфейс Простого Вычисляемого Вопроса. Задайте наименование вашему 

Вопросу (Question name) в заголовке. 

http://moodle.org/mod/forum/discuss.php?d=150923
https://moodle.org/mod/forum/discuss.php?d=230558
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The question text 
Fill the question text (note that the {param} names can be chosen at will. 

 

 

 

 

 

 

 

 

 

The Correct Answer Formula 
 
Fill the Correct Answer Formula using the {param} names used in the 

question text. 

 

 

 

 

Other answer and response parameters 
You will set the Grade to 100%, as this is the only answer in this question. 

Leave the other parameters as they appears (0.01 relative means ±1% 

tolerance). 

Find the {param} in the formula 
In simple calculated only the {param} that are in the formula will be used. 

In the question text, the {param} that are in the formula will appear with 

there numerical values. 

Any other {enclosed text} will appear as is i.e. {enclosed text}. 

 

 

Click on the button 
Click on the "Find the wild cards {x...} present in the correct answer 

formulas" button, then click "Wild cards parameters used to generate the 

values" and "Wild card(s) values". 

 

 

On reload the two {b} and {h} will be displayed. 

 

 

 

Текст Вопроса 
Заполните текст Вопроса (заметьте, что наименования в {param} могут быть 

выбраны по вашему желанию, но на английском языке!). 

 

 

 

 

 

 

 

 

Формула 
правильного ответа 

Заполните Формулу правильного ответа, используя наименования из {param}, 

использованные в тексте Вопроса (у нас {b} и {h}). 

 

 

 

 

Другие параметры ответа Студента и отклика Преподавателя 
Установите Оценку равной 100%, поскольку это единственный ответ (Студента) в 

этом Вопросе. 

Оставьте другие параметры такими, какими они появились (0.01 соответствует 

значению ±1% Допустимого отклонения). 

Найдите {param} в этой формуле 
В Простом вычисляем Вопросе могут быть применены только те {param} 

(параметры), которые есть в формуле (у нас: {b} и {h}). 

В тексте Вопроса параметры {param}, которые есть в формуле, появятся в виде их 

(сгенерированными Moodle) численных значений. 

Любой другой {вложенный текст} появится таким как есть, т.е. как {вложенный текст}. 

Щёлкните по каждой из этих кнопок 
Щёлкните по кнопке «Find the wild cards {x...} present in the correct answer formulas 

(найти шаблоны подстановки {x...}, которые представлены в формулах правильного 

ответа)», затем щёлкните «Wild cards parameters used to generate the values (параметры 

шаблонов подстановки, используемые для генерации значений)» и «Wild card(s) values 

(значения шаблона(ов) подстановки)». 

После перезагрузки будут отображены два параметра {b} и {h}. 
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Set the minimum and maximum values 
Here the {b} range has been set to a 15-20 range and the {h} range has 

been set to a 5-10 range as we want a rectangle with a larger base than 

height. 

Select the number of sets to generate (here 10) and to 
display (here 2) 
Just to illustrate that you can control the number of values displayed which 

is useful if you create 100 sets. 

Note that a valid question needs at least one set of {wild card} values. You 

will not be allowed to save the question if you don't do the next step. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Установите минимальное и максимальное значения 
Здесь область значений {b} установлена как область значений от 15 до 20, а 

область значений {h} – от 5 до 10, поскольку мы хотим иметь прямоугольник с большим 

основанием, чем высота. 

Выберите число наборов для генерации (здесь 10) и для отображения 
(здесь 2) 

Просто для иллюстрации того, что вы можете управлять рядом отображаемых 

значений, которые полезны, если вы создадите 100 наборов. 

Заметьте, что допустимый Вопрос нуждается, по крайней мере, в одном наборе 

{Шаблоне Подстановки} значений. Вам не будет позволено сохранить этот Вопрос, если 

вы не сделаете следующий шаг. 
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Click on the generate button 
Note the sets are shown in reverse order so the number indicates how many 

sets were created. 

 

The two sets illustrate that the variability defined by the Min and Max 

values. 

 

Note that the formula result is analyzed and the tolerance limit (here 1% 

relative) is shown 

 

The correct response that will be shown to the student is also shown. 

 

The 2 decimals where defined are the default values defined as the last 

parameter under the Correct formula. 

 

 

 

Click on the Save button 
Test your first Simple calculated question 
On the question bank click on the preview icon. 

Enter the result you have calculated yourself or click on the Fill with 

Correct button. 

The values should be identical... 

 

 

 

 

Editing a Simple Calculated question: Additional 
comments 

 
 Set the default question grade (i.e. the maximum number of marks for 

this question). 

 Set the Penalty factor (see Penalty factor below). Correct answer 

formula syntax for further details. 

 Choose the grade that the student will get for this question if they give 

this answer. This should be a percentage of the total marks available. 

For example, you could give 100% for a correct answer, and 50% for an 

answer that is nearly right. One of the answers must have a 100% 

grade. 

Щёлкните по кнопке Генерировать 
Заметьте, что наборы показываются 

в обратном порядке, а это число указывает, 

сколько наборов было создано. 

Два набора иллюстрируют, какая 

вариабельность определена минимальным и 

максимальным значениями. 

Заметьте, что результат формулы 

анализируется и показывается ограничение 

Допустимого отклонения (здесь 1%). 

Правильный ответ, который будет 

показан Студенту, также представлен. 

2 десятичных числа, которые 

определены, являются значениями по 

умолчанию, определёнными в качестве 

последнего параметра Формулы 

правильного ответа. 

Щёлкните кнопку «Save (сохранить)» 
Протестируйте ваш первый Простой вычисляемый Вопрос 

В Банке Вопросов щёлкните 

иконку предварительного просмотра. 

Введите результат, который вы 

вычислили сами, или щёлкните по кнопке 

«Fill with Correct (заполнить правильным 

значением)». 

Эти значения должны быть 

идентичны. 

Редактирование Простого 
Вычисляемого Вопроса: 
Дополнительные комментарии 
 Установите Оценку за этот Вопрос по умолчанию (т.е. максимальное число баллов за 

этот Вопрос). 

 Установите Штрафной фактор (см. «Штрафной фактор» ниже). Скорректируйте 

Синтаксис Формулы Правильного Ответа для дальнейшей информации. 

 Выберите Оценку, которую Студент получит за этот Вопрос, если он даст ответ на этот 

Вопрос. Это должен быть процент от доступных Итоговых баллов. Например, вы 

можете дать 100% за правильный ответ и 50% за ответ, который близок к правильному. 

Один из ответов должен иметь Оценку 100%. 



 

358 

 Determine the tolerance for error that you will accept in the answer. 

The tolerance and tolerance type settings combine to give a range of 

acceptable scores. So, if tolerance = t, correct answer = x and the 

difference between the user's answer and the 

 correct answer is dx, then the tolerance types are as follows: 

 

 Nominal - mark correct if dx <= t 

 Relative - mark correct if dx / x <= t 

 The next 2 settings, "Correct answer shows" and "Format" determine 

the precision of the Correct answer shown. They are not used for 

grading. 

 Add some feedback which the student will see if they enter this answer. 

 You can specify as many answer formulae as you like - click "Add 

another answer blank" to add more. 

 You can also specify units for the answers. For example, if you enter a 

unit of 'cm' here, and the accepted answer is 15, then the answers '15cm' 

and '15' are both accepted as correct. If you add more than one unit, you 

can also specify a multiplier. So, if your main answer was 5500 with 

unit W, you can also add the unit kW with a multiplier of 0.001. This 

means that the answers '5500', '5500W' or '5.5kW' would all be marked 

correct. Note that the accepted error is also multiplied, so an allowed 

error of 100W would become an error of 0.1kW. 

Penalty factor 
The 'penalty factor' only applies when the question is used in a quiz using 

adaptive mode - i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student will lose that proportion of the maximum 

grade upon each successive attempt. For example, if the default question 

grade is  

 

 

 

 

 

 

 

 

 

 

 Определите Допустимое отклонение для ошибки, которую вы примите в ответе. 

Настройки Допустимого отклонения и типа Допустимого отклонения комбинируются, 

чтобы задать область приемлемых Накопленных баллов. Итак, если Допустимое 

отклонение = t, Правильный ответ = x, а разница между ответом пользователя и 

 Правильным ответом есть dx, тогда типами Допустимого отклонения являются 

следующими: 

 Номинальный – балл корректируется, если dx <= t. 

 Относительный – балл корректируется, если dx/x <= t. 

 Следующие 2 настройки «Correct answer shows (демонстрации правильных ответов)» и 

«Format (формат)» определяют точность правильного ответа. Они не используются для 

оценивания. 

 Добавить некоторую Обратную Связь, которую Студент увидит, если введёт этот ответ. 

 Вы можете указать, сколько формул ответа вы предпочитаете, – щёлкните «Add another 

answer blank (добавьте другой бланк ответа)», чтобы добавить больше. 

 Вы можете также указать Единицы измерения для ответов. Например, если вы 

введёте здесь измерение в «см», а принятый ответ будет 15, тогда оба ответа «15 см» и 

«15» будут приняты как правильные. Если вы добавляете более одной единицы 

измерения, вы можете также указать множитель. Так что, если ваш главный ответ был 

5500 с единицей измерения W, вы можете также добавить единицу измерения kW с 

множителем 0.001. Это означает, что все ответы «5500», «5500W» или «5.5kW» будут 

помечены как правильные. Заметьте, что принятая ошибка также умножается, так что 

допустимой для 100W ошибкой станет ошибка 0.1kW. 

Штрафной фактор 
«Штрафной фактор» применяется, только когда Вопрос применяется в Экзамене, 

использующем адаптивный режим, – т.е. когда Студенту разрешены множественные 

попытки ответа на Вопрос даже внутри одной и той же попытки выполнить Экзамен. Если 

Штрафной фактор больше 0, тогда Студент при каждой успешной попытке будет терять 

пропорционально максимальной Оценке. Например, если Оценка по умолчанию за Вопрос 

равна  
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10, and the penalty factor is 0.2, then each successive attempt after the first 

one will incur a penalty of 0.2 x 10 = 2 points. 

Correct answer formula syntax 
DO NOT PUT THE = sign in the formula 
 In the recent versions of the calculated question type, you could have 

more than one answer formula and applied a specific grading value to 

each of them as long as there is at least one 100% correct answer 

formula. 

If more than one correct answer formula input field are displayed when 

editing, your site has the multiple answer feature.  

 As a general rule, write these formulas like you would in a calculator 

e.g. 3 + 5 * sin(3/{x}) A notable exception is  

exponentiation, where x3 cannot be entered as {x}^3, but instead 

should be entered as pow(x, 3). 

 Each function's placeholders and other arguments should be in 

parentheses (brackets). For example, if you want students to calculate 

the sine of one angle and cosine of two times of another angle, you 

would enter sin({a}) + cos({b}*2). 

 It's usually better to have too many parentheses (brackets) than too few. 

The server won't care, and the more specific you are about what you 

mean, the more likely it will like your complex formulas. 

 There is no implicit multiplication. To you, the human editor, "5(23)" or 

"5x" may seem perfectly obvious. To the server doing the math, it's 

crazy talk and won't be understood. Always use the "*" for 

multiplication. 

 Any special mathematical function must have parentheses around its 

values. Take the sine function in the first bullet  

point for instance. Notice that the 3 / x is wrapped in parentheses 

(brackets)--this is so the server can understand it properly. Without 

those parentheses, the server won't know if you mean "(sin 3) / x" or 

"sin (3 / x)" and will reject the entire formula accordingly. 

Available functions 
The available functions are the same as for the calculated question type. 

 

 

 

 

 

 

10, а Штрафной фактор равен 0.2, тогда каждая успешная попытка после первой попытки 

подвергнется Штрафному фактору – уменьшению на 0.2 x 10 = 2 балла. 

Скорректируйте синтаксис Формулы правильного ответа 
НЕ ПОМЕЩАЙТЕ знак = в формулу 
 В последних версиях Вычисляемого Вопроса вы можете иметь более одной формулы 

ответа и применять отдельное значение Оценки для каждой из них до тех пор, пока 

существует, по крайней мере, одна Формула 100% правильного ответа. 

 

Если при редактировании отображается более одного поля ввода Формулы правильного 

ответа, значит, ваш Сайт имеет средство многократного ответа. 

В качестве общего правила: записывайте эти формулы так, как и в калькуляторе, 

например, 3 + 5 * sin(3/{x}). Примечательным исключением является возведение в 

степень, где x3 не может быть введено как {x}^3, а вместо этого должно быть введено 

как pow({x}, 3). 

 Каждый указатель места заполнения функции или другие аргументы должны быть в 

круглых скобках (скобках). Например, если вы хотите, чтобы Студенты вычисляли 

синус одного угла и косинус двукратного другого угла, вы могли бы ввести 

sin({a}) + cos({b}*2). 

 Обычно лучше иметь слишком много круглых скобок (скобок), чем слишком мало. 

Сервер не будет беспокоиться, и чем более вы конкретизируете то, что подразумеваете, 

тем более вероятно ему понравятся ваши сложные формулы. 

 Подразумеваемого умножения не существует. Вам – редактору с человеческими 

возможностями может показаться совершенно очевидными «5(23)» или «5x». Серверу, 

выполняющему математические вычисления, это станет непосильной задачей и 

невозможной для понимания. Всегда используйте «*» для умножения. 

 Любая специальная математическая функция должна заключать свои значения в 

круглые скобки. Возьмите, например, функцию синуса в первом пункте настоящего 

маркированного списка. Заключение 3/х в круглые скобки (квадратные скобки) – это 

то, что сервер может понять правильно. Без этих круглых скобок сервер не узнает, что 

вы подразумеваете «(sin 3)/x» или «sin(3/x)» и, соответственно, отвергнет формулу 

целиком. 

Доступные функции 
Доступные функции являются теми же самыми, что и для Вопросов Вычисляемого типа. 
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Predefined constants 
Actually there is NO Predefined constant that is allowed other than pi() as 

a function without parameter. Pierre Pichet 00:00, 5 June 2009 (UTC) 

 

4.6.8.1.3.Calculated Multichoice 
Calculated multichoice questions are like multichoice questions with the 

additonal property that the elements to select can include formula results 

from numeric values that are selected randomly from a set when the quiz is 

taken. They use the same wildcards than Calculated questions and their 

wildcards can be shared with other Calculated multichoice or regular 

Calculated questions. 

 

 

The main difference is that the formula is included in the answer choice as 

{=...} i.e if you calculate the surface of a rectangle {={l}*{w}}. 

The value will be displayed as set by the Correct answer shows (0,1,2 

etc) and Format (decimals, significant figures). 

 

 

So a Choice text could be 

The rectangle surface is {={l}*{w}} cm2. 

If {l} = 4,0 , {w} = 2,5 , Correct answer shows 1 and Format decimals 

The choice will display as 

The rectangle surface is 10.0 cm2 

Handling of the wild cards, and the available functions is similar to the 

calculated question type. 

4.6.8.1.4.Description 
A Description question page simply shows some text (and possibly 

graphics) without requiring an answer. It is more of a label than a question 

type. 

TIP: When shuffling questions is turned off, this type of page can 

provide information to be used by a following group of questions. 

4.6.8.1.5.Essay 
The essay question type is intended for short answers of a paragraph or 

two, that one often finds on exams. For longer essays, Online text 

assignment or Upload a single file assignment are better choices. 

 

 

 

Предопределённые константы 
В действительности НЕ существует предопределённой константы, которая бы 

допускала отличную от pi() функцию без параметра. Пьер Пиче 00:00, 5 июня 2009 (по 

всеобщему скоординированному времени). 

4.6.8.1.3.Вычисляемые со множественным выбором 
Вычисляемые с множественным выбором Вопросы подобны Вопросам с 

множественным выбором, но с дополнительным свойством состоящем в том, что их 

элементы могут включать результаты формул из числовых значений, которые выбираются 

случайным образом из набора, когда принимается Экзамен. Они используют те же самые 

Шаблоны Подстановки, что и Вычисляемые Вопросы, и их Шаблоны Подстановки могут 

быть совместно использованы другими 

Вычисляемыми с Множественным Выбором Вопросами или обычными 

Вычисляемыми Вопросами. 

Основное отличие состоит в том, что формула включается в Выбор ответа как 

{=...}, т.е., если вы вычисляете площадь прямоугольника, то {={l}*{w}}. 

 

Значение будет отображаться так, как установлено параметрами Correct answer 

shows (0,1,2 и т.д.) и Format (decimals (десятичные дроби), significant figures (значащие 

цифры)). 

Так, текст Выбора мог бы быть 

Площадь прямоугольника есть {={l}*{w}} cm2. 

Если {l} = 4,0, {w} = 2,5, Correct answer shows=1 и Format=decimals, тогда 

Выбор будет отображён как 

Площадь прямоугольника есть 10.0 cm2. 

«Обработка Шаблонов Подстановки (п. 4.6.1.1.3)» и «Доступные функции 

(п. 4.6.1.1.6.)» подобны типу Вычисляемых Вопросов. 

4.6.8.1.4.Описание 
Страница Вопроса типа «Описание» просто показывает некоторый текст (и 

возможно графику) без требования ответа. Это больше похоже на этикетку, чем на тип 

Вопроса. 

Совет: Когда перемешивание Вопросов отключено, этот тип страницы может 

предоставить информацию для использования следующей группой Вопросов. 

4.6.8.1.5.Эссе 
Тип Вопроса-Эссе предназначен для коротких ответов из одного-двух параграфов, 

а не ответов, часто встречающихся на Экзаменах. Для длинных Эссе лучше выбрать 

Задания по составлению текста в режиме онлайн или Задания с ответом в виде одного 

файла. 
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Question set-up 
1. Choose a category 

2. Give the question a descriptive name - this allows you to identify it in 

the question bank. 

3. Enter the question in the 'question text' field 

4. Select an image to display if you want to add a picture to the question. 

For the student, it appear immediately after the question text. 

5. Set the 'default question grade' (i.e. the maximum number of marks for 

this question). 

6. Add 'General Feedback' if required. This is text that appears to the 

student after the question is graded. 

7. Set an input box size to indicate the length of answer expected. 

8. Allow attachments if required. 

9. Add information for graders as appropriate. 

10. Click Save changes to add the question to the category. 

Creating a response template 
When using the Essay question type, you can set a template which appears 

in the students' text editor to help them scaffold their response:   

       New feature in Moodle 2.5! 

 

 

Screenshot 1: «Response template in question set up screen» 

 

Screenshot 2: «What the student sees» 

 

 

 

 

Question grading 
The essay question will not be assigned a grade until it has been reviewed 

by a teacher and manually graded. Until that happens, the student's grade 

will be 0. 

To grade a student's answer in a quiz, follow the 'manual grading' link 

under quiz results in the navigation block. When manually grading an 

essay question, the grader is able to enter a custom comment in response to 

the essay and assign a score for the essay. 

 

 

 

 

Установка Вопроса 
1. Выберите Категорию Вопроса. 

2. Задайте Вопросу описательное наименование – это позволит вам идентифицировать его 

в Банке Вопросов. 

3. Введите вопрос в поле «Question text (текст вопроса)». 

4. Выберите изображение, если хотите поместить рисунок в Вопрос. Для Студента оно 

появится сразу после текста Вопроса. 

5. Установите «оценку за Вопрос по умолчанию» (т.е. максимальное число баллов за этот 

Вопрос). 

6. Добавьте «Общую Обратную Связь», если нужно. Это текст, который появится перед 

Студентом после того, как этот Вопрос будет оценён. 

7. Установите размер окошка для ввода, чтобы указать ожидаемую длину ответа. 

8. Позвольте присоединять файлы, если нужно. 

9. Добавьте подобающую информацию для Оценивающих. 

10. Щёлкните Save changes, чтобы добавить Вопрос в Категорию 

Создание Шаблона ответа           Новое средство в Moodle 2.5! 
При создании Вопроса-Эссе, вы можете установить Шаблон, который появится в 

текстовом редакторе Студента, чтобы помочь ему обустроить его ответ. 

 

 

 

 

 

 

 

 

 

1.Шаблон ответа на экране установки Вопроса  2. То, что видит Студент 

Оценивание Вопроса 
Вопросу-Эссе не будет назначена Оценка до тех пор, пока он не будет просмотрен 

Преподавателем и оценён вручную. Пока этого не случится, оценка Студента будет 

оставаться равной 0. 

Чтобы оценить ответ Студента на Экзамене, перейдите по ссылке «Manual grading 

(ручное оценивание)» под результатами Экзамена в Блоке Навигации. При оценивании 

Вопроса-Эссе вручную, Оценивающий может ввести комментарий клиента в качестве 

отклика на это Эссе, и назначить баллы за это Эссе. 
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Essay questions in a Lesson 
To grade lesson essay questions, first click on the name of the lesson in 

your course page. If there are essay questions to be graded, there will be a 

link saying "Grade essay questions". This link will open a screen showing 

how many ungraded essay questions there are. Ungraded essay questions 

will be in listed in red. Click the link for the essay you wish to grade. 

The essay grading screen shows the title of the question, the student's essay 

response, and a place you can write optional comments and give the essay 

a score. Click the Submit grade button to record your score and comments. 

Graded questions will be displayed in green. Repeat the process to finish 

grading. Click the "Email graded essays" link to email your responses to 

your students. 

 

See also 
 Using Moodle Grading essay questions forum discussion 

4.6.8.1.6.Matching 
Matching questions have a content area and a list of names or statements, 

which must be correctly matched against another list of names or 

statements. For example, "Match the Capital with the Country" with the 

two lists "Canada, Italy, Japan" and "Ottawa, Rome, Tokyo". In the Quiz 

Module, each match is equally weighted to contribute towards the grade 

for the total question. 

Question set-up in Question bank 
1. Select the question category 

2. Give the question a descriptive name - this allows you to identify it in 

the question bank. 

3. Enter some instructions in the 'Question text' field to tell the students 

what they are matching. 

4. Set the 'Default mark' (i.e. the maximum number of points for this 

question). 

5. If you wish, add general feedback. This is text that appears to the 

student after he/she has answered the question. 

6. Check the 'shuffle' box if you want the answers in the drop-down menus 

to be shuffled. Note: The Quiz display setting 

 

 

 

 

 

Вопросы-Эссе в Уроке 
Чтобы оценить Вопросы-Эссе Урока, сначала щёлкните по названию Вопроса на 

странице вашего Курса. Если есть Вопросы-Эссе, которые должны быть оценены, значит, 

будет присутствовать ссылка «Grade essay questions (оценить вопросы-эссе)». Эта ссылка 

откроет экран, показывающий, сколько имеется неоценённых Вопросов-Эссе. 

Неоценённые Вопросы-Эссе будут при перечислении подсвечены красным цветом. 

Щёлкните ссылку на Эссе, которое хотите оценить. 

Экран оценивания Эссе покажет заголовок этого Вопроса, отклик на Эссе Студента 

и место, куда вы сможете записать необязательные комментарии и присвоить баллы за это 

Эссе. Щёлкните кнопку «Submit grade (передать оценку)», чтобы записать ваш баллы и 

комментарии. Оценённые Вопросы будут отображаться зелёным цветом. Повторите 

процесс, чтобы закончить оценивание. Щёлкните ссылку «Email graded essays (отправить 

по почте оценённое эссе)», чтобы отправить по почте ваши ответы вашим Студентам. 

См. также 
 Обсуждения форума по использованию Moodle «Оценивание Вопросов-эссе». 

4.6.8.1.6.Вопросы на Сопоставление 
Вопросы на Сопоставление имеют область содержимого и список названий или 

предложений, которые должны быть корректно сопоставлены с другим списком названий 

или предложений. Например, «Сопоставьте столицу со страной» с двумя списками 

«Канада, Италия, Япония» и «Оттава, Рим, Токио». В модуле «Экзамен» каждое 

сопоставление имеет равный вес при внесении вклада в Оценку за Вопрос в целом. 

 

Установка Вопроса в Банк Вопросов 
1. Выберите Категорию Вопросов. 

2. Задайте Вопросу описательное название – это позволит вам идентифицировать его в 

Банке Вопросов. 

3. Введите некоторые инструкции в поле «Question text (текст вопроса)», чтобы сообщить 

Студентам, что они сопоставляют. 

4. Установите «Default mark (отметку по умолчанию)» (т.е. максимальное число баллов за 

этот Вопрос). 

5. Если вы желаете, добавьте общую Обратную Связь. Это тот текст, который появится 

перед Студентом после того, как он/она ответят на этот Вопрос. 

6. Пометьте окошко «Shuffle (перемешать)», если вы хотите, чтобы ответы в 

ниспадающем меню перемешивались. Замечание: Настройка отображения Экзамена  

http://moodle.org/mod/forum/discuss.php?d=159689
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must also be set to shuffle within a questions for this to work. For the 

first matching item, enter the question and a matching answer. 

7. Fill in at least two questions and three answers. Click 'Blanks for 3 

more questions' to add more. You can enter as many as 10 items (or 

more - see 'See also' below). You can provide extra wrong answers by 

giving an answer with a blank question. 

 

8. Set the 'Penalty for each incorrect try' (see grading below). 

9. Click Save changes to add the question to the category. 

Grading 
 Each sub-question is equally weighted to contribute towards the grade 

for the total question. For example a student who correctly matches 3 of 

the 4 possible matches will receive 3/4 or 75% of the total possible 

score for that question. 

 The 'penalty factor' only applies when the question is used in a quiz 

using adaptive mode - i.e. where the student is allowed multiple 

attempts at a question even within the same attempt at the quiz. If the 

penalty factor is more than 0, then the student will lose that proportion 

of the maximum grade upon each successive attempt. For example, if 

the default question grade is 10, and the penalty factor is 0.2, then each 

successive attempt after the first one will incur a penalty of 0.2 x 10 = 2 

points. 

Repeated entries 
It is possible to have repeated entries in one of the lists but care should be 

taken to make the repeats identical. For example "Identify the type of these 

creatures" with the lists "Ant, Cow, Dog, Sparrow" and "Insect, Mammal, 

Mammal, Bird". 

 

Ordered questions 
In the Quiz module, it is possible for both the question list and the answer 

list to be shuffled. The answer list is always shuffled. The "shuffle within 

questions" must be "Yes" as a quiz setting under Display AND the shuffle 

question box must be check on the individual question. 

 

 

 

 

 

 

 

также должна быть установлена, на перемешивание Вопросов для того, чтобы это 

работало. Для первого сопоставляемого элемента введите Вопрос и сопоставляющий 

ответ. 

7. Заполните, по крайней мере, два вопроса и три ответа. Щёлкните «Blanks for 3 more 

questions (бланки для трёх дополнительных вопросов)», чтобы добавить больше. Вы 

можете ввести целых 10 элементов (или больше – см. «См. также» ниже). Вы можете 

предоставить дополнительные неправильные ответы, задавая ответ с пустым Вопросом. 

8. Установите Штрафной фактор за каждую неверную попытку (см. «Оценивание» ниже). 

9. Щёлкните Save changes, чтобы добавить Вопрос в Категорию. 

Оценивание 
 Каждый подВопрос равновзвешен при внесении вклада в Оценку за Вопрос в целом. 

Например, Студент, который корректно сопоставил 3 из 4 возможных сопоставлений, 

получит 3/4 или 75% от суммарного возможного накопленного балла за этот Вопрос. 

 «Штрафной фактор» применяется, когда Вопрос используется в Экзамене с 

адаптивным режимом, – т.е. где Студенту позволены множественные попытки ответить 

на Вопрос, даже внутри одной и той же попытки выполнить Экзамен. Если Штрафной 

фактор больше 0, тогда Студент будет терять эту долю от максимальной Оценки при 

каждой успешной попытке. Например, если Оценка за Вопрос по умолчанию равна 10 и 

Штрафной коэффициент равен 0.2, тогда каждая успешная попытка после первой будет 

подвергаться штрафу из 0.2 x 10 = 2 баллов. 

 

 

Повторяющиеся записи 
Можно иметь повторяющиеся записи в одном из списков, но следует остерегаться 

делать идентичные повторения. Например, «Identify the type of these creatures 

(идентифицируйте тип этих созданий)» со списками «Ant, Cow, Dog, Sparrow (муравей, 

корова, собака, воробей)» и «Insect, Mammal, Mammal, Bird (насекомое, млекопитающее, 

млекопитающее, птица)». 

Упорядоченные Вопросы 
В модуле «Экзамен» возможно перемешивание как списка Вопросов, так и списка 

ответов. Список ответов перемешивается всегда. Опция «Shuffle within questions 

(перемешать вопросы)» должна быть установлена в «Yes», в то время как настройка 

Экзамена под «Display (отобразить)» И окошко «Shuffle question (перемешать вопросы)» 

должны быть помечены в каждом конкретном Вопросе. 
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Consider the question "Match the letter with its position in the alphabet" 

with the question list "1, 2, 3, 4" and answer list "A, B, C, D". The answer 

list is always shuffled for each student in the pull down list of the possible 

matches. However, only when both the quiz and individual question 

shuffles are turned on, will the question list be shuffled to something like 

"2,4,1,3". 

Lesson Module matching questions 
Matching questions are also used in the Lesson Module. However, while 

they look similar to the student, they are different for the teacher. Quizzes 

don't have jumps. 

 In the Lesson Module, all matches must be right for the question to be 

scored as correct. 

 What is called the question list in a Quiz, does not shuffle in the Lesson 

Module. In the earlier example, A, B, C , D will always be in that order 

and 1,2,3,4 will always be shuffled in the Lesson Module. 

 Lesson Module has an "answer" and a "matching answer" instead of a 

"question" and "answer". 

 In Lesson Module there has to be matching pairs. It is not possible to 

have 4 items in one list to match with 1 of 5 items in another list. Both 

lists will be equal in their number. 

Ordered questions in Lesson Module 
In the Lesson Module, unlike Multiple choice questions or the Quiz 

Module, the question list is always the same order and the choices are 

shown in a random order. 

Tips and tricks 
 Matching questions look better on screen if you put the longer piece of 

text in the question and not the match. For example, when vocabulary 

matching put the single word in the match and the definition sentence in 

the question. Otherwise the drop down for long questions will be 

awkward to use and difficult to read. 

 Matching questions in a Lesson module are slightly different than in a 

Quiz module when the teacher is in edit mode. For example, there are 

scoring differences and a quiz does not use jumps. 

 

 

 

 

 

 

Рассмотрим Вопрос «Match the letter with its position in the alphabet (сопоставить 

букву с её порядком в алфавите)» со списком вопросов «1, 2, 3, 4» и списком ответов «A, 

B, C, D». Список ответов всегда перемешивается для каждого Студента в ниспадающем 

списке возможных сопоставлений. Однако, только когда включено перемешивания и для 

Экзамена, и для конкретного Вопроса, список Вопросов будет перемешан что-то вроде «2, 

4, 1, 3». 

Вопросы на Сопоставление в модуле «Урок» 
Вопросы на Сопоставление также используются и в модуле «Урок». Однако, если 

для Студента они выглядят так же, то для Преподавателя – по-другому. Экзамены не 

имеют переходов (как в Уроках со страницы на страницу, в зависимости от ответа). 

 В модуле «Урок» все сопоставления для Вопроса должны быть выполнены правильно, 

чтобы он был оценён положительно. 

 То, что называется списком Вопросов в Экзамене, не перемешивается в модуле «Урок». 

Из предыдущего примера A, B, C, D всегда будет в таком порядке, а 1, 2, 3, 4 всегда 

будет перемешиваться в модуле «Урок». 

 Модуль «Урок» имеет опции «Answer (ответ)» и «Matching answer (сопоставление 

ответа)» вместо «Question (вопрос)» и «Answer». 

 В модуле «Урок» должно выполняться сопоставление пар. Невозможно иметь 4 

элемента в одном списке для сопоставления с элементами от 1 до 5 в другом списке. 

Оба списка должны иметь одинаковое число членов. 

Упорядоченные Вопросы в модуле «Урок» 
В модуле «Урок», в отличие от Вопросов со Множественным выбором (п. 4.6.3.8) 

или модулем «Экзамен»», список Вопросов всегда имеет тот же самый порядок, а 

альтернативы ответов показываются в случайном порядке 

Советы и трюки 
 Вопросы на Сопоставление выглядят на экране лучше, если текст Вопроса будет 

длиннее текста сопоставления. Например, при терминологическом сопоставлении текст 

сопоставления задать одним словом, а вопрос – определяющим предложением. Иначе, 

ниспадающий список (альтернатив ответов) для длинных Вопросов будет неудобным для 

использования и трудным для чтения. 

 Вопросы на Сопоставление в модуле «Урок» и модуле «Экзамен» отличаются 

незначительно для Преподавателя, когда он работает в режиме редактирования. 

Например, имеются отличия в оценивании и Экзамен не использует переходы 

(п. 4.3.9.4). 
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See also 
 Using Moodle Matching question type: more than 10 items forum 

discussion. 

4.6.8.1.7.Embedded Answers (Cloze) 
Embedded answers (Cloze) questions consist of a passage of text (in 

Moodle format) that has various answers embedded within it, including 

multiple choice, short answers and numerical answers. 

Until mid2013, there was no graphical interface to create these questions 

within your Moodle site - you needed to specify the question format using 

the text box or by importing them from external files. 

You can link to an external web site that does create these questions from a 

graphical interfase, see the Online Cloze Question quiz generator below. 

 

There is one Cloze editor module add-on in the Moodle plugins database 

for Moodle 1.9 and 2.x, that will let you create these questions from a 

graphical interfase within your Moodle site, but it will overwrite your 

current HTML editor. 

Lots of people suggested that Hot Potatoes software is the easiest way to 

create Embedded answer (Cloze) questions. Once you have created your 

questions on your PC, you can then import them into Moodle's quiz 

module. 

Question set-up 
1. Select the question category 

2. Give the question a descriptive name - this allows you to identify it in 

the question bank. 

3. Enter the passage of text (in Moodle format - see Format below) into 

the 'question text' field. 

4. Select an image to display if you want to add a picture to the question. 

For the student, it appears immediately above the question text. 

5. Set the 'default question grade' (i.e. the maximum number of marks for 

this question). 

6. Set the 'Penalty factor' (see Penalty factor below). 

7. If you wish, add general feedback. This is text that appears to the 

student after he/she has answered the question. 

 

 

 

 

 

См. также 
 Обсуждения форума по использованию Moodle «Тип вопросов на сопоставление: более 

чем 10 элементов». 

4.6.8.1.7.Встроенные ответы (Учебный тест) 
Вопросы со Встроенными ответами (Учебным тестом) состоят из прохождения 

текста (в формате Moodle), который имеет различные ответы, встроенные в внутрь него, в 

том числе с Множественным выбором, Краткими ответами и Числовыми ответами. 

До середины 2013 года не существовало никакого графического интерфейса для 

создания этих вопросов внутри вашего Сайта Moodle – вам нужно было указывать формат 

Вопроса, используя текстовое окошко или импортируя их из внешних файлов. 

Вы можете сослаться на внешний веб-Сайт, чтобы создать эти Вопросы в 

графическом интерфейсе, см. Онлайн-

Генератор Экзамена с Вопросами типа Учебных Тестов ниже. 

Существует один модуль редактора Учебного теста, встроенный в базу плагинов 

Moodle, для Moodle 1.9 и 2.x, что позволит вам создавать эти Вопросы в графическом 

интерфейсе внутри вашего Сайта Moodle, но он заменит ваш текущий редактор HTML. 

 

Многие люди предложили использовать программное обеспечение «Hot Potatoes 

(горячая Картошка)» как самый простой способ создавать Вопросы со Встроенными 

ответами (Учебным тестом). После того, как вы создали Вопросы на вашем компьютере, 

вы можете импортировать их в модуль «Экзамен» системы Moodle. 

Установка Вопроса 
1. Выберите Категорию Вопроса 

2. Дайте Вопросу описательное название – это позволит идентифицировать его в 

Банке Вопросов. 

3. Введите прохождение текста (в формате Moodle – см. «Формат» ниже) в поле «Question 

text (текст вопроса)». 

4. Выберите изображение, если вы хотите, чтобы оно отображалось в Вопросе. Для 

Студента оно предстанет непосредственно над текстом Вопроса. 

5. Установите «Default question grade (оценка вопроса по умолчанию)» (то есть 

максимальное количество баллов за этот Вопрос). 

6. Установите «Penalty factor (штрафной фактор)» (см. «Штрафной Фактор» ниже). 

7. Если хотите, добавьте общую Обратную Связь. Это текст, который появится перед 

Студентом после того как он/она ответил(а) на этот Вопрос. 

http://moodle.org/mod/forum/discuss.php?d=67314
http://moodle.org/mod/forum/discuss.php?d=67314
http://projects.ael.uni-tuebingen.de/quiz/htmlarea/index.php
http://projects.ael.uni-tuebingen.de/quiz/htmlarea/index.php
https://moodle.org/plugins/view.php?plugin=other_cloze
http://docs.moodle.org/25/en/Hot_Potatoes
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8. The editor has been modified and allows you to test if your syntax is 

good. The different questions elements decoded will be displayed and 

syntax errors pinpoint. However, it cannot check if the question 

decoded is two questions in one because of an error syntax. 

9. Click Save changes to add the question to the category. 

Penalty factor 
The 'penalty factor' only applies when the question is used in a quiz using 

adaptive mode - i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student will lose that proportion of the maximum 

grade upon each successive attempt. For example, if the default question 

grade is 10, and the penalty factor is 0.2, then each successive attempt after 

the first one will incur a penalty of 0.2 x 10 = 2 points.  

Question rendering 
The question answer INPUT HTML ELEMENT (Short and Numerical) or 

SELECT HTML ELEMENT (multichoice) are normally displayed in-line 

with the text. 

 

The size of INPUT HTML ELEMENT (Short and Numerical) will be 

adjustable to the length of the longest answer (good or bad) + a random 

number (0 to 15% total length). (Pierre Pichet 15:37, 26 January 2008 

(CST)) 

The size will adjust to the length of the student response when displayed in 

the grading and feedback process. 

The size of the SELECT HTML ELEMENT (multichoice) adjusts itself 

automatically to the longest answer. 

Format 
Questions consist of a passage of text (in Moodle format) that has various 

sub-questions embedded within it, including 

 short answers (SHORTANSWER or SA or MW), case is unimportant, 

 short answers (SHORTANSWER_C or SAC or MWC), case must 

match, 

 numerical answers (NUMERICAL or NM), 

 multiple choice (MULTICHOICE or MC), represented as a dropdown 

menu in-line in the text 

 multiple choice (MULTICHOICE_V or MCV), represented a vertical 

column of radio buttons, or 

 multiple choice (MULTICHOICE_H or MCH), represented as a 

horizontal row of radio-buttons. 

8. Редактор был модифицирован и позволяет проверить, хорош ли ваш синтаксис. Будут 

отображаться различные декодированные элементы Вопросов и точно указываться 

место синтаксических ошибок. Тем не менее, редактор не может проверить, является ли 

декодированный Вопрос двумя Вопросами в одном из-за ошибочного синтаксиса. 

9. Щёлкните кнопку Save changes, чтобы добавить Вопрос в Категорию. 

Штрафной Фактор 
«Штрафной Фактор» применяется, только когда Вопрос используется в 

Экзамене с Адаптивным Режимом – то есть там, где Студенту позволяется несколько 

попыток отвечать на Вопрос, даже в пределах одной сдачи Экзамена. Если 

Штрафной Фактор больше 0, то Студент потеряет эту часть от Максимальной Оценки 

при каждой последующей попытке. Например, если Оценка Вопроса по умолчанию равна 

10, а Штрафной Коэффициент равен 0,2, то каждая последующая попытка после первой 

подвергнется штрафу в размере 0,2 х 10 = 2 баллов. 

 

Визуализация Вопросов 
Ответ на Краткий Вопрос и Числовой Вопрос «Введите элемент HTML» или на 

Вопрос со Множественным Выбором «Выберите элемент HTML» обычно отображается в 

строке с текстом Вопроса. 

Размер текста «Введите элемент HTML» (для Краткого и Числового типа) будет 

отрегулирован по длине самого длинного ответа (хорошего или плохого) + случайное 

число (размером от 0 до 15% общей длины). (Пьер Пиче в 15:37, 26 января 2008 (по 

центральному поясному времени)). 

Размер будет отрегулирован по длине ответа Студента, когда он отображается в 

процессе оценивания или Обратной Связи. 

Размер «Выберите элемент HTML» (Множественный Выбор) регулирует сам себя 

автоматически по самому длинному ответу. 

Формат 
Вопросы состоят из прохождения текста (в формате Moodle), который имеет 

различные подВопросы внутри него, в том числе 

 Краткие ответы (SHORTANSWER или SA, или MW), вариант не имеет значения, 

 Краткие ответы (SHORTANSWER_C или SAC или MWC), вариант должен совпадать, 

 

 Числовые ответы (NUMERICAL или NM), 

 Множественный выбор (MULTICHOICE или MC), представляется в виде 

ниспадающего меню в строке текста Вопроса. 

 Множественный выбор (MULTICHOICE_V или MCV), представляет собой 

вертикальную колонку переключателей или 

 Множественный выбор (MULTICHOICE_H или MCH), представляются в виде 

горизонтальной строки переключателей. 
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The structure of each cloze sub-question is identical: 

{ start the cloze sub-question with a bracket (AltGr+7) 

1 define a grade for each cloze by a number (optional). This used for 

calculation of question grading. 

:SHORTANSWER: define the type of cloze sub-question. Definition is 

bounded by ':'. 

~ is a seperator between answer options 

= marks a correct answer 

# marks the beginning of an (optional) feedback message 

} close the cloze sub-question at the end with a bracket (AltGr+0) 

Now a very simple example: 

{1:SHORTANSWER:=Berlin} is the capital of Germany. 

For full details of the format for embedded-answers questions, see the 

detailed syntax explanation below. 

NB: Be careful when copying a cloze type question into the WYSIWYG 

HTML editor, as line breaks tend to get added, which destroys the 

question. 

If the correct answer contains } # ~ / “ or \ you will have to escape them by 

putting a \ in front of each such character. The { shouldn’t be escaped, this 

can be vital in getting TeX expressions to work. In the feedback ~ and } 

must be escaped otherwise it will be interpreted as the next answer or end 

of the short answer section respectively. Quotation signs: “ can lead to 

trouble anyhow in both places. Use the HTML entity: &quot; (without the 

space between & and quot;). If you want to have Mathematical symbols 

there can be problems with the \ used in TeX expressions. One alternative 

can be to use Unicode characters. 

See the notes further down about numerical embedded question! 

Examples 
Example 1 
The following text creates a simple embedded-answers question: 

Match the following cities with the correct state: 

* San Francisco: {1:MULTICHOICE:=California#OK~Arizona#Wrong} 

* Tucson: {1:MULTICHOICE:California#Wrong~%100%Arizona#OK} 

* Los Angeles: {1:MULTICHOICE:=California#OK~Arizona#Wrong} 

* Phoenix: {1:MULTICHOICE:%0%California#Wrong~=Arizona#OK} 

The capital of France is 

{1:SHORTANSWER:%100%Paris#Congratulations! 

~%50%Marseille#No, that is the second largest city in France 

(after Paris).~*#Wrong answer. The capital of France is Paris, 

of course.} 

Структура каждого подВопроса с Учебным тестом идентична: 

{start Вопрос с Учебным тестом со скобкой (AltGr+7) 

1 определяет Оценку числом для каждого Учебного теста (по желанию). Это используется 

для расчёта Оценки за Вопрос. 

:SHORTANSWER: определяет тип подВопроса с Учебным тестом. Определение 

заключается в «:». 

~ Является разделителем опций ответа. 

= Помечает собой правильный ответ. 

# Помечает начало (по желанию) сообщения Обратной Связи. 

} Завершает подВопрос с Учебным тестом скобкой (AltGr+0). 

Вот очень простой Вопрос: 

{1:SHORTANSWER:=Берлин} – это столица Германии. 

Полную информацию о формате Вопросов со Встроенными Ответами см. в 

подробном объяснении синтаксиса ниже. 

Обратите особое внимание: Будьте осторожны при копировании Вопроса с 

Учебным тестом в редактор WYSIWYG HTML, поскольку, как правило, при этом 

добавляются разрывы строк, что разрушает Вопрос. 

Если правильный ответ содержит } # ~ / “ или \ вам придётся экранировать их, 

поставив \ перед каждым таким символом. Символ { экранироваться не должен, так как он 

может быть жизненно важным для работы выражений TeX. В Обратной связи ~ и } 

должны быть экранированы, в противном случае они будут интерпретироваться как 

следующий ответ или конец Раздела с Кратким ответом, соответственно. Знаки кавычек: “ 

могут, так или иначе, привести к неприятностям в обоих случаях. Используйте объект 

HTML: &quot, (без промежутка между & и quot. Если вы хотите иметь математические 

символы, могут возникнуть проблемы с использованием \ в выражениях TeX. Одной из 

альтернатив может стать использование символов Unicode. 

См. примечания к Числовому Встроенному Вопросу ниже! 

Примеры 
Пример 1 

Следующий текст создаёт простой Вопрос со Встроенными ответами. 

Сопоставьте следующие города с правильным штатом: 

* Сан-Франциско: {1:MULTICHOICE:=Калифорния#Хорошо!~Аризона#Не верно} 

* Тусон:{1:MULTICHOICE:Калифорния#Не верно~%100%Аризона#Хорошо!} 

* Лос-Анджелес: {1:MULTICHOICE:=Калифорния #OK~Аризона#Не верно} 

* Финикс: {1:MULTICHOICE:%0%Калифорния#Неправильно~=Аризона#OK} 

Столицей Франции является 

{1:SHORTANSWER:%100%Париж#Поздравления! 

~%50%Марсель#Нет, это второй по величине город во Франции(после Парижа). 

~*#Неправильный ответ. Столицей Франции является Париж, конечно.} 

 



 

368 

And the result will be: 

Screenshot «Cloze question type». 

Example 2 

This question consists of some text with an answer embedded right here 

{1:MULTICHOICE:Wrong answer#Feedback for this wrong 

answer~Another wrong answer#Feedback for the other wrong 

answer~=Correct answer#Feedback for correct answer~%50%Answer that 

gives half the credit#Feedback for half credit answer} 

 

and right after that you will have to deal with this short answer 

{1:SHORTANSWER:Wrong answer#Feedback for this wrong 

answer~=Correct answer#Feedback for correct answer~%50%Answer that 

gives half the credit#Feedback for half credit answer} 

and finally we have a floating point number 

{2:NUMERICAL:=23.8:0.1#Feedback for correct answer 

23.8~%50%23.8:2#Feedback for half credit answer in the nearby region of 

the correct answer}. 

The multichoice question can also be shown in the vertical display of the 

standard moodle multiple choice. {2:MCV:1. Wrong answer#Feedback for 

this wrong answer~2. Another wrong answer#Feedback for the other 

wrong answer~=3. Correct answer#Feedback for correct answer~%50%4. 

Answer that gives half the credit#Feedback for half credit answer} 

Or in an horizontal display that is included here in a table {2:MCH:a. 

Wrong answer#Feedback for this wrong answer~b. Another wrong 

answer#Feedback for the other wrong answer~=c. Correct 

answer#Feedback for correct answer~%50%d. Answer that gives half the 

credit#Feedback for half credit answer} 

 

A shortanswer question where case must match. Write moodle in upper 

case letters {1:SHORTANSWER_C:moodle#Feedback  

for moodle in lower case ~=MOODLE#Feedback for MOODLE in upper 

case ~%50%Moodle#Feedback for only 

first letter in upper case} 

Note that addresses like www.moodle.org and smileys :-) all work as 

normal: 

a) How good is this? {:MULTICHOICE:=Yes#Correct~No#We have a 

different opinion} 

b) What grade would you give it? {3:NUMERICAL:=3:2} 

 

 

И результатом будет:  

Снимок с экрана «Тип Вопроса «Учебный тест» 

Пример 2 

Этот Вопрос состоит из некоторого текста со 

Встроенным Ответом: {1:MULTICHOICE:Неправильный 

ответ#Обратная Связь для этого неправильного 

ответа~Другой неправильный ответ#Обратная Связь для этого другого неправильного 

ответа~=Правильный ответ#Обратная Связь для правильного ответа~%50%Ответ, 

который приносит половину «Кредита»#Обратная связь на ответ с половиной «Кредита»} 

и справа от нго вы должны заняться Кратким ответом 

{1:SHORTANSWER:Неправильный ответ#Обратная Связь на этот неправильный 

ответ~=Правильный ответ#Обратная Связь для правильного ответа~%50%Ответ, который 

приносит половину «Кредита»#Обратная Связь для ответа с половиной «Кредита»} 

и окончательно мы имеем число с плавающей точкой 

{2:NUMERICAL:=23.8:0.1#Обратная связь для правильного 

ответа~%50%23.8:2#Обратная Связь для ответа с половиной «Кредита» в ближайшей 

области от правильного ответа}. 

Вопрос с Множественным Выбором может быть показан в вертикальном 

отображении стандартного модуля «Множественный выбор». {2:MCV:1. Неправильный 

ответ#Обратная Связь для этого неправильного ответа ~2. Другой неправильный 

ответ#Обратная Связь для другого неправильного ответа ~=3. Правильный ответ 

#Обратная связь для правильного ответа ~%50%4. Ответ, который даёт половину 

«Кредита»#Обратная Связь для ответа с половиной «Кредита»} 

Или в горизонтальном отображении, которое включается здесь в таблице 

{2:MCH:a. Неправильный ответ# Обратная связь для этого неправильного ответа 

~b.Другой неправильный ответ#Обратная Связь для другого неправильного ответа~=c. 

Правильный ответ#Обратная Связь для правильного ответа~%50%d. Ответ, который даёт 

половину «Кредита»#Обратная Связь для ответа с половиной кредита} 

Вопрос с Кратким Ответом, где вариант должен соответствовать. Запишите Moodle 

заглавными буквами {1:SHORTANSWER_C:moodle#Обратная Связь для moodle, 

записанной строчными буквами~=MOODLE#Обратная Связь для MOODLE, записанной 

заглавными буквами~%50%Moodle#Обратная Связь только для первой буквы в верхнем 

регистре} 

Заметьте, что адреса, подобные www.moodle.org, и смайлики  – всё работает как 

обычно: 

a) Насколько это хорошо? {:MULTICHOICE:=Да#Правильноt~Нет#Мы имеем 

другую опцию} 

b) Какую Оценку могли бы вы дать этому? {3:NUMERICAL:=3:2} 

http://www.moodle.org/
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Screenshot «Cloze example». 

Some things to note: 

 The individual embedded answers are represented by the code in braces 

{}. 

 The number at the start is the ‘weight’, so in this case each answer 

contributes an equal share of the overall grade. 

 The correct option in each case is preceded either by an = sign or by 

%100%. 

 The text appearing after the # that follows each option is the feedback 

that the student will see if they choose that option. 

 If the student enters ‘Marseille’ in the final example, they score 50% of 

the total grade. 

 The asterisk * preceding the “Wrong answer” feedback in the final 

example means that the student will see this feedback if they enter 

anything other than “Paris” or “Marseille”. 

 For multiple choice vertical or horizontal rendering there is no 

automatic numbering, though can added at each answer. 

Detailed syntax explanations 
1. all question items within a cloze-type question are coded inside curled 

braces { } 

2. the number which appears between the opening brace and the colon {1: 

is the weighting of that item; if it is set at 1 for all the items, it needs not 

be specified, so you can have {: 

3. after the colon we have the item question type: MULTICHOICE, 

SHORTANSWER, NUMERICAL NOTE. - If you have installed the 

REGEXP question type plugin you can also use the REGEXP question 

type 

4. the syntax for MULTICHOICE and SHORTANSWER is the same; the 

only difference is in the displaying of the item to the student 

5. the order of the various answers is indifferent (except if you want a 

catch-all for wrong answers, see #13 below) 

6. a correct answer is preceded with the equal sign = or a percentage 

(usually %100%) - Note: The equal sign (=) doesn't seem to work with 

SHORTANSWER. 

7. a wrong answer is preceded with nothing or a percentage (usually 

%0%) but you can even use negative points by preceding with ~%-25% 

[not before Moodle 2.0]) 

8. you can allocate some points between 0 and 100 to some answers, if 

you put the appropriate percentage 

 

Снимок с экрана: «Пример Учебного теста». 

Некоторые вещи на заметку: 

 Отдельные встроенные ответы представляются кодом в скобках {}. 

 

 Число в начале является «весом», так как в этом случае каждый ответ предлагает 

равное распределение общей Оценки. 

 Правильная опция в каждом случае должна предваряться либо знаком =, либо %100%. 

 Текст, появляющийся после знака #, который сопровождает каждую опцию, начинает 

Обратную связь, которую Студент увидит, если выберет эту опцию. 

 Если Студент введёт «Марсель» в последнем примере, он получит 50% от итоговой 

Оценки. 

 Звёздочка *, предшествующая Обратной связи для «Неправильного ответа» в 

последнем примере означает, что Студент увидит эту Обратную связь, если он введёт 

что-либо отличное от «Париж» или «Марсель». 

 Для вертикальной или горизонтальной визуализация множественного выбора не 

существует автоматической нумерации, хотя она может быть добавлена к каждому 

ответу. 

Подробные объяснения синтаксиса 
1. Все элементы Вопроса внутри Вопроса с Учебным тестом кодируются внутри 

фигурных скобок { } 

2. Номер, который появляется между открывающей скобкой и двоеточием {1:, является 

взвешиванием этого элемента; если оно установлено в 1 для всех элементов, что не 

нужно указывать, так как вы можете проста иметь {: 

3. После двоеточия указывается тип Вопроса этого элемента: MULTICHOICE, 

SHORTANSWER, NUMERICAL ЗАМЕЧАНИЕ. Если вы установили плагин для 

Вопросов типа REGEXP, вы можете также использовать и Вопросы типа REGEXP. 

 

4. Синтаксис для MULTICHOICE и SHORTANSWER тот же самый; единственное 

различие состоит в отображении этого элемента Студенту 

5. Порядок различных ответов безразличен (исключая тот случай, когда вы захотите 

захватить все неправильные вопросы, см. № 13 ниже) 

6. Правильный ответ начинается со знака равенства = или процента (обычно %100%) – 

Замечание: Знак равенства (=) не в состоянии работать с типом SHORTANSWER 

 

7. Неправильному ответу либо не предшествует никакой знак, либо предшествует 

процент (обычно %0%), но вы можете использовать даже отрицательные баллы, 

помещая в начале  ~%-25% [но не в версиях ниже Moodle 2.0]. 

8. Вы можете распределить некоторые баллы от 0 до 100 между некоторыми ответами, 

посредством установки подходящих процентов 

http://docs.moodle.org/25/en/File:Cloze_example.png
http://moodle.org/mod/data/view.php?d=13&rid=338
http://moodle.org/mod/data/view.php?d=13&rid=338
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9. all answers except the first one are separated from one another by the 

tilde ~ sign 

10. answers can be followed by an optional feedback message, preceded 

with the # sign; if there is no feedback message, the # sign can be 

present or absent, it does not matter 

11. note that the feedback message and (since Pierre Pichet 24 May 2008) 

in 1.9 the correct answer are displayed in a small popup window (if and 

when the correct and or feedback have been declared accessible to the 

students in the Quiz settings) upon mouse hovering. The popup window 

has a title "feedback" and you can use HTML tags to format your 

feedback. In some browsers (For example IE 5.5) the form fields can 

cover part of the feedback windows. It can help to not have the form 

fields for the answers too close to each other. 

12. in the SHORTANSWER type you may want to put a catch-all (wrong) 

answer in order to send a "wrong, try again" feedback; you can do this 

by inserting an asterisk * as the very last expected answer in your 

formula 

13. in the MULTICHOICE question type the answers are automatically 

scrambled 

Numerical Cloze questions 
From the student perspective, a numerical Cloze question looks just like a 

short-answer question or fill in the blanks. The difference is that numerical 

answers are allowed to have an accepted error. This allows a continuous 

range of answers to be set. You can also express your answer in some 

different numerical formats. 23.4 23,4 (some countries use , as a decimal 

separator) and 2.34E+1 (meaning 2.34*10^1) would be interpreted as the 

same. 

False positives 
Note: the following examples of false positives do not apply to Moodle 

1.8+, where you cannot use percentages or fractions as the answers in a 

numerical Cloze test; Moodle will generate an error if you try to save such 

a question. However the following may be relevant for earlier versions of 

Moodle. 

More examples:   

0.5 accepts .5 0.5 ,5 0,5 0.500 5e-1 5E-1 but not 1/2 50%    

50% accepts 50% 50.0% 5E1% 50/100 even 50/1000 50 but not 500/1000 

0.5 

1/2 accepts 1/2 1/3 1twenty but not 2/4 0.5 0,5 3/6 50% ½   

½ accepts ½   

HALF doesn't even accept HALF (maybe 0?)   

9. Все ответы, исключая первый, отделены друг от друга знаком тильда ~ 

 

10. За ответом может следовать, если хотите, сообщение Обратной Связи, предшествуемое 

знаком #, если сообщения Обратной Связи нет, знак # может присутствовать или 

отсутствовать, это не имеет значения 

11. Заметьте, что сообщение Обратной Связи и (со времени Пьера Пиче 24 мая 2008 г.) 

правильный ответ в версии 1.9 отображаются в небольшом всплывающем окне при 

зависании указателя мыши (если и когда правильный ответ и/или Обратная Связь 

объявляются доступными Студентам в настройках Экзамена). Всплывающее окно 

имеет заголовок «Feedback» и вы можете использовать теги HTML, чтобы 

отформатировать вашу Обратную Связь. В некоторых браузерах (например, IE 5.5) 

поля формы могут покрывать часть окошек Обратной Связи. Это может помочь не 

иметь поля формы для ответов слишком близко расположенными друг к другу. 

12. В типе SHORTANSWER вы можете захотеть захватить все (неправильные) ответы, для 

того чтобы отослать Обратную Связь «неправильно, попробуйте снова»; вы можете 

сделать это, вставив звёздочку * в качестве самого последнего ожидаемого ответа в 

вашей формуле 

13. В Вопросе типа MULTICHOICE ответы автоматически перемешиваются. 

 

Числовые Вопросы с Учебным Тестом 
С точки зрения Студента числовые Вопросы с Учебным Тестом выглядят так же, 

как Вопросы с Кратким Ответом или Заполнить пропуски. Различие состоит в том, что 

Числовым ответам позволяется иметь приемлемые ошибки. Это допускается установкой 

непрерывной области ответов. Вы можете также выразить ваш ответ в некоторых других 

числовых форматах. 23.4, 23,4 (некоторые страны используют в качестве десятичного 

разделителя запятую) и 2.34E+1 (означающее 2.34*10^1), интерпретируемые, как одно и 

то же число. 

Ложные срабатывания 
Замечание: Следующие примеры ложных срабатываний не применимы к Moodle 

1.8 и выше, где вы не можете использовать проценты или дроби в качестве ответов в 

Числовых Учебных Тестах; Moodle сгенерирует ошибку, если вы постараетесь сохранить 

такой Вопрос. Однако следующее может быть релевантным ранним версиям Moodle. 

 

Дальнейшие примеры: 

0.5 принимает .5 0.5 ,5 0,5 0.500 5e-1 5E-1, но не 1/2 50%    

50% принимает 50% 50.0% 5E1% 50/100 даже 50/1000 50, но не 500/1000 0.5 

 

1/2 принимает 1/2 1/3 двенадцатой, но не 2/4 0.5 0,5 3/6 50% ½ 

½ принимает ½   

HALF не принимает даже HALF (может быть 0?)   

http://docs.moodle.org/25/en/User:Pierre_Pichet
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If you want to accept several variants you can have them in the same {} 

but be careful, notice the "false positives" in bold! 

Syntax for numerical Cloze questions 
The format of a NUMERICAL Cloze question is similar to that of the 

other Cloze types and they can be mixed in the same question. As with 

other Cloze tests, you write your question or incomplete text, and add the 

Cloze code at the point where the student is supposed to enter their 

numerical answer. 

An example of the syntax used is shown below: 

Note: It is preferable to write the code in 'source code' mode. The 

WYSIWYG editor can insert linebreaks that make the question not 

function. The linebreak in the example box below is for readability only! A 

problem with these questions is the readability of the code! :( 

{2:NUMERICAL:=23.8:0.1#Feedback for correct answer 23.8   

~%50%23.8:2#Feedback for ½credit near correct answer}.    

In this example: 

 2: is the question point weight, which means that this question has twice 

the weight in the final point(s) for this question as other partial answers 

with weight 1 (or no declared weight – you can start with {: for the 

default weight 1) in the same question. 

 NUMERICAL: says what kind of question it is. It must be in CAPS. 

 

 =23.8:0.1 = or %100% means correct if the answer is 23.8 with an 

accepted error of 0.1, then any number between 23.7 and 23.9 will be 

accepted as correct. (In the GIFT numerical question one can express an 

interval like this 13..15 or 14:1 but in Cloze only 14:1 works.) 

 #Feedback for correct answer 23.8 is preceded by # 

 ~%50%23.8:2~ is the separator for answer alternatives %50% means 

this answer would get 50% of the score that the more precise answer 

had gotten. Because the tolerance here is 2, 21.8 to 25.8 would get this 

point and feedback. 

The feedback (which is seen within a popup window when the user hovers 

over the answer space) is formattable with HTML tags. For example, if 

you want an exponent, surround it with superscript tags: <sup> </sup>. 

You can even include pictures in the feedback popup, but you must clean 

out all “ characters and save while still in source code mode (not 

WYSIWYG). So, this works in feedback popup: 

#See this picture:<br><img src=Something.gif />}   

 

 

Если вы хотите принять несколько вариантов, вы можете заключить их в те же 

самые {}, но будьте осторожны, помня о «ложных срабатываниях»! 

Синтаксис для Числовых Вопросов с Учебным тестом. 
Формат Числового Вопроса с Учебным Тестом подобен форматам других типов 

таких тестов, а они могут быть смешаны в одном и том же Вопросе. Так как с другими 

такими тестами, вы записываете ваш Вопрос или неполный текст, и добавляете код теста 

там, где Студенту предлагается ввести его числовой ответ. 

Пример используемого синтаксиса показан ниже. 

Замечание: Предпочтительно записать этот код в режиме «source code (исходный 

код)». Редактор WYSIWYG может вставить прерывания строк, которые сделают Вопрос 

не функциональным. Прерывание строки в окошке примера ниже приведено только для 

читабельности! Проблема с этими Вопросами состоит в читабельности кода! :( 

 

{2:NUMERICAL:=23.8:0.1#Обратная связь для правильного ответа 23.8~%50%23.8:2# 

Обратная связь для ½ «Кредит» в диапазоне правильного ответа}. 

В этом примере: 

 2: – вес Вопроса в баллах, который означает, что этот Вопрос имеет двойной вес в 

Итоговых баллах за этот Вопрос по сравнению с другими частичными ответами в том 

же самом Вопросе с весом 1 (или с не объявленным весом – вы можете начать Вопрос с 

{: для задания по умолчанию веса, равного 1). 

 NUMERICAL: говорит о типе этого Вопроса. Тип Вопроса пишется заглавными 

буквами. 

 =23.8:0.1 или %100% означает правильно, если ответ 23.8 в приемлемом диапазоне 

ошибки 0.1, т.е. любое число от 23.7 до 23.9 принимается в качестве правильного. (В 

числовом Вопросе GIFT диапазон ошибки может быть выражен интервалом подобным 

13..15 или 14:1, но в Учебном Тесте работает только 14:1). 

 #Обратная связь для правильного ответа 23.8 предваряется знаком # 

 ~%50%23.8:2~ – разделитель альтернатив ответа, причём %50% означает, что этот 

ответ получит 50% от баллов, который получит наиболее точный ответ. Поскольку 

Допустимое отклонение здесь равно 2 ответ от 21.8 до 25.8 получит эти баллы и 

Обратную Связь. 

Обратная Связь (которую увидят во всплывающем окне, когда пользователь 

зависнет указателем мыши над пространством для ответа) форматируется тегами HTML. 

Например, если вам нужна экспонента, заключите её надстрочными тегами <sup> </sup>. 

Вы можете даже включить картинки во всплывающую Обратную Связь, но вы должны 

избавиться от всех символов “ и сохранить ещё раз в режиме «source code» (не 

WYSIWYG). Так это работает во всплывающей Обратной Связи: 

#См. эту картинку:<br><img src=Какая-то.gif/>}  
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but not this: 

#See this picture:<br><img src=”Something.gif” />}   

(ALGEBRA and TEX filters don’t work in the feedback popups, but they 

can be very useful in the question writing for math/science expressions). 

But you can use Unicode characters. 

If you want to give feedback for any answer that didn’t fit the intervals you 

already have specified feedback for, add some BIG general intervals, like 

for positive answers (if they aren’t bigger than 20000 you could add): 

~%0%10000.0001:10000#Feedback for unspecified not_right answers} 

This would give feedback for anything from 0.0001 to 20000.0001 (that 

hadn't already gotten feedback). I didn't want to include 0 since that special 

case as well as negative ought to have specific reactions. 

~%0%0#Hey! It can't be zero   

~%0%-10000.0001:10000#We just want the size here,   

so a negative value is not what we want}     

Numerical questions could, before version 1.7, also have case-

insensitive non-numerical answers. This is useful whenever the answer for 

a numerical question is something like +inf, -inf, NaN etc. 

Importing CLOZE questions 
If you try importing directly as CLOZE this text: 

 

Single line per question! Match the following cities with the correct state: 

* San Francisco: {1:MULTICHOICE:=California#OK~Arizona#Wrong} 

* Tucson: {1:MULTICHOICE:California#Wrong~%100%Arizona#OK} 

* Los Angeles: {1:MULTICHOICE:=California#OK~Arizona#Wrong} 

* Phoenix: {1:MULTICHOICE:%0%California#Wrong~=Arizona#OK} 

The capital of France is 

{1:SHORTANSWER:%100%Paris#Congratulations!~%50%Marseille#No

, that is the second largest city in France (after Paris).~*#Wrong answer. 

The capital of France is Paris, of course.}. 

23+ 0.8 = {2:NUMERICAL:=23.8:0.1#Feedback for correct answer 23.8 

~%50%23.8:2#Feedback for ½credit near correct answer}.   

You would get all three questions as different parts of ONE question. 

(NOTE see that there are no linebreaks between the { }!) 

Multiple CLOZE questions can be imported using the XML format: 

 

 

 

 

но не это: 

# См. эту картинку:<br><img src=”Какая-то.gif”/>}  

(Фильтры ALGEBRA и TEX не работают во всплывающей Обратной Связи, но они 

могут быть очень полезны при написании математических/научных выражений). Но вы 

можете использовать символы Unicode. Если вы хотите дать Обратную Связь для любого 

ответа, который не включает интервалы, которые вы уже указали для Обратной Связи, 

добавьте некоторые общие интервалы BIG, похожие на те, что для положительных ответов 

(если они не больше 20000, которые вы могли бы добавить): 

~%0%10000.0001:10000#Обратная Связь для не указанных неправильных ответов} 

Это могло бы быть Обратной Связью для любого ответа от 0.0001 до 20000.0001 

(который уже не получил Обратную Связь). Я не хочу включать 0, так как это 

специальный случай в дополнение к отрицательному следует иметь специальные реакции. 

~%0%0#Эй! Это не может быть нулём   

~%0%-10000.0001:10000#Мы просто хотим здесь размер, так что отрицательное значение 

– это не то, что мы хотим}    

Числовые Вопросы могли бы, до версии 1.7, также иметь чувствительные к регистру не 

числовые ответы. Это полезно всякий раз, когда ответ для числового Вопроса выглядит 

наподобие +inf, -inf, NaN и т.д. 

Импортирование Вопросов с Учебным Тестом 
Если вы постараетесь импортировать непосредственно в качестве такого 

Учебного Теста этот текст: 

Единственная строка на Вопрос! Сопоставьте следующие города с правильными штатами: 

* Сан-Франциско:{1:MULTICHOICE:=Калифорния#Хорошо!~Аризона#Неверно} 

* Тусон:{1:MULTICHOICE:Калифорния#Неверно~%100%Аризона#Хорошо!} 

* Лос-Анджелес:{1:MULTICHOICE:=Калифорния#Хорошо!~Аризона#Неверно} 

* Финикс:{1:MULTICHOICE:%0%Калифорния#Неверно~=Аризона#Хорошо!} 

Столицей Франции является 

{1:SHORTANSWER:%100%Париж#Поздравления!~%50%Марсель#Нет, это второй по 

величине город во Франции (после Парижа).~*#Неправильный ответ. Столица Франции, 

конечно, Париж.}. 

23+ 0.8 = {2:NUMERICAL:=23.8:0.1#Обратная Связь на правильный ответ 23.8 

~%50%23.8:2#Обратная связь на ½»Кредита» в диапазоне правильного ответа}. 

Вы получите все три Вопроса как различные части ОДНОГО Вопроса. 

(ЗАМЕТЬТЕ, что между { } нет разрывов строк!) 

Вопросы типа Учебного Теста с Множественными Ответами могут быть 

импортированы с использованием формата XML: 
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<?xml version="1.0" encoding="UTF-8"?> 

<quiz> 

<!-- question: 1  --> 

<question type="cloze"> 

<name><text>Book Test #1</text> 

</name> 

<questiontext> 

<text><![CDATA[..............]]></text> 

</questiontext> 

<generalfeedback> 

<text></text> 

</generalfeedback> 

<shuffleanswers>0</shuffleanswers> 

</question> 

<!-- question: 2 --> 

<question type="cloze"> 

<name><text>Book Test #2</text> 

</name> 

<questiontext> 

<text><![CDATA[............]]></text> 

</questiontext> 

<generalfeedback> 

<text></text> 

</generalfeedback> 

<shuffleanswers>0</shuffleanswers> 

</question> 

</quiz> 

You would put the question text including CLOZE code in the ....... spaces. 

 

Online Cloze Question quiz generator 
 There is a website to generate CLOZE quizzes for Moodle (1.9 and 2.x 

versions) and/or to try out the CLOZE editor integration for Moodle. 

 This editor was built at the Chair of Applied English Linguistics at 

Universitaet Tuebingen, Germany, by Andreas Glombitza 

(andiglombitza(at)googlemail.com) and Achim Skuta 

(achim.skuta(at)googlemail.com). 

 The authors are currently maintaining this software and webservice as a 

private project. 

Website: http://projects.ael.uni_tuebingen.de/quiz/htmlarea/index.php. 

 

<?xml version="1.0" encoding ="UTF-8"?> версия 1.0, кодировка UTF-8 

<quiz>      экзамен (начало) 

<!-- question: 1 -->    вопрос 1 

<question type="cloze">   тип вопроса: Учебный тест 

<name><text>Book Test #1</text>  наименование: тест книги 1 

</name> 

<questiontext> 

<text><![CDATA[..............]]></text>  текст вопроса 

</questiontext> 

<generalfeedback> 

<text></text>     текст обратной связи 

</generalfeedback> 

<shuffleanswers>0</shuffleanswers>  перемешивание ответов 

</question> 

<!-- question: 2 -->    вопрос 2 

<question type="cloze">   тип вопроса: Учебный тест 

<name><text>Book Test #2</text>  наименование: тест книги 2 

</name> 

<questiontext> 

<text><![CDATA[............]]></text>  текст вопроса 

</questiontext> 

<generalfeedback> 

<text></text>     текст обратной связи 

</generalfeedback> 

<shuffleanswers>0</shuffleanswers>  перемешивание ответов 

</question> 

</quiz>      экзамен (конец) 

Вы можете поместить текст Вопроса, включая код заполняемого (Учебного) теста, 

на место «........» пробелов 

Онлайн-генератор Вопросов с Учебным Теста для Экзамена 
 Существует веб-Сайт для генерации Экзаменов с Учебным Тестом для Moodle (версий 

1.9 и 2.х) и/или испытайте сборку редактора CLOZE для Moodle. 

 Этот редактор разработан Андреасом Гломбитцей на кафедре прикладной английской 

лингвистики в университете Тюбингена Германии (andiglombitza на googlemail.com) и 

Ахметом Скутой (achim.skuta на googlemail.com). 

 

 В настоящее время авторы поддерживают это программное обеспечение и веб-службу 

как частный проект. 

Веб-Сайт: http://projects.ael.uni_tuebingen.de/quiz/htmlarea/index.php. 

http://projects.ael.uni_tuebingen.de/quiz/htmlarea/index.php
http://projects.ael.uni_tuebingen.de/quiz/htmlarea/index.php
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See also 
 See the Moodle add-on in the Moodle plugins database that will let you 

create these questions from a graphical interfase within your Moodle 

site, but it will overwrite your current TinyMCE editor. 

 See the online Cloze question generator. 

 Download the newest version of the Cloze editor module for Moodle 

1.9, 2.0, 2.1 and 2.4 (compatible with 2.5) from google code 

This information was drawn from: 

 Using Moodle Is there a guide to using the cloze format? forum 

discussion 

 Using Moodle Cloze-type question syntax forum post 

 

4.6.8.1.8.Multiple Choice 
Moodle provides teachers with a lot of flexibility when creating this 

common question type. You can create single-answer and multiple-answer 

questions, include pictures, sound or other media in the question and/or 

answer options (by inserting HTML) and weight individual answers. 

Remember that Lesson module questions behave differently. 

There are two types of multiple choice questions - single answer and 

multiple answer. 

Single-answer questions 
These questions allow one and only one answer to be chosen by providing 

radio buttons next to the answers. You will specify non-negative marks for 

each answer, usually zero marks for wrong answers, maximum marks for 

correct answers and partial marks for partially correct answers. 

 

Multiple-answer questions 
The teacher can select "multiple answers are allowed" in a Multiple Choice 

question type. "Multiple answers" questions types in a quiz allow one or 

more answers to be chosen by providing check boxes next to the answers. 

Each answer may carry a positive or negative grade, so that choosing ALL 

the options will not necessarily result in good grade. If the total grade is 

negative then the total grade for this question will be zero. 

 

Feedback can be associated either with specific answers, or with the 

question as a whole. 

 

 

 

См. также 
 См. «Встроенные программы Moodle в базе данных Плагинов Moodle», что позволит 

вам создавать эти Вопросы из графического интерфейса внутри вашего Сайта Moodle, 

но он заменит ваш текущий редактор TinyMCE. 

 См. Онлайн-генератор Вопросов Учебного Теста. 

 Загрузите новейшую версию модуля редактора заполняемого теста для Moodle 1.9, 2.0, 

2.1 и 2.4 (сравнима с 2.5) с Сайта из кода Google. 

Эта информация переписана с: 

 Обсуждения форума по использованию Moodle «Есть руководство по использованию 

формата Учебного теста». 

 Корреспонденции форума по использованию Moodle «Синтаксис вопросов типа 

Учебного теста». 

4.6.8.1.8.Множественный Выбор 
Moodle предоставляет Преподавателям большую гибкость при создании этого 

общего типа Вопросов. Вы можете создать Вопросы с Единственным Ответом и с 

несколькими ответами, включить фотографии, звук или другие средства информации в 

опции Вопроса и/или ответа (вставкой HTML) и взвесить отдельные ответы. Помните, что 

вопросы модуля «Урок» (п. 4.3.9) ведут себя по-другому. 

Есть два типа Вопросов Множественного Выбора: с Единственным Ответом и с 

Многими Ответами. 

Вопросы с Единственным Ответом 
Эти Вопросы позволяют выбрать один и только один ответ посредством 

предоставления переключателей рядом с ответами. Вы будете определять 

неотрицательные оценки за каждый ответ, и, как правило, нулевые оценки за 

неправильные ответы, максимальные отметки за правильные ответы, и дробные оценки за 

частично правильные ответы. 

Вопросы с Многими Ответами 
Преподаватель может выбрать «Multiple answers are allowed (многие ответы 

разрешены)» в типе Вопросов с Множественным Выбором. Типы Вопросов с «Многими 

Ответами» в Экзамене позволяют выбрать один или несколько ответов, посредством 

предоставления окошек-флажков рядом с ответами. Каждый ответ может принести 

положительную или отрицательную Оценку, так что выбор ALL (все) не обязательно 

приведёт в хорошей Оценке. Если суммарная Оценка отрицательная, то итоговая Оценка 

за этот Вопрос будет равна нулю. 

Обратная Связь может быть связана либо с конкретными ответами, либо с 

Вопросом в целом. 

https://moodle.org/plugins/view.php?plugin=other_cloze
http://projects.ael.uni-tuebingen.de/quiz/htmlarea/index.php
http://docs.moodle.org/25/en/Cloze_editor_module
google
http://moodle.org/mod/forum/discuss.php?d=36521
http://moodle.org/mod/forum/discuss.php?d=36521
http://moodle.org/mod/forum/discuss.php?d=36430&parent=170308
http://moodle.org/mod/forum/discuss.php?d=36430&parent=170308
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Question set-up 
 Select the question category 

 Give the question a descriptive name. You'll use the name to track your 

questions later so "Question 1" isn't a good idea. The name will be used 

in the question lists on the quiz editing page or in the lesson as a page 

title. It will not be shown to the students, so you can choose any name 

that makes sense to you and possibly other teachers. 

 

 Create the question text. If you're using the HTML Editor, you can 

format the question just like a word processing document. 

 Select an image to display if you want to add a picture to the question. 

The available images are those you have uploaded to the main Moodle 

files area (they cannot be in folders). For the student, the image appears 

immediately after the question text and before the answer options. 

 Alternatively, if you used the HTML editor to create the question 

text, you can click the image icon. This will pop up the Insert Image 

window. You can choose to upload an image into your files area 

from this window, or you can add the URL of an image on the web. 

If you add a file to your files area, click the name of the file after 

you upload it to insert the link into the URL text entry at the top of 

the screen. Then click OK. 

 Set the 'default question grade' (i.e. the maximum number of marks for 

this question). 

 Set the 'Penalty factor' (see Penalty factor below). 

 Moodle 1.7+: If you wish, add general feedback. This is text that 

appears to the student after he/she has answered the question. 

 Choose whether students can only select one answer or multiple 

answers 

 Choose whether to shuffle the answer options 

 Write your first answer in the Choice 1 text field. Inserting HTML into 

this area also makes it possible to add an image or a sound file. 

 Select a grade percentage for the answer. This is the percentage of the 

total points for the question that selecting this response is worth. You 

can select negative percentages as well as positive percentages. So, 

selecting a correct response in a multiple answer question may give you 

50% of the possible points, while selecting a wrong answer may take 

away 10%. Note that in a multiple-answer question, the grades must 

add up to 100%. 

 

Установка Вопроса 
 Выберите Категорию Вопроса. 

 Дайте Вопросу описательное название. Вы используете это название для отслеживания 

ваших Вопросов позднее, так что название «Вопрос 1» – не хорошая идея. Это название 

будет использовано в списках Вопросов на странице редактировании Экзамена или в 

Уроке в качестве заголовка. Оно не будет показано Студентам, так что вы можете 

выбрать любое название, которое придаст смысл вам и, возможно, другим 

Преподавателям. 

 Создайте текст Вопроса. Если вы используете редактор HTML, вы можете 

отформатировать этот Вопрос наподобие обработки текстового документа. 

 Выберите изображение для отображения, если хотите добавить картинку к Вопросу. 

Доступными изображениями являются те, которые вы переслали в главную область 

файлов Moodle (они не могут быть в папках). Для Студента это изображение появится 

сразу после текста Вопроса и перед опциями ответа. 

 В дополнение, если вы используете редактор HTML для создания текста Вопроса, 

вы можете щёлкнуть иконку Image (изображение). Всплывёт окно Insert Image 

(вставить изображение). Вы можете выбрать в этом окне пересылку изображения в 

вашу область файлов или добавить указатель URL вашего изображения в сети. Если 

вы добавляете файл в вашу область файлов, щёлкните название файла после того, 

как перешлёте его, чтобы вставить ссылку в запись текста URL вверху экрана. Затем 

щёлкните OK. 

 Установите «Default question grade (оценка за вопрос по умолчанию)» (т.е. 

максимальное число баллов за этот Вопрос). 

 Установите «Penalty factor (штрафной фактор)» (см. «Штрафной фактор ниже»). 

 Moodle 1.7 и выше: Если хотите, добавьте общую Обратную Связь. Это текст, который 

предстанет перед Студентом после того, как он/она ответят на этот Вопрос. 

 Установите, могут ли Студенты выбирать только один ответ или множество ответов. 

 

 Выберите, могут ли перемешиваться варианты ответов. 

 Запишите ваш первый ответ в текстовом поле Choice 1 (выбор 1). Вставка HTML в эту 

область делает возможным добавление изображения или звукового файла в неё. 

 Выберите Оценку за этот ответ в процентах. Это процент от Итоговых баллов за 

Вопрос, если считать этот ответ наихудшим. Вы можете выбрать отрицательные 

проценты наряду с положительными. Так выбор правильного ответа в 

Вопросе с Многими Ответами может дать вам 50% от возможных баллов, в то время 

как выбор неправильного ответа может забрать 10%. Заметьте, что в 

Вопросе с Многими Ответами все Оценки в сумме должны составлять 100%. 
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 If you wish, you can add feedback for each response. It may be a bit 

more work, but it’s good practice to tell the students why each answer is 

right or wrong using the feedback area. If students know why an answer 

is right or wrong, they can analyse their own thinking and begin to 

understand why an answer is correct. Your feedback will only be 

displayed if you select Show Feedback in the quiz body options. 

 Fill in the rest of the response choices in the rest of the form. Any 

unused areas will be ignored. 

 Moodle 1.7+: Fill in the overall feedback fields if you wish. 

 Select the "Save Changes" button at the bottom of the screen. 

Penalty factor 
The 'penalty factor' only applies when the question is used in a quiz using 

adaptive mode - i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student will lose that proportion of the maximum 

grade upon each successive attempt. For example, if the default question 

grade is 10, and the penalty factor is 0.2, then each successive attempt after 

the first one will incur a penalty of 0.2 x 10 = 2 points. 

General feedback 
General feedback is some text that gets shown to the student after they 

have attempted the question. Unlike feedback, which depends on the 

question type and what response the student gave, the same general 

feedback text is shown to all students. 

You can control when general feedback is shown to students using the 

"Students may review:" check-boxes on the quiz editing form. 

 

You can use the general feedback to give students some background to 

what knowledge the question was testing. Or to give them a link to more 

information they can use if they did not understand the questions. 

Overall feedback 
The option overall feedback for correct/partially correct/incorrect 

responses is particularly useful for multiple-response questions, where it is 

difficult to control what feedback students see just using the answer-

specific feedback. 

So, when the student submits the question, they will see the answer-

specific feedback next to the option(s) they selected, the overall feedback 

in a box below the options, and if applicable, the general feedback 

underneath everything else. 

 

 Если хотите, вы можете добавить Обратную Связь для каждого ответа. Это немного 

увеличит работу, но явится хорошей практикой показать Студентам, чем каждый ответ 

хорош или плох, они смогут проанализировать свои размышления и начать понимать, 

почему ответ правилен. Ваша Обратная Связь будет отображена, если только вы 

выберите Show Feedback (показать обратную связь) в опциях тела этого Экзамена. 

 

 Заполните оставшиеся альтернативы ответов в этой форме ниже. Всякие 

неиспользованные области будут игнорироваться. 

 Moodle 1.7 и выше: Заполните, если хотите, поля всеобщей Обратной Связи (ниже). 

 Выберите кнопку «Save Changes (сохранить изменения)» внизу экрана. 

Штрафной Фактор 
«Штрафной фактор» применяется только тогда, когда Вопрос используется в 

Экзамене с адаптивным режимом – там, где Студенту разрешается предпринять несколько 

попыток ответить на Вопрос даже внутри одного и того же выполнения Экзамена. Если 

Штрафной Фактор больше 0, то Студент потеряет эту долю Максимальной Оценки при 

каждой последующей попытке. Например, если Оценка за Вопрос по умолчанию равна 10, 

а Штрафной Фактор – 0,2, то каждая последующая попытка после первой приведёт к 

штрафу в 0,2 х 10 = 2 балла. 

Общая Обратная Связь 
Общая Обратная Связь – это некоторый текст, который предстаёт перед каждым из 

Студентов после его попытки ответить на Вопрос. В отличие от Обратной Связи, которая 

зависит от типа Вопроса и того, какой ответ дал Студент, один и тот же текст 

Общей Обратной Связи будет показан всем Студентам. 

Вы можете управлять тем, когда Общую Обратную Связь показывать Студентам, 

используя окошки-флажки «Students may review (Студенты могут просмотреть):» в форме 

редактирования Экзамена. 

Вы можете использовать Общую Обратную Связь, чтобы предоставить Студентам 

некоторые базовые знания того, что тестировал этот Вопрос. Или дать им ссылку на 

дополнительную информацию, которую они могут использовать, если не поняли Вопросы. 

Полная Обратная Связь 
Опция Полной Обратной Связи для правильного/частично правильного/ 

неправильного ответов особенно полезна для Вопросов с Многими Ответами, где трудно 

управлять тем, какую Общую Обратную Связь увидят Студенты, только что 

использовавшие Обратную Связь на конкретные ответы. 

Так, когда Студент передаёт на рассмотрение готовый ответ на Вопрос, он видит 

Обратную Связь на этот конкретный ответ, соответствующую варианту(ам), который(е) он 

выбрал, Полную Обратную Связь в окошке ниже вариантов и, если существует, 

Общую Обратную Связь ниже этого всего. 
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Lesson module multiple choice questions 
This page was created for the Quiz module. A Lesson Multiple Choice or 

Multianswer question type looks the same to the 

student but is very different in the teacher's edit mode. A lesson question 

offers the teacher the chance to both grade a student's answer, give 

feedback and also to send the student to another specific page based upon 

the student's choice. 

There are other differences. Quiz has a more robust scoring system that is 

similar to "Custom Scoring" in the Lesson module. Even with custom 

scoring turned on, Lesson will not give percentage credit of a question's 

score for an answer. And students must select all the correct answers to 

receive any credit for the multianswer question in the Lesson module. 

 

See also 
 Using Moodle Mathematical questions forum discussion 

 Adding sound to question 

 Using Moodle forum discussions: Why do we have a. b. c. next to 

multiple choice answers? 

 Default Mark 

4.6.8.1.9.Short-Answer 
In a short answer question, the student types in a word or phrase in 

response to a question (that may include a image). Answers may or may 

not be case sensitive. The answer could be a word or a phrase, but it must 

match one of your acceptable answers exactly. It's a good idea to keep the 

required answer as short as possible to avoid missing a correct answer 

that's phrased differently. 

The Quiz and Lesson modules both have short answer question types. The 

analysis of the question given below works for both modules. However 

there is another analysis type available for Lesson which is not available in 

a Quiz (see note below). 

Question set-up 
 Select the question category 

 Give your question a descriptive name. 

 Create the question text. If you're using the HTML Editor, you can 

format the question just like a word processing document. 

 Tip: if the answer is intended to fill a gap in the text, use underscores (5 

or more) to indicate where the gap is. 

 Select an image to display if you want to add a picture to the question 

(see step 4 in Multiple Choice question type for more detail). 

Вопросы с Множественным выбором в модуле «Урок» 
Эта страница была создана для модуля «Экзамен». Тип Вопроса с множественным 

выбором в Уроке (п. 4.3.9) или тип Вопроса с многими ответами (п. 6.4) выглядят точно 

так же для Студента, но очень отличаются в режиме редактирования Преподавателем. 

Вопрос Урока предлагает Преподавателю Возможность как оценить ответ Студента и 

передать ему Обратную Связь, так и отправить учащегося на другую конкретную 

страницу, в зависимости от выбранного Студентом ответа. 

Есть и другие различия. Экзамен имеет более надёжную систему оценивания, 

которая похожа на «Custom Scoring (оценивание клиента)» в модуле «Урок». Даже с 

включённым оцениванием клиента Урок не выдаст «Кредит» для ответа на Вопрос в 

процентах от Накопительного балла. И Студенты должны выбрать только правильные 

ответы, чтобы получить любой «Кредит за Вопрос с Множественным Выбором в модуле 

«Урок». 

См. также 
 Обсуждения форума по использованию Moodle «Математические Вопросы». 

 Добавление звука в Вопрос. 

 Обсуждения форума по использованию Moodle: Почему рядом с ответами 

множественного выбора используются a. b. c.?. 

 Отметка по умолчанию. 

4.6.8.1.9.Краткий Ответ 
В Вопросе с Кратким Ответом, Студент набирает слово или фразу в ответ на 

Вопрос (это может включать изображение). Ответ может (или не может) быть 

чувствительным к регистру. Ответ может быть словом или фразой, но он должен точно 

соответствовать одному из ваших приемлемых ответов. Хорошая идея в том, чтобы 

придерживаться как можно более краткого требуемого ответа, чтобы не пропустить 

правильный ответ, который сформулирован по-другому. 

Оба модуля «Экзамен» и «Урок» имеют типы Вопросов с Кратким Ответом. 

Анализ Вопроса, приведённый ниже, работает для обоих модулей. Однако существует и 

другой тип анализа, доступный для Урока, который не доступен в Экзамене (см. замечание 

ниже). 

Установка Вопроса 
 Выберите Категорию Вопроса. 

 Дайте Вопросу описательное название. 

 Создайте текст Вопроса. Если вы используете редактор HTML, вы можете 

отформатировать этот Вопрос как при обработке текстового документа. 

 Совет: Если ответ предназначен для заполнения промежутка в тексте, используйте 

подчерки (5 или более) для указания этого промежутка. 

 Выберите изображение для отображения, если хотите добавить картинку к Вопросу 

(см. шаг 4 в Вопросах с Множественным Выбором для дополнительной информации). 

http://moodle.org/mod/forum/discuss.php?d=58615
http://docs.moodle.org/25/en/MP3_player#Inserting_sounds_into_questions
http://moodle.org/mod/forum/discuss.php?d=69050
http://moodle.org/mod/forum/discuss.php?d=69050
http://moodle.org/mod/forum/discuss.php?d=193464
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 Set the 'default question grade' (i.e. the maximum number of marks for 

this question). 

 Set the 'Penalty factor' (see Penalty factor below). 

 If you wish, add general feedback. This is text that appears to the 

student after he/she has answered the question. 

 Choose whether the answers are case-sensitive. Case sensitivity can be 

tricky where capitalization is important. Will you accept Ban Ki-moon 

as well as ban ki-moon as an answer? 

 Next, fill in the answers you will accept. You could give common 

misspellings partial credit with this option. For example will you accept 

"Ban Ki moon"? Use wildcards to allow for variants on a word pr 

phrase. 

 Add grade for each answer. 

 Create feedback for any and all answers. This will appear if the student 

enters that answer. 

 Note: It is good practice to add a single wild card * for the last answer, 

so you can create a feedback response and a score for all other answers 

students might have. 

 Click Save Changes to add the question to the category. 

Penalty factor 
The 'penalty factor' only applies when the question is used in a quiz using 

adaptive mode - i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student  

will lose that proportion of the maximum grade upon each successive 

attempt. For example, if the default question grade is  

10, and the penalty factor is 0.2, then each successive attempt after the first 

one will incur a penalty of 0.2 x 10 = 2 points. 

Wildcard usage 
You can use the asterisk character (*) as a wildcard to match any series of 

characters. For example, use ran*ing to match any word or phrase starting 

with ran and ending with ing. If you really do want to match an asterisk 

then use a backslash like this: \* 

If you want one question with the two answers fuel and oxygen, you ought 

to be able to limit the number of variants by writing fuel*oxygen 100%. 

This would accept "fuel oxygen", "fuel, oxygen", "fuel; oxygen", "fuel and 

oxygen", "fuel & oxygen" "fuel oxygen", "fuel und oxygen" 

"fuel&&oxygen". It would even accept "fuel or oxygen", "fuel but not 

oxygen" "fuel|oxygen" which might not be so good but you can never 

 Установите «Default question grade (оценка за вопрос по умолчанию)» (т.е. 

максимальное число баллов за этот Вопрос). 

 Установите «Penalty factor (штрафной фактор)» (см. «Штрафной фактор ниже»). 

 Если хотите, добавьте общую Обратную Связь. Это текст, который предстанет перед 

Студентом после того, как он/она ответят на этот Вопрос. 

 Выберите, являются ли ответы чувствительными к регистру. Чувствительность к 

регистру может быть хитростью, когда важны заглавные буквы. Что бы вы приняли в 

качестве ответа Пан Ги Мун и пан ги мун? 

 Далее заполните ответы, которые вы примете. Вы можете дать частичный «Кредит» за 

общие орфографические ошибки в этой опции. Например, вы примете «Пан Ги мун»? 

Используйте Шаблоны Подстановки, чтобы предоставить варианты по слову, скажем 

«фр*» для «фраза». 

 Добавьте Оценку за каждый ответ. 

 Создайте Обратную Связь для любого и всех ответов. Она появится, если Студенты 

введут ответ. 

 Замечание: Хорошая практика – добавить единственный Шаблон Подстановки * для 

последнего ответа, таким образом вы можете создать ответную Обратную Связь и 

Накопленный балл за все другие ответы, которые Студенты должны сделать. 

 Щёлкните Save Changes, чтобы добавить этот Вопрос в выбранную Категорию. 

Штрафной Фактор 
«Штрафной Фактор» применяется только тогда, когда этот Вопрос используется в 

Экзамене с адаптивным режимом, т.е. когда Студенту предоставлено несколько попыток 

ответа на Вопрос даже внутри одной и той же попытки выполнить этот Экзамен. Если 

штрафной фактор больше 0 (но меньше 1), тогда Студент потеряет эту долю от 

максимальной Оценки за каждую последующую попытку. Например, если Оценка за 

Вопрос по умолчанию равна 10, а штрафной фактор равен 0.2, тогда каждая последующая 

попытка после первой будет подвергаться штрафу в 0.2 x 10 = 2 балла. 

Применение Шаблона подстановки 
Вы можете использовать символ звёздочки (*) в качестве шаблона подстановки, чтобы 

сопоставить с ней любой набор символов. Например, использование ran*ing соответствует 

любому слову или фразе, начинающейся с ran и заканчивающейся на ing. Если вы на 

самом деле хотите вставить сам символ звёздочки, тогда используйте обратную косую 

черту перед ним \*. 

Если вам нужен один вопрос с двумя ответами («топливо» и «кислород»), вы должны быть 

в состоянии ограничить количество вариантов, написав топливо*кислород 100%. При этом 

будут приниматься «топливо кислород», «топливо, кислород», «топливо; кислород», 

«топливо и кислород», «топливо & кислород» «топливо кислород», «топливо und 

кислород» «топливо&&кислород». И даже «топливо или кислород», «топливо, но не 

кислород» «топливо|кислород», которые могут не быть так же хороши, но вы никогда не 
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be completely safe! 

Here are some answers and scores for a question "What does a rocket 

burn?". 

1. *oxygen*fuel with a score 100%  

2. *fuel* with a score 50% 

3. *oxygen* with a score 50% 

4. *air* with a score 40%  

5. with a score of 0% 

The order of the answers is important. The answers are evaluated from 1st 

to last. When a match is found the process stops. If no match is found the 

question is scored wrong and the general response is used. It is a good 

practice to put a wildcard as the last answer so the evaluation process 

knows what to do when nothing above it matches. 

Without wildcards, the answers are compared exactly, so be careful with 

your spelling! 

Feedback for wrong answers 
When you wish to have short answer type questions, you 

naturally have a limited number of variations that would be  

acceptable. So in case you wish to give a feedback in case of a wrong 

answer, you must spell out the right answers exactly and  

then use * as a final answer which will have grade as zero, and feedback 

will be the one for wrong answer. 

Effectively, ANYTHING other than the specific answers mentioned by 

you will be treated as this option due to wildcard and will be deemed 

wrong; it'll give 0 marks and show the feedback for a wrong answer. 

Here is an example: 

What is a rabbit? 

answer1: animal 

feedback: right 

grade: 100% 

answer2: mammal 

feedback: right 

grade: 100% 

answer3: vertebrate 

feedback: right 

grade: 100% 

answer4: * 

feedback: ouch! that was wrong 

grade: none 

сможете полностью уберечься от этого! 

Вот некоторые ответы и Накапливаемые баллы за Вопрос «Что сжигает ракета?»: 

 

1. *кислород*топливо с накапливаемым баллом 100%, 

2. *топливо*  с накапливаемым баллом 50%, 

3. *кислород*  с накапливаемым баллом 50%, 

4. *воздух*  с накапливаемым баллом 40%, 

5. с накапливаемым баллом 0%. 

Порядок ответов важен. Ответы оцениваются с первого до последнего. При 

обнаружении совпадения процесс останавливается. Если совпадение не найдено, Вопрос 

оценивается отрицательно, и используется общий ответ. Хорошая практика в том, чтобы 

применить Шаблон Подстановки в качестве последнего ответа с тем, чтобы процесс 

вычисления Оценки знал, что делать, когда ничего выше этого ответа не совпало. 

Без Шаблонов Подстановки, ответы сравниваются точно, так что будьте 

осторожны с вашей орфографией! 

Обратная Связь для неправильных ответов 
Когда вы хотите иметь Вопросы с кратким типом ответа, вы, естественно, имеете 

ограниченное число вариантов, которые могли бы быть приемлемы. Так, при желании дать 

Обратную связь на неправильный ответ, вам потребуется точно растолковать правильные 

ответы и затем использовать * в качестве финального ответа, который вы оценили нулём и 

Обратная связь будет одна для неправильного ответа. 

В сущности, благодаря Шаблону, НИЧЕГО другого, кроме конкретных ответов, 

упомянутых Вами, вкачестве этой опции рассматриваться не будет, и будет считаться 

неправильным ответом; что принесёт 0 баллов и покажет Обратную Связь для 

неправильного ответа. 

Вот пример: 

Что такое кролик? 

Ответ 1: животное 

Обратная связь: правильно 

Оценка: 100% 

Ответ 2: млекопитающее 

Обратная связь: правильно 

Оценка: 100% 

Ответ 3: позвоночное 

Обратная связь: правильно 

Оценка: 100% 

Ответ 4: * 

Обратная связь: О! Это неправильно 

Оценка: никакой 
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Remember: you cannot do negative marking in this type and ANYTHING 

other than your right answer will be treated as option 4 due to the wildcard 

and given that feedback and zero marks. 

Tip: Prototype your questions 
You may like to prototype your short answer questions to catch common 

acceptable answers you hadn't thought of. Start out by creating a few 

acceptable answers, then include the question in a quiz for no points. Be 

sure to tell students you are testing a new question. Once the quiz is over, 

review students' answers and add their acceptable answers to the list. 

 

Lesson module note 
In the Lesson module, there are two different student answer analysis 

systems available for the Short Answer type of question: the simple system 

is used by default. The second type only available in Lesson Module is 

called "Regular Expressions". See Short answer analysis for a description 

of the new type, with examples. 

See also 
 Adding sound to a question 

4.6.8.1.10.Numerical 
From the student perspective, a numerical question looks just like a short-

answer question. The difference is that numerical answers are allowed to 

have an accepted error. This allows a fixed range of answers to be 

evaluated as one answer. 

For example, if the answer is 30 with an accepted error of 5, then any 

number between 25 and 35 will be accepted as correct. 

You are able to 

 grade independently the number and the unit, 

 choose to handle the unit response either as 

 a text input element or as 

 a multichoice radio element, 

 just grade the number with the option to write the unit close to the input 

element, 

 put the unit either 

 at right of the number as the most common occurence 

 or at left as in $ 100,00. 

 

Furthermore your valid number formats and specific intructions on how to 

answer will be put near the answer input element. An example Screenshot 

«Numerical multiple choice unit example» 

Помните: вы не можете произвести отрицательного оценивания в этом типе и 

НИЧЕГО другого, кроме вашего правильного ответа не будет рассматриваться как вариант 

4, благодаря Шаблону Подстановки, и будет дана Обратная Связь и нуль баллов. 

Совет: Создайте прототипы ваших Вопросов 
Вы можете подобно прототипам ваших Вопросов с Кратким Ответом захватить 

общеприемлемые ответы, какие бы вы не придумали. Начните с создания нескольких 

приемлемых ответов, затем включите этот Вопрос в неоцениваемый Экзамен. Не забудьте 

рассказать Студентам, что вы тестируете новый Вопрос. После того, как Экзамен 

закончился, просмотрите ответы Студентов и добавьте свои приемлемые ответы в их 

список. 

Замечание к модулю «Урок» 
В модуле «Урок» существуют две различные системы анализа студенческих 

ответов, доступные для Вопросов с Кратким Ответом: «Простая система» используется по 

умолчанию. Второй тип, доступный только в модуле «Урок», называется «Регулярные 

выражения». См. Анализ Краткого Ответа (п. 4.3.9.2.2) с примерами для описания нового 

типа. 

См. также 
 Добавление звука в Вопрос. 

4.6.8.1.10.Числовые 
С точки зрения Студента Числовой Вопрос выглядит подобно 

Вопросу с Кратким Ответом. Разница заключается в том, что Числовым Ответам 

позволено иметь приемлемую ошибку. Это разрешается заданием фиксированного 

диапазона ответов для вычисления Оценки как одного ответа. 

Например, если при составлении Вопроса ответ задан равным 30 с приемлемой 

ошибкой 5, тогда любое число между 25 и 35 будет принято, как правильное. 

Вы можете: 

 Оценить независимо само число и единицу измерения. 

 Выбрать обработку единицы измерения в ответе либо как 

 элемент ввода текста, либо как 

 многовариантный переключатель. 

 Просто оценить число с опцией записи единицы измерения рядом с элементом ввода. 

 

 Установить единицу измерения либо 

 справа от числа, что встречается наиболее часто, 

 либо слева, как в $ 100,00. 

Более того, ваши форматы правильного числа и конкретные инструкции того, как 

отвечать на Вопрос, будут расположены рядом с элементом ввода ответа. Например, 

Снимок с экрана «Пример Числового Вопроса с Множественным Выбором 

единицы измерения». 

http://docs.moodle.org/25/en/MP3_player#Inserting_sounds_into_questions
http://docs.moodle.org/25/en/File:numerical_multichoice_unit_example_1.jpg
http://docs.moodle.org/25/en/File:numerical_multichoice_unit_example_1.jpg
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Questions may have different answers with different levels of accuracy. 

That lets you create questions like "What is a root of x^2 - 3x + 2?" and 

award different levels of credit depending on the accuracy of the answer. 

Text answers are no longer allowed - Short-Answer question type should 

be used instead. 

Numerical question set-up 
 In Quiz or Question bank 

 Select the question category 

 Give the question a descriptive name - this allows you to identify it in 

the question bank. 

 Enter a question in the 'question text' field. This can include an equation 

- Moodle has a couple of text filters that allow you to type an equation 

and have it properly typeset when displayed. The Algebra filter is very 

good for writing common mathematical expressions in a simple way. 

More complicated expressions may be written using the TeX filter. 

Filters contains information for administrators on how to enable these 

filters. Alternatively, select an image to display if you want to add a 

picture to the question. 

 Select an image to display if you want to add a picture to the question. 

For the student, it appears immediately after the question text and 

before the choices. 

 Set the 'default question grade' (i.e. the maximum number of marks for 

this question). 

 Set the 'Penalty factor' (see Penalty factor below). 

 Add general feedback. This is text that appears to the student after 

he/she has answered the question. 

 Now enter the first accepted answer(s). Note: Floating point numbers, 

e.g. 23.4, may also be written as 23,4 or 2.34E+1. 

 Enter an accepted error for this answer. This is the range above or 

below the answer that Moodle will accept as a match. For example, if 

the correct answer is 5, but you will accept 4 or 6 as answers, your 

accepted error is 1. 

 Enter a grade for this answer. 

 Enter feedback for the accepted answer. This is the text that the student 

will see if they enter a number within the accepted error of the answer. 

 

 

 

 

Вопросы могут иметь различные ответы с различными уровнями точности. Это 

позволяет создавать Вопросы наподобие «Чему равен корень из x^2 - 3x + 2?» и 

присуждать различные уровни «Кредита» в зависимости от точности ответа. 

Текстовые ответы дольше не разрешаются – вместо этого следует использовать 

Вопрос с Кратким ответом. 

Установка Числового Вопроса 
 В Экзамен или Банк Вопросов. 

 Выберите Категорию Вопроса. 

 Задайте Вопросу описательное название – это позволит вам идентифицировать его в 

Банке Вопросов. 

 Введите Вопрос в поле «Question text (текст вопроса)». Он может включать уравнение – 

Moodle имеет пару текстовых Фильтров, которые позволяют вам набирать уравнение и 

отображать в математически правильном виде. Фильтр Algebra очень хорош для 

написания общих математических выражений простым способом. Более сложные 

выражения могут быть написаны с помощью Фильтра TeX (п. 5.5.1). Фильтры (п. 5.5) 

содержат информацию для Администраторов о том, как подключить эти Фильтры. В 

дополнение выберите изображение, если хотите добавить картинку к этому Вопросу. 

 

 Выберите изображение, если хотите добавить картинку к этому Вопросу. Для 

Студента оно появится сразу после текста Вопроса и перед альтернативами ответов. 

 

 Установите «Default question grade (оценка за вопрос по умолчанию)» (т.е. 

максимальное число баллов для этого Вопроса). 

 Установите «Penalty factor (штрафной фактор)». 

 Добавьте общую Обратную Связь. Это текст, который появится перед Студентом после 

того, как он/она ответят на этот Вопрос. 

 Сейчас введите первый приемлемый ответ(ы). Замечание: Числа с плавающей точкой, 

например, 23.4 могут быть также записаны как 23,4 или 2.34E+1. 

 Введите приемлемую ошибку для этого ответа. Это диапазон выше и ниже ответа, 

который Moodle приемлет как соответствующий. Например, если правильный ответ – 5, 

но вы будете считать приемлемыми ответы от 4 до 6, если ваша приемлемая ошибка 

установлена равной 1. 

 Введите Оценку для этого ответа. 

 Введите Обратную Связь для приемлемого ответа. Это текст, который Студент увидит, 

если введёте число внутри приемлемого диапазона ошибок для этого ответа. 
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 Repeat for each of the answers you want to accept. You can provide 

feedback for all wrong answers by using a wildcard, i.e. the asterisk 

character (*), as an answer with grade 'None'. 

 Units can also be specified. For example, if you enter a unit of 'cm' 

here, and the accepted answer is 15, then the answers '15cm' and '15' are 

both accepted as correct. You can also specify a multiplier. So, if your 

main answer was 5500 with unit W, you can also add the unit kW with 

a multiplier of 0.001. This means that the answers '5500', '5500W' or 

'5.5kW' would all be marked correct. Note that the accepted error is also 

multiplied, so an allowed error of 100W would become an error of 

0.1kW. 

 Click 'Save changes' to add the question to the category. 

Penalty factor 
The 'penalty factor' only applies when the question is used in a quiz using 

adaptive mode - i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student will lose that proportion of the maximum 

grade upon each successive attempt. For example, if the default question 

grade is 10, and the penalty factor is 0.2, then each successive attempt after 

the first one will incur a penalty of 0.2 x 10 = 2 points. 

Tips and tricks 
 Remember that numerical questions in the Quiz module are slightly 

different than those in the Lesson module. 

Error messages 
"One of the answers you entered was not a valid number." The decimal 

point used must be a . not a , which is used in some countries. But the error 

can come anyhow. See (or add to): discussion Though that didn't help me 

at the time. 

See also 
 Embedded / CLOZE question type which functions similarly to this one. 

 Lesson question types for more information about a numerical question 

in a Lesson Activity 

4.6.8.1.11.True/False 
A student is given only two choices for an answer in this kind of question: 

True or False. The question content can include an 

image or html code. When feedback is enabled, the appropriate feedback 

message is shown to the student after the answer. For example, if the 

correct answer is "False", but they answer "True" (getting it wrong) then 

the "True" feedback is shown. 

 Повторите для каждого ответа, который вы хотите принять. Вы можете предоставить 

Обратную Связь для всех неправильных ответов применением Шаблона подстановки, 

т.е. символа * в качестве ответа с Оценкой «None (никакая)». 

 Единицы измерения также могут быть указаны. Например, если вы введёте здесь 

единицу измерения «см» и приемлемый ответ равный 15, тогда оба ответа «15 см» и 

«15» принимаются как правильные. Вы можете также указать множитель. Так, если 

ваш главный ответ был 5500 с единицей измерения Вт, вы можете также добавить 

единицу измерения кВт с множителем 0.001. Это означает, что ответы «5500 Вт», 

«5500» или «5500 кВт». Заметьте, что приемлемая ошибка также умножается, так что 

разрешённая ошибка 100 Вт станет ошибкой 0.1 кВт. 

 

 Щёлкните «Save changes», чтобы добавить этот Вопрос в выбранную Категорию. 

Штрафной Фактор 
«Штрафной Фактор» применяется только тогда, когда Вопрос используется в 

Экзамене с Адаптивным Режимом – то есть, где Студенту предоставляется несколько 

попыток ответа на Вопрос даже в пределах одной попытки выполнить Экзамен. Если 

Штрафной Фактор больше 0, тогда Студент будет терять эту часть 

Максимальной Оценки на каждой последующей попытке ответить. Например, если по 

умолчанию Оценка за Вопрос равна 10, а Штрафной Фактор составляет 0,2, то каждая 

последующая попытка после первой приведёт к штрафу в 0,2 х 10 = 2 балла. 

Советы и трюки 
 Помните, что Числовые Вопросы в модуле «Экзамен» слегка отличаются от таких же в 

модуле «Урок». 

Сообщения об ошибках 
«Один из ответов, который вы ввели, – неправильное число.» Используемый 

символ-разделитель целой и дробной части должен быть точкой «.», а не запятой «,» 

которая используется в некоторых странах. Но ошибка всё же может произойти. Смотрите 

(или добавьте) обсуждение. Хотя это не помогло мне в своё время. 

См. также 
 Тип Вопроса Встроенные/Учебный Тест, функции которых похожи на этот Вопрос. 

 Типы Вопросов для Урока с дополнительной информацией о Числовом Вопросе в 

Интерактивном Действии «Урок». 

4.6.8.1.11.Истина/Ложь 
Студенту в этом виде Вопросов даётся только две альтернативы ответа: истина или 

ложь. Содержимое Вопроса может включать изображение или HTML-код. Когда 

позволена Обратная Связь, соответствующее сообщение Обратной Связи показывается 

Студенту после его ответа. Например, если правильный ответ «Ложь», но он отвечает 

«Истина» (получение его неверно), тогда на эту «Истина» будет показана Обратная Связь. 

http://moodle.org/mod/forum/discuss.php?d=79942
http://docs.moodle.org/25/en/Cloze_editor_module
http://docs.moodle.org/25/en/Lesson_question_types
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Note that the True/False question type in a Lesson module is quite 

different. It is effectively the same as the Multiple Choice question type in 

a Lesson, but with only 2 responses. See Lesson_module#Multiple_choice. 

Question set-up 
 Select the question category 

 Give the question a descriptive name - this allows you to identify it in 

the question bank. 

 Enter a question in the 'question text' field. 

 Select an image to display if you want to add a picture to the question. 

For the student, it appears immediately after the question text and 

before the choices. 

 Set the 'default question grade' (i.e. the maximum number of marks for 

this question). 

 Set the 'Penalty factor' (see Penalty factor below). 

 Moodle 1.7+: If you wish, add general feedback. This is text that 

appears to the student after he/she has answered the question. 

 Select the correct answer - true or false. 

 Finally, provide feedback for each of the answers 'true' and 'false'. 

 

 Click 'Save changes' to add the question to the category. 

Penalty factor 
The 'penalty factor' only applies when the question is used in a quiz using 

adaptive mode - i.e. where the student is allowed multiple attempts at a 

question even within the same attempt at the quiz. If the penalty factor is 

more than 0, then the student will lose that proportion of the maximum 

grade upon each successive attempt. For example, if the default question 

grade is 10, and the penalty factor is 0.2, then each successive attempt after 

the first one will incur a penalty of 0.2 x 10 = 2 points. 

 

 

 

 

 

 

 

 

 

 

 

Обратите внимание, что тип Вопросов Истина/Ложь в модуле «Урок» совершенно 

иной. Он фактически то же самый, что и тип Вопросов с Множественным Выбором в 

Уроке, но только с 2 ответами. Смотрите «Множественный выбор в модуле "Урок"». 

Установка Вопроса 
 Выберите Категорию Вопроса. 

 Задайте Вопросу описательное название – это позволит вам идентифицировать его в 

Банке Вопросов. 

 Введите Вопрос в поле «Question text (текст вопроса)». 

 Выберите изображение, если хотите добавить картинку к этому Вопросу. Для Студента 

оно появится сразу после текста Вопроса и перед вариантами ответов. 

 

 Установите «Default question grade (оценка за вопрос по умолчанию)» (т.е. 

максимальное число баллов для этого Вопроса). 

 Установите «Penalty factor (штрафной фактор)». 

 Moodle 1.7 и выше: Если хотите, добавьте общую Обратную Связь. Это текст, который 

появится перед Студентом после того, как он/она ответят на этот Вопрос. 

 Выберите правильный ответ – истину или ложь. 

 Окончательно, предоставьте Обратную Связь для каждого из ответов «истина» и 

«ложь». 

 Щёлкните «Save changes», чтобы добавить этот Вопрос в выбранную Категорию. 

Штрафной Фактор 
«Штрафной Фактор» применяется только тогда, когда Вопрос используется в 

Экзамене с адаптивным режимом, т.е., где Студенту предоставляется несколько попыток 

ответа на Вопрос даже в пределах одной попытки выполнить Экзамен. Если 

Штрафной Фактор больше 0, тогда Студент будет терять эту часть 

Максимальной Оценки при каждой последующей попытке ответить. Например, если по 

умолчанию Оценка за Вопрос равна 10, а Штрафной Фактор составляет 0,2, то каждая 

последующая попытка после первой приведёт к штрафу в 0,2 х 10 = 2 балла. 

http://docs.moodle.org/25/en/Lesson_module#Multiple_choice
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4.6.8.1.12.Third-party question types 
Besides the standard question types that are part of the core Moodle 

distribution, there are a number of question type add-ons in the add-ons 

database. 

Some of those add-ons have additional documentation here: 

 Algebra question type 

 Calculated Objects question type 

 Cloze editor module 

 Combined question type 

 Concept map question type 

 Correct writing question type 

 Drag and drop image or text question type 

 Drag and drop into text 

 Drag and drop marker question type 

 Drag and drop matching question type 

 Drag and drop onto image question type 

 Gapfill question type 

 Interval question type 

 Java Molecular Editor question type 

 Matrix question type 

 Multinumerical question type 

 Music key signature question type 

 Music scale question type 

 Opaque question type 

 OU multiple response question type 

 Pattern-match question type 

 Pattern-match with JME question type 

 Perl-compatible regular expression question type 

 POAS abstract question type 

 PoodLL recording question type 

 Preg question type 

 Programmed responses question type 

 Regular Expression Short-Answer question type 

 Reverse pattern match question type 

 Select missing words question type 

 Set splitting question type 

 Spreadsheet question type 

 STACK question type 

4.6.8.1.12.Типы Вопросов независимых разработчиков 
Кроме стандартных типов Вопросов, которые являются частью дистрибутива ядра 

Moodle, существует ряд встроенных типов Вопросов в Базе данных плагинов. 

 

Документация по некоторым из них находится здесь: 

 Тип Алгебраических Вопросов. 

 Тип Вопросов с Вычисляемыми объектами: 

 Модуль редактора Учебного теста:  

 Тип Комбинируемых Вопросов: 

 Тип Вопросов в виде Карты: 

 Тип Вопросов с Правильным написанием: 

 Тип Вопросов с буксировкой изображения или текста: 

 Отбуксировать в текст: 

 Тип Вопросов с Буксировкой отметок: 

 Тип Вопросов с Буксировкой сопоставлений: 

 Тип Вопросов с Буксировкой в изображение: 

 Тип Вопросов с заполнением пропусков в тексте: 

 Тип Интервальных Вопросов: 

 Тип Вопросов с молекулярным Java-редактором 

 Тип Матричных Вопросов: 

 Тип Многочисленных Вопросов: 

 Тип Вопросов с Музыкальными ключевыми знаками: 

 Тип Вопросов с Музыкальной шкалой: 

 Тип Непрозрачных Вопросов: 

 Тип Вопросов с Множественными ответами Открытого университета: 

 Тип Вопросов на Сопоставление с образцами: 

 Тип Вопросов на Сопоставление с образцами в молекулярном редакторе: 

 Тип Вопросов с Perl-совместимыми стандартными выражениями: 

 Тип Абстрактных Вопросов Волгоградского университета: 

 Тип Вопросов записывающих PoodLL: 

 Тип Вопросов с регулярными выражениями: 

 Тип Вопросов с Программируемыми ответами: 

 Тип Вопросов «Краткий ответ» с регулярными выражениями: 

 Тип Вопросов на сопоставление с реверсивными образцами: 

 Тип Вопросов «Выбрать пропущенные слова»: 

 Тип Вопросов «Установить разделение»: 

 Тип Вопросов «Электронные таблицы»: 

 Тип Вопросов STACK: 

https://moodle.org/plugins/browse.php?list=category&id=29
https://moodle.org/plugins/browse.php?list=category&id=29
http://docs.moodle.org/25/en/Algebra_question_type


 

385 

 UB hot spots question type 

 Variable numeric question type 

 Variable numeric set question type 

 Variable numeric set with units question type 

 Vertical matching question type 

4.6.9.Questions FAQ 
4.6.9.1.How can questions be shared between 
courses? 
See How to let teachers share questions between courses 

 

4.6.9.2.If I change a question in the question 
bank, will it be changed in all the quizzes it 
appears? 
Yes. See Tim Hunt's forum post 

https://moodle.org/mod/forum/discuss.php?d=234011&parent=1016542#

p1016558 

4.6.9.3.See also 
 Quiz FAQ 

4.6.10.Question permissions 
Roles and capabilities are combined with Question categories to give a 

user permission to create, edit and view questions in the Question bank. 

For example, a combination might allow a student being able to edit 

questions in a specific quiz activity or all science teachers being able to use 

the question categories created for their department and not view other 

departments categories. In short, question categories are contexts (see 

Question contexts) and work with roles to determine a user's permissions in 

managing individual questions. 

 

Also, Question permissions allow a user to grant other users permissions. 

For example, a teacher in a course may decide to share their questions 

located in a specific course question category with other teachers who do 

not have permission to enter their course. This is all done with permissions 

that are given to a role in a specific context. 

 

 

 

 

 Тип Вопросов «Горячие точки мочевого пузыря»: 

 Тип Вопросов с Числовыми переменными: 

 Тип Вопросов с набором Числовых переменных: 

 Тип Вопросов с набором Числовых переменных и единицами измерений: 

 Тип Вопросов с Вертикальным сопоставлением: 

4.6.9.Часто задаваемые вопросы по Вопросам 
4.6.9.1.Как могут Вопросы совместно использоваться в 
Курсах? 

См. «Как позволить Преподавателям совместно использовать Вопросы в Курсах»: 

п. 4.6.11. 

4.6.9.2.Если изменить Вопрос в Банке Вопросов, 
изменится ли он при появлении в Экзаменах? 
 

Да. См. корреспонденцию на форуме Тима Ханта: 

https://moodle.org/mod/forum/discuss.php?d=234011&parent=1016542#p1016558. 

 

4.6.9.3.См. также 
 Часто задаваемые вопросы по Экзамену. 

4.6.10.Полномочия Вопросов 
Роли и Полномочия (п. 3.4) комбинируются с Категориями Вопросов (п. 4.6.4), 

чтобы дать Полномочие пользователю создавать, редактировать и просматривать Вопросы 

в Банке Вопросов (п. 4.6.3). Например, комбинация может предоставить Студенту 

возможность редактирования Вопросов в определённом Интерактивном Действии 

«Экзамен» или всем Преподавателям естественных наук Возможность использовать 

Категории Вопросов, созданные для их отдела, но не просматривать Категории других 

отделов. Короче говоря, Категории Вопросов являются Контекстами (см. Контексты 

Вопросов в п. 4.6.2) и работают с Ролями для определения Полномочий пользователя в 

управлении отдельными Вопросами. 

Кроме того, Полномочия Вопросов позволяют пользователю предоставить 

Полномочия другим пользователям. Например, Преподаватель в Курсе может принять 

решение совместно использовать их Вопросы, размещённые в определённой Категории 

Вопросов Курса, с другими Преподавателями, которые не имеют Полномочий на вход в их 

Курс. Все это делается с Полномочиями, которые даны Роли в определённом Контексте. 

https://moodle.org/mod/forum/discuss.php?d=234011&parent=1016542#p1016558
http://docs.moodle.org/25/en/Quiz_FAQ
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4.6.10.1.Brief review of permission concepts 
 
The 2.0 Moodle Question bank simplifies the task of organization of 

questions but the terminology can be confusing. In general, a set of 

questions is created in what is called a question category. A question 

category is like a folder in a computer file system or in file cabinet. Like a 

file folder, a question category might contain other question categories or 

just a set of questions. Permissions are assigned to question categories. The 

nesting (placing of a question category within another question category) 

can create a hierarchy of permissions when it comes to dealing with 

individual questions located in a question category. 

By default a course teacher does not have permission to do anything with 

questions placed in a category outside the course in which they are 

assigned a teacher role. By default, students can not even see the Question 

bank or edit any question. 

The default permissions can be changed to meet specific goals of a site, a 

course or even a specific quiz activity. 

4.6.10.2.Technical notes for administrators 
For users who have privileges to alter the permissions for a role, here are 

some permissions that affect Question bank and its management and use: 

 

moodle/question:config 

moodle/question:managecategory 

moodle/question:add - determines whether a user has permission to import 

questions 

 

moodle/question:editall 

moodle/question:editmine 

moodle/question:moveall 

moodle/question:movemine 

moodle/question:useall 

moodle/question:viewall 

moodle/question:viewmine 

Certain capabilities contain the words all or mine: 

 all means all questions, and if you have the all capability, mine is not 

tested. 

 mine means that you have the capability for your questions but not for 

questions created by others 

 

4.6.10.1.Краткий обзор концепций Полномочий 
(http://docs.moodle.org/25/en/Question_permissions) Банк Вопросов (п. 4.6.3) 

Moodle 2.0 упрощает задачу организации Вопросов, но терминология может сбить 

с толку. В общем, набор Вопросов создаётся в том, что называется Категорией Вопросов. 

Категория Вопросов подобна папке в файловой системе компьютера или в картотеке. 

Подобно папке файлов Категория Вопросов может содержать другие Категории Вопросов 

или просто набор Вопросов. Полномочия назначаются Категориям Вопросов. Вложения 

(размещение Категории Вопросов внутри другой Категории Вопросов) могут создавать 

иерархию Полномочий, когда приходится иметь дело с отдельными Вопросами, 

расположенными в Категории Вопросов. 

 

По умолчанию Преподаватель Курса не имеет Полномочия, делать что-нибудь с 

Вопросами, размещёнными в Категории вне Курса, в котором им назначена Роль 

Преподавателя. По умолчанию, Студенты не могут даже увидеть Банк Вопросов или 

отредактировать любой Вопрос. 

Полномочия по умолчанию могут быть изменены, чтобы встретить специфические 

цели Сайта, Курса или даже конкретного Интерактивного Действия «Экзамен». 

4.6.10.2.Технические замечания для Администраторов 
Для пользователей, которые имеют привилегии изменять Полномочия для Роли, 

вот некоторые Полномочия, которые влияют на Банк Вопросов и его управление и 

использование: 

moodle/question:config 

moodle/question:managecategory 

moodle/question:add – определяет, имеет ли пользователь Полномочие импортировать 

Вопросы. 

moodle/question:editall 

moodle/question:editmine 

moodle/question:moveall 

moodle/question:movemine 

moodle/question:useall 

moodle/question:usemine 

moodle/question:viewall 

moodle/question:viewmine 

Определяет Возможности, которые содержат слова все или мой: 

 all (все) означает все Вопросы и, если вы имеете Возможность все, мой не тестируется. 

 

 mine (мой) означает, что вы имеете Возможность для ваших Вопросов, но не Вопросов, 

созданных другими. 

http://docs.moodle.org/25/en/Question_permissions
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4.6.10.3.See also 
Using Moodle forum discussions: 

 capability for editing new questions 

 examining present capabilities for questions 

4.6.11.How to let teachers share questions 
between courses 
The page explain how Administrators can let teachers share questions 

between courses in Moodle. 

4.6.11.1.What you need to do 
4.6.11.1.1. Create a new role Question sharer 
As usual, you create a new role by going to Administration -> Users -> 

Permissions -> Define roles. Then click 'Add a new role'. 

 

You can use whatever Name and Short name you like for the role. Set the 

'Legacy role type' to None. 

 

In Moodle 2.0 and later, set the role to be assignable in the System and 

Category contexts. 

Set the following capabilities to Allow: 

 moodle/question:add 

 moodle/question:editall 

 moodle/question:managecategory 

 moodle/question:moveall 

 moodle/question:viewall 

 moodle/question:useall 

Now click the 'Add a new role' button at the bottom of the page. N.B. 

Teachers have similar permissions, but it is not a good idea simply to 

assign the role of teacher in the System context to members since those 

teachers will show up as teachers for every single course in the entire 

system (as noted in Moodle when you're changing the settings above). 

4.6.11.1.2.Assign the new role in the System 
context 
Any user who you wish to be able to access the shared areas of the 

question bank must have the new role assigned in the System context. 

(Administration -> Users -> Permissions -> Assign system roles) 

Or, for more control, you can assign this role in a course category. That 

lets the user share questions only between the courses in that category. 

4.6.10.3.См. также 
Использование обсуждений форума Moodle: 

 Возможность для редактирования новых Вопросов. 

 Рассмотрение настоящих Возможностей для Вопросов. 

4.6.11.Как позволить Преподавателям совместно 
использовать Вопросы между Курсами 

Этот раздел объясняет, как Администраторы могут позволить Преподавателям 

совместно использовать Вопросы между Курсами в Moodle. 

4.6.11.1.Что вам нужно сделать 
4.6.11.1.1.Создайте новую Роль совладельца Вопросов 

Как обычно, чтобы создать новую Роль, перейдите в 

Administration→Users→Permissions→Define roles. Затем нажмите кнопку «Add a new role 

(добавить новую роль)». 

Вы можете использовать любое название и краткое название, которое вам 

понравится для этой Роли. Установите «Legacy role type (тип наследуемой роли)» в «None 

(никакой)». 

В Moodle 2.0 и более поздних версиях, установите эту Роль в Контекстах Системы 

и Категории. 

Установить следующие Возможности в «Allow (позволить)»: 

 moodle/question:add 

 moodle/question:editall 

 moodle/question:managecategory 

 moodle/question:moveall 

 moodle/question:viewall 

 moodle/question:useall 

Теперь щёлкните кнопку «Add a new role (добавить новую роль)» в нижней части 

страницы. Обратите особое внимание: Преподаватели имеют схожие Полномочия, но 

просто присвоить Роль Преподавателя в Контексте Системы всем преподающим – не 

очень хорошая идея, поскольку тогда все эти Преподаватели будут показываться как 

Преподаватели для каждого отдельного Курса во всей системе (как это отмечается в 

Moodle, когда вы изменяете вышеуказанные настройки). 

4.6.11.1.2.Назначьте новую Роль в Контексте системы 
Любой пользователь, который вы хотите, чтобы иметь Возможность доступа к 

общим областям Банка Вопросов должны иметь новую Роль, которая отводится в 

Контексте системы. (Administration→Users→Permissions→Assign system roles). Или, для 

большего контроля, вы можете назначить эту Роль в Категории Курса. Это позволит 

пользователю совместно использовать Вопросы только внутри Курсов этой Категории. 

http://moodle.org/mod/forum/discuss.php?d=67725
http://moodle.org/mod/forum/discuss.php?d=68072
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4.6.11.2.What teachers need to do 
Once you have done the above steps. Teachers who have the Question 

sharer role will be able to see the shared areas of the question bank when 

they are editing quizzes, or when they click on the 'Questions' link in the 

course administration block. 

Any questions they store in the shared areas of the question bank will be 

visible in all their courses. 

4.6.11.3.Why does this work? 
See: Question permissions explained with diagrams. 

4.6.11.4.See also 
 Question bank 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.6.11.2.Каким Преподавателям нужно это делать 
Однажды вы сделали приведённые выше шаги. Преподаватели, которые имеют 

Роль совладельца Вопросов, смогут увидеть совместно используемые области 

Банка Вопросов при редактирования Экзаменов или при щелчке по ссылке «Вопросы» в 

блоке управления Курсом. 

Любые Вопросы, которые они сохранят в совместно используемых областях 

Банка Вопросов, будут видны во всех своих Курсах. 

4.6.11.3.Зачем делать эту работу? 
См. «Полномочия Вопросов, объясняемые диаграммами»: (п. 4.3.10.8). 

4.6.11.4.См. также 
 Банк Вопросов: (п. 4.6.3). 
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4.7.Course enrolment 
How to give students access to your course. 

Course enrolment is the process where authenticated site users can be 

registered as course participants. 

4.7.1.Enrolled users 
4.7.1.1.Enrolled users 
All course participants are enrolled in the course and assigned an 

appropriate role. Scgeenshot «Enrolled users». 

Enrolled users: 

 Can be assigned to groups 

 Have grades 

 Can submit assignments 

 Are visible in the list of participants 

 Can subscribe to forums 

 Can participate in choices 

Only enrolled users are true participants in course. 

 

The enrolled users page Administration > Course administration > Users 

> Enrolled users lists all users enrolled in the course, together with their 

last access time, roles, groups and enrolment methods. 

4.7.1.2.Roles 
To assign an enrolled user a role, click the 'Assign roles' icon (a plus sign) 

in the roles column then select the desired role. 

To remove a role assignment, click the delete icon (a cross) next to the role 

name. 

Notes: 

1. Only roles which can be assigned in the course context type are 

available to select. The course context type may be set by an admin by 

editing the role via 'Administration > Site administration > Users > 

Permissions > Define roles. 

2. Only roles which a user is allowed to assign are available to select. 

 

 

 

 

 

 

 

4.7.Зачисление на Курс 
Как предоставить Студентам доступ к вашему Курсу. 

Зачисление на Курс – это процесс, в котором Аутентифицированные Пользователи 

Сайтa могут быть зафиксированы как Участники Курса. 

4.7.1.Зачисленные пользователи 
4.7.1.1.Зачисленные пользователи 

Все Учпстники Курса зачисляются на Курс и им назначается подходящая Роль. 

Снимок с экрана «Зачисленные пользователи». 

Зачисленные пользователи: 

 Могут быть распределены по Группам. 

 Получать Оценки. 

 Могут передавать готовые ответы на рассмотрение. 

 Их имена видимы в списке Участников Курса. 

 Могут подписаться на Форумы. 

 Могут участвовать в Интерактивных Действиях «Выбор». 

Только Зачисленные пользователи являются действительными Участниками в 

Курсе. 

Страница Зачисленных пользователей 

(Administration→Course administration→Users→Enrolled users) 

 перечисляет всех зачисленных на Курс пользователей, вместе с их последним временем 

доступа, Ролями, Группами и методами зачисления. 

4.7.1.2.Роли 
Чтобы назначить зачисленному пользователю Роль, нажмите иконку «Assign roles 

(знак плюс)» в столбце Ролей, затем выберите нужную Роль. 

Чтобы удалить назначенную Роль, щёлкните иконку Delete (крестик) рядом с 

названием Роли. 

Замечания: 

1. Только Роли, которые могут быть назначены в Контексте Курса, доступны для выбора. 

Контекст Курса может быть установлен Администратором путём редактирования Роли 

через 

Administration→Site administration→Users→Permissions→Define roles. 

2. Только Роли, которые пользователю разрешено назначать, доступны для выбора.. 

http://docs.moodle.org/25/en/File:Enrolled_users.png
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4.7.1.3.Groups 
To add a user to a group (requires at least one group to have been created 

previously), click the 'Add to group' icon (a plus sign) in the groups 

column, select the desired group then click the 'Save changes' button. 

4.7.1.4.Enrolling users 
See Manual enrolment for two methods of enrolling users. 

 

4.7.1.5.Searching enrolled users 
New featurein Moodle 2.5! 

The search facility allows a teacher to search for specific enrolled users. 

This is useful when a course has many users enrolled with different 

methods. 

Screenshot «Searching enrolled users». 

4.7.1.6.See also 
 I don't see the Enrol users button - FAQ #17 

 Assign roles 

4.7.2.Enrolment methods 
4.7.2.1.Enrolment methods 
Depending upon which enrolment methods are enabled for the site (by an 

administrator in Administration > Site administration > Plugins > 

Enrolments > Manage enrol plugins), some or all of the following are 

available within a course: 

4.7.2.1.1.Manual enrolment 
 This enables users to be enrolled manually in Administration > Course 

administration > Users > Enrolled users. 

 It allows the teacher of the course to manage individual or collective 

enrolment to their course themselves - for example: if a new student 

arrives to class unexpectedly with just a login to the site, they may be 

enrolled by the teacher into their course without any input from an 

administrator. 

 See Manual enrolment (п. 3.3.2) for full details of how this can work in 

your course. 

 

 

 

 

 

4.7.1.3.Группы 
Чтобы добавить пользователя в Группу (требуется заранее создать, как минимум, 

одну Группу), нажмите иконку «Add to group (добавить в группу)» (знак плюс) в столбце 

Групп, выберите нужную Группу, и нажмите кнопку «Save changes (сохранить 

изменения)». 

4.7.1.4.Зачисление пользователей 
См. в «Зачисление Вручную (п. 3.3.2)» о двух методах Зачисления пользователей. 

4.7.1.5.Поиск зачисленных пользователей 
Новые средства в Moodle 2.5! 

Это средство поиска позволяет Преподавателю искать конкретных Зачисленных 

пользователей. Что полезно, когда Курс имеет много пользователей, Зачисленных 

различными методами. 

Снимок с экрана «Поиск зачисленных пользователей». 

4.7.1.6.См. также 
 Я не вижу кнопки Зачислить пользователей – Часто задаваемые вопросы №17. 

 Назначить Роли (п. 3.4.2). 

4.7.2.Методы зачисления 
4.7.2.1.Методы зачисления 

В зависимости от методов Зачисления разрешённых для Сайта 

(Administration→Site administration→Plugins→Enrolments→Manage enroll plugins), неко-

торое или всё из следующего доступно внутри Курса. 

 

4.7.2.1.1.Зачисление вручную 
 Это позволяет зарегистрировать пользователей вручную в 

Administration→Course administration→Users→Enrolled users. 

 Это позволяет Преподавателю Курса самому управлять индивидуальным или 

коллективным зачислением на свой Курс – например: если новый Студент прибывает в 

класс неожиданно, будучи зарегистрированным на Сайте, он может быть зачислен 

Преподавателем в Курс, минуя Администратора. 

 

 Наиболее полная информация о том, как работает Зачисление Вручную в ваш Курс, 

приведена в п. 3.3.2. 

http://docs.moodle.org/25/en/File:Searchenrolledusers.png
http://docs.moodle.org/25/en/Enrolment_FAQ
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4.7.2.1.2.Self enrolment 
 This allows users to enrol themselves into a course, either directly or 

via an enrolment key ("course password") The teacher does not then 

have to manually add students. 

 More than one instance of the self enrolment method can be used so 

that when users enrol themselves they are assigned different roles e.g. 

certain users can be assigned the role of student and other users can be 

assigned the role of non-editing teacher 

 The self-enrolment method also allows for users to enrol themselves 

into groups by using a group enrolment key. 

 See Self enrolment for full details of how this can work in your course. 

 

4.7.2.1.3.Guest access 
 This allows those with the guest role to view the contents of a course. 

 Users with the "guest role" may be visitors who do not have an account 

on your Moodle, or users who do have an account ("authenticated 

users") but who would just like to explore your course. 

 It is possible to add an enrolment key so that only those guest users you 

wish to grant access can enter the course 

 Entering a course with guest access doesn't allow a user to participate in 

any activities; they can only view information. 

 See Guest access for full details of how this can work in your course. 

 

4.7.2.1.4.Cohort sync 
 A cohort is a set of users which has been added either to the site as a 

whole or to a particular category and which can then be made available 

in a course through the cohort-sync enrolment plugin. 

 Only an administrator or a manager can use this plugin. 

 See Cohort sync for full details of how this can work in your course. 

 

4.7.2.1.5.Course meta link 
 This allows users who are in another course to be automatically 

enrolled into your course as well. An example might be if a Moodle site 

has a course for "Staff Only" and a course for "Moodle Help". If the 

"Staff Only" course is added to the "Moodle Help" course with the 

course meta link plugin, then every time a new member of staff joins 

the "Staff Only" course, they will automatically be enrolled in the 

"Moodle Help" course as well. 

4.7.2.1.2.Самозачисление 
 Это позволяет пользователям зачислить себя в Курс, либо непосредственно, либо через 

ключ зачисления («Пароль Курса»). Преподавателю тогда не придётся вручную 

добавлять Студентов. 

 Можно использовать более одного варианта Самозачисления, так что когда 

пользователи самозачисляют себя, им назначаются различные Роли, например, 

некоторым пользователям может быть назначена Роль Студента, а другим 

пользователям могут быть назначена Роль неРедактирующего Преподавателя. 

 Метод Самозачисления также позволяет пользователям самим зачисляться в Группы, 

посредством использования Ключа Зачисления Группы. 

 Наиболее полная информация о том, как может работать самозачисление в вашем 

Курсе, приведена в разделе «Самозачисление» (п. 3.3.3). 

4.7.2.1.3.Доступ Гостя 
 Это позволяет тем, у кого есть Роль Гостя, просматривать содержимое Курса. 

 Пользователи с «Ролью Гостя» могут быть посетителями, которые не имеют учётной 

записи в вашей Moodle, или пользователи, которые имеют учётную запись 

(«Аутентифицированные Пользователи»), но кто просто хотел бы изучить ваш Курс. 

 Можно добавить Ключ Зачисления так, что только те Гостевые пользователи, которым 

вы хотите предоставить доступ, смогут войти в Курс. 

 Вхождение в Курс с Гостевым доступом не позволяет пользователю участвовать в 

любых Действиях, он может только просматривать информацию. 

 Наиболее полная информация о том, как может работать Гостевой доступ в вашем 

Курсе, приведена в разделе 3.3.6. 

4.7.2.1.4.Синхронизация Когорт 
 Когорта представляет собой множество пользователей, которые были добавлены либо 

на уровне Сайта или в определённую Категорию, и которые затем могут быть сделаны 

доступными в Курсе через Плагин зачисления Cohort-sync. 

 Только Администратор или Менеджер могут использовать этот Плагин. 

 Наиболее полная информация о том, как может работать синхронизация Когорт в 

вашем Курсе, приведена в разделе 3.3.1.2.2. 

4.7.2.1.5.Ссылка на Метакурс 
 Это позволяет пользователям, которые находятся в другом Курсе, также быть 

автоматически зачисленными в ваш Курс. В качестве примера пусть Сайт Moodle имеет 

Курс «Только для Преподавателей» и Курс «Помощь по Moodle». Если Курс «Только 

для Преподавателей» добавляется в Курс «Помощь по Moodle» посредством плагина 

«Ссылка на Метакурс», то каждый раз, когда новый сотрудник будет присоединяться к 

Курсу «Только для Преподавателей», он автоматически будет зачисляться также и в 

Курс «Помощь по Moodle». 
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 Teachers can only select from courses in which they are teachers when 

using this method. 

 See Course meta link for full details of how this can work in your 

course. 

4.7.2.1.6.PayPal 
 This allows users to pay for a course. The PayPal enrolment plugin 

needs to be enabled sitewide by the administrator and the plugin needs 

to be added to a course by the administrator or a manager. 

 The course teacher can select a cost(and currency for their course) 

along with other course-specific requirements. 

 See PayPal enrolment for full details of how this can work in your 

course. 

4.7.2.2.Managing enrolment methods 

 
Managers and teachers (and any other users with the 

capabilitymoodle/course:enrolconfig) (п. 3.4.8) can manage enrolment 

methods in Settings > Course administration > Users > Enrolment 

methods. 

4.7.2.3.See also 
 Enrolment plugins 

4.7.3.Enrolment key 
A course enrolment (or enrollment) key is one method of restricting Self 

enrolment to a smaller group. The default setting is not to set a key and 

allow anyone to enrol themselves into the course. 

An enrolment key is often used as a simple method of having someone else 

beside the teacher determine if a particular student can self enrol in the 

course. The idea is that one or more people will supply the course key to 

authorized people. Sometimes this distrubution is private email, snail mail, 

on the phone or even verbally in a face to face meetings such as a class or 

counselor's office. 

 При использовании этого метода Преподаватели могут выбирать только из Курсов, в 

которых они являются Преподавателями. 

 Наиболее полная информация о том, как может работать ссылка на Метакурс в вашем 

Курсе, приведена в разделе 3.3.1.2.6. 

4.7.2.1.6.Оплата Курса онлайн по PayPal 
 Это позволяет пользователям оплатить Курс. Плагин зачисления PayPal должен быть 

включен для всего Сайта Администратором и этот Плагин необходимо добавить в Курс 

Администратором или Менеджером. 

 Преподаватель Курса может указать стоимость (и валюту для его Курса) наряду с 

другими специфическими для Курса требованиями. 

 Наиболее полная информация о том, как может работать ссылка на Метакурс в вашем 

Курсе, приведена в разделе 3.3.1.2.7. 

4.7.2.2.Управление методами зачисления 

Методы зачисления 

Название Пользователи Вверх/вниз Редактировать 

Зачисления вручную 3   
Самозачисление (Студента) 0   
Доступ Гостя 0   

Синхронизация Когорты (Год 1 – Студент) 0   
Добавить метод                    Выберите…    V 

Менеджеры и Преподаватели (и любые другие пользователи с Возможностью 

capabilitymoodle/course:enrolconfig) (п. 3.4.8) могут управлять методами Зачисления в 

Administration→Course administration→Users→Enrolment methods. 

 

4.7.2.3.См. также 
 Плагины зачислений (п. 3.3.1.). 

4.7.3.Ключ Зачисления 
Ключ Зачисления Курса (или Зачисления) является одним из способов ограничения 

Самозачисления в небольшую Группу. Настройка по умолчанию не устанавливает Ключ и 

не позволяет любому зачислять себя самому на Курс. 

Ключ Зачисления часто используется в качестве простого способа защиты от того, 

чтобы кто-то ещё кроме Преподавателя определял, может ли конкретный Студент 

самостоятельно зачислиться на Курс. Идея состоит в том, что один или несколько человек 

предоставят Ключ Курса к Аутентифицированным лицам. Иногда эта раздача 

осуществляется через личную электронную почту, обычную почту, по телефону или даже 

в устной форме при встречах лицом к лицу в классе или консультационном офисе. 

http://docs.moodle.org/25/en/File:Enrolment_methods1.png
http://docs.moodle.org/25/en/Capabilities/moodle/course:enrolconfig
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4.7.3.1.Setting an enrolment key within a 
course 
 In the course administration block, click Users>Enrolment methods 

 

 Make sure self enrolment is enabled (has its eye open) and then click 

the edit icon on the right: 

 
 Add your enrolment key in the box provided. (Click Unmask to see 

what you are typing.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Save changes 

4.7.3.2.Setting a group enrolment key 
 It is possible also to enrol students into the course and also directly into 

groups by use of a group enrolment key. 

 To do this, you first need to add the course enrolment key as in the 

section above. 

 If you do not set a master course enrolment key for the course, then 

anyone can enrol without a key and users will not be put into groups. 

 

4.7.3.1.Настройка Ключа Зачисления внутри Курса 
 
 В блоке управления Курсом щёлкните 

Administration→Course administration→Users→Enrolment methods 

 Убедитесь, что включено Самозачисление (его глаз открыт), а затем щёлкните иконку 

редактирования справа: 

 

 

 

 

 

 

 

 

 

 Добавьте ваш Ключ Зачисления в соответствующем окошко. (Щёлкните Unmask (снять 

маску), чтобы увидеть, что вы набираете.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Щёлкните «Save changes (сохранить изменения)». 

4.7.3.2.Настройка Ключа Зачисления Группы 
 Можно зачислить Студентов на Курс, а также непосредственно в Группы посредством 

использования Ключа Зачисления Группы. 

 Чтобы сделать это, в первую очередь необходимо добавить Ключ Зачисления Курса как 

в предыдущем разделе. 

 Если вы не установите Ключ Зачисления Курса для данного Курса, то любой человек 

может зачисляться без Ключа, и пользователи не будут разделены на Группы. 
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 Users in groups do not need to know the master course enrolment key, 

only their own group enrolment key. 

 Users not in a group can use the master course enrolment key as usual 

 

 Change the setting Use group enrolment keys to Yes 

 Save the changes and then in the Course administration settings, click 

Groups>Create groups 

 Add an enrolment key to the group. This will be the key they type in to 

access the course. (The course enrolment key is simply there to keep 

others out) 

 See also this screencast: Group enrolment keys in Moodle 2.0 [1] 

4.7.3.3.Admin settings 
4.7.3.3.1.Making an enrolment key required in 
every course 
 By default, enrolment keys are not set. However, if the administrator 

wants to ensure all teachers set enrolment keys then this can be forced 

in Administration>Site Administration>Plugins>Enrolments>Self 

enrolment This means that self enrolment settings will not "stick" until 

the teacher adds an enrolment key. NOTE: It does NOT provide a site 

wide enrolment key. 

4.7.3.3.2.Using the password policy for enrolment 
keys 
 To ensure that teachers use secure keys that follow your Moodle's 

password policy, check the box in Administration>Site 

Administration>Plugins>Enrolments>Self enrolment 

4.7.3.3.3.Giving users a hint of the enrolment key 
 
 By default, for security reasons, Moodle will not give any clues as to 

what the enrolment key is. Checking the box in Administration>Site 

Administration>Plugins>Enrolments>Self enrolment will provide the 

first letter of the enrolment key if needed. 

4.7.3.4.Tips and Tricks 
 If the enrolment key for a course "gets out" and unwanted people self 

enrol: 

 Change the key. Currently enrolled students will not need the key 

again. 

 

 Пользователи в Группах не нуждаются в знании Ключа Зачисления на главный Курс, 

им достаточно только Ключа Зачисления своей Группы. 

 Пользователи не из Группы могут использовать, как обычно, 

Ключ Зачисления Главного Курса. 

 Изменените настройку Ключи Зачисления в Группу на «Yes (да)». 

 Сохраните изменения и затем в настройках управления Курсом, щёлкните 

Groups→Create groups. 

 Добавьте Группе Ключ Зачисления. Это будет Ключом для получения доступа в Курс 

Студентам. (Ключ Зачисления на Курс нужен там просто для того, чтобы не допустить 

посторонних). 

 См. также этот фильм с экрана: «Ключи Зачисления Группы в Moodle 2.0». 

4.7.3.3.Настройки Администратора 
4.7.3.3.1.Создание Ключа Зачисления, требуемого в каждом 
Курсе 
 По умолчанию Ключ Зачисления не устанавливается. Однако,  если Администратор 

хочет гаранировать, чтобы все Преподаватели  установили свои Ключи Зачисления, он 

может принудить их к этому в Administration→Site Administration→Plugins→ 

Enrolments→Self enrolment Это означает, что настройки Самозачисления не будут 

«работать» до тех пор, пока Преподаватель не добавит Ключ Зачисления. 

ЗАМЕЧАНИЕ: Это НЕ создаёт Ключа Зачисления для всего Сайта. 

4.7.3.3.2. Использование политики паролей для 
Ключей Зачисления 
 Чтобы гарантировать, что Преподаватели используют Ключи безопасности, которые 

соответствуют политеке паролей вашей Moodle, пометьте окошко в 

Administration→Site Administration→Plugins→Enrolments→Self enrolment. 

4.7.3.3.3.Предоставление пользователям подсказки по 
Ключу Зачисления 
 По умолчанию по причинам безопасности Moodle не даёт никаких подсказок того, что 

является Ключом Зачисления. Отметка окошка в 

Administration→Site Administration→Plugins→Enrolments→Self enrolment предоставит 

первую букву Ключа Зачисления, если нужно. 

4.7.3.4.Советы и трюки 
 Если «устранить» Ключ Зачисления для Курса, то нежелательные люди 

самоотчислятся: 

 Измените этот Ключ. Зачисленным к настоящему времени Студентам этот Ключ в 

дальнейшем не потребуется. 

http://www.youtube.com/watch?v=4xzF7xerle0
http://www.youtube.com/watch?v=4xzF7xerle0
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 Unenrol the unwanted users via Enrolled_users in the course 

administration block. 

 Changing or placing a key does not impact currently enrolled students, 

nor does it impact students who may also be enrolled by an enrolment 

plugin. 

 Guests may (optionally) be required to supply the enrolment key (as 

specified on the Course Settings page). They will be required to supply 

the code every time they enter the course. 

 The "No" or "Date range" options in the "Course available" setting 

effectively disables the enrolment key feature, even if it is set. 

 

4.7.3.5.See also 
 Group enrolment keys in Moodle 2.0 video 

4.7.4.Unenrolment 
Unenrolment is the process of removing users from a course. It is 

controlled by one or more of the following: 

 The enrolment duration, which suspends students after the specified 

time has elapsed. Some plugins include the option to unenrol users after 

enrolment expiration 

 For self enrolment, the 'Unenrol inactive after' setting in Administration 

> Course administration > Users > Enrolment methods > Self enrolment 

can be set to specify a time after which a student is automatically 

unenrolled from a course if they haven't accessed it in that time 

 

 An enrolment plugin may decide that the enrolment has expired, for 

example, if a user for a course is not present in an LDAP database, or if 

a Flat file is processed by Cron. 

In addition, users with the appropriate permission can unenrol themself 

from a course. 

4.7.4.1.Enrolment duration 
The default enrolment duration for manual enrolment can be set in 

Administration > Course administration > Users > Enrolment methods > 

Manual enrolment. It can be amended from the default value when 

enrolling users manually in Administration > Course administration > 

Users > Enrolled users. 

The enrolment duration for self enrolment can be set in Administration > 

Course administration > Users > Enrolment methods > Self enrolment. 

 

 Отчислите (п.4.7.4) нежелательных пользователей через Enrolled_users (п.4.7.1) в 

Блоке Управления Курсом. 

 Изменение или размещение Ключа не влияет на уже зачисленных Студентов, и не 

повлияет на Студентов, которые могут также быть зачисленными посредством Плагина 

зачисления. 

 От Гостей (по желанию) можно потребовать применить Ключ Зачисления (как указано 

на странице настроек Курса.). От них потребуется применение кода каждый раз, когда 

онибудут входить в Курс. 

 Опции «No» или «Date range (временной предел)» в настройке «Course available (курс 

доступен)» эффективно отключается средвом Ключа Зачисления, даже если он 

установлен. 

4.7.3.5.См. также 
 Видео «Ключи Зачисления Группы в Moodle 2.0». 

4.7.4.Отчисление 
Отчисление – это процесс удаления пользователей из Курса. Он управляется одним 

или более из следующих признаков: 

 Продолжительность зачисления, которая исключает Студентов после заданного 

времени. Некоторые Плагины включают эту возможность, чтобы исключить 

пользователей после истечения срока Зачисления. 

 Для Самозачисления, может быть установлена настройка «Unenrol inactive after 

(отчислить неактивных после)» в 

Administration→Course administration→Users→Enrolment methods→Self enrolment, 

чтобы указать время, по истечении которого Студент автоматически Отчислится из 

Курса, если он не обращался к Курсу в течение этого времени. 

 Плагин зачисления может решить, что срок зачисления истек, например, если 

пользователь Курс не присутствует в базе данных LDAP, или если плоский (из 

однородных записей) файл обработан Хроном. 

Кроме того, пользователи с соответствующими Полномочиями могут отчислить 

сами себя из Курса. 

4.7.4.1.Продолжительность Зачисления 
Продолжительность Зачисления по умолчанию для Зачисления Вручную может 

быть установлена в Administration→Course administration→Users→Enrolment methods→ 

Manual enrolment. Она может быть изменена со значения по умолчанию при Зачислении 

пользователей вручную в Administration→Course administration→Users→Enrolled users. 

 

Продолжительность Зачисления для Самозачисления может быть установлена в 

Administration→Course administration→Users→Enrolment methods→Self enrolment. 

http://www.youtube.com/user/UsingMoodle?feature=mhum#p/u/0/4xzF7xerle0
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4.7.4.2.Bulk unenrolment 
Users who were previously manually enrolled may be unenrolled in bulk 

via Administration > Course administraton > Users > Enrolment methods 

then clicking on the 'Enrol' users icon. 

4.7.4.3.Unenrolment and grade history 
When a user is unenrolled, their grade history is not deleted. If a user is 

unenrolled accidentally, their grades can be restored by going to 

Administration > Course administration > Users > Enrolled users, clicking 

'Enrol users' and making sure that the 'Recover user's old grades if possible' 

checkbox is ticked in the enrolment options before re-enrolling the user. 

 

 

Users enrolled with methods other than manual will have their grades 

restored depending on the value of "recovergradesdefault" in 

Administration>Site administration>Grades>General settings 

 

4.7.4.4.Suspended or Unenrolled? 
Suspended users are not longer able to access their courses on Moodle but 

their data is preserved, so it is possible for them to return to their course at 

a later time. This might be useful for example, for keeping safe the work of 

students who have left the establishment but whose data might be needed 

for inspection in future years. Suspended users currently still appear in the 

gradebook. 

Note: A single user may be suspended by editing their profile and selecting 

"Suspended account". Groups of users may be suspended from 

"Users>Enrolled users". With the manual enrolments selected, choose 

"Edit user enrolments" and "Alter status>Suspended". 

 

 

Unenrolled users do not normally retain any data and will not appear in 

the gradebook. However, see #Unenrolment and grade history 

Unenrolment is typically more final than suspension. 

4.7.4.5.See also 
Screencast: how to bulk unenrol students from a course. 

 

 

 

 

4.7.4.2.Массовое отчисление 
Пользователи,которые ранее были Зачислены Вручную, могут быть Отчислены все 

все вместе через Administration→Course administration→Users→Enrolment methods, затем 

щелчком по иконке «Enrol (зачислить)» пользователей. 

4.7.4.3.История отчислений и Оценок 
Когда пользователь Отчислен, история его Оценок не удаляется. Если 

пользователь Отчислен случайно, его Оценки могут быть восстановлены посредством 

прехода в Administration→Course administration→Users→Enrolled users, щелчка «Enrol 

users (зачислить пользователей)» и созданием уверенности в том, что окошко-флажок 

«Recover user's old grades if possible (восстановить старые оценки пользоваателя, если 

возможно)» помечень в опциях Зачисления перед повторным Зачислением этого 

пользователя. 

Пользователи, Зачисленные методами, отличными от метда «вручную», смогут 

восстановить свои Оценки в зависимости от значения «Recovergradesdefault 

(восстановитьоценкипоумолчанию)» в 

Administration→Site administration→Grades→General  settings. 

4.7.4.4.Исключение или Отчисление? 
Исключённые пользователи больше не могут иметь доступ к своим Курсам в 

Moodle, но их данные сохраняются, так что в дальнейшем можно их вернуть на свой Курс. 

Это может быть полезно например, для поддержания безопасной работы Студентов, 

которые покинули учебное учреждение, но чьи данные могут потребоваться для проверки 

в будущие годы. Исключённые пользователи в настоящее время по-прежнему появляются 

в Журнале Оценок. 

Замечание: Отдельный пользователь может быть Исключён путём редактирования 

его Профиля и выбором «Suspended account (исключённая учётная запись)»». Группы 

пользователей могут быть искючены из списка Зачисленных пользователей в 

«Users→Enrolled users». С установленным Зачислением Вручную выберите 

«Редактировать Зачисления пользователей» и «Alter status→Suspended (изменить 

статус→исключённый)». 

Нормально не сохранять никаких данных исключённых пользователей и не 

отображать их в Журнале Оценок. Тем не менее, см. «История отчислений и Оценок» 

Отчисление более окончательное, чем Исключение. 

4.7.4.5.См. также 
Снимок с экрана «Как Отчислить Студентов с Курса всех вместе?»: 

http://www.screencast.com/t/XtPhA6w2SM
http://docs.moodle.org/25/en/Unenrolment#Unenrolment_and_grade_history
http://www.screencast.com/t/XtPhA6w2SM
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4.7.5.Other users 
Other users  - users assigned a role in a course without enrolling them. 

Users can be assigned a role in a course without enrolling them in 

Administration > Course administration > Users > Other users. 

This means they can carry out tasks relevant to their permissions but they 

don't appear in the Participants list. An example of this would be assigning 

a user to a Principal, Manager or Helpdesk type role to provide them 

access without confusing the participants list. 

This page also lists users who have been assigned a similar role at Site or 

Category level. 

Note: By default, the only role which can be assigned to other users is the 

manager role. To enable other roles, such as teacher to be assigned, the 

capability moodle/course:view should be allowed for the role. 

 

Screenshot «Assign Others Link». 

 

Screenshot «The following users are not enrolled  in this course but do 

have roles, 

inherited or 

assigned 

within it». 
 

4.7.6.See also 
 Assign roles 

 Using Moodle Moodle 2.0 hidden teacher forum discussion 

 

 

 

 

 

 

 

 

 

 

4.7.5.Другие пользователи 
Другие пользователи – пользователи с назначенной Ролью без Зачисления на Курс. 

Пользователям может быть назначена Роль в Курсе без их зачисления в 

Administration→Course administration→Users→ Other users. 

Это означает, что они могут выполнять задачи, относящиеся к их Полномочиям, но 

они не появляются в списке Участников. Примером этого может служить присвоение 

пользователю Роли директора, Менеджера или помощника по компьютерам, чтобы 

предоставить им доступ, не делая смущающих изменений в списке Участников. 

На этой странице также перечисляются пользователи, которым была назначена 

аналогичная Роль на уровне Сайта или Категории. 

Замечание: По умолчанию, единственная Роль, которая может 

быть назначена другим пользователям Роль Менеджера. Чтобы 

позволить назначать другие Роли, например, Преподавателя, для этой 

Роли должна быть разрешена Возможность Moodle/course:view. 

Снимок с экрана «Ссылка на назначить других 

пользователей»: 

Снимок с экрана «Следующие пользователи не Зачислены на 

этот Курс, но имеют Роли, унаследованные или назначенные в нём»: 

 

4.7.6.См.также 
 Назначить Роли (п. 3.4.2). 

 Обсуждения форума по использованию «Скрытый Преподаватель в в Moodle 2.0». 

 

http://moodle.org/mod/forum/discuss.php?d=168264
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4.8.Grouping users 

4.8.1.Groups 
On the course level can you assign a user to one (or more) groups. In a 

course you can assign a context(activity) to a group. When members of the 

group leave the course, they lose their identity with the group. 

A teacher can organise users into groups within the course or within 

particular activities. 

4.8.1.1.Why use groups? 
 You are a teacher in a course where you have several classes and you 

want to filter your activities and gradebook so you only see one class at 

a time. 

 You are a teacher sharing a course with other teachers and you want to 

filter your activities and gradebook so you don’t see the students from 

your colleagues’ classes. 

 You want to allocate a particular activity or resource to just one class or 

set of users and you don’t want others to see it. See Groupings.(п. 4.8.3) 

 

4.8.1.2.Group levels 
A group or grouping can be used on two levels: 

 

 Course level - The group mode defined at the course level is the default 

mode for all activities defined within that course. To use groups you 

need first to set a group mode in Administration>Course 

administration>Edit settings. 

 Activity level - Each activity that supports groups can also have its own 

group mode defined. If the course setting "Force group mode" is set to 

"Yes" then the option to define the group mode for individual activities 

is not available. If it is set to "No", then the teacher may change the 

group mode: 

 

Screenshot «Group mode course». 

 

 

 

 

 

4.8.Группирование пользователей 
4.8.1.Группы 

На уровне Курса вы можете назначить пользователя в одну (или более) Групп. В 

Курсе Группе можно назначить Контекст (Действие). Когда члены Группы покидают 

Курс, они теряют свою принадлежность к Группе. 

Преподаватель может организовать пользователей в Группы внутри Курса или 

внутри  конкретных Интерактивных Действий. 

4.8.1.1.Зачем использовать Группы 
 Вы Преподаватель в Курсе, где у вас есть несколько классов, и вы хотите 

отфильтровать Интерактивные Действия и Журнал Оценок так, чтобы видеть классы по 

отдельности. 

 Вы Преподаватель, совместно использующий Курс с другими Преподавателями, и вы 

хотите отфильтровать Интерактивные Действия и Журнал Оценок так, чтобы не видеть 

Студентов из классов ваших коллег. 

  Вы хотите выделить конкретное Интерактивное Действие или Ресурс только одному 

классу или группе пользователей, и вы не хотите, чтобы другие видели это. См. 

«Распределение по Группам (п. 4.8.3)» 

4.8.1.2.Уровни Групп 
Группу или Группировку из нескольких Групп можно использовать на двух 

уровнях: 

 Уровень Курса – Групповой режим определён на уровне Курса по умолчанию для всех 

видов Интерактивных Действий в рамках этого Курса. Чтобы так использовать Группы, 

нужно сначала установить Групповой Режим в 

Administration→Course administration→Edit settings. 

 Уровень Интерактивного Действия – Каждое Интерактивное Действие, которое  

должно выполняться Группой, может также иметь свой индивидуально определённый 

Групповой Режим. Если настройка Курса «Force group mode (принудительный 

групповой режим)» установлена в «Yes», тогда эта опция не способна определять 

Групповой режим отдельных Интерактивных Действий. Если она установлена в «No», 

то Преподаватель может изменять Групповой Режим от Группы к Группе: 

Снимок с экрана: «Курс с Групповым режимом». 

http://docs.moodle.org/25/en/File:groupmodecourse.png
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4.8.1.2.1.Group modes 
There are three group modes 

 No groups - There are no sub groups, everyone is part of one big 

community 

 Separate groups - Each group can only see their own group, others are 

invisible. 

 Visible groups - Each group works in their own group, but can also see 

other groups. (The other groups' work is read-only.) 

  

For example, enabling either separate or visible groups on an assignment 

drop-box enables staff to filter the student submissions to see only those 

from a particular tutor group. With visible groups, students can see which 

other groups are doing the same activities as they are; with separate 

groups, they do not know which other groups are doing the same activities. 

 

Using groups with discussion forums allow teachers to restrict interaction 

between students. Separate groups mean only students in the same group 

can see and participate in discussions within a particular forum. Visible 

groups allow students to see other group's discussions, but only participate 

in their own group's discussions. 

4.8.1.3.Creating a group 
1. Click the 'Create group' button in Administration> Course 

administration > Users > Groups 

2. Add a group name and optional description (displayed above the list of 

group members on the participants page), enrolment key and picture 

(displayed on the participants page and next to forum posts) 

3. Click the 'Save changes' button 

4. Select the group to which you want to add participants, then click the 

'Add/remove users button 

5. In the "Potential members" list, select the users you want to add to the 

group. Multiple users may be selected using the Crtl key. 

 

6. Click the Add button to add the users to the group 

An optional group ID number (an advanced setting) may be added for 

matching the group against external systems. Group ID numbers are not 

displayed anywhere on the site. Within a course, all group ID numbers 

must be unique. Thus it's not possible to create a group with a duplicate 

group ID number. 

 

4.8.1.2.1.Групповые Режимы 
Есть три Групповых Режима: 

 No groups (нет групп) – Нет подГрупп, каждый является частью одного большого 

сообщества. 

 Separate groups (раздельные группы) – Каждая Группа может видеть только свою 

собственную Группу, другие невидимы. 

 Visible groups (видимые группы) – Каждая группа Студентов работает в своей 

собственной Группе, но может также видеть другие Группы. (Работа других Групп 

доступна только в режиме «для чтения»). 

Например, включение настройки Separate groups или Visible groups в окне 

настройки Интерактивного Действия «Задание» (в области Common module settings) 

позволяет сотрудникам отфильтровать переданные на рассмотрение студенческие работы, 

чтобы увидеть только Группу конкретного наставника. В режиме Visible groups Студенты 

могут видеть, какие другие Группы осуществляют те же мероприятия, что и они; в режиме 

Separate groups Студенты не знают, что делают другие Группы. 

Использование Групп в дискуссионных Форумах позволяет Преподавателям 

ограничить взаимодействие между Студентами. Separate groups означает только, что 

Студенты одной Группы могут видеть и принять участие в обсуждениях в рамках 

определённого Форума. Visible group позволяют Студентам видеть обсуждения другой 

Группы, но участвовать в обсуждениях они могут только в их собственной Группе. 

4.8.1.3.Создание Группы 
1. Щёлкните кнопку «Create group (создать группу)» в 

Administration→Course administration→Users→Groups. 

2. Добавьте название Группы и по выбору описание (отображается над списком членов 

Группы на странице Участников), ключ для Зачисления и изображение (отображаются 

на странице Участников, рядом с корреспонденциями Форума). 

3. Нажмите кнопку «Save changes (сохранить изменения)». 

4. Выберите Группу, в которую вы хотите определить Участников, а затем нажмите 

кнопку «Add/remove users (добавить/удалить пользователей)». 

5. В списке «Potential members (потенциальные члены)» выберите пользователей, которых 

вы хотите распределить в эту Группу. Сразу несколько пользователей могут быть 

выбраны при удерживании нажатой клавиши Crtl. 

6. Нажмите кнопку Add (добавить), чтобы добавить пользователей в эту Группу. 

Назначаемый ID (идентификационный номер) Группы (продвеинутые настройки) 

может быть добавлен для согласования Группы с внешними системами. 

Идентификационные номера Групп нигде не показываются на Сайте. Все ID Групп в 

Курсе должны быть уникальными. Таким образом, невозможно создать Группу с 

повторяющимся идентификационным номером Группы. 
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4.8.1.4.Auto-create groups 
Groups may be created automatically via the 'Auto-create groups' button in 

Administration > Course administration > Users > Groups. To see all the 

settings, click the Show Advanced button. 

Select members from ... allows you to choose from roles or available 

cohorts. Specify and Group/Member count work together. 

 

You can specify if you would like to create 

 x number of Groups or 

 each group contain x number of students 

When selecting Members per group the Prevent last small group will 

allocate additional members to an existing group rather then create a 

new group with fewer members than x. In Moode 2.5 this setting is 

found by clicking on the Show More link. 

 

A naming scheme can be created automatically. # is replaced by 

sequential numbers, and @ by letters. For example: 

 Group @ will create group with a naming scheme Group A, Group B, 

Group C… 

 Group # will create group with a naming scheme Group 1, Group 2, 

Group 3… 

Create in grouping and Grouping name allows you to create a new 

grouping and allocate the new autocreated groups to be created to it. 

 

Prior to creating the groups, you can view the groups. 

4.8.1.5.Groups and enrol plugins 
Where groups are created automatically with enrol plugins such as IMS 

Enterprise, members cannot be unenrolled manually via the groups screen 

inside a course. This has to be done from the plugin. Additionally, when 

group members are owned by a plugin like this, there is information below 

their name on the groups screen. 

4.8.1.6.Groups overview 
A overview of groups and groupings is available via the Overview tab in 

Administration > Course administration > Users > Groups. 

The table may be filtered to display particular groupings or groups. 

 

 

 

 

4.8.1.4.Авто-создание Групп 
Группы могут быть созданы автоматически посредством кнопки «Auto-create 

groups (авто-создание групп)» в Administration→Course administration→Users→Groups. 

Чтобы увидеть все настройки, щёлкните кнопку Show Advanced. 

Настройка «Select members from... (выберите членов из…)» позволяет вам выбрать 

из Ролей или доступных Когорт. Настройки Specify (указать) и Group/Member count 

(количество групп/членов) работают вместе. 

Вы можете указать, что вы хотели бы создать: 

 х (число) Групп, или 

 в каждой Группе по х Студентов. 

При выборе опции Members per group (Студентов в группе) настройка  «Prevent last 

small group (предотвратить малочисленность последней группы)» распределит 

дополнительных Студентов в существующую Группу, а не создаст новую Группу с 

количеством Студентов меньше х. В Moode 2.5 эту настройку можно обнаружить, 

щёлкнув по ссылке Show More. 

Схема поименования может быть создана автоматически. # заменится 

последовательными числами, а @ – буквами. Например, 

 Если в настройке Naming scheme указать значение «Группа @», тогда автоматически 

будут генерироваться имена Групп: Группа А, Группа B, Группа C… 

 Если в настройке Naming scheme указать значение «Группа #», тогда автоматически 

будут генерироваться имена Групп: Группа 1, Группа 2, Группа 3… 

Настройки Create in grouping (создать в группировке) и Grouping name (название 

группировки) позволяют создать новую Группировку и разместить в неё новые 

автоматически создаваемые Группы. 

Перед созданием Групп вы можете просмотреть Группы. 

4.8.1.5.Группы и Плагины зачислений 
Если Группы создаются автоматически с помощью Плагинов зачислений, таких 

как IMS Enterprise, члены не могут быть отчислены вручную через экран Групп внутри 

Курса. Это должно быть сделано из плагина. Кроме того, когда члены Группы 

зачисляются посредством плагина, подобного этому, на экране Групп ниже их имени 

приводится информация. 

4.8.1.6.Просмотр Групп 
Обзор Групп и Группировок доступен через этикетку Overview в 

Administration→Course administration→Users→Groups. 

Эта таблица может быть отфильтрована так, чтобы отображать конкретные 

Группировки или Группы. 



 

401 

4.8.1.7.Groups capabilities 
4.8.1.7.1.Manage groups 
Capabilities/moodle/course:managegroups 
 This allows a user to add/delete/update groups in a course 

 This capability is allowed for the default roles of manager and teacher 

4.8.1.7.2.Access all groups 
Capabilities/moodle/site:accessallgroups 
 This allows a user to access all groups in the given context (system, 

front page, course category or course context), irrespective of what 

group the user is in or whether they are in a group at all. For example, a 

user with this capability set to allow can browse forum postings of users 

in other groups when the forum is set to separate groups. 

 

 The default teacher and non-editing teacher roles have this capability 

set to allow. 

Note: Users with a role in which moodle/course:managegroups is allowed 

and moodle/site:accessallgroups is not set are able to add/delete/update 

groups (and groupings, if enabled) in a course. 

4.8.1.7.3.Manage group calendar entries 
Capabilities/moodle/calendar:managegroupentries 
 This allows a user to add, update or delete calendar group entries in the 

context this capability applies to (system, course category or course) 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Example usage 

 Calendar editor role 

4.8.1.8.See also 
 Upload users - for importing users into groups 

 

 

 

 

 

 

 

 

 

4.8.1.7.Возможности Групп 
4.8.1.7.1.Управлять Группами 

Возможность Capabilities/moodle/course:managegroups 

 Позволяет пользователю добавлять/удалять/обновлять Группы в Курсе. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

4.8.1.7.2.Доступ ко всем Группам 
Возможность Capabilities/moodle/site:accessallgroups 

 Это позволяет пользователю получить доступ ко всем Группам в данном Контексте 

(системным, Главной страницы, Категории Курса или Контекста Курса), независимо от 

того, входит ли пользователь в конкретную Группу, или же он просто является членом 

какой-то Группы Курса. Например, пользователь с этой Возможностью, установленной 

в Allow, может просматривать корреспонденции на форумах пользователей других 

Групп, когда в Форуме установлен режим Separate groups. 

 Эта Возможность по умолчанию установлена в Allow для Ролей Преподавателя и 

нередактирующего Преподавателя. 

Замечание: Пользователи с Ролью, в которой разрешена Возможность 

moodle/course:managegroups, а в moodle/site:accessallgroups не установлена, способны 

добавлять/удалять/обновлять Группы (и Группировки, если они позволены) в Курсе. 

4.8.1.7.3.Управлять записями Календаря Группы 
Возможность Capabilities/moodle/calendar:managegroupentries 

 Позволяет пользователю добавлять, обновлять или удалять записи Календаря (п. 3.17.7) 

Группы в Контексте применений этой Возможности (системы, Категории Курса или 

Курса). 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Пример использования 

 Роль редактора Календаря (п. 3.4.4.11).  

4.8.1.8.См. также 
 «Переслать пользователей» – для импорта пользователей в Группы (п. 3.2.4). 

http://docs.moodle.org/25/en/Groups
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4.8.2.Import groups 
Groups import provides a simple, easy way to create groups from a 

spreadsheet (CSV). 

To import groups 

 Click the 'Import groups' button in Settings > Course administration > 

Users > Groups 

 Upload the CSV file (see below for file format) either by dragging and 

dropping into the box with the arrow (1 below) or by clicking "choose a 

file" and uploading from the File picker. (2 below) 

 
 Click the 'Import groups' button 

4.8.2.1.CSV file fieldnames 
The CSV file has just one required fieldname (groupname), but can include 

default and/or optional fieldnames 

 Each line of the file contains one record 

 Each record is a series of data separated by commas 

 The first record of the file is special, and contains a list of fieldnames. 

This defines the format of the rest of the file. 

Required fieldnames - These fields must be included in the first record, 

and defined for each column. 

groupname 

Default fieldnames - These are optional - if they are not included then the 

values are taken from the current language and current course 

idnumber,coursename,lang 

Optional fieldnames 

description,enrolmentkey 

(Note: The field "picture" and "hidepicture" will produce a "not a valid 

fieldname" error when uploaded.) 

 

 

4.8.2.Импортировать Группы 
«Импортировать Группы» обеспечивает простой и удобный способ для создания 

Групп из Электронной Таблицы (CSV). 

Чтобы импортировать Группы 

 Щёлкните кнопку «Import groups» в 

Administration→Course administration→Users→Groups. 

 Загрузите файл CSV (см. ниже о формате файла) либо с помощью буксировки в поле со 

стрелкой (1 ниже) или, нажав кнопку «Choose a file» и загрузку из меню файлов. (2 

ниже). 

 
 Щёлкните кнопку «Import groups (импортировать группы)» 

4.8.2.1.Имена полей файла CSV 
Файл CSV имеет только одно необходимое имя поля (имя Группы), но может по 

умолчанию включать дополнительные имена полей. 

 Каждая строка файла содержит одну запись. 

 Каждая запись является последовательностью данных, отделённых запятыми. 

 Первая запись файла является специальной и содержит список имён полей.Он 

определяет формат остатка файла. 

Требуемые имена полей. Эти поля еужно включить в первую запись и устанавливаться 

для каждой колонки (поля колонок в каждой записи отеляются запятыми). 

groupname 

Имена полей по умолчанию. Они не обязательны. Если не включены, тогда берутся 

значения из текущего языкового пакета и текущего Курса. 

idnumber,coursename,lang 

Назначаемые имена полей. 

description,enrolmentkey 

(Замечание. Поля «picture» и «hidepicture» вызовут отклик «Not a valid fieldname (неверное 

имя поля)» об ошибке при загрузке). 
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New feature in Moodle 2.5! 

If the groupingname is included, the imported groups will be allocated to 

those groupings. The groupings will be created if they do not already 

exist:э 

groupingname 

Separation between the comma and the text can not be a blank. 

Commas within the data should be encoded as &#44 - the script will 

automatically decode these back to commas. 

For Boolean fields, use 0 for false and 1 for true. 

Either idnumber or coursename can be used to identify the course. 

Idnumber overrides coursename. If neither is specified, the groups will be 

added to the current course. 

Coursename is the course shortname. 

Group ID numbers are for matching groups against external systems. 

Within a course, all group ID numbers must be unique. 

The file must be in ANSI encoding, at least not be saved in UTF-8 

encoding. 

Note: If a group is already registered in the Moodle database for a 

particular course, this script will return the group name for that group. 

Teachers are only allowed to upload groups in courses they are authorized 

to edit. 

A sample file looks like this: 

groupname,description,enrolmentkey 

Team 1,Group Assignment Team 1,orange 

Team 2,Group Assignment Team 2,purple 

Team 3,Group Assignment Team 3,green 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Новое средство в Moodle 2.5! 

Если название Группировки включено, импортированные Группы будут 

размещены в этих Группировках. Группировки будут созданы, если они ещё не 

существуют: 

groupingname 

Между запятой и текстом не должно быть пробела. 

Запятые в данных должны быть закодированы как &#44, – сценарий 

автоматически декодируеть их обратно в запятые. 

Для логических полей , используйте 0 для лжи и 1 для истины. 

Либо номер ID, либо название Курс могут быть использованы для идентификации 

Курса. Номер ID переопределяет название Курса. Если ничего не указано, эти Группы 

будут добавлены в текущий Курс. 

Название Курса – это краткое название Курса. 

Идентификационные номера Групп служат для сопоставления Групп с внешними 

системами. В Курсе, все ID-номера Групп должны быть уникальными. 

Файл должен быть в кодировке ANSI, по крайней мере, сохранён не в кодировке 

UTF-8. 

Замечание: Если Группа уже зарегистрирована в базе данных Moodle для 

конкретного Курса, этот сценарий будет возвращать название Группы для этой Группы. 

Преподавателям разрешено загружать Группы только в те Курсы, которые они 

уполномочены редактировать. 

Образец файла выглядит следующим образом: 

groupname,description,enrolmentkey (имя группы, содержание, ключ зачисления) 

Команда 1, групповое Задание Команде 1, оранжевый 

Команда 2, групповое Задание Команде 2 , фиолетовый 

Команда 3, групповое Задание Команде 3, зелёный 
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4.8.3.Groupings 
Groupings are a collection of groups. If you had 10 groups, you could 

combine or mix and match the smaller groups into 2 or more groupings. 

You can assign a grouping to a context like an assignment. 

 

If you want to make an activity (such as an assignment or a quiz) visible to 

only one set of users within a course, you need first to put the users into a 

group and then put them into a grouping. A single grouping can house one 

group or several groups. 

If you assign an activity to a grouping then only the group/grouping that is 

selected will be able to see and do the activity. It will be invisible to other 

groups or groupings. 

NOTE: if you want to show resources (such as a folder or webpage) to just 

to one group and not another, see Available for group members only. 

 

4.8.3.1.Adding groups to a grouping 
To add groups to a grouping: 

 In your course, click Settings > Course administration > Users > 

Groups. 

 Click the groupings tab: 

 If necessary, create a new 

grouping by clicking the 

create grouping button on 

the groupings page. 

An optional grouping ID number 

(an advanced setting) may be added 

for matching the grouping against external systems. Grouping ID numbers 

are not displayed anywhere on the site. Within a course, all grouping ID 

numbers must be unique. Thus it's not possible to create a grouping with a 

duplicate grouping ID number. 

 Click the "Show groups in grouping" people icon in the edit column: 

 

 

 

 

 

 

 

 

4.8.3.Группировки 
Группировки представляют собой набор из нескольких Групп. Если у вас 10 Групп, 

вы могли бы объединить или смешать эти малочисленные Группы,  создав 2 или более 

Группировок. Вы можете назначить Группировку для отдельного Контекста, подобного 

Заданию. 

Если вы хотите сделать Интерактивное Действие (такое, как Задание или Экзамен) 

видимым только одной Группе пользователей в Курсе, вам нужно сначала поместить 

пользователей в Группу, а затем поместить их в Группировку. Одна Группировка может 

состоять из одной или нескольких Групп. 

Если вы назначили Интерактивное Действие Группировке, то только выбранная 

Группа/Группировка сможет увидеть и выполнить это Интерактивное Действие. Оно 

будет невидимым для других Групп или Группировок. 

ЗАМЕЧАНИЕ: если вы хотите показать Ресурсы (такие, как Папка или Веб-

страница) только одной Группе и никакой другой, см. «Доступно только для членов 

группы» (п. 4.8.5). 

4.8.3.1.Добавление Групп в Группировку 
Чтобы добавить Группу в Группировку: 

 В вашем Курсе щёлкните Administration→Course administration→Users→Groups. 

 

 Щёлкните этикетку «Groupings». 

 Если необходимо, создайте новую 

Группировку, щёлкнув кнопку «Create 

grouping (создать группировку)» на странице 

Groupings (см. снимок с экрана слева) 

Необязательный ID-номер Группировки 

(продвинутая настройка) может быть добавлен 

для согласования с внешними системами. ID-

номера Группировок не отображаются нигде на Сайте. Внутри Курса все ID-номера 

Группировок должны быть уникальными. Другими словами, невозможно создать 

Группировки с дублирующимся ID-номером Группировки. 

 Щёлкните иконку «человечек» «Show groups in grouping (показать группы в 

группировке)» в колонке Edit (редактировать). 
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 On the add/remove groups page, select the group(s) you want to add to 

the grouping from the "Potential members" list. 

 

 Click the arrow button that points towards the "Existing members" list. 

 

 Click the "Back to groupings" button. The group(s) you added to the 

grouping will now be listed in the table on the groupings page. 

 

 

Existing groupings can be edited and/or deleted using the appropriate icons 

in the edit column of the table on the groupings page. 

 

4.8.3.2.Setting the default grouping 
Once some groupings have been created, a default grouping for course 

activities and resources may be set. 

1. Follow the settings link in the course administration block. 

2. In the groups section in the course settings, select the default grouping. 

The default grouping is used on the Participants page 

4.8.3.3.Selecting grouping in activity 
To use a particular grouping in an activity: 

 In the "edit settings" link of the Settings block for the activity, click the 

"Show advanced" button in the common module settings section. 

 

 Ensure that the group mode is set to separate or visible groups. 

 

 Select the grouping from the grouping dropdown menu. 

 Check the "Available for group members only" box. 

 

 Click the "Save changes" button at the 

bottom of the page. 

Students will only see the activities they have 

been assigned to. Teachers will see the name of 

the grouping in brackets after the activity name 

on the course page. A count of activities 

assigned to each grouping is kept on the groupings page. 

Please note that the grouping option appears by default only in activities 

that support group modes. If you enable Available for group members only 

you will be able to assign resources to specific groups also. 

 

 На странице «Add/Remove groups (добавить/переместить группы)», выберите 

Группу(ы), которую(ые) вы хотите добавить в Группировку из списка «Potential 

members (потенциальных членов)». 

 Щёлкните кнопку со стрелкой, которая указывает в сторону списка «Existing members 

(существующие члены)». 

 Щёлкните кнопку «Back to groupings (назад к 

группировкам)». Группа(ы), которую(ые) вы 

добавили в Группировки теперь будут 

перечисляться в таблице на странице Группировок. 

Существующие Группировки могут быть отредактированы и/или удалены с 

помощью соответствующих иконок в столбце редактирования таблицы на странице 

Группировок. 

4.8.3.2.Настройка Группировки по умолчанию 
После того, как несколько Группировок создано, можно установить для 

Интерактивных Действий Курса и Ресурсов Группировки по умолчанию. 

1. Перейдите по ссылке настроек в Блоке управления Курсом. 

2. В разделе Groups (группы) в настройках Курса, выберите Группировку по умолчанию. 

Группировка по умолчанию используется на странице Participants (участники). 

4.8.3.3.Выбор Группировки в Интерактивном Действии 
Чтобы использовать конкретную Группировку в Интерактивном Действии: 

 По ссылке «Edit settings (настройки редактирования)» Блока настроек 

Интерактивного Действия, щёлкните кнопку «Show advanced (показать расширенно)» в 

разделе обычных настроек модуля. 

 Убедитесь, что Групповой режим установлен в «Separate groups (отдельные группы)» 

или «Visible groups (видимые группы)». 

 Выберите Группировку из ниспадающего меню Группировок. 

 Пометьте окошко «Available for group members only 

(доступные только для группы)». 

 Щёлкните кнопку «Сохранить изменения» в нижней части 

страницы. 

Студенты будут видеть только те мероприятия, в которые 

они были вовлечены. Преподаватели будут видеть название Группировки в скобках после 

имени Интерактивного Действия на странице курса. Количество 

Интерактивных Действий, назначенных каждой Группировке хранится на странице 

Группировок. 

Обратите внимание, что опция Группировки отображается по умолчанию только в 

Интерактивных Действиях, которые поддерживают Групповые Режимы. Если вы 

включите «Available (доступно)» только для членов Группы, вы сможете также назначать 

Ресурсы для конкретных Групп. 
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4.8.3.4.Restricting a whole topic to a grouping 
 
There is a dropdown setting in each topic summary which allows you to 

select a particular grouping for that topic section. To enable this setting, 

you need to enable both Conditional activities and Available for group 

members only 

4.8.3.5.Examples of groupings 
It sometimes helps to think of a grouping as a Romulan cloaking device 

Those groups inside it know of their existence but other groups within the 

course cannot see them. 

 

4.8.3.5.1.Example 1: Differentiation 
 You have course on Macbeth shared by three teachers. The activities 

and resources are mostly the same and used by all three classes. 

 

 However, Mr Brown’s class are a higher ability and so are set some 

extension assignments that must not be seen by Mrs Smith’s class who 

are of a lower ability. Mrs Smith’s class need some extra assistance and 

are set some activities which are too easy for Mr Brown's students. 

 

Ms Black’s class are middle ability and can cope with some of the 

higher tasks but also benefit from some of the supportive tasks Mrs 

Smith uses. 

Groupings would allow all three teachers to share the course and yet direct 

activities to specific classes: 

 3000 word in-depth assignment - only for Class Brown. The class is 

added to the grouping “Class Brown” and the assignment is set to the 

“Class Brown” grouping. Only these students will see it. 

 Basic Shakespeare vocabulary –a page only for Class Smith. The class 

is added to the grouping “Class Smith” and the page is set to the "Class 

Smith" grouping (See Available for group members only for resources) 

Only the students with special educational needs will see it. 

 Quiz on the main protagonists –suitable for Class Brown (high ability) 

but offered to Class Black also to extend their learning. Both classes are 

added to a grouping “ClassBrownBlack” and the quiz is set to the 

"ClassBrownBlack" grouping. These two classes will see the quiz but 

Mrs Smiths’s will not. 

 

4.8.3.4.Предоставление целой Темы Курса только одной 
Группировке 

Существует настройка в выпадающем меню в каждом резюме Темы, которая 

позволяет выбрать конкретную Группировку для Раздела этой Темы. Чтобы включить эту 

настройку, необходимо позволить как «Обусловленные Интерактивные Действия» (п. 

4.9.2), так и «Доступно только для членов Группы» (п. 4.8.5). 

4.8.3.5.Примеры Группировок 
Это иногда наводит на мысль думать о Группировке как о Ромуланском устройстве 

маскировки (из американского научно-фантастического сериала «Звёздный путь», где говорится о 

маскирующих технологиях), те Группы, что внутри неё, знают об их существовании, но другие 

Группы в Курсе и не догадываются. 

4.8.3.5.1.Пример 1:Установление различий 
 У вас есть Курс по Макбету, совместно используемый тремя Преподавателями. 

Интерактивные Действия и Ресурсы в основном совпадают и используются всеми 

тремя классами. 

 Однако, способности класса мистера Брауна несколько выше и поэтому установлены 

некоторые расширения Задания, которые не должны быть видны классам миссис Смит, 

которые обладают более низкими способностями. Классу миссис Смит нужна 

дополнительная помощь, и поэтому для него устанавливаются некоторые 

Интерактивные Действия, которые слишком легки для Студентов мистера Брауна. 

Класс мисс Блэк средних способностей, и может справиться с некоторыми из высших 

задач, но также и извлечь выгоду из некоторых вспомогательных задач, используемых 

миссис Смит. 

Группировки позволяют всем трём Преподавателям совместно использовать этот 

Курс, и в то же время направлять разные Интерактивные Действия конкретным классам: 

 3000 слов в углублённом Задании – только для класса Браун. Класс добавляется в 

Группировку «Класс Браун» и Задание устанавливается в Группировку «Класс Браун». 

Только эти Студенты будут видеть его. 

 Основной словарь Шекспира – страница только для класса Смита. Этот класс 

добавляется в Группировку «Класс Смит» и страница установливается в группировку 

«Класс Смит» (о ресурсах см. «Доступно только для членов Группы»). Только 

Студенты с особыми образовательными потребностями увидит его. 

 Экзамен по главным героям – подходит для класса Брауна (высокие способности), но 

предлагается и классу Блэк с тем, чтобы расширить их познания. Оба класса 

добавляются в Группировку «Класс Брауна Блэк», и Экзамен устанавливается для 

Группировки «Класс Брауна Блэк». Эти два класса будут видеть Экзамен, но класс 

миссис Смит не будет. 

http://docs.moodle.org/25/en/Available_for_group_members_only
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4.8.3.5.2.Example 2: Mandatory and optional 
modules 
 A university has a mandatory module of work FS32 and two optional 

modules FS33 and FS34 within a single Moodle course. So all students 

must complete FS32 and then choose either one of the other two 

options. Once students have signed up to one of the optional modules 

they are not allowed to view the contents of the other module. 

 Three groups may be made: group FS32 including all students on the 

course; group FS33 including only those who have signed up for this 

optional module, and group FS34 including only those who have signed 

up for the other optional module. 

 Nothing needs to be done with the activities in the mandatory module 

FS32 as all students need to access them. The activities can be set to 

separate or visible groups but no grouping is necessary. 

 In order for only those students who signed up for optional modules 

FS33 and FS34 to view them, "Group FS33" needs to be put into 

"Grouping FS33". and "Group FS32" needs to be put into "Grouping 

FS34" 

 The activities in each of the two optional modules can then be assigned 

to the respective groupings. With Moodle 2.3 it is possible to allocate 

whole course sections to groupings so it might be useful to add the 

activities to a particular course section to save administrative time. 

4.8.3.6.One way to visualise groupings 
Olympic metaphor: at the Olympics, there are different sports (gymnastics, 

swimming, track) and many countries. There are two ways to think of an 

Olympian athlete: by the sport they compete in, and by their nationality. To 

be part of the United States Olympic Team, you must first be a swimmer, a 

gymnast, or a runner. You cannot be in the US Team without first being an 

athlete in a specific sport. The sport is your group. Your country is your 

grouping. You must belong to a group before joining a grouping. 

 

4.8.3.7.See also 
 Available for group members only 

 Importing users into groupings via CSV 

 Groupings FAQ 

 Using Moodle Moodle Groups vs. Groupings forum discussion 

including youtube video showing how to set up groupings 

 

4.8.3.5.2.Пример 2: Обязательные и элективные модули 
 
 Университет имеет обязательный модуль работы FS32 и два элективных модуля, FS33 

и FS34, в рамках одного курса Moodle. Таким образом, все Студенты должны 

выполнить FS32, а затем выбрать какой-либо один из двух других вариантов. Как 

только Студенты подписались на один из элективных модулей, им не разрешается 

просматривать содержимое другого модуля. 

 Могут быть созданы три Группы: Группа FS32, включающая всех Студентов Курса; 

Группа FS33, включающая только тех, кто подписался на этот элективный модуль, и 

Группа FS34, включающая только тех, кто подписался на другой элективный модуль. 

 

 Ничего не нужно делать с Интерактивными Действиями в обязательном модуле FS32, 

так как все Студенты должны получить к ним доступ. Интерактивные Действия можно 

установить в режим Separate groups или Visible groups, но Группировке это не нужно. 

 Для того, чтобы только те Студенты, которые подписались на элективные модули FS33 

и FS34, просматривали их, «Группа FS33» должна быть введена в «Группировку FS33», 

а «Группа FS32» должна быть введена в «Группировку FS34» 

 Интерактивные Действия в каждом из двух элективных модулей могут быть назначены 

в соответствующие Группировки. В Moodle 2.3 можно распредеоить целые разделы 

Курса в Группировки, так что может оказаться полезным добавление 

Интерактивных Действий к конкретный раздел Курса, чтобы съэкономить 

Административное время. 

4.8.3.6.Пример, поясняющий, что такое Группировки 
Олимпийская метафора: в Олимпиаде участвуют различные виды спорта 

(гимнастика, плавание, легкая атлетика) и многие страны. Есть два способа, чтобы 

представить олимпийского спортсмена: участником какого-либо вида спорта и участником 

своей национальной сборной. Чтобы быть участником олимпийской сборной 

Соединенных Штатов, нужно сначала быть пловцом, гимнастом или бегуном. Вы не 

можете быть в сборной США, не будучи атлетом в определённом виде спорта. Этот вид 

спорта – ваша Группа. Ваша страна – это ваша Группировка. Вы должны принадлежать 

Группе до присоединения к Группировке. 

4.8.3.7.См. также 
 «Доступно только для членов Группы» (п. 4.8.5). 

 «Импорт пользователей на Группы через CSV» (п. 4.8.2). 

 «Часто задаваемые вопросы по Группировкам» (п. 4.8.8). 

 См. Обсуждения на форуме «Группы и Группировки в Moodle», включающие показ 

видео в Youtube о том, как устанавливать Группировки. 

http://moodle.org/mod/forum/discuss.php?d=131905
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4.8.4.Cohorts 
On the site or category level you assign a user to a cohort. Cohorts are used 

to bulk enrol users into one or more courses. If you wish the cohort to be 

members of a group within the course you will then have to add them to a 

group in a further step. 

Cohorts, or site-wide groups, enable all members of a cohort to be enrolled 

in a course in one action, either manually or synchronised automatically. 

 

4.8.4.1.Creating a cohort 
Cohorts can be created by site administrators and other users with 

appropriate permissions. 

 Access Administration > Site administration > Users > Accounts > 

Cohorts 

 Click the Add button 

 NOTE In the dropdown you can choose between making your cohort 

available throughout the site "system" or in a named category. 

 Complete the details and save the changes. 

 Follow the assign link opposite the cohort name in the list of available 

cohorts. 

 Select potential users from the list then click the Add button. 

To synchronise cohort members with course participants, the Cohort sync 

enrolment plugin should be enabled in Administration > Site 

administration > Plugins > Enrolments > Manage enrol plugins. 

4.8.4.2.Adding users to a cohort in bulk 
1. Access Administration > Site administration > Users > Accounts > 

Bulk user actions 

2. Find users by setting an appropriate filter 

3. Add users from the available list to the selected list 

4. Choose 'Add to cohort' with selected users 

4.8.4.3.Uploading users to a cohort 
An administrator can upload users via CSV file to existing cohorts as 

follows: 

1. Access Administration > Site administration > Users > Accounts > 

Upload users 

2. Upload a text file with the following format: 

username,password,firstname,lastname,email, cohort1 

tomjones,Pass1234*,Tom,Jones,tomjones@example.com, year3 

marysmith,Pass1234*,Mary,Smith,marysmith@example.com, year4 

4.8.4.Когорты 
На уровне Сайта или Категории вы назначаете пользователя в Когорту. Когорты 

используются для массового зачисления пользователей в один или несколько Курсов. Если 

вы хотите, чтобы Когорта была членами Группы в Курсе, вам придётся добавить их в 

Группу на следующем шаге. 

Когорты или Группы для всего Сайта позволяют всем членам Когорты быть 

зачисленными в Курс в одном Интерактивном Действии, либо вручную, либо 

автоматически синхронно. 

4.8.4.1.Создание Когорты 
Когорты могут быть созданы Администраторами Сайта или другими 

пользователями с соответствующими Полномочиями. 

 Перейдите в Administration→Site administration→Users→Accounts→Cohorts. 

 

 Щёлкните кнопку «Add (добавить)». 

 ЗАМЕТЬТЕ, что в выпадающем списке вы можете выбрать между созданием вашей 

Когорты, доступной по всему Сайту «Система», или только в названной Категории. 

 Завершите детали и сохраните изменения. 

 Перейдите по ссылке Assign (назначить) напротив имени Когорты в списке доступных 

Когорт. 

 Выберите потенциальных пользователей из списка и нажмите кнопку «Add». 

Для синхронизации членов Когорты с участниками курса, Когорта синхронизации 

плагин регистрации должна быть включена в 

Administration→Site administration→Plugins→Enrolments→Manage enroll plugins. 

4.8.4.2.Массовое добавление пользователей в Когорту 
1. Перейдите в Administration→Site administration→Users→Accounts→Bulk user actions. 

 

2. Найдите пользователей, установив соответствующий фильтр. 

3. Добавьте пользователей из списка доступных в выбранный список. 

4. Выберите «Add to cohort (добавить в когорты)» для выбранных пользователей 

4.8.4.3.Загрузка пользователей в Когорту 
Администратор может загрузить пользователей с помощью CSV-файла с 

существующими когорт следующим образом: 

1. Перейдите в Administration→Site administration→Users→Accounts→Upload user. 

 

2. Загрузите текстовый файл в следующем формате: 

имя пользователя,пароль,имя,фамилия,э-почта,когорта1 

tomjones,Pass1234*,Том,Джонс,tomjones@example.com,Год3 

marysmith,Pass1234*,Мэри,Смит,marysmith@example.com,Год4 
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where year3 and year4 are the cohort ids of existing cohorts (i.e. not their 

names) 

4.8.4.4.Searching cohorts 
When a site has a large number of cohorts, keywords may be entered into 

the Search Cohorts box to search for or filter the available cohorts. 

 

Please note, as the page title indicates, this only searches for cohorts 

created in the System context (i.e. it searches site-level cohorts but not 

category-level cohorts). To search for cohorts created in a Category 

context, go to that Category's page and in its Settings block, click the link 

to Cohorts. 

4.8.4.5.Managing category cohorts 
Cohorts which have been created for a category rather than the system can 

be located by selecting the appropriate category and then clicking the 

Cohorts link in Settings>Category (name)>Cohorts 

4.8.4.6.Cohort capabilities 
4.8.4.5.1.Add and remove cohort members 
Capabilities/moodle/cohort:assign 

 This capability allows a user to add or remove users from a cohort in 

Settings > Site administration > Users > Accounts > Cohorts 

 The default role of manager has this set to allow 

4.8.4.5.2.Create, delete and move cohorts 
Capabilities/moodle/cohort:manage 

 This capability allows a user to create, delete and move cohorts from 

Settings > Site Administration > Users > Accounts > Cohorts 

 The default role of manager has this set to allow. 

4.8.4.5.3.Configure cohort instances 
Capabilities/enrol/cohort:config 

 This allows a user to add the Cohort sync enrolment plugin to a course 

via Settings > Course administration > Users > Enrolment methods 

(provided that it has been enabled by admin in Settings > Site 

administration > Plugins > Enrolments > Manage enrol plugins) 

 The default roles of Manager and Teacher have this set to allow. 

NOTE: By default, a teacher cannot add the Cohort sync plugin to their 

course. It needs to be configured by an Administrator or a user with the 

Manager role. 

 

 

где Год3 и Год4 являются идентификаторами существующих Когорт (т.е. не их 

названиями) 

4.8.4.4.Отыскание Когорт 
Когда Сайт имеет большое количество Когорт, ключевые слова могут быть 

введены в окошко «Search Cohorts (отыскать когорты)», чтобы отыскать или 

отфильтровать имеющиеся Когорты. 

Пожалуйста, обратите внимание на заголовок страницы, который указывает, что 

ищутся только Когорты, созданные в Контексте системы (то есть ищутся Когорты на 

уровне Сайта, но не Когорты на уровне Категорий). Для поиска Когорт, созданных в 

Контексте Категорий, перейдите на страницу этой Категории и в её Блок настройки, 

щёлкните ссылку на Когорту. 

4.8.4.5.Управление Когортами Категорий 
Когорты, которые были созданы для Категорий, а не для системы, могут быть 

найдены путём выбра соответствующей Категории, и затем щёлчка по ссылке Когорты в 

меню Settings→Category(имя) →Cohorts. 

4.8.4.6.Возможности Когорты 
4.8.4.5.1.Добавить и переместить членов Когорты 

Возможность Capabilities/moodle/cohort:assign 

 Позволяет пользователю добавлять или перемещать пользователей из Когорты в 

Administration→Site administration→Users→Accounts→Cohorts. 

 По умолчанию эта Возможность предоставлена Роли Менеджера. 

4.8.4.5.2.Добавить, удалить и передвинуть Когорты 
Возможность Capabilities/moodle/cohort:manage 

 Позволяет пользователю созлаваать, удалять и перемещать Когорты из 

Administration→Site administration→Users→Accounts→Cohorts. 

 По умолчанию эта Возможность предоставлена Роли Менеджера. 

4.8.4.5.3.Сконфигурировать экземпляры Когорт 
Возможность Capabilities/enrol/cohort:config 

 Позволяет пользователю добавлять Плагин зачисления Cohort sync (п. 3.3.4) в Курс 

через Administration→Course administration→Users→Enrolment methods (при условии, 

что это разрешено Администратором в 

Administration→Site administration→Plugins→Enrolments→Manage enroll plugins). 

 По умолчанию эта Возможность предоставлена Ролям Менеджера и Преподавателя. 

ЗАМЕЧАНИЕ: По умолчанию, Преподаватель не может добавить Плагин 

Cohort sync в свой Курс. Это должно быть сконфигурировано Администратором или 

пользователем с Ролью Менеджера. 
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The required capabilities for setting up a cohort sync are: 

 moodle/course:enrolconfig in the course context 

 moodle/cohort:config in the course context 

 moodle/cohort:view in the same context as cohort 

The required capabilities for manually enrolling cohort members are the 

same as cohort sync (note: this is a bug MDL-28431) 

 enrol/manual:enrol in course context 

 moodle/course:enrolreview in course context 

4.8.4.5.4.View site-wide cohorts 
Capabilities/moodle/cohort:view 

 This allows a user to view site-wide cohorts from within a course 

  

 This capability is allowed for the default roles of manager and teacher 

4.8.4.7.See also 
 Cohort sync enrolment method 

 Cohort enroller role 

 MDL-34189 Make category cohorts visible sitewide for site 

administrators 

 A three minute Cohort in Moodle 2.0 video 

 Cohorts in Moodle 2.0 video 

 Using cohorts with Moodle 2.2 blog entry by Gavin Henrick 

4.8.5.Available for group members only 
Available for group members only is an experimental feature which may 

be enabled by an administrator in Settings > Site administration > 

Development > Experimental. 

4.8.5.1.Assigning an activity to a grouping 
 
To assign an activity to a particular grouping: 

1. On the edit activity page, expand "Common module settings". 

 

2. Ensure that the group mode is set to separate or visible groups. 

3. Select the grouping from the grouping dropdown menu. 

4. Check the "Available for group members only" checkbox 

 

5. Click the "Save changes" button at the bottom of the page. 

The name of the grouping will then appear in brackets after the activity 

name on the course page. 

Необходимыми Возможностями для настройки синхронизации Когорт являются: 

 moodle/course:enrolconfig в контексте Курса. 

 moodle/cohort:config в контексте Курса. 

 moodle/cohort:view в том же контексте, что и Когорта. 

Необходимые Возможности для зачислении членов Когорты вручную такие же, 

как для синхронизации Когорты (замечание: это ошибка MDL-28431). 

 enrol/manual:enrol в контексте Курса. 

 moodle/course:enrolreview в контексте Курса. 

4.8.4.5.4.Просмотреть Когорты по всему Сайту 
Возможность Capabilities/moodle/cohort:view 

 Позволяет пользователю просматривать Когорты (п. 4.8.4) по всему Сайту изнутри 

Курса. 

 По умолчанию эта Возможность предоставлена Ролям Менеджера и Преподавателя. 

4.8.4.7.См. также 
 Метод зачисления «Синхронизация Когорты (п. 3.3.4)». 

 Роль «Зачисляющий в Когорты». 

 MDL-34189 Сделать Когорты Категории видимыми по всему Сайту для 

Администратора Сайта. 

 Трёхминутное видео «Когорты в Moodle 2.0». 

 Видео «Когорты в Moodle 2.0». 

 «Использование Когорт в Moodle 2.2» запись Блога Гевина Хенрика. 

4.8.5.Доступно толко для членов Групп 
Доступность только для членов Группы – это экспериментальная функция, которая 

может быть включена Администратором в меню 

Administration→Site administration→Development→Experimental. 

4.8.5.1.Назначение Интерактивного Действия 
Группировке 

Чтобы назначить Интерактивное Действие для конкретной Группировки: 

1. На странице редактирования Интерактивного Действия, разверните «Common module 

settings (общие настройки модуля)». 

2. Убедитесь, что Групповой Режим установлен в Separate groups или Visible groups. 

3. Выберите Группировку из ниспадающего меню Группировок. 

4. Пометьте окошко-флажок «Available for group members only (доступно только для 

членов группы)». 

5. Щёлкните кнопку «Save changes (сохранить изменения)» в нижней части страницы. 

Название Группировки появится в скобках после имени Интерактивного Действия 

на странице Курса. 

http://tracker.moodle.org/browse/MDL-28431
http://docs.moodle.org/25/en/Cohort_enroller
http://tracker.moodle.org/browse/MDL-34189
http://www.youtube.com/watch?v=FMWZW_n0eVI
http://www.youtube.com/watch?v=dMqaeOGXuHQ
http://www.somerandomthoughts.com/blog/2011/11/22/using-cohorts-with-moodle-2-2/
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Note: If a graded activity is assigned to a particular grouping only, it 

will still appear in the gradebook (п. 3.9.1.1) for all users unless 

gradebook categories are set up in a certain way. See MDL-13868 for 

further details. 

Note: You cannot make an activity visible to only one group of students 

without first placing them into a grouping. 

4.8.5.2.Examples 
Classroom teachers in different departments might tell some students to 

enroll in a refresher course. Each department has their own tutor. Each 

student in the refresher course might be assigned to a group associated with 

their classroom teacher. The groups are put into department groupings. For 

example, a University has Anthropology, Engineering and Computing 

departments with 3 or 4 teachers in each department that have their 

students take a refresher statistics class. 

While all students in the statistics class may receive some of the same 

material, groupings will allow a department focus, while still tracking 

students by their classroom teacher. If a student is not in a classroom 

group, they will not be in a department grouping. And a student who is 

both in a Computing classroom group and an Engineering classroom 

group, will belong to more than one grouping. 

4.8.5.3.See also 
 Groupings 

 Groupings FAQ 

4.8.6.Cohorts FAQ 

4.8.6.1.What is the difference between a 
cohort and a group? 
See #1.2 in Groups FAQ 

4.8.6.2.I created a cohort and now I can't find it 
again! 

If you create a cohort from Settings>Site 

administration>Users>Accounts>Cohorts and then assign it to a category, 

you will not see it listed on that screen. To view or edit it, you need to go 

to the category page and click the Cohorts link in the Settings block there: 

 

4.8.6.3.How can teachers enrol cohorts? 
By default, regular teachers are not able to enrol cohorts. However, you 

can give them the Cohort enroller role to allow them 

Замечание: Если оцениваемое Интерактивное Действие назначается только конкретной 

Группировке, оно всё равно появится в Журнале Оценок (п. 3.9.1.1) для всех 

пользователей, если Категории Журнала Оценок не настроены определёенным образом. 

Подробности см. в MDL-13868. 

Замечание: Вы не можете сделать Интерактивное Действие видимым для только одной 

Группы Студентов без предварительного размещения их в Группировку. 

4.8.5.2.Примеры 
Аудиторные Преподаватели на разных кафедрах могут сказать нескольким 

Студентам, чтобы те зачислились на Курсы переподготовки. Каждая кафедра имеет своего 

собственного наставника. Каждый Студент на Курсе переподготовки может быть назначен 

в Группу, связанную с их аудиторным Преподавателем. Эти Группы вводятся в 

Группировки кафедр. Например, университет имеет кафедры антропологии, инженерного 

дела, и информатики с 3 или 4 Преподавателями на каждой кафедре, которая проводят 

переподготовку своих Студентов в классе статистики. 

В то время как все Студенты в классе статистики могут получать некоторые 

одинаковые материалы, Группировки позволят кафедре внести свою специфику, хотя 

руководить Студентами будет их аудиторный Преподаватель. Если Студент не в 

аудиторной Группе, они не будут в Группировке кафедры. А Студент, который есть и в 

компьютерной аудиторной Группе, и в инженерной аудиторной Группе, будет 

принадлежать более чем одной Группировке. 

4.8.5.3.См. также 
 Группировки (п. 4.8.3). 

 Часто задаваемые вопросы по Группировкам (п. 4.8.8). 

4.8.6.Часто задаваемые вопросы по Когортам 
4.8.6.1.В чём разница между Когортой и Группой? 
 

См. «Часто задаваемые вопросы по Группам» (п. 4.8.7.1.2). 

4.8.6.2.Я создал Когорту,а теперь не могу найти её! 
 

Если вы создаете Когорту из 

Administration→Site administration→Users→Accounts→Cohorts , а затем назначаете её в 

Категорию, то вы не увидите её в списке на этом экране. Чтобы увидеть или 

отредактировать Когорту, необходимо перейти на страницу Категории, и щёлкнуть там 

ссылку Cohorts в Блоке Settings (настройки): 

4.8.6.3.Как Преподаватели могут зачислять Когорты? 
По умолчанию, обычные Преподаватели не в состоянии зачислять Когорты. Тем не 

менее, вы можете предоставить им роль зачисляющего в Когорты, чтобы позволить им 

http://docs.moodle.org/25/en/Groups_FAQ
http://tracker.moodle.org/browse/MDL-13868
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to do this. 

4.8.6.4.Can I synch cohorts with LDAP 
groups? 
This is not currently available as standard. However, the tracker issue for 

this - MDL-25011- offers a patch which works on versions up to and 

including 2.3. It has not yet been tested on 2.4. 

4.8.6.5.Where can I practise with some ready 
made cohorts? 
Log into the Moodle School demo site with username: manager and 

password: moodle You can access system cohorts 

fromhttp://school.demo.moodle.net/cohort/index.php. 

4.8.7.Groups FAQ 

4.8.7.1.General 
4.8.7.1.1.What is the 'groups mode' setting? 
You can have several classes/groups working in a single course with 

different (or the same) teacher. Groups mode is a way of filtering the 

students so that work and grades can be accessed separately. See Groups 

for more information. There are three different groups modes – No groups, 

Separate Groups, Visible Groups. In ‘Separate groups’ mode, each group 

can only see their own group – other groups are invisible. In ‘Visible 

groups’ mode, each group works in their own group, but can also see other 

groups. 

 

Teachers are normally able to see other teachers' groups's activities as well 

as their own unless the capability Capabilities/moodle/site:accessallgroups 

has been set to "prevent". 

4.8.7.1.2.What is the difference between a cohort 
and a group? 
A group exists only within a course. You might have a class 10B for 

example which you want to enrol in course 1 and course 2. The group 

would need to be created in both courses and its members enrolled 

separately in both courses. Cohorts are groups of users created by admin 

which can then be brought in "en masse" to courses. So if class 10B is 

created as a cohort by admin, then it can be selected in those courses where 

enrolment via cohort has been enabled. (For more information on creating 

and using cohorts, see here: Cohorts) Once members of a cohort have been 

added to a course, they 

делать это. 

4.8.6.4. Могу ли я синхронизировать Когорты с Группами 
LDAP? 

В настоящее время это не входит в стандартную комплектацию. Однако 

Средство Отслеживания по этому поводу (MDL-25011) предлагает вставку в программу, 

которая работает на версиях вплоть до 2,3. Оно ещё не протестировано в версии 2,4. 

4.8.6.5.Где можно попрактиковаться с некоторыми 
готовыми Когортами? 

Войдите на демо-Сайт школы Moodle с именем пользователя manager и паролем 

moodle. Вы сможете получить доступ к системным Когортам из 

http://school.demo.moodle.net/cohort/index.php. 

4.8.7.Часто задаваемые вопросы по Группам 
4.8.7.1.General 
4.8.7.1.1.Что это за настройка: «Режим Групп»? 

Вы можете иметь несколько классов/Групп, работающих в единственном Курсе, с 

разными (или тем же самым) Преподавателем. Режим Групп является способом 

фильтрации Студентов так, чтобы работа и Оценки были доступны по-отдельности. См. 

раздел «Группы (п. 4.8.1» для получения дополнительных сведений. Существуют три 

различных режима Групп – «No groups (нет групп)», «Separate Groups (отдельные группы), 

«Visible Groups (видимые группы)». В режиме Separate Groups, каждая из сторон может 

видеть только свою собственную Группу – другие Группы невидимы. В режиме Visible 

Groups, каждая Группа работает в своей собственной Группе, но также можно увидеть 

другие Группы. 

Преподаватели, как правило, в состоянии видеть деятельность Групп других 

Преподавателей, также как свою собственную, если только Возможность 

Capabilities/moodle/site:accessallgroups не была установлена, в «Prevent (предотвратить)». 

4.8.7.1.2.В чём различие между Когортой и Группой? 
 
Группа существует только в пределах Курса. Вы, например, можете иметь класс 10Б, 

который вы хотите зачислить на Курс 1 и Курс 2. Группа должна быть создана в обоих 

Курсах, и её члены зачислены отдельно в обоих Курсах. Когорты – это группы 

пользователей, создаваемые Администратором, которые затем могут быть переданы 

в "массовом порядке" в Курсы. Так что, если класс 10Б создан Администратором как 

Когорта, то он может быть выбран в тех Курсах, где зачисление производилось через 

Когорты. (Для получения дополнительной информации о создании и использовании 

Когорт, см. «Когорты»). После того, как члены Когорты были добавлены в Курс, они 

http://tracker.moodle.org/browse/MDL-25011
http://school.demo.moodle.net/cohort/index.php
http://docs.moodle.org/25/en/Capabilities/moodle/site:accessallgroups
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can be included in a group, either by using the "auto create groups" feature 

or by adding the members to an empty or pre-created group. 

4.8.7.1.3.What is the 'force' setting? 
If force is set to yes, then all activities are group activities. This overrides 

any settings for individual activities. If force is set to no, then activities are 

only group activities if they have been set to group mode. In this case, each 

activity requires to be set to group mode individually. 

 

 

4.8.7.1.4.Can I automatically add users to a group 
at the same time that I enroll them via a csv file? 
Yes. One of the optional field names that can be uploaded in the flat file is 

"group1, group2, etc". The group must be associated to the corresponding 

course and the course short name used in the field course1. If the group 

doesn't already exist then Moodle will create the group. Here is an example 

of a portion of a csv file that would enroll students into a group entitled 

'Class A' within a course entitled 'Astro1'. (Note that you can assign 

students to groups using this file even if they are already enrolled in 

Moodle, as you can select to update the user details when uploading the 

file.) 

username, password, firstname, lastname, email, course1, group1,... 

    jdoe, changeme, Jane, Doe, jdoe@email.org, Astro1, Class A,... 

4.8.7.1.5.How do I assign a teacher to a group? 
Can a teacher be in more than one group? 
You can assign a teacher to a group in exactly the same way that you 

assign a student to a group. 

4.8.7.1.6.How do I restrict a teacher to view only 
information about the groups that they are in? 
 
For Separate Groups mode, the capability moodle/site:accessallgroups may 

be used to restrict access to all groups in a particular context. 

 

4.8.7.1.7.What determines whether students can 
see a teacher's profile? 
A student can see the profile of all teachers that are members of their group 

or that have edit rights. 

 

могут быть включены в группу, либо с помощью "Автоматически создавать Группы" 

функции, или путем добавления членов в пустую или предварительно созданную Группу. 

4.8.7.1.3.Что это за настройка: «Force (принудить)»? 
Если она установлена в «Yes (да)», то все Интерактивные Действия являются 

Интерактивными Действиями Групп. Эта настройка перекрывает любые настройки для 

отдельных Интерактивных Действий. Если Force установлена в «No (нет)», то 

Интерактивные Действия будут Интерактивными Действиями Групп, только если им был 

установлен Групповой режим. В этом случае, каждому Интерактивному Действию 

потребуется установить Групповойм режим индивидуально. 

4.8.7.1.4.Можно автоматически добавлять пользователей в 
Группу при зачислении их через файл CSV? 

Да. Одним из дополнительных имён полей, которые могут быть загружены в 

плоский файл, является «group1, group2, и т.д.». Группа должна быть связана с 

соответствующим Курсом, а краткое имя Курса использовано в поле «course1». Если 

Группа ещё не существует, то Moodle создаст Группу. Вот пример части файла CSV по 

зачислению Студентов в Группу под названием «Класс1» в рамках Курса под названием 

«Космический1». (Обратите внимание, что вы можете зачислить Студентв в Группу с 

помощью этого файла, даже если они уже зачислены в Moodle, поскольку вы можете 

выбрать обновление информации о пользователе при загрузке этого файла.) 

 

username, password, firstname, lastname, email, course1, group1,... 

    jdoe, changeme, Jane, Doe, jdoe@email.org, Astro1, Class A,... 

4.8.7.1.5.Как назначить Преподавателя в группу? Может 
Преподаватель быть более чем в одной Группе? 

Вы можете назначить Преподавателя в Группу точно так же, как вы назначаете 

Студента в Группу. 

4.8.7.1.6.Как ограничить просмотр информации 
Преподавателем информацией только о тех Группах, 
которые он ведёт? 

Для режима «Separate Groups» можно использовать Возможность 

moodle/site:accessallgroups, чтобы ограничить доступ ко всем Группам в определённом 

Контексте. 

4.8.7.1.7.Что определяет, может ли Студент видеть профиль 
Преподавателя? 

Студент может посмотреть профиль всех Преподавателей, являющихся членами 

своей Группы или которые имеют права редактирования. 

http://docs.moodle.org/25/en/Capabilities/moodle/site:accessallgroups
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4.8.7.1.8.I have two groups that meet on different 
days. Can I set up activities for different times for 
the two groups? 
You can use Groupings to achieve this to some degree. If you are using 

Moodle's Quiz you can set different times for different groups using the 

Group override settings. 

4.8.7.1.9.Can I use the same groups for more than 
one course? 
Not directly, although there are some workarounds to accomplish this. 

 Use the Import_groups Import tool to import a file with the groups and 

settings (though not memberships). 

 Create the groups by import or manually with enrollment keys on them 

and give the students group enrolment keys to enrol themselves into the 

right group for each course. 

 Admins and managers can enrol users in bulk via File Upload or 

Cohorts to include group membership. 

 Make a template with the enrolments and groups and restore it to a new 

course with user data. 

 Create a master course with all the students enrolled and in the correct 

groups, and then to make each of the courses a metacourse based on 

that master course. Note that metacourses do not carry over group 

enrolments. See the documentation on Metacourses. 

4.8.7.1.10.Can a student be a member of more 
than one group? 
Yes, a student can be in more than one group. 

4.8.7.1.11.If one student is in a group, do all 
students have to be in some group? 
No, a student does not have to belong to any group. 

4.8.7.1.12.If I have several groups, can I make a 
specific activity or resource visible to just one of 
those groups? 
You can organise groups into groupings, then assign an activity (or 

resource) to a particular grouping. If you want to show a resource (such as 

a file or folder) to only one group then Make sure that you admin has 

enabled "available for group members only" in Settings>Site 

administration>Development>Experimental and then see Available for 

group members only 

4.8.7.1.8.У меня две Группы, которые общаются в разные 
дни. Можно установить Интерактивные Действия на 
различное время для этих двух Групп? 

Можно использовать Группировки, чтобы до некоторой степени достичь этого. 

Если вы используете Экзамен Moodle, вы можете установить разные времена для разных 

Групп, используя настройки переопределения Группы. 

4.8.7.1.9.Можно ли использовать те же самые Группы более 
чем для одного Курса? 

Не напрямую, хотя есть некоторые обходные пути, чтобы достичь этого. 

 Используйте инструмент импорта Import_groups (п. 4.8.2), чтобы импортировать файл с 

Группами и настройками (хотя и не членов). 

 Создайте эти группы посредством импорта или вручную с помощью ключей 

зачисления в них и дайте Студентам Ключи Зачисления в Группы для Самозачисления 

в нужную Группу для каждого Курса. 

 Администраторы и Менеджеры могут провести массовое зачисление пользователей 

через загрузку файлов или Когорт, чтобы включить в Группы членов. 

 Сделайте шаблон с зачислениями и Группами и восстановите его в новый Курс с 

пользовательских данных. 

 Создайте главный Курс со всеми зачислившимися Студентами и в правильные Группы, 

а затем, чтобы встройте каждый из Курсов в метаКурс, основанный на этом главном 

Курсе. Обратите внимание, что метаКурсы не переносят зачисления в Группы. См. 

документацию по метаКурсам (п. 3.3.1.2.6). 

4.8.7.1.10.Могут ли Студенты быть членами более чем одной 
Группы? 

Да, Студент может быть более чем в одной Группе. 

4.8.7.1.11.Если один Студент в Группе, должны ли все 
Студенты быть в какой-либо Группе? 

Нет, Студент не обязательно должен принадлежать к какой-либо Группе. 

4.8.7.1.12.Если у меня несколько Групп, могу я сделать 
конкретное Интерактивное Действие или Ресурс видимым 
только в одной из этих Групп? 

Можно организовать Группы в Группировки, а затем назначить 

Интерактивное Действие (или Ресурс) конкретной Группировке. Если вы хотите показать 

Ресурс (такой как Файл или Папка) только одной Группе, убедитесь, что ваш 

Администратор включил «Available for group members only (доступно только для членов 

группы» в Administration→Site administration→Development→Experimental, и затем 

посмотрете Available for group members only. 
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In any version of Moodle you can make a forum post visible to just one 

group. You must first select that specific group from the dropdown and 

post the message to that group (rather than to "all participants") 

 

4.8.7.1.13.Can I have one set of groups for 
Activity A and another set of groups for Activity 
B? 
You can create two different groupings (a grouping is a set of groups), and 

assign different groupings to the two activities. 

4.8.7.1.14.Is it possible to view all the groups in a 
course as a list to print out? 
The groups overview page in Settings > Course administration > Users > 

Groups provides a table listing groups, group members and a user count. 

 

4.8.7.1.15.When I try to add a student, they are 
always added to the first group, whichever group 
I select? 
Make sure that the students name does not include any punctuation. There 

is also a workaround – give each group a temporary name at the start of the 

alphabet, put your students in the group and then rename the group. 

4.8.7.1.16.How can I delete a group? 
After clicking, "Groups" in Settings>Course 

administration>Users>Groups.. 

1. Select the group that you want to delete. 

2. Click the "Delete selected group" button 

4.8.7.1.17.How can I import a list of students into 
a group? 
Please check Upload users. 

4.8.7.1.18.How can I sort students automatically 
into groups during enrolment? 
You can make use of enrolment keys. Set an enrolment key in 

Settings>Course administration>Users>Enrolment methods>Self 

enrolment (to enforce the enrolment key dialogue form when students 

enrol). That key is only for students who should not be in a group and to 

keep out any unwanted students. Then in Settings>Course 

administration>Users>Groups you create your groups and add a different 

 

В любой версии Moodle вы можете сделать корреспонденцию Форума видимой 

только одной Группе. Вы должны сначала выбрать эту конкретную Группу из 

ниспадающего меню, и отправить почтой сообщение в эту Группу (а не «всем 

участникам»). 

4.8.7.1.13.Можно ли иметь один набор Групп для 
Интерактивного Действия А, а другой набор для 
Интерактивного Действия Б? 

Вы можете создать две различных Группировки (Группировка является набором 

Групп), и назначить различные Группировки этим двум Интерактивным Действиям. 

4.8.7.1.14.Можно ли просмотреть все Группы в Курсе в виде 
списка для распечатки? 

Страница обзора Групп в Administration→Course administration→Users→Groups 

предоставляет собой таблицу с перечислением Групп, членов Группы и количества 

пользователей. 

4.8.7.1.15.Когда я пытаюсь добавить Студента, он всегда 
попадает в первую Группу,какую бы Группу я не выбрал? 
 

Убедитесь в том, что имя Студентов не содержит знаков препинания. Существует 

также обходной путь, – дайте каждой Группе временное имя в начале алфавита, поместите 

Студентов в Группу, а затем переименуйте Группу. 

4.8.7.1.16.Как можно удалить Группу? 
После щелчка по «Groups» в Administration→Course administration→Users→Groups 

 

1. Выберите Группу, которую вы хотите удалить. 

2. Щёлкните кнопку «Delete selected group (удалить выбранную группу)» 

4.8.7.1.17.Как можно импортировать список Студентов в 
Группу? 

Посмотрите, пожалуйста, «Переслать пользователей» в п. 3.2.4. 

4.8.7.1.18.Как можно автоматически рассортировать 
Студентов по Группам во время Зачисления? 

Вы можете использовать Ключи Зачислений (п. 4.7). Установите 

Ключ Зачисления в 

Administration→Course administration→Users→Enrolment methods→Self enrolment (чтобы 

приводить в действие диалоговую форму Ключа Зачисления при Зачислении Студентов). 

Этот Ключ только для тех Студентов, которых не должно быть в Группе, и не пустит 

нежелательных Студентов. Затем вы создаёте свои Группы в 

Administration→Course administration→Users→Groups и добавляете различные 
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enrolment key for each group. When a student enrols, using an enrolment 

key that is connected to a certain group, the student will automatically be 

part of that group. 

4.8.7.1.19.How can I change the sort order of the 
participants? 
The admin can change the "fullnamedisplay" variable which will affect the 

sort order of participants for the entire Moodle site. This can be found in 

the Site administration block under Security>Site Policies>Full name 

format. The default is First+Surname, with First, and Surname+First as 

options. Some language packs have other options. 

4.8.7.1.20.What is the difference between a group 
and a grouping? 
See Groups versus groupings forum post 

http://moodle.org/mod/forum/discuss.php?d=131905. A grouping can be 

thought of as a category of groups. A grouping is a meta group. Student 

membership to a "grouping" can only happen by their membership to a 

group that is associated with the grouping. 

4.8.7.1.21.What is an orphan group? 
An orphan group is a group that does not belong to any grouping. 

4.8.7.1.22.Is there any way to enable students to 
choose a group? 
There is a contributed module ChoiceGroup which will do this.  

See also on youtube:this screencast 

4.8.7.1.23.How can I view the participants list for 
just one group? 
For this, you need Groups mode switched ON at course level in Course 

settings. 

4.8.7.2.Activity modules and groups 
Different activity modules vary as to how they treat groups – some have 

better support for groups than others! 

In general if you have questions about how an activity supports groups, 

you’re advised to post in the forum for the activity module, and not the 

groups forum. 

4.8.7.2.1.Which activity modules do NOT support 
group mode? 
All activity modules support the use of group mode apart from Glossary, 

Lesson, and SCORM. 

Ключи Зачисления для каждой Группы. Когда Студент Зачисляется, используя 

Ключ Зачисления, связанный с определённой Группой, этот Студент автоматически 

становится частью этой Группы. 

4.8.7.1.19.Как изменить порядок сортировки Участников? 
 

Администратор может изменить переменную «fullnamedisplay», которая повлияет 

на порядок сортировки Участников для всего Сайта Moodle. Она может быть найдена в 

Блоке Site administration в области Security→Site Policies→Full name format. По умолчанию 

используется Имя + Фамилия, по Имени, и Фамилия + Имя – в качестве вариантов. 

Некоторые языковые пакеты имеют другие варианты. 

4.8.7.1.20.В чём отличие между Группой и Группировкой? 
 

См. корреспонденцию Форума «Группы против Группировок» по адресу. 

Группировку можно рассматривать как Категорию Групп. Группировка – это 

метаГруппа. Членство Студента в «Группировке» может произойти только через 

членство в Группе, которая связана с этой Группировкой. 

 

4.8.7.1.21.Что такое сиротская Группа? 
Сиротская группа – это Группа, которая не принадлежит ни к одной Группировке. 

4.8.7.1.22.Существует какой-нибудь способ позволить 
Студентам выбирать Группу? 

Существует предлагаемый модуль ChoiceGroup, который сделает это:. 

См. также на YouTube: этот фильм с экрана:  

4.8.7.1.23.Как можно увидеть список Участников только 
одной Группы? 

Для этого вам необходимо в настройках Курса включить на уровне Курса режим 

Groups в ON. 

4.8.7.2.Модули Интерактивных Действий и Группы 
Различные модули Интерактивных Действий изменяются в соответствии с тем, как 

они относятся к Группам, – некоторые имеют лучшую поддержку для Групп, чем другие! 

В общем, если у вас есть вопросы о том, как Интерактивное Действие 

поддерживает Группы, советуем вам написать в форум по модулю 

Интерактивного Действия, а не на форум по Группам. 

4.8.7.2.1.Какие модули Интерактивных Действий НЕ 
поддерживают Групповой Режим? 

Все модули Интерактивных Действий поддерживают использование Групповой 

режим, не говоря уже о Глоссарии, Уроке, и SCORM. 

http://moodle.org/mod/forum/discuss.php?d=131905
https://moodle.org/plugins/view.php?plugin=mod_choicegroup%257C
http://www.youtube.com/watch?v=JQFaDLtHZdY&feature=player_embedded%7C
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4.8.7.2.2.What happens if I switch an activity from 
being in non-groups mode to being in groups 
mode? 
This depends on the activity module in question. 

For forums, posts made before the forum is put into groups mode are 

visible to all students after you have put the forum into group mode. 

However students cannot reply to these posts if they have no group (i.e. 

blank). 

4.8.7.2.3.What happens if I change the groups for 
an activity in groups mode e.g. if I move a student 
from one group to another? 
Again this depends on the activity module. You may find that grades or 

activity logs are lost, so check for the specific activity module first. 

 

4.8.7.2.4.How do I post a message in a forum that 
only one group can see? 
Before you click 'Add a new topic', you need to choose the group from the 

Separate groups drop-down menu at the top left. 

 

4.8.7.2.5. As a teacher I want to put the same post 
in each group's forum with students able to reply 
to that post. How can I do this? 
You need to post the same message into the forum for each group. There is 

currently no way to do this in one go if you want students to be able to 

reply to your post. If you don't mind students not being able to reply, then 

you can of course just post the message to all participants. 

4.8.7.2.6.How can I hide an activity/resource in 
the course from anyone who is not assigned to a 
group? 
You can use the Available for group members only experimental setting for 

allowing access to an activity/resource only to participants who are 

assigned to a group. If no participant on the course site is assigned to a 

group, ticking the 'Available for group members only' will effectively hide 

the activity/resource from everyone. 

 

 

4.8.7.2.2.Что произойдёт, если я переключу 
Интерактивное Действие из неГруппового Режима в 
Режим Групп? 

Это зависит от модуля Интерактивного Действия, о котором идёт речь. 

Для Форумов, корреспонденции, созданные до переключения Форума в 

Режим Групп, становится видимы всем Студентам после того, как вы переключили Форум 

в Групповой Режим. Однако Студенты не смогут отвечать на эти корреспонденции, если 

они имеют No group (то есть пробел). 

4.8.7.2.3.Что произойдёт, если я изменю Группы для 
Интерактивного Действия в Режим Групп, например, если я 
перемещу Студента из одной Группы в другую? 

Опять же, это зависит от модуля Интерактивного Действия. Вы можете 

обнаружить, что Оценки или журналы Интерактивных Действий теряются, так что сначала 

проверьте конкретный модуль Интерактивного Действия. 

4.8.7.2.4.Как мне отправить сообщение по почте на Форум, 
который может видеть только одна Группа? 

Прежде чем нажать кнопку «Add a new topic (добавить новую тему)», вам нужно 

выбрать Группу из ниспадающемся меню Separate groups (отдельные группы) вверху 

слева. 

4.8.7.2.5.Как Преподаватель, я хочу поместить некоторые 
корреспонденции на Форум каждой Группы. Как это 
сделать? 

Вы должны отправить то же самое сообщение в каждый из Форуме для каждой 

Группы. В настоящее время нет способов сделать это за один раз, если вы хотите, чтобы 

Студенты были в состоянии ответить на вашу почту. Если вам неважано, ответят или нет 

Студенты, то вы, конечно, можете просто отправить это сообщение всем Участникам. 

4.8.7.2.6.Как я могу скрыть от любого, кто не в Группе, 
Интерактивное Действие/Ресурс? 
 

Вы можете использовать экспериментальную настройку «Доступно только для 

членов Группы (п. 4.8.5)» для предоставления доступа к 

Интерактивному Действию/Ресурсу только Участникам, которые входит в Группу. Если 

ни один из Участников на Сайте Курса не назначен в Группу, пометка галочкой 

«Доступно только для членов группы» будет эффективно скрывать 

Интерактивное Действие/Ресурс от каждого. 
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4.8.7.3.See also 
 Groupings FAQ 

 Using Moodle Groups forum 

4.8.8.Groupings FAQ 

4.8.8.1.What is a grouping? 
A grouping is a collection of groups. When you have made groups in a 

course you have the option of adding them to a grouping. A single 

grouping can house one group or several groups. 

Note that since you can have a group of only one member, you can 

therefore have a grouping of only one member too, if you wish to restrict 

an activity to a single person in your course. 

Groupings were designed to allow selection of different sets of groups in 

each activity. If you assign an activity to a grouping then only the 

group/grouping that is selected will be able to see and do the activity. It 

will be invisible to other groups or groupings. 

 

4.8.8.2.What is the difference between a group 
and a grouping? 
A group is a set of users. A grouping is a set of groups. 

4.8.8.3.Why is the 'Available for group 
members' feature still experimental? 
 
There are known problems that will not be probably fixed. However, there 

is a tracker issue related to this: MDL-42979  

4.8.8.4.Why does a graded activity assigned to 
a particular grouping only appear in the 
gradebook for all users? 
 
This is the case for teachers viewing the gradebook in a course. The 

gradebook does not currently consider the experimental Available for 

group members (п. 4.8.5) only functionality. (See MDL-13868 for details. 

http://tracker.moodle.org/browse/MDL-13868) It is recommended that 

separate courses are used instead. A possible workaround is: 

1. Put all graded activity is assigned to a particular grouping into one 

category 

 

4.8.7.3.См. также 
 Часто задаваемые вопросы по Группировкам (п. 4.8.8). 

 Использование Moodle, форум «Группы». 

4.8.8.Часто задаваемые вопросы по Группировкам 
4.8.8.1.Что такое Группировка? 

Группировка (п.4.8.3) – это коллекция Групп. Когда вы создали Группы в Курсе у 

вас есть возможность добавить их в Группировку. Единственная Группировка может 

вместить одну Группу или несколько Групп. 

Обратите внимание, что поскольку вы можете иметь Группу только из одного 

члена, вы, следовательно, и можете иметь Группировку только из одного члена тоже, если 

хотите поручить работу с Интерактивным Действием одному человеку в вашем Курсе. 

Группировки были разработаны, чтобы позволить выбор различных наборов Групп 

в каждом Интерактивном Действии. Если вы назначаете Интерактивное Действие 

Группировке, тога только Группа/Группировка, которая выбирается, сможет увидеть и 

выполнить своё Интерактивное Действие. Оно будет невидимым для других Групп или 

Группировок. 

4.8.8.2.В чём различе между Группой и Группировкой? 
 

Группа – это набор пользователей. Группировка – это набор Групп. 

4.8.8.3.Почему средство «Available for group members 
(доступно для членов группы) всё ещё 
экспериментальное»? 

Существуют известные проблемы, которые возможно не будут решены. Однако, 

есть вывод Средства Отслеживания, относящийся к этому: MDL-42979. 

4.8.8.4.Почему оцениваемое Интерактивное Действие 
назначается только той конкретной Группировке, 
которая появляется в Журнале Оценок для всех 
пользователей? 

Это тот случай, для просмотра Преподавателем Журнала Оценок в Курсе. В 

настоящее время Журнал Оценок не считает экспериментальную настройку «Доступно 

только для членов Группы (п. 4.8.5)» только функциональностью. (См. подробности в 

MDL-13868). Рекомендуется, чтобы вместо этого использовались отдельные Курсы. 

Возможным решением является: 

1. Поместить все оцениваемые Интерактивные Действия, которые назначены в 

конкретную Группировку, в одну Категорию. 

http://tracker.moodle.org/browse/MDL-13868
http://moodle.org/mod/forum/view.php?f=320
http://tracker.moodle.org/browse/MDL-42979
http://tracker.moodle.org/browse/MDL-13868
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2. Set the aggregation for the category to maximum grade 

3. Hide the individual activities 

However, this is not the case for students viewing their grades. They 

should NOT see activities that were allocated to a different grouping from 

their own. (See MDL-31510 for details 

http://tracker.moodle.org/browse/MDL-31510) 

4.8.8.5.See also 
 Using Moodle Groups forum 

4.8.9.See also 
 Groups FAQ 

 Groupings FAQ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Установить Агрегацию для Категорию равной максимальной Оценке. 

3. Скрытб индивидуальные Интерактивные Действия. 

Однако, это не тот случай для просмотра Студентами своих Оценок. Они НЕ 

должны видеть Интерактивные Действия, которые были распределены Группировке, 

отличной от их собственной. (См. подробности в MDL-31510). 

 

4.8.8.5.См. также 
 Использование Moodle, форум «Группы». 

4.8.9.См. также 
 Часто задаваемые вопросы по Группам (п. 4.8.7) 

 Часто задаваемые вопросы по Группировкам(п. 4.8.8). 

http://tracker.moodle.org/browse/MDL-31510
http://tracker.moodle.org/browse/MDL-31510
http://moodle.org/mod/forum/view.php?f=320
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4.9.Tracking progress 

How to control and display progress through a course. 

4.9.1.Grades 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.9.1.1.Gradebook 
All the grades for each student in a course can be found in the course 

gradebook, or 'Grader report' in Settings > Course administration > Grades. 

The grader report collects items that have been graded from the various 

parts of Moodle that are assessed, and allows you to view and change them 

as well as sort them out into categories and calculate totals in various ways. 

When you add an assessed item in a Moodle course, the gradebook 

automatically creates space for the grades it will produce and also adds the 

grades themselves as they are generated, either by the system or by you. 

The grades displayed are initially displayed as the raw marks from the 

assessments themselves, so will depend on how you set those up e.g. an 

essay out of 36 will appear as however many raw marks that student got, 

not a percentage (although this can be changed later, see below). 

 

Note that various default options for the gradebook are set at system level 

by the administrator and can be marked as being overridable by you, or 

fixed. This means that the options will not always be set up the same way 

for every user when they see the grader report for the first time. 

 

4.9.Отслеживание прогресса хода обучения 
Как контролировать и отображать ход обучения в течение Курса. 

4.9.1.Оценки 
Примечание редактора перевода ко всему п. 4.9.1 «Оценки» 

Данный подраздел документации системы Moodle предназначен Преподавателям, которые 

решили осуществлять преподавание своих Курсов средствами её версии 2.5. Система Moodle 

поддерживает реализацию в учебном процессе любых методик, употребляющихся в учебном процессе (от 

многофункциональных типа Урока или Форума, до отдельных узкоцелевых операций над данными, типа 

Оценивания), и предоставляет Преподавателям возможность вводить в Курс собственные новые 

педагогические средства. 

Подраздел посвящён оцениванию степени освоенности конкретным Студентом пройденного 

Курса. В российской системе образования установлены простые стандарты итогового оценивания, 

вносимые в официальные документы об образовании: четырёхбальная оценка за экзамен («отлично», 

«хорошо», «удовлетворительно», «неудовлетворительно») и двухбалльная – за зачёт («зачтено», «не 

зачтено»). И если Преподаватель намерен, и при использовании Moodle в своей работе, ограничиться 

только этой привычной системой Оценок, то для него ознакомление с данным разделом не обязательно. Но 

в практике иногда Преподаватели вводят (для собственного пользования!) промежуточные градации, типа 

«плюсов» и «минусов» или дробных чисел. В том случае, если Преподаватель хотел бы оценивать работу 

Студентов более детально (отдельно по разным частям Курса) или более точно (с большим числом 

градаций Оценки), то в Moodle он может найти подходящие для этого средства. Возможно также, что в 

ходе идущей реформы образования будут введены новые стандарты оценивания. 

В данном подразделе изложено, как система Mооdle поддерживает Первичное Оценивание в 

различных (количественных и качественных) измерительных Шкалах и Итоговое Оценивание 

(Агрегирование Первичных Оценок) по разным алгоритмам и формулам. 

4.9.1.1.Журнал Оценок 
Все Оценки для каждого Студента в Курсе могут быть найдены в Журнале Оценок 

или Отчёте Оценивающего в AdministrationCourse administrationGrades. 

Отчёт Оценивающего собирает все ответы Студентов из разных частей Moodle, 

которые были оценены, и позволяет просмотреть и изменить их, рассортировать по 

Категориям и подсчитать Итоговые Оценки различными способами. Когда вы добавляете 

Элемент Оценивания в Курс Moodle, Журнал Оценок автоматически создаёт пространство 

под Оценки, которые будут проставлены, а также сам заполняет его Оценками, как только 

они генерируются Системой или вами. 

Отображаемые Оценки первоначально отображаются как Исходные Отметки 

непосредственно из материалов оценивания, так что всё зависит от того, как вы это 

установили; например, Эссе, состоящее из 36 оцениваемых пунктов, предстанет как 36 

Исходных Отметок, которые получил этот Студент, а не в процентах верных ответов (хотя 

позднее это может быть изменено, см. ниже). 

Заметьте, что различные опции по умолчанию для Журнала Оценок 

устанавливаются на системном уровне Администратором, и могут быть помечены вами 

как Overridable (переопределяемые) или как Fixed (фиксированные). Это означает, что 

опции не всегда будут установлены одинаковым образом для каждого из пользователей, 

когда они увидят Отчёт Оценивающего впервые. 
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4.9.1.1.1.Display 
Along the top of the grader report are several rows: first the course, then 

the category, then the columns for each graded activity (for example: 

Assignment, Quiz, Lesson). Any activities settings which were left 

"uncategorised" will appear in the general category which is named after 

the course by default (any category name can be changed). 

 

You can add a row showing the range of possible scores by selecting 

'Show ranges' in 'My report preferences’. 

 

There are three ways that the categories can be displayed: 

 Grades only - without the category totals column 

 Collapsed - Category total column only 

 Full view - grades and the aggregates (the totals column for the 

category) 

Each section has a small icon immediately to the right of its name. 

Clicking this will cycle through these display modes for that category. + 

goes to grades only view, o goes to full view and - goes to collapsed view. 

 

Highlighting rows and columns 
When your gradebook starts to grow, it can be hard to keep track of which 

student and which assignment a cell refers to. Highlighting solves that. 

 

 Clicking on empty space in the cell that contains the students name will 

toggle the highlighting of that entire row 

 Clicking on empty space in the cell at the top of each column will 

toggle highlighting of the entire column 

(Note: this requires Javascript to be enabled in your browser.)\ 

Sorting by columns 

You can sort by any column. Click the  symbol near the top of a column 

to sort by that column. This will change the symbol to a single down 

arrow. Clicking again will sort lowest-to-highest, changing the symbol to 

an up arrow. The arrows will toggle between these two states until you 

click on a different column. 

The student name columns do not have the  symbol. Clicking on either 

the first or last name will cause the report to sort. 

 

 

 

4.9.1.1.1.Отображение 
Вдоль верхней части Отчёта Оценивающего располагаются несколько строк: 

сначала Курс, затем Категория, затем колонки для каждого оцениваемого 

Интерактивного Действия (например, Задания, Теста, Урока). Любые настройки 

Интерактивных Действий, которые были оставлены «некатегоризированными» (т.е. не 

отнесены к той или иной Категории), появятся в общей Категории, которая по умолчанию 

получает наименование Курса (любое наименование Категории может быть изменено). 

Вы можете добавить строку, показывающую диапазон возможных значений 

Оценок, посредством выбора «Show ranges» (Показать диапазоны) в «My report 

preferences» (Мои предпочтения в Отчёте). 

Существует три способа отображения Категорий: 

 Grades only (Только оценки) – без колонки Итогов по Категории. 

 Collapsed  (Свёрнутый)  – только колонка Итогов по Категории. 

 Full view  (Полный просмотр) – Оценки и Агрегации (колонка 

Итогов по Категории). 

Каждый раздел имеет маленькую иконку непосредственно справа от его названия. 

Щелчок по ней приводит к циклу по этим режимам отображения для этой Категории. 

Щелчок по «+» вызывает просмотр Grades only, по «о» – Full view, а щелчок по «–» 

вызывает просмотр Collapsed. 

Подсветка строк и колонок 
Когда ваш Журнал Оценок начинает расти, становится трудно отследить, к какому 

Студенту и к какому Заданию относится та или иная ячейка Отчёта. Подсветка решает эту 

проблему. 

 Щёлкните по пустому пространству в ячейке с именем Студента, и – вы переключитесь 

в режим подсветки всей этой строки. Ещё щелчок, и подсветка отключится. 

 Щёлкните по пустому пространству в ячейке вверху каждой колонки – включится 

подсветка всей этой колонки. 

(Замечание: Это требует, чтобы в вашем браузере был позволен Javascript.) 

Сортировка по колонкам 

Вы можете сортировать по любой колонке. Щёлкните по значку  вверху 

колонки, чтобы отсортировать по этой колонке. Значок изменится на единственную 

стрелочку вниз. Ещё щелчок по ней отсортирует всё в обратном порядке, изменив значок 

на стрелочку вверх. Стрелки будут переключаться между этими двумя состояниями, пока 

вы не щёлкнете по другой колонке. 

Колонка с именем Студента не имеет значка . Щелчок по имени или фамилии 

вызовет сортировку Отчёта по именам Студентов. 
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Highlighting scores that are either adequate or 
unacceptable in red and green 
Turn editing on and click on the edit icon in the controls cell at the top of 

the column. You can then (maybe need to click 'show advanced') see the 

option to enter a 'grade to pass'. Once set, any grades falling above this will 

be highlighted in green and any below will be highlighted in red. 

 

Note that the highlighting will not show if the Grader report is viewed in 

the editing mode. 

Horizontal scrollbar 

A horizontal scrollbar enables teachers to scroll grades in the grader report. 

(Note that this feature is not available for IE6 users or for users who have 

have the screenreader setting in their profile set to Yes.) 

 

Mouse-over tooltips 
Each grade cell in the table has a tooltip indicating the user and grade item 

to which the grade belongs. 

Filtering the gradebook by groups 
If you change the course settings Group mode to Visible groups or 

Separate groups a drop-down menu will appear in the gradebook to allow 

you to filter your students by groups. 

 

4.9.1.1.2.Editing 
Note: Editing anything in the gradebook refers to editing the grades only 

and none of the available operations bear any relationship to editing the 

main course page i.e. the appearance of your course page cannot be 

influenced by anything you do in the gradebook. The "Turn editing on" 

button functions separately from the main course one, so editing can be on 

in the gradebook, but simultaneously off when you switch back to course 

view. This is because editing grades and editing the course page are 

separate capabilities. Roles such as 'non-editing teacher' may only have one 

or the other. 

 

Altering the grades 
You can click "Turn editing on" at the top right to show an edit icon next 

to each grade. Clicking on the icon will bring up the editing screen for that 

grade which will allow you to set the grade, its written feedback and a 

number of other attributes. 

 

Подсветка зелёным или красным Накопленных Баллов, которые 
либо выше, либо ниже Проходной Оценки 

Перейдите в режим редактирования и щёлкните по иконке редактирования в 

ячейке средств управления вверху колонки. Затем вы сможете (может быть, потребуется 

щёлкнуть по «Show advanced (показать дополнительные)») увидеть опцию «Grade to pass 

(зачётная оценка)». После установки любые Оценки, превышающие значение 

Проходной Оценки, подсвечиваются зелёным, не достигающие его – красным. 

Заметьте, что подсветка не показывается, если Отчёт Оценивающего 

просматривается в режиме редактирования. 

Горизонтальная управляющая линейка с бегунком 
Горизонтальная управляющая линейка с бегунком даёт возможность 

Преподавателям прокручивать Оценки в Отчёте Оценивающего. (Заметьте, что это 

средство недоступно для пользователей браузера IE6 или пользователей, у которых 

настройка Screenreader [считывателя экрана] в их профиле установлена в Yes). 

Наведение курсора мышки на ячейки вызывает подсказки 
Каждая ячейка Оценки в этой таблице имеет подсказку, указывающую 

пользователя и Элемент Оценки, к которым эта Оценка относится. 

Фильтрация Журнала Оценок по Группам 
Если вы в настройках Курса измените режим «Group (группы)» на «Visible groups 

(видимые группы)» или «Separate groups (раздельные группы)», в Журнале Оценок 

появится ниспадающее меню, которое позволит отфильтровать ваших Студентов по 

Группам. 

4.9.1.1.2.Редактирование 
Замечание. Редактирование чего бы то ни было в Журнале Оценок относится 

только к редактированию Оценок, и никакая из доступных операций не имеет никакого 

отношения к редактированию Главной страницы Курса, т.е. на оформление вашей 

страницы Курса не может повлиять ничто из того, вы делаете в Журнале Оценок. Кнопка 

«Turn editing on (включить редактирование)» функционирует отдельно от такой же кнопки 

в основном Курсе, так что режим редактирования может быть включён в Журнале Оценок, 

в то же время этот режим останется выключенным, когда вы вернётесь к просмотру Курса. 

Это связано с тем, что редактирование Оценок и редактирование страницы Курса 

являются отдельными Возможностями. Такие Роли, как 

«Нередактирующий Преподаватель», могут иметь только одну из этих Возможностей. 

Внесение изменений в Оценки 
Вы можете щёлкнуть «Turn editing on» вверху справа, чтобы появились иконки 

редактирования непосредственно за каждой Оценкой. Щелчок по одной из них вызовет 

появление экрана редактирования для этой Оценки, который позволит вам установить 

саму Оценку, письменную Обратную Связь на неё, и ряд других характеристик. 
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Alternatively, you can choose "Quick grading" and "Quick feedback" in 

'My preferences' to make the report appear with editable boxes containing 

each grade, so you can change many at once. This capability can be a real 

time saver, but make sure to save at reasonable intervals lest a pageful of 

changes be lost. 

 

Note: If you make changes here, they are then shown highlighted to 

indicate grades which have been manually changed. 

Hiding columns or individual grades 
Turning on editing then clicking the "Show show/hide icons" link will give 

you the familiar show/hide eye icon next to each grade and at the top of 

each column. 

Introduction 
In the context of the gradebook, hiding is completely separate from the 

show/hide in the main course page, where the activities are shown/hidden. 

The gradebook ones refer to whether a student will be able to see that 

grade or grade item in their user report. You can have an activity available 

on the course page for which you would not want the students to know 

their grade. Also in reverse - an offline activity that is hidden in the course 

page, but which you want the students to know their grade for. 

Hidden until 
Date before which the grades will be hidden. Usually this date is set to the 

end of the activity, and the beginning of the grading process. A typical 

sequence of events would be: 

 

 

 

 

 

 

 

Effects of hiding 
Hiding simply prevents students from viewing the categories, grade items 

and grades to which it applies. They appear to admins and teachers, but 

with a special style that clearly identifies them as hidden. 

Recalculating 
If you change any part of an assessment e.g. alter the maximum grade for 

one of the questions in a quiz, you may find that the columns do not yet 

reflect the change you have made. Click Turn editing on twice 

В качестве альтернативы можно выбрать «Quick grading» (быстрое оценивание) и 

«Quick feedback» (быстрая обратная связь) в «My preferences» (мои предпочтения), чтобы 

вызвать появление Отчёта с редактируемыми окошками, содержащими каждую Оценку с 

тем, чтобы вы смогли внести сразу несколько изменений. Эта Возможность может 

действительно сэкономить время, но не забудьте о сохранении ваших изменений через 

разумные интервалы, чтобы не потерять целую страницу изменений. 

Замечание. Если вы делаете изменения здесь, они потом показываются 

подсвеченными, чтобы указать на Оценки, которые были изменены вручную. 

Сокрытие колонок или отдельных Оценок 
Включение режима редактирования, затем выбор ссылки «Show show/hide icons 

(показать иконки «показать/скрыть»)» выдаст вам знакомую иконку Show/hide eye (глаз 

показать/скрыть), следующей за каждой Оценкой вверху каждой колонки. 

Введение 
В контексте Журнала Оценок «сокрытие» полностью отделено от «показать/скрыть» на 

Главной Странице Курса, где показываются/скрываются Действия Курса. Эти 

возможности в Журнале Оценок относятся к тому, какую Оценку или 

Элемент Оценивания увидит Студент в своём Пользовательском Отчёте. У вас может быть 

доступ к Интерактивному Действию на странице Курса, свои Оценки по которому вы не 

хотите, чтобы знали Студенты. И наоборот, – офлайн Интерактивное Действие, скрытое 

на странице Курса, свои Оценки по которому вы хотите, чтобы знали Студенты. 

Скрытая до поры 
Дата, до которой Оценки будут скрыты. Обычно эта дата совмещается с концом 

выполнения Интерактивного Действия и началом процесса оценивания. Типичной будет 

такая последовательность событий. 

Эффекты сокрытия 
Сокрытие просто не даёт Студентам просмотреть Категории, 

Элементы Оценивания и Оценки, для которых оно применено. Их видят Администраторы 

и Преподаватели, но в специальном стиле, который ясно указывает, что они скрыты от 

Студентов. 

Перерасчёт Оценок 
Если вы изменяете любую часть оценивания, например, изменяете  

максимальную Оценку для одного из Вопросов в Экзамене, вы можете обнаружить, что 

эти колонки всё ещё не отражают внесённые вами изменения. Щёлкните дважды по  

Event Locked Hidden 

Start of activity and participant submissions 

 
No Yes 

End of activity and beginning of grading/feedback Yes Yes 

End of grading/feedback, and release of grades Yes No 

Событие Заблокировано Скрыто 

Начало Интерактивного Действия и передача готовых ответов участников 

Курса на рассмотрение 
Нет Да 

Конец Интерактивного Действия и начало Оценивания/Обратной Связи Да Да 

Конец Оценивания/Обратной Связи, и Оглашение Оценок Да Нет 

http://docs.moodle.org/25/en/Grade_locking
http://docs.moodle.org/25/en/Grade_locking
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to force the gradebook to re-check. 

4.9.1.1.3.Gradebook capabilities 
There is just one gradebook capability, View the grader report, which is 

allowed for the default roles of manager, teacher and non-editing teacher. 

 

4.9.1.1.4.Extending the gradebook 
The Gradebook can be extended in three main ways: 

1.Grade reports 
Which are the main way to view and manipulate grades 

 LAE Grader Report Alternative to Grader report that scrolls vertically 

and horizontally without losing student columns or grade item header 

rows. Lot of additional enhancements. 

 

 Upload PDF Grader Report lets you view assignment grades, comments 

and lateness in a report 

2.Grade import plugins 
Which allow data to be imported from external sources 

3.Grade export plugins: 
Which allow you to export grade data for other systems 

 PDF document This is moodle plugin for exporting grades in PDF 

format. It is developed by using "Moodle PDF library" 

 Checklist This is a grade export plugin which will create an Excel 

spreadsheet containing all the checkmarks from a single checklist. 

4.9.1.1.5.Gradebook report settings 

The gradebook report settings determine the appearance of gradebook 

reports in all courses on the site. The site administrator will find the default 

and enabled/disabled settings in the administration area. 

There Teachers can use the "My report preferences" link in any course to 

essentially change their defaults and the way a report will display. These 

preferences become the new defaults for that teacher until they are changed 

by the teacher. 

 

 

 

 

 

 

 

 

Turn editing on, чтобы заставить Журнал Оценок вычислить Оценки заново. 

4.9.1.1.3.Возможности Журнала Оценок 
Существует только одна возможность Журнала Оценок – «View the grader report 

(просмотреть Отчёт Оценивающего)», которая по умолчанию разрешена для Ролей 

Менеджера, Преподавателя и неРедактирующего Преподавателя. 

4.9.1.1.4.Расширение Журнала Оценок 
Журнал Оценок может быть расширен по трём основным направлениям. 

1.Отчёты по Оценкам 
Являются основным способом просмотра и манипулирования Оценками. 

 LAE Grader Report – альтернатива Отчёту Оценивающего, который прокручивается 

вертикально и горизонтально, причём колонки с именем Студента и строки с 

заголовком оцениваемого Элемента не исчезают. Содержит много дополнительных 

усовершенствований. 

 Переслать Отчёт Оценивающего в формате PDF позволяет вам просмотреть Оценки по 

Заданию, Комментарии и опоздание с Отчётом. 

2.Плагины импорта Оценок 
Позволяют импортировать данные из внешних источников. 

3.Плагины экспорта Оценок: 
Позволяют экспортировать данные Оценок для других систем. 

 Документ PDF. Это Плагин Moodle для экспортирования Оценок в формат PDF. 

Развивается он путём использования «Библиотеки PDF Moodle». 

 Checklist. Этот Плагин для экспортирования Оценок создаст электронную таблицу 

Excel, содержащую все пункты из единого перечня. 

4.9.1.1.5.Настройки отчёта по Журналу Оценок 
Настройки Отчёта по Журналу Оценок определяют внешний вид Отчётов по 

Журналу Оценок во всех Курсах на данном Сайте. Администратор Сайта найдёт настройки 

по умолчанию и включаемые/отключаемые настройки в Административной области. 

Преподаватели могут использовать ссылку «My report preferences (мои 

предпочтения по отчёту)» в любом Курсе, чтобы существенно изменить предоставленные 

им настройки по умолчанию и способ, каким будет отображаться Отчёт. Эти 

предпочтения станут новыми настройками по умолчанию для этого Преподавателя, пока 

он их сам не изменит. 

http://docs.moodle.org/25/en/Capabilities/gradereport/grader:view
http://docs.moodle.org/25/en/Capabilities/gradereport/grader:view
http://docs.moodle.org/25/en/LAEGrader_report
https://moodle.org/plugins/view.php?plugin=gradereport_updfgrades
https://moodle.org/plugins/view.php?plugin=gradeexport_pdf
https://moodle.org/plugins/view.php?plugin=gradeexport_checklist
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4.9.1.1.6.Grader report settings 

Location: Administration > Grades > Report settings > Grader report 

Grader report settings include whether to show calculations, show/hide 

icons, column averages etc. Individual teachers may override certain 

settings for their own grader report view via their "My report preferences" 

tab. 

 

Quick grading and quick feedback 
 Quick grading adds a text input element in each grade cell on the grader 

report, allowing you to edit the feedback for many grades at once. You 

can then click the Update button to perform all these changes at once, 

instead of one at a time. 

 Quick feedback adds a text input element in each grade cell on the 

grader report, allowing you to edit many grades. You can then click the 

Update button to perform all these changes at once, instead of one at a 

time. 

 By default, both quick grading and quick feedback are enabled. They 

can be disabled by de-selecting the appropriate checkbox. at once. 

Static students column 
A static students column may be enabled so that teachers can scroll grades 

in the grader report using a horizontal scrollbar. (Note that this feature is 

not available for users who have have the screenreader setting in their 

profile set to Yes.) 

4.9.1.1.7.Overview report settings 

Location: Administration > Grades > Report settings > Overview report 

The overview report setting may be overridden for all overview reports in a 

course by a teacher in the course settings. 

 

Show rank 
If the show rank checkbox is ticked, the position of a grade item in relation 

to the rest of the class will be shown. 

4.9.1.1.8.User report settings 

Location: Administration > Grades > Report settings > User report 

The user report settings may be overridden for all user reports in a course 

by a teacher in the course settings. 

Show rank 
If the show rank checkbox is ticked, the position of a grade item in relation 

to the rest of the class will be shown. 

 

4.9.1.1.6.Настройки Отчёта Оценивающего 
Местоположение настроек: AdministrationGradesReport settingsGrader report 

Настройки Отчёта Оценивающего включают: показывать ли вычисления, 

показывать/скрывать ли иконки, средние по колонкам и т.д. Отдельные Преподаватели 

могут заменить определённые настройки в соответствии с их собственным 

представлением об Отчёте Оценивающего посредством таблицы «My report preferences» 

(мои предпочтения по Отчёту, см. п. 4.9.1.2)». 

Быстрое Оценивание и Быстрая Обратная Связь 
 Быстрое Оценивание добавляет элемент ввода текста в каждую ячейку Оценок в 

Отчёт Оценивающего, позволяя редактировать Обратную Связь по нескольким 

Оценкам сразу. Потом можно щёлкнуть кнопку Update (Обновить), чтобы выполнить 

все эти изменения сразу, вместо внесения их по одному. 

 Быстрая Обратная Связь добавляет элемент ввода текста в каждую ячейку Оценок в 

Отчёт Оценивающего, позволяя редактировать сразу много Оценок. Потом можно 

щёлкнуть кнопку Update, чтобы выполнить все эти изменения сразу, вместо внесения 

их по одному. 

 По умолчанию и Быстрое Оценивание, и Быстрая Обратная Связь включены. Они сразу 

обе могут быть отключены посредством снятия флажка в соответствующем окошке. 

Закреплённые колонки Студентов 
Можно закрепить колонку с именами Студентов, чтобы Преподаватели могли 

прокручивать Оценки в Отчёте Оценивающего, используя горизонтальную линейку 

прокрутки. (Заметьте, что это средство недоступно пользователям, которые имеют 

настройку Screenreader [считыватель экрана] в их профиле, установленную в Yes). 

4.9.1.1.7.Настройки Обзорного Отчёта 
Местоположение настроек: 

AdministrationGradesReport settingsOverview report  

Настройки Обзорного Отчёта могут быть переопределены Преподавателем для 

всех Обзорных Отчётов Курса в настройках Курса, (см. п. 4.1.3). 

Показать Ранг 

Если кнопка Show rank отмечена флажком, будет показана позиция 

Элемента Оценивания по отношению к остальным в классе. 

4.9.1.1.8.Настройки Пользовательского Отчёта 
Местоположение настроек: AdministrationGradesReport settingsUser report  

Настройки Пользовательского Отчёта могут быть переопределены Преподавателем 

для всех Пользовательских Отчётов Курса в настройках Курса (см. п. 4.1.3). 

Показать Ранг 

Если кнопка Show rank отмечена флажком, будет показана позиция 

Элемента Оценивания по отношению к остальным в классе. 
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Show percentage 
If the show percentage checkbox is ticked, the percentage value of each 

grade item will be shown. 

4.9.1.1.9.See also 
 Join the discussions about gradebook plugins in the Gradebook forum. 

 Video explaining the different gradebook reports. 

4.9.1.2.Grade settings 
4.9.1.2.1.Course grade settings 
Course grade settings determine how the gradebook appears for all 

participants in the course. 

Course grade settings are found in Settings > Grade administration > 

Course grade settings or via the gradebook Settings tab. 

 

The default course grade settings are set by an administrator in Settings > 

Site administration > Grades. 

Screenshot «Course grade settings». 

4.9.1.2.2.Grader report preferences 
Teachers can set their preferences for the grader report via the gradebook 

'My preferences' tab. These settings will apply to all courses for that 

teacher. The teacher may change them at any time. 

 

The default grader report preferences are set by an administrator 

in Settings > Site administration > Grades > Report settings > Grader 

report. 

In Moodle 2.4.2 onwards, the default number of students per page 

(grade_report_studentsperpage) can safely be increased without any loss of 

data when grading large numbers of students with many assignments. 

Screenshot «Grader report preferences». 

4.9.1.2.3.Site administration settings 
Default values for all grade settings can be set by an administrator. The 

easiest way to do so is to log in as admin then browse a course gradebook 

and follow the 'Change defaults' links. 

 

The following additional grade settings can be found in Settings > Site 

administration > Grades > General settings. The settings will affect all 

gradebooks used by all teachers. 

 

 

Показать проценты 

Если кнопка Show percentage отмечена флажком, будет показано значение в 

процентах верных ответов для каждого Элемента Оценивания. 

4.9.1.1.9.См. также 
 Присоединяйтесь к обсуждениям Плагинов Журнала Оценок на форуме. 

 Видео, объясняющее различные Отчёты по Журналу Оценок. 

4.9.1.2.Настройки Оценок 
4.9.1.2.1.Настройки Оценок Курса 

Настройки Оценок Курса определяют внешний вид Журнала Оценок для всех 

участников этого Курса. 

Настройки Оценок Курса (когда вы на странице этого Курса) находятся в 

AdministrationGrade administration Course grade settings или к ним можно добраться 

через таблицу настроек Журнала Оценок. 

По умолчанию настройки Оценок Курса устанавливаются Администратором в 

AdministrationSite administrationGrades. 

Снимок с экрана «Настройки Оценок Курса». 

4.9.1.2.2.Предпочтения Отчёта Оценивающего 
Преподаватели могут установить свои предпочтения для Отчёта Оценивающего 

посредством таблицы «My preferences» (мои предпочтения) Журнала Оценок. Эти 

настройки будут применяться для всех Курсов этого Преподавателя. Преподаватель может 

изменить их в любое время. 

Предпочтения Отчёта Оценивающего по умолчанию устанавливаются 

Администратором в 

AdministrationSite administrationGradesReport settingsGrader report. 

Начиная с версии Moodle 2.4.2, по умолчанию число Студентов на странице 

(grade_report_studentsperpage) может быть безопасно увеличено без потери данных при 

оценивании большого числа Студентов со многими Заданиями. 

Снимок с экрана «Предпочтения Отчёта Оценивающего». 

4.9.1.2.3.Настройки управления Сайтом 
Значения по умолчанию для всех настроек Оценок могут быть установлены 

Администратором. Легче всего сделать это так: войти в систему как Администратор, затем 

просмотреть Журнал Оценок Курса и проследовать по ссылкам «Change defaults» 

(изменить настройки по умолчанию). 

Другие дополнительные настройки Оценок могут быть найдены в 

AdministrationSite administrationGradesGeneral settings. Эти настройки будут 

эффективными для всех Журналов Оценок, используемых всеми Преподавателями. 

https://moodle.org/mod/forum/view.php?id=2122
http://www.youtube.com/watch?v=5hrLNbifiGQ
http://docs.moodle.org/24/en/File:Course_grade_settings.png
http://docs.moodle.org/24/en/File:Grader_report_preferences.png.
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Graded Roles 
Graded roles are the type of user that will appear in the gradebook. Most of 

the time "student" is the only one needed. 

User profile report 
The default user profile report setting has just one option, 'User report', 

unless a custom user report has been added to the site. 

 

Teachers can view the user reports for all or selected students in the course 

in Settings > Grades administration > User report. 

Include scales in aggregation 
Scales can be included as numbers in all aggregated grades across all 

gradebooks in all courses. Changing this setting will force all aggregated 

grades to be recalculated. 

If this is checked (and it is by default) then all custom scales will have a 

corresponding value that is assigned based on the number of options in the 

scale (ie. three values will have values of 1, 2, 3) and this will be included 

in the grade aggregation. 

Enable publishing 
Grade publishing is a way of importing and exporting grades via a URL 

without being logged in to Moodle. Grade publishing is intended for 

administrators only. Security implications should be thoroughly considered 

before allowing non-admin users to publish grades. Grade publishing may 

be enabled by checking the gradepublishing box. If enabled, administrators 

are provided with grade export publishing settings in each course 

gradebook. 

Screenshot «Grade publishing settings». 

Recover grades default 
When manually enrolling a student in a course, there is an option 'Recover 

user's old grades if possible', however this checkbox is easy to miss. 

Enabling 'Recover grades default' results in 'Recover user's old grades if 

possible' being ticked for every course. 

 

Unlimited grades 
Teachers can enter grades over 100% directly in the gradebook if 

the unlimitedgrades setting is enabled. 

 

 

 

 

Оцениваемые Роли 
Оцениваемые Роли – это тип пользователя, который будет представлен в 

Журнале Оценок. Почти всегда Роль «Студент» является единственно необходимой. 

Отчёт по Профилю Пользователя 
По умолчанию настройка Отчёта по Профилю Пользователя имеет только одну 

опцию «User report («пользовательский отчёт», если только не был добавлен Custom user 

report (привычный для клиента отчёт). 

Преподаватели могут просмотреть Пользовательские Отчёты для всех или 

выбранных Студентов курса в AdministrationGrades administrationUser report 

Включить Шкалы в Агрегацию 
Шкалы могут быть включены как числа во все Агрегируемые Оценки (aggregated 

grades) во все Журналы Оценок во все Курсы. Изменение этой настройки приведёт к 

пересчёту всех Агрегируемых Оценок. 

Если эта настройка отмечена флажком (а по умолчанию она отмечена), тогда все 

Привычные для Клиента Шкалы будут иметь значение, которое назначается исходя из 

числа градаций в этих Шкалах (например, Шкала из трёх градаций состоит из чисел 1, 2, 

3) и это будет включено в Агрегацию Оценок. 

Разрешить публикацию 
Публикация Оценок – это способ импорта и экспорта Оценок посредством URL без 

регистрации в Moodle. Публикация Оценок предназначена только для Администраторов. 

Возможные нарушения безопасности должны быть тщательно рассмотрены прежде, чем 

разрешать не-Администраторам публиковать Оценки. Публикация Оценок может быть 

включена отметкой флажком окошка Gradepublishing (публикация оценок). Если она 

включена, Администраторам предоставлены настройки публикования Экспорта Оценок в 

каждом Журнале Оценок Курса. 

Снимок с экрана «Настройки Публикации Оценок». 

Восстанавливать Оценки по умолчанию 
При зачислении Студента на Курс вручную имеется опция «Recover user's old 

grades if possible» (восстановить старые Оценки этого пользователя, если возможно), 

однако, эту кнопку-флажок легко пропустить. Включение «Recover grades default» 

(восстановить оценки по умолчанию) приводит к тому, что во всех Курсах окошки 

«Recover user's old grades if possible» будут помечены. 

Неограниченные Оценки 
Преподаватели могут ввести Оценки, 

превышающие 100% непосредственно в 

Журнал Оценок, если включена настройка 

Unlimitedgrades. 

http://docs.moodle.org/25/en/Grade_export
http://docs.moodle.org/25/en/Enrolled_users
http://docs.moodle.org/24/en/File:Grade_publishing_settings.png
http://docs.moodle.org/24/en/Enrolled_users
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4.9.1.2.4.Grade capabilities 
Edit grades 

Capabilities/moodle/grade:edit 

 This allows a user to turn editing on/off in the Grader report in order to 

edit grades directly or to hide or lock individual grades. 

 

 This capability is allowed for the default roles of manager and teacher 

and is not set for the default role of non-editing teacher. 

 If not set, a user may still hide or lock Grade items via the edit 

categories and items page. 

 

Export grades 
Capabilities/moodle/grade:export 

 This allows a user to export grades of other users. 

 This capability is allowed for the default roles of teacher and non-

editing teacher, do NOT allow for students. 

 The formats which a user is allowed to export to (Excel spreadsheet, 

OpenDocument spreadsheet, plain text file or XML file) are controlled 

by separate capabilities. 

Hide/unhide grades or items 
Capabilities/moodle/grade:hide 

 This allows a user to hide/unhide individual grades. 

 This capability is allowed for the default role of teacher and is not set 

for the default role of non-editing teacher. 

 It is not necessary to allow this capability in addition to 

moodle/grade:manage. In other words, this capability may be used to 

allow a user to hide/unhide grades but not manage grades. 

 

Import grades 
Capabilities/moodle/grade:import 

 This allows a user to import grades. 

 This capability is allowed for the default role of teacher and is not set 

for the default role of non-editing teacher. 

 The formats which a user is allowed to import from (CSV or XML file) 

are controlled by separate capabilities. 

 

 

 

4.9.1.2.4.Возможности Оценок 
Редактировать Оценки 

Возможность Capabilities/moodle/grade:edit 

 Позволяет пользователю включить/выключить редактирование в 

Отчёте Оценивающего (п. 4.9.1.1) для того, чтобы непосредственно редактировать 

Оценки или чтобы скрыть или заблокировать отдельные из них. 

 Эта Возможность по умолчанию разрешена для Ролей Менеджера и Преподавателя и не 

установлена для Роли нередактирующего Преподавателя. 

 Если Возможность не установлена, пользователь всё же может скрыть или 

заблокировать Элементы Оценивания (п. 4.9.1.3.1) посредством редактирования 

Категорий и страницы Элементов. 

Экспорт Оценок 
Возможность Capabilities/moodle/grade:export 

 Позволяет пользователю экспортировать Оценки (п. 4.9.1.8) других пользователей. 

 Эта Возможность по умолчанию предоставляется для Ролей Преподавателя и 

неРедактирующего Преподавателя, и НЕ предоставляется Студентам. 

 Форматы, в которые пользователю разрешается экспортировать Оценки в (электронная 

таблица Excel, электронная таблица OpenDocument, простой текстовый файл или файл 

XML), контролируются отдельными Возможностями. 

Скрыть/показать Оценки или Элементы Оценивания 
Возможность Capabilities/moodle/grade:hide 

 Позволяет пользователю скрыть/показать индивидуальные Оценки. 

 Эта Возможность предоставляется по умолчанию для Роли Преподавателя, и НЕ 

предоставляется по умолчанию для Роли неРедактирующего Преподавателя. 

 Нет необходимости предоставлять эту Возможность в дополнение к Возможности 

moodle/grade:manage (п. 3.4). Другими словами, эта Возможность может быть 

использована, чтобы разрешить пользователю скрывать/показывать Оценки, но не 

управлять ими. 

Импорт Оценок 
Возможность Capabilities/moodle/grade:import 

 Позволяет пользователю импортировать Оценки (п. 4.9.1.7). 

 Эта Возможность предоставляется по умолчанию для Роли Преподавателя, и НЕ 

предоставляется по умолчанию для Роли неРедактирующего Преподавателя. 

 Форматы, из которых разрешается импортировать Оценки (простой текстовый файл 

CSV или файл XML), контролируются отдельными Возможностями. 
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Lock grades or items 
Capabilities/moodle/grade:lock 

 This allows a user to lock grades. 

 This capability is allowed for the default role of teacher and is not set 

for the default role of non-editing teacher. 

 It is not necessary to allow this capability in addition to 

moodle/grade:manage. In other words, this capability may be used to 

allow a user to lock grades but not manage grades. 

Manage grade items 
Capabilities/moodle/grade:manage 

 This allows a user to manage grade items and categories in the 

gradebook (create, edit, lock, hide, delete, etc.) 

 This capability is allowed for the default role of teacher and is not set 

for the default role of non-editing teacher. 

Manage advanced grading methods 
Capabilities/moodle/grade:managegradingforms 

 This allows a user to manage Advanced grading methods 

 This capability is allowed for the default roles of manager and teacher 

  

Manage grade letters 
Capabilities/moodle/grade:manageletters 

 This allows a user to edit Grade letters 

 This capability is allowed for the default roles of manager and teacher 

and is not set for the default role of non-editing teacher 

 

Manage grade outcomes 
Capabilities/moodle/grade:manageoutcomes 

 This allows a user to add outcomes either at course level in Settings > 

Course administration > Outcomes or for managers at site level in 

Settings > Site administration > Grades > Outcomes 

 This capability is allowed for the default roles of manager and teacher 

 

Unlock grades or items 
Capabilities/moodle/grade:unlock 

 This allows a user to unlock grades. 

 This capability is allowed for the default role of teacher and is not set 

for the default role of non-editing teacher. 

 

Блокировать Оценки или Элементы Оценивания 
Возможность Capabilities/moodle/grade:lock 

 Позволяет пользователю заблокировать Оценки. 

 Эта Возможность предоставляется по умолчанию для Роли Преподавателя, и НЕ 

предоставляется по умолчанию для Роли неРедактирующего Преподавателя. 

 Нет необходимости предоставлять эту Возможность в дополнение к Возможности 

moodle/grade:manage. Другими словами, эта Возможность может быть использована, 

чтобы разрешить пользователю заблокировать Оценки, но не управлять ими. 

Управление Элементами Оценивания 
Возможность Capabilities/moodle/grade:manage 

 Позволяет управлять Элементами Оценивания и Категориями (п. 4.9.1.3.1-2) в 

Журнале Оценок (создавать, редактировать, блокировать, скрывать, удалять и пр.). 

 Эта Возможность предоставляется по умолчанию для Роли Преподавателя, и НЕ 

предоставляется по умолчанию для роли неРедактирующего Преподавателя. 

Управление Методами Продвинутого Оценивания 
Возможность Capabilities/moodle/grade:managegradingforms 

 Позволяет пользователю управлять Методами Продвинутого Оценивания (п. 4.9.1.9). 

 Эта Возможность предоставляется по умолчанию для Ролей Преподавателя и 

Менеджера. 

Управление Буквенными Оценками 
Возможность Capabilities/moodle/grade:manageletters 

 Позволяет пользователю редактировать Буквенные Оценки (п. 4.9.1.6). 

 Эта Возможность предоставляется по умолчанию для Ролей Менеджера и 

Преподавателя, и НЕ предоставляется по умолчанию для Роли 

неРедактирующего Преподавателя. 

Управление Показателями Оценивания 
Возможность Capabilities/moodle/grade:manageoutcomes 

 Позволяет пользователю добавлять Показатели (п. 4.9.1.5) либо на уровень Курса в 

AdministrationCourse administrationOutcomes, либо, для Менеджеров, на уровень 

Сайта в AdministrationSite administrationGradesOutcomes. 

 Эта Возможность предоставляется по умолчанию для Ролей Преподавателя и 

Менеджера. 

Разблокировать Оценки или Элементы Оценивания 
Возможность Capabilities/moodle/grade:unlock 

 Позволяет пользователю разблокировать Оценки. 

 Эта Возможность предоставляется по умолчанию для Роли Преподавателя, и НЕ 

предоставляется по умолчанию для роли неРедактирующего Преподавателя. 
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 It is not necessary to allow this capability in addition 

tomoodle/grade:manage. In other words, this capability may be used to 

allow a user to unlock grades but not manage grades. 

View own grades 
Capabilities/moodle/grade:view 

 This allows a user to view their own grades 

 The default student role has this capability set to allow 

View grades of other users 
Capabilities/moodle/grade:viewall 
This allows a user to view the grades of other users, including hidden 

grades 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View hidden grades for owner 
Capabilities/moodle/grade:viewhidden 

 This allows a user to view grades that are hidden 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

4.9.1.3.Managing grades 
 

 

4.9.1.3.1.Grade items 
A grade item is a unit (typically an activity) where course participants are 

assessed through a grade or mark. As such, a grade item is a container for 

grades and a set of settings applied to these grades. The settings affect the 

calculation and display of the grades in the gradebook reports and exports. 

 

Grade items may refer to course activities (e.g. a quiz, an assignment etc.), 

Outcomes or manual grades. 

 

Grade items and gradebook 
The three building blocks of the Gradebook are: 

1. The grade item 

2. The grade category 

3. The grade 

Grade items are represented by columns in the grader report. 

Within a category, a grade summary is also a grade item itself. Summary 

grade items for a category can show up in reports, 

 Нет необходимости предоставлять эту Возможность в дополнение к Возможности 

tomoodle/grade:manage. Другими словами, эта Возможность может быть использована, 

чтобы разрешить пользователю разблокировать Оценки, но не управлять ими. 

Просмотр собственных Оценок 
Возможность Capabilities/moodle/grade:view 

 Позволяет пользователю просматривать свои собственные Оценки. 

 Эта Возможность по умолчанию предоставляется Роли Студента. 

Просмотр Оценок других пользователей 
Возможность Capabilities/moodle/grade:viewall 

 Позволяет пользователю просматривать Оценки других пользователей, включая 

скрытые Оценки. 

 Эта Возможность предоставляется по умолчанию для Ролей Менеджера, Преподавателя 

и неРедактирующего Преподавателя. 

Просмотр скрытых для собственника Оценок 
Возможность Capabilities/moodle/grade:viewhidden 

 Позволяет пользователю просматривать Оценки, которые скрыты. 

 Эта Возможность предоставляется по умолчанию для Ролей Менеджера, Преподавателя 

и нередактирующего Преподавателя. 

4.9.1.3.Управление Оценками 
Управление Оценками – это управление Элементами Оценивания (Grade items), Категориями Оценок 

(Grade categories) и вычислениями Оценок (Grade calculations). 

4.9.1.3.1.Элементы Оценивания 
Элемент Оценивания – это раздел Курса (обычно Интерактивное Действие), в 

котором Участники Курса оцениваются посредством Оценок или Баллов. Как таковой, 

Элемент Оценивания – это контейнер для Оценок и множества настроек, 

применяемых к этим Оценкам. Эти настройки влияют на вычисление и отображение 

Оценок в Отчётах по Журналу Оценок и на экспорт Оценок (п. 4.9.1.8). 

Элементы Оценивания могут ссылаться на Интерактивные Действия Курса 
(например, Экзамен, Задание и т.д.), Показатели Оценивания или Оценки, 

проставляемые вручную. 

Элементы Оценивания и Журнал Оценок 
Имеется три конструируемых блока Журнала Оценок: 

1. Элемент Оценивания. 

2. Категория Оценок (п. 4.9.1.3.2). 

3. Оценка (п. 4.9.1). 

Элементы Оценивания представляются колонками в Отчёте Оценивающего. 

Внутри Категории Оценок резюме по Оцениванию само по себе также является 

Оценкой. Резюме по Элементам Оценивания для Категории могут показываться в отчётах 
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and can be used in the calculation of the grade for the parent category. 

Adding a grade item 
Grade items can be added in either of two ways: 

1. Automatically: Modules that include a form of grading, such as 

Assignments and Quizzes, automatically generate a matching grade 

item. See Activity-based grade items for more details. 

 

2. Manually: To add a manual grade item: 

1. Select "Categories and items: Simple view" or "Categories and 

items: Full view" from the gradebook dropdown menu. 

 

2. Click the "Add grade item" button near the bottom of the page. 

 

3. Give the grade item a meaningful name. 

4. Select grade item settings as appropriate. Advanced settings may be 

made available by clicking the "Show advanced" button. See Manual 

grade items for more details. 

 

5. Click the "Save changes" button. 

Activity-based grade items 
 
Modules that include a form of grading use the Gradebook API to generate 

a matching grade item, and to communicate their grades to the gradebook. 

The generated grade item can later be edited from within the gradebook 

interface (Course -> Grades -> Edit Categories and items -> Edit (hand 

icon) grade item), as seen in the screenshot to the right, but several of its 

settings will be 'frozen', only changeable from the activity module's 

interface. 

 

 

 

 

 

 

These are listed and explained below in the manual grade items section. 

 

 

 

 

 

и могут быть использованы в вычислении Оценки для родительской Категории. 

Добавление Элемента Оценивания 
Элемент Оценивания может быть добавлен куда-либо двумя путями: 

1. Автоматически: Модули, которые включают Форму Оценивания, такие как «Задание» 

или «Экзамен», автоматически генерируют соответствующий Элемент Оценивания. 

Дополнительную информацию ищите чуть ниже под заголовком 

«Элементы Оценивания, создаваемые Интерактивными Действиями». 

2. Вручную:. Чтобы добавить Элемент Оценивания вручную: 

1. Выберите «Categories and items: Simple view (категории и элементы: простой вид)» 

или «Categories and items: Full view (категории и элементы: полный вид)» из 

ниспадающего меню Журнала Оценок. 

2. Щёлкните кнопку «Add grade item (добавить Элемент Оценивания)» внизу 

страницы. 

3. Присвойте Элементу Оценивания значимое наименование. 

4. Выберите для Элемента Оценивания необходимые настройки. Продвинутые 

настройки могут стать доступны щелчком по кнопке «Show advanced (показать 

продвинутые)». Дополнительная информация приведена ниже в 

«Элементы Оценивания, создаваемые вручную». 

5. Щёлкните кнопку «Save changes (сохранить изменения)». 

Элементы Оценивания, создаваемыеые 
Интерактивными Действиями 

Модули, которые включают 

Форму Оценивания, используют Интерфейс 

прикладного программирования 

Журнала Оценок, чтобы сгенерировать 

соответствующий Элемент Оценивания. 

Сгенерированный Элемент Оценивания 

позднее может быть отредактирован внутри 

интерфейса Журнала Оценок 

(Course administrationGrades) щелчком по 

иконке редактирования  как представлено 

справа на снимке с экрана «Редактирование Элемента Оценивания», но некоторые из его 

настроек могут быть «заморожены» и доступны для изменения только из интерфейса 

модуля Интерактивного Действия. 

Ниже они перечислены и объяснены в разделе «Элементы Оценивания, 

построенные вручную». 



 

432 

Here is a list of the settings that can be edited for an activity-based grade 

item: 

 Item info: General information about the grade item. Optional. 

 Grade to pass: Specify the minimum grade a student must achieve to be 

considered to have passed this item. This must be in real grades, not a 

percentage. Once this is done, grades will be highlighted in red for fail 

and green for pass in the gradebook. It doesn't work for scales, as it is 

yet to be fully implemented in Moodle 1.9. It is planned for use in 

course completion in Moodle 2.0. 

 

 Grade display type: See the Grade display type doc 

 Overall decimal points: This specifies the number of decimal points to 

display for each grade. It has no effect on grade calculations, which are 

made with an accuracy of 5 decimal places. 

 Multiplicator: Factor by which all grades for this grade item  

will be multiplied, with a maximum value of the maximum grade. For 

example, if the multiplicator is 2 and the maximum grade is 100, then 

all grades less than 50 are doubled, and all grades 50 and above are 

changed to 100. 

 Offset: Number that will be added to every grade for this grade item, 

after the Multiplicator is applied. (Can be a negative number.) 

 Hidden: Whether this grade item should be hidden from students. 

 Hidden until: An optional date after which the grade item will no longer 

be hidden (i.e. a grades release date) 

 Locked: Whether or not to lock this grade item. A locked grade item 

doesn't accept changes to its settings or grades from its related module. 

 

 Locked after: A date after which the locking will be effective, usually 

after the grades release date. 

Grade outcome items 
These can either be generated by the creation of a new activity module (by 

selecting Outcomes in the module creation form), or manually created like 

manual grade items. A grade outcome item uses a course outcome as its 

grading type, so such an outcome must be made available at the course 

level before a grade outcome item can be manually created. 

 

 

 

 

Здесь представлен список настроек, которые могут быть отредактированы для 

Элемента Оценивания, созданного Интерактивным Действием: 

 Item info: общая информация об Элементе Оценивания. Не обязательна. 

 Grade to pass: указывает минимальную Оценку, которую Студент должен получить, 

чтобы считался выполнившим этот Элемент. Она должна быть одной из 

Фактических Оценок, не указанной в процентах. Если эта настройка сделана, Оценки, 

меньшие указанной здесь, будут подсвечиваться в Журнале Оценок красным, а равные 

или больше – зелёным. Это не работает для Шкал, так как ещё не полностью 

реализовано в Moodle 1.9. Эта настройка запланирована для применения в 

Завершении Курса в Moodle 2.0 и выше. 

 Grade display type: см. док. «Тип отображения Оценок» (п. «См. также» ниже). 

 Overall decimal points: указывает число десятичных знаков, отображаемых для каждой 

Оценки. Эта настройка не действует на вычисления Оценок, которые вычисляются с 

точностью до 5 десятичных знаков.  

 Multiplicator: Множитель, на который будут умножаться все Оценки для этого 

Элемента Оценивания, но чтобы максимальное получаемое значение не превышало 

Maximum grade (максимальная оценка). Например, если множитель равен 2, а Maximum 

grade равна 100, тогда все Оценки меньшие 50 будут удваиваться, а все оценки 50 и 

выше будут сделаны равными 100. 

 Offset: число, которое будет добавлено к каждой Оценке за этот Элемент Оценивания, 

после применения множителя. (Может быть и отрицательным.) 

 Hidden: должен ли этот Элемент Оценивания быть скрытым от Студентов. 

 Hidden until: необязательная для установки дата, после которой этот 

Элемент Оценивания более не будет скрыт (т.е. дата высвобождения Оценок). 

 Locked: будет ли заблокирован этот Элемент Оценивания. Заблокированный 

Элемент Оценивания не принимает изменения его настроек или Оценки от связанного с 

ним модуля. 

 Locked after: дата, после которой наступит блокировка, обычно после даты 

высвобождения Оценок. 

Элементы Показателя Оценивания 
Они могут генерироваться либо при создании нового модуля 

Интерактивного Действия (посредством выбора Outcomes (п. 4.9.1.5) в 

Форме Создания Модуля), либо вручную, подобно созданию Элементов Оценивания 

вручную. Элемент Показателя Оценивания использует Показатель Курса в качестве своего 

типа оценивания, так что такой Показатель должен быть доступен на уровне Курса до 

того, как Элемент Показателя Оценивания может быть создан вручную. 

http://docs.moodle.org/dev/Course_completion
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Screenshot «Editing a grade outcome item». 

Grade outcome items can optionally be linked with an activity module. 

This is done automatically when a grade outcome item is generated by the 

creation of an activity module in which outcomes were selected. In this 

scenario, a grade category is also created and named after the activity 

module, and the grade item and grade outcome items are created as 

children of that category. 

 

 

 

 

 

 

 

The settings of the grade outcome item edit form are identical to those of 

manual grade items, with the addition of two settings: 

 

 Outcome: The course outcome represented by this item 

 Linked activity: The optional activity module to which this item will be 

linked 

Manual grade items 
These grade items are created manually through the "Edit Categories and 

Items" page. The "Add grade item" button is clicked, and the form appears. 

Several options are available here which are normally automatically filled 

out by the activity module creating an activity-based grade item: 

Screenshot «Editing a grade outcome item». 

 

 

 Item name: The display name of your grade item 

 

 ID Number: An arbitrary string of characters used to refer to this grade 

item in Formulas. If set, it must be unique. 

 

 

 

 Grade type: The type of grade: None (no grading possible), Value (a 

numerical value), Scale (an item in a list) or Text (arbitrary text). 

 

 

 

Снимок с экрана «Редактирование Элемента Показателя Оценки». 

Элементы Показателя Оценивания 

могут по выбору быть связаны с 

модулем Интерактивного Действия. 

Это делается автоматически, когда 

Элемент Показателя Оценивания 

генерируется при создании модуля 

Интерактивного Действия, в котором 

были выбраны Показатели. В этом 

сценарии также создаётся и 

именуется Категория Оценок в 

соответствии с модулем 

Интерактивного Действия, а Элемент Оценивания и Элементы Показателя Оценивания 

создаются как дочерние по отношению к этой Категории. 

Настройки формы редактирования Элемента Показателя Оценивания идентичны 

таким же из Элементов Оценивания, создаваемых вручную, с двумя дополнительными 

настройками: 

 Outcome: Показатель Курса, представленный этим Элементом. 

 Linked activity: Модуль Интерактивного Действия, с которым этот Элемент связан. 

 

Элементы Оценивания, создаваемые вручную 
Эти Элементы Оценивания создаются вручную на странице «Edit Categories and 

Items (редактировать категории и элементы)». Щелчок кнопки «Add grade item», и 

появляется форма. Некоторые доступные здесь опции, которые обычно заполняются 

автоматически модулем Интерактивного Действия, создающим этот Элемент Оценивания: 

Снимок с экрана «Редактирование 

Элемента Оценивания, построенного 

вручную» 

 Item name: отображает название вашего 

Элемента Оценивания. 

 ID Number: произвольная строка 

символов, используемая для ссылки на 

этот Элемент Оценивания в Формулах. 

Если установлен, он должен быть 

уникальным. 

 Grade type: тип Оценки: None 

(оценивание невозможно), Value 

(числовое значение), Scale (элемент в 

списке) или Text (произвольный текст). 
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 Scale: Which scale to use for grading: available only when the Scale 

grade type is selected. 

 Maximum grade: The maximum grade that can be given (for scales: the 

number of items in the scale - 1) 

 Minimum grade: The minimum grade that can be given (for scales: 0) 

Conversely, two of the settings found in the form for activity-based grade 

items are absent from this form: 

 Multiplicator 

 Offset 

See also 
 Grade item settings - for administrators. 

4.9.1.3.2.Grade categories 
Grades can be organised into grade categories. A grade category has its 

own aggregated grade which is calculated from its grade items. There is no 

limit to the level of nesting of categories (a category may belong to another 

category). However, each grade item may belong to only one category. 

Also, all grade items and categories belong to at least one, permanent 

category: the course category. 

 

Adding a grade category 
To add a grade category: 

1. Select "Categories and items" from the gradebook dropdown menu. 

2. Click the "Add category" button near the bottom of the page. 

3. Give the grade category a meaningful name. 

4. Select grade category settings as appropriate. Advanced settings may be 

made available by clicking the "Show advanced" button. 

5. Click the "Save changes" button. 

Editing a grade category 
To edit a grade category: 

1. Select "Categories and items" from the gradebook dropdown menu. 

 

2. Click the edit icon opposite the grade category you wish to edit. 

 

 

3. After editing the grade category, click the "Save changes" button. 

 

Screenshot «Editing a grade category». 

 

 

 Scale: какая Шкала используется для оценивания: доступна, только когда выбрана Scale 

в качестве типа Оценки. 

 Maximum grade: максимальная Оценка, которая может быть дана (для Шкал – число 

элементов в этой Шкале минус-1). 

 Minimum grade: минимальная Оценка, которая может быть дана (для Шкал: 0). 

И наоборот, две из настроек, имеющихся в форме для Элементов Оценивания, 

создаваемых Интерактивным Действием, в этой форме отсутствуют: 

 Multiplicator (множитель). 

 Offset (смещение). 

См. также 
 Настройки Элемента Оценивания для Администраторов. 

4.9.1.3.2.Категории Оценок 
Оценки могут быть распределены по Категориям Оценок. Каждая Категория 

Оценок имеет свою собственную Агрегированную Оценку, которая вычисляется из её 

Элементов Оценивания. Не существует ограничений на уровень вложенности Категорий 

(Категория может принадлежать другой Категории). Однако, каждый 

Элемент Оценивания может принадлежать только одной Категории. Кроме того, все 

Элементы Оценивания и Категории принадлежат одной постоянной Категории, Категории 

Курса (п. 4.9.1.3.2). 

Добавление Категории Оценок 
Чтобы добавить Категорию Оценок: 

1. Выберите «Categories and Items» из ниспадающего меню Журнала Оценок. 

2. Щёлкните кнопку «Add category» внизу страницы. 

3. Задайте этой Категории Оценок значимое наименование. 

4. Выберите подходящие настройки Категории Оценок. Щёлкнув кнопку «Show more…», 

получите доступ к дополнительным настройкам. 

5. Щёлкните кнопку «Save changes» (Сохранить изменения). 

Редактирование Категории Оценок 
Чтобы отредактировать Категорию Оценок: 

1. Выберите в ниспадающем меню 

Журнала Оценок «Categories and items». 

2. Щёлкните иконку редактирования справа от 

Категории Оценок, которую вы хотите 

отредактировать. 

3. После редактирования Категории Оценок 

щёлкните по кнопке «Save changes». 

Снимок с экрана «Редактирование 

Категории Оценок»: 

http://docs.moodle.org/24/en/Grade_item_settings
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Settings 
If any of the following do not appear in your page, it may mean that they 

are set globally in your site. See Forcing settings for more information. 

 

Aggregation 

See Category aggregation for a detailed explanation. 

Aggregate only non-empty grades 
Non-existent grades are either treated as minimal grades or not included in 

the aggregation. For example, an assignment graded between 0 and 100 for 

which only half the students have been graded will either count the non-

graded submissions as 0 (option switched off) or will ignore them (option 

switched on). 

Important: An empty grade is simply a missing gradebook entry, and could 

mean different things. For example, it could be a participant who hasn't yet 

submitted an assignment, an assignment submission not yet graded by the 

teacher, or a grade that has been manually deleted by the gradebook 

administrator. Caution in interpreting these "empty grades" is thus advised. 

 

Aggregate including sub-categories 
The aggregation is usually done only with immediate children, it is also 

possible to aggregate grades in all subcategories excluding other 

aggregated grades. 

Include outcomes in aggregation 
Including outcomes in aggregation may not lead to the desired overall 

grade, so you have the option to include or leave them out. 

Drop the lowest 
If set, this option will drop the X lowest grades, X being the selected value 

for this option. 

Note: You can only make use of either this option or the option below 

`Keep Highest`. If you have both set then only `Drop the lowest` will be 

usable under course categories 

Keep the highest 
If set, this option will only retain the X highest grades, X being the selected 

value for this option. 

Note: If you have `Drop the lowest` set to anything other than null then this 

option will have no effect 

Parent Category – Item Weight 
If your course is set to use weighted mean of grades, you can assign a 

weight that the grade for this category will have inside the parent category. 

Настройки 
Если какие-либо из следующих настроек не появились на вашей странице, это 

может означать, что они установлены глобально на вашем Сайте. Дополнительную 

информацию можно найти в «Принудительные настройки (п. 4.9.1)» 

Агрегация 
Подробные объяснения приведены в Агрегация Категории. 

Агрегировать только не пустые Оценки 
Не существующие Оценки либо приравниваются к минимальным Оценкам, либо 

не включаются в Агрегацию. Например, Задание, оцениваемое от 0 до 100, по которому 

только половина Студентов была оценена, будет либо подсчитывать не оценённые ответы 

Студентов как 0 (опция выключена), либо игнорировать их (опция включена). 

 

Важно: Пустая Оценка – это просто недостающая запись Журнала Оценок (missing 

gradebook entry) и может означать различные вещи. Например, это может быть связано с 

участником, который всё ещё не ответил на Задание, ответом на Задание пока не 

оценённым Преподавателем, или Оценкой, которая вручную была удалена 

Администратором из Журнала Оценок. Поэтому рекомендуется быть осторожным при 

интерпретации этих «empty grades (пустых оценок)». 

Агрегировать, включая подКатегории 
Агрегация обычно выполняется только с непосредственными «дочерними 

подКатегориями», но можно также Агрегировать Оценки во всех подКатегориях, 

исключая их Агрегированные Оценки. 

Включить Показатели в Агрегацию  
Включение Показателей в Агрегацию может не привести к желаемой 

Общей Оценке, так что вы можете включать эту опцию или нет. 

Отбросить низшие 
Если эта опция установлена, будет отброшено Х низших Оценок, Х – выбранное 

для этой опции значение. 

Замечание: Вы можете использовать либо только эту опцию, либо следующую 

«Keep Highest (сохранить наивысшие)». Если вы установите обе опции, внутри Категорий 

Курса будет применена только данная «Отбросить низшие». 

Сохранить высшие 
Если эта опция установлена, останется только Х высших Оценок, Х – выбранное 

для этой опции значение. 

Замечание. Если в опции «Отбросить низшие» установлено число, отличное от 0, 

тогда данная опция работать не будет. 

Родительская Категория – Вес Элемента 
Если ваш Курс настроен на использование взвешенных средних Оценок, вы 

можете назначить Вес, который будет иметь каждая из Оценок этой Категории.

http://docs.moodle.org/25/en/Category_aggregation
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Within all of the subcategories of the parent category, the weight values do 

not need to add up to 100. 

Aggregation view 
Each category can be displayed in three ways: Full mode (aggregated 

column and grade item columns), the aggregated column only, or the grade 

items alone. 

 

See also 
 Grade items. 

 Edit categories and items. 

 Grade category settings for administrators. 

 Video showing the effects of the grade category settings 

4.9.1.3.3.Grade calculations 
A grade calculation is a formula used to determine grades, based 

(optionally) on other grade items. Note that this is not the same as 

Calculated question types. 

Calculations for the gradebook follow the pattern of formulas/functions in 

popular spreadsheet programs. They start with an equal (=) sign, and use 

common mathematical operators and functions to produce a single 

numerical output. This output is then used as the computed value for the 

grade item you are editing. 

Setting a grade calculation 
To set a grade calculation: 

1. Login as teacher or other user with permission to edit grades 

 

2. Click on Grades in the course administration block 

3. Click the 'Categories and items' tab (or select it from the gradebook 

dropdown menu) 

4. Click the 'calculator symbol' (in the 'Actions' column, on the category 

total line) for the category you wish to set a calculation for 

5. Start with an equal sign (=) 

6. Choose a function; Example: =sum() 

7. Plug in your ID numbers enclosed in double square brackets, for 

example =sum([[item1]][[item2]][[item3]]) 

8. Separate each ID number with a comma, for example 

=sum([[item1]],[[item2]],[[item3]]) 

9. Click the "Save Changes" button. 

 

 

Внутри всех подКатегорий родительской Категории нет необходимости значения весов 

дополнять до 100. 

Вид отображения Агрегации 
Каждая Категория может быть отображена тремя способами. «Full mode (полный 

режим) – (агрегированная колонка и колонки элементов оценивания)», «Aggregated column 

only (только агрегированная колонка)» или «Grade items alone (элементы оценивания по 

отдельности)». 

См. также 

 Элементы Оценивания – п. 4.9.1.3.1. 

 Редактировать Категории и Элементы – п. 4.9.1.3.2. 

 Настройки Категории Оценок для Администраторов – п. 4.9.1. 

 Видео, показывающее эффекты настроек Категории Оценок. 

4.9.1.3.3.Вычисление Оценок 
Вычисление Оценки – это Формула, используемая для определения Оценок, 

основанная (по выбору) на различных Элементах Оценивания. Заметьте, что это не то же 

самое, что Типы Вычисляемых Вопросов (п. 4.6.1). 

Вычисления для Журнала Оценок ведутся в соответствии с шаблонами 

формул/функций популярных программ электронных таблиц. Они начинаются со знака 

равенства (=) и используют общематематические операции и функции, чтобы образовать 

единственный числовой результат. Этот результат затем используется как вычисленное 

значение для Элемента Оценивания, который вы редактируете. 

Настройка вычисления Оценок 
Чтобы настроить вычисление Оценок: 

1. Зарегистрируйтесь как Преподаватель или другой пользователь с полномочиями 

редактирования Оценок. 

2. Щёлкните по Grades в блоке «Course administration». 

3. Щёлкните таблицу «Categories and items» (или выберите это в ниспадающем меню 

Журнала Оценок). 

4. Щёлкните по «Calculator symbol (символ калькулятора )» (в колонке «Actions 

(действия)» строки Итоговой Категории) той Категории, для которой вы желаете 

настроить вычисления. 

5. Начните со знака равенства (=). 

6. Выберите функцию, например, =sum( ). 

7. Занесите ваши идентификационные номера, заключённые в двойные квадратные 

скобки, например, =sum([[item1]][[item2]][[item3]]). 

8. Отделите каждый идентификационный номер запятой, например, 

=sum([[item1]],[[item2]],[[item3]]). 

9. Щёлкните по кнопке «Save Changes». 

http://docs.moodle.org/25/en/Calculated_question_type
http://www.youtube.com/watch?v=sUslTuZPu6A
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Assigning ID numbers 
You can include the values of other grade items by using their ID number 

as references in your formulas. 

The ID number is surrounded by double square brackets, for example if 

you have a grade item with Quiz.3 as ID number, you will refer to this item 

as [[Quiz.3]] in your calculation. 

Below the calculation field is a list of your course with its grade 

categories and grade items. Next to each item or category's total is 

displayed the ID number you can use in your calculation (already 

surrounded with double square brackets). However, since the ID number is 

optional, some items may not yet have one. These items without an ID 

number have instead a form field which lets you enter an ID number 

directly. 

As soon as you have assigned the ID numbers you need, you can click the 

"Add ID numbers" button, and the page will reload and show you the same 

list with the ID numbers you have just assigned. 

Calculation functions 
Every calculation must start with an equal sign (=). Following is a list of 

the functions supported by the calculation. The comma (,) character is used 

to separate arguments within function brackets. The comma can also be 

used to separate different functions. (The separator character could be a 

semicolon (;) in other languages, see below). 

 average([[item1]], [[item2]]...): Returns the average of a sample 

 max([[item1]], [[item2]]...): Returns the maximum value in a list of 

arguments 

 min([[item1]], [[item2]]...): Returns the minimum value in a list of 

arguments 

 mod(dividend, divisor): Calculates the remainder of a division 

 pi(): Returns the value of the number Pi 

 power(base, power): Raises a number to the power of another 

 round(number, count): Rounds a number to a predefined accuracy 

 sum([[item1]], [[item2]]...): Returns the sum of all arguments 

 an asterisk (*) gives the product of two items: [[item1]]*[[item2]] 

A number of mathematical functions is also supported: 

 sin 

 sinh 

 arcsin 

 asin 

 arcsinh 

Назначение Идентификационных Номеров 
Вы можете включить в ваши Формулы значения других Элементов Оценивания, 

используя их Идентификационные Номера в качестве ссылок. 

Идентификационный Номер заключается в двойные квадратные скобки, например, 

если у вас есть Элемент Оценивания с идентификатором Quiz.3, вы ссылайтесь на него как 

[[Quiz.3]] в вашем вычислении. 

Ниже поля вычислений есть список вашего Курса с его Категориями Оценок и 

Элементами Оценивания. Рядом с каждым Элементом или Итогом по Категории 

отображается Идентификационный Номер, который вы можете использовать в вашем 

вычислении (уже заключённый в двойные квадратные скобки). Однако, поскольку 

Идентификационный Номер необязателен, некоторые Элементы Оценивания могут не  

иметь его. Такие элементы без Идентификационного Номера имеют вместо него поле, 

куда вы можете ввести Идентификационный Номер непосредственно. 

Как только вы назначили нужный Идентификационный Номер, вы можете 

щёлкнуть по кнопке «Add ID numbers», страница редактирования перезагрузится и 

покажет тот же список, но уже с назначенными вами Идентификационными Номерами. 

Функции вычислений 

Каждое вычисление должно начинаться со знака (=), за которым следует список 

функций для вычисления. Запятая (,) используется для разделения аргументов внутри 

квадратных скобок функции. Запятая также может быть использована для разделения 

различных функций. (Разделителем может служить точка с запятой (;) в других языках, 

см. ниже). 

 average([[item1]], [[item2]]...) – выдаёт среднее по выборке. 

 max([[item1]], [[item2]]...) – выдаёт максимальное значение в списке аргументов. 

 

 min([[item1]], [[item2]]...) – выдаёт минимальное значение в списке аргументов. 

 

 mod(dividend, divisor) – вычисляет остаток от деления. 

 pi() – выдаёт значение числа Пи. 

 power(base, power) – возводит основание base в степень power. 

 round(number, count) – округляет число number до указанной точности count. 

 sum([[item1]], [[item2]]...) – выдаёт сумму всех аргументов. 

 an asterisk (*) – даёт произведение двух элементов: [[item1]]*[[item2]]. 

Поддерживается также ряд математических функций: 

 sin 

 sinh 

 arcsin 

 asin 

 arcsinh 
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 asinh 

 cos 

 cosh 

 arccos 

 acos 

 arccosh 

 acosh 

 tan 

 tanh 

 arctan 

 atan 

 arctanh 

 atanh 

 sqrt 

 abs 

 ln 

 log 

 exp 

Example calculations 
=average([[Quiz.1]], [[Quiz.4]], [[Assignment.1]]) 

=average(max([[Quiz.1]], [[Quiz.4]], [[Assignment.1]]), min([[Quiz.1]], 

[[Quiz.4]], [[Assignment.1]])) 

Weighted grade calculations where item 1 is weighted 30%, item 2 is 

weighted at 60% and item 3 is weighted at 200%: 

=sum([[1]]*0.3,[[2]]*0.6,[[3]]*2) 

Calculations when user language is not English 

Calculation formulas use decimal and list separators as defined in each 

language pack. 

The decimal separator (a symbol used to mark the boundary between the 

integral and the fractional parts of a decimal number) is a point (.) in 

English. In other languages it may be a comma (,). 

The list separator (a symbol used to separate a list of ID numbers in square 

brackets) is a comma (,) in English. In other languages it may be a 

semicolon (;). 

4.9.1.4. Scales 
Scales are a way of evaluating or rating a students' performance. Moodle 

offers a standard set of numeric scales. It is also possible to create custom 

scales which can be available on the site. For example, 

 asinh 

 cos 

 cosh 

 arccos 

 acos 

 arccosh 

 acosh 

 tan 

 tanh 

 arctan 

 atan 

 arctanh 

 atanh 

 sqrt 

 abs 

 ln 

 log 

 exp 

Примеры вычислений 

=average([[Quiz.1]], [[Quiz.4]], [[Assignment.1]]). 

=average(max([[Quiz.1]], [[Quiz.4]], [[Assignment.1]]), min([[Quiz.1]], [[Quiz.4]], 

[[Assignment.1]])). 

Вычисления взвешенных оценок (с учётом весовых коэффициентов), если элемент 

1 имеет весовой коэффициент 30%, элемент 2 – 60%, а элемент 3 – 200%: 

=sum([[1]]*0.3,[[2]]*0.6,[[3]]*2). 

Вычисления, когда язык пользователя не английский 
Формулы вычислений используют разделители в десятичной дроби и списке, как 

определено в каждом языковом пакете (language pack). 

Десятичный разделитель (символ, используемый для отметки границы между 

целой и дробной частями десятичного числа) есть точка (.) в английском. В других языках 

это может быть запятая (,). 

Разделитель списка (символ, используемый для отделения идентификаторов, 

заключённых в двойные квадратные скобки [[ ]]) есть запятая (,) в английском. В других 

языках это может быть точка с запятой (;). 

4.9.1.4.Шкалы 
Шкалы являются способом вычисления или ранжирования выполненной 

Студентами работы. Moodle предлагает стандартный набор Числовых Шкал. Имеется 

также возможность создать привычные для клиента Шкалы на уровне Сайта. Например,  
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you can give the student a word or small phrase as a way of rating or 

giving a student feedback. 

Scales may be used in Forums, Glossaries and Assignments for rating 

and/or grading a student's activity. 

4.9.1.4.1.Standard scales 
Moodle includes 100 different numeric scales which can not be edited, and 

one non-numeric example. 

Numeric 
Moodle includes numeric scales that range from a maximum of 100 to a 

minimum of 1. For example, selecting a scale of 10, will allow a rating on 

a scale between 10 and 1. Numeric scales can be calculated as a grade. 

 

4.9.1.4.2.Creating a new scale 
New scales can be created by teachers with editing rights or by 

administrators or by any user with the manage scales role capability. 

Creating course scales 
 Click the "Add a new scale" button in Settings > Grade administration > 

Scales or via the gradebook Scales tab. 

 

 On the next page give your scale a name in the Name box (highlighted 

in red in the screenshot) that will identify it among other scales. 

 In the Scale box (highlighted in green), create your scale. Each item in 

the scale should be separated by a comma. You can use as many options 

here as you require. You must order the comma separated elements in 

increasing order of value. For example, an A,B,C,D scale must be 

entered as D,C,B,A. 

 Write a detailed description in the Description box (highlighted in blue) 

for your scale. Your students will have access to the description, and 

you can use this to give them additional feedback. 

The more details you put in the description, the more students will 

understand what each scale item means. 

Creating a standard scale 
An administrator can create a standard scale which can be used in any 

course in Settings > Site administration > Grades > Scales. 

4.9.1.4.3.Using a scale 
First the teacher needs to assign a specific scale to the activity using a drop 

down menu in the activities setting. Then the teacher and/or students can 

rate 

вы можете передать Студенту слово или краткую фразу в качестве способа ранжирования 

или передачи Обратной Связи Студенту. 

Шкалы могут быть использованы в Форумах, Глоссариях и Заданиях для 

ранжирования и/или оценивания деятельности Студента. 

4.9.1.4.1.Стандартные Шкалы 
Moodle включает 100 различных Числовых Шкал, которые не могут быть 

отредактированы, и один пример нечисловой Шкалы. 

Числовые Шкалы 
Moodle включает Числовые Шкалы, область значений которых изменяется от 

максимального 100 до минимального 1. Например, выбирая Шкалу из 10 элементов, вы 

определяете Рейтинг по Шкале от 10 до 1. Числовые Шкалы можно использовать для 

вычисления Оценки. 

4.9.1.4.2.Создание новой Шкалы  
Новые Шкалы могут быть созданы Преподавателями или Администраторами, или 

любым пользователем, роль которого имеет полномочия управлять Шкалами. 

Создание Шкал Курса 
 Щёлкните кнопку «Add a new scale (Добавь новую Шкалу)» в 

AdministrationGrade administrationScales или через ярлычок Scales 

Журнала Оценок. 

 На следующей странице в окошке Name (с красной подсветкой на экране) задайте своей 

Шкале название, которое будет идентифицировать её среди других Шкал. 

 В окошке Scale (подсвеченном зелёным) создайте свою Шкалу. Каждый элемент в 

Шкале должен быть отделён запятой. Здесь вы можете использовать столько опций, 

сколько потребуется. Вы должны упорядочить разделяемые запятыми элементы в 

порядке возрастания их значений. Так, например, Шкала A,B,C,D должна быть введена 

как D,C,B,A. 

 Напишите подробное описание в окошке «Description» (с синей подсветкой) для вашей 

Шкалы. Ваши Студенты будут иметь доступ к этому описанию, а вы можете 

использовать его, чтобы дать им дополнительную Обратную Связь. 

Чем больше деталей вы сообщите в этом описании, тем лучше Студенты поймут, что 

означает каждый элемент Шкалы. 

Создание Стандартной Шкалы 
Администратор может создать Стандартную Шкалу, которая может быть 

использована в любом Курсе, в AdministrationSite administrationGradesScales. 

4.9.1.4.3.Использование Шкалы 
Сначала Преподавателю нужно назначить конкретную Шкалу 

Интерактивному Действию, используя ниспадающее меню в настройке этого 

Интерактивного Действия. Затем Преподаватель и/или Студенты могут оценить 

http://docs.moodle.org/24/en/File:moodle19_scales_edit.jpg
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an activity element (for example, a post in a forum) with the pre-defined 

scale. 

4.9.1.4.4.Editing a scale 
If a scale has not yet been used, you will see an edit, move, and delete icon 

in the edit column. Once a scale is used for an activity, it is no longer 

possible to move or delete it, and you can only edit the scale name and 

description. 

4.9.1.4.5.Example scales 
The Cool Scale - Not cool, Not very cool, Fairly cool, Cool, Very cool, 

The coolest thing ever! 

 (Valued as 0/5pts, 1/5pt, 2/5pts, 3/5pts, 4/5pts, and 5/5pts respectively 

in any normalized aggregation method) 

 (Valued as 1, 2, 3, 4, 5, and 6 respectively in the sum aggregation 

method) 

General Introductions (The Affirmative Scale) - Welcome!, Glad to have 

you here!, Great post! 

 (Valued as 0/2pts, 1/2pt, and 2/2pts respectively in any normalized 

aggregation method) 

 (Valued as 1, 2, and 3 respectively in the sum aggregation method) 

If you would like two options in your scale (incomplete and complete) type 

"incomplete, complete" in the scale box. 

 (Valued as 0/1pts and 1/1pt respectively in any normalized aggregation 

method like weighted mean, mean, simple weighted mean, etc.). 

 (Valued as 1 and 2 respectively in the sum aggregation method) 

Generic Social Forum (This scale only worked prior to the averaging 

function) - Please clarify., I don’t understand., Hmmm. Tell me more., 

Interesting, Very cool., Awesome! 

 (Valued as 0/6pts, 1/6pt, 2/6pts, 3/6pts, 4/6pts, 5/6pts, and 6/6pts 

respectively in any normalizedaggregation method) 

 (Valued as 1, 2, 3, 4, 5, 6, and 7 respectively in the sum aggregation 

method) "Refer", pass, merit, distinction 

 

 (Valued as 0/2pts, 1/2pt, and 2/2pts respectively in any normalized 

aggregation method) 

 (Valued as 1, 2, and 3 respectively in the sum aggregation method) 

"Hesitant", Fail, Acceptable, Average, Excellent 

 (Valued as 0/3pts, 1/3pt, 2/3pts, and 3/3pts respectively in any 

normalized aggregation method) 

 (Valued as 1, 2, 3, and 4 respectively in the sum aggregation method) 

элемент этого Интерактивного Действия (например, корреспонденции на Форуме) по этой 

заранее определённой Шкале.  

4.9.1.4.4.Редактирование Шкалы 
Если Шкала ещё не была использована, вы увидите иконки для редактирования,  

перемещения и удаления в колонке редактирования. Если Шкала была хоть раз применена 

для Интерактивного Действия, вы не сможете перемещать или удалять её, можете только 

отредактировать название и описание такой Шкалы. 

4.9.1.4.5.Примеры Шкал 
Шкала качества – Не хорошо, не очень хорошо, довольно хорошо, хорошо, очень 

хорошо, лучше не бывает! 

 (Оценено как 0/5 целого, 1/5 целого, 2/5 целого, 3/5 целого, 4/5 целого, 5/5 целого в 

указанном порядке в любом Нормированном Методе Агрегации) 

 (Оценено как 1, 2, 3, 4, 5 и 6 соответственно в Методе Агрегации Суммированием) 

 

Начальное знакомство (Позитивная Шкала) – Добро пожаловать!, Рад вашему 

появлению!, Ваше послание замечательно! 

  (Оценено как 0/2, 1/2, 2/2 целого в указанном порядке в любом 

Нормированном Методе Агрегации). 

 (Оценено как 1, 2 и 3 в указанном порядке в Методе Агрегации Суммированием). 

Если вы предпочитаете иметь две опции в вашей Шкале (зачтено, не зачтено), 

введите «incomplete, complete» (не завершено, завершено) в окошко «Scale».  

 (Оценено как 0/1, 1/1 целого в указанном порядке в любом 

Нормированном Методе Агрегации). 

 (Оценено как 1, и 2 в указанном порядке в Методе Агрегации Суммированием). 

Типичный Социальный Форум (эта Шкала раньше работала только с функцией 

усреднения) – Пожалуйста, поясните, Я не понял, Хммм, Расскажите побольше, 

Интересно, Очень круто, Потрясающе! 

 (Оценено как 0/6, 1/6, 2/6, 3/6, 4/6, 5/6, 6/6 целого в указанном порядке в любом 

Нормированном Методе Агрегации) 

 (Оценено как 1, 2, 3, 4, 5, 6 и 7 в указанном порядке в 

Методе Агрегации Суммированием) «Отослать на пересдачу», удовлетворительно, 

хорошо, отлично 

 (Оценено как 0/2, 1/2, 2/2 целого в указанном порядке в любом 

Нормированном Методе Агрегации) 

 (Оценено как 1, 2 и 3 в указанном порядке в  Методе Агрегации Суммированием) 

«Сомневаюсь, трудно оценить», неудовлетворительно, приемлемо, средне, великолепно 

 (Оценено как 0/3, 1/3, 2/3, 3/3 целого в указанном порядке в любом 

Нормированном Методе Агрегации) 

 (Оценено как 1, 2, 3 и 4 в указанном порядке в Методе Агрегации Суммированием). 
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"Stars" ☆----, ☆☆---, ☆☆☆--, ☆☆☆☆-, ☆☆☆☆☆ 

  (Valued as 0/4pts, 1/4pt, 2/4pts, 3/4pts, and 4/4pts respectively in any 

normalized aggregation method) 

 (Valued as 1, 2, 3, 4, and 5 respectively in the sum aggregation method)  

4.9.1.4.6.Values calculated as percentage scores 
 
Moodle uses the last entry to determine the number of points in the scale 

for computing percentages. For example, if your scale is 0,5,6,7,8,9,10 

then Moodle will use a 0-6 or 1-7 point scale depending on your chosen 

aggregation method. 

When using a normalized aggregation method, 0 will become 0/6, 5 will 

become 1/6, 6 will become 2/6, 7 will become 3/6, 8 will become 4/6, 9 

will become 5/6, and 10 will become 6/6 for grade computation, 

respectively. 

When using the sum aggregation method, 0 will become 1, 5 will become 

2, 6 will become 3, 7 will become 4, 8 will become 5, 9 will become 6, and 

10 will become 7. 

Either way, the numbers you enter for your scale are NOT calculated as 

entered, the system calculates the number of non-zero entries and then 

creates a scale from 0 to the total number of entries (n) with their values 

calculates as 0/n, 1/n, 2/n, 3/n.... 

TIP: If your scale is a custom non-value (not a number), Moodle's behavior 

in combining or averaging the scores into a percentage value is 

unpredictable. When an average or aggregate is important, then it is a good 

idea to stick with the standard 100% scale to compute an overall grade. 

Tip: Some sites do not like the "0" (zero) in any normalized aggregation 

method. 

4.9.1.4.7.Scales capabilities 
View scales 

Moodle/course:viewscales 

 This allows a user to view scales used in a course 

 This capability is allowed for the default roles of manager, teacher, non-

editing teacher and student 

Manage scales 
Moodle/course:managescales 

 This allows a user to add/update/delete scales in Settings > Course > 

Grade administration > Scales or via the gradebook Scales tab (or for a 

manager in Settings > Site administration > Grades > Scales) 

«Звёзды» ☆----, ☆☆---, ☆☆☆--, ☆☆☆☆-, ☆☆☆☆☆ 

 (Оценено как 0/4, 1/4, 2/4, 3/4, 4/4 целого в указанном порядке в любом 

Нормированном Методе Агрегации) 

 (Оценено как 1, 2, 3, 4 и 5 в указанном порядке в Методе Агрегации Суммированием) 

4.9.1.4.6.Значения, вычисленные как 
Накопленные Баллы в Процентах 

Moodle использует последнюю запись, чтобы определить число делений Шкалы 

для вычисления процентов. Например, если ваша Шкала имеет семь делений: 0, 5, 6, 7, 8, 

9, 10, тогда Moodle будет использовать Шкалу делений 0-6 или 1-7, в зависимости от того, 

какой выбран метод Агрегации. 

Когда используется Нормированный Метод Агрегации, тогда 0 станет 0/6, 5 

станет 1/6, 6 станет 2/6, 7 станет 3/6, 8 станет 4/6, 9 станет 5/6 и 10 станет 6/6 при 

вычисления Оценки. 

 

Когда используется Методе Агрегации Суммированием, 0 станет 1, 5 станет 2, 6 

станет 3, 7 станет 4, 8 станет 5, 9 станет 6 и 10 станет 7. 

 

В любом случае, числа, которые вы вводите в вашу Шкалу, НЕ вычисляемы в 

том виде, в котором введены. Система сначала подсчитывает число ненулевых записей в 

Шкале, а затем создаёт Шкалу от 0 до общего числа элементов (n) со своими 

вычислениями значений, как 0/n, 1/n , 2/n, 3/n… 

Совет. Если привычная вам Шкала не из значений (не числовая), поведение 

Moodle по комбинированию или усреднению её элементов в значения в процентах не 

предсказуемо. Когда Среднее или Агрегация важны, тогда лучше привязаться к 

стандартной 100% шкале, чтобы вычислить Общую Оценку. 

Совет. Некоторые Сайты не любят «0» (ноль) в любом 

Нормированном Методе Агрегации. 

4.9.1.4.7.Возможности Шкал 
Просматривать Шкалы 

Возможность moodle/course:viewscales 

 Позволяет пользователю просматривать Шкалы, используемые в Курсе. 

 Эта Возможность по умолчанию предоставлена таким Ролям, как Менеджер, 

Преподаватель, неРедактирующий Преподаватель и Студент. 

Управлять Шкалами 
Возможность moodle/course:managescales 

 Позволяет пользователю добавлять/обновлять/удалять Шкалы внутри Курса в 

AdministrationGrade administrationScales или через таблицу Scales Журнала 

Оценок( или для Менеджера в AdministrationSite AdministrationGradesScales). 
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 This capability is allowed for the default roles of manager and teacher 

 

4.9.1.4.8.See also 
 Outcomes 

 Ratings 

Using Moodle forum discussions: 
 Gradebook letter grade an item 

 Creating a new scale 

 Standard letter scale reversed for information on how to delete a scale 

4.9.1.5.Ratings 
It is possible to rate glossary entries, forum posts and database records 

within Moodle. These ratings are then aggregated to produce a grade for 

that activity for the student being rated. For example a student's forum 

posts may be rated by their fellow students with those ratings being 

averaged and that grade then contributing to the students overall course 

grade. You can choose whether ratings can be submitted by students and/or 

by teachers. 

4.9.1.5.1.Enabling ratings 
Here is the process to enable ratings within an activity: 

1. Go to the activity settings and select the aggregation method you want 

applied. Average is typically the most useful. 

2. Choose a scale. The scale you select determines the list of options raters 

can choose from. Choosing a number, 10 for example, means that raters 

can choose any number from 0 to 10. Custom non-numeric scales can 

also be defined. To create a site wide custom scale go to Settings > Site 

Administration > Grades > Scales. To create a course specific custom 

scale go to the gradebook and select "Scales - View". 

 

3. Optionally choose to restrict the submission of ratings to within a date 

range. 

4. Save your activity settings. 

Once ratings have been enabled within an activity that activity will 

automatically appear in the gradebook. 

4.9.1.5.2.Ajax 
 Ajax is an Internet technology that enables user input such as ratings to 

be sent back to the Moodle server without the whole page having to 

reload. It is recommended that you enable Ajax if possible as it allows 

you to submit ratings without having to wait for 

 Эта Возможность по умолчанию предоставлена таким Ролям, как Менеджер и 

Преподаватель. 

4.9.1.4.8.См. также 
 Показатели (п. 4.9.1.5). 

 Рейтинги. 

Обсуждения форума по использованию Moodle: 
 Элемент Оценивания буквами в Журнале Оценок: 

 Создание новой Шкалы. 

 Обратная Стандартная Буквенная Шкала для информации о том, как удалить Шкалу. 

4.9.1.5.Рейтинги 
Внутри Moodle можно ранжировать Записи Глоссария, Корреспонденции Форума, 

Записи Базы Данных. Эти Рейтинги затем Агрегируются, чтобы образовать Оценку для 

оцениваемого Студента за выполнениеим им этого Интерактивного Действия. Например, 

корреспонденции Студентов в Форуме могут быть ранжированы их коллегами 

Студентами с усреднением этих Рейтингов, а эта Оценка затем передаётся в 

Общую Оценку Студента за Курс. Вы можете выбрать, могут ли Рейтинги переданы на 

рассмотрение Студентами и/или Преподавателями. 

4.9.1.5.1.Позволение Рейтингов 
Вот процесс по позволению Рейтингов внутри Интерактивного Действия. 

1. Перейдите в настройки Интерактивного Действия и выберите метод Агрегации, 

который вы хотите применить. Обычно наиболее полезно Арифметическое Среднее. 

2. Выберите Шкалу. Шкала, которую вы выбираете, определяет список опций, из 

которого выбирают ранжирующие. Выбор числа 10, например, означает, что 

ранжирующие могут выбрать любое число от 0 до 10. Также могут быть определены 

привычные для клиента нецифровые Шкалы. Чтобы создать привычную для клиента 

Шкалу для всего Сайта, перейдите в AdministrationSite AdministrationGrades 

Scales. Чтобы создать специфическую привычную для клиента Шкалу для Курса 

перейдите в Журнал Оценок и выберите «Scales – View». 

3. При желании ограничьте передачу на рассмотрение Рейтингов временным интервалом. 

 

4. Сохраните ваши настройки Интерактивного Действия. 

После разрешения Рейтингов внутри Интерактивного Действия это 

Интерактивное Действие автоматически появится в Журнале Оценок. 

4.9.1.5.2.Ajax 
Ajax – это интернет-технология, которая разрешает пользователю ввести такие 

данные, как Рейтинги, которые должны быть отправлены обратно на сервер Moodle, без 

перезагрузки целой интернет страницы. Рекомендуется, чтобы вы подключили Ajax, если 

возможно, так как это позволит вам отправлять Рейтинги на рассмотрение без ожидания  

http://docs.moodle.org/24/en/Ratings
https://moodle.org/mod/forum/discuss.php?d=106031
https://moodle.org/mod/forum/discuss.php?d=142262
https://moodle.org/mod/forum/discuss.php?d=152689
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the page to reload every time you do so. If Ajax is disabled (or if the user's 

browser has JavaScript disabled) Moodle will automatically use the non-

Ajax ratings elements instead. 

To enable Ajax: 

1. Go to Settings > Site administration > Appearance > AJAX and 

JavaScript 

2. Check Enable AJAX and click save changes. 

4.9.1.5.3.Capabilities and roles 
Capabilities and roles determine whether a given user can submit ratings, 

view aggregated ratings or even view the individual ratings that have been 

submitted. By default students can view the aggregation of all rating on 

their own items and only teachers can rate items. 

 

The relevant capabilities are: 

 moodle/rating:view - allows the user to view aggregated ratings made 

on their own items 

 moodle/rating:viewany - allows the user to view aggregated ratings 

made on other people's items (but not their own) 

 moodle/rating:viewall - allows the user to see individual ratings 

 moodle/rating:rate - allows the user to rate other people's items 

Module capabilities 
Activity modules may define their own set of capabilities. When these 

exist the user needs BOTH the core capability and the module capability. 

 

Database 
 mod/data:rate 

 mod/data:viewrating 

 mod/data:viewanyrating 

 mod/data:viewallratings 

Forum 
 mod/forum:rate 

 mod/forum:viewrating 

 mod/forum:viewanyrating 

 mod/forum:viewallratings 

Glossary 
 mod/glossary:rate 

 mod/glossary:viewrating 

 mod/glossary:viewanyrating 

перезагрузки страницы каждый раз, когда вы это делаете. Если Ajax отключён (или если в 

браузере пользователя отключён JavaScript), Moodle автоматически использует не-Ajax 

элементы Рейтинга вместо него. 

Чтобы включить Ajax: 

1. Перейдите к AdministrationSite AdministrationAppearanceAJAX and JavaScript. 

 

2. Проверьте подключение Ajax и щёлкните Save changes. 

4.9.1.5.3.Возможности и Роли 
Возможности и Роли определяют, может ли данный пользователь передавать на 

рассмотрение Рейтинги, просматривать Агрегированные Рейтинги или даже 

просматривать отдельные Рейтинги, которые уже были переданы на рассмотрение. По 

умолчанию Студенты могут просматривать Агрегацию всех Рейтингов по их собственным 

Элементам, и только Преподаватели могут Ранжировать Элементы. 

Значимыми Возможностями являются: 

 moodle/rating:view – позволяет пользователю просматривать 

Агрегированные Рейтинги, сделанные по их собственным Элементам. 

 moodle/rating:viewany – позволяет пользователю просматривать 

Агрегированные Рейтинги по Элементам других людей (но не их собственным). 

 moodle/rating:viewall – позволяет пользователю видеть отдельные Рейтинги. 

 moodle/rating:rate – позволяет пользователю Ранжировать Элементы других людей. 

Возможности модуля 
Модули Интерактивных Действий могут определять их собственный набор 

Возможностей. Когда они есть, пользователю нужны ОБЕ Возможности: ядра системы и 

модуля. 

БазаДанных 
 mod/data:rate 

 mod/data:viewrating 

 mod/data:viewanyrating 

 mod/data:viewallratings 

Форум 
 mod/forum:rate 

 mod/forum:viewrating 

 mod/forum:viewanyrating 

 mod/forum:viewallratings 

Глоссарий 
 mod/glossary:rate 

 mod/glossary:viewrating 

 mod/glossary:viewanyrating 
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 mod/glossary:viewallratings 

4.9.1.5.4.See also 
 Scales. 

4.9.1.6.Outcomes 
Outcomes are specific descriptions of what a student has demonstrated and 

understood at the completion of an activity or course. Each outcome is 

rated by some sort of scale. Other terms for outcomes are Competencies 

and Goals. 

In simple terms outcomes are similar to sub components of a grade. A 

grade is an assessment of overall performance that may include tests, 

participation, attendance and projects. Outcomes assess specific levels of 

knowledge through a series of statements, that maybe coded with numbers 

or letters. Thus an overall grade can be given for a course, along with 

statements about specific competencies in the form of outcomes. 

4.9.1.6.1.Enabling outcomes 

1. Go to Site administration > Advanced features and ensure that Enable 

outcomes is checked (by default, it isn't). 

4.9.1.6.2.Using outcomes 

1. Choose or define some outcomes for your course (see below). 

2. For each activity, choose which of these outcomes apply using the 

tickbox in the activity's settings page. 

 

3. When grading that activity, grade each student using the Outcome 

scales. Note: You can also edit the grades in the Grader report (useful 

for modules that don't feature inbuilt grading). 

 

4. Use the outcomes as part of the assessment for students, or look at the 

Outcomes report for some useful feedback on how students in the class 

in general are performing. 

4.9.1.6.3.Outcomes report 
The outcomes report in Administration > Course administration > Grades 

> Outcomes report helps teachers monitor their students' progress using 

outcomes. It lists site-wide outcomes and custom outcomes used in the 

current course, their overall average (each outcome can be measured 

through many grade items). It will show the name, course and site wide 

average, the activity, the average values and the number of "grades" given. 

 

The outcomes report is a table with 6 columns: 

 

 mod/glossary:viewallratings 

4.9.1.5.4.См. также 
 Шкалы (п.4.9.1.4). 

4.9.1.6.Показатели 
Показатели являются специфическими описаниями того, что Студент 

продемонстрировал и понял по завершению какого-либо Интерактивного Действия или 

Курса. Каждый Показатель оценивается по Шкале какого-либо типа. Другие термины для 

Показателей – Компетенции, Цели. 

Проще говоря, Показатели подобны подКомпонентами Оценки. Оценка является 

мерилом общей результативности, которая может включать Тесты, посещаемость и 

участие в проектах. Показатели оценивают конкретные уровни знания посредством серии 

высказываний, которые могут быть закодированы числами или буквами. Таким образом, 

Общая Оценка может быть дана для Курса наряду с высказываниями о конкретных 

компетенциях в форме Показателей. 

4.9.1.6.1.Подключение Показателей 
1. Перейдите к AdministrationSite AdministrationAdvanced features и убедитесь, что 

«птичка» в окошке «Enable outcomes» установлена (по умолчанию её нет). 

4.9.1.6.2.Использование Показателей) 
1. Выберите или определите некоторые из Показателей для вашего Курса (см. ниже). 

2. Для каждого Интерактивного Действия выберите, какие из этих Показателей 

применять, проставив «галочки» в соответствующих окошках каждой из страниц 

настроек Интерактивных Действий. 

3. При оценивании этого Интерактивного Действия оценивайте каждого Студента, 

используя Шкалы Показателей. Замечание. Вы можете также редактировать Оценки в 

Отчёте Оценивающего (полезно для модулей, не имеющих встроенных средств 

оценивания). 

4. Используйте Показатели как часть оценивания Студентов или просматривайте в 

Отчёте по Показателям некоторую полезную Обратную Связь о том, как Студенты в 

классе работали в целом. 

4.9.1.6.3.Отчёт по Показателям 
Отчёт по Показателям помогает Преподавателю отслеживать ход обучения своих 

(AdministrationCourse administrationGradesOutcomes report) Студентов, используя 

Показатели. Он содержит список Показателей и привычных для клиента Показателей для 

всего Сайта и используемых в текущем Курсе, их Общее Среднее (каждый Показатель 

может быть измерен по многим Элементам Оценивания). Отчёт покажет название 

Показателя, Курс и Среднее по Сайту, каждому из Интерактивных Действий, каждому из 

Средних Значений и число проставленных «оценок». 

Отчёт по Показателям состоит из 6 колонок: 
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 Short name - the short name of the outcome used in this course. 

 Course average - shows two values representing the average scores 

given to students for each outcome used in this course. 

  

 Site-wide - Whether the outcome is a site-wide outcome or not. 

 Activities - This lists the activities that use this outcome in this course. 

A new row is created for each activity, and the activity name is linked 

to the activity's page. 

 Average - the average score for each activity using the outcome in this 

course. 

 Number of Grades - The number of grades given to students for each 

activity using the outcome. 

4.9.1.6.4.Outcomes used in course 

Outcomes may be set at site and/or course level. To choose outcomes for 

use in your course: 

 View available standard outcomes in Administration> Course 

administration > Outcomes or via the gradebook Outcomes tab 

 Add outcomes from the standard available list (right side), and use the 

left-facing arrow button to add them to outcomes used list (left side). 

Multiple outcomes may be selected by holding down the Ctrl key whilst 

clicking on the individual outcomes. 

 

4.9.1.6.5.Adding course-level outcomes 
To add a course-level outcome: 

 Click the 'Edit outcomes' link in Administration > Course 

administration > Outcomes 

 Click the 'Add a new outcome' button. 

 Complete the form then click the 'Save changes' button. 

4.9.1.6.6.Adding standard outcomes 
An administrator can add standard outcomes, which are available site-

wide, in Administration > Site administration > Grades > Outcomes. 

Multiple standard outcomes can be added using the import outcomes 

functionality (see below). 

4.9.1.6.7.Exporting outcomes 
Outcomes (and their associated scales) can be exported by clicking the 

"Export all outcomes" button. This will send a file (in .csv format) that can 

be read by Excel, OpenOffice.org or by any text editor. 

 Short name – краткое название Показателя, используемое в этом Курсе. 

 Course average – показывает два значения, представляющие средние накопленные 

баллы (average scores), выставленные Студентам по каждому Показателю, 

используемого в этом Курсе. 

 Site-wide – показывает, относится ли Показатель ко всему Сайту или нет. 

 Activities – здесь перечислены все Интерактивные Действия, которые используют этот 

Показатель в этом Курсе. Для каждого Интерактивного Действия создаётся новая 

строка, а имя Интерактивного Действия служит ссылкой на его страницу. 

 Average – Среднее по Накопленным Баллам для каждого Интерактивного Действия, 

использующего этот Показатель в данном Курсе. 

 Number of Grades – Число Оценок, проставленных Студентам по каждому 

Интерактивному Действию, использующему этот Показатель. 

4.9.1.6.4.Показатели, используемые в Курсе 
Показатели могут быть установлены на уровне Сайта и/или Курса. Здесь вы 

можете выбрать Показатели для использования в вашем Курсе: 

 Просмотрите доступные Стандартные Показатели в AdministrationCourse 

administrationOutcomes или через таблицу Outcomes Журнала Оценок. 

 Добавьте Показатели из Доступного Стандартного Списка (правая сторона таблицы) и, 

используя кнопку со стрелкой «влево», добавьте их в 

Список Используемых Показателей (левая сторона). Можно выбрать сразу несколько 

Показателей, удерживая нажатой клавишу Ctrl, пока щёлкаете по отдельным 

Показателям. 

4.9.1.6.5.Добавление Показателей на уровень Курса 
Чтобы добавить Показатель на уровень Курса: 

 Выберите ссылку «Edit outcomes (редактировать Показатели)» в 

AdministrationCourse administrationOutcomes. 

 Щёлкните по «Add a new outcome (добавить новый Показатель)». 

 Заполните форму и затем щёлкните по кнопке «Save changes». 

4.9.1.6.6.Добавление Стандартных Показателей 
Администратор может добавить Стандартные Показатели, которые доступны по 

всему Сайту в AdministrationSite AdministrationGradesOutcomes. Несколько 

Стандартных Показателей может быть добавлено применением функции импорта 

Показателей (см. ниже). 

4.9.1.6.7.Экспорт Показателей 
Показатели (и связанные с ними Шкалы) могут быть экспортированы щелчком по 

кнопке «Export all outcomes (экспортировать все Показатели)». Это вызовет отправку 

файла (в формате .csv), который может быть прочитан Excel, OpenOffice.org или любым 

текстовым редактором. 
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4.9.1.6.8.Importing outcomes 

Outcomes (and associated scales) may be imported by submitting a csv 

file. The format should be as follows: 
outcome_name;outcome_shortname;outcome_description;scale_name;scale_items

;scale_description 

Here is an example: 
Participation;participation;;Participation scale;"Little or no participation, 

Satisfactory participation, Full participation"; 

To import outcomes: 

 Click the 'Import outcomes' link in Administration > Course 

administration > Outcomes 

 Choose 'Import as custom outcomes (only this course)' or 'Import as 

standard outcomes' as required 

 

 Upload the csv file 

Note that while importing: 

 Existing outcomes and scale will be used if available (no overwriting is 

done by the script) 

 The script will stop if it detects that the file contains invalid data 

4.9.1.6.9.Removing selected outcomes for 
activities 

Previously selected outcomes are greyed out on the update activity page, 

however they can be removed via the gradebook on the categories and 

items page. They will appear in the list either below or above the activity 

they have been enabled in and will have the same icon as that activity.  

 

Note that if you have renamed the outcome since you assigned it to the 

activity, the orginal name will be displayed. Deleting the outcomes from 

this list will result in 

4.9.1.6.8.Импорт Показателей 

Показатели (и связанные с ними Шкалы) могут быть импортированы передачей на 

рассмотрение файла csv. Структура файла должна быть следующей: 
имя_показателя;краткое_имя_показателя;описание_показателя;имя_шкалы;элементы_шкалы;опи 

 

Вот пример: 
Участие;Участие;;Шкала участия;«Участие недостаточно или отсутствует, удовлетворительное 

участие, полное участие»; 

Чтобы импортировать Показатели: 

 Щёлкните ссылку «Import outcomes (импортировать Показатели)», в 

AdministrationCourse administrationOutcomes. 

 Выберите «Import as custom outcomes (only this course) (импортировать в качестве 

привычных для клиента Показателей (только для этого Курса))» или «Import as standard 

outcomes (импортировать в качестве Стандартных Показателей (для всего Сайта))». 

 Загрузите .csv-файл. 

Заметьте, что пока идёт импортирование: 

 Будут использоваться существующие Показатели и Шкала, если доступны (перезапись 

не сделана Script [сценарием]). 

 Сценарий остановится, если он обнаружит, что этот файл содержит неверные данные. 

4.9.1.6.9.Удаление выбранных Показателей для 
Интерактивных Действий 

Предварительно отобранные Показатели подсвечиваются серым цветом на 

Странице Обновления Интерактивного Действия, однако, они могут быть удалены через 

Журнал Оценок по Категориям и страницу «Categories and items (категории и элементы)». 

Они либо появятся в списке ниже, либо выше Интерактивного Действия, где они были 

разрешены, и будут иметь туже самую иконку, что и это Интерактивное Действие. 

Заметьте, что если вы переименовали этот Показатель после того, как вы его назначили 

этому Интерактивному Действию, отображаться будет первоначальное название. 

Удаление Показателей из этого списка приведёт к тому, что на 

Field name Description Required Format 

outcome_name The full name of the outcome Yes String 

outcome_shortname The short name of the outcome Yes String 

outcome_description The description of the outcome No String 

scale_name The name of the scale used Yes String 

scale_items 
A comma-separated list of scale 

items 
Yes String 

scale_description The description of the scale No String 

Название поля Описание Обязательно Формат 

Имя Показателя Полное название 

Показателя 

Да Строка 

Краткое название Показателя Краткое название 

Показателя 

Да Строка 

Описание Показателя Описание показателя Нет Строка 

Наименование шкалы Название используемой 

шкалы 

Да Строка 

Элементы Шкалы Список элементов 

Шкалы через запятую 

Да Строка 

Описание Шкалы Описание Шкалы Нет Строка 
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the outcomes being deselected on the update activity page. 

4.9.1.6.10.Outcomes capabilities 
View the outcomes report 
Capabilities/gradereport/outcomes:view 
 This allows a user to view the outcomes report. 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Manage grade outcomes 
Capabilities/moodle/grade:manageoutcomes 
 This allows a user to add outcomes either at course level in Settings > 

Course administration > Outcomes or for managers at site level in 

Settings > Site administration > Grades > Outcomes 

 This capability is allowed for the default roles of manager and teacher 

4.9.1.6.11.See also 
Example: British Higher National Diplomas 
 
We run British HE qualifications called Higher National Diplomas, 

awarded by Edexcel / BTEC. 

 

 

 

 

 
 

The qualification has 16 units (classes) and each unit has defined 

Outcomes/Assessment criteria - see the Outcomes attachment that I posted 

here... 

http://moodle.org/mod/forum/discuss.php?d=63577 (same post but with an 

attachment) for an example. 

There are almost always 4 outcomes in these units, and each outcome has 

3-7 assessment criteria. 

For a student to "pass" a unit, he must produce evidence for ALL 

assessment criteria. The teacher is responsible to create a number of 

assignments (we recommend 3), each of which will cover a subset of the 

total assessment criteria for the unit. All together, the assignments for the 

unit will (must!) provide the opportunity to cover all assessment criteria - 

and depending on the unit and assignment structure, some assessment 

critera may be covered multiple times. 

странице обновления этого Интерактивного Действия Показатели станут невыбираемыми. 

4.9.1.6.10.Возможности Показателей 
Просмотреть Отчёт по Показателям 

Возможность Capabilities/gradereport/outcomes:view 
 Позволяет пользователю просматривать Отчёт по Показателям. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Управлять Показателями Оценок 
Возможность Capabilities/moodle/grade:manageoutcomes 

 Позволяет пользователю добавлять Показатели либо на уровень Курса в 

AdministrationCourse administrationOutcomes, либо на уровень Сайта в 

AdministrationSite AdministrationGradesOutcomes. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

4.9.1.6.11.См. также 
Пример: Британские государственные дипломы о высшем 
образовании 

Мы осуществляем оформление британских аттестатов, называемых Высшими 

национальными дипломами и выдаваемых Edexcel/BTEC – компанией Edexcel и/или 

Советом делового и технологического образования. 
(Из Wikipedia: Edexcel [от англ. слов «educational – образовательный» и 

«excellence – совершенство»] – одна из пяти основных экзаменационных 

комиссий Англии, Уэльса и северной Ирландии, входящая в крупнейшую в мире 

компанию образовательных технологий и публикаций. Edexcel/BTEC предлагает 

профессиональное образование и квалификации уровня BTEC). 
Квалификация имеет 16 разделов (классов), и каждый раздел имеет определённые 

Показатели/Критерии оценивания, см. присоединение Показателей. Которые я привёл 

здесь… 

http://moodle.org/mod/forum/discuss.php?d=63577 (та же самая корреспонденция, но с 

присоединением) для примера. 

Почти всегда в этих разделах присутствуют 4 Показателя, и каждый Показатель 

имеет 3-7 критериев оценивания. 

Чтобы Студент получил «зачёт» по разделу, он должен удовлетворить ВСЕМ 

критериям оценивания. Преподаватель отвечает за создание ряда Заданий (мы 

рекомендуем 3), каждое из которых будет покрывать некоторое подмножество всех 

критериев оценивания для каждого из разделов. Все вместе эти Задания для каждого из 

разделов (должны!) обеспечить покрытие всех критериев оценивания – и, в зависимости от 

каждого из разделов и структуры Заданий, некоторые критерии оценивания могут 

перекрываться неоднократно. 

http://moodle.org/mod/forum/discuss.php?d=63577
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Each assignment is graded for the assessment criteria on a Met/Not Met 

basis. The results are then tracked in a rubric - see the second attachment 

for a rough idea, where the number in the matrix refers to the assignment 

number where the evidence was produced. 

Students who miss some criteria on a particular assignment may be given a 

"referral", or opportunity to resubmit. Or the unit may be structured in a 

way that the assessment criteria appears in a later assignment as well. This 

is up to the teacher, based on his assigment design. 

 

If a student meets all PASS assessment criteria, then the work is graded for 

MERIT and DISTINCTION. 

 

In these Edexcel programs, there are 3 broad Merit criteria and 3 broad 

Distinction critera (hence the shorthand for M1,M2, M3. D1, D...). 

However, unlike the pass criteria, which are set in the course specification, 

the M/D grading requires the teacher to rewrite the broad indicators in the 

context of the particular assignment. The requirements for M and D 

grading criteria are made clear to the student on each assignment brief. 

 

Like the Pass critera, the M/D criteria are then graded in a rubric on a 

Met/Not Met basis, with reference to the assignment number where the 

evidence is produced. Also, there may be multiple possibilities to get a 

particular M/D in the various assignments. 

The students final grade for the unit is a MERIT only if all pass criteria are 

met, and M1,M2,M3. 

The students final grade for the unit is a DISTINCTION only if a MERIT 

plus D1,D2,D3 is met 

In an ideal solution: 

 the Outcomes/pass assessment criteria would be imported to a particular 

Moodle course 

 the teacher would create the assignment in Moodle, attach the 

Outcomes and Assessment criteria that are covered in that assignment 

as a subset from above, and attach and contextualise the M/D criteria 

 students would submit their work, which could be either one or multiple 

files, links or descriptions of physical work with a digital archive, 

thereby creating a rudimentary portfolio 

 teachers would grade according to the rubric, and either send work back 

for re-submission or post to the "gradebook" - in this case the matrix of 

Pass and M/D assessment criteria. 

 

Каждое из Заданий оценивается по каждому из критериев по Шкале Met\Not 

Met – (зачтено/не зачтено). Результаты затем отправляются в соответствующую Рубрику 

(где число в матрице отсылает к номеру Задания, на которое дан ответ). 

 

Студенты, которые не удовлетворят некоторым критериям конкретного Задания, 

могут получить Оценку «направление на пересдачу», дающую  возможность повторного 

тестирования. Либо раздел может быть структурирован таким образом, что те же критерии 

оценивания появятся в последующих Заданиях. Это зависит от Преподавателя, от его 

метода конструирования Задания. 

Если Студент получит PASS («зачтено») для всех критериев оценивания, 

тогда каждая из его работ оценивается по градациям MERIT («хорошо») и 

DISTINCTION («отлично»). 

В таких Edexcel-программах существует 3 степени Merit-критерия и 3 

градации Distinction-критерия (отсюда аббревиации M1, M2, M3, D1, D2, D3; у нас 

вместо этих 6-ти градаций только две: «Синий», «Красный»). Однако, в отличие от 

критериев Pass, которые установлены в спецификации Курса, M/D оценивание требует от 

Преподавателя определить каждый из основных индикаторов в контексте конкретного  

Задания. Требования по критериям оценивания M и D кратко объясняются  Студентам 

непосредственно в тексте каждого Задания. 

Подобно критериям Pass, критерии M/D затем оцениваются в Рубрике на 

бинарной основе «зачтено\не зачтено», с учётом числа успешно выполненных 

Заданий. Кроме того, могут существовать разные возможности для получения 

конкретного M/D в различных Заданиях. 
Итоговая оценка Студента по каждому из разделов будет MERIT, только если 

удовлетворены все критерии Pass и M1, M2, M3. 

Итоговая оценка Студента для каждого из разделов будет DISTINCTION, только 

если удовлетворены МERIT и D1, D2, D3. 

В идеальном решении: 

 Критерии оценивания Показатели/Зачтено должны быть встроены в конкретный Курс 

Moodle. 

 Преподаватель должен создать каждое из Заданий в Moodle, присоединив Показатели и 

Критерии оценивания, которые покрывались бы в этом Задании как подмножеством, 

указанным выше, так и конкретизацией критериев M/D. 

 Студенты должны подавать на рассмотрение свою работу в виде одного или 

нескольких файлов, ссылок или описания практической работы с цифровым архивом, 

создавая таким образом элементарный Портфель. 

 Преподаватели должны оценивать в соответствии с Рубрикой, и либо отсылать работу 

обратно для повторной пересдачи, либо отправлять в «Журнал Оценок» – т.е. в матрицу 

критериев оценивания Pass и M/D. 
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 Feedback should be made by the teacher for the overall assignment and 

for each Pass Merit and Distinction criteria on that particular 

assignment 

 At the end of the class, a final grade of P/M/D could be either extracted 

automatically or manually by the teacher, and posted to a transcript area 

either in Moodle or an external SIS. 

Comments and thoughts: 

 numeric grades are irrelevant and confusing in this system, so best if 

they could be turned on/off 

 the roadmap spec for competencies should meet our needs, although a 

slight reworking of the assignment module would be ideal for us  

 a portfolio system that locked down the evidence for each assignment 

submission would also be highly desirable Edexcel / BTEC curriculum 

is widely used in the UK and around the world. From what I have seen 

of similar HE competency tracking in US systems, with the addition of 

numeric grading for each assessment criteria (0-4 GPA or %), it should 

be easily used there too. 

4.9.1.7.Grade letters 
Grade letters, also called letter grades, are symbols used to represent a 

range of grades. For example "A" could be used to represent grades of 80% 

and above, "B" to represent grades between 70 and 80%, "C" to represent 

grades between 50 and 70%, and so on. Alternatively, you could have 

"Pass" for grades above 50% and "Fail" for grades below 50%. 

4.9.1.7.1.Displaying letter grades 
To change particular grade items, category and course summaries (called 

aggregations) in the grader report and user reports to display letter grades: 

 

 Follow the grades link in the course administration block. 

 Select "Categories and items" from the gradebook dropdown menu. 

 

 Click the edit icon for Category total or Course total. 

 

 From the Grade display type menu, select letter. 

 Click the "Save changes" button at the bottom of the page. 

Repeat this for any other totals that you want displayed as letters. 

Alternatively, to display ALL grades as letter grades: 

 Follow the grades link in the course administration block. 

 

 

 Преподаватель должен дать Студенту Обратную Связь по всему Заданию и для 

каждого из критериев PASS, MERIT и DISTINCTION этого конкретного Задания. 

 В конце Курса окончательная оценка P/M/D может быть извлечена автоматически, или 

Преподавателем лично, и отправлена либо в область копий Moodle, либо во внешний 

SIS (science information system – систему научной информации (например, журнал 

Преподавателя). В обиходе Moodle такая оценка называется «вне Сайта» – вне Moodle). 

Комментарии и соображения: 

 Числовые оценки неуместны и сбивают с толку в этой системе, так что лучше если они 

могли бы быть включены/отключены. 

 Спецификация «Дорожной карты» для компетенций должна отражать наши нужды, 

хотя незначительная доработка модуля «Задание» могла бы стать идеалом для нас. 

 Система Портфелей, которая группирует всю информацию из переданных на 

рассмотрение Заданий, могла бы также быть весьма желаемым элементом программы 

Edexcel/BTEC, широко используемой в Объединённом королевстве и во всём мире. Из 

того, что я узнал о подобной системе оценивания уровня компетентности в США, при 

добавлении числовых оценок по каждому критерию оценивания (0-4 GPA или %), это 

может быть легко использовано и там. 

4.9.1.7.Оценки Буквами 
Оценки Буквами, также называемые буквенными Оценками, являются символами, 

используемыми для представления Области Оценок. «A» может быть использована для 

представления Оценок от 80% и выше, «B», чтобы представлять Оценки между 70 и 80%, 

«C», чтобы представлять Оценки между 50 и 70%, и т.д. В качестве альтернативы вы 

можете иметь «Зачтено» для Оценок выше 50% и «Не зачтено» для Оценок ниже 50%. 

4.9.1.7.1.Отображение Оценок Буквами 
Чтобы изменить конкретные Элементы Оценивания (п. 4.9.1.3.1), Категории, и 

Итоги по Курсу (называемые Агрегациями) в grader report (Отчёт Оценивающего) и user 

reports (пользовательские отчёты) для отображения Оценок Буквами: 

 Перейдите по ссылке AdministrationCourse administrationGrades. 

 Выберите «Categories and items (категории и элементы» из ниспадающего меню 

Журнала Оценок. 

 Щёлкните по иконке редактирования для Category total (итог по Категории) или Course 

total (итог по Курсу). 

 Выберите Letter (буква) в меню Grade display type (тип отображения Оценки). 

 Щёлкните по кнопке «Save changes (Сохранить изменения)» внизу страницы. 

Повторите это для любых Итогов, которые вы хотите отображать буквами. 

Альтернативно, чтобы отобразить ВСЕ Оценки как Оценки Буквами: 

 Перейдите по ссылке Grades в блоке управления Курсом 

AdministrationCourse administrationGrades. 

http://docs.moodle.org/24/en/User_report


 

450 

 Select "Course settings" from the gradebook dropdown menu. 

 From the Grade display type menu, select letter. 

 Click the "Save changes" button. 

Screenshot «Default grade letters». 

4.9.1.7.2.Editing course-level grade letters 
 
Grade letters are set initially at site level. To use different grade letters in a 

particular course: 

 

 Follow the grades link in the course administration block. 

 

 Select Letters/Edit from the from the gradebook dropdown menu. 

 

 

 Check the override site defaults box. 

 

 Change grade letters and/or boundaries as required. 

You may wish to use words, for example Below Pass, Pass, Merit, 

Distinction, rather than letters.) 

 Scroll to the bottom of the page and click the "Save changes" button. 

 

Screenshot «Editing grade letters». 

4.9.1.7.3.Setting grade letter site-level defaults 
 
To set grade letter site defaults: 

 

 Login as an administrator. 

 Access Site administration > Grades > Letters. 

 

 

 Change grade letters and/or boundaries as required. 

 Scroll to the bottom of the page and click the "Save changes" button. 

 

Screenshot «Pass/fail grade letters». 

 

 

 

 

 Выберите «Course settings (настройки курса» из ниспадающего меню Журнала Оценок. 

 Выберите Letter (буква) в меню Grade display type. 

 Щёлкните по кнопке «Save changes». 

Снимок с экрана «Оценки Буквами» по умолчанию»:  

4.9.1.7.2.Редактирование Оценок Буквами на 
уровне Курса 

Оценкибуквами устанавливаются первоначально на уровне 

Сайта. Чтобы использовать различные Оценки Буквами в 

конкретном Курсе: 

 Перейдите по ссылке Grades в 

AdministrationCourse administrationGrades. 

 Выберите Letters/Edit (буквы/редактировать) в ниспадающем 

меню Журнала Оценок (Gradebook или, что то же самое, Grader 

report). 

 Отметьте «галочкой» окно Override site defaults (отменить 

значения по умолчанию для Сайта). 

 Измените Оценки Буквами и/или границы как требуется.  

Вы можете пожелать использовать вместо букв слова, например, Плохо, 

Удовлетворительно, Хорошо, Отлично. 

 Прокрутите страницу вниз и щёлкните по кнопке 

«Save changes». 

Снимок с экрана «Редактирование Оценок Буквами»: 

4.9.1.7.3.Установка Оценки Буквами 
по умолчанию на уровне Сайта 

Чтобы установить Оценки Буквами по 

умолчанию на уровне Сайта: 

 Войдите в систему как Администратор. 

 Перейдите по 

AdministrationSite AdministrationGradesLetters. 

 Измените Оценки Буквами и/или границы как требуется. 

 Прокрутите страницу вниз и щёлкните по кнопке 

«Save changes». 

Снимок с экрана «Оценки Буквами зачтено/не зачтено»: 



 

451 

4.9.1.7.4.Forcing grade letter site-level defaults 
 
To force grade letter site-level defaults in all courses i.e. remove the ability 

for teachers to override site defaults and edit grade letters in their courses: 

 

 Login as an administrator. 

 Access Administration > Users > Permissions > Define roles 

 Edit the role of teacher and change the capability 

moodle/grade:manageletters from Allow to Not set. 

 

 Scroll to the bottom of the page and click the "Save changes" button. 

4.9.1.7.5.Accuracy of grade calculations 
Grade calculations are made with an accuracy of 5 decimal places and 

grade letters assigned accordingly. The overall decimal points setting (in 

the system grade item settings and for individual grade items) is for display 

purposes only and is not used when assigning grade letters. 

 

4.9.1.8.Grade import 
Grades may be imported as a CSV or XML file. 

The import file format is the same as the corresponding export format. 

 

Note: Grade import is equivalent to manual grading in the grader report. 

Thus, if grades for a particular Moodle activity such as an assignment are 

imported, they can no longer be edited via the assignment submission 

page. 

4.9.1.8.1.Importing grades 
Screenshot «CSV grade import». 

To import grades into the gradebook: 

1. Decide on an import format - CSV or XML file (see below) - then 

export some grades using the corresponding export format. 

 

2. Edit the export file as appropriate and save it. 

3. Tip: If you opened your exported file in Excel, don't add columns there 

because Moodle will reject the import if there are new columns that 

didn't exist in the exported file. If you need to add columns, do that in 

Moodle BEFORE you export your gradebook. 

4. Select your chosen import format from the gradebook dropdown menu. 

5. Browse and upload your previously saved file. 

4.9.1.7.4.Принуждение Оценок Буквами по умолчанию на 
уровне Сайта 

Чтобы установить принудительные Оценки Буквами по умолчанию на уровне 

Сайта, т.е. лишить Преподавателей возможности отменять значения по умолчанию для 

Сайта и редактировать Оценки Буквами для их Курсов: 

 Войдите в систему как Администратор. 

 Перейдите по AdministrationSite AdministrationGradesLetters  

 Отредактируйте Роль Преподавателя и измените Возможность 

moodle/grade:manageletters на странице Editing role «Teacher» и ниже в разделе «Course» 

с Allow (разрешить) на Not set (не устанавливать). 

 Прокрутите страницу вниз и щёлкните по кнопке «Save changes». 

4.9.1.7.5.Точность вычислений Оценок 
Вычисления Оценок осуществляются с точностью 5 знаков после запятой, и 

Оценки Буквами назначаются соответственно. Настройка общего числа десятичных знаков 

(в настройках Элементов Оценивания на уровне системы и для отдельных 

Элементов Оценивания) нужна только в целях отображения и не используется при 

Оценке Буквами. 

4.9.1.8.Импорт оценок 
Оценки могут импортироваться как CSV или XML файл. 

Форматы файлов импорта такие же, как соответствующие форматы файлов 

экспорта. 

Замечание. Импорт Оценок эквивалентен формированию Отчёта Оценивающего 

(п. 4.9.1.1) вручную. Таким образом, если Оценки для конкретного 

Интерактивного Действия Moodle, такого как Задание, импортированы, они уже не могут 

быть далее отредактированы через Страницу передачи Задания на рассмотрение. 

4.9.1.8.1.Импортирование Оценок 
Снимок с экрана «Импорт CSV-Оценок». 

Чтобы импортировать Оценки в ваш Журнал Оценок: 

1. Решите, каким форматом файла воспользоваться для импорта – CSV или XML (см. 

ниже) – затем экспортируйте какие-нибудь Оценки, используя соответствующий 

формат для экспорта. 

2. Отредактируйте экспортированный файл подходящим образом и сохраните его. 

3. Совет: Если вы открыли ваш экспортированный файл в Excel, не добавляйте там 

колонки, поскольку Moodle отвергнет импорт, если там появились новые колонки, 

которые не существовали в экспортированном файле. Если вам всё же нужно добавить 

колонки, сделайте это в Moodle, прежде чем вы экспортируете ваш Журнал Оценок. 

4. Выберите принятый вами формат импорта из ниспадающего меню Журнала Оценок. 

5. Просмотрите и загрузите предварительно сохранённый вами файл. 

http://docs.moodle.org/24/en/File:Csv_grade_import.png
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6. Set options as required. 

7. Click the "Upload grades" button. 

8. CSV import only: Preview the grade import and choose the column 

mapping then click the "Upload grades" button to complete the grade 

import. 

1. Tip: By default "Map from" is set to First Name, and "Map to" to 

userid. Change both dropdowns to: "Email Address" to "useremail", 

or to "Id Number" to "useridnumber" (assuming that your users have 

ID number fields filled in in their profiles). 

 

2. Tip: Unlike in most email programs, email addresses are case 

sensitive in grade import files. (This should eventually be fixed as 

per MDL-29315.) 

You need two permissions to import grades: (1) general permission to 

import grades and (2) permission to import grades in a particular format. 

For example, to import CSV grades you need  

 

moodle/grade:import("Import grades")=Allow 

gradeimport/csv:view("Import grades from CSV")=Allow 

4.9.1.8.2. XML import 
XML import requires the numerical grade, activity idnumber and user 

idnumber. 

Remote file URL 

The remote file URL field is for fetching data from a remote server, such 

as a student information system. 

4.9.1.8.3.CSV import 
CSV import is more flexible than XML import, as you may choose the 

column mapping. 

Encoding 
If you are unsure of the encoding of your CSV file, try selecting the second 

option in the encoding dropdown menu. If you've used Excel to produce 

the CSV file the second option WINDOWS-xxx encoding is probably the 

correct one. The grade import preview will tell you if you guessed the 

encoding correctly. 

Verbose scales 
Scales can be either specified as a raw id - eg. 0, 1, 2, 3, etc. or as a string, 

eg. "good", "bad", "not very bad". The later format is called "verbose". 

 

 

6. Установите требуемые опции. 

7. Выберите кнопку «Upload grades (переслать оценки)». 

8. Только для импорта CSV: Предварительно просмотрите файл импорта и выберите 

колонку соответствия, затем щёлкните по кнопке «Upload grades», чтобы завершить 

импорт Оценок. 

1. Совет: По умолчанию «Map from (отобразить из)» устанавливается на First Name 

(имя), «Map to (отобразить в)» – на Userid (идентификатор пользователя). Измените 

оба ниспадающих списка: «Email Address» – на «Useremail» или «Id Number» – на 

«Useridnumber» (предполагая, что ваши пользователи имеют в своих профилях 

заполненные поля ID number). 

2. Совет: В отличие от большинства программ электронной почты, адреса 

электронной почты чувствительны к регистру букв в файлах импорта Оценок. (Это 

со временем может быть зафиксировано посредством MDL-29315). 

Для импорта оценок вам необходимы два Полномочия: (1) general permission 

(общее полномочие) на импортирование оценок и (2) permission to import grades in a 

particular format (полномочие на импорт оценок в конкретном формате). Например, чтобы 

импортировать CSV Оценки, вам необходимы: 

moodle/grade:import("Import grades")=Allow 

gradei mport/csv:view("Import grades from CSV")=Allow 

4.9.1.8.2.XML Импорт 
XML импорт требует, чтобы каждая из оценок была числовой, чтобы были 

Идентификационные Номера Интерактивного Действия и пользователя. 

Единый указатель URL на удалённый файл 
Поле URL удалённого файла нужно для выборки данных с удалённого сервера, 

такого как студенческая информационная система. 

4.9.1.8.3.CSV Импорт 
CSV импорт более гибок, чем XML импорт, так как вы можете выбрать колонки 

соответствия. 

Кодирование 
Если вы не уверены в кодировании вашего CSV файла, попробуйте выбрать 

другую опцию (на странице Import CSV) в ниспадающем меню Encoding (кодирование). 

Если вы использовали Excel для создания CSV файла, вероятно, стоит выбрать в Encoding 

в качестве второй опции что-либо из WINDOWS-xxx. Предварительный просмотр импорта 

Оценок сообщит вам, правильно ли вы выбрали кодирование. 

Подробные Шкалы 
Шкалы могут быть указаны либо как Исходные Идентификаторы, например, 0, 1, 

2, 3 и т.д., либо как строка, например, «хорошо», «плохо», «не очень плохо». Последний 

формат называется «Verbose (подробный или многословный)» 

http://tracker.moodle.org/browse/MDL-29315
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4.9.1.8.4.Grade import capabilities 
Import grades from CSV 
Capabilities/gradeimport/csv:view 

 This allows a user to import grades via CSV file 

 This capability is allowed for the default roles of manager and teacher 

Publish import grades from XML 
Capabilities/gradeimport/xml:publish 

 This allows a user to import grades by accessing a special URL 

 This capability is allowed for the default role of manager only 

Import grades from XML 
Capabilities/gradeimport/xml:view 

 This allows a user to import grades via XML file 

 This capability is allowed for the default roles of manager and teacher 

4.9.1.8.5.See also 
Using Moodle forum discussions: 

 Gradebook confusion 

 Can external software insert data into the gradebook? 

4.9.1.9.Grade export 
Grades can be exported to Excel spreadsheet, OpenDocument spreadsheet, 

plain text file or XML file. 

Grade export is NOT intended for students. 

4.9.1.9.1.How to export grades 
To export grades from the gradebook: 

1. Choose an export format from the gradebook dropdown menu. 

2. Set options as required. 

3. If the course uses groups, select whether to export grades for all 

participants or for a particular group. 

4. Select the grade items to be included. Note that ID numbers are 

required for all activities for XML file export. An ID number field can 

be found in the common module settings for each activity. 

 

5. Click the submit button. 

6. After previewing the data on the following page, click the download 

button. 

4.9.1.9.2.XML file export 
To export grades to XML file, you need to ensure that: 

 Users have ID numbers (an optional field in the user profile) 

4.9.1.8.4.Возможности импорта оценок 
Импорт оценок из CSV 

Возможность Capabilities/gradeimport/csv:view 

 Позволяет пользователю импортировать оценки через файл CSV. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя. 

Публикация Оценок, импортированных из XML 
Возможность Capabilities/gradeimport/xml:publish 

 Позволяет пользователю импортировать Оценки путём доступа по конкретному URL. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя 

Импорт оценок из XML 
Возможность Capabilities/gradeimport/xml:view 

 Позволяет пользователю импортировать Оценки через файл CSV. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера и Преподавателя 

4.9.1.8.5.См. также 
Обсуждения форума по использованию Moodle: 

 Неразбериха с Журналом Оценок. 

 Может ли внешнее программное обеспечение вставить данные в Журнал Оценок? 

4.9.1.9.Экспорт Оценок 
Оценки могут быть экспортированы в электронную таблицу Excel, электронную 

таблицу OpenDocument, простой текстовый файл или файл XML. 

Экспорт Оценок НЕ предназначен для Студентов. 

4.9.1.9.1.Как экспортировать Оценки 
Чтобы экспортировать Оценки из Журнала Оценок: 

1. Выберите формат экспорта из ниспадающего меню Журнала Оценок. 

2. Установите параметры в соответствии с требованиями. 

3. Если Курс использует Группы, будут ли экспортировать Оценки для всех Участников 

или для определённой Группы. 

4. Выберите Элементы Оценивания, которые будут включены. Заметьте, что 

идентификационные номера (ID) являются обязательными для всех 

Интерактивных Действий при экспорте в файл XML. Поле с номером ID можно 

отыскать в общих настройках модуля для каждого Интерактивного Действия. 

5. Нажмите кнопку Submit (отправить на рассмотрение препоавателю). 

6. После предварительного просмотра данные появляются на следующей странице, 

щёлкните кнопку Download (скачать). 

4.9.1.9.2.Экспорт в файл XML 
Чтобы экспортировать Оценки в файл XML, убедитесь, что: 

 Пользователи имеют номера ID (необязательное поле в Профиле Пользователя) 

https://moodle.org/mod/forum/discuss.php?d=85944
https://moodle.org/mod/forum/discuss.php?d=92081
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 Activities have ID numbers (an optional field in the common module 

settings) 

4.9.1.9.3.Default grade export settings 
The grade export display type and grade export decimal points site-wide 

defaults may be set by an administrator in Site administration > Grades > 

General settings. 

4.9.1.9.4.User profile fields export 
In Moodle 2.4 onwards, an administrator can specify user profile fields and 

custom profile fields to be included in the grade export in Site 

administration > Grades > General settings 

 

4.9.1.9.5.Grade publishing 
Grade publishing is a way of importing and exporting grades via a URL 

without being logged in to Moodle. Grade publishing is intended for 

administrators only, due to the security implications. 

Grade publishing is disabled by default. It can be enabled by an 

administrator by checking the gradepublishing box in Settings > Site 

administration > Grades > General settings. Users with grade publishing 

capabilities (normally administrators only) are then provided with grade 

export publishing settings. 

To determine the URL for exporting grades, follow an export format link 

e.g. XML file, select a user key or 'Create a new key' to generate a new 

one, select other options as required, then click the Submit button. A 

download URL e.g. 

 

http://qa.moodle.net/grade/export/xml/dump.php?id=2&groupid=&itemids

=-

1&export_letters=&export_feedback=0&updatedgradesonly=0&displaytyp

e=1&decimalpoints=2&key=ed18257297c48d15096dd49c1d09ac06 will 

then be provided. 

4.9.1.9.6.Grade export capabilities 
Publish ODS grade export 
Capabilities/gradeexport/ods:publish 

 This allows a user to publish OpenOffice grade exports i.e. set up a 

URL for accessing exported grades without having to login to Moodle. 

 This capability is set to allow for the default role of manager. 

Note: Grade publishing is disabled by default. It can be enabled by 

checking the gradepublishing box in Administration > Grades > Grade 

settings. 

 Интерактивные Действия имеют номера ID (необязательное поле в общих настройках 

модуля) 

4.9.1.9.3.Настройки экспорта Оценки по умолчанию 
Значения по умолчанию для типа отображения экспорта Оценки и числа 

десятичных знаков после запятой экспортируемых Оценок на уровне Сайта могут быть 

установлены Администратором в 

Administration→Site administration→Grades→General settings. 

4.9.1.9.4.Экспорт полей Профиля Пользователя 
В Moodle 2.4 и выше, Администратор может задать поля Профиля Пользователя и 

поля привычного для клиента Профиля, которые будут включены в экспорт Оценок в 

Site aadministration→Grades→General settings. 

4.9.1.9.5.Публикация Оценок 
Публикация Оценок – это способ импорта и экспорта Оценок через URL без входа 

в Moodle. Публикация Оценок предназначена только для Администраторов, в связи с 

последствиями для безопасности. 

Публикация Оценок по умолчанию отключена. Она может быть включена 

Администратором установкой флажка в окошке Gradepublishing в 

Site aadministration→Grades→General settings. Пользователи с Возможностями 

Публикации Оценок (обычно только Администраторы) затем обеспечиваются 

настройками Публикации Экспорта Оценок. 

Чтобы определить URL для экспорта Оценок, перейдите по ссылке 

форматирования экспорта, например, в файл XML, выберите ключ пользователя или 

«Create a new key (создать новый ключ)» для создания нового ключа, выберите другие 

опции по мере необходимости, а затем щёлкните кнопку «Submit (отправить на 

рассмотрение)». Скачивание URL, например, 

http://qa.moodle.net/grade/export/xml/dump.php?id=2&groupid=&itemids=-

1&export_letters=&export_feedback=0&updatedgradesonly=0&displaytype=1&decimalpoints=

2&key=ed18257297c48d15096dd49c1d09ac06 затем будет обеспечено. 

 

 

4.9.1.9.6.Возможности экспорта Оценок 
Публиковать Экспорт Оценки в ODS (открытоя система документов) 

Возможность Capabilities/gradeexport/ods:publish 

 Позволяет пользователю Публиковать Экспорт Оценок в OpenOffice, т.е. настроить 

URL для доступа к экспортируемым Оценкам без необходимости входа в Moodle. 

 Эта Возможность по умолчанию предоставлена Роли Менеджера. 

Замечание: Публикация Оценок по умолчанию отключена. Она может быть 

включена установкой флажка в окошке Gradepublishing в 

Aadministration→Site aadministration →Grades→Grades settings. 

http://qa.moodle.net/grade/export/xml/dump.php?id=2&groupid=&itemids=-1&export_letters=&export_feedback=0&updatedgradesonly=0&displaytype=1&decimalpoints=2&key=ed18257297c48d15096dd49c1d09ac06
http://qa.moodle.net/grade/export/xml/dump.php?id=2&groupid=&itemids=-1&export_letters=&export_feedback=0&updatedgradesonly=0&displaytype=1&decimalpoints=2&key=ed18257297c48d15096dd49c1d09ac06
http://qa.moodle.net/grade/export/xml/dump.php?id=2&groupid=&itemids=-1&export_letters=&export_feedback=0&updatedgradesonly=0&displaytype=1&decimalpoints=2&key=ed18257297c48d15096dd49c1d09ac06
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Use OpenDocument grade export 
Capabilities/gradeexport/ods:view 

 This allows a user to use the OpenOffice grade export. 

 This capability is set to allow for the default roles of manager, teacher 

and non-editing teacher. 

Publish text file grade export 
Capabilities/gradeexport/txt:view 

 This allows a user to export grades as a text file. 

 This capability is set to allow for the default roles of manager, teacher 

and non-editing teacher. 

Publish XLS grade export 
Capabilities/gradeexport/xls:publish 

 This allows a user to publish Excel grade exports i.e. set up a URL for 

accessing exported grades without having to login to Moodle 

 This capability is set to allow for the default role of manager only 

Note: Grade publishing is disabled by default. It can be enabled by 

checking the gradepublishing box in Settings > Site administration > 

Grades > Grade settings. 

Use Excel grade export 
Capabilities/gradeexport/xls:view 

 This allows a user to use the Excel spreadsheet grade export 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

Publish XML grade export 
Capabilities/gradeexport/xml:publish 

 This allows a user to publish XML file grade exports i.e. set up a URL 

for accessing exported grades without having to login to Moodle 

 This capability is allowed for the default role of manager only 

Note: Grade publishing is disabled by default. It can be enabled by 

checking the gradepublishing box in Settings > Site administration > 

Grades > Grade settings. 

Use XML grade export 
Capabilities/gradeexport/xml:view 

 This allows a user to use the XML file grade export 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

 

 

Использовать экспорт Оценок в OpenDocument  
Возможность Capabilities/gradeexport/ods:view 

 Позволяет пользователю использовать экспорт Оценок в OpenOffice. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Публиковать Экспорт Оценок в текстовый файл 
Возможность Capabilities/gradeexport/txt:view 

 Позволяет пользователю экспортировать Оценки в текстовый файл. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Публиковать Экспорт Оценок в файл XLS 
Возможность Capabilities/gradeexport/xls:publish 

 Позволяет пользователю Публиковать Экспорт Оценок в Excel, т.е. настроить URL для 

доступа к экспортированным Оценкам без необходимости входа в Moodle. 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера. 

Замечание: По умолчанию Публикация Оценок отключена. Она может быть 

включена установеой флажка в окошке Gradepublishing в 

Aadministration→Site aadministration→Grades→Grades settings. 

Публиковать Экспорт Оценок в электронную таблицу Excel 
Возможность Capabilities/gradeexport/xls:view 

 Позволяет пользователю использовать экспорт Оценок в электронную таблицу Excel. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Публиковать Экспорт Оценок в файл XML 
Возможность Capabilities/gradeexport/xml:publish 

 Позволяет пользователю Публиковать Экспорт Оценок в файл XML, т.е. настроить 

URL для доступа к экспортированным Оценкам без необходимости входа в Moodle. 

 Эта Возможность по умолчанию предоставлена только Роли Менеджера. 

Замечание: По умолчанию Публикация Оценок отключена. Она может быть 

включена установеой флажка в окошке Gradepublishing в 

Aadministration→Site aadministration→Grades→Grades settings. 

Использовать экспорт Оценок в XML 
Возможность Capabilities/gradeexport/xml:view 

 Позволяет пользователю использоывть экспорт Оценок в файл XML. 

 Эта Возможность по умолчанию предоставлена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 
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4.9.1.9.7.Tips and tricks 
 Export grades in a spreadsheet format. Then copy and paste that 

information into another file that has worksheet ("raw grades"). Create 

other worksheets which are custom reports which take their data from 

"raw grades". This works if graded activities are not moved around to 

different positions in the course. This allows you to create a standard 

printed report(s). For example a compact landscape report of all 

students and all grades for each activity, a report of just quizes, another 

of lessons, another of assignments. A pivot table of students by scores, 

generated from a report worksheet, which gets its data from the raw 

data. 

 Mailmerge exported grades into custom documents. For example, a 

document that is given to a department to file as a proof of training, 

with scores for every subject quiz. 

4.9.1.9.8.See also 
 dev:Gradebook export developer documentation 

 Video showing how to export grades in Moodle 1.9 

4.9.1.10.Advanced grading methods 
Advanced grading methods enable various assessment forms to be used for 

calculating grades. 

 

4.9.1.10.1.Advanced grading method types 
 Rubrics 

 Marking guide 

 Learning Analytics Enriched Rubric (new plugin since Moodle 2.3) 

 

4.9.1.10.2.Basic concepts 
By default, numerical grades in Moodle are selected by the teacher from a 

range like 0-100. When advanced grading methods are enabled, the grade 

selection element is replaced with a more complex assessment form 

provided by the plugin. The plugin contains the logic how to calculate the 

4.9.1.9.7.Советы и трюки 
 Экспортируйте Оценки в формат электронной таблицы. Затем скопируйте и вставьте 

эту информацию в другой файл, который имеет рабочую таблицу («исходные 

Оценки»). Создайте другие рабочие таблицы, которые являются привычными для 

клиента отчётами, которые возьмут себе данные данные из «исходных Оценок». Это 

работает, если оцениваемые Интерактивные Действия не перемещаются по разным 

позицим в Курсе. Это позволяет создать стандартный печатный отчёт(ы). Например, 

компактный эскизный отчёт обо всех Студентах и всех Оценках за каждое 

Интерактивное Действие, отчёт только об Экзаменах, других Уроках, других Заданиях. 

Сводная Таблица Студентов по Баллам, сгенерирванная из рабочей таблицы отчёта, 

который берёт себе данные из исходных (сырых) данных. 

 Составьте стандартные письма по экспортируемым Оценкам в привычных для клиента 

документах. Например, документ, который подаётся на кафедру в виде файла, как 

доказательство обучения, с баллами по каждому предмету Экзамена. 

4.9.1.9.8.См. также 
 Документация разработчика «Экспорт Журнала Оценок». 

 Видео, показывающее, как экспортировать Оценки в Moodle 1.9. 

4.9.1.10.Продвинутые методы оценивания 
Продвинутые методы оценивания включают различные Формы Оценивания, 

которые могут использоваться для вычисления Оценок. 

 

4.9.1.10.1.Типы продвинутых методов оценивания 
 Рубрики (см. п. 4.9.1.10.8 ниже). 

 Руководство по Проставлению Отметок (см. п. 4.9.1.10.9 ниже). 

 Изучение Аналитически Обогащённой Рубрикации (см. п. 4.9.1.10.10 ниже – новый 

Плагин, начиная с Moodle 2.3). 

4.9.1.10.2.Базовые концепции 
По умолчанию Числовые Оценки в Moodle выбираются Преподавателем в 

диапазоне подобном 0-100. Когда включены продвинутые Методы Оценивания, 

Элемент Выбора Оценки замещается более сложной Формой Оценивания, обеспечиваемой 

специальным Плагином. Этот Плагин содержит логику вычисления 

http://docs.moodle.org/dev/Gradebook_export
http://www.youtube.com/watch?v=yZcbN_7p2zI
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grade. Such a calculated  grade is then passed back to the activity module 

as if the teacher used the standard grade value selector. 

 

Example: The teacher creates new Assignment in the course with the grade 

up to 30. She defines a rubric to be used for grading. The rubric itself 

produces raw score up to 12 (eg it has four criteria with levels 0, 1, 2, 3). 

So the rubric's score 12 leads to the assignment grade 30, the score 6 leads 

to the grade 15 etc. 

 

 

For each activity, a new copy of the assessment form is created. Note that 

this is different from how scales work. While scales are defined at the site 

level or course level and then can be used in all activities, advanced 

grading forms create a new copy of the form definition for every single 

activity that uses it. So a change in the form definition in one assignment 

does not affect other places where the same rubric is used. 

 

Example: The teacher defines a rubric for an assignment in the course. 

Then she re-uses the rubric in another assignment (see below on how to do 

this). When the teacher modifies the rubric in the second assignment, the 

first assignment still uses the original rubric. 

The grading form definition is part of the activity data. It is included in the 

activity's backup and it is copied when the activity is duplicated via the 

"x2" icon or imported from another course. 

 

4.9.1.10.3.Configuring an activity module to use 
advanced grading methods 
Modules that support advanced grading methods have the grading method 

selector included in their settings form (for example in the Assignment 

settings (п. 4.3.1.1) form). The teacher can choose either 'Simple direct 

grading' or one of the installed grading methods plugins. Selecting 'Simple 

direct grading' means that the advanced grading is not used and the 

standard grade selector is displayed. 

Alternative way is to follow the link 'Advanced grading' in the activity 

Settings block (п. 4.5.2). The link leads to a page where the current active 

grading method can be changed, too. 

 

 

 

 

Оценки. Вычисленные таким образом Оценки затем передаются модулю 

Интерактивного Действия так же, как если бы Преподаватель использовал стандартный 

селектор значения Оценки. 

Пример: Преподаватель создаёт новое Задание в Курсе с максимальной 

Итоговой Оценкой в 30 баллов. Он определяет Рубрику, которая должна быть 

использована для оценивания. Эта Рубрика, в свою очередь, образует до 12 

Исходных Накопливаемых Баллов (например, Рубрика имеет четыре критерия с уровнями 

0, 1, 2, 3). Так что Исходные Накопленные Баллы по Рубрике равные 12 баллам ведут к 

Оценке Задания в 30 баллов, Накопленные Баллы равные 6 ведут к Оценке в 15 баллов и 

т.д. 

Для каждого Интерактивного Действия создаётся новая копия Формы Оценивания. 

Заметьте, что это отличается от того, как работают Шкалы. В то время как Шкалы, 

которые определены на уровне Сайта или на уровне Курса, могут затем использоваться во 

всех Интерактивных Действиях, продвинутые Формы Оценивания создают новую копию 

Определения Формы для каждого отдельного Интерактивного Действия, которое её 

использует. Так что изменение в Определении Формы в одном Задании не влияет на 

другие места, где используется та же самая Рубрика. 

Пример: Преподаватель определяет Рубрику для Задания в Курсе. Затем он  

использует эту Рубрику в другом Задании (см. ниже, как сделать это). Когда 

Преподаватель модифицирует эту Рубрику во втором Задании, первое Задание всё ещё 

использует исходную Рубрику. 

Определение Формы Оценивания является частью данных 

Интерактивного Действия. Оно включается в резервную копию Интерактивного Действия 

и оно копируется, когда Интерактивное Действие дублируется посредством иконки «х2» 

или импортируется из другого Курса. 

4.9.1.10.3.Настройка модуля Интерактивного Действия для 
использования продвинутых Методов Оценивания 

Модули, которые поддерживают продвинутые методы оценивания имеют селектор 

Методов Оценивания, который включён в Форму их настроек (например, в Форму 

настроек Задания – п. 4.3.1.1). Преподаватель может выбрать либо «Simple direct grading 

(простое прямое оценивание)» или один из установленных Плагинов 

Методов Оценивания. Выбор «Simple direct grading» означает, что продвинутое 

оценивание не используется и отображается стандартный селектор оценивания. 

Альтернативный способ заключается в переходе по ссылке «Advanced grading 

(продвинутое оценивание)» в Блоке настроек Интерактивного Действия (п. 4.5.2). Эта 

ссылка ведёт на страницу, где текущий Метод Оценивания Интерактивного Действия 

может быть тоже изменён. 
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The form definition and the associated assessment data are stashed when 

the grading method is changed from one type to another. That means it is 

safe to change the current active grading method from 'Rubric' to 'Simple 

direct grading' and back to 'Rubric'. The rubric definition is kept in the 

database, although it may not be available while the current grading 

method is set to some other method. 

4.9.1.10.4.Assessment form definition 
The link 'Advance grading' in the activity settings form leads to a 

management screen where the assessment form can be defined, edited, 

deleted and eventually shared as a public template (if the user has such 

permission). If there is no form of the selected method defined yet, there 

are two options: 

 Define new grading form from scratch - creates a blank grading form 

and lets you define it. Each grading plugin provides its own grading 

form editor. 

 Create new grading form from a template - lets you re-use a previously 

defined form. You can copy any of your own grading forms (that is 

those you have created elsewhere) or a grading form that was shared as 

a public template at your site. 

 

Every grading form has a name and a description. These are not displayed 

to students. The description should summarize the form, explain its usage 

etc. 

The grading form definition can be saved as a draft or as a final version. If 

the grading form is saved as a draft, it can't be used for assessing. To 

release the form and make it available to assessment, save it using the 

button 'Save and make it ready'. The current status of the form definition is 

indicated via a tag displayed next to the form name. 

 

Modifying the form after it has been used 
It may happen that you define a grading form, make it ready for usage and 

start assessing students with it. After some time you realize there is a typo 

in the form or that it should be actually improved significantly (like by 

adding another criterion into the rubric). In such case, you are about to edit 

a form that has already been used for assessment. 

If the grading plugin considers your change as significant, it may force you 

to mark all current assessment with a special flag 'Needs review'. It is your 

duty to go through all existing assessments made by the previous version 

of the form and re-assess them to make the calculated grades valid a 

comparable. 

Определение Формы и связанные данные оценивания будут спрятаны, когда 

Метод Оценивания изменится от одного типа к другому. Это означает, что менять 

текущий Метод Оценивания Интерактивного Действия «Рубрика» на «Простое прямое 

оценивание» и обратно в «Рубрику» безопасно. Определение Рубрики хранится в базе 

данных, хотя оно не может быть доступно, в то время как текущий Метод Оценивания 

установливается в некоторый другой Метод. 

4.9.1.10.4.Определение Формы Оценивания 
Ссылка «Advance grading (продвинутое оценивание)» в Форме настроек 

Интерактивного Действия приводит к экрану управления, где Форма Оценивания может 

быть определена, отредактирована, удалена и, со временем, совместно использована в 

качестве общественного Шаблона (если пользователь имеет такое Полномочие). Если 

Форма выбранного Метода ещё не определена, есть два варианта: 

 Определить новую Форму Оценивания с нуля – создать пустую Форму Оценивания и 

позволить определить её. Каждый Плагин оценивания предоставляет свой собственный 

Редактор Форм Оценивания. 

 Создать новую Форму Оценивания на основе Шаблона – позволить повторно 

использовать ранее определённую Форму. Вы можете скопировать любую из ваших 

собственных Форм Оценивания (то есть тех, что вы создали в другом месте) или 

Форму Оценивания, которая была предоставлена в качестве общественного Шаблона 

на вашем Сайте.  

Каждая Форма Оценивания имеет название и описание. Они не отображаются для 

Студентов. Описание должно кратко описывать форму, объяснять её применение и т.д. 

 

Определение Формы Оценивания может быть сохранено в виде черновой или 

окончательной версии. Если Форма Оценивания сохраняется как черновик, она не может 

быть использована для оценивания. Чтобы освободить Форму и сделать её доступной для 

оценивания, сохраните её с помощью кнопки «Save and make it ready (сохранить и сделать 

её готовой)». Текущее состояние Определения Формы указывается с помощью тега, 

отображаемого рядом с названием формы. 

Модификация Формы после того, как она была применена 
Может случиться, что вы определите Форму Оценивания, сделаете её готовой к 

применению и начнёте оценивать Студентов с ней. Через некоторое время вы поймёте, что 

есть опечатка в этой Форме или, что она должна быть на самом деле значительно 

улучшена (подобно добавлению ещё одного критерия в Рубрику). В таком случае, вы 

собирётесь отредактировать форму, которая уже была применена для оценивания. 

Если Плагин Оценивания посчитает вашу замену столь значительной, он может 

принудить вас пометить всё текущее оценивание специальным флагом «Needs review 

(требует пересмотра)». Это ваша обязанность, пройти через все существующие 

оценивания, сделанные в предыдущей версии этой формы и по-новому оценить их, чтобы 

сделать вычисляемые Оценки действительно приемлемыми. 
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If the change seems to be a trivial change (eg fixing a typo in the text), the 

form editor may ask you to decide whether the existing assessment should 

be marked with the 'Needs review' flag or not. 

Please note, when there are other people using the form for assessment (eg 

there are several non-editing teachers in the course who participate on the 

submissions assessment), even a trivial rewording can be understood as 

significant change in the criterion meaning. Make sure you communicate 

the changes well with your colleagues. 

 

4.9.1.10.5.Re-using assessment forms 
Instead of defining the new grading form from scratch, you can use some 

existing form as the initial template to create it from. When clicking the 

'Create new grading form from a template' icon, a new page opens and you 

can search for a grading form there. Simply type words that should appear 

somewhere in the form name, its description or the form body itself. To 

search for a phrase, wrap the whole query in double quotes. 

 

Screendoot «Searching for a grading form to re-use» 

Shared templates 
Users who were given a special permission can save their grading forms as 

shared templates on the site. Such forms can be then picked and re-used by 

all teachers in their courses. Users who published the form as a template 

can also delete it from the list of shared templates. There is also another 

permission to manage the whole "bank" of shared template. Users with this 

permission can delete any shared template, even if they are not the authors 

of it (see below for more details on these permissions). 

 

Grading forms can be shared at the site level only. There is no way how to 

share forms at lower context levels (eg at the course category level as the 

question bank does). 

Re-using own forms without sharing them 
By default, only the grading forms that have been saved as shared 

templates are included in the search results. You can also include all your 

own grading forms in the search results. This way, you can simply re-use 

your grading forms without sharing them. Only forms marked as 'Ready 

for usage' can be re-used this way. 

 

 

 

 

Если изменение ему покажется тривиальным (например, фиксация опечатки в 

тексте), Редактор Формы может попросить вас решить, нужно ли существующее 

оценивание помечать флажком «Needs review (требует пересмотра)» или нет. 

Пожалуйста, обратите внимание, когда есть другие люди, использующие эту 

Форму для оценивания (например, есть несколько Преподавателей, нередактирующих 

Преподавателей в Курсе, которые участвуют в оценивании переданных на рассмотрение 

ответов), даже тривиальное изменение формулировки можно понимать как существенное 

изменение смысла критерия. Убедитесь, что вы сообщили об этих изменениях своим 

коллегам. 

4.9.1.10.5.Повторное использование Форм Оценивания 
Вместо определения новой Формы Оценивания с нуля, вы можете использовать 

некоторую существующую форму в качестве начального Шаблона для создания новой 

Формы. При щелчке по иконке «Create new grading form from a template (создать новую 

форму оценивания на основе шаблона)», открывается новая страница, и вы можете 

отыскать Форму Оценивания там. Просто введите слова, которые могут обнаружиться где-

то в названии Формы, её описании или в самом теле формы. Чтобы отыскать фразу, 

заключите весь запрос в двойные кавычки. 

Снимок с экрана «Отыскание Формы Оценивания для повторного использования». 

Совместно используемые Шаблоны 
Пользователи, которым дано специальное Полномочие, могут сохранять свои 

Формы Оценивания в качестве совместно используемых Шаблонов на Сайте. Такие 

Формы могут быть затем взяты и повторно использованы всеми Преподавателями в их 

Курсах. Пользователи, опубликовавшие Форму как Шаблон, также могут и удалить его из 

списка разделяемых Шаблонов. Существует также ещё одно Полномочие на управление 

всем «банком» разделяемых Шаблонов. Пользователи с таким Полномочием могут 

удалить любой разделяемый Шаблон, даже если они не его авторы (см. ниже более 

подробную информацию по этим Полномочиям). 

Формы Оценивания могут быть совместно использованы только на уровне Сайта. 

Нет никакого способа совместного использования Форм на более низких уровнях 

Контекста (например, на уровне Категорий Курсов такой, как Банк Вопросов). 

Повторное применение Форм без совместного их использования 
По умолчанию, только Формы Оценивания, которые были сохранены как 

разделяемые Шаблоны, включаются в результаты поиска. Вы можете также включить все 

ваши собственные Формы Оценивания в результаты поиска. Таким образом, вы можете 

просто повторно использовать ваши Формы Оценивания, не разделяя их с другими. 

Только Формы, отмеченные как «Ready for usage (готова к использованию)», могут быть 

использована повторно этим способом. 

http://docs.moodle.org/23/en/File:grading-pick-search.png
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Permissions 
There are two capabilities that affect the user's permission to work with 

templates. 

Share advanced grading form as a template 

(moodle/grade:sharegradingforms) - grants the ability to save a grading 

form as a new shared template and eventually edit and remove own 

templates (templates originally shared by that user). Users with the role of 

manager are given this permission by default. 

 

Manage advanced grading form templates 

(moodle/grade:managesharedforms) - grants the ability to edit and remove 

any shared template, even those originally shared by other users. 

 

If you want to give these permissions to other users (eg to experienced 

teachers who are known to be able to produce high quality grading forms), 

ask your site administrator to define new system roles, eg. 'Grading forms 

publisher' and 'Grading forms manager', having the above capabilities 

granted respectively. Your site admin can then assign these roles to the 

selected users. 

Sharing your grading forms world-wide 
At the moment, there is no way how to export/import grading form 

definitions. The known workaround is to create an empty assignment 

module and attach the grading form to it. Then make a standard activity 

backup of this assignment in the MBZ format and share it. By restoring the 

assignment, the attached grading form is restored, too. It can be then 

picked for your own activities or shared as a template at your site. 

 

 

4.9.1.10.6.What the students see 
When students click on an assignment which has a rubric or marking guide 

attached to it, they will see a link "Submissions grading" under the 

assignment name in their navigation block. Clicking on this will bring up 

the rubric or marking guide in a new screen. 

 

Note: If you think it would be better for students to see grading forms 

directly on the assignment rather than via a link, then there is a tracker 

entry you might like to vote on: MDL-34088. 

 

 

Полномочия 
Есть две Возможности, которые влияют на Полномочие пользователя для работы с 

Шаблонами. 

Поделиться Формой продвинутого оценивания как Шаблоном 

(moodle/grade:sharegradingforms) – предоставляет Возможность сохранять 

Форму Оценивания в качестве нового разделяемого Шаблона и, со временем, 

редактировать и удалять собственные Шаблоны (Шаблоны изначально разделяемые этим 

пользователем). Пользователям с Ролью Менеджера это Полномочие предоставлено по 

умолчанию. 

Управлять Шаблонами Форм продвинутого оценивания 

(moodle/grade:managesharedforms) – гарантировать способность редактировать и удалять 

любые разделяемые Шаблоны, даже те, которые изначально совместно использовались 

другими пользователями. 

Если вы хотите дать эти Полномочия другим пользователям (например, опытным 

Преподавателям, известным способностью создавать высокого качества 

Формы Оценивания), попросите Администратора вашего Сайта определить новые 

системные Роли, например, «Издатель Форм Оценивания», имеющие соответвтвующие 

дополнительные Возможности. Администратор вашего Сайта может затем назначитьэти 

Роли выбранным пользователям. 

Совместное применение ваших Форм Оценивания со всем миром 
На данный момент, нет никакого способа экспорта/импорта 

Определений Форм Оценивания. Известный обходной путь этой проблемы, создать пустой 

модуль «Задание» и прикрепить к нему нужную Форму Оценивания. Затем сделать 

стандартную резервную копию данного Интерактивного Действия «Задание» в формате 

MBZ и поделиться им с другими. Восстанавление этого Задания, восстанавливает 

прилагаемую форму оценивания тоже. Она может быть затем найдена для ваших 

собственных Интерактивных Действий или совместно использована в качестве Шаблона 

на вашем Сайте. 

4.9.1.10.6.Что видят Студенты 
Когда Студенты щёлкнут по Заданию, которое имеет Рубрику или 

Руководство по Проставлению Отметок, прикреплённое к нему, они увидят ссылку 

«Submissions grading (оценивание переданных Студентами готовых ответов)» под 

названием Задания в их Блоке навигации. Щелчок по ней выведет Рубрику или 

Руководство по Проставлению Отметок на новом экране. 

Замечание: Если вы думаете, что было бы лучше для Студентов видеть 

Формы Оценивания непосредственно в Задании, а не через ссылку, то есть запись 

Средства Отслеживания, за которую вам желательно бы проголосовать на: MDL-34088. 

http://docs.moodle.org/23/en/Capabilities/moodle/grade:sharegradingforms
–%20http:/docs.moodle.org/23/en/Capabilities/moodle/grade:managesharedforms
http://tracker.moodle.org/browse/MDL-34088
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4.9.1.10.7.The future of advanced grading 
methods 
Advanced grading methods can currently only be used for assignments. In 

future Moodle versions it is hoped that they can be used in more activity 

modules, such as glossaries and database activities. In addition more 

grading methods can be implemented as independent plugins (including 

custom ones fitting your particular need). 

 

 

Using Moodle forum discussions: 

 A few Advanced Grading questions for Moodle 2.2.1 

 Wrong Gradebook Calculation from 2.2 Rubric 

4.9.1.10.8.Rubrics 
Rubrics are advanced grading forms used for criteria-based assessment. 

The rubric consists of a set of criteria. For each criterion, several 

descriptive levels are provided. A numerical grade is assigned to each of 

these levels. The rater chooses which level answers/describes the given 

criterion best. The raw rubric score is calculated as a sum of all criteria 

grades. The final grade is calculated by comparing the actual score with the 

worst/best possible score that could be received. 

 

 

4.9.1.10.9.Marking guide 
A marking guide is an advanced grading method where a teacher enters a 

comment per criterion and a mark up to a maximum. 

 

 

4.9.1.10.10.Learning Analytics Enriched Rubric 
The Learning Analytics Enriched Rubric (LA e-Rubric) is an advanced 

grading method used for criteria-based assessment. As a rubric, it consists 

of a set of criteria. For each criterion, several descriptive levels are 

provided. A numerical grade is assigned to each of these levels. 

An enriched rubric contains some criteria and related grading levels that 

are associated to data from the analysis of learners’ interaction and 

learning behavior in a Moodle course, such as number of post messages, 

times of accessing learning material, assignments grades and so on. 

Using learning analytics from log data that concern collaborative 

interactions, past grading performance and inquiries of course resources, 

the LA e-Rubric can automatically calculate the score of the various 

4.9.1.10.7.Будущее Продвинутых Методов Оценивания 
 

Продвинутые Методы Оценивания в настоящее время могут быть использованы 

только для Заданий. Есть надежда, что в будущих версиях Moodle они могут быть 

использованы в большинстве модулей Интерактивных Действий, таких как 

Интерактивные Действия «Глоссарии» и «Базы Данных». В дополнение несколько 

Методов Оценивания могут быть реализованы в виде модулей независимых 

производителей (включая привычные для клиента Методы Оценивания, соответствующие 

вашей конкретной потребности).  

Обсуждения форума по использованию Moodle:  

 Несколько вопросов по продвинутому оцениванию для Moodle 2.2.1. 

 Неверные перенесение Оценок в Журнал Оценок из Рубрик версии Moodle 2.2. 

4.9.1.10.8.Рубрики 
Рубрики являются продвинутыми Формами Оценивания, используемыми для 

оценивания по Критериям. Рубрика состоит из набора Критериев. Для каждого критерия 

предоставляется несколько уровней Описания. Для каждого из этих уровней назначается 

Числовая Оценка. Ранжирующий выбирает, какой уровень ответов/описаний для данного 

критерия наилучший. Исходные Накопленные Баллы по Рубрике рассчитывается как 

сумма всех Оценок по критериям. Итоговая Оценка рассчитывается путём сравнения 

фактически Накопленных Баллов с наихудшими/максимально возможными 

Накопленными Баллами, которые могли бы быть получены. 

Дальнейший текст этого раздела располагается по адресу. 

4.9.1.10.9.Руководство по Проставлению Отметок 
Руководство по Проставлению Отметок является продвинутым методом 

оценивания, в котором Преподаватель вводит комментарий по критерию и устанавливает 

отметку вплоть до максимальной. 

Дальнейший текст этого раздела располагается по адресу. 

4.9.1.10.10.Изучение Аналитически Обогащённой Рубрики 
Изучение Аналитически Обогащенной Рубрики (ИАО-Рубрика) является 

передовым методом оценивания, используемым для оценивания на основе критериев. Как 

и Рубрика она состоит из набора Критериев. Для каждого Критерия предоставляется 

несколько уровней описания.Числовая Оценка назначается для каждого из этих уровней. 

Обогащённая Рубрика содержит некоторые Критерии и соответствующие 

Уровни Оценивания, которые связаны с данными из анализа взаимодействия учащихся и 

протекания обучения в Курсе Moodle, таких как количество почтовых сообщений, 

обращений к учебному материалу, Оценки за Задания и так далее. 

Используя аналитику обучения из регистрируемых данных, которые касаются 

совместных взаимодействий, прошлые результаты оценивания и запросы ресурсов Курса, 

ИАО-Рубрика может автоматически рассчитать Накопленные Баллы на различных  

http://moodle.org/mod/forum/discuss.php?d=193460
http://moodle.org/mod/forum/discuss.php?d=193961
http://docs.moodle.org/25/en/Rubrics
http://docs.moodle.org/25/en/Marking_guide
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levels per criterion. The total rubric score is calculated as a sum of the 

scores per each criterion. 

You may click this link to view the Introduction to Learning Analytics 

Enriched Rubric video. 

 

4.9.1.11.Grade editing 
In the grader report (In the Gradebook), in editing mode, users with the 

appropriate permissions can edit individual grades. Following is an 

explanation of the various settings and their effects on grades. 

4.9.1.11.1.General description 
This form has a number of fields which are 'frozen': they cannot be 

changed except under certain conditions: 

 User: The name of the course participant to whom this grade is 

attributed 

 Item name: The name of the grade item to which this grade belongs 

 

 Final grade: The grade value after all calculations have been 

performed. This can be edited if the grade was created manually. 

4.9.1.11.2.Editable settings 
Overridden 
When on, the overridden flag prevents any future attempts to automatically 

adjust the value of the grade. This flag is often set internally by the 

gradebook, but can be switched on and off manually using this form 

element. 

This must be distinguished from the "locked" flag, which only prevents 

modules from changing the grade value. With "overriden", even the 

gradebook calculations and aggregations no longer have any effect on this 

grade. 

Excluded 
When on, prevents this grade from being included in any aggregation. 

 

Hidden 
If on, the grade will appear as a hyphen (-) to any user without the 

permission to view hidden grades. This usually refers to students. 

 

Hidden until 
This is used instead of the "hidden" flag, when hiding is desired until a 

certain date, after which the grade will be revealed. 

уровнях критерия. Итоговый Накопленный Балл по Рубрике рассчитывается как сумма 

баллов по каждому критерию. 

Вы можете по этой ссылке посмотреть видео «Введение в 

Изучение Аналитически Обогащенной Рубрики». 

Дальнейший текст этого раздела располагается по адресу. 

4.9.1.11.Редактирование Оценок 
В Отчёте Оценивающего (в Журнале Оценок), в режиме редактирования, 

пользователи с соответствующими Полномочиями могут редактировать Оценки. Ниже 

приведено объяснение различных настроек и их влияние на Оценки. 

4.9.1.11.1.Обычное описание 
Эта форма имеет ряд полей, которые «заморожены»: они не могут быть изменены, 

за исключением определённых условий: 

 User (имя): Имя участника Курса, который этой Оценкой характеризуется. 

 

 Item name (название элемента): Название Элемента Оценивания, которому Эта Оценка 

принадлежит. 

 Final grade (итоговая оценка): Значение Оценки после всех вычислений, которые были 

выполнены. Она может быть отредактирована, если эта Оценка была создана вручную. 

4.9.1.11.2.Редактируемые настройки 
Переопределенный 

Если включён (в «On»), флажок «Overridden» предотвращает любые будущие 

попытки автоматически настроить значение этой Оценки. Этот флажок часто 

устанавливается изнутри Журнало Оценок, но может быть включён или выключен 

вручную, используя этот элемент Формы. 

«Overridden» нужно отличать от флажка «Locked (заблокировано)», который 

предотвращает модули только от изменения значения Оценки. С «Locked» даже 

вычисления Журнала Оценоки и Агрегации дольше не оказывают какого-либо эффекта на 

эту Оценку. 

Запрещено 
Если включено (в «On»), предотвращает эту Оценку от включения в какую-либо 

Агрегацию. 

Скрыто 
Если включено (в «On»), Оценка будет появляться как дефис (-) любому 

пользователю без Полномочия видеть скрытые Оценки. Это обычно относится к 

Студентам. 

Скрыто до 
Это используется вместо флажка «Скрыто», когда сокрытие желательно до 

определённой даты, после которой эта Оценка будет открыта. 

http://www.youtube.com/watch?v=AUaw-_fh84o&hd=1
http://www.youtube.com/watch?v=AUaw-_fh84o&hd=1
http://docs.moodle.org/25/en/Learning_Analytics_Enriched_Rubric
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Locked 
If on, the grade will ignore updates from the module. 

Locked after 
This is used instead of the "locked" flag, when locking is desired only after 

a certain date, after which the grade will be locked. This date is usually set 

as the same as the "hidden until" date., or shortly before (giving teachers a 

chance to review the grades before revealing them). 

 

Feedback 
The grader's comments about the grade. 

Format 
The formatting to be applied to the feedback once displayed. 

 

4.9.1.11.3.See also 
Using Moodle forum discussions: 

 Grading locked in assignments but not locked in gradebook? 

 Resetting all overridden flags 

4.9.1.12.Grades FAQ 
4.9.1.12.1.General 
How can I change how grades are displayed? 
Grades may be displayed as actual grades, as percentages (in reference to 

the minimum and maximum grades) or as letters. 

The default grade display type for the site is set by an administrator in 

Administration > Grades > Grade item settings. However, this may be 

changed at course level. 

To change how grades are displayed for particular grade items, or category 

and course summaries (called aggregations): 

1. Follow the grades link in the course administration block. 

2. Select "Categories and items" from the gradebook dropdown menu. 

3. Click the edit icon for the grade item, category total or course total. 

 

4. From the Grade display type menu, select real (for actual grades), 

percentage or letter. 

5. Click the "Save changes" button at the bottom of the page. 

Alternatively, to change how grades are displayed for the whole course: 

1. Follow the grades link in the course administration block. 

2. Select "Course settings" from the gradebook dropdown menu. 

 

Заблокировано 
Если включено (в «On»), Оценка будет игнорировать обновления из модуля. 

Заблокировано после 
Это используется вместо флажка «Заблокировано», когда блокирование 

желательно только после определённой даты, после которой эта Оценка будет 

заблокирована. Эта дата обычно установлена так же, как дата «Срыто до» или, для 

краткости, до (давая Преподавателям возможность предварительно просмотреть Оценки 

прежде, чем открыть их). 

Обратная Связь 
Комментарии Оценивающего об этой Оценке. 

Формат 
Форматирование, которое должно быть применено к однажды отображённой 

Обратной Связи. 

4.9.1.11.3.См. также 
Обсужддения форума по использованию Moodle: 

 Оценивание, заблокированное в Заданиях, но не заблокированное в Журнале Оценок? 

 Переустановка всех переопределённых флажков. 

4.9.1.12.Часто задаваемые вопросы по Оценкам 
4.9.1.12.1.Обычные 
Как можно изменить то, какие Оценки отображаются? 

Оценки могут отображаться как фактические (Real) Оценки, в процентах (по 

отношению к минимальной и максимальной Оценкам) или в виде Букв. 

Тип отображения Оценки по умолчанию для Сайта устанавливается 

Администратором в Site Administration→Grades→Grade item settings. Тем не менее, он 

может быть изменен на уровне Курса.  

Чтобы изменить то, как отображаются Оценки для отдельных 

Элементов Оценивания или Категории и Резюме по Курсу (называемых Агрегациями): 

1. Следуй ссылке Grades (оценки) в Блоке управления Курсом. 

2. Выберите «Categories and items (категории и элементы)» из меню Журнала Оценок. 

3. Щелкните иконку редактирования для элемента Оценки, общей Категории или общего 

Курса. 

4. В меню Grade display type (тип отображения оценки), выберите Real (для фактических 

Оценок), Percentage (процент) или Letter (буква). 

5. Щёлкните кнопку «Save changes (сохранить изменения)» в нижней части страницы.  

Кроме того, чтобы изменить способ оценки отображаются за весь Курс. 

1. Следуйте ссылке Grades (оценки) в Блоке управления Курсом. 

2. Выберите «Course settings (настройки курса)» из ниспадающего меню Журнала Оценок. 

http://moodle.org/mod/forum/discuss.php?d=97807
http://moodle.org/mod/forum/discuss.php?d=114150#p502755
http://docs.moodle.org/23/en/Grade_item_settings
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3. From the Grade display type menu, select real (for actual grades), 

percentage or letter. 

4. Click the "Save changes" button. 

How can I hide entered grades until a specified date? 
To set a "Hidden until" date: 

1. Access the course gradebook via the grades link in the course 

administration block. 

2. Select "Categories and items" from the gradebook dropdown menu. 

 

3. Click on the edit icon opposite the activity for which a "Hidden until" 

date is to be set. 

4. On the edit grade item page, ensure that advanced settings are 

displayed. (Click the "Show advanced" button if not.) 

5. Enable the "Hidden until" setting by unchecking the disable checkbox, 

then set a date. 

6. Click the "Save changes" button. 

Is it possible to show the teachers/administrators' 
grades in the grader report? 
Yes, at the site level you can define which roles will appear in the grader 

report. This can be found in Administration > Grades > General settings. 

Also read this discussion for some more ideas. 

Why can't I change a grade within an assignment 
after changing it in the gradebook? 
When you edit a grade directly in the gradebook, an "overridden" flag is 

set, meaning that the grade can no longer be changed from within the 

assignment. 

However, the flag can be removed by turning editing on in the grader 

report, then clicking the edit grade icon, unchecking the overridden box 

and saving the changes. 

How do I get groups to show up in the grader report? 
For groups to show up in the grader report, group mode should be set to 

visible or separate groups in the course settings. This will result in a groups 

dropdown menu being displayed, enabling a teacher to view the grades of 

all participants, or only the grades for a selected group. 

How can I make the gradebook simpler for teachers? 
See Simplifying the gradebook by changing permissions. 

 

 

 

3. В меню Grade display type (тип отображения оценки), выберите Real (для фактических 

Оценок), Percentage (Оценки в процентах) или Letter (для Оценки буквами). 

4. Щёлкните кнопку «Save changes (сохранить изменения)». 

Как скрыть введённые Оценки до конкретной даты? 
Чтобы установить дату «Hidden until (скрыто до)»: 

1. Перейдите в Журнал Оценок Курса по ссылке Grades в Блоке управления Курсом. 

 

2. Выберите «Categories and items (категории и элементы)» из ниспадающего меню 

Журнала Оценок. 

3. Щёлкните иконку редактирования рядом с Интерактивным Действием, для которого 

должна быть установлена дата Hidden until). 

4. На странице «Edit grade item (редактировать элемент оценивания)» убедитесь, что 

отображены продвинутые настройки (щёлкните кнопку «Show advanced», если  нет). 

5. Включите настройку «Hidden until» снятием пометки с окошка-флажка «Disable 

(отключено)», затем установите дату. 

6. Щёлкните кнопку «Save changes». 

Можно показать Оценки Преподавателей/Администраторов в 
Отчёте Оценивающего? 

Да, на уровне Сайта можно определить какие Роли появятся в Журнале Оценок. 

Это можно отыскать в Site Administration→Grades→General settings. Также прочитайте эту 

дискуссию для получения дополнительных идей. 

Почему я не могу изменить Оценку внутри Задания после 
изменения её в Журнале Оценок? 

При редактировании Оценки непосредственно в Журнале Оценок установливается 

флажок «Overridden (переопределённое)», означающий, что эта Оценка не может быть 

больше изменена изнутри Задания. 

Однако этот флажок можно снять, включив режим редактирования в 

Отчете Оценивающего, затем щёлкнув иконку «Edit grade (реадктировать оценку)», сняв 

пометку окошка «Overridden» и сохранив изменения. 

Как осуществить показ Групп в Отчёте Оценивающего? 
Чтобы показывать Группы в Отчёте Оценивающего, в настройках Курса дожен 

быть установлен Групповой Режим в Visible groups или Separate groups. Это подействует 

на отображение ниспадающего меню Groups, позволяя Преподавателю просматривать 

Оценки всех Участников или только Оценки выбранной Группы. 

Как упростить Журнал Оценок для Преподавателей? 
См. «Упрощение Журнала Оценок» путём изменения Полномочий»:. 

http://moodle.org/mod/forum/discuss.php?d=92612
http://docs.moodle.org/23/en/Simplifying_the_gradebook_by_changing_permissions


 

465 

The quiz grades keep disappearing from the student 
view, even after I un-hide them! 
Check your quiz settings. Under the Review options heading, in the Later, 

while the quiz is still open and/or the After the quiz is closed columns, you 

probably have Scores un-checked. Each time a student completes a quiz, 

these settings are consulted and the scores will be hidden from all students. 

If your students don't all take the quiz at the same time, it can look like 

quiz scores reset themselves to 'hidden' randomly, even after you un-hide 

them. 

4.9.1.12.2.Grades and user removals 
What happens to gradebook data when a user is 
unenrolled from a course? 
On re-enrolling, you can recover their grades from before: see Recover 

grades on re-enrol 

4.9.1.12.3.Advanced grading 
Why can't I see the advanced grading option?? 
To see the option for Advanced grading, you first have to create an 

assignment and choose Advanced grading/Rubric from the Grading 

method dropdown. Advanced grading will then appear in 

Settings>Assignment administration. 

How can I allow teachers to save rubrics as templates 
for others? 
Create a new role and assign it in the system context. Give this role the 

capability moodle/grade:sharegradingforms (for sharing as a template) and 

if desired moodle/grade:managesharedforms (for editing or deleting 

templates created by others) Assign this role to those teachers you wish to 

have this ability. 

How do students see the Marking guide? 
Assuming the teacher has allowed this in the Marking guide settings, the 

student may click "submissions grading" under the assignment name in 

their navigation block: 

 

4.9.1.12.4.Reports 
How do I create my own custom gradebook reports? 
 
Here is a tutorial explaining all the main steps involved. 

 

 

Оценки за Экзамен остаются не видимыми Студенту даже после 
того, как я снял их сокрытие! 

Проверьте настройки Экзамена. Под заголовком опций обзора (Review), в Later 

(позднее), пока Экзамен остаётся открытым и/или После сокрытия колонок Экзамена, у 

вас, вероятно, не-проверены Накопленные Баллы. Каждый раз, когда Студент завершает 

Экзамен, эти настройки принимаются во внимание, а Накопленные Баллы будут скрыты 

от всех Студентов. Если ваши Студенты не все пройдут Экзамен в одно и то же время, это 

может выглядеть подобно Экзамену, Оценки которого повторно устанавливают себя в 

«Hidden» случайным образом, даже после того как вы снимите их сокрытие. 

4.9.1.12.2.Оценки и исключения пользователей 
Что произойдёт с данными Журнала Оценок при исключении 
пользователя с Курса? 

При повторном зачислении, вы можете восстановить свои предыдущие Оценки: 

см. «Восстановить Оценки при повторном зачислении». 

4.9.1.12.3.Продвинутое оценивание 
Почему я не могу видеть опцию продвинутого оценивания?? 
Чтобы увидеть опцию для «Advanced grading (продвинутое оценивание)», сначала нужно 

создать Задание и выбрать Advanced grading/Rubric а в выпадающем окне Grading method 

(метод оценивания). Advanced grading тогда появится в 

Administration→Assignment administration. 

Как позволить Преподавателям сохранять Рубрики в виде 
Шаблонов для других? 

Создать новую Роль и назначить её в Контексте системы. Предоставьте этой Роли 

возможность moodle/grade:sharegradingforms (для совместного использования в качестве 

шаблона) и, при желании moodle/grade:managesharedforms (для редактирования или 

удаления шаблонов, созданных другими). Назначьте эту Роль тем Преподавателям, 

которым хотите предоставить эту способность. 

Как Студентам увидеть Руководство по Проставлению Отметок? 
Предполагая, что Преподаватель позволил это в настройках 

Руковоство по Проставлению Отметок, Студент может щёлкнуть «Submissions grading 

(оценивание переданных на рассмотрение ответов)» под 

названием Задания в своём Блоке Навигации: 

4.9.1.12.4.Отчёты 
Как создать мои собственные привычные мне Отчёты по 
Журналу Оценок? 

Вот руководство, объясняющее все включённые главные шаги. 

http://docs.moodle.org/23/en/Grade_settings#Recover_grades_default
http://docs.moodle.org/23/en/Development:Gradebook_Report_Tutorial
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How can I sort or change the order of column 
headings? 
Go to Grades link, then select one of the "Category & items" actions from 

the pulldown on the top left. Use the move icon to change the position of 

the graded item. And/or you could create categories for the items and move 

them into a category so they will be grouped that way first. 

 

How can I remove user ID numbers and/or email 
addresses from the grader report 
Go to Settings > Site administration > Users > Permissions > User policies 

and untick the 'ID number' and/or 'email address' checkboxes for 'Show 

user identity'. 

 

Note that this will result in ID numbers and/or email addresses not being 

shown when searching for users and displaying lists of users. See the 

section 'Show user identity' in Roles settings for a list of locations where 

user identity fields are shown. 

4.9.1.12.5.Aggregation 
I can't find where to change the aggregation type for 
my gradebook categories! 
Each category has an aggregation type, which can be changed through that 

category's "edit" page. To access that page, you must use one of 2 ways: 

 

1. In the grader report, turn "Editing" on, then click the little "hand" icon 

next to the category whose aggregation you want to change. 

 

2. In the "Edit categories and Items" page (accessible through the "choose 

an action" menu, top left), you see a tree view of the categories and items 

in your gradebook. The top category is the course category. Each category 

also has a "hand" icon, which leads to the category edit page. 

 

How can I grade some of my activities without the 
results affecting my students' course total? 
1. Go to Grades and choose the "Category and items" tab. 

2. Add two Grade categories, one for your "Graded activities" and 

one for your "Not graded activities". In the "Not graded activities" 

category choose "None" in grading type. 

 

Как можно отсортировать или изменить порядок заголовков 
колонок? 

Перейдите по ссылке Grades (оценки), а затем выберите одно из действий 

«Category & items (категория и элементы)» в выпадающем меню в левом верхнем углу. 

Используйте иконку Move (переместить), чтобы изменить положение 

Элемента Оценивания. И/или вы могли бы создать Категории для Элементов и 

переместить их в Категорию, с тем чтобы сначала сгруппировать их таким путём. 

Как можно удалить из Отчёта Оценивающего пользовательские 
номера ID и/или адреса э-почты 

Перейдите в 

Administration→Site administration→Users→Permissions→User policies и снимите галочку с 

«ID number (идентификационный номер)» и/или флажки «Email address (адрес э-почты)» 

для «Show user identity (показать подлинность пользователя). 

Заметьте, что это приведёт к тому, что номера ID и/или адреса э-почты не будут 

показаны при поиске пользователей и отображения списков пользователей. См. раздел 

«Show user identity (показать подлинность пользователя)» в настройках Ролей для списка 

местоположений, где показываются поля подлинности пользователя. 

4.9.1.12.5.Агрегация 
Я не могу найти, где изменить тип Агрегации для моих Категорий 
Журнала Оценок! 

Каждая Категория имеет тип Агрегации, который может быть изменён через 

страницу «Edit (редактировать)» для этой Категории. Чтобы получить доступ к этой 

странице, вы должны использовать один из 2 способов:  

1. В Отчёте Оценивающего, включите «Editing (редактирование)», затем щёлкните 

небольшую иконку «Hand (рука)» рядом с Категорией, чью Агрегацию вы хотите 

изменить. 

2. На странице «Edit categories and Items (изменить категории и элементы)», доступной 

через меню «Choose an action (выберите действие)» вверху слева, вы увидите в вашем 

Журнале Оценок Категории и элементы в виде дерева. Самая верхняя Категория 

является категорией Курса. Каждая категория имеет значок «шестерёнка», который 

приведёт к странице редактирования Категории. 

Как можно оценить некоторые из Интерактивных Действий так, 
чтобы они не повлияли на Итоговую Оценку Студентов за Курс? 
1. Перейдите в Grades и выберите вкладку «Category and items (категория и предметы)». 

2. Добавьте две Категории Grade, одну для ваших «Graded activities (оцениваемые 

интерактивные действия)» и одну для ваших «Not graded activities (не оцениваемые 

интерактивные действия)». В Категории Not graded activities выберите тип оценивания 

«None (никакой)». 
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3. Ensure that "Aggregate including subcategories" (an option visible 

only in "full view") is unchecked for your top level course grade 

category. 

4. If you want to completely hide the "Not graded activities" category 

from your students tick the "Hidden" icon too. 

5. Save your changes. 

6. Move all your normally graded activities into the "Graded 

activities" category. 

7. Move all your excluded from grading activities into "Not graded 

activities" category. 

Note: Following the above steps the not graded activities will be 

completely hidden from your students. So... 

 IF you want the activity grades of the "Not graded activities" category, 

to remain visible to your student without their grades affecting their 

course total, simply click the eye to show the "Not graded activities" 

category. 

 IF you want students to be able to see the activity grades and the 

category total of the "Not graded activities", then you have to let the 

category visible and also choose a grading type between value, scale or 

text, by editing the category. 

 

In this case you can exclude the "Not graded activities" from course total 

using the "Weighted mean of grades" aggregation method in Course 

category and assigning 100 weight to the "Graded activities" and 0 weight 

to the "Not graded activities". 

 

 IF you don't want to use grade categories, you can also exclude the 

grades of a specific activity by changing the "Multiplicator" (visible 

only in "full view") from 1.0 into 0.0. 

 Last, IF you want to exclude the grade of an activity only to one or 

some specific students, then follow these steps: 

1. From the grader report "Turn editing on" 

2. Click the "Edit grade" icon of the activity of the student you want to 

exclude. 

3. In the Edit grade page, check the tick box next to the "Excluded" 

option and "Save changes". 

 

 

 

 

3. Убедитесь, что с опции «Aggregate including subcategories (агрегировать включая 

подкатегории)» (опция видна только в режиме «Full view (полный вид)») снята отметка 

для вашей верхнего уровня Категории Оценок за Курс. 

4. Если вы хотите полностью скрыть Категорию Not graded activities от ваших Студентов 

отметьте также иконку «Hidden (скрытая)». 

5. Сохраните изменения. 

6. Переместите все ваши обычно оцениваемые Интерактивные Действия в Категорию 

Graded activities. 

7. Переместите все ваши исключённые из оценивания Интерактивные Действия в 

Категорию Not graded activities. 

Замечание: Следуя приведённым выше шагам не оцениваемые 

Интерактивные Действия будут полностью скрыты от ваших Студентов. Итак... 

 Если вы хотите, чтобы оценки за Интерактивное Действие Категории Not graded 

activities остались видимыми вашему Студенту без их Оценок, влияющих на 

Итоговую Оценку за Курс, просто нажмите на «глаз», чтобы показать Категорию Not 

graded activities. 

 ЕСЛИ вы хотите, чтобы Студенты были в состоянии видеть Оценки за 

Интерактивное Действие и Итоговую Оценку за Категорию Not graded activities, тогда 

вы должны позволить быть Категории видимой, а также выбрать тип оценивания из 

Value (значение), Scale (шкала) или Text (текст) посредством редактированием 

Категории. 

В этом случае вы можете исключить Not graded activities (не оцениваемые 

интерактивные действия) из Итоговой Оценки за Курс с помощью метода Агрегации 

«Weighted mean of grades (взвешенное среднее из оценок)» в Категории Курса, присвоив 

вес 100 к «Graded activities (оцениваемые интерактивные действия)» и вес 0 «Not graded 

activities (не оцениваемые интерактивные действия)». 

 ЕСЛИ вы не хотите использовать Категории Оценок, вы также можете исключить 

Оценки за конкретное Интерактивное Действие, изменением «Multiplicator 

(множитель)» (видимый только в «Full view») от 1,0 в 0,0. 

 Последнее, ЕСЛИ вы хотите исключить Оценку за Интерактивное Действие только 

одному или некоторым конкретным Студентам, тогда выполните следующие действия: 

1. Из Отчёта Оценивающего включите режим редактирования. 

2. Щёлкните иконку «Edit grade (редактировать оценку)» того 

Интерактивного Действия Студента, за которое необходимо исключить Оценку. 

3. На странице Edit grade, пометьте галочкой окошко рядом с опцией «Excluded 

(исключённые)» и щёлкните «Save changes (сохранить изменения)». 
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My student completed only one activity out of 5, but 
his course total shows 100%. How do I show a more 
"progressive" course total? 
Step-by-Step Explanation 
1. From the view menu in the gradeboook, select "Categories and items" 

2. At the top line there is a folder icon and an edit icon on the right, click 

the edit icon 

3. You'll then see the title "Grade category," the 3rd item is "Aggregate 

only non-empty grades." 

 

4. Uncheck this. 

5. Save. 

Another Explanation 
By default, only non-empty grades are aggregated, the others are ignored. 

However, you can change this setting as well as others that affect the 

course total, by turning "Editing" on in the grader report, and clicking the 

"Edit" icon next to the course category (the very top row of the grader 

report). 

You can untick the box "Aggregate only non-empty grades" if you want to 

show a more "progressive" score for each student. Their empty grades will 

count as a 0 and will be counted in the course mean/total. 

 

If you prefer to show a sum of points, rather than a percentage, you can 

change the course category's aggregation method to "Sum of grades". 

How can I display the average grade for my course 
categories (not grade categories)? 
In Moodle 1.9 there is no way to aggregate course totals within each 

category. The gradebook is course-centered, and there is currently no User 

Interface for showing grades within an entire course category at once. 

 

How can I setup weighted assignments? 
See Using "Weighted Mean of Grades" to weight categories containing 

assignments. 

4.9.1.12.6.Categories 
How many depths of categories/subcategories can I 
create? 
There is no programmatic limit, but there are practical limits. 

Very deeply nested structures are difficult to manage. 3 levels of categories 

Мой Студент завершил только одно Интерактивное Действие из 
5, но его Итоговая Оценка за Курс установлена в 100%. Как 
показать более «Последовательную» Итоговую Оценку за Курс? 
Пошаговое объяснение  
1. В меню просмотра Журнала Оценок, выберите «Categories and items (категории и 

элементы)». 

2. В верхней строке есть иконка папки и справа иконка редактирования, щёлкните иконку 

редактирования  

3. Затем вы увидите название «Grade category (категория оценки)», 3-й элемент является 

опцией «Aggregate only non-empty grades (агрегировать только непустые оценки)». 

4. Снимите отметку. 

5. Сохраните. 

Другоеобъяснение 
По умолчанию только непустые Оценки Агрегируются, другие игнорируются. Тем 

не менее, вы можете изменить эту настройку, а также другие, которые влияют на 

Итоговую Оценку за Курс, включив режим редактирования в Отчёте Оценивающего, и 

нажав на иконку «Edit (изменить)» рядом с Категорией Курса (самая верхняя строка 

Отчета Оценивающего). 

Вы можете снять флажок «Aggregate only non-empty grades (агрегировать только 

непустые оценки)», если хотите показать более «Progressive (последовательную)» Оценку 

для каждого Студента. Их пустые Оценки будут учитываться как 0 и будут 

подсчитываться в Курсе как Средняя/Итоговая Оценка. 

Если вы предпочитаете показывать Сумму Баллов, а не Проценты, вы можете 

сменить Метод Агрегирования Категории Курса на «Sum of grades (сумма оценок)». 

Как отобразить Среднюю Оценку для Категорий моего Курса (не 
Категорий Оценок)? 

В Moodle 1.9 нет никакого способа, чтобы Агрегировать Итоговые Оценки Курса 

внутри каждой Категории. Журнал Оценок ориентируется на Курс, и в настоящее время 

нет Пользовательского интерфейса для показа Оценок сразу внутри целой Категории 

Курса. 

Как можно установить взвешенные Задания? 
См. «Использование «Взвешенное среднее Оценок)», содержащие Задания». 

 

4.9.1.12.6.Категории 
Как много уровней Категорий/подКатегорий можно создать? 
 

Нет программного ограничения, но существуют практические ограничения. 

Очень глубоко вложенными структурами трудно управлять. 3 уровня Категорий 

http://docs.moodle.org/23/en/Using_%22Weighted_Mean_of_Grades%22_to_weight_categories_containing_assignments
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should be sufficient for most situations. Note that there is always at least 

one level of categories, since the Course category always encompasses all 

other categories and grade items, can cannot be deleted. 

I can't find setting X in the grade category edit page! 
Where is it? 
If a setting documented on the Grade categories page does not appear on 

your edit page, it may mean that it is set globally in your site. See Forcing 

settings for more information. 

 

4.9.1.12.7.Outcomes 
I want to set up an outcome item for my course. What 
are the steps required? 
1. The site administrator needs to have enabled outcomes via 

Settings>Site Aaministration > Advanced Features >Enable Outcomes 

2. In your course, go to Settings>Course administration>Grades>Scales 

and create the scale you need. 

 

3. Create a scale 

4. In Settings>Course administration>Outcomes, create a course outcome 

assigning it to the scale you just created. 

5. Read the outcomes documentation for instructions). 

6. You can now give your students a rating on the outcome dimension you 

just created. If you created a standard outcome, you will be able to use 

it in other courses and follow your students' performance across these 

courses. 

How can I remove an outcome from an activity? 
An outcome can be removed from an activity by deleting it on the 

gradebook edit categories and items page. This results in the outcomes 

being deselected on the update activity page. 

 

4.9.1.12.8.Modules 
The activity module (Module name) doesn't support 
grading. How can I give my students a grade 
anyway? 
You can create a grade item manually in the gradebook. You will have to 

grade your students through the Grader report interface (in editing mode). 

 

 

должно быть достаточно для большинства ситуаций. Заметьте, что всегда есть, по крайней 

мере, один уровень Элементы Оценивания, и не может быть удалена. 

 

Я не могу найти настройку X на странице редактирования 
Категории Оценок! Где она? 

Если настройка, задокументированная на странице Категории Оценок, не 

появляется на вашей странице редактирования, это может означать, что она установлена в 

глобальном масштабе на Вашем Сайте. Смотрите «Forcing settings (принуждающие 

настройки)» для получения дополнительной информации. 

4.9.1.12.7.Показатели 
Я хочу установить Элемент Показателя для моего Курса. Какие 
требуются шаги? 
1. Администратор Сайта должен включить Показатели через 

Administration→Site Administration→Advanced Features→Enable Outcomes. 

2. В вашем Курсе перейдите в меню 

Administration→Course Administration→Advanced Features→Enable Outcomes. и создайте 

Шкалу, если вам нужно. 

3. Создайте Шкалу  

4. В меню Administration→Course Administration→Outcomes создайте Показатель Курса, 

приписав его Шкале, которую вы только что создали. 

5. Прочтите документацию о Показателях для получения инструкций. 

6. Теперь вы можете задать своим Студентам Рейтинг по измерению Показателя, который 

вы только что создали. Если вы создали стандартный Показатель, вы сможете 

использовать его в других Курсах и следовать действиям ваших Студентов в этих 

Курсах. 

Как можно удалить Показатель из Интерактивного Действия? 
Показатель может быть удалён из Интерактивного Действия, удалением его из 

Категорий редактирования Журнала Оценок и со страницы Элементов. Это приведёт к 

тому, что выбор Показателей будет отменён на странице обновления 

Интерактивного Действия. 

4.9.1.12.8.Модули 
Модуль Интерактивного Действия (название модуля) не 
поддерживает оценивание. Как бы то ни было, как дать 
Студентам Оценку? 

Вы можете создать Элемент Оценивания вручную в Журнале Оценок. Вам 

придётся оценить ваших Студентов через интерфейс Отчёта Оценивающего (в режиме 

редактирования). 
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I just graded some of my students using the (Module 
name) interface, but the results aren't showing up in 
the grader report. What's going on? 
Here are some of the possible reasons: 

1. The site settings>Grades>General settings may not have the correct 

graded roles checked off to appear in grade book. If you see no students 

in the Gradebook but do see columns for the graded activities, then 

check the graded role settings. 

 

2. The corresponding grade item is locked, or its parent category is locked. 

 

3. The module code is not using the gradebook API correctly. 

I just created a new assignment with the "Grade" 
setting set to "No grade", but it still appears in the 
gradebook 
The reason is that the gradebook is now the place where both numerical 

and textual types of feedback are recorded for all activity modules. The 

word "Grading" in assignment relates only to numerical grades, but the 

ability to give text feedback remains, and must be recorded in the 

gradebook. This is why a grade item is created for it. You can hide the 

grade item if you do not want it to appear in the user reports. 

4.9.1.12.9.Weights and extra credits 
How do weighted grades influence the category or 
course total? 
A weight (also called coefficient) only has meaning in reference to other 

weights. If you only have one grade item, changing its weight will not have 

any effect. However, if you have two grade items, each with a different 

weight, the "heavier" item will have more influence on the total grade than 

the "lighter" one. 

You can set the weights to any positive numerical value you choose. 

Usually, at least one of the weights will be 1 and serve as the baseline for 

other weights. If another item has a weight of 2, its grades will be 

multiplied by 2 compared with the grades of the first grade item, before 

being averaged. The denominator used for averaging is the sum of all the 

weights. 

 

 

 

Я просто оценил некоторых из моих Студентов, используя 
интерфейс (название модуля), но результаты не показываются в 
Отчёте Оценивающего. Что происходит? 

Вот некоторые из возможных причин: 

1. Administration→Site Administration→Grades→General settings. могут не иметь 

правильно оценённые Роли без пометок, позволяющих им появляться в 

Журнале Оценок. Если вы не видите Студентов в Журнале Оценок, но видите столбцы 

для оцениваемых Интерактивных Действий, тогда пометьте настройки оцениваемой 

Роли. 

2. Соответствующий Элемент Оценивания блокируется или его родительская Категория 

блокируется. 

3. Код модуля не использует корректно API Журнала Оценок. 

Я просто создал новое Задание с настройкой «Grade», 
установленной в «No grade», но оно всё равно появляется в 
Журнале Оценок 

Причина в том, что Журнал Оценок теперь – место, где учитываются как числовые, 

так и текстовые типы Обратной Связи для всех модулей Интерактивных Действий. Слово 

«Grading (оценивание)» в Задании относится только к Числовым Оценкам, но способность 

дать текстовую Обратную Связь остаётся и должна быть учтена в Журнале Оценок. 

Именно поэтому Элемент Оценивания создан для неё. Вы можете скрыть 

Элемент Оценивания, если не хотите, чтобы он появился в пользовательских отчётах. 

4.9.1.12.9.Веса и экстра «кредиты» 
Как Взвешенные Оценки влияют на Итоговую Оценку по 
Категории или Курсу? 

Вес (также называемый коэффициентом) имеет смысл только по отношению к 

другим Весам. Если у вас есть только один Элемент Оценивания, изменение его Веса не 

будет иметь никакого эффекта. Однако, если у вас есть  два Элемента Оценивания, 

каждый с разным Весом, более «тяжёлый» элемент будет иметь большее влияние на 

Итоговую Оценку, чем более «лёгкий». 

Вы можете задать Веса любым положительным числом, которое выберите. Как 

правило, по крайней мере, один из Весов задаётся равным 1 и служит в качестве базового 

уровня для других Весов. Если другой элемент имеет Вес 2, его Оценки перед 

вычислением Среднего будут умножаться на 2 по сравнению с Оценками первого 

элемента Оценки. Знаменатель, используемый для вычисления Среднего, является суммой 

всех Весов. 
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An example follows: 

item 1 weight: 1 

item 2 weight: 3 

item 3 weight: 0.5 

 

item 1 grade: 40/100 

item 2 grade: 60/100 

item 3 grade: 20/100 

 

Calculation:  

total = ((40 * 1) + (60 * 3) + (20 * 0.5)) / (1 + 3 + 0.5) 

       = (40 + 180 + 10) / (4.5) 

       = 230 / 4.5 

       = 51.11 

 

The total for this category will then be 51.11 out of 100 

 

Do I have to put a value in each "weight" input box? 
No. If you do not put a value, it will default to 1. If all items are set to 1 

then they all have equal weight. If you set a weight to 0, the item's grades 

will not count at all in the category or course average. 

 

Do all the weights have to add up to 100 or some 
similar value? 
No, the numbers you put as weights are completely arbitrary. 

They must be positive numbers, and can add up to anything you 

want. Note however that the following four sets of weights are identical in 

value: 

(1 1.75 3) 

(4 7 12) 

(8 14 24) 

(400 700 1200) 

What is the difference between Weight and Extra 
Credit? 
Weight is only available with "Weighted mean of grades". For the "Simple 

weighted mean of grades", the weight is taken from the grade item's 

maximum grade. A weight is used to give a grade item more or less 

importance in the computation of 

 

Ниже приведён пример: 

элемент 1 вес: 1 

элемент 2 вес: 3 

элемент 3 вес: 0.5 

 

элемент 1 оценка: 40/100 

элемент 2 оценка: 60/100 

элемент 3 оценка: 20/100 

 

Вычисление:  

Итог = ((40 * 1) + (60 * 3) + (20 * 0.5)) / (1 + 3 + 0.5) 

       = (40 + 180 + 10) / (4.5) 

       = 230 / 4.5 

       = 51.11 

 

Итоговая Оценка для этой Категории будет тогда равна 51.11 баллу из 100 

возможных. 

Нужно ли заполнять каждое входное окошко «Weight»? 
Нет, если вы не установите значение, по умолчанию будет 1. Если все элементы 

устанавливаются в 1, то все они имеют равный Вес. Если вы установите Вес, равный 0, 

Оценки Элемента совсем не будут подсчитываться в этой Категории или Курсе при 

вычислении Среднего. 

Должны ли все Веса в сумме составлять 100 или другое 
подобное значение? 

Нет, числа, заданные в качестве Весов, являются совершенно произвольными. 

Они должны быть положительными числами, и могут составлять любую сумму, 

какую вы хотите. Заметьте, однако, что следующие четыре комплекта Весов одинаковы по 

значению: 

(1 1,75 3) 

(4 7 12) 

(8 14 24) 

(400 700 1200) 

В чём разница между Весом и Экстра «кредитом»? 
 

Вес доступен только с опцией «Weighted mean of grades (взвешенное среднее из 

оценок)». Для «Simple weighted mean of grades (простое взвешенное среднее из оценок)», 

Вес берётся из максимальной Оценки среди Элемента Оценивания. Вес используется, 

чтобы придать Элементу Оценивания большую или меньшую важность, при вычислении  
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the category total or average, compared with the other items of the same 

category. 

Extra credit replaces grade item weight if the aggregation method is "Mean 

of grades (with extra credits)" or "Sum of grades". The effect of extra 

credit is different for both methods, hence some confusion: 

 

 Mean of grades (with extra credits): A value of 0 does nothing. Any 

other value is used to multiply the grade and add it to the total after the 

computation of the mean. This grade is not used in the computation of 

the mean, however, only added afterwards. Additionally, this cannot 

bring the category total over its maximum grade unless grades over 

100% are enabled by the site administrator (since 1.9.5). This grade 

item is not counted either in the denominator used to compute the 

category mean. 

 Sum of grades: Extra credit is a checkbox, not a number. Normally, 

with Sum of Grades, the category's maximum grade is the sum of the 

maximum grades of all its grade items. If one of them is set as "Extra 

Credit", however, its maximum grade is not added to the category's 

maximum grade, but its grades will be. This way it is possible to 

achieve maximum grade (or grades over maximum if enabled by the 

site administrator) in the category without getting the maximum grade 

in all the grade items. 

How do I create an assignment for which students 
can receive a grade higher than the maximum? 
In Moodle 1.9.5 onwards, a new unlimited grades setting in Administration 

> Grades > General settings enables administrators to allow teachers to 

enter grades over 100% directly in the gradebook. 

In earlier versions of 1.9, it is possible for a student to get less than the 

maximum grade in some grade items, while still getting the maximum 

grade in the category or course total. The Extra Credit feature is used for 

this purpose, as described above. 

 

4.9.1.12.10.Formulas 
How do I give a fixed score for a successful quiz 
attempt? 
Suppose you want to give 5 points for a passing grade (say, 70) in a certain 

quiz. Possible scenario ([1]): extra credit points to every student that gets a 

"passing grade" in a "practice test" at the end of each chapter covered in 

the course, 

Итоговой или Средней Оценки по Категории, по сравнению с другими Элементами той же 

Категории. 

Экстра «кредит» заменяет полноценный Вес Элемента, если методом Агрегации 

является «Mean of grades (with extra credits) – (среднее из оценок (с экстра «кредитами))» 

или «Sum of grades (сумма оценок)». Эффект Экстра «кредита» отличается для обоих 

методов , поэтому существует некоторая путаница: 

 Mean of grades (with extra credits): Значение 0 ничего не делает. Всякое другое значение 

используется, чтобы умножить Оценку и добавить полученное к Итоговой Оценке 

после расчёта среднего. Эта Оценка не используется при вычислении среднего, а 

только в качестве добавляемой позже. Кроме того, она не может повысить 

Итоговую Оценку по Категории выше её максимальной Оценки, даже если Оценки 

более 100% позволены Администратором Сайта (начиная с версии 1.9.5) . Этот 

Элемент Оценивания не подсчитывается и в знаменателе, используемом для 

вычисления Средней Оценки по Категории. 

 Sum of grades: Экстра «кредит» является окошком-флажком, а не числом. Как правило, 

с Методом Агрегации Sum of grades, максимальная Оценка по Категории является 

суммой максимальных Оценок всех её Элементов Оценивания. Если один из них 

установлен как «Extra Credit», его максимальная Оценка не добавляется к 

максимальной Оценке по Категории, но его Оценки добавляются. Таким образом 

можно достичь максимальной Оценки (или Оценок, превышающих максимум, если это 

позволено Администратором Сайта) по Категории, не получая максимальную Оценку 

во всех Элементах Оценивания. 

Как создать Задание, за которое Студенты могут получать 
Оценку выше максимальной? 

В Moodle 1.9.5 и далее, новая настройка неограниченных Оценок в 

Administration→Site Administration→Grades→General settings позволяет Администраторам 

разрешить Преподавателям вводить Оценки свыше 100% непосредственно в 

Журнал Оценок. 

В более ранних версиях, чем 1.9, для Студента можно получать меньшую, чем 

максимальная Оценка в некоторых Элементах Оценивания, в то же время по-прежнему 

получая максимальную Оценку в Итоговой Оценке по Категории или Курсу. Для этой 

цели используется средство Экстра «кредита», как описано выше. 

4.9.1.12.10.Формулы 
Как установить фиксированные Баллы за успешную попытку 
выполнить Экзамен? 

Предположим, вы хотите дать 5 баллов Экстра «кредита», чтобы «довести» Оценку 

до проходной в определённом Экзамене (скажем, оценённом в 70 баллов). Возможный 

сценарий: баллы Экстра «кредита» побуждают каждого Студента, который получает 

«Проходную Оценку» в «практическом тесте» в конце каждой главы, включённой в Курс  

http://moodle.org/mod/forum/discuss.php?d=148576
http://moodle.org/mod/forum/discuss.php?d=148576
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to encourage them to practice after the homework quizzes and to get 

familiar with a "test type" situation before the actual test. 

The following formula should do the trick: 

=round((||quiz||/70)-0.49,0)*5 

The formula may be added to a designated grade item or category. 

 

Sample calculations: 

Score 70: 

=round((70/70)-0.49,0)*5 

=round(1-0.49,0)*5 

=round(0.51,0)*5 

=1*5 

=5 

Score 69: 

=round((69/70)-0.49,0)*5 

=round(0.98-0.49,0)*5 

=round(0.49,0)*5 

=0*5 

=0 

4.9.1.12.11.See also 
 Gradebook Scenarios/Use Cases [2] 

 Using Moodle Gradebook forum 

Using Moodle forum discussions: 

 Excluding practice quizzes from gradebook 

 Course total not sum of max grade column? 

 Why do only certain items have multiplicator & offset boxes? 

4.9.1.13.Grade item settings 
Location: Administration > Grades > Grade item settings 

Grade item settings screen 

Grade item settings are the various settings that the administrator is able to 

edit for all gradebooks used by teachers. These settings will change what 

items are displayed for each grade. As administrator, you would turn on or 

off various settings and the teacher would input the actual data. 

 

4.9.1.13.1.Grade display type 
This is the type of grade that is to be shown for each individual grade. 

Different school districts use different grading systems so this can be 

changed to suit your district. 

 

для выполнения домашних Экзаменов и ознакомления с «типами тестов» перед 

действительным тестом. 

Следующая формула должна сделать своё дело: 

=round((||Экзамен||/70)-0.49,0)*5 

Формула может быть добавлена к назначенному Оцениваемую Элементу или 

Категории. 

Примеры расчёта: 

Накопленных баллов 70: 

=round((70/70)-0.49,0)*5 

=round(1-0.49,0)*5 

=round(0.51,0)*5 

=1*5 

=5 

Накопленных баллов 69: 

=round((69/70) -0.49,0) * 5 

=round(0.98-0.49,0) * 5 

=round(0.49,0)*5 

=0*5 

=0 

4.9.1.12.11.См. также 
 Сценарии Журнала Оценок/Примеры использования. 

 Форум по использованию Moodle «Журнал Оценок». 

Обсуждения форума по использованию Moodle. 

 Исключение практических Экзаменов из Журнала Оценок. 

 ИтоговаяОценка за Курс – не сумма колонки максимальных Оценок? 

 Почему только некоторые элементы имеют окошко мультипликатора и смещения? 

4.9.1.13.Настройки Элементов Оценки 
Местоположение экрана настроек Элемента Оценивания: 

Administration→Grades→Grade item settings. 

Настройками Элемента Оценивания являются различные настройки, которые 

Администратор может отредактировать для всех Журналов Оценки используемых 

Преподавателями. Эти настройки будут изменять то, как Элементы отображаются для 

каждой Оценки. Как Администратор, вы могли бы включить или выключить различные 

настройки, а Преподаватель мог бы ввести фактические данные. 

4.9.1.13.1.Тип отображения Оценки 
Это тип Оценки, который должен быть показан для каждого отдельной Оценки. 

Различные школьные округа используют различные системы оценивания, так что это 

может быть изменено в соответствии с вашим выбором. 

http://docs.moodle.org/en/experimental:_gb_tutoring
http://moodle.org/mod/forum/view.php?id=2122
http://moodle.org/mod/forum/discuss.php?d=123143
http://moodle.org/mod/forum/discuss.php?d=193705
https://moodle.org/mod/forum/discuss.php?d=167596
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 Real - Grade from minimum to maximum range indicating total points 

received. Default from 0-100 but may be arbitrary. 

 Percentage - Grade from 0 - 100% indicating the total points received 

divided by maximum possible amount times 100. 

 Letter - Grade in the form of a letter representing a range of 

percentages. 

4.9.1.13.2.Overall decimal points 
This setting is for display purposes only. Grade calculations are made with 

an accuracy of 5 decimal places and grade letters, if used, are assigned 

accordingly. 

If rounding of grades in grade calculations is required, the round(number, 

count) function may be used. 

4.9.1.13.3.Advance grade item options 
In Moodle 2.0 Course administration>Grades>Category & Items>Add 

grade item, or Simple view>edit item brings up the Grade item page with 

the "Show advanced" button. 

These features can be set or viewed: 

Item info 

ID Number 

Grade Type 

Scale 

Minimum Grade 

Maximum Grade 

Grade to pass 

Offset 

Multiplicator 

Grade display type 

Overall decimal places 

 

Hidden 

Hidden until 

Locked 

Locked after 

 

Both Full and Simple views have "Add category" and "Add grade item" 

buttons at the bottom of the page. 

Old Version for advanced grade item options 
Older versions of Moodle contained a list of various fields that can be 

toggled on or off to appear on the default grade item screen or hidden. By 

selecting a field, it is put into the "Advanced" items menu and a field that 

is not selected will appear on the main grade item menu by default. Note 

that all of these options will always be available to teachers with a click of 

the button "Show Advanced". 

To highlight more than one field, use ctrl+click and both will be 

highlighted. To highlight from one field to another, use shift+click the 

range between two will be highlighted. Shift+ctrl+right click will combine 

a range of selections to those already highlighted. To de-highlight a field 

just do the same steps but click on already highlighted fields. 

4.9.1.13.4.See also 
 Grade items - for teachers  

 Real – Оценка в Диапазоне от минимального до максимального значения с указанием 

Общей Суммы полученных баллов. По умолчанию от 0 до 100, но может быть 

произвольным. 

 Percentage – Оценка от 0 до 100%, указывающая Общую Сумму Баллов, полученных 

делением максимально возможного количества на 100. 

 Letter – Оценка в форме буквы, представляющей диапазон процентов. 

4.9.1.13.2.Общее число десятичных знаков 
Эта настройка используются исключительно в целях отображения. Расчёты 

Оценки, делаются с точностью до 5 десятичных знаков после запятой и Оценки Буквами, 

если используется оценивание буквами, назначаются соответственно. 

Если при вычислениях Оценки требуется округление, может быть использована 

функция round(число, количество). 

4.9.1.13.3.Опции элемента продвинутой Оценки 
В Moodle 2.0 Course Administration→Grades→Category & Items→Add grade item 

или Simple view→edit item откроет страницу Grade item с кнопкой «Show advanced 

(показать дополнительные)». 

Эти средства могут быть установлены или просмотрены: 

Элемент информации 

Номер ID 

Тип Оценки 

Шкала 

Минимальная Оценка 

Максимальная Оценка 

Зачётная Оценка 

Смещение 

Множитель 

Тип отображения Оценки 

Общее число десятичных разрядов 

 

Скрытая 

Скрытая до 

Заблокирована 

Заблокирована до 

Оба вида Full (полный) и Simple (простой) имеют кнопки «Add category (добавить 

категорию)» и «Add grade item (добавить элемент оценивания)» в нижней части страницы. 

Старая версия для опций Продвинутого Элемента Оценивания 
Старые версии Moodle, содержащие список различных полей, которые могут быть 

включены или выключены, чтобы появиться на экране Элемента Оценивания по 

умолчанию или быть скрытой. Пометка поля ведёт к появлению меню Элементов 

«Advanced (продвинутые)» и поля, которое не выбрано, появятся в главном меню 

Элемента Оценивания. Заметьте, что все эти опции будут всега доступны Преподавателям 

по щелчку кнопки «Show Advanced (показать продвинутые)». 

Чтобы подсветить более одного поля, используйте Ctrl+Click и тот и другой будут 

подсвечены. Чтобы подсветить поля с одного по другое, используйте Shift+Click внутри 

области между двумя, которыебудут подсвечены. Щелчок Shift+Ctrl+Right соединит 

область выборок с теми, которые уже подсвечены. Чтобы убрать подсветку поля, просто 

проделайте те же самые шаги, но теперь уже щёлкните по подсвеченным полям. 

4.9.1.13.4.См. также 
 Элементы Оценивания для Преподавателей (п. 4.9.1.3.1). 



 

475 

 Video tutorial on Grade Item Setting and Grade Letters 

4.9.2.Conditional activities 
A group of setting in a resource or activity which sets conditions upon 

entry into, or if an activity or resource can be even seen by the student. 

Conditional activities enable teachers to restrict the availability of any 

activity or even a course section (in Moodle 2.3 onwards) according to 

certain conditions such as dates, grade obtained, or activity completion. 

When it is enabled by the administrator, a "Restrict access" setting appears 

in the settings of activities or resources and also when editing a course 

section. 

 

4.9.2.1.Conditional activities settings 

4.9.2.1.1.Enabling the use of conditional activities 
 
To use conditional activities, the feature must be enabled by an 

administrator by checking the enable availability box in Settings > Site 

administration > Advanced features. A restrict access section will then 

appear for teachers on the edit activity page. 

 

4.9.2.1.2.Restricting access 

The restrict access section asks for the conditions when the activity (or 

resource) should be visible. This can be based upon dates, and/or score 

ranges of other activities and/or if other activities are considered completed 

(see Activity completion). 

Note that ALL access restrictions (date, grade condition, activity 

completion condition) have to be met in order for the activity to be made 

available and that access may be restricted to an actual time and not just a 

date. 

Generally access is prevented before the conditions are met, however if 

'Allow access until' is enabled, then access is prevented after the specified 

date. 

Restricting access to course sections 
It is possible to restrict access to activities within a whole course section by 

specifying the conditions in the settings for that particular section. 

Watch the "Restrict access to course sections" screencast for a 

demonstration. 

 

 

 Видео-руководство по настройке Элемента Оценивания и Оценивание Буквами. 

4.9.2.Обусловленные Действия 
Группа настроек в Ресурсе или Интерактивном Действии, которая устанавливает 

условия, при которых в них можно войти, или только при которых Ресурсы или 

Интерактивные Действия могут быть увидены Студентами. 

Обусловленные Действия позволяют Преподавателям ограничить доступность 

любого Действия или даже раздела Курса (в Moodle 2.3 и выше) в соответствии с 

определёнными условиями такими, как даты, полученные Оценки, или 

Завершение Действий (п.4.9.3). Когда они разрешены Администратором, появляется 

настройка «Restrict access (ограничить доступ)» в настройках Интерактивных Действий 

или Ресурсов, а также при редактировании Раздела Курса. 

4.9.2.1.Настройки Обусловленных Действий 
4.9.2.1.1.Позволение использования 
Обусловленных Действий 

Чтобы использовать обусловленные Действия, Администратор должен включить 

это средство посредством пометки окошка «Enable availability (разрешение 

использования)» в Administration→Site administration→Advanced feature. Для 

Преподавателей появится раздел ограничения доступа на странице редактирования 

Действия. 

4.9.2.1.2.Ограничение доступа 
Раздел ограничения доступа запросит условия, при которых 

Интерактивное Действие (или Ресурс) должны быть видимы. Они могут быть основаны на 

датах и/или диапазонах Исходных Оценок других Действий, и/или на том, что другие 

Действия считаются завершенными (см. «Завершение Действия»).  

Обратите внимание, что ВСЕ ограничения доступа (по датам, Оценкам, 

Завершённости Действий) должны быть выполнены для того, чтобы данное Действие 

стало доступным, и этот доступ может быть ограничен фактическим временем, а не только 

датой. 

Вообще доступ не разрешается до тех пор, пока условия не выполнятся, однако, 

если включён «Allow access until (разрешить доступ до)», то доступ не разрешается и 

после указанной даты. 

Ограничение доступа к разделам Курса 
Можно ограничить доступ к Действиям внутри целого Раздела Курса путём 

указания условий в настройках конкретного раздела. 

См. демонстрацию в фильме с экрана «Ограничить доступ к разделам Курса». 

http://www.moodletutorials.org/view_video.php?viewkey=d7fbdea1afc51c7c6ad2
http://youtu.be/5Z0pYuOiZ5E
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Restricting access by user profile fields 
It is possible to restrict access to activities based on a custom user profile 

field. You can select a field type, condition and name. For more 

information please see Conditional user fields. You can also watch the 

"Conditional profile fields" screencast to see this feature in action. 

 

Grade condition 
You can specify a condition on any grade in the course: the full course 

grade, the grade for any activity, or a custom grade that you create 

manually. You can enter either a minimum value (at least percentage), a 

maximum value (less than percentage), both, or neither. The activity will 

only appear if the student has a value for the specified grade, and if it falls 

within any specified number range. You can add more than one grade 

condition. All conditions must be met in order for the activity to appear. 

 

 The range numbers can be fractional (with up to five decimal places) if 

necessary. 

 Be careful with the maximum value; if the maximum is 7, a student 

who scores exactly 7 will not see the activity. You could set it to 7.01 if 

you really wanted to include 7. 

 If creating several different activities that appear according to grade 

ranges, use the same number for the maximum of one activity, and the 

minimum of the next. For example, you might create one activity with a 

maximum of 7 and another with a minimum of 7. The first would 

appear to everyone scoring between 0 and 6.99999, and the second 

would appear to everyone scoring 7.00000 to 10. This guarantees that 

everyone with a grade will see one or other. 

 

Removing a grade condition 
To remove a grade condition, set the assessment name to 'none' and 

remove the range number values 

4.9.2.2.Using Conditional activities 
4.9.2.2.1.An example of use 
Here follows a basic example. Students are required to undertake 4 tasks in 

a precise order. According to their score in a quiz, the fourth task - a 

Moodle lesson - is either at a lower or more advanced level. They must 

 view a webpage explaining the course 

 post an introductory message in a forum 

 take a quiz 

Ограничение доступа полями Профиля Пользователя 
Можно ограничить доступ к Действиям на основе поля Профиля Пользователя 

(постоянного клиента). Вы можете выбрать тип поля, условие и название. Дополнительная 

информация приведена в «Обусловленные поля пользователя» (п. 4.9.2.3). Можно также 

посмотреть фильм с экрана «Обусловленные поля Профиля», чтобы увидеть это средство 

в действии. 

Условие (ограничение) на Оценки 
Вы можете указать Условие, связанное с любой Оценкой в Курсе: 

Итоговой Оценкой за Курс, Оценкой за любое Интерактивное Действие или 

Обычной Оценкой, которую вы создаёте вручную. Вы можете ввести либо минимальное 

значение (наименьший допустимый процент), максимальное значение (процент не менее, 

чем), оба значения или ни одного. Данное Действие появится только в случае, если 

значение указанной Оценки Студента попадает внутрь указанной числовой области. Вы 

можете добавить более одного Условия Оценки. Все эти Условия должны быть 

выполнены, для того чтобы это Действие появилось (на экране Студента). 

 Числа области могут быть дробными (имеющими до пяти цифр после десятичной 

точки), если необходио. 

 Будьте осторожны с максимальным значением; если максимум равен 7, Студент, 

который получит Исходную Оценку равную точно 7, не увидит данное Действие. Вы 

можете установить его равным 7.01, если действительно хотите включить 7. 

 При создании нескольких различных Интерактивных Действий, которые появляются в 

соответствии с областями Оценок, используйте одно и то же число для максимума 

одного Интерактивного Действия и минимума для другого. Например, вы можете 

создать одно Интерактивное Действие с максимумом равным 7, а другое с минимумом 

равным 7. Первое появится перед каждым Студентом, получившем Исходную Оценку 

от 0 до 6.99999, а второе появится перед каждым Студентом, получившем 

Исходную Оценку от 7.00000 до 10. Это гарантирует, что каждый получивший 

Исходную Оценку увидит одно или другое (Интерактивное Действие). 

Удаление Условия Оценки 
Чтобы удалить Условие Оценки, установите название оценивания в «None (ни 

какого)» и удалите числовые значения областей. 

4.9.2.2.Использование обусловленных Действий 
4.9.2.2.1.Пример использования 

Ниже приведён типичный пример. Студенты обязаны выполнить 4 задачи в 

заданном порядке. Четвёртая задача – Урок Moodle – даётся либо на более низком, либо на 

более высоком уровне, в соответствии с их Итоговой Оценкой за Эзамен. Они должны: 

 просмотреть веб-страницу, объясняющую Курс, 

 разместить вступительное сообщение на Форуме, 

 пройти Экзамен, 
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 move onto a lesson tailored to their performance in the quiz. 

Here is the teacher view. 

 
Students will only see the first task (the webpage)with the second task (the 

forum) greyed out. The other tasks only appear once the conditions have 

been met. How's it done? 

 Task 1, the webpage must be read (or at least viewed) before students 

can access the forum. In task 1 the activity completion condition is set 

to require view 

 

 Task 2, the forum, needs to have the "Restrict availablity" section set 

such that the webpage Read This First must be marked complete. It is 

also set so the forum is greyed out until available: 

 

 

 

 Task 3, the forum, needs to require students to make a post before they 

can do the quiz. The activity completion condition is set to "require 

posts" 

 

 

 

 

 

 

 

 

 

 перейти на Урок с учётом их выполнения Экзамена. 

Как это видно Преподавателю: 

 
Студенты будут видеть только первую задачу (Веб-страница) со второй задачей 

(Форум) подсвеченной серым цветом. Другие задачи появятся только после выполнения 

условий. Как это делается? 

 Задача 1, Веб-страница должна быть прочитана (или 

по крайней мере просмотрена) перед тем, как 

Студенты смогут получить доступ к Форуму. В задаче 1 Условие Завершения Действия 

устанавливается в «Require view (требуется просмотр)». 

 Задача 2, Форум, должен иметь раздел «Restrict 

availablity (ограничить доступность)», 

установленный так, чтобы Веб-страница «Read this 

first! (сначала прочтите это!)» должна была 

помечена завершённой. Он также устанавливается как Форум подсвеченный серым, 

пока недоступен: 

 Задача 3, Форум должен потребовать от Студентов создать сообщение, прежде чем они 

могут выполнить Экзамен. Условие 

«Activity completion 

(Завершение Действия)» устанавливается в 

положение «Require posts (требуют 

сообщений)». Снимок с экрана по 

установкам настроек Форума см. ниже. 
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 Task 3, the quiz, needs to have the "Restrict availablity section" set 

such that the forum must be marked complete. It is also set so that that 

the quiz is completely hidden until a student has posted in the forum: 

 

 

 

 

 

 

 Task 4 is two lessons - either at level 1 (basic) or level 2 (advanced). If 

the student scores less than 50% in the quiz they do Level 1; if they 

score more, they do Level 2. In the Level 1 lesson, the "Restrict 

Availablity" section is set such that students can only access it if they 

get under 50% in the quiz 

 

 

 

The Level 2 lesson has the "Restrict availability" section such that 

students can only access it if they get 50% or more: 

 

 

 

4.9.2.2.2.Tricks and techniques 
With a bit of lateral thinking, you can achieve some interesting results 

beyond the most obvious uses of the system. Here is one example: 

 

Project allocation 
Imagine that you let students choose one of two projects. Each project has 

its own activities (a forum for all the people doing that project, resources 

with information about the project, etc). You want it to hide all the 

activities that a student isn't doing. 

This can already be achieved in Moodle using the Groupings system. 

However, conditional activities gives another way to set this up which 

might be preferable in some cases. Here's how: 

 Create two forums called 'Frog project sign-up forum' and 'Zombie 

project sign-up forum'. 

 Set both forums to be automatically marked complete once the user 

makes 1 post. 

 

 Задача 3, Экзамен должен установить «Restrict availablity section (ограничить 

доступность раздела)» так, чтобы Форум должен быть помечен как завершённый. Здесь 

также установливается то, что Экзамен полностью скрыт до тех пор, пока Студент не 

отправит сообщение на Форум: 

 

 

 

 

 

 Задача 4 состоит из двух уроков – либо на уровне 1 (основной), либо на уровне 2 

(продвинутый). Если Исходный Балл Студента менее 50% за Экзамен, он выполняет 

уровень 1, если он получил Исходный Балл больше, он выполняет уровень 2. В уровне 

1 Урока, раздел «Restrict Availablity (ограничить доступность)» устанавливается так, 

чтобы Студенты могли получить доступ к нему только, если они получили менее 50% 

Исходных Баллов за Экзамен. 

 

 

Уровень 2 Урока имеет раздел «Restrict Availablity» такой, что Студенты могут 

получить доступ к нему только, если они получат 50% Исходных Баллов или более: 

 

 

 

4.9.2.2.2.Трюки и технические приёмы 
С более широким подходом к вопросу, можно добиться некоторых интересных 

результатов, помимо самых очевидных применений системы. Вот один из примеров: 

 

Распределение ресурсов проекта 
Представьте, что вы позволили Студентам выбрать один из двух проектов. Каждый 

проект имеет свои собственные Действия (Форум для всех людей, выполняющих этот 

проект, Ресурсы с информацией о проекте и т.д.). Вы хотите скрыть все Действия, которые 

Студент не выполняет. 

Это уже может быть достигнуто в Moodle с помощью системы Группировок 

(п. 4.8.3). Однако, Обусловленные Действия дают ещё один способ реализовать эту 

возможность, который может быть предпочтительнее в некоторых случаях. И вот как: 

 Создайте два Форума, называемые «Форум подписки на проект "Лягушка"» и «Форум 

подписки на проект "Зомби"». 

 Установите оба Форума быть автоматически помеченными как завершённые, как 

только пользователь создаст 1 сообщение. 
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 Set each forum to be conditionally available only if the other forum is 

NOT complete. 

 Create other activities for the frog and zombie projects. For each Frog 

activity, set it to be conditionally available only if the Frog sign-up 

forum is marked complete. For each Zombie activity, set it to be 

conditionally available only if the Zombie sign-up forum is marked 

complete. 

When a student first visits the site, they see the frog and zombie sign-up 

forums and none of the project activities. As soon as they post in one of the 

forums, the other forum will disappear, and all the activities for their 

preferred project will appear. (If they want to change their mind, they can 

delete their forum post so that it isn't marked complete any more, and it'll 

be back to square one.) 

4.9.2.2.3.Discussion: Should you really use 
conditional activities? 
Conditional activities are a way for you to force your students to do things 

in a certain order. Is that really what you want? The answer will depend on 

your particular circumstances, but it is worth taking a moment to reflect 

upon the degree to which conditional activities are appropriate for your 

course. 

Cautions 
It is certainly good course design to make it clear to your students what 

they are expected to do next, to give good guidance. But do you need to 

use force? Might it not be better to leave students in control of their own 

learning and just use labels and layout, rather than locks and keys to 

suggest the best path? 

New adaptive learning paths 
This may allow the teacher to separate students by a range of performance 

they have achieved. For example, after a quiz any one of three different 

lessons might appear to a student, depending upon their score. The teacher 

can have one for low scores, one for high scores and one for average score 

ranges. 

The teacher could have a short quiz like survey, with 7 questions asking 

the student to give their feelings on a 1 to 5 scale. A range of scores would 

reveal different activities. Students who liked dark colors might get the 

black and gray activities revealed, those who liked light colors might get 

the white and gray activities. 

On the other hand, you may have to design a certified training course that 

requires approval from unenlightened government  

 Установите каждый Форум быть доступным по условию, что другой форум НЕ 

является завершённым. 

 Создание других Действий для проектов «Лягушка» и «Зомби». Для каждого Действия 

проекта «Лягушка», установите, что оно будет доступно по условию, что Форум 

подписки на проект «Лягушка» помечен завершённым. Для каждого Действия «Зомби» 

установите, что оно будет доступно то условию, что Форум подписки на проект 

«Зомби» помечен завершённым. 

Когда Студент заходит на Сайт впервые, он видит Форумы подписки на проекты 

«Лягушка» и «Зомби» и ни одного Действий в проектах. Как только он отправит 

сообщение в один из Форумов, другой Форум исчезнет, и появятся все Действия для 

выбранногоим проекта. (Если он захочет изменить своё мнение, он могут удалить своё 

сообщение на Форум, так что тот перестанет быть помеченным завершённый, и это 

позволит вернуться к исходной точке.) 

4.9.2.2.3.Обсуждение: Нужно ли на самом деле использовать 
Обусловленные Действия? 

Обусловленные Действия являются одним из способов заставить своих Студентов 

делать что-то в определённом порядке. Это действительно то, что вы хотите? Ответ будет 

зависеть от ваших конкретных обстоятельств, но об этом стоит поразмышлять с того 

момента, когда потребуется отразить, в какой степени Обусловленные Действия являются 

подходящими для вашего Курса. 

Предостережения 
Это, определённо, хороший план Курса для подсказки вашим Студентам того, что 

от ннх ожидается в дальнейшем, для предоставления им хорошего руководства. Но вы 

нуждаетесь в использовании принуждения? Не лучше ли оставить Студентам управление 

их собственным обучением, и просто использовать метки и раскладку, а не блокировки и 

ключи, чтобы выбрать оптимальный путь? 

Новые пути адаптивного обучения 
Это может позволить Преподавателю разделить Студентов по диапазону 

эффективности, которой они добились. Например, после Экзамена любой из трёх 

различных Уроков может появиться перед Студентом, в зависимости от их 

Исходной Оценки. Преподаватель может иметь одно для низких Исходных Баллов, одно 

для высоких Исходных Баллов и одно для средних диапазонов Исходных Баллов. 

Преподаватель может иметь краткий Экзамен, подобный Опросу, с 7-мью 

Вопросами, предлагающими Студенту выразить свои чувства по шкале от 1 до 5 баллов. 

Диапазон Исходных Баллов будет предлагать различные Действия. Студенты, которые 

любят тёмные цвета, могут получить чёрные и серые Действия, те, кто любил светлые 

цвета, могут получить белые и серые Действия. 

С другой стороны, вам может придётся разрабатывать сертифицированный 

учебный Курс, который потребует одобрения от непросвещённых государственных 
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regulators. Conditionalactivities will assure them that the trainees have 

been exposed to everything in the course, in a fixed order, and that the 

trainees must meet certain quantifiable standards from time to time before 

being allowed to proceed in the course. Correct use and explanation of 

conditional activities may ensure validation of your course. 

4.9.2.2.4.See also 
 Using Moodle Using response in Choice activity as a condition? forum 

discussion 

 Forum thread Conditional by number of days for using post threshold 

blocking to restrict access to topics by days. 

4.9.2.3.Conditional user fields 
This page explains how to restrict an activity, resource or course section 

via user fields and/or custom profile fields. 

4.9.2.3.1.Instructions 
1. Conditional access must be enabled (see Conditional activities for 

instructions on how to enable this for your site). 

2. When adding or editing an activity, resource or course section scroll to 

the user fields in the 'Restrict Access' section. 

 

3. Choose which fields you want to restrict by (adding more if needed), 

select the restriction you want to put in place and then enter a value. 

 

4. Save the settings. 

4.9.2.3.2.Example 
This is an example of the interface in Moodle when adding an activity to a 

course with the conditional functionality enabled 

This is how it will appear to users who fail to meet the restrictions set in 

place. 

 

 

 

 

 

 

 

 

 

 

 

регулирующих органов. Обусловные Действия будут уверять их, что слушатели были 

обучены всему в Курсе, в установленном порядке, и что эти слушатели должны 

соответствовать определённым стандартам количественной Оценки, время от времени, 

прежде чем допустить продолжение в Курсе. Правильное использование и объяснение 

Обусловных Действий может обеспечить признание вашего Курса. 

4.9.2.2.4.См. также 
 Форум обсуждения по использованию Moodle «Использование ответа в 

Интерактивном Действии «Выбор» в качестве условия?». 

 Тема на форуме «Обусловленный количеством дней» для рассылки сообщения о пороге 

блокировки по ограничению доступа к темам по дням. 

4.9.2.3.Обусловленные Поля Пользователя 
Эта раздел объясняет, как ограничить Интерактивное Действие, Ресурс или 

Раздел Курса посредством Полей Пользователей и/или Полей Профиля Пользователя. 

4.9.2.3.1.Инструкции 
1. Условный доступ должен быть позволен (см. «Обусловленные Действия» для 

получения инструкций о том, как позволить это для вашего Сайта). 

2. При добавлении или редактировании Интерактивного Действия, Ресурса или 

Раздела Курса прокрутите страницу к Полям Пользователя в разделе «Restrict Access 

(ограничение доступа)». 

3. Выберите, какие поля вы хотите ограничить по (добавляя больше, если нужно), 

выберите ограничение, которое вы хотите расположить на должное место, а затем 

введите значение. 

4. Сохраните настройки. 

4.9.2.3.2.Пример 
Это пример интерфейса в Moodle при 

добавлении Действия в Курс с позволенной 

обусловленной функциональностью. 

Вот как это будет отображаться для 

пользователей, которые не выполняют 

ограничения, установленные в должном 

месте. 

 

 

 

 

 

http://moodle.org/mod/forum/discuss.php?d=140327
http://moodle.org/mod/forum/discuss.php?d=140327
https://moodle.org/mod/forum/discuss.php?d=231400
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4.9.2.3.3.User fields 
You can restrict by using one of the user fields that are located in the 

Moodle user table. Not all the user fields are included, as not all of them 

would make sense in this context. The ones included are listed below. 

 

 AIM ID - This is the value in the 'aim' column 

 Address - This is the value in the 'address' column 

 City/town - This is the value in the 'city' column 

 Country - This is the value in the 'country' column 

 Department - This is the value in the 'department' column 

 Email Address - This is the value in the 'email' column 

 First name - This is the value in the 'firstname' column 

 ICQ number - This is the value in the 'icq' column 

 ID number - This is the value in the 'idnumber' column 

 Institution - This is the value in the 'institution' column 

 Interests - This is the value in the 'interests' column 

 MSN ID - This is the value in the 'msn' column 

 Mobile phone - This is the value in the 'phone2' column 

 Phone - This is the value in the 'phone1' column 

 Skype ID - This is the value in the 'skype' column 

 Surname - This is the value in the 'lastname' column 

 Web page - This is the value in the 'url' column 

 Yahoo ID - This is the value in the 'yahoo' column 

4.9.2.3.4.Custom profile fields 
These are all the custom profile fields that have been created on the 

Moodle site. See User profile fields. 

4.9.2.3.5.Operators 
The operators define the relationship between the field chosen and the 

value entered. For example, when the user's email must contain 

@school.com, the field chosen is 'Email address', the operator is 'contains' 

and the value is '@school.com'. 

Contains 

This operator restricts access to those whose chosen field contains the 

value provided. 

Does not contain 

This operator restricts access to those whose chosen field does not contain 

the value provided. 

 

4.9.2.3.3.Поля Пользователя 
Вы можете ограничить с помощью одного из пользовательских полей, которые 

находятся в таблице пользователей Moodle. Не все Поля Пользователя включены, 

поскольку не все из них имели бы смысл в этом контексте. Включённые Поля 

перечислены ниже. 

 AIM ID – Это значение в колонке «Aim (цель)» 

 Address – Это значение в колонке «Address (адрес)» 

 City/town (город/посёлок) – Это значение в колонке «City (город)» 

 Country (страна) – Это значение в колонке «Country (страна)» 

 Department (департамент) – Это значение в колонке «Department (департамент)» 

 Email Address (адрес э-почты) – Это значение в колонке «Email (э-почта)» 

 First name (имя) – это значение в колонке «First name (имя)» 

 ICQ number (номер ICQ) – Это значение в колонке «ICQ» 

 ID number (идентификатор) – Это значение в колонке «ID Number (идентификатор)» 

 Institution (учреждение) – Это значение в колонке «Institution (учреждения)» 

 Interests (интересы - Это значение в колонке «Interests (интересы)» 

 MSN ID (идентификатор MSN) – Это значение в колонке «MSN» 

 Mobile phone (мобильный телефон) – Это значение в колонке «Phone2» 

 Phone (телефон) – Это значение в колонке «Phone1» 

 Skype ID (идентификатор Skype) – Это значение в колонке «Skype (скайп)» 

 Surname (фамилия) – это значение в колонке Surname (фамилия) 

 Web page (веб-страница) – Это значение в колонке «URL (указатель ресурса)» 

 Yahoo ID – Это значение в столбце «Yahoo (э-почта Yahoo)» 

4.9.2.3.4.Поля Профиля Клиента 
Это все Поля Профиля Пользователя, которые были созданы на Сайте Moodle. См. 

«Поля Профиля Пользователя». 

4.9.2.3.5.Операторы 
Операторы определяют связь между выбранным полем и введённым значением. 

Например, когда электронная почта пользователя должна содержать «@school.com», 

выбранное поле – это «Email address (адрес э-почты)», оператор – это «Contains 

(содержит)» и значением является «@ school.com». 

Содержит 

Этот оператор ограничивает доступ к тем, чьё выбранное поле не содержит 

предоставленное значение. 

Не содержит 

Этот оператор ограничивает доступ к тем, чьё выбранное поле не содержит 

предоставленное значение. 

http://docs.moodle.org/25/en/User_profile_fields
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Is Equal To 

This operator restricts access to those whos chosen field equals the value 

provided. 

Starts With 

This operator restricts access to the activity to those whos chosen field 

starts with the value provided. 

Ends With 

This operator restricts access to the activity to those whos chosen field 

ends with the value provided. 

Is Empty 

This operator restricts access to the activity to those whos chosen field is 

empty. Note, if any value is provided in this case, it is ignored. 

4.9.2.4.Conditional activities FAQ 
 
4.9.2.4.1.What ARE Conditional activities? 
Conditional activities is a feature that enables a teacher to release resources 

and activities for their students based on certain criteria such as date, grade 

received or participation. 

4.9.2.4.2.Where are the settings to use 
Conditional activities? 
The Moodle admin needs to enable it site wide in Settings>Site 

administration>Advanced features and a teacher will then see "restrict 

access" options in the setup screen of each activity. 

4.9.2.4.3.Can I make access to a course 
conditional upon completing another course? 
Not currently, no. It is not possible to restrict access to course B until a 

student has completed course A. There are workarounds such as setting a 

final page at the end of course A which is only revealed once the student 

has completed course A. In this page you can include the enrolment key for 

course B. However - this relies on trusting students not to pass the key onto 

others. 

4.9.2.4.4.Can I set conditional activities for a 
whole section, not just individual activities? 
Yes you can. The settings are within each course section when you click 

the "edit" icon. See the screencast access to course sections in Moodle 2.3. 

 

 

 

Is Equal To (равно ) 

Этот оператор ограничивает доступ к тем, чьё выбранное поле равно предоставленному 

значению. 

Начинается с  

Этот оператор ограничивает доступ к Действию тем, чьё выбранное поле начинается с 

предоставленного значения. 

Заканчивается на  

Этот оператор ограничивает доступ к Действию тем, чьё выбранное поле заканчивается 

на предоставленное значение. 

Пусто 
Этот оператор ограничивает доступ к Действию тем, чьё выбранное поле пусто. 

Заметьте, что любое приводимое в этом случае значение игнорируется. 

4.9.2.4.Часто задаваемые вопросы по 
Обусловленным Действиям 
4.9.2.4.1.Что ЯВЛЯЕТСЯ Обусловленными Действиями? 

Обусловленные Действия – это средство, которое позволяет Преподавателю 

передать Ресурсы и Интерактивные Действия своим Студентам на основе определённых 

критериев, таких как дата, полученная Оценка или участие. 

4.9.2.4.2.Где находятся настройки по использованию 
Обусловленных Действий? 

Администратор Moodle должен позволить это на уровне Сайта в меню 

Administration→Site administration→Advanced features и Преподаватель тогда увидит 

опции «Restrict access (ограничить доступ)» на экране настроек каждого Действия. 

4.9.2.4.3.Можно организовать доступ к Курсу по условию 
завершения другого Курса? 

В настоящее время нет. Невозможно ограничить доступ к Курсу B пока Студент не 

завершит Курс A. Есть обходные пути, такие как установление последней страницы в 

конце Курса А, которая открывается только после того, как Студент закончил курс A. На 

этой странице вы можете включить ключ зачисления на Курс B. Однако – это зависит от 

доверия Студентам, что они не передадут ключ другим. 

 

4.9.2.4.4.Можно установить Обусловленные Действия для 
целого Раздела Курса, не только отдельные Действия? 

Да, вы можете. Настройки находятся внутри каждого раздела Курса, когда вы 

щёлкаете иконку «Edit (отредактировать)». См. фильм с экрана «Доступ к разделам Курса 

в Moodle 2.3». 

http://www.youtube.com/watch?v=5Z0pYuOiZ5E&list=UUCRg_EbhU9tdpLdiGGN1Mgg&index=1&feature=plcp%7CRestrict
http://www.youtube.com/watch?v=5Z0pYuOiZ5E&list=UUCRg_EbhU9tdpLdiGGN1Mgg&index=1&feature=plcp%7CRestrict
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4.9.2.4.5.See also 
Using Moodle how to clear checks on completion page as admin user 

forum discussion 

4.9.3.Activity completion 
Activity completion allows the teacher to set completion criteria in a 

specific activity's settings. A check (tick) appears against the activity 

when the student meets this criterion. The criterion might be viewing, 

receiving a certain score or a student marking it as complete. 

 

4.9.3.1.Activity completion settings 

4.9.3.1.1.Activity settings 
Depending on the type of activity, there are different completion 

requirements. For example, a Page might have the requirement to require 

view; a Quiz might have the requirement to require grade while a Forum 

might have the requirement to require posts/discussions/replies. 

 

 

 

 

 

 

 

 

 

 

 

Completion tracking 
There are three options: 

 Do not indicate activity completion - this will not show checks(ticks) 

next to the activity 

 Students can manually mark the activity as completed - students press 

the check(tick) to change it. (Note: they can do this even without doing 

the activity!) 

 Show activity as complete when conditions are met - the selected 

completion criteria must be met before the check(tick) will change style 

 

 

 

4.9.2.4.5.См. также 
Обсуждение на форуме по использованию Moodle «Как очистить проверки на 

странице завершения подобноАдминистратору?». 

4.9.3.Завершение Действия 
Завершение Действия позволяет Преподавателю установить критерии Завершения 

в настройках конкретного Действия. Ярлычок (галочка)  появляется напротив Действия, 

когда Студент сталкивается с этим критерикм. Критерий может визуализироваться, при 

получении определённой Исходной Оценки или пометке Студентом Действия как 

Завершённого. 

4.9.3.1.Настройки Завершения Действия 
4.9.3.1.1.Настройки Действия 

В зависимости от Действия, существуют различные требования к Завершению. 

Например, Страница (п. 4.4.6) может иметь требование «Require view (требуется 

просмотр)»; Экзамен (п. 4.3.10) может иметь требование «Require grade (требуется 

оценка)», в то время как Форум (п. 4.3.7), может иметь требование «Require 

posts/discussions/replies (требуются сообщения/обсуждения/отклики)». 

 

 

 

 

 

 

 

 

 

 

Отслеживание Завершения 
Есть три варианта (см. на снимке выше в меню Completion tracking приведён 3-ий вариант):  

 Do not indicate activity completion (не указывать завершение действия) – не 

показываются пометки (галочки) рядом с Действием. 

 Students can manually mark the activity as completed (Студенты могут вручную отметить 

действие как завершённое) – Студенты нажимают эту отметку (помечают «галочкой»), 

чтобы изменить его. (Примечание: они могут сделать это даже не выполняя Действия!)  

 Show activity as complete when conditions are met (показать действие как завершённое, 

когда условия будут выполнены) – выбранные критерии Завершения должны быть 

выполнены до того, как изменится стиль пометки. 

http://moodle.org/mod/forum/discuss.php?d=167914
http://moodle.org/mod/forum/discuss.php?d=167914
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Require view 
When this option is turned on, students have to view the activity in order to 

complete it. 

 In most cases, clicking the link is enough to 'view' the activity. 

 You should usually not turn on the 'view' condition if you have other 

requirements - this makes extra work for the server and it's unlikely that 

a student could meet any other conditions without viewing the activity. 

Require grade 
When this option is turned on, students have to get a grade on the activity 

in order to complete it. For example, a quiz would be marked completed as 

soon as the user submits it (so long as it doesn't contain any "essay" 

questions). 

It does not matter how well the student did. Getting any grade will mark 

the activity completed. 

It is possible to distinguish between 'pass' and 'fail' grades so that the 

activity becomes 'completed, passed' or 'completed, not passed' instead of 

just 'completed'. These results show a different icon and alternative text. 

 

To set this up, you need to specify the pass value for this activity's 

individual grade: 

1. Go to the course gradebook by clicking the 'Grades' link on the course 

administration block. 

2. From the 'Choose an action' dropdown, pick 'Categories and items'. 

 

3. Click the Edit icon next to the grade item for this activity. 

 

4. Turn on 'Show Advanced'. 

5. Type a grade value (e.g. 5.0) in the 'Grade to pass' box. 

 

Once you have done this, anybody submitting the quiz will receive either 

the pass or fail completion icon. If the quiz can be taken multiple times, the 

completion icon will automatically update whenever the grade does. 

 

There is one limitation: this only works if grades are immediately visible to 

students. The grade must be neither permanently hidden, nor hidden until a 

certain date. If a grade is hidden then only the standard 'completed' state 

will be displayed - even once the hidden date has passed. 

 

 

 

Требуется просмотр 
Когда эта опция включена (см. на снимке выше она отключена), Студенты должны 

просмотреть своё Действие, чтобы завершить его. 

 В большинстве случаев, щелчка по ссылке достаточно, «просмотреть» Действие. 

 Обычно не нужно включать условие «View», если у вас есть другие требования – это 

создаёт дополнительную работу для сервера и маловероятно, что Студент сможет 

выполнить любые другие условия, не просматривая Действие. 

Требуется Оценка 
Когда эта опция включена (см. на снимке выше она отключена), Студенты должны 

получить Оценку за это Действие, чтобы завершить его. Например, Экзамен будет 

помечен как Завершённый, как только пользователь отправит свой готовый ответ на него 

(при условии, что Экзамен не содержит никаких Вопросов типа Эссе). 

Не имеет значения, насколько хорошо Студент выполнил Действие. Получение 

любой Оценки приведёт к пометке Действия как завершённого. 

Можно провести различие между Оценками «зачтено» и «не зачтено» так, что 

Действие становится «завершённым, зачтённым) или «завершённым, не зачтённым», а не 

просто «завершённым». Эти результаты показывают, разные иконки и альтернативный 

текст. 

Чтобы установить это, необходимо указать значение для «зачтено» для конкретной 

Оценки этого Действия: 

1. Перейдите в Журнал Оценок Курса, щёлкнув ссылку «Grades (оценки)» в Блоке 

управления Курсом. 

2. Из ниспадающего списка «Choose an action (выбрать действие)», выберите «Categories 

and items (категории и элементы)». 

3. Щёлкните иконку Edit (редактировать) рядом с Элементом Оценки для этого 

Действия. 

4. Включите «Show Advanced (показать продвинутые)». 

5. Введите значение Оценки (например, 5.0 ) в окошке «Grade to pass (оценка для 

зачёта)». 

После того как вы сделали это, всякий, передавший готовый ответ по Экзамену, 

получит иконку Завершения «зачтено» или «не зачтено». Если Экзамен могут быть 

приняты несколько раз, значок Завершения будет автоматически обновляться каждый раз, 

когда присуждается Оценка. 

Существует одно ограничение: это работает только, если Оценки сразу же 

становятся видны для Студентов. Оценка не должна быть постоянно скрыта, или скрыта 

до определённой даты. Если Оценка скрыта, то только стандартное состояние 

«завершено» будет отображаться – даже после того, как дата сокрытия наступила. 
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Require submission 
This setting appears in assignments and means that an assignment may be 

considered as completed once the student has submitted - but before the 

teacher has had time to grade it. 

Expect completed on 
The date is not shown to students and is only displayed in the Activity 

completion report. 

Require posts 
This setting is seen in forums. For the forum to be classed as "complete" 

the student must either start a discussion or reply to a discussion. The 

number of posts they must make can be specified in the box. 
 

Require discussions 
This setting is seen in forums. For the forum to be classed as "complete", 

the student must start a discussion topic. The number of posts they must 

make can be specified in the box. 

Require replies 
This setting is seen in forums. For the forum to be classed as "complete" 

the student must reply to a discussion. The number of posts they must 

make can be specified in the box. 

4.9.3.1.2.Locked completion options 
If at least one person has completed an activity, completion options are 

'locked'. This is because changing these options may result in unexpected 

behaviour. For example, if somebody has ticked an activity as manually 

completed, and you then set it to automatic completion, the activity will 

become unticked - very confusing for the student who had already ticked 

it! 

Tip: It is best not to unlock options unless you are sure it won't cause 

problems - for example, if you know that students don't have access to 

the course yet, so it will only be staff who have marked the activity 

completed when testing. 

4.9.3.1.3.What happens when you unlock 
Once you unlock options and then click 'Save changes', all completion 

information for the activity will be deleted and, if possible, regenerated 

according to the new settings. 

 If the new completion option is manual, everyone will be set to 'not 

completed' regardless of any previous setting. 

 

 

Требуется передать готовый ответ на рассмотрение 
Эта настройка появляется в назначениях и средствах, в которых назначение может 

рассматриваться как завершенное после того, как Студент передал на рассмотрение 

готовый ответ – но до того, как Преподаватель нашёл время оценть его. 

Ожидать Завершения 
Дата Студентам не показывается, а только отображается в «Отчёте о 

Завершении Действия» (п. 4.9.3.2). 

Требуется отправка сообщений 
Этот параметр виден в Форумах. Чтобы Форум был классифицирован как 

«завершённый», Студент должен либо начать обсуждение, либо ответить на обсуждение. 

Количество сообщений, которые он должен отправить может быть указано в окошке (см. на 

снимке выше указано значение 1). 

Требуются обсуждения 
Этот параметр виден в Форумах. Чтобы Форум был классифицирован как 

«завершённый», Студент должен создать тему для обсуждения. Количество сообщений, 

которые он должен отправить может быть указано в окошке. 

Требуются ответы 
Этот параметр виден в Форумах. Чтобы Форум был классифицирован как 

«завершённый», Студент должен ответить на обсуждение. Количество сообщений, 

которые он должен отправить может быть указано в окошке. 

4.9.3.1.2.Опции Заблокированного Завершения 
Если хотя бы один человек завершил Действие, опции Завершения «блокируются». 

Это потому, что изменение этих параметров может привести к неожиданным 

последствиям. Например, если кто-то пометил Действие как Завершённое Вручную, а вы 

затем установите его в Автоматическое Завершение, Действие станет непомеченным – 

очень сконфузив Студента, который уже пометил его! 

 

Совет: лучше не разблокировать опции, если вы не уверены, что это не вызовет 

проблем – например, если вы знаете, что Студенты ещё не имеют доступ к Курсу, так 

это послужит только персоналу, который пометил это Действие Завершенным при 

тестировании. 

4.9.3.1.3.Что происходит при разблокировании 
После того как вы разблокируете опции и затем щёлкните «Save changes 

(сохранить изменения)», вся информация о Завершении Действия будет удалена и, если 

возможно, регенерируется в соответствии с новыми настройками. 

 Если новая опция Завершения есть «Manual (вручную)», каждый? будет установлен в 

«Not completed (не завершённое)», независимо от любой предыдущей настройки. 
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 If it is automatic then, depending on the options chosen, the system may 

or may not be able to construct a correct current value for everyone. 

 

 The 'viewed' requirement will not work - even if a student has 

viewed the activity before, it will not be marked completed until 

they view it again. 

 Most other options will be recalculated successfully. 

If you change completion options while a student is logged in, they may 

not see the changes for some minutes. 

4.9.3.1.4.Required site settings 
To use activity completion, the feature needs to be enabled for the site by 

an administrator as follows: 

1. In Administration > Site administration > Advanced features check 

the "Enable completion tracking". 

2. Click the 'Save changes' button 

Tip: The default Cron trigger for activity completion is every 10 

minutes. Students and Teachers often think any course completion 

should instantly show up in a report. 

4.9.3.1.5.Required course settings 
Administration > Course administration > Edit settings and look for the 

Completion tracking section. 

You must enable this setting. 

4.9.3.2.Using Activity completion 
4.9.3.2.1.Why use Activity completion? 
 If this feature is enabled, it is a helpful way for students to be able to 

track their progress in a course. The student has an easy to see checklist 

of what they have done so far. 

 It can also be linked to Course completion in order to allow both 

students and teachers to watch progress through a course. As each 

activity is checked off as "complete", the student moves futher towards 

final completion of the course. 

 It can also be linked to Conditional activities in order to allow the 

teacher to set criteria upon which a student is allowed to progress 

through a course and access materials. 

 

 

 

 

 

 Если это «Automatic (автоматически)» тогда, в зависимости от выбранных опций, 

система может быть или не быть в состоянии построить правильное текущее значение 

для каждого. 

 Требование «Viewed  (просмотрено)» работать не будет – даже если Студент 

просмотрел Действие раньше, оно не будет помечено как Завершённое, пока он не 

просмотрит его снова. 

 Большинство других опций будет успешно пересчитаны. 

Если изменить опции завершения пока Студент входит в систему, он может не 

увидеть изменения в течение нескольких минут. 

4.9.3.1.4.Требуемые настройки Сайта 
Для использования Завершение Действия, это средство должно быть включено на 

уровне Сайта Администратором следующим образом:  

1. В Administration→Site administration→Advanced features установите флажок «Enable 

completion tracking (включить завершение отслеживания)». 

2. Щёлкните кнопку «Save changes (сохранить изменения)»  

Совет: по умолчанию триггер Cron (хрон) для Завершения Действия является каждые 

10 минут. Студенты и Преподаватели часто думают, что любое Завершение Курса 

следует немедленно показать в отчёте. 

4.9.3.1.5.Требуемые настройки Курса 
Administration→Course administration→Edit settings и найдите Completion tracking 

section (раздел отслеживания завершения). 

Вы должны включить эту настройку. 

4.9.3.2.Использование Завершение Действия 
4.9.3.2.1.Почему используется Завершение Действия? 
 Если это средство включено, это полезный способ для Студентов, иметь возможность 

отслеживать свой прогресс в Курсе. Студент сможет легко увидеть список того, что он 

делал до сих пор. 

 Это также может быть связано с Завершением Курса, с тем чтобы позволить и 

Студентам, и Преподавателям просматривать прогресс в Курсе. Так как с каждого 

Действия снимается пометка как «завершённое», Студенты двигаются дальше к 

окончательному Завершению Курса. 

 Это также может быть связано с Обусловленными Действиями, чтобы позволить 

Преподавателю установить критерии, которые допустят Студента к прогрессу Курса 

через материалы Курса и доступа. 
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4.9.3.2.2.Activity completion icons 
 

 

 

 

 

 

 

 

 

4.9.3.2.3.Activity completion report 
Activity completion info can be viewed by managers, teachers and non-

editing teachers (and any other users with the capability 

report/progress:view) in Administration> Course administration> Reports 

> Activity completion. 

4.9.3.3.Activity completion FAQ 
 
4.9.3.3.1 What happens when completion 
conditions are unlocked? 
Once you unlock options and then click 'Save changes', all completion 

information for the activity will be deleted and, if possible, regenerated 

according to the new settings. See the section 'What happens when you 

unlock' in Activity completion settings for further details. 

 

4.9.3.3.2 Activity completion status does not 
change 
Has Cron been run on the server side? Activity completion default is to be 

trigger by a cron event at a regular interval. The default is 10 minutes. 

 

Why so long a gap? My students want instant gratification and positive 

reinforcement they have taken another step! The update on a site can take 

time and resources of the server because it looks at every course, every 

activity, every user. 

 

 

 

 

 

4.9.3.2.2.Иконки Завершения Действия 
Manual (вручную) – всё ещё не отмеченные как Завершённые 

Manual – включено 

Manually completed – Завершённые вручную 

Automatically completed – Завершённые Автоматически 

Automatically failed – Автоматически не удавшиеся 

Automatically – не Завершённые 

Automatically passed – Автоматически получившие зачёт 

Automatically – включённые 

 

4.9.3.2.3.Отчёт о Завершении Действия 
Информацию о Завершении Действия могут просмотреть, Менеджеры, 

Преподаватели и неРедактирующие Преподаватели (и любые другие пользователи с 

возможностью report/progress:view) в 

 

4.9.3.3.Часто задаваемые вопросы по 
Завершению Действия 
4.9.3.3.1.Что происходит при разблокировании условий 
Завершения? 

После того как вы разблокировали опции и затем нажади «Save changes (сохранить 

изменения)», вся информация о Завершении для Действия будет удалена и, если 

возможно, регенерирована в соответствии с новыми настройками. См. раздел «Что 

происходит при разблокировании» в настройках Завершения Действия (п. 4.9.3.1), для 

получения дополнительной информации. 

4.9.3.3.2.Состояние Завершения Действия не изменяется 
 

Cron (хрон) был запущен на стороне сервера? Завершение Действия по умолчанию 

должно быть запущено сигналом Хрона в течение очередного интервала. По умолчанию 

он составляет 10 минут.  

Почему такой длинный разрыв? Мои Студенты хотят мгновенного удовлетворения 

и положительного подкрепления того, что они сделали ещё один шаг! Обновление на 

Сайте может занять некоторое время и ресурсы сервера, потому что он следит за каждым 

Курсом, каждым Действием, каждым пользователем. 



 

488 

4.9.3.3.3.How do I change the default time to 
refresh course completion reports 
Want to change the default time? This will require a code tweak at line 126 

or so in the /lib/completionlib.php file. Make sure the server is sending a 

cron message to Moodle every 10 minutes or more often. If the server is 

sending a cron trigger to Moodle every 60 minutes, that will be the length 

of time which will pass before the change will appear. 

4.9.3.3.4 Can I move the activity completion 
checkboxes to the left instead of the right? 
If you are using Formal white theme, add the following to the Custom CSS 

box in Appearance>Themes>Formal white 

 

/* Completion Checkbox Left of Activity Icon */ 

.path-course-view li.activity span.autocompletion, .path-course-view 

li.activity form.togglecompletion { right: auto; left: 0; } 

/* Align Checkboxes Full Left */ 

.path-course-view li.activity div.mod-indent-1 span.autocompletion { 

margin-left: -30px; } 

/* Small Space Between Checkbox & Icon */  

.path-course-view .section .activity img.activityicon { padding-left: 1em; } 

Administration→Course administration→Reports→Activity completion. 

(Thanks to Christian Herman for this tip) 

4.9.4.Course completion 
Allows for a course to be officially marked as finished, either manually or 

automatically according to specified criteria. 

Course completion shows if a course has been completed. It can show the 

progress a student is making towards finishing the course according to 

specific criteria. The criteria can include meeting an activity's grade level 

or a manual checking "complete" by either the student and/or teacher. The 

report can also show if the student has completed another course(s) that is 

marked as a "completion dependent" course. 

Course completion does not have a "restrict access" function. It is best 

thought of as a report. 

4.9.4.1.Course completion settings 
4.9.4.1.1.Course completion settings 
In order to use the course completion features, it has to be enabled in the 

site administration settings before the course completion link will 

4.9.3.3.3.Как изменить время по умолчанию для освежения 
отчётов по Завершению Курса 

Хотите изменить время по умолчанию? Это потребует корректировки кода в 

строке 126 или около того в файле /lib/completionlib.php. Убедитесь, что сервер посылает 

сообщение Хрона в Moodle каждые 10 минут или чаще. Если сервер переключает Хрон 

для Moodle каждые 60 минут, что будет тем отрезком времени, который пройдёт, прежде 

чем появятся изменения. 

4.9.3.3.4 Можно переместить кнопки-флажки 
Завершения Действия справа налево? 

Если вы используете Официальное белую тему фоновой картинки, добавьте 

следующие строки в окошке Custom CSS в 

Administration→Site administration→Appearance→Themes→Formal white: 

/* Кнопка-флажок Завершения слева от иконки Действия */  

.path-course-view li.activity span.autocompletion, .path-course-view li.activity 

form.togglecompletion { right: auto; left: 0; } 

/* Выравнять кнопки-флажки по левомукраю */ 

.path-course-view li.activity div.mod-indent-1 span.autocompletion { margin-left: -30px; } 

 

/* Небольшой зазор между кнопкой-флажком и иконкой */ 

.path-course-view .section .activity img.activityicon { padding-left: 1em; } 

 

(Благодарим Кристиана Германа за предоставленный код) 

4.9.4.Завершение Курса 
Позволяет официально пометить Курс как Завершённый либо Вручную, либо 

Автоматически в соответствии с заданными критериями. 

Завершение Курса показывает, что Курс Завершён. Оно может показывать 

прогресс Студента, сделанный при прохождении Курса в соответствии с определёнными 

критериями. Эти критерии могут включать получение проходных Оценок Действий или 

пометки «завершён» вручную Студентом, и/или Преподавателем. Отчёт может также 

показать, что Студент завершил другой Курс(ы), который. помечен как Курс 

«необходимый для Завершения».  

Завершение Курса не имеет функции «ограничить доступ». Лучше всего думать о 

нём как о виде отчёта. 

4.9.4.1.Настройки Завершения Курса 
4.9.4.1.1.Настройки Завершения Курса 

Для того, чтобы использовать средства ЗавершенияКурса, он должен быть включен 

в настройках Администратора Сайта до того, как ссылка 
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appear in Administration>Course administration>Course completion. 

There are also settings which need to be reviewed in the course 

administration settings. You should also install the Course completion 

status block and if required the Self completion block to view reports and 

use some of the features of course completion. 

General 
Choose here how you wish to mark the course complete -whether you want 

Any or All of the requirements that follow to count towards completion. 

Condition: Activity completion 
Tick the boxes of the activities you wish to count towards completion of 

the course. (You need to have Activity completion enabled to be able to do 

this. You can decide whether ALL of the activities must be completed or 

ANY one of them.) 

Condition: Completion of other courses 
This setting allows you to make "the completion of another course" as a 

condition for completing the course you are currently working in. This 

does not block the student from your current course; it simply means that 

the current course will not be marked complete until the first course has 

been marked complete. Thus, completion of the current course is 

dependent upon completion of an earlier course. Just select one or more 

courses in the "Courses available box". Note: Once you have selected a 

course, it's not currently possible to remove it. See MDL-27114. 

Condition: Date 
If you tick the Enable box you can then set a date after which the course 

will be declared complete. 

 

Condition: Enrolment duration 
If you tick the Enable box you can then choose a number of days after 

enrolment upon which the course will be marked complete. 

 

 

Condition: Unenrolment 
If you tick "Enable" here then the course will be marked complete once the 

student is unenrolled. 

Condition: Course grade 
If you tick the Enable box, you can set a passing grade for the course. 

 

 

 

«Course completion (завершение курса)» появится в 

Administration→Course administration→Course completion. Есть также настройки, которые 

должны быть просмотрены в «Course administration→Edit settings». Вы также должны 

инсталлировать Блок Со Завершения Курса и, если требуется, Блок Само Завершения для 

просмотра отчётов и использования некоторых средств Завершения Курса. 

Обычные 
Выберите здесь, как вы хотите пометить Завершение Курса – либо после 

выполнения Любого из, либо Всех требований, которые следует принять во внимание. 

Условие: Завершение Действия 
Отметьте «галочками» окошки Действий, выполнение которых вы считаете 

необходимым для завершения Курса. (Вам нужно иметь включённным Activity completion, 

чтобы иметь возможность сделать это. Вы можете решить, ВСЕ Действия должны быть 

завершены, либо ЛЮБОЕ из них.) 

Условие: Завершение других Курсов 
Эта настройка позволяет сделать «Завершение другого Курс» в качестве условия 

для Завершения данного Курса, над которым вы в настоящее время работаете. Это не 

запрещает Студенту работать над вашим текущим Курсом, это просто означает, что 

нынешний Курс не будет помечен как Завершённый до тех пор, пока каждый из более 

ранних Курсов не будет помечен как Завершённый. Таким образом, Завершение текущего 

Курса зависит от Завершения предыдущего Курса. Просто выберите один или более 

Курсов в «Courses available box (окошке доступных курсов)». Замечание: После того как 

вы выбрали Курс, удалить его в настоящее время невозможно. См. MDL-27114. 

Условие: Дата 
Если вы пометите «галочкой» окошко Enable 

(позволить), вы сможете установить дату, после которой 

Курс будет объявлен Завершённым. 

Условие: Период зачисления 
Если вы пометите «галочкой» окошко Enable, вы 

сможете выбрать количество дней 

после зачисления, в течение 

которых этот Курс может быть помечен как Завершённый. 

Условие: Отчисление 
Если пометить «галочкой» окошко Enable здесь, то этот Курс 

будет помечен как Завершённый после того, как Студента отчислят. 

Условие: Оценка за Курс 
Если вы пометите «галочкой» 

окошко Enable, то вы сможете установить 

проходную Оценку для этого Курса.

http://tracker.moodle.org/browse/MDL-27114
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Condition: Manual self-completion 
If this is enabled then a student can mark the course complete themselves 

from the Self completion block 

Condition: Manual completion by others 
Users with selected roles may mark the course as complete if their role is 

ticked here. The roles listed are ones for which the capability Mark users 

as complete in course completion is allowed. 

 

ALL means that each role must mark the course complete before; ANY 

means that it will be classed as complete once one role has marked it 

complete. 

 

 

 

 

 

 

 

 

4.9.4.1.2.Course administration settings 
Course administration > Edit settings 

 Completion tracking must be enabled. 

4.9.4.1.3.Site administration settings 
Use 

Site administration > Advanced features > Enable completion tracking 

(check enabled) in order to allow completion tracking on your site. 

 

You can set Completion tracking as On or Off in new courses as a course 

default in Site administration > Courses > Course default settings. 

 

Tip: The Cron trigger default for course completion is every 10 minutes. 

This is not usually what the Teachers and Students expect. The length of 

time can be impacted by the server cron schedule and by the code found in 

/lib/completionlib.php under "Cache expiry time" 

4.9.4.1.4.Course completion capabilities 
There are two capabilities, both of which are allowed for the default roles 

of manager, teacher and non-editing teacher: 

 View course completion report 

 Mark users as complete in course completion 

Условие: СамоЗавершение вручную 
Если окошко Enable помечено «галочкой», тогда Студент может пометить Курс как 

Завершённый из Блока СамоЗавершение (п. 4.5.1). 

Условие: Завершение вручную другими 
Пользователи с выбранными Ролями могут пометить Курс как Завершённый, если 

их Роль отмечена здесь. Перечисленные Роли являются теми, для которых разрешена 

Возможность «Пометить пользователей как способных завершать Курс 

(moodle/course:markcomplete)».  

ALL (все) означает, что каждая Роль должна пометить этот Курс как Завершённый 

прежде (чем он будет считаться Завершённым); ANY (любой) означает, что он будет 

классифицироваться как Завершённый, как только одна Роль пометит его как 

Завершённый. 

 

 

 

 

 

 

 

4.9.4.1.2.Настройки управления Курсом 
Administration→Course administration→Edit settings 

 Настройка Completion tracking должна быть включена. 

4.9.4.1.3.Настройки управления Сайтом 
Используйте 

Administration→Site administration→Advanced features→Enable completion tracking 

(проверьте, что включено), с тем чтобы позволить отслеживание Завершений на вашем 

Сайте. 

Вы можете установить настройку Completion tracking (отслеживание завершений) в 

On (включено) или Off  (выкл.) в новых Курсах как настройку Курсов по умолчанию в 

Administration→Site administration→Courses→Course default settings. 

Совет: По умолчанию Cron для Завершения Курса переключается каждые 10 

минут. Обычно, это не то, что Преподаватели и Студенты ожидают. Продолжительность 

времени может зависеть от графика Cron на сервере и от кода, найденного в 

/lib/completionlib.php под заголовком «Cache expiry time (время истечения срока)». 

4.9.4.1.4.Возможности Завершения Курса 
Есть два Возможности, обе из которых разрешены по умолчанию для Ролей 

Менеджер, Преподавателя и неРедактирующего Преподавателя: 

 Просматривать Отчёт о Завершении Курса. 

 Отмечать пользователей как способных проставить пометку Курс Завершён.  

http://docs.moodle.org/25/en/Capabilities/report/completion:view
http://docs.moodle.org/25/en/Capabilities/moodle/course:markcomplete
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4.9.4.2.Using Course completion 
4.9.4.2.1.Ways of using course completion 
Course completion can be used in many ways. It is important to remember 

that this feature is only a reporting feature. 

While course completion will not lock a student out of another course, it 

will allow a teacher to see if a student has completed the recommended 

prerequisite courses. 

It can also work with Activity completion to show students the activities 

they have completed. This can be via a check mark next to the activity on 

the course's home page, or by looking at the Course completion status 

block. 

It is a way to ensure that the teaching team's members sign off that a 

student has completed the course. For example, Teacher B is the instructor 

for Course2, which has a recommended prerequisite for completing 

Course1. Teacher B, is the non-editing teacher in Course1 and must check 

the box that indicates the student has completed the course. 

 

Courses can be linked via their course completion criterion. 

Note: The course completion feature works with Cron. Thus changes in 

reports may not appear until after cron.php has run. 

4.9.4.2.2.Manual completions 
Depending upon the settings, course completion can require that an activity 

or the entire course be manually marked as complete. The settings will 

allow any number of combinations. For example, an activity might require 

the student to receive a minimum score and have the non-editing teacher 

manually check complete. Or merely require the student to check an 

activity or the course as complete. 

Manual marking by student examples 
A course completion setting may require the student to confirm they have 

completed the course. Students do this by using the Self completion block. 

A course completion setting may require a student to manually mark an 

activity when they believe they have finished it. On the course homepage, 

the student may see a box to check as a self completion of the activity. 

 

Manual marking by teacher examples 
In order for a teacher (or non editing teacher, Manager or other role) to 

mark a course as complete, the appropriate box in the Manual Completion 

by.. section must be checked in the completion tracking settings. 

 

4.9.4.2.Использование Завершения Курса 
4.9.4.2.1.Способы использования Завершения Курса 

ЗавершениеКурса может быть использовано по-разному. Важно помнить, что это 

средство является лишь средством отчётности. 

Наряду с тем, что Завершение Курса не запрещает Студенту работать с другим 

Курсом, оно позволяет Преподавателям увидеть, завершил ли Студент рекомендуемые 

предварительные Курсы. 

Оно также может работать с Завершением Действия, чтобы показать Студентам 

Действия, которые они Завершили. Завершение может быть передано посредством 

«галочки» рядом с Действием на Домашней Странице Курса, либо показом в 

Блоке Статуса Завершения Курса (п. 4.9.4.3). 

Завершение Курса – это способ гарантировать, что члены команды Преподавателей 

подписали, что Студент закончил Курс. Например, Преподаватель B является 

инструктором для Курса2, который имеет рекомендованный Обязательный для 

Завершения Курс1. Преподаватель B является неРедактирующим Преподавателем в 

Курсе1, и должен пометить «галочкой» окошко, которое указывает, что Студент Завершил 

этот Курс. 

Курсы могут быть связаны через их критерии Завершения Курса.  

Замечание: Средство Завершение Курса работает с Cron. Поэтому изменения в 

отчётах могут появиться только после запуска cron.php. 

4.9.4.2.2.Завершения Вручную 
В зависимости от настроек Завершение Курса может потребовать, чтобы Действие 

или весь Курс могли быть помечены вручную как Завершённые. Эти настройки позволят 

создать любое количество комбинаций. Например, Действие может потребовать от 

Студента получать минимальное количество Исходных Баллов и ожидать от 

неРедактирующего Преподавателя вручную помечать Завершение. Или просто потребует, 

чтобы Студент помечал Действие или Курс как Завершённые. 

Примеры пометок Студентом вручную 
Настройка Завершение Курса может потребовать, чтобы Студент подтверждал, что 

он завершил Курс. Студенты осуществляют это, используя Блок СамоЗавершения 

(п. 4.9.4.4). Настройка Завершение Курса может потребовать, чтобы Студент вручную 

отмечал Действие как Завершённое, когда он сочтёт, что он действительно завершил его. 

На Домашней Странице Курса Студент может увидеть окошко для пометки 

самоЗавершение Действия. 

Примеры пометок Преподавателем вручную 
Для того, чтобы Преподаватель (или неРедактирующий Преподаватель, Менеджер 

или другая Роль) помечала Курс как Завершённый, соответствующее окошко в разделе 

«Завершение Вручную посредством…» должно быть помечено в настройках 
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The teacher then accesses the Course completion status block and checks 

the names of the students who are deemed to have completed the course. 

 

Just course completion with a teacher check is being used: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.9.4.2.3.Course completion based on specified 
criteria 
It is possible to have a course marked as complete dependent on a 

combination of specified criteria such as activities completed, grade 

achieved or length of time spent in the course. This is decided in the 

overall criteria type aggregation. 

The settings for automatic course completion are described in more detail 

in Course completion settings and these include: 

 activities completed 

 date 

 duration after enrolment 

 grade 

 unenrolment 

4.9.4.2.4.Course completion report 
Course completion info can be viewed by managers, teachers and non-

editing teachers (and any other users with the capability 

report/completion:view) in Administration> Course administration > 

Course completion or via a link in the Course completion status block. 

 

4.9.4.2.5.See also 
 Course completion status block 

отслеживаения Завершения.  

Затем Преподаватель обращается к Блоку Статуса Завершения Курса (п. 4.9.4.3) и 

помечает те имена Студентов, которые считаются завершившими Курс. 

Вот как используется ЗавершениеКурса только Преподавателем:. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.9.4.2.3.Завершение Курса на основе заданных критериев 
 

Можно иметь Курс, помеченный как Завершённый, в зависимости от сочетания 

конкретных критериев, таких как Завершённые Действия, Полученная Оценка или 

Продолжительность времени прохождения Курса. Выбор такой комбинации делается при  

Суммарной Агрегации Критериев. 

Настройки для автоматического Завершения Курса описаны более подробно в 

настройках окончании Курса, и к ним относятся: 

 Завершённые Действия 

 Дата 

 Срок после зачисления (продолжительность пребывания в Курсе) 

 Полученная Оценка 

 Отчисление 

4.9.4.2.4.Отчёт о Завершении Курса 
Информация о Завершении Курса может быть просмотрена Менеджерами, 

Преподавателями и неРедактирующими Преподавателями (и любыми другими 

пользователями с Возможностью report/completion:view) в 

Administration→Course administration→Course completion или посредством ссылки в 

Блоке Состояния Завершения Курса (п. 4.9.4.3). 

4.9.4.2.5.См. также 
 Блок Состояния Завершения Курса (п. 4.9.4.3). 

http://docs.moodle.org/25/en/Capabilities/report/completion:view
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 Self completion block 

4.9.4.3.Course completion status block 
The course completion status block shows what has been done towards 

completing the course. The student and teacher will both see this block. 

The "More information" link will lead to a more detailed report. This 

report can have some interactive elements in the form of check boxes for 

the student and teacher. 

 The "Course completion block" must be added to the course in order to 

see the "Course completion status" block. 

4.9.4.3.1.Student view of Course completion 
status block 
The student can see their progress in the course by looking at the content of 

the block or clicking on the "More details" link to see a report. 

The student, if required, can mark an activity as completed on the course's 

homepage. 

4.9.4.3.2.Teacher view of Course completion 
status block 
This block shows the status for each student. It is also the place where the 

teacher (or others) can mark the course as complete. 

Note: The course completion status block will only appear if completion 

tracking criteria are set in Settings > Course administration > Completion 

tracking. 

4.9.4.3.3.Capabilities 
Be shown on completion reports 

4.9.4.4.Self completion block 
The self completion block provides a link for students to declare that they 

have completed the course. This maybe part of the Course completion 

requirements. 

When a student believes they have completed the course, they click on the 

"Complete course" link in this block. 

4.9.4.4.1.Using the self completion block 
To allow a student to decide for themselves when they have completed a 

course, there are two requirements: 

 The completion tracking setting must have the "Manual Self 

Completion" box checked. 

 The Self completion block must be added to the course. 

The student may then click the "complete course link" in the block. 

 

 Блок СамоЗавершения (п. 4.9.4.4). 

4.9.4.3.Блок Состояния Завершения Курса 
Блок Состояния Завершения Курса показывает, что было сделано в направлении 

Завершения Курса. Студент и Преподаватель оба увидят этот Блок. Ссылка «More 

information (более подробная информация)» приведёт к более детализированному Отчёту. 

Этот отчёт может иметь некоторые интерактивные элементы в виде окошек-флажков для 

Студента и Преподавателя. 

 Блок «Завершение Курса» должен быть добавлен в Курс для того,чтобы видеть Блок 

«СостояниезавершенияУрса». 

4.9.4.3.1.Как видит Студент Блок 
Состояния Завершения Курса 

Студент может видеть свой прогресс в Курсе, глядя на содержимое этого Блока 

или щёлкнув ссылку «More details (подробнее)», чтобы увидеть отчёт 

Студент, в случае необходимости, может отметить Действие как Завершённое на 

Домашней Странице Курса. 

4.9.4.3.2.Как Преподаватель видит 
Блок Состояния Завершения Курса 

Этот Блок показывает состояние каждого Студента. Это также место, где 

Преподаватель (или другие) могут отметить Курс как Завершённый. 

Замечание: Блок Состояния Завершения Курса появится только тогда, когда 

критерии отслеживания Завершения установлены в 

Administration→Course administration→Completion tracking. 

4.9.4.3.3.Возможности 
Показываются в отчётах о Завершении. 

4.9.4.4.Блок самоЗавершение 
Блок СамоЗавершение предоставляет связь Студентам для заявления, что они 

Завершили Курс. Это может быть частью требований к Завершению Курса. 

 

Когда Студент считает, что он завершил Курс, он щёлкает ссылку «Complete course 

(завершить курс)» в этом Блоке. 

4.9.4.4.1.Использование Блока самоЗавершение 
Чтобы позволить Студенту самому решать, что он завершил Курс, есть два 

требования:  

 Настройка «Completion tracking (отслеживание завершения)» должна иметь окошко 

«Manual Self Completion (само завершение вручную)» помеченным «галочкой». 

 Блок самоЗавершение должен быть добавлен в Курс. 

Студент может затем щёлкнуть «Complete course link (ссылка завершения курса)» в 

этом Блоке. 
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They are then asked to confirm they have completed the course and the 

course status will change to "complete" after the next Cron job. 

 
Tip: Cron is an important part of the course completion process. It 

basically re-compiles all the course completion reports. 

4.9.4.5.Course completion FAQ 
4.9.4.5.1.Students have completed things but the 
report does not show it 
The default time for updating course completion is every 10 minutes. You 

have several options: 

 Tell your students the update schedule. 

 Ask your site administrator to tell you the when the 10 minute Cron will 

run, so you can tell your students "The competition report or Activity 

completion block will be upgraded every 10 minutes, starting 5 minutes 

after each hour." 

 Alter the language pack, or help files to include this information. 

 Ask your site administrator how often the Moodle cron php file is 

triggered If it is longer than 10 minutes, that will be the default interval. 

 Ask your site administrator if they would change the cache expiry time 

from 10 minutes to something different. They might tweak the code at 

/lib/completionlib.php around line 126. 

 Ask your site administrator to make sure the server cron triggers 

Moodle to run cron at the same interval as the cron setting for course 

completion. 

 See if you can trigger cron by going to your Moodle site and adding 

/admin/cron.php to your browser address. For example after logging 

into your Moodle site, in the browser address put 

mymoodlesite.edu/admin/cron.php. 

Затем он просит подтвердить, что он Завершил Курс и состояние Курса будет 

изменено на «завершённый» после очередной работы Cron: 

 
Совет: Cron является важной частью процесса Завершения Курса. Он в основном 

повторно компилирует все отчёты об окончании Курсов. 

4.9.4.5.Часто задаваемые вопросы о Завершении Курса 
4.9.4.5.1.Студенты что-то завершили, но Отчёт не 
показывает это 

По умолчанию обновление информации о Завершении Курса просходит каждые 10 

минут. У вас есть несколько вариантов: 

 Расскажите своим Студентам о графике обновлений. 

 Попросите Администратора Сайта сообщить вам, когда работает 10-минутный Cron, 

чтобы вы могли сказать своим Студентам: «Отчёт о конкуренции или 

Блок Завершения Действия обновляется каждые 10 минут через 5 минут после каждого 

часа». 

 Измените языковой Пакет, или помогите включить эту информацию в файлы. 

 Спросите Администратора Сайта, как часто PHP-файл Cron срабатывает в Moodle. Если 

больше, чем через 10 минут, это и будет интервал по умолчанию . 

 Попросите Администратора Сайта изменять величину времени истечения с 10 минут на 

какую-то другую. Они могут настроить код в /lib/completionlib.php где-то в районе 126 

строки. 

 Попросите Администратора Сайта убедиться, что Cron сервера заставляет Moodle 

запускатьь Cron с тем же интервалом, который указан в настройках Cron по 

Завершению Курса. 

 Помотрите, сможете ли вызвать Cron, зайдя на ваш Сайт Moodle и поместив 

/admin/cron.php в адрес вашего браузера. Например, войдя на ваш Сайт Moodle, в адрес 

браузере поместить mymoodlesite.edu/admin/cron.php. 

http://docs.moodle.org/25/en/Cron
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4.9.4.5.2.I have set up course prerequisites but 
my students can still access the second course 
before they have finished the first 
Sorry - the course prerequisites feature does NOT prevent students from 

accessing courses. It merely prevents the course from being marked as 

"complete" until they have completed another course. 

4.9.4.5.3.I made a mistake and had to erase my 
student data. Do my students have to redo the 
activities? 
No. For example, if you set the course completion for All aggregation 

methods and wanted to reset it to "Any", Moodle will warn you that you 

are deleting compiled student data. It will delete the student data only for 

the course completion information. When cron.php runs it will recompile 

the course completion information. 

4.9.4.5.4.My student got an error message when 
they click on more information in the course 
completion block 
Moodle is confused by your course completion settings. This may happen 

at the start of the course when the student has not completed an activity 

and/or you have selected an aggreation method of All and have not 

checked off that they have completed the activity. 

4.9.4.5.5.Where do my students tell me they have 
finished the course? 
Did you install the Self completion block? When they click on the link in 

that block, that will indicate they think they are done. You will have to 

wait for Cron to run before seeing the results in your course completion 

report. 

4.9.4.5.6.How can I set my course completion to 
be longer than 30 days after enrolment? 
Currently the dropdown menu only allows you to choose from up to 30 

days after enrolment. There is a tracker entry about this here MDL-34678. 

However, if you are happy editing the database then you can manually 

change the value. (Thanks to Aaron Barnes for the following instructions) 

You'll need to look in the mdl_course_completion_criteria table. The 

Duration After Enrolment criteria will have the "criteriatype" value of 5 

and the number of days is recorded in the column "enrolperiod" in seconds 

(so #days x 86400). You should be able to adjust the enrolperiod value and 

4.9.4.5.2.Я установил требуемый предварительно Курс, но 
мои Студенты всё равно имеют доступ ко второму Курсу, не 
окончив первого 

К сожалению, – средство требуемого заранее Курса не отменяет Студентам доступ 

к Курсам. Оно лишь не даёт отметить Курс как «Завершённый», пока они не завершили 

другой Курс. 

4.9.4.5.3.Я сделал ошибку и должен стереть данные моего 
Студента. Должны ли мои Студенты повторно выполнять 
каждое из Действий? 

Нет. Например, если вы установите Завершение Курса для ВСЕХ методов 

Агрегации и захотели переустановить его в «Any (любой)», Moodle предупредит, что вы 

удаляете собранные данные Студента. Это удалит только данные Студента, касающиеся 

информации о Завершении Курса. При запуске cron.php информация о Завершении Курса 

будет перекомпилирована. 

4.9.4.5.4.Мой Студент получил сообщение об ошибке, когда 
щёлкнул по «More information» в Блоке Заершения Курса 
 

Moodle сбили с толку ваши настройки Завершения Курса. Это может произойти в 

начале Курса, когда Студент не завершил Действие и/или вы выбрали метод Агрегации All 

(все) и не сняли пометку, что он завершил Действие. 

 

4.9.4.5.5.Где мои Студенты сообщат мне,что они завершили 
Курс? 

Вы установилиБлок СамоЗавершение? Когда они щёлкнут ссылку в этом Блоке, 

это укажет, они считают, что они завершили Курс. Вам придётся ждать запуска Cron до 

того, как увидите результаты в вашем отчёте о Завершении Курса. 

 

4.9.4.5.6.Как установить Завершение Курса на срок более 30 
дней после зачисления? 

В настоящее время из ниспадающего меню можно выбрать только до 30 дней 

после зачисления. Существует запись в Средстве Отслеживания об этом MDL-34678. 

Однако, если вам нравится редактировать базы данных, то вы можете вручную изменить 

это значение. (Благодарим Аарон Барнеса за следующие инструкции). Вам следует 

заглянуть в таблицу mdl_course_completion_criteria. Критерии Duration After Enrolment 

(срок после зачисления) будут иметь значение «criteriatype» равное 5, а число дней 

записывается в графе «enrolperiod» в секундах (как чиссло дней, умноженное на 86400). 

Вы должны быть в состоянии настроить значение enrolperiod и 

http://tracker.moodle.org/browse/MDL-34678
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after the next cron run everything will use the new value. 

4.9.4.5.7.See also 
Using Moodle forum discussions: 

 Confused how Completion.... err.... completes 

 How to set course completion requirements to include a minimum quiz 

grade? 

4.9.5.Badges 
Badges are a good way of celebrating New feature in Moodle 2.5! 

achievement and showing progress. Badges may be awarded based on a 

variety of chosen criteria and are fully compatible with Mozilla Open 

Badges. Badges created in Moodle may be displayed on a user's profile or 

pushed to their Open Badges backpack and public badge collections in 

their backpack will display in their Moodle profile. 

 

There are two categories of badges: 

 Site badges - available to users site-wide and related to the site wide 

activities, like finishing a set of courses. 

 Course badges - available to users enrolled in the course and related to 

the activities that happen inside the course. 

4.9.5.1.Managing badges 
Badges may be managed at the course or site level. (Note that teachers in a 

course cannot by default access site badges unless they have been given a 

system role with badge managing capabilities) For information on adding 

course or site badges, see 

Using badges. Individual 

users can manage their 

badges from their profile. 

 

 

 

 

 

 

 

 

 

 

 

 

после следующего запуска Cron всё будет использовать новое значение. 

4.9.4.5.7.См.также 
Обсуждения форума по использованию Moodle: 

 Непонятно, как Завершение …  эээ … завершает. 

 Как установить требования о Завершении Курса, чтобы включить минимальную 

Оценку за Экзамен? 

4.9.5.Символы Отличия 
Символы Отличия (беджики), это хороший способ Новая возможность в Moodle 2.5! 

отметки достижений и демонстрации прогресса. Символы Отличия можно присуждать в 

зависимости от различных выбранных критериев и полностью совместимы с Mozilla Open 

Badges. Символы Отличия, созданные в Moodle, могут отображаться в 

Профиле Пользователя или помещаться в Open Badges backpack (рюкзак открытых 

символов отличия) и коллекции общественных Символов Отличия в их Рюкзаке будет 

отображаться в их Профиле Moodle. 

Есть две категории Символов Отличия: 

 Символы Отличия Сайта – доступные для пользователей на уровне и относящиеся к 

Действиям на уровне Сайта, такие как Завершение набора Курсов). 

 Символы Отличия Курса – присваиваются пользователям, зачисленным на Курс, и 

связаны с деятельностью, которая происходит внутри Курса.  

4.9.5.1.Управление Символами Отличия 
Символами Отличия можно управлять на уровне Курса или Сайта. (Заметьте, что 

Преподаватели в Курсе не могут управлять Символами Отличия Сайта по умолчанию, 

если им не дана системная Роль с Возможностями управления Символами Отличия.) 

Сведения о добавлении Символов Отличия на уровне Сайта или Курса см. в разделе 

«Использование Символов Отличия» (п. 4.9.5.3). Отдельные пользователи могут 

управлять своими 

Символами Отличия из своего 

Профиля. 

http://moodle.org/mod/forum/discuss.php?d=184602
http://moodle.org/mod/forum/discuss.php?d=194747
http://moodle.org/mod/forum/discuss.php?d=194747
http://openbadges.org/
http://openbadges.org/
https://backpack.openbadges.org/
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4.9.5.1.1.Managing course badges 
 If course badges have been enabled in Administration>Site 

administration>Badges>Badges settings, then a teacher will see a link 

Administration>Course administration>Badges>Managing badges. 

This will show a list of badges created and available for allocation, 

along with actions which may be performed on them: 

 Badge status: Badges may be made available or not by enabling or 

disabling with the "eye" icon or enable/disable button 

  

 Criteria : This shows how the badge is awarded 

 Recipients: This shows the number of users awarded the badge 

 Actions: The following actions are available 

 
Note: Availability of enable and disable access actions depends on the 

current status of a badge (e.g. if a badge is available to users, "disable 

access" icon will be shown). 

Before a badge has been issued to at least one user, all its details and 

settings can be edited by clicking the "Edit badge" action icon. 

 

Clicking on the name of a badge takes you to the screen where you can 

manage details of that particular badge. The following tabs are available: 

Overview 
This screen provides an overview of the badge details. 

Edit details 
If you wish to change the details of a badge once you have set it up, you 

must first click to "disable access". Once you have edited the details, you 

must then click to "enable access" again. 

Criteria 
Here you can see the criteria set when adding the badge. 

 

 

 

4.9.5.1.1.Управление Символами Отличия Курса 
 Если Символы Отличия позволены в 

Administration→Site administration→Badges→Badges settings, то Преподаватель увидит 

ссылку Administration→Course administration→Badges→Managing badges. Переход по 

ней покажет список Символов Отличия, созданных и доступных для размещения 

наряду с действиями, которые могут быть выполнены с ними: 

 Статус Символа Отличия: Символы Отличия могут быть сделаны доступными или нет 

посредством путём включения или отключения иконки «глаз» или кнопки 

Enable/disable (влючить/отключить). 

 Критерии: показывает, за что присуждаются Символы Отличия. 

 Получатели: показывает число пользователей, получивших этот Символ Отличия. 

 Действия: доступны следующие действия 

 
Замечание: Доступность включать и отключать доступ к Действиям зависит от 

текущего состояния Символа Отличия (например, если Символ Отличия доступен для 

пользователей, будет показан иконка «Disable access (отключить доступ)»).  

До первого присвоения Символа Отличия, все его детали и настройки могут быть 

отредактированы щелчком иконки действия «Edit badge (отредактировать символ 

отличия)». 

Щелчок по названию Символа Отличия приведёт к экрану, где можно управлять 

деталями этого конкретного Символа Отличия. Доступны следующие вкладки: 

Обзор 
Этот экран содержит обзор деталей Символа Отличия. 

Отредактировать детали 
Если вы хотите изменить детали Символа Отличия после его установки, вы 

должны сначала щёлкнуть «Disable access (запретить доступ)». После редактирования 

деталей, нужно затем снова щёлкнуть «Enable access (разрешить доступ)». 

Критерии 
Здесь вы можете увидеть критерии, установленные при добавлении 

Символа Отличия (п. 4.9.5.3). 
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Message 
This setting allows you to edit the message which goes to a badge earner. 

Among additional options here are "Attach badge to message" which 

allows adding an image file to an email and "Notify badge creator" selector 

which allows to set frequency of notifications sent to badge creator when 

this badge is issued to users. 

 

Recipients 
This tab displays a list of users who have already earned the badge 

 

4.9.5.1.2.Managing site badges 
 Badges should be enabled by default in Administration>Site 

administration>Advanced features and can be managed from 

Administration>Site administration>Badges>Manage badges. (For 

information on adding site badges see Using badges) 

 

 All existing badges are displayed in a table showing current badge 

image, name, status, criteria, how many users have already earned this 

badge and a set of available actions. 

 Other settings are the same as for course badges. Badges that have 

manual award among their criteria can be issued by one user to another. 

Users who issue a badge must have "moodle/badges:awardbadge" 

capability. Site administrators can choose their role when issuing a 

badge. 

4.9.5.1.3.Individual user badge management 
 
 Users may manage their site and external badges by clicking on 

Navigation>My profile>My badges. From here, they can view, search 

for and download badges. 

 

 This then displays "badges" in the Administration block. 

 

 

 

Example of a My badges screen 

 

 

 

 

Сообщение 
Эта настройка позволяет отредактировать сообщение, которое идёт к получившему 

Символ Отличия. Среди дополнительных опций есть такие «Attach badge to message 

(прикрепить символ отличия к сообщению)», которая позволяет присоединять файл с 

изображением к электронной почте, и селектор «Notify badge creator (известить создателя 

символа отличия)», который позволяет установить частоту уведомлений, отправляемых 

создателю Символа Отличия, когда этот Символ Отличия присваивается пользователям. 

Получатели 
На этой вкладке отображается список пользователей, которые уже заработали 

Символ Отличия. 

4.9.5.1.2.Управление Символами Отличия Сайта 
 Символы Отличия по умолчанию должны быть позволены в 

Administration→Site administration→Advanced features и могут управляться из 

Administration→Site administration→Badges→Manage badges. (Дополнительные 

сведения о добавлении Символов Отличия Сайта см. в разделе «Использование 

Символов Отличия» (п. 4.9.5.3)). 

 Все существующие Символы Отличия отображаются в таблице, показывающей образ 

текущего Символа Отличия, название, состояние, критерии, сколько пользователей уже 

заработали этот Символ Отличия и набор доступных Действий. 

 Другие настройки такие же, как для Символов Отличия Курса. Символы Отличия, 

которые имеют Manual award (присуждаются вручную) среди своих критериев могут 

быть присуждены одним пользователем к другому. Пользователи, которые присуждают 

Символ Отличия, должны иметь Возможность «moodle/badges:awardbadge». 

Администраторы Сайта могут выбрать себе Роль при присуждении Символа Отличия. 

4.9.5.1.3.Управление Символом Отличия отдельного 
пользователя 
 Пользователи могут управлять Символами Отличия своего Сайта и внешними 

Символами Отличия, щёлкнув Navigation→My profile→My badges. Отсюда, они могут 

просматривать, отыскивать и загружать 

Символы  Отличия. 

 Это затем отобразит «Символы Отличия» 

в Блоке Управления. 

 

 

Пример экрана «Мои Символы Отличия». 

 

 

http://docs.moodle.org/25/en/File:Badge_recipients.png
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Preferences 
Here users can decide whether to automatically display all badges earned. 

(Badges can be individually displayed or hidden from Navigation>My 

profile>My badges) 

Backpack settings 
Backpack connection 
If the email address a user has for Moodle is the same as their Open 

Badges email address, then they will be automatically connected here and 

may choose to disconnnect if they wish. If the email address a user has for 

Moodle is not the same, then they can add the email address which will 

connect them to their backpack. They can then choose to "push" to their 

backpack badges which they have earned on Moodle.The badge must then 

be added to a public collection for it to be visble on their Moodle profile. 

 

Badge import settings 
Here, a user is prompted to choose which public collections to import and 

display. 

4.9.5.2.Badges settings 
4.9.5.2.1.Individual user settings 
 A user can manage badges from Navigation>My profile>My badges. 

 

 A user can view available course badges from Navigation>Current 

course>Badges. 

4.9.5.2.2.Course administration settings 
 A teacher can add and manage badges in their course if the 

administrator has enabled course badges in Administration>Site 

administration>Badges settings. 

 They will see a link to badges in Administration>Course 

administration>Badges. where badges may be managed and added. 

 

4.9.5.2.3.Site administration settings 
 Badges are enabled by default and can be disabled in 

Administration>Site administration>Advanced features. (Note that 

disabling the feature once badges have been awarded does not prevent 

those badges being verified by external backpacks.) 

 The site settings for badges are located in Administration>Site 

administration>Badges>Badges settings 

 

Предпочтения 
Здесь пользователи могут решить, следует ли автоматически отображать все 

присуждённые Символы Отличия. (Символы Отличия могут быть индивидуально 

отображены или скрыты из Navigation→My profile→My badges.) 

Настройки Рюкзака  
Соединение Рюкзака 

Если адрес электронной почты пользователя имеет то же самое значение для 

Moodle, что и её адрес электронной почты Открытых Символов Отличия, то он будет 

автоматически подключён туда, и сможет выбираться для отсоединения, если 

пользователь захочет. Если адрес электронной почты пользователя для Moodle другой, то 

пользователь может добавить свой адрес электронной почты, который присоединит его к 

своему Рюкзаку. Далее он сможет выбрать «Push (поместить)» Символы Отличия, которые 

ему присудили в Moodle, в свой Рюкзак. Символ Отличия затем нужно поместить в 

публичную коллекцию, чтобы он стал видимым в его профиле Moodle. 

Настройки импорта Символов Отличия 
Здесь пользователю предлагается выбрать, какие из всех общественных коллекций 

следует импортировать и отображать. 

4.9.5.2.Настройки Символов Отличия 
4.9.5.2.1.Настройки отдельного пользователя 
 Пользователь может управлять Символами Отличия из 

Navigation→My profile→My badges. 

 Пользователь может просматривать доступные Символы Отличия Курса из 

Navigation→Current course→Badges. 

4.9.5.2.2.Настройки управления Курса 
 Преподаватель может добавлять и управлять Символами Отличия в своём Курсе, если 

Администратор разрешил Символы Отличия Курса в 

Administration→Site administration→Badges→Badges settings. 

 Он увидит ссылку на Символы Отличия в 

Administration→Course administration→Badges→Managing badges. где 

Символами Отличия можно управлять и добавлять их. 

4.9.5.2.3.Настройки управления Сайта 
 Символы Отличия позволяются по умолчанию и могут быть отключены в 

Administration→Site administration→Advanced features. (Заметьте, что отключение этого 

средства не мешает Символы Отличия, которые были уже присуждены, проверяться 

внешними Рюкзаками.) 

 Настройки Сайта для Символов Отличия расположены в 

Administration→Site administration→Badges→Badges settings. 
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Default badge issuer 
Here you set the name and email address of the issuer. The name will 

appear where the badges are displayed and might typically be the name of 

the organization. 

Salt for hashing recipient's email address 
If a hash is used (numbers and letters only) then backpack services can 

confirm a badge earner without exposing their email address. 

Enable connection to external backpacks 
This should be enabled in order to connect to, for example Mozilla Open 

Badges. Note that this will not work on a Moodle hosted locally/offline. 

Enable course badges 
Ticking this box will allow teachers to add and manage badges in their 

courses. 

4.9.5.2.4.Badges capabilities 
There are a number of capabilities associated with badges: 

Add a new My latest badges block 
Capabilities/block/badges:addinstance 

 This allows a user to add a My latest badges block to the front page. 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager and teacher 

Award a badge 
Capabilities/moodle/badges:awardbadge 

 This allows a user to award a badge to a user 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager, course 

creator, teacher and non-editing teacher, and is prevented for the role of 

student 

Set up criteria for awarding a badge 
Capabilities/moodle/badges:configurecriteria 

 This allows a user to set up/edit criteria of earning a badge 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager, course 

creator and teacher, and is prevented for the role of student 

Set up and edit badge details 
Capabilities/moodle/badges:configuredetails 

 This allows a user to set up/edit badge details 

New feature in Moodle 2.5 

 

Эмитент Символов Отличия по умолчанию 
Здесь вы можете установить название и адрес электронной почты эмитента. Это 

название появится там, где отображаются Символы Отличия и обычно может быть 

названием организации. 

Изюминка хэширования адресов э-почты получателей 
Если используется хэш (только цифры и буквы), то сервисы Рюкзака могут 

подтвердить заслужившего Символ Отличия, не демонстрируя адрес его э-почты. 

Позволить соединение с внешними Рюкзаками 
Это должно быть включен для подключения, например Mozilla Open Badges. 

Заметьте, что это не будет работать на Moodle, размещённой локально/оффлайн. 

Позволить Символы Отличия Курса 
Пометка флажком этого окошка позволит Преподавателям добавлять и управлять 

Символами Отличия в своих Курсах. 

4.9.5.2.4.Возможности Символов Отличия 
Есть целый ряд возможностей, связанных с Символами Отличия: 

Добавить новый Блок «Мои последние Символы Отличия» 
Возможность Capabilities/block/badges:addinstance 

 Позволяет пользователю добавить Блок «Мои последние Символы Отличия» (п. 4.5.25) 

на свою Главную Страницу.           Новое средство Moodle 2.5 

 Эта возможность по умолчанию позволена Ролям Менеджера и Преподавателя. 

Присвоить Символ Отличия 
Возможность Capabilities/moodle/badges:awardbadge 

 Позволяет пользователю о присуждении Символа Отличия пользователю. 

Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Ролям Менеджера, Создателя Курсов, 

Преподавателя и неРедактирующего Преподавателя, и не позволена Роли Студента. 

 

Установить критерии для присвоения Символа Отличия 
Возможность Capabilities/moodle/badges:configurecriteria 

 Позволяет пользователю настроить/отредактировать критерии получения 

Символа Отличия.       Новое стредство в Moodle 2.5. 

 Эта возможность позволена по умолчанию Ролям Менеджера, Создателя Курсов и 

Преподавателя и не позволена Роли Студента. 

Установить и отредактировать детали Символа Отличия 
Возможность Capabilities/moodle/badges:configuredetails 

 Позволяет пользователю настроить/отредактировать детали Символа Отличия. 

Новое стредство в Moodle 2.5. 

http://openbadges.org/
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 This capability is allowed for the default roles of manager, course 

creator and teacher, and is prevented for the role of student 

Configure badges messages 
Capabilities/moodle/badges:configuremessages 

 This allows a user to configure badge messages 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager, course 

creator and teacher, and is prevented for the role of student 

Create or duplicate badges 
Capabilities/moodle/badges:createbadge 

 This allows a user to create and duplicate badges 

 This capability is allowed for the default roles of manager, course 

creator and teacher, and is prevented for the role of student 

Delete badges 
Capabilities/moodle/badges:deletebadge 

 This allows a user to delete badges 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager, course 

creator and teacher, and is prevented for the role of student 

Earn badges 
Capabilities/moodle/badges:earnbadge 

 This allows a user to earn badges 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of student and 

authenticated user 

Manage badges site administration settings 
Capabilities/moodle/badges:manageglobalsettings 

 This allows a user to manage badges site administration settings 

New feature in Moodle 2.5 

 This capability is allowed for the default role of manager and is 

prevented for the role of student 

View and manage your own earned badges 
Capabilities/moodle/badges:manageownbadges 

 This allows a user to view and manage their own earned badges 

New feature in Moodle 2.5 

 This capability is allowed for the default role of authenticated user 

 

 

 Эта возможность позволена по умолчанию Ролям Менеджера, Создателя Курсов и 

Преподавателя, и не позволена Роли Студента. 

Сконфигурировать сообщения Символы Отличия 
Возможность Capabilities/moodle/badges:configuremessages 

 Позволяет пользователю сконфигурировать сообщения Символа Отличия.  

         Новое стредство в Moodle 2.5. 

 Эта возможность позволена по умолчанию Ролям Менеджера, Создателя Курсов и 

Преподавателя, и не позволена Роли Студента. 

Создать или сдублировать Символы Отличия 
Возможность Capabilities/moodle/badges:createbadge 

 Позволяет пользователю создать или сдублировать Символы Отличия. 

 Эта возможность позволена по умолчанию Ролям Менеджера, Создателя Курсов и 

Преподавателя, и не позволена Роли Студента. 

Удалить Символы Отличия 
Возможность Capabilities/moodle/badges:deletebadge 

 Позволяет пользователю удалить Символы Отличия. 

Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Ролям Менеджера, Создателя Курсов и 

Преподавателя, и не позволена Роли Студента. 

Заработать Символы Отличия 
Возможность Capabilities/moodle/badges:deletebadge 

 Позволяет пользователю заработать Символы Отличия. 

Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Ролям Студента и 

Аутентифицированного Пользователя. 

Настройки управления Сайтом по управлению Символами Отличия 
Возможность Capabilities/moodle/badges:manageglobalsettings 

 Позволяет пользователю управлять Символами Отличия через настройки управления 

Сайтом.         Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Роли Менеджера и не позволена Роли 

Студента. 

Просматривать присвоенные вами Символы Отличия и управлять ими 
Возможность Capabilities/moodle/badges:manageownbadges 

 Позволяет пользователю управлять Символами Отличия через настройки управления 

Сайтом.         Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Роли Менеджера и не позволена Роли 

Студента. 
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View users who earned a specific badge without being able 

to award a badge 
Capabilities/moodle/badges:viewawarded 

 This allows a user to view users who earned a specific badge without 

being able to award a badge 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View badges without earning them 
Capabilities/moodle/badges:viewbadges 

 This allows a user to view badges without earning them 

New feature in Moodle 2.5 

 This capability is allowed for the default roles of manager, student and 

authenticated user 

View public badges in other users' profiles 

 
Capabilities/moodle/badges:viewotherbadges 

 This allows a user to view public badges in other users' profiles 

New feature in Moodle 2.5 

 This capability is allowed for the default role of authenticated user 

NOTE: When upgrading to 2.5.1 from 2.5.0 there are some permissions for 

Administrators to check/set. See the section 'Upgrading from Moodle 2.5 

to 2.5.1 or later' in Upgrading. 

4.9.5.3.Using badges 
This page is about how to add badges to a course or the site and how users 

can access their badges. For managing badges which have already been 

added, see Managing badges. 

 

4.9.5.3.1.Adding a course badge 
If course badges have been enabled in Administration > Site 

administration > Badges > Badges settings then a teacher can add badges 

from Administration > Course administration > Badges > Add a new 

badge. 

Badge details 
Add a name and description and upload your badge here. 

Issuer details 
If you add the teacher name here, it will appear when the badge is 

displayed. An email address is optional. 

Просматривать пользователей, которые заработали конкретный 

Символ Отличия, без способности присудить Символ Отличия 
Возможность Capabilities/moodle/badges:viewawarded 

 Позволяет пользователю просматривать пользователей, которые заработали 

конкретный Символ Отличия, без способности присудить Символ Отличия.  

          Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Просматривать Символ Отличия без зарабатывания их 
Возможность Capabilities/moodle/badges:viewbadges 

 Позволяет пользователю просматривать Символы Отличия без зарабатывания их. 

          Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Ролям Менеджера, Студента и 

Аутентифицированного Пользователя. 

Просматривать публичные Символы Отличия в Профилях других 

пользователей 
Возможность Capabilities/moodle/badges:viewotherbadges 

 Позволяет пользователю просматривать публичные Символы Отличия в Профилях 

других пользователей.       Новое стредство в Moodle 2.5 

 Эта возможность позволена по умолчанию Роли Аутентифицированного Пользователя. 

Замечание: При обновлении версии 2.5.0 до 2.5.1 существует несколько 

Полномочий для Администраторов, чтобы помечать/устанавливать. См. раздел 

«Обновление с версии 2.5.0 до 2.5.2 или выше» в Upgrading. 

4.9.5.3.Использование «Символов Отличия» 
Эта страница о том, как добавлять Символы Отличия в Курс или на Сайт, и как 

пользователи могут получить доступ к своим Символам Отличия. Для управления 

Символами Отличия, которые уже были добавлены, см. раздел «Управление 

Символами Отличия» (п. 4.9.5.1). 

4.9.5.3.1.ДобавлениеСимвола Отличия на уровень Курса 
Если Символы Отличия уровня Курса включены в 

Administration→Site administration→Badges→Badges settings,  

то Преподаватель может добавлять Символы Отличия из 

Administration→Course administration→Badges→Add a new badge. 

Детали Символа Отличия 
Добавьте название и описание и загрузите Символ Отличия здесь. 

Подробности об эмитенте 
Если вы добавите имя Преподавателя здесь, оно появится при отображении 

Символа Отличия. Адрес электронной почты не является обязательным. 

http://docs.moodle.org/25/en/Upgrading
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Badge expiry 
Set a date here if the badge will cease to be valid after a certain date. Leave 

it to never if you want the badge to be permanently displayed. 

 

 When the settings are saved, you are then taken to the Manage badges 

screen where you can decide the criteria for awarding the badge. 

 

Criteria 
 For course badges, the criteria are: Manual completion by role; course 

completion and activity completion. 

 When selecting Manual completion by role, you can choose the role 

you wish to award the badge, so for example a teacher could allow a 

non-editing teacher to award badges in the course. 

 For badges to be awarded for course or activity completion, Completion 

tracking must be enabled in the site and the course. 

 

 Once criteria have been set, you are returned to the Manage badges 

screen where you must "enable access" for the badge to be available: 

 

Awarding the badge 
Badges may be awarded manually from Administration > Course 

administration > Badges > Manage badges > Recipients and clicking the 

"Award badge" button. 

For information on the Overview, Edit details, Message and Recipients tab, 

see Managing badges. 

 

Tip: If your site has a large number of users, it's easier to search for email 

addresses than names. 

Important Note: Currently once a badge has been issued it cannot be 

revoked. So make sure that you are giving a badge to the correct users! 

 

4.9.5.3.2.Adding a site badge 
 An administrator can add a site badge from Administration > Site 

administration > Badges > Add a new badge. 

 While the settings are basically the same as for a teacher in a course, the 

criteria are slightly different because of the global nature of the badge. 

These are: manual issue by role; completing a set of courses or profile 

completion. 

 

Истечение срока действия Символа Отличия 
Установите дату здесь, если Символ Отличия перестанет быть действительным 

после определённой даты. Пометьте его значением Never (никогда), если хотите, чтобы 

Символ Отличия отображался постоянно. 

 Выполнив сохранение настроек, вы подключаетесь к экрану «Управление 

Символами Отличия», где вы можете задавать критерии для награждения 

Символом Отличия. 

Критерии 
 Для Символов Отличия Курса критериями являются: Завершение Вручную 

обладающим соответствующей Ролью; Завершение Курса и Завершение Действия. 

 При выборе Завершения Вручную, можно выбрать Роль, которой хотите доверить 

присуждение данного Символа Отличия; так, например, Преподаватель может 

позволить неРедактирующему Преподавателю присуждать Символы Отличия за Курс. 

 Для Символов Отличия, которые будут присвоены за завершение Курса или Действия, 

Отслеживание Завершения (п. 4.9.3.1.1)должно быть включено на уровне Сайта и 

Курса. 

 После того, как критерии были установлены, вас возвращают к экрану «Управление 

СимволамиОтличия» (п. 4.9.3), где вы должны установить «Enable access (позволить 

доступ)» для того, чтобы Символы Отличия были доступны: 

Присуждение Символа Отличия 
Символы Отличия могут быть присуждены вручную из Administration→Course 

administration→Badges→Manage badges→Recipients щелчком по кнопке «Award badge 

(присудить символ отличия)». 

Для получения информации о вкладках Overview, Edit details, Message and 

Recipients (обзор, отредактировать детали), сообщение и получатели) см. в раздел 

«Управление Символами Отличия». 

Совет: Если ваш Сайт имеет большое количество пользователей, проще искать 

адреса электронной почты, чем имена. 

Важное замечание: В настоящее время после выдачи Символа Отличия он не 

может быть отозван. Поэтому убедитесь, что вы присуждаете Символ Отличия 

действительно заслужившему это пользователю! 

4.9.5.3.2.Добавление Символа Отличия на уровень Сайта 
 Администратор может добавить Символ Отличия на уровень Сайта из 

Administration→Site administration→Badges→Add a new badges. 

 В то время как настройки в основном такие же, как для Преподавателя в Курсе, 

критерии немного отличаются из-за глобального характера Символа Отличия. К ним 

относятся: выдача вручную обладающим соответствующей Ролью; завершение ряда 

Курсов или завершение Профиля. 
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 In order to be able to award a site badge based on completing a set of 

courses, Completion tracking needs to be enabled in the site and 

courses. 

4.9.5.3.3.Earning badges 
 Once all criteria are set and badge creator is happy with badge details 

and settings, site users can start earning it. For users to be able to earn a 

badge, a badge creator/administrator needs to enable access to this 

badge on a badge overview page or "Manage badges" page (as shown 

on the picture). 

 

 

 Normally badges are awarded to users automatically based on their 

actions in the system. The completion criteria of an active badge are re-

calculated every time an event such as completion of a course or 

activity, or updating user profile happens. If a user has completed all 

necessary requirements they are issued a badge and sent an email 

notification. 

Only badges with enabled access are available to users and can be earned! 

 

 

 

 

 

 

 

 

 

4.9.5.3.4.See also 
 Custom Reports for Badges - Get some Here - forum post 

 

 School demo example: Managing site badges (Log in with username: 

manager, password: moodle) 

 School demo example: Managing course badges (Log in with 

username: teacher, password: moodle) 

 School demo example: Viewing your own badges (Log in with 

username: student, password: moodle) 

 Research Design Principles for Studying Learning with Digital Badges 

Re-mediating assessment blog post 

 

 Для того, чтобы иметь возможность присудить Символ Отличия уровня Сайта на 

основе завершения ряда Курсов, необходимо включить отслеживание Завершения на 

уровне Сайта и Курсов. 

4.9.5.3.3.Зарабатывание Символов Отличия 
 После того, как все критерии установлены, и создатель Символ Отличия доволен 

деталями и настройками Символа Отличия, пользователи Сайта могут начать 

зарабатывать его. Для пользователей, чтобы иметь возможность зарабатывать себе 

Символ Отличия, создателю/Администратору Символа Отличия необходимо 

предоставить доступ к этому Символу Отличия на странице обзора Символов Отличия 

или странице «Manage badges (управлять Символами Отличия)» (как показано на 

рисунке. 

 Обычно Символы Отличия присуждаются пользователям автоматически на основе их 

действий в системе. Критерии Завершения активного Символа Отличия 

пересчитываются каждый раз, когда происходит такое событие, как Завершения Курса 

или Действия, или обновление Профиля пользователя. Если пользователь завершил все 

необходимые требования, ему выдаётся Символ Отличия и отправляется уведомление 

по электронной почте. 

Только Символы Отличия с разрешённым доступом доступны для 

пользователей и могут быть заработаны! 

 

4.9.5.3.4.См. также 
 Отчёты пользователя по Символам Отличия – получите некоторые здесь – сообщение 

форума. 

 Демоонстрационный пример Школы: управление Символами Отличия уровня Сайта 

(войдите с именем пользователя: manager, паролем: moodle). 

 Демоонстрационный пример Школы: управление Символами Отличия уровня Курса 

(войдите с именем пользователя: teacher, паролем: moodle). 

 Демоонстрационный пример Школы: просмотр ваших собственных Символов Отличия 

(войдите с именем пользователя: student, паролем: moodle). 

 Научно-исследовательские принципы дизайна для изучения обучения с цифровыми 

Символами Отличия – сообщение блога «Оцениевание через посредников». 

https://moodle.org/mod/forum/discuss.php?d=235135
http://school.demo.moodle.net/badges/index.php?type=1
http://school.demo.moodle.net/badges/index.php?type=2&id=115
http://school.demo.moodle.net/badges/mybadges.php
http://remediatingassessment.blogspot.co.nz/2013/07/research-design-principles-for-studying.html
http://remediatingassessment.blogspot.co.nz/2013/07/research-design-principles-for-studying.html
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4.9.5.4.Badges FAQ 
4.9.5.4.1.How can teachers award site badges? 
 
By default, teachers can only award course badges. Only users with 

capabilities to manage badges in the system are able to do this, so if you 

wish teachers to award site badges you need to create a new, global role. 

 

1. Go to Administration > Site administration > Users > Permissions > 

Define roles and add a new role called for example "Site badge 

awarder" 

2. Add it to the "System" context 

3. Set the following capabilities to "allow": moodle/badges:awardbadge, 

moodle/badges:viewbadges, moodle/badges:configurecriteria 

4. Assign this role to the teachers you wish to award site badges. 

 

The teacher with the role "Site badge awarder" will see a link to Badges in 

the Administration block. 

4.9.5.4.2.Can more than one teacher in a course 
award the same badge? 
(copied from MDL-39189) It's not the user who issues the badge, but a 

role. Users with multiple roles will have an option to use both of them to 

issue badges. If the badge is awarded twice by different roles, both roles 

are displayed and criteria (ALL/ANY) is given. In some cases it will be 

required for a badge to be awarded by several different roles. When there 

are, let's say, three teachers in the course and they go to award a badge as a 

teacher, each of them will see the list of users who already got the badge 

from a teacher, so they won't need to award the badge again. 

 

4.9.5.4.3.What's the difference between a 
backpack and a collection? 
When you upload a badge to the Openbadges site you are adding it to your 

backpack, which is the general area you put your badges in. (Like a 

backpack!) You then organise them into collections (like separate little 

bags in your backpack) and you choose which to display on your Moodle 

profile. So a badge may be in your backpack and not in a collection, but it 

must be in your backpack before it can be in a collection. (Note the 'public' 

box must be ticked too.) Collections allow you to control which badges 

you share with people. 

4.9.5.4.Часто задаваемые вопросы по Символам Отличия 
4.9.5.4.1.Как Преподаватели могут присуждать 
Символы Отличия уровня Сайта? 

По умолчанию, Преподаватели могут присуждать Символы Отличия только 

уровня Курса. Только пользователи с Возможностями управления Символами Отличия на 

уровне системы в состоянии сделать это, так что, если вы хотите, чтобы Преподаватели 

присуждали Символы Отличия уровня Сайта, нужно создать новую глобальную Роль.  

1. Перейдите в Administration→Site administration→Users→Permissions→Define roles и 

добавить новую Роль под названием, например, «Присуждающий Символы Отличия 

уровня Сайта». 

2. Добавьте её в контекст «Система». 

3. Установите следующие Возможности в «Allow (разрешить)»: 

moodle/badges:awardbadge, moodle/badges:viewbadges, moodle/badges:configurecriteria. 

4. Назначьте эту Роль Преподавателям, которым вы хотите позволить присуждать 

Символы Отличия уровня Сайта. 

Преподаватель с Ролью «Присуждающий Символы Отличия уровня Сайта» увидит 

ссылку на Символы Отличия в Блоке Управления. 

4.9.5.4.2.Могут ли в Курсе несколько Преподавателей 
присуждать один и тот же Символ Отличия? 

(скопировано с MDL-39189) Не пользователь присуждает Символ Отличия, а Роль. 

Пользователи с несколькими Ролями будут иметь возможность использовать каждую из 

них для выдачи Символов Отличия. Если Символ Отличия присуждается дважды 

различными Ролями, обе эти Роли отображаются, и выдаётся критерий (ALL/ANY). В 

некоторых случаях это потребуется, чтобы Символ Отличия присуждался несколькими 

разными Ролями. Когда существуют, скажем, три Преподавателя в Курсе и они 

собираются присуждать Символ Отличия в качестве Преподавателя, каждый из них 

увидит список пользователей, которые уже получили Символ Отличия от Преподавателя, 

поэтому им не нужно присуждать Символ Отличия снова. 

4.9.5.4.3.В чём разница между Рюкзаком и Коллекцией? 
Когда вы загружаете Символ Отличия на Сайт Openbadges (открытые символы 

отличия) вы добавляете его в свой Рюкзак, который является общей площадью, на 

которую вы складываете свои Символы Отличия (как в рюкзак!). Затем вы организуете их 

в Коллекции (как в отдельные маленькие пакеты в вашем рюкзаке) и выбираете, какие из 

них отображать в вашем Профиле Moodle. Так, Символ Отличия может быть в вашем 

Рюкзаке и не в Коллекции, но он должен быть в вашем Рюкзаке, прежде чем он сможет 

попасть в Коллекцию. (Заметьте, окошко «Public (общественный)» также должно быть 

помечено.) Коллекции позволяют вам контролировать, какими Символами Отличия вы 

делитесь с людьми. 
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4.9.5.4.4.How can I change the badge image size? 
 
Badges are by default 90 x 90 pixels but you can change the default size if 

you wish by editing the code according to this forum post. 

 

4.9.5.4.5.Can I award a badge based on a specific 
grade? 
There are two ways of awarding a badge based on a specific grade. 

Method 1: 

Set a passing grade for the quiz or assignment in the gradebook, as 

explained in section 1.3 of Activity completion settings. 

Method 2: 

1. Create a page resource and set the restrict access conditions so that it 

only appears if the user obtains a certain grade in the quiz or assignment 

 

2. Set the activity completion for the page as "view" 

3. Set the badge criteria such that the page has to be completed (i.e. 

viewed) 

4.9.5.4.6.Do I have to use my Moodle email for my 
backpack? 
No, but see this forum post about Badges and Identity. 

4.9.5.4.7.Which roles can see which badges? 
See this forum post on viewing badges 

4.9.5.4.8.Can I change a badge images once 
awarded? 
The short answer is 'no', but see this forum post on changing badge images 

for more information. 

4.9.5.4.9.Can I revoke a badge once it has been 
awarded? 
No. See MDL-40551 

4.9.5.4.10.See also 
 Using Moodle Badges forum 

 Open Badges and Moodle blog post from Gavin Henrick 

 badg.us - a service for creating and issuing badges 

 P2PU Badge Maker - a step by step guide on how to make a badge 

 OpenBadges.me - An open-access image creator from 

MyKnowledgeMap to support all of your Open Badge building needs. 

4.9.5.4.4.Как можно изменить размер изображения 
Символа Отличия? 

По умолчанию изображения Символов Отличия имеют размер 90 х 90 пикселей, но 

вы можете изменить этот размер по умолчанию, если хотите, отредактировав код в 

соответствии с этим сообщением форума. 

4.9.5.4.5.Можно присуждать Символ Отличия на основе 
конкретной Оценки? 

Есть два способа присуждения Символа Отличия на основе конкретной Оценки. 

Способ 1: 

Установите Проходной Балл для Экзамена или Задания в Журнале Оценок, как 

описано в разделе 1.3 «Настроек Завершения Действия (п. 4.9.3)».  

Способ 2: 

1. Создайте Ресурс «Страница» и задайте условия ограничения доступа, чтобы он 

появился только тогда, когда пользователь получает определённую Оценку за Экзамен 

или Задание. 

2. Установите Завершение Действия для «Страница», как «View (видимое)». 

3. Установите критерии Символа Отличия такие, что «Страница» должна быть завершена 

(т.е. видима). 

4.9.5.4.6.Следует использовать мою э-почту Moodle для 
моего Рюкзака? 

Нет, но посмотрите это сообщение форума «О Символах Отличия и подлинности». 

4.9.5.4.7.Какие Роли какие Символы Отличия могут видеть? 
См. это «Сообщения форума по просмотру Символов Отличия». 

4.9.5.4.8.Можно изменить изображения Символов Отличия 
после их присуждения? 

Краткий ответ – «нет», но для получения дополнительных подробностей смотрите 

это сообщение форума «Изменение изображений Символов Отличия». 

4.9.5.4.9.Можно отозвать Символ Отличия после его 
присуждения? 

Нет. См. MDL-40551. 

4.9.5.4.10.См.также 
 Использование Moodle: «Форум по Символам Отличия». 

 Собщение блога Гэвина Хенрика «Открытые Значки и Moodle». 

 badg.us – сервис для создания и выдачи Символов Отличия. 

 P2PU Знак Maker – пошаговое руководство о том, как создать Символ Отличия. 

 OpenBadges.me – создатель изображений открытого доступа от MyKnowledgeMap для 

поддержки всех ваших потребностей по созданию Открытых Символов Отличия. 

https://moodle.org/mod/forum/discuss.php?d=230591#p1001383
https://moodle.org/mod/forum/discuss.php?d=232875#p1011613
https://moodle.org/mod/forum/discuss.php?d=234155&parent=1017187#p1017363
https://moodle.org/mod/forum/discuss.php?d=228553
http://tracker.moodle.org/browse/MDL-40551
https://moodle.org/mod/forum/view.php?id=8085
http://www.somerandomthoughts.com/blog/2013/05/06/open-badges-and-moodle/
http://badg.us/en-US/
https://p2pu.org/en/groups/how-do-i-make-a-badge/
https://www.openbadges.me/


 

507 

 Badges For Your Moodle - CC-licensed badges available for free 

download 

 

4.9.6.Course reports 
4.9.6.1.Logs 
Logs in Moodle are activity reports. Logs are available at site and course 

level. 

4.9.6.1.1.Logs of course activity 
A log of activity in the course may be generated by a teacher in 

Administration> Course administration>Reports > Logs. 

 
To generate a log, select any combination of group, student, date, activity 

and actions, then click the "Get these logs" button. 

 

 

You can see what pages the student accessed, the time and date they 

accessed it, the IP address they came from, and their actions (view, add, 

update, delete). 

You can choose to display the logs on a page or download them in text, 

ODS or Excel format. 

Note: The log report page contains active links enabling you to access a 

student's profile page or a particular page that the student was viewing. The 

IP address link provides an estimate of the student's location. 

 

4.9.6.1.2.Logs of site activity 
A log of site activity may be generated by a site administrator in Settings > 

Site administration > Reports > Logs.The log can display all activities, site 

news or site errors, such as failed login attempts. Note: In Moodle 2.4.2 

onwards, the log also includes actions done at the category level, such as 

adding or deleting courses. 

 

 Символ Отличия для вашей Moodle – Символы Отличия, лицензированные 

сертификатом соответствия техническим условиям (CC – certificate of conformance), 

доступные для свободного скачивания. 

4.9.6.Отчёты по Курсу 
4.9.6.1.Журналы Регистрации 

Журналы Регистрации в Moodle являются Отчётами о Действиях. 

Журналы Регистрации ведутся на уровне Сайта и Курса. 

4.9.6.1.1.Журналы Регистрации мероприятий Курса 
Журнал Регистрации мероприятий в Курсе может быть сгенерирован 

Преподавателем в Administration→Course administration→Reports→Logs. 

 
Чтобы создать Журнал Регистрации, выберите любую комбинацию из (в версии 

Moodle 2.5: укажите «All (все)» или выберите конкретный): Курс, участник, дата, Действие, 

мероприятие и что отобразить, а затем нажмите кнопку «Get these logs (получить эти 

журналы регистрации)». 

Вы сможете увидеть, к каким страницам обращался Студент, дату и время 

обращения, IP-адрес, с которого он обратился, и его действия (просмотр, добавление, 

обновление, удаление).  

Вы можете выбрать, отобразить ли Журналы Регистрации на странице или 

загрузить их в формат текста, ODS или Excel.  

Замечание: На странице Отчёта в форме Журнала Регистрации содержатся 

активные ссылки, позволяющие получить доступ к странице Профиля Студента или 

определённой странице, которую просматривал Студент. Ссылка на IP адрес обеспечивает 

оценивание местоположения Студента. 

4.9.6.1.2.Журналы Регистрации мероприятий на Сайте 
Журнал Регистрации мероприятий на Сайте может быть сгенерирован 

Администратором Сайта в Administration→Site administration→Reports→Logs. Этот 

Журнал Регистрации может отображать все виды мероприятий, новости Сайта или 

ошибки Сайта, такие как неудачные попытки входа.Замечание: В Moodle 2.4.2 и далее, 

этот Журнал Регистрации также включает в себя мероприятия проведённые на уровне 

Категорий, такие как добавление или удаление Курсов. 

http://moodlebadges.com/
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4.9.6.1.3.Live logs from the past hour 
Live logs from the past hour (either for a course or for the site) are 

available via a link on the logs page. 

4.9.6.1.4.View logs capabilities 
View course logs 
Capabilities/report/log:view 
 This allows a user to view Logs of course activities in Navigation > 

Courses > My course > Reports > Logs 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View today's logs 
Capabilities/report/log:viewtoday 
 This allows a user to view Logs for today in Navigation > Courses > 

My course > Reports > Logs 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

View live logs 
Capabilities/report/loglive:view 
 This allows a user to view live Logs from the past hour in Navigation > 

Courses > My course > Reports > Live logs (or Settings > Site 

administration > Reports > Logs for administrators and any users with 

this capability applied as a system role) 

 

 This capability is allowed for the default roles of manager, teacher and 

non-editing teacher 

4.9.6.2.Activity report 
Course activity reports 
A course activity report, showing the number of views for each activity 

and resource (and any related blog entries), can be viewed by managers, 

teachers and non-editing teachers (and any other users with the capability 

report/outline:view) in Administration > Course administration > Reports 

> Activity report. 

An activity report for the front page is available for administrators and 

managers in Administration > Front page settings>Reports > Activity 

report. 

 

4.9.6.1.3.Динамика Журналов Регистрации за последний час 
Динамика Журналов Регистрации за последний час (или для Курса, или для Сайта) 

доступна посредством ссылки на страницу Logs (Журналы Регистрации). 

4.9.6.1.4.Возможности просмотра Журналов Регистрации 
Просмотреть Журналы Регистрации Курса 

Возможность Capabilities/report/log:view 
 Позволяет пользователю просматривать Журналы Регистрации Действий, 

используемых в Курсе, перейдя сначала в Блоке Навигации в нужный Курс, а затем в 

Administration→Course administration→Reports→Logs. 

 Эта Возможность по умолчанию позволена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Просмотреть Журналы Регистрации за сегодня 

Возможность Capabilities/report/log:viewtoday 
 Позволяет пользователю просматривать Журналы Регистрации за сегодня, перейдя 

сначала в Блоке Навигации в нужный Курс, а затем в 

Administration→Course administration→Reports→Logs. 

 Эта Возможность по умолчанию позволена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

Просмотреть динамику Журналов Регистрации 

Возможность Capabilities/report/loglive:view 
 Позволяет пользователю просматривать динамику Журналов Регистрации за последний 

час, перейдя сначала в Блоке Навигации в нужный Курс, а затем в 

Administration→Course administration→Reports→Live logs  

    (или Administration→Site administration→Reports→Logs для Администраторов и 

пользователей с этой Возможностью, применённой в качестве системной Роли). 

 Эта Возможность по умолчанию позволена Ролям Менеджера, Преподавателя и 

неРедактирующего Преподавателя. 

4.9.6.2.Отчёт по Действию 
Отчёты по Действиям Курса 

Отчёт по Действию Курса, показывающий количество просмотров для каждого 

Интерактивного Действия и Ресурса (и любые относящиеся Записи Блога), может быть 

просмотрен Менеджерами, Преподавателями и неРедактирующими Преподавателями. (и 

любыми другими пользователями с Возможностью report/outline:view) в 

Administration→Course administration→Reports→Activity report. 

Отчёт по Действию для Главной Страницы доступен для Администраторов и 

Менеджеров в Administration→Front page settings→Reports→Activity report. 
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The length of time that the activity report covers is determined by the 

loglifetime setting in Administration > Site administration > Courses > 

Backups > General backup defaults. 

An activity report is computed from the course's start date (in the course 

settings). 

Individual activity reports 
If activity reports are enabled for a course in the course settings, each 

course participant can access reports of their contributions, such as forum 

posts or assignment submissions, logs and a statistics report. 

 

4.9.6.3.Participation report 
A participation report for a particular activity can be generated by a 

manager, teacher or non-editing teacher (or any other user with the 

capability report/participation:view) in Administration > Course 

administration > Reports > Course participation. 

The definition of View and Post for the selected activity type will be given 

on screen. 

For example: 

Forum View: View Discussion, Search, Forum, Forums, Subscribers 

Forum Post: Add Discussion, Add Post, Delete Discussion, Delete Post, 

Move Discussion, Prune Post, Update Post. 

 

An extremely useful feature of the participation report is the option to send 

a message to all students who have not completed a certain action. Other 

options with selected users are to add a note or extend enrolment. 

 

NOTE: If a forum post is moved, the participation report will show 

incorrect results for the affected forums. For example, take a student who 

posted in forum A and had their post moved to forum B. In the course 

participation report the student will still be listed has having made a post in 

forum A, but will not be listed as having made a post yet in forum B. 

4.9.6.3.1.See also 
 Tracker issue MDL-21415 – Course Participation Report doesn't abide 

by separate groups 

4.9.6.4.Statistics 
If statistics are enabled for the site, graphs and tables of user activity may 

be generated. 

The statistics graphs and tables show how many hits there have been on 

various parts of your site during various time frames. They do not show  

Продолжительность времени Отчёта по Действию определяется настройкой 

Loglifetime в 

Administration→Site administration→Courses→Backups→General backup defaults. 

Отчёт по Действию исчисляется с даты начала Курса (в настройках Курса). 

 

Отчёты по конкретным Действиям 
Если Отчёты по Действиям позволены для Курса в настройках этого Курса, тогда 

каждый участник Курса может получать доступ к Отчётам по их материалам, таким как 

сообщения Форума или переданным на рассмотрение готовым ответам по Заданию, 

Журналам Регистрации и Статистическим Отчётам. 

4.9.6.3.Отчёт о совместной работе 
Отчёт о совместной работе для конкретного коллективного Действия может быть 

сгенерирован Менеджером, Преподавателем или неРедактирующим Преподавателем  

(или любым другим пользователем  с  Возможностью  report/participation:view) в 

Administration→Course administration→Reports→Course participation. 

Определение View (вид) и Post (сообщение) для выбранного типа Действия будет 

выдано на экране. 

Например:  

Вид Форума: Просмотреть обсуждение, Поиск, Форум, Форумы, Абоненты. 

Сообщения Форума: Добавить обсуждение, Добавить сообщение, Удалить обсуждение, 

удалить сообщение, Переместить обсуждение, Переместить сообщение, Обновить 

сообщение. 

Чрезвычайно полезной функцией Отчёта по совместной работе является 

возможность отправить сообщение всем Студентам, которые не завершили определённое 

Действие. Другими возможностями с отдельными пользователями являются: добавить 

Примечание или продлить Зачисление.  

ЗАМЕЧАНИЕ: Если корреспонденции Форума перемещаются, Отчёт о совместной 

работе покажет неверные результаты для пострадавших Форумов. Например, возьмём 

Студента, который, отправил корреспонденцию на Форум А и переместил её затем на 

Форум B. В Отчёте о совместной работе в Курсе этот Студент всё ещё будет числиться 

отправившим сообщение на Форум А, но не будет указан переславшим её и на Форум В. 

4.9.6.3.1.См. также 
 Выпуск Средства Отслеживания MDL-21415 – «Отчёт о совместной работе в Курсе» не 

поддерживает отдельные Группы. 

4.9.6.4.Статистические данные 
Если статистические данные позволены для Сайта, тогда графики и таблицы о 

пользовательской деятельности могут быть сгенерированы. 

Статистические графики и таблицы показывают, сколько удачных попыток было 

произведено на различных частях вашего Сайта в различные сроки. Они не показывают 

http://tracker.moodle.org/browse/MDL-21415
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how many distinct users there have been. They are processed daily at a 

time you specify. You must enable statistics before you will see anything. 

4.9.6.4.1.Enabling statistics 
Statistics must be enabled by a site administrator in Administration > Site 

administration > Advanced features. 

In Moodle 2.4.2 onwards, once statistics have been enabled, the screen to 

configure them becomes visible as a link in Settings > Site administration 

> Server > Statistics. (In older versions the link was always available 

irrespective of whether statistics was enabled.) 

The Course overview report will also then be accessible from 

Administration> Site administration > Reports. 

4.9.6.4.2.Site administration settings 
Various settings for statistics may be set by an administrator in Settings > 

Site administration > Server > Statistics. 

As stats processing is quite resource intensive, it is recommended that you 

should set the stats processing to start in the early morning. 

TIP: Set the stats processing to start an hour before your automated course 

backups are scheduled to start, then set the maximum runtime to 1 hour. 

This ensures that stats are not being processed at the same time as course 

backups are being made. 

4.9.6.4.3.Statistics not working? 
If statistics isn't working and you have checked all the obvious (such as 

whether it's enabled), check Settings > Site administration > Plugins > 

Activity modules for any old hidden modules in the database which miss 

the files in the moodle/mod folder on your server. If you find any, they 

should be deleted. 

You can also try limiting the length of time logs are kept for to reduce the 

size of the tables. Go to Settings > Site administration > Server > Cleanup 

to set this. 

To run stats manually, go to the database, go to the mdl_config table and 

set statslastdaily, statslastweekly and statslastmonthly to 0 (leave 

statslastmonthly alone if you think it might be large logtables causing the 

problem). Then go to Settings > Site administration > Server > Statistics 

and set statsruntimestarthour to 5 mins ago. Then visit 

http://www.yoursite.com/admin/cron.php. You should see output there 

saying that stats are processing, but be patient if it appears to hang - this 

can take between 5 mins and several hours depending on how big your site 

is, so just leave it going. 

 

сколько было различных пользователей. Они обрабатываются ежедневно в указанное вами 

время. Вы должны включить Statistics, прежде чем что-нибудь увидите. 

4.9.6.4.1.Включение статистических данных 
Статистические данные должны быть включены Администратором Сайта в 

Administration→Site administration→Advanced features. 

В Moodle 2.4.2 и далее, как только статистические данные включены, экран для 

настройки их становится видимым посредством ссылки в 

Administration→Site administration→Server→Statistics. (В старых версиях эта ссылка была 

доступна всегда независимо от того, была ли включена Statistics.)  

Обзорный Отчёт по Курсу также будет доступен из 

Administration→Site administration→Reports. 

4.9.6.4.2.Настройки управления Сайта 
Различные настройки для статистических данных могут быть установлены 

Администратором в Administration→Site administration→Server→Statistics. 

Поскольку обработка статистических данных весьма ресурсоёмка, рекомендуется, 

установить начало обработки статистических данных рано утром. 

СОВЕТ: Установите начало обработки статистических данных на час ранее 

запланированных автоматизированных резервных копирований Курса, а затем установите 

максимальное время выполнения до 1 часа. Это гарантирует, что статистические данные 

не будут обрабатываться в то же время, когда делаются резервные копии Курса. 

4.9.6.4.3.Статистика не работает? 
Если статистика не работает, и вы проверили всё очевидное (например, включена 

ли она), проверьте Administration→Site administration→Plugins→Activity modules для 

любых старых скрытых модулей в базе данных, которая пропускает файлы в папку 

moodle/mod на вашем сервере. Если вы обнаружите что-либо, это должно быть удалено. 

Вы также можете попробовать ограничить промежутки времени на сохранение 

Журналов Регистрации, чтобы уменьшить размер таблиц. Перейдите в раздел 

Administration→Site administration→Server→Cleanup, чтобы установить это. 

Для запуска обработки статистических данных вручную перейдите к базе данных, 

перейдите в таблицу mdl_config и установите в 0 statslastdaily, statslastweekly и (оставьте 

statslastmonthly без изменений, если вы думаете, что это крупные logtables могли быть 

причиной проблемы). Затем перейдите в 

Administration→Site administration→Server→Statistics и установите statsruntimestarthour на 

5 минут назад. Затем посетите http://www.yoursite.com/admin/cron.php. Вы должны там 

увидеть, что статистика обрабатывается, но не спешите, если покажется, что всё зависло, – 

процесс может занимать от 5 минут до нескольких часов, в зависимости от размера вашего 

Сайта, так что просто оставьте всё в состоянии исполнения вычислений. 
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4.9.6.4.4.Viewing statistics 
A manager, teacher or non-editing teacher (or any other user with the 

capability report/stats:view) can view statistics for their course in 

Administration > Course administration > Reports > Statistics. 

An administrator can view statistics for the site in Administration > Site 

administration > Reports > Statistics. 

4.9.6.5.See also 
 Site-wide reports in Managing a Moodle site 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.9.6.4.4.Просмотр статистических данных 
Менеджер, Преподаватель или неРедактирующий Преподаватель (или любой 

другой пользователь с Возможностью report/stats:view) может просмотреть статистику по 

их Курсу в Administration→Course administration→Reports→Statistics. 

Администратор может просматривать статистику по Сайту в 

Administration→Site administration→Reports→Statistics. 

4.9.6.5.См. также 
 Отчёты для всего Сайта в управлении Сайтом Moodle. 

http://docs.moodle.org/25/en/Site-wide_reports


 

512 

4.10.Reusing activities 
There are several ways to reuse a course or parts of a course. Most of them 

involve or are similar to a backup and restore process. 

 

4.10.1.Activity backup 
4.10.1.1.Backing up individual activities 
 It is possible to make a copy or backup of individual activities in a 

Moodle course and then re-use these activities in a different Moodle site 

or in a different course on the same Moodle. (Note that if you wish to 

re-use activities within the same Moodle it might be simpler to use the 

import function. See Import course data for information on how to do 

this. 

 To make a backup of an activity, ensure you are logged in with editing 

rights, as a teacher for example, and click on the activity you wish to 

backup. The settings block to the side will have a link Backup as with 

the assignment in the following screenshot: 

 In the next screen, check/tick the type of item you wish to backup - in 

this case, just activities 

 Click Next and on the next screen, check the activity you wish to 

backup - in this case, our assignment. 

 Click Next and on the next screen, if you wish, rename the filename 

(keeping its .mbz extension), check you have included the correct 

activity and click Perform backup. 

 You will get a message saying the backup file was successfully created. 

Click Continue and you will find your backup in the User Private 

backup area of the next screen. 

 You can download your file from here and then restore it to a course in 

another Moodle site. See Activity restore for infomation on how to do 

this. 

NOTE: For security reasons, those with the teacher role are not able to 

backup user information belonging to activities so there will be a red cross 

and padlock next to any user information. 

 

4.10.1.2.Backing up whole courses 
It is also possible to make a copy or backup of a whole course and re-use it 

elsewhere. See Course backup for information on how to do this. The 

process is the same as backing up a single activity as we have done here. 

 

4.10.Повторное использование Действий 
Есть несколько способов повторного использования Курса или частей Курса. 

Большинство из них включают (или похожи на) резервное копирование и процесс 

восстановления. 

4.10.1.Резервная копия Действия 
4.10.1.1.Резервное копирование отдельных Действий 
 Можно сделать резервную копию отдельных Действий в Курсе Moodle, а затем 

использовать эти Действия на другом Сайте Moodle или в другом Курсе той же самой 

Moodle. (Заметьте, что если вы хотите повторно использовать Действия в пределах той 

же Moodle, проще использовать функцию импорта. См. «Импорт данных Курсов» для 

получения информации о том, как это сделать.) 

 

 Чтобы сделать резервную копию Действия, убедитесь, что вы вошли в систему с 

правами редактирования, например, как Преподаватель, и щёлкните кнопку Действия, 

резервную копию которого вы хотите сделать. Настройки сбоку будут иметь ссылку 

«резервное копирование» с назначением как на следующем снимке с экрана: 

 На следующем экране, проверьте/отметьте тип Элемента, резервную копию которого 

вы хотите сделать – в этом случае, только Действия. 

 Нажмите кнопку Далее, и на следующем экране проверьте Действие, резервную копию 

которого вы хотите сделать, – в данном случае, наше Задание. 

 Нажмите кнопку «Next (далее)» и на следующем экране, если хотите, переименуйте 

файл (сохраняя его расширение .mbz). Проверьте, правильное ли Действие вы 

включили, и щёлкните по кнопке Perform backup (выполнить резервное копирование). 

 Вы получите сообщение о том, что файл резервного копирования был успешно создан. 

Нажмите кнопку Continue (продолжить), и вы найдете вашу резервную копию в разделе 

резервных копий Индивидуального пользователя на следующем экране. 

 Вы можете скачать файл отсюда и затем вставить его в другой Курс на другом Сайте 

Moodle. См. Восстановление Действия для получения информации о том, как это 

сделать.  

ЗАМЕЧАНИЕ: По соображениям безопасности, те с Ролью Преподаватели, кто не в 

состоянии выполнить резервное копирование информации о Действиях пользователя, 

будут помечены значками красного креста и замка рядом с любой пользовательской 

информацией. 

4.10.1.2.Резервное Копирование целых Курсов 
Кроме того, можно сделать копию или резервную копию всего Курса и повторно 

использовать его в другом месте. Смотрите «Резервная Копия Курса» (п. 3.7.2) для 

получения информации о том, как это сделать. Процесс такой же, как 

Резервное Копирование отдельного Интерактивного Действия, как мы сделали здесь. 

http://docs.moodle.org/25/en/Activity_restore
http://docs.moodle.org/25/en/Import_course_data
http://docs.moodle.org/25/en/File:Activitybackup1.png
http://docs.moodle.org/25/en/File:Includeactivities.png
http://docs.moodle.org/25/en/File:Userprivatebackuparea.png
http://docs.moodle.org/25/en/Activity_restore
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4.10.1.3.Backup and restore of assignments 
from Moodle 2.2 and older 
The assignment activity module was completely rewritten in Moodle 2.3. 

Thus, assignments from Moodle 2.2 and older (e.g. from Moodle 1.9) need 

to be upgraded in order to continue being usable. See the section 'Restoring 

course backups from Moodle 2.2 and older' in Assignment upgrade tool for 

details of what to do. 

4.10.1.4.Activity backup capabilities 
There is just one capability, Backup activities, which is allowed for the 

default roles of manager and teacher. 

4.10.2.Activity restore 
4.10.2.1.Restoring individual activities 
 It is possible to bring in or "restore" into a new Moodle activities that 

have been copied or backed up in a different Moodle. (Note that if you 

wish to re-use activities within the same Moodle it might be simpler to 

use the import function. See Import course data for information on how 

to do this.) 

 To restore an activity you have backed up from another Moodle, ensure 

you have your backup file available (eg, on your computer or a USB 

pen) and ensure you are logged in with editing rights, as a teacher for 

example, and click the Restore link in the Course administration block. 

 

 On the next screen, either drag and drop your backed up activity into 

the box with the arrow (1 below) or else click Choose a file to add it via 

the File picker (2 below); upload your backed up activity and click 

Restore. 

 On the next screen, click Continue and then select the course into which 

you wish to restore your activity. Click Continue and then click Next. 

You will see your chosen activity. 

 

 

 Click Next and on the next screen, click Perform restore. Your activity 

will be added to your chosen course. 

4.10.2.2.Restoring a whole course 
 It is possible to restore a whole course rather than just individual 

activities. See Course restore for information on how to do this. 

 

 

4.10.1.3.Резервное Копирование и Восстановление 
Заданий из Moodle версии 2.2 и старше 

Модуль Интерактивного Действия «Задание» был полностью переделан в версии 

Moodle 2.3. Таким образом, Задания из Moodle 2.2 и старше (например, от Moodle 1.9) 

должны быть обновлены, чтобы оставаться годными к употреблению. См. раздел 

«Восстановление резервных копий Курсов из Moodle 2.2 и старше» в разделе «Средство 

обновления Задания» (п. 4.3.1.4) для получения информации о том, что делать. 

4.10.1.4.Возможности РезервногоКопирования Действия 
Существует только одна Возможность, Backup activities (см. п. 4.3.1.4), которая по 

умолчанию предоставлена Ролям Менеджера и Преподавателя. 

4.10.2.Восстановление Действия 
4.10.2.1.Восстановление отдельных Действий 
 В качестве новых Действий в Moodle можно использовать те, которые были 

скопированы, или «восстановлены» из резервных копий в другой Moodle. (Заметьте, 

что если вы хотите повторно использовать Действия в рамках одной и той же Moodle, 

то может быть проще использовать функцию импорта. См. «Импорт данных Курса» 

(п. 4.10.3) для получения информации о том, как это сделать.) 

 Чтобы восстановить Действие, для которого вы создали резервную копию в другой 

Moodle, убедитесь, что вы имеете доступ к файлу с резервной копией (например, на 

вашем компьютере или памяти USB), и убедитесь, что вы вошли в систему с правами 

редактирования (например, как Преподаватель), и щёлкните ссылку Restore 

(восстановить) в Блоке управления Курсом. 

 На следующем экране, либо отбуксируйте вашу резервную копию Действия в окошко 

со стрелкой (1 ниже), либо щёлкните ещё Choose a file (выбрать файл), чтобы добавить 

его через файловое меню (2 ниже); загрузите резервную копию Действия и щёлкните 

кнопку Restore (восстановить). 

 На следующем экране щёлкните Continue (продолжить), а 

затем выберите Курс, в который вы хотите восстановить 

ваше Действие. Нажмите кнопку Continue, а затем 

нажмите кнопку Next (далее). Вы увидите выбранное 

вами Действие. 

 Нажмите кнопку Next и на следующем экране выберите Perform restore (выполнить 

восстановение). Ваше Действие будет добавлено в выбранный вами Курс. 

4.10.2.2.Восстановление Курса целиком 
 Можно восстановить весь Курс, а не только отдельные Действия. Смотреть 

«Восстановление Курса» (п. 3.7.3) для получения дополнительной информации о том, 

как это сделать. 
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4.10.2.3.See also 
 Restoring file aliases 

4.10.3.Import course data 
Allows a teacher to go to another course they teach and import elements 

into the current course. Similar to a Backup and Restore, except it is one 

process. 

Course activities and resources may be imported from any other course 

that the teacher has editing permissions in. This will allow teachers to re-

use instead of re-creating one or more activities or resources. 

 

Import course data is similar to a backup and restore process and does not 

include any user data. 

4.10.3.1.How to import activities or resources 
 
 In Course Administration>Settings, click on the Import link: 

 Select the course you wish to import from and click Continue. 

 You will be presented with the "backup settings" page. Use the check 

boxes for import activities, blocks and or filters as types of items which 

will show on the next screen. 

 Select the elements you want to include in the import in the Schema 

settings step 

 Review and click Perform import or click the cancel or previous 

buttons. The confirmation page will place green check marks and red 

marks next to the backup settings and include item list for you to 

review. 

 You should see the "Import complete. Click continue to return to the 

course." message, or an error message indicating that the import process 

did not take place. 

4.10.3.2.Examples and tips 
 Importing a quiz from course A to course B, will also add the questions 

to the question bank so you can use them in new quizzes. 

 Tip: Groups can also be imported as a batch from a file. 

 Tip: It may be necessary to check all Activities (Forums, Assignments, 

etc.) to assure they are now using HTML format. Due to the change in 

the HTML editor from 1.9 to 2.2, editing of Activities comes up as 

"Moodle Auto-format" which displays the HTML version of the 

Description. Once the "Moodle Auto-format" has been changed to 

"HTML format" the new HTML editor is available by default 

4.10.2.3.См. также 
 Восстановление псевдонимов файлов 

4.10.3.Импорт данных Курса 
Позволяет Преподавателю войти в другой Курс, которому учат Студентов, и 

импортировать элементы из него в свой Курс. Это подобно резервному копированию и 

восстановлению, за исключением одного процесса. 

Интерактивные Действия Курса и Ресурсы могут быть импортированы из любого 

другого Курса, в котором Преподаватель имеет Полномочия редактирования. Это 

позволит Преподавателям использовать готовые Интерактивные Действия и Ресурсы 

вместо создания заново одного или нескольких из них. 

Импорт данных Курса похож на процесс резервного копирования и 

восстановления, и не включает какие-либо пользовательские данные. 

4.10.3.1.Как импортировать Интерактивные Действия и 
Ресурсы 
 В Administration→Course administration→Settings щёлкните ссылку Import. 

 Выберите Курс, который вы хотите импортировать, и щёлкните кнопку Continue. 

 Вам будет представлена странице «Backup settings (Настройки резервного 

копирования)». Используйте окошки-флажки для импорта Действий, Блоков и/или 

Фильтров, которые будут показаны как типы Элементов на следующем экране. 

 Выберите Элементы, которые вы хотите включить в импорт на шаге настройки Схемы. 

 

 Просмотрите и щёлкните кнопки Perform import (выполнить импорт) или щёлкните 

Cancel (отменить) или Previous (вернуться к предыдущему шагу). Страница 

подтверждения разместит зелёные галочки и красные пометки около настроек 

резервного копирования и включит список Элементов для вашего обзора. 

 Вы должны увидеть сообщение «Import complete. Click continue to return to the course. 

(импорт завершён, нажмите «продолжить», чтобы вернуться к курсу)» или сообщение 

об ошибке, указывающее, что процесс импорта не произошёл. 

4.10.3.2.Примеры и советы 
 Импорт Экзамена из Курса А в Курс B поместит и его Вопросы в Банк Вопросов Курса 

B, так что вы сможете использовать их в новых Экзаменах. 

 Совет: Группы также могут быть импортированы в виде пакета файлов. 

 Совет: Возможно потребуется проверить все Действия (Форумы, Задания, и т.д.), 

чтобы убедиться, что они в настоящее время используют формат HTML. В связи с 

изменением в редакторе HTML при переходе от версии 1,9 к 2,2, редактирование 

Действий появляется как «Moodle Auto-format», который отображает HTML-версию 

описания. После изменения «Moodle Auto-format» на «HTML format» новый редактор 

HTML становится доступным по умолчанию 

http://docs.moodle.org/25/en/Restoring_file_aliases
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when editing. 

4.10.3.3.Import course capabilities 
 Backup for import - allows a user to backup a course ready for 

importing into another course 

 Restore from files targeted as import - allows a user to import activities 

or resources from another course 

4.10.3.4.See also 
 Course backup & Course restore - for a similar process 

 

4.10.4.Reset course 
Basically cleans all the activity from the current course. 

4.10.4.1.Overview 
This allows you to empty a course of user data, while retaining the 

activities and other settings. Please be warned when choosing items you 

will delete your chosen user data from this course forever! 

 

You can select which user data to remove at a granular level under the 

categories of General, Roles, Gradebook, Groups and Activity data. 

Note: Only users with the reset course capability (by default managers and 

teachers) can reset a course. 

 

4.10.4.2.How to Reset - step by step 
 
1. Log in and go to the course area you want to reset 

 

2. Resetting a given activity is irreversible, so ensure that you have taken a 

Backup of your area including the user data - this is a snapshot and can 

be reinstated if necessary 

 

3. In your area's Administration block, click on Reset 

4. Click any Show Advanced button to show all options for that category 

 

5. Make your selections based on the options (see below for more on 

these) 

6. Click the Reset button 

7. Return to your area and check that things are as you want them. 

 

 

при редактировании. 

4.10.3.3.Возможности импорта Курса 
 Резервное копирование для импорта – позволяет пользователю подготовить резервную 

копию Курса для импорта в другой Курс. 

 Восстановление из файлов, предназначенных для импорта – позволяет пользователю 

импортировать Интерактивные Действия или Ресурсы из другого Курса. 

4.10.3.4.См. также 
 «Резервная Копия Курса» (п. 3.7.2) и «Восстановление Курса» (п. 3.7.3) для подобного 

процесса. 

4.10.4.Возврат Курса в исходное состояние 
В основном очищает все Действия текущего Курса. 

4.10.4.1.Обзор 
Возврат Курса в Исходное Состояние позволяет освободить Курс от 

пользовательских данных, сохраняя при этом Действия и прочие настройки. Пожалуйста, 

имейте в виду, что выбрав Элементы, вы навсегда удалите выбранные вами 

пользовательские данные из этого Курса! 

Вы можете выбрать, какие пользовательские данные удалять на детальном уровне 

в Категориях данных, – Общие, Роли, Журнал Оценок, Группы и Действия. 

Замечание: только пользователи с Возможностью Возврат Курса  в  

Исходное Состояние (по умолчанию  Менеджеры и Преподаватели) могут Возвратить 

Курс в исходное состояние. 

4.10.4.2.Как возвратить в исходное состояние – шаг за 
шагом 
1. Войти в систему и перейти в область Курса, которую нужно возвратить в исходное 

состояние. 

2. Возвращение данного Действия в исходное состояние является необратимым, поэтому 

убедитесь, что вы сделали резервную копию вашей области, в том числе 

пользовательских данных, – это выборочный динамический дамп, и он может быть 

повторно инсталлирован в случае необходимости. 

3. В Блоке Управления вашей областью щёлкните Reset. 

4. Щёлкните любую кнопку Show Advanced (показать дополнительное), чтобы показать 

все опции для этой Категории. 

5. Выберите нужные опции (см. подробности о них ниже). 

 

6. Щёлкните кнопку Reset. 

7. Вернитесь в вашу область, и убедитесь, что нужные вам вещи там. 

http://docs.moodle.org/25/en/Capabilities/moodle/backup:backuptargetimport
http://docs.moodle.org/25/en/Capabilities/moodle/restore:restoretargetimport
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4.10.4.3.General Reset Options 
You can set a new Course Start Date for the freshly reset course, delete all 

Calendar events, comments, course AND activity completion data, course 

log report data and user notes attached to the course. 

 

(Before you reset) You will need to make sure that you back up the 

information that you have within your course before you reset. When you 

back up the course make sure that you back it up with the user information. 

That way you will have a back up data on the ones that have taken your 

course before you reset it for another group or department. 

 

4.10.4.4.Role Reset Options 
These Role Reset options allow you to unenrol all users with a particular 

role within a course (e.g students) as well as remove all role overrides and 

role assignment specific to the course. This does not affect user role 

assignments outside the context of the course. 

4.10.4.5.Gradebook Reset Options 
 
The Gradebook reset options allow you to delete all gradebook items and 

categories and/or delete all recorded grades within the course. Note that 

these grades are still recorded against a user's account. 

4.10.4.6.Group Reset Options 
The Group reset options provides you with the ability to delete all groups 

created in the course and/or remove all users from any groups within the 

course. 

You can also delete all groupings created in the course and/or remove all 

users from any groupings within the course. 

4.10.4.7.Activity Reset Options 
 
Depending on the activities used within a course, you will be provided 

with the option to remove the user data associated with these learning 

objects. This includes responses to Choices, Quiz attempts, Feedback 

Responses, Forum posts (from selected Forum types), Glossary entries etc. 

 

You can remove all attempts from all quizzes. 

You can also specify a new course start date. 

4.10.4.3.Обычные опции возврата в исходное состояние 
Вы можете установить дату начала нового Курса для недавно возвращённого в 

исходное состояние Курса, удалить все события Календаря, Комментарии, данные о 

Завершении Курса, данные о Завершении Действий в отчётах Журнала Регистрации Курса 

и пользовательские заметки, прикреплённые к Курсу. 

Перед тем, как возвратить что-то в исходное состояние: Вам нужно убедиться, что 

вы выполнили резервное копирование всей информации в вашем Курсе, прежде чем 

возвращать Курс в исходное состояние. При резервном копировании Курса убедитесь, что 

его резервная копия имеет пользовательскую информацию. Таким образом, вы будете 

иметь данные резервного копирования те, которые имел ваш Курс до возврата его в 

исходное состояние для другой Группы или кафедры. 

4.10.4.4.Опции Ролей возврата в исходное состояние 
Эти опции для Ролей по возврату в исходное состояние позволяют отчислить всех 

пользователей с определённой Ролью в Курсе (например, Студентов), а также удалить все 

переопределения и назначения Ролей, характерных для этого Курса. Это не влияет на 

пользовательские назначения Ролей вне контекста Курса. 

4.10.4.5.Опции возврата в исходное состояние 
Журнала Оценок 

Опции по возврату в исходное состояние Журнала Оценок позволяют удалить все 

элементы и Категории Журнала Оценок, и/или удалить все записанные внутри Курса 

Оценки. Имейте в виду, что эти Оценки все ещё записаны в учётной записи пользователя. 

4.10.4.6.Опции возврата в исходное состояние Группы 
Опции по возврату в исходное состояние Группы предоставляют вам возможность 

удалить все Группы, созданные в Курсе и/или удалить всех пользователей из любых Групп 

внутри Курса. 

Вы также можете удалить все Группировки, созданные в Курсе и/или удалить всех 

пользователей из любых Группировок внутри Курса. 

4.10.4.7.Опции по возврату в исходное состояние 
Интерактивного Действия 

В зависимости от Интерактивных Действий, используемых в Курсе, вам будет 

предоставлена опция удаления пользовательских данных, связанных с этими учебными 

объектами. Это включает в себя ответы на Выборы, попытки выполнить Экзамен, ответы 

на Обратную Связь, сообщения Форумов (из выбранных типов Форумов), записей 

Глоссариев и т.д. 

Вы можете удалить все попытки из всех Экзаменов. 

Вы также можете указать дату начала нового Курса. 
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4.10.5.Clone resource/activity 
 
In edit mode use the x2 icon to duplicate the activity or resource. 

 

4.10.6.See also 
4.10.6.1.Course backup 
 Course backup - The traditional way (along with Restore) to take all or 

parts of a course and duplicate it on the current site or on a different 

Moodle site. 

4.10.6.2.Course restore 
 Course restore - Allows taking all or parts of a course backup and 

adding it to an existing course or creating a new course. 

There are other ways to share your course beside the above. 

4.10.6.3.Community hub 
 Community hub - Tell others about your course or find other courses to 

use or linkto (needs site administrator). 

4.10.6.4.MNet 

 MNet - A way site administrators can network (loosely connect) 

Moodle sites together. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.10.5.Клонировать 
Ресурсы/Интерактивные Действия 

В режиме редактирования используйте значок x2, чтобы сдублировать 

Интерактивное Действие или Ресурс. 

4.10.6.См. также 
4.10.6.1.Резервная Копия Курса 
 Резервная Копия Курса (п. 3.7.2) – традиционный способ (наряду с Восстановлением) 

взять весь или части Курса и сдублировать его на текущий Сайт или на другой Сайт 

Moodle. 

4.10.6.2.Восстановление Курса 
 Восстановление Курса (п. 3.7.3) – позволяет захват всего или частей Курса из резервной 

копии и помещение этого в существующий Курс или в создаваемый новый Курс. 

Есть и другие способы, чтобы разделить свой Курс с кем-то, кроме упомянутых 

выше. 

4.10.6.3.Хаб Сообщества 
 Хаб Сообщества – расскажи другим о своём Курсе, или найди другие Курсы, чтобы 

использовать или сослаться на них (через Администратора Сайта). 

4.10.6.4.MNet 

 MNet – способ, которым Администраторы Сайта могут соединить вместе в сети 

(произвольным образом) Сайты Moodle. 

http://docs.moodle.org/25/en/Community_hub
http://docs.moodle.org/25/en/MNet
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Полное оглавление 
4.Управление Курсом Moodle 

4.1.Курсы 

4.1.1.Добавление нового Курса 

4.1.1.1.Добавление Курса 

4.1.1.2.Удаление Курса(ов) 

4.1.1.3.Заявки на создание Курсов 

4.1.1.4.Создание Курсов оптом 

4.1.1.5.См. также 

4.1.2.Категории Курсов 

4.1.2.1.Добавление Категории 

4.1.2.2.Редактирование или перемещение Категории 

4.1.2.3.Добавление подКатегорий Курсов 

4.1.2.4.Сокрытие Категорий 

4.1.2.5.Настройка глубины Категорий 

4.1.2.7.См. также 

4.1.3.Настройки Курсов 

4.1.3.1.Обычные настройки 

4.1.3.1.1.Полное название Курса 
4.1.3.1.2.Краткое название 
4.1.3.1.3.Категория Курсов 
4.1.3.1.4.Дата начала Курса 
4.1.3.1.5.Видимый 
4.1.3.1.6.ID-номер Курса 

4.1.3.2.Описание 

4.1.3.2.1.Краткое изложение Курса 
4.1.3.2.2.Файлы с кратким изложением Курса 

4.1.3.3.Формат Курса 

4.1.3.3.1.Формат 
4.1.3.3.2.Число Разделов 
4.1.3.3.3.Скрытые Разделы 
4.1.3.3.4.Компоновка Курса 

4.1.3.4.Внешний вид 

4.1.3.4.1.Принудительная Фоновая Картинка Курса 
4.1.3.4.2.Принудительный язык Курса 
4.1.3.4.3.Показ Элементов новостей 
4.1.3.4.4.Показать Журнал Оценок Студентам 
4.1.3.4.5.Показать Отчёты по Интерактивным Действиям 
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4.1.3.5.Файлы и пересылки 

4.1.3.5.1.Максимальный Размер пересылки 
4.1.3.6.Отслеживание Завершения 

4.1.3.7.Доступ Гостя 

4.1.3.8.Группы 

4.1.3.8.1. Групповой Режим 
4.1.3.8.2.Принуждение 
4.1.3.8.3.Распределение по Группам по умолчанию 

4.1.3.9.Переименование Роли 

4.1.3.10.Настройки Администратора Сайта 

4.1.3.11.Предотвращение редактирования настроек Курса Преподавателями 

4.1.4.Форматы Курсов 

4.1.4.1.Стандартные форматы Курсов 

4.1.4.1.1.Формат Еженедельный 
4.1.4.1.2.Формат Тематический 
4.1.4.1.3.Социальный формат 
4.1.4.1.4.Формат SCORM 

4.1.4.2.Предлагаемые кем-то форматы Курсов 

4.1.4.2.1.СвёрнутыеТемы 
4.1.4.2.2. Формат Ежедневный – с разбивкой Курса по дням 
4.1.4.2.3.Сетевой формат 
4.1.4.2.4.Формат Меню Тем 
4.1.4.2.5.Формат Доски Объявлений 
4.1.4.2.6.Формат Одной Темы 
4.1.4.2.7.Формат Цветовой Темы 
4.1.4.2.8.Гибкий формат Разделов 
4.1.4.2.9.Формат Единственного Интерактивного Действия 

4.1.4.3.См. также 

4.1.5.Домашняя Страница Курса 

4.1.5.1.Стандартный вид незаполненного Курса 

4.1.5.1.1.Части Домашней Страницы Курса 
4.1.5.2.Разделы Курса 

4.1.5.3.Блоки 

4.1.5.4.Интерактивные Действия и Ресурсы 

4.1.5.5.Редактирование элементов на Домашней Странице вашего Курса 

4.1.5.6.Советы и трюки 

4.1.5.7.Возможности Домашней Страницы Курса 

4.1.5.7.1.Управлять видимостью Раздела 
4.1.5.7.2.Установить текущий Раздел 

4.1.5.8.См. также 
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4.1.6.Часто задаваемые вопросы по Курсу 

4.1.6.1.Как избавиться от имён Преподавателей в описаниях моих Курсов? 

4.1.6.2.Как добавить имена неРедактирующих Преподавателей в описания моих Курсов? 

4.1.6.3.Некоторые из моих Курсов демонстрируют краткое изложения Курса, но некоторые имеют только информационную иконку. Почему? 

4.1.6.4.Почему можно добавить только одну гиперссылку на Страницу или в Этикетку? 

4.1.6.5.Как помешать Преподавателям дублировать Действия Курсов? 

4.1.6.6.Я не хочу нового селектора Действий. Как вернуть старые ниспадающие списки? 

4.1.6.7.Как сделать Домашнюю Страницу моего Курса выглядящей более похожей на веб-Сайт? 

4.1.6.8.Я не могу отредактировать аннотацию Темы: иконка редактирования больше не работает (не щёлкается) 

4.1.6.9.Где можно найти список всех Ресурсов Курса? 

4.1.6.10.Можно загрузить все файлы из Курса? 

4.1.6.11.Я получил сообщение об ошибке «Панель разбиения на страницы требует значения Perpage» 

4.1.6.12.Могу я разместить Курс более, чем в одной Категории? 

4.1.6.13.Существует ли быстрая клавиша URL для перехода к Курсу? 

4.2.Редактирование текста 

4.2.1.Текстовый редактор 

4.2.1.1.Свёрнутый редактор 

4.2.1.2.Список групп 

4.2.1.3.Специальные средства 

4.2.1.3.1.Средства выбора цвета 
4.2.1.3.2.Вставить изображения и медиа 

4.2.1.4.Настройки управления Сайта 

4.2.1.5.См. также 

4.2.2.Форматирование текста 

4.2.2.1.Опции форматирования текста 

4.2.2.2.Формат HTML 

4.2.2.3.Авто-формат Moodle 

4.2.2.4.Формат простого текста 

4.2.3.Формат Markdown 

4.2.4.Часто задаваемые вопросы по текстовому редактору 

4.2.4.1.Я не могу найти опцию, чтобы сделать...... 

4.2.4.2.Можно ли настроить текстовый редактор или добавить другие иконки, подобные закладке или линейке горизонтальной прокрутки? 

4.2.4.3.Текстовый редактор не появляется 

4.2.4.4.Как включить проверку орфографии? 

4.2.4.5.Как использовать проверку орфографии браузером Firefox 

4.2.4.6.Как отключить кнопку проверки орфографии для особых примеров в Экзамене? 

4.2.4.7.Какую наибольшую порцию текста вы можете редактировать? 

4.2.4.8.Существуют какие-нибудь клавиши быстрого доступа? 

4.2.4.9.См. также 

4.3.Интерактивные Действия 
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4.3.0.Управление Интерактивными Действиями 

4.3.0.1.Управлять Интерактивными Действиями 

4.3.0.1.1.Число Интерактивных Действий 
4.3.0.1.2.Версия 
4.3.0.1.3.Сокрытие модуля 
4.3.0.1.4.Удаление модуля 
4.3.0.1.5.Настройки модуля 

4.3.0.2.Уменьшение числа Интерактивных Действий, перечисляемых в окне выбора Действий 

4.3.1.Задания 

4.3.1.1.Настройки Задания 

4.3.1.1.1.Добавление и редактирование Интерактивного Действия «Задание» 
4.3.1.1.2.Обычные настройки 
4.3.1.1.3.Доступность 
4.3.1.1.4.Типы готовых ответов 
4.3.1.1.5.Типы Обратной Связи 
4.3.1.1.6.Настройки готового ответа 
4.3.1.1.7.Настройки готового ответа Группы 
4.3.1.1.8.Извещения 
4.3.1.1.9.Оценка 
4.3.1.1.10.Общие настройки модулей 
4.3.1.1.11.Настройки ограниченности доступа 
4.3.1.1.12.Локально назначенные Роли 
4.3.1.1.13 Возможности Задания 
4.3.1.1.14.Настройки управления Сайта 
4.3.1.1.15.См. также 

4.3.1.2.Применение Задания 

4.3.1.2.1.Различные опции готовых ответов 
4.3.1.2.2.Какой тип готового ответа подходит вам лучше? 
4.3.1.2.3.Как Студентам переслать готовые ответы по их Заданиям? 
4.3.1.2.4.Извещения о передаче готовых ответов 
4.3.1.2.5.Просмотр и оценивание Заданий, на которые переданы готовые ответы 
4.3.1.2.6.Сохранение записей (архивирование, экспортирование, резервное копирование) 
4.3.1.2.7.Советы и трюки 
4.3.1.2.8.См. также 

4.3.1.3.Часто задаваемые вопросы по Заданию 

4.3.1.3.1.Как найти ещё неоценённые Задания? 
4.3.1.3.2.Почему невозможно отредактировать Оценки за готовые ответы по Заданию? 
4.3.1.3.3.Как можно удалить выбранный Показатель из Задания? 
4.3.1.3.4.Могут ли Студенты получать подтверждение о передаче готового ответа через э-почту? 
4.3.1.3.5.Можно ли загрузить сразу все Задания, по которым переданы ответы? 
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4.3.1.3.6.Как экспортировать уровни Рубрикации и критерии наряду с готовыми ответами Студентов? 
4.3.1.3.7.Почему не видно кнопки Upload при переключении моей Роли на Роль Студента, чтобы протестировать Задание, которое я сделал? 
4.3.1.3.8.Что произойдёт, если я восстановлю резервную копию Интерактивных Действий «Задание» (версия 2.2)? 
4.3.1.3.9.Что это за момент – «Дата окончания»? 
4.3.1.3.10.У меня нет доступа к комментариям готового ответа на Задание с экрана оценивания 
4.3.1.3.11.См. также 

4.3.1.4.Средство обновления Задания 

4.3.1.4.1.Обновление Заданий 
4.3.1.4.2.Отображение Настроек 
4.3.1.4.3.Отключение старого модуля «Задание» 
4.3.1.4.4.Восстановление Заданий (версии 2.2) на более поздний Сайт 

4.3.2.Чат 

4.3.2.1.Настройки Чата 

4.3.2.1.1.Добавление Чата в ваш Курс 
4.3.2.1.2.Сессии Чата 
4.3.2.1.3.Общие настройки модуля 
4.3.2.1.4.Ограничить Завершения Доступа/Действия 
4.3.2.1.5.Локально назначенные Роли 
4.3.2.1.6.Настройки управления Сайта 
4.3.2.1.7.Возможности Чата 

4.3.2.2.Применение Чата 

4.3.2.2.1.Вхождение в Чат 
4.3.2.2.2.Присоединение к сессии Чата 
4.3.2.2.3.Отчёты по Чату 
4.3.2.2.4.Экспортирование сессий Чата 
4.3.2.2.5.Зачем использоватьЧат? 
4.3.2.2.6.Почему НЕ следует использовать Чат? 
4.3.2.2.7.См. также 

4.3.2.3.Часто задаваемые вопросы по Чат 

4.3.2.3.1.Как я могу позволить Гостям участвовать в деятельности Чата? 
4.3.2.3.2.Как можно использовать аудио Чат? 
4.3.2.3.3.Как ограничить Чат таким образом, чтобы определённые пользователи не могли на него попасть? 
4.3.2.3.4.См. также 

4.3.3.Выбор 

4.3.3.1.Настройки Выбора 

4.3.3.1.1.Настройки управления Выбором 
4.3.3.1.2.Обычные настройки 
4.3.3.1.3.Опции 
4.3.3.1.4.Доступность 
4.3.3.1.5.Результаты 
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4.3.3.1.6.Общие настройки модуля 
4.3.3.1.7.Ограничить Доступ/Завершение Действия 
4.3.3.1.8.Возможности модуля «Выбор» 

4.3.3.2.Применение Выбора 

4.3.3.2.1.Что видит Студент 
4.3.3.2.2.Что видит Преподаватель 
4.3.3.2.3.Некоторые способы применения Выбора 
4.3.3.2.4.Примеры использования Выбора 
4.3.3.2.5.См. также 

4.3.3.3.Часто задаваемые вопросы по Выбору 

4.3.3.3.1.Как можно позволить пользователям участвовать в Главной странице Интерактивного Действия «Выбор»? 
4.3.3.3.2.Можно позволить Студентам делать более одного выбора? 
4.3.3.3.3.Можно ли использовать изображения в качестве альтернатив Выбора вместо текста? 
4.3.3.3.4.См. также 

4.3.4.База Данных 

4.3.4.1.Настройки Базы Данных 

4.3.4.1.1.Добавление Интерактивного Действия «База Данных» 
4.3.4.1.2.Обычные настройки 
4.3.4.1.3.Записи Базы Данных 
4.3.4.1.4.Доступность 
4.3.4.1.6.Оценка 
4.3.4.1.7.Рейтинги 
4.3.4.1.8.Общие настройки модуля 
4.3.4.1.9.Ограничить Доступ/Завершение Действия 
4.3.4.1.10.Настройки управления Сайтом 
4.3.4.1.11.Возможности Интерактивного Действия «База Данных» 

4.3.4.2.Разработка Базы Данных 

4.3.4.2.1.Поля Базы Данных 
4.3.4.2.2.Заранее установленные (Базы Данных) 

4.3.4.3.Шаблоны Баз Данных 

4.3.4.3.1.Применение тегов 
4.3.4.3.2.Шаблон списка 
4.3.4.3.3.Одиночный Шаблон 
4.3.4.3.4.Шаблон расширенного поиска 
4.3.4.3.5.Добавить Шаблон 
4.3.4.3.6.Шаблон RSS 
4.3.4.3.7.Шаблон CSS 
4.3.4.3.8.Шаблон Javascript 
4.3.4.3.9.Кнопка восстановления шаблонов 
4.3.4.3.10.See also 
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4.3.4.4.Использование Базы Данны 

4.3.4.4.1.Представления Баз Данных 
4.3.4.4.2.Добавление Записи Базы Данных 
4.3.4.4.3.Автоматическое Связывание Записей Базы Данных 
4.3.4.4.4.Импортирование многих Записей Базы Данных 
4.3.4.4.5.Экспортирование Записей Баз Данных 
4.3.4.4.6.Экспортирование во внешний Портфель 
4.3.4.4.7.Возможные Базы Данных 
4.3.4.4.8.Творческие применения 
4.3.4.4.9.См. также 

4.3.4.5.Часто задаваемые вопросы по Интерактивному Действию «База Данных» 

4.3.4.5.1.Откуда я могу скачать дополнительные заранее установленные Базы Данных? 
4.3.4.5.2.Как увеличить список заранее установленных Баз Данных, доступных пользователям для выбора 
4.3.4.5.3.Как создать Базу Данных, в которой Студенты могли бы просматривать только свои Записи БД 
4.3.4.5.4.Как включить функцию сортировки щелчком по заголовкам полей? 
4.3.4.5.5.Как добавить подсветку такую, как на странице Module и странице Плагинов? 
4.3.4.5.6.Как представить информацию Базы Данных не вертикально, а горизонтально? 
4.3.4.5.7.Невозможно вывести колонки в представлении списком построчно 
4.3.4.5.8.Как создать заранее установленную Базу Данных «Энциклопедия»? 
4.3.4.5.9.Существует ли маркировка времени для Записей Базы Данных? 
4.3.4.5.10.Как внести заголовок Записи Базы Данных в ссылку? 
4.3.4.5.11.Как создать вызываемый по щелчку мыши адрес электронной почты? 
4.3.4.5.12.Как скрыть Запись Базы Данных, которая была предварительно одобрена? 
4.3.4.5.13.Как добавить по умолчанию упорядочение Записей Баз Данных? 
4.3.4.5.14.Почему моя База Данных так медленно показывает каждую страницу? 
4.3.4.5.15.Как предотвратить Студентов от добавления Записей в Базу Данных? 
4.3.4.5.16.Как Опустошить Базу Данных/Удалить Записи из многих Баз Данных? 
4.3.4.5.17.Я получил сообщение об ошибке при импортировании Записей Базы Данных из CSV-файла 
4.3.4.5.18.См. также 

4.3.5.Внешнее приложение 

4.3.6.Обратная Связь 

4.3.6.1.Настройки Обратной Связи 

4.3.6.1.1.Включение модуля «Обратная Связь» 
4.3.6.1.2.Включение Блока «Обратная Связь» 
4.3.6.1.3.Настройки управления Обратной Связью 
4.3.6.1.4.Обычные настройки 
4.3.6.1.5.Доступность 
4.3.6.1.6.Настройки вопроса и готового ответа 
4.3.6.1.7.После отправки готового ответа 
4.3.6.1.8.Общие настройки модуля 
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4.3.6.1.9.Ограничить Доступ/Завершение Действия 
4.3.6.1.10.Отобразить Обратную Связь в Курсах 
4.3.6.1.11.Настройки управления Сайта 
4.3.6.1.12.Возможности Обратной Связи 

4.3.6.2.Построение Обратной Связи 

4.3.6.2.1.Стандартные опции 
4.3.6.2.2.Возможные типы Вопросов 
4.3.6.2.3.См. также 

4.3.6.3.Использование Обратной Связи 

4.3.6.3.1.Что видит Студент 
4.3.6.3.2.Что видит Преподаватель 
4.3.6.3.3.Почему используют Обратную Связь? 

4.3.6.4.Feedback FAQ 

4.3.6.3.4.См. также 
4.3.6.4.Часто задаваемые вопросы по Обратной Связи 

4.3.6.4.1.Как можно разрешить не зарегистрированным пользователям давать Обратную Связь? 
4.3.6.4.2.Как создать Интерактивное Действие «Обратная Связь» и добавить Вопросы? 
4.3.6.4.3.Как Преподаватель может создать публичный Шаблон для использования в другом месте? 
4.3.6.4.4.Я не вижу таблицы «Редактировать Вопросы». Что делать? 
4.3.6.4.5.См. также 

4.3.6.5.См. также 

4.3.7.Форум 

4.3.7.1.Настройки Форума 

4.3.7.1.1.Добавление и редактирование Форума 
4.3.7.1.2.Обычные настройки 
4.3.7.1.3.Присоединения и подсчёт слов 
4.3.7.1.4.Подписка и слежение 
4.3.7.1.5.RSS 
4.3.7.1.6.Пороговая величина для блокирования почты 
4.3.7.1.7.Оценка 
4.3.7.1.8.Рейтинги 
4.3.7.1.9.Общие настройки модуля 
4.3.7.1.10.Ограничить Доступ/Завершение Действия 
4.3.7.1.11.Локально назначаемые Роли 
4.3.7.1.12.Полномочия Форума 
4.3.7.1.13.Настройки управления пользователем 
4.3.7.1.14.Настройки управления Сайтом 

4.3.7.2.Применение Форума 

4.3.7.2.1.Представления Форума 
4.3.7.2.2.Опции отображения 
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4.3.7.2.3.Отправка сообщений Форума 
4.3.7.2.4.Экспортирование сообщений Форума 
4.3.7.2.5.Перемещение обсуждения 
4.3.7.2.6.Рекомендации по использованию Форумов Преподавателями и Студентами 
4.3.7.2.7.Выбор типа Форума 
4.3.7.2.8.Подписка на Форум 
4.3.7.2.9.Концепции, используемые в Форумах 
4.3.7.2.10.Некоторые потенциальные возможности Форума 
4.3.7.2.11.Рейтинги Форума позволяют пользователям оценивать сообщения в Форуме 

4.3.8.Глоссарий 

4.3.8.1.Настройки Глоссария 

4.3.8.1.1.Добавление Глоссария 
4.3.8.1.2.Обычные настройки 
4.3.8.1.3.Записи 
4.3.8.1.4.Внешний вид 
4.3.8.1.5.RSS 
4.3.8.1.6.Оценка 
4.3.8.1.7.Рейтинги 
4.3.8.1.8.Общие настройки модуля 
4.3.8.1.9.Ограничить доступ/завершение ИнтерактивногоДействия 
4.3.8.1.10.Добавлление новой Записи в Глоссарий 
4.3.8.1.11.Полномочия Глоссария 
4.3.8.1.12.Настройки управления Сайта 

4.3.8.2.Использование Глоссария 

4.3.8.2.1.Добавление Записи в Глоссарий 
4.3.8.2.2.Редактирование Записей Глоссария/Добавление Категорий 
4.3.8.2.3.Просматривать опции 
4.3.8.2.4.Опции Поиска 
4.3.8.2.5.Ожидание одобрения 
4.3.8.2.6.Распечатка Глоссария 
4.3.8.2.7.Комментарии Глоссария 
4.3.8.2.8.Экспортирование записей Глоссария в другой Глоссарий 
4.3.8.2.9. Экспортирование записей Глоссария в Портфель 
4.3.8.2.10.Импортирование записей Глоссария 
4.3.8.2.11.Как использовать Глоссарий? 
4.3.8.2.12.Отключение ссылок на термины Глоссария 
4.3.8.2.13.См. также 

4.3.8.3.Часто задаваемые вопросы по Глоссарию 

4.3.8.3.1.Как включить авто-связывание по Глоссарию? 
4.3.8.3.2.Как авто-связывать записи Глоссария ТОЛЬКО с первым элементом на странице? 
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4.3.8.3.3.Как удалить вложенный файл из записи Глоссария? 
4.3.8.3.4.Как включить авто-связывание Глоссария в пересылаемых файлах HTML? 
4.3.8.3.5.Как освободить отдельные слова от авто-связывания с записью Глоссария? 
4.3.8.3.6.Как предотвратить авто-связывание Глоссария в Экзамене? 
4.3.8.3.7.Как сделать, чтобы Студенты могли Глоссарий только читать? 
4.3.8.3.8.Как импортировать Записи из другого Глоссария? 
4.3.8.3.9.Я отчаялся, пытаясь импортировать мой старый Глоссарий изображений в новый Глоссарий с XML 
4.3.8.3.10.Как сделать Глоссарий глобальным? 
4.3.8.3.11.Какова кодировка различных форматов отображения? 
4.3.8.3.12.См. также 

4.3.9.Урок 

4.3.9.1.Настройки Урока 

4.3.9.1.1.Настройки управления Уроком 
4.3.9.2.Разработка Урока 

4.3.9.2.1.Планирование вашего Урока 
4.3.9.2.2.Добавление содержимого и Вопросов к вашему Уроку 
4.3.9.2.3.Продвижение вперёд в вашем Уроке 
4.3.9.2.4.Окончание вашего Урока 

4.3.9.3.Использование Урока 

4.3.9.3.1.Что видят Студенты 
4.3.9.3.2.Что видят Преподаватели 
4.3.9.3.3.Оценивание Уроков 
4.3.9.3.4.Понимание последовательности действий 
4.3.9.3.5.Идеи по использованию Уроков 

4.3.9.4.Переходы 

4.3.9.5.Часто задаваемые вопросы по Уроку 

4.3.9.5.1.Что такое Таблица переходов? 
4.3.9.5.2.Импорт PowerPoint не работает 
4.3.9.5.3.Переходы по страницам не работают в Вопросе 
4.3.9.5.4.Редактирования ответов или кнопки переходов не сохраняются 
4.3.9.5.5.Что такое Ветвь? 
4.3.9.5.6.Множественный Выбор и проблемы Мультиответа 
4.3.9.5.7.Есть ли примеры Уроков, которые можно посмотреть? 
4.3.9.5.8.Урок был завершён, но это не запротоколировано 
4.3.9.5.9.Зависимость в Уроке не работает 
4.3.9.5.10.Как добавить звук на страницу Урока 
4.3.9.5.11.Можно отключить перемешивание ответов в Уроке? 
4.3.9.5.12.Можно заменить стандартные слова, используемые Уроком 
4.3.9.5.13.Бррр, что-то произошло – список Уроков не правилен – невозможно ничего переместить 
4.3.9.5.14.Что случилось с моим HTML-кодом на странице Урока? 
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4.3.9.5.15.Страницы не отображаются в меню Уроков слева 
4.3.9.5.16.Студенты не возвращаются туда, где оставили Урок 
4.3.9.5.17.См. также 

4.3.9.6.Анализ кратких ответов 

4.3.9.6.1.Простой анализ 
4.3.9.6.2.Анализ регулярных выражений 
4.3.9.6.3.Советы и трюки 
4.3.9.6.4.См. также 

4.3.9.7.See also 

4.3.10.Экзамен 

4.3.10.1.Настройки Экзамена 

4.3.10.1.1.Управление Экзаменом 
4.3.10.1.2.Обычные настройки 
4.3.10.1.3.Планирование времени Экзамена 
4.3.10.1.4.Оценка 
4.3.10.1.5.Компоновка 
4.3.10.1.6.Поведение Вопросов 
4.3.10.1.7.Опции просмотра 
4.3.10.1.8.Отображение 
4.3.10.1.9.Дополнительные ограничения на попытки 
4.3.10.1.10.Общая Обратная Связь 
4.3.10.1.11.Общие настройки модулей 
4.3.10.1.12.Ограничить доступ/завершение Действия 
4.3.10.1.13.Переопределения Группы и пользователя 
4.3.10.1.14.Настройки управления Сайтом 
4.3.10.1.15.См. также 

4.3.10.2.Построение Экзамена 

4.3.10.2.1.Как работает Экзамен системы Moodle 
4.3.10.2.2.Добавление Вопросов 
4.3.10.2.3.Компоновка Экзамена 
4.3.10.2.4.Назначение баллов за Вопросы 
4.3.10.2.5.Предварительный просмотр Экзамена 
4.3.10.2.6.После попытки выполнения Экзамена 
4.3.10.2.7.См. также 

4.3.10.3.Использование Экзамена 

4.3.10.3.1.Как Студенты используют Экзамен 
4.3.10.3.2.Как Преподаватели видят Экзамен 
4.3.10.3.3.Идеи по применению Экзамена 
4.3.10.3.4.См. также 

4.3.10.4.Отчёты по Экзамену 
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4.3.10.4.1.Отчёт по оценкам 
4.3.10.4.2.Отчёт по экзаменационным ответам 
4.3.10.4.3.Статистический отчёт 
4.3.10.4.4.Отчёт по оцениванию вручную 
4.3.10.4.5.См. также 
4.3.10.4.6.Вычисление статистических данных Экзамена 

4.3.10.5.Оценивание Экзамена 

4.3.10.5.1.Оценивание Экзаменов 
4.3.10.6.Часто задаваемые вопросы по Экзамену 

4.3.10.6.1.Можно иметь разные времена начала/согласование по времени, число попыток для различных Групп? 
4.3.10.6.2.Что произойдёт, если Студенты предадут на рассмотрение ответы после даты закрытия Экзамена? 
4.3.10.6.3.Существует хороший способ напечатать копию Экзамена? 
4.3.10.6.4.Почему мне дольше не позволено добавлять или перемещать комментарии? 
4.3.10.6.5.Как отключить автосвязывание Глоссария в Экзамене? 
4.3.10.6.6.Как можно удалить проблемный Вопрос после того, как Экзамен стали сдавать? 
4.3.10.6.7.Можно ли иметь Экзамен, который не оценивается? 
4.3.10.6.8.Почему мой Экзамен не отображается в ЖурналеОценок? 
4.3.10.6.9.Как мне позволить пересдать экзамен человеку, которому я установил 1 попытку? 
4.3.10.6.10.Как задать конкретным Студентам дополнительное время в синхронизированном Экзамене? 
4.3.10.6.11.Я вручную ввёл Оценки за Экзамен в Журнал Оценок. Как позволить Студентам улучшить эти Оценки? 
4.3.10.6.12.Как позволить извещать о передаче на рассмотрение Экзамена? 
4.3.10.6.13.Почему люди (Гости) не могут сдавать Экзамен без создания учётной записи и регистрации? 
4.3.10.6.14.Можете объяснить ошибку «Требуемое число случайным образом вызываемых Вопросов больше, чем доступно в этой Категории!»? 
4.3.10.6.15.Как послать сообщение сразу всем Студентам, которые не завершили Экзамен? 
4.3.10.6.16.How do random questions work? 
4.3.10.6.17.Можно загрузить Вопросы Экзамена не в формате Moodle? 
4.3.10.6.18.Как отключить отметку Вопросов флажками? 
4.3.10.6.19.Как создать Категории Вопросов на уровне системы? 
4.3.10.6.20.Как помешать Студентам просматривать или переходить от Вопроса к Вопросу в Экзамене? 
4.3.10.6.21.Как минимизировать загрузку сервера при использовании Экзамена? 
4.3.10.6.22.Как сделать таймер Экзамена «плавающим» или переместить вниз страницы? 
4.3.10.6.23.См. также 

4.3.10.7.Возможности 

4.3.10.8.См. также 

4.3.10.9.Полномочия Вопросов, объясняемые диаграммами 

4.3.10.9.1.Простая история 
4.3.10.9.2.Краткое изложение правил 
4.3.10.9.3.См. также 

4.3.11.Формат СДО SCORM 

4.3.12.Опрос 
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4.3.12.1.Настройки Опроса 

4.3.12.1.1.Добавление Опроса 
4.3.12.1.2.Обычные настройки 
4.3.12.1.3.Общие настройки модуля 
4.3.12.1.4.Ограничить доступ/завершение ИнтерактивногоДействия 
4.3.12.1.5.Локально назначаемые Роли 
4.3.12.1.6.Полномочия Опроса 

4.3.12.2.Применение Опроса 

4.3.12.2.1.Отчёт по Опросу 
4.3.12.3.Часто задаваемые вопросы по Опросу 

4.3.12.3.1.Как можно создать пользовательские Опросы? 
4.3.12.4.См. также 

4.3.13.Вики 

4.3.13.1.Настройки Вики 

4.3.13.1.1.Добавление Вики 
4.3.13.1.2.Обычные настройки 
4.3.13.1.3.Формат 
4.3.13.1.4.Общие настройки модуля 
4.3.13.1.5.Ограничить доступ/завершение ИнтерактивногоДействия 
4.3.13.1.6.Локально назначаемые Роли 
4.3.13.1.7.Полномочия Вики 

4.3.13.2.Применение Вики 

4.3.13.2.1.Создание первой страницы 
4.3.13.2.2.Добавление дополнительных страниц 
4.3.13.2.3.Редактирование Вики в общем 
4.3.13.2.4.Видеть 
4.3.13.2.5.Редактировать 
4.3.13.2.6.Комментарии 
4.3.13.2.7.История 
4.3.13.2.8.Отобразить 
4.3.13.2.9.Файлы 
4.3.13.2.10.Управление 
4.3.13.2.11.Удаление страниц 
4.3.13.2.12.Язык разметки 
4.3.13.2.13.Зачем использовать Вики? 
4.3.13.2.14.Идеи по использованию Вики 
4.3.13.2.15.См. также 

4.3.13.3.Часто задаваемые вопросы по Вики 

4.3.13.3.1.Можно ли создать Вики, который мои Студенты смогут читать, но не редактировать? 
4.3.13.3.2.Студенты не могут видеть Вики других 
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4.3.13.3.3.Как оценивать Вики моих Студентов? 
4.3.13.3.4.Можно ли экспортировать Вики? 
4.3.13.3.5.См. также 

4.3.14.Семинар 

4.3.14.1.Ключевые возможности 

4.3.14.2.Настройки Семинара 

4.3.14.2.1.Добавление нового Семинара 
4.3.14.2.2.Общие настройки 
4.3.14.2.3.Настройки Аттестации 
4.3.14.2.4.Настройки готового ответа 
4.3.14.2.5.Настройки оценивания 
4.3.14.2.6.Обратная связь 
4.3.14.2.7.Возможные готовые ответы 
4.3.14.2.8.Доступность 
4.3.14.2.9.Общие настройки модуля 
4.3.14.2.10.Ограничить доступ/Завершение Действия 
4.3.14.2.11.Установить фазу 
4.3.14.2.12.Фаза предоставления готового ответа 
4.3.14.2.13.Фаза оценивания 
4.3.14.2.14.Фаза определения стоимости оценивания 
4.3.14.2.15.Настройки управления Сайта 
4.3.14.2.16.См. также 

4.3.14.3.Использование Семинара 

4.3.14.3.1.Фазы Семинара 
4.3.14.3.2.Оценивание Семинара 
4.3.14.3.3.Группы и Семинар 
4.3.14.3.4.См. также 

4.3.14.4.Стратегии оценивания 

4.3.14.4.1.Стратегия накапливающегося оценивания 
4.3.14.4.2.Комментарии 
4.3.14.4.3.Число ошибок 
4.3.14.4.4.Рубрика 

4.3.14.5.Часто задаваемые вопросы по Семинару 

4.3.14.5.1.Как автоматически переключать фазы Семинара? 
4.3.14.5.2.Как сделать рецензирование анонимным? 
4.3.14.5.3.Можно ли использовать Семинар, чтобы Студенты оценивали работы друг друга в режиме офлайн? 

4.3.14.6.См.также 

4.4.Ресурсы 

4.4.1.Книга 

4.4.1.1.Настройки Книги 
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4.4.1.1.1.Добавление Книги 
4.4.1.1.2.Обычные настройки 
4.4.1.1.3.Внешний вид 
4.4.1.1.4.Общие настройки модуля 
4.4.1.1.5.Ограничить доступ/Завершение Действия 
4.4.1.1.6.Настройки управления Сайтом 
4.4.1.1.7.Добавление глав и подГлав 
4.4.1.1.8.Импортирование Глав 
4.4.1.1.9.Возможности Книги 

4.4.1.2.Применение Книги 

4.4.1.2.1.Перемещаться по вашей Книге 
4.4.1.2.2.Применения модуля «Книга» 
4.4.1.2.3.Печатание Книги 
4.4.1.2.4.Экспортирование Книги в формате пакета с IMS-содержимым 
4.4.1.2.5.См. также 

4.4.1.3.Часто задаваемые вопросы о Книге 

4.4.1.3.1.Как позволить Студентам редактировать Книгу? 
4.4.1.3.2.Как позволить Студентам импортировать веб-страницы? 
4.4.1.3.3.Как позволить Преподавателям экспортировать Книгу в формате пакета с IMS содержимым? 
4.4.1.3.4.Почему только два уровня? 
4.4.1.3.5.Как осуществлять поиск внутри Книги? 
4.4.1.3.6.Можно импортировать Powerpoint-презентацию в Книгу? 
4.4.1.3.7.Можно изменить шрифт печатного вида Книги? 
4.4.1.3.8.См. также 

4.4.1.4.См. также 

4.4.2.Файл 

4.4.2.1.Настройки Ресурса «Файл» 

4.4.2.1.1.Добавление Файла 
4.4.2.1.2.Обычные настройки 
4.4.2.1.3.Содержимое 
4.4.2.1.4.Внешний вид 
4.4.2.1.5.Общие настройки модуля 
4.4.2.1.6.Ограничить доступ/Завершение Действия 
4.4.2.1.7.Отображение индексной страницы веб-Сайта 
4.4.2.1.8.Возможности модуля «Файл» 
4.4.2.1.9.Настройки управления Сайтом 

4.4.2.2.Часто задаваемые вопросы по Ресурсу «Файл» 

4.4.2.1.1.Мои Студенты не могут открыть файл, который я им переслал 
4.4.2.1.2.Зачем дана возможность выбирать множество файлов в настройках Файла? 
4.4.2.1.3.Как я могу переслать множество файлов за один шаг? 
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4.4.2.1.4.Как изменить высоту окошка в рамке, при отображении в нём Файла 
4.4.2.1.5.Если я переслал файл в один Курс, могу ли я использовать его также и в другом Курсе? 
4.4.2.1.6.Как сделать ppt-презентации открывающимися в Moodle, а не после загрузки в свой компьютер? 
4.4.2.1.7.Как показать размер Файла на странице Курса? 
4.4.2.1.8.Если Студенты могут ссылаться на пересланные файлы по их псевдонимам, как остановить замены Студентами имён Файлов на псевдонимы в 

их Заданиях? 

4.4.2.1.9.Я переслал видео Файл, но размер его окна показа очень мал. Как изменить размер по умолчанию этого видео? 
4.4.3.Папка 

4.4.3.1.Настройки Ресурса «Папка» 

4.4.3.1.1.Добавление паки в ваш Курс 

4.4.3.1.2.Создание и пересылка в новую Папку 

4.4.3.1.3.Отобразить содержимое Папки 

4.4.3.1.4.Возможности Папки 

4.4.3.1.5.Настройки управления Сайтом 

4.4.3.2.Часто задаваемые вопросы по Ресурсу 

4.4.3.2.1.У меня есть Папка файлами-ссылками в ней. Как отобразить это в Moodle? 

4.4.3.2.2.Как сослаться на Папку в репозитории? 

4.4.3.2.3.Можно предотвратить режим принудительного скачивания файлов в Папку? 

4.4.3.2.4.Как разрешить Студентам пересылать в Папку, которую я отобразил? 

4.4.4.Пакет с IMS содержимым 

4.4.4.1.Настройки пакета с IMS содержимым  См. 

4.4.4.2.Часто задаваемые вопросы о пакетах IMS См. 

4.4.5.Этикетка 

4.4.5.1.Настройки модуля «Этикетка» 

4.4.5.1.1.Добавление Этикетки 

4.4.5.1.2.Общие настройки 

4.4.5.1.3.Общие настройки модуля 

4.4.5.1.4.Ограничить доступ/Завершение Действия 

4.4.5.1.5.Возможности Этикетки 

4.4.5.2.Применение Этикетки 

4.4.5.2.1.Добавление изображений в Этикетку 

4.4.5.2.2.Добавление текста в Этикетку 

4.4.5.2.3.Добавление ссылки в Этикетку 

4.4.5.2.4.Добавление звука или видео в Этикетку 

4.4.5.2.5.Добавление кода в Этикетку 

4.4.5.2.6.См. также 

4.4.5.3.Часто задаваемые вопросы по Этикетке 

4.4.5.3.1.Я больше могу редактировать Этикетку. Что мне делать? 

4.4.5.3.2.См. также 

4.4.6.Страница 
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4.4.6.1.Настройки Ресурса «Страница» 

4.4.6.1.1.Добавление новой Страницы в ваш Курс 

4.4.6.1.2.Обычные настройки 

4.4.6.1.3.Содержимое 

4.4.6.1.4.Внешний вид 

4.4.6.1.5.Общие настройки модуля 

4.4.6.1.6.Ограничить доступ/Завершение Действия 

4.4.6.1.7.Возможности модуля «Страница» 

4.4.6.1.8.Настройки управления Сайтом 

4.4.6.2.Применение Страницы 

4.4.6.2.1.Почему Страница, а не Файл? 

4.4.6.2.2.Как создать Страницу 

4.4.6.3.Часто задаваемые вопросы по Странице 

4.4.6.3.1.Я завершил свою Страницу, но она не позволяет мне её сохранить. Почему не? 

4.4.6.3.2.Как сделать мою страницу открываемой во всплывающем окошке? 

4.5.Блоки 

4.5.1.Стандартные Блоки 

4.5.2.Управляющие Блоки 

4.5.2.1.Работа с блоками 

4.5.2.1.1.Повторяемость блока 

4.5.2.1.2.Версия 

4.5.2.1.3.Сокрытие Блока 

4.5.2.1.4.Защита Блоков от удаления 

4.5.2.1.5.Удаление Блока 

4.5.2.1.6.Настройки Блока 

4.5.2.2.Возможности Блока 

4.5.2.2.1.Управлять Блоками моей домашней страницы 

4.5.2.2.2.Редактировать Блоки на страницах тегов 

4.5.2.2.3.Управлять Блоками в своём собственном публичном Профиле пользователя 

4.5.2.2.4.Управлять Блоками в пользовательских Профилях других пользователей 

4.5.2.2.5.Редактировать настройки Блока 

4.5.2.2.6.Просмотреть Блок 

4.5.2.2.7.Управлять Блоками на странице 

4.5.2.3.Предлагаемые кем-то Блоки 

4.5.2.4.См. также 

4.5.3.Настройки Блока 

4.5.3.1.Добавление Блока на страницу 

4.5.3.2.Конфигурация Блока 

4.5.3.2.1.Настройки Блока 

4.5.3.2.2.Где этот Блок появится 
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4.5.3.2.3.На этой странице 

4.5.3.3.«Прилипчивые Блоки» 

4.5.3.3.1.Создание Блока, прилипчивого по всему Сайту 

4.5.3.3.2.Создание Блока, прилипчивого по всему Курсу 

4.5.3.3.3.Создание Блока, прилипчивого в Категории 

4.5.3.3.4.Создание Блока, прилипчивого в Ресурсе или Интерактивном Действии 

4.5.3.3.5.Добавление Блока ко всем страницам Профиля Пользователя 

4.5.3.3.6.Добавление Блока на Домашнюю Страницу для всех пользователей 

4.5.3.4.Полномочия Блока 

4.5.4.Действия 

4.5.5.Закладки Администратора 

4.5.6.Управление 

4.5.7.Меню Блога 

4.5.7.1.См. также 

4.5.8.Теги Блогов 

4.5.8.1.Добавление Блока «Теги Блогов» на страницу Курса 

4.5.8.2.Конфигурация Блока 

4.5.8.3.См. также 

4.5.9.Календарь 

4.5.10.Комментарии 

4.5.10.1.Настройки управления Сайтом 

4.5.11.Поисковик сообществ 

4.5.11.1.Загрузка Курсов из хаба 

4.5.11.2.Отыскание Курсов, чтобы зачислиться на них 

4.5.11.3.Возможности 

4.5.11.4.См. также 

4.5.12.Состояние завершения Курса 

4.5.12.1.Как Студент видит Блок «Состояние Завершения Курса» 

4.5.12.2.Как Преподаватель видит Блок «Состояние Завершения Курса» 

4.5.12.4.См. также 

4.5.13.Обзор Курсов 

4.5.13.1.Расположение Курсов в порядке привычном клиенту 

4.5.14.Резюме Курса/Сайта 

4.5.15.Курсы 

4.5.15.1.Настройки управления Сайта 

4.5.15.2.См. также 

4.5.16.ОбратнаяСвязь 

4.5.16.1.См. также 

4.5.17.Хранение и использование цифровых фотографий и видеороликов 

4.5.18.Язык гипертекстовой разметки 
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4.5.18.1.Настройки управления Сайтом 

4.5.19.Самые последние новости 

4.5.19.1.См. также 

4.5.20.Вход в систему 

4.5.22.Главное меню 

4.5.23.1.Добавление Блока «Поднадзорные» 

4.5.23.2.Видимость Блока 

4.5.23.3.Пример применения 

4.5.23.4.См. также 

4.5.24.Сообщения 

4.5.25.Мои последние Символы Отличия 

4.5.25.1.Возможности 

4.5.25.1.1.Добавить новый Блок «Мои последние Символы Отличия». 

4.5.25.1.2.Добавить новый Блок «Мои последние Символы Отличия» на Мою Домашнюю Страницу. 

4.5.26.Мои личные файлы 

4.5.27.Навигация 

4.5.27.1.Обзор 

4.5.27.1.1.Моя Домашняя Страница 

4.5.27.1.2.Страницы Сайта 

4.5.27.1.3.Мой профиль 

4.5.27.1.4.Мои Курсы 

4.5.27.1.5.Навигация внутри Курса «Текущий Курс» 

4.5.27.2.Настройки Блока Навигации 

4.5.27.3.Сокрытие Блока Навигации 

4.5.27.4.Часто задаваемые вопросы 

4.5.27.4.1.Можете вы изменить то, какие ссылки доступны в Блоке Навигации? 

4.5.28.Сетевые серверы 

4.5.29.Онлайн-пользователи 

4.5.29.1.Настройки управления Сайта 

4.5.29.2.См. также 

4.5.30.Люди 

4.5.31.Результаты Экзамена 

4.5.32.Выбираемая случайным образом Запись Глоссария 

4.5.32.1.Заголовок 

4.5.32.2.Принимать Записи из этого Глоссария 

4.5.32.3.Дней до выбора новой Записи 

4.5.32.4.Как выбирается новая Запись 

4.5.32.5.Показать идею (заголовок) для каждой Записи 

4.5.32.6.Ссылки 

4.5.32.7.См. также 
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4.5.33.Недавняя деятельность 

4.5.33.1.Полный отчёт о недавней деятельности 

4.5.33.2.Настройки управления Сайтом 

4.5.33.3.См. также 

4.5.34.Недавние Записи Блогов 

4.5.34.1.См. также 

4.5.35.Удалённые RSS-рассылки 

4.5.35.1.Конфигурирование Блока RSS-рассылок 

4.5.35.1.1.Показать описание вызванного элемента? 

4.5.35.1.2.Максимальное число Записей для отображения 

4.5.35.1.3.Выберите ссылки, обеспечивающие доступность 

4.5.35.1.4.Заголовок 

4.5.35.1.5.Отображать ссылку? 

4.5.35.1.6.Показать изображение канала? 

4.5.35.2.Добавлять/управлять всеми RSS-рассылками 

4.5.35.4.См. также 

4.5.36.Искать Форумы 

4.5.36.1.Продвинутый поиск Форума 

4.5.36.2.Плагины поиска Firefox 

4.5.37.Ссылки на Разделы 

4.5.37.1.Настройки управления Сайта 

4.5.38.СамоЗавершение 

4.5.38.1.Использование Блока «СамоЗавершение» 

4.5.38.2.См. также 

4.5.39.Социальные Интерактивные Действия 

4.5.40.Теги 

4.5.40.1.Добавление Блока «Теги» на страницу Курса 

4.5.40.2.Настройки управления Сайта 

4.5.40.3.См. также 

4.5.41.Наступающие события 

4.5.42.Показ видеоматериалов (Youtube) 

4.5.43.Часто задаваемые вопросы о Блоках 

4.5.43.1.Как скрыть Блоки Главной Страницы от незарегистрированных пользователей? 

4.5.43.2.Как освободиться от ссылки на «Страницы Сайта» в Блоке Навигации? 

4.5.43.3.Как сделать Блок «Главная Страница» видимым для Преподавателей, но не Студентам? 

4.5.43.4.Как можно изменить наименование элемента «Блок» из списка внутри Блока? 

4.5.43.5.Как можно сделать Блок "прилипчивым"? 

4.5.43.6.Откуда этот Блок взялся? Я не хочу его! 

4.5.43.7.Как можно задать порядок, в котором Блоки пристыковываются? 

4.5.43.8.Как можно добавить Блок на все страницы Профилей Пользователей? 
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4.5.43.9.Как предотвратить пользователей от добавления Блоков на их Домашнюю Страницу? 

4.5.43.10.Блоки исчезли с Главной Страницы/страницы Курса! 

4.5.43.11.Помогите, я нечаянно скрыл Блок управления, не понимая последствий! 

4.5.43.12.Я нечаянно удалил Блок Навигации (или управления)! 

4.5.43.13.Мои ссылки Блока Управления не развёртываются! 

4.5.43.14.Как добавить Блок подачи сообщений Твиттера 

4.5.43.15.См. также 

4.5.44.См. также 

4.6.Вопросы 

4.6.1.Управление Вопросами 

4.6.1.1.Управление типами Вопросов 

4.6.1.1.1.Количество вопросов 

4.6.1.1.2.Версия 

4.6.1.1.3.Требования 

4.6.1.1.4.Доступно? 

4.6.1.1.5.Удалить 

4.6.1.1.6.Настройки 

4.6.1.2.См. также 

4.6.2.Контексты Вопросов 

4.6.2.1.См. также 

4.6.3.Банк Вопросов 

4.6.3.1.Выбрать Категорию 

4.6.3.2.Добавить новый Вопрос 

4.6.3.3.Предварительно просмотреть, отредактировать, удалить и переместить 

4.6.3.4.Советы и трюки 

4.6.3.5.Совместное использование и управление Банками Вопросов 

4.6.4.Категории Вопросов 

4.6.4.1.Что такое Категории Вопросов? 

4.6.4.2.Совместное использование Вопросов 

4.6.4.3.Установка и управление Категориями 

4.6.4.3.1.Удаление Категорий 

4.6.4.3.2.Использование иконок стрелок для перемещения Категорий 

4.6.5.Импорт Вопросов 

4.6.5.1.Импортирование Вопросов из существующего файла 

4.6.5.1.1.Процесс импорта Банка Вопросов 

4.6.5.1.2.Обработка модуля «Урок» 

4.6.5.2.Форматы импорта Вопросов 

4.6.5.2.1.Текстовый формат GIFT 

4.6.5.2.2.Расширяемый язык разметки Moodle XML 

4.6.5.2.3.Формат Aiken 
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4.6.5.2.4.Формат Blackboard 

4.6.5.2.5.Тест-Менеджер Курсов 

4.6.5.2.6.Встроенные Ответы (Учебный тест) 

4.6.5.2.7.Тесты формата Examview 

4.6.5.2.8.Горячая картошка 

4.6.5.2.9.Обучающие Вопросы 

4.6.5.2.10.Пропущенное Слово 

4.6.5.2.11.Формат WebCT 

4.6.5.2.12.Формат таблицы Word 

4.6.5.3.Импортирование из других программ 

4.6.5.3.1.Генератор тестов Diploma 6 

4.6.5.3.2.Старые форматы 

4.6.5.4.Кодировка символов 

4.6.5.5.Согласовать Оценки 

4.6.5.6.Советы и трюки 

4.6.5.7.См. также 

4.6.6.Экспорт Вопросов 

4.6.6.1.Процесс 

4.6.6.2.Возможные применения файлов экспорта 

4.6.6.3.Формат GIFT 

4.6.6.3.1.Общие инструкции 

4.6.6.3.2.Примеры форматов Вопросов 

4.6.6.3.3.Опции 

4.6.6.3.4.Советы и трюки 

4.6.6.3.5.Инструментарий текстового процессора и электронной таблицы, который создаёт GIFTы 

4.6.6.3.6.См. также 

4.6.6.3.7.Внешние ссылки 

4.6.6.4.Формат Moodle XML 

4.6.6.4.1.Слово о достоверности (и символьных данных CDATA) 

4.6.6.4.2.Общая структура файла XML 

4.6.6.4.3.Общие теги ко всем типам Вопросов 

4.6.6.4.4.Множественный Выбор 

4.6.6.4.5.Истина/ложь 

4.6.6.4.6.Краткий Ответ 

4.6.6.4.7.Числовой ответ 

4.6.6.4.8.Сопоставление 

4.6.6.4.9.Эссе 

4.6.6.4.10.Другие типы Вопросов 

4.6.6.4.11.Текстовые форматы 

4.6.6.4.12.Полезные утилиты 
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4.6.6.4.13.См. также 

4.6.6.5.Формат XHTML 

4.6.6.6.См. также 

4.6.7.Образцы действий с Вопросами 

4.6.7.1.Управление моделями поведения Вопросов 

4.6.7.2.См. также 

4.6.8.Типы Вопросов 

4.6.8.1.Стандартные типы Вопросов 

4.6.8.1.1.Вычисляемые 

4.6.8.1.2.Простые Вычисляемые 

4.6.8.1.3.Вычисляемые со множественным выбором 

4.6.8.1.4.Описание 

4.6.8.1.5.Эссе 

4.6.8.1.6.Вопросы на Сопоставление 

4.6.8.1.7.Встроенные ответы (Учебный тест) 

4.6.8.1.8.Множественный Выбор 

4.6.8.1.9.Краткий Ответ 

4.6.8.1.10.Числовые 

4.6.8.1.11.Истина/Ложь 

4.6.8.1.12.Типы Вопросов независимых разработчиков 

4.6.9.Часто задаваемые вопросы по Вопросам 

4.6.9.1.Как могут Вопросы совместно использоваться в Курсах? 

4.6.9.2.Если изменить Вопрос в Банке Вопросов, изменится ли он при появлении в Экзаменах? 

4.6.9.3.См. также 

4.6.10.Полномочия Вопросов 

4.6.10.1.Краткий обзор концепций Полномочий 

4.6.10.2.Технические замечания для Администраторов 

4.6.10.3.См. также 

4.6.11.Как позволить Преподавателям совместно использовать Вопросы между Курсами 

4.6.11.1.Что вам нужно сделать 

4.6.11.1.1.Создайте новую Роль совладельца Вопросов 

4.6.11.1.2.Назначьте новую Роль в Контексте системы 

4.6.11.2.Каким Преподавателям нужно это делать 

4.6.11.3.Зачем делать эту работу? 

4.6.11.4.См. также 

4.7.Зачисление на Курс 

4.7.1.Зачисленные пользователи 

4.7.1.1.Зачисленные пользователи 

4.7.1.2.Роли 

4.7.1.3.Группы 
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4.7.1.4.Зачисление пользователей 

4.7.1.5.Поиск зачисленных пользователей 

4.7.1.6.См. также 

4.7.2.Методы зачисления 

4.7.2.1.Методы зачисления 

4.7.2.1.1.Зачисление вручную 

4.7.2.1.2.Самозачисление 

4.7.2.1.3.Доступ Гостя 

4.7.2.1.4.Синхронизация Когорт 

4.7.2.1.5.Ссылка на Метакурс 

4.7.2.1.6.Оплата Курса онлайн по PayPal 

4.7.2.2.Управление методами зачисления 

4.7.2.3.См. также 

4.7.3.Ключ Зачисления 

4.7.3.1.Настройка Ключа Зачисления внутри Курса 

4.7.3.2.Настройка Ключа Зачисления Группы 

4.7.3.3.Настройки Администратора 

4.7.3.3.1.Создание Ключа Зачисления, требуемого в каждом Курсе 

4.7.3.3.2. Использование политики паролей для Ключей Зачисления 

4.7.3.3.3.Предоставление пользователям подсказки по Ключу Зачисления 

4.7.3.4.Советы и трюки 

4.7.3.5.См. также 

4.7.4.Отчисление 

4.7.4.1.Продолжительность Зачисления 

4.7.4.2.Массовое отчисление 

4.7.4.3.История отчислений и Оценок 

4.7.4.4.Исключение или Отчисление? 

4.7.4.5.См. также 

4.7.5.Другие пользователи 

4.7.6.См.также 

4.8.Группирование пользователей 

4.8.1.Группы 

4.8.1.1.Зачем использовать Группы 

4.8.1.2.Уровни Групп 

4.8.1.2.1.Групповые Режимы 

4.8.1.3.Создание Группы 

4.8.1.4.Авто-создание Групп 

4.8.1.5.Группы и Плагины зачислений 

4.8.1.6.Просмотр Групп 

4.8.1.7.Возможности Групп 
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4.8.1.7.1.Управлять Группами 

4.8.1.7.2.Доступ ко всем Группам 

4.8.1.7.3.Управлять записями Календаря Группы 

4.8.1.8.См. также 

4.8.2.Импортировать Группы 

4.8.2.1.Имена полей файла CSV 

4.8.3.Группировки 

4.8.3.3.Выбор Группировки в Интерактивном Действии 

4.8.3.4.Предоставление целой Темы Курса только одной Группировке 

4.8.3.5.Примеры Группировок 

4.8.3.5.1.Пример 1:Установление различий 

4.8.3.5.2.Пример 2: Обязательные и элективные модули 

4.8.3.6.Пример, поясняющий, что такое Группировки 

4.8.3.7.См. также 

4.8.4.1.Создание Когорты 

4.8.4.2.Массовое добавление пользователей в Когорту 

4.8.4.3.Загрузка пользователей в Когорту 

4.8.4.4.Отыскание Когорт 

4.8.4.5.Управление Когортами Категорий 

4.8.4.6.Возможности Когорты 

4.8.4.5.1.Добавить и переместить членов Когорты 

4.8.4.5.2.Добавить, удалить и передвинуть Когорты 

4.8.4.5.3.Сконфигурировать экземпляры Когорт 

4.8.4.5.4.Просмотреть Когорты по всему Сайту 

4.8.4.7.См. также 

4.8.5.Доступно толко для членов Групп 

4.8.5.1.Назначение Интерактивного Действия Группировке 

4.8.5.2.Примеры 

4.8.5.3.См. также 

4.8.6.Часто задаваемые вопросы по Когортам 

4.8.6.1.В чём разница между Когортой и Группой? 

4.8.6.2.Я создал Когорту,а теперь не могу найти её! 

4.8.6.3.Как Преподаватели могут зачислять Когорты? 

4.8.6.4. Могу ли я синхронизировать Когорты с Группами LDAP? 

4.8.6.5.Где можно попрактиковаться с некоторыми готовыми Когортами? 

4.8.7.Часто задаваемые вопросы по Группам 

4.8.7.1.General 

4.8.7.1.1.Что это за настройка: «Режим Групп»? 

4.8.7.1.2.В чём различие между Когортой и Группой? 

4.8.7.1.3.Что это за настройка: «Force (принудить)»? 
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4.8.7.1.4.Можно автоматически добавлять пользователей в Группу при зачислении их через файл CSV? 

4.8.7.1.5.Как назначить Преподавателя в группу? Может Преподаватель быть более чем в одной Группе? 

4.8.7.1.6.Как ограничить просмотр информации Преподавателем информацией только о тех Группах, которые он ведёт? 

4.8.7.1.7.Что определяет, может ли Студент видеть профиль Преподавателя? 

4.8.7.1.8.У меня две Группы, которые общаются в разные дни. Можно установить Интерактивные Действия на различное время для этих двух Групп? 

4.8.7.1.9.Можно ли использовать те же самые Группы более чем для одного Курса? 

4.8.7.1.10.Могут ли Студенты быть членами более чем одной Группы? 

4.8.7.1.11.Если один Студент в Группе, должны ли все Студенты быть в какой-либо Группе? 

4.8.7.1.12.Если у меня несколько Групп, могу я сделать конкретное Интерактивное Действие или Ресурс видимым только в одной из этих Групп? 

4.8.7.1.13.Можно ли иметь один набор Групп для Интерактивного Действия А, а другой набор для Интерактивного Действия Б? 

4.8.7.1.14.Можно ли просмотреть все Группы в Курсе в виде списка для распечатки? 

4.8.7.1.15.Когда я пытаюсь добавить Студента, он всегда попадает в первую Группу,какую бы Группу я не выбрал? 

4.8.7.1.16.Как можно удалить Группу? 

4.8.7.1.17.Как можно импортировать список Студентов в Группу? 

4.8.7.1.18.Как можно автоматически рассортировать Студентов по Группам во время Зачисления? 

4.8.7.1.19.Как изменить порядок сортировки Участников? 

4.8.7.1.20.В чём отличие между Группой и Группировкой? 

4.8.7.1.21.Что такое сиротская Группа? 

4.8.7.1.22.Существует какой-нибудь способ позволить Студентам выбирать Группу? 

4.8.7.1.23.Как можно увидеть список Участников только одной Группы? 

4.8.7.2.Модули Интерактивных Действий и Группы 

4.8.7.2.1.Какие модули Интерактивных Действий НЕ поддерживают Групповой Режим? 

4.8.7.2.2.Что произойдёт, если я переключу Интерактивное Действие из неГруппового Режима в Режим Групп? 

4.8.7.2.3.Что произойдёт, если я изменю Группы для Интерактивного Действия в Режим Групп, например, если я перемещу Студента из одной Группы в 

другую? 

4.8.7.2.4.Как мне отправить сообщение по почте на Форум, который может видеть только одна Группа? 

4.8.7.2.5.Как Преподаватель, я хочу поместить некоторые корреспонденции на Форум каждой Группы. Как это сделать? 

4.8.7.2.6.Как я могу скрыть от любого, кто не в Группе, Интерактивное Действие/Ресурс? 

4.8.7.3.См. также 

4.8.8.Часто задаваемые вопросы по Группировкам 

4.8.8.1.Что такое Группировка? 

4.8.8.2.В чём различе между Группой и Группировкой? 

4.8.8.3.Почему средство «Available for group members (доступно для членов группы) всё ещё экспериментальное»? 

4.8.8.4.Почему оцениваемое Интерактивное Действие назначается только той конкретной Группировке, которая появляется в Журнале Оценок для всех 

пользователей? 

4.8.8.5.См. также 

4.9.Отслеживание прогресса хода обучения 

4.9.1.Оценки 

4.9.1.1.Журнал Оценок 

4.9.1.1.1.Отображение 
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4.9.1.1.2.Редактирование 

4.9.1.1.3.Возможности Журнала Оценок 

4.9.1.1.4.Расширение Журнала Оценок 

4.9.1.1.5.Настройки отчёта по Журналу Оценок 

4.9.1.1.6.Настройки Отчёта Оценивающего 

4.9.1.1.7.Настройки Обзорного Отчёта 

4.9.1.1.8.Настройки Пользовательского Отчёта 

4.9.1.1.9.См. также 

4.9.1.2.Настройки Оценок 

4.9.1.2.1.Настройки Оценок Курса 

4.9.1.2.2.Предпочтения Отчёта Оценивающего 

4.9.1.2.3.Настройки управления Сайтом 

4.9.1.3.Управление Оценками 

4.9.1.3.1.Элементы Оценивания 

4.9.1.3.2.Категории Оценок 

4.9.1.3.3.Вычисление Оценок 

4.9.1.4.Шкалы 

4.9.1.4.1.Стандартные Шкалы 

4.9.1.4.2.Создание новой Шкалы 

4.9.1.4.3.Использование Шкалы 

4.9.1.4.4.Редактирование Шкалы 

4.9.1.4.5.Примеры Шкал 

4.9.1.4.6.Значения, вычисленные как Накопленные Баллы в Процентах 

4.9.1.4.7.Возможности Шкал 

4.9.1.4.8.См. также 

4.9.1.5.Рейтинги 

4.9.1.5.1.Позволение Рейтингов 

4.9.1.5.2.Ajax 

4.9.1.5.3.Возможности и Роли 

4.9.1.5.4.См. также 

4.9.1.6.Показатели 

4.9.1.6.1.Подключение Показателей 

4.9.1.6.2.Использование Показателей) 

4.9.1.6.3.Отчёт по Показателям 

4.9.1.6.4.Показатели, используемые в Курсе 

4.9.1.6.5.Добавление Показателей на уровень Курса 

4.9.1.6.6.Добавление Стандартных Показателей 

4.9.1.6.7.Экспорт Показателей 

4.9.1.6.8.Импорт Показателей 

4.9.1.6.9.Удаление выбранных Показателей для Интерактивных Действий 
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4.9.1.6.10.Возможности Показателей 

4.9.1.6.11.См. также 

4.9.1.7.Оценки Буквами 

4.9.1.7.1.Отображение Оценок Буквами 

4.9.1.7.2.Редактирование Оценок Буквами на уровне Курса 

4.9.1.7.3.Установка Оценки Буквами по умолчанию на уровне Сайта 

4.9.1.7.4.Принуждение Оценок Буквами по умолчанию на уровне Сайта 

4.9.1.7.5.Точность вычислений Оценок 

4.9.1.8.Импорт оценок 

4.9.1.8.1.Импортирование Оценок 

4.9.1.8.2.XML Импорт 

4.9.1.8.3.CSV Импорт 

4.9.1.8.4.Возможности импорта оценок 

4.9.1.8.5.См. также 

4.9.1.9.Экспорт Оценок 

4.9.1.9.1.Как экспортировать Оценки 

4.9.1.9.2.Экспорт в файл XML 

4.9.1.9.3.Настройки экспорта Оценки по умолчанию 

4.9.1.9.4.Экспорт полей Профиля Пользователя 

4.9.1.9.5.Публикация Оценок 

4.9.1.9.6.Возможности экспорта Оценок 

4.9.1.9.7.Советы и трюки 

4.9.1.9.8.См. также 

4.9.1.10.Продвинутые методы оценивания 

4.9.1.10.1.Типы продвинутых методов оценивания 

4.9.1.10.2.Базовые концепции 

4.9.1.10.3.Настройка модуля Интерактивного Действия для использования продвинутых Методов Оценивания 

4.9.1.10.4.Определение Формы Оценивания 

4.9.1.10.5.Повторное использование Форм Оценивания 

4.9.1.10.6.Что видят Студенты 

4.9.1.10.7.Будущее Продвинутых Методов Оценивания 

4.9.1.10.8.Рубрики 

4.9.1.10.9.Руководство по Проставлению Отметок 

4.9.1.10.10.Изучение Аналитически Обогащённой Рубрики 

4.9.1.11.Редактирование Оценок 

4.9.1.11.1.Обычное описание 

4.9.1.11.2.Редактируемые настройки 

4.9.1.11.3.См. также 

4.9.1.12.Часто задаваемые вопросы по Оценкам 

4.9.1.12.2.Оценки и исключения пользователей 
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4.9.1.12.3.Продвинутое оценивание 

4.9.1.12.4.Отчёты 

4.9.1.12.5.Агрегация 

4.9.1.12.6.Категории 

4.9.1.12.7.Показатели 

4.9.1.12.8.Модули 

4.9.1.12.9.Веса и экстра «кредиты» 

4.9.1.12.10.Формулы 

4.9.1.12.11.См. также 

4.9.1.13.Настройки Элементов Оценки 

4.9.1.13.1.Тип отображения Оценки 

4.9.1.13.2.Общее число десятичных знаков 

4.9.1.13.3.Опции элемента продвинутой Оценки 

4.9.1.13.4.См. также 

4.9.2.Обусловленные Действия 

4.9.2.1.Настройки Обусловленных Действий 

4.9.2.1.1.Позволение использования Обусловленных Действий 

4.9.2.1.2.Ограничение доступа 

4.9.2.2.Использование обусловленных Действий 

4.9.2.2.2.Трюки и технические приёмы 

4.9.2.2.3.Обсуждение: Нужно ли на самом деле использовать Обусловленные Действия? 

4.9.2.2.4.См. также 

4.9.2.3.Обусловленные Поля Пользователя 

4.9.2.3.1.Инструкции 

4.9.2.3.2.Пример 

4.9.2.3.3.Поля Пользователя 

4.9.2.3.4.Поля Профиля Клиента 

4.9.2.3.5.Операторы 

4.9.2.4.Часто задаваемые вопросы по Обусловленным Действиям 

4.9.2.4.1.Что ЯВЛЯЕТСЯ Обусловленными Действиями? 

4.9.2.4.2.Где находятся настройки по использованию Обусловленных Действий? 

4.9.2.4.3.Можно организовать доступ к Курсу по условию завершения другого Курса? 

4.9.2.4.4.Можно установить Обусловленные Действия для целого Раздела Курса, не только отдельные Действия? 

4.9.2.4.5.См. также 

4.9.3.Завершение Действия 

4.9.3.1.Настройки Завершения Действия 

4.9.3.1.1.Настройки Действия 

4.9.3.1.2.Опции Заблокированного Завершения 

4.9.3.1.3.Что происходит при разблокировании 

4.9.3.1.4.Требуемые настройки Сайта 
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4.9.3.1.5.Требуемые настройки Курса 

4.9.3.2.Использование Завершение Действия 

4.9.3.2.2.Иконки Завершения Действия 

4.9.3.2.3.Отчёт о Завершении Действия 

4.9.3.3.Часто задаваемые вопросы по Завершению Действия 

4.9.3.3.1.Что происходит при разблокировании условий Завершения? 

4.9.3.3.2.Состояние Завершения Действия не изменяется 

4.9.3.3.3.Как изменить время по умолчанию для освежения отчётов по Завершению Курса 

4.9.3.3.4 Можно переместить кнопки-флажки Завершения Действия справа налево? 

4.9.4.Завершение Курса 

4.9.4.1.Настройки Завершения Курса 

4.9.4.1.1.Настройки Завершения Курса 

Обычные 

Условие: Завершение Действия 

Условие: Завершение других Курсов 

Условие: Дата 

Условие: Период зачисления 

Условие: Отчисление 

Условие: Оценка за Курс 

Условие: СамоЗавершение вручную 

Условие: Завершение вручную другими 

4.9.4.1.2.Настройки управления Курсом 

4.9.4.1.3.Настройки управления Сайтом 

4.9.4.1.4.Возможности Завершения Курса 

4.9.4.2.Использование Завершения Курса 

4.9.4.2.2.Завершения Вручную 

4.9.4.2.3.Завершение Курса на основе заданных критериев 

4.9.4.2.4.Отчёт о Завершении Курса 

4.9.4.2.5.См. также 

4.9.4.3.Блок Состояния Завершения Курса 

4.9.4.3.1.Как видит Студент Блок Состояния Завершения Курса 

4.9.4.3.2.Как Преподаватель видит Блок Состояния Завершения Курса 

4.9.4.3.3.Возможности 

4.9.4.4.Блок самоЗавершение 

4.9.4.4.1.Использование Блока самоЗавершение 

4.9.4.5.Часто задаваемые вопросы о Завершении Курса 

4.9.4.5.1.Студенты что-то завершили, но Отчёт не показывает это 

4.9.4.5.2.Я установил требуемый предварительно Курс, но мои Студенты всё равно имеют доступ ко второму Курсу, не окончив первого 

4.9.4.5.3.Я сделал ошибку и должен стереть данные моего Студента. Должны ли мои Студенты повторно выполнять каждое из Действий? 

4.9.4.5.4.Мой Студент получил сообщение об ошибке, когда щёлкнул по «More information» в Блоке Заершения Курса 
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4.9.4.5.5.Где мои Студенты сообщат мне,что они завершили Курс? 

4.9.4.5.6.Как установить Завершение Курса на срок более 30 дней после зачисления? 

4.9.4.5.7.См.также 

4.9.5.Символы Отличия 

4.9.5.1.Управление Символами Отличия 

4.9.5.1.1.Управление Символами Отличия Курса 

4.9.5.1.2.Управление Символами Отличия Сайта 

4.9.5.1.3.Управление Символом Отличия отдельного пользователя 

4.9.5.2.Настройки Символов Отличия 

4.9.5.2.1.Настройки отдельного пользователя 

4.9.5.2.2.Настройки управления Курса 

4.9.5.2.3.Настройки управления Сайта 

4.9.5.2.4.Возможности Символов Отличия 

4.9.5.3.Использование «Символов Отличия» 

4.9.5.3.2.Добавление Символа Отличия на уровень Сайта 

4.9.5.3.3.Зарабатывание Символов Отличия 

4.9.5.3.4.См. также 

4.9.5.4.Часто задаваемые вопросы по Символам Отличия 

4.9.5.4.1.Как Преподаватели могут присуждать Символы Отличия уровня Сайта? 

4.9.5.4.2.Могут ли в Курсе несколько Преподавателей присуждать один и тот же Символ Отличия? 

4.9.5.4.3.В чём разница между Рюкзаком и Коллекцией? 

4.9.5.4.4.Как можно изменить размер изображения Символа Отличия? 

4.9.5.4.5.Можно присуждать Символ Отличия на основе конкретной Оценки? 

4.9.5.4.6.Следует использовать мою э-почту Moodle для моего Рюкзака? 

4.9.5.4.7.Какие Роли какие Символы Отличия могут видеть? 

4.9.5.4.8.Можно изменить изображения Символов Отличия после их присуждения? 

4.9.5.4.9.Можно отозвать Символ Отличия после его присуждения? 

4.9.5.4.10.См.также 

4.9.6.Отчёты по Курсу 

4.9.6.1.Журналы Регистрации 

4.9.6.1.1.Журналы Регистрации мероприятий Курса 

4.9.6.1.2.Журналы Регистрации мероприятий на Сайте 

4.9.6.1.3.Динамика Журналов Регистрации за последний час 

4.9.6.1.4.Возможности просмотра Журналов Регистрации 

4.9.6.2.Отчёт по Действию 

4.9.6.3.Отчёт о совместной работе 

4.9.6.3.1.См. также 

4.9.6.4.Статистические данные 

4.9.6.4.1.Включение статистических данных 

4.9.6.4.2.Настройки управления Сайта 
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4.9.6.4.3.Статистика не работает? 

4.9.6.4.4.Просмотр статистических данных 

4.9.6.5.См. также 

4.10.Повторное использование Действий 

4.10.1.Резервная копия Действия 

4.10.1.2.Резервное Копирование целых Курсов 

4.10.1.3.Резервное Копирование и Восстановление Заданий из Moodle версии 2.2 и старше 

4.10.1.4.Возможности РезервногоКопирования Действия 

4.10.2.Восстановление Действия 

4.10.2.1.Восстановление отдельных Действий 

4.10.2.2.Восстановление Курса целиком 

4.10.2.3.См. также 

4.10.3.Импорт данных Курса 

4.10.3.1.Как импортировать Интерактивные Действия и Ресурсы 

4.10.3.2.Примеры и советы 

4.10.3.3.Возможности импорта Курса 

4.10.3.4.См. также 

4.10.4.Возврат Курса в исходное состояние 

4.10.4.1.Обзор 

4.10.4.2.Как возвратить в исходное состояние – шаг за шагом 

4.10.4.3.Обычные опции возврата в исходное состояние 

4.10.4.4.Опции Ролей возврата в исходное состояние 

4.10.4.5.Опции возврата в исходное состояние Журнала Оценок 

4.10.4.6.Опции возврата в исходное состояние Группы 

4.10.4.7.Опции по возврату в исходное состояние Интерактивного Действия 

4.10.5.Клонировать Ресурсы/Интерактивные Действия 

4.10.6.См. также 

4.10.6.1.Резервная Копия Курса 

4.10.6.2.Восстановление Курса 
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1. О Системе Moodle

(About Moodle)



1.1.Философия (Philosophy)

1.1.1.Конструктивизм 1.1.1.Constructivism

1.1.2.Конструкционизм 1.1.2.Constructionism

1.1.3.Социальный конструктивизм 1.1.3.Social constructivism

1.1.4.Связанное и раздельное 1.1.4.Connected and separate

1.1.5.Заключение 1.1.5.Conclusion

1.1.6.См. также 1.1.6.See also



1.2.Педагогика (Pedagogy)

1.2.1.Определение педагогики 1.2.1.Definition of Pedagogy

1.2.2.Moodle в трёх коротких параграфах 1.2.2.Moodle in three short paragraphs

1.2.3.Социальный конструкционизм как опорная 
концепция

1.2.3.Social Constructionism as a Referent

1.2.4.Как Moodle старается поддерживать 
концепции социального конструкциониста

1.2.4.How Moodle tries to support a Social 
Constructionist view

1.2.5.Нахождение баланса 1.2.5.Finding a balance

1.2.6.Развитие 1.2.6.Progression

1.2.7.Что ещё вы хотели бы увидеть? 1.2.7.What else would you like to see?

1.2.8.Интересные ссылки 1.2.8.Interesting links



1.3.Стандарты (Standards)

1.3.1.Инициатива Открытого ресурса 1.3.1.An Open Source Initiative

1.3.2.Сертифицированный IMS LTI™ 1.3.2.IMS LTI™ Certified

1.3.3.Отвечающий требованиям SCORM-ADL 1.3.3.SCORM-ADL compliant

1.3.4.Открытые Символы Отличия 1.3.4.Open Badges

1.3.5.Moodle и многостороннее управление 1.3.5.Moodle and Interoperability



1.4.История (History)



1.5.Применение Moodle (Usage)

1.5.1.Кто использует Moodle? 1.5.1.Who uses Moodle?

1.5.2.Сколько существует Сайтов Moodle 1.5.2.How many Moodle sites are there

1.5.3.Как собирается и поддерживается 
статистика

1.5.3.How statistics are collected and 
maintained

1.5.4.См. также 1.5.4.See also



1.6.Просмотр свойств (Features tour)

1.6.1.Вы Преподаватель? 1.6.1.Are you a teacher?

1.6.2.Вы Студент? 1.6.2.Are you a student?

1.6.3.Вы Администратор? 1.6.3.Are you an administrator?



1.7.Новые средства в 2.5 (New features in 2.5)

1.7.1.Для Преподавателей и Студентов 1.7.1.For teachers and students

1.7.2.Для Администраторов 1.7.2.For administrators

1.7.3.См. также 1.7.3.See also



1.8.Сайт Moodle – базовая структура

(Moodle site - basic structure)

1.8.1.Как работает Moodle? 1.8.1.How does Moodle work?

1.8.2.См. также 1.8.2.See also



1.9.Ключевые термины Moodle

(Moodle key terms)

1.9.1.Интерактивные Действия 1.9.1.Activities

1.9.2.Ресурсы 1.9.2.Resources

1.9.3.Блоки 1.9.3.Blocks



1.10. Часто задаваемые вопросы о Moodle

(About Moodle FAQ)

1.10.1.Знакомство с Moodle 1.10.1.Starting with Moodle

1.10.2.Навигация и настройки 1.10.2.Navigation and settings

1.10.3.Примеры 1.10.3.Examples

1.10.4.Обучение с Moodle – педагогические 
вопросы

1.10.4.Learning with Moodle – pedagogy

1.10.5.Студенты 1.10.5.Students

1.10.6.Получение помощи 1.10.6.Getting help

1.10.7.Основной жаргон Moodle 1.10.7.Basic Moodle jargon

1.10.8.Безопасность 1.10.8.Security



2. Инсталляция Moodle

для Windows

(Installing Moodle for Windows)



2.1.Инсталляция (Installation)

2.1.1.Инсталляция. Быстрый старт 2.1.1.Installation Quickstart

2.1.2.Инсталляция Moodle 2.1.2.Installing Moodle

2.1.2.1.Завершённые Пакеты Инсталляции Moodle
для Windows

2.1.2.1.Complete install packages for Windows

2.1.3.«Хрон» 2.1.3.Cron

2.1.4.Инсталлирование дополнительных 
плагинов

2.1.4.Installing add-ons



2.2.Модернизация (Upgrading)

2.2.1.Модернизация 2.2.1.Upgrading

2.2.2.Обзор модернизации 2.2.2.Upgrade overview

2.2.3.Git для администраторов 2.2.3.Git for Administrators

2.2.4.Управление через командную строку 2.2.4.Administration via command line



3. Управление Сайтом Moodle

(Managing a Moodle Site) 



3.1.Аутентификация (Authentication)

3.1.1.Плагины Аутентификации 3.1.1.Authentication plugins

3.1.2.Управление аутентификацией 3.1.2.Managing authentication



3.2.Управление учётными записями (Managing accounts)

3.2.1.Просмотреть список пользователей 3.2.1.Browse list of users

3.2.2.Действия с массовым пользователем 3.2.2.Bulk user actions

3.2.3.Добавить нового пользователя 3.2.3.Add a new user

3.2.4.Загрузить пользователей 3.2.4.Upload users

3.2.5.Изображения пользователей 3.2.5.User pictures

3.2.5.6.См. также 3.2.5.6.See also

3.2.6.Поля Профиля Пользователя 3.2.6. User profile fields

3.2.7.Часто задаваемые вопросы по учётным 
записям

3.2.7.Accounts FAQ



3.3.Зачисления на Курсы (Enrolments)

3.3.1.Плагины зачислений 3.3.1.Enrolment plugins

3.3.2.Зачисление вручную 3.3.2.Manual enrolment

3.3.3.СамоЗачисление 3.3.3.Self enrolment

3.3.4.Синхронизация Когорты 3.3.4.Cohort sync

3.3.5.Ссылка на мета-Курс 3.3.5.Course meta link

3.3.6.Доступ Гостя 3.3.6.Guest access

3.3.7.Зачисления в Категорию 3.3.7.Category enrolments

3.3.8.Зачисление из внешней базы данных 3.3.8.External database enrolment

3.3.9.Плоский файл 3.3.9.Flat file

3.3.10.По стандарту IMS Enterprise 3.3.10.IMS Enterprise

3.3.11.LDAP-Зачисление 3.3.11.LDAP enrolment

3.3.12.Удалённые зачисления по MNet 3.3.12.MNet remote enrolments

3.3.13.Зачисления с оплатой по Paypal 3.3.13.Paypal enrolment



3.4.Роли и Полномочия (Roles and permissions)

3.4.1.Управление Ролями 3.4.1.Managing roles

3.4.2.Назначать Роли 3.4.2.Assign roles

3.4.3.Настройки Ролей 3.4.3.Roles settings

3.4.4.Применение Ролей 3.4.4.Using roles

3.4.5.Стандартные Роли 3.4.5.Standard roles

3.4.6.Создание клиентских Ролей 3.4.6.Creating custom roles

3.4.7.Роль Родителя 3.4.7.Parent role

3.4.8.Полномочия 3.4.8.Permissions

3.4.9.Риски 3.4.9.Risks

3.4.10.См. также 3.4.10.Roles FAQ

3.4.11.Переопределить Полномочия 3.4.11.Override permissions



3.5.Безопасность (Security)

3.5.1.Рекомендации по безопасности 3.5.1.Security recommendations

3.5.2.XSS-надёжные пользователи 3.5.2.XSS trusted users

3.5.3.Обзорный отчёт по безопасности 3.5.3.Security overview report

3.5.4.Политики Сайта 3.5.4.Site policies

3.5.5.Извещения 3.5.5.Notifications

3.5.6.Добавление случайных чисел к паролю 3.5.6.Password salting

3.5.7.Процедуры безопасности Moodle 3.5.7.Moodle security procedures

3.5.8.Усиление конфиденциальности 3.5.8.Increasing privacy

3.5.9.Сокращение спама 3.5.9.Reducing spam

3.5.10.См. также 3.5.10.See also



3.6.Качество работы (Performance)

3.6.1.Рекомендации по работе Системы 3.6.1.Performance recommendations

3.6.2.Настройки режима работы 3.6.2.Performance settings

3.6.3.Обзор характеристик режима работы 3.6.3.Performance overview

3.6.4.Кэширование 3.6.4.Caching

3.6.5.Часто задаваемые вопросы по 
характеристикам работы

3.6.5.Performance FAQ



3.7.Резервное копирование (Backup)

3.7.1.Резервное копирование Сайта 3.7.2.Course backup

3.7.2.Резервное копирование Курса 3.7.2.Course backup

3.7.3.Восстановление Курса 3.7.3.Course restore

3.7.4.Автоматическое резервное 
копирование Курсов

3.7.4.Automated course backup

3.7.5.Процедуры конца года 3.7.5.Year-end procedures

3.7.6.Импорт и экспорт общего картриджа 
IMS

3.7.6.IMS Common Cartridge import and export

3.7.7.Часто задаваемые вопросы по 
резервному копированию и восстановлению

3.7.7.Backup and restore FAQ



3.8.Внешний вид Сайта (Site appearance)

3.9.Язык (Language)

3.10.Настройки сервера (Server settings)

3.11.Отчёты по всему Сайту (Site-wide reports)



3.12.Инструментарий Администратора (Admin tools)

3.12.1.Какие технические навыки мне нужны, 
чтобы стать администратором Moodle?

3.12.1.What kind of technical skills do I need to 
take on Moodle Administration?



3.13.Инструментарий разработчика (Developer tools)

3.14.Веб-сервисы (Web services)

3.15.Moodle для мобильных устройств (Moodle for mobile)

3.16.Социальные хабы (Community hubs)



3.17.Дополнительные средства (More features)

3.17.1.Блоги 3.17.1.Blogs

3.17.2.Комментарии 3.17.2.Comments

3.17.3.Теги 3.17.3.Tags

3.17.4.Обмен сообщениями 3.17.4.Messaging

3.17.5.Заметки 3.17.5.Notes

3.17.6.Рассылка RSS 3.17.6.RSS feeds

3.17.7.Календарь 3.17.7.Calendar



4.Управление Курсом Moodle

(Managing a Moodle course) 



4.1.Курсы (Courses)

4.1.1.Добавление нового Курса 4.1.1.Adding a new course

4.1.2.Категории Курсов 4.1.2.Course categories

4.1.3.Настройки Курсов 4.1.3.Course settings

4.1.4.Форматы Курсов 4.1.4.Course formats

4.1.5.Домашняя Страница Курса 4.1.5.Course homepage

4.1.6.Часто задаваемые вопросы по Курсу 4.1.6.Course FAQ



4.2.Редактирование текста (Editing text)

4.2.1.Текстовый редактор 4.2.1.Text editor

4.2.2.Форматирование текста 4.2.2.Formatting text

4.2.3.Формат Markdown 4.2.3.Markdown

4.2.4.Часто задаваемые вопросы по 
текстовому редактору

4.2.4.Text editor FAQ



4.3.Интерактивные Действия (Activities)

Начало

4.3.0.Управление Интерактивными 
Действиями

4.3.0.Managing activities

4.3.1.Задания 4.3.1.Assignments

4.3.2.Чат 4.3.2.Chat

4.3.3.Выбор 4.3.3.Choice

4.3.4.База Данных 4.3.4.Database

4.3.5.Внешнее приложение 4.3.5.External tool

4.3.6.Обратная Связь 4.3.6.Feedback

4.3.7.Форум 4.3.7.Forum

4.3.8.Глоссарий 4.3.8.Glossary



4.3.Интерактивные Действия (Activities)

Продолжение

4.3.9.Урок 4.3.9.Lesson

4.3.10.Экзамен 4.3.10.Quiz

4.3.11.Формат СДО SCORM 4.3.11.SCORM

4.3.12.Опрос 4.3.12.Survey

4.3.13.Вики 4.3.13.Wiki

4.3.14.Семинар 4.3.14.Workshop



4.4.Ресурсы (Resources)

4.4.1.Книга 4.4.1.Book

4.4.2.Файл 4.4.2.File

4.4.3.Папка 4.4.3.Folder

4.4.4.Пакет с IMS содержимым 4.4.4.IMS content package

4.4.5.Этикетка 4.4.5.Label

4.4.6.Страница 4.4.6.Page



4.5.Блоки (Blocks)

Начало

4.5.1.Стандартные Блоки 4.5.1.Standard blocks

4.5.2.Управляющие Блоки 4.5.2.Managing blocks

4.5.3.Настройки Блока 4.5.3.Block settings

4.5.4.Действия 4.5.4.Activities

4.5.5.Закладки Администратора 4.5.5.Admin bookmarks

4.5.6.Управление 4.5.6.Administration

4.5.7.Меню Блога 4.5.7.Blog menu

4.5.8.Теги Блогов 4.5.8.Blog tags

4.5.9.Календарь 4.5.9.Calendar

4.5.10.Комментарии 4.5.10.Comments

4.5.11.Поисковик сообществ 4.5.11.Community finder

4.5.12.Состояние завершения Курса 4.5.12.Course completion status



4.5.Блоки (Blocks)

Продолжение 1

4.5.13.Обзор Курсов 4.5.13.Course overview

4.5.14.Резюме Курса/Сайта 4.5.14.Course/site summary

4.5.15.Курсы 4.5.15.Courses

4.5.16.ОбратнаяСвязь 4.5.16.Feedback

4.5.17.Хранение и использование цифровых 
фотографий и видеороликов

4.5.17.Flickr

4.5.18.Язык гипертекстовой разметки 4.5.18.HTML

4.5.19.Самые последние новости 4.5.19.Latest news

4.5.20.Регистрация 4.5.20.Login

4.5.21.Пользователь, вошедший в систему 4.5.21.Logged in user

4.5.22.Главное меню 4.5.22.Main menu

4.5.23.Поднадзорные 4.5.23.Mentees

4.5.24.Сообщения 4.5.24.Messages



4.5.Блоки (Blocks)

Продолжение 2

4.5.25.Мои последние Символы Отличия 4.5.25.My latest badges

4.5.26.Мои личные файлы 4.5.26.My private files

4.5.27.Навигация 4.5.27.Navigation

4.5.28.Сетевые серверы 4.5.28.Network servers

4.5.29.Онлайн-пользователи 4.5.29.Online users

4.5.30.Люди 4.5.30.People

4.5.31.Результаты Экзамена 4.5.31.Quiz results

4.5.32.Случайным образом выбираемая 
Запись Глоссария

4.5.32.Random glossary entry

4.5.33.Недавняя деятельность 4.5.33.Recent activity

4.5.34.Недавние Записи Блогов 4.5.34.Recent blog entries

4.5.35.Дистанционная Лента новостей 4.5.35.Remote RSS feeds

4.5.36.Искать Форумы 4.5.36.Search forums

4.5.37.Ссылки на Разделы Курса 4.5.37.Section links



4.5.Блоки (Blocks)

Продолжение 3

4.5.38.Самостоятельное завершение Курса 
Студентами

4.5.38.Self completion

4.5.39.Социальные Интерактивные Действия 4.5.39.Social activities

4.5.40.Теги 4.5.40.Tags

4.5.41.Предстоящие события 4.5.41.Upcoming events

4.5.42.Показ видеоматериалов (Youtube) 4.5.42.Youtube



4.6.Вопросы (Questions)

4.6.1.Управление Вопросами 4.6.1.Managing questions

4.6.2.Контексты Вопросов 4.6.2.Question contexts

4.6.3.Банк Вопросов 4.6.3.Question bank

4.6.4.Категории Вопросов 4.6.4.Question categories

4.6.5.Импорт Вопросов 4.6.5.Import questions

4.6.6.Экспорт Вопросов 4.6.6.Export questions

4.6.7.Образцы действий с Вопросами 4.6.7.Question behaviours

4.6.8.Типы Вопросов 4.6.8.Question types

4.6.9.Часто задаваемые вопросы по 
Вопросам

4.6.9.Questions FAQ

4.6.10.Полномочия Вопросов 4.6.10.Question permissions

4.6.11.Как позволить Преподавателям 
совместно использовать Вопросы между 
Курсами

4.6.11.How to let teachers share questions 
between courses



4.7.Зачисление на Курс (Course enrolment)

4.7.1.Зачисленные пользователи 4.7.1.Enrolled users

4.7.2.Методы зачисления 4.7.2.Enrolment methods

4.7.3.Ключ Зачисления 4.7.3.Enrolment key

4.7.4.Отчисление 4.7.4.Unenrolment

4.7.5.Другие пользователи 4.7.5.Other users

4.7.6.См.также 4.7.6.See also



4.8.Группирование пользователей (Grouping users)

4.8.1.Группы 4.8.1.Groups

4.8.2.Импортировать Группы 4.8.2.Import groups

4.8.3.Группировки 4.8.3.Groupings

4.8.4.Когорты 4.8.4.Cohorts

4.8.5.Доступно только для членов Групп 4.8.5.Available for group members only

4.8.6.Часто задаваемые вопросы по Когортам 4.8.6.Cohorts FAQ

4.8.7.Часто задаваемые вопросы по Группам 4.8.7.Groups FAQ

4.8.8.Часто задаваемые вопросы по 
Группировкам

4.8.8.Groupings FAQ

4.8.9.См. также 4.8.9.See also



4.9.Отслеживание прогресса хода обучения

(Tracking progress)

4.9.1.Оценки 4.9.1.Grades

4.9.2.Обусловленные Действия 4.9.2.Conditional activities

4.9.2.Завершение Действия 4.9.3.Activity completion

4.9.4.Завершение Курса 4.9.4.Course completion

4.9.5.Символы Отличия 4.9.5.Badges

4.9.6.Отчёты по Курсу 4.9.6.Course reports



4.10.Повторное использование Действий (Reusing activities)

4.10.1.Резервная копия Действия 4.10.1.Activity backup

4.10.2.Восстановление Действия 4.10.2.Восстановление Действия

4.10.3.Импорт данных Курса 4.10.3.Import course data

4.10.4.Возврат Курса в исходное состояние 4.10.4.Возврат Курса в исходное состояние

4.10.5.Клонировать Ресурсы/Интерактивные 
Действия

4.10.5.Clone resource/activity

4.10.6.См. также 4.10.6.See also



Основная терминология Moodle





Moodle – это пакет программного обеспечения, первоначально предназначенный для

производства учебных курсов и веб-сайтов на основе интернет-технологий.

Её название «Moodle» является аббревиатурой от «Modular Object-Oriented Dynamic

Learning Environment» – Модульная объектно-ориентированная динамическая

среда обучения. Она является

Открытой Системой Управления Ресурсами Учебных Программ (Open Source

Course Management System (CMS)), известной также как

Система Управления Обучением (Learning Management System (LMS)), или как

Виртуальная Среда Образования (Virtual Learning Environment (VLE)).



Большая популярность этой системы объясняется тем, что она спроектирована с

максимальным учётом передовых классических и современных педагогических

идей:

• интерактивность взаимодействий Преподавателя и Студента (вплоть до обмена

ролями);

• возможность индивидуализации состава и структуры учебной программы;

• возможность внесения улучшающих изменений и в содержание, и в методику со

стороны всех Участников процесса (в том числе студентов);

• совместное интерактивное развитие всех Курсов, входящих в одну учебную

программу;

• участие в развитии данного Курса Преподавателей, ведущих такой же Курс в

разных университетах;

• продвинутые методы контроля и оценивания знаний;

• системный менеджмент функционирования всей системы обучения

и многое другое.



Столь гибкое управление ресурсами учебных программ обеспечивается:

• включением в состав системы Ролей (таких как Администратор, Менеджер,

Преподаватель, Студент, Родитель, Гость и пр.), присваиваемых пользователям,

• наделением тех или иных Ролей Полномочиями,

• каждое из которых поддерживается некоторой совокупностью из более чем 520

разнообразных Возможностей.

Роль, наделённая Полномочиями по использованию тех или иных средств системы

Moodle в различных Контекстах (сайта, Главной Страницы, Категории, Курса,

Интерактивного Действия, Банка Вопросов и пр.),

синхронизируется системой с другими Ролями,

что обеспечивает непротиворечивость и согласованность всей инфраструктуры

Ролей.



Существует иерархия Контекстов никакая Роль, назначаемая в

конкретном Контексте, не работает в других Контекстах одного

с ним и, подавно, более высокого уровня иерархии.

Кроме того, Роль не работает и в том Контексте, в котором

назначена, если в этом Контексте эта Роль уже или ещё пока не

поддерживается системой Moodle.



Контекст – это пространство в Moodle, где могут назначаться Роли

зарегистрированным в системе пользователям. Например, сайт Moodle является

одним Контекстом, который содержит ряд других Контекстов внутри себя.

Роль в Moodle (например, «студент», «преподаватель») определяет, что пользователю

разрешено (а что нет) делать на сайте Moodle.

Роль – это коллекция Полномочий, делегируемых конкретным пользователям при

назначении им этой Роли в конкретном Контексте. Администратор сайта может

предоставить пользователю с любой Ролью более 520 Возможностей (в версии

Moodle 2.5). Возможности не предоставляются каждой Роли, что называется

«навалом». Они группируются в Полномочия, которые система делегирует той или

иной Роли. Одна или несколько Возможностей могут быть предоставлены/устранены

Администратором для/у какой-либо Роли сверх/из стандартных, связанных с

Полномочиями этой Роли.

Комбинация Ролей и Контекста определяет способность конкретного пользователя

делать что-то на любой странице Курса.



Скрытые Роли. Если вы хотите предоставить пользователям доступ к Курсу, но не

хотите, чтобы они были представлены в списке участников Курса, используйте

ссылку «Другие пользователи» в меню «Управление» этого Курса. Назначение Ролей

здесь обеспечивает доступ к Курсу и права редактирования в соответствии с

Полномочиями, установленными для назначаемой Роли, без действительного

зачисления этого пользователя на этот Курс.

По умолчанию единственная Роль, которая может быть назначена в «Других

пользователях» является Роль менеджера. Чтобы назначать другие роли, такие как

преподаватель, для этой Роли должна быть Администратором разрешена

специальная Возможность.



Неразумные Роли. Существует много назначений Ролей, которые не имеют смысла,

поскольку не существует подразумеваемой функциональной возможности.

Именно потому, что когда вы даёте кому-то «право» делать что-то, это ещё не

гарантирует, что действительно существуют интерфейс или Возможность внутри

Контекста, в котором вы выполнили это назначение. Например, вы можете назначить

пользователю право создавать новые Категории в контексте конкретной Категории.

Однако, внутри Moodle нет интерфейса, который бы делал это (создание Категории

доступно только на системном уровне).



Разнородные Роли. Инфраструктура Ролей – это способность назначать одному

пользователю различные Роли (в одно и то же время). Возможности каждой Роли

сливаются и образуют эффективный набор Возможностей. Пользователь может быть в

одном и том же Курсе Преподавателем и Студентом.

Итак, одному и тому же пользователю Moodle может быть назначено несколько Ролей, и

он может переключаться между ними. Однако заметьте – это не совсем полноценное

переключение. Скажем, пользователь с Ролью преподавателя, после завершения им

какой-то части своего Курса, может захотеть просмотреть, как эту часть увидит студент с

позиций своей Роли, и переключится на Роль студента. Однако, на экране перед ним

предстанет не совсем та картинка, которую увидит студент: Возможности Ролей

преподавателя и студента разные, и синхронизировать их переключением Ролей

полностью невозможно. Лучше иметь несколько настоящих Ролей: «тестового

нередактирующего преподавателя», «тестового студента», «тестового гостя» и, может

быть каких-то других, чтобы входить под их регистрационным именем и паролем и

видеть именно то, что будут видеть другие пользователи с такой же Ролью.



Иерархия Контекстов и унаследование Ролей. Назначением Роли пользователю в

определённом Контексте, вы гарантируете ему Полномочия, делегированные этой Роли

для этого Контекста и во всех более низких Контекстах.

Список Контекстов в иерархическом порядке:

• System – система (нет более высокой родительской иерархии).

• Front page – Главная страница (родитель = система).

• Course category – Категория Курса (родитель = Категория родителя или система).

• Course – Курс (родитель = Категория или система).

• Activity – Действие (родитель = Курс или Система).

• Block – блок (родитель = Курс или система).

• User – пользователь (родитель = система).

Роли могут быть унаследованы, и будут работать, если только назначение каждой из

них сделано в правильном Контексте. Например, Роль преподавателя должна быть

назначена пользователю в Контексте Курса или Категории Курсов; Модератор Форума

для конкретного Форума должен назначаться в этом конкретном Форуме.



Регистрация – это создание учётной записи пользователя с его регистрационным

именем и паролем вручную Администратором или Менеджером Уровня Сайта,

студентами посредством саморегистрации по э-почте с разрешённых почтовых

доменов (скажем из аудитории) и в течение короткого периода времени.

Аутентификация – это различные методы идентификации пользователей при входе в

систему Moodle. Она может состоять либо из регистрации и проверки полномочий при

входе, либо только из проверки полномочий, если регистрация уже была.

Аутентификация – это проверка полномочий пользователя, входящего в систему.

Если полномочия не подтверждаются – попросить зарегистрироваться!

Зачисление – это фиксация пользователей как Участников в каком-то учебном Курсе.

Это касается и Студентов и Преподавателей.

Зачислить можно:

• в Категорию Курсов (на все Курсы этой Категории сразу),

• на Курс,

• в мета-Курс, присоединением к нему «дочерних» Курсов (и всех зачисленных на

них пользователей, а потом выбором из них для зачисления в новые Курсы),

• в Когорту (а потом всех зачисленных в Когорту скопом зачислять на какой-либо

Курс).



Категория – это группа чего-то, и имеет в Moodle несколько значений. Она может быть

Категорией Курсов, отобранных по определённому критерию (такому как наука,

начальная школа, область преподавательского состава). Она может быть группой

Вопросов или группой записей в Глоссарии.



Когорта представляет собой множество пользователей, которые были добавлены в неё

либо в Контексте Сайта, либо в Контексте определённой Категории.

Все пользователи Когорты могут быть все вместе сразу зачислены на Курс или в

Группу.

По умолчанию Преподаватель не может зачислить пользователей Когорты на свой Курс.

Это может Администратор или Менеджер уровня Сайта, а не уровня Категории.

Если вы хотите, чтобы пользователь с Ролью Менеджера уровня Категории видел эту

опцию зачисления, нужно добавить соответствующие Когорты на уровень этой

Категории, НЕ на уровень Сайта.

Члены Когорты могут быть зачислены в предварительно созданную Группу.

Если любые члены добавляются или удаляются из Когорты, они автоматически

добавляются или удаляются из этой Группы.

Рекомендуется, чтобы предпочтение отдавалось зачислению в Когорты по

сравнению с зачислениям в Категорию, поскольку имеются вопросы по выполнению

при зачислениях в Категорию



Курс – это основная обучающая область в Moodle, где преподаватель представляет

материалы своим студентам. По умолчанию обычный преподаватель не может

добавить новый Курс. Чтобы добавить новый Курс в Moodle, нужно иметь права или

Администратора или Менеджера уровня Сайта или уровня Категории Курсов.

Добавление новых Курсов производится в какую-либо Категорию Курсов.

Лучше создать принятую в учебном заведении, на факультете или кафедре иерархию

Категорий, тогда и студентам и преподавателям и гостям будет легче

ориентироваться в наличии нужных им Курсов.

Список Курсов внутри Категории показывает по умолчанию преподавателей и

аннотацию каждого Курса.

Если число Курсов внутри Категории превышает 9 (10 или более), тогда

показывается краткий список, без имён преподавателей и аннотаций.



Как только область под Курс создана, преподаватель может вносить туда конкретное

содержимое (Ресурсы и Интерактивные Действия, необходимые студентам для

использования и исполнения в процессе обучения), реорганизовывать его в

соответствии с его собственными задумками, зачислять на него студентов, гостей.

Ссылка на мета-Курс. Можно создать один или несколько так называемых «мета-

Курсов», а другие Курсы (назовём их «дочерними) с зачисленными на них участниками,

присоединить к этим мета-Курсам, а потом, при зачислении участников на новый Курс,

можно в качестве метода зачисления выбрать «Ссылку на мета-Курс». И участники тех

«дочерних Курсов», где вы являетесь преподавателем, автоматически зачислятся на

новый Курс.

Например, имеется Курс «Только для преподавателей» и Курс «Помощь по Moodle».

Если Курс «Только для преподавателей» добавляется в Курс «Помощь по Moodle»

посредством «Ссылки на мета-Курс», то участники, зачисленные на Курс «Только для

преподавателей», автоматически зачисляются также и на Курс «Помощь по Moodle».



Группа – часть студентов на Курсе, которым поручается выполнить какие-то

Действия.

Группировка – объединение нескольких Групп. Служит для выполнения массовых

действий сразу со всеми её членами.



Ресурс в Moodle является Действием, которое преподаватель предлагает выполнить

Студенту в Курсе индивидуально. Например, изучить содержимое Файла, Папки,

Страницы, Книги, Этикетки, того, на что ссылается Гиперссылка.

Интерактивное Действие является тем, что Студент будет выполнять во

взаимодействии с другими Студентами и/или Преподавателем, т.е. интерактивно. В

Moodle имеется более дюжины стандартных Интерактивных Действий, например,

Форум, Вики, Чат, Урок, Задание, Семинар, Выбор, База данных, Глоссарий, Экзамен,

Обратная связь, Опрос.

Интерактивные Действия могут оцениваться.

Кроме стандартных Интерактивных Действий, которые идут с дистрибутивом, есть и

дополнительные от независимых разработчиков.



Обусловленные Действия – группа настроек в Ресурсе или Интерактивном Действии

для установки условий, при которых в них можно войти, или даже при которых эти

Действия могут быть увидены студентами.

Обусловленные Действия позволяют преподавателям ограничить доступ к любому

Действию или даже Разделу Курса в соответствии с определёнными условиями

такими, как

• даты,

• полученные Оценки,

• Завершение других Действий.

Завершение Действия/Курса позволяет преподавателю установить критерии

завершения для конкретного Действия. Ярлычок (галочка) появляется напротив

Действия после получения определённого результата или просто после маркировки

студентом Действия/Курса как завершённого.



Страница – область представления части Курса на экране. Состоит из боковых полос и

центральной части. Боковые полосы заполняются Блоками, если это нужно

преподавателю.

Раздел – центральная область внутри страницы Курса, в которую вносятся Ресурсы и

Интерактивные Действия.

Стандартными форматами Разделов Курса являются:

• Тематический,

• Еженедельный,

• Социальный

• SCORM.

Они влияют на вид центральной части страниц Курса.



Блоки – информационные элементы, которые могут быть добавлены слева или справа

на Домашнюю Страницу Курса.

Блоки дают дополнительную информацию или ссылки на учебные пособия.

Блоки подобны «вспомогательным устройствам», приспособленным для облегчения

работы в режиме онлайн, и могут содержать, например, RSS Рассылки Новостей,

Результаты Экзаменов, Календарь Событий, Ссылки на Блоги, Термины Глоссария

или Личные Файлы.

Существует также простой Блок HTML, который может быть настроен в соответствии

с пожеланиями преподавателя.

Moodle имеет ряд Стандартных Блоков, но существуют также Дополнительные Блоки

от независимых разработчиков.



Фильтры могут использоваться для добавления ссылок, вставки проигрывателей

мультимедиа, конвертации математических выражений (например, в нотации TeX)

или картинок, выражающих эмоции (смайликов), в отображаемое изображение.

Плагин является дополнительной компонентой по выбору, которая может добавить

функциональности вашей Moodle.

Некоторые стандартные Плагины Moodle требуют их включения Администратором

Сайта.

Множество плагинов предлагается независимыми производителями, например,

плагины дополнительных форматов Курсов, Блоков, фильтров и пр.



Процедуры конца года. Поскольку Moodle используется в академической среде, такой

как школа или университет, полезно иметь в наличии процедуры для отчисления

студентов и преподавателей, которые покинули учебное заведение, и перемещения

текущих студентов на следующий год, с гарантией того, что вся существенная работа

сохранится.

Хотя мы говорим о «процедурах конца года», процесс подготовки следующего

набора студентов для одного или более Курсов, может выполняться не в конце

года.

Некоторые организации могут запускать двухнедельные онлайн Курсы каждый

месяц; другие могут выполнять оценивание каждую сессию/семестр, а некоторые

могут предоставить обучающимся самостоятельный выбор скорости изучения

материала, скользящую программу с зачислением/отчислением в любое время.



О системе оценивания в Moodle



Moodle поддерживает реализацию в учебном процессе любых методик (от

многофункциональных типа Урока или Форума, до узкоцелевых операций над данными,

типа Оценивания) и предоставляет преподавателям средства вводить в Курс

собственные новые педагогические средства.

Мы говорим об оценивании степени освоенности каждым студентом пройденного

курса. В российской системе образования установлены простые стандарты итогового

оценивания, вносимые в официальные документы об образовании: четырёх-бальная

оценка за экзамен («отлично», «хорошо», «удовлетворительно»,

«неудовлетворительно») и двухбалльная – за зачёт («зачтено», «не зачтено»).

В практике преподаватели иногда вводят (для себя!) промежуточные градации, типа

«плюсов» и «минусов» или дробных чисел.



Более детальное оценивание (отдельно по разным частям Курса) или

более точное (с большим числом градаций оценки),

то в Moodle он может найти подходящие для этого средства.

Возможно также, что в ходе идущей реформы образования будут введены новые

стандарты оценивания.

Mооdle поддерживает:

Исходное Оценивание в различных (количественных и качественных) измерительных

шкалах и

Итоговое Оценивание (агрегирование первичных оценок) по разным алгоритмам и

формулам.



Все Оценки для каждого студента в Курсе могут быть найдены в Журнале Оценок

(называемого также «Отчётом Оценивающего»).

Существует три способа отображения Журнале Оценок:

• Grades only (Только оценки) – без колонки Итоговых Оценок по Категории.

• Collapsed (Свёрнутый) – только колонка Итоговых Оценок по Категории.

• Full view (Полный просмотр) – Оценки и Агрегации (Сводные Показатели –

колонка Итоговых Оценок для Категории).

.



О Вопросах в Moodle



Типы Вопросов

Вопросы можно задавать в модулях Интерактивных Действий «Экзамен» и «Урок».

Некоторые Вопросы модуля «Экзамен» аналогичны Вопросам модуля «Урок», которых

числом меньше и функционируют они иначе. Об особенностях и отличиях см.

Документацию по Moodle.

Кроме стандартных типов Вопросов, которые являются частью дистрибутива ядра

Moodle, существует ряд встраиваемых типов Вопросов в Базе данных плагинов от

независимых производителей.



Стандартные типы Вопросов модуля «Экзамен»

1. Вычисляемые

2. Вычисляемые с множественным выбором

3. Описание

4. Эссе

5. Вопросы на сопоставление

6. Встроенные ответы (Учебный тест)

7. Множественный выбор

8. Краткий ответ

9. Числовые

10. Истина/ложь



Встраиваемые типы Вопросов от независимых 

производителей 

1. Вопросы Алгебраического типа,

2. Вопросы с Вычисляемыми объектами,

3. Вопросы, подготавливаемые в Модуле редактора Учебного теста,

4. Вопросы типа Комбинируемых

5. Вопросы в виде Карты,

6. Вопросы с Правильным написанием,

7. Вопросы с буксировкой изображения или текста,

8. Вопросы с Буксировкой в текст,

9. Вопросы с Буксировкой отметок,

10. Вопросы с Буксировкой сопоставлений,



Встраиваемые типы Вопросов от независимых 

производителей (продолжение 1)

11. Вопросы с Буксировкой в изображение,

12. Вопросы с заполнением пропусков в тексте,

13. Вопросы Интервального типа,

14. Вопросы с молекулярным Java-редактором

15. Вопросы Матричного типа,

16. Вопросы Многочисленных типа,

17. Вопросы с Музыкальными ключевыми знаками,

18. Вопросы с Музыкальной шкалой,

19. Вопросы Непрозрачных типов,

20. Вопросы с Множественными ответами Открытого университета,



Встраиваемые типы Вопросов от независимых 

производителей (продолжение 2)

21. Вопросы на Сопоставление с образцами,

22. Вопросы на Сопоставление с образцами в молекулярном редакторе,

23. Вопросы с Perl-совместимыми стандартными выражениями,

24. Вопросы Абстрактного типа от Волгоградского университета,

25. Вопросы записывающих PoodLL,

26. Вопросы Preg,

27. Вопросы с Программируемыми ответами,

28. Вопросы с Краткими ответами стандартных выражений,

29. Вопросы на сопоставление с реверсивными образцами,

30. Вопросы «Выбрать пропущенные слова»,



Встраиваемые типы Вопросов от независимых 

производителей (продолжение 3)

31. Вопросы «Установить разделение»,

32. Вопросы «Электронные таблицы»,

33. Вопросы STACK,

34. Вопросы «Горячие точки мочевого пузыря»,

35. Вопросы с Числовыми переменными,

36. Вопросы с набором Числовых переменных,

37. Вопросы с набором Числовых переменных и единицами измерений,

38. Вопросы с Вертикальным сопоставлением.



Спасибо за внимание!


